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1. Docs

1.1 Welcome to KUMAVISION Help

With our online help we hope to provide you with the best possible guidance. If something should be unclear, please do not

hesitate to contact our support.

The content of the KUMAVISION Help reflects the latest versions of the KUMAVISION industry solutions and apps. If you are using a

different version, some features and processes may not yet be available for the version you are using.

1.1.1 Verticals

base (BOOSTER)

project365

project365 Real Estate

project365 Architects

project365 Engineering

trade365

healthcare365

factory365

medtec365

1.1.2 Apps

Applications Overview

Note

• 

• 

• 

• 

• 

• 

• 
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• 
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1.2 Verticals

1.2.1 base (BOOSTER)

KUMAVISION base (BOOSTER)

KUMAVISION base (BOOSTER) provides the base functionality for all KUMAVISION industry solutions. For more information,

see the following topics.

Topics

General Business Functionality

Financial Management

Sales

Purchasing

Manufacturing

Warehouse Management

Service

Purchase Request

Dispatch

Compliance

Warranty Claims, Complaints, and FMEA

Unique Device Identification

Package Labels

Packages / Carriers: Microsoft Dynamics 365 Business Central extension

General Setup

Get KUMAVISION BOOSTER from Microsoft AppSource

• 

• 

• 

• 

• 
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General Business Functionality

The following features expand standard Microsoft Dynamics 365 Business Central1 functions to provide additional options to

those using General Business Functionality.

CONTACT MANAGEMENT

As an addition to standard marketing functionality, the contact management feature provides salespeople and purchasers alike

with the option of creating cockpit views that include every relevant piece of information stored about a contact.

Each view can be customized to meet a specific user’s requirements. You can also directly add certain actions to a view. 

Setup

To specify what information and functions should be part of the cockpit:

Choose the Search icon, enter User Setup, and then choose the related link.

Select a user and choose Edit on the ribbon.

On the Cockpit View FastTab, specify what you want to display, such as marketing functions and sales documents if you’re a

salesperson.

On the Cockpit Actions FastTab, select what actions are required in the view, depending on whether the cockpit is used in sales or

purchasing.

Contact card

Each contact card now shows the information and actions that you specified.

Choose the Search icon, enter Contacts, and then choose the related link.

This opens a list on which organization contacts are shown in bold. The people associated with the relevant organization are shown

underneath, in standard font. Double-click an organization.

Go to the FastTab called Contacts (which was added to the card) to see the people linked to the company contact.

Contacts

Ribbon actions

On the ribbon, you’ll find the functions that you specified in User Setup on the Cockpit Actions FastTab.

You can hide and unhide functions and FactBoxes on the contact card in the same way you would in the standard system. The default

values specified in User Setup will then be overridden.

Contact Statistics

1. 

2. 

3. 

4. 

1. 

2. 

3. 

Field Description

No. Specifies the number of the contact person. Clicking this field opens the card related to the contact.

Name Specifies the contact person’s name.

Phone No. Specifies the contact’s phone number.

If a connection to a TAPI interface has been established, the number entered in this field can be dialed

immediately.

Comment A Yes indicates that remarks have been stored for this contact. Clicking the field will show them to you.

Email Specifies the contact’s email address.

If you select the address entered in this field, you can send an email to the contact via your email provider.

Note

1.2.1 base (BOOSTER)
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Found on the right-hand side of the card, this FactBox displays the marketing activities and sales documents linked to the

contact. You can click a value to open the data records associated with each of the fields.

Forecast

Also on the right-hand side, you can see the current sales opportunities linked to the contact and the sales quotes related to

those opportunities.

TRANSLATE RESOURCES AND WORK TYPES

As companies are increasingly branching out into markets around the world, texts for resources and work types must be

translated as well. They can be found both on the Translations page and on purchase and sales documents.

Setup

You can store translations of resources and work types as base data. To set up a translation:

Choose the Search icon, enter Resources or Work Types, and then choose the related link.

Open a resource or work type card.

Choose Translations on the ribbon and enter a language code in the Description field.

Fill in the remaining fields as necessary.

Use a translation

When you enter a resource on sales documents, the system checks whether a translation has been specified for the resource in

the language entered on the sales header.

If a translation is found, it is entered in the Description and Description 2 fields on the sales lines. If none is available for a

language code, the standard text is used. The same is true for work types when you enter a type on a purchase or sales

document.

EDIT TEXT

In the standard system, long paragraphs are broken up into smaller segments and distributed onto multiple lines. Because of

this, you can’t simply copy and paste larger bodies of text, which might make adding notes to documents a tedious and

cumbersome task.

The solution to this has been to develop an easy-to-use text editor for copying and pasting extended and document texts without

line breaks. As an example, to create an extended text (see also Extended Text), you can do the following:

Write a note, for example, in Microsoft Word.

Open the Extended Text page.

Choose Manage > Formatting Editor on the ribbon.

Use the copy-and-paste function to copy the note from Word.

Even if you format text in a certain way, some of your stylistic choices—such as having text printed in bold, italic, or underlined—

might not appear on documents printed from Microsoft Dynamics 365 Business Central1.

You can also enter a beginning or ending text on a document line.

Open a document.

Go to the Lines FastTab.

Select the line for which you want to enter text.

Choose Related Information > Document Texts > Beginning or Ending Text on the ribbon.

On the Document Text card, choose Formatting Editor.

Enter a text manually or copy and paste one that you wrote earlier.

1. 

2. 

3. 

4. 

1. 

2. 

3. 

4. 

Note

1. 

2. 

3. 

4. 

5. 

6. 
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To have the text printed on certain documents, select the relevant Print fields on the line that you entered the text on.

EXTENDED TEXT

Besides using standard functionality to add item descriptions to a document, you can now also specify text that you want shown

on headers and footers or before and after a line on a document.

Document texts that you want to enter at the line level, that is, as beginning or ending texts, can be specified as early as setting

up items, resources, or G/L accounts. At the header level, you can store these texts as early as setting up a customer or vendor.

Create an extended text

To create an extended text:

Open the card of an item, resource, G/L account, vendor, or customer.

Choose Extended Text on the ribbon.

Enter a text on a line.

Fill in the Starting Date and Ending Date fields if you want to make the text available only during a certain period. You can also

select the All Languages checkbox if you want it shown regardless of the language code stored for a customer’s or vendor’s

documents.

You can then select other checkboxes on the line to specify on which kind of purchase or sales document you want the text to be

shown.

Afterward, you can choose between three options in the Use as Document Text field as described in the following table.

In the Position field, you can choose whether the extended text should appear as a beginning text at the top of documents or

above a description of an item, a resource, or a G/L account—or as an ending text at the bottom or below any of these

descriptions. To put an extended text on a document:

Open a document.

Go to the Lines FastTab.

Choose Functions, and then choose Insert Ext. Texts.

Document starting and ending dates

Although you can use standard functionality to specify how long an extended text assigned to base data should be displayed on

documents, the availability of a certain text is only checked when you create a document but not when its content is copied to

another type of document or when it is still open after the last date on which to include the text has passed.

As a result, printouts might contain lines that should no longer be available. To remedy this situation, the starting and ending

dates assigned to a text are now automatically copied to the Beginning Text or Ending Text page or to the lines of a document

when extended text is being added.

The system then checks these dates when you run the Copy Document action or choose Create Sales Order on a sales quote, for

example, to determine if a certain text line should be retrieved at all.

Advertising groups

Besides adding extended texts to vendor, customer, and other documents, you can assign them to advertising groups.

1. 

2. 

3. 

4. 

5. 

Option Description

Yes The text can be opened by choosing Line > Document Texts > Beginning or Ending Text.

No The text is used as a document line.

Automatic The text is inserted automatically.

1. 

2. 

3. 
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Advertising groups are used to store extended texts for multiple or all vendors or customers, for example, to inform about

company holidays, physical stock-taking periods, and trade shows. To set up a group:

Choose the Search icon, enter Advertising Groups, and then choose the related link.

Choose New on the ribbon to create a new advertising group or choose Edit to change an existing group. You can also choose

Delete if you want to remove a group from the list.

Fill in the fields as described in the following table.

To assign an extended text to an advertising group:

Select a group.

On the ribbon, choose Extended Text.

Choose New and enter a text.

For more information on how to create a text module, see Extended Text.

POSITION NUMBERS

You can also assign position numbers to lines to structure a document.

You can enter numbers manually in the Position No. fields on document lines. Alternatively, you can run the Assign Position Nos.

function from the ribbon to have numbers assigned automatically.

1. 

2. 

3. 

Field Description

Code Specify a meaningful description for the advertising group.

Description Enter a more detailed description of the group and the extended texts stored for it.

All Customers Select this checkbox if you want the advertising group used for all customers.

No. of Customers Instead of selecting All Contacts, you can specify in this field a certain number of contacts for whom

the group should be used.

Selecting the lookup in the field will take you to the Advertising Group Members page, where you can

add specific customers.

All Vendors Select this checkbox if you want the advertising group used for all vendors.

No. of Vendors Instead of selecting All Vendors, you can specify in this field a certain number of vendors for whom

the group should be used.

Selecting the lookup in the field will take you to the Advertising Group Members page, where you can

add specific vendors.

All Contacts Select this checkbox if you want the advertising group used for all contacts.

No. of Contacts Instead of selecting All Contacts, you can specify in this field a certain number of contacts for whom

the group should be used.

Selecting the lookup in the field will take you to the Advertising Group Members page, where you can

add specific contacts.

No. of Extended

Texts

Shows the number of extended texts stored for the group.

1. 

2. 

3. 
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How position numbers are assigned can be specified in Purchases & Payables Setup or Sales & Receivables Setup as described in

the following table.

PRINT LINE

To cut down on paper usage, lines without price information can be removed from printouts. To hide a line, open a document, go

to the Lines FastTab, and select the relevant line. Afterward, clear its Print Line checkbox.

PRINT LINE BREAK

For layout purposes, a page break can be added to printouts by selecting Print Line Break on a document line.

STRUCTURE DOCUMENTS

You can now structure purchase, sales, and service documents more easily by adding a heading to a document line or by having

certain lines form a subtotal or bundle (with per-line prices not being shown). You can also assign a position number to each line.

Field Description

Check Pos. Nos. on Purch./

Sales Lines

(blank)

No impact.

Check

Checks for position numbers when a document is released. Shows an error message if the

numbers are missing.

Auto Assign

Checks for numbers and assigns them automatically when a document is released.

Auto Pos. Nos. (Type) (blank)

No impact.

Single

Assigns sequential numbers. How big the steps between numbers are is set in the Auto

Position Nos. (Step) field.

Multilevel

The Position No. field contains an outline (1 / 1.1…).

This can be helpful especially when it comes to subtotals and bundles, as position numbers

then point to their level within the structure.

Auto Pos. Nos. (Step) Specifies how big the steps between position numbers are (10, 100, or 1000).

1.2.1 base (BOOSTER)
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To structure a document, you need to fill in the Type field on the relevant lines. The options of the field are described in the

following table.

MANUFACTURING DATE / SUBCONTRACTED LOT

Besides using standard item tracking functionality, you can now store the manufacturing date and the external lot number for an

item.

Setup

You can store the date when an item was manufactured or the lot number that a supplier used for it together with the standard

item tracking code.

Choose the Search icon, enter Item Tracking Codes, and then choose the related link.

Choose New on the ribbon or select a code and choose Edit.

Fill in the fields as necessary. On the Misc. FastTab, turn on the Manual Prod. Date Required or the Manual External Lot Required

toggle, or both, to specify that the field(s) must be filled in for tracking codes.

Assign a tracking code

To assign a tracking code to an item:

Choose the Search icon, enter Items, and then choose the related link.

Choose New on the ribbon or select an item and choose Edit.

Go to the Item Tracking FastTab and fill in the Item Tracking Code field.

You can assign a code to any outgoing or incoming document. For a posted entry, a posted tracking code is stored retroactively.

See the standard online help for more information: Trace Item-Tracked Items.

BLOCK AN ITEM OR A VARIANT

Sometimes, business decisions might lead you to block items from being used in sales and purchasing (but not in service, for

example). To prevent the use of an item in a specific area:

Open an item card.

On the Item FastTab, turn on the Blocked toggle that corresponds to the area where you don’t want the item to be entered.

(For more information, see Block Base Data.) You can also block item variants from being used in some or all areas.

On the item card, choose Related > Item > Variants.

Select a line with a variant and select the Blocked fields that correspond to the areas where you don’t want the variant to be

used.

Field Description

Headline Shows text entered in the Description field in bold on printouts.

Subtotal Shows text entered as a description in bold on printouts and marks the starting point for a number of

items, resources, or G/L account lines you want included in a subtotal.

Bundle Shows text entered as a description in bold on printouts and marks the starting point for a number of

items, resources, or G/L account lines you want included in a bundle.

Prices for bundles are shown as totals on printouts, without line prices, discounts, and amounts.

End-Subtotal/

Bundle

Shows text entered as a description in bold on printouts and marks the end point for a number of items,

resources, or G/L account lines you want included in a subtotal or bundle.

Subtotals can be changed in sales to reflect reductions or increases in price. The price difference is

then distributed evenly among the sales lines.

1. 

2. 

3. 

1. 

2. 

3. 

• 

• 

• 

• 
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In addition to standard app options, KUMAVISION base (BOOSTER) also offers you variant blocking in the following areas:

Manufacturing

Consumption

Transfers

Assembly

Projects

You see an error message if a blocked variant is entered in any of these, and the entry will be discarded. In purchasing, for

example, the system checks for blocked variants in the following order of priority:

Blocked toggle on the item card

Purchasing Blocked toggle on the same card

Purchase Variant Blocked toggle on the variant card

ITEM ATTRIBUTES

Item attributes are used to group and find items according to certain criteria. You can assign attributes to every item that is

stored in the system, either by assigning them to an individual item or to a category of items.

Setup

Before you can use this feature, you need to set up the required attributes and their attribute values.

Choose the Search icon, enter Item Attributes, and then choose the related link. 

Choose New on the ribbon.

Fill in the fields as described in the following table.

Printing

On this FastTab, you can specify whether to print an item attribute on sales or purchase documents.

Select an attribute.

Use the Assist Button next to the Sales or Purchasing field to open the print selection.

Select the checkboxes for the type of sales or purchase documents on which you want to print the attribute, and then choose Close.

• 

• 

• 

• 

• 

1. 

2. 

3. 

1. 

2. 

3. 

Field Description

Name Specify the description of the attribute.

You can enter a maximum of 250 characters in this field.

Type Specify the type of data referenced on this line. Any value that you specify for the attribute must

match this type.

You can choose between Option, Text, Integer, Decimal, and Date.

Values Used to specify values for attributes of type Option.

Note

This field is only shown if you chose Option in the Type field.

Blocked With the toggle turned on, the attribute can no longer be used.

Required Turn on this toggle if you want to require users to fill in this attribute for item masters.

Printing Sequence

No.

Specify the order in which you want attributes printed if more than one attribute is included on a

document.

1. 

2. 

3. 

1.2.1 base (BOOSTER)

- 11/1545 - Copyright © 2018 - 2024 KUMAVISION AG



To select the field on more than one line:

Mark the relevant lines.

Choose Print on Document > Sales or Purchase on the ribbon. Initially, all fields will be blank (that is, deactivated).

Select the relevant checkboxes and confirm by choosing Close.

Print settings that you’ve already specified will be overwritten (provided you choose Yes on the message that appears).

Unit of measure translations

For attributes that come with a unit of measure, you can choose Translations on the ribbon to store—and later print on

documents—a translation of the unit in another language.

Assign an attribute

Items

To assign an attribute to an item:

Open an item card.

Choose Item > Attributes on the ribbon.

Fill in the fields as necessary.

You can then see the assigned attributes in the Item Attributes FactBox on the card.

If the Required checkbox is selected for an attribute and the Item Field Check toggle was turned on in Inventory Setup, a mandatory

field check is performed when you’re about to complete item maintenance. An error message will be shown if you haven’t entered a

value for an attribute specified as Required or if a category with a required but (so far) unspecified attribute was assigned to the

item.

Printing

On this FastTab on the Item Attribute Values page, you can specify whether to print an item attribute on sales or purchase

documents.

Select an item attribute.

Use the Assist Button next to the Sales or Purchasing field to open the print selection.

Select the checkboxes for the type of sales or purchase documents on which you want to print the attribute, and then choose Close.

Selections that might have already been made because of how you set up the item attribute or category will be replaced by what you

specify on this page.

To select the field on more than one line:

Go to the Item Attribute Values FastTab.

Mark the relevant lines.

Choose Print on Document > Sales or Purchase on the ribbon. Initially, all fields will be blank (that is, deactivated).

Select the relevant checkboxes and confirm by choosing Close.

Print settings that you’ve already specified will be overwritten (provided you choose Yes on the message that appears).

Item categories

1. 

2. 

3. 

1. 

2. 

3. 

Note

1. 

2. 

3. 

Note

1. 

2. 

3. 

4. 
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To assign an attribute to an entire category of items:

Choose the Search icon, enter Item Categories, and then choose the related link.

Select a category to open it.

Fill in the fields on the Attributes FastTab.

You can then see the attributes you assigned to categories in the Attributes FactBox on the right-hand side of the Item Categories

page. When you later assign an item to a category, attributes stored for the category will be copied to the item automatically.

Should you change attributes of a category, the items assigned to it will be updated as well.

Attributes specified for parent categories are inherited to subcategories but can’t be changed there. Instead, you need to adjust

these attributes for each item using them.

Printing

On the Item Categories page, you can again specify whether to print an item attribute on sales or purchase documents.

Select an item attribute.

Use the Assist Button next to the Sales or Purchasing field to open the print selection.

Select the checkboxes for the type of sales or purchase documents on which you want to print the attribute, and then choose Close.

Selections that might have already been made because of how you set up the item attribute will be replaced by what you specify on

this page.

To select the field on more than one line:

Go to the Attributes FastTab.

Mark the relevant lines.

Choose Print on Document > Sales or Purchase. Initially, all fields will be blank (that is, deactivated).

Select the relevant checkboxes and confirm by choosing Close.

Print settings that you’ve already specified will be overwritten (provided you choose Yes on the message that appears).

Specify attribute values

On the Item Attribute card, you can use a lookup in the Values field to select a predefined value for an attribute. If no value has

been entered, you can create a new one according to the format given in the Type field on the card.

You can’t release an item for which a required attribute hasn’t been specified.

Search by attributes

You can use the attribute search feature to look for item attributes in sales or purchasing.

The standard way of searching for items is to filter the item list for a specific attribute. Keeping this in mind, the search feature

has been extended so that you can set filters on document entries as well.

1. 

2. 

3. 

Note

1. 

2. 

3. 

Note

1. 

2. 

3. 

4. 

Note
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To run the extended search:

Open a sales or purchase document.

On the Lines FastTab, select a line and choose Manage > Search by Attributes.

Enter an item category to see the first related attribute. You can extend this list to include other attributes, up to a maximum of 20.

Specify an attribute value in the second field. The line needs to be of the Item type.

After you’ve specified the search criteria, choose Filter by Attributes on the ribbon.

Choose OK to copy the relevant line to the document.

If you’re using KUMAVISION factory365, click here for more details about attribute searches.

APPLICATION TRACING

For easier traceability or checks of application sequences for incoming and outgoing items, use the Application Tracing feature.

To run the feature, choose Related > Application Tracing on the Items page.

The page that opens shows the complete application sequence. If an item is incoming (Receipt, Purchase, Output), the page

shows each movement of the entry, along with its quantity and value, up until the last outbound transaction (Shipment, Sale,

Consumption), including all transfers.

If an item is outgoing, the page shows each movement, as well as its quantity and value, up to the first incoming transaction,

again including all transfers.

SPECIAL NOTES

Comments that you add for a customer, a vendor, or an item can be marked as special notes so that they’re included in the

information pane on the right-hand side of a sales, purchase, or service document, or a purchase request.

Setup

Comment Line Codes

First, you need to set up a code for each special note:

Choose the Search icon, enter Comment Line Codes, and then choose the related link.

Fill in the Code and Description fields per line.

Purchases & Payables Setup

To assign a code to purchase documents:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the General FastTab, in the Special Notes Code field, specify a code that will be used to distinguish special remarks from other

comments.

You can then fill in the special notes code in the Code field on comment lines entered for a vendor, an item, or a resource.

Because you can specify different codes for purchase, sales, and service documents, and purchase requests, certain notes might only

be shown on some of the document types available in the system.

Purchase Requests

1. 

2. 

3. 

4. 

5. 

6. 

Note

1. 

2. 

1. 

2. 

Note
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To assign a code to purchase requests:

Choose the Search icon, enter Purchase Request Setup, and then choose the related link.

On the General FastTab, in the Special Notes Code field, specify a code that will be used to distinguish special remarks from other

comments.

You can then fill in the special notes code in the Code field on comment lines entered for a vendor, an item, or a resource.

Because you can specify different codes for purchase, sales, and service documents, and purchase requests, certain notes might only

be shown on some of the document types available in the system.

Sales & Receivables Setup

To assign a code to sales documents:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the General FastTab, in the Special Notes Code field, specify a code that will be used to distinguish special remarks from other

comments.

You can then fill in the special notes code in the Code field on comment lines entered for a customer, an item, or a resource.

Because you can specify different codes for purchase, sales, and service documents, and purchase requests, certain notes might only

be shown on some of the document types available in the system.

Service Management Setup

To assign a code to service documents:

Choose the Search icon, enter Service Management Setup, and then choose the related link.

On the General FastTab, in the Special Notes Code field, specify a code that will be used to distinguish special remarks from other

comments.

You can then fill in the special notes code in the Code field on comment lines entered for a customer, an item, or a resource.

Because you can specify different codes for purchase, sales, and service documents, and purchase requests, certain notes might only

be shown on some of the document types available in the system.

1. 

2. 

Note

1. 

2. 

Note

1. 

2. 

Note
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Workflow

Special notes can be displayed on the following documents:

Purchase quotes

Purchase orders

Purchase invoices

Sales quotes

Sales orders

Sales invoices

Service quotes

Service orders

Purchase requests

They’re shown in the information pane on the right-hand side when you select a customer or a vendor whom special notes are

stored for or when you switch between documents on which this type of customer or vendor is entered.

Special notes about items are shown in the pane to the right of the document lines when you select an item these notes are

stored for or when you change from one line assigned to this kind of item to another.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Financial Management

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s finance department.

CHECK VAT STATEMENT FOR COMPLETION

VAT declarations come in many forms. To ensure that the entries posted and the product and business posting groups specified

for value-added taxes are shown on statements on a consistent and constant basis, accounting staff can use a report to create

and reconcile these documents. To open the report:

Choose the Search icon, enter Check VAT Statement for Completion, and then choose the link.

Fill in the fields as necessary.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Sales

The following features expand standard Microsoft Dynamics 365 Business Central functionality to provide additional options to

those working in your organization’s sales department.

CREATE HIERARCHIES

Hierarchies are used to link (any number of) customers, vendors, or contacts to each other. Hierarchical relationships can be

shown progressing from top to bottom or bottom to top.

Type Setup

When you’re trying to add a customer to a hierarchy, you might see the following:

“Specify at least one hierarchy type.”

This means that no hierarchy has been set up yet. To create a hierarchy:

Choose the Search icon, enter Hierarchy Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Assign customers

To specify hierarchical relationships between customers:

Choose the Search icon, enter Customers, and then choose the related link.

Open a customer card.

To set up a top-down structure

a. On the ribbon, choose Related > Customers > Hierarchy – Related Customers.

To set up a bottom-up structure

b. On the ribbon, choose Related > Customers > Hierarchy – Relates to Customer.

Check if the correct type filter is set.

Specify a customer number in the Value field.

Choose another line and repeat the steps.

View a hierarchy

To see a hierarchy:

Open a customer card.

On the ribbon, choose Related > Customers > Hierarchy – Where-Used.

Select a method for display:

• Related records (top-down approach)

• Relates to records (bottom-up approach)

Choose Calculate.

1. 

2. 

3. 

Field Comment

Code Specify a code for the type of hierarchy.

Description Enter a text that describes the type of hierarchy.

Default Specify if this type of hierarchy should be used as the default type when you create new hierarchies.

Source Table Caption Specify if you want to link the hierarchy type to customers, vendors, or contacts.

1. 

2. 

3. 

4. 

5. 

1. 

2. 

3. 

4. 
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SALES ORDER TYPES

Keeping track of large numbers of unposted documents in the system can be a difficult task: some might have been created to

fulfill standard orders, some might have been set up for rush jobs, and some might be the basis for repairs or consignment. A

quick solution to this problem is to organize documents by type so that they can be filtered later.

Setup

To set up an order category:

Choose the search icon, enter Sales Order Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

If you’re using KUMAVISION trade365, you have additional options for setting up order types. For more information, click here.

1. 

2. 

3. 

Field Description

Code Specify a code for this type of order. The code must be unique.

Description Specify a description for this type of order.

Minimum Profit % Specify a minimum profit in percent. For more information, see Line-Level and Document-Level Profit

Check.

Default Specify if this type should be used as the default type for new sales orders.

Shopify Default Turn on this toggle if you want to have the system fill in the type for orders created through the

Shopify function.

Payment Terms

Code

Specify the payment terms typically associated with this type of order, to replace those stored in the

customer master.

When the order type is entered on a document, the system then fills in the terms from this page. If

necessary, however, you can change them again manually on the document.

Payment Method

Code

Specify the payment method typically associated with this type of order, to replace the method stored

in the customer master.

When the order type is entered on a document, the system then fills in the method from this page. If

necessary, however, you can change the method again manually on the document.

Duplicate 

Orders

Select this field to see a message if an order of the same type and with the same customer and item

already exists.

Note
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Assign dimensions

You can then assign dimensions to an order type for analytical purposes. To assign a dimension:

Choose the Search icon, enter Sales Order Types, and then choose the related link.

Choose Related > Sales Order Type > Dimensions > Dimensions-Single to assign the current record or choose Dimensions-

Multiple to assign more than one data record.

Choose OK to open the Dimensions page.

Fill in the fields as described in the following table.

Select reports by type

You can also use order types to specify what sales reports to print.

Choose the Search icon, enter Report Selection – Sales, and then choose the related link.

In the Usage field, specify the type of document that you want printed.

Fill in the Report ID field on a line or choose Order Types on the ribbon to store a report based on a specific type.

Like on the standard report selection page, you can specify a sequence if you want to enter more than one report here.

Assign an order type

To assign a type to an order:

Create or open a sales order.

On the General FastTab, in the Sales Order Type field, select a type.

ORDER BACKLOG

Large and midsize organizations often use their order backlog as an indicator of how business is going.

Backlog, as understood in this context, means the value of all incoming orders and of all unposted invoices not created from

orders minus the value of return orders and of unposted credit memos, as revenues are typically generated at a much later date.

The backlog value might change with every edit made to a sales document. It can therefore be a daunting, if not impossible, task

to determine that value for a specific point in time from the documents posted in the system. This is also true when trying to add

together the amounts that remain on invoices not yet posted. However, both figures play a key role in management decisions.

Setup

You need to set up the feature before you can use it.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the ribbon, choose Actions > Enable Backlog Statistics. This will also turn on the Create Order Backlog toggle on the page.

On the General FastTab, in the Backlog Creation Date and Backlog Modification Date fields, select whether you want the creation

and change of backlog entries to be based on an order date or the work date.

1. 

2. 

3. 

4. 

Field Description

Dimension Code Select the code of the dimension that will be used.

Dimension Value

Code

Select the value that will be used.

Value Posting Specify the requirements that need to be met should you want to use the dimension and dimension

value.

• Code Required

• Shared Code

• No Code

Allowed Values Filter Description to follow.

1. 

2. 

3. 
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It may take a while for the feature to be initialized during first-time setup.

Workflow

To track the value of orders placed with your organization, the system adds backlog entries to the following documents:

Sales orders

Sales return orders

Sales invoices (not created from an order)

Sales credit memos

For an order or return order, entries are created when the status of the sales document is set from Open to Released or from

Released to Open (the latter applies only if you activated the backlog feature after releasing the order).

The same is true when you invoice or reverse the document. Entries change, on the other hand, when you reopen a released

order for editing purposes, for example, and invoice, edit, or delete some of the lines.

For an invoice or a credit memo, entries are created once—during the posting process—unless the lines of the document have

been assigned to an order or a return order.

Backlog entries can be created for ongoing sales transactions but not for documents that have already been archived.

Each backlog entry contains all the information from the sales or return order line for which it was set up. This means an

unbilled line is mapped to an entry with the terms and conditions, as well as dimensions, specified on it, whereas a line that has

been invoiced is mapped with the values and dimensions taken from the related invoice.

When the status on a document header is reset from Released to Open, order backlog will include—broken down by dimension—

only amounts already billed. Amounts on lines that have yet to be billed, on the other hand, will be negative to offset the positive

value entries created during release.

ITEM REFERENCE NUMBERS

Many orders include numbers that a customer uses for items. These numbers can be filled in on an order provided they’re

specified in the item or customer master.

To facilitate data maintenance, item references can now also be created and changed directly on sales lines after filling in, for

example, the following fields:

Type = Item

No. = [item number]

Reference No. = [number that the customer assigned to the item]

Unit of Measure Code = [standard unit used for the item]

Variant Code = [blank]

If a certain combination already exists, you’re asked if you want to replace the old item reference with the new number.

Note

• 

• 

• 

• 

Note

• 

• 

• 

• 

• 

Note
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LINE UNIT COST AND PROFIT %

In contrast to standard functionality, you can now specify if the Unit Cost (LCY) field on a sales line can be edited. To activate this

option:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Prices FastTab, turn on the Can Edit Unit Cost toggle.

If you turn on the toggle, the minimum profit check might no longer work as intended. (You also see a message about this when you

change the unit cost on a sales line.)

With the toggle turned off, costs are filled in on documents by using item card (or, if available, stockkeeping unit) data.

The Profit %, a field value related to the unit cost, is also no longer copied from an item card, like in the standard app, but is

determined based on the Unit Cost (LCY), Unit Price, and Discount line values so that you can see the actual profit on each line.

LINE-LEVEL PROFIT CHECK

A lower profit limit can be specified for each item and item category stored in the system. This way, you’ll be notified immediately

when the money that you would make from a transaction will not earn you enough profit. You’ll also see the price required to

achieve the lowest possible profit target.

Only specially authorized users can then continue with the transaction without having to adjust item prices. The system will

check for profit minimums in the following order of priority:

Item

Item Category

Setup

User setup

On this page, you can specify the users who can continue with transactions even if those transactions generate less than the

minimum profit.

Choose the Search icon, enter User Setup, and then choose the relevant link.

Select the user whom you want to authorize for the procedure.

On the line, select the Deactivate Profit Minimum field.

Alternatively, open the card linked to the user. On the KUMAVISION FastTab, turn on the Deactivate Profit Minimum toggle.

An authorized user then sees a brief note when a certain profit threshold isn’t met but will be allowed to continue. If the field is

cleared (or the toggle turned off), the user will see an error message instead.

Maintain minimum profits

To have lines checked for minimum profits, you need to specify them on item cards or for item categories first.

On Item Cards

To set a minimum profit on an item card:

Open a card.

On the Prices & Sales FastTab, in the Minimum Profit % field, enter the profit that should at least be achieved with each

transaction.

On Item Categories

1. 

2. 

Note

1. 

2. 

1. 

2. 

3. 
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An item category can be used to group profit targets so that each item in the category is set up with the same minimum profit. To

set up a minimum for a group:

Open an item group card.

On the relevant line, in the Minimum Profit % field, enter the profit that should at least be achieved with each transaction.

DOCUMENT-LEVEL PROFIT CHECK

You can also set profit requirements on documents. However, like with line-level checks, an authorized user can continue with a

transaction even if the minimum profit isn’t achieved.

For this purpose, the Deactivate Minimum Profit field can be selected in User Setup. Separate authorizations for releasing

documents and their lines aren’t available. The system will check for document-wide profit minimums in the following order of

priority:

Customer

Sales Order Type

Sales & Receivables Setup

Setup

Sales & Receivables Setup

To set up a lower profit limit for use throughout the system:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the relevant link.

On the KUMAVISION FastTab, in the Minimum Profit % field, enter the profit that should at least be achieved on sales documents. 

Sales order types

For a sales order type, you set the limit by filling in the Minimum Profit % field on the relevant line.

Customers

On a customer card, you specify the minimum profit on the Invoice FastTab.

Workflow

When a document is assigned to a customer for whom a minimum profit has been specified, you receive a message if the profit

isn’t achieved with a sales transaction. The message also shows you the price required for achieving the lowest possible profit

target.

Only authorized users can then continue with a transaction without having to change prices in the system. To authorize a user:

Choose the Search icon, enter User Setup, and then choose the relevant link.

Select the user whom you want to authorize for the procedure.

On the line, select the Deactivate Minimum Profit field.

Alternatively, open the card linked to the user. On the KUMAVISION FastTab, turn on the Deactivate Minimum Profit toggle.

Typically, profit checks are performed when you release documents—unless release is automatic, for example, after creating an

advance invoice.

Archive

To see how often a profit minimum hasn’t been met:

Open a sales document.

On the ribbon, choose Navigate or Releases.

You can now track in detail who released orders that fell short of the minimum profit and when this occurred, information which

you can also find in the Sales Document Information FactBox. This box will additionally tell you how high the profit should have

been (at least) and where the lower profit limit comes from.
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If a minimum profit isn’t achieved at either line or document level, the system will log only the shortfall at document level, whereas

line shortfalls will be released.

FACTBOXES

The new FactBoxes and FactBox-related functions included with KUMAVISION base (BOOSTER) can provide you with even more

details on sales documents and their lines.

Sales Line Profit Details

Provides the contents of the following fields filled in for an item or a customer on a sales document line:

No. (=item number)

Line Amount (LCY)

Line Amount (LCY) Excl. VAT

Unit Cost (LCY)

Cost (LCY)

Profit (LCY)

Profit %

Minimum Profit %

Min. Profit Source

Low Profit Released By

Sales Document Information

Provides the contents of the following fields filled in for a customer on a sales document:

Beginning Text

Ending Text

Sell-to Customer (Comment)

Bill-to Customer (Comment)

Profit (LCY)

Profit %

Minimum Profit %

Min. Profit Source

Low Profit Released By

Sell-to Customer Sales History

As with standard functionality, provides the number of documents created for a customer in the sales area.

In contrast to standard functionality, however, the extended FactBox now also includes tiles that show the number of archived

quotes, orders, blanket orders, or return orders. You can click a tile to view the individual documents.

You can also set a date filter to limit how many of them will be shown. To set up the filter period:

Choose the Search icon, enter Sales & Receivables Setup.

On the Archiving FastTab, in the Sales History Date Formula field, specify a formula, such as -1Y.

Note

• 

• 

• 

• 

• 

• 
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• 

• 
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The formula used will limit the period based on the work date. To avoid confusion, the filter also only applies to archived and posted

documents but not to those that are still being processed.

If you’re using KUMAVISION trade365, you'll additionally see a Bill-to Customer Sales History on the right side of the page. For more

information, click here.

ADD TRANSACTION DATA

You can use the Add Transaction Data function to correct posting information on orders that have been shipped but not invoiced.

You make the corrections before choosing this action on the ribbon. When you run the action, the contents of the following fields

will be copied from the lines that have been shipped but not billed to a posted shipment and the associated item, G/L, and value

entries:

Gen. Bus. Posting Group

VAT Bus. Posting Group

Gen. Prod. Posting Group

VAT Prod. Posting Group

Dimension Set ID

Global Dimension 1 Code

Global Dimension 2 Code

PRINT RELEASED DOCUMENTS

The system performs multiple checks when a sales document is released. This includes checking if mandatory fields are filled in

and whether prices and costs have been calculated.

For this reason, KUMAVISION base (BOOSTER) limits printouts to documents that have been released, the only exception being

quotes (print previews will not be restricted either).

SEND QUOTES TO CONTACTS

You can use a customer template to send quotes to potential suppliers, that is, to contacts to whom no customer has been

assigned.

Customer templates are set up in Finance. You can then run the Create Sales Quote action from the ribbon of a customer card to

fill in a new quote with the required contact details and choose in the Customer Template Code field the template that you want

to use.

You can also create a quote without having to create a customer. In this case, a customer must be set up only when you convert

the quote to an order.

BLANKET ORDER EXTENSION

When you create a sales order from a standard blanket agreement, the prices set by the agreement are copied alongside other

data to the new order.

However, when you change the quantity on the order, the prices specified on it will most likely change as well. This is because

standard functionality updates all prices regardless of origin. See also Price Origin.

The new pricing feature, on the other hand, will update only lines on which the Blanket Order field has not been selected.

Note

Note
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Create a sales order from a blanket order

When you fill in a quote or an order line, you might see a message saying that the item and customer given on the line have both

been assigned to a blanket sales agreement.

After the number of the blanket order is entered in the Blanket Order No. field, you’re asked whether you want to copy the

contents of the Unit Price and Line Discount % to the line. You can choose Yes to replace current values or No to keep the price

and discount stored on the quote or order line.

For trackability purposes, you can now also see in the Qty. on Order and Rem. Qty. on Blanket Order fields on a blanket

agreement the quantities entered on related sales orders and the quantity that remains for release.

The field additions were required because standard functionality doesn’t show the quantity delivered with an order until you post

a sales shipment for it.

An error message appears if you attempt to retrieve more from an agreement than is available after the order quantity is

subtracted from the quantity that is still outstanding.

FRAMEWORK AGREEMENTS

Framework agreements are an addition to (customer-specific) blanket orders. In contrast to blanket orders, framework

agreements can be used by multiple customers linked to each other in a hierarchy. The agreement therefore binds both the main

customer and the customers on a lower hierarchical level.

Framework agreements aren’t assigned to requisition or planning worksheets. As a result, you need to use a variety of settings

or sales plans to manage the items that will be used on sales orders created from this type of agreement.

Setup

You need to set up the feature before you can use it.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Number Series FastTab, in the Framework Agreement Nos. field, select the series that will be used for framework

agreements.

You can also specify the hierarchy type that should be used by filling in the Framework Hierarchy Type Code field on the

KUMAVISION FastTab.

Only customers who are linked to this type of hierarchy can later be assigned to a framework agreement.

Create a framework agreement

To set up an individual agreement:

Choose the Search icon, enter Open Framework Agreements, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

1. 

2. 

3. 

Note

1. 

2. 

3. 
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General

Lines

On the framework lines, you can store for each item the total quantity that can be purchased by all customers during the period

entered in the Valid From and Valid To fields.

Instead of an item, you can also enter an item price group; the specific item is then retrieved from the group when you create an

order from the agreement.

Prices and discounts can be specified here too. All values are shown without VAT, as the framework agreement feature is only

used for B2B transactions.

When you’ve finished filling in the fields, you can choose Release and Confirm on the ribbon to release and print the agreement,

respectively.

Create an order from an agreement

When you fill in a standard quote or order, you’ll see a message if a framework agreement exists for an item and customer

entered on a document line.

When the number of the agreement is then filled in on the line, the system will copy the price and discount specified for the

agreement to the quote or order.

On the agreement, on the Lines FastTab, you can choose Line and the relevant document line function if you want to see the

quantities that have been copied to (archived) sales documents.

After an agreement is no longer valid, you can archive it by choosing Actions > End to move it to the Completed Framework

Agreements page.

This decision cannot be undone. However, you can use the Copy Framework Agreement function (as you can use the Copy

Document function) to copy a completed agreement to a new one. You can choose on the options dialog if you want to transfer all

data from the old header and lines or just transfer the header or the lines.

MANAGE SALES COMMISSIONS

You can use the commission feature to determine the compensation that your sales representatives should receive for their

performance. Each payment will be calculated with the help of an invoice or a credit memo posted in Microsoft Dynamics 365

Business Central1.

Only revenues generated as part of standard workflows count toward payouts. This excludes, for example, sales recorded and

posted manually in the form of invoices to G/L accounts in Finance.

To fill in the Salesperson Code and Salesperson 2 Code fields when you set up commissions, you can have salespeople copied

from the customer master. As an alternative, you can specify them on a sales invoice or credit memo prior to posting.

The commission feature is used only on a field that is filled in. If you specify a salesperson in both fields, a commission will be

calculated for each. However, neither field influences the other when payments are calculated.

Field Description

No. Exit the field to have the system automatically assign a new number from the series set up for this

purpose.

Customer No. Specify the customer to whom the agreement should be linked.

For an agreement to be used by multiple customers, you must fill in the main customer in this field. Other

customers are then linked to the main customer through the hierarchy type code.

Name Shows the name of the customer entered in the Customer No. field.

Description

Description 2

Here you can specify an internal description for the agreement.

Valid From

Valid To

Fill in these fields to specify the period in which the agreement should be valid.
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As salesperson codes apply to a document as a whole, the codes aren’t found on unposted lines.

A commission can be calculated for a certain customer or product, a group of customers or products, or a responsibility center.

The amount that a sales rep receives can be based on net or gross revenues or on profits.

Only with the Salesperson Code field and, if necessary, the Salesperson 2 Code field filled in on a posted sales document will a

commission be calculated. You can clear both fields manually if an order doesn’t involve commission payments.

Setup

Salespeople

Each salesperson whom you want to pay a commission to must be set up on the Salespeople/Purchasers page and be assigned on

the relevant customer card in the Salesperson Code or Salesperson 2 Code field (on the Commission FastTab).

Commission groups

Commission groups are used if the same commission rate applies to multiple customers or items. They’re copied to posted

documents automatically.

Customer Commission Groups

On this page, you can set up codes and descriptions for groups of customers. A code can then be selected on the Commission

FastTab on a customer card.

Product commission groups

Here you can group items in the same way as you did customers. The groups can then be selected on item cards on the Prices &

Sales FastTab.

To achieve standardization, you can assign product commission group codes to each G/L account, item, resource, fixed asset, and

item charge stored in the system.

Commission rates

Commission rates regulate how much commission a salesperson can receive. You can specify a variety of factors that will be used

to determine payments in each case. To search for a rate:

Choose the Search icon, enter Commission Rates, and then choose the related link.

On the header, fill in the fields as described in the following table.

Note

1. 

2. 

Field Description

Salespers. Commission Type Filter Specify if you want to see only a certain type of commission.

Starting Date Filter Specify if you want to see only rates starting from a certain date.

Salesperson Filter Specify if you want to see only rates stored for a certain salesperson.
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To set up or change a rate, select a line and fill in the fields as described in the following table.

Calculate a commission

Payouts are calculated based on the commission rate that is valid at the time. If more than one is valid within the period specified

on a sales document, the rate is retrieved according to the following order of priority:

Individual rates are preferred over general rates. A rate linked to a single customer will therefore be prioritized over entries

assigned to customer commission groups. These, in turn, have a higher priority than rates that have been assigned to all

customers.

A valid rate for an individual product will be selected before a rate linked to a customer is. Customer-specific rates, in turn,

will be prioritized over those assigned to salespeople.

In combination with a responsibility center, a rate will be retrieved as follows:

If no rate can be found for a certain salesperson and responsibility center, the system will use the rate assigned to the All

Salespeople option in combination with the responsibility center.

If a rate for the salesperson and responsibility center is found, the rate will be used.

If no responsibility center has been specified for a salesperson, the system will use the rate set up for this salesperson in

combination with a blank Responsibility Center field.

Workflow

Commission journal Post a commission

Field Description

Salesperson Commission

Type

Specify if the rate should be valid for the person shown in the Salesperson Code or the

Salesperson 2 Code field—or for all salespeople.

Salesperson Code Fill in this field according to the option that you selected in the Salesperson Commission Type

field.

Customer Commission

Type

Specify if the rate should be used for all customers, a group of customers, or a specific customer.

Customer Code Fill in this field based on the option that you selected in the Customer Commission Type field.

Product Commission

Type

Specify if the rate should be used for items, G/L accounts, resources, fixed assets, item charges,

product commission groups, or all products.

Product Code Fill in this field based on the option that you selected in the Product Commission Type field.

Responsibility Center Specify a responsibility center if you want to make the commission calculation dependent on

one.

Starting Date

Ending Date

Fill in these fields if you want to further restrict the period in which the rate should be valid.

Commission Base Select the posted document line value based on which the rate should be calculated:

• Amount Excl. VAT

• Profit

• Adjd. Profit

• Amount Incl. VAT

Commission % Specify the commission amount in percent.

Description If necessary, add an internal note explaining the rate.

Blocked Select this field if you want to block the rate from being used.

• 

• 

• 

• 
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On the commission journal, you can have commission payments suggested based on posted document lines.

Choose the Search icon, enter Commission Journal, and then choose the related link.

On the ribbon, choose Set Up Commission to fill in the journal lines. You can choose on the Options tab what filters to set. For

example, you can set a filter on document dates or posting dates, customer ledger entries, salespeople, or invoice headers.

The function then uses the posted lines that include salespeople for whom no commissions have been posted to calculate valid

commission rates. The business logic as described here lends itself to the creation of a variety of agreements with multiple levels

of granularity. As a result, more than one rate might be applicable in a given situation.

The number of currently valid commission rates can be found in the lower part of the journal. Rates aren’t totaled; to see them,

select the highlighted number in the No. of Valid Commission Rates field. All journal lines can also be edited manually.

Commission entries are created by using the Post function. When you run this action, the invoice line field Commission Posted

(Salesperson) or Commission Posted (Salesperson 2) is automatically selected for the salesperson linked to the entry (to prevent

a commission from being paid twice).

The journal lines represent only suggestions and can be deleted or corrected. If a line is deleted, it will be inserted again when you

rerun the Post function.

Cancel a commission

Commission entries can be cancelled.

Choose the Search icon, enter Commission Entries, and then choose the related link. You can also open a posted invoice and

choose Related > Invoice > Commission Entries on the ribbon.

Select a line.

On the ribbon, choose Reverse Entries.

Cancellation results in the Commission Posted (Salesperson) or Commission Posted (Salesperson 2) field being cleared on the

relevant document line. This way, you can retrieve a commission statement again for editing.

Commission register

Commission entries can also be analyzed through reports. Printouts of these reports provide the basis for commission statements

(commission data isn’t copied to payroll or purchase documents anymore).

You can print one of the following reports:

Commission Register

Commission Statement (By Group)

Commission Statement (By Doc.)

A register shows all posted commission entries, whereas a statement shows the payout per salesperson (if necessary, broken

down by commission group). You can set filters, for example, on posting dates and salespeople, before you print a report.

ALTERNATE QUOTE LINES

When you fill in a sales quote, you can specify for each document line whether the price shown on it should be included in the

total quote price.

A line where the Alternative field is set to Alternative, Optional, Selectable, or On Request then appears on printouts in a

different format and alongside the value you chose in that field so that you can make customers aware of their options for

customization.
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VALIDITY PERIOD ON QUOTES

To limit the period in which an offer is valid, you can fill in the Quote Expiration Date field on the General FastTab of a quote

document or have the system fill in the date by specifying a formula in the Quote Validity Formula field in Sales & Receivables

Setup.

Afterward, users will be notified of validity issues when quotes are converted to orders but can ignore the warning if necessary.

QUOTE STATUS

A status code was added to sales quotes so that when you create or convert a quote, you can enter this code (for example, NEW

or ORDER) in the Quote Status Code field on the document or have it filled in automatically. To set up a status:

Choose the Search icon, enter Quote Status, and then choose the related link.

On the ribbon, choose New.

In the Code and Description fields, specify the code and description that will be used for the status.

Afterward, select one of the other fields on the line if you want the code filled in automatically under the specified circumstances.

NON-BILLABLE LINES

Standard functionality typically prevents users from invoicing sales orders on which one or more line amount fields are empty.

However, as some of these lines might still need to be shown on invoices, for example, because of a goodwill policy or warranty

claim, the Not Billable field has been added to all invoice lines. Choosing an option in this field will allow an invoice to go through

and display the option value on printouts.

When you choose an option on a line, you can also decide whether to have the line amount field cleared or keep the amount and

have a line discount of 100% entered automatically.

You can specify in setup when the system should check for blank line amount fields.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link. 

On the FastTab, turn on the Check Not Billable on Release field to have the system check for non-billable lines when a document is

released. If the toggle is turned off, lines will only be checked after the document is posted.

PROFORMA INVOICE ON ORDER

Some businesses, especially those exporting goods, need to provide shipping agents or customers with a proforma invoice prior

to delivery. The invoice can be printed from every order available in the system.

Basically, a proforma invoice looks like a confirmation receipt, the difference being that the extended texts printed on invoices

are also printed on proforma documents.

Setup

Sales & Receivables Setup

Proforma invoices typically require an invoice number. To set up a number series for them:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Proforma Invoice FastTab, turn on the Get Invoice No. toggle.

Report Selection – Sales

You also need to set up the proforma invoice report on the Report Selection – Sales page.

Printing

To print a proforma invoice:

Open an order.

On the ribbon, choose Actions > Posting > Proforma Invoice.
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The system then uses the series set up for invoices to assign a number to the proforma invoice, adding a P upfront. Despite the

added P, the number can no longer be used for posting a standard invoice later.

PRINT SHIPMENT OR DELIVERY DATE ON ORDER CONFIRMATION

With this feature, you can specify if you want the Planned Shipment Date or the Planned Delivery Date printed on confirmation

receipts.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION FastTab, in the Print Planned Shipment or Delivery Date field, select the date that you want printed in this

context.

DUPLICATE ORDERS

Besides telling you about existing quotes and blanket orders, the system can also notify you of possible duplicates when you fill in

a sales order.

Setup

Sales & Receivables Setup

You need to set up the feature before you can use it.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link. 

On the General FastTab, in the Duplicate Orders Period field, enter how far back the system should go to search for the same item

having been added to an order for the same customer. All periods are entered with a minus sign.

Sales order types

A notification is only shown if you’re also using sales order types. As a result, you must select the Duplicate Orders field for types

that you want to show the notification for.

Check for duplicates

After the feature has been set up and assigned to an order type, you can enter an order for a customer. You are notified if another

order of this type contains a line on which the item has been entered within a certain period.

To identify the correct search period, the system will use the formula entered in setup and, as a starting point, the date shown in

the Created On field on the new order.

DROP SHIPMENT AND SPECIAL ORDER EXTENSION

As an addition to standard functionality, you can now create purchase orders for drop shipments and special deliveries directly in

the sales area.

Drop shipments

You use drop shipments to have goods shipped by one of your suppliers to a customer without the items being delivered to you

first. To make a drop shipment in sales:

Create a sales order and enter the items you want to sell on the lines.

Select the Drop Shipment field on lines that you want delivered to the customer without your direct involvement.

On the ribbon, choose Order > Drop Shipment > Purchase Order.

Instead of selecting the Drop Shipment field, you can also fill in the Purchasing Code field to choose a line for drop shipment. When

you fill in this field, the Drop Shipment field is selected automatically.

Like in the standard app, the selected lines are then copied when you choose OK on the vendor selection page (on which the

default vendor is filled in). If a drop shipment includes items from a variety of suppliers, that is, the item master shows a different

vendor for each item, a purchase order is created per vendor.
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Special orders

You can use special orders, for example, to receive customized items from a supplier for inspection by your quality management

staff. To create a special order in sales:

Create a sales order and enter the items you want to sell on the lines.

Select the Special Order field for lines that you want delivered for inspection.

On the ribbon, choose Order > Special Order > Purchase Order.

Instead of selecting the Special Order field, you can also fill in the Purchasing Code field to choose a line for a special order. When

you fill in this field, the Special Order field is selected automatically.

Like in the standard app, the selected lines are then copied when you choose OK on the vendor selection page (on which the

default vendor is filled in). If a special order includes items from a variety of suppliers, that is, the item master shows a different

vendor for each item, a purchase order is created per vendor.

PROCESS IDS

A shared document number, known as a document process ID in the system, can be helpful, for example, for tracking a sale from

quote entry to (potential) return receipt.

This is especially true if the documents used during a transaction need to be connected across departments, such as when orders

returned by customers must be linked to orders that will be returned to vendors.

Setup

Before you can use document tracking, you need to set up a number series for process IDs.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Number Series FastTab, in the Document Process ID Nos. field, select the number series that you want to use for this

purpose.

Workflow

A process ID is always copied from the header of the initial document to each header and line created from the document on

quotes, orders, shipments, and invoices, as well as return orders (provided the Get Posted Document Lines to Reverse action was

used to set up the order lines) and their archived versions.

For example, a process ID entered on a sales order is transferred to an invoice or shipment that you created from it when you

post the order.

On the order, on the Line FastTab, you can then choose Line > Navigate Doc. Process ID on the ribbon to see the documents

linked to the ID. You can also view individual documents by selecting the value in the No. of Entries field, or you can use the

standard Navigate action to look for them.

When you copy a document or run the Get Posted Document Lines to Reverse function to create lines from a return order, the

system will transfer the ID that is specified on the source document to all new lines. Afterward, you can find a line only by

searching for the source document ID.

If you don’t want this to occur, you must turn off the Copy Document Process ID toggle on the options dialog before you fill in

document lines with the Copy Document function. As for return order lines, the ID is always copied from the original sales order.

SALUTATION ON DOCUMENTS

In addition to formal and informal ways of addressing contacts with the help of standard functions, you can choose in the Sell-to

Contact field a salutation for assignment to documents.

This feature was introduced because some contacts might not have their first names stored in the system, which means that only

their last names without a salutation would be printed in the standard app.
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Setup

Document-based salutations should be set up for all available salutation codes.

Choose the Search icon, enter Salutations, and then choose the related link.

Select the line for which you want to set up a salutation formula.

On the ribbon, choose Formulas.

For each language code, fill in the fields as necessary.

SHOW SALESPEOPLE ON PRINTOUTS

In KUMAVISION base (BOOSTER), you can specify two salesperson codes on each customer card and sales document.

One or the other code might later show up on documents sent to customers. For example, the Salesperson Code field might

contain the code of the sales rep whom you pay commissions to, whereas the Salesperson 2 Code might refer to the person whom

the customer will be talking to.

In this context, the customer should see only the contact details of the second person. To specify the correct code on a document,

you need to fill in the Print Salesperson field on the Commission FastTab there. Alternatively, as a global setting, you can fill in

the Print Salesperson field on the KUMAVISION FastTab in Sales & Receivables Setup.

COMMUNICATION TYPES (DATA PRIVACY)

OOn September 1, 2012, an amendment to Germany’s data privacy act BDSG took effect, in many ways changing the way

customer data is being handled.

The revisions, especially to section 28 of the act, mainly covered the use and processing of personal data for advertising

purposes. Tailoring ad content to specific audiences therefore became an even more difficult challenge, as the success of any

campaign now hinges entirely on the consent of those whom the ads are supposed to reach.

Additionally, the revisions might apply retroactively to data already collected. Even though non-personalized ads, such as ad

papers that land in mailboxes, aren’t affected by the new rules, many customers most likely have had to opt in to their data being

processed.

What’s more, consent given over the phone must be confirmed in writing. The people targeted by personalized ads must also be

informed each time another company begins storing their information.

For the CRM functionality, this means:

Contacts need to consent to the use of personal data prior to their inclusion in marketing segments used for ad campaigns. This

primarily affects campaigns that are distributed over email. Personalized ads in the mail are allowed if they haven’t been

objected to. Organizations, by contrast, can always be contacted through any method.

Communication types in contact management

On contact cards, you can set up the following types of communication on the Communication FastTab:

Fax

Email

Phone

Letter

You can select Yes or No in each field. Initially, all of them are blank. However, the fields must be filled in before you can assign

contacts to a segment.

To see if or when (and by whom) the fields have been edited, choose Related > Related Information > Communication Log

Entries on the ribbon.

When you fill in or change a communication type field, you’ll see a text window where you need to enter a comment (such as

“consent given during our phone conversation on”) to ensure that changes aren’t made by mistake and that you can quickly

respond to inquiries about the permitted means of communicating with a contact.
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To set all types to No for contacts stored in the system (as blank fields cannot be used anywhere), you can run the Initialize

Communication Allowance batch job.

None of the settings you make, however, will prevent you from sending emails to contacts via the email symbol or create

individual interactions. The system will only check if certain communication types are permitted when you set up interactions on

the Logged Segments page.

Add contacts to a segment

After creating a segment, you must add a communication type before adding contacts. This ensures that only those contacts who

have agreed to a certain means of communication will be part of the segment.

Before the segment is logged, the system will recheck if the specified types of communication haven’t been objected to in the

meantime.

You can specify a type by selecting an interaction template on the header of a segment. We recommend that you set up one

interaction template per type of communication.

When you run the Add Contacts function on the ribbon, the system will check if a person who matches the search criteria can be

contacted in the way that has been described in the segment. Only contacts for whom the entered type is allowed will be added.

A subsequent change in communication types on the segment header doesn’t affect the contacts who have already been added.

If you want to change a type completely, you must do so on the interaction template and pull that template onto the segment

header to have the system perform another check.

AUTO SHIP ADDED SALES LINES

Besides specifying items that require warehouse handling, you often need to enter associated expenses, such as freight costs, on

document lines. Service items are also being used in this context with increasing frequency.

Typically, with the release of an order, the sales department’s job is done (as delivery of the order is handled in the warehouse

and inventory area with the help of a one-stage or two-stage picking process and invoices are sent by the billing department on a

periodic basis).

However, any item not posted through the standard warehouse and inventory functionality will not be shipped or billed in this

scenario. Although sales staff could go ahead and post these items manually, that would mean spending an inordinate amount of

time and effort on posting the related invoices as well.

For this reason, KUMAVISION base (BOOSTER) provides you with the Auto Ship Added Sales Lines function. This feature

automatically invoices all items on a sales order when you post warehouse and inventory documents for the order.

SETUP

KUMAVISION Module Setup

You need to turn on the function before you can use it.

Choose the Search icon, enter KUMAVISION Module Setup, and then choose the related link.

On the Settings FastTab, turn on the Auto Ship Added Sales Lines toggle.

You must activate this toggle to see the setup options available for additional line shipments.

Note
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Add sales lines

To set up a sales line:

Choose the Search icon, enter Added Sales Line Shipment Setup, and then choose the related link.

On the lines, fill in the fields as described in the following table.

Workflow

The auto ship feature is only used when you post a warehouse or an inventory document on a sales order. For drop shipments, for

example, quantities must still be entered manually. If an order contains lines with and without warehouse and inventory items,

the feature is run each time you post a warehouse or an inventory document. Non-warehouse items that have been shipped

earlier can be posted manually.

Before a shipment is posted, the system checks if the document that you’re working on contains a line stored in Added Sales Line

Shipment Setup, such as a G/L account used for freight costs. If so, the Qty. to Ship field is filled in automatically.

This doesn’t create a second shipping note, however; everything is still shown on the same note.

For the items mentioned, except for items of type Service, no entries will be created when you ship them.

PRINT ALTERNATIVE LINE TOTALS

With this feature, you can print separate totals on sales quotes.

Separate means that one total line will show the sum of all lines related to a bundle or subtotal, whereas a second number put in

parentheses will display the total value of all lines marked as alternate lines.

To set up the feature:

Choose the Search icon, enter Company Information, and then choose the related link.

Turn on the Print Alternative Line Totals toggle. With the toggle turned off, the bundle or subtotal lines specified as alternative

totals will not be printed when you print the quote document.

UNDO POSTED SHIPMENTS

Sometimes, you might want to remove only a partial quantity from a shipment. To activate this feature:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION FastTab, set the Warehouse Undo Type field from Default to Extended Undo.

1. 

2. 

Field Description

Type Specify the service item, resource, or G/L account that will be shipped with sales orders.

No. Depending on what option you selected in the Type field, specify the number of an item, a resource, or a

G/L account—unless you want the line to be valid for all items, resources, or G/L accounts, in which case

you leave this field blank.

Description Shows the description of the data record entered in the No. field.

Print Line Select this field if the line should be printed on shipping notes, if applicable.

Shipping Time Specify if the shipment of the line should be posted with the first or last delivery associated with the order.

Note
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To reverse a partial quantity on a document:

Choose the Search icon, enter Sales Shipments, and then choose the related link.

Open the relevant shipment and select the line you want to cancel.

On the ribbon, choose Change Cancellation Qty.

Fill in a quantity.

Choose Post to post the reversal document.

Only unbilled shipments can be reversed in this way.

If you’re using KUMAVISION medtec365, transaction codes for cancellation lines will be determined when you run the Post function.

For more information, click here.

PACKAGING ACT (GERMANY)

Extended producer responsibility has been a staple of EU waste management policy for many years. As a short explanation, EPR

programs are based on the principle that manufacturers should also be responsible for the environmental impact of the goods

that they put on the market.

Among the laws intended to reduce, reuse, and recycle waste across the Union is the German Packaging Act of 2019—which

established a national packaging registry by the name of LUCID, among other things.

In KUMAVISION base (BOOSTER), you can maintain all information that must be submitted to ZSVR, who manages LUCID,

including data regarding the amount of material used to pack items that you intend to sell in the country

Currently, the aim of this feature is to ensure compliance with German regulations on industrial and consumer goods packaging. If

requested, however, the function can be adapted to meet the requirements of other European Union countries.

Setup

LUCID

Those who market goods in Germany, whether they’re manufacturers or ‘initial distributors,’ must report the materials they use

to pack the items to ZSVR. For this purpose, they must register with the agency’s LUCID database.

The registration requirement, which took effect on July 1, 2022, applies to any kind of packaging used for products sold in a

store, shipped to a customer, or repacked in a warehouse if the manufacturer or initial distributor participates, including

financially, in a system where the collection, sorting, and recycling of waste is left to a producer responsibility organization.

The requirement, however, also applies to all materials not collected by a PRO, including transport wrappings, as well as

reusable or single-use packaging you might need to redeem a deposit for.

To simplify the management aspect of waste collection, a business such as a bakery, which packages goods just before selling

them to end customers, can take advantage of a special rule that lets it buy pre-licensed materials from its suppliers, that is,

packaging for which waste collection and recycling fees have already been paid.

Depending on whether a supplier or customer has agreed to bear the costs for wrapping the requested items, you might need to

store the business partner’s LUCID ID in the system so that you can check the number in ZSVR’s registry, if necessary.

To specify an ID, open a customer (or vendor) card, and then fill in the LUCID ID field on the Shipping (or Receiving) FastTab.
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To maintain (and print) your own ID, fill in the field with the same name on the Company Information page (on the General

FastTab). You can use the Tell Me function to get to the page.

Default unit of measure

You can also choose a shared unit of measure, for example, gram or kilogram, that all materials designated for packing items

should be shown in.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION FastTab, fill in the Packaging Material Unit of Measure field.

Packaging Materials

On this page, which can be opened by using the Tell Me function, you specify the materials that will be assigned as packaging to

items. Examples are PPT, glass, and tinplate.

You need to set up the materials in a way that they match the packaging quantities reported in LUCID.
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Assign materials to items

If you want to calculate the amount of packaging (materials) that you placed on the market, you need to assign packaging to

every item involved.

Open an item card.

On the ribbon, choose Related > Item > Packaging Material Assignment. Alternatively, use the Tell Me function to open the page.

Fill in the fields as described in the following table.

Packaging materials entries

These entries are used to determine the amount of packaging that was placed on the German market. An entry is created

automatically each time you assign a material.

You can also have the system determine the amount needed for certain items even if those items have been shipped already. This

way, you can still enter or change the packaging material on orders where none is assigned or where the wrong packaging or

quantity has been specified. To edit an entry:

Choose the Search icon, enter Packaging Material Entries, and then choose the related link.

On the Lines FastTab, select the entries that you want to change. You can also select all of them, if necessary.

On the ribbon, choose Manage > Delete, and then choose OK to confirm.

Afterward, choose Actions > Refresh Entries on the ribbon. You can set filters on the request page if you want to limit the number

of entries that should be recreated.

You can then use Excel, Power BI, or the analytical tools provided by Microsoft Dynamics 365 Business Central1 to evaluate and

report packaging materials to ZSVR (a separate analysis option isn’t part of this feature).

1. 

2. 

3. 

Field Description

Item No. Shows the number of the item for which you want to store packaging material.

This field is also used as a filter field. You can remove the filter if you need to specify

packaging for multiple items at once.

Variant Code Specify a code if the material differs by variant.

If you leave the field blank, the selected material is used to pack all variants of the item.

Item Description Shows the description of the item for tracking purposes.

You cannot change the content of this field.

Packaging Material Code Select the material that you want to assign to the item.

Packaging Material

Description

Shows the description of the packaging material.

Quantity per Qty. (Base) Specify the quantity of material per the item’s base unit.

Example

If 250 grams of glass are required for one item (the base unit), enter 250 here (provided Gram

is set up as a unit of measure).

Starting Date

Ending Date

Specify the period in which the material should be used to pack the item.

By filling in both fields, you can respond more quickly to changing material requirements.

Note

To calculate the amount of packaging that was placed on the market, the system will use the

date when you shipped the item.
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ITEM REFERENCE STARTING DATE

With standard functionality, you can enter both starting and ending dates for item references in the system.

In KUMAVISION base (BOOSTER), you can also specify if the starting date should be filled in automatically when a reference is

created from a sales line.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the General FastTab, in the Item Reference Starting Date, select one of the options described in the following table.

ITEM REFERENCE VALIDITY

If valid at the time, item reference starting and ending dates can also be used for framework agreements, labels, and price data.

PRICES

Quoting prices to customers

For retailers that sell products over the phone or online, providing quick price estimates is an indispensable part of doing

business. With a new feature, you can now tell customers immediately whether certain items are in stock and at what price they

can be shipped.

You can also save newly agreed-on prices and discounts in the system, show price histories, and log the quotes provided to a

customer. To create a quote for an item:

Open a contact card.

On the ribbon, choose Related > New Price Quote (Customer).

Fill in the fields as described in the following table.

1. 

2. 

Option Description

None No starting date is retrieved.

Document Date The starting date equals the date of the document from which the reference is created.

Note

On invoices and credit memos, the posting date is used instead.

Old Value The starting date is copied from the previous item reference.

Ask You see a message asking you what date should be entered.
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Price quotes are available for contacts assigned to the customer master. If a contact hasn’t been turned into a customer, you need to

take the standard route by creating a sales quote first. You’ll be notified when you’re trying to quote prices to contacts who aren’t

customers yet.

From the copied or manually entered price and discount data, the system then calculates a line amount (without VAT) that can be

quoted to the customer.

Besides the Line Amount (LCY) Excl. VAT, you can also see the Cost (LCY), the Profit (LCY), and the Profit % on a price quote line.

None of these fields can be edited, however.

Note

Field Description

No. Specify the number of the item for which a price should be quoted.

Variant Code If the item has variants, specify the requested variant in this field.

Quantity Enter for what item quantity the customer wants a price quoted.

Unit of Measure Code Shows the item’s base unit.

You can enter another unit manually if necessary.

Date Shows when the price was quoted.

You can enter another date manually if necessary.

Currency Code Shows the currency that is used by the customer.

You can enter another currency manually if necessary.

Price Unit Shows the item’s price unit.

You can enter another unit manually if necessary.

Responsibility Center

Code

Shows the responsibility center assigned to the customer.

Sales Order Type Here you can assign a sales order type to the price quote if a type is available.

Description

Description 2

Shows the relevant descriptions from the item master.

Base Unit of Measure

Code

Shows the base unit from the item master.

Unit Cost (LCY) Shows the unit cost from the item master.

Minimum Profit % Shows the minimum profit stored in the item master.

Location Code Shows the location code assigned to the customer. You can change the location manually if

necessary.

Unit Price Shows the unit price for the item.

You can enter another price manually if necessary.

Line Discount % Shows the line discount granted for the item.

You can enter another discount manually if necessary.
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The Comment, Minimum Quantity, Starting Date and Ending Date, on the other hand, can be changed. They’re used when you

copy prices and discounts from the price quote to the Sales Prices and Sales Discounts pages.

You can store a price or discount by choosing Save Sales Price or Discount on the ribbon. You can also have price data saved

automatically when leaving the page by turning on the Auto Save on Exit toggle. 

Price source

The Price Source field indicates where the Unit Price Excl. VAT or Unit Price (Price Unit) Excl. VAT value on a document line

comes from:

When copied to a sales order from a blanket agreement or entered manually, the unit price will—contrary to standard processes—not

be updated when you enter a new quantity on the order.

For line discounts, the equivalent to this field is the Line Discount Source field.

Save prices or discounts

Often, the sheer number of item variations sold in the retail sector means that prices aren’t maintained in advance but depend on

quotes or orders.

The Save Price/Discount feature provides a convenient way for you to save for reuse the item prices that you agreed to on quotes

or orders the next time that the items are needed. To save prices from a quote or an order:

Create a sales quote or order that contains the requested items.

Change the values in the Unit Price and Line Discount % line fields to what has been agreed on.

Select a line that you want to save a price or discount for.

On the Lines FastTab, on the ribbon, choose Line > Related Information > Price/Discount Calculation > Save Price/Discount.

Fill in the fields as described in the following tables.

You can select multiple lines before running this function; only lines of type Item will be saved. If none are among those selected, you

will see a message and the process will be canceled.

Field Description

Item

Sales Price

The value was copied from an item card or the sales price master.

Blanket Order The value was retrieved from a blanket sales order.

Manual The value was entered manually.

Note

1. 

2. 

3. 

4. 

5. 

Note
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For sales prices:

For line discounts:

Sales conditions

Sales conditions provide another way for you to calculate a wide variety of prices or discounts on documents. For this purpose, a

condition is linked to calculation lines on which you can enter the price or discount formulas that should be used within the

system.

You can already specify calculation lines when you set up base data in the app and can later copy these lines along with a

condition to one or more price or discount records.

Create a condition

Field Description

Save Price Select this field to save the unit price entered on the line. 

You need to turn on this toggle before you can fill in the other fields.

Customer No. Specify for what customer the price should be saved.

Starting Date Specify the date starting on which the price should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the price should no longer apply.

Copy Min.

Quantity

Turn on this toggle if you want the quantity specified on the line to be considered the minimum quantity

for applying the price to the item.

Copy Variant

Code

Turn on this toggle if you want the variants specified on the line to be sold at this sales amount per unit.

With the toggle turned off, the unit price will be valid for all variants.

Show New Price Turn on this toggle if you want to see the new unit price on the Sales Prices page so that you can

review and (potentially) revise the sales price for the item.

Field Description

Save Line Discount Select this field to save the discount entered on the line.

You need to turn on this toggle before you can fill in the other fields.

Customer No. Specify for what customer the discount should be saved.

Starting Date Specify the date starting on which the discount should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the discount should no longer apply.

Copy Min. Quantity Turn on this toggle if you want the quantity specified on the line to be considered the minimum

quantity for applying the discount to the item.

Copy Variant Code Turn on this toggle if you want the variants specified on the line to be bought at this discount per

unit.

With the toggle turned off, the line discount will be valid for all variants.

Show New Line

Discount

Turn on this toggle if you want to see the new discount on the Sales Line Discounts page so that you

can review and (potentially) revise the line discount for the item.
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To create a sales condition:

Choose the Search icon, enter Sales Condition List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following tables.

General

Lines

On the lines, you can specify how a price or a reduction in price will be calculated when the condition applies.

Prices and discounts will later be determined based on the order in which you fill in these lines.

1. 

2. 

3. 

Field Description

No. Exit the field to have the system assign a number from the series set up for this purpose or enter a

number manually. The number must be unique.

Description Specify a description for the condition.

Calculation

Base

Specify what the condition is used for.

Currency Code Specify the currency code that will be used for the condition.

You must fill in this field, as a sales condition is always used in combination with one and the same

currency code.

Note

Field Description

Description Specify a description for the condition line.

Operators Specify the operator that will be used for the price or discount.

+

adds the entered percentage or amount

-

subtracts the entered percentage or amount

Value Specify the percentage or amount that you want to add or subtract (depending on what operator

you’re using).

Calculation

Method

Specify the type of price calculation that will be performed.

Previous Result

Calculates a percentage based on the result of the previous condition line.

Net Percentage

Determines a percentage by using the total direct unit cost or line discount.

Currency Amount

Adds or subtracts the entered amount in the specified currency.
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As an example, a condition might have been specified as follows:

In this example, a 10% discount needs to be deducted from the cost amount—which is EUR 3,040—before 5% is added to the

resulting EUR 2,736 (EUR 3,040 - EUR 304) because the product has a markup.

By applying the condition, the item is then sold at EUR 2872.80. As another example, consider the following net percentage

conditions:

In this example, a 10% discount needs to be deducted from the cost amount—which is EUR 3,040—before 5% is added to the

resulting EUR 2,736 (EUR 3,040 - EUR 304) because the product has a markup.

Additionally, you can choose Translations on the Lines FastTab to have steps in the calculation translated and copied

automatically to documents on which the specified language code is used.

Although sales conditions aren’t typically printed on documents in KUMAVISION, the translations can be retrieved if required for a

specific implementation project.

Link a condition to a price or line discount

You must fill in the Sales Condition No. field if you want to link a condition to a price or line discount. The currency that you’ve

specified for the condition must match the currency entered for the price or discount.

For prices or discounts linked to conditions, the Unit Price or Discount % field will always be blank in the item master. The values

in these fields will be filled in only when you enter a condition-based price or discount on a document line.

Use a condition to find the best price or line discount

When trying to determine the best prices or reductions in prices, the system uses condition-based prices or line discounts in the

same way as standard functionality; a condition isn’t a factor in deciding whether a certain price or line discount can be entered

on a sales document. The only difference to standard functions is that sales prices or line discounts linked to conditions are

calculated in real time.

The standard business logic for calculating sales prices or line discounts hasn’t changed.

Get Sales Price

Description Operator Value Calculation Method

Trade show discount - 10 Previous result

General markup + 5 Previous result

Description Operator Value Calculation Method

Trade show discount - 10 Net percentage

General markup + 5 Net percentage

Field Description

Target Language Choose a language for translation.

Value Enter the translated description of the calculation step.

Note

Note
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The standard Get Sales Price action can be used to copy the sales prices that are available for a document to selected document

lines. With this action, you can bypass the pricing function that is run when you enter an item number or a quantity on a line.

The same is true for the Get Line Disc. action. However, this function now also calculates for each line that is assigned to a sales

condition the discount based on price entries that include the condition (instead of retrieving a value of 0 from the item master).

Sometimes, the currency and unit of measure specified for the document line and price record might differ when you’re trying to

calculate the best price for an item. The following fields were therefore added to the Sales Prices page:

Unit of Measure (Calc.)

Currency Code (Calc.)

Unit Price (Calc.)

The first two fields contain the values that were entered on the document line from which the calculation was run. The third field

shows the price in the unit and currency specified on the line—unlike the standard Unit Price field, which shows prices in the

currency and unit stored in the sales price master. You can select the Assist button next to the Sales Condition No. field to see in

what way a condition has been used to determine sales prices or discounts.

Copy a condition to a calculation line

When you specify a price or discount on a sales line, the condition lines that might be linked to either will be copied to a sales

line subpage. To see the subpage:

Open a sales order.

Go to the Lines FastTab and select a line.

On the ribbon, choose Line > Price/Discount Calculation > Price or Line Discount. 

You can change, delete, or insert lines here if necessary. Alternatively, you can set up a blank calculation sheet and use a ribbon

function to copy values from condition lines.

Edits are made on this buffer page so that you can simulate their impact first and discard them if necessary; only changes that

are accepted by you will be copied to the relevant sales line (and saved for when you want to reopen the page to make revisions).

When you exit the page, the Price Calculation or Discount Calculation field will be selected on the associated sales line

depending on which kind of calculation has been changed.

Both checkboxes are hidden by default.

Copy calculation lines

When you post or archive a sales order, all calculation lines that have been filled in for a condition-based price or discount on the

order are copied alongside other data to the posted or archived document. However, you can still open the lines from there

(albeit in read-only format).

Exceptions are shipment and return receipt lines, as neither contain sales price fields.

Price units

The following formula is used in the standard app to determine the price on a document line:

Line Amount Excl. VAT = Quantity * Unit Price * [(100 – Line Discount %) / 100]

But there are other formulas. One of them provides a method for calculating a multiple of an amount by using a price unit.

Typically, this method is preferred when dealing with items that are large in number but low in price (like screws).

• 

• 

• 

• 

• 

• 

Note

Note
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Example 1

You enter Piece as the base unit on an item card and a document line.

You can then state a price on the line in multiples of 1000, that is, the price unit (or price per unit) equals the sales price for 1000

pieces.

Example 2

You enter Piece as the base unit of measure on an item card and Package on a purchase line. A package equals 50 pieces, as

specified on the Item Units of Measure page.

You can then state a price on the line in multiples of 50, that is, the price unit (or price per unit) represents the sales price for 50

packages.

You can already specify price units that you and your customers agreed on when you set up basic app data.

Price units aren’t used to convert one unit of measure into another. This is because fixed conversion rates cannot be entered for item

units of measure.

For example, you might want to use the unit Piece and enter an item on a document line in pieces. However, the price for the line

is determined based on weight (weight-dependent document pricing). To calculate this price, you will need another method that

requires a separate explanation (outside the scope of this article).

Item price groups

For items of the same type, you can specify a price per category. For example, a group of paperbacks might cost the same

because of the size and material used (regardless of who authored each book).

You can set up prices for item groups in the same way as for individual items. The feature supports entering agreements:

For sales types

For campaigns

In customer hierarchies

For sales conditions

According to quantity, delivery date, and currency

Based on units of measure, in the following way:

You can store the price (for a group) in a certain unit of measure on a document line provided the unit has been assigned to the

relevant group beforehand.

Item price groups cannot be used to store prices for variants. If variants are available for an item assigned to a price group, the

group price will apply to all variants.

Note

• 

• 

• 

• 

• 

• 

Note
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To set up a price group for an item:

Choose the Search icon, enter Item Price Groups, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

After creating a group, you can choose Related > Item Price Group > Sales Prices on the ribbon to enter prices for the group.

This process is the same as for prices maintained per customer or customer group in the standard app.

Block prices

What values are shown in the Unit Price and Line Discount % fields on document lines depends on the agreements you have in

place with customers.

You can specify a wide variety of sales price and discount agreements in the system, including agreements made with an

individual customer, a group of customers, or all customers, as well as agreements covering single products or an entire group of

items.

When you add an item to a document, the system will compare the value that you enter in the Quantity field on a line against the

minimum quantities set for the associated customer in the item master to calculate the best sales price and discount available.

In short, the standard app calculates prices and discounts separately on each line of a document. Sometimes, however, you might

need to enter one and the same item on multiple lines, for example, because products must be delivered in batches on different

dates.

For this reason, standard functionality has been extended so that prices and discounts can now be determined based on the total

quantity entered for an item on all lines of a document. For a line to be included in the total, however, the values in the following

fields must also match those on the other lines:

Type and No.

Variant Code

Unit of Measure Code and Qty. per Unit

Allow Line Disc. and Allow Invoice Disc.

Lines on which the following fields aren’t blank will not be included under any circumstances:

Shipment No. or Return Receipt No. (concerns invoice or credit memo lines created from a blanket sales order)

Blanket Order No. (concerns order lines that refer to a blanket order line)

Alternate

To calculate block prices:

Open a sales document.

On the ribbon, choose Update Block Pricing. Block prices are then calculated when you release the document.

If you manually change the Unit Price or Line Discount % field on a document line, the system will not update the value in either

field when you run the function, and the line will not become part of the quantity for calculation.

The same will happen with document lines that are related to blanket order or framework lines, with alternate lines, and when

you invoice posted shipments or returns.

1. 

2. 

3. 

Field Description

Code Specify a meaningful abbreviation for the group.

Description Specify a description for the group.

Sales Turn on this toggle if the group should be used in sales.

Purchases Turn on this toggle if the group should be used in purchasing.

• 

• 

• 

• 

• 

• 

• 

1. 

2. 
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You can also deactivate the block pricing feature on individual documents by turning off the Price/Disc. Min. Qty. per Line toggle

on the relevant document header. This might be necessary if you want to show a customer how a block price or discount is

calculated on a quote.

For this feature to work, you need to have selected Extended Pricing in the Pricing Method field in Sales & Receivables Setup and

turned off the Price/Disc. Min. Qty. per Line toggle there.

Pricing by order type

IIn certain situations, you might need differing (price and discount) conditions considering the purpose of an item, such as when

it is sold to a new customer versus when it is required for repairs.

For this reason, you can now assign a sales order type to sales prices and line discounts on item cards. Either is then used by the

pricing functionality only if you enter the relevant order type on the header of a sales document.

Customer resource prices

As another option, you can now assign customer-specific prices to resources on customer or resource cards.

Resource prices can be created for a specific customer, a customer group, or all customers. They can also be linked to an

individual resource or a resource group and, like item prices, can be given a starting and an ending date.

The business logic that undergirds best price and price sequence calculations is also used to determine resource prices.

Prices for resource work aren’t incorporated into hierarchy-based pricing.

Save prices or discounts

Often, the sheer number of item variations sold in the retail sector means that prices aren’t maintained in advance but depend on

quotes or orders.

The Save Price/Discount feature provides a convenient way for you to save for reuse the item prices that you agreed to on quotes

or orders the next time that the items are needed. To save prices from a quote or an order:

Create a sales quote or order that contains the requested items.

Change the values in the Unit Price and Line Discount % line fields to what has been agreed on.

Select a line that you want to save a price or discount for.

On the Lines FastTab, on the ribbon, choose Line > Related Information > Price/Discount Calculation > Save Price/Discount.

Fill in the fields as described in the following tables.

You can select multiple lines before running this function; only lines of type Item will be saved. If none are among those selected, you

will see a message and the process will be canceled.

Note

Note

1. 

2. 

3. 

4. 

5. 

Note
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For sales prices:

For line discounts:

Afterward, choose OK to exit the page.

Best price calculations

Microsoft Dynamics 365 Business Central1 will always calculate the best price on sales documents. In this context, the best price

is the lowest unit price with the highest line discount allowed on a given date. Sometimes, this means that a higher unit price

with a line discount might beat out a lower price that comes with no discount.

Certain customers, however, are typically charged prices slightly above those calculated by the system. For this reason, you can

now turn off the best price option for everyone or only certain customers.

Field Description

Save Price Select this field to save the unit price entered on the line. 

You need to turn on this toggle before you can fill in the other fields.

Customer No. Specify for what customer the price should be saved.

Starting Date Specify the date starting on which the price should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the price should no longer apply.

Copy Min.

Quantity

Turn on this toggle if you want the quantity specified on the line to be considered the minimum quantity

for applying the price to the item.

Copy Variant

Code

Turn on this toggle if you want the variants specified on the line to be sold at this sales amount per unit.

With the toggle turned off, the unit price will be valid for all variants.

Show New Price Turn on this toggle if you want to see the new unit price on the Sales Prices page so that you can

review and (potentially) revise the sales price for the item.

Field Description

Save Line Discount Select this field to save the discount entered on the line.

You need to turn on this toggle before you can fill in the other fields.

Customer No. Specify for what customer the discount should be saved.

Starting Date Specify the date starting on which the discount should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the discount should no longer apply.

Copy Min. Quantity Turn on this toggle if you want the quantity specified on the line to be considered the minimum

quantity for applying the discount to the item.

Copy Variant Code Turn on this toggle if you want the variants specified on the line to be bought at this discount per

unit.

With the toggle turned off, the line discount will be valid for all variants.

Show New Line

Discount

Turn on this toggle if you want to see the new discount on the Sales Line Discounts page so that you

can review and (potentially) revise the line discount for the item.
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Turning off the feature corresponds to hierarchical pricing.

General setup

To change the pricing rules:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the General FastTab, in the Best Price Calculation field, select if and to what extent the best price option should be used.

Customer-specific setup

If you selected See Customer in Sales & Receivables Setup, the No Best Price toggle must be turned off for each customer for

whom you want to calculate the best possible sales price.

With the No Best Price toggle for a customer turned on, the system will always use a price that is specific to the customer, even if

that price is higher than the standard price. The toggle then also turns on automatically on each document created for this

customer.

You can still change the setting on a sales document if you selected Always or See Customer in the Best Price Calculation field in

setup (if you set it to Never, the field will be grayed out). This way, you can offer the lowest prices also to a customer typically not

included in best price calculations, for example.

Pricing behavior

To account for a variety of item quantities, customers, and customer groups, you can enter different (but equally valid) prices for

an item. If the best price calculation is used, the system then retrieves these price records to find the lowest possible price at

which the item can be sold.

Pricing date

The date used to calculate prices on quotes, orders, and return orders is the order date. On credit memos and invoices, it’s the

posting date.

Price sequences

1. 

2. 

Option Description

Always The system should always calculate the best possible price.

Never Best price calculation should not take place at all.

See Customer Whether the best price for an item is calculated will depend on the Best Price setting on the relevant

customer card.
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With the Best Price toggle turned off, the system will retrieve a price based on the following field values, each listed in order of

priority:

Hierarchy Level

Lowest to highest. The value in this field, however, is only used if you’re working with hierarchies in the system, for example, when

selling to members of an association.

Sales Type

Campaign, Customer, Customer Price Group, All Customers

Sales Order Type

[filled in], [not filled in]

Type

Item, Item Price Group

Variant Code

[code specified], [no variant]. The value in this field, however, is only relevant if you’re working with variant codes in the system.

Unit of Measure Code

[filled in], [not filled in]

Currency Code

[code], [no code]. The value in this field, however, is only relevant if the customer uses a foreign currency.

Responsibility Center Code

[filled in], [not filled in]

Minimum Quantity

Starting Date

[newest], [older], [not filled in]

When you enter a campaign created for a customer on a sales document, the customer’s other (active) campaigns will be

disregarded. The prices specified for this campaign have a higher priority than all other types of prices.

If no campaign is specified, every campaign linked to the customer or contact will be included in the price calculation (when a

hierarchy is available: if it was created for the main customer in a hierarchy).

Initially, the best price is determined only for the customer whom you entered on the document. If the customer is linked to

another customer in a hierarchy, the latter will be ignored by the system for the time being.

However, if no valid price is found for the customer, the system will search the next level of the hierarchy. You’ll see an error

message if the customer has been linked to multiple other customers on the same level.

The number of hierarchy levels can be unlimited. If no valid price can be found for the customer on any level, the system will go

through the available customer price groups based on the same logic. Within a group, a price for an item variant has a higher

priority than a general price for an item—provided the sales and item type match.

The same check is later repeated for currencies. In this context, a price with a currency is prioritized over prices for which no

currency has been set up.

As for the minimum quantity, the highest quantity threshold within the validity period will be used to retrieve the price.

Lastly, the system will check the starting date, with a more recent price given a higher priority than older entries. Essentially,

only prices available on the order date can be retrieved.

Discount calculations

Discounts are determined in the exact same way as prices. 

Pricing by responsibility center

In addition to standard functionality, you can now also assign prices and line discounts to different responsibility centers.

To be able to use this feature, you only need to fill in the Responsibility Center field for a unit price or line discount record.

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 
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Pricing by hierarchy

Another new feature will include the prices and discounts stored at a higher level of a customer hierarchy (see Create

Hierarchies) to determine the lowest price with the highest discount for an item that you want to sell to a customer. However,

before you can use this feature, you must set it up first:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

In the Hierarchy Type Code Pricing field, select the type of hierarchy that you want to use for extended pricing.

Customers linked to this hierarchy are then included in calculating the best price and discount on a document line based on

multiple price-related factors, such as the validity period, minimum quantity, unit of measure, currency, and responsibility center.

At which level of a customer hierarchy a value is determined isn’t relevant in this situation, as prices or discounts might be

calculated, for example, for customers and item price groups at multiple levels at the same time.

Price worksheets

Price worksheet extension

The Extended Sales Price Worksheet page includes the following fields for when you want to calculate or save prices:

Price Unit

Current Unit Price (Price Unit)

New Unit Price (Price Unit)

Responsibility Center

Sales Order Type

PRICES (VERSION 20.0 OR HIGHER)

New pricing experience

The new pricing features must first be turned on.

Choose the Search icon, enter Feature Management, and then choose the related link.

Go to the line that says Feature Update: New Sales Pricing Experience and set the Enabled For field to All Users.

If you’re using the older pricing functionality, do not turn on this feature. Once turned on, the new feature cannot be turned off

again.

Quoting prices to customers

For retailers that sell products over the phone or online, providing quick price estimates is an indispensable part of doing

business. With a new feature, you can now tell customers immediately whether certain items are in stock and at what price they

can be shipped.

You can also save newly agreed-on prices and discounts in the system, show price histories, and log the quotes provided to a

customer. To create a quote for an item:

Open a contact card.

On the ribbon, choose Related > New Price Quote (Customer).

Fill in the fields as described in the following table.

1. 

2. 

• 

• 

• 

• 

• 

1. 

2. 

Note

1. 

2. 

3. 
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Price quotes are available for contacts assigned to the customer master. If a contact hasn’t been turned into a customer, you need to

take the standard route by creating a sales quote first. You’ll be notified when you’re trying to quote prices to contacts who aren’t

customers yet.

Note
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Field Description

No. Specify the number of the item for which a price should be quoted.

Variant Code If the item has variants, specify the requested variant in this field.

Quantity Enter for what item quantity the customer wants a price quoted.

Unit of Measure Code Shows the item’s base unit.

You can enter another unit manually if necessary.

Date Shows when the price was quoted.

You can enter another date manually if necessary.

Currency Code Shows the currency that is used by the customer.

You can enter another currency manually if necessary.

Price Unit Shows the item’s price unit.

You can enter another unit manually if necessary.

Responsibility Center

Code

Shows the responsibility center assigned to the customer.

Sales Order Type Here you can assign a sales order type to the price quote if a type is available.

Description

Description 2

Shows the relevant descriptions from the item master.

Base Unit of Measure

Code

Shows the base unit from the item master.

Unit Cost (LCY) Shows the unit cost from the item master.

Minimum Profit % Shows the minimum profit stored in the item master.

Location Code Shows the location code assigned to the customer. You can change the location manually if

necessary.

Unit Price Shows the unit price for the item.

You can enter another price manually if necessary.

Line Discount % Shows the line discount granted for the item.

You can enter another discount manually if necessary.

Line Discount Amount Shows the discount amount calculated based on the Line Discount % field.

Line Amount Excl. VAT Shows the net amount of the sales line.

Minimum Quantity Specify the minimum quantity to be sold.

You need this field if the prices that you quote to the customer should be saved in a price list.

Starting Date

Ending Date

Specify in what period the price should apply (as agreed on with the customer).

You need these fields if the prices that you quote should be saved in a price list.

Allow Line Disc. Turn on this toggle if you want to use an available line discount on the item line.

Allow Invoice Disc. Turn on this toggle if you want to use an available invoice discount on the item line.
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From the copied or manually entered price and discount data, the system then calculates a line amount (without VAT) that can be

quoted to the customer.

Besides the Line Amount (LCY) Excl. VAT, you can also see the Cost (LCY), the Profit (LCY), and the Profit % on a price quote line.

None of these fields can be edited, however.

The Comment, Minimum Quantity, Starting Date and Ending Date, on the other hand, can be changed. They’re used when you

copy prices and discounts from the price quote to the Sales Price Lists page.

You can store a price or discount by choosing Save Sales Price or Discount on the ribbon. You can also have price data saved

automatically when leaving the page by turning on the Auto Save on Exit toggle.

When you run either function, the system will also check for duplicate records. If a combination of customer, item, and variant

already exists in a certain price list, you’ll be notified so that you can remove the lines from that list.

Field Description

Pricing Method Specify the pricing method that should be used.

Lowest price

Standard sales pricing

KUMAVISION base Lowest price

Best price calculation

KUMAVISION base Price Sequences

No best price calculation

Price List Code Select a price list.

You must fill in this field if you want to save sales prices.

Discount Price List Code Specify a discount price list.

You must fill in this field if you want to save sales prices.

Comments Indicates whether comments have been entered for this line.

Auto Save on Exit With the toggle turned on, prices are saved automatically.
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Price source

The Price Source field indicates where the Unit Price Excl. VAT or Unit Price (Price Unit) Excl. VAT value on a document line

comes from:

When copied to a sales order from a blanket agreement or entered manually, the unit price will—contrary to standard processes—not

be updated when you enter a new quantity on the order.

For line discounts, the equivalent to this field is the Line Discount Source field.

Sales conditions

Sales conditions provide another way for you to calculate a wide variety of prices or discounts on documents. For this purpose, a

condition is linked to calculation lines on which you can enter the price or discount formulas that should be used within the

system.

You can already specify calculation lines when you set up base data in the app and can later copy these lines along with a

condition to one or more price or discount records.

Create a condition

To create a sales condition:

Choose the Search icon, enter Sales Condition List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following tables.

Option Description

Item The value was copied from an item card.

Sales Price The value was copied from a sales price list.

Blanket Order The value was retrieved from a blanket sales order.

Manual The value was entered manually.

Item Price Group The value was copied from a sales price list (item price group).

Framework The value was retrieved from a framework agreement valid at the time.

External The value was transferred from an external application.

Note

With the field set by the external program, the price is not recalculated in the system.

Assembly The value was copied from an assembly BOM.

Resource The value was retrieved from a resource card.

Note

1. 

2. 

3. 
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General

Lines

On the lines, you can specify how a price or a reduction in price will be calculated when the condition applies.

Prices and discounts will later be determined based on the order in which you fill in these lines.

As an example, a condition might have been specified as follows:

In this example, a 10% discount needs to be deducted from the cost amount—which is EUR 3,040—before 5% is added to the

resulting EUR 2,736 (EUR 3,040 - EUR 304) because the product has a markup.

Field Description

No. Exit the field to have the system assign a number from the series set up for this purpose or enter a

number manually. The number must be unique.

Description Specify a description for the condition.

Calculation

Base

Specify what the condition is used for.

Currency Code Specify the currency code that will be used for the condition.

You must fill in this field, as a sales condition is always used in combination with one and the same

currency code.

Note

Field Description

Description Specify a description for the condition line.

Operators Specify the operator that will be used for the price or discount.

+

adds the entered percentage or amount

-

subtracts the entered percentage or amount

Value Specify the percentage or amount that you want to add or subtract (depending on what operator

you’re using).

Calculation

Method

Specify the type of price calculation that will be performed.

Previous Result

Calculates a percentage based on the result of the previous condition line.

Net Percentage

Determines a percentage by using the total direct unit cost or line discount.

Currency Amount

Adds or subtracts the entered amount in the specified currency.

Description Operator Value Calculation Method

Trade show discount - 10 Previous result

General markup + 5 Previous result
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By applying the condition, the item is then sold at EUR 2872.80. As another example, consider the following net percentage

conditions:

Here, a 10% discount needs to be deducted from the cost amount before a 5% markup based on the original amount is added to

the total.

In this situation, the item can be sold at EUR 2888.00 (with EUR 2,736 left after applying the basic discount but EUR 136.80

added at the end).

Additionally, you can choose Translations on the Lines FastTab to have steps in the calculation translated and copied

automatically to documents on which the specified language code is used.

Although sales conditions aren’t typically printed on documents in KUMAVISION, the translations can be retrieved if required for a

specific implementation project.

Link a condition to a price or line discount

You must fill in the Price Condition No. field on a price list if you want to link a condition to a price or line discount. The currency

that you’ve specified for the condition must match the currency entered for the price or discount.

For prices or discounts linked to conditions, the Unit Price or Discount % field will always be blank in the price list. The values in

these fields will be filled in only when you enter a condition-based price or discount on a document line.

Use a condition to find the best price or line discount

When trying to determine the best prices or reductions in prices, the system uses condition-based prices or line discounts in the

same way as standard functionality; a condition isn’t a factor in deciding whether a certain price or line discount can be entered

on a sales document. The only difference to standard functions is that sales prices or line discounts linked to conditions are

calculated in real time.

Get Sales Price

The standard Get Sales Price action can be used to copy the sales prices that are available for a document from a price list to

selected document lines. With this action, you can bypass the pricing function that is run when you enter an item number or a

quantity on a line.

The same is true for the Get Line Disc. action. However, this function now also calculates for each line that is assigned to a sales

condition the discount based on price lists that include the condition (instead of retrieving a value of 0 from the item master).

Sometimes, the currency and unit of measure specified for the document line and price record might differ when you’re trying to

calculate the best price for an item. The following fields were thus added to the Sales Price Lists page:

Unit of Measure (Calc.)

Currency Code (Calc.)

Unit Price (Calc.)

Description Operator Value Calculation Method

Trade show discount - 10 Net percentage

General markup + 5 Net percentage

Field Description

Target Language Choose a language for translation.

Value Enter the translated description of the calculation step.

Note

• 

• 

• 
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The first two fields contain the values that were entered on the document line from which the calculation was run. The third field

shows the price in the unit and currency specified on the line—unlike the standard Unit Price field, which shows prices in the

currency and unit stored in the price list master.

You can select the Assist button next to the Price Condition No. field to see in what way a condition has been used to determine

sales prices or discounts.

No default units on sales lines

Standard functionality will fill in the sales unit of measure as the unit on new price list lines.

However, this means that if you regularly store prices in the item’s base unit, you will need to remove that unit manually from

each price before the system can calculate a new price based on another unit of measure.

To have the unit field left blank on new lines:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Prices FastTab, turn on the No Default UOM Code toggle.

Price units

The following formula is used in the standard app to determine the price on a document line:

Line Amount Excl. VAT = Quantity * Unit Price * [(100 – Line Discount %) / 100]

But there are other formulas. One of them provides a method for calculating a multiple of an amount by using a price unit.

Typically, this method is preferred when dealing with items that are large in number but low in price (like screws).

Example 1

You enter Piece as the base unit on an item card and a document line.

You can then state a price on the line in multiples of 1000, that is, the price unit (or price per unit) equals the sales price for 1000

pieces.

Example 2

You enter Piece as the base unit of measure on an item card and Package on a purchase line. A package equals 50 pieces, as

specified on the Item Units of Measure page.

You can then state a price on the line in multiples of 50, that is, the price unit (or price per unit) represents the sales price for 50

packages.

You can already specify price units that you and your customers agreed on when you set up basic app data.

Price units aren’t used to convert one unit of measure into another. This is because fixed conversion rates cannot be entered for item

units of measure.

For example, you might want to use the unit Piece and enter an item on a document line in pieces. However, the price for the line

is determined based on weight (weight-dependent document pricing). To calculate this price, you will need another method that

requires a separate explanation (outside the scope of this article).

Item price groups

For items of the same type, you can assign sales prices per category. For example, a group of paperbacks might cost the same

because of the size and material used (regardless of who authored each book).

1. 

2. 

Note
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You can set up prices for item groups in the same way as for individual items. The feature supports entering agreements:

For sales types

For campaigns

In customer hierarchies

For sales conditions

According to quantity, delivery date, and currency

Based on units of measure, in the following way:

You can store the price (for a group) in a certain unit of measure on a document line provided the unit has been assigned to the

relevant group beforehand.

Item price groups cannot be used to store prices for variants. If variants are available for an item assigned to a price group, the

group price will apply to all variants.

To set up a price group for an item:

Choose the Search icon, enter Item Price Groups, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

After creating a group, you can choose Prices > Sales Prices on the ribbon to enter prices for the group. This process is the same

as for prices maintained in the standard app.

Block prices

What values are shown in the Unit Price and Line Discount % fields on document lines depends on the agreements you have in

place with customers.

You can specify a wide variety of sales price and discount agreements in the system, including agreements made with an

individual customer, a group of customers, or all customers, as well as agreements covering single products or an entire group of

items.

When you add an item to a document, the system will compare the value that you enter in the Quantity field on a line against the

minimum quantities set for the associated customer in the item master to calculate the best sales price and discount available.

In short, the standard app calculates prices and discounts separately on each line of a document. Sometimes, however, you might

need to enter one and the same item on multiple lines, for example, because products must be delivered in batches on different

dates.

• 

• 

• 

• 

• 

• 

Note

1. 

2. 

3. 

Field Description

Code Specify a meaningful abbreviation for the group.

Description Specify a description for the group.

Sales Turn on this toggle if the group should be used in sales.

Purchases Turn on this toggle if the group should be used in purchasing.
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For this reason, standard functionality has been extended so that prices and discounts can now be determined based on the total

quantity entered for an item on all lines of a document. For a line to be included in the total, however, the values in the following

fields must also match those on the other lines:

Type and No.

Variant Code (depending on whether you turned on the relevant toggle in Sales & Receivables Setup or on the item card)

Unit of Measure Code and Qty. per Unit

Allow Line Disc. and Allow Invoice Disc.

You can also have the system calculate block prices independent of variants (that is, a quantity is calculated without considering

any variant).

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

Turn on the No Variant Block Prices toggle.

To change the global setting for individual items, open an item card and in the No Variant Block Prices (Sales) field, choose one of

the options described in the following table.

You cannot maintain variant-specific prices if you want to use this feature.

Lines on which the following fields aren’t blank will not be included under any circumstances:

Shipment No. or Return Receipt No. (concerns invoice or credit memo lines created from a blanket sales order)

Blanket Order No. (concerns order lines that refer to a blanket order line)

Alternate

To calculate block prices:

Open a sales document.

On the ribbon, choose Update Block Pricing. Block prices are then calculated when you release the document.

If you manually change the Unit Price or Line Discount % field on a document line, the system will not update the value in either

field when you run the function, and the line will not become part of the quantity for calculation.

The same will happen with document lines that are related to blanket order or framework lines, with alternate lines, and when

you invoice posted shipments or returns.

You can also deactivate the block pricing feature on individual documents by turning off the Price/Disc. Min. Qty. per Line toggle

on the relevant document header. This might be necessary if you want to show a customer how a block price or discount is

calculated on a quote.

If you’ve already filled in the lines of a sales document, you’re asked to confirm your choice.

• 

• 

• 

• 

1. 

2. 

3. 

Option Description

Default Applies the Yes or No option (see below) to the item depending on whether you turned the No Variant

Block Prices toggle in Sales & Receivables Setup on or off.

Note

As the global setting is inherited to the item, this option is always set initially.

No Block prices are calculated according to the quantities and prices on all lines referring to the same sales

document, item, and variant.

Yes Block price quantities are determined based on item numbers, independent of variants.

Note

• 

• 

• 

1. 

2. 
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For this feature to work, you need to have selected the KUMAVISION Lowest Price or KUMAVISION Price Sequences option in the

Pricing Method field in Sales & Receivables Setup and turned on the Price/Disc. Min. Qty. per Line toggle there.

Pricing by order type

In certain situations, you might need differing (price and discount) conditions considering the purpose of an item, such as when it

is sold to a new customer versus when it is required for repairs.

For this reason, you can now assign a sales order type to sales prices and line discounts on item cards. Either is then used by the

pricing functionality only if you enter the relevant order type on the header of a sales document.

Customer resource prices

As another option, you can now assign customer-specific prices to resources on customer or resource cards.

Resource prices can be created for a specific customer, a customer group, or all customers. They can also be linked to an

individual resource or a resource group and, like item prices, can be given a starting and an ending date.

The business logic that undergirds best price and price sequence calculations is also used to determine resource prices.

Prices for resource work aren’t incorporated into hierarchy-based pricing.

Save prices or discounts

Often, the sheer number of item variations sold in the retail sector means that prices aren’t maintained in advance but depend on

quotes or orders.

The Save Price/Discount feature provides a convenient way for you to save for reuse the item prices that you agreed to on quotes

or orders the next time that the items are needed. To save prices from a quote or an order:

Create a sales quote or order that contains the requested items.

Change the values in the Unit Price and Line Discount % line fields to what has been agreed on.

Select a line that you want to save a price or discount for.

On the Lines FastTab, on the ribbon, choose Line > Related Information > Price/Discount Calculation > Save Price/Discount.

Fill in the fields as described in the following tables.

You can select multiple lines before running this function; only lines of type Item will be saved. If none are among those selected, you

will see a message and the process will be canceled.

Note

Note

1. 

2. 

3. 

4. 

5. 

Note
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For sales prices:

For line discounts:

Afterward, choose OK to exit the page.

Close prices or discounts

The system retrieves unit prices and line discounts based on the starting and ending dates entered for them on a price list.

Field Description

Save Price Select this field to save the unit price entered on the line. 

You need to turn on this toggle before you can fill in the other fields.

Price List Code Select a price list.

You must fill in this field if you want to save sales prices.

Customer No. Specify for what customer the price should be saved.

Starting Date Specify the date starting on which the price should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the price should no longer apply.

Copy Min.

Quantity

Turn on this toggle if you want the quantity specified on the line to be copied as the minimum quantity

for the price to a price list.

Copy Variant

Code

Turn on this toggle if you want the variants specified on the line to be copied to a price list as being sold

at this amount per unit.

With the toggle turned off, the unit price will be valid for all variants.

Show New Price Turn on this toggle if you want to see the new unit price on the Price List Lines page so that you can

review and (potentially) revise the sales price for the item.

Field Description

Save Line Discount Select this field to save the discount entered on the line.

You need to turn on this toggle before you can fill in the other fields.

Customer No. Specify for what customer the discount should be saved.

Starting Date Specify the date starting on which the discount should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the discount should no longer apply.

Copy Min. Quantity Turn on this toggle if you want the quantity specified on the line to be copied as the minimum

quantity for the discount to a price list.

Copy Variant Code Turn on this toggle if you want the variants specified on the line to be copied to a price list as

variants bought at this discount per unit.

With the toggle turned off, the line discount will be valid for all variants.

Show New Line

Discount

Turn on this toggle if you want to see the new discount on the Price List Lines page so that you can

review and (potentially) revise the line discount for the item.
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KUMAVISION base (BOOSTER) always uses the most recent price or discount for an item or item group provided all other

factors with an impact on sales remain the same.

However, you can also have an ending date assigned automatically when you create another price or discount for which you

enter a later starting date. This might make it easier for users to understand changes in prices and discounts. To have a date

assigned automatically:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Prices FastTab, turn on the Close Prices and Discounts toggle.

If you then enter a price or discount for the same item-price or item-discount combination but enter a later starting date, the

system will fill in the Ending Date field for the previously valid entry with a date set to one day before the new starting date.

A price or discount can only be closed if the entry replacing it doesn’t have an ending date.

Move prices to another price list

You can now move sales price lines from one price list to another, for example, to a list that you’ve set up for the sole purpose of

storing historic prices.

Open a sales price list.

Go to the Lines FastTab and select the prices that you want to transfer.

On the ribbon, choose Move Lines.

This opens the Select Price List window, where you can set filters to limit the number of lists that are displayed on the page.

Choose a list, and then choose OK.

Afterward, the selected price lines are both copied to the new list and deleted from the old one.

This feature is also available for price lines created in purchasing.

Best price calculations

Microsoft Dynamics 365 Business Central1 will always calculate the best price on sales documents. In this context, the best price

is the lowest unit price with the highest line discount allowed on a given date.

Sales prices and discounts are entered on price lists independently from each other. This means that a sales line might contain

the lowest price of one price list line and the highest discount of another.

Certain customers, however, are typically charged prices slightly above those calculated by the system. For this reason, you can

now turn off the best price option for everyone or only certain customers.

Turning off the feature corresponds to hierarchical pricing.

General setup

1. 

2. 

Note

1. 

2. 

3. 

4. 

5. 

Note
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To change the pricing rules:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the General FastTab, in the Pricing Method field, select if and to what extent the best price option should be used.

Customer-specific setup

You can also specify a price calculation method for a customer by filling in the Pricing Method field on the relevant customer

card. The option you select then replaces the setting you made in Sales & Receivables Setup.

With the No Best Price toggle for a customer turned on, the system will always use a price that is specific to the customer, even if

that price is higher than the standard price. The pricing method is also copied automatically to the Invoice Details FastTab on

each document created for this customer.

The correct calculation method is determined in the following order of priority:

Manual setting on the sales document

Customer card

Customer price group

Sales & Receivables Setup

Pricing behavior

To account for a variety of item quantities, customers, and customer groups, you can enter different (but equally valid) prices for

an item. If the best price calculation is used, the system then retrieves these price records to find the lowest possible price at

which the item can be sold.

Pricing date

The date used to calculate prices on quotes, orders, and return orders is the order date. On credit memos and invoices, it’s the

posting date.

Price sequences

1. 

2. 

Option Description

(blank) The system should always calculate the best possible price.

KUMAVISION

base

Price Sequences

Best price calculation should not take place at all.

KUMAVISION

base

Lowest price

If the best price for an item is calculated will depend on whether you’ve turned on the Best Price toggle

on the relevant customer card.

1. 

2. 

3. 

4. 
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With the Best Price toggle turned off, the system will retrieve a price based on the following field values, each listed in order of

priority:

Hierarchy Level

Lowest to highest. The value in this field, however, is only used if you’re working with hierarchies in the system, for example, when

selling to members of an association.

Sales Type

Campaign, Customer, Customer Price Group, All Customers

Sales Order Type

[filled in], [not filled in]

Type

Item, Item Price Group

Variant Code

[code specified], [no variant]. The value in this field, however, is only relevant if you’re working with variant codes in the system.

Unit of Measure Code

[filled in], [not filled in]

Currency Code

[code], [no code]. The value in this field, however, is only relevant if the customer uses a foreign currency.

Responsibility Center Code

[filled in], [not filled in]

Minimum Quantity

Starting Date

[newest], [older], [not filled in]

When you enter a campaign created for a customer on a sales document, the customer’s other (active) campaigns will be

disregarded. The prices specified for this campaign have a higher priority than all other types of prices.

If no campaign is specified, every campaign linked to the customer or contact will be included in the price calculation (when a

hierarchy is available: if it was created for the main customer in a hierarchy).

Initially, the best price is determined only for the customer whom you entered on the document. If the customer is linked to

another customer in a hierarchy, the latter will be ignored by the system for the time being.

However, if no valid price is found for the customer, the system will search the next level of the hierarchy. You’ll see an error

message if the customer has been linked to multiple other customers on the same level.

The number of hierarchy levels can be unlimited. If no valid price can be found for the customer on any level, the system will go

through the available customer price groups based on the same logic. Within a group, a price for an item variant has a higher

priority than a general price for an item—provided the sales and item type match.

The same check is later repeated for currencies. In this context, a price with a currency is prioritized over prices for which no

currency has been set up. As for the minimum quantity, the highest quantity threshold within the validity period will be used to

retrieve the price.

Lastly, the system will check the starting date, with a more recent price given a higher priority than older entries. Essentially,

only prices available on the order date can be retrieved.

Discount calculations

Discounts are determined in the exact same way as prices. Sales prices and discounts are entered on price lists independently

from each other. This means that a sales line might contain the lowest price of one price list line and the highest discount of

another.

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 
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Pricing by hierarchy

Another new feature will include the prices and discounts stored at a higher level of a customer hierarchy (see Create

Hierarchies) to determine the lowest price with the highest discount for an item that you want to sell to a customer. However,

before you can use this feature, you must set it up first:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

In the Hierarchy Type Code Pricing field, select the type of hierarchy that you want to use for extended pricing.

Customers linked to this hierarchy are then included in calculating the best price and discount on a document line based on

multiple price-related factors, such as the validity period, minimum quantity, unit of measure, currency, and responsibility center.

At which level of a customer hierarchy a value is determined isn’t relevant in this situation, as prices or discounts might be

calculated, for example, for customers and item price groups at multiple levels at the same time.

Pricing by responsibility center

In addition to standard functionality, you can now also assign prices and line discounts to different responsibility centers.

To be able to use this feature, you only need to fill in the Responsibility Center field for a unit price or line discount on a price

list.

Document pricing by sell-to (not bill-to) customer

Standard functionality calculates prices on a sales document by using the bill-to customer entered on it.

This might cause difficulties when invoices are sent to an association, as you might have agreed on a different set of prices with a

member of the association (=sell-to customer).

With the new feature, you can now decide which customer you want to run the pricing functionality for.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

In the Pricing Customer field, choose one of the options described in the following table.

If you choose the second or third option, you can change the setting again on the relevant customer card.

Consider item categories in pricing

Standard functionality only allows the assignment of one group of prices per customer. However, not all items a certain customer

buys from you might be subject to the same sales agreement.

With this extension, you can assign a price group to every item category, and its subcategories, in the system.

Example

One of your customers typically needs to pay the prices specified in group A. However, for items of the Bicycle category and its

subcategories (such as Tires, Apparel, and Accessories), the customer will be billed at group B prices, as per your setup.

Setup Sales & receivables setup

To be able to work with the feature:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Prices FastTab, turn on the Consider Item Categories toggle.

Item categories

1. 

2. 

1. 

2. 

Option Description

Default Standard functionality will be used.

Sell-to Prices and price information (=customer price groups) will be retrieved from sell-to customers.

Bill-to Prices and price information (=customer price groups) will be retrieved from bill-to customers.

1. 

2. 
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To create an item category or subcategory:

Choose the Search icon, enter Item Categories and then choose the related link.

On the ribbon, choose New, and then fill in the fields as necessary.

For more details, see Categorize Items - Business Central | Microsoft Learn.

Customer price groups

Set up one or more customer price groups, as described under Register New Customers - Business Central | Microsoft Learn.

Afterward, you must assign at least one of these groups to an item category.

Open a customer card.

On the ribbon, choose Related > Sales > Item Categories, and then fill in the fields as necessary.

For more details, see Assign a Category to a Customer.

Items

Assign the items that you want to set up special prices for to the relevant item categories.

Prices (List)

Create price lists for the price groups and items that you want to use. For more information, see Record special sales prices and

discounts - Business Central | Microsoft Learn.

To be able to do this, you must have activated the New Pricing Experience.

Assign a category to a customer

To assign a generally valid price group to a customer, fill in the Customer Price Group field on the relevant customer card (on the

Invoicing FastTab). You can then assign another group to a specific category of items by choosing Related > Sales > Item

Categories on the ribbon.

Based on our earlier example, you can therefore fill in price group A directly on the customer card while running the relevant

ribbon function to assign group B to the Bicycle category.

Workflow

Following setup, the system will start retrieving price list entries based on the customer price group and item category that

you’ve assigned to the customer and item entered on a sales document (in addition to the currency, order type, and other criteria

specified on it). For more general information about the pricing business logic, click here.

Price worksheets

Price worksheet extension

The following fields have been added to the Price Worksheet page for when you want to calculate or save prices on a price list:

Price Unit

Unit Price (Price Unit)

Responsibility Center

Order Type

Price Condition No.

Link a sales condition to a worksheet

1. 

2. 

1. 

2. 

Note
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• 

• 

• 

• 

1.2.1 base (BOOSTER)

- 69/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://learn.microsoft.com/de-DE/dynamics365/business-central/inventory-how-categorize-items?wt.mc_id=d365bc_inproduct_helppane
https://learn.microsoft.com/de-DE/dynamics365/business-central/sales-how-register-new-customers?wt.mc_id=d365bc_inproduct_helppane
https://learn.microsoft.com/de-DE/dynamics365/business-central/sales-how-record-sales-price-discount-payment-agreements?wt.mc_id=d365bc_inproduct_helppane&tabs=current-experience
https://learn.microsoft.com/de-DE/dynamics365/business-central/sales-how-record-sales-price-discount-payment-agreements?wt.mc_id=d365bc_inproduct_helppane&tabs=current-experience


In Microsoft Dynamics 365 Business Central1, you can use price worksheets to specify factors for calculating unit prices. In

KUMAVISION base (BOOSTER), you can now also use a sales condition (see Sales Conditions) on a price worksheet.

Workflow

To link a condition to a worksheet:

Choose the Search icon, enter Price Worksheet, and then choose the related link.

On the ribbon, choose Suggest Lines.

Choose Price Condition in the Calculation Type field.

In the Price Condition No. field, create or select the condition that should be used to determine a new price.

The price is then created and copied to the worksheet.

For conditions that relate to unit costs, you can fill in the Unit Cost Calculation Date field to specify when the cost should be

calculated, giving you the option of calculating unit prices for future unit costs.

You can then use the standard Implement Price Change function to copy the prices to the Sales Prices page.

If you perform multiple calculations for an item on the same worksheet, for example, because you want to use another date each

time, you can run the Calculation action from the ribbon to view the calculation log (consisting of the condition lines).

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Purchasing

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s procurement department.

CREATE HIERARCHIES

Hierarchies are used to link (any number of) vendors, customers, or contacts to each other. Hierarchical relationships can be

shown progressing from top to bottom or bottom to top.

Type Setup

When you’re trying to add a vendor to a hierarchy, you might see the following:

“Specify at least one hierarchy type.”

This means that no hierarchy has been set up yet. To create a hierarchy:

Choose the Search icon, enter Hierarchy Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Assign vendors

To specify hierarchical relationships between vendors:

Choose the Search icon, enter Vendors, and then choose the related link.

Open a vendor card.

To create a top-down structure

a. On the ribbon, choose Related > Vendors > Hierarchy – Related Vendors

To create a bottom-up structure

b. On the ribbon, choose Related > Vendors > Hierarchy – Relates to Vendor

Check if the correct type filter is set.

Enter a vendor number in the Value field.

Choose another line and repeat the steps.

View a hierarchy

To see a hierarchy:

Open a vendor card.

On the ribbon, choose Related > Vendor > Hierarchy – Where-Used.

Select a method for display:

• Related records (top-down approach)

• Relates to record (bottom-up approach)

Choose Calculate.

1. 

2. 

3. 

Field Description

Code Specify a code for the type of hierarchy.

Description Enter a text that describes the type of hierarchy.

Default Specify if this type of hierarchy should be used as the default type when you create new hierarchies.

Source Table Caption Specify if you want to link the hierarchy type to vendors, customers, or contacts.

1. 

2. 

3. 

4. 

5. 
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PURCHASE ORDER TYPES

Keeping track of large numbers of unposted documents in the system can be a difficult task: some might have been created to

fulfill standard orders, some might have been set up for rush jobs, and some might be the basis for repairs or consignment. A

quick solution to this problem is to organize documents by type so that they can be filtered later.

Setup

To set up an order category:

Choose the search icon, enter Purchase Order Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Assign dimensions

You can then assign dimensions to an order type for analytical purposes. To assign a dimension:

Choose the Search icon, enter Purchase Order Types, and then choose the related link.

Choose Related > Purchase Order Type > Dimensions > Dimensions-Single to assign the current record or choose Dimensions-

Multiple to assign more than one data record.

Choose OK to open the Dimensions page.

Fill in the fields as described in the following table.

1. 

2. 

3. 

Field Description

Code Specify a code for the type of order. The code must be unique.

Description Specify a description for the order type.

Type Specify the type of order:

• Standard

• Quote Request

• Subcontracted

Transaction Code Select a code in this field if you want to set a transaction filter on the reports available for purchase

order types.

Default Specify if this type will be used as the default type for new purchase orders.

Payment Terms

Code

You can assign special payment terms to each type of order to replace those stored in the vendor

master.

1. 

2. 

3. 

4. 

Field Description

Dimension Code Select the code of the dimension that should be used.

Dimension Value

Code

Select the dimension value that should be used.

Value Posting Specify the requirements that need to be met should you want to use the dimension and dimension

value.

• Code Required

• Shared Code

• No Code

Allowed Values Filter Description to follow.
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Select reports by type

You can also use order types to specify what purchase reports to print.

Choose the Search icon, enter Report Selection – Purchase, and then choose the related link.

In the Usage field, specify the type of document that you want printed.

Fill in the Report ID field on a line or choose Order Types on the ribbon to store a report based on a specific type.

Like on the standard report selection page, you can specify a sequence if you want to enter more than one report here.

Assign an order type

To assign a type to an order:

Create or open a purchase order.

On the General FastTab, in the Purchase Order Type field, select a type.

DISTRIBUTE WORKSHEET LINES

In large and midsize organizations, requisition and planning worksheets might be maintained by more than one person.

For this reason, you can distribute the results of requisition and planning onto worksheets assigned to individual employees.

More specifically, when you’ve completed a worksheet, the lines that you filled in on the document can be copied to various

worksheet names, which you can then assign to any number of IDs. To be able to use the feature, you must first assign an item to

an ID:

Open an item card.

On the Planning FastTab, fill in the Assigned User ID field.

On requisition or planning worksheets, the Assigned User ID field is then filled in on the lines where you enter the number of the

item.

Additionally, you must set up a link between the assigned ID and a worksheet name:

Choose the Search icon, enter Wksh. Line Distribution Filter, and then choose the related link.

Fill in the fields as necessary.

Each ID can only appear once within the distribution filters.

SPLIT REQUISITION WORKSHEETS BY LOCATION

When a requisition worksheet created in Microsoft Dynamics 365 Business Central1 contains multiple worksheet lines assigned

to the same vendor, the system will combine all of them into one purchase order even if the location assigned to each line is

different (that is, the items that were entered on the lines will be received at different sites). 

As a result, the purchase header shows that the order will be sent to address A, whereas the lines also show locations B, C and D

—and all items ultimately end up at A despite different sites specified on the lines. To prevent this from happening:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION FastTab, choose Yes in the Copy from Req. Wksh. by Location field.

QUOTE REQUESTS AND PRICE OVERVIEW

You can use the new Price Overview page to see all price quotes requested for purchasing products individually or in bulk, the

prices themselves, and the lead times for procuring the items from vendors and contacts.

The information shown on the page can be copied to a vendor-item catalog or stored with the relevant unit cost entries.

1. 

2. 

3. 
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Quote requests are typically created from a requisition or planning worksheet for multiple vendors or contacts at once.

Alternatively, you can enter vendors from a vendor-item catalog. To create a quotation request from a worksheet:

Open a worksheet.

Select the For Quote Requests field on the worksheet line that you want to create a request for.

On the ribbon, choose Related > Quote Request > Request Selection > Dimensions-Single or Dimensions-Multiple to select the

vendors or contacts whom you want to ask for prices.

Choose Create Quote Requests on the ribbon to generate requests per vendor or contact number.

On the dialog, choose whether—besides the vendors or contacts listed on the request selection—you also want to use vendors from

the item-vendor catalog.

Turn on the Print Quote Requests toggle if you want to print the quote requests immediately after running the function.

Choose OK.

The conditions that must be met for achieving certain prices are then entered on a price list. To see the list:

Open a requisition or planning worksheet.

Choose Related > Quote Request > Item Price Overview.

Besides unit costs grouped by vendor, the list includes information from other fields, such as the Lead Time field.

At the end of a line, you can see the field Direct Unit Cost Excl. VAT (Base / LCY). This field shows you the result of dividing the

line amount without VAT by the unit quantity. If you specify a currency code, the value in the field will also be converted to the

entered currency.

The actions that you can run from the overview are described in the following tables.

Action > Functions

Related > Purchase Prices

1. 

2. 

3. 

4. 

5. 

6. 

7. 

• 

• 

Field Description

Item/Vendor

Catalog

Copies the lead time on a line to the field with the same name in the catalog assigned to the selected

vendor and item.

Save Price/

Discount

Used to create block prices or update them on orders.

Creates lines on the Purchase Price Lists page and copies the data for the selected vendor and item

there. The Starting Date field on the lines, however, is filled in with the work date.

If the Vendor No. field on a quote is still blank, you’re asked if the entered contact should be converted

to a vendor. Choose No if you want to cancel the entire process.

Field Description

Item Opens the related item card.

Purchase Prices Opens the purchase prices specified for this item and vendor combination.

Item/Vendor Catalog Opens the catalog that has been assigned to this item and vendor.

Quote Request Opens the related quote request.

Document Texts

Header Text

Extended Texts

Opens the document, header, or extended texts assigned to the document line.
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VALIDITY PERIOD ON QUOTES

To limit the period in which an offer should be valid, you can fill in the Quote Expiration Date field on the General FastTab of a

quote document.

When you run the Save Prices/Discounts function from the Lines FastTab and this field is filled in, the validity date will be

suggested as the ending date for the entire quote. However, you can still change the date manually if necessary.

PURCHASE ORDER AND SUPPLIER CONFIRMATION

You can now enter confirmation documents you received from vendors directly on purchase orders.

Open a purchase order.

Select one or more lines, and then choose Line > Functions > Create Purch. Order Cnfrmn.

Fill in the fields as described in the following table.

Afterward, choose OK to close the page so that the system can create a purchase order confirmation entry to store the

confirmation document that you received.

You can track on a purchase confirmation document both the confirmation status and the history of delivery dates. To view a

document:

Open a purchase order.

Choose Related > Documents > Purch. Order Cnfrmn. on the ribbon.

ORDER CONFIRMATION REMINDERS

You can also remind suppliers to confirm the orders you placed with them.

Setup

Purchases & Payables Setup

To set up confirmation reminders:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the General FastTab, in the Default PO Cnfrm. Rmdr. Date field, select a reference date for confirmation reminders.

On the Number Series FastTab, specify a number series for new and issued confirmation reminders.

Confirmation reminder codes

1. 

2. 

3. 

Field Description

Confirmation No. Enter the number of the supplier confirmation.

Confirmation Date Enter the date printed on the confirmation.

Confirmed Delivery Date Here you can specify the receipt date entered by the supplier on the confirmation document.

This date is then copied to the selected lines as the Promised Receipt Date.

Delivery Date Confirmed When the supplier has confirmed the requested receipt date, you do not need to enter anything. 

Instead, turn on this toggle to have the new date copied to the Promised Receipt Date field.

1. 

2. 

1. 
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3. 

1.2.1 base (BOOSTER)

- 75/1545 - Copyright © 2018 - 2024 KUMAVISION AG



To set up conditions for a reminder:

Choose the Search icon, enter Purch. Order Cnfrmn. Rmdr. Terms, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

To specify the number of reminder levels and assign text to them:

Choose the Search icon, enter Purch. Order Cnfrmn. Rmdr. Terms, and then choose the related link.

Select a reminder.

On the ribbon, choose Level.

Fill in the number of levels and the formula that you want to use on each level.

To enter introductory and closing texts for a stage, choose Related > Level > Beginning or Ending Text on the ribbon.

Assign terms to vendors

To assign reminder terms to a vendor:

Choose the Search icon, enter Vendors, and then choose the related link.

Open a vendor card.

On the Receiving Tab, select a reminder in the Cnfrmn. Rmdr. Terms Code field.

Extended Report Selection

As a last step, you need to make the reminder report available in the system.

Choose the Search icon, enter Report Selection – Extended, and then choose the related link.

In the Usage field, select the PO Cnfrmn. Rmdr. Test option.

On the lines, fill in the Sequence and Report ID fields.

Issue a reminder

To remind a supplier of a delivery and ask the supplier to confirm the order:

Choose the Search icon, enter Purch. Order Cnfrmn. Rmdr. List, and then choose the related link.

Exit the No. field to have the system fill in a number from the series set up for this purpose.

On the ribbon, choose Create Confirmation Reminder.

You can then fill in the filter fields, for example, to limit the creation of a reminder to a certain vendor or item. Leave these fields

blank if you want the system to search for all overdue confirmation receipts.

Choose OK.

Before you can send a confirmation reminder to a vendor, a reminder terms code must be specified for the vendor on the vendor

card.

1. 

2. 

3. 

Field Description

Code Specify a code for the reminder.

Description Specify a description for the reminder.

Max. No. of PO Cnfrmn. Rmdrs. Specify how many reminders can be sent when using this code.

1. 

2. 

3. 

4. 

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 

4. 

5. 

Note
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The reminder must then be registered in the system so that you can set up reminder levels and print reminder documents. To

register a reminder:

On the ribbon, choose Issue.

When you run the action, the corresponding receipt will be printed on the device set up as the default printer.

Alternatively, you can print the reminder from the Issued Purch. Order Cnfrmn. Rmdr. List.

PROCESS IDS

Shared document IDs can be helpful, for example, for tracking purchases from quote entry to (potential) return shipment.

This is especially true if the documents used for a transaction must be linked across departments—such as when you want to tie

a customer’s return order to an order returned to a vendor. 

Setup

Before you can use document tracking, you need to set up a number series for process IDs.

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the Number Series FastTab, in the Document Process ID Nos. field, select the number series that you want to use for this

purpose.

Workflow

A process ID is always copied from the header of the initial document to the headers and lines on quotes, orders, receipts,

invoices, return orders (if the return order lines were created by using the Get Posted Document Lines to Reverse action), and

archived documents created from the document.

For example, a process ID entered on a purchase order is transferred to an invoice or receipt created from it when you post the

order.

On the order, on the Line FastTab, you can then choose Line > Navigate Doc. Process ID on the ribbon to see the documents

linked to the ID. You can also view individual documents by selecting the value in the No. of Entries field or use the standard

Navigate action to look for them.

When you copy a document or run the Get Posted Document Lines to Reverse function to create lines from a return order, the

system copies the process ID from the source document to the new lines. Afterward, you can only find them by searching for the

source document ID.

If you don’t want this to occur, you must turn off the Copy Document Process ID toggle in Purchases & Payables Setup before you

fill in document lines with the Copy Document function. As for return order lines, the ID is always copied from the order.

ADD TRANSACTION DATA

You can use the Add Transaction Data function to correct posting information on orders that have been received but not invoiced.

You make the corrections before choosing this action on the ribbon. When you run the function, the contents of the following

fields are copied from lines that have been received but not invoiced yet to a posted receipt and the associated item, material,

and value entries:

Gen. Business Posting Group

VAT Business Posting Group

Gen. Product Posting Group

VAT Product Posting Group

Dimension Set ID

Global Dimension Code 1

Global Dimension Code 2

SEND QUOTES TO CONTACTS

You can use a vendor template to send quotes to potential suppliers, that is, to contacts to whom no vendor has been assigned.

• 

• 

• 
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Vendor templates are set up in Finance. You can then run the Create Purchase Quote action from the ribbon of a vendor card to

fill in the purchase quote with the required contact details and choose in the Vendor Template Code field the template that you

want to use.

You can also create a quote without having to create a vendor. In this case, a vendor must be set up only when you convert the

quote to an order.

PRINT RELEASED DOCUMENTS

The system performs multiple checks when a purchase document is released. This includes checking if mandatory fields are filled

in and whether prices and costs have been calculated.

For this reason, KUMAVISION base (BOOSTER) limits printouts to documents that have been released, the only exception being

quotes (print previews will not be restricted either).

BLANKET ORDER EXTENSION

When you want to purchase items in large quantities, you often set up blanket orders in the system so that you can receive

products from suppliers at lower prices but in multiple smaller shipments over a specified period.

However, when using standard functionality, you might not see that creating a purchase order from a blanket agreement is even

possible until that order has been posted. Moreover, because you cannot see or select blanket agreements on requisition and

planning worksheets, you run the risk—especially when you need to order many items at once—that products might be bought at

standard conditions and prices.

To solve these issues, the Rem. Blanket Order Qty. field has been added to the lines of purchase orders and the Blanket Order No.

field to those of requisition and planning worksheets. This way, you can assign a line of a worksheet to a line of a purchase order

provided a large enough part of the originally agreed-on quantity remains, with vendor data and price terms being retrieved from

the blanket agreement.

Alternatively, you can have the blanket order lines that are still available for the selected vendor assigned by the system, with

price conditions copied too. You can also create separate purchase orders for every blanket order line.

The Rem. Blanket Order Qty. (Base) is a FlowField that totals the Rem. Blanket Order Qty. (Base) values on purchase lines

created from a blanket order. From the value in this and in the Qty. Per field, the system then calculates the Rem. Blanket Order

Qty. value when you create standard purchase orders. Other fields that have been added to worksheet lines are:

No. of Blanket Order Lines

Blanket Order No.

Blanket Order Line No.

The first is a FlowField that indicates the number of blanket purchase lines on which the type, number, and location match and

the value in the Rem. Blanket Order Qty. (Base) field is greater than 0.

You can use the lookup in the other fields to assign a blanket order or blanket order line to the worksheet. Filling in either copies

the vendor and, if available, the vendor item number and price terms and conditions (cost, discount, price unit, and currency)

from the assigned blanket purchase line.

The system then checks if subtracting the value in the Outstanding Qty. (Base) from the Rem. Blanket Order Qty. (Base) and

worksheet line quantity results in a value greater than 0 in the Quantity (Base) field.

Should you clear the Blanket Order No. and Blanket Order Line No. fields later, the system will recheck the assigned vendor

number and update the purchase prices if necessary.

Auto assign a blanket order

To have blanket order lines assigned automatically:

Open a purchase order.

On the ribbon, choose Assign Blanket Order. Other options are Delete or Reassign (a combination of Assign and Delete).

Alternatively, choose Carry Out Action Message on the ribbon when you create a purchase order and select Auto Assign Blanket

Order.
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When you run the assignment function, the system checks all worksheet lines for which the carry out action message was set to

New.

If you haven’t linked lines manually, the search will extend to all blanket orders that have been assigned to this vendor, item, item

variant, and location and for which the outstanding quantity is not 0, starting with the lowest document and document line

number.

When a blanket order line with enough remaining quantity is found, the line will be assigned to the worksheet line or split off

prior to assignment for a quantity that is greater.

Besides assigning the blanket order line, the system will copy the contents of cost and price fields (Unit Cost, Price Unit, and

Line Discount, for example) to the worksheet line.

You can remove a line by selecting it and choosing Delete on the ribbon. The vendor is then revalidated, and the line will be

repriced.

Additionally, a new toggle is now included with the Carry Out Action Message function. Turning on this toggle—called One Order

per Blanket Order—will sort worksheet lines based on blanket order and blanket order line numbers before a new order is

created for each line where these numbers are filled in.

Assign an order manually

You can also use the Assign function to transfer the terms and conditions of a blanket agreement to a manually created purchase

line by filling in the Blanket Order No. field on that line.

You are then asked whether you want to copy the value in the Direct Unit Cost Excl. VAT or the Line Discount % field from the

line on the blanket agreement.

Location-independent orders

Additionally, you can now use a blanket order for items that must be delivered to multiple locations, with the focus being on the

quantity that you want to buy and the agreed-on prices.

To be able to use this feature, the relevant blanket order lines must not contain location codes. As in the standard app, you can

then have the system copy the needed quantities from a requisition worksheet to the lines. Afterward, you can run the Carry Out

Action Message function to create a purchase order for each location that was specified on the worksheet.

COPY ITEM FUNCTION

The following options have been added to the Copy Item action:

Running the function then creates not only an item but also a production BOM or a routing filled in with the number of the item

in the No. field and linked to it on the item card. The following item header information is also copied:

Field Description

All Turns all options on or off.

Version

(Prod. BOM)

Fills in this field with the production BOM version that is valid at the time. However, the version can be

changed manually if necessary.

Version

(Routing)

Fills in this field with the routing that is valid at the time. However, the version can be changed manually

if necessary.

Field Description

Description Specifies the description of the item.

Unit of Measure Code Specifies the basic unit code of the item.

Type Specifies the type of routing or production BOM that will be copied.
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Item versions aren’t copied but must be assigned manually. As the version codes of routings and production BOMs aren’t linked to

triggers, the system will copy only the entries it has found so that a version you create by using the relevant toggle must be changed

manually as well.

ITEM TRACKING

In Microsoft Dynamics 365 Business Central1, you can specify that items must be posted with serial or lot number tracking.

Often, however, this specification changes during the lifecycle of a product, which makes the item more difficult to track and

complicates repairs.

In KUMAVISION base (BOOSTER), you can change both numbers under certain conditions:

The item cannot have open item entries.

The relevant item entries cannot be fully invoiced.

The unit cost on the item card must have been adjusted.

Reservations for the item cannot be made with a serial or lot number.

These conditions also apply to items for which you set the costing method to Specific.

SUPPORTING DOCUMENTS

This feature is used to maintain item-related documents, such as drawings and certificates, in the system.

Store a document

To store a document for an item:

Choose the Search icon, enter Items, and then choose the related link.

Open an item card.

On the ribbon, choose Related > Item > Supporting Documents.

Fill in the fields as described in the following table.

Note

• 

• 

• 

• 

1. 

2. 

3. 

4. 

Field Description

Type Specify the type of document. Options are:

• Drawing

• Protocol

• Description

• Marketing

• Prescription

• Approval Letter

• Certification

• Long-Term Supply Contract

• Short-Term Supply Contract

File Name Use the arrows to select a file for upload.

Description Enter a description for the document.

Starting Date

Ending Date

Specify the period in which the document is valid.

Version Specify the version of the document.

Sub Version Specify the sub-version of the document.
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The actions found on the ribbon are described in the following table.

UNDO POSTED RECEIPTS

Sometimes, you might want to cancel only a partial quantity from a receipt. To activate this feature:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION FastTab, set the Warehouse Undo Type field from Default to Extended Undo.

To reverse a partial quantity on a document:

Choose the Search icon, enter Purchase Receipts, and then choose the related link.

Open the relevant receipt and select the line you want to cancel.

On the ribbon, choose Change Cancellation Qty.

Fill in a quantity.

Choose Post to post the reversal document.

Only unbilled receipts can be reversed in this way.

PRICES

Price source

The Price Source field indicates where the Direct Unit Cost Excl. VAT or Direct Unit Cost (Price Unit) Excl. VAT value on a

document line comes from:

When copied to a purchase order from a blanket agreement or entered manually, the direct unit cost will—contrary to standard

processes—not be updated when you enter new quantities on the order.

For line discounts, the equivalent to this field is the Line Discount Source field.

Extended pricing

You can now also assign purchase prices and line discounts to different responsibility centers.

Function Description

Import Imports a file for the selected line.

Export Exports a file for the selected line for storage elsewhere in the system.

Delete Deletes the document stored for the selected line.

1. 

2. 

1. 

2. 

3. 

4. 

5. 

Note

Option Description

Item

Purchase Price

The value was copied from an item card or the purchase price master.

Blanket Order The value was retrieved from a blanket purchase order.

Manual The value was entered manually.

Note
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Moreover, you can use the prices and discounts stored at a higher level of a vendor hierarchy (see Create Hierarchies) to

determine the lowest price with the highest discount for an item that you want to purchase from a vendor. However, before you

can use this feature, you must set it up first:

Choose the Search icon, enter Purchases & Payables, and then choose the related link.

In the Hierarchy Type Code Pricing field, select the type of hierarchy that you want to use for extended pricing.

Vendors linked to this hierarchy are then included in calculating the best price and discount on a document line based on

multiple price-related factors, such as the validity period, minimum quantity, unit of measure, currency, and responsibility center.

At which level of a vendor hierarchy a value is determined isn’t relevant in this situation, as prices or discounts might be

calculated, for example, for vendors and item price groups at multiple levels at the same time.

Purchase conditions

Purchase conditions provide another way for you to enter line discounts. For this purpose, a condition is linked to calculation

lines on which you can enter your various discounting methods for use on purchase documents.

A condition can already be created and transferred to one or more purchase discount records when you create base data in the

app.

Create a condition

To create a purchase condition:

Choose the Search icon, enter Purchase Condition List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

General

Lines

On the lines, you can specify how a reduction in price will be calculated when the condition applies.

1. 

2. 

1. 

2. 

3. 

Field Description

No. Exit the field to have the system assign a number from the series set up for this purpose or enter a

number manually. The number must be unique.

Description Specify a description for the condition.

Calculation

Base

Specify what the condition is used for.

Currency Code Specify the currency code that will be used for the condition.

You must fill in this field, as a purchase condition is always used in combination with one and the same

currency code.
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Discounts will later be determined based on the order in which you fill in these lines.

As an example, a condition might have been specified as follows:

In this example, a 5% discount needs to be deducted from the direct unit cost of a certain item before another 3% discount

applied to the original amount is subtracted from the result because the product is on offer.

You now want to buy the item from vendor 3000 on 04/15/2023 as part of a new purchase order. The line discount that has been

assigned to the item is valid within the following period:

Because the discount in this example depends on a purchase condition, the Discount % field in the item master remains empty; the

system will instead calculate the actual value the moment you assign the line discount to a purchase document.

When you fill in the document, the condition specified for the discount is then used by the standard pricing function to calculate

the total line discount (8%).

Note

Field Description

Description Specify a description for the condition line.

Operators Specify the operator that will be used for the discount.

+

adds the entered percentage or amount

-

subtracts the entered percentage or amount

Value Specify the percentage or amount that you want to add or subtract (depending on what operator

you’re using).

Calculation

Method

Specify the type of price calculation that will be performed.

Previous Result

Calculates a percentage based on the result of the previous condition line.

Net Percentage

Determines a percentage by using the total purchase price or direct unit cost.

Currency Amount

Adds or subtracts the entered amount in the specified currency.

Description Operator Value Calculation Method

Basic discount - 5 Net percentage

Special offer - 3 Net percentage

Vendor Discount % Purchase Condition No. Valid From Valid Until

3000 PUR_COND_EX 01/01/2023 04/30/2023

Note
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To see how values are calculated, you can go to the Lines FastTab, select a line, and choose Line > Price/Discount Calculation > Line

Discount on the ribbon.

Additionally, you can choose Translations on the Lines FastTab to have steps in the calculation translated and copied

automatically to documents on which the specified language code is used.

Although purchase conditions aren’t typically printed on documents in KUMAVISION, the translations can be retrieved if required for

a specific implementation project.

Link a condition to a line discount

You must fill in the Purchase Condition No. field if you want to link a condition to a line discount. The currency that you’ve

specified for the condition must match the currency entered for the discount.

For discounts linked to conditions, the Discount % field will always be blank in the item master. The value in this field will be

determined only when you enter a condition-based discount on a document line.

Use a condition to find the best discount

When trying to determine the best reductions in item prices, the system uses condition-based line discounts in the same way as

standard line discounts; a condition isn’t a factor in deciding whether a certain discount can be entered on a purchase document.

The only difference to standard functionality is that discounts linked to conditions are calculated in real time.

The standard business logic for calculating line discounts hasn’t changed.

Copy a condition to a calculation line

When you specify a discount on a purchase line, the condition lines that might be linked to the discount will be copied to a

purchase line subpage. To see the subpage:

Open a purchase order.

Go to the Lines FastTab and select a line.

On the ribbon, choose Line > Price/Discount Calculation > Price or Line Discount.

You can change, delete, or insert lines here if necessary. Alternatively, you can set up a blank calculation sheet and use a ribbon

function to copy values from condition lines.

Edits are made on this buffer page so that you can simulate their impact first and discard them if necessary; only changes that

are accepted by you will be copied to the relevant purchase line (and saved for when you want to reopen the page to make

revisions).

When you exit the page, the Discount Calculation field will be selected on the associated purchase line.

Note

Field Description

Target Language Choose a language for the translation.

Value Enter the translated description of the calculation step.

Note

Note

• 

• 

• 
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This checkbox is hidden by default.

Copy calculation lines

When you post or archive a purchase order, all calculation lines that have been filled in for a condition-based discount on the

order are copied alongside other data to the posted or archived document. However, you can still open the lines from there

(albeit in read-only format).

Exceptions are receipt and return shipment lines, as neither contain purchase price fields.

Additionally, the lines are copied from one document to another when you use the Copy Document action or when you create a

purchase order from a blanket order. Only if you run the Recalculate Lines function will they be updated instead.

The Discount Calculation checkbox can also be unhidden there.

Price units

The following formula is used in the standard app to determine the price on a document line:

Line Amount Excl. VAT = Quantity * Direct Unit Cost * [(100 – Line Discount %) / 100]

But there are other formulas. One of them provides a method for calculating a multiple of an amount by using a price unit.

Example 1:

You enter Piece as the base unit on an item card and a document line. You can then state prices on the line in multiples of 1000,

that is, the price unit (or price per unit) equals the purchase price for 1000 pieces.

Example 2:

You enter Piece as the base unit of measure on an item card and Package on a purchase line. A package equals 50 pieces, as

specified on the Item Units of Measure page.

You can then state a purchase price on the line in multiples of 50, that is, the price unit (or price per unit) represents the price

for 50 packages.

You can already specify price units that you and your vendors agreed on when you set up basic app data.

Workflow

You use the following fields to specify price units on purchase lines:

Price Unit 

Direct Unit Cost (Price Unit) Excl. VAT

These fields can also be found on archived and posted documents.

Alternatively, you can assign a unit to a single document or store the unit for use by the pricing functionality.

When you assign direct unit costs to items, you need to ensure that price units are set up as well.

Price units aren’t used to convert one unit of measure into another. This is because fixed conversion rates cannot be entered for item

units of measure.

Note

Note

• 

• 

Note
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For example, you might want to use the unit Piece and enter an item on a document line in pieces. However, the price for the line

is determined based on weight (weight-dependent document pricing). To calculate this price, you will need another method that

requires a separate explanation (outside the scope of this article).

Item price groups

For items of the same type, you can assign purchase prices per category. For example, a group of paperbacks might cost the

same because of the size and material used (regardless of who authored each book).

You can set up prices for item groups in the same way as for individual items. The feature supports entering agreements:

In vendor hierarchies

For purchase conditions

According to quantity, delivery date, and currency

Based on units of measure, in the following way:

You can store the price (for a group) in a certain unit of measure on a document line provided the unit has been assigned to the

relevant group beforehand.

Item price groups cannot be used to store prices for variants. If variants are available for an item assigned to a price group, the

group price will apply to all variants.

When you enter the number of an item on a purchase line, the following will happen:

Besides the price stored specifically for the item, the system will also use the prices entered for the relevant item price group.

The best price will be determined among all prices found in the system, with neither item-specific nor group prices boasting an

advantage here.

You can use the FactBoxes on purchase (invoice) lines to look up item prices, including those specified for a group. You can also

select a price there (which corresponds to running the Get Purchase Price action).

To set up a price group for an item:

Choose the Search icon, enter Item Price Groups, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

After creating a group, you can choose Related > Item Price Group > Purchase Prices on the ribbon to enter prices for the group.

This process is the same as for prices maintained per vendor or vendor group in the standard app.

Block prices

What values are shown in the Direct Unit Cost and Line Discount % fields on document lines depends on the agreements you

have in place with vendors.

You can specify a wide variety of purchase price and discount agreements in the system, including agreements made with an

individual vendor, a group of vendors, or all vendors, as well as agreements covering single products or an entire group of items.

• 

• 

• 

• 

Note

• 

• 

1. 

2. 

3. 

Field Description

Code Specify a meaningful abbreviation for the group.

Description Specify a description for the group.

Sales Turn on this toggle if the group should be used in sales.

Purchases Turn on this toggle if the group should be used in purchasing.
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When you add an item to a document, the system will compare the value that you enter in the Quantity field on a line against the

minimum quantities set for the associated vendor in the item master to calculate the best purchase price and discount available.

In short, the standard app calculates prices and discounts separately on each line of a document. Sometimes, however, you might

need to enter one and the same item on multiple lines, for example, because products must be delivered in batches on different

dates.

For this reason, standard functionality has been extended so that prices and discounts can now be determined based on the total

quantity entered for an item on all lines of a document. For a line to be included in the total, however, the values in the following

fields must also match those on the other lines:

Type and No.

Variant Code

Unit of Measure Code and Qty. per Unit

Allow Line Disc. and Allow Invoice Disc.

Lines on which the following fields aren’t blank will not be included either:

Receipt No. or Return Shipment No. (concerns invoice or credit memo lines created from a blanket purchase order)

Blanket Order No. (concerns order lines that refer to a blanket order line)

Alternate

To calculate block prices:

Open a purchase document.

On the ribbon, choose Update Block Pricing. Block prices are then calculated when you release the document.

If you manually change the Direct Unit Cost or Line Discount % field on the line of a document, the system will update neither

value when you run the function, and the line will not become part of the quantity for calculation.

The same is true for document lines related to blanket order or alternate lines and when you invoice posted receipts or returns.

This feature is only available if you selected Extended Pricing in the Pricing Method field in Purchases & Payables Setup.

Save prices or discounts

Often, the sheer number of item variations sold in the retail sector means that prices aren’t maintained in advance but depend on

quotes or orders.

The Save Price/Discount feature provides a convenient way for you to save for reuse the item prices that you agreed to on quotes

or orders the next time that the items are needed. To save prices from a quote or an order:

Create a purchase quote or order that contains the requested items.

Change the values in the Direct Unit Cost and Line Discount % line fields to what has been agreed on.

Select a line that you want to save a price or discount for.

On the Lines FastTab, on the ribbon, choose Line > Price and Discount Calculation > Save Price/Discount.

Fill in the fields as described in the following tables.

You can select multiple lines before running this function; only lines of type Item will be saved. If none are among those selected, you

will see a message and the process will be canceled.

• 

• 

• 

• 

• 

• 

• 

1. 

2. 

Note

1. 

2. 

3. 

4. 

5. 

Note
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For purchase prices:

For line discounts:

Afterward, choose OK to exit the page.

Close prices or discounts

The system retrieves direct unit costs and line discounts based on the starting and ending dates entered for them.

KUMAVISION base (BOOSTER) always uses the most recent direct unit cost or discount for an item or item group provided all

other factors with an impact on purchases remain the same.

Field Description

Save Price Select this field to save the unit cost entered on the line. 

You need to turn on this toggle before you can fill in the other fields.

Vendor No. Specify for what vendor the unit cost should be saved.

Starting Date Specify the date starting on which the unit cost should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the unit cost should no longer apply.

Copy Min.

Quantity

Turn on this toggle if you want the quantity specified on the line to be considered the minimum quantity

for applying the cost to the item.

Copy Variant

Code

Turn on this toggle if you want the variants specified on the line to be bought at this cost amount per

unit.

With the toggle turned off, the direct unit cost will be valid for all variants.

Show New Price Turn on this toggle if you want to see the new unit cost on the Purchase Prices page so that you can

review and (potentially) revise the purchase price for the item.

Field Description

Save Line Discount Select this field to save the discount entered on the line.

You need to turn on this toggle before you can fill in the other fields.

Vendor No. Specify for what vendor the discount should be saved.

Starting Date Specify the date starting on which the discount should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the discount should no longer apply.

Copy Min. Quantity Turn on this toggle if you want the quantity specified on the line to be considered the minimum

quantity for applying the discount to the item.

Copy Variant Code Turn on this toggle if you want the variants specified on the line to be bought at this discount per

unit.

With the toggle turned off, the line discount will be valid for all variants.

Show New Line

Discount

Turn on this toggle if you want to see the new discount on the Line Discounts page so that you can

review and (potentially) revise the line discount for the item.
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However, you can also have an ending date assigned automatically when you create another price or discount for which you

enter a later starting date. This might make it easier for users to understand changes in prices and discounts. To have a date

assigned automatically:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION FastTab, turn on the Close Prices and Discounts toggle.

If you then enter a cost or discount for the same item-price or item-discount combination but enter a later starting date, the

system will fill in the Ending Date field for the previously valid entry with a date set to one day before the new starting date.

A price or discount can only be closed if the entry replacing it doesn’t have an ending date.

PRICES (VERSION 20.0 OR HIGHER)

New pricing experience

The new pricing features must first be turned on.

Choose the Search icon, enter Feature Management, and then choose the related link.

Go to the line that says Feature Update: New Sales Pricing Experience and set the Enabled For field to All Users.

If you’re using the older pricing functionality, do not turn on this feature. Once turned on, the new feature cannot be turned off

again.

Price source

The Price Source field indicates where the Direct Unit Cost Excl. VAT or Direct Unit Cost (Price Unit) Excl. VAT value on a

document line comes from:

When copied to a purchase order from a blanket agreement or entered manually, the direct unit cost will—contrary to standard

processes—not be updated when you enter new quantities on the order.

For line discounts, the equivalent to this field is the Line Discount Source field.

1. 

2. 

Note

1. 

2. 

Note

Option Description

Item The value was copied from an item card.

Purchase Price The value was copied from a purchase price list.

Blanket Order The value was retrieved from a blanket purchase order.

Manual The value was entered manually.

Item Price Group The value was copied from a purchase price list (item price group).

External The value was transferred from an external application.

Note

With the field set by the external program, the price is not recalculated in the system.

Resource The value was retrieved from a resource card.

Note
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Save prices or discounts

Often, the sheer number of item variations sold in the retail sector means that prices aren’t maintained in advance but depend on

quotes or orders. The Save Price/Discount feature provides a convenient way for you to save for reuse the item prices that you

agreed to on quotes or orders the next time that the items are needed. To save prices from a quote or an order:

Create a purchase quote or order that contains the requested items.

Change the values in the Direct Unit Cost and Line Discount % line fields to what has been agreed on.

Select a line that you want to save a price or discount for.

On the Lines FastTab, on the ribbon, choose Line > Price and Discount Calculation > Save Price/Discount.

Fill in the fields as described in the following tables.

You can select multiple lines before running this function; only lines of type Item will be saved. If none are among those selected, you

will see a message and the process will be canceled.

For purchase prices:

1. 

2. 

3. 

4. 

5. 

Note

Field Description

Save Price Select this field to save the unit cost entered on the line.

You need to turn on this toggle before you can fill in the other fields.

Price List Code Specify a price list.

You must fill in this field if you want to save purchase prices in the system.

Vendor No. Specify for what vendor the unit cost should be saved.

Specify the date starting on which the unit cost should apply.

This field is filled in with the work date by default but can be changed manually.

Starting Date Specify when the unit cost should no longer apply.

Ending Date Specify for what vendor the unit cost should be saved.

Copy Min.

Quantity

Turn on this toggle if you want the quantity specified on the line to be stored as the minimum quantity

on the price list assigned to the item.

Copy Variant

Code

Turn on this toggle if you want the variant specified on the line to be copied to the price list at this cost

amount per unit.

With the toggle turned off, the direct unit cost will be valid for all variants.

Show New Price Turn on this toggle if you want to see the new unit cost on the Price List Lines page so that you can

review and (potentially) revise the purchase price for the item.

1.2.1 base (BOOSTER)

- 90/1545 - Copyright © 2018 - 2024 KUMAVISION AG



For line discounts:

Afterward, choose OK to exit the page.

Purchase conditions

Purchase conditions provide another way for you to enter line discounts. For this purpose, a condition is linked to calculation

lines on which you can enter your various discounting methods for use on purchase documents.

A condition can already be created and transferred to one or more purchase discount records when you create base data in the

app.

Create a condition

To create a purchase condition:

Choose the Search icon, enter Purchase Condition List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

General

Lines

On the lines, you can specify how a reduction in price will be calculated when the condition applies.

Field Description

Save Line Discount Select this field to save the discount entered on the line.

You need to turn on this toggle before you can fill in the other fields.

Vendor No. Specify for what vendor the discount should be saved.

Starting Date Specify the date starting on which the discount should apply.

This field is filled in with the work date by default but can be changed manually.

Ending Date Specify when the discount should no longer apply.

Copy Min. Quantity Turn on this toggle if you want the quantity specified on the line to be stored as the minimum

quantity on the price list assigned to the item.

Copy Variant Code Turn on this toggle if you want the variant specified on the line to be copied to the price list at this

discount per unit.

With the toggle turned off, the line discount will be valid for all variants.

Show New Line

Discount

Turn on this toggle if you want to see the new discount on the Price List Lines page so that you can

review and (potentially) revise the line discount for the item.

1. 

2. 

3. 

Field Description

No. Exit the field to have the system assign a number from the series set up for this purpose or enter a

number manually. The number must be unique.

Description Specify a description for the condition.

Calculation

Base

Specify what the condition is used for.

Currency Code Specify the currency code that will be used for the condition.

You must fill in this field, as a purchase condition is always used in combination with one and the same

currency code.

1.2.1 base (BOOSTER)

- 91/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Discounts will later be determined based on the order in which you fill in these lines.

As an example, a condition might have been specified as follows:

In this example, a 5% discount needs to be deducted from the direct unit cost of a certain item before another 3% discount

applied to the original amount is subtracted from the result because the product is on offer.

You now want to buy the item from vendor 3000 on 04/15/2023 as part of a new purchase order. The line discount that has been

assigned to the item is valid within the following period:

Because the discount in this example depends on a purchase condition, the Discount % field in the item master remains empty; the

system will instead calculate the actual value the moment you assign the line discount to a purchase document.

When you fill in the document, the condition specified for the discount is then used by the standard pricing function to calculate

the total line discount (8%).

Note

Field Description

Description Specify a description for the condition line.

Operators Specify the operator that will be used for the discount.

+

adds the entered percentage or amount

-

subtracts the entered percentage or amount

Value Specify the percentage or amount that you want to add or subtract (depending on what operator

you’re using).

Calculation

Method

Specify the type of price calculation that will be performed.

Previous Result

Calculates a percentage based on the result of the previous condition line.

Net Percentage

Determines a percentage by using the total purchase price or direct unit cost.

Currency Amount

Adds or subtracts the entered amount in the specified currency.

Description Operator Value Calculation Method

Basic discount - 5 Net percentage

Special offer - 3 Net percentage

Vendor Discount % Purchase Condition No. Valid From Valid Until

3000 PUR_COND_EX 01/01/2023 04/30/2023

Note
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To see how values are calculated, you can go to the Lines FastTab, select a line, and choose Line > Price/Discount Calculation > Line

Discount on the ribbon.

Additionally, you can choose Translations on the Lines FastTab to have steps in the calculation translated and copied

automatically to documents on which the specified language code is used.

Although purchase conditions aren’t typically printed on documents in KUMAVISION, the translations can be retrieved if required for

a specific implementation project.

Link a condition to a price or line discount

You must fill in the Price Condition No. field if you want to link a condition to a price or line discount. The currency that you’ve

specified for the condition must match the currency entered for the price or discount.

For price lists linked to conditions, the Discount % field will always be blank in the item master. The value in this field will be

determined only when you enter a condition-based price or discount on a document line.

Use a condition to find the best price or discount

When trying to determine the best reductions in item prices, the system uses condition-based purchase prices in the same way as

standard prices; a condition isn’t a factor in deciding whether a certain price can be entered on a purchase document. The only

difference to standard functionality is that prices linked to conditions are calculated in real time.

The standard business logic for calculating line discounts hasn’t changed.

No default units on purchase lines

Standard functionality will fill in the purchase unit of measure as the unit on new price list lines.

However, this means that if you regularly store prices in the item’s base unit, you will need to remove that unit manually from

each price before the system can calculate a new price based on another unit of measure.

To have the unit field left blank on new lines:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the Prices FastTab, turn on the No Default UOM Code toggle.

Price units

The following formula is used in the standard app to determine the price on a document line:

Line Amount Excl. VAT = Quantity * Direct Unit Cost * [(100 – Line Discount %) / 100]

But there are other formulas. One of them provides a method for calculating a multiple of an amount by using a price unit.

Example 1

You enter Piece as the base unit on an item card and a document line.

Note

Field Description

Target language Choose a language for the translation.

Value Enter the translated description of the calculation step.

Note

Note

1. 

2. 
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You can then state prices on the line in multiples of 1000, that is, the price unit (or price per unit) equals the purchase price for

1000 pieces.

Example 2

You enter Piece as the base unit of measure on an item card and Package on a purchase line. A package equals 50 pieces, as

specified on the Item Units of Measure page.

You can then state a purchase price on the line in multiples of 50, that is, the price unit (or price per unit) represents the price

for 50 packages.

Workflow

You use the following fields to specify price units on purchase lines:

Price Unit 

Direct Unit Cost (Price Unit) Excl. VAT

These fields can later also be found on archived and posted documents.

Alternatively, you can assign a unit to a single document or store the unit for use by the pricing functionality. When you specify

direct unit costs for items, you need to ensure that price units have been specified as well.

Price units aren’t used to convert units, as fixed conversions cannot be entered for item units of measure

For example, you might want to use the unit Piece and enter an item on a document line in pieces. However, the price for the line

is determined based on weight (weight-dependent document pricing). To calculate this price, you will need another method that

requires a separate explanation.

Print a unit on documents

Price units and the direct unit costs specified in these units can be printed on each purchase document in the system.

You can already specify price units that you and your vendors agreed on when you set up basic app data.

Item price groups

For items of the same type, you can assign purchase prices per category. For example, a group of paperbacks might cost the

same because of the size and material used (regardless of who authored each book).

You can set up prices for item groups in the same way as for individual items. The feature supports entering agreements:

In vendor hierarchies

For purchase conditions

According to quantity, delivery date, and currency

Based on units of measure, in the following way:

You can store the price (for a group) in a certain unit of measure on a document line provided the unit has been assigned to the

relevant group beforehand.

Item price groups cannot be used to store prices for variants. If variants are available for an item assigned to a price group, the

group price will apply to all variants.

• 

• 

Note

• 

• 

• 

• 

Note
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When you enter the number of an item on a purchase line, the following will happen:

Besides the price stored specifically for the item, the system will also use the prices entered for the relevant item price group.

The best price will be determined among all prices found in the system, with neither item-specific nor group prices boasting an

advantage here.

You can use the FactBoxes on purchase (invoice) lines to look up item prices, including those specified for a group. You can also

select a price there (which corresponds to running the Get Purchase Price action).

To set up a price group for an item:

Choose the Search icon, enter Item Price Groups, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

After creating a group, you can choose Related > Item Price Group > Purchase Prices on the ribbon to enter prices for the group.

This process is the same as for prices maintained in the standard app.

Block prices

What values are shown in the Direct Unit Cost and Line Discount % fields on document lines depends on the agreements you

have in place with vendors.

You can specify a wide variety of purchase price and discount agreements in the system, including agreements made with an

individual vendor, a group of vendors, or all vendors, as well as agreements covering single products or an entire group of items.

When you add an item to a document, the system will compare the value that you enter in the Quantity field on a line against the

minimum quantities set for the associated vendor in the relevant price lists to calculate the best purchase price and discount

available.

In short, the standard app calculates prices and discounts separately on each line of a document. Sometimes, however, you might

need to enter one and the same item on multiple lines, for example, because products must be delivered in batches on different

dates.

For this reason, standard functionality has been extended so that prices and discounts can now be determined based on the total

quantity entered for an item on all lines of a document. For a line to be included in the total, however, the values in the following

fields must also match those on the other lines:

Type and No.

Variant Code (depending on whether you turned on the relevant toggle in Purchases & Payables Setup or on the item card)

Unit of Measure Code and Qty. per Unit

A blank alternative line

Allow Line Disc. and Allow Invoice Disc.

• 

• 

1. 

2. 

3. 

Field Description

Code Specify a meaningful abbreviation for the group.

Description Specify a description for the group.

Sales Turn on this toggle if the group should be used in sales.

Purchases Turn on this toggle if the group should be used in purchasing.

• 

• 

• 

• 

• 
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You can also have the system calculate unit costs independent of variants (that is, a quantity is calculated without considering

any variant).

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

Turn on the No Variant Block Prices toggle.

To change the global setting for individual items, open an item card and in the No Variant Block Prices (Purchases) field, choose

one of the options described in the following table.

You cannot maintain variant-specific prices if you want to use this feature.

Lines on which the following fields aren’t blank will not be included under any circumstances:

Receipt No. or Return Shipment No. (concerns invoice or credit memo lines created from a blanket purchase order)

Blanket Order No. (concerns order lines that refer to a blanket order line)

Alternate

To calculate block prices:

Open a purchase document.

On the ribbon, choose Update Block Pricing. Block prices are then calculated when you release the document.

If you manually change the Direct Unit Cost or Line Discount % field on the line of a document, the system will update neither

value when you run the function, and the line will not become part of the quantity for calculation.

The same is true for document lines related to blanket order or alternate lines and when you invoice posted receipts or returns.

This feature is only available if you selected KUMAVISION Lowest Price in the Pricing Method field in Purchases & Payables Setup.

Close prices or discounts

The system retrieves direct unit costs and line discounts from price lists based on the starting and ending dates entered for

them.

KUMAVISION base (BOOSTER) always uses the most recent direct unit cost or discount for an item or item group provided all

other factors with an impact on purchases remain the same.

1. 

2. 

3. 

Option Description

Default Applies the Yes or No option (see below) to the item depending on whether you turned the No Variant

Block Prices toggle in Purchases & Payables Setup on or off.

Note

As the global setting is inherited to the item, this option is always set initially.

No Block prices are calculated according to the quantities and prices on all lines referring to the same

purchase document, item, and variant.

Yes Block price quantities are determined based on item numbers, independent of variants.

Note

• 

• 

• 

1. 

2. 

Note
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However, you can also have an ending date assigned automatically when you create another price or discount for which you

enter a later starting date. This might make it easier for users to understand changes in prices and discounts. To have a date

assigned automatically:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the Prices FastTab, turn on the Close Prices and Discounts toggle.

If you then enter a cost or discount for the same item-price or item-discount combination but enter a later starting date, the

system will fill in the Ending Date field for the previously valid entry with a date set to one day before the new starting date.

A price or discount can only be closed if the entry replacing it doesn’t have an ending date.

Best price calculations

Microsoft Dynamics 365 Business Central1 will always calculate the best price on purchase documents. In this context, the best

price is the lowest unit price with the highest line discount allowed on a given date.

Purchase prices and discounts are entered on price lists independently from each other. This means that a purchase line might

contain the lowest price of one price list line and the highest discount of another.

Certain suppliers, however, are typically charged prices slightly above those calculated by the system. For this reason, you can

now turn off the best price option for everyone or only certain suppliers.

Turning off the feature corresponds to hierarchical pricing.

General setup

To change the pricing rules:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the Prices FastTab, in the Price Calculation Method field, select if and to what extent the best price option should be used.

Vendor-specific setup

You can also specify a price calculation method for a vendor by filling in the Price Calculation Method field on the relevant

vendor card. The option you select then replaces the setting you made in Purchases & Payables Setup.

With the No Best Price toggle for a vendor turned on, the system will always use a price that is specific to the vendor, even if that

price is higher than the standard price. The pricing method is also copied automatically to the Invoice Details FastTab on each

document created for this vendor.

The correct calculation method is determined in the following order of priority:

Manual setting on the purchase document

Vendor card

Vendor price group

Purchases & Payables Setup

1. 

2. 

Note

1. 

2. 

Option Description

Lowest Price The Microsoft Dynamics 365 Business Central1 standard pricing should always be used.

KUMAVISION

base

Lowest price

If the best price for an item is calculated will depend on whether you’ve turned on the Best Price toggle

on the relevant supplier card.

KUMAVISION

base

Price Sequences

Best price calculation should not take place at all.

1. 

2. 

3. 

4. 
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Pricing behavior

To account for a variety of item quantities, vendors, and vendor groups, you can enter different (but equally valid) prices for an

item. If the best price calculation is used, the system then retrieves these price records to find the lowest possible price at which

the item can be sold.

Pricing date

The date used to calculate prices on quotes, orders, and return orders is the order date. On credit memos and invoices, it’s the

posting date.

Price sequences

With the Best Price toggle turned off, the system will retrieve a price based on the following field values, each listed in order of

priority:

Hierarchy Level

The lowest hierarchical level of a creditor has priority over the next higher level. This only comes into play when working with

creditor hierarchies, e.g. within the framework of association structures.

Purchase Type

Campaign, Vendor, Vendor Price Group, All Vendors

Purchase Order Type

[filled in], [not filled in]

Type

Item, Item Price Group

Variant Code

[code specified], [no variant]. The value in this field, however, is only relevant if you’re working with variant codes in the system.

Unit of Measure Code

[filled in], [not filled in]

Currency Code

[code], [no code]. The value in this field, however, is only relevant if the vendor uses a foreign currency.

Responsibility Center Code

[filled in], [not filled in]

Minimum Quantity

Starting Date

[newest], [older], [not filled in]

When you enter a campaign created for a vendor on a purchase document, the vendor's other (active) campaigns will be

disregarded. The prices specified for this campaign have a higher priority than all other types of prices.

If no campaign is specified, every campaign linked to the vendor or contact will be included in the price calculation (when a

hierarchy is available: if it was created for the main vendor in a hierarchy).

Initially, the best price is determined only for the vendor whom you entered on the document. If the vendor is linked to another

vendor in a hierarchy, the latter will be ignored by the system for the time being.

However, if no valid price is found for the vendor, the system will search the next level of the hierarchy. You’ll see an error

message if the vendor has been linked to multiple other vendors on the same level.

The number of hierarchy levels can be unlimited. If no valid price can be found for the vendor on any level, the system will go

through the available vendor price groups based on the same logic. Within a group, a price for an item variant has a higher

priority than a general price for an item—provided the purchase and item type match.

The same check is later repeated for currencies. In this context, a price with a currency is prioritized over prices for which no

currency has been set up.

As for the minimum quantity, the highest quantity threshold within the validity period will be used to retrieve the price.

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 
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Lastly, the system will check the starting date, with a more recent price given a higher priority than older entries. Essentially,

only prices available on the order date can be retrieved.

Discount calculations

Discounts are determined in the exact same way as prices. Purchase prices and discounts are entered on price lists

independently from each other. This means that a sales line might contain the lowest price of one price list line and the highest

discount of another.

Pricing by responsibility center

In addition to standard functionality, you can now also assign prices and line discounts to different responsibility centers.

To be able to use this feature, you only need to fill in the Responsibility Center field for a unit price or line discount record.

Move prices to another price list

You can now move purchase price lines from one price list to another, for example, to a list that you’ve set up for the sole purpose

of storing historic prices.

Open a purchase price list.

Go to the Lines FastTab and select the prices that you want to transfer.

On the ribbon, choose Move Lines.

This opens the Select Price List window, where you can set filters to limit the number of lists that are displayed on the page.

Choose a list, and then choose OK.

Afterward, the selected price lines are both copied to the new list and deleted from the old one.

This feature is also available for price lines created in sales.

Pricing by responsibility center

In addition to standard functionality, you can now also assign purchase prices and line discounts to different responsibility

centers.

To be able to use this feature, you only need to fill in the Responsibility Center field for a unit cost or line discount field on a price

list.

Document pricing by buy-from (not pay-to) vendor

Standard functionality calculates prices on a purchase document by using the pay-to vendor entered on it.

This might cause difficulties when invoices are sent to your association, as you might have agreed on a different set of prices

with your supplier (=buy-from vendor).

With the new feature, you can now decide which vendor you want to run the pricing functionality for.

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

In the Pricing Vendor field, choose one of the options described in the following table.

If you choose the second or third option, you can change the setting again on the relevant vendor card.

1. 

2. 

3. 

4. 

5. 

Note

1. 

2. 

Option Description

Default Standard functionality will be used.

Buy-from Prices and price information (=vendor price groups) will be retrieved from buy-from vendors.

Pay-to Prices and price information (=vendor price groups) will be retrieved from pay-to vendors.
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Keep worksheet prices

When data is copied from a requisition or planning worksheet to a purchase order, the standard app rechecks the order date on

the document, which will also refresh the prices stored on it. To prevent this from happening:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION FastTab, in the Update Price when Copied from Req. Wksh., select No Repricing.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

1. 

2. 

1. 
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Manufacturing

The following features expand standard Microsoft Dynamics 365 Business Central[^1] functionality to provide additional options

to those working in your organization’s production department.

COMPLIANCE WITH 21 CFR PART 11 / GAMP5

In manufacturing, more than one employee might be logged on to the same work center when a product is reported as finished.

To fulfil 21 CFR Part 11, production journals need to contain an identifier (an electronic signature) to show who reported item

consumption or completion.

Setup

Extended Manufacturing Setup

Before you can decide who will report on production progress, you must turn on the digital signature feature:

Choose the Search icon, enter Extended Manufacturing Setup, and then choose the related link.

On the General tab, turn on the Check Digital Signature toggle.

Manufacturing User Setup

To specify who can post to manufacturing and store their digital signatures:

Choose the Search icon, enter Manufacturing User Setup, and then choose the related link.

Choose New on the ribbon.

Assign access to posting based on the following criteria:

a) If individual login credentials are assigned to everyone, fill in the User ID field but leave the Resource No. field blank.

b) If one ID is assigned to each work center (so that more than one person can post at a station), group the relevant resources by

ID.

c) If output can be reported on any work center, enter an authorized resource in the Resource No. field but leave the ID field blank.

Fill in the rest of the fields as described in the following table.

Post production journals

Provided the Digital Signature feature is turned on in Extended Manufacturing Setup, the system will ask for a signature when a

production journal is posted.

If multiple resources are assigned to the same work center, the resource authorized to post to manufacturing must be specified in a

Resource No. field in Manufacturing User Setup.

1. 

2. 

1. 

2. 

3. 

4. 

Field Description

Digital Signature Specify the person’s digital signature.

Signature Blocked Turn on the toggle if you want to block this signature from being used.

Signature Fail Count Shows the number of times the wrong signature was entered.

Following three failed attempts, the Signature Blocked toggle turns on automatically. The reason for

blocking the sign-off is then shown in the Signature Blocking Reason field.

Signature Blocking

Reason

Shows why the signature was blocked.

Reset Signature With the toggle turned on, the signature needs to be updated before it can be used again.

Note
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ID and resource log

During the posting process, the user ID and the resource number of the person who entered a digital signature is stored with the

item or capacity entry posted so that you can see who created a certain entry.

PRODUCTION ORDER COCKPIT

Two fields have been added to the list and to the cards of released production orders to indicate in percent and through a traffic

light system the progress of the following production order values:

Material consumption

Capacity consumption

Completion (output status)

Other new fields show the progress of outsourced tasks:

% Subcontracted

Indicates in percent—for each subcontracted operation—the total of Outstanding Qty. (Base) field values from related purchase

lines and the Quantity (Base) values from posted receipt lines. These values, which represent all operations, are then divided

by the input quantities entered for the order before being divided by 100. The Subcontracted field, written without the percent

sign, indicates by color the degree to which work on the production order has been outsourced to other companies.

% Subcontrd. Output

Indicates in percent—for each subcontracted operation—the total of output values as stored in the associated capacity entries.

These values, which represent all operations, are then divided by the input quantities entered for the order before being

divided by 100. The Subcontrd. Output field, without the percent sign, indicates by color how much subcontracted work has

been reported as finished.

For performance reasons, the cockpit entries aren’t updated automatically after each change made to an order. You can choose Home

> Update Cockpit on the Released Production Orders ribbon to refresh the data for the selected production order or all orders at

once.

NAVIGATE PRODUCTION BOMS AND ROUTINGS

This feature gives you direct access to the production bill of materials and the routing from an item card, making it easier to find

production base data.

Component BOMs now also show the BOM and the routing stored for an item, and you can navigate further from there.

Day-to-day production management and work preparations often require that users can go directly from the item card to, for

example, the Production BOM and the Routing pages.

However, to see a BOM version in the system, for example, you typically need to open the relevant item and go from there to the

production BOM list before you can open the versions page from that list. The goal of the new feature is thus to provide a faster,

one-click experience when looking for manufacturing-related information.

Assist button

To see production data, just use the Assist button next to a production field:

On the item card, to see the production BOM and the routing, as well as their versions, use the button next to Production BOM

or Routing.

On production BOM lines, to see the related BOM, select the button next to the Production BOM field.

The Assist button feature available in KUMAVISION factory365 provides even more options. For details, click here.

• 

• 

• 

• 

• 

Note

• 

• 

Note
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Create production data

If the production BOM and routing fields on an item card are empty, you can also use the Assist button to create and link the

base data of manufacturing with assembly items.

Open an item card.

On the Purchasing FastTab, select the Assist button next to the Production BOM No. field.

You’re asked if you want to set up a new BOM. Choose Yes to open the production BOM for editing and certification.

CHECK SHORTAGE PRIOR TO RELEASE

Another new feature adds a missing parts list to production orders. Called a shortage list, it contains all components that aren’t

available at present.

You can open the list manually from a production order by choosing Shortage List on the ribbon, but it will also open on its own

when an order is checked for shortages prior to release.

Setup

You need to turn on the feature before you can use it.

Choose the Search icon, enter Manufacturing Setup, and then choose the related link.

On the General tab, choose an option in the Shortage Release Check field to specify whether to show the shortage list—and,

potentially, a warning message—when a production order is released.

Regardless of what option you choose, the list will include the fields described in the following table.

PRODUCTION STRUCTURE LISTS

A production structure is a partly of fully exploded BOM that shows, along with routings, the data used to manufacture a certain

item. All lower-level BOMs for components can also be exploded in this view.

1. 

2. 

3. 

1. 

2. 

Field Description

Type Specifies the type of component (item) that is not available.

No. Specifies the number of the component item.

Due Date Specifies when the production item must be completed.

Description Specifies the description of the component item.

Quantity per Specifies the component quantity that is not available for completing the production item.

Unit of Measure

Code

Specifies the unit used for the component item (the typical unit for these items is Piece).

Flushing Method Specifies the method used to record the consumption of the component item in manufacturing.

Expected Quantity Specifies the estimated demand for the component item in manufacturing.

Remaining Quantity Shows the result of subtracting the expected from the output quantity.

Projected Available

Balance

Specifies how many component items (with the same variant and location code) are available prior to

the due date entered on the line, considering all positive and negative adjustments made during that

period.

Available Inventory Specifies the number of component items in inventory.

Substitution

Available

Specifies if an item substitute is available for the component.
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To see a detailed breakdown of how an item is produced:

Choose the Search icon, enter Production Structures List, and then choose the related link.

Select an item in the Item Filter field. This will fill in both the Prod. BOM Filter field with the BOM stored for this item and the

Routing Filter field with the routing number linked to the item.

The Prod. BOM Version Filter shows the BOM version that is active on the date values are calculated, whereas the Routing Version

Filter field displays the active routing version.

The Calculation Date field initially shows the date specified for the routing.

If—in addition to BOM components—you also want to see operations on the page, turn on the Show Routings toggle.

You can then run the Calculate function from the ribbon to show all first-level components and operations (=Level field contains

the number 1) on the lines.

Afterward, you can expand or collapse the structure by using the arrows next to Level fields. To show every part of the structure,

choose the double arrows.

To see the card, BOM, or routing of the item originally used for the production structure, go to the ribbon, choose Related >

Production Structure, and select the option you want.

To see the same information about an item stored within the structure, that is, on a line, select a line before choosing Related >

Line and the option you want on the ribbon.

To see the structure for a different calculation date than the working date:

In the Calculation Date field, choose the date for which you want to display the structure. After you’ve specified a date, the system

will search for BOM and routing versions active on that date and fill in the Prod. BOM Version Filter and the Routing Version Filter.

Choose Calculate on the ribbon.

To calculate a BOM version that isn’t active on a certain calculation date, you need to change the Prod. BOM Version Filter

manually. The new date will only affect the validity of individual components (within starting and ending dates).

You can also see the structure of production BOMs that aren’t assigned to any item. These are known as phantom BOMs.

On the Production Structures List page, enter a number in the Prod. BOM Filter field so that the system can start searching for a

BOM version active on the calculation date.

Note

If you calculate a phantom BOM without an item number, routings cannot be shown. 

Choose Calculate on the ribbon.

PRODUCTION ORDER STRUCTURES

With the help of a production order structure, you can explode all components of a production order in a single view across all

levels (provided that the order has more than one level).

Choose the Search icon, enter Production Structures List (Prod. Order), and then choose the related link.

In the Prod. Order Status Filter and Prod. Order No. Filter fields, select the status and the number of the order that you want to

show.

If—in addition to BOM components—you also want to see operations on the page, turn on the Show Routings toggle.

Choose Calculate on the ribbon.

The actions on the ribbon of the page provide the same functionality as on the Production Structures List page.

CANCEL A PRODUCTION ORDER RELEASE

In the standard system, a production order cannot be completed when you’ve already posted, for example, consumption or

resource hours to it but have yet to specify actual output (that is, a warehouse receipt).

Thanks to a new feature, you can now cancel these orders and set their status to Finished.

1. 

2. 

3. 

4. 

5. 

1. 

2. 

1. 

2. 

1. 

2. 

3. 

4. 
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Requirements

For the cancellation feature to work, the following conditions need to be met:

In User Setup, on the KUMAVISION FastTab, the Can Cancel Prod. Order toggle must be turned on for users who require the

function.

If output, that is, receipts, have already been posted, they must first be cancelled in the Output Journal.

If consumption postings have already been canceled, the system will check whether the cancelled amounts match those

originally consumed. If the amounts don’t match, the feature can’t be used.

Instead—as in the standard app—manual intervention is required to cancel transfers tied to production and set the order to

Finished.

Cancel a release

If the stated conditions are met, the production order is cancelled per line via consumption and capacity postings. All postings

will be made on the working date.

Consumption postings

Remaining material quantities are reversed through application of the related consumption entries. Therefore, one reversal is

posted per entry.

Any dimension value is copied from its original consumption entry.

Output (capacities)

For each routing and operation number, the system will total the output and scrap quantities posted, the setup and run times,

the downtime, and the direct and overhead costs.

The direct cost is calculated per cancelled posting based on total times (setup times, run times, and downtime), as they’re

reversed with each posting.

If a finished or semi-finished product entered on an order line isn’t valuated according to the standard method, the overhead

(Indirect Cost %) is weighted and posted based on total overhead.

Any dimension value is copied from its original capacity entry.

Complete a production order

After the consumption and output postings have been reversed on each line, the production order is set to Finished with the help

of standard functionality.

Using standard functionality to change the status of a production order to Finished could very well still allow ‘retroactive’ postings,

such as those for operation-related setup times.

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note
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Warehouse Management

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s logistics department.

MAKE COPIES OF SHIPPING NOTES

By using standard app functionality, you can specify a set number of invoice copies that are printed when you post an invoice

sent to a customer.

A new feature lets you do the same for shipping notes so that, for example, as a wholesaler, you can respond to forwarders’

requests for a certain number of copies that they need to supply to international clients.

Each copy is printed automatically when a shipping note is posted. To specify the number of copies:

Choose the Search icon, enter Customers, and then choose the related link.

Open a customer card.

On the General FastTab, fill in the No. of Shpt. Copies field.

SHOW QUANTITIES IN ITEM STATISTICS

The statistics page you can open from item cards in Microsoft Dynamics 365 Business Central1 provides multiple ways in which

to list currency amounts for a specific item. None of these views, however, contain item-related quantities. Therefore, a Quantity

option has been added to the page.

To see quantities in statistics:

Choose the Search icon, enter Items, and then choose the related link.

Open an item card.

Choose Related > Statistics > Item Statistics.

Select Quantity in the Show as Lines field and fill in the other fields as necessary.

Choose Show Matrix on the ribbon.

You can then see the following quantity totals for each item ledger entry type:

Positive Adjmt. (Qty.)

Purchases (Qty.)

Output (Qty.)

Assembly Output (Qty.)

Quantity Increase

Sales (Qty.)

Consumption (Qty.)

Assembly Consumption (Qty.)

Quantity Decrease

Transfer (Qty.)

All quantities except those related to item ledger entries of the Transfer type are shown as positive values. You can drill down on

a field to see all the item ledger entries totaled for a certain type.

IDENTIFY RECEIPTS BY SUPPLIER

When retrieving source document lines for warehouse receipts, you can now see the external reference numbers stored on the

document lines in addition to item numbers. This way, you can filter for a supplier’s item reference when creating documents for

warehouse receipts.

1. 

2. 

3. 

1. 

2. 

3. 

4. 

5. 
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MANAGE NEGATIVE INVENTORY BY LOCATION

By using standard system functionality, you can prevent negative inventory at every location of your company. However, some

locations might need to make use of the option of posting into the negative.

A field has been added to the location card so that you can decide individually for each location how posting negative

adjustments should be handled.

Choose the Search icon, enter Locations, and then choose the related link.

Select a location card.

On the General FastTab, fill in the Prevent Negative Inventory field.

If you didn’t turn on the Prevent Negative Inventory toggle in Inventory Setup, the field on location cards shows the following

options:

Default (No)

No

Yes

However, if you turned on the toggle in Inventory Setup, the options are:

Default (Yes)

No

Yes

In other words, the default setting at a location depends on whether you’ve turned the toggle in Inventory Setup on or off.

What default option is set in item masters, that is, a Default (Yes) or a Default (No), always depends on whether you turned on the

Prevent Negative Inventory toggle in Inventory Setup.

When you’re trying to post a negative adjustment, the system goes through the following sequence to decide whether to perform

or prevent the posting:

What option is set on the item card?

What option is set for the location?

Has the toggle been turned on in Inventory Setup?

SUPPLY CERTIFICATES OF CONFORMITY

You can now also store conformance certificates for lots and provide them to customers if necessary.

Setup

Extended Manufacturing Setup

To be able to use this feature, you need to specify a number series for certificates. To set up a series:

Choose the Search icon, enter Extended Manufacturing Setup, and then choose the related link.

On the General FastTab, select a series in the Conformance Certificate Nos. field. Alternatively, to create a new series, select the

button next to the field and then choose New.

1. 

2. 

3. 
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Manage a certificate

To manage certificates:

Choose the Search icon, enter Conformance Certificate List, and then choose the related link.

On the ribbon, choose New to create a certificate or choose Manage > View or Edit after selecting an existing one.

If you choose New, the No. field will be filled in with a number from the series that you set up for this purpose. You can also assign

a number manually.

Optionally, fill in the Description and Certificate No. fields based on what you see written on the certificate. The other fields on the

General FastTab will be filled in by the system after you’ve run the Import function.

Choose Import on the ribbon to select the file that contains the certificate.

You can then choose Get Lots from Purch. Receipts, Get Lots from Lot No. Info, or Get Lots from ILEs on the ribbon to assign the

certificate to a lot.

The other actions available on the ribbon are described in the following table.

Lot No. Information card

This card shows in the Conformance Certificate No. field the number of a certificate of conformity. You can use the Assist button

next to the field to open the card of the certificate itself.

POST TRANSFERS AUTOMATICALLY

Another new feature is that you can have the receipt of transfer orders posted at the same time as their shipment. This can be

useful, for example, when you have no staff member who could confirm receipt at the destination.

You can use standard or KUMAVISION functionality for direct transfer orders, the difference being that when you choose the

default option, you cannot ship or receive only part of an order.

With the KUMAVISION option, on the other hand, the system also posts partial receipts and shipments. To set up the feature:

Choose the Search icon, enter Inventory Setup, and then choose the related link.

On the Numbering FastTab, in the Direct Transfer Setup field, select the option you want to use (Microsoft Direct Transfer or

KUMAVISION base Direct Transfer).

In the Direct Transfer Posting field, select Direct Transfer for standard functionality. For the KUMAVISION base extension, select

Receipt and Shipment.

However, for the KUMAVISION base function to work, you must also turn on the feature for a location:

Open a location card.

On the General FastTab, turn on the Auto Post Transfers toggle.

The toggle is then set automatically on transfer orders to which this location is assigned.

1. 

2. 

3. 

4. 

5. 

Function Description

Export Saves the image file displayed on the header.

Open Shows the image file displayed on the header.

Delete Deletes the image file displayed on the header.

1. 

2. 

3. 

1. 
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GET SOURCE DOCUMENT LINES

In Microsoft Dynamics 365 Business Central1, you can use the Get Source Documents function to retrieve source data for the

following inventory and warehouse documents:

Inventory Put-Away

Inventory Pick

Whse. Receipt

Whse. Ship

All lines that still need to be received or shipped are then copied there. Lines that aren’t required must be deleted manually. The

new Get Source Document Lines function extends standard functionality to include filter options for the lines of source

documents. Grouped by type of document, the lines can then be filtered, for example, by item numbers so that only part of a

document is retrieved.

POST DURING INVENTORY COUNTS

Standard functionality allows you to post to locations even during physical inventory counts. To prevent this, you can now specify

that items can only be posted to other locations or not all during stocktaking.

Choose the Tell Me function, enter Inventory Setup, and then choose the related link.

Turn the Allow Posting of Items in Physical Inventory on or off.

Deactivating the toggle means you cannot post any item that is currently stored in a physical inventory journal or on an inventory

order. Items that aren’t can be used for posting, however.

Activate the toggle if you want to allow items to be posted to other locations. As an example, you might need to take stock in

Warehouse 1 but want to continue working in Warehouse 2.

GET BLOCKED ITEMS OR VARIANTS

Typically, blocked items or item variants cannot be used in physical inventory journals.

This means that they aren’t copied to a journal, for example, when you run the Calculate Inventory action from it, and you cannot

enter them manually on the lines either. You also aren’t notified whether some are still in inventory despite being blocked.

In KUMAVISION base (Booster), you can use a ribbon function to specify items that would typically be unavailable but must be

included in a count temporarily:

Open a physical inventory journal.

On the ribbon, choose Get Blocked Items/Variants.

On the page that opens, you can select the items you want to unblock, and then choose Unblock Items/Variants to include them in a

count.

Afterward, the items or variants remain unblocked on the page until you select them again and choose Block Items/Variants.

Rerunning the function clears the current page, however. This means that any items that you didn’t re-block before exiting the page

will remain available in the system.

• 

• 

• 

• 
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The lines on the page contain the fields described in the following table. You cannot change any of them manually.

We recommend that you first use the Get Blocked Items/Variants action to fill in the page, then select the lines that you want to

unblock and run the Unblock Items/Variants function from the ribbon.

Afterward, you can add the lines to the relevant journal manually (or choose Calculate Inventory on the ribbon) before

completing the count and running the Block Items/Variants function to block the items again.

To be able to use unblocked items or variants on sales or purchase documents, the Sales or Purchasing Blocked toggle must also be

turned off on the associated item or variant cards.

INVENTORY

Overview

The Inventory Summary page provides you with a comprehensive overview of what inventories you have and what tracking

information is available for them.

This means that the summary includes all items and item variants, as well as their tracking codes in the form of lot, serial, and

package numbers, sorted by location, zone, and bin. Quantities are shown in the relevant item’s base unit of measure and, if

you’re using advanced warehouse functionality, put-away unit.

Field Description

Journal Template

Name

Specifies the name of the journal template that the line is associated with.

This field is relevant only to users working with multiple physical inventory journals at once.

Journal Batch Name Specifies the name of the journal that the line is associated with.

This field is relevant only to users working with multiple physical inventory journals at once.

Line No. Specifies the number of the line, in steps of 100.

Item No. Specifies the number of the blocked item.

Variant Code If available, specifies the item variant that is blocked.

Blocked By Specifies if the item or variant was blocked because of a failed field check or because a user did so

manually.

Blocked (User) If the item or variant was blocked by a user, specifies the ID of the person who blocked it.

Item Jnl. Variant

Block

Specifies if the item variant is blocked in an item journal.

Unblocked (Temp.) Specifies if the line was unblocked by using the Unblock Items/Variants function.

With the field selected, the item or variant shown on the line can be manually entered in a physical

inventory journal or be filled in by running the Calculate Inventory action.

Unblocked (Temp.)

At/On

Specifies when the Unblock Items/Variants function was run.

Unblocked (Temp.)

By

Specifies who ran the Unblock Items/Variants function.

Created On Specifies when the Get Blocked Items/Variants function was run.

Created By Specifies who ran the Get Blocked Items/Variants function.

Note
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For locations that don’t need bins, the quantity is shown per serial number if the SN Specific Tracking toggle is turned on for the

tracking code assigned to the item. For locations where bins are mandatory, inventory is shown by serial numbers if the SN

Warehouse Tracking toggle is activated instead.

The same applies to lot and package numbers and their toggles.

Setup

To turn on the feature:

Choose the Search icon, enter Inventory Setup, and then choose the related link.

Fill in the fields on the Inventory Summary FastTab as described in the following table.

Inventory summary

To see the items your business currently has in stock, choose the Search icon, enter Inventory Summary, and then choose the

related link. The values you see on the page are described in the following table.

Note

1. 

2. 

Field Description

Auto Create Inventory

Summary

Turn on this toggle if you want the overview to be kept up to date by the system. When the

toggle is turned on, an initial summary is created based on all inventory movements that have

already been posted.

You can turn the toggle off again if you notice that the real-time updates are slowing down the

app. You can then still update the overview, albeit manually, by using the Refresh Summary

action.

Include Adjustment Bins

in Summary

Turn on this toggle if you want the summary to also display all quantities entered in adjustment

bins (see the Adjustment Bin Code field on the relevant location card).

Include Negative

Inventory in Summary

Turn on this option if you want the summary to also show any negative inventory quantity that

might exist.
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You might need to use the Personalize function to unhide some of the fields that will be described in this table.

Note
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Field Description

Entry No. Shows the unique number of the entry, assigned from a number series when the entry was created.

Location Code Specifies the location that inventory is shown for.

Zone Code Specifies the zone that inventory is shown for.

Bin Code Specifies the bin that inventory is shown for.

Item No. Shows the number of the item specified on the line.

Variant Code Shows the code of the item variant specified on the line.

Lot No. Shows a lot number if one is specified for the posted item.

Serial No. Shows a serial number if one is specified for the posted item.

Package No. Shows a package number if one is specified for the posted item.

Description Specifies the description of the item.

Description 2 If available, specifies the additional description of the item.

Quantity In advanced warehousing configurations, specifies the item quantity in the put-away unit of

measure.

In all other configurations, specifies the quantity in the item’s base unit of measure.

Unit of Measure

Code

In advanced warehousing configurations, shows the put-away unit of measure assigned to the item.

In all other configurations, specifies the item’s base unit of measure.

Qty. per Unit of

Measure

Specifies the inventory quantity in the item’s base unit of measure in relation to its put-away unit.

Quantity (Base) Specifies the item quantity in the base unit of measure.

Item Blocked If selected, specifies that transactions with the item cannot be posted, for example, because it is in

quarantine.

Mvmt. Blocked (Bin) Specifies if the associated bin does not allow outbound or inbound transfers, or both.

Mvmt. Blocked (Bin

Content)

Indicates if the associated bin content cannot be used in inbound or outbound transfers, or both.

Inventory Blocked Specifies whether transactions with this inventory can be posted.

The field is only selected if:

• Item Blocked is selected.

• Bin Blocked is set to Outbound or All.

• Mvmt. Blocked (Bin) is set to Outbound or All.

• Iten Trkg. Blocked is selected.

Item Trkg. Blocked If selected, at least one of the tracking information cards associated with the inventory (that is, the

Lot No. Information Card, Package No. Information Card, or Serial No. Information Card) is

blocked.

Dedicated If selected, specifies that the inventory in the associated bin cannot be picked to meet demand from

orders elsewhere.

Bin Ranking Shows the priority of the associated bin.

Bin Mandatory Indicates if the Bin Mandatory toggle is turned on for the location at which the item is stored.

Lot Specific Tracking
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Ribbon functions

None of these actions can be run if you select multiple records at once.

For base data and on documents

Field Description

Indicates if the Lot Specific Tracking toggle is turned on for the item on the associated Item

Tracking Code Card.

Lot Warehouse

Tracking

Indicates if the Lot Warehouse Tracking toggle is turned on for the item on the associated Item

Tracking Code Card.

SN Specific Tracking Indicates if the SN Specific Tracking toggle is turned on for the item on the associated Item

Tracking Code Card.

SN Warehouse

Tracking

Indicates if the SN Warehouse Tracking toggle is turned on for the item on the associated Item

Tracking Code Card.

Package Specific

Tracking

Indicates if the Package Specific Tracking toggle is turned on for the item on the associated Item

Tracking Code Card.

Package Warehouse

Tracking

Indicates if the Package Warehouse Tracking toggle is turned on for the item on the associated Item

Tracking Code Card.

Function Description

Item Card Opens the item card associated with the selected record.

Variant Card Opens the variant summary, filtered to the item number and variant code that is entered on the

selected record.

Note

This ribbon action is only shown if a variant code is assigned to the record.

Lot Information Card Opens the lot number information card that is linked to the selected record.

Note

This ribbon action is only available if a lot number is assigned to the record. You see an empty page

if no card exists.

Serial No. Info Card Opens the serial number information card linked to the selected record.

Note

This ribbon action is only available if a serial number is assigned to the record. You see an empty

page if no card exists.

Package No. Info

Card

Opens the package number information card linked to the selected record.

Note

This ribbon action is only available if a serial number is assigned to the record. You see an empty

page if no card exists.

Bin Opens the bin summary, filtered to the location and bin code that is entered on the selected record.

Note

This ribbon action is only shown if a bin is assigned to the record.

Note
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You can also see a filtered summary of available inventory by running the Inventory Summary action from the following pages:
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Run from Summary filtered to

Items Item number

Item Card Item number

Item Variants Item variant

Item Variant Card Item variant

Stockkeeping Units Item number, variant code, and location

Stockkeeping Unit Card Item number, variant code, and location

Lot No. Information List Item number, variant code, and lot number

Lot No. Information Card Item number, variant code, and lot number

Serial No. Information List Item number, variant code, and serial number

Serial No. Information Card Item number, variant code, and serial number

Package No. Information List Item number, variant code, and package number

Package No. Information Card Item number, variant code, and package number

Bins Location code, zone code, and bin code

Bin Content/Bin Contents Location code, zone code, bin code, item number, variant code, and unit of

measure code

(the exact filters depend on the page that the action is run from)

Purchase Order (Lines FastTab) Location code, item number, and variant code (as entered on the line)

Note

Here, the action can only be run for lines of type Item.

Sales Order (Lines FastTab) Location code, item number, and variant code (as entered on the line)

Note

Here, the action can only be run for lines of type Item.

Transfer Order (Lines FastTab) Outbound location (Transfer-from Code), item number, and variant code (as

entered on the line)

Released Production Order (Lines

FastTab)

Item number, variant code, location code, and bin code (as entered on the line)

Production Order Components Item number, variant code, location code, and bin code (as entered on the line)

Assembly Order (Lines FastTab) Item number, variant code, location code, and bin code (as entered on the line)

Warehouse Receipt (Lines FastTab) Item number, variant code, location code, and bin code (as entered on the line)

Warehouse Shipment (Lines FastTab) Item number, variant code, location code, and bin code (as entered on the line)

Internal Movement (Lines FastTab) Item number, variant code, location code, and From Bin Code (as entered on the

line).

Warehouse Put-away (Lines FastTab) Item number, variant code, location code, and bin code (as entered on the line)

Warehouse Pick (Lines FastTab) Item number, variant code, location code, and bin code (as entered on the line)

Inventory Movements (Lines FastTab) Item number, variant code, location code, and bin code (as entered on the line)

Warehouse Movements (Lines

FastTab)

Item number, variant code, location code, and bin code (as entered on the line)
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Run from Summary filtered to

Item Journals Item number, variant code, location code, and bin code

Item Reclassification Journals Item number, variant code, location code, and bin code

Physical Inventory Journals Item number, variant code, location code, and bin code

Warehouse Item Journal Item number, variant code, location code, and bin code

Warehouse Reclassification Journals Item number, variant code, and location code

Warehouse Physical Inventory Journal Item number, variant code, and location code

Warehouse Internal Put-away (Lines

FastTab)

Item number, variant code, location code, and From Bin Code (as entered on the

line).

Warehouse Internal Pick (Lines

FastTab)

Item number, variant code, and location code (as entered on the line).

Movement Worksheets Item number, variant code, location code, From Zone Code, and From Bin Code (as

entered on the line)

1. 
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Service

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s service department.

ALTERNATE QUOTE LINES

When you open the service item worksheet assigned to a service quote, you can specify for each document line whether the price

shown on it should be included in the total quote price.

A line where the Alternative field is set to Alternative, Optional, Selectable, or On Request then appears on printouts in a

different format and alongside the value you chose in that field so that you can make customers aware of their options for

customization.

REPAIR IN-HOUSE EQUIPMENT

Logs repairs and similar services for in-house machinery or other equipment in the system. To use this function:

Choose the Search icon, enter Service Management Setup, and then choose the related link.

Turn on the Internal Orders toggle on the KUMAVISION FastTab.

This ensures that service orders set up for a customer for whom the Internal checkbox is selected don’t create open entries. As a

result, these services are treated as not billable on invoices.

CONTROL SERVICE (ITEM) LINES ON DISPATCH ORDERS

Specifies whether you want service (item) lines included on dispatch orders, for example, to create package labels with tracking

codes.

Choose the Search icon, enter Service Management Setup, and then choose the related link.

Activate one or both fields described in the following table.

PAYMENT TERMS: SERVICE ORDER TYPES

You can assign payment terms to a service order type, to replace those stored in the customer master. To assign terms to an

order type:

Choose the Search icon, enter Service Order Types, and then choose the related link.

On the ribbon, choose New. Alternatively, choose Edit List to edit a type that already exists.

Fill in the Payment Terms Code field.

PROFORMA INVOICES

Some businesses, especially those exporting goods, need to provide shipping agents or customers with a proforma invoice prior

to delivery. The invoice can be printed from every serviceorder available in the system.

Basically, a proforma invoice looks like a confirmation receipt, the difference being that the extended texts printed on invoices

are also printed on proforma documents.

Setup

Service Management Setup

1. 

2. 

1. 

2. 

field description

Service Item Lines on Dispatch

Order

Turning on this toggle copies service item lines (that is, repaired items) to dispatch

orders.

Service Lines on Dispatch Order Turning on this toggle copies service lines (that is, a list of the spare parts consumed) to

dispatch orders.

1. 

2. 

3. 
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A proforma invoice typically requires an invoice number. To specify a number series for these kinds of documents:

Choose the Search icon, enter Service Management Setup, and then choose the related link.

On the General FastTab, turn on the Proforma Invoice Nos. toggle.

Report Selection – Service

You also need to set up the proforma invoice report on the Report Selection – Service page.

Print a proforma invoice

To print a proforma invoice:

Open a service order.

On the ribbon, choose Actions > Posting > Proforma Invoice.

The system then uses the series set up for invoices to assign a number to the proforma invoice, adding a P upfront. Despite the

added P, the number can no longer be used for posting a standard invoice later.

COPY SERVICE DATA

For repeated transactions, you can now use the Copy Document action that is part of standard sales and purchases functionality

on service documents.

You can copy both service items and the following documents by running the function from the relevant ribbon:

Service Quotes

Service Orders

Service Invoices

Service Credit Memos

Posted Service Shipments

Posted Service Invoices

Posted Service Credit Memos

The feature is currently not available for archived documents.

Like in sales, you can copy documents including selected document headers, or copy the lines and refresh the prices on them.

Service items are copied as part of base data by opening a service item card and choosing Copy Service Item on the ribbon. You

can transfer the following data in this way:

General item information

Components

Maintenance Plans

Resource skills

Comments

Warranty starting and ending dates

DROP SHIPMENTS AND SPECIAL ORDERS IN SERVICE

In the standard app, you cannot work with drop shipments or special orders in Service. But for on-site repairs especially, having

replacement items sent from a supplier directly to a customer can be a useful feature.

1. 

2. 
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To be able to work with drop shipments or special orders in service:

Open the Service Item Worksheet.

Select a line, and then select the Drop Shpt. Order or the Special Order field.

Alternatively, fill in the Purchasing Code field.

Repeat the process as necessary.

When you’ve changed the required lines, choose Actions > Plan > Drop Shipment or Special Order to create a purchase order or

open the document linked to them.

You might need to use the Personalize function to unhide the Drop Shipment, Special Order, or Purchasing Code field on the page.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Purchase Request

OVERVIEW

A purchase request (BANF in German) is made for items that aren’t linked to item masters. Examples are marketing materials

and work clothes.

Requests have their own release process that doesn’t involve standard item planning options, such as requisition worksheets.

Request lines can instead be filled with pseudo-items linked to G/L accounts.

A completed request can then be submitted to your company’s procurement department, where staff can create a purchase order

from it in the same way as from a requisition worksheet.

You need a separate license before you can use this functionality.

SETUP

Purchase Request Setup

To set up the functionality:

Choose the Search icon, enter Purchase Request Setup, and then choose the related link.

Fill in the fields as described in the following tables.

General

No. Series

Note

1. 

2. 

Field Comment

Purchase Order Type Specify the default type that will be assigned to purchase orders created from requests.

Department Code Specify Global Dimension Code 1.

In Microsoft Dynamics 365 Business Central1, this code typically refers to a department.

Customergroup Code Specify Global Dimension Code 2.

In Microsoft Dynamics 365 Business Central1, this code typically refers to a cost unit.

Field Comment

No. Series Specify the number series that will be used for requests.
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Email Notification

Email accounts

The Purchase Request functionality includes approval workflows during which people set up as approvers in the system will

receive email notifications about the progress of requests that they need to respond to.

The email account from which notifications should be sent can be a standard account used by your organization or one

specifically created for this purpose. To specify a separate account:

Choose the Search icon, enter Email Scenario Assignment, and then choose the related link.

Choose Assign Scenarios and select Purchase Request.

Fill in the fields as necessary.

Approval User Setup

You can now assign an approval administrator and request workflow codes. The approval administrator has all rights to purchase

request functions. Only a single user can be selected as the administrator.

Choose the Search icon, enter Approval User Setup, and then choose the related link.

Fill in the fields as described in the following table.

Field Comment

Email Notification Turn on this toggle if you want people working on requests to receive notifications about them

by email.

Declined Offers Select who will be notified should a request be declined, the person who approved it or everyone

involved in the process.

You can also leave the field blank if nobody should receive an email.

Extended Text for

Releases

Specify a message that will be included on emails notifying the relevant people of requests

released during an approval workflow.

Extended Text for

Rejections

Specify a message that will be included on emails notifying the relevant people of requests

rejected during an approval workflow.

Extended Text for

Orders

Specify a message that will be included on emails notifying the relevant people of requests

ordered during an approval workflow.

Reminder Interval Specify the interval after which people will be reminded that they still have purchase requests to

respond to.

1. 

2. 

3. 

1. 
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All users who work with purchase requests should have a workflow code entered on this page, as the code is needed to identify both

the approval process and individual approvers.

A workflow code that you enter on this page is automatically copied to a new request that involves the person assigned to the

code. This way, you can drill down on the Code field to set up a workflow before you make a request. For more information about

how to specify a workflow, see Workflows.

You will need to enter the code, at the latest, when you fill in the request itself. Else, the document cannot be submitted due to a

missing workflow. However, the requester can choose another code mid-process. This might be necessary if the approval

procedure or the cost center has changed.

Note

Field Description

User ID Select the ID of the user involved in the approval process.

Salespers./Purch. Code Specify the code of the salesperson or purchaser linked to the user.

Approver ID Select the ID of the user who must approve requests made by the person specified in the User

ID field.

Sales Amount Approval

Limit

Specify the maximum sales amount that the user entered in the Approver ID field can approve.

Unlimited Sales Approval Select this checkbox if the user entered in the Approver ID field can approve all kinds of

amounts in sales.

You cannot fill in a Sales Amount Approval Limit if this field is selected.

Purchase Amount

Approval Limit

Specify the maximum purchase amount the user entered in the Approver ID field can approve.

Unlimited Purchase

Approval

Select this checkbox if the user entered in the Approver ID field can approve all kinds of

amounts in purchasing.

You cannot fill in a Purchase Amount Approval Limit if this field is selected.

Request Amount

Approval Limit

Specify the maximum request amount that the user entered in the Approver ID field can

approve.

Unlimited Request

Approval

Select this checkbox if the user entered in the Approver ID field can approve purchase requests

regardless of amount.

You cannot fill in a Request Amount Approval Limit if this field is selected.

Substitute Specify a person that can assume the approver role if the original approver is not available.

E-Mail Enter an email address for each person involved in the approval process. You can also use

shared addresses.

Phone No. Enter the user’s phone number.

Approval Administrator Turn on the toggle if the user entered on this line is also the workflow administrator, who has

unrestricted access to the entire purchase request functionality.

Request Workflow Code Specify the code of the required approval process.
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Workflows

A workflow specifies the number and permissions of people or departments required for the approval process. To set up a

workflow:

Choose the Search icon, enter Approval Workflows, and then enter the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

You can then choose Approvers on the ribbon to add people to the workflow.

If you're using KUMAVISION project365, you can store an approval workflow on the Projects Setup page. For more information, click

here.

1. 

2. 

3. 

Field Description

Code Specify a code for the workflow.

Description Specify a meaningful description for the approval process.

No. of Approvers Shows the number of approvers required for the process.

Field Description

Approver ID Select the user who will be involved in the approval process.

Name Shows the name of the user specified in the Approver ID field.

Level Specify the order in which approvers will be notified or need to approve a document.

You can put more than one person on the same level. They are then notified at the same time.

Approval Amount

Limit

Fill in this field if the approver should only be notified when the requested amount exceeds a certain

limit during approval.

Can Edit Select this field if the approver should be able to edit requests.

Can Reject Select this field if the approver should be able to reject requests.

Notify if Fixed Asset Select this field if the approver should be notified that a fixed asset has been entered on a request

line.

Note
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PSEUDO ITEMS

You can create and manage any number of G/L account-linked pseudo items for use on purchase requests. To set up a pseudo

item:

Choose the Search icon, enter Pseudo Item List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

When you create a purchase request later, the lines of the request will be filled in with the information entered on this page.

Pseudo items cannot currently be used with project budgets created in KUMAVISION project365. For more information, click here.

Extended Texts

For each pseudo item, you can store extended texts that will be copied to the orders created from purchase requests. To store a

text:

Open a pseudo item card.

On the ribbon, choose Extended Texts.

1. 

2. 

3. 

Field Description

No. Specify the number that will be used for the item. 

You must fill in this field manually.

Description Specify the name of the item.

Description 2 Here you can enter a more detailed description of the item if necessary.

G/L Account Specify a G/L account that you want to link the item to.

You can only choose an account that can be used to post to purchasing (that is, an account for which

the Direct Purchasing field has been selected).

G/L Account

Description

Shows the description of the account linked to the item.

Vendor No. Specify the vendor of the item. 

You can only choose an existing vendor in this field.

Vendor Item No. Shows the number assigned to the item by the vendor.

Direct Unit Cost Here you can enter a per-unit price for the item.

Unit of Measure

Code

Specify the unit in which the item is purchased.

Department Code Specify Global Dimension Code 1.

In Microsoft Dynamics 365 Business Central1, this code typically refers to a department.

Customergroup

Code

Specify Global Dimension Code 2.

In Microsoft Dynamics 365 Business Central1, this code typically refers to a cost unit.

No. of Extended

Texts

Shows the number of text modules stored for the item.

Note

1. 

2. 
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For more information on the topic, see Create an Extended Text.

Purchase Prices

You can also maintain special purchase prices for pseudo items. To set up a price:

Open a pseudo item card.

On the ribbon, choose Prices.

Fill in the fields as necessary.

For example, you can enter a starting and an ending date for prices that you only want used within a certain period. Or you can

enter a minimum quantity starting at which a certain price should apply.

The Vendor Item No. field can be filled in to differentiate between prices set by multiple or alternative suppliers. If you change

vendors on a pseudo item line, the default price entered for the item is then replaced by this new price.

PURCHASE REQUEST WORKFLOW

Create a request

To create a purchase request:

Choose the Search icon, enter Purchase Request List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

1. 

2. 

3. 

1. 

2. 

3. 
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General

If a workflow code hasn’t already been selected in Approval User Setup, you need to select a code here—or the request cannot be

sent because of a missing workflow. A code can be created as described under Approval User Setup and Workflows.

Lines

You can then fill in the lines. A line can be of type G/L account, Item, Resource, or Fixed Asset. Standard items are ordered

through requisition worksheets.

However, you can also select a pseudo item on a line. You don’t specify a line type in this case. Instead, the type is automatically

set to G/L account and the account number linked to the item is entered in the No. field.

Field Description

No. Exit the field or press Enter to have the system assign a number automatically.

Order Date This field is automatically filled in with the work date.

Due Date Specify a date that will represent the requested, planned, and expected receipt dates during the

ordering process.

Request Workflow

Code

Specify a code for the request workflow.

This field might be filled in with a value from the Approval User Setup page if a code has been

specified there.

Reason Code Specify a reason code for the Reject function.

Department Code Specify Global Dimension Code 1.

In Microsoft Dynamics 365 Business Central1, this code typically refers to a department.

Customergroup Code Specify Global Dimension Code 2.

In Microsoft Dynamics 365 Business Central1, this code typically refers to a cost unit.

Status Shows the status of the document within the approval process. The request might be:

• Open

• Pending Release

• Rejected

• Ready for Ordering

Created By Shows the user who created the purchase request.

Created On Shows the date and time when the request was created.

Last Modified On Shows when the document was last edited.

Last Modified By Shows by whom the document was last edited.

Level Indicates how far the request is in the approval process.

You can select the hyperlink to see the order of approval.

Comments Indicates if comments have been stored for the request.

You can select the hyperlink to see them.

Net Total Amount Shows the net amount for all items entered on the lines.

Note
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After you’ve entered a quantity for item, the unit cost stored for the specified vendor is copied from the Direct Unit Cost field on

the pseudo item card—or the Pseudo Item Purchase Prices page if the relevant cost is specified there. The same applies to costs

specified on G/L account, item, and fixed asset lines.

If the purchase price page includes alternative supplier costs or cost scales, you can also drill down on a Vendor No. field to

choose a supplier and an item number on the request line. However, because of a lack of grouping criteria, a separate number is

often created for a pseudo item.

The Purchase Request URL field supports the procurement department. It can be used by the person who requested an item to

enter a web address that the purchaser tasked with fulfilling the request can open to see more information about the item itself

and the terms and conditions of its delivery (by selecting a line and choosing Open URL on the ribbon).

When all required data has been entered, the request can be sent to the initial approver. To send a request:

Choose Send on the ribbon.

Choose Yes to start the approval workflow. Or choose No to make changes or corrections.

If you choose No to correct the request, you must restart the workflow after making the correction by again choosing Send and

choosing Yes on the dialog that appears.

To send emails as part of an approval workflow, an SMTP server needs to be set up by your company’s IT department.

Afterward—unless the value of what is being asked exceeds an approval limit specified in Approval User Setup—the request is

sent to the approver that has been set up for the next step in the process.

Release a request

An approver can release a request by clicking the link in the notification email they receive or search for the request number

within Microsoft Dynamics 365 Business Central1. To release a request in the system as an approver:

Choose the Search icon, enter Purchase Request List, and then choose the related link.

Choose Search and enter the number you received in the notification email. You’ll see the status of the request having been set to

Release.

Choose Edit to open the request.

Choose Release on the ribbon. To add notes to the approval workflow, choose the Comments function and enter a note prior to

release.

The request is then sent to the next specified approver. This exact process is repeated until the request has passed through all

approval stages. In the last stage, the request is set to Ready for Ordering.

Reject a request

After being emailed about a pending release, an approver can also reject the request that is referenced in the email, because the

person who is asking for certain items might not have been authorized to do so. To reject a request:

Choose the Search icon, enter Purchase Request List, and then choose the related link.

Choose Search and enter the number you received in the notification email. You’ll see the status of the request having been set to

Release.

Choose Edit to open the request.

On the General FastTab, fill in the Reason Code field to specify why this request is being rejected.

Choose Reject on the ribbon.

The request document is then reset to Open, and the requester is notified of the rejection.

Resubmit a request

• 

• 

• 

Note

1. 

2. 

3. 

4. 

1. 

2. 

3. 

4. 

5. 
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Following a rejection, the requester can edit the document before choosing Send to restart the approval process as described

above.

Cancel a request

If a request has been rejected and there’s no reason to expect that a revised document would fare any different, the request can

instead be canceled and archived. To cancel the request:

Choose Cancel on the ribbon.

A dialog appears. Choose Yes to set the document status to Cancelled and have it moved to the Archived Purchase Request

List.

Create an order

If a purchase request has been released by all specified approvers, the items can be procured.

Choose the Search icon, enter Purchase Request List, and then choose the related link.

Choose Search and enter the number you—working in your company’s procurement department—received in the notification email.

You’ll see the status of the request having been set to Ready for Ordering.

Choose Edit to open the request.

Choose Create Purchase Order on the ribbon. Based on the number of different vendors shown on the request, one or more

purchase orders will be created. Afterward, the request will be completed and archived.

The requester will be notified of the order by email.

All orders created from purchase requests include the following information:

Purchase header

Purchase lines

Actions – Document Texts

Running the Beginning Text or Ending Text function from the purchase order also shows all texts entered for pseudo items on the

original request.

Archived requests

Requests are archived when you create purchase orders for them by using the Create Purchase Order function or, following

rejection, choose Cancel (without creating an order).

• 

• 

1. 

2. 

3. 

4. 

5. 

Field Description

Purchase Order Type This field is set to Default, unless otherwise specified in Purchase Request Setup.

Due Date Shows the due date entered on the purchase request.

Field Description

Promised Receipt Date Specifies the promised receipt date of the purchased items.

The content of this field is calculated based on the expected receipt date.

Expected Receipt Date Specifies the due date entered on the purchase request.

Requested Receipt Date Specifies the requested receipt date of the purchased items.

The content of this field is calculated based on the expected receipt date.

Purchase Request No. Specifies the document number from the purchase request.

Pseudo Item No. Specifies a pseudo item, used as a G/L account filter.

Requester ID Specifies the person who created the purchase request.
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With the status set to Ordered or Cancelled, the documents are then moved to the Archived Purchase Request List.

Request log

All steps in the request process are recorded in a log. To see the log, choose Log Entries on the ribbon of a purchase request

card or choose Related > Log Entries on the ribbon during the approval process.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Dispatch

OVERVIEW

With the Dispatch functionality, you can create orders that contain item lines, manually created document lines—such as for the

simple dispatch of sample parts—and information about the packaging used for delivery.

Orders of this type might contain posted shipments alongside warehouse and inventory documents, such as Whse. Shipment and

Inventory Pick. On each order, you can assign different unit loads (carriers) to one another to create a deep-nested packaging

structure. You can then assign a carrier ID on each level so that when you send (that is, post) the order, the consumption of

packaging material and the related warehouse or inventory documents will be posted at the same time.

You can also set up packing suggestions to store instructions on how to pack items and make use of available packaging

materials. A suggestion specifies the packing methods for one type of item or packaging material. For grouping different items or

materials on a higher level, for example, a pallet, you need to combine both types of suggestions.

The words “carrier” and “packaging," found in Dispatch Setup and elsewhere in the system, are interchangeable in this context. Both

describe common types of unit loads and packaging materials.

On dispatch lines, a carrier specifies a single package that might be identified by an ID. The terms “carrier” and “package” are also

synonyms here. 

As a carrier has, by definition, a quantity of 1, the functionality shouldn’t be used for posting the consumption of ancillary packaging

materials (10 meters of stretch film or 4 pieces of edge protectors, for example).

SETUP

You need to set up the functionality before you can use it.

Dispatch Setup

Choose the Search icon, enter Dispatch Setup and then choose the related link.

Fill in the fields as described in the following tables.

Note

Note

1. 

2. 
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General

Carrier Posting

Only journals that aren't already linked to a number series can be entered in these fields.

Field Description

Dispatch Order Nos. Specify the number series that will be used for dispatch orders.

Packing Suggestion

Nos.

Specify the series that will be used for packing suggestions.

Posting Type Specify if the Post function should be used to ship orders or ship and invoice them at the same

time.

Print Shipment Turn on this toggle if you want to use the Post and Print function to print the shipment documents

created for a dispatch order.

Print Invoice Turn on this toggle if you want to use the Post and Print function to print the invoice documents

created for a dispatch order.

Print Posted Dispatch

Order

Turn on this toggle if you want to use the Post and Print function to print a posted dispatch order.

Company ID Specify the ID that GS1 has assigned to your company.

Carrier ID Nos. Specify the number series that will be used for a carrier as part of a carrier ID. A carrier ID

combines a company ID and a number from another series.

Set Carrier IDs at

Order Release

Turn on this toggle if you want a carrier or package ID assigned automatically when a dispatch

order is released.

Set Check Digit for

Carrier IDs

Turn on this toggle if you want to create SSCC-compliant carrier IDs. Activating the option will

affect both the calculation and input of IDs.

As mentioned previously, a carrier ID combines a company ID and a number from another series.

With the toggle turned on, the system will check if the specified string is SSCC-compliant.

SSCC-compliant means the ID must be numerical in nature and consist of 17 characters in total

(the check digit not included). You will see an error message if one of these conditions is not met

during the creation of an ID.

New Carrier Posting

Method

Turn on this toggle to activate carrier postings.

This way, you can post disposable and returnable carriers at different locations.

Dispatch Field Check Specifies if the mandatory field check is run on dispatch headers and lines.

Field Description

Carrier Item Jnl. Template

Name

Choose the name of the item journal template that you want to post shipments with non-

returnable packaging to.

Carrier Item Jnl. Batch Name Choose the name of the item journal batch that you want to post shipments with non-

returnable packaging to.

Carrier Transfer Jnl. Template

Name

Choose the name of the item journal template that you want to post transfers with

returnable packaging to.

Carrier Transfer Jnl. Batch

Name

Choose the name of the item journal batch that you want to post transfers with returnable

packaging to.

Note
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Packing suggestion groups

You can assign groups of packing suggestions to certain customers, vendors, and locations by using the Packing Suggestion Links

function on the ribbon of the relevant card. To set up a group:

Choose the Search icon, enter Packing Suggestion Groups and then choose the related link.

Fill in the fields as described in the following table.

Report selection

The dispatch functionality comes with its own group of reports. To set them up:

Choose the Search icon, enter Report Selection – Dispatch, and then choose the related link.

In the Usage field, select one of the options described in the following table.

You can then fill in the rest of the fields as for any other report selection. For more information, see Report Selection for

Documents in Business Central - Business Central | Microsoft Learn.

For the Posted Dispatch SSCC Label report, you can also specify in the Source Type (Contents) field whether the report should

be used to print carrier or item labels. Afterward, you can narrow down your choice to a certain carrier or item in the Source No.

(Contents) field, if necessary (see the following table).

Carriers

To set up a carrier:

Choose the Search icon, enter Carriers, and then choose the related link.

Fill in the fields as described in the following tables.

1. 

2. 

Field Description

Code Specify a unique identifier for the group.

Description Enter a description for the group.

1. 

2. 

Option Uses (as default) report

Dispatch Orders 5048961 – Dispatch Order

Posted Dispatch Orders 5048962 – Posted Dispatch Order

Posted Dispatch Label 5049202 – Posted Dispatch SSCC Label

Option Uses (as default) report

(blank) Nothing has been selected or set up.

All Items The report will be used to print labels for all items set up in the system.

Item The report will only be used for the item specified in the Source No. (Contents) field.

All Carriers The report will be used to print labels for all carriers set up in the system.

Carrier The report will only be used for the carrier specified in the Source No. (Contents) field.

Item Category The report will only be used for items that belong to the category specified in the Source No. (Contents)

field.

1. 

2. 
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General

There is no inventory management feature that links lot or serial numbers to carriers.

Dimensions

Locations

The location card has been extended to include a FastTab covering dispatch-related functions. To set up the new features:

Choose the Search icon, enter Locations, and then choose the related link.

Open a location card.

Fill in the fields on the Dispatch FastTab as described in the following table.

Field Description

Code Specify a code for the carrier.

You cannot assign a number from a series in this field.

Description Enter a description for the carrier.

Added

Packaging

Turn on this toggle if the carrier represents additional packaging.

Inventory If the carrier is linked to an item, this field shows how many of these types of carriers you have on hand.

Item No. Fill in this field if the carrier should be linked to an item.

Carrier Posting

Type

If the carrier is posted to a warehouse and the Item No. field has been filled in, you can use this field to

specify whether the carrier can be returned to the sender.

For disposable packaging, negative adjustment is posted during dispatch. For multi-use units, a transfer

is posted to the address set up to receive the carrier (address of a customer or vendor, or another type

of location).

ID Required Turn on this toggle if you want the system to check for a carrier or package ID when the dispatch order

assigned to the carrier is released.

Carrier ID Nos. Here you can specify another number series for the carrier so that a number from this series (instead of

the series selected in Dispatch Setup) will be used to create a carrier ID. 

As mentioned previously, a carrier ID combines a company ID and a number from another series. With

the Set Check Digit for Carrier IDs toggle turned on in Dispatch Setup, the system will also check if the

specified string is SSCC-compliant.

Note

Field Description

Length Specify the length of the carrier in the unit commonly used in your company.

Width Specify the width of the carrier in the unit commonly used in your company.

Height Specify the height of the carrier in the unit commonly used in your company.

Weight Specify the weight of the carrier in the unit commonly used in your company.

1. 

2. 

3. 
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Field Description

Dispatch Type Specify if you want to use the Dispatch functionality at this location.

(blank)

The functionality will not be used. However, if necessary, you can still create a dispatch order

that is based on documents linked to the site.

Packages

You can enter packages on sales, purchase return, and transfer orders without having to create

dispatch orders.

However, if necessary, you can still create a dispatch order from documents linked to the site.

Dispatch Orders

Dispatch orders will be used.

Dispatch Qty.

(Suggestion)

Specify the item quantities that should be copied from (warehouse, inventory, or posted)

document lines to the lines that you want to dispatch.

Quantity

The quantity entered on each document lines is transferred.

Remaining Quantity

Only what remains to be sent is copied, which means the quantities specified on open and

registered but not yet dispatched orders.

Create Dispatch from

Pick

With the toggle turned on, the Register Pick and Create Dispatch function is shown on pick

documents. When you run the function while registering a pick, a dispatch order is created.

Note

The toggle can only be turned on if you selected the Dispatch Orders option in the Dispatch Type

field.

Dispatch Picked Qty.

Only

With the toggle turned on, the system copies the pick quantity from the Net Change field to a

dispatch order on which the Register Pick and Create Dispatch function is run.

Registered quantities that are entered on pick lines (as posted net change) but have not been

dispatched (as they originate with open and registered dispatch orders) are not transferred

along.

They are, however, if this toggle is turned off and the Dispatch Qty. (Suggestion) field is set to

Remaining Quantity.

With the field set to Quantity, the number of items is copied from the associated warehouse

shipment line.

Note

You need to activate the Create Dispatch from Pick option before you can turn on this toggle.

Dispatch for Whse.

Shipments

With the toggle turned on, the functions Create New Dispatch and Add to Dispatch are shown on

the Warehouse Shipment page.

Running the former action creates a dispatch order for the quantity in the Qty. to Ship field;

running the latter extends an existing order to include that quantity.

Note

The toggle can only be changed if you selected Dispatch Orders in the Dispatch Type field and

turned on the Require Shipment toggle on the Warehouse FastTab.
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Customers

The customer and vendor cards have also been extended to include dispatch-related functions. To set up the features for a

customer:

Choose the Search icon, enter Customers, and then choose the related link.

Open a customer card.

Fill in the fields on the Dispatch FastTab as described in the following table.

Dispatch

Field Description

Packing Suggestion

Group

Specify a group for packing suggestions.

By assigning a group, you do not need to create a link to a packing suggestion each time an

internal dispatch order is received at one of your company’s locations.

Outbound Packaging

Location Code

Specify the location that you want to use for packaging that will be shipped.

You can then post negative adjustments of disposable and multi-use carriers to this location.

Outbound Packaging Bin

Code

Specify the bin that you want to use for packaging that will be shipped.

You can then post negative adjustments of disposable and multi-use carriers to this bin.

Inbound Packaging

Location Code

Specify the location that you want to use for packaging that will be received.

You can then post internal transfers of multi-use carriers to this location.

Inbound Packaging Bin

Code

Specify the bin that you want to use for packaging that will be received.

You can then post internal transfers of multi-use carriers to this bin.

1. 

2. 

3. 

Field Description

Packing Suggestion Group Specify a group for packing suggestions.

By specifying a group, you do not need to create a link to a packing suggestion each time a

dispatch order is sent to a customer.

Inbound Packaging Location

Code

Specify the location that you want to use for packaging that will be received.

Multi-use carriers from the customer’s dispatch orders are then posted to this location.

For maximum transparency, only one customer should be set up per location.

Inbound Packaging Bin

Code

Specify the bin that you want to use for packaging that will be received.

Multi-use carriers from the customer’s dispatch orders are then posted to this bin.
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Ship-to Addresses (action)

Vendor

The customer and vendor cards have also been extended to include dispatch-related functions. To set up the features for a

vendor:

Choose the Search icon, enter Vendors, and then choose the related link.

Open a vendor card.

Fill in the fields on the Dispatch FastTab as described in the following table.

Dispatch

Packing suggestions

Packing suggestions contain all the information relevant to creating dispatch orders. To include a suggestion on an order, you

can use the Process Packing Suggestions function found on the ribbon.

The numbers of suggestions are already filled in on the lines of an order when you run one of the actions to get data from

warehouse, inventory, or posted documents.

Create a packing suggestion

To set up a suggestion:

Choose the Search icon, enter Packing Suggestions, and then choose the related link.

Fill in the fields as described in the following tables.

Field Description

Inbound Packaging Location

Code

Specify the location that you want to use for packaging that will be received.

Multi-use carriers from dispatch orders shipped to the specified address are then posted

to this location.

For maximum transparency, only one address should be set up per location.

Inbound Packaging Bin Code Specify the bin that you want to use for packaging that will be received.

Multi-use carriers from dispatch orders shipped to the specified address are then posted

to this bin.

1. 

2. 

3. 

Field Description

Packing Suggestion Group Specify a group for packing suggestions.

By specifying a group, you do not need to create a link to a packing suggestion each time a

dispatch order is sent to a vendor.

Inbound Packaging Location

Code

Specify the location that you want to use for packaging that will be received.

Multi-use carriers from the vendor’s dispatch orders are then posted to this location.

For maximum transparency, only one vendor should be set up per location.

Inbound Packaging Bin

Code

Specify the bin that you want to use for packaging that will be received.

Multi-use carriers from the vendor’s dispatch orders are then posted to this bin.

1. 

2. 
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General

Lines

Field Description

Packing Suggestion

No.

Exit the field to have a number assigned automatically from the series set up for this purpose.

Type Specify if the suggestion will be used for an item or a carrier.

No. Enter the number of an item or a carrier, depending on what option you chose in the Type field.

Description After filling in the No. field, you can see the description of the item or carrier here.

You can also change the description if necessary.

Status Specifies the status of the suggestion.

New

Automatically set when you create a new packing suggestion.

In this status, you can both change an assigned checklist and the suggestion itself.

Certified

You can no longer edit the suggestion.

Suggestions need to be in this status before you can use them on dispatch orders. To change a

certified suggestion, you need to reset the status to Under Development.

Under Development

You can edit the suggestion.

Expired

Specifies that the suggestion has expired and is no longer in use. It can also no longer be changed.
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To create or delete suggestion lines, choose Insert Line or Delete Line on the ribbon at the top of the Packing Suggestion page.
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Field Description

Sequence No. A sequence number is assigned automatically when you use the Insert line function to add a line to the

suggestion.

The content of this field cannot be changed manually.

Object Type Specifies if the suggestion covers instructions for an item or a carrier.

On the first packing line, the value in this field is copied from the suggestion header. On all subsequent

lines, it is copied from the Packing Type field found on the preceding line.

The content of this field cannot be changed manually.

Object No. Specifies the item or carrier packed at the specified level.

Depending on the option specified in the Object Type field, this field is filled in with the item or carrier

that was assigned to the suggestion. On all subsequent lines, the number is copied from the Packing

No. field found on the preceding line.

The content of this field cannot be changed manually.

Packing Type Select whether you want the item or carrier shown in the Object No. field packed inside a specific

carrier or if it should be linked to a suggestion instead.

Packing No. Depending on the option specified in the Packing Type field, this field shows the suggestion number

used for packing the item or carrier entered in the Object No. field.

Packing

Description

Shows the description of the suggestion entered in the Packing No. field. However, you can change the

description if necessary.

Qty. per Level Specifies how many pieces of the item or carrier entered in the Object No. field can be packed on one

level.

You can only fill in this field if the Object Type and Packing Type are both set to Carrier.

No. of Levels Specifies how many levels can be stacked inside the carrier that was entered in the Packing No. field.

You can only fill in this field if the Object Type and Packing Type are both set to Carrier.

Total Quantity Shows the result of multiplying the Quantity per Unit and No. of Levels fields.

If, on a line of packaging type Carrier, the value in this field is 0, you can enter another value manually.

You cannot fill in the field on lines of type Packing Suggestion.

Single Lot Turn on this toggle to ensure that only one type of carrier or item has been entered on the line when

you create a dispatch order.

The toggle can only be turned on if the line is the first line on the suggestion or the toggle is also

activated on the preceding line.

On lines of type Item, the toggle can only be turned on if the item is set up for lot tracking.

Use Packaging as

Filler

Specify if you want to use packaging material to fill up container deliveries.

(blank)

No packaging will be added on the last level.

Fill Level

On the last level, the container is filled with as many carriers as needed to match the number shown in

the Qty. per Level field.

Fill Corners

1.2.1 base (BOOSTER)

- 141/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Assign a suggestion

To link an item to a packing suggestion:

Choose the Search icon, enter Packing Suggestion Links, and then choose the related link.

Choose New.

Fill in the fields as described in the following table.

Field Description

On the last level, carriers will be added to fill out the corners of the container.

You can only choose something in this field if the Qty. per Level and No. of Levels fields contain a value

other than 0. The Object Type and Packing Type fields must also be set to Carrier.

Added Packaging Indicates if the Added Packaging function on the Lines FastTab was used to add more packaging to the

line.

1. 

2. 

3. 
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When you work with item variants, item and packing suggestion numbers can always be found at the lowest level of suggestions used

for dispatch orders so that you can group the variants. To have a variant packed individually, you must create a separate suggestion

and separate links for it.

WORKFLOW

Every dispatch needs a dispatch order, a delivery that consists of one or more packages (=carriers). You can specify packages as

early as creating the sales, purchase return, and transfer orders that you want to dispatch.

When you post their shipment, dispatch orders are created and posted by the system while the amount of packaging that you

have on hand is reduced (for more information, see Packages on Outbound Documents.

Note

Field Description

Item No. Specify the number of the item for which a suggestion will be set up on the line.

Variant Code Here you can specify an item variant if available.

Item Description Shows the description of the item entered in the Item No. field. You cannot change this field

manually.

Link Type Specify the type of recipient that the suggestion should be used for.

(blank)

Represents the default assignment if no other option can be used for the item when entered on

a dispatch order.

Customer

Links the item to a customer.

Vendor

Links the item to a vendor.

Location

Links the item to a location. This is the default option for assigning internal orders.

Suggestion Group

Links the item to a packing suggestion group. The group can then be assigned to a customer,

vendor, or location.

Link No. Specify a number for the link based on the Link Type field.

Link Description Shows the description of the link entered in the Link No. field.

Packing Suggestion No. Specify the number of the suggestion that should be used for the item and the link on a

dispatch order.

Packing Suggestion

Description

Shows the description of the suggestion that you entered in the Packing Suggestion No. field.

You cannot change this field manually.

Packing Suggestion Status Shows the status of the suggestion entered in the Packing Suggestion No. field.

Note

Only certified suggestions can be used for dispatch orders.

Starting Date

Ending Date

Specify the period for which you want the link to be valid.

Note

Filling in these fields is optional.
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By creating orders manually, you can link different packages together to set up a multilevel structure for a shipment (for more

information, see Dispatch Orders for Warehouse and Inventory Documents and Dispatch Orders for Posted Documents). You can

also assign packages to individual document lines only.

The location that items are shipped from or consumed at isn’t important to creating a dispatch order. 

Packages on outbound documents

For ease of use, you can enter packages (=carriers) on the following outbound documents:

Sales orders

Purchase return orders

Before you can specify a carrier type or quantity on a document, however, you need to enter on the document header a location

for which the Dispatch Type field is set to Packages. This is because linking a carrier to a document line or one carrier to another

(such as a box to a pallet) isn’t possible here.

When the document is posted as shipped, the system then creates and posts a dispatch order including the source lines and

carriers before it transfers the carriers to another location (if they’re returnable) or removes them altogether (if they aren’t).

If you select the Packages option on a location card and then enter the location on a document header, you must add at least one

package to this document as well.

A carrier used in inventory management, that is, a carrier assigned to an item tracked through a serial or lot number, doesn’t lower

inventory levels. Moreover, you can post any document assigned to the carrier and will not encounter an error.

You can also enter carriers on transfer orders where the Transfer-from Code location supports this option. A dispatch order is

then created and posted as you post the outbound transfer.

The transfer order fields can be filled in as described in the following table.

Manual dispatch

To create a dispatch order manually:

Choose the Search icon, enter Dispatch Order List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Note

• 

• 

Note

Note

Field Description

Carrier Code Specify the code of the carrier.

Carrier Description This description is copied from the carrier card and cannot be changed.

Carrier Quantity Specify the number of carriers used.

Carrier Gross Weight (Scales) Specify the gross weight of the filled carrier.

1. 

2. 

3. 
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General

Field Description

No. Exit the field to have a number assigned automatically from the series set up for this purpose.

Dispatch Location

Code

Enter the location from where the requested goods should be dispatched.

You can also use this field to specify the location to which packaging must be posted.

Shipment Method

Code

Specify the method for dispatch.

You must fill in this field. When you copy another document to the order, the value in this field will

be overwritten with the method stored on that document.

Shipping Agent Code Specify the shipping agent responsible for the dispatch.

You must fill in this field. When you copy another document to the order, the value in this field will

be overwritten with the agent code stored on that document.

Shipping Agent

Service Code

Specify the shipping agent service rendered for the order.

Shipping Agent Text For more information, see Shipping Agent Text.

Dispatch Notes For more information, see Dispatch Notes.

Dispatch Provider For more information, see Shipping Agents.

V-LOG Company For more information, see V-LOG Setup.

Forwarder/Waybill No. Specify the number that was assigned to the dispatch order by the forwarder or can be found on

the bill of lading.

Assigned User ID Specify the ID of the user responsible for the document.

Single-Package

Dispatch

Select this field if you want to create a posted order for each carrier or package when you send

(post) this dispatch order.

Status Shows the status of the order.

Goods Value Shows the total value of the goods that you want to dispatch.

Destination Type The field is filled in automatically when the first document is retrieved.

Destination No. The field is filled in automatically when the first document is retrieved.

Sell-to Contact No. The field is filled in automatically when the first document is retrieved.

Ship-to Code The field is filled in automatically when the first document is retrieved.

Ship-to Name The field is filled in automatically when the first document is retrieved but can be changed on the

order.

Ship-to Country/

Region Code

This field is filled in automatically when the first document is retrieved but can be changed on the

order. This field must be filled in.

Ship-to Post Code The field is filled in automatically when the first document is retrieved but can be changed on the

order.

Ship-to Contact The field is filled in automatically when the first document is retrieved but can be changed on the

order.

Fixed Shipping Date Here you can enter the fixed shipment date that you want transmitted via the V-LOG interface.

Fixed Shipping Time Here you can enter the fixed shipping time that you want transmitted via the V-LOG interface.

Document ID Scan Used to insert lines by scanning a document ID.
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Shipping Agent/Forwarder

Packaging Locations

Ribbon Actions Dispatch

Posts an order according to the posting type specified in Dispatch Setup. This process includes:

Posting warehouse and source documents assigned to the order.

Posting the packaging material consumed.

For single-lot dispatch, creating a separate posted dispatch order for each carrier or package. The source document will be

displayed in the Single-Package Dispatch Parent Order No. field on every order.

Archiving the posted document(s).

The dispatch order must be released before you can run this function.

Post and Print

Posts a dispatch order and prints the documents that you selected via toggle in Dispatch Setup. 

The dispatch order must be released before you can run this function.

Goods Value

Updates the value of goods on the header and lines of a dispatch order.

Release

Field Description

Pickup Date Specify the date on which the order needs to be picked up.

Pickup Time Specify the date at which the order needs to be picked up.

Received On Specify the date on which the order needs to be delivered.

Received At Specify the time at which the order needs to be delivered.

Field Description

Outbound Packaging Location

Code

Specify the location that you want to use for packaging that will be shipped.

You can then post negative adjustments of disposable and multi-use carriers to this

location.

Outbound Packaging Bin Code Specify the bin that you want to use for packaging that will be shipped.

You can then post negative adjustments of disposable and multi-use carriers to this bin.

Inbound Packaging Location Code Specify the location that you want to use for packaging that will be received.

You can then post internal transfers of multi-use carriers to this location.

Inbound Packaging Bin Code Specify the bin that you want to use for packaging that will be received.

You can then post internal transfers of multi-use carriers to this bin.

• 

• 

• 

• 

Note

Note
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Changes the status of a dispatch order from Open to Released. The following checks are performed automatically when an order

is released:

Have the Shipment Method Code, Shipping Agent Code, Ship-to Name, Ship-to Country/Region Code and Ship-to Post Code

been filled in?

Has at least one carrier been specified on the order?

Have all item lines and manual lines been assigned to the specified carriers or have none been assigned to them?

For single-package shipments:

Are carriers found only on level 1 of the packing structure and have the document lines been assigned to the specified

carriers?

If the answer to all these questions is Yes, the order will be released.

Reopen

Resets the status of an order from Released to Open.

Scan Document ID (Scanner)

Used to create dispatch lines automatically by scanning a document ID.

Can be run for all documents that can also be retrieved by using the Get Warehouse Shpt. or Get Inventory Pick action.

Actions – Functions

The following functions can be called via the menu item "Functions":

Manual Line

Used to enter dispatch lines manually. For more information, see Manual Lines on Dispatch Orders.

Process Packing Suggestions

See Process a Packing Suggestion.

Refresh Packing Structure

Updates the packing structure.

This function also runs automatically when you add packaging materials or assign document lines to packages.

Assign Carrier ID

Assigns an ID to each carrier entered on a dispatch order as early as the order being in the Open status.

For the function to work, you must have specified a number series for carrier IDs and turned on the ID Required toggle for the

carrier.

Actions – Warehouse & Inventory

See Dispatch Orders for Warehouse and Inventory Documents. 

Actions – Posted Documents

See Dispatch Orders for Warehouse and Inventory Documents. 

Related

Choose Dispatch Order > Comments if you want to enter comments for a dispatch order.

• 

• 

• 

• 

Note

Note
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Choose Dispatch Order > Edit Dispatch Notes to change the shipping notes sent with V-LOG transmissions.

Dispatch lines

The Lines FastTab contains the item or manual dispatch lines (see Manual Lines on Dispatch Orders) you want dispatched and

the carriers that will be used for delivery.

Carriers can be assigned to one another to create a multilevel structure on an order. One or more carriers can also be assigned

to item lines or manual lines.
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The fields shown on the FastTab are described in the following table.
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Field Description

Document Line

Type

Specifies the type of dispatch line. Options are:

• (blank)

• Item

• Carrier

Document Line No. Specifies the number of an item or the code of a carrier.

Packing Structure This field is filled in by the system.

Added Packaging Specifies a line to which no contents (items) can be added but that completes the packaging used (by

providing wrapping foil, pallet bands, or box lids, for example).

Empty Packaging Specifies a packaging line where there are no contents (items) to retrieve. They can be added,

however.

You can also have this kind of packaging complete a carrier (such as a pallet) to make it safe for

transport.

Carrier Posting

Type

Specifies if the shipment comes with disposable or multi-use packaging.

The field is also used to post packages when you post orders. Disposal packaging is then posted

(consumed) off a warehouse that you specified, whereas multi-use packaging is transferred to another

location.

Description Shows the description of the item from the source document line, the manual dispatch line, or the

carrier.

Service Item No. If the order relates to the service area, this field shows number of the service item to be shipped.

Serial No. Shows the serial number that was stored on the warehouse, inventory, or posted document assigned

to the line.

Lot No. Shows the lot number that was stored on the warehouse, inventory, or posted document assigned to

the line.

Quantity This field is filled in by the system.

Qty. to Handle This field is filled by the system.

You can reduce the Qty. to Handle by choosing Functions > Split Line on the ribbon to create multiple

lines with carriers.

Unit of Measure

Code

Specifies the unit used on the source document line or for the carrier.

Packing Suggestion

Group

Shows the code of a suggestion group if the packing suggestion is based on one.

Packing Suggestion

No.

Shows the number of a suggestion if the dispatch line was inserted based on a suggestion link.

Packing Suggestion

Status

Shows the status of the suggestion that was retrieved.

Goods Value

Comment

Shows, if stored, comments made about the goods value.

Length Specifies the length of the packaging.

Width Specifies the width of the packaging.

Height Specifies the height of the packaging.

1.2.1 base (BOOSTER)

- 150/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Manage

Choose Delete Line to remove one or more lines from a dispatch order.

Functions Split Line

Splits a line of type Item into two lines.

For the function to work, the quantity on the source line must be greater than 1 and the Qty. to Handle less than the total. The

difference between the original quantity and the Qty. to Handle is then entered on the new line.

Add More Packaging

Adds one or more carriers or packaging materials to a dispatch order.

You can specify the total quantity you want to add when you select the carrier or material. A dispatch line with a quantity of 1 is

then entered on the order for each individual carrier or material.

Highlight Lines

Highlights in red one or more manually selected dispatch lines so that they can be assigned to another dispatch line.

Remove Highlighting

Deletes the highlighting from lines.

Add to Package

Assigns the highlighted lines to another dispatch line.

Lines of document line type Item or (blank) can only be assigned to a dispatch line of type Carrier.

Lines of document line type Carrier can only be assigned to a dispatch line of type Carrier.

Assigning one line to another creates a multilevel structure, with the relations between lines indicated in the Packing Structure

field. If you assign a dispatch line that contains a substructure, the entire structure will be added as well.

Field Description

Carrier ID You can enter a carrier ID manually or have one calculated by the system.

For automatic calculation, you need to have turned on the ID Required field on the card of the carrier

and set up a number series for carrier IDs.

As mentioned previously, a carrier ID combines a company ID and a number from another series. If

the Set Check Digit for Carrier IDs toggle is turned on in Dispatch Setup, the system will check if the

specified string is SSCC-compliant.

For more information, see Dispatch Setup.

Note

The carrier ID is shown without the check digit here. A check digit is typically required for barcode

carrier IDs. However, in the present context, the digit must be calculated later based on the type of

barcode that should be printed.

Carrier ID

Required

Specifies if the carrier requires an ID.

Weight per UOM Specifies the gross weight stored on the source document line or the weight of the entered carrier.

You can change the content of this field manually.

• 

• 

1.2.1 base (BOOSTER)

- 151/1545 - Copyright © 2018 - 2024 KUMAVISION AG



You should always assign carriers from bottom to top. On Level 1—the lowest level---you should, for example, specify the pallet used.

On Level 2, you should store the first set of cardboard boxes. On Level 3, an anti-slip mat might be introduced, and Level 4 might

then contain another set of boxes.

Remove from Package

Removes the highlighted lines from a carrier or package.

A line that contains a carrier or package with a substructure is moved to Level 1 in the packing structure, with the substructure

left intact.

Line Source Document Line

Opens the source document for a line of type Item. Source documents can be:

Sales orders

Purchase return orders

Service orders

Transfer orders

Posted shipments

Posted service shipments

Posted return shipments

Posted outbound transfers

Whse. Document Line

Opens the warehouse shipment or inventory pick for a line of type Item.

FactBoxes

Dispatch order

Note

• 

• 

• 

• 

• 

• 

• 

• 

Field Description

Dispatch Comment Indicates if notes have been added to the dispatch order.

Customer No./Vendor

No.

Shows the content of the Destination Type field from the dispatch header.

Gross Weight Shows the total gross weight on Level 1 dispatch lines.

Tare Weight Shows the total tare weight from all carrier lines, regardless of their level within the structure.

Net Weight Shows the total net weight from all item and manual dispatch lines, regardless of their level

within the structure.

No. of Packages (Level

1)

Shows the total number of packages on Level 1.

No. of Packages (Total) Shows the total number of packages on all levels.

Interface Indicates if an interface is used for the dispatch order.
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Dispatch Lines

Dispatch orders for warehouse and inventory documents

You can copy data from warehouse shipments or inventory picks to manually created dispatch orders by choosing Actions >

Warehouse & Inventory on the ribbon of an order.

When data is copied from the first document, the Ship-to Address entered on it is transferred to the field with the same name on

the dispatch header. Each time you retrieve data from additional documents, you then see a message if the address initially

copied to the header is different from the one entered on the document that you want to copy. If you choose OK, the system will

create new document lines but leave the data on the header unchanged.

Get Warehouse Shpt. (action)

Copies warehouse shipment data to a dispatch order.

For this function to work, the following requirement must be met:

The Qty. to Ship field on the shipment lines must be filled in.

In two-stage picking, picks need to be registered before you can copy a warehouse shipment to a dispatch order.

Field Description

Tare Weight Specifies the carrier net weight that was entered on the carrier card.

Net Weight For carrier lines without substructures, this field is empty. For carrier lines with substructures, this field

shows the total gross weight from all substructure levels.

For item lines, the value in this field is identical to the gross weight of the item times the quantity entered

for the item on the lines.

Note

Dispatch considers net and gross weights to be interchangeable. This is because items have already been

packed at this point—for example, paint has already been filled into a can.

Gross Weight For a carrier line without a substructure, this field shows the weight of the carrier. For a carrier line with

a substructure, the field shows the total net weight plus the tare weight.

For item lines, the value in this field is identical to the gross weight of the item times the quantity entered

for the item on the lines.

Length Specifies the length of the carrier.

Width Specifies the width of the carrier.

Height Specifies the height of the carrier.

• 

Note
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The information stored on the warehouse shipment lines is then used to fill in new dispatch lines as described in the following

table.

Get Inventory Pick (action)

Copies inventory picking data to a dispatch order.

For this function to work, the following requirements must be met:

The inventory pick is not part of another dispatch order.

Field Description

Document Line Type This field is filled in with line type Item.

Document Line No. This field is filled in with the number of the item.

Packing Structure This field is not filled in automatically.

Description This field shows the item description from the source document line.

Serial No. This field is filled in if the warehouse shipment line contains an item tracking line with a serial

number.

Lot No. This field is filled in if the warehouse shipment line contains an item tracking line with a lot

number.

Quantity This field is filled in by the system.

Qty. to Handle This field is filled in by the system.

Unit of Measure Code This field shows the unit of measure used on the source document line.

Packing Suggestion

Group

This field is filled in if the packing suggestion entered for the order in the Packing Suggestion No.

field was calculated with the help of a suggestion group.

Packing Suggestion

No.

This field shows the number of the packing suggestion specified for the line.

Packing Suggestion

Status

This field shows the status of the specified packing suggestion.

Only certified suggestions can be used for dispatch orders.

Carrier ID For item lines, this field remains blank.

Weight per UOM This field shows the gross weight from the source document line.

You can change the value in this field on the dispatch line.

• 
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The data stored on the inventory pick lines is then used to fill in new dispatch lines as described in the following table.

Packing structure

For more details on how to add carriers or packaging materials to a dispatch order and assign them to one another, as well as

assign item lines to carriers or packaging materials, see Dispatch Lines.

Dispatch an order

Before a dispatch order can be sent (that is, posted), it must be released. The following checks are performed automatically when

an order is released:

Have the Shipment Method Code, Shipping Agent Code, Ship-to Name, Ship-to Country/Region Code and Ship-to Post Code

been filled in?

Has at least one carrier been specified on the order?

For single-package shipments:

Are carriers found only on level 1 of the packing structure and have the document lines been assigned to the specified

carriers?

If the answer to all these questions is Yes, the order will be released. Posting the order will:

Post the consumption of packaging material.

For single-package shipments, create a separate posted dispatch order for each carrier or package. The source document will

be displayed in the Single-Package Dispatch Parent Order No. field on every order.

Archive the posted document(s).

Dispatch orders for posted documents

Get posted documents

Field Description

Document Line Type This field is filled in with line type Item.

Document Line No. This field is filled in with the number of the item.

Packing Structure This field is not filled in automatically.

Description This field shows the item description from the source document line.

Serial No. This field is filled in if the inventory pick line contains an item tracking line with a serial number.

Lot No. This field is filled in if the inventory pick line contains an item tracking line with a lot number.

Quantity This field is filled in by the system.

Qty. to Handle This field is filled in by the system.

Unit of Measure Code This field shows the unit of measure used on the source document line.

Packing Suggestion

Group

This field is filled in if the packing suggestion entered for the order in the Packing Suggestion No.

field was calculated with the help of a suggestion group.

Packing Suggestion

No.

This field shows the number of the packing suggestion specified for the line.

Packing Suggestion

Status

This field shows the status of the specified packing suggestion.

Only certified suggestions can be used for dispatch orders.

Carrier ID For item lines, this field remains blank.

Weight per UOM This field shows the gross weight from the source document line.

You can change the value in this field on the dispatch line.

• 

• 

• 

• 

• 

• 
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You can copy data from the following posted documents to manually created dispatch orders by choosing Actions > Posted

Documents on the ribbon of an order:

Posted sales shipments

Posted service shipments

Posted transfer shipments

Posted return shipments

Regarding posted service shipments, the system copies only lines on which the For Dispatch Order checkbox is selected.

When data is copied from the first document, the Ship-to Address entered on it is transferred to the field with the same name on

the dispatch header. Each time you retrieve data from additional documents, you then see a message if the address initially

copied to the header is different from the one entered on the document that you want to copy. If you choose OK, the system will

create new document lines but leave the data on the header unchanged.

The information that was entered on the source document lines is then used to fill in new dispatch lines as described in the

following table.

Packing structure

For more details on how to add carriers or packaging materials to a dispatch order and assign them to one another, as well as

assign item lines to carriers or packaging materials, see Dispatch Lines.

• 

• 

• 

• 

Note

Field Description

Document Line Type This field is filled in with line type Item.

Document Line No. This field is filled in with the number of the item.

Packing Structure This field is not filled in automatically.

Description This field shows the item description from the source document line.

Serial No. This field is filled in if the source document line contains an item tracking line with a serial number.

Lot No. This field is filled in if the source document line contains an item tracking line with a lot number.

Quantity This field is filled in by the system.

Qty. to Handle This field is filled in by the system.

Unit of Measure Code This field shows the unit of measure used on the source document line.

Unit This field shows the unit of measure used on the source document line.

Packing Suggestion

Group

This field is filled in if the packing suggestion entered for the order in the Packing Suggestion No.

field was calculated with the help of a suggestion group.

Packing Suggestion

No.

This field shows the number of the packing suggestion specified for the line.

Packing Suggestion

Status

This field shows the status of the specified packing suggestion.

Only certified suggestions can be used for dispatch orders.

Carrier ID For item lines, this field remains blank.

Weight per UOM This field shows the gross weight from the source document line.

You can change the value in this field on the dispatch line.
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Dispatch an order

Before a dispatch order can be sent (that is, posted), it must be released. The following checks are performed automatically when

an order is released:

Have the Shipment Method Code, Shipping Agent Code, Ship-to Name, Ship-to Country/Region Code and Ship-to Post Code

been filled in?

Has at least one carrier been specified on the order?

For single-package shipments:

Are carriers found only on level 1 of the packing structure and have the document lines been assigned to the specified

carriers?

If the answer to all these questions is Yes, the order will be released. Posting the order will:

Post the consumption of packaging material.

For single-package shipments, create a separate posted dispatch order for each carrier or package. The source document will

be displayed in the Single-Package Dispatch Parent Order No. field on every order.

Archive the posted document(s).

Dispatch workflow

Besides the option of creating dispatch orders and lines based on unposted warehouse or inventory documents or based on 

posted documents, you can create or add lines to dispatch orders during certain logistics processes, as described in the

following. 

Picking

When you turn on the Create Dispatch from Pick toggle on a location card, you can create a dispatch order for the location when

you register a pick. As for the quantity to deliver, you can choose one of the following options after turning on the toggle

Dispatch Picked Qty. Only on the card:

Picked quantity

Picked quantity + registered quantities

For more information, see Locations – Dispatch.

Warehouse shipments

When you turn on the Dispatch for Whse. Shipments toggle on a location card, you can create a dispatch order or add quantities

to an existing order on the Warehouse Shipment page.

For more information, see Locations – Dispatch.

Process a packing suggestion

To create a set of instructions on how to pack items and carriers according to the suggestion numbers that were filled in on

dispatch lines, choose Actions > Functions > Process Packing Suggestions. The numbers were copied to the lines when you used

one of the functions to get data from a warehouse, an inventory, or a posted document.

When you run the action, the system creates a temporary structure with the help of the specified packing suggestion and the

links between suggestions and items that you set up on the Packing Suggestion Links page.

You cannot edit the structure that you see, but you can copy it to the order by choosing OK.

• 

• 

• 

• 

• 

• 

• 

• 
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Manual lines on dispatch orders (no warehouse, inventory, or posted documents)

To add document lines to a dispatch order manually:

Choose the Search icon, enter Dispatch Order List, and then choose the related link.

Open a dispatch order.

On the ribbon, choose Actions > Functions > Manual Line.

Fill in the fields as described in the following table.

This creates a dispatch line with the following field values on the lines:

Packing structure

For more details on how to add carriers or packaging materials to a dispatch order and assign them to one another, as well as

assign manually created lines to carriers or packaging materials, see Dispatch Lines.

Dispatch an order

Before a dispatch order can be sent (that is, posted), it must be released. The following checks are performed automatically when

an order is released:

Have the Shipment Method Code, Shipping Agent Code, Ship-to Name, Ship-to Country/Region Code and Ship-to Post Code

been filled in?

Has at least one carrier been specified on the order?

For single-package shipments:

Are carriers found only on level 1 of the packing structure and have the document lines been assigned to the specified

carriers?

1. 

2. 

3. 

4. 

Field Description

Description Specify a description for the dispatch line.

Quantity Enter a quantity for the line.

Field Description

Document Line Type Remains blank and cannot be changed.

Document Line No. Remains blank and cannot be changed.

Packing Structure Remains blank and cannot be changed.

Description Shows the entered description.

Serial No. Remains blank and cannot be changed.

Lot No. Remains blank and cannot be changed.

Quantity Shows the entered quantity.

Qty. to Handle The field is filled in by the system.

Unit of Measure Code Remains blank and cannot be changed.

Carrier ID Is determined automatically.

Weight per UOM Remains blank and cannot be changed.

• 

• 

• 
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If the answer to all these questions is Yes, the order will be released. Posting the order will:

Post the consumption of packaging material.

For single-package shipments, create a separate posted dispatch order for each carrier or package. The source document will

be displayed in the Single-Package Dispatch Parent Order No. field on every order.

Archive the posted document(s).

V-LOG dispatch

Besides the packing slip, wholesalers might need other shipping documents, especially a package label for use by the shipping

agent. The interface to the program used to ship orders is thus often adapted to meet the requirements of specific projects.

KUMAVISION base (BOOSTER) provides Dispatch users with an interface to V-LOG. With the help of V-LOG, they can automate

workflows for shipping orders via UPS, DHL, DPD, and other logistics companies and forwarders.

However, this means that all data needed for V-LOG transfers, for example, the delivery address, the number of packages, and

the weight, must be provided in a standardized format.

Additionally, you need to set up the interface in the system as described in the following:

V-LOG response fields

Some fields transmitted with a KUMAVISION V-LOG request must be copied over to the message returned by ecovium, as the

codes stored in them will need to be analyzed by the system after the response has been received.

No. Series

Specify a number series for future orders if necessary.

For more information on how to create a series, see Dispatch Setup.

Carrier Setup

Set up the carriers required for the interface.

For more information on how to set up a carrier, see Dispatch Setup.

Locations

Set up one or more locations with dispatch type Dispatch Orders.

Only locations with this setup can be transferred via the interface.

V-LOG Setup

• 

• 

• 

Field Used after receiving a response by ecovium to…

send_referenznr_02 …determine the PostedDispatchHandHeader of the specified shipment.

send_referenznr_06 …determine the postedDispatchHandlingLine of the specified package.

send_referenznr_07 …determine the postedDispatchHandlingLine of the specified package.

send_gewichteinzel …set the postedDispatchHandlingLine to Gross Weight (Scales).
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Turn on the interface itself.

Choose the Search icon, V-LOG Setup, and then choose the related link.

Fill in the fields as described in the following table.

Note

Usually, this interface is set up in collaboration with KUMAVISION staff.

Shipping agents

Specify V-LOG as the default dispatch provider for a shipping agent.

Choose the Search icon, enter Shipping Agents, and then choose the related link.

Select a shipping agent.

Select V-LOG in the Default Dispatch Provider field.

This option is used so that you don’t need to enter the provider manually on every new order. However, you can choose a

different provider if necessary.

1. 

2. 

Field Description

Active Turn on this toggle to activate the V-LOG interface.

Note

The interface should be turned on only after you finished configuring the web service endpoint.

Webservice

Endpoint

Specify an ecovium-compliant URL.

V-LOG Company Enter a company in an ecovium-compliant format.

Authentication Type Here you can choose between anonymous (none) and basic authentication. If basic authentication is

selected, fields for user name and password are also displayed. We expressly recommend connecting

V-Log with authentication. This applies in particular but not exclusively to SaaS environments. 

Other V-LOG authentication Types can be implemented on a project-specific basis.

Printer Select the printer that labels should be printed on.

Status Request

Cooldown (min)

Specify the cooldown period required between successive, manually triggered status requests on a V-

LOG line.

Another V-LOG update can only be requested by a user after the time entered in this field has passed.

Verify V-LOG

Postage Mapping

Specify whether the system should check for valid V-LOG postage mappings before dispatch orders

are released.

Use XML

Formatting

Turn on this toggle if you want to use the XML format to transfer the following values:

• 'Send_Date'

• 'Send_DateTime'

• 'inch_value'

• 'send_height'

• 'send_length'

• 'send_width'

• 'send_value of goods'

The option is turned on automatically when you first set up the interface.

For an existing setup, you can turn off this option to test if the program receiving the data can handle

the XML values.

1. 

2. 

3. 
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Transmissions to V-LOG mainly consist of numeric key values. If you want all dispatch orders shipped by an agent transmitted

through V-LOG, you need to enter the agent’s numeric value in the V-LOG Code field. This numerical value must be requested

from ecovium on a case-by-case basis.

Shipping method

A growing number of carriers require that you include a shipping method when you transmit data through V-LOG.

Choose the Search icon, enter Shipping Agents, and then choose the related link.

On the ribbon, choose Shipping Agent Services.

Select a line, and then fill in the fields described in the following table. 

V-LOG notes

1. 

2. 

3. 

Field Description

V-LOG Code Specify the numeric value of the carrier whose services that you want to use. The value must be

requested from ecovium on a case-by-case basis.

V-LOG Shipping

Method

Specify the shipping method that you want to transmit through V-LOG.

Note

This method is used to further specify the code entered in the previous field, but it is not always

required. Whether a method must be entered depends on the carrier that you have chosen.<>
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Additionally, you can add notes that the shipping agents require. These notes might include descriptions of the dispatch process

and customizable, numeric V-LOG codes that can later be assigned to an order. To add a note:

Choose the Search icon, enter Shipping Agents, and then choose the related link.

Select a shipping agent.

On the ribbon, choose Related > Line > Dispatch Notes.

Fill in the fields as described in the following table.

Shipping agent text

You can use the Shipping Agent Text field on dispatch orders to enter another note that you want to transmit to a shipping agent.

You can enter a maximum of 250 characters here.

Dispatch notes

You can also drill down on the Dispatch Notes field found on dispatch orders to select a V-LOG dispatch note that you assigned to

a certain shipping agent.

Status and package tracking requests

1. 

2. 

3. 

4. 

Field Description

Shipping Agent Shows the shipping agent for whom you want to add a note.

V-LOG Dispatch Note Enter a V-LOG code to categorize the dispatch note. For more information, see the following

table.

Description Specify a text that will be used as a description when you assign the note to a dispatch

order.

Numeric V-LOG Dispatch

Note

Specify a numeric V-LOG code manually, if necessary.

V-LOG Code Option Name ecovium Field Name

DEL Delivery Remarks Delivery Advice

SUR Miscellaneous Miscellaneous Information

SIN Tail Lift Required Tail Lift Required

SE Secured Secured

INV Order Group (Separate Billing) Consignment Group (for Separate Invoice)

RE Invoice Text Invoice Text

COD COD at Pickup COD for Collection

AVI Pickup Notice Advice Information for Collection

C01 Order Text 1 Order Text 1

C02 Order Text 2 Order Text 2

I01 Invoice Text 1 Invoice Text 1

I02 Invoice Text 2 Invoice Text 2

I03 Invoice Text 3 Invoice Text 3

I04 Invoice Text 4 Invoice Text 4

EAV Email Address Email Address
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If V-LOG isn’t used in Black Box mode or doesn’t return a tracking number for a package automatically, you can retrieve the

required information by scheduling a job queue entry for codeunit Codeunit 5049232 KVSKBAVLOGJobQueue .

This entry must include the value entered in the Status field. To get it, you need to set the following filters on each V-LOG line:

Published field is selected.

Completed field is selected.

V-LOG status code is neither 8?? nor 9??

Status transferred before the period specified in the Status Request Cooldown (min) field in V-LOG setup (default being 10

minutes). The codeunit can also be used to transmit all V-LOG lines in the Waiting status (see Interface Command field) to the

V-LOG program at once.

• 

• 

• 

• 
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Mapping V-LOG Interface Data Response to V-LOG
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V-LOG XML Tag Microsoft Dynamics 365 Business

Central1 Table

Field/Value

send_mandant KVSKBAPostedDispatchHandHeader "KVSKBA V-LOG Company"

send_frankaturkz Shipment Method "KVSKBA V-LOG Code"

empf_land_kurz PostedDispatchHandHeader "Ship-to Country/Region Code"

frachtfuehrer Shipping Agent "KVSKBA VLOG ShippingAgentCode"

empf_mail Customer "E-Mail"

send_referenznr_01 KVSKBAPostedDispatchHandHeader "No."

send_referenznr_02 KVSKBAPostedDispatchHandHeader "No."

empf_adr_01 KVSKBAPostedDispatchHandHeader "Ship-to Name"

empf_adr_02 KVSKBAPostedDispatchHandHeader "Ship-to Name 2"

empf_adr_03 KVSKBAPostedDispatchHandHeader "Ship-to Contact"

empf_ort KVSKBAPostedDispatchHandHeader "Ship-to City"

empf_plz KVSKBAPostedDispatchHandHeader "Ship-to Post Code"

empf_staat KVSKBAPostedDispatchHandHeader "Ship-to County"

empf_strasse KVSKBAPostedDispatchHandHeader "Ship-to Address"

empf_tel -

send_hilf_01 KVSKBAPostedDispatchHandHeader "KVSKBA V-LOG ShippingAgentText"

serviceindicator_count KVSKBAVLOGPostDispSvcInictr Count

collection_index empty

serviceindicatorcode KVSKBAVLOGPostDispSvcInictr "V-LOG Service Indicator"

send_serviceindicator KVSKBAVLOGPostDispSvcInictr "Numeric V-LOG ServiceIndicator"

send_serviceindicator_text_01 KVSKBAVLOGPostDispSvcInictr Description

send_artlademittel_01 KVSKBAVLOGCarrierMapping "V-Log Code"

send_beschreibunginhalt KVSKBAVLOGCarrierMapping Description

send_2n_prodcode Shipping Agent "KVSKBA VLOGShippingServiceCode"

send_versandart Shipping Agent KVSKBAVLOGShippingMethod

send_nr PacketNo

end_hoehe PostedDispatchHandlLine or Carrier Height

send_laeng PostedDispatchHandlLine or Carrier Length

send_breite PostedDispatchHandlLine or Carrier Width

send_gewichteinzel KVSKBAPostedDispatchHandlLine "Gross Weight (Scale)" or "Net Weight" +

KVSKBAPostedDispatchHandlLine.Tara

send_referenznr_06 KVSKBAPostedDispatchHandlLine "No."

send_referenznr_07 KVSKBAPostedDispatchHandlLine "Line No."

Zoll_InhaltKurzb Item "Tariff No."
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Data Response from V-LOG

Posted dispatch orders

To print a posted dispatch order:

Choose the Search icon, enter Posted Dispatch Orders List, and then choose the related link. Alternatively, open any posted order

linked to the dispatch order.

Select a dispatch order and choose Reports > Print. Alternatively, open the relevant document and choose Line > Dispatch.

If you open the posted order from a source document, the source document lines found on it are highlighted in blue.

SHIP LIMITED HAZMAT QUANTITIES

With the Dangerous Goods feature, you can restrict the amount of hazardous material that is handed over to forwarders with

each package and carrier per day and monitor compliance with these quantity specifications.

The functionality is meant to help you manage your company’s day-to-day operations but isn’t a replacement for apps covering all

aspects of dangerous goods handling. It cannot be used to automate the classification of hazardous materials, for example.

It also doesn’t provide the options needed to create safety and other datasheets, formulate operating guidelines, or implement rules

and checks regarding storage and mixed shipments.

You need a separate license before you can use this feature.

Setup

Hazmat classes

V-LOG XML Tag Microsoft Dynamics 365 Business

Central1 Table

Field/Value

send_Warenwert KVSKBAPostedDispatchHandlLine "KVSKBA V-LOG Value of Goods"

send_warenwertwaehrung 'EUR'

article empty

Send_TerminDatum KVSKBAPostedDispatchHandHeader "KVSKBA V-LOGAgreedShippingDate"

Send_TerminUhrzeit KVSKBAPostedDispatchHandHeader "KVSKBA V-LOGAgreedShippingTime"

zoll_waehrung 'EUR'

zoll_Wert KVSKBAPostedDispatchHandHeader "KVSKBA V-LOG Value of Goods"

XML Tag Microsoft Dynamics 365 Business Central1 Table Field/Value

send_referenznr_02 KVSKBAPostedDispatchHandHeader "No."

shipment_status KVSKBAVLOGInterfaceLine "V-LOG Status Code"

send_referenznr_06 KVSKBAPostedDispatchHandlLine "No."

send_referenznr_07 KVSKBAPostedDispatchHandlLine "Line No."

send_gewichteinzel KVSKBAPostedDispatchHandlLine "Gross Weight (Scale)"

send_id KVSKBAPostedDispatchHandlLine "Package Tracking No."

1. 

2. 

Note

Note
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As a first step, you need to set up hazmat classes that can later be assigned to hazmat IDs. To set up a class:

Choose the Search icon, enter Hazmat Classes, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Transportation categories

These categories indicate how likely it is that certain materials will cause an unreasonable risk to safety, health, and property

during shipping. The higher the number, the greater the danger posed by the material.

Typically ranging from 0 to 4, each category includes a factor (often, a value between 0 and 50) that is multiplied with the

amount of dangerous goods to be shipped, the result being the hazmat score assigned to the delivery.

To set up a category:

Choose the Search icon, enter Transportation Categories, and then choose the related link.

Fill in the fields as described in the following table.

Tunnel codes

A tunnel code—usually, in the form of A to E—is assigned to hazmat IDs to specify what types of dangerous goods can be

transported safely through tunnels with this code.

Choose the Search icon, enter Tunnel Codes, and then choose the related link.

Fill in the fields as described in the following table.

Hazmat classification

On the Hazmat Classification page, available via the general search function, you can specify the properties of dangerous goods,

such as whether they’re corrosive, toxic, or oxidizing.

Hazmat IDs

1. 

2. 

3. 

Field Description

Code Specify a code for the class of hazardous materials.

Description Specify a description for the class.

1. 

2. 

Field Description

Transportation Category Specify a code for the category.

Factor Specify the factor that will be used for the category as required by law.

1. 

2. 

Field Description

Code Specify a code for the tunnel restriction.

Description Enter a description for the restriction.

Field Description

Code Specify a code for the hazardous material classification.

Description Enter a description for the classification.
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To set up the numbers used to identify hazardous materials.

Choose the Search icon, enter Hazmat IDs, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Label items as dangerous

To label an item as potentially dangerous:

Open an item card.

On the Warehouse FastTab, fill in the Hazmat ID field.

You also must fill in the Hazmat Pts. per Base Unit field, as this score is used to monitor the quantity allowed per inner packaging

and carrier.

Maximum hazmat score (shipping agent)

Afterward, you need to specify the maximum number of hazmat points that are allowed on the supplier side:

Choose the Search icon, enter Shipping Agents, and then choose the related link.

Select the relevant agent, and then fill in the Max. Hazmat Pts. per Day field.

1. 

2. 

3. 

Field Description

Code Specify the code that will be used to identify the hazardous material.

UN Number Enter the code that the UN assigned to the material to classify it as a dangerous good which might

pose a risk to the public during transportation.

Hazmat Class Specify the class of hazardous materials that you want to assign to the ID.

Packing Group Specify the packing group that will be used for this ID.

Shipping Class Specify the shipping class that will be used for this ID.

Special Regulations If available, specify a code for special regulations governing this class of dangerous goods.

Limited Quantity Specify the maximum hazmat quantity that a package can contain according to the requirements for

limited quantities.

Excepted Quantity Specify the maximum hazmat quantity that a package can contain according to the requirements for

excepted quantities.

Unit of Measure Specify the unit of measure that will be used for limited and excepted quantities.

Description Specify a description for the hazmat ID.

Environmental

Hazard

Select this field if the material is considered harmful to the environment.

Transportation

Category

Specify the transportation category (typically, one between 0 and 4) that will be used for this ID.

The category indicates the likelihood that items with this hazmat ID will cause an unreasonable risk

to safety, health, and property when transported in commerce.

Factor Shows the multiplication factor that has been specified for the transportation category.

This factor is later multiplied with the quantity being shipped, the result of which will be assigned as

a hazmat score to the delivery.

Tunnel Code Shows the tunnel restrictions that will be in place for this hazard ID.

Classification Code Assign a classification to this ID.

1. 

2. 

3. 

1. 

2. 
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Workflow

Deliver hazmat materials

After a sales line containing dangerous goods is posted as shipped, you need to create a dispatch order and run the Posted

Documents action to copy data from the posted shipment to the new document. Afterward, you can fill in and post the order as

you’re used to.

Daily balance End of day worksheet (hazmat)

Before dangerous goods are handed over to a forwarder, the system checks if their shipment exceeds the maximum number of

hazmat points that a supplier can use per day.

To see the total score, open the End of Day Worksheet (Hazmat) page via the general search function. The page header shows the

following information:

You can then run the Get Lines function from the ribbon to copy to the page all posted dispatch lines on which dangerous goods

are entered but that have yet to be registered. The fields on the lines are described in the following table.

You can then use the Register function on the ribbon to confirm handover of the goods to the supplier.

Hazmat deliveries exceeding the daily point limit cannot be registered unless you lower the number of dispatch lines. Delete the

relevant lines from the journal and rerun the Register action. The lines you’ve removed are available again afterward.

Register a Daily Balance

To see the hazmat deliveries registered on a certain day:

Choose the Search icon, enter End of Day List (Hazmat), and then choose the related link.

On the ribbon, choose Report > Daily Balance to see a manifest of all dangerous goods shipments on the specified loading date.

Field Description

Loading Date Specifies on which date the dangerous goods were loaded by the shipping agent.

Loading Time Specifies at which time the dangerous goods were loaded by the shipping agent.

Total Score Shows the sum of hazardous material points from the worksheet lines.

Note

If this value exceeds the maximum number of points allowed per day, the score in the field is shown in red.

Max. Points Specifies the maximum number of points that are allowed for the relevant shipping agent per day.

Field Description

No. Shows the number of the posted dispatch order from which the hazmat line originates.

Ship-to Name Shows the name goods were shipped to according to the posted dispatch order from which the

hazmat line originates.

Shipping Agent Code Shows the agent who delivered the goods according to the posted dispatch order from which

the hazmat line originates.

Shipping Agent Service

Code

Shows the shipping agent service that was used according to the posted dispatch order from

which the hazmat line originates.

Total Score Shows the total hazardous material points, as entered on the posted dispatch order from which

the hazmat line originates.

Note

1. 

2. 

1.2.1 base (BOOSTER)

- 169/1545 - Copyright © 2018 - 2024 KUMAVISION AG



You also see the following information on an End of Day Card where goods have been registered:

The worksheet lines contain the posted dispatch lines that were copied to the carrier when the daily balance was registered.

Cancel and recreate a daily Balance

To cancel a daily balance:

Choose the Search icon, enter End of Day List (Hazmat), and then choose the related link.

Select the relevant end-of-day registration.

On the ribbon, run the Cancel action. The daily balance is deleted and the posted dispatch lines it contained can be re-registered in

another worksheet.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

No. Specifies the sequence number assigned to the daily balance.

Loading Date Specifies the loading date for the daily balance.

Loading Time Specifies the loading time for the daily balance.

Total Score Shows the sum of all hazmat points from the posted dispatch lines at the end of the day.

1. 

2. 

3. 

1. 
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Compliance

OVERVIEW

The Compliance functionality helps you design processes that can fulfil regulations such as FDA 21 CFR 11. It supplies, for

example, the operational system checks you need for properly certifying BOMs and routings, releasing items, vendors,

customers, and validation plans, and providing feedback on manufacturing operations.

You can specify individual regulatory requirements through table and field filters. If, following a change in data, you want to re-

release a record that must meet some of those requirements, a compliance document will be generated. This document then

needs to be approved by certain staff members prior to release.

You need a separate license before you can use this functionality. If you’re working with KUMAVISION medtec365 and the Workflow

and Notification Manager, you can also specify a workflow for handling approvals.

If you’re working with KUMAVISION healthcare365 and the Workflow and Notification Manager, you can also specify a workflow for

handling approvals.

SETUP

Compliance Setup

To set up compliance management:

Choose the Search icon, enter Compliance Setup, and then choose the related link.

Fill in the field as described in the following table.

Compliance permissions

Individual permissions

You set up permissions for users to specify who will be involved in each step of the compliance process. To set up a permission:

Choose the Search icon, enter Compliance Permissions, and then choose the related link.

Choose New on the ribbon.

Fill in the fields on the new line as described in the following table.

Permission groups

Note

Note

1. 

2. 

Field Description

Compliance Nos. Specify the number series that you want to use for compliance documents.

Legal Owner or Possessor Reqd. for

Rejection

Turn on this toggle if you want only the user who created a compliance document to

be able to reject it.

With the toggle turned off, all users who have the relevant compliance permissions

can reject the document.

1. 

2. 

3. 

Field Description

Code Enter a meaningful code to identify the permission. You can later assign this code to a permission group.

Description Enter a brief text to describe the permission.

1.2.1 base (BOOSTER)

- 171/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Individual permissions can be grouped before being assigned to a user authorized to manage compliance checks. To set up a

group:

Choose the Search icon, enter Compliance Permission Groups, and then choose the related link.

Choose New on the ribbon to insert a new line on the page.

Fill in the fields as described in the following table.

To add individual permissions to a group, fill in the Code fields on the Lines FastTab.

You can then enter a maximum net amount that values entered on purchase or sales documents will be checked against. If a

value you specify is exceeded, the document can no longer be released. Should you also require minimum amounts for multi-level

approval processes, you can enter them in the relevant Compliance Tables.

Compliance User Setup

This page specifies the users who are authorized to manage compliance checks. It also contains all digital signatures for case-

related functionality. To set up a user for compliance procedures:

Choose the Search icon, enter Compliance User Setup, and then choose the related link.

Choose New on the ribbon to insert a line for a new user.

Fill in the fields on the line as described in the following table.

If you’re using KUMAVISION medtec365, you can assign follow-ups at this point. For more information, click here.

Assign permission groups

1. 

2. 

3. 

Name Description

Code Enter a meaningful code to identify the permission group.

Description Enter a brief text to describe the group.

1. 

2. 

3. 

Field Description

User ID Specify the user for whom you want to add a signature.

Salespers./Purch. Code Shows the code from the field with the same name in standard user setup after you’ve entered an

ID.

Digital Signature Enter the digital signature of the user.

Signature Blocked Turn on this toggle if you want to block the user from using the entered signature.

Signature Fail Count Shows the number of times the user has entered the wrong digital signature.

Signature Blocking

Reason

Shows why the digital signature was blocked.

Reset Signature With the toggle turned on, the user’s digital signature needs to be updated before another

attempt to enter it can be made.

Note
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Any number of compliance permission groups can be assigned to a user. What the user is authorized for is covered by the

individual permissions assigned to a group. For example, if permission A is required for a certain compliance table, the user must

have this permission according to at least one assigned permission group. To assign a group:

Choose the Search icon, enter Compliance User Setup, and then choose the related link.

Select a user on a line.

Choose Compliance Permission Groups on the ribbon.

Fill in or change the group. If you change it, choose OK to confirm.

Compliance tables

You can specify in compliance tables for which records a check for compliance is required. To set up a table:

Choose the Search icon, enter Compliance Tables, and then choose the related link.

Choose New on the ribbon.

Fill in the fields on the new line as described in the following table.

1. 

2. 

3. 

4. 

1. 

2. 

3. 

Field Description

Code Enter a unique code for the data record.

Table No.

Table Caption

Specify a table for which you want to check compliance.

Note

Some tables have subtables that might become part of the compliance check.

Sorting If the system finds multiple entries that differ in their field filters, a record might be subject to

more than one release requirement.

You can then use this field to specify the order in which to check entries in the table. The sequence

is always ascending.

Description Specify an internal description for the table.

No. of Field Filters Shows how many requirements must be fulfilled before the table is said to be compliant with the

relevant regulation. You specify a requirement by choosing Compliance Fields on the ribbon.

Status Indicates if the table is part of the compliance process. Only in the Released status will a

compliance rule that you specified on the line be applied throughout the system.

Minimum Amount You can use this field to specify an amount limit on purchase and sales documents.

If this amount exceeds the total net value entered on the relevant document, approval will be

required.

Signature Required for

Release

Select this checkbox if you want each compliance release verified through the digital signature.

Change Permission

Code

Choose the code that permits changing the record. This will start the compliance process.

Release Permission

Code

Choose the code that permits release of the record.

Reject Permission

Code

Choose the code that permits rejection of the record.

Release 1-5 Select the releases, that is, approvals required for the record. You can have up to 5 levels of

approval.

Release 1-5

Permission Code

Select the permission codes for releases.
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If you’re using KUMAVISION medtec365, you’ll see additional options on this page. For more information about them, click here.

You can specify compliance requirements per table. To set a filter on a field:

Select a table.

Choose Compliance Fields on the ribbon.

Fill in the fields as described in the following table.

If you don’t fill in these fields, the entire record will be checked. This means that any change to the table will trigger a

compliance check.

If a field value has been specified, the system will check whether this value matches the field value in the relevant table. Only

then will it trigger a compliance check or set up a compliance record.

If you’re using KUMAVISION medtec365, you’ll see additional options on this page. For more information about them, click here.

For example, you might want to monitor the tracking code field of a certain item. The current value in the field is BE. You now

change the code to NL, which will generate a compliance document.

Or you might want to track changes to the Quote document type. The data records to be monitored have already been filtered

based on the Buy-from Vendor field, with the filter set on a specific vendor. When a quote is later created for the vendor, a

compliance document will be created as well.

Only if a data record meets at least one of the specified requirements will the system create a compliance document. Also, filling in a

table that has subtables might mean that they, too, will be checked for compliance. You can see the relations to subtables on the

Compliance Tables page by unhiding the Subtable ID Filter.

Audit trail (change log)

The Compliance functionality only logs the time when a compliance record was last modified and the ID of the user who modified

the record, whereas the content of the changes made to checked data are listed in a log called an Audit Trail.

Note

1. 

2. 

3. 

Field Description

Field No.

Field Caption

Specify the number of a field available in the selected table.

Field Value Specify a value for the field.

Note

Note
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However, you first need to set up this change log for—at least—the tables entered on the Compliance Tables page. To set up a

log:

Choose the Search icon, enter Change Log Setup, and then choose the related link.

Alternatively, enter Compliance List, select a data record, and choose Report > Audit Trail. You can also select an open or archived

record and then choose this function.

On the Change Log Setup card, turn on the Change Log Activated toggle.

On the ribbon, choose Tables and select the table for which you want to set up an audit trail.

In the Log Insertion, Log Modification, and Log Deletion fields on the line, you can specify if the log should include changes to

some or all fields.

To specify the exact fields when selecting the Some Fields option, choose the Assist button next to Log Insertion, Modification, or

Deletion to open a list of all fields in the relevant table. Depending on the log function you selected, you can then choose Insertion,

Modification, or Deletion on the relevant line.

Afterward, you can choose Audit Trail in open compliance records or the compliance list to see all changes that must be released,

whereas the Compliance List Archive—and archived compliance records in general—also include changes made previously.

MANAGE COMPLIANCE

Trigger compliance

Changing and releasing a record or completing data maintenance in a table triggers a check for compliance if one of the

conditions specified on the Compliance Tables page is met.

Following the change, you need to give a reason for why the data record needs to be released again. You can also enter a longer

explanation of the change via a separate text field if necessary. After you’ve entered a reason, the system informs you that the

record can only be released after the changes have been approved.

You can see the status and history of compliance procedures related to the record in the Compliance FactBox on the right.

Edit a compliance document

To see a compliance document:

Choose the Search icon, enter Compliance List, and then choose the related link.

This opens a list of all documents with open compliance procedures. Select a record and choose Manage > View on the ribbon.

Document approvals

Document releases (that is, approvals) are handled based on how you’ve set up the approval process for compliance documents.

To release a document:

Select the approvals in the Approvals area and choose Release on the ribbon.

Depending on the release option you chose for the relevant compliance table, the system might now ask you for your digital

signature.

When all approvers have released the compliance document, the source document is also released.

Following approval, the compliance document will be closed and archived.

Reject a document

To reject a document:

Select a record and choose Reject on the ribbon.

Enter a reason for the rejection. You can also enter a longer explanation in a separate field.

Following rejection, the compliance document will be closed and archived.

1. 

2. 

3. 

4. 

5. 

6. 

1. 

2. 

1. 

2. 

Note

1. 

2. 
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Based on what you specified in Compliance Setup, only the legal owner or possessor of a piece of equipment might be able to reject a

compliance document covering the machinery. The user who wants to reject the document must also have been granted the

necessary compliance permissions.

Audit trail (compliance card and list)

If you set up an audit trail, you can see a log of all changes by running the Audit Trail function on the card or list ribbon. The

basis for this trail is the change log you set up as described earlier (see Audit Trail (Change Log).

Compliance List Archive

To view already completed compliance documents, choose the Search icon, enter Compliance List Archive, and then choose the

related link.

The page that opens shows you two sets of records, the released and the rejected compliance documents.

Note
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Warranty Claims, Complaints, and FMEA

OVERVIEW

The Complaints Management functionality helps you handle warranty claims and customer complaints that concern products or

services provided by your organization.

Based on ISO 9001:2015 and ISO 13485:2016, “claim” and “complaint” have the following meaning when used in KUMAVISION

base (BOOSTER):

Claim

Refers to a specific product or service and grants legal remedies should the product or service not be up to standard.

Complaint

Voices displeasure with the quality of a product or service.

When you receive a claim or complaint, you can enter in the system the people and products or services written on the document

and the staff members who will investigate or review the matter. Staff can also look at the purchase, sales, service, or production

documents that might be relevant to the case.

The claim or complaint can then be reviewed, with the aim of taking preventive or corrective actions to remedy or mitigate

failures. The effectiveness of these measures can later be evaluated as part of a failure mode and effects analysis (FMEA).

You need separate licenses before you can use Complaints Management and FMEA functions.

SETUP

Claims and complaints

Warranty Claims & Complaints Setup

To be able to enter claims and complaints in the system, you must turn on the functionality first.

Choose the Search icon, enter Warranty Claims & Complaints Setup, and then choose the related link.

Fill in the fields as described in the following table.

General

If you’re using KUMAVISION medtec365, you can see additional options for adjusting transaction codes on this page. For more

information, click here. 

Warranty Claims

In the Warranty Claim Nos. field, specify a number series that will be used for warranty claims.

Note

1. 

2. 

Field Description

Contact Creation Specify whether you want a contact created automatically when you receive a claim or complaint by a

person or organization not yet stored in the system.

Update Contact Specify whether data for an existing contact who is involved in a claim or complaint should be

updated if some of the information given on the document differs from what is stored in the system.

Check Digital

Signature

Turn on this toggle if a user’s signature should be required when a complaint, claim, or FMEA card is

released, reopened, archived, or deleted.

Note

1.2.1 base (BOOSTER)

- 177/1545 - Copyright © 2018 - 2024 KUMAVISION AG



For all other fields, use the Create Permissions action on the ribbon to assign codes to functions for which permissions should be

checked.

Complaints

In the Complaint Nos. field, specify a number series that will be used to assign numbers to complaints.

For all other fields, use the Create Permissions action on the ribbon to assign codes to functions for which permissions should be

checked.

Ribbon Function

Choose Create Permissions to have permission codes initialized during setup of the functionality and copied to the Claim &

Complaint Permissions page.

Do not rerun this function after the permission codes have been initialized.

Claim & Complaint Permissions

For more information on how to initialize the values shown on this page, see Warranty Claims & Complaints Setup.

For users to be able to view claims or complaints, they must have at least the Read permission assigned to an associated

permission group.

Claim & Complaint Permission Groups

On this page, claim and complaint permissions can be grouped on the lines.

The Super permission group must contain each individual permission for a claim or complaint.

Warranty Claims & Complaints User Setup

To specify who can use the functionality and store their digital signatures:

Choose the Search icon, enter Warranty Claims & Complaints User Setup, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Note

Note

1. 

2. 

3. 

Field Description

User ID Select the ID of the user for whom you want to enter a digital signature.

Digital Signature Specify the user’s digital signature.

Signature Blocked Turn on the toggle if you want to block this signature from being used.

Signature Fail Count Shows the number of times the wrong signature was entered.

Following three failed attempts, the Signature Blocked toggle turns on automatically. The reason for

blocking the sign-off is then shown in the Signature Blocking Reason field.

Signature Blocking

Reason

Shows why the signature was blocked.

Reset Signature With the toggle turned on, the signature needs to be updated before it can be used again.
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You can then assign permissions in groups to a user authorized to manage claims and complaints:

Select the line on which to find the relevant user.

On the ribbon, choose Claim & Complaint Permission Groups.

Any number of groups can be assigned to the user. If a specific permission is required for a complaint, the user must have this

permission in at least one of the assigned groups.

Failures

On the Analysis FastTab of claims and complaints, you can specify a code for every category of failures that you want to record.

For a complete, meaningful evaluation of claims and complaints, each of these categories needs to cover as many defects and

errors as possible. To set up a code:

Choose the Search icon, enter Failure Categories, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

The type and subtype specified for a claim or complaint determine the codes available on the Analysis FastTab of the claim or

complaint card. If no type or subtype has been specified, all codes will be available for selection, including those that haven’t

been assigned anywhere.

The system doesn’t check if the case type or subtype that you selected is valid.

• 

• 

1. 

2. 

3. 

Field Description

Code Specify a code that clearly identifies the failure.

Type Specify for which document the code can be selected.

(blank)

You can select this category on claims and complaints.

Complaint

The category is only available for complaints.

Warranty Claim

The category is only available for claims.

Description Here you can enter a more detailed description of the error.

Description 2 Here you can enter even more details.

Case Type Code Specify for which type of case the code can be selected.

Case Subtype Code Specify for which subtype of a case the code can be selected.

Note
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Authorities

To set up the authorities to which incidents must be reported:

Choose the Search icon, enter Authorities, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Government authorities that must be notified of certain claims or complaints are later entered on the Analysis FastTab of a claim

or complaint card.

Reasons for rejecting cases

To specify reasons why a claim or complaint might have been rejected:

Choose the Search icon, enter Case Rejection Reasons, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

A rejection reason code must be filled in when the Justified field on a claim or complaint card that you want to close has been set

to No. The codes can be found on both open and archived document lists.

Types and subtypes of cases

To specify case types:

Choose the Search icon, enter Case Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

1. 

2. 

3. 

Field Description

Code Specify a code for the agency to which incidents must be reported.

Description Enter a brief description of the agency.

1. 

2. 

3. 

Field Description

Code Specify a code for the rejection reason. The code must be unique.

Description Describe why the claim or complaint is being rejected.

Relevant to

Statistics

Specify if the rejection reason should be included in statistical analyses.

This checkbox can be used for informational purposes or as part of BI functionality.

Default Select a procedure that the system needs to follow in certain situations.

(blank)

No default procedure to follow.

Closed by Class Change

If you reclassify a warranty claim or complaint, the system will archive the document with this option

selected in the Rejection Reason Code field on the claim or complaint card.

1. 

2. 

3. 

Field Description

Code Specify a code for the type. The code must be unique.

Description Specify a description for the type.

No. of Case Subtypes Indicates the number of subtypes assigned to this type. You can select this field to see the subtypes.
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To assign subtypes to a certain type:

Select the highlighted No. of Case Subtypes field. Alternatively, select a line and choose Case Subtypes on the ribbon.

Fill in the fields as described in the following table.

Both types and subtypes might be linked to a claim or complaint, for example, to distinguish between complaints by document

type. You assign them to documents in the fields described in the following table.

Although archived claims and complaints also include these types, you cannot edit them there.

Actions

Mitigation and remedial measures can be maintained in the system as stand-alone actions or in the context of specific claims,

complaints, or FMEAs. For this reason, they cannot be specified in Warranty Claims & Complaints Setup.

Action Setup

To set up actions for use throughout the system:

Choose the Search icon, enter Action Setup, and then choose the related link.

Fill in the fields as described in the following table.

General

Permissions

On this FastTab, codes are assigned to functions for which permission checks should be performed. To initialize these codes,

choose Create Permissions on the ribbon.

For users to be able to view actions, they must have at least the Read permission assigned to an associated permission group.

Do not rerun this function after the permission codes have been initialized.

Action Permissions

For more information on how to initialize the values shown on this page, see Actions Setup.

Action Permission Groups

On this page, action permissions can be grouped on the lines.

1. 

2. 

Field Description

Code Specify a code for the subtype. The code must be unique.

Description Specify a description for the subtype.

Field Description

Type Select a case type from the Case Types page.

Subtype Select a subtype from the Case Subtype page based on the type of case specified.

1. 

2. 

Field Description

Action Nos. Specify the number series that will be used for actions.

Action Data Check Turn on this toggle if you want to activate the mandatory field check feature for actions.

Check Risk Assessment

Texts

Specify if risk assessment texts need to be available when an action card is closed or an FMEA (or

an archived FMEA) has been linked to the action.

Note
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Action User Setup

Here you can assign permissions in groups to a user authorized to manage actions. To assign a group:

Select the line on which to find the relevant user.

On the ribbon, choose Action Permission Groups.

Any number of groups can be assigned to the user. If a specific permission is required for an action, the user must have this

permission in at least one of the assigned groups.

The setup on this page doesn’t replace the roles and permissions specified for a user elsewhere in the system.

Case CAPA

CAPA stands for Corrective and Preventive Actions. This quality management subsystem is part of the continuous improvement

process (CIP).

A CAPA process ensures GMP-compliant work through identifying deviations from a specified standard before corrective and

preventive actions are taken.

CAPA are used to immediately correct a failure and avoid further repercussions.

To set up a procedure:

Choose the Search icon, enter Case CAPA, and then choose the related link.

Fill in the fields as described in the following table.

CAPA codes are used on action cards in the Action Code field on the General FastTab. What codes are available depends on what

you choose in the Action Type field there.

FMEA

FMEA, which is short for Failure Mode and Effects Analysis, is used to assess the risks associated with an error or a defect.

Because FMEAs can be created from actions or as stand-alone solutions, you cannot specify them in Warranty Claims &

Complaints Setup.

FMEA Risk Matrix Field Setup

Before you can work with risk matrices, you must specify a color scheme for the graphs.

• 

• 

Note

Note

1. 

2. 

Field Description

Code Specify a code for the CAPA.

Type Specify for which type of action the code can be selected:

• (blank)

• Corrective

• Preventive

Description Specify a description for the CAPA.

Description 2 Enter a more detailed description of the CAPA if necessary.
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Based on a set of x and y coordinates [(1|1) – (4|4)], these colors can then help you visualize, for example, if the severity or effect

probability associated with a certain failure has changed since the last time you printed a matrix for it. To initialize the colors:

Choose the Search icon, enter FMEA Risk Matrix Setup, and then choose the related link.

Select a line and fill in the fields as described in the following table.

Repeat the process until a color has been specified for all coordinates.

You can also choose New > Initialize on the ribbon to have the system set up a default color scheme or reset the current matrix

to those default values.

FMEA Setup

To set up FMEAs for use throughout the system:

Choose the Search icon, enter FMEA Setup, and then choose the related link.

Fill in the fields as described in the following.

General

In the FMEA Nos. field, specify the number series that will be used for analyses.

Permissions

On this FastTab, codes are assigned to functions for which permission checks should be performed. To initialize these codes,

choose Create Permissions on the ribbon.

Do not rerun this function after the permission codes have been initialized.

Indicators

On this FastTab, specify the indicators that will be shown on FMEA lines when the analyzed values exceed certain risk priority

thresholds.

1. 

2. 

3. 

Field Description

X Axis Specify the X coordinate (1 – 4) that will be assigned to this line on the matrix.

Y Axis Specify the X coordinate (1 – 4) that will be assigned to this line on the matrix.

Field No. Select what field content should be shown at the coordinates entered in the X Axis and Y Axis fields.

Field Caption Shows the caption of the matrix field that you selected a Field No. for.

1. 

2. 

Note

Field Description

Green Light Select this field to choose an image file that, as part of a traffic light system, should represent the green

light on FMEA lines.

Yellow Light Select this field to choose an image file that, as part of a traffic light system, should represent the yellow

light on FMEA lines.

Red Light Select this field to choose an image file that, as part of a traffic light system, should represent the red light

on FMEA lines.
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Changing the files will not update the images that have already been in use on open and archived FMEA lines unless you also change

something else on these lines.

FMEA Permissions

For more information on how to initialize the values shown on this page, see FMEA Setup.

FMEA Permission Groups

On this page, FMEA permissions can be grouped on the lines.

For users to be able to view analyses, they must have at least the Read permission assigned to an associated permission group.

FMEA User Setup

Here you can assign permissions in groups to a user authorized to perform analyses:

Select the line on which to find the relevant user.

On the ribbon, choose FMEA Permission Groups.

Any number of groups can be assigned to the user. If a specific permission is required for an analysis, the user must have this

permission in at least one of the assigned groups.

Only users entered on this page can view, create, or edit FMEAs.

Internal claims and complaints

You can also register claims and complaints that arise within a company, for example, while a product is being manufactured. To

set up a case that will be handled internally:

Create a new contact card and fill in your company information.

Select Internal on the card.

Proceed as if the claim or complaint came from an external contact.

REGISTER A WARRANTY CLAIM

To register a claim in the system:

Open the card of an existing contact, customer, or vendor for which you want to register a claim.

Choose New Case on the ribbon.

Choose Warranty Claim.

The data stored for the contact, customer, or vendor is then copied to the claim automatically. The other fields must be filled in as

described in the following table.

This is the only way to register a claim in the system; you cannot choose New on the ribbon of a warranty claim list.

Note

• 

• 

Note

• 

• 

• 

1. 

2. 

3. 

4. 

Note
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Field Description

No. Shows the number of the claim document. This number is assigned by the system and cannot be

changed manually.

Description Enter a brief text that describes the claim.

Type Specify if the claim was received internally or from a vendor or customer.

Vendor No.

Customer No.

Based on the type of claim, one of these fields might be filled in automatically.

If the wrong vendor or customer has been entered, you must create a new record and close the

current case.

Contact No. This field is always filled in and cannot be changed.

Name

Name 2

Based on the type of claim, these fields show the name and additional name of a vendor, customer,

or contact.

Note Shows if notes have been entered for a customer or vendor.

Justified Specify if the claim is justified.

(blank)

The claim has not been classified yet.

Yes

Is justified.

No

Is not justified.

Goodwill

Is accepted because of a goodwill policy.

Classifying the claim will open an editor in which you must enter the reason for the classification.

Without entering something there, the claim cannot be (re)classified.

Justification Text Selecting Yes in the Justified field will open an editor in which you must enter a text to explain why

the claim is considered justified.

Only the first line of text entered in the editor will later be shown in this field, regardless of

whether the line comes from a justification or analysis. You can adjust this in the editor.

Changes to the text will be added as new versions to the description of the analysis.

Rejection Reason Code Select a code for why the claim was rejected.

You can only select a code if the Justified field is set to No; you can then close the case if

necessary.

Changing the Justified field will remove the code in this field.

Rejection Reason

Description

Shows a text that describes the rejection.

Status Indicates the status of the claim.

Open

The document can be edited.

Released

The document requires only final review.
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Reported By

This FastTab shows the person who made the claim.

If the person has been entered as a contact, data from the contact master is entered automatically on this FastTab. With a CTI

system connected to Microsoft Dynamics 365 Business Central1, you can also call the person from the app.

Other contacts can be entered on the following lines. For people already in the system, this means that each contact linked to the

person who made the claim can be chosen in the No. field.

The details of these contacts are then filled in by the system if automatic contact creation has been turned on in Warranty Claims

& Complaints Setup. Else, you need to fill in the line fields manually.

Reported For

This FastTab is used to enter the items, services (resources or G/L accounts), and other things that were named in the claim and

that the person who made the claim has reported issues with.

You can also have the lines filled in with data from documents available in the system. For more information, see Ribbon Actions.

If you fill in the lines manually, you should do so field by field, starting with the Type field. This ensures that, for example, you can

enter things not maintained in the app—for example, because a warranty claim had not been resolved prior to switching to

another software system.

Registration Text

On this FastTab, you can use a plain text editor to note down the conversation that led to registering the case in the system.

Choose New Text on the ribbon to make an entry. When you’re finished, the text will be displayed on the tab. 

Texts are versioned. For more information on how to enter text here, see Enter Text.

Field Description

If the signature feature has been turned on, the status will not change until the specified signature

has been entered.

Source No. If the claim was created by converting a complaint, this field is filled in with the number of the

complaint document.

Case Type Code Choose a code to specify the type of case being handled.

Case Subtype Code Choose a code to specify the subtype of the case.

Assigned User ID Select an ID in this field to assign a user to the claim.

No. of FMEAs Shows the number of analyses linked to the claim.

No. of Archived

FMEAs

Shows the number of archived analyses linked to the claim.

No. of FMEA Actions Shows the number of FMEA actions implemented to resolve the claim.

No. of Archived FMEA

Actions

Shows the number of archived FMEA actions implemented to resolve the claim.
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Analysis

On this FastTab, you can document the analysis of the issues named on the claim document.

Assigned Actions

On this tab, you can link preventive and corrective actions to open claims or create new action cards based on the claims for use

on other documents.

All actions are managed on cards. Actions created or entered for a claim are transferred along when you archive the document.

Field Description

Analyzed On

Analyzed By

These fields specify who analyzed the claim and when.

Analysis Reviewed On

Analysis Reviewed By

These fields specify who checked the analysis and when.

Note

The user who checks the analysis cannot also be the user who performed it (dual control

principle).

Notification Required Turn on this toggle if the warranty claim must be reported to the authorities.

Notifications to

Authorities

Indicates how many notifications are related to the case. You can select the blue hyperlink to view

or enter notifications.

Note

You cannot transmit notifications from Microsoft Dynamics 365 Business Central1.

Assigned Failures On this FastTab, you can categorize the errors or defects that were found during analysis by using

the failure codes set up in the system.

You must fill in the Failure Code field here. The Description and Description 2 fields are filled in

from Warranty Claims & Complaints Setup.

Analysis Text Shows the analysis and justification texts that have already been entered in the system.
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You can only close claims for which all actions have been set to Implemented.

Ribbon actions

Based on whether the claim you registered came from a customer, a vendor, or an internal source, the ribbon found on the

warranty claim card will display different functions.

To open a customer or vendor card or the contact list, choose Home and the corresponding option.

To retrieve data from a vendor or customer document, choose Get Document and the relevant document.

If a complaint comes from an internal source, some of the functions might be grayed out or might only be available to a limited

extent, considering there are no outbound documents to manage.

To change the status of a complaint, choose Status and the relevant option.

To enter text for registration, analysis, or in other situations, choose Actions > Functions > New Text. For more information, see

Enter Text.

To print a claim, choose Print > C & C Sheet. You can then fill in the No. of Copies field to specify how many copies of the

document you want printed and choose what to include on each by turning toggles on or off.

To create a new action for a claim, choose Create Action on the ribbon. To create a new FMEA, choose Create FMEA.

To reclassify a claim, choose Actions > Functions > Change Classification. 

For a list of who created, edited, or deleted entries on a complaint, choose Related > Change Log on the ribbon.

Note

Field Description

Action Card No. Specify the action card that you want to assign to the claim.

Failure Code Assign a failure code to the claim.

If an action is created from the Analysis FastTab, the failure code used for analysis will be

copied to the card created for this action.

Description Shows the description of the action as specified on the related action card.

Description 2 Shows the additional description of the action as specified on the related action card.

Status Shows the status of the action as specified on the related action card.

Action Type Shows the type of the action as specified on the related action card.

Action Code Shows the code of the action as specified on the related action card.

Successful Shows the content of the field from the related action card.

No. of FMEAs Shows the number of FMEAs entered on the action card.

No. of FMEA Actions Shows the number of FMEA actions entered on the action card.

No. of Archived FMEAs Shows the number of archived FMEAs specified on the action card.

No. of Archived FMEA

Actions

Shows the number of archived FMEA actions specified on the action card.
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EDIT A CLAIM

To change information on a warranty claim:

Choose the Search icon, enter Warranty Claims, and then choose the related link.

Select a claim and choose Edit on the ribbon.

You can now add details to the document, such as the items named on the document (by filling in the relevant fields on the Issues

Reported For FastTab).

If you also want to perform an FMEA (only possible from a claim or an action), choose Create FMEA on the ribbon. For more

details on how errors or defects can be analyzed, see Perform an analysis.

When all required data has been entered, the claim can be released by choosing Release on the ribbon.

If the release of the claim requires your signature, you need to sign in the Digital Signature field on the query that appears and

choose OK.

The claim is then released. It’s not closed yet.

REGISTER A COMPLAINT

To set up a complaint in the system:

Open the card of an existing contact, customer, or vendor for which you want to register a complaint.

Choose New Case on the ribbon.

Choose Complaint.

The data stored for the contact, customer, or vendor is then copied to the complaint automatically. The other fields must be filled in

as described in the following table.

This is the only way to register a complaint in the system; you cannot choose New on the ribbon of a complaint list.

1. 

2. 

3. 

Note

1. 

2. 

3. 

4. 

Note
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General
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Field Description

No. Shows the number of the complaint document. This number is assigned by the system and cannot

be changed manually.

Description Enter a brief text that describes the complaint.

Type Specify if the complaint was received internally or from a vendor or customer.

Vendor No.

Customer No.

Based on the type of complaint, one of these fields might be filled in automatically.

If the wrong vendor or customer has been entered, you must create a new record and close the

current case.

Contact No. This field is always filled in and cannot be changed.

Name

Name 2

Based on the type of complaint, these fields show the name and additional name of a vendor,

customer, or contact.

Note Shows if notes have been entered for a customer or vendor.

Justified Specify if the complaint is justified.

(blank)

The complaint has not been classified yet.

Yes

Is justified.

No

Is not justified.

Goodwill

Is accepted because of a goodwill policy.

Classifying the complaint will open an editor where you must enter the reason for the

classification. Without entering something there, the complaint cannot be (re)classified.

Justification Text Filling in the Justified field will open an editor in which you must enter a text to describe why the

complaint is justified.

Only the first line of text entered in the editor will later be shown in this field, regardless of

whether the line comes from a justification or analysis. You can adjust this in the editor.

Changes to the text will be added as new versions to the description of the analysis.

Rejection Reason Code Select a code for why the complaint was rejected.

You can only select a code if the Justified field is set to No; you can then close the case if

necessary.

Changing the Justified field will remove the code in this field.

Rejection Reason

Description

Shows a text that describes the rejection.

Status Indicates the status of the complaint.

Open

The document can be edited.

Released

The document requires only final review.
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Reported By

This FastTab shows the person who made the complaint.

If the person has been entered as a contact, data from the contact master is entered automatically on this FastTab. With a CTI

system connected to Microsoft Dynamics 365 Business Central1, you can also call the person from the app.

Other contacts can be entered on the following lines. For people already in the system, this means that each contact linked to the

person who made the complaint can be chosen in the No. field.

The details of these contacts are then filled in by the system if automatic contact creation has been turned on in Warranty Claims

& Complaints Setup. Else, you need to fill in the line fields manually.

Reported For

This FastTab is used to enter the items, services (resources or G/L accounts), and other things that were named in the complaint

and that the person who made the complaint has reported issues with.

You can also have the lines filled in with data from documents available in the system. For more information, see Ribbon Actions.

If you fill in the lines manually, you should do so field by field, starting with the Type field. This ensures that, for example, you can

enter things not maintained in the app—for example, because a complaint had not been resolved prior to switching to another

software system.

Registration Text

On this FastTab, you can use a plain text editor to note down the conversation that led to registering the case in the system.

Choose New Text on the ribbon to make an entry. When you’re finished, the text will be displayed on the tab.

Texts are versioned. For more information on how to enter text here, see Enter Text.

Field Description

If the signature feature has been turned on, the status will not change until the specified signature

has been entered.

Source No. If the complaint was created by converting a warranty claim, this field is filled in with the number

of the claim document.

Case Type Code Choose a code to specify the type of case being handled.

Case Subtype Code Choose a code to specify the subtype of the case.

Assigned User ID Select an ID in this field to assign a user to the complaint.

No. of FMEAs Shows the number of analyses linked to the complaint.

No. of Archived

FMEAs

Shows the number of archived analyses linked to the complaint.

No. of FMEA Actions Shows the number of FMEA actions implemented to resolve the complaint.

No. of Archived FMEA

Actions

Shows the number of archived FMEA actions implemented to resolve the complaint.
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Analysis

On this FastTab, you can document the analysis of the issues named on the complaint document.

Assigned Actions

On this tab, you can link preventive and corrective actions to open complaints or create new action cards based on the

complaints for use on other documents.

All actions are managed on cards. Actions created or entered for a complaint are transferred along when you archive the

document.

Field Description

Analyzed On

Analyzed By

These fields specify who analyzed the complaint and when.

Analysis Reviewed On

Analysis Reviewed By

These fields specify who checked the analysis and when.

Note

The user who checks the analysis cannot also be the user who performed it (dual control

principle).

Notification Required Turn on this toggle if the complaint must be reported to the authorities.

Notifications to

Authorities

Indicates how many notifications are related to the case. You can select the blue hyperlink to view

or enter notifications.

Note

You cannot transmit notifications from Microsoft Dynamics 365 Business Central1.

Assigned Failures On this FastTab, you can categorize the errors or defects that were found during analysis by using

the failure codes set up in the system.

You must fill in the Failure Code field here. The Description and Description 2 fields are filled in

from Warranty Claims & Complaints Setup.

Analysis text Shows the analysis and justification texts that have already been entered in the system.
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You can only close complaints for which all actions have been set to Implemented.

Ribbon actions

Based on whether the complaint you registered came from a customer, a vendor, or an internal source, the ribbon found on the

complaint card will display different functions.

To open a customer or vendor card or the contact list, choose Home and the corresponding option.

To retrieve data from a vendor or customer document, choose Get Document and the relevant document.

If a complaint comes from an internal source, some of the functions might be grayed out or might only be available to a limited

extent, considering there are no outbound documents to manage.

To change the status of a complaint, choose Status and the relevant option. To enter text for registration, analysis, or in other

situations, choose Actions > Functions > New Text. For more information, see Enter Text.

To print a complaint, choose Print > C & C Sheet. You can then fill in the No. of Copies field to specify how many copies of the

document you want printed and choose what to include on each by turning toggles on or off.

For a list of who created, edited, or deleted entries on a complaint, choose Related > Change Log on the ribbon.

EDIT A COMPLAINT

To change information on a complaint:

Choose the Search icon, enter Complaints, and then choose the related link.

Select a complaint and choose Edit on the ribbon.

You can now add details to the document, such as the name and ID of the second person who will be participating in dual-control

procedures (by filling in the relevant fields on the Analysis FastTab).

Note

Field Description

Action Card No. Specify the action card that you want to assign to the complaint.

Failure Code Assign a failure code to the complaint.

If an action is created from the Analysis FastTab, the failure code used for analysis will be

copied to the card created for this action.

Description Shows the description of the action as specified on the related action card.

Description 2 Shows the additional description of the action as specified on the related action card.

Status Shows the status of the action as specified on the related action card.

Action Type Shows the type of the action as specified on the related action card.

Action Code Shows the code of the action as specified on the related action card.

Successful Shows the content of the field from the related action card.

No. of FMEAs Shows the number of FMEAs entered on the action card.

No. of FMEA Actions Shows the number of FMEA actions entered on the action card.

No. of Archived FMEAs Shows the number of archived FMEAs specified on the action card.

No. of Archived FMEA

Actions

Shows the number of archived FMEA actions specified on the action card.

1. 

2. 

3. 
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For more information, see Analysis. When all required data has been entered, the complaint can be released by choosing Release

on the ribbon.

If the release of the complaint requires your signature, you need to sign in the Digital Signature field on the query that appears and

choose OK.

The complaint is then released. It’s not closed yet.

CONVERT A CLAIM TO A COMPLAINT

If, when you process a warranty claim, you determine that what you’re working on reads more like a complaint than a claim with

a legal basis, you can create a complaint from the document that you originally registered in the system as a claim while keeping

the information you’ve already recorded.

To convert a claim:

Choose the Search icon, enter Warranty Claims, and then choose the related link.

Open the claim that you want to convert into a complaint. The status of a released claim will be reset during this process.

On the ribbon, choose Change Classification and choose OK.

The claim is then converted, and all available information is transferred to the complaint. Afterward, the original claim will be

closed and archived.

Reclassification is indicated on a claim in the Rejection Reason Code and the Rejection Reason Text fields. For the fields to be

filled in, you must have set them up as described under Reasons for Rejecting Cases.

You can open an archived claim that is the source of a complaint by clicking the highlighted portion of the Source No. field on the

complaint card. After you’ve finished filling in the new complaint document, choose OK to exit.

CONVERT A COMPLAINT TO A CLAIM

If, when you process a complaint, you determine that the case you’re working on reads more like a warranty claim, you can

create a warranty claim from the complaint while keeping the information you’ve already recorded. To convert a complaint:

Choose the Search icon, enter Complaints, and then choose the related link.

Open the complaint that you want to convert into a claim. The status of a released complaint will be reset during this process.

On the ribbon, choose Change Classification and choose OK.

The complaint is then converted, and all available information is copied to the claim. Afterward, the original complaint will be

closed and archived.

Reclassification is indicated on a complaint in the Rejection Reason Code and the Rejection Reason Text fields. For the fields to

be filled in, you must have set them up as described under Reasons for Rejecting Cases.

You can open an archived complaint that is the source of a warranty claim by clicking the highlighted portion of the Source No.

field on the claim card.

After you’ve finished filling in the new claim document, choose OK to exit.

CLOSE A CLAIM OR COMPLAINT

Claims and complaints that have been processed and set to Released can be closed and archived by using a ribbon function.

Note

1. 

2. 

3. 

1. 

2. 

3. 
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Close a warranty claim

All warranty claims can be closed and archived after processing. To close a claim:

Choose the Search icon, enter Warranty Claims, and then choose the related link.

Select the claim that you want to close.

On the ribbon, choose Close Case and choose Yes to confirm.

If the Justified field on the complaint was set to No, a rejection reason code must be entered before you can close the document.

You also might need to enter your digital signature if closing the case requires it.

Archived claims can be viewed on the Warranty Claims Archive page.

Close a complaint

All complaints can be closed and archived after being processed. To close a complaint:

Choose the Search icon, enter Complaints, and then choose the related link.

Select the complaint that you want to close.

On the ribbon, choose Close Case and choose Yes to confirm.

If the Justified field on the complaint was set to No, a rejection reason code must be entered before you can close the document.

You also might need to enter your digital signature if closing the case requires it.

Archived complaints can be viewed on the Complaints Archive page.

IMPLEMENT ACTIONS

Actions are recorded on cards, which contain all necessary information, such as contact details and item specifications linked to

a case. A Failure Modes and Effects Analysis and a risk matrix can be created based on them as well. For more information about

the latter, see FMEA Risk Matrices.

Besides creating and implementing actions because of a claim or complaint, actions can also be created and implemented on

their own.

Create an action

To create an action on its own:

Choose the Search icon, enter Actions, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following tables.

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 
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General

Risk Assessment

Field Description

No. Shows the action number assigned from the series set up for this purpose (see Action Setup).

Action Type Specify whether the action is corrective or preventive.

Action Code Choose the code of an action entered on the Case CAPA page.

The codes that are available depend on what option has been selected in the Action Type field.

Description Specify a description for the action.

Description 2 Here you can enter an additional description of the action.

Source Type Indicates from where the action originates.

(empty)

The action has no source.

Action Card

The action was created as a follow-up to another action.

Complaint

The action was created from a complaint document.

Claim

The action was created from a claim document.

FMEA

The action was created during an analysis.

Source No. Specify the number of an action card, a complaint or claim document, or an FMEA based on the

option you selected in the Source Type field.

Status Indicates the status of the action card.

Open

The card is ready for editing.

Closed

The action is completed. You can no longer edit or reopen the card.

Successfully

Implemented

Shows if the action was successfully implemented.

The toggle turns on automatically, for example, when the Success Evaluated toggle is turned on.

If the field is set to No when a card is completed, a follow-up action is created automatically if

necessary.

Successfully

Implemented On

Shows when the Successfully Implemented toggle was turned on.

Successfully

Implemented By

Shows who was logged on to the system when the Successfully Implemented toggle was turned

on.

Follow-Up Action No. Specify a follow-up action that you want to implement if the Successfully Implemented field is

not turned on when the action card is closed.

Closed On Specifies when the action card was closed.

Closed By Specifies who closed the action card.
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This tab shows the risk assessment texts that were entered by using the New Text function on the ribbon.

Texts are versioned and can only be entered if a card is in the Open status. For more information, see Enter Texts.

Evaluate Success

More Information

Ribbon actions

Field Description

No. of FMEAs Shows the number of FMEA lines that are assigned to the action because they were created from it.

No. of Arch. FMEAs Shows the number of archived FMEA lines assigned to the action because they were created from it.

Field Description

No. of FMEA Actions Shows on how many FMEA lines that have been assigned to the action the Successfully

Implemented toggle is turned on.

No. of Arch. FMEA

Actions

Shows on how many archived FMEA lines assigned to the action the Successfully Implemented

toggle is turned on.

Success Evaluated This toggle needs to be turned on manually when the success of the action has been evaluated.

Note

You cannot turn on this toggle if a related FMEA has not been completed.

Evaluation Comment Here you can enter a text to describe the outcome of the effectiveness analysis.

Success Evaluated On Indicates when the Success Evaluated toggle was turned on.

Success Evaluated By Shows who turned on the Success Evaluated toggle.

Field Description

Created On Indicates when the action card was created.

Created By Shows who created the action card.

Modified On Indicates when the action card was last changed.

Modified By Shows who last changed the action card.

Function Description

Edit Description to follow

Delete

(Icon Recycle Bin)

Description to follow.

New Text Used to enter a text describing the risk assessment.

Create FMEA Creates an FMEA for an action.

The FMEA and action cards are then linked through shared data. For more information, see FMEAs.

Close Case Closes an action card.

Notes:

If the Implemented Successfully field on the action card was set to No, a follow-up action is

automatically created so that the card can be closed.

Change Log

Entries

Shows the change log of an action card.
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Edit an action

To change information about an action:

Choose the Search icon, enter Actions, and then choose the related link.

This opens a list that shows all actions—both those with and without a reference to a claim or complaint.

On the ribbon, choose Edit. You can now add text or create an FMEA or fill in fields that are needed later, such as the fields that

will be used to evaluate the effectiveness of a measure.

Create FMEA (action)

Analyzes the current measure. For more information, see FMEAs.

Create a follow-up action

If the Successfully Implemented toggle on an action card hasn’t been turned on, the fields Successfully Implemented On and By

will not be filled when you close the card.

Instead, another action will be created automatically, and the number of the new measure is entered on the card of the previous,

unsuccessful action in the Follow-Up Action No. field.

You can then use this field to get to the follow-up. The new measure is also shown on the actions list.

On the card of the follow-up action, the source action is shown in the Source Type and Source No. fields.

If an action was created from a claim or complaint, the follow-up measure must be added manually to the Actions FastTab on the

claim or complaint.

Close an action

An action can be closed and archived regardless of origin (action list, claim, complaint, or FMEA). The only requirement is that

the action is completed.

To close an action card:

Choose the Search icon, enter Actions, and then choose the related link.

Choose Edit to open an action card.

On the ribbon, choose Close.

The Success Evaluated toggle needs to be turned on before you can close the card. The Success Evaluated On and By fields on

the Assessment FastTab are then filled in automatically.

Closed actions can be found on the regular action list. To view only those that have been closed, you can filter the list for the

Completed status.

FMEAS

An FMEA, or Failure Mode and Effects Analysis, is a method for investigating and preventing potential errors and defects during

day-to-day operations.

Multiple definitions exist; the FMEA procedures implemented in KUMAVISION base (BOOSTER) originate from DIN EN

60812:2015-08. According to this standard, there are four types of FMEA:

Process FMEA

Investigates potential weaknesses in production or performance based on the results of a design analysis.

Product FMEA

Examines potential errors and defects of a specific product.

1. 

2. 

3. 

Note

1. 

2. 

3. 
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System FMEA

Analyzes the interaction of components within a complex system, such as a machine or piece of industrial equipment, and the

interaction of that system with the environment.

Design FMEA

Evaluates a product’s ease of manufacturing and assembly.

The aim is to identify the causes of errors and defects before implementing actions that are demonstrably effective (=CAPA) to

eliminate them from the affected processes while using the lessons learned from those experiences for the creation of a

knowledge base that can help a company avoid making the same mistakes again in the future.

Individual errors are described and evaluated based on the following criteria:

Effect Probability A

High likelihood of failures occurring is rated at 4, with low probability put at 1.

Failure Effect Severity B

Seen from the customer's point of view. High-priority errors that affect internal or external processes are rated at 4, low-impact

errors at 1.

By multiplying A and B, you’ll get priority numbers, which can be mapped to a risk matrix.

After initiating CAPA, another FMEA must be performed to gauge their impact and calculate new risk priority numbers. The

lower in priority errors are ranked this time, the more effective the implemented measures have been.

FMEA cards can be used to record and document the analysis process. A card can be created from a complaint or an action, in

which case a reference to the original document will be included. However, you can also create FMEAs from the list view, without

a reference.

Create an FMEA

To create an analysis on its own:

Choose the Search icon, enter FMEA Overview, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

General

Afterward, choose OK to exit. As no other FastTabs have been filled in, you’re asked if you want to delete the analysis. Choose

No.

Lines

1. 

2. 

3. 

Field Description

No. Shows the number of the analysis. This number is assigned automatically and cannot be changed.

Source No. This field shows the number of a complaint or an action if the analysis was created from one.

For standalone FMEAs, the field remains blank.

Type Specify the type of analysis. Options are:

• Process

• Product

• System

• Design

Department Specify the department or area examined in the context of the analysis.

No. of Risk

Matrices

Shows the number of risk matrices created from the analysis.

You can select the highlighted value to get to the FMEA Risk Matrix Overview, which will be filtered

for entries related to this analysis.
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The results of the analysis are documented on the lines. Every error or defect needs to be recorded on a separate line as

described in the following table.

The second part of each line indicates the effectiveness of actions taken:

Ribbon actions

Field Description

Failure Location Specify where the error occurred, for example, as part of a process chain or within a certain

department.

Potential Failure Specify the error or defect that can occur or has occurred.

Failure Effect Specify the impact of the error or defect.

Cause of Failure Specify the potential cause of the error or defect.

Verification Specify a method that can be used to check if the error or defect does, in fact, occur.

Severity Specify the severity of the damage. For more information, see FMEA Basics.

Effect

Probability

Specify how likely the damage will occur. For more information, see FMEA Basics.

Risk Priority Indicates by color the risk priority. For more information, see FMEA Risk Matrix.

Field Description

Recommended

Action

Specify the action that should be implemented so that risks can be mitigated or eliminated

altogether.

Person Responsible Specify the person in charge of the measure.

Deadline Specify when the action has been completed.

Filling in this field will open a follow-up document so that you can notify the person responsible for

the measure.

Action Taken Specify the action that has been implemented to mitigate the risk or eliminate the error altogether.

New Severity Specify the new damage severity if the failure reoccurs after implementing the action.

For more information, see FMEA Basics.

New Effect

Probability

Specify the new likelihood of failure after implementing the action.

For more information, see FMEA Basics.

New Effect Priority Indicates by color the new effect priority. For more information, see FMEA Risk Matrix.

Function Description

New Text Used to enter various texts, such as comments and descriptions of (implemented) actions.

Create Action Creates a new action as part of the FMEA.

Close Case Closes and archives the analysis.

Risk Matrices Opens the FMEA Risk Matrix for the current analysis.

Risk Matrix Previews or prints the FMEA Risk Matrix.

Change Log Shows tracked changes if the feature has been turned on for the relevant tables in Change Log Setup.
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Edit an FMEA

To change information about an analysis:

Choose the Search icon, enter FMEA Overview, and then choose the related link.

This opens a list that shows all analyses—both those with and without a reference to a claim or complaint.

On the ribbon, choose Edit.

The Action Taken field on FMEA cards is used as a counter if an FMEA was created from an action so that the No. of FMEA

Actions field is displayed on the related action card.

You can now add a text on the Action Taken FastTab to describe any measure that was implemented. To add text:

Choose New Text on the ribbon.

Enter a text and close the editor.

The text is then filled in on the tab. When you choose New Text again, the new description that you enter will be specified as a

follow-on version.

The same is true for remarks about the analysis. To enter a remark, choose Related > Comments on the ribbon.

When all necessary information has been filled in, choose OK to exit the card.

Risk matrix

This matrix indicates based on a traffic light system on FMEA lines the risk associated with a certain error or defect. For more

information about the general setup of matrices, see FMEA Setup.

Matrices can be printed directly from FMEA cards. What colors will be used on these graphs depends on the values specified in

the risk assessment fields on the lines.

Risk matrices can only be created for open FMEAs.

All matrix-related functions and fields found on FMEA cards are described in the following table.

FMEA Risk Matrix Overview

This page shows the matrices added to an analysis (along with the status that the matrices are in). Initially, all analyses are

created without a matrix.

1. 

2. 

3. 

• 

• 

Note

Function/Field Description

Related > Risk Matrices Opens the FMEA risk matrix overview assigned to the current analysis.

Reports > Risk Matrix Prints the current version of the FMEA risk matrix.

A white matrix means that no values have been set up yet.

No. of Risk Matrices Indicates the number of related matrices.

Clicking the hyperlink will open the FMEA Risk Matrix Overview page.
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Ribbon actions

Create a new version

To create a new matrix:

Open the FMEA Risk Matrix Overview page.

On the ribbon, choose Create New Version.

Fill in the fields as described in the following table.

General

Evaluate Success

On this tab, you can specify the colors used to indicate the severity of a failure and the likelihood of damage in the form of risk

priority numbers. You can also specify colors to show changes in priority after implementing actions.

You can leave a field blank or select yellow or red. Leaving a field blank will result in the use of the RDLC color set up on the Risk

Matrix FastTab in FMEA Setup.

More Information

The fields found on this FastTab show when and by whom this matrix version was created or last changed.

Edit a matrix

You can change a graph until the Close function is used. To change a matrix:

Open the FMEA Risk Matrix Overview page.

On the ribbon, choose Edit.

A matrix that is in the Invalid or Valid status cannot be edited, and you need to create a new version for editing.

A new version is Under Development until you choose close on the ribbon to turn the graph into a valid risk matrix. The contents

of the Evaluation FastTab fields are always copied from one version to the next.

Complete a matrix

The colors used to indicate risk are governed by the matrix that is in the Valid status. When a new version is completed and the

close action is run from the ribbon, this version is set to valid, whereas the previous graph is set to Invalid.

The change in matrices then changes the indicators to how they are set up on the FMEA lines in the new version.

Field Description

Create New Version Creates a new version of the risk matrix.

View Opens the matrix for viewing.

Edit Opens the matrix for editing.

Print Prints or previews the matrix.

1. 

2. 

3. 

Field Description

FMEA No. Shows the number of the analysis for which a matrix is created.

Version No. Shows the version of the matrix.

Status Indicates the status of the matrix.

Description

Description 2

These fields can be used to describe the matrix.

Reason You must select a reason in this field when you create a new version of the matrix or change an existing

graph.

• 

• 
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Ribbon actions

Close an analysis

An analysis can be closed and archived regardless of origin (FMEA overview or action). The only requirement is that the analysis

has been completed. To close an FMEA card:

Choose the Search icon, enter FMEA Overview, and then choose the related link.

Choose Edit to open an FMEA card.

On the ribbon, choose Close, and then choose Yes.

The FMEA is then closed, archived, and moved to the FMEA Archive Overview.

Archived analyses and matrices cannot be edited. However, you can print an analysis by choosing Risk Matrix on the ribbon of an

archived card.

ENTER TEXT

You can specify a wide variety of texts on complaint, claim, action, and FMEA cards. Each text you add is subject to versioning.

As the method for entering texts is identical for warranty claims, complaints, actions, and analyses, except for the type of text

that you want to enter (that is, for registration or analysis), the example provided in the following applies to all text entry

functions in Complaints Management.

Open the card on which you want to enter text.

Choose New Text on the ribbon.

This opens a text editor. Select the type of text by using the relevant function and specify the text you want in the editor.

Afterward, the text will be shown on the relevant FastTab, where the description can be changed or supplemented.

Every text is versioned, including new entries and text changes on the relevant pages but also cancelled entries, which will be

shown as empty lines. You can see other versions by choosing Previous or Next on the ribbon.

When the Justified toggle is modified on claims and complaints, a text editor opens automatically so that you can enter a reason

for the change. This text must be filled in and will be copied to the Analysis Text FastTab as a new text version.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

View Opens a version for viewing.

Edit Opens a version for editing.

Delete

(Icon Recycle Bin)

Deletes a matrix version.

You can only delete matrices set to Under Development.

Finish Sets a matrix version to Completed.

The status of the version then changes to Valid, whereas all previous versions are set to Invalid.

Print Prints or previews the matrix.

1. 

2. 

3. 

Note

• 

• 

• 

• 

1. 
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Unique Device Identification

OVERVIEW

To simplify the tracking of medical products (in the case of recalls especially) and to prevent counterfeit goods from being sold,

manufacturers must assign a UDI to every product and its packaging prior to the item entering the market.

With the UDI functionality that can be integrated into Microsoft Dynamics 365 Business Central1, you can maintain the

information you need to meet Unique Device Identification rules and prepare GUDID and EUDAMED reports.

You need a separate license to use this functionality.

ABBREVIATIONS

UDI USER SETUP

To configure users’ individual access rights to UDI data:

Choose the Search icon, enter UDI Setup, and then choose the related link.

Enter or select a user and fill in the fields as necessary.

SET UP EUDAMED

UDI Setup

To set up the UDI-EUDAMED interface:

Choose the Search icon, enter UDI Setup, and then choose the related link.

On the General and EUDAMED FastTabs, fill in the fields described in the following table.

Actions New DI

Creates a new DI, such as a Basic DI, a UDI-DI, or a Secondary DI. 

Related – Base Data

Note

Acronyms / Initialisms Description

DUNS Data Universal Numbering System

EUDAMED European Database on Medical Devices

GUDID Global Unique Device Identification Database

GUDID Data Elements Reference Table (List of UDI data elements as published by the FDA)

UDI Unique Device Identification

UDI Data Dictionary (List of UDI data elements as published by the European Commission)

XML Extensible Markup Language

XSD XML Scheme Definition

1. 

2. 

1. 

2. 

Field Description

Default Issuing Entity / Agency Code Specify the default issuing entity.

Default Manufacturer SRN Specify the manufacturer’s default SRN.
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Contains the functions needed to maintain basic EUDAMED data, as described in the European Commission’s UDI Data

Dictionary. For more information on a specific field function, see the following table.

Function Description

CMR Categories Specifies if the device contains a CMR (carcinogenic, mutagenic, or toxic to reproduction)

substance.

Clinical Size Types Specifies the type of clinical size associated with the device.

Sizes can be identified by their type (such as length or width), precision (single value, range, or

text), or unit of measure.

Device Certificate

Types

Specifies the type of product certificate assigned to the device. This type is part of the data that

must be provided when you register products that need to be certified.

Issuing Entities Specifies the issuing entities tasked by the European Commission with creating EUDAMED DI

codes (Basic UDI-DIs, UDI-DIs, Unit of Use DIs, Secondary DIs, and Package Level DIs).

EMDN Codes Specifies EMDN nomenclature code(s) associated with the UDI-DI.

Measure Units Specifies the unit used for the clinical size associated with the device.

Sizes can be identified by their type (such as length or width), precision (single value, range, or

text), or unit of measure.

Multi-Component

Devices

Specifies if the Basic UDI-DI refers to a system that is a device itself, a procedure pack that is a

device itself in accordance with Article 22(4) MDR, or a kit.

This field is applicable only to standard devices, not systems or procedure packs.

The Kit option is also only applicable to IVDR devices and systems that are devices themselves. In

the case of procedure packs, this field applies only to MDR devices.

Non-Medical Device

Types (Annex XVI)

References the intended non-medical purpose of the device (UDI-DI) as described in Annex XVI of

the MDR regulation.

Notified Bodies References the organization that issued the product certificate for the device. The organization’s

contact details are part of the data that must be provided when you register products that need

to be certified.

Risk Classes Specifies the risk class of the device that is assigned to the Basic UDI-DI. What risk class the

device is put in depends on the legislation applicable to it.

Special Devices Specifies if the device is of a special type and if so, the type thereof. You cannot use this function

if the device is a standard device that has the options of System or Procedure Pack (devices

themselves) or is a system or procedure pack.

Storage and Handling References the storage and handling conditions associated with the device (UDI-DI).

Types of Substances Specifies the type of medicinal substances contained in the device. This includes substances

understood as a medicinal product or as a medicinal product derived from human blood or

plasma.

Warning Values Specifies critical warnings or contra-indications linked to the UDI-DI.
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Related – UDI

DI List

This list stores all DIs available in the system, including DIs already in use and those not in use but acquired from issuing

entities. The following chart shows the regulations that certain types of EUDAMED data are subject to.

The fields found on each line of the list are described in the following table.

Actions

Function Description

DI List Shows a list of all DIs, such as Basic DIs, UDI-DIs, and Secondary DIs, including those that have already

been assigned.

Product

Designers

Specifies the product designer, that is, the company who originally manufactured or designed the

device.

Also provides data on manufacturers and designers not available in EUDAMED.

Basic UDI-DI List Shows a list of all Basic UDI-DIs, including those already assigned.

Change Log Lists the changes made to UDI information.

Field Description

Code Specifies the relevant UDI-DI, such as GTIN or HIBC.

Issuing Entity / Agency

Code

Specifies the issuing entity, such as GS1.

Description Can be used for a more detailed description of the record. This description will not be copied to

EUDAMED (or GUDID).

DI Type Specifies the type of DI:

• None (placeholder for acquired but not yet assigned DIs)

• Basic UDI-DI

• UDI-DI

• Unit of Use DI

• Secondary DI

• Package Level DI

• EUDAMED DI

• UDI-DI (Legacy)

Used in EUDAMED Specifies whether the DI is part of a EUDAMED record.

Used in GUDID Specifies whether the DI is part of a GUDID record.

1.2.1 base (BOOSTER)

- 208/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Based on the type of DI, you can choose one of the following functions on the ribbon:

Basic UDI Card

You enter Basic UDI-DI data on the Basic UDI-DI Card. To enter new data:

On the DI List, select a DI record of type Basic UDI-DI.

Choose Open DI Card on the ribbon. To enter data that you previously used in GUDID or haven’t yet used at all, choose Create

EUDAMED DI.

Fill in the fields according to the UDI Data Dictionary. Fields that aren’t part of the dictionary are listed in the following.

General

Actions

UDI-DI card

You enter UDI-DI data on the UDI-DI Card. To enter new data:

On the DI List, select a DI record of type UDI-DI.

Choose Open DI Card on the ribbon. To enter data that you previously used in GUDID or haven’t yet used at all, choose Create

EUDAMED DI.

Fill in the fields according to the UDI Data Dictionary. Fields that aren’t part of the dictionary are listed in the following.

Function Description

Create EUDAMED DI Creates a new EUDAMED record with a Basic UDI-DI, UDI-DI, or EUDAMED DI.

New Inserts a new line on the page.

Open DI Card Opens the EUDAMED record.

Open DI Versions Opens a list of all versions of the DI.

Open Item Relations Opens the item relations specified for the record.

Audit Trail Opens the change log for the record.

1. 

2. 

3. 

Field Description

Description Specifies a text to describe the Basic UDI-DI.

Released Specifies whether this version of the EUDAMED record has been released.

Active Specifies whether this version is being or has been the last one edited.

Internal Version Specifies the version of the Basic UDI-DI.

Function Description

Create New Version Creates a new version of the Basic UDI-DI record.

Release Version Releases the current Basic UDI-DI version.

Open DI Versions Opens a list of all versions of the DI.

Audit Trail Opens the change log for the record.

1. 

2. 

3. 
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General

Actions

Actions - Functions

Legacy Device card

You enter EUDAMED DI data on the Legacy Device card. To enter new data:

On the DI List, select a DI record of type EUDAMED DI.

Choose Open DI Card on the ribbon. To enter data that you previously used in GUDID or haven’t yet used at all, choose Create

EUDAMED DI.

Fill in the fields according to the UDI Data Dictionary. Fields that aren’t part of the dictionary are listed in the following.

Basic UDI

Field Description

Description Specifies a text to describe the UDI-DI.

Released Specifies whether this version of the EUDAMED record has been released.

Active Specifies whether this version is being or has been the last one edited.

Internal Version Specifies the version of the UDI-DI.

Function Description

Create New Version Creates a new version of the UDI-DI record.

Release Version Releases the current UDI-DI version.

Open DI Versions Opens a list of all versions of the DI.

Open Item Relations Specifies the relation of the UDI-DI to an item or its variant and unit of measure.

Audit Trail Opens the change log for the record.

Function Description

Copy UDI Data Copies base data from another UDI record.

Delete Basic UDI Deletes the assigned Basic UDI.

Delete Secondary UDI Deletes the assigned Secondary UDI.

Delete Unit of Use DI Deletes the assigned Unit of Use DI.

Delete Direct Marking DI Deletes the assigned Direct Marking DI.

Delete Legacy Device Deletes the assigned Legacy Device.

Delete Product Designer Link Deletes the link to the Product Designer.

1. 

2. 

3. 

Field Description

Description Specifies a text to describe the DI.

Released Specifies whether this version of the EUDAMED record has been released.

Active Specifies whether this version is being or has been the one last edited.

Internal Version Specifies the version of the DI.
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Actions

Actions - Functions

SET UP GUDID

UDI Setup

To set up the UDI-GUDID interface:

Choose the Search icon, enter UDI Setup, and then choose the related link.

On the General and GUDID FastTabs, fill in the fields described in the following table.

Actions

Related – Base Data

Function Description

Create New Version Creates a new version of the EUDAMED DI record.

Release Version Releases the current version.

Open DI Versions Opens a list of all versions of the DI.

Open Item Relations Specifies the relation of a EUDAMED DI to an item or its variant and unit of measure.

Audit Trail Opens the change log for the record.

Function Description

Copy from Legacy Copies base data from another UDI record.

Delete Secondary UDI Deletes the assigned Secondary UDI.

Delete Unit of Use DI Deletes the assigned Unit of Use DI.

Delete Direct Marking DI Deletes the assigned Direct Marking DI.

Delete Product Designer Link Deletes the link to the product designer.

1. 

2. 

Field Description

Default Issuing Entity /Agency

Code

Specify the default issuing agency.

DUNS Number Specify the DUNS number that has been assigned by the FDA to identify the

manufacturer.

The number is used on documents and for reporting data to the agency.

Export Despite XSD Fail Specifies if an XML export is possible despite failed XSD validation.

GUDID XSD Validation Specifies if XSD validation is active (requires an XSD file).

GUDID XSD Specifies if an XSD file has been stored for validation during the XML export process.

Function Description

New DI Creates a new DI, such as a Basic DI, a UDI-DI, or a Secondary DI.

Import GUDID XSD Imports a GUDID XSD file.

Delete GUDID XSD Deletes the stored GUDID XSD file.
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Contains the functions needed to maintain basic GUDID data, as described in the FDA UDI system. For more information on a

specific field function, see the following table.

DI List

This list stores all DIs in the system. The DIs relevant to the GUDID database are shown in the following chart.

You set up GUDID data in the same way as you do EUDAMED information. For more details, see here.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Function Description

Units of Measure Specifies units of measure used for clinically relevant sizes, as well as storage and handling

conditions.

FDA Product Codes Specifies devices based on FDA categories.

GMDN Codes / FDA

Preferred Term Codes

Specifies GMDN or Preferred Term (PT) codes. These are unique five-digit codes used to identify

common device types. PT codes are assigned to medical devices and related health care

products for the purposes of grouping and categorization.

Clinically Relevant Sizes Specifies the dimension types for the clinically relevant measurement of the medical device.

Submission Types Indicates the type of FDA premarket submission. This includes 510(k), De Novo, PMA, PDP,

HDE, BLA, ANDA, and NDA.

Storage Handling

Conditions

Indicates the storage and handling requirements for the device, such as temperature, humidity,

and atmospheric pressure needs.

Sterilization Methods Indicates the methods of sterilization that can be used for the device prior to use on a patient.

1. 
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Package Labels

OVERVIEW

The Label Interface – LIF functionality provides a way for you to transmit data structures that store item-related information

supplied by Microsoft Dynamics 365 Business Central1 to a label design and print program.

After the structures are imported to the third-party solution, they’re used to fill in graphical templates set up there so that you

can create (and print) a variety of package labels at any time. The interface can be connected to the following programs:

Loftware NiceLabel3 Cloud (Business edition or higher)

Loftware NiceLabel3 On-Premises (LMS Enterprise edition or higher)

Seagull Scientific BarTender2 (Automation edition or higher)

Interface basics

Two key components help integrate the interface with the standard app:

Label Designer

NiceLabel3 Designer – Pro

BarTender2 Designer

Automation / Integration Builder

NiceLabel3 Automation Builder – Pro

NiceLabel3 Automation Builder

BarTender2 Integration Builder

The design component is used to customize label templates and layouts. The builder, on the other hand, helps those working with

the functionality to create an automated printing process. This includes everything from setting a trigger (to import data) and

opening a template to assigning variables and selecting a print option to feeding back values to the source system.

For a more detailed explanation of these processes, see the NiceLabel3 Cloud Setup, NiceLabel3 On-Premises Setup, and 

BarTender2 Setup.

The standard NiceLabel3 Label Cloud API has a limitation of 5 calls per second. That frequency is suitable for the majority of labeling

projects.

Sometimes, there are requirements for even faster printing. To satisfy demands for higher print frequency, a new high-throughput

Label Cloud API is available. The new API expands the throughput to 30 calls per second and 50,000 calls per hour, whichever is

achieved first.

The new API is not included in the Label Cloud subscription by default. You can include it as an add-on for an additional charge. In

this case, please contact NiceLabel3. (Source: NiceLabel3 (27.11.2023).

Interface options

The functionality comes with an array of tables, pages, and actions. Above all, however, it provides the configurations needed for

multiple printing scenarios. You can choose between the following interface options:

KUMAVISION Label Interface – NiceLabel3 Cloud

KUMAVISION Label Interface – NiceLabel3 On-Premises Web Service

KUMAVISION Label Interface – BarTender2 Web Service

• 

• 

• 

• 

• 

• 

• 

• 

Note

• 

• 

• 
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Another component—called KUMAVISION Label Interface File Extension—can be used to export files via on-premises solutions.

As file access is restricted in SaaS environments, a separate app had to be developed for this purpose.

Because the KUMAVISION Label Interface File Extension isn’t compatible with Unicode, the use of this extension can cause an

increase in licensing costs for Microsoft products.

General setup

You must set up the label interface before you can transmit information to an external program. You can also set up additional

features during this process.

Activate the interface

To turn on the interface:

Choose the Search icon, enter KUMAVISION Module Setup, and then choose the related link.

On the Settings FastTab, turn on the Label Interface toggle.

You need a separate license before you can use the label interface.

Label position codes

The data structures transmitted to third-party software programs contain a list of values, each coupled with an identifier. These

identifiers are the same on all labels, regardless of what the labels will be used for. To set up a value:

Choose the Search icon, enter Label Position Code List, and then choose the related link.

Fill in the fields as described in the following table.

Label Interface Setup

To configure the label interface:

Choose the Search icon, enter Label Interface Setup, and then choose the related link.

Fill in the fields as described in the following table.

Note

1. 

2. 

Note

1. 

2. 

Field Description

Code Specify a unique code that can later be linked to a label structure.

You can enter a maximum of 20 characters in this field.

Description Specify a description for the code to clarify the label contents.

You can enter a maximum of 80 characters in this field.

1. 

2. 
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General

File Export

Available after installing the KUMAVISION Label Interface File Extension app.

Field Description

Printer Position

Code

Enter the code that will be used for the printer on this line.

The value in this field is automatically copied to label structure lines when you create a new

structure.

No. of Copies

Position Code

Enter the code that will be used for specifying how many labels you want to create.

The value you enter in this field can be transmitted as a variable to a label design and print program

for analysis if you set up the variable there. The field has the following impact on the creation of data

structures:

a) For items without item tracking, the system will create a structure line and enter the No. of Copies

value from the source document line there.

For lot-tracked items, the system will create a structure line filled in for each lot. The No. of Copies

value will be copied from the relevant item tracking line.

b) For items tracked through serial numbers, the system will create a structure line with a No. of

Copies value of 1 per number.

If you leave this field blank, the system will create as many lines as needed to match the quantity

entered in the field. A quantity of 100 entered in this field, for example, will add 100 lines to the

transfer file.

Log Content File

Export

Turn on this toggle if you want the label creation process logged by the system. You can see an

overview of all archived print jobs on the Label Print Job Archive List page.

Output Interface Specify the interface that will be used to create labels.

Note

The KUMAVISION Label Interface File Extension is available as a separate app. Other interface

solutions are available on request.

Field Description

Structure File Export

Path

Specify the directory that will be used to store the structure file you want to export to the label

design and print program.

Content File Export

Path

Specify the directory that will be used to store the label file you want to export to the label design

and print program.

Default Export

Separator

Specify the separator that will be required to export label files.

Text Encoding Specify the type of character encoding that will be used for label files (Windows, UTF8, UTF16, or

MSDOS).

Pictograph Export

Path

Specify the path that label design and print programs should use to retrieve pictographs stored in

KUMAVISION (Booster).

Pictograph File Type Specify the file type of pictographs (JPG or BMP).

Note

KUMAVISION functionality doesn’t separate pictograph files by type. You should therefore select a

type here to avoid errors when working with third-party software.
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Depending on what option you selected in the Output Interface field, the page might show additional interface features. For more

information, see NiceLabel Cloud Setup, NiceLabel3 On-Premises Setup, and BarTender2 Setup.

Label Printers

To set up a device for printing labels:

Choose the Search icon, enter Label Interface Setup, and then choose the related link.

On the ribbon, choose Label Printer.

Fill in the fields as described in the following table.

One printer can be stored per label code and ID. This is to ensure that external programs transmit the data stored in label

structures to the correct printers. A printer can be assigned in the following ways:

To a certain label code and user.

To a certain label code and all users (that is, the User ID field is blank).

To all codes (that is, the Label Code field is blank) but only one user.

To all codes and users (Label Code and User ID fields are both empty).

Pictographs (Legacy)

By using pictographs, you can assign symbols to labels in Microsoft Dynamics 365 Business Central1. No longer supported by

NiceLabel3 Cloud and BarTender2 Web Service, the feature remains for legacy reasons.

Instead, pictographs should now be added through external sources. By using parameters (such as "PAR_*“ codes specified on

the Label Position Code List page) and a certain function, however, you can still choose whether to show a symbol on a certain

label.

Label structures

Label structures are representations of the core information used for labeling. Within a structure, you can assign position codes

to Microsoft Dynamics 365 Business Central1 records and fields. The lines of the structure specify the data that you want to show

on a label and where this information comes from. The structures can be used for multiple items (none are related to a specific

item). 

Note

1. 

2. 

3. 

Field Description

Label Code Select the label code that will be used for the printer.

User ID Specify the ID of the user who will print labels.

Printer Name Specify the name of the device on which labels should be printed.

1. 

2. 

3. 

4. 
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To set up a structure:

Choose the Search icon, enter Label Structure List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Label structure lines

1. 

2. 

3. 

Field Description

Code Specify a code for the structure. The code must be unique.

You can enter a maximum of 20 characters in this field.

Name Specify a brief description for the structure.

You can enter a maximum of 50 characters in this field.

Label Type Specify the type of label. Options are:

• (blank)

• Location

• Product

• Shipment• 

Whse. Receipt

Note

This field is used for informational purposes only.

Status Shows the status of the structure. A structure can have one of the following statuses:

• New

• Certified

• Under Development

• Expired

Note

You can only create labels from certified structures.

Version Nos. Specify the number series that will be used to assign version numbers to the label.

Filling in this field is optional.

Active Version Shows the currently active version of the structure.

This is the version that is certified and valid on the date on which you open the structure.

From Date Specify from when the structure should be valid.

To Date Specify until when the structure should be valid.

If this field is left blank, this version of the structure will be used until it is replaced by another active

version.

1.2.1 base (BOOSTER)

- 217/1545 - Copyright © 2018 - 2024 KUMAVISION AG



The structure lines represent the individual positions that should be printed on the label.
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Field Description

Position Code Specify a unique position code that stands for a value on the label. You can select a code from the list or

create a new one.

For example, you can select position code ITEM_NO in this field to assign the item number from the

item master to the label.

Position

Description

Shows the description of the code.

The description is copied from the Position Code Label List page but can be changed manually in this

field.

Source Type Specify where the data entered for the code comes from.

For example, you can choose Text here if you want the system to use the content of the Source Value

field.

For more information on how to select a source type and subtype, see Source Type—Subtype

Combinations.

Source Subtype Enter another type that will be used in combination with the Source Type field.

For example, for the Item source type, you can specify in this field if you want to use the description or

the content (=value) stored in the item master.

For more information on how to select a source type and subtype, see Source Type—Subtype

Combinations.

Source Field No. You can only fill in this field for source types linked to a table. The number you enter here identifies the

field from which a value or a description is copied from.

For more information on how to select a source type and subtype, see Source Type—Subtype

Combinations.

Source Code This field can only be used in the following ways:

Option 1

If the source type is Pictograph and the subtype is Database, you can choose the code of a pictograph

from the pictograph master.

This option is available for legacy reasons. It is only used for the KUMAVISION Label Interface File

Extension (which needs to be installed separately).

Option 2

If the source type is Item Tracking and the subtype Expiration or Production Date, you can format this

date in the following ways:

<YYYY>: In this format, the year is represented by four digits.

<YY>: The year is represented by the last two digits.

<MM>: In this format, the month is shown as a number.

<MONTH>: The month is written out.

<DD>: In this format, the day is written out.

Example 1

<MONTH> <YYYY> will list the date as December 2022.

Example 2

<YYYY>-<MM>-<DD> will list the date as 2022-07-09.
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Source type-subtype combinations

Field Description

Option 3

If the source type is Item Attribute, you must assign the attribute that you want to specify for the label

(applies to both Caption and Value subtypes).

To select an attribute, use the lookup in the field.

Source Value This field is filled in automatically unless you chose source type Text or source type Pictograph and

subtype Path.

If you chose Text, enter the text you want printed for the position code.

For source type Pictograph and subtype Path—and if symbols are not stored in the system but a

directory—specify the path at which the pictograph can be found.

This option is only available for legacy reasons and is only used in combination with the KUMAVISION

Label Interface File Extension, which needs to be installed separately.

For more information on how to select a source type and subtype, see Source Type—Subtype

Combinations.

Language Code Here you can specify different item codes to add translations to the label structure.

The field is only used for types Item Translation, EUDAMED UDI-DI, and EUDAMED Legacy in

combination with subtype Value, or for type Item Attribute and subtype Caption or Value.
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The following table shows the subtypes that you can add to a source type and what will happen if you do (=source value).
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Source type Source

subtype

Source value

Text (blank) None; enter a text that you want printed on a label for the selected position code.

Pictograph Path None; specify the file path to a pictograph that will be used for the selected

position code.

This option exists for legacy reasons. For more information, see KUMAVISION

Label Interface File Extension.

Pictograph Database The Source Value field is filled in automatically with the name of a pictograph

that will be used for the selected position code.

This option exists for legacy reasons. For more information, see KUMAVISION

Label Interface File Extension.

Item Caption The Source Value field is filled in automatically with the caption of an Item table

field selected via the Source Field No.

Item Value The Source Value field is filled in automatically with the content of an Item table

field selected via the Source Field No.

Item Attribute Caption The Source Value field is filled in automatically with the caption of an Item

Attribute table field selected via the Source Field No.

If you select the Name field and have specified a language code, the Source Value

field is filled in with the translation entered for the attribute.

If no translation is available, the system shows the default name instead.

Item Attribute Value The Source Value field is filled in automatically with the content of an Item

Attribute table field selected via the Source Field No.

If you select the Value field and have specified a language code, the Source Value

field is filled in with the translation entered for the attribute.

If no translation is available, the system shows the default value instead.

Item Variant Caption The Source Value field is filled in automatically with the caption of an Item

Variant table field selected via the Source Field No.

Item Variant Value The Source Value field is filled in automatically with the content of an Item

Variant table field selected via the Source Field No.

Item Translation Caption The Source Value field is filled in automatically with the caption of an Item

Translation table field selected via the Source Field No.

Item Translation Value The Source Value field is filled in automatically with the content of an Item

Translation table field selected via the Source Field No.

You can use the Language Code field to specify for which language the item

translations should be filtered.

Item UOM Caption The Source Value field is filled in automatically with the caption of an Item Unit

of Measure table field selected via the Source Field No.

Item UOM Value The Source Value field is filled in automatically with the content of an Item Unit

of Measure table field selected via the Source Field No.

Item Tracking Serial No. The Source Value field is filled in automatically with the serial number that was

entered for the item assigned to the selected position code.

Item Tracking Lot No.
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Source type Source

subtype

Source value

The Source Value field is filled in automatically with the lot number that was

entered for the item assigned to the selected position code.

Item Tracking External Lot

No.

The Source Value field is filled in automatically with the external lot number that

was entered for the item assigned to the selected position code.

Item Tracking Expiration Date The Source Value field is filled in automatically with the expiration date that was

entered for the item assigned to the selected position code.

You can use the Source Code field to reformat the date.

Item Tracking Production

Date

The Source Value field is filled in automatically with the production date that was

entered for the item assigned to the selected position code.

You can use the Source Code field to reformat the date.

Customer Caption The Source Value field is filled in automatically with the caption of a Customer

table field selected via the Source Field No.

Customer Value The Source Value field is filled in automatically with the content of a Customer

table field selected via the Source Field No.

Vendor Caption The Source Value field is filled in automatically with the caption of a Vendor table

field selected via the Source Field No.

Vendor Value The Source Value field is filled in automatically with the content of a Vendor table

field selected via the Source Field No.

Customer Ref. Caption The Source Value field is filled in automatically with the caption of an Item

Reference table field selected via the Source Field No.

This table is prefiltered for customers.

Customer Ref. Value The Source Value field is filled in automatically with the content of an Item

Reference table field selected via the Source Field No.

This table is prefiltered for customers.

Vendor Ref. Caption The Source Value field is filled in automatically with the caption of an Item

Reference table field selected via the Source Field No.

This table is prefiltered for vendors.

Vendor Ref. Value The Source Value field is filled in automatically with the content of an Item

Reference table field selected via the Source Field No.

This table is prefiltered for vendors.

Company Info Caption The Source Value field is filled in automatically with the caption of a Company

Information table field selected via the Source Field No.

Company Info Value The Source Value field is filled in automatically with the content of a Company

Information table field selected via the Source Field No.

Barcode Ref. Barcode The Source Value field is filled in automatically with an item reference number

based on an item number, a variant code, an item UOM, and the reference type

Barcode.

Barcode Ref. Text The Source Value field is filled in automatically with an item reference number

based on an item number, a variant code, an item UOM and the reference type

Barcode.
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Copy structure (action)

Copies an existing label structure. To use this function:

On the Label Structure List page, choose New.

On the ribbon, choose Copy Structure.

In the Copy from Label Code field, specify the code of the structure that you want to copy lines from.

Turn on the Copy Incl. Values toggle if also want to copy manual source values (source type Text or source type Pictograph in

combination with subtype Path). If you leave the toggle turned off, their source values will be blank, and you need to fill them in

again.

Choose OK to copy the lines from the selected structure to the new one.

You can also use this function to revise an existing structure by copying lines from another prior to making changes. If you run the

function from a structure for which lines exist, the system will delete them before copying the other lines.

Label structure versions

Source type Source

subtype

Source value

Printer (empty) The Source Value field is filled in automatically with the printer that will be used

for the chosen combination of label structure and user ID.

No. of Copies (empty) The Source Value field is filled in automatically with the number of required

labels.

Document No. (empty) The Source Value field is filled in automatically with the number of the source

document if this document triggered the printing process.

Transaction

Code

Value The Source Value field is filled in automatically with the transaction code from a

document, for example, a warehouse receipt, if this document triggered the

printing process.

Location Code Value The Source Value field is filled in automatically with the location code from a

document, for example, a warehouse receipt, if this document triggered the

printing process.

Location Code Value The Source Value field is filled in automatically with the bin code from a

document, for example, a warehouse receipt, if this document triggered the

printing process.

EUDAMED UDI-

DI

Caption The Source Value field is filled in automatically with the caption of a UDI-DI field

selected via the Source Field No.

EUDAMED UDI-

DI

Value The Source Value field is filled in automatically with the content of a UDI-DI field

selected via the Source Field No.

EUDAMED

Legacy

Caption The Source Value field is filled in automatically with the caption of a UDI-DI field

selected via the Source Field No.

EUDAMED

Legacy

Value The Source Value field is filled in automatically with the content of a UDI-DI field

selected via the Source Field No.

1. 

2. 

3. 

4. 

5. 

Note
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You can create versions of a label structure if you want to use some version of the structure to start being valid on a specified

date. To set up this feature:

Choose the Search icon, enter Label Structure List, and then choose the related link.

Open a label structure.

In the Version Nos. field, enter a number series that will be used for the versions of this structure.

You can then see the current structure version in the Active Version field. Data copied from previous, expired versions remains

available as well.

The system identifies the active structure version by looking for one where the work date is within the period specified in the

Starting Date and Ending Date fields. If this results in more than one search hit, the version with the highest number will be used

as the active version.

If you want to work with version numbers, we recommend that you add leading zeros to these numbers, as the Version No. is a code

field (which is sorted in alphanumeric order).

Create a new version

To create a new version of a label structure:

Choose the Search icon, enter Label Structure List, and then choose the related link.

Open a label structure.

On the ribbon, choose Versions and then choose New.

With the Version Nos. field filled in, you can exit the No. field to have a number assigned automatically. If the Version Nos. field

hasn’t been filled in on the structure card, you need to enter a number manually.

The work date is then automatically suggested in the Starting Date field. However, you can specify another date if needed.

You can now enter data on the lines manually or choose Copy Structure on the ribbon to copy lines from an existing structure or

version.

Version Matrix (action)

Compares structure versions on a matrix. You can specify filters here before you choose Show Matrix on the ribbon.

Change Log (action)

Shows changes to a label structure if structures and versions are tracked. This action extends the standard change log

functionality. To include label structures on logs, you must add the following tables in Change Log Setup: 

Table 5488108 - KVSKBALabelStructureHeader

Table 5488109 - KVSKBALabelStructureLine

Table 5488116 - KVSKBALabelStructureVersion

For more information about tracking changes, see Auditing changes.

Item-Label Relations

Label structures essentially tell another program where to print lines (position codes) on a label and how to calculate values for

them.

All structures are universally valid so that they can be used for multiple items. To assign a structure to an item, choose Item-

Label Relations on the ribbon of the relevant structure, item, or item variant.

The Item-Label Relations page stores the links between items and structures, as well as their units of measure, language codes,

and customers or vendors. These values are then used to find a label structure or create a new label.

1. 

2. 

3. 

Note

1. 

2. 

3. 

4. 

5. 

• 

• 

• 
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For example, by specifying a unit of measure and a customer number, you can create an OEM label for a certain customer as

described in the following table.

Overpack quantities

The Overpack Quantity field is used when the Print at Receipt toggle is turned on and the No. of Copies Position Code field in

Label Interface Setup is blank. When both conditions are met, the number of copies is calculated as follows:

Non-tracked and tracked items

Label contents and preview

For the most part, labels are created automatically in Microsoft Dynamics 365 Business Central1 before they’re copied to a third-

party solution.

Field Description

Item No. Specifies the number of the item the structure will be linked to.

Variant Code Specifies the variant of the item the structure will be linked to.

Label Code Specifies the code of the structure used.

Item Description Specifies the item description that will be linked to the structure.

Label Name Specifies the name of the structure that will be linked to the item.

Item UOM Specifies the unit of measure in which label data (contents) will be calculated.

Language Code This field is filled in with the language that has been specified for calculating label contents.

Customer No. Specifies the customer for which label contents will be calculated.

Vendor No. Specifies the vendor number for which label contents will be calculated.

Print at Receipt With the toggle turned on, the label is printed when the item is received at a location.

Print on Prod.

Order

If the article linked to the structure is a production article, this checkbox must be activated so that a

corresponding label can be printed from the production order.

Print at Shipment With the toggle turned on, the label is printed when the item is shipped.

Overpack Qty. This field is used only when the Print at Receipt toggle is turned on and the No. of Copies Position

Code field in Label Interface Setup is empty.

No. of Sample

Labels

This field can be filled in if labels are printed, for example, as reserve samples.

If the field is filled in, the No. of Copies will be increased by the number specified here.

Order Quantity 100

Unit of Measure Pieces

Overpack Quantity 1

= 100 labels (100 divided by 1)

Order Quantity 100

Unit of Measure Pieces

Overpack Quantity 2

= 50 labels (100 divided by 2)
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After the labels have been imported, the external program creates the relevant information and sends it to the selected printer.

Manual intervention shouldn’t be necessary in this context.

However, to track the generation of label contents in Microsoft Dynamics 365 Business Central1 and preview labels for revisions,

you can choose Show Label Contents on the ribbon of a label structure or the Item-Label Relations page.

When you run this function from the Item-Label Relations page, data is filtered for the selected relations. If you run it from a

structure, you can only filter for a label code.

On the Label Contents page, you can fill in values on the header, for example, a serial number or an expiration date. You can also

enter other information to see how specific label positions are calculated.

The fields in the following table must be filled in as described:

Field Description

Item No. Specify the number of the item for which you want to create a label.

This number is also used to determine the contents of source types Item, Item Variant, Item UOM, Item

Translation, Customer Ref., Vendor Ref., and Barcode and is set as a filter on values when label data is

calculated.

Variant Code Specify the code of the item variant for which you want to create a label.

The code is also used to determine the contents of source types Item, Item Variant, Item UOM, Item

Translation, Customer Ref., Vendor Ref., and Barcode and is set as a filter on values when label data is

calculated.

Label Code Specify the code based on which you want to calculate label contents.

Label Name Shows the name of the label. The name is entered automatically.
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You can also enter something in other fields if necessary:

Calculate Contents (Action)

Starts in Microsoft Dynamics 365 Business Central1 the process of calculating line values based on the specified label structure.

Preview Label (Action)

Provides an online preview of labels created in NiceLabel3 Cloud or BarTender2 Web Service.

For this purpose, the label design and print program will simulate the standard printing process, store the results as a PDF file,

and send the PDF to Microsoft Dynamics 365 Business Central1.

Field Description

Item UOM Here you can specify the item unit of measure for which you want to create a label.

The unit is also used to determine the contents of source types Item, Item Variant, Item UOM, Item

Translation, Customer Ref., Vendor Ref., and Barcode and is set as a filter on values when label

data is calculated.

Language Code Here you can specify the language code that you want to use to create content for source type Item

Translation.

Serial No. Here you can specify the number that you want to use to create content for source type Serial No.

Lot No. Here you can specify the number that you want to use to create content for source type Item

Tracking and subtype Lot No.

External Lot No. Here you can specify the number that you want to use to create content for source type Item

Tracking and subtype External Lot No.

Expiration Date Here you can specify the number that you want to use to create content for source type Item

Tracking and subtype Expiration Date.

Production Date Here you can specify the number that you want to use to create content for source type Item

Tracking and subtype Production Date.

Customer No. Here you can specify the number that you want to use to create content for source types Customer

and Customer Ref.

Vendor No. Here you can specify the number that you want to use to create content for source types Vendor

and Vendor Ref.

Label Printer Name Shows the device on which labels will be printed. This field is filled in automatically depending on

setup.

Document No. Here you can specify the number of a document.

Transaction Code Here you can specify the code of a transaction.

Location Code Here you can specify the code of a location.

Bin Code Here you can specify the code of a bin.

NiceLabel Cloud

Trigger API ID
Shows a unique trigger ID that will be used for NiceLabel3 Cloud.

Note

An ID is only filled in if you selected KUMAVISION Label Interface – NiceLabel3 Cloud in Label

Interface Setup.
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To distinguish this preview from the printing process itself, an additional parameter called PreviewFormat is passed on to the label

design program. This parameter has the value True for each preview, whereas the value is False for actual printouts.

After you run the Preview Label action, the label is shown on the Preview Label FastTab.

Create Structure File (Action)

Creates a file that contains all codes and sample values assigned to positions on a label, as a basis for designing new data

structures.

After the structure is created, it is stored in the standard Download folder. The file name shows the label code, the ID of the user

who created the file, and the date and time of creation.

If you’re using KUMAVISION Label Interface – NiceLabel3 Cloud or BarTender2 Web Service, the file extension will be JSON. If

you’re using the KUMAVISION Label Interface – NiceLabel3 On-Premises Web Service, the structure will be in the XML format.

File contents are arranged in the same way as in the file sent to the label design and print program.

Create a Label (Manually)

After the label information has been determined for a specific item, label data can be created and transmitted by choosing Create

Label File. This will create a file manually.

Create a label (automatically)

Warehouse receipt

If the Print at Receipt checkbox is selected on the Item-Label Relations page, labels will automatically be created for items when

you post their receipt at a warehouse.

As an example, you created and ordered in advance multiple items, which are now being received.

You then post their receipt so that a label is created and copied automatically to the relevant label design and print program. The

PDF file generated for the label will be three pages long, with each page showing one of the three items listed in the Qty.

Received field on the receipt.

NICELABEL3 ON-PREMISES

Required version or edition

The NiceLabel3 Web Service requires the Loftware NiceLabel3 On-Premises LMS Enterprise edition or higher.

NiceLabel3 On-Premises Setup

Label Interface Setup

On this page, you need to select KUMAVISION Label Interface – NiceLabel3 On-Premises Web Service in the Output Interface

field.

Everything else can be configured in the same way as for the default interface.

Label structure

To transmit data to NiceLabel3 On-Premises through a web service call, you need to fill in the NiceLabel3 On-Premises Web

Service URL field in the label structure.

Note

Field Description

NiceLabel On-Premises Web

Service URL
Specify the URL of the NiceLabel3 Automation Builder that will be used for

transmitting data to NiceLabel3.
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You can only see this field if NiceLabel3 On-Premises Web Service has been selected on the Label Interface Setup page.

Using NiceLabel3 On-Premise

You can take the following steps to integrate Loftware NiceLabel3 On-Premises with your Microsoft Dynamics 365 Business

Central1 environment.

The setup examples provided with this article are not meant to replace NiceLabel3 documentation nor any training in using the

program.

NiceLabel3 Automation Builder

With the help of filters and triggers provided by NiceLabel3 Automation Builder, you can set up print scenarios based on data

provided by Microsoft Dynamics 365 Business Central1.

XML Data Filter

Because data is transferred to NiceLabel3 On-Premises in the XML format, you need an XML filter. Add this filter, and a name, to

a new data structure. On the ribbon, choose Import Data Structure to import a structure file from Microsoft Dynamics 365

Business Central1. For more information on how to generate the file, see Create Structure File.

To use XML nodes as variables, you can then set the Usage property of every element in the structure to Variable Value.

Create a trigger

Afterward, create a unique trigger that contains the processes that you want to run. Go to the Configuration Items tab, choose

Add, and then choose Web Service.

Give the trigger a unique name and assign a port for communication with the web service. The port will be part of the web

service URL and will be linked to the label structure in Microsoft Dynamics 365 Business Central1.

Typically, the label design program is set up in a way so that variables will be read off the labels. Since label integration in this

scenario occurs throughout the system and the labels used are transmitted as parameters of a structure, you need to set up

integration variables manually by choosing Add > Variable on the Variables tab.

We recommend that, as names, you use the descriptions specified for the variables on the structure lines created in Microsoft

Dynamics 365 Business Central1. This way, label information will be mapped automatically to the variables.

To respond to preview or printout requests sent from Microsoft Dynamics 365 Business Central1, you must also add the

ResponseData variable. This variable will later be used to return values to the app.

Use Data Filter

Now, assign the NiceLabel3 parameters to the specified variables by adding the Use Data Filter function to the Actions tab.

Afterward, enter the XML structure as a name on the Filter tab. If the names of the XML variables match the position codes set

up in Microsoft Dynamics 365 Business Central1, choose Auto Map on the Data Mapping tab.

The information stored in the data structure is then assigned to each variable by the system. If names are different, you must

create mappings manually.

Open Label

Note

Note

Note
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Open the relevant label. As the label name is stored on a data structure line in Microsoft Dynamics 365 Business Central1, you

can again use a variable to get the name. Add the Open Label action, select the Data Source checkbox on the Settings tab, and

fill in the Label Name field.

Preview: Print to PDF

To save print information as a PDF file so that you can preview the label, add the Redirect Printing to PDF action, enter a file

name, and select the Overwrite File checkbox.

Because this action should only be performed for previewing a label, go to the Show Execution and Error Handling Options tab

and add the condition that for this function to work, the PreviewFormat variable must be set to True.

Print Label

Afterward, add the Print Label action and specify that the number of labels to print (=No. of Copies) will be sourced from a

variable.

Preview: Read data from file

For previews, the contents of the PDF file must then be read and copied to the ResponseData variable. Add the Read Data from

File action. In the properties, set the File Name as explained under Preview: Print to PDF and enter 20 as the Number of Retries.

Because, again, this action should only be performed for label previews, add on the Show Execution and Error Handling Options

tab the condition that for this function to work, the PreviewFormat variable must be set to True.

Preview: Set ResponseType PDF

Because the return value for a preview consists of a PDF document, you also need to convert the ResponseType. For this

purpose, add another action that sets the variable to application/pdf in the case of previews.

NICELABEL3 CLOUD

Required version or edition

The NiceLabel3 Cloud interface requires NiceLabel3 Cloud Business edition or higher.

NiceLabel3 Cloud setup

NiceLabel3 Cloud APIs Using NiceLabel3 Cloud APIs

Before you can use NiceLabel3 APIs, you need to log on to the API Developer Portal, create a subscription, and link the

subscription to your Control Center. For more information, see Cloud Integrations – NiceLabel3 Help Center page.

Label Interface Setup

On this page, you must select KUMAVISION Label Interface – NiceLabel3 Cloud Web Service in the Output Interface field and

enter an API subscription key.

Everything else can be set up in the same way as for the default interface.

Label printers

With NiceLabel3 Cloud, you can store what is known as cloud printers. As they aren’t connected to Microsoft Dynamics 365

Business Central1, they cannot be selected in the app.

To add them, you need to retrieve printer information through the API from the NiceLabel3 Cloud by choosing NiceLabel3 Printer

on the ribbon.

Field Description

NiceLabel Cloud API

Subscription Key

Specify the primary key shown on the Developer Portal.

This key is used as a component of API authentication, that is, it is included in the header

information for HTTP requests as “Ocp-Apim-Subscription-Key.”
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You can then choose Update Printer List to connect to the API and get the list of cloud printers stored online.

Label structure

With NiceLabel3 Cloud, you can set up automated workflows to specify labeling actions and processes. You can also create a

single workflow for use in every print scenario by assigning a variety of variables to the parameters available in the NiceLabel3

Automation Builder.

Automated workflows can be identified by their trigger IDs. To send label data structures from Microsoft Dynamics 365 Business

Central1 to the right triggers, you need to store a NiceLabel3 Cloud API identifier for each of them.

The content of this field must match the name of the trigger specified in the NiceLabel3 Control Center.

Use NiceLabel3 Cloud

You can take the following steps to integrate Loftware NiceLabel3 Cloud with your Microsoft Dynamics 365 Business Central1

environment.

The setup examples provided with this article are not meant to replace NiceLabel3 documentation nor any training in using the

program.

NiceLabel3 Automation Builder

With the help of filters and triggers provided by NiceLabel3 Automation Builder, you can set up print scenarios based on data

provided by Microsoft Dynamics 365 Business Central1.

Json data filter

Because data is transferred to NiceLabel3 Cloud in the JSON format, you need a JSON filter. Add this filter, and a name, to a new

data structure. On the ribbon, choose Import Data Structure to import a structure file from Microsoft Dynamics 365 Business

Central1. For more information on how to generate the file, see Create Structure File.

To use JSON parameters as variables, you can then set the Usage property of every element in the structure to Variable Value.

Create a trigger

Afterward, create a unique trigger that contains the processes that you want to run. On the Configuration Items tab, choose Add,

and then choose Cloud.

Give the trigger a unique name and a unique ID. This ID will be used to trigger cloud services and will be linked to the label

structure in Microsoft Dynamics 365 Business Central1.

Typically, the label design program is set up in a way so that variables will be read off the labels. Since label integration in this

scenario occurs throughout the system and the labels used are transmitted as parameters of a structure, you need to set up

integration variables manually by choosing Add > Variable on the Variables tab.

We recommend that, as names, you use the descriptions specified for the variables on the structure lines created in Microsoft

Dynamics 365 Business Central1. This way, label information will be mapped automatically to the variables.

Field Description

NiceLabel Cloud Trigger API

ID
Enter the unique Trigger Name used by an automated NiceLabel3 workflow for the label

structure.

Note

Note
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To respond to preview or printout requests sent from Microsoft Dynamics 365 Business Central1, you must also add the

ResponseData and ResponseType variables. These will later be used to return values to the app.

Use Data Filter

Now, assign the NiceLabel3 parameters to the specified variables by adding the Use Data Filter function to the Actions tab.

Afterward, enter the JSON structure as a name on the Filter tab. If the names of the JSON variables match the position codes set

up in Microsoft Dynamics 365 Business Central1, choose Auto Map on the Data Mapping tab.

The information stored in the data structure is then assigned to each variable by the system. If names are different, you must

create mappings manually.

Open Label

Open the relevant label. As the label name is stored on a data structure line in Microsoft Dynamics 365 Business Central1, you

can again use a variable to get the name. Add the Open Label action, select the Data Source checkbox on the Settings tab, and

fill in the Label Name field.

Initialize ResponseType variable

Set the ResponseType to application/json. Add the Set Variable action, enter ResponseType in the Name field, and select the

application/json value.

Initialize ResponseData variable

The ResponseData variable, on the other hand, must be “{}.” For this purpose, add the Set Variable action, enter ResponseData

in the Name field, and enter {}.

Preview: Print to PDF

To save print information as a PDF file so that you can preview the label, add the Redirect Printing to PDF action, enter a file

name, and select the Overwrite File checkbox.

Because this action should only be performed for previewing a label, go to the Show Execution and Error Handling Options tab

and add the condition that for this function to work, the PreviewFormat variable must be set to True.

Print label

Afterward, add the Print Label action and specify that the number of labels to print (=No. of Copies) will be sourced from a

variable.

Preview: Read data from file

For previews, the contents of the PDF file must then be read and copied to the ResponseData variable. Add the Read Data from

File action. In the properties, set the File Name as explained under Preview: Print to PDF and enter 20 as the Number of Retries.

Because, again, this action should only be performed for label previews, add on the Show Execution and Error Handling Options

tab the condition that for this function to work, the PreviewFormat variable must be set to True.

Preview: Set ResponseType PDF

Because the return value for a preview consists of a PDF document, you also need to convert the ResponseType. For this

purpose, add another action that sets the variable to application/pdf in the case of previews.

Set ResponseType and ResponseData

As a last step, open the trigger settings. On the Communications tab, enter ResponseType in the Response Type and

[ResponseData] in the Response Data field for use by the cloud trigger.

SEAGULL SCIENTIFIC BARTENDER2

Required version or edition

BarTender2 Web Service requires the Seagull Scientific BarTender2 Automation edition or higher.
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BarTender2 setup{ #additional-bartender-setup }

Label Interface Setup

On this page, you must select KUMAVISION Label Interface – BarTender2 Web Service in the Output Interface field.

Everything else can be set up in the same way as for the default interface.

Label structure

To transmit data to BarTender2 through web service requests, you also need to fill in the following fields on label structure

headers:

You can only see these fields if BarTender2 Web Service has been selected on the Label Interface Setup page.

USE BARTENDER2

You can take the following steps to integrate Seagull Scientific BarTender2 with your Microsoft Dynamics 365 Business Central1

environment.

The setup examples provided with this article are not meant to replace BarTender2 documentation nor any training in using the

program.

BarTender2 Integration Builder

With the Integration Builder, you can create and manage print scenarios.

When you set up a new scenario, you can also select the trigger that you want to use for interfacing with Microsoft Dynamics 365

Business Central1. Choose Web Service.

Service

The name of the scenario will match the name of the web service. However, if necessary, you can change the name on the

Integration tab.

Input data

On the Input Data tab, set the input format to JSON Variables and choose New Sample to select the structure file that you

created in Microsoft Dynamics 365 Business Central1. For more information on how to generate the file, see Create Structure

File.

Field Description

BarTender Web Service

URL
Specify the URL of the BarTender2 Integration Builder that will be used for transmitting data

to BarTender2.

BarTender Authentication Turn on the toggle if basic authentication should be required to gain access to BarTender2.

BarTender Username Specify the username needed to log on to BarTender2.

This field is only filled in if Basic has been selected in the BarTender Authentication field.

BarTender Password Specify the password needed to log on to BarTender2.

This field is only filled in if Basic has been selected in the BarTender Authentication field.

Note

Note
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This will transfer the values of the variables set up in Microsoft Dynamics 365 Business Central1 to BarTender2 as sample data.

Response

On the Response tab, select the format and the content that you want returned to Microsoft Dynamics 365 Business Central1.

As an encoded PDF stream is required to preview labels, the response by the app should be copied to a new variable to ensure

that this value is filled in by an independent action.

Variables

On the Variables tab, you can change default variables used in print scenarios or add new variables. As neither action is required

in this case, you don’t need to change anything here for now.

Actions

On the Actions tab, you can store various steps that make up something of a workflow. The program will follow each step as data

is received. The actions have been classified as follows:

Print

Transform

Input

Output

Execute

File

Database

Each action also comes with a subset of steps that can be linked together as needed. For more information, see the

BarTender2documentation.

Sample task

Have the label design and print program save label data received for preview as a PDF file before transmitting the information to

Microsoft Dynamics 365 Business Central1 in a response stream.

If the data isn’t meant for preview, however, have the program print the label information by using the printer specified in the

associated data structure. 

• 

• 

• 

• 

• 

• 

• 
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Solution

Print or preview

First, add a Select Case action to perform a check if the action that triggered the printing process is used when previewing labels

(that is, if the PreviewFormat variable linked to the action has been set to True). Specify that the next steps in the process will be

different for previews and printouts.

Preview

Assuming the ETI_DOCUMENT variable will be used to transfer data from Microsoft Dynamics 365 Business Central1 label

structures, the document that you want to open must now be linked to the variable.

The use of this method will reduce the number of printing scenarios needed, as the data structures already designate the relevant

labels.

Regarding print options, specify that print data should be saved to a PDF and enter the path to the directory where you want to

store the file. Afterward, choose Named Data Sources to assign the variables that you want to add to data sources in the Label

Designer.

As a next step, you need to store the PDF file in Base64 format in a variable (to allow a response by the label interface). Add the

PowerShell Command action, select Embedded Commands for the Source property, and enter the following:

[convert]::ToBase64String((Get-Content -path < file name from extended print options > -Encoding byte))

Afterward, enter the variable that you set up under Response in the Send Command Output and Errors to Variable field.

No preview = print

For a label to be printed instead, add the Print Document action. The look of the label remains because the layout is specified by

the label structure stored in Microsoft Dynamics 365 Business Central1.

As for print options, you can use variables to specify the printer you want to use and the number of labels you want printed based

on the label structure created in Microsoft Dynamics 365 Business Central1. Variables are specified in BarTender2 via %< name of

variable >% (for example, %TYPE_NO% or %ETI_PRINTER%).

As a last step, choose Named Data Sources to assign the variables you want transmitted from the relevant print scenario to the

named data sources used in the Label Designer.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

BarTender is a registered trademark of Seagull Scientific, Inc. 

NiceLabel is a trademark of the Euro Plus, d.o.o. 

1. 

2. 

3. 

1. 

2. 

3. 
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Packages / Carriers: Microsoft Dynamics 365 Business Central extension

OVERVIEW

According to DIN 30781, a carrier is a means to combine items into a unit load. Mainly, it is any piece of equipment, such as a

pallet, with which goods can be moved from one place to another at higher speeds and with greater efficiency than if each item

were transported on its own. With the Carrier Management extension, you can set up the carriers that you’re typically working

with and follow their path through the system with ease. Built on the package tracking capabilities provided with Microsoft

Dynamics 365 Business Central1, this extension is a fully integrated alternative to functions such as identifying items by their

serial or lot numbers.

You can work with carriers as part of the Dispatch functionality without having to use the standard feature for tracking packages.

INVENTORY SETUP

To set up the feature:

Choose the Search icon, enter Inventory Setup, and then choose the related link.

Fill in the fields as described in the following tables.

Package Management

Carrier Management

This FastTab only appears if the Enable Carriers toggle is turned on (see Package Management).

Note

• 

• 

Field Description

Enable

Carriers

Turn on this toggle if you want to work with carriers.

The Package Caption field (see Dimensions) is then filled in with the word ‘Carrier’ while the Carrier

Management FastTab appears on the page.

Afterward, the following toggles are also turned on automatically for item tracking codes that are used to

track packages:

• Carrier Info. Inbound Must Exist

• Carrier Info. Outbound Must Exist

Note

Field Description

Dispatch

Integration

Turn on this toggle if you want the carriers on warehouse, inventory, or posted documents that are

retrieved for a dispatch order to be filled in on the relevant dispatch lines.

Note

Carriers can be used in dispatch without turning on this toggle.
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Dimensions

ITEM TRACKING

As mentioned in the overview, this app extension is based on standard item tracking functionality.

To see what items are in or on certain carriers and in which quantity:

Choose the Search icon, enter Item Tracking Codes, and then choose the relevant link.

Select a code that will be assigned to items transported by carrier.

Turn on the following toggles on the Package Tracking FastTab:

• [Carrier caption] Specific Tracking

• [Carrier caption] Info. Inbound Must Exist

• [Carrier caption] Warehouse Tracking

• [Carrier caption] Info. Outbound Must Exist

ITEM TRACKING LINES

To make use of the new tracking feature, you also need to fill in the following fields on the standard Item Tracking Lines page.

Header

Lines

CARRIER NO. (PACKAGE NO.) INFORMATION CARD

A Carrier No. (Package No.) Information Card links a package number created in the standard app to a carrier set up in

KUMAVISION base (BOOSTER).

With carrier management turned on in Inventory Setup, a card is (in contrast to standard functionality) automatically created

when you post a transaction that includes the carrier.

The fields added to the card for the purpose of handling carriers are described in the following tables.

Field Description

Package

Caption

Fill in this field with the word ‘Carrier’ to replace the standard Package caption.

When you turn on the Enable Carriers toggle, the field is filled in automatically.

Note

The caption always remains in the language it which it was entered. This means that after a change in

system language, the text in this field needs to be adjusted manually.

Note

1. 

2. 

3. 

Field Description

Default Carrier

Code

Specifies the carrier code that will be copied to all lines when you run the Assign Package No.

function.

Field Description

Carrier Code Indicates the code that should be assigned to the carrier (package) number on the line.

You can use the code from the header for this. When you post to the page, the code is then copied to the

related Carrier No. (Package No.) Information Card.
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General

Dimensions

You can also run a ribbon function to print labels from the data entered on the card.

The caption change from ‘Package’ to ‘Carrier’ doesn’t affect all parts of the program in the same way.

If you want to use the general search function to see the carrier number information cards available and open a card from there, the

search term that you need to enter is Package No. Information List, not Carrier No. Information List. When the page opens, the

caption then changes to Carrier No. Information List.

PUT-AWAY TEMPLATES

During standard put-away, the system distributes the quantities combined into one unit load (as a set of packages) onto multiple

bins.

A field has therefore been added to the Put-Away Templates page so that you can now specify whether the system should only

suggest bins that can take up the entire quantity assigned to a carrier (package).

Lines

Field Description

Carrier Code Specifies the code that was entered for the carrier (package) number on the relevant item tracking line

prior to posting.

Field Description

Length Specifies the length of the carrier.

The value in this field is copied from base data but can be changed manually, if necessary.

Width Specifies the width of the carrier.

The value in this field is copied from base data but can be changed manually, if necessary.

Height Specifies the height of the carrier.

The value in this field is copied from base data but can be changed manually, if necessary.

Weight Specifies the weight of the carrier.

The value in this field is copied from base data but can be changed manually, if necessary.

Net Weight (Item) Specifies the net weight based on the entered item quantity.

Gross Weight (Item) Specifies the gross weight based on the entered item quantity.

Note

Field Description

No Carrier Qty.

Split

With the toggle turned on, the system suggests only bins that can take up the entire quantity specified

for a carrier (package).
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When you’re working with packages in the standard app, the quantity that is assigned to a carrier (via a package number) might end

up in more than one bin. The extension gives users a choice in this case, to retain a certain degree of flexibility as required of all

Microsoft Dynamics 365 Business Central1 solutions.

EXTENDED PACKAGE NO. INFO

This list shows you the following carrier information:

Item No.

Variant Code

Lot No.

Serial No.

Expired Inventory

Inventory

You can open the list by using the general search function. You can also use a ribbon function to print labels from the data

entered on it.

Microsoft, Microsoft Dynamics und Microsoft Dynamics 365 sind Marken der Microsoft-Unternehmensgruppe. 

Note

• 

• 

• 

• 

• 

• 

1. 
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General Setup

STANDARDIZE DOCUMENTS

Master reports use a standardized format for document creation in Microsoft Dynamics 365 Business Central1. Covering all

relevant areas, they can simplify the editing process, as changes that are made to the layout of one document will be copied to all

others of the same type. The following master reports are available for this purpose:

Purchasing

Purchase Quote

Purchase – Order

Purchase Return Order

Purchase Invoice

Purchase Credit Memo

Purchase – Receipt

Purchase Return Shipment

Blanket Purchase Order

Archived Purchase Quote

Archived Purchase Order

Archived Purchase Return Order

Archived Blanket Purchase Order

Sales

Sales Quote

Sales Order Confirmation

Return Order Confirmation

Sales Invoice

Sales Credit Memo

Sales Shipment

Blanket Sales Order

Archived Sales Quote

Archived Sales Order Confirmation

Archived Blanket Sales Order

Archived Return Order Confirmation

Sales Pro Forma Invoice

Sales Draft Invoice

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Service

Service – Quote

Service – Order

Service – Invoice

Service Pro Forma Invoice

Service – Credit Memo

Service – Shipment

Service Item Worksheet

Service – Contract

Service – Contract Quote

Reminders

Issued Purch. Order Cnfrmn. Reminder

Issued Delivery Reminder

Sales Reminder 

Transfers

Transfer Order

Transfer Shipment

Direct Transfer

Dispatch

Posted Dispatch Order

Before you can work with a master report, it must be added to the relevant report selection.

Do not enter the plus-minus sign (±) on any page available in the system, for example, to indicate tolerances in a drawing. If you do,

you might no longer be able to use the Print action on the document linked to the entry.

To configure the VAT Amount Specification section on these documents, you can use the VAT Code, a standard Microsoft

Dynamics 365 Business Central1 field that originates with VAT Posting Setup.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note

Note
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ADD DOCUMENT DETAILS

A tab has been added to the Company Information page. The tab provides you with an array of options for customizing

documents in the system.

Choose the Search icon, enter Company Information, and then choose the related link.

Go to the Documents FastTab and fill in the fields as described in the following table.

1. 

2. 

1.2.1 base (BOOSTER)

- 243/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Field Description

Preprinted Address Enter your company’s address as it should appear within an envelope window.

Text Length

(Header)

Text Length (Lines)

These fields are only used for the plain text editor.

The editor window is then adjusted in size to the values you specify here. However, any text that you

enter in the window is later printed across the entire width of a document unless line breaks are

added to it manually.

Neither field is required when working with the more recent HTML-based text tool.

Line Indent (Pts.) Specify by how much you want to indent a line to form a bundle or mark the begin-total of a block of

lines.

Print on Next Page Specify if you want to print an available subtotal on the next page of a document. You can select if

you want subtotals to appear only at the bottom or at the bottom and top of a page.

Print Alternate

Totals

Turn on this toggle to print alternate totals on sales quotes. For more information, see Alternate

Quote Lines.

Print Company

Letterhead

Turn on this toggle if you want your company’s address to be printed in the form of a letterhead.

Default Font Specify a default font and size for new master documents. The default setting for all is Segoe UI at a

size of 9.

Default Font Size A change in either field affects the entire document (that is, both the header and the lines).

For an explanation of how to change fonts on lines only, see Format Lines.

Default Footer Font

Size

Specify the size of the font chosen for the footer. The default size is 7.

Heading Right

Border Style

Heading Line

Border Style

Specify a border style for document information shown to the right of or below the address.

Hide Background

Color

Turn on this toggle if you want to replace the gray areas on printed documents with a transparent

background.

Heading Style Specify where to show contact information, that is the seller’s contact details, on a document.

You can display the data in block format on the upper right of a document or as a five-column section

below the address.

Separator Specify if you want more space or a divider added between document lines to serve as a visual aid.

Print External Lot

No.

Turn on this toggle to include on printouts the external lot numbers entered for a standardized

document.

When you print the document, the numbers will be shown on both the relevant lines and available

attachments.

Print Expiration

Date

Turn on this toggle to include on printouts the expiration dates entered for a standardized document.

When you print the document, the dates will be shown on both the relevant lines and available

attachments.

Print Production

Date

Turn on this toggle to include on printouts the production dates entered for a standardized

document.
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FORMAT LINES

You can also select a different format for each kind of document line, such as a heading or an alternative line, although you don’t

have to. If none is selected, the system will use the default format specified by the designer of the original document.

If you want a different style overall (such as a different font), you can set up a line and enter a report ID of 0. You only need to

enter a specific ID if you want a certain type of document formatted in a certain way.

The Default option plays a key role in this. If you want all lines to have the same format, you don’t need to set up more than a line

of the Default type.

The font style can also be changed for a document line before printing. In this case, choosing the Default option means that the

style will be the same as on a standard line. The system retrieves the format for printouts according to the following sequence:

Font style on current sales line.

Report ID of document to print and line type to be printed.

Report ID of document to print and line type Default.

Report ID = 0 and line type to be printed.

Report ID = 0 and line type Default.

Format according to document design.

Besides the font style, you can specify page breaks on document lines. If you don’t, breaks will be inserted automatically.

Field Description

When you print the document, the dates will be shown on both the relevant lines and available

attachments.

Print Customer

EORI No.

Specify if you want printouts of sales invoices and shipments to show your company’s or the

customer’s EORI number.

With the toggle turned on, a printout shows the number that you were given by the customer whose

VAT ID is entered on the document. We recommend that you then put your own number in the footer.

1. 

2. 

3. 

4. 

5. 

6. 
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Set up a format

To format document lines:

Open the Search icon, enter Company Information, and then choose the related link.

Choose Document Line Format on the ribbon.

Fill in (or change) the fields as described in the following table.

1. 

2. 

3. 
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Field Description

Report ID Select the report you want to use the format for. If you leave this field blank, the settings you make in

other fields are used for all documents.

Report

Description

Shows the description of the report.

This field is filled in automatically based on the Report ID field.

Line Type Choose the line type for which you want to specify a format.

The following options are available:

• Default

• Beginning Text (Header) – shown as DocHeaderLine

• Ending Text (Header) – shown as DocFooterLine

• Beginning Text (Line) – shown as PosHeaderLine

• Ending Text (Line) – shown as PosFooterLine

• Line Dimension

• Standard Line

• Line (Not Billable) – shown as NullPositionLine

• Alternative Line

• Shipping Information Line – shown as ShipmentLine

• Comment Line

• Heading (Line) – shown as HeaderLine

• Begin-Subtotal – shown as SubtotalHeader

• Bundle – shown as BundleHeader

• End-Subtotal/Bundle – shown as SubtotalBundleFooter

• Attribute – shown as ItemAttributeLine

• Assembly Line

• Reminder Line

• Item Tracking Heading

• Item Tracking Line

• Payment Terms/Shipment Methods – shown as PaymentShipmentTerms

• Item (Charge) Lines – shown as ItemChargeAssignmentLine

• Formatted Text

• Amount Line

Font Select the font that you want to use on all documents created from this report.

Font Size Select the font size that you want to use.

Font Color Select the font color that you want to use.

Font Style Choose the font style that you want to use:

• Default

• Normal

• Bold

• Italic

• Bold Italic

Text Decoration Choose a text decoration if necessary. Options are:

• Default

• None

• Underline

• Overline

• Strikethrough
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The settings you make here only apply to KUMAVISION reports (ID5XXXXXX) that have been included in the relevant report

selections.

If, after you have completed the general setup for all line types, you want to use a different format on a certain type of document,

you can copy that line format there and change only what you need. To copy the format:

Open the Document Line Formats page.

Select a line format.

Choose Copy Format on the ribbon.

Enter the source and target report ID. Choose OK.

TRANSLATE FOOTERS

You can set up footer texts for documents in different languages. To set up a translation:

Open the Search icon, enter Company Information, and then choose the related link.

Choose Document Text Translation on the ribbon.

Choose New and fill in the fields as necessary.

The information given at the bottom of document pages is then printed in the language you stored for the relevant vendor or

customer.

You don’t need a language code if you set up a footer in the language that you used to install the app. Instead, you can select the

Default Language field on the line.

MANDATORY FIELDS

You can use the mandatory field check to see whether a certain field has been filled in when you add or change base data, such

as on a customer order.

Note

1. 

2. 

3. 

4. 

1. 

2. 

3. 

Note
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Application areas

You can set requirements for field completion across a variety of application areas.

Setup Field

Item Inventory Setup Item Field Check

Warehouse receipt 

(header and lines)

Warehouse shipment

(header and lines)

Inventory Setup Inventory Field Check

Customers Sales & Receivables Setup Customer Field Check

Sales document

(header and lines)

Sales & Receivables Setup Sales Field Check

Vendor Purchase & Payables Setup Vendor Field Check

Purchase document 

(header and lines)

Purchase & Payables Setup Purchasing Field Check

Service document 

(header and lines)

Service Management Setup Service Field Check

Dispatch header and lines Dispatch Carrier Setup Check Mandatory Fields

Actions Action Setup Action Data Check

Resources Resources Setup Check Mandatory Fields
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Make a field mandatory

To make filling in a field mandatory:

Choose the Search icon, enter Mandatory Field Setup, and then choose the related link.

The page that opens shows how many fields will be checked for completion in every table that is entered on the lines. To see the

fields, select the No. of Fields hyperlink on a line.

To add a checking routine or change one that is already available, choose New or Edit List on the ribbon.

Enter a table number, if needed, and then choose Mandatory Fields on the ribbon.

Fill in the lines as described in the following.

• For technical reasons, you cannot set conditions on primary key fields in the system.

• Conditions set on Boolean fields should be ‘True’ or ‘False’ in all cases. Date fields cannot be used as conditions.

• The system also only runs checks on sales, purchase, and service document lines where the No. field is filled in.

Mandatory field checks are run when you use End Update or Release actions, such as the End Item Update function on an item

card or the Release function on a shipping document.

On the item, vendor, and customer list, you can also choose Actions > Check Mandatory Fields to have the system check the

records that you’ve selected for having all the necessary fields filled in. Records that can be released will be during this process,

whereas all other sets of data remain blocked.

After you’ve run the End Update action, the relevant record can no longer be edited (although related records, such as

comments, can). At the same time, the Update field on the card header is set to Completed.

1. 

2. 

3. 

4. 

5. 

Field Description

Field No. Specify the number of the field that you want users to fill in.

Field Caption Shows the name of the field that you entered a number for.

Field No.

(Condition)

If the field only needs to be filled in when a certain condition is met, for example, when the type of the

related document is set to Order or the customer’s posting group to Global, the number entered here

refers to the field that the condition will be based on. 

Afterward, you can use the Condition field to specify the exact requirement.

Field Caption 

(Condition)

Shows the name of the field that decides whether completing the field in this table will be mandatory.

Condition Specify a requirement for the condition field to tell the system when to make filling in the field in this

table mandatory.

Action Choose what happens if the field in this table is not filled in. The following options are available:

Cancel

The relevant process cannot be cancelled until the field is filled in.

Notify

The system shows a notification when the field remains empty. Users, however, can still process or release

documents that the field has been entered on.

Note
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If you exit a page before all mandatory fields are filled in, you’re asked if you’re sure that you want to do so. To turn off this

message:

Choose My Settings on the top ribbon.

Select the hyperlink in the Notifications field.

Clear the relevant notification field.

To change an updated record, you again need to run the edit function from the relevant card.

The mandatory field check integrated into KUMAVISION factory365 differs from the check described here; for more information, see 

factory365. For a description of how to validate item attributes, see Item Attributes.

BLOCK BASE DATA

You now have even more options to block an item from being used in certain application areas.

Choose the Search icon, enter Items, and then choose the relevant link.

Open the card of the item for which you want to limit usage.

On the General FastTab, turn on one (or more) of the toggles described in the following.

Physical inventory

Independent of the toggles, the system will check fields such as Location and Bin to determine whether a certain item is part of a

physical inventory order or physical inventory recording, and a message stating as much will appear if an attempt is made to post

to the item.

ASSIGNED USER ID

The Assigned User ID field that can be found on sales and purchase documents is a standard Microsoft Dynamics 365 Business

Central1 field used to identify who set up a sales or purchase document or to filter documents for specific IDs.

The KUMAVISION base industry solution fills in this field automatically with the ID of the user who is currently logged in to the

system.

ORDER TYPES

To easily identify and manage orders within the system, you can now assign a category to them. They cover:

Sales (includes service orders)

Purchases

Transfers

Production

You can also set up subcategories, such as standard, rush, VMI, subcontract, or rework orders, on each Order Type page.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

1. 

2. 

3. 

Note

1. 

2. 

3. 

Field Description

Manufacturing Blocked With the toggle turned on, the item cannot be added or posted to in manufacturing.

Prod. Consumption Blocked With the toggle turned on, the item cannot be consumed in manufacturing.

Transfers Blocked With the toggle turned on, the item cannot be entered on transfer orders.

Assembly Blocked With the toggle turned on, the item cannot be entered on assembly orders.

Projects Blocked With the toggle turned on, the item cannot be entered on projects.

• 

• 

• 

• 

1. 
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Deprecated Features

Title Description Disabled in

Release

Extensions to the discontinued

Microsoft price calculation.

The KUMAVISON base extensions have been implemented

again on the basis of the new Microsoft price calculation.

Note: Microsoft has repeatedly postponed the removal of

this function.

BC 2021 Wave 1

Bonus Function discontinued. BC 2024 Wave 2

Own cancellation functionality in

Sales and Purchase

Will be replaced with the new option (to be set up in the

Sales & Purchasing Setups): "Extended Cancellation Basis".

BC 2025 Wave 2

Source Location A new solution for finding locations was implemented in the

Dispatch Module.

BC 2025 Wave 2

KUMAVISION Label Interface File

Extension

The app is not Universal Code compliant. The interface has

been replaced by the web services.

BC 2025 Wave 1
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1.2.2 factory365

KUMAVISION factory365

With KUMAVISION factory365, you can easily master the balancing act between costs, resources, logistics and adherence to

schedules. Because the integrated industry software is perfectly tailored to the needs of the manufacturing industry and offers all

functionalities in one system.

Continuous connection between design and production

Project management with concurrent calculation

Pre-, post- and concurrent article costing

Transaction-related storage of objects such as documents, drawings and certificates

Role-based interface

Order proposal with integrated frame processing

Demand forecasts for inventory optimization

Flexible management of all types of storage

Content

General Business Functionality

Sales

Purchasing

Manufacturing

Warehouse Management

Service

Engineering and Design

Item Versions

Scheduling Agreement Management

Calculation

Plant Engineering

General Setup

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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General Business Functionality

GENERAL BUSINESS FUNCTIONALITY

The following features expand standard Microsoft Dynamics 365 Business Central1 functions to provide additional options to

those using General Business Functionality.

Item Attributes

Subcontracting

Metal Surcharges

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

1. 
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ITEM ATTRIBUTES

General

Item attributes are used to classify and retrieve articles based on their characteristics. Characteristics can be assigned to each

article. Either individually or via the characteristics preassigned to the article category.

In the following, the functional enhancements of the item attributes in KUMAVISION factory365 are explained in more detail.

Basic information on this area is provided in the Microsoft Dynamics 365 Business Central1 Online Help.

Establishment

Item Attribute

Before you can work with the article attributes, you have to set up the required characteristics and their attributes. To do this,

call up the "Article attributes" via the user search. Via "New" in the menu ribbon you can define a new article attribute with the

help of the tables below.

Inforegister General

Inforegister unit

Inforegister Factory Item Synchronization

Field Description

Code Here you can define a unique code for the attribute, by using codes as unique keys you prevent input

errors.

Name Assign a name for the attribute

Type Specifies the type of attribute.

You can choose from the following:

• Option

• Text

• Integer

• Decimal number

• Date

Note

Please note that by assigning the type, the "Data type" field is automatically pre-populated by the system.

NAV data type This field is updated when the "Type" field is maintained and sets the data type defined in the database. *

Default value Define the value with which the attribute value is always pre-assigned.

Sorting Specify the sort criterion for tabular display here. If you leave the field empty, sorting is based on the

Name attribute.

Field Description

Unit code Here you can assign a unit code, by the assignment the field unit is assigned in the background and

possibly also overwritten.

Only for numeric types, and for option if integer or decimal was assigned here.

Unit Specifies the base unit in relation to the unit code.
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For a simple and unambiguous recording, values of the article card can be synchronized with the article attributes, so that the

data must be maintained only in one place. The necessary setups are made on the "Factory article synchronization" info tab of

the respective article attribute. The synchronization setup is described below:

When linking a field of the article card (with a field value) to selection values of the source table, the field "Type" must be equal

to "Option": 

At this point in the online help, only the additional setup options for item attributes in KUMAVISION factory365 are explained in

more detail. You can find the online help for the general setup options here.

Ribbon function Factory Item Synchronization

Update attribute values

Use this call to transfer the data records from the reference table to the article attributes.

If changes are made in the article attribute values table, the new data records or corrections are transferred to the target table.

A maintenance in the reference table does not lead to an automatic update of the article attribute values, these must be taken over

via Update attribute values.

Update reference tables

Field Description

Target field ID Enter the field of the item that contains the assignment here.

For example, the ID 47 field if you want to synchronize data via the customs position.

Field name Specifies the name of the assigned field in "Target field ID".

Field Description

NAV Tables ID In this field you specify which table should be synchronized to the options table.

For example, the table ID 260 for synchronization of data from the table Customs position.

Table designation Specifies the name of the assigned field in "NAV Table ID".

NAV Key Field ID In this field you specify the primary key of the source table, these are usually "Code" or "No.".

This value is transferred to the code field of the item attribute values table.

For example, the field ID 1 for the field No. of the table Customs item.

Field name Specifies the name of the assigned field in "NAV Key Field ID".

NAV Description Field ID In this field you specify the information field of the source table that you want to synchronize.

This value is transferred to the value field of the item attribute values table.

For example, the field ID 2 for the Description field of the Customs Item table.

Field name Specifies the name of the assigned field in "Description field name".

After the field assignment, the system automatically determines the "Data type" field.

Note

Note
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Use this call to transfer the data records from the article attribute values to the reference table.

Synchronization logic

When synchronizing, note the following:

Item

If a field defined in the item attribute card is changed on the item card, this value is transferred to the item attributes; if the item

attribute is not yet assigned, the assignment is made by the system.

Item variant

If the affected item has item variants, the changes are also transferred there. Deviating from this are fields that can be

maintained in the tables themselves. These are for item variants:

Description

Description 2

Sale locked

Purchasing locked

Service locked

Production locked

Item version

If the affected item has item versions, the changes are also transferred there. Deviating from this are fields that can be

maintained in the tables themselves. These are for item versions

Material

Drawing no.

Drawing format

Manufacturer code

Finished parts list no.

Work plan no.

Please note that expired item versions will not be updated.

Attributes maintenance

If you maintain the assignment of the attributes, these changes are transferred to the articles as well as to any existing article

variants and article versions in the case of defined synchronization.

Call Usage

The "Usage" call in the ribbon displays the records that currently have the corresponding item attribute assigned in the system.

The fields of the "Usage" table are explained below:

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Field Description

Table The table ID of the item, item category and item variants or version used by the system. This field is not

displayed to you.

No./Code Indicates the article no. from the article, article variant or article version as well as the code from the

article category and the Lfd. No. from the catalog article.

Variant code The variant code from the article variant or article version. The field remains empty for articles and

article categories.

Article version

code

Specifies the item version code from the item version. For article, article category, article variant the

field remains empty

Description Specifies the description.
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You can display the corresponding map via "Show map" in the ribbon.

Item attributes assignment

KUMAVISION factory365 allows you to use item attributes not only for the item, but also for catalog articles, article variants and

article versions and provides the full range of functions here.

The following inheritance logic must be observed:

The diagram shows you horizontally what can be derived from which element and vertically how it is inheritable in itself.

Item

On the item card, you can assign the attributes for the item via the "Attributes" call in the menu ribbon. In the "item attributes"

info box on the item card, the data of the assigned attributes are displayed directly.

Item category

On the item category card, you can use the "Attributes" call in the ribbon to assign the attributes for the item category. In the

"item attributes" info box on the item category card, the data of the assigned attributes is displayed directly.

If you assign this item category to an item, the attributes from the item category are transferred to the item.

If changes are subsequently made to the attributes of the item category, they will be inherited by the assigned item. 

Please note that the attributes of the parent item categories are inherited by the child item categories. However, the inherited

attributes cannot be changed in the subordinate item categories. Per item, item variant as well as item version these can always be

adapted individually.

Catalog items

On the catalog item card, you can use the "Attributes" call in the ribbon to assign the attributes for the catalog item. In the

"Article attributes" info box on the catalog item card, the data of the assigned attributes are displayed directly.

Note
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If an article is created from a catalog item, the attribute definitions are taken from the catalog article. 

Please note that after the item creation, no more maintenance of the attributes via the catalog articles is possible, but only on the

corresponding item card.

If you subsequently assign an article category to the created article, any article attributes stored will be inherited by the item.

Item variant

When creating new item variants, the attribute assignments of the article are transferred one-to-one to the variant and can be

adjusted there according to your requirements.

To do this, call up the "Attributes" callup in the ribbon in the article variant in order to assign the type attributes for the variant.

The data of the assigned attributes are displayed directly in the "Article attributes" info box.

Changes to the values of the article attributes are not transferred to the variants.

Item version

When creating new article versions, the attribute assignment of the article or variant is transferred one-to-one and can be

adjusted there according to your requirements.

To do this, call up the "Attributes" callup in the ribbon in the article version in order to assign the attributes for the article

version. In the "Article attributes" info box on the article version, the data for the assigned attributes are displayed directly

In the article version, you cannot define print control for sales.

The transfer of new attributes from the associated article or variant is performed depending on the definition via the

"Automatically transfer attributes to versions" field in the Design & Development setup:

Attribute search

The standard allows to control the overview in the article overview via attribute filters. The extension of the attribute usage to

article variant as well as article version make this filter possibility incomplete, because it is not usable for article variant, article

version as well as catalog articles, for this reason there is the article attribute search.

Note

Note

Note

Field selection Description

Not No attributes are transferred.

New only New attributes are only transferred to the versions in New status.

Until Certified New attributes are transferred to the article versions with the statuses New and Certified.

until Certified and

reset to New

New attributes are transferred to the article versions with the statuses New and Certified. If the

article version has certified, this is reset to New, so that manual editing or checking becomes

necessary.

All Basically the attributes are transferred.
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You can call the attribute search directly via the user search or accordingly from the documents listed below:

Assembly parts list

Assembly order

Project plan line

Production parts list

Request

Frame order

Order

Invoice

Return

Purchase credit

Offer

Framework order

Order

Blanket order

Take back

Credit

When calling from the documents, the data of the source line are determined and maintained as header data. If you have not yet

made any selection other than setting the type to article, no initialization is performed either.

In the listed documents, you can use the attribute search, filter by article and transfer directly to the document. Please note that the

article version is not taken into account for consuming documents.

If you want to transfer a catalog article, you must first create it as the correct article via the catalog article. Afterwards, please start

the search again or enter the newly created article directly.

In the header area of the attribute search, you can have the search lines suggested via the fields Article category, Article, Article

variant as well as Article version by maintaining the fields.

The maintenance of the fields should be done hierarchically from article category to article version. According to the hierarchy,

the sequence selections are restricted.

If you do not enter data hierarchically, the higher data will be determined and filled in by the system. For example, if you start

with the article version, the system determines and maintains the article category, article and article variant as defined in the

article version.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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• 
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• 

• 

• 

• 

• 

• 

• 

Note
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EXTERNAL PRODUCTION WITH PROVISION

General

A work process that is outsourced (also called extended workbench) occurs particularly frequently in contract finishing processes

and also in the assembly of subassemblies. Outsourcing is also a possible alternative to in-house processing when capacity

bottlenecks occur in the company itself. Components are often provided that are required for further processing at the external

manufacturer. In most cases, the product already machined is also provided.

In the case of external production with provision, the standard functionality of external production has been extended by a

provision. The provision allows you to define the components that are sent along for external production or that are also provided

by the external manufacturer. For logistical processing, a stock transfer order can be created for the purchase orders from the

external work worksheets. The corresponding logistics documents can be printed out for the posted stock transfers.

When posting the external production order, depending on the setup of the components, the debit is made from the external

production warehouse in the corresponding quantity.

Establishment

The following sections describe how to set up external production with provision of materials. The basic facilities for

manufacturing/production apply as a prerequisite for setting up external production with provision. For more information, please

refer to the Microsoft Dynamics 365 Business Central1 Helpsite.

Production bill of material, version

In the following, only the special features of external production with provision are discussed. As a prerequisite for setting up

external production with provision, the facilities for manufacturing/production apply. For further information, please refer to the 

Microsoft Dynamics 365 Business Central1 Helpsite.

Inforegister lines
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In the production BOM (version), the fields "Connection code" (this field identifies the component as a raw material provision

relevant to logistics) and "Provision type" must be set.

A component defined on a production BOM of an item can be linked to a specific operation using connection codes. Thus, it can be

defined at which operation an item is needed or consumed. In order to use the functionality of the provision, the connection code

must be defined

The connection code must first be stored in the operation before the setting for the component can be made in the production BOM.

Otherwise, an error message will be displayed when trying to certify the BOM.

Work plan, versions

In the following, only the special features of external production with provision are discussed. As a prerequisite for setting up

external production with provision, the facilities for manufacturing/production apply. For further information, please refer to the 

Microsoft Dynamics 365 Business Central1 Helpsite.

Provision type

option

Description Note

Empty No provision (Business Central Standard)

Order-related The components are not sent via a stock transfer order until the

external production orders are created.

The outgoing storage location in the FA components is set to the

storage location of the external worker (entered in the work center

group under storage locations of origin) when the stock transfer

order is created.

Connection code must be

maintained.

The posting method must

be manually changed to

"Backwards" or "Commiss.

+ backwards" in the

respective FA component

line.

The provision item is

transferred to the stock

transfer order created for

the external work.

Neutral The external processor receives a certain quantity of goods in

advance. The stock transfer order required for this must be created

manually or via a planning worksheet. When a production order is

created, the external processor only receives the order for external

processing and, if necessary, a stock transfer of the product already

processed. The components to be provided are already at the external

processor. Here, too, the posting method of the FA components is

changed to "backwards".

The issue storage location in the components is already set to the

external processor when the production order is created or within the

planning (is entered at the work center group under origin storage

locations). When using this type of provision, it is recommended to

set up storage data for the respective components at the storage

location of the external processor.

Connection code must be

maintained

The booking method must

be manually changed to

"Reverse" or "Commiss. +

backwards" in the

respective FA component

line.

The provision item is not

transferred to the stock

transfer order created via

the external work.

Supplier Here, the component is only in the production BOM for information

("info section"). The procurement is done by the external processor.

This setting is also used when the customer provides parts. Here no

stock or issue posting takes place.

The provided item is not

transferred to the stock

transfer order created via

the external labor

Note
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Information register: lines

The connection code must be maintained for the use of the provision in the operations.

Workstation group

In the following, only the special features of external production with provision are discussed. As a prerequisite for setting up

external production with provision, the facilities for manufacturing/production apply. For further information, please refer to the 

Microsoft Dynamics 365 Business Central1 Helpsite.

Usually, the following settings are made when creating a workstation group for external work:

Inforegister General

In the "Department code" field, the workstation group is assigned to a separate department (e.g. external work).

Information register booking

On the workstation group, the vendor must be stored in the "Vendor no." field that performs the external work.

The posting method must be set to "manual", as the postings are posted via the external labor order.

In the product posting group, a separate posting group for "external labor" should be set up and assigned to better distinguish

the origin of non-cash items in accounting.

The product posting group defines G/L accounts that are posted when sales and purchase postings are made.

The cost price calculation type is usually set to "piece" for external work In this case, you should then also activate the "Special

cost price" check box.

If you have agreed with the vendor on a different price for each process for external work, select the Special cost price check

box.

If you use the "special cost price" indicator, then you must enter the "Cost price per unit" field in the operations. The cost price in the

"Posting" info tab of the work center group is then not taken into account.

Inforegister Planning

The "Unit code" field is usually set to days, since external processing is usually calculated in days.

As a rule, a separate company calendar is created for external processing.

Navigate menu tab

Field Description

Third party

article

This field marks the operation as "Provision of semi-finished products" relevant to logistics. The external

operation can be transferred to a stock transfer order. The registration takes place in the FA-operation

or as booked capacity item with quantity without time and value.

Standard catalog

code

The standard catalog code is used for external labor pricing

Connection code Connection code selection

Note

Note

Note
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In addition, the external work prices and the origin storage location can be stored via "Belonging" > "Workplace group".

Determination of prices for external work

In Microsoft Dynamics 365 Business Central1 Standard, a price for the external work (i.e. the price that will later be used in the

purchase order) can only be stored on the work center group card or the operation (if the work center group is set up with

"special cost price"). Different prices per vendor, per scale quantity, per activity (standard catalog code) or period-dependent

prices cannot be maintained. 

In KUMAVISION factory365 you have your own price table for the external work orders. The prices for the external work can be

stored in different places. Thereby the entries of the external work prices override the prices of the work group card or the work

operation.

Third-party work prices Prices (with the option of graduated prices) can be stored for the following combinations via the

external work prices:

Workstation group (MUST)

Article (MUST)

Vendor (MUST)

Standard catalog (external work activity)

Start and end date

Minimum quantities (graduated quantities)

Price units (conversion factor weight share)

The external work prices can be called from the following masks with appropriate filtering:

Workplace group card / list

Accounts payable card / list

If more than one operation of an item should be processed via external labor, then you must assign different standard catalog codes

in the operations, so that you can also define different prices.

Origin camp location

With the origin storage locations you can control which storage locations should be used for the provided components. For

external processing you must use the type "all items". 

The call of the origin storage locations is made from the workstation group map/list.

Type of origin: workplace group

Origin code: which specific workstation group

Type: All items or a specific item

Code: for specific article: Item number

Storage location code: which storage location is to be controlled

Relocation routes

With the help of the stock transfer routes you have the possibility to create the link between the vendor warehouse (i.e. the

warehouse of the external processor) and your own warehouse.

To set up the stock transfer routes, call them up via the user search.

The stock transfer routes overview opens. In the info tab "Stock transfer route matrix" you can now make the assignment for

your own warehouse (stock transfer from code = own warehouse (e.g. BLUE)) and the vendor warehouse (e.g. external).

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note

• 

• 

• 

• 

• 
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By clicking on the Assist button you get to the transfer route specification on which you enter in the field "Transit Code = Own-

LOG". This field must be filled with an appropriate code, the other fields can remain empty if no fixed deliverer is defined.

You can then close the Stock Transfer Route Specification and Stock Transfer Route Matrix windows.

Process of external production with provision

Initial situation: Production is planned and a released FA has been created.

Outside Work Worksheet Calculate external labor

In the external work worksheets, you can calculate which released production orders are to be sent to the vendor. You can filter

on the work center group, the vendor or the FA number, among other things.

The external work worksheet then lists the pending external work calculated according to the filtering.

The vendor is taken from the work center group, the price depending on the stored prices. If there is already external work for

an FA, this is not calculated twice.

The external work worksheet shows that a stock transfer order (for the operation itself or for order-related provisions) is created

for the respective operation.

Work in the external work worksheet

Change of the creditor: The vendor can be changed per line (order), thus the external labor price stored in the new vendor is also

used.

Perform event reporting

The proposal line can be converted into an order using the "Execute event message" function and the "Accept event message"

checkbox activated.

If the "Create stock transfer order" checkbox is activated in the external works worksheet, a stock transfer is also created. This

can be several stock transfers if different storage locations are involved.

Default lines in which the "Accept event message" checkbox is not activated remain in the external work worksheet without an

order being created.

In order to subsequently generate the stock transfer order for the materials provided, the external work order must be deleted again

and recalculated. Alternatively, it is also possible to create the stock transfer order in the external work order using the "Create stock

transfer order to external manufacturer..." function.

Released production order Pursuit of the foreign work

The tracking of external labor is done at the line level in the production order. To do this, select the corresponding line and call

up the "External work tracking" via Line.

The linked documents can be viewed and called up via the window called up by this function.

Order

In the external work order, the activity or operation of the item is ordered. Accordingly, the description of the item line in the

purchase order does not contain the name of the item, but the operation description.

The columns FA no., FA line no., work center group no. and operation no. should be shown, as they represent the reference to

production.

In the respective order line, you can use the "Line" menu tab to call up the FA components assigned to the operation via the

connection code.

Note
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The order type FREMD is automatically preset for orders from the external work worksheet, but can be changed manually. This

can be used to preset certain data, such as payment terms and other fields.

If the purchase order is delivered, the operation is confirmed at the same time.

If it is the last operation of a production routing, the receipt to stock (item actual message) is posted.

Book delivery

Depending on the setup of the storage location where the production order and thus the external production order was created,

the delivery of the external production is to be posted directly via the purchase order or the corresponding logistics documents.

The basic process of creating logistics documents or entering delivery quantities is no different for an external production order

than for an order for articles.

No stock placements are generated after the goods receipt has been posted, as this is not a stock movement of an article.

As already mentioned, external production is the ordering of activities or operations on an item. Therefore, only a capacity item

is generated within the production order when posting. Only if it concerns the last operation an article item (item type "actual

message") and thus a stock movement is generated additionally.

If FA components are assigned to the operation or order line as a provision via the connection code, they are automatically

posted in the background when the delivery is posted in the corresponding quantity. A special feature here are FA components

with article tracking, this must be assigned to the respective FA components. Due to this, as already mentioned, the call of the FA

components is available in the purchase order as well as in the logistics documents.

Stock transfer

In the stock transfer header, the field Stock transfer order type indicates that the stock transfer is for external production. If you

do not receive a separate message from your external processor about the receipt of the provision at his storage location, you

should set the switch "Outbound automatically posts inbound" in the stock transfer order, because otherwise the provision is in

transit and you would have to post the stock receipt to the vendor again.

Alternatively, you can perform the setup globally on the corresponding storage location card for third-party manufacturers. To do

this, activate the switch "Transfer order output posts automatic input". The switch in the stock transfer header is then preset

according to this setup.

The posting of the stock transfer order issue is again done depending on the setup of the storage location either directly via the

stock transfer order or the logistics documents (goods issue or warehouse picking).

If the "Order-related" provision type is set in the FA components, the item tracking is automatically inherited when the stock

transfers for the provision are posted. If the "neutral" provision type is set, the supplier must report the item tracking used on

their delivery documents and this must then be entered accordingly in the FA components before the external production is

posted.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

Note

Note

1. 
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METAL TAX SURCHARGE

General

The app "KUMAVISION Metal Tax Surcharge" for KUMAVISION factory365 enables a simple administration and automatic

booking of all stock values in purchasing and sales. Based on the precious metal weight share of an item, with a corresponding

base price and possible additional purchase costs, a surcharge/discount value is automatically calculated in the offer and order

and also automatically posted in the further process.

In addition, any number of surcharges can be managed per article, since a separate surcharge line is generated for each

precious metal component. Furthermore, the precious metal weight of assemblies or products can be easily determined via the

parts list using a special function.

Please note that the use of the app requires a possible additional licensing.

Establishment

KUMAVISION Module Setup

The metal control surcharge is an activation module, the use of which is only possible with additional licensing and activation. To

activate the module, call up the "KUMAVISION module setup" via the user search and activate the "Activate metal surcharge"

button. Provided that you have licensed the module, the functionalities are available to you in the full extent.

Article Surcharges/Discounts

Using the surcharges/discounts, you can map additional costs of an item in Microsoft Dynamics 365 Business Central1 and thus

ensure correct warehouse valuation.

The precious metal costs also belong to the surcharges shown and must be entered in the system in advance. To do this, first call

up the "Article surcharges/deductions" via the user search.

Further information can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Warehouse facility

An additional info tab "Metal surcharge" has been integrated in the warehouse setup. On this info tab, you can use the "Metal

surcharge" field to store the previously defined article surcharge/discount. By the assignment you define the calculation basis of

the metal surcharge in the sales and purchase documents.

Article metal list

In the article metal list, all article metals are initially listed with their base prices and percentage delivery costs.

Metal quotation

In the metal quotations you manage the current exchange-dependent price quotations for the metals.

Filter area

Note

Field Description

Code Specifies an abbreviation for the metal.

Description Specifies a description of the metal.

Base price Indicates the base price for the metal on which the quotation is calculated.

Delivery costs Indicates possible delivery costs as a percentage.

Field Description

Current metal code Selection on the metal code on which the filtering is to be set.
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Lines

Article metal content list

You can call the article metal part list on the one hand via the user search or on the other hand via the article card via a lookup in

the field "Metal list".

Via the article metal parts list you define which metals an article consists of or which surcharges are to be taken into account for

an article for sale/purchase.

Surcharges in the sales process

In the sales documents, the overhead rates are calculated using the following formula:

As soon as you enter an article line with a quantity specification in a sales document, the system automatically determines the

corresponding surcharge rates for you and automatically inserts them in the sales document in the form of surcharge/discount

line(s). 

In case of a quantity change of the article line, a quantity change of the surcharge/discount line(s) takes place automatically as

well.

If you convert a sales quotation into a sales order, use the "Copy document" function or create a subsequent credit note, the

addition/sales lines will also be taken into account.

Surcharges in the purchasing process

In the purchasing documents, the overhead rates are calculated using the following formula:

Field Description

Metal code Specifies the corresponding metal code of the record.

Offer date Specifies the offer date of the record.

Offer price Specifies the offer price of the record.

Note

The offer price always refers to 100 kg.

Field Description

Item no. Indicates the part number to which the metal allocation applies.

Metal code Specifies the assignment of the corresponding metal code for the item.

Net weight Indicates the net weight of the respective item, which is indicated on the item card in the

"Net weight" field.

Metal weight In this field you can maintain the metal weight in kilograms.

Start date Here you can specify a date from which the surcharge is to be taken into account.

Berech. Sales surcharge Check the box if you want the surcharge to be included in the sales documents.

Berech. Purchase. Metal

surcharge

Check the box if you want the surcharge to be included in the purchasing documents.
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As soon as you enter an article line with a quantity specification in a purchasing document, the system automatically determines

the corresponding surcharge rates and automatically inserts them in the purchasing document in the form of surcharge/discount

line(s).

In case of a quantity change of the article line, a quantity change of the surcharge/discount line(s) takes place automatically as

well.

If you convert a purchase request to a purchase order, use the "Copy document" function or create a subsequent credit note, the

surcharge/discount lines will also be taken into account.

Metal weight across multiple BOM levels

With the action "Calculate metal weight" in the menu ribbon of the part card, the metal weights of the production BOM

components in the assemblies can be written into the fields "Metal weight" and "Single-level metal weight" and "Multi-level metal

weight" via the production structure BOM.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Sales

The following features expand standard Microsoft Dynamics 365 Business Central functionality to provide additional options to

those working in your organization’s sales department.

CHECK EXTERNAL DOCUMENT

This function enhancement checks when a sales document (order, sales return, invoice and credit memo) is released whether the

external document number is entered in the field of the same name and whether it is already used in other documents.

To do this, the "Check external document" switch must be activated in the Accounts Receivable & Sales setup.

If the switch is activated in the Accounts Receivable & Sales Setup, a release and posting of the document is only possible by

entering a unique external document number.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

1. 

1.2.2 factory365

- 270/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://learn.microsoft.com/en-us/dynamics365/business-central/sales-manage-sales


Purchasing

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s procurement department.

TOLERANCE (TIME) IN BOTH DIRECTIONS

In the standard Microsoft Dynamics 365 Business Central1 a tolerance time can be set for the procurement run to avoid too many

change notifications. This refers to the length of time that a requirement cover (e.g. a purchase order) can be received earlier

than a requirement originator (e.g. an order) requires this.

The setup is done in Microsoft Dynamics 365 Business Central1 Standard first centrally in the production setup via the field

"Standard tolerance period" and can be overridden article specific in the article or inventory data with the field "Tolerance

period".

In KUMAVISION factory365 the standard fields were renamed to "Standard tolerance period too early" and "Tolerance period too

early".

Furthermore, the production setup was extended by the "Standard tolerance period too late" and the article or stock data by

"Tolerance period too late". Thus, in KUMAVISION factory365 tolerances can be defined in both directions in the replenishment

procedure "lot-by-lot".

Basically, the lot accumulation period must be defined if the tolerance period is to be used. Here the rule applies that the lot

accumulation period must be larger than the tolerance period.

Tolerance setup

Global

Enter the term "Production setup" via the user search and select the corresponding link.

Via the "Planning" info tab, you have the option of entering the tolerance times in the "Standard tolerance period too early" and

"Standard tolerance period too late" fields.

Specific

To set and define specific tolerances, open the desired item or inventory data card for this purpose. On the "Planning" info tab,

you can define the tolerances in the "Tolerance period Too early" and "Tolerance period Too late" fields. 

The specific tolerances override the global tolerances from the production setup.

OPTIMIZED PLANNING PARAMETERS

In Microsoft Dynamics 365 Business Central1, reservations must not be used for the planning parameter "minimum stock".

Otherwise, this could lead to untraceable proposal lines.

In KUMAVISION factory365, the planning parameters for the replenishment procedures "Fixed order quantity" and "Replenish to

maximum stock" have been optimized so that the "Reserve" field is set to "Never" by default.

When the replenishment procedure is changed to "Fixed order quantity" or "Replenish to maximum stock", the system

automatically checks whether any reservations still exist. If this is the case, a message appears informing you to delete them.

COLLECTIVE REQUESTS

The function extension "Collective inquiries" is to prevent that as soon as a FA component with reservation reference is given via

the order proposal into a purchase inquiry, the reservation reference to the later order is not lost. 

Note

Note
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The order proposal line with reservation and inquiry reference must not be deleted when the "Calculate planning" function is

repeatedly executed. Additional requirements are determined as further order proposal lines.

If the purchase inquiry line is converted into a purchase order, the reservation is inherited to the purchase order from the

existing order proposal line, and the additional inquiry lines are deleted or marked as ordered.

To be able to use this functionality, the following settings must be made in advance:

Setup

In the "Accounts Payable & Purchasing", a number series for the collective requests must first be stored in the "Collective

request number series" field on the "Number series" info tab.

Procedure

If procurement planning is run for an article via the planning or order worksheet, it is possible to send price inquiries to various

vendors for the respective proposal line via the "Generate collective inquiry" function.

To do this, the "Generate price inquiry" checkbox is first set for the corresponding proposal line. For the marked line(s), the

desired vendors for generating the purchase requests can be stored via "Related" > "Price request" > "Selection for price

request" > "Assignment for current data record" or for "Assignment for marked data record".

For the actual generation of the collective inquiry, subsequently execute the function "Create collective inquiry" under "Related"

> "Other".

A subsequent message gives you the information how many inquiries have been created by the system. Furthermore, the order

proposal line receives an identifier with the associated collective inquiry number in the "Collective inquiry no." field and the

associated line number in the "Collective inquiry line" field.

Collective request

Via the column "Collective request no." of the suggestion line, you have the possibility to get into the collective request by a

lookup on the number. Otherwise, you can access the overview via the user search using the search term "Collective requests",

from which you can also call up the desired collective request.
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Inforegister General

Inforegister Collective request lines

In the collective request lines you can see the article lines which have been requested.

Matrix

The menu item "Display matrix" takes you to an overview that shows you the requested item(s) with the corresponding vendor

requests summarized in one line.

field description

No. Indicates the number of the collection request according to the defined number series.

Description Gives a description of the collection request.

User ID Indicates the user ID from which the collection request has been created.

Creation Date Specifies the date when the collection request has been created.

Requested end

date

Specifies a requested end date by which the request process should be completed.

Status Distinguishes between the following statuses:

Requested:

A collection request has the status "Requested", if it is still in the editing process.

Finished:

A bulk request has the status "Finished" as soon as there are no more requests for the bulk request.

Canceled:

A bulk request has the status "Canceled" as soon as the bulk request has been canceled using the

"Cancel" function in the matrix.

Number of

requests

Indicates the number of requests associated with the collection request.

A lookup on the number, you get to the purchase request overview, which is filtered to the associated

requests of the collection request.

field description

Type Indicates the type of the request line.

No Indicates the number of the requested line item. This field is related to the "Type" field.

Quantity Get the quantity that has been requested.

Quantity (base) Indicates the quantity (base) that has been requested.

Order Quantity Indicates the order quantity.

Order Quantity (Base) Indicates the Order Quantity (Base).

Remaining order quantity Indicates a possible remaining order quantity.

Remaining quantity (base) Gives a possible remaining order quantity (base).

Unit Code Indicates how a unit of the item or resource is measured (e.g. pieces or hours).

Variant code Indicates the variant of an item (if applicable).

Work Type Code Indicates a work type code.

Storage Location Code Specifies a code for the storage location where the requested items will be registered.

Finished The checkmark is set once an order has been created and there is no remaining order quantity.
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Using the buttons on the "General" info tab, you can select which information is to be displayed in the rows.

In the matrix lines you have the possibility to store the confirmed prices of the suppliers and to compare them with each other.

Otherwise, you can also store the prices directly in the purchase request. The system transfers the prices from the purchase

request to the matrix overview and vice versa, automatically.

Create order

As soon as you have chosen a supplier, you can accept the quantity via the matrix by clicking on the quantity of the

corresponding supplier.

The "Accept" screen will open where you can accept the quantity via the "Quantity to accept" field. The status for the creditor

changes in the line to "Allocated" while the other one gets the status "Not allocated".

You can then use the "Generate purchase order" action in the ribbon to generate the desired purchase order. You will receive a

message that the order has been created. The matrix then receives the status "Order/Purchase order". The collective inquiry

receives the status "Finished" and the associated order proposal line is deleted.

As long as no orders have been created for a collective request and the collective request is not "Finished", you can cancel the

process after distribution. To do this, use the "Cancel" function in the menu ribbon of the matrix rows. Confirm the query with

"Yes" to delete all associated requests. The collective request is then set to "Canceled" by the system. The reference to the order

worksheet line is also deleted so that the process can be restarted.

If the planning is recalculated a second time, all lines will be recalculated except for the lines that are in a collective request. The

lines that are in a collective request remain unchanged in the planning/order worksheet.

PURCHASE CONSIGNMENT PROCESSING

With the purchasing consignment processing you have the possibility to manage a supplier warehouse in KUMAVISION

factory365 in order to map possible receipts/issues of consignment items.

Setup

Origin codes

In the origin codes, a corresponding code must be created by specifying a code (abbreviation) and a description. This origin code

is then assigned in the origin code setup.

Origin code setup

In the origin code setup, you can store the origin code previously set up for consignment processing on the "Purchasing" info tab

in the "Consignment withdrawal" field.

Warehouse Setup

In the warehouse setup, first of all, the field "Einst.-Pr. (averages) Ber.-Art" on the info tab "General" for the cost price calculation

must be mandatorily set to the option "Artikel Lagerort und Variante".

Note

field Description

Consignment

Withdrawal

Specifies the origin code for the purchasing process during warehouse withdrawal.

Setting up this origin code allows direct posting of purchasing deliveries when posting the

purchasing document in conjunction with a "controlled" storage location.
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Furthermore, for consignment processing, the number series must be set on the "Numbering" info tab and the purchase order

type must be set on the "General" info tab.

Storage location

For the consignment storage location, the following fields must also be set up on the storage location card:

For consignment storage locations (switch consignment withdrawal set) the following has to be considered:

the "controlled logistics" and "outgoing logistics documents" (goods issue, picking or warehouse picking) cannot be used and must

be deactivated accordingly in the setup. 

within the warehouse entries, this indicator is checked in particular in connection with cost prices. No stock values may be posted

to these marked storage locations. 

this storage location cannot be used in any outgoing documents (sales, service, stock transfer order, production order, assembly

order, projects, purchase credit memo and purchase complaint). The use of consignment stocks is also restricted in the accounting

sheets. In the article stock transfer ledger sheets, the consignment warehouse can also be used, but only for internal stock

transfers between consignment storage locations or storage bins. 

withdrawal from this storage location is possible via the inventory process, the article ledger sheet and the "consignment

withdrawal" document and the subsequent process. 

the receipt to this storage location can be posted via the stocktaking process, the article book sheet and a corresponding purchase

order or invoice (without value). 

the "cancel goods receipt" function in the "posted purchase deliveries" for consignment receipts is not available.

Storage bins

The storage bins can still be set up and used. It is also possible to assign the storage bins to a specific vendor via the "Vendor

no." field.

Field Description

Consignment Withdrawal Numbers Indicates the number series for the consignment withdrawal.

Consignment Withdrawal Numbers

Purchase Order Type Consignment

Withdrawal

Indicates the purchase order type for the purchase orders generated from

consignment withdrawals.

field description

Consignment

Withdrawal

Identifies the storage location as a "consignment warehouse" for purchasing.

The indicator can only be changed if no "open item items" exist on the storage location. Furthermore,

all item items must be settled and in a closed warehouse posting period.

Note:

Please note that the switch is only released for the DACH region.

Vendor No. Indicates the vendor number of a consignment storage location.

The field is a mandatory field if it is a consignment warehouse without storage bins.

If the consignment warehouse is set up with storage bins, primarily the vendor number in the

respective storage bins will be checked, if no unique assignment is found in the storage bins, the

content of this field will be used.

Please note:

Please note:

The field is a mandatory field if it is a consignment warehouse without storage bins.

1. 

2. 

3. 

4. 

5. 

6. 
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The "Vendor no." field can only be used for storage locations with the "EK consignment warehouse" indicator. It is only possible to

change the field if there is no storage location content. If the field is not set up, then the vendor number must be stored in the

storage location. 

It is technically possible to set up storage locations with different vendor numbers, but special attention must be paid to this in the

warehouse organization with regard to ownership.Basically, it is recommended to set up a separate storage location for each vendor.

Warehouse posting setup

Despite a general check that no warehouse values can be posted, it is recommended to set up appropriate separate G/L accounts

that are not used in balance sheets or similar in the required "Warehouse posting setup".

Stock data

The following setups must be made for the items that will be handled through this process: 

within the inventory data card used by a storage location with the "EK Consignment" indicator, the procurement method

"Purchasing" must be set up.

Furthermore, a corresponding vendor number must be assigned to the inventory data card. In accordance with the Microsoft

Dynamics 365 Business Central1 standard, this is adopted as a default within MRP via the purchase order and planning

worksheets. The possible setup of a vendor number in the storage bins of the consignment warehouse have no direct influence

within the planning and scheduling.

for the storage locations of the consumptions of the consignment articles must be furnished appropriate stockkeeping data with the

procurement procedure "transfer" and the appropriate consignment stock as "transfer of warehouse orrcode".

the use of the replenishment procedures are not restricted in the inventory data and are basically supported according to Microsoft

Dynamics 365 Business Central1standard.

The stock data card for the consignment warehouse can only be deleted if there are no "open" item items on this combination.

Furthermore, all item items must be regularized and be in a closed accounting period.

In connection with the stock issue method "Standard", the "Cost price (fixed)" is immediately set to 0 by the system within the

corresponding stock data card and can also not be changed.

Report selection - warehouse

In the "Report selection - warehouse", the additional option "Consignment withdrawals" is available for customer-specific

documents.

Carry out consignment processing

The processes for consignment processing are described below:

Receipts Consignment Stock

An entry for a consignment warehouse can be made via the article ledger sheet and via the document types "Purchase order" or

"Purchase invoice". The basic rule here is that the document lines with a consignment warehouse have a line amount of "0". Any

article surcharge/discount allocations are suppressed.

Surcharges resulting from the "Metal taxation surcharge" module will only be transferred to the following documents in the

purchase orders at the time of the consignment withdrawals.

Note

Attention

1. 

2. 

3. 

4. 

5. 

Note
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Any checks regarding the line amounts are made during the document release.

In the lines of the purchasing and logistics documents, the vendor number from the storage location(s) is taken into account

when assigning or selecting the corresponding storage bins.

Currently, the billing documents for deliveries to the consignment warehouse must be posted directly from the purchase order

when posting, or via separate invoice runs when using logistics documents. 

Consignment warehouse withdrawals

Withdrawals from the consignment warehouse can be made via the item book sheet and the consignment withdrawal card. To do

this, first call up the "Consignment withdrawal overview" via the user search. You can create a new withdrawal using the table

below via "New" in the ribbon.

Alternatively, you can create the withdrawal documents from the planning worksheets using the "Execute event message"

function.

Inforegister General

field description

No. Allocation of a consecutive document number from the number series defined in the

warehouse facility.

Document date Indicates the document date.

Assigned Date Indicates the date when a user was assigned.

This field is used as an information field for the logistics processes and is automatically

set when a user is assigned.

Assigned Time Indicates the time when the assignment of a user took place.

The field serves as an information field for the logistics processes and is automatically

set with the assignment of a user.

Assigned User ID Indicates the warehouse employee who is processing this document.

Consignment Warehouse

Location Code

Indicates the warehouse location of the withdrawals.

The selection is limited to the consignment warehouses set up in the system.
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Inforegister Lines

When withdrawal lines are entered, a check is made for the availability of the articles or variants. If the articles are subject to a

serial or batch number obligation, the corresponding article tracking must be assigned for each line.

Functions in the menu ribbon Post

This function is used to post the consignment withdrawal. The system generates a purchase order and posts the delivery. The

purchase orders generated via consignment withdrawals can be identified via the "Purchase order type".

field Description

Article No. Indicates the article number of the item to be withdrawn.

To assign article tracking, a corresponding callout is provided in

the document lines menu.

Variant Code Indicates (if available) the article variant to be taken.

Description Indicates the corresponding article description of the article to

be withdrawn.

Vendor Code Indicates the associated vendor from the

storage location or bin.

Description 2 Indicates (if available) the additional

related item description of the item to be taken.

Quantity Indicates the total target withdrawal quantity.

Unit Code Indicates the unit code.

Reserved Quantity Indicates how many units of the item have been reserved in the

row.

Purchased Movement Quantity Indicates the actual quantity of the withdrawal posted.

Consignment Storage Location Indicates the consignment storage location.

The field is pre-populated with the header information. A

LookUp to other consignment warehouses for a manual change

is possible.

Consignment storage bin If the selected consignment warehouse is set up with storage

bins, it will be specified in this field.

Storage location code Indicates the destination storage location.

Storage bin code Indicates the destination storage bin.

Takeout quantity Actual takeout quantity (partial quantity postings)

can be set via functions and is automatically supplied

with the target quantity when the document line is

created.

Date due Is automatically taken from the planning worksheets during

creation and represents the requirement date from planning.

Note
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Only the rows with a transaction quantity will be considered by the posting process.

Fill movement quantity

The field "Movement quantity" in the existing withdrawal lines will be filled with the remaining quantity (Difference "Quantity"

and "Geb. Quantity").

Clear movement quantity

Deletes the movement quantity in all withdrawal lines for manual entry by the user (partial quantity withdrawals or similar).

Print

If a document has been stored in the "Report selection - warehouse", it can be printed out here.

The document must be created and set up on a customer-specific basis.

Posted purchase deliveries

The posted purchase deliveries that were generated via the consignment withdrawals receive the number from the number range

that is stored in the warehouse facility for the posted consignment withdrawal numbers. These posted purchase deliveries can be

identified via the "Purchase order type".

The "Cancel goods receipt" function for posted deliveries for consignment receipts is not permitted and cannot be executed.

The "Cancel goods receipt" function is permitted for posted deliveries for consignment issues and can be executed.

Invoice consignment withdrawals

Invoicing then takes place again in the Microsoft Dynamics 365 Business Central[1] standard processes of the purchase invoice

or directly in the purchase order.

Planning / Disposition

Via the setup of the respective replenishment procedures, consignment processing is also taken into account within the purchase

order and planning worksheets. 

If a proposal line is generated on the basis of an inventory data card with stock transfer from a consignment warehouse, the

option "consignment withdrawal" is set instead of the procurement method "stock transfer".

By means of the function "Execute event notification" the order proposal lines with the procurement method "Consignment issue"

will be transferred to it, if the option "Create stock transfer orders" is activated. Any reservations (due to the set replenishment

procedure) are passed on from the order proposal line to the consignment issue line.

Inventory

An inventory is also possible in principle within the consignment storage locations. However, only quantity corrections are

possible here. However, it is not possible to post warehouse values

Revaluation

The standard functionality "Revaluation book.sheets" is not available for consignment storage locations.

Intrastat

Note

Note
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With Microsoft Dynamics 365 Business Central1 version 24.0, the previous Intrastat functionality is outsourced to a standalone app

(must be activated via the function management). Within the new Intrastat functionality, deliveries to the consignment warehouse

can be excluded via the switch "Skip zero amounts". 

Direct deliveries

Since storage locations marked "consignment warehouse" cannot be used in outgoing documents, direct deliveries must first be

processed via consignment withdrawal to a sales warehouse. Direct posting out of the consignment warehouse is prevented.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Attention

1. 
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Manufacturing

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s production department.

MANUFACTURING SETUP

The following table describes the "Production setup" extensions in KUMAVISION factory365 with links to the topics.

Further information can be found at: Manufacturing | Microsoft Learn

COMFORT NAVIGATION FOR PRODUCTION BILL OF MATERIALS AND ROUTINGS

This service area gives you direct navigation to the production bill of materials and routing from the parts card. This facilitates

navigation to the production-related master data.

For further information see "comfort navigation for production bill of materials and routings “

Field Description

Testing overproduction Checking deviations from the target production quantity.

See Overproduction

Mandatory field check Workstation If the switch is set, the mandatory field check for workstations is activated.

See Mandatory field check

Mandatory field check work center

group

If the switch is set, the mandatory field check for workstation groups is

activated.

See Mandatory field check

Standard tolerance period Too early Defines the time period for the tolerance period (too early).

See Two-way tolerance

Standard tolerance period Too late Defines the time span for the tolerance period (Too late).

See Two-way tolerance

Retain operating cycle values Activate the switch if you want to retain the work process description.

See Retain operating cycle values

Separator Aisle no. Personnel Define a prefix for the "Personnel" operation.

See Set up secondary operations

Basic operation no. Personnel Define a suffix for the "Personnel" operation.

See Set up secondary operations

Separator Operation no. Tool Specify a prefix for the "Tool" operation.

See Set up secondary operations

Basic operation No. Tool Define a suffix for the "Tool" operation.

See Set up secondary operations

Note
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For further information, see "Convenient navigation for production BOM and routings".

In KUMAVISION factory365, the insight via the Assist call has been extended so that it can also be called at the following places

in the system:

From the E+D order line to the production bill of materials, routing with its versions 

From the design monitoring line to the production bill of materials, routing with its versions 

From the MRP monitoring line to the production bill of materials, routing with its versions 

REPLACE ARTICLE IN PARTS LIST COMFORT

Using the "Replace article parts list comfort" function, you have the possibility in KUMAVISION factory365 to consider only

active versions for the replacement of an article / parts list via the field "Consider only active versions".

RETAIN OPERATING CYCLE VALUES

In Microsoft Dynamics 365 Business Central1 Standard, when the capacity unit (work center or work center group) is changed in

the FA operation or the operation line in the operation description, individual values such as setup, transport or waiting times 

(work center “routing setup”) are also overwritten when the work center is changed.

However, as the description in the operation is the description of the activity to be performed, but existing default values are also

simply changed when the capacity unit is changed, this behaviour can be prevented by activating the "Retain operation values"

switch in the Manufacturing Setup.

To do this, call up the "Production setup" via the user search and make this setting.

When a new FA operation or operation line is created, both the description of the respective capacity unit and the default values

for the "work centre" capacity unit are adopted.

Activation is particularly recommended when using the standard catalogs or the "etagis Interface" activation module.

Changes in the planning work plan of the planning worksheets remain unaffected by the scope of functions described.

SECONDARY OPERATIONS

General

In Microsoft Dynamics 365 Business Central1 it is possible to assign tools and personnel to an operation. However, these

assignments are only managed by the system for information purposes.

Through the secondary operations in KUMAVISION Factory, it is possible to manage the capacity and costs of the tools as well as

the personnel assignments.

The superior, leading operation (primary operation) defines the main process of an activity. All assigned personnel or tool

assignments dependent on it are defined as secondary operations. These are linked to the primary operation via permanently

assigned fields. Dates and quantities are managed in the primary operation and automatically derived into the secondary

operations. This means that the secondary operations always run in parallel and within the start and finish times of the primary

operation.

It is possible to edit the secondary operations, for example, to load an assistant only 50% of the time (to be loaded at the same

time = 0.5) in the case of multiple machine occupancy.

Tool management

With this extension of the operation tool table it is possible to manage and post specific tools for a machine in terms of capacity

and costing. Tools can thus be managed as an independent capacity in production planning (by work center or work center

• 

• 

• 

Note

Note
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group), as an article in warehouse, logistics and disposition, as an asset in the financial area or also as a cost object for

controlling.

Detailed Personnel Planning

The extension of the operation personnel table enables employee-specific operation and capacity planning and management per

operation. It is recommended to plan at the work center group level and confirm or schedule at the employee work center level.

Each employee is then set up as a work center and the work center group as a consolidated calendar.

Outlook Industry 4.0

The management of additional production factors such as energy or CO² certificates will become increasingly important in the

future in order to describe the accompanying processes of production more comprehensively and transparently. With secondary

operations, an approach has been found that plans and manages these in a capacity-relevant manner.

Establishment

Production facility

First, call up the production setup via the user search. On the "General" info tab, the fields must be set up according to the

following table for the secondary operations:

Work plan facility

To set up the secondary operations, call up the desired routing via the item card. If you have not yet created a task list, create

one first.

Please note that the routing for the secondary operations must be defined "Type=Parallel".

Then select the operation line. Via the menu selection "Work operation" you can assign these to the work operation via the

selection "Tools" or "Personnel".

Tools

Field Description

Separator Work gang no.

Personnel

Primary operation = prefix + separator.personnel + suffix (base operation

no.personnel)

Basic operation no. Personnel Suffix for operation personnel

Separator operation no. Tool Primary operation = Prefix + Separator.Tool + Suffix (Base operation no.Tool)

Basic operation no. Tool Suffix for operation personnel

Note

Field Description

Type This field defines the selection of the capacity. Depending on the assignment, a secondary operation is

created

• Blank = Standard

• Workstation group

• Workplace

No. Depending on the type, the field is filled as follows:

• Blank (default): The field is not editable

• Workstation group: Enter workstation group code

• Workstation: Enter workstation code
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Personal

On the routing, the secondary operations can be displayed by clicking on the "Display secondary operations" item in the line

menu. 

The secondary operations are inserted, the operation number of which is composed of the primary operation + separator for

personnel, tool + current operation number personnel, tool.

The line values of the primary operation are copied to the secondary ones and can be edited here.

If you enter a routing separately from an article, the secondary operations are set up in the same way.

Standard catalog codes forms secondary operations

The attachment tables (-> secondary operations) for the operation can be preset by means of a standard catalog code (standard

operation). As soon as a standard catalog code is inserted in the routing line, the operation attachment tables (tool, personnel,

remarks, test specification) are updated. 

This procedure can be used, for example, to preset tool sets as the standard catalog.

To set up a standard catalog, first call up "Standard catalogs" via the user search.

Via "New" in the menu ribbon you can create a new standard catalog under specification of a code and description.

Via the menu tab "Associated" > "Catalog" you have the possibility to assign tools / personnel to the standard catalog.

Then insert the standard catalog into a parallel routing on the desired line in the "Standard catalog" field. Secondary operations

are created for the individual tools. Thus, capacity management and cost allocation can be tracked at the desired detail level for

each individual tool.

Secondary operations in the production order

Secondary operations can also be edited directly in a production order. The individual secondary operations can be edited and

fine-tuned by production planning. It is important that the scheduling lies within the start-end dates of the primary operation.

Using the example of a firmly planned production order, you have to call up the routings via the "Line" call in the info tab of the

same name.

Execute the "Show secondary operations" function in the ribbon under the "Start" menu tab to display the secondary operations.

Deleting / inserting a secondary operation

To delete a secondary operation or add another one, first select the line of the primary operation.

Then select the "Tools" or "Personnel" menu item under "Associated" in the ribbon.

The Tools / Personal Edit card opens, where you can insert a secondary operation via "New" or delete an existing one via

"Delete". Confirm your change with "OK".

Editing a secondary operation

If the capacity of a secondary operation is to accompany the process with a certain percentage, proceed as follows:

Field Description

Type This field defines the selection of the capacity. Depending on the assignment, a secondary operation is

created

• Blank = Standard

• Workstation group

• Workplace

No. Depending on the type, the field is filled as follows:

• Blank (default): The field is not editable

• Workstation group: Enter workstation group code

• Workstation: Enter workstation code
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Change the field: "Simultaneously debit and debit the processing time with equal proportions.

As a result, the cycle time of the operation is maintained within the start-finish time of the primary operation, the Erw. capacity

requirement is reduced and the target operation costs are reduced to the percentage share.

Of course, the primary operations can still be processed in addition to the secondary operations. The secondary operations are then

automatically assigned the default values of the primary operation.

OVERPRODUCTION

With this functionality you can define which deviation of the target production quantities you want to allow in percentage.

To do this, call up the production setup via the user search. On the "General" info tab, activate the "Check overproduction" check

box.

On the item card, you can then define the desired percentage of overproduction on the "Procurement" info tab in the

"Overproduction %" field.

When this function is activated in the production setup, the system checks the Overproduction % field on the item card to see if

the quantity completed is greater than the Maximum overproduction quantity. If this is the case, an error message appears.

The check of the overproduction quantity is done per operation. Thus, a deposit of a work plan is a prerequisite.

Example With an FA quantity of 1000, a maximum overproduction quantity of 20% = 200 is calculated. This results in a tolerance

quantity of 1000..1200 and from 1201 an error message of the finished quantity appears.

CAPACITY QUANTITIES IN FA OVERVIEW

The following status fields have been added to the FA overviews:

Allocated capacity requirements 

Actual time (according to workstation group filter)

Remaining time (as the difference between the two fields)

These fields are in the overviews: 

Releasing production orders (Microsoft Dynamics 365 Business Central1 Standard)

Releasing E+D order

Releasing E+D order (costing)

TRAFFIC LIGHT ENTRIES

The availability traffic light in KUMAVISION factory365 extends the production order of Microsoft Dynamics 365 Business

Central1 with the visualization of MRP and capacity availability.

These are available in the overviews of the production orders and in the production order lines ("MRP availability" and

"Capacitive availability") as well as in the FA components (only "MRP availability") and the FA routing (only "Capacitive

availability") in the status: Planned, Firmly planned and Released.

The "Calculate availability traffic light" function is available in the above overviews to determine the planning and capacity

availability.

Note

Note

• 

• 

• 

• 

• 

• 
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Please note that availability is not calculated at runtime.

Please note that the calculation is not performed automatically when "Update lines in E+D order".

Setup

Traffic light assignment setups

Before you can use the availability traffic light, you must store the symbols required for visualization.

The "Availability traffic light setup" facility is available for this purpose.

Call up the "Availability traffic light setup" via the user search. Use "New" in the ribbon to create a data record for each option

value and store the required symbol (image).

The traffic light symbol examples have a size of 16x16px.

Threshold values (minimum threshold %) and (maximum threshold %)

Threshold values "Capacity (min.) %" and "Capacity (max.) %" can be stored hierarchically at the workstation, the workstation

group and/or the department.

To do this, call up the "Workstations" or "Workstation group" via the user search and open the respective card.

You can store the threshold values "Capacity (min.) %" and "Capacity (max.) %" on the "Traffic light control" information tab.

To store the threshold values "Capacity (min.) %" and "Capacity (max.) %" in the department, call up the "Departments" via the

user search and select "Edit list".

Further information can be found under: Set up workstations and workstation groups.

Traffic light entries dispositiv

Grundlage zur Ermittlung der dispositiven Verfügbarkeit sind die Artikel-"Verfügbarkeit nach Ereignis" und die

"Reservierungen".

Die Artikel-"Verfügbarkeit nach Ereignis" wurde um das Feld "Restbestandsmenge" erweitert, welches die Artikelverfügbarkeit -

ohne geplante Zugänge angibt. Die Menge beinhaltet alle Bedarfe, jedoch nicht den voraussichtlichen Zugang und wird zur

nachfolgenden Definition herangezogen.

Baugruppen erben das jeweils "schlechteste" Komponenten – Ergebnis.

Note

Note

Note
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The definition of the "MRP availability traffic light" is as follows:

* The traffic light symbols must be stored in the "Availability traffic light setup".

Traffic light entries capacitive

"without" thresholds

The basis for determining the capacitive availability is the "capacity" based on the calendar items compared to the "allocated

capacity (FA capacity requirement)".

Assemblies inherit the "worst" component result!

The definition of the "Capacitive availability traffic light" without setting up threshold values is as follows:

* The traffic light symbols must be stored in the "Availability traffic light setup".

Option Description Definition of Traffic light

symbol

Example*

Empty not calculated

Green Reservation against stock Reservation against article items

Green sufficiently available on date (in

stock)

Availability balance: positive or results

in 0

Remaining stock: positive or results in 0

Yellow Reservation against receipt Reservation against order or relocation

Yellow Sufficiently available on date (by

receipt)

Availability balance: positive or results

in 0

Remaining stock: negative

Warning Reservation against receipt with

reservation conflict

Reservation against order or stock

transfer with reservation conflict

Red not available on date Availability balance: negative

Note

Option Description

"without threshold values"

Traffic light symbol

Example*

Empty not calculated

Green "Allocated capacity" is less than or equal to the "Capacity"

Red "Allocated capacity" is greater than "Capacity"

Note
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"with" threshold values

The basis for determining the capacity availability is the "Capacity (min.)" and "Capacity (max.)", which are calculated using the

"Capacity" based on the calendar items and the threshold values "Capacity (min.) %" and "Capacity (max.) %" stored at the

department, work center group or work center, compared to the "Assigned capacity (FA capacity requirement)".

The calculation is made with the "Calculate availability traffic light" as follows:

Assemblies inherit the "worse" component result.

The definition of the "Capacitive availability traffic light" with the establishment of threshold values is defined as follows:

* The traffic light symbols must be stored in "Availability traffic light setup".

AUTOMATIC ARTICLE TRACKING UPON RELEASE OF THE FA

By means of the functionality "Automatic article tracking when FA is released" the steps:

Manually open the article tracing

Calling the function for determining the serial number from the item-specific number series

Closing the mask: Article tracing

Repeat steps per actual message line determined automatically.

Triggers for automatic generation of item tracking are:

Status change to Released FA, item tracking lines are created

Update production order" function

Erect the FA from planning proposal

Establish the FA from sales order

Establishment

Article card

Field Formula Example

"Capacity (min.)" "Capacity" - ("Capacity" x "Capacity (min.) %" / 100 ) 8 - (8 x 20/100) = 6,4

"Capacity (max.)" "Capacity" + ("Capacity" x "Capacity (max.) %" / 100 ) 8 + (8 x 20/100) = 9,6

Option Description

"with threshold value"

Traffic light

symbol

Example*

Empty not calculated

Green "Allocated capacity" is less than the "Capacity (min.)"

Yellow "Allocated capacity" is equal to or greater than the "Capacity (min.)" and less

than or equal to the "Capacity (max.)"

Red "Allocated capacity" is greater than the "Capacity (max.)"

Note

• 

• 

• 

• 

• 

• 

• 

• 
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The items with stored item tracking can be set up for automatic assignment in the "Item tracking" info tab via the "Set up

production autom. item tracking" field.

Article pursuits

Item tracking is set up using the Microsoft Dynamics 365 Business Central1 Standard.

Number assignment for automatic article tracking

The automatic assignment of the article tracking is only valid for "actual messages of production" and not for consumption

messages. Thus, this assignment only affects output-side usage in the Production application area. Serial numbers If only serial

numbers are ticked, an automatic generation of n item tracking line and quantity 1 will take place. Batch numbers If only batch

numbers are checked, an automatic generation of an article tracking line with 1 batch and corresponding quantity will take

place. Serial and batch numbers If both fields of the item tracking code are checked, n item tracking lines are created with serial

numbers and quantity 1 and always the same batch numbers for all quantity = 1.

The serial numbers or batch numbers are always generated from the number series stored on the article card ("Serial number" or

"Batch number" field). If the number series is missing there, a message is displayed.

Procedure

The automatic generation of the article tracking lines takes place for all FA lines of the production order for which an automatic

creation is set in the article. It is always filled up to the maximum possible FA line quantity.

It applies: n lines with serial number and quantity 1, or 1 line with batch number and quantity=maximum possible quantity or

combination of both).

The user can manually change these automatically generated item tracking lines afterwards (if desired). 

A new execution of one of the above events (e.g. a status change of the FA) will take into account any article tracking lines that

have already been created, regardless of whether they were previously created manually or automatically. Then, if necessary,

article tracking lines will be created automatically only up to the difference to the maximum possible quantity.

Example:

The FA was created in Planned status. The FA line has the quantity 7 and an article with automatic serial number generation for

status Fixed Planned. In the Planned status, the user already manually enters 4 serial numbers for the FA line. After that, the

user will change the status of the FA to Fixed Planned. The application will generate only the 3 missing serial numbers for the FA

line.

Field Description

<empty> No item tracking lines are generated.

Firmly planned If the item is used in a FA line and the status of the FA is Fixed Scheduled, then when one of the events

listed below is performed, the application will automatically establish item tracking lines to the FA line

Released If the item is used in a FA line and the status of the FA is Released, then when one of the events listed

below is performed, the application will automatically establish item tracking lines to the FA line

Note
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It should also be noted:

1. If the user manually changes the Quantity field in an FA line, this will not result in the automatic generation of item tracking lines.

2. A manual reduction of the quantity in the FA line below the already deposited article tracking lines to the FA line is not allowed by

default.

3. A manual increase of the quantity in the FA line must be compensated by the user by manually entering item tracking lines

(default behavior).

(Therefore, the above function "Update production order" should be used if possible, because a manual change of the quantity in the

FA line also affects other data, which are also not automatically trailed).

OPTIMIZED ABSENTEEISM MANAGEMENT

For the recording of absences from machines for maintenance / repairs etc., the Microsoft Dynamics 365 Business Central1

process requires that you first register the absences, then transfer the registered absences as absenteeism items and update the

calendar afterwards.

In KUMAVISION factory365, this process has been optimized so that the individual steps can be executed directly when the

function is called. To maintain the absence times in KUMAVISION factory365, proceed as follows:

Call up the "Logged absences" via the user search.

Via the menu items "Reasonable. Absence time (workstation)" or "Appropriate absence time (workgroup)" in the menu ribbon.

Absence time (work group) in the menu ribbon, you can enter the absence times for a work center or for a work group.

The entry screen opens, where you can enter the absences using the table below.

Confirm your entry with "OK". If the "Apply" and "Update calendar" fields have been activated, the registered absences have

automatically been adopted as absence items and the calendar updated accordingly.

SHIPPING UNITS

When manufacturing complex articles, the situation can arise in shipping that the manufactured article must be broken down

again into so-called shipping units that can be sensibly transported. In order to be able to map this process in Microsoft

Dynamics 365 Business Central1, this scope of services supports shipping units in manufacturing and logistics.

The shipping units can currently cover three different scenarios, which are described below.

Note

Field Description

Start/end time Enter the start/end time of the missing time

Start/End date Enter the start/end date of the absence time

Note - The "End date" field must be filled in because the "Logged absences" table is used to calculate the

resource calendar. If the absence time extends, you can change the end date later.

Capacity Enter the capacity that cannot be used during the downtime. For example, if there are 3 production lines,

there will not necessarily be downtime on all lines.

Description Enter a brief description for the cause of the absenteeism

Overwrite If this field is activated, the items for the respective time in this workstation group will be overwritten.

Apply If this field is activated, the absence times are taken over as absence time items

Update

calendar

If this field is checked, the calendar will be updated automatically
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ESTABLISHMENT

Design & development facility

In the Design & Development setup, you have the option of using the "Use shipping units for logistical structure explosion"

switch on the "Execution" info tab to control whether you want to visually display the logistical structure explosion divided into

the corresponding shipping units in an E+D order. For this option you activate this switch. In the E+D order, the option

"logistical" can then be selected in the process for the visualized representation via the "Structure resolution" field.

Shipping units

Via the "Shipping units" you can define them in general by assigning a code (abbreviation) and an associated description.

Assignment in the master data

Shipping units can already be preassigned in the planning phase. For this purpose, a shipping unit code can be entered in the

lines of the production bills of material. This code does not yet have a fixed reference to a production order. When a production

order is created, this shipping unit code is transferred.

Assignment in process

If there is an existing production order, shipping units can be assigned in the components. This can be done in the component

lines as well as in released and finished E+D orders in the lines. In addition, the project module has also been integrated so that

the assignment from the project structure Project structure out of the project. For this purpose, the fields "Shipping unit code",

"Project-specific shipping unit", "Component as shipping unit" and "Transfer quantity to shipping unit" can be displayed in the

respective screens. 

In the FA components list there is only the "shipping unit code" and "project specific shipping unit".

RELOCATION OF COMPONENTS

Components combined to form a higher-level shipping unit

A production order is set up whose components are to be transferred to a production warehouse for assembly. The components

are grouped into shipping units that are easy to transport. From a released (and a completed) E+D order, these components can

be inserted into a stock transfer order.

To do this, first select the desired lines and then execute the "Transfer selected shipping units" function via Lines > Function.

It is checked that the components to be transferred have already been consumed. If the correspondingly marked components

have been consumed, then a stock transfer order is created, which transfers the shipping units from the component storage

location to the FA storage location. The information from the transfer route is used for the "In Transit Code". In the FA shipping

units list you can now see that the "Quantity in Outbound Document" is changed.

In the drilldown the corresponding shipping unit item is displayed and via the function "Display document" it is possible to switch

to the corresponding document. If the storage locations are subject to goods issue or goods receipt, these can be created and

posted according to the standard.

No new item items are created in the background because the components have already been consumed. New shipping unit

items are created by the postings. Via these, the status can be checked from the shipping unit overview (opens by the lookup on

a shipping unit). After posting the receipt, the order is completed. The shipping unit can now no longer be shipped, as it has

already delivered the complete quantity.

Shipping individual components as a shipping unit

It may be necessary to create suitable logistics documents for the customer or the transport, for individual components of a

production order. With the "Component as shipping unit" identifier in the E+D order lines (and the Project structure) you have

the possibility to define a shipping unit that is specific for a single component in the production order. If the check mark is set, a

shipping unit is automatically created that has the item number of the component as the shipping unit code and corresponds to

the FA component line in terms of quantity, unit and description.

Note
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The "Transfer quantity to shipping unit" field can be used to control whether only a partial transfer of the component is to take

place. The field is preset with the quantity available for stock transfer. This is the difference between the posted quantity and the

quantities that are already in shipping or have been shipped. Therefore, it is necessary that at least the quantity of the

component to be shipped is posted as consumption.

If the stock transfer is to take place, you can enter the corresponding lines in the E+D order or the Project structure and transfer

them to a stock transfer order using the "Transfer selected shipping units" function. The rest of the procedure is the same as that

described in the section "Components combined to form a higher-level shipping unit".

SHIPPING UNITS IN SALES

If a production item is sold, the shipping units stored in the production order can also be inserted in a goods issue that was

created from a sales order. For this purpose, the function "Insert shipping units" can be used in the goods issue.

The "Insert shipping units" function is only available once you have already inserted corresponding lines in the goods issue using the

"Get origin documents / document lines" function.

If the sales line was reserved on a corresponding item line, then the shipping units from this production order will be

automatically inserted. If there is no reservation, a selection of items is opened and the user can decide which item should be

sold. After selection, the shipping units belonging to the item are inserted into the goods issue.

If the production order belonging to the item is not yet finished, the user must confirm that he wants to continue.

The original line remains, but the quantities are removed, since this item is automatically posted in the background after posting

the shipping units. The posting of the goods issue with shipping units is now done as in the standard. After complete posting, the

original item is also delivered and can be invoiced.

PROJECT-SPECIFIC OR CROSS-FA SHIPPING UNITS

In connection with the plant engineering solution, it is also possible to use shipping units across FAs within a project. For more

information, see Shipping preparation.

SHIPPING UNITS ITEM

When inserting a shipping unit into a document, items are written. These can have 4 statuses:

Outbound (Shipment): a stock transfer was created or a goods issue was created from a sales order without anything being

posted.

In Transit: The goods have left the warehouse but have not yet arrived, i.e. the goods issue has been posted but the goods

receipt has not.

Receipt: The receipt of the goods has been recorded, but not yet booked.

Delivered: The goods have been delivered completely. The items are used to track the quantities in the shipping units overview,

even if the posted documents should already be deleted.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

• 

• 

• 

• 

1. 
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Warehouse Management

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s logistics department.

OTHER LINE TYPES IN LOGISTICS

In Microsoft Dynamics 365 Business Central1, in the following logistics documents:

Warehouse Storage, 

Warehouse picking,

Goods Receipt,

Outgoing goods 

only the processing for the line type "article" can be performed. This service area has been extended in KUMAVISION factory365

by the logistics documents for the processing of the other line types from purchasing and sales.

Establishment

Logistics facility

In the logistics setup you have the possibility to set up whether additional line types are possible for the goods receipt and the

goods issue.

First call up the "Logistics setup" via the user search. 

On the "General" info tab via the "Additional types for receipt" and "Additional types for delivery" buttons you can activate the

line types.

Storage location

The single-stage logistics process for goods receipt and goods issue must be activated on the storage location card.

Financial accounting

In Financial Accounting, the G/L accounts for the purchasing or sales process must be enabled for direct posting in the chart of

accounts.

General

After successful activation can now be used in the sales processes:

Article,

Article additions/deductions,

Resources, 

G/L accounts

as well as in the purchasing processes:

Article, 

Article Additions/Discounts

G/L accounts

be processed via the logistics documents. This means that load carriers, freight services, handling costs, services and article-

neutral expenses can be sent and collected via delivery bill. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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All logistics documents and book sheets are extended by two new columns:

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

Document lines

type

The document line type knows the same option as in the document lines themselves: , G/L account, item,

resource, WG/asset and addition/deduction (item).

Depending on the type, the document line no. then corresponds to a G/L account, article, resource, WG/

asset or article addition deduction.

When creating logistics documents, not only the lines of type=article, but all lines - except text modules

(type = empty) and the line types for document structuring (heading, From subtotal, End subtotal/

bundle, Bundle) are then transferred.

Document lines

no.

This corresponds to the field number in the corresponding document

1. 
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Service

Description to follow.
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Engineering and Design

DESIGN AND DEVELOPMENT

General

Design and development extends the production processing of Microsoft Dynamics 365 Business Central1 in numerous places. 

The following sections describe the use and administration of the "Design and Development" module of KUMAVISION

factory365.

The following sections describe how to use and manage the "Design and Development" module of KUMAVISION factory365.

Setup

E+D Order

E+D Mod. Prop. Worksheet

E+D Order Planning

Monitoring

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

• 

1. 
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SETUP

Engineering & Design Setup

The "Design & Development Setup" is the central place for the setup of the "Design & Development" module. Call up the "Design

& development setup" via the user search and make the necessary settings with the help of the tables below.
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General
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Field Description

Variant required This defines whether in the design & development with article variants must be posted. (If the

required article master has variants).

Usable status article

version

With this selection you can control which status article versions may be used in the design &

development processes.

The following selections are available:

All:

The article version can be used independent of the status.

Certified only:

Only certified item versions can be used.

Display FA in reservation structure Depending on the selection in this field, the E+D mask or the

standard mask is called in the reservation structure in the FA.

The following selections are available:

Standard FA:

As soon as the "Display document" function is used in the reservation structure, the production

order is called up in the standard mask.

E+D Order:

As soon as the "Display document" function is used in the reservation structure, the production

order is called up in the E+D order mask.

Barcode separator The separator for the barcode in report 5500 - "FA component and routing" is hereby defined.

Example:

Barcode separator = $ 

Barcode in the "FA Component and Routing" report would be for released FA 101031,

item 1000, operation 010:

101031\(1000\)010

Stepwise E+D

Position no.

This facility is required for the determination of a unique E+D position. With this field you can

define the step-by-step positioning in the E+D order lines of the "E+D position" field.

Position item

separator

This setup is required for the determination of a unique E+D position.

With this field you can define the separator for the items in the E+D order lines of the "E+D

position" field.

Position phantom

separator

This setup is required for the determination of a unique E+D position. With this field you can

define the separator for the phantom BOMs in the E+D order lines of the "E+D position" field.

Position operation

separator

This setup is required for the determination of a unique E+D position. With this field you can

define the separator for the operations in the E+D order lines of the "E+D position" field.

Position common part

summary

This facility is required for the determination of a unique E+D position.

This field specifies the character for the common parts grouping. If an article is used in several

assemblies of a production order, the system combines them and generates a "collective FA line"

for this.

Such production order lines are marked in the E+D position with the defined character as suffix.

Important:

The system only groups together non-variable parts if no item no. is maintained in the component.

Position Additional

costs

Separator This facility is required for the determination of a unique E+D position.
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Item Mapping

Field Description

This field specifies the separator for the additional costs (only with the "Valuation & calculation"

module) in the E+D order lines of the "E+D item" field.

Field Description

Automatically transfer

attributes to versions

Define here how the system should behave when assigning new attributes to an article:

Not:

Entering new attributes at the article has no effect on the article version.

New only:

Newly entered article attributes are transferred to article versions with the status "New".

to Certified:

Newly entered article attributes are transferred to article versions with the status "New" as

well as "Certified".

to Certified and reset to New:

Newly entered article attributes are transferred to article versions with the status "New"

and "Certified". If the status of the article version is Certified, it is reset to "New".

All:

Newly entered article attributes are always transferred to the article versions.

Item attribute logistic

structure resolution

If the same attribute is stored at the FA component, the E+D order lines are categorized

according to the article attribute values for the logistical structure explosion based on the

specified article attribute.

Item attribute logistic

structure resolution Name

Specifies the name of the assigned value in the "Item attribute logistic structure resolution"

field.
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Execution
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Field Description

Precision duration Presets the field of the same name in the E+D order with the option: "millisecond", "second",

"minute", "hour" or "day".

Calculate times incl.

secondary operations

With the activation of the switch, the secondary operations are taken into account for the

calculation of times and completed quantities ("Planned time (ms)", "Consumed time (ms)",

"Remaining time (ms)", "Planned time", "Consumed time", "Remaining time", "Consumed time

%", "Completed quantity" and "Completed quantity (base)") in the E+D order lines.

Calculate routing in

change message through

comparison

For the "Reschedule" function in the production order, the planning direction is preset with

Forward or Backward.

Shipping units for

logistic structure

resolution

Specify here whether you want to have the logistic view or the shipping units displayed via an

attribute assignment.

For more information on this topic, see "Shipping units" and "Item attributes".

Note:

If you activate the switch, the value in the "Item attribute logistic structure resolution" field will

be cleared.

Observance of the

production type in the

D+D order

Use this field to define how the system should behave when calculating production orders with

maintained E+D project no. in relation to multi-level production:

Standard

The system checks whether the production order line is set to production type "make-to-order"

and procurement method "production order".

Always contract manufacturing

In principle, make-to-order production is implemented regardless of the parameterization to

articles or inventory data.

Contract manufacturing according to master data

The system checks whether the component is set to production type "make-to-order" and

procurement method "production order".

This setting is the default value. In the production order, the production type can again be

adapted to the specific order using the function "E+D Change production type".

Procurement type for

quantity increase

At this point, define how the system is to behave in the event of quantity changes in the FA:

Enterprise Resource Planning

The system behaves as in the standard

Project management and enterprise resource planning

If component quantities in a production order are increased after they were originally procured,

this setting does not include the requirement in the planning worksheet, but it is handled as

follows during the FA update:

The quantity deviation is implemented by duplicating the FA component with the deviating

quantity in the system. In the background, a reserved purchase order is created directly in the

purchasing case and a new FA line is created for the duplicated component in the production

case.

Autom. update after

E+D planning

If the switch is active, the E+D order lines are automatically updated when the E+D order

planning has been carried out.

Check status (finished

parts list/work plan)

Define here whether the status of the routing and production BOM:

Always
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See also: E+D Oder Card - Display

Monitoring

Traffic Light

Field Description

Always be checked

If E+D project no. empty

Only if the field "E+D project no. " is empty should be checked.

Calculate available for

relocation in E+D

planning

Specify here whether the quantity should be calculated for other storage locations for

information purposes during (E+D) order planning.

If the switch is active here, the information is not displayed. This field is particularly useful for a

large number of storage locations, as it can optimize the runtime.

Planning - Accept event

message

The "Accept event message" identifier is preset to "Yes" in E+D planning if the Automatic option

is selected. Otherwise, the identifier "No" is preset for Manual.

Structure Explosion Preallocates the field of the same name in the E+D order with the selected option.

You can choose from the following options:

• Konstruktiv

• Dispositiv

• Logistisch

Calculate routing Preallocates the field of the same name in the E+D order with the selected option.

You can choose from the following options:

• No

• Hide Sec. Rtng. Lines

• Show Sec. Rtng. Lines

Field Description

Max. Finished parts

list level

Specifies the maximum finished parts list levels for the plausibility check for design monitoring.

If the system determines a higher vertical range of manufacture, the system terminates when the

level is exceeded and shows this as a structural error in the result.

Item no. required Specifies whether the "Position" field in the finished parts list line must be filled.

If the switch is active here, the system checks whether the "Position" field in the finished parts list

line is filled when the finished parts list is certified.

Field Description

Incl. blanket orders in availability Specifies whether blanket orders should be taken into account when calculating item

availability.

Incl. planning proposals in

availability

Specifies whether planning proposals for calculating item availability should be taken

into account.
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Prod. Order Types

The production order types have been extended by KUMAVISION factory365 as follows:

If a production order type is assigned to the production order, the fields: Precision duration, structure explosion and routing in the

E+D order are filled with the stored values of the production order type. Otherwise, the default values come from the "Design &

development setup".

See also:

Engineering & Design Setup

E+D Oder Card - Display

Order Types

Field Description

Precision duration Presets the field of the same name in the E+D order with the option: "millisecond", "second",

"minute", "hour" or "day".

Structure

Explosion

Preallocates the field of the same name in the E+D order with the selected option.

You can choose from the following options:

• Konstruktiv

• Dispositiv

• Logistisch

Calculate routing Preallocates the field of the same name in the E+D order with the selected option.

You can choose from the following options:

• No

• Hide Sec. Rtng. Lines

• Show Sec. Rtng. Lines

Note

• 

• 

• 
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E+D ORDER

The engineering and design order is essentially a production order that is converted from a repetitive manufacturing order to a

machine and plant engineering order - i.e.: design + development order - by means of a project number. The data from a

production order is displayed in an E+D order as a structured BOM, which is supplemented by the following information fields:

E+D Positions (Position Index),

Quantities, deadline, status and change traffic light, 

Information about the demand cover and requester 

Functions for the specific processing of the FA position round off the whole. 

As with a production order, the E+D orders can have the status: Simulated, Firmly planned, Released, Finished. Separate E+D

order overviews are available for the different statuses.

In summary, the E+D order is intended to provide a central information hub for reporting the status, processing the respective

item and interacting with the upstream and downstream processes of design, work preparation, scheduling, purchasing and

warehouse/logistics. 

Create

There are two ways to create an E+D order:

You create a production order as usual, manually or via the planning worksheets. In the course of this, an E+D order is generated

automatically by the system.

You create an E+D order manually. In the course of this, a production order is generated automatically by the system.

The status of the E+D order always corresponds to the status of the underlying production order.

E+D Order Card

The structure of the E+D job card is identical regardless of its status "Simulated", "Firmly planned", "Released", "Finished".

Depending on the status, some functions cannot be executed.

• 

• 

• 

1. 

2. 
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Screen

Field Description

Structure

resolution

The structure resolution controls the view of the E+D lines with the following options:

constructive:

Depending on the due date, the valid master finished parts lists, routings and versions are displayed. In

addition, phantom levels of the construction are displayed.

dispositive:

Displays the current procurement-manufacturing structure of the FA. The constructive phantom levels

are exploded, the FA lines, FA operations and FA components can be edited manually.

logistically:

Assembles the lines according to the logistic characteristic (if available- from Design & Development -

Setup).

Calculate work

plan

No:

Only the structure BOM is displayed.

Show primary AG

The primary operations and the structural BOMs are displayed.

Display primary and secondary AG

In addition to the primary operations and the structured BOM, the secondary operations for other

capacities such as "Tool" and "Personnel" are also displayed.

Precision

duration

Formats the duration of the E+D order line rounded up to millisecond, second, minute, hour, day.

The value is suggested from the Design & Development setup when you open the page. You can

override the default setting.
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General

Lines E+D Position

The E+D position is formed for the unique identification of individual lines. Each position in a production order is uniquely

defined by the E+D position and is thus very helpful for reconciliation or for the coordination of the different departments.

The E+D position has a maximum length of 30 characters, if this is exceeded, the last 3 characters of the 30 characters are displayed

with "...".

To determine a unique E+D item, you must maintain the fields "Stepwise E+D item no. ", "Item item separator", "Item phantom

separator", "Item operation separator", "Item common parts summary" and "Item additional costs separator" in the Design &

Development setup.

Determination of the E+D position no.

Field Description

No. Document number - number range freely definable.

E+D Project no. The project number can be entered manually from the project list. When executing the planning

function "Project order" in the sales order, the project can be preset.

Several FAs can thus be combined into one group.

Description Description of the production order. This is pre-assigned with the description of the article and can be

changed manually.

Description 2 Additional description of the production order. This is pre-assigned with description 2 of the item and

can be changed manually.

Type of origin The origin type gives the user an indication of what the production order was created for.

The following selection options are available:

- Item, 

- Family, 

- Sales header, 

- Project

Origin no. Number of item / family / sales order or "blank" to be produced.

This field is logically related to the origin type.

Search Keyword Is formed automatically from the first 30 digits of the description and can be changed manually.

Quantity Number of items to be produced with this production order.

Due date Date by which the production order should be completed.

Assigned user Entry of the responsible clerk.

Production order

type

For classification of construction contracts.

Dimensions can be changed or added depending on the order type.

Locked If this identifier is active, postings (consumption and actual report) with the FA are not possible.

Corrected on The date on which the FA was last modified.

Note

Note
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The E+D item number is determined by the system when calculating the production order or the planning worksheets as well as

when maintaining the item number.

The system proceeds with the determination as follows:

Production order line (producing item)

The system fills the E+D position depending on the creation of the production order:

Manually or via the planning worksheets, the E+D item no. is preset with the value from the Design & Development setup of

the "Stepwise E+D item no. " field.

In order planning, the E+D item no. corresponds to the item no., the sales item to be covered.

In project planning, the E+D item no. corresponds to the project task no. of the project plan line to be covered.

Component

The E+D item number corresponds to the E+D item number of the FA line + the item item separator defined in the Design +

Development setup and the own item number.

Production order line (assembly)

The E+D position no. of the assembly corresponds to the E+D position no. of the component to be covered.

Operation

The E+D item no. corresponds to the E+D item no. of the FA line + the item operation separator defined in the Design +

Development setup and the own operation number.

Additional costs

The E+D position no. corresponds to the E+D position no. of the FA line + the position additional costs separator defined in the

design + development setup and the own position no.

Equal parts summary

In the standard system, the same parts are grouped together depending on whether the following fields match:

Variant code

Connection code

Position

Position 2

Position 3

Length

Wide

Weight

Depth

Unit code

If an article is used in several assemblies of a production order, the system combines them and generates a collective FA

component for this article.

The E+D item no. corresponds to the E+D item no. of the FA line + the item same-part summary separator defined in the Design

+ Development setup and its own item number.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Schedule
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Field Description

E+D Position The E+D position should describe the exact installation position across all drawing levels. In the case

of existing CAD integration, the position should match the designations on the CAD drawing and thus

forms search information, e.g. for assembly drawings.

E+D Position Initial value:

In the "Order quantity" replenishment procedure, the E+D item is filled based on the item number of

the sales line or based on the project task of the project plan line.

If no entry is found here, the step size from the Design & Development setup is assigned.

E+D Calculate position:

The calculation of the E+D position is already done in the planning worksheets and can be shown

there in the field "E+D position". In addition, the field is also available in the standard FA documents.

E+D Position manual change:

A manual correction of the initial value is possible in the E+D order via Navigate\lines.

All other manual changes are called from the E+D order component/FA component.

E+D Position Forms of presentation:

In the FA components, as well as the E+D order components, the "E+D Position" is combined with

the standard field "Position". Here, the field values "E+D Position" and "Position" are separated using

the "Position item separator" from the "Design & Development Setup".

E+D Position Phantom levels:

Can be identified in the dispositive view with the "Position phantom separator" from the "Design &

development uni". In the constructive view, the phantom layer is unfolded with its component.

E+D Contract Work Plan:

In the E+D order routing, the E+D position is formed from the operation number. A change is made

in the master data and can be updated via the E+D change synchronization. The "Position operation

separator" can be defined via the "Design & development setup".

Tools and personnel:

Can be managed in the secondary operations. For this purpose, the E+D position receives an

additional suffix. The separator for tool and personnel is defined via the "Production setup" of the

fields "Separator operation no. personnel" and "Separator operation no. tool". The numbering for

personnel and tool is defined via the "Personnel basic operation no." and "Tool basic operation no."

fields.

Additional costs:

In the E+D order, imputed additional costs can be stored for the FA line.

E+D Position Representation of the outsourced substructure:

By means of the "E+D Planning" function, assemblies can be outsourced to another production order.

The outsourced structure is marked in color and is dispositive or dispositive total depending on the

structure explosion.

E+D Position Lookup:

From the E+D position, you can branch directly to the edit mask via an AssistEdit call.

Type = Windows

Article = Show components

Workplace

/Workplace group = Show work plan

Additional costs = Show additional costs

Dispositive

availability traffic

light

Shows the availability of the component.

Assemblies inherit the "worst" result of the components.
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Field Description

see also:

- Availability traffic light

- Setting up the availability traffic light

Capacitive

availability traffic

light

Shows the availability of the workstation (group).

Assemblies inherit the "worst" result of the components.

see also:Availability traffic light

-Setting up the availability traffic light

Type Type of E+D line:

Article, phantom bill of material, workstation group, workstation, functional level, logistic level

E+D Production

type

Specifies the production type of the item taking into account the master data and also stock card

(options: make-to-order, make-to-stock).

No. Specifies the number depending on the type.

Description Specifies the description of the line depending on the "Type" and "Number" fields.

E+D Proposed

change available

icon

Indicates whether an E+D change proposal exists.

The icon is assigned from the "Factory Bitmaps" setup from the "Default line Existing" field.

Finished parts lists

Status

Displays the status of the finished parts list.

The options are "New", "Certified", "In Development" and "Expired".

The icons are obtained from the "Factory Bitmaps" facility.

Routing status Displays the status of the task list status.

The options are "New", "Certified", "In Development" and "Expired".

The icons are obtained from the "Factory Bitmaps" facility.

Component

quantity

Required quantity to produce one unit of the parent component.

Requirement date Indicates when the item of the parent level (x-1) is needed. E.g. from goods issue date of VK line, due

date FA component.

Quantity required Indicates the quantity required.

Reserved quantity Indicates reserved quantity (if in stock or on order) for this line.

Residual

requirement

quantity

Indicates the demand of the quantities not yet withdrawn or produced.

Storage bin code Specifies the bin code of the FA component.

Availability balance For items, the available quantity in stock and demand date is displayed.

For work center/work center group the available capacity of the FA work operation from start date/

time to end date/time is displayed.

Via drilldown, the calculated items can be called up and analyzed.

Reserved stock

(base)

Indicates the reserved quantity (if in stock) for this row.

Due date Indicates the due date of the FA line when the assembly will be ready according to the FA work plan

and calendar model.
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Functions Change E+D Manufacturing Policy

The production type of the selected item line is changed between make-to-stock production/order-related production.

Substructures are set or deleted.

Sub production order

For an FA line with the E+D MRP type Production part, the option is offered to create a separate production order if the FA line

is to be produced for the higher level on an order-related basis.

Create link to Production Part

For a stock part a link to a FA line can be created. The FA line is thus the requirement cover of the component and the E+D MRP

type is changed from stock part to production part.

E+D Order Planning

Order planning is called up specifically for the selected E+D lines. In the course of this, the demand cover is reserved directly for

the originator of the demand.

Reserve (line)

Calling the reservation functionality for the E+D line existing as FA line.

Reserve (components)

Calling the reservation functionality for the E+D row existing as FA component.

Order Tracking (line)

Field Description

If an assembly is outsourced and scheduled, the due date of the FA line (level x+1) differs from the

requirement date of the FA component (level x).

Note

The due date of the FA components can be over-scheduled by entering the lead time shift.

Quantity Specifies the number of items to be produced.

Finished quantity Here you can see the already finished quantities.

Quantity in

proposal line

Indicates the quantity in the planning/purchase order worksheets.

If the procurement documents are triggered from this, then (provided that with the reservation is

worked) autm. the field "Reserved quantity" is adapted accordingly.

Duration The duration is calculated from "End date/time" minus "Start date/time" of the FA operation and the

FA line.

For FA components with procurement type = purchasing, the procurement time of the item is

displayed.

Total duration The total duration is the cumulative result of the operations sorted in chronological order for one FA

line.

Supplied by Indicates reserved demand deckers. If there is no reserved demand deck, the field is "empty".

In case of uniqueness the card is displayed directly and via lookup you can branch directly to the

document.

If there are (several) demand coverers, you can branch to the reservation items via lookup.

Alternatively, you can branch directly to the documents via the line function Requirement originator

(component).

Remaining time Indicates the remaining time. The output "hours", "minutes" or similar depends on the definition in

the Design & Development Setup in the "Precision Duration" field.
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Calling the demand originator functionality for the E+D line existing as FA line.

Order Tracking (component)

Calling the demand originator functionality for the E+D row that exists as an FA component.

Transfer marked dispatch units

This function allows you to transfer the selected shipping units.

Show dispatch units

With this call you can display the shipping units for the respective line.

Item availability by

Displays item availability by event, period, variant, storage location or BOM level. For further information, please refer to the 

Microsoft Dynamics 365 Business Central[^1] Helpsite.

Reservation structure

This function allows you to display the reservation structure of a selected document line.

Reservation entries

Displays the items for each reservation made manually or automatically. For more information, see the Microsoft Dynamics 365

Business Central[^1] Helpsite.

Dimensions

Display or edit dimensions. Further information can be found in the Microsoft Dynamics 365 Business Central[^1] Helpsite.

Card

Depending on the line type: article, workstation, workstation group, the master data card is called directly.

Routing

Displays the E+D order operations for the selected E+D line. It is also possible to call up the E+D item.

Components

Displays the E+D order components for the selected E+D line. A call from the E+D position is also possible.

Opportunity cost

Additional imputed costs can be entered for preliminary costing. This item is relevant for the "Valuation & Costing" module.

Item tracking lines

Displays the item tracking assigned to the document row. For more information, see the Microsoft Dynamics 365 Business

Central[^1] Helpsite.

Subcontracting tracking

Document navigation to the external work documents "Purchase order" and "Stock transfer".

Shortage list

Call the missing parts list for the selected E+D line.

E+D Modif. Prop. Worksheet

Call the pending proposed changes to the marked E+D line.

E+D Additional charge

Call the markup calculation for the E+D line with level 0.
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Long dated items overview

Post consumption and expenses. Further information can be found in the Microsoft Dynamics 365 Business Central[^1] Helpsite.

Scheme

Posting

Functions on the ribbon

Refresh tree

Field Description

Start date Specifies the start date of the E+D order.

Start time Specifies the start time of the E+D job.

End date Specifies the end date of the E+D order.

End Time Specifies the end time of the E+D job.

Planned time 

(Current order)

Specifies the scheduled time for the current job.

Planned time 

(Overall structure)

Specifies the planned time for the overall structure.

Time consumed 

(Current order)

Indicates the time spent on the current job.

Time consumed 

(total structure)

Indicates the time spent on the overall structure.

Remaining time

(Current order)

Specifies the remaining time for the current job.

Remaining time

(Overall structure)

Specifies the remaining time for the overall structure.

Time consumed %

(Current order)

Indicates the time used for the current job in %.

Time consumed %

(Overall structure)

Indicates the time spent on the overall structure in %.

Field Description

Stock posting

group

Indicates the stock posting group of the production item. This value is preset with the value from the

item card.

Product posting

group

Specifies the product posting group of the production item. This value is preset with the value from

the item card.

Business posting

group

Specifies the business posting group of the production item. This value is preset with the value from

the item card.

Global dimension

code 1

The "Global dimension 1" is defined in the "Financial accounting setup". This can be the cost center,

for example. The value is pre-assigned with the value of the respective dimension from the item

dimension..

Global dimension

code 2

The "Global dimension 2" is defined in the "Financial accounting institution". This can be the cost

object, for example. The value is pre-assigned with the value of the respective dimension from the

item dimension.

Location code Specifies the storage location code.

Storage bin code Specifies the storage location.
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The structure of the E+D order lines is updated. This function is executed manually if required, for example, if the status samples

of the E+D order lines are to be checked again at the current time.

The availability traffic lights (dispositive + capacitive) are not automatically recalculated by the "Structure updated" function.

E+D Order Planning

E+D order planning is called up for the complete production order. In this overview, order-related procurement is carried out. 

See also E+D Order planning.

Refresh E+D Order

Has the same functionality as "Update production order..." in FA.

Replan

Reschedules the connected production order lines of the current FA. Other production orders connected to the FA lines are not

updated.

If the lead time shift is changed in the FA components, a new due date of the reserved FA line follows.

Calculate net change plan

The "Perform change comparison" function is used to compare production data, taking into account the change flexibility

parameter on the E+D order line.

See also "E+D Mod. Prop. Worksheet".

Replan net change plan

The new comparison ignores the change flexibility parameter in the change comparison and thus takes all E+D order lines into

account.

Change status

You can use this function to change the status of this document to Fixed planned, Released or Finished.

Copy E+D Order Document

This function is similar to the conventional "Copy voucher" function. With this function you can copy the data from an already

existing voucher into a new voucher to be created.

Calculate traffic light entries

This function is used to calculate the availability traffic lights (dispositive + capacitive).

E+D Statistics

Displays statistical data related to the E+D job.

Shortage List

Call the missing parts list as a table or also report.

Reservation Entries Components

Calling the reservation functionality for the E+D lines existing as FA component.

Report

Note
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The following reports can be printed out:

Project Card

Mat. Requisition

Shortage List

E+D Order

Long dated items overview

With this function the long run article overview for the referenced production order can be called. In the case of the E+D order,

it is the production order that is listed in the header of the E+D order.

For more information, see "Long-run items: Call for a production order / E+D order".

Update unit cost

This function allows you to update the cost prices across all levels or one level.

Create inventory put away pick movement

With this function you can create picking and putaway / transfer.

Create inbound Whse. Request

This function allows you to request an internal putaway request.

Create Whse. Pick

With this function you can create the picking.

Entries

You can view the following items by selecting "Items":

Item Ledger Entries

Capacity Ledger Entries

Value Entries

Warehouse Entries

Comments

You can enter remarks for the order via "Remarks".

Dimensions

Displays the dimensions.

Subcontracting Tracking

The external work tracking function is called up for the E+D order planning line. This shows all associated orders and stock

transfers (provisions).

Calculation Worksheet E+D

Opens the E+D calculation proposal.

Lines

Opens the E+D order line card for processing.

Dispatch unit

Opens the shipping unit card.

Subcontractor - Dispatch List }{ #subcontractor-dispatch-list }

• 

• 

• 

• 

• 

• 

• 

• 
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In this menu item you can print the foreign worker dispatch list.
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E+D MOD. PROP. WORKSHEET

KUMAVISION factory365 offers the functionality E+D Change Proposal to compare the manufacturing data (FA routings and FA

components) of the E+D order with the master data (routings and finished parts lists). If the data of the E+D order differs from

the master data, the E+D change proposal suggests a change in the E+D order.

If the change flexibility of the E+D order line is set to "none", this line is ignored in the change comparison.

Note
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The mask can be called up both via the user search and directly via the E+D order using the functions "Execute change

proposal" and "Execute new comparison".
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Field Description

E+D Position Position number of the line in the structure of the assemblies.

Type Definition of the line, the options are:

• Article,

• Phantom Bill of Materials,

• Workstation Group, 

• Workplace

No. The number is dependent on the type.

Working aisle no. Number of the operation, if the type is "work center group" or "work center".

Event message Indicates the corresponding event message.

Accept event

message

The "Accept event message" identifier is preset to "Yes" in E+D Planning if the "Planning - Accept

event message" field in the "Design & development settings" is set to "Automatic". If the field is set

to "Manual", the identifier is pre-assigned with "No".

Detail. Change

notification

Shows the description of the change.

Description Description depending on the type.

(e.g.: article description, operation description)

Age value Displays the value from the production order.

New value Displays the value from the finished parts list or routing.

Area Displays the area where the change is to be made.

FA status Displays the status of the production order in which the change is to be made.

FA no. Displays the production order number in which a change is made.

FA line no. Displays the line no. of the production order in which a change is made.

Change flexibility Identifier, which allows a line to be excluded from the proposed change.

The available options are "Unlimited" and "None".

This parameter is set manually by the production management per FA line and FA component.

Comparison date Displays the date of the comparison.

Variant code (to be

manufactured)

Specifies the variant to be manufactured.

Version code (to be

fert.)

Specifies the version to be manufactured.

Proposal version code

(to be fert.)

Version that would have to be made if the proposed change is executed.

Change notification Marks the line as a change and the type of change -. 

• New, 

• Change, 

• Remove, 

• Empty

Accept change

message

Here it can be decided line by line which change is accepted by the user.

The program will suggest you changes.
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Functions in the ribbon

Get Error Log

Opens the E+D error log.

Prod. Order Routing

Opens the FA work plan of the FA line.

Calculate net change plan

The "Perform change comparison" function is used to compare production data, taking into account the change flexibility

parameter on the E+D order line.

Calculate regenerative plan

The new comparison ignores the change flexibility parameter in the change comparison and therefore takes all E+D order lines

into account.

Carry out action message

The marked lines are accepted/executed with the "Execute event message" function.

Field Description

Item no. (component) If the change concerns a component, its article number is displayed here.

Variant code

(component)

If the change concerns a component and this has a variant, the valid variant of the article number

is displayed here.

Work plan ref. no. Line number of the production order to which the routing is assigned.

Work plan no. Displays the job number of the FA line.

Routing version code Displays the version of the routing assigned in the production order.

Proposal work plan

ref. no.

Displays the line number of the production order in which the routing is to be assigned.

Proposal Work plan

no.

Displays the task list number that is entered after the change adjustment.

Proposal routing

version code

Displays the new valid version of the task list number entered after change matching.

Proposal work plan

status

Displays the status that the routing assumes in the FA when the change proposal is executed.

Finished parts list no. Indicates the production BOM found.

Finished parts list

version no.

Indicates the found valid version of the production BOM.

FA- Component line

no.

Specifies the component line number in the found production BOM.

Proposal Finished

parts list no.

Displays the found and valid production BOM.

Proposal Fert. version

code

Displays the valid BOM version that is transferred to the FA during a change comparison.

Proposal Finished

BOM status

Displays the status found with the current production BOM.

The change proposal lines only have an influence on the E+D order as soon as the Execute change

message function is carried out for the selected proposal lines (Accept change message = YES).
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Production Order

Opens the production order (standard view).

Prod. Order Components

Opens the FA components (standard view).

E+D-Order

Opens the E+D order (similar to production order).

E+D Order Routing Plan

Opens the E+D order routing (analogous to FA routing).

E+D Order Components

Opens the E+D order components.

E+D Modification Proposal Order Routing

Displays the routing lines of the E+D order line.

E+D Modification Proposal Components

Displays the component lines of the E+D order line.
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E+D ORDER PLANNING

E+D order planning is called up for the complete production order. In this overview, order-related procurement is carried out.

The person creating the requirement receives a direct reservation with a requirement cover. The following requirements

coverers are possible: purchase order, planned/released production order, stock transfer order, assembly order and external work

order.

Functions in the ribbon

Update Lines

You can use this action to update the lines if changes have already been made in the background, possibly by other users.

Structure disable / enable

If the structure is activated, the components are displayed in the building structure including the assemblies.

Inventory parts disable / enable

Controls whether stock items are displayed or not.

Subcontracting disable / enable

Controls whether external work is displayed or not.

Only unplanned lines / all lines

Controls whether only unplanned rows or all rows are displayed.

Accept Action Message

Field Description

E+D Position no. This field maps the E+D position from the E+D order.

E+D Planning line

type

The following types are available: structure heading, stock section and external operation.

Type The article and workstation group types are possible.

No. Depending on the type, this field indicates the no. of the item or workstation group.

Description Depending on the type, this field indicates the description of the item or operation.

Requirement date Indicates the due date of the item/external operation.

Unit code Informatively specifies the units from the FA component.

Planning quantity The target quantity is shown here.

Planning completed If this identifier is set by the system, this means for the user that the article or the external operation

already has a reserved requirements cover.

Procurement

quantity

This quantity defines the procurement quantity that is to be transferred to the requirements planner

later in the process via the "Create orders" functionality.

Procurement

method

Indicates the procurement method of the item. Situationally, the procurement method can be

manually changed to purchase, production order, stock transfer or assembly.

Deliver from Specifies the vendor from which the item/external work is to be obtained.

Reserve The "Reserve" identifier defines whether the demand cover to be created is to be reserved for the

demand originator.

Accept event

message

Only E+D order planning lines that have this identifier set will be considered in the "Create orders"

function.
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Activates the "Accept event message" indicator for the selected line.

Refuse Action Message

Deactivates the "Accept event message" indicator of the selected line.

Reserve

Calls up the reservation functionality for the selected line.

Make Supply Requisitions

You can use this action to transfer the marked lines ("Accept event message") to a planning worksheet.

Make Orders

You can use this action to generate purchase orders, production orders, stock transfer orders, assembly orders or external work

orders for the marked lines ("Accept event message"), depending on the procurement method.

Reservation Structure

You can use this function to display the reservation structure of a selected voucher line.

Reservation entries

Displays the items for each manual or automatic reservation. Further information can be found in the Microsoft Dynamics 365

Business Central1 online help.

Requisition lines

Displays the respective order proposal lines.

Subcontracting Order Lines

Displays the respective external work orders (only for planning line type "External operation").

Subcontracting Tracking

External work tracking is called up for the E+D order planning line. This shows all associated orders and stock transfers

(provisions).
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MONITORING

Execution monitoring is used to get a quick overview of the execution status of the design and development process. 

For this purpose, there is the design monitoring for the master data view and the disposition monitoring for the design +

development order view (E+D orders). In both monitoring functions, the scope of monitoring can be defined specifically

according to articles, sales orders and E+D orders and projects in the case of MRP monitoring.

The MRP monitoring also lists the finished parts lists and operation lines, but compares these with the components and

operations of the E+D order or production order. Additionally, information regarding date and quantity as well as procurement is

displayed.

Construction Monitoring

Design monitoring allows you to monitor the status of your production master data. Design monitoring lists the finished parts

lists and operation lines and displays their processing status.

Please note that the system takes into account the inventory data, if available, when determining the data.

You can call up the "Design monitoring" via the user search.

General

In the "General" area, you can first define what should be checked and how.

Lines

Note

Field Description

Sales order filter If you want to check the production data for an entire sales order, maintain the order number here. The

system determines all articles entered in the order.

Article filter Enter here the article no. of the article to be checked.

Calculate work

plan

Use this field to specify how the system should take the routings into account:

No:

Routings are not taken into account in the calculation and are therefore not included in the result.

Show primary AG

Routings are included in the calculation, but secondary operations are not shown.

Display primary and secondary AG

Routings are fully considered in the calculation, primary as well as secondary operations are shown.

Structure check

only

Activate the switch if you only want to see items with notes in the result. This means that you will only

see lines whose BOM levels are greater than the value in the "Max. finished BOM level" field in the

Design and Development setup.

1.2.2 factory365

- 325/1545 - Copyright © 2018 - 2024 KUMAVISION AG



The main fields of the display lines are explained in more detail below:
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Field Description

E+D position This field displays the E+D position.

The top level is filled with the "Order position no. " in case of an order reference. Otherwise, the

value is initialized according to the Design & Development setup in the "Step size E+D item no. "

field.

The other levels are calculated according to their definition in Design & Development.

Level Represents the BOM level.

Sales order no. In this field the possibly passed order no. is displayed.

Type This field shows the type of line:

(blank):

It is a comment line

Article:

It is an item, the sources are production order line and components.

Note:

Please note that the variant code is maintained when displayed in blue.

Phantom Bill of Materials:

The component is defined as a phantom.

Workstation Group:

This is an operation of the "workstation group" type.

Workplace:

This is a "workstation" type operation.

Additional costs:

This is an additional cost item from the calculation.

Functional Level:

It is an attribute value according to your attribute definition in the Design & Development setup

in the "Item attribute functional structure resolution name" field.

Logistical level:

It is an attribute value according to your attribute definition in the Design & Development setup

in the field "Item attribute logistic structure resolution name".

Notice:

Please note that the types Additional costs, Functional as well as Logistical level are not used in

construction monitoring.

No. In this field, depending on the "Type", the "No. " field of the respective master data record is

displayed.

Description Depending on the "Type" and "No. ", the description of the source data set is displayed here.

Finished parts lists

Status

For the types "Article" and "Phantom BOM", the status of the stored production BOM is displayed

here.

Finished parts list no. For the types "Article" and "Phantom BOM" the production BOM no. of the stored production

BOM is displayed here.

Routing status For the types "Article", "Workstation" and "Workstation group", the status of the stored

production parts list is displayed here.
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Functions Calculate

With this action you perform the calculation according to your calculation settings.

Routing Plan

Use this action to open the displayed routing(s).

Production BOM

With this action you open the displayed production BOM (version).

Item

With this action you open the article card for items.

Disposition monitoring

The MRP monitoring offers a resolved tree structure of the production order. The required quantity and the availability balance

of the components and capacities can be viewed here. 

Visualization takes place with the dispositive and capacitive availability traffic light.

If there are reserved requirements coverers available for the requirements originators, these can be called up using the info box.

General

Field Description

Work plan no. For the type "Article", the routing no. of the stored routing is displayed here.

Procurement method

(master data)

Here you are shown the procurement method from the article master for type=article.

For type=workstation group, depending on whether it is external work, at

Outside work: Purchasing

Internal: Production order

set.

In the case of type=phantom bill of materials, "Stock transfer" is displayed.

Production type

(master data)

Here with kind=article with the procurement type "production order" the production type from

the stockkeeping data is represented to you.

For items with the procurement type "Purchase", a reference to the re-procurement

procedure, whereby:

• (empty) is displayed with " ".

• Order quantity with order production

• the others are shown with make-to-stock production.

For type=phantom BOM, " " (empty) is always displayed here.

Comment Here the system shows you irregularities of your master data.
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In the "General" area, you can first define what should be checked and how.

Field Description

Sales order filter A sales order filter can be specified. If there are sales lines for the sales order that are reserved with

a production order, the reserved production orders are listed and resolved in the MRP monitoring.

Project filter The project filter acts here analogously to the sales filter. If production orders are reserved for

project task lines, the production orders are listed in the MRP monitoring.

Article filter If an article filter is specified, the MRP monitoring searches over all production orders for the

specified article filter and lists the production orders found in the MRP monitoring.

Production

application filter

Enter here a production order no. of the item to be checked.

Calculate work plan Use this field to specify how the system should take the routings into account:

No:

Routings are not taken into account in the calculation and are therefore not included in the result.

Hide sec AG:

Routings are included in the calculation, but secondary operations are not shown.

Sec. AG Ads:

Routings are fully considered in the calculation, primary as well as secondary operations are shown.

Overall structure Activate the switch if you want to display the overall structure in the result.
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Lines
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Field Description

E+D position This field displays the E+D position. 

The top level is filled with the "Order position no. " in case of an order reference. Otherwise, the

value is initialized according to the Design & Development setup in the "Step size E+D item no. "

field.

The other levels are calculated according to their definition in Design & Development.

Level Represents the BOM level.

FA Status Indicates the status of the stored production order.

FA no. Indicates the number of the stored production order.

Sales order no. In this field the possibly passed order no. is displayed.

Project no. In this case, the corresponding project number is displayed.

Procurement method

(master data)

Here you are shown the procurement method from the article master for type=article.

For type=workstation group, depending on whether it is external work, at

Outside work: Purchasing

Internal: Production order

set.

In the case of type=phantom bill of materials, "Stock transfer" is displayed.

Production type (master

data)

Here with kind=article with the procurement type "production order" the production type from

the stockkeeping data is represented to you.

For items with the procurement type "Purchase", a reference to the re-procurement procedure,

whereby:

• (empty) is displayed with " ".

• Order quantity with order production

• the others are shown with make-to-stock production.

For type=phantom BOM, " " (empty) is always displayed here.

Dispositive availability

traffic light

Shows the availability of the component.

Assemblies inherit the "worst" result of the components.

see also:

-Availability traffic light

-Setting up the availability traffic light

Capacitive availability

traffic light

Shows the availability of the workstation (group).

Assemblies inherit the "worst" result of the components.

see also:

- Availability traffic light

- Setting up the availability traffic light

Type This field shows the type of line:

(blank):

This is a comment line.
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Field Description

Article:

It is an item, the sources are production order line and components.

Notice:

Please note that the variant code is maintained when displayed in blue.

Phantom Bill of Materials:

The component is defined as a phantom.

Workstation Group:

This is an operation of the type work center group.

Workplace:

This is a "workstation" type operation.

Additional costs:

This is an additional cost item from the calculation.

Functional Level:

It is an attribute value according to your attribute definition in the Design & Development setup

in the "Item attribute functional structure resolution name" field.

Logistical level:

It is an attribute value according to your attribute definition in the Design & Development setup

in the field "Item attribute logistic structure resolution name".

Note:

Please note that the types Additional costs, Functional as well as Logistical level are not used in

construction monitoring.

No. In this field, depending on the "Type", the "No. " field of the respective master data record is

displayed.

Description Depending on "Type" and "No. " the description of the source dataset is displayed here.

E+D Proposed change

available icon

Indicates whether an E+D change proposal exists.

Finished parts lists

Status

For the types "Article" and "Phantom BOM", the status of the stored production BOM is

displayed here.

Routing status For the types "Article", "Workstation" and "Workstation group", the status of the stored

production parts list is displayed here.

Requirement date Indicates when the item is needed.

Quantity required Indicates the quantity required.

Reserved quantity Indicates the reserved quantity if in stock or on order for this line.

Residual requirement

quantity

Indicates the demand of the quantities not yet withdrawn or produced.

Requested from Specifies the demand originator for this line.

Availability balance For items, the available quantity in stock and demand date is displayed.

For work center/work center group the available capacity of the FA work operation from start

date/time to end date/time is displayed.

Reserved stock (base) Indicates the reserved quantity if in stock for this line.
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Functions Calculate

With this action you perform the calculation according to your calculation settings.

Production order

With this action you open the associated production order.

Work plan

Use this action to open the displayed routing(s).

Component

Use this action to open the FA component row overview.

E+D Order

With this action you open the corresponding E+D order

E+D Contract Work Plan

With this action you open the E+D order routing.

E+D order components

Use this view to open the E+D order component overview.

Article

With this action you open the article card for articles.

E+D Proposed change

Opens the E+D change proposal.

Field Description

Due date Date by which the production order should be completed.

Quantity Specifies the quantity of this line.

Finished quantity Here you can see the already finished quantities.

Duration The duration is calculated from "End date/time" minus "Start date/time" of the FA operation and

the FA line.

Supplied by Specifies the demand cover for this line.

Comment Here the system shows you irregularities of your master data.
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Item versions

GENERAL

The item versions in KUMAVISION factory365 extend the item management of Microsoft Dynamics 365 Business Central1.

An item version can be used to map the product life cycle of an item. 

The item versions are an informal summary of an item or an item variant and its production master data (bill of materials and

routing).

The determination of the production master data is not changed by the item version, i.e. the production master data (bill of

materials/routing) is determined via the item or stock data card.

Please note, item versions are not stocked.

The following sections describe how to use and manage item versions in KUMAVISION factory365.

SETUP

Item version type

The item version types are used to classify the item versions later on. To define these first, call up the "Article version type" page

via the user search.

Via "New" in the menu ribbon, you can define a new item version type by entering the "Code" and "Description".

Item version

The "item version" allows you to map the product life cycle of an item. By assigning an "item version type", the item versions can

be classified so that they can be distinguished from one another.

Note
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To define a new item version, call up the "Article version" page via the user search. You can define a new item version using the

table below via "New" in the ribbon:

The item including item version can be specified in the procurement process.

An item version is automatically determined by comparing the production BOM number, the production BOM version code, the

routing number and the routing version code of the item version with the item or the stock data.

Field Description

Item No. In this field, enter the item number for which you want to create a version.

Variant Code If the selected item is variant-managed, you can define the variant of the item for which you

want to create a new version here.

Version Code Enter an "abbreviation" for the item version to be created.

Description Gives the description of the selected item.

Item Version Type By assigning an item version type, you have the option of classifying the item version.

Material Here you can assign a material to the item version.

Status Indicates the status of the item version. Three statuses are assigned here:

New

The item version is currently being edited. 

Certified

The item version has a released status. No changes can be made in this status.

Expired

The item version is no longer valid.

You can change the status via the ribbon by selecting "New", "Certified" and "Expired".

Version Starting Date Specifies the start date of a version.

Drawing No. Enter a drawing number (if available) for the version.

Drawing Format Specify a drawing format (if available) for the version.

Drawing Index Enter a drawing index (if available) for the version.

Manufacturer Code Enter a manufacturer code (if available) for the version.

Manufacturer Item Code Enter a manufacturer item number (if available) for the version.

Delivery Standard Enter a delivery standard (if available) for the version.

Norm Specify a standard (if available) for the version.

Production BOM No. Enter the production BOM number.

Production BOM Version

Code

Enter the production BOM version code.

Routing No. Enter the work center number.

Routing Version Code Enter the routing version code.
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The production BOM number, the production BOM version code, the routing number and the routing version code stored in the item

version are not transferred to the production order. These are only used to determine the item version.

Please note that the item version type of the consuming item is checked to ensure that it matches the item version type to be

reported.

The item version does not differentiate the stock level of the item. If it is necessary to differentiate the stock on the item at item

version level, the item variant can be managed in addition to the item version. This means that the stock level is taken into

account for the item variants and therefore also for the corresponding item version.

Functions in the ribbon New, Certified, Expired

These functions set the item version to the status of the same name.

Where used

This functionality is used to determine in which assembly/production item the component is located.

Structure

Microsoft Dynamics 365 Business Central1 uses this to display the production structure/tree structure of the production item

based on the specified production BOM and routing.

Quantity explosion of bom

The structure parts list is output as a report.

Rolled up cost shares

The costs of the production item are calculated on the basis of the production bill of materials and the routing and output as a

report.

Cost Shares

The costs are mapped in a tree structure as in Microsoft Dynamics 365 Business Central1 Standard.

Detailed calculation

The costs are displayed as in Microsoft Dynamics 365 Business Central1 Standard Detailed Costing.

BOM cost share distribution

The cost shares (material, capacity, external labor, capacity & production overheads) are displayed graphically in a report.

Attributes

This menu item is used to assign item attributes to the item version.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

Note

1. 
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Scheduling Agreement Management

The module "Delivery schedule management" includes the areas: "Sales delivery schedule" and "Purchasing delivery schedule".

The scheduling agreement management is an unlock module, the use of which is only possible with additional licensing and 

activation.

Sales delivery schedule

For series production, delivery schedules with preview quantities and production-related JIT delivery schedules are sent to the

suppliers, mostly electronically. On the other hand, the suppliers send delivery note data to the manufacturers, which in turn are

already available to the customer at the time of physical goods receipt. Payment can then be settled either via invoices or via the

credit memo procedure.

Delivery schedules serve as the central core for processing. They form a symbiosis between sales orders and sales planning.

Together with master scheduling agreements, they also form an extension of order control. They offer similar functions to orders,

but when order quantities and deadlines change dynamically, special functions come into play. The dynamics results from the so-

called delivery schedules or JIT delivery schedules, which are usually received periodically.

The quantities and dates mapped in the scheduling agreements are taken into account in inventory planning and logistics for

shipping. The quantities and dates are entered in the scheduling agreements via the "Incoming documents". All group-wide

scheduling agreements with price information can be displayed in the outline scheduling agreements.

Purchasing delivery plan

With the "purchasing scheduling agreement" a functional extension of the procurement process in Microsoft Dynamics 365

Business Central1 was realized.

While the standard of Microsoft Dynamics 365 Business Central1 knows the processing of purchase orders with or without

recourse to blanket purchase orders, it does not know the processing of scheduling agreements (often also known as "call

orders") so.

In the case of scheduling agreements, a framework agreement is agreed between the customer and the supplier for each article.

Based on a fixed framework agreement, which describes the general contract modalities and must not be confused with the

framework order in Microsoft Dynamics 365 Business Central1, the current date and quantity information is exchanged between

the customer and the supplier in day-to-day business. Here, an essential difference to the "normal" purchase orders is that the

latest transmission of date and quantity information always replaces the last information and only the latest information is valid.

All known date and quantity information is also always exchanged, so that, as a rule, dates from today to dates that are only

several years away can be transmitted.

In order to be able to map this process in Microsoft Dynamics 365 Business Central1, the "purchasing scheduling agreement" has

been created. With this, the so-called scheduling agreements can be defined and managed. There is always exactly one valid

purchasing delivery schedule in Microsoft Dynamics 365 Business Central1 for each master agreement. The recurring

transmission of the date and quantity information is called a forecast delivery schedule. The "Purchasing scheduling agreement"

can be used to generate and send these forecast delivery schedules.

As described before, the schedule and quantity information is updated and transmitted from time to time and then the current

delivery schedule always applies. Due to the usual transport times in goods traffic, it can happen in practice that deliveries from

the supplier still refer to the previous delivery schedule, but the new delivery schedule is already active at the customer. For a

correct allocation of quantities on the schedule line, the management of cumulative quantities is used. A cumulative delivered

quantity is managed on the supplier side and the cumulative received quantity is managed on the customer side. The "purchasing

scheduling agreement" supports users in managing these cumulative quantities.

Note
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SALES DELIVERY SCHEDULE

Establishment

Roll Center

A corresponding role center was designed for managing the scheduling agreements. This gives users a direct overview of their

worklist and allows them to conveniently navigate to the corresponding overviews.

The role "Delivery schedule editor" can be assigned via "My settings". The role center is available after confirming with "Ok".

Scheduling Template

Using the scheduling template, it is possible to define which type of call-off quantities are to be taken into account in logistics or

production.
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The combination of JIT delivery schedule with preview or delivery schedule is not possible. JIT delivery schedules dominate over

delivery schedules and preview quantities. JIT call quantities within the same date range replace preview quantities.

Article reference

The customer article numbers are mapped via the article references. Under Reference type referring numbers for vendor as well

as customer can be entered. The reference type barcode can be used to define barcodes, e.g. for the EAN number.

To set the article references, call up the desired article card. You can access the article references via the ribbon by selecting

"Related" > "Articles". For more information on article references, see the Microsoft Dynamics 365 Business Central1 Helpsite.

Delivery schedule facility

Note

Field Description

Type The following selections are available:

Planning code

With the selection "Planning code" you define a scheduling template for production. You use the selection

in the "Production Code" field in the scheduling agreement to control which quantities in the scheduling

agreement are relevant for production.

Logistics code:

With the selection "Logistics code" you define a scheduling template for logistics. You use the selection in

the "Logistics code" field in the scheduling agreement to control which quantity in the scheduling

agreement is relevant for logistics.

Code At this point, assign a meaningful abbreviation for the scheduling template.

Description Provide a brief description for the scheduling template.Planned Check the box if you want the planned

quantities ("Quantity preview" field) to be included in the delivery schedule.

Retrieval Place a check mark if the released quantities ("Delivery schedule quantity" field) are to be taken into

account in the scheduling agreement.

Daily call-off Place a check mark if the quantities finely called off (field "Quantity finely called off") are to be taken into

account.

Disposition

method

You use the MRP method to specify how "Floating Goods" (goods that are on their way to the customer)

are determined when a new forecast delivery schedule is copied into a scheduling agreement. The

following options are available:

Empty

This option only applies to the production code. For logistics code, one of the other three options must

always be selected.

Date basis without residual quantity allocation:

The quantities of the new delivery schedule replace the previous values. Quantities already delivered on

a date are not taken into account and are omitted.

Date offset with residual quantity offsetting:

The quantities of the new delivery schedule first the previous values. But delivered quantity to a date

remain and are added to the new delivery schedule quantities corresponding.

Cumulative Quantity:

The quantities of the new forecast delivery schedule replace the previous values. The difference between

own cumulative quantity and customer cumulative quantity is considered as "floating goods" and is

deducted from the first forecast delivery schedule quantity accordingly.
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In the "Delivery schedule setup" the basic setup of the delivery schedule management is made, which will be explained to you in

more detail below:

Inforegister General

Numbering

The number series for the delivery schedule management are defined on the "Numbering" info tab.

Group hierarchy

The master scheduling agreement is primarily used for a corporate group and the conventional scheduling agreements for

plants. Therefore, it is essential for the system to know which customer (as a plant) belongs to which customer (as a group).

For this purpose, a group hierarchy is used via the hierarchies in the system. Which hierarchy type is used for the group

assignment. Specify in the Hierarchy Type Code Group Assignment field in the scheduling agreement setup. A hierarchy type can

be used with the customer as the origin and destination.

The group assignment itself is made via the customer and the here archie relationship..

Scheduling Agreements

Contrary to a sales order, a scheduling agreement always refers to a customer and an article or an article variant. Therefore, the

article number is not in the lines, but in the header.

To create a new scheduling agreement, call up the "Scheduling agreements" via the user search. The following table explains the

fields of the scheduling agreement in more detail.

Inforegister filter representation

Field Description

Min. diff. Cumulative

quantity for zero setting

Specifies the minimum difference that must be reached for zeroing the cumulative

quantities.

Progress ct. Proposal Name

for zero position

In this field you define a default sheet, which will be preset for zeroing in the cumulative

quantities proposal.

Default In Transit Code In this field, a transit storage location must be specified as the default for consignment

processing.

Hierarchy type code Group

assignment

Defines a hierarchy type code for the group assignment.

Mandatory field check The use of the mandatory field check for scheduling agreements can be activated separately

at this point. Further information on setting up mandatory field checks can be found here.
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Using the filter area, you can change the display of the delivery schedule for clarity:

Field Description

Display details The quantities preview, forecast delivery schedule, JIT delivery schedule, PUS are displayed summarized

in the lines as daily, weekly, monthly, quarterly or annual quantities, depending on the selection.

Preview /

Retrieval

You can filter the display to a specific version of the type=preview.

Note

Only the versions of the type=preview are available in the selection.

Daily call-off You can filter the display to a specific version of the type=fine call.

Note

In the selection, only the versions of the type=fine call-off are available.

PUS You can filter the display to a specific version of the type=PUS.

Note

Only the versions of the type=PUS are available in the selection.

Rounding factor This allows you to display the quantities (preview, forecast delivery schedule, JIT delivery schedule and

PUS) rounded. The following selection options are available:

None:

The quantities are displayed without rounding

1

The quantities are displayed rounded to whole numbers

1000

The quantities are displayed to you /1000.

Optimized

display

Activate the switch if you only want to display lines with actual quantity values. Otherwise, depending on

the display details filter, you will also be shown days, weeks, months, quarters or years for which no

requirement quantities are available.
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Inforegister General
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Field Description

No. This field is used to identify the scheduling agreement. The number must be unique and can be up to

20 characters. The number field can be set to the default value by using the number series option in

the delivery schedule setup. However, it can also be created manually.

Sales to customer

no.

This field contains the customer number that you have assigned for it in your system.

Delivery to code Indicates the address to which the products will be delivered. With this field you can enter a different

delivery address.

Item no. This field contains the article number of the customer article that you have assigned for it in your

system.

Variant code This field contains the code of a variant of the item, if any.

Article description Indicates the description of the selected item.

Item description 2 Specifies an additional description for the selected item.

Customer item no. This field contains the customer item number. For this purpose, it must be created as an article

reference beforehand in order to be selected here (see Setting an Article reference).

Supplementary part

number

Indicates a supplementary part number. This field serves only as an information field.

Customer item no.

export option

Indicates the customer item no.

Accept incoming

document

Use this field to specify how Incoming Receipts can be accepted. You can choose from the following

options: 

Manual

The incoming receipts must be accepted manually. Typically, when an electronic processing is newly

set up, and each receipt must be tested again beforehand to be on the safe side.

Automatic

Incoming documents are processed automatically when they are processed electronically. Typically,

when the electronic processing is running securely and user intervention is no longer required.

Locked

An incoming document cannot be accepted and leads to an error message there. Typically, when

there are problems in the delivery schedule and further reading of incoming documents must be

prevented.

Locked This field controls the possible use of the scheduling agreement in stock planning (also called MRPII

run) or logistics. This can prevent further processing in the event of incorrect data within the

scheduling agreement. The following options are available:

Empty

This option is the default value. Here the scheduling agreement is visible and usable in the inventory

planning as well as in the logistics.

Inventory planning

The scheduling agreement is not visible in inventory planning (both purchasing and production) and

no longer triggers any requirements there. However, stocks can still be delivered via logistics. 

Logistics

This option is the strongest lock. The scheduling agreement does not trigger requirements in stock

planning, nor can stock be delivered via logistics.

Status
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Field Description

A scheduling agreement can assume the following statuses:

New

Is the initial status for new scheduling agreements. It indicates that not all fields are correctly

defined yet. Therefore, it is neither demand-triggering nor can a logistics document be created for it.

Likewise, no incoming documents can be accepted yet.

Open

After a scheduling agreement has been completely set up, this status is necessary for each change of

modifiable fields. As with a sales order, this only affects the creation or posting of logistics

documents. For this, the status must be set to Released.

Share

In this status, the delivery schedule is read-only.

Ends

Once a scheduling agreement has been completed, it can be archived via this status. It then also no

longer triggers any requirements, no logistics document can be created for it, and no incoming

documents can be accepted.

If the status of a scheduling agreement is changed from "New", a check is carried out to see whether

an incomplete scheduling agreement already exists for the uniqueness criteria. This is important so

that only one scheduling agreement can be found via the incoming documents. The criteria are

thereby:

- Sales to customer no. 

- Delivered to code 

- Item no. 

- Variant code 

- Usage key 

- Status [Open to Released]

Outline delivery

schedule no.

If the scheduling agreement was created from an outline scheduling agreement, this field contains

the outline scheduling agreement number.

Logistics code This field is used to define a scheduling template for logistics. It controls which quantities are

relevant for logistics.

Production code This field is used to define a scheduling template for production. It controls which quantity is

relevant for production.

Cost center code Specifies the code for the cost center (dimension 1) that you have set up in the "Financial accounting

setup".

Cost unit code Specifies the code for the cost object (dimension 2) that you have set up in the "Financial accounting

setup".

Plant Indicates a possible plant at the customer. This field is an information field.

Unloading point Indicates a possible unloading point. This field is an information field.

Point of

consumption

Indicates a possible consumption point. This field is an information field.

Storage location at

customer

Indicates the storage location at the customer. This field is an information field.

Usage key This field is used to define which use the item has. It is used to distinguish uniqueness when the

same item is sent to the same customer to the same delivery address, e.g. once as serial parts and

once as spare parts. The following options are supported:
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Inforegister lines

The lines of a scheduling agreement do not really exist. Rather, the different quantity types from the items are displayed to the

user at runtime similar to the sales lines. However, there is not only one quantity column, but four and the actual quantity field,

which represents the relevant quantity depending on the logisitkcode.

If an overdelivery takes place, this is offset in the remaining delivery schedule quantity and the next quantity is already reduced.

Field Description

- blank

- Series

- Replacement general 

- Series and use

- Try

- Pilot

- Additional requirements

- Initial sample

- Pattern

- Other

This field is an information field.

Contract/Order No. This field corresponds to the document or order number. It is entered in the "External document

number" field in the created sales order when a delivery is made.

Field Description

Delivery date Specifies the date on which the goods are to be delivered.

Planned goods issue

date

Specifies the date when the goods are to be shipped from the warehouse.

Goods issue date As in the sales order, this date corresponds to the due date in the warehouse as a requirement and is

therefore relevant when creating the logistics documents.

Outgoing Stock

cycle time

Specifies the time needed to prepare the goods from the storage location for goods issue.

Transport time Specifies the time required for delivery of the goods to the customer.

Quantity preview These quantities are used as preview e.g. in monthly rhythm.

Quantity delivery

schedule

These quantities correspond to a finer subdivision of preview quantity. Therefore, they replace

preview quantity within the same date period. E.g.: this quantity is made on days.

Quantity JIT call-off These quantities are usually sent on a daily basis. They do not replace any preview or delivery

quantities, but exist in parallel.

Quantity PUS This quantity is filled in the special call-off PickUp Sheet. For this purpose, sales order lines already

exist before delivery in exactly the same quantities. PUS quantities do not replace each other in new

call-offs, but are always additive.

Target cumulative

quantities

Starting from the cumulative quantity received from the customer, the target cumulative quantity is

determined here using the relevant forecast delivery schedule quantity.

Quantity This quantity depends on the logistics code and shows the actual relevant quantities.

Quantity supplied This field indicates the quantity delivered from the set.

Remaining order

quantity

This field displays the remaining delivery schedule quantity as the difference between the quantity

and the quantity delivered.

Note
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Inforegister delivery

Framework delivery schedule

Outline scheduling agreements are a combination of several scheduling agreements. Therefore, it is well suited for later

evaluations, since all existing scheduling agreements with the respective plant are mapped for one article. For this reason, an

outline delivery schedule is primarily created for corporate groups.

The master scheduling agreement takes on another important meaning when the agreed prices and planned quantities are

determined. Therefore, one and the same scheduling agreement can occur several times in a master scheduling agreement with

different prices and planned quantities. The fields "From date" and "To date" are used to determine which line is then valid.

To create an outline delivery schedule, call it up via the user search. Via "New" in the menu ribbon you can define a new

framework scheduling agreement with the help of the table below.

Field Description

Delivered to code Specifies the address to which the products will be delivered. With this field you can enter a different

delivery address.

Delivered to Name Specifies the name of the recipient of the delivery.

Delivered to name

2

Specifies additional name information of the recipient of the delivery.

Delivered to

address

Specifies the delivery address.

Delivered to

address 2

Specifies additional address information.

Delivered to zip

code / city

Specifies the postal code of the associated city of the delivery address.

Delivered on site Specifies the location of the associated delivery address.

Location code Specifies the storage location from which stock items are to be delivered to the named customer by

default.

Storage bin code Specifies the bin location from which stock items are to be delivered to the named customer by

default.

Delivery code Specifies the code for the delivery agent transport type used for this customer.

Carrier transport

type code

Specifies the code that represents the default carrier shipment type code that you use for this delivery

schedule.

Transport time Indicates the time between the delivery of goods from the warehouse to the delivery.

Outgoing Stock

cycle time

Specifies a date formula for the time required to make items from this storage location ready for

delivery.

Ames-T This switch serves as information. With the help of AMES-T (Advanced Mobility Engineering and

Services for Transportation), the procurement process within the Volkswagen Group is improved. You

receive this information from your customer via the incoming documents.

Consignment

processing

Specifies that the scheduling agreement is consignment processing.
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Inforegister General

Field Description

No. This field is used to identify the framework delivery schedule. The number must be unique and can be

up to 20 characters. The number field can be set to the default value by using the number series option

in the scheduling agreement setup. However, it can also be created manually.

Customer no.

(Group)

This field contains the customer number that you have assigned for it in your system.

Delivered to

Name

Specifies the name of the recipient of the delivery.

Item no. This field contains the article number of the customer article that you have assigned for it in your

system.

Variant code This field contains the code of a variant of the item, if any.

Article

description

Indicates a description of the item.

Item description

2

Indicates a further description of the item.

Customer item

no.

This field contains the customer item number.For this purpose, it must be created as an article

reference beforehand in order to be selected here (see Setting an Article reference).

Status A master scheduling agreement can assume the following statuses:

New

Is the initial status for new framework scheduling agreements. It indicates that not all fields are

correctly defined yet.

Open

After a master scheduling agreement has been completely set up, this status is required each time

modifiable fields are changed.

Share

In this status, the delivery schedule is read-only.

Ends

Once an outline delivery schedule is complete, it can be archived using this status.

Logistics code This field is used to define a scheduling template for logistics. It controls which quantities are relevant

for logistics.

Production code This field is used to define a scheduling template for production. It controls which quantity is relevant

for production.

Cost center code Specifies the code for the cost center (dimension 1) that you have set up in the "Financial accounting

setup".

Cost unit code Specifies the code for the cost object (dimension 2) that you have set up in the "Financial accounting

setup".
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Inforegister lines

Inforegister delivery

Creation of scheduling agreements via master scheduling agreements

To create a scheduling agreement from an outline scheduling agreement, call up the "Create scheduling agreement" function in

the menu ribbon of the outline scheduling agreement.

The system determines all plants and their delivery addresses via the group hierarchy. In the "Unloading point selection", all

combinations of these are displayed for which there is not yet a scheduling agreement.

Assignment of existing scheduling agreements to master scheduling agreement

To assign an existing scheduling agreement to a framework scheduling agreement, first call up the corresponding framework

scheduling agreement. Enter the scheduling agreement number in a new line in the "Scheduling agreement no." field. This

assigns the scheduling agreement. 

Field Description

Delivery schedule

no.

Specifies a scheduling agreement number associated with the master scheduling agreement.

Customer no. (plant) Specifies the customer number (plant) defined in the associated scheduling agreement.

Delivered to code Specifies a possible alternate address for the associated scheduling agreement.

From date Specifies the date from which the plan line is valid.

Until date Specifies the date until when the plan line is valid.

Planned quantity Specifies the agreed quantity for the framework scheduling agreement line.

Price origin Which price is actually used for the scheduling agreement is determined by the Field Price origin

fixed:

Invoice to debtor

The standard pricing for the invoice debitor from the Delivery schedule.

Sales to debtor

The standard pricing for the sales debitor from the scheduling agreement applies.

Framework delivery schedule

The price from the Price (MW) field is valid, for the from date and Until date valid frame delivery

schedule line.

UK price (MW) Indicates the determined sales price.

Field Description

Delivered to Name Specifies the name of the recipient of the delivery.

Delivered to name 2 Specifies an additional name of the recipient of the delivery.

Delivered to address Specifies the delivery address.

Delivered to address 2 Specifies additional address information.

Postcode code / place Specifies the postal code of the associated city of the delivery address.

Delivered on site Specifies the location of the associated delivery address

Note
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Incoming documents (Incoming call-off)

The incoming documents are transferred to the concrete documents, the scheduling agreements, in this area. They can be

transferred manually or directly via EDI interface. EDI is the technical Basis for the transfer of incoming documents. Since

setting up the EDI interface is not part of this section, the manual transfer of the documents is explained here. In this process,

the delivery schedules are transferred to the scheduling agreements and scheduling agreement items. The document for the Pick

Up Sheet (PUS) is the sales order. Credit memos and stock reports can be processed without documents. The shipment data

represents the entry of consignment material.

Incoming documents are:

Call-offs

Daily call-offs

"PICK UP SHEET" (PUS)

Credit note display

Transport data.

After receipt of a forecast delivery schedule, it must be entered in the system. For this purpose, you have on the one hand the

possibility to enter the entry directly via the scheduling agreement using the function "Item direct entry" or usually to generate a

corresponding incoming document (forecast delivery schedule / JIT delivery schedule etc.). 

Incoming call off

In the incoming call-offs, you are informed of the customer's requirement quantities over a longer period of time, so that you can

plan these requirements accordingly in your procurement / production. 

Via the user search, you can call this up by entering "Incoming call-off" and manually enter a new one or, if you are working with

an interface, open a call-off transmitted by the interface.

A forecast delivery schedule always refers to a scheduling agreement. The delivery schedule concretizes the delivery plan.

The fields of the call-off card are explained in more detail below:

• 

• 

• 

• 

• 

Note
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Field Description

No. This field is used to identify the incoming call-off. The number must be unique and can be up to 20

characters. The number field can be set to the default value by using the number series option in the

delivery schedule setup. However, a manual number can also be created.

Delivery schedule

no.

Selection of the associated scheduling agreement. In this view, only the scheduling agreements with

the status "Open" and "Released" are displayed. However, you can only select scheduling agreements

with the status "Released".

Debtor no. This field contains the customer number that you have assigned for the customer in your system.

Usually this data is filled automatically from the related scheduling agreement.

Delivered to code Specifies the address to which the products will be delivered. You can use this field to enter a different

delivery address. As a rule, this data is automatically filled from the associated delivery schedule.

Delivered to

Name

Specifies the name to which the products are to be delivered.

Item no. This field contains the article number of the customer article that you have assigned for it in your

system. As a rule, this data is filled automatically from the associated scheduling agreement.

Variant code If necessary, this field contains the code of a variant of the item. As a rule, this data is automatically

filled from the associated scheduling agreement.

Article

description

Specifies the description of the selected item. As a rule, this data is automatically filled from the

associated scheduling agreement.

Item description

2

Specifies an additional description for the selected item. Usually this information is filled automatically

from the related delivery schedule.

Customer item

no.

This field contains the customer item number. For this purpose, this must be created beforehand as an

article reference. As a rule, this information is automatically filled from the associated scheduling

agreement.

Error description If you execute the "Change status" or "Complete and check" function and the document contains

incomplete or incorrect data, these errors will be displayed in the text field.

My supplier no. Indicates the supplier number that your customer has assigned for you. This information is

communicated to you via the incoming documents. This field serves only as an information field.

Call-off no. New Specification of the current forecast delivery schedule. This field must be filled for the transfer of the

delivery schedule into the scheduling agreement.

Call date new Specification of the current call-off date. This field must be filled for the transfer of the delivery

schedule into the scheduling agreement.

Plant Indicates a possible plant at the customer. This field is an information field.

Unloading point Indicates a possible unloading point. This field is an information field.

Point of

consumption

Indicates a possible consumption point. This field is an information field.

Warehouse

customer

Indicates a possible customer warehouse. This field is an information field.

Usage key This field is used to define which use the item has. It is used to distinguish uniqueness when the same

item is sent to the same customer to the same delivery address, e.g. once as serial parts and once as

spare parts. The following options are supported:

- blank

- Series

- Replacement general

- Series and use
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Field Description

- Try 

- Pilot

- Additional requirements

- Initial sample

- Pattern

- Other

This field is an information field.

Contract/Order

No.

This field corresponds to the document or purchase order number. It is entered in the "External

document number" field when a delivery is made in the created sales order.

Status An incoming call can take the following statuses:

Open

The incoming call-off can be edited / recorded.

Accepted

The incoming call-off is confirmed. With the status change, the requirements are taken into account in

the associated scheduling agreement.

Rejected

The incoming call-off is not confirmed and is deleted with the status change.

Incorrectly

documented

If you execute the "Change status" or "Complete and check" function and the document contains

incomplete or incorrect data, the switch is activated and you can get detailed error information from

the "Error description" field.
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Inforegister lines

Field Description

Type Specifies the type "item" of the demand. The selection "empty" is not accepted.

Quantity Indicates the number of demand.

Requirement type blank

The quantity is regarded as a call-off quantity and is transferred to the Delivery call-off quantity column

in the scheduling agreement.

No need

This is an informational quantity only and will no longer be included in the delivery schedule.

Backlog

If no requirement date is entered, the current date is used as the requirement date. 

Instant demand

If no requirement date is entered, the current date is used as the requirement date.

Preview

The quantity is viewed as a preview quantity and transferred to the Preview quantity column in the

scheduling agreement.

Requirement

date

Specifies the date when the customer needs the goods. KW call-off Specifies a call-off period from which

calendar week the goods are required.

Call off until KW Specifies a call-off period by which calendar week the goods are required.

Demand month Indicates the month when the goods are needed.

Demand year Indicates the year in which the goods are required.

Requirement

status

The status "B" indicates that FAB data must be taken over from previous transfers as constant from you

as supplier until this date. This field is an information field.
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Inforegister delivery

Field Description

Delivered to code Specifies the address to which the products will be delivered. You can use this field to enter a

different delivery address. As a rule, this data is automatically filled from the associated delivery

schedule.

Delivered to Name Specifies the name of the recipient of the delivery.

Delivered to name 2 Specifies an additional name of the recipient of the delivery.

Delivered to address Specifies the delivery address.

Delivered to address 2 Specifies additional address information.

Zip code / Place Specifies the postal code of the associated city of the delivery address.

Delivered on site Specifies the location of the associated delivery address.

Delivered to country/

region codes

Specifies the country code of the associated delivery address.

Delivery interval Specifies a possible interval for the delivery. This field is an information field and has no effect in

the system.

The following options are available:

-blank

- According to expiration date

- Daily

- Weekly 

- Monthly

Appointment key Specifies a possible appointment key. This field is an information field and has no effect in the

system. The following options are available:

- blank

- Arrival date customer

- Shipping date supplier

- Arrival date PAB

- Planning preview

- Daily scheduling

- Short term information

Kanban no. Indicates a possible Kanban number. This field is an information field.

Production release Specifies a date for the production release. This field is an information field and has no effect in

the system.

Production release end

date

Specifies an end date for the production release. This field is an information field and has no

effect in the system.

Material release Specifies a date for the material release. This field is an information field and has no effect in the

system.

Material release end

date

Specifies an end date for the material release. This field is an information field and has no effect

in the system.
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Information register cumulative quantity

With the accept the lines are taken over into the scheduling agreement and become scheduling agreement items. The function

call offers two further functions, on the one hand the call can be checked for completeness and on the other hand there is the

possibility to have a suitable scheduling agreement identified. After acceptance, the delivery schedule with quantities and dates

is available to logistics and production for further processing.

Incoming daily call-off

The entry of a daily call-off is analogous to the incoming call-off. JIT delivery schedules dominate call-offs and previews. The JIT

delivery schedule must be set in the logistics code and/or production code. The codes are stored in the scheduling agreement.

Via the user search, you can call this up by entering "Incoming daily call-off" and manually enter a new one or, if you are working

with an interface, open a daily call-off transmitted by the interface.

The fields are analogous to those of the "Incoming call-off".

Depending on the base calendar, the individual JIT delivery schedule quantities are combined in the date. This always ensures timely

demand triggering and delivery.

Incoming Pick Up Sheet (PUS)

The "Pick Up Sheet" (PUS) is also recorded in the same way as a call-off or JIT delivery schedule. In contrast to the call-offs, each

PUS is a separate binding order, i.e. a PUS does not replace a previous PUS, but supplements the whole. Pick up sheets may not

be combined. Only the notified quantities in the corresponding packaging are picked up at the time of collection or delivery.

Therefore, when accepting incoming PUS, not only the delivery schedule is updated, but also a corresponding sales order is

created.

To create a Pick Up Sheet, call up the "Incoming PUSes" via the user search. Via "New" in the menu ribbon you can create a new

PUS.

Field Description

Progress number customer Indicates the cumulative quantity that the customer has listed for this transaction.

Last delivery quantity customer Indicates the last delivered quantity that the customer has listed with him for this

operation.

Last delivery note no. Customer Indicates the last delivery note number that the customer has listed for this

transaction.

Date last delivery bill customer Specifies the date of the last delivery bill that the customer has listed for this

transaction.

Arrival date customer Indicates the arrival date that the customer has listed for this transaction.

Zeroing date cumulative quantity

received

Specifies the zeroing date of the cumulative quantity received, which the customer

has set for this operation.

Cumulative quantity reached for

zeroing

Indicates the number of cumulative steps reached, which the customer has listed for

this transaction.

Note
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Field Description

No. This field is used to identify the incoming PUS. The number must be unique and can be up to 20

characters. The number field can be set to the default value by using the number series option in the

delivery schedule setup. However, a manual number can also be created.

Delivery

schedule no.

Selection of the associated scheduling agreement. In this view, only the scheduling agreements with the

status "Open" and "Released" are displayed. However, you can only select scheduling agreements with

the status "Released".

Debtor no. This field contains the customer number that you have assigned for the customer in your system.

Usually this data is filled automatically from the related scheduling agreement.

Delivered to

code

Specifies the address to which the products will be delivered. You can use this field to enter a different

delivery address. As a rule, this data is automatically filled from the associated delivery schedule.

Delivered to

Name

Specifies the name of the recipient of the delivery.

Item no. This field contains the article number of the customer article that you have assigned for it in your

system. As a rule, this data is filled automatically from the associated scheduling agreement.

Variant code If necessary, this field contains the code of a variant of the item. As a rule, this data is automatically

filled from the associated scheduling agreement.

Article

description

Specifies the description of the selected item. As a rule, this data is automatically filled from the

associated scheduling agreement.

Item description

2

Specifies an additional description for the selected item. Usually this information is filled automatically

from the related delivery schedule.

Item code Specifies the unit code used when selling the item.

Customer item

no.

This field contains the customer item number.

For this purpose, this must be created beforehand as an article reference. As a rule, this information is

automatically filled from the associated scheduling agreement.

Error description If you execute the "Change status" or "Complete and check" function and the document still has

incomplete or incorrect information, the error descriptions will be displayed in this field.

My supplier no. Indicates the supplier number that your customer has assigned for you. This information is

communicated to you via the incoming documents. This field serves only as an information field.

Call-off no. New Specification of the current PUS. This field must be filled for the document to be accepted.

Call date new Specification of the current call-off date. This field must be filled for accepting the document retrieval.

Plant Indicates a possible plant at the customer. This field is an information field.

Unloading point Indicates a possible unloading point. This field is an information field.

Warehouse

customer

Indicates a possible customer warehouse. This field is an information field.

Point of

consumption

Indicates a possible consumption point. This field is an information field.

Usage key This field is used to define which use the item has. It is used to distinguish uniqueness when the same

item is sent to the same customer to the same delivery address, e.g. once as serial parts and once as

spare parts. The following options are supported:

- blank

- Series

- Replacement general

- Series and use

- Try
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Field Description

- Pilot

- Additional requirements

- Initial sample

- Pattern

- Other

This field is an information field.

Contract/Order

No.

This field corresponds to the document or order number. It is entered in the "External document

number" field when a delivery is made in the created sales order.

Status A PUS can assume the following statuses:

Open:

Is the initial status for new PUS. It indicates that not all fields are correctly defined yet. Therefore, it is

neither demand-triggering nor can a logistics document be created for it.

Accepted:

By changing the status to "Accepted", the incoming requirements are accepted. The status change

creates the corresponding sales order.

Rejected:

Changing the status to "Rejected" deletes the incoming document.

Document

incorrect

If you execute the "Change status" or "Complete and check" function and the document still has

incomplete or incorrect information, the switch is activated. Further information is displayed in the

"Error description" field.
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Inforegister lines

Proposal Incoming call-off documents

Field Description

Type Indicates the type of demand.

Quantity Indicates the number of demand.

Requirement

type

blank:

The quantity is considered as a release quantity and is transferred to the quantity PUS column in the

scheduling agreement.

No need:

This is an informational quantity only and will no longer be included in the delivery schedule.

Backlog:

If no requirement date is entered, the current date is used as the requirement date.

Immediate Need:

If no requirement date is entered, the current date is used as the requirement date.

Preview:

The quantity is viewed as a preview quantity and transferred to the Preview quantity column in the

scheduling agreement.

Requirement

date

Specifies the date when the customer needs the goods.

KW call-off Specifies a call-off period from which calendar week the goods are required.

Call off until KW Specifies a call-off period by which calendar week the goods are required.

Demand month Indicates the month when the goods are needed.

Demand year Indicates the year in which the goods are required.

Requirement

status

The status "B" indicates that FAB data up to this date must be taken over from previous transfers as

constant from you as supplier. This field is an information field.
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The proposal incoming call-off documents shows you all call-off documents of the type "Incoming call-off", "JIT call-off" as well as

PUS in an overview. By means of the filters you can filter this overview individually.

Document actions

With the "Voucher actions" function, you can quickly process incoming vouchers by accepting or rejecting them via the action. To

do this, first check the "Selected document" box in the lines for which the function is to be executed. Then execute the desired

action.

Open

With the action "Open" the respective document is opened

Incoming credit advice

The credit advice note is a possible settlement type to settle delivered quantities from scheduling agreements. Here, no invoice is

sent to the customer (manufacturer), but the manufacturer creates a so-called credit advice based on all delivery bills. This is

entered in the system in the same way as the other documents against the corresponding delivery bills, scheduling agreements

and completed by setting the status to Accepted. 

Please note that the self-billing document in the system is a kind of "information document" and does not replace the billing

document of the traditional sales process. Nevertheless, the posted sales amount should match the credit advice amount.

Incoming transport data

Field Description

Status filter This filter allows you to filter on a specific status of the documents. You can choose from the following:

blank

All document statuses are displayed

Open

All documents of the "Open" status are displayed to you

Accepted

All documents of the status "Accepted" are displayed to you

Rejected

All documents of the "Rejected" status are displayed to you

Document filter This filter allows you to filter on a specific document type. You can choose from the following:

blank

All document types are displayed

Retrieval

All documents of the "Incoming calls" are displayed.

Daily call-off

All documents of the "Incoming JIT delivery schedules" are displayed to you

PUS

All documents of the "Incoming PUS" are displayed to you

Debtor filter With this filter you can filter on documents of a specific customer.

Note
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This area is used to enter the documents for consignment material. The following document types are available:

Incoming message

Damage/Loss

Return

Stock

Departure notification

Delivery notification

A corresponding scheduling agreement number is recorded as a reference. If a document Incoming transit data is accepted, the

system creates a new sales invoice for delivery of the quantity from the consignment warehouse and later billing.

Delivery schedules and logistics

Deliveries cannot be made directly from a scheduling agreement as in a sales order. Logistics documents are always necessary

for this. Normally, however, these are not posted directly either, but are transferred to a shipping order. There, the packaging

regulations come into play and, depending on the delivery quantity, the number of load carriers and packaging materials is

shown as a regulation.

Shipping & Load Carrier

The Shipping & Load Carrier Management module in KUMAVISION factory365 provides the possibility to process packaging.

The packaging can be recorded unspecifically or specifically in the shipping processing order. In addition to the logistics

documents warehouse picking, goods issue and / or picking, posted documents such as posted sales delivery bills, posted stock

transfer outgoing goods and posted return delivery bills can also be transferred to the shipping processing order. When posting a

shipping order, the logistics documents are posted and the interfaces are addressed, e.g. a sales order is automatically generated

by the posting. The load carriers themselves can be disposable or reusable packaging and can therefore be managed with or

without inventory management. In addition, the load carriers can be stored as packaging instructions for the articles. The

packaging instructions are transferred to the shipping orders.

Please note that the Shipping & Load Carrier Management module is an activation module that requires additional licensing.

Establishment

For the scope of functions, some settings must first be made in advance, which will be discussed in more detail below.

Shipping & Load Carrier Setup

The number series must be stored in the shipping & load carrier setup. To do this, call up the "Shipping & load carrier setup" via

the user search.

Shipping processing parameters

• 

• 

• 

• 

• 

• 

Note

Field Description

Shipping order

number

In this field, a series is entered from the number series for the numbers of the dispatch processing

orders.

Output existing

shipping

Activate this switch if you want to receive a message when selecting a logistics document in a

shipping order if it already exists in a shipping order. Otherwise nothing will happen.
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The dispatch processing parameters are used to decide which interface is used with which deliverer or their transport type. In

addition, other important control parameters can be set here.

From version 14.0 on, all interfaces are delivered without additional licensing, but are not further supported or updated. This is due

to the fact that the interfaces were changed spontaneously in the past and KUMAVISION was often not informed about this change

on the part of the deliverer. In order to be put into operation, each feeder is now tested individually and project-specifically. This may

require some effort in terms of customization. A project-specific connection to Beo or ecovium (Vlog) is possible.

Thanks to these control parameters, employees in the shipping department no longer need to worry about how the posting is to

take place. They simply select the carrier and, if necessary, the mode of transport and press "send".

Load carrier

Load carriers are all packages in which articles can be shipped. Via the user search you can call up the "load carriers" and define

them.

Field Description

Interface This field defines which interface is addressed during shipping. For scheduling agreements only the

option "EDI" is to be used.

Delivery code This field defines the deliverer to which the parameters and interface apply.

Note

The delivery agent and the delivery agent transport type are used to define the shipping processing

parameters and thus the interface together with all other sterilization parameters.

Carrier transport

type code

If different transport types are used, these can be specified here.

Sticker only After booking, the shipping label is generated. (Only possible in conjunction with a shipping cut).

Do not create file No file should be created when posting the delivery.

Invoice After posting the delivery, invoicing is also carried out immediately.

Print deliveries When sending, not only the sales order or stock transfer order is created, but also the document is

printed after posting the delivery.

Print invoices After invoicing, the receipt is also printed.

DHL Product ID Parameterization DHL as a deliverer.

DHL Services Parameterization DHL as a deliverer.

DPD Services Parameterization DPD as a deliverer.

DPD export parcel

type

Parameterization DPD as a deliverer.

DPD Collection type Parameterization DPD as a deliverer.

Note
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General

Dimensions

Inventory managed load carriers

Load carriers that are inventory managed must be created as articles. To create a load carrier as an article, select the

appropriate article category code and unit and then execute the "Create article" function in the ribbon.

Packing instruction group

Similar to the suppliers of an item, several different packing instruction groups can also be defined for the instruction types:

Internal

Debtor

Vendor

Field Description

Code Enter a code for a load carrier here. A number series is not available.

Description Enter the description of the load carrier here.

Load carrier type Specify a type of load carrier. You can choose from:

- Single

- Master

- Addition single

- Addition master

Reusable load

carrier

Activate the switch as soon as a returnable load carrier (e.g. Euro pallet) is involved.

Label ID This field is the same as the report selection in sales or purchasing. It controls which report will be

printed for the load carrier.

Stock Indicates, if the load carrier is inventory managed, the current stock level of the item.

Item no. Indicates the article number, if the load carrier is inventory-managed.

Item Template

Code

Specifies, if the load carrier is inventory managed, the appropriate configuration template for the

associated item.

Unit Specifies the unit of the charge carrier.

Field Description

Length Specifies the length dimensions of the load carrier

Wide Indicates the width dimensions of the load carrier

Height Indicates the height dimensions of the load carrier

Weight Indicates the weight of the load carrier

• 

• 

• 
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To define the packing instruction group, call it up via the user search. Via "New" in the menu ribbon you can create a new

packing instruction group with the help of the table below.

Packing instruction

The actual regulations, i.e. which load carriers are to be used in what quantity, are defined in the packaging regulations. 

To define the packing instructions, call them up via the user search. 

The "General" area initially contains, among other things, filter options which you can use to filter for specific packaging

regulations.

Field Description

Packaging

specification group

This field defines the code for the group.

Packing instruction

type

There are the options:

Internal

This group is used internally. There is currently no use for it.

Debtor

This group is used for debtors.

Vendor

This group is used for creditors

Packaging instruction

code

Depending on the packing instruction type, this field defines a concrete customer or vendor.

Item no. This field defines the article for the regulation group.

Start date This date can be used to define from when this group is valid.

End date This date can be used to define until when this group is valid.

Standard One group per packing instruction type can be defined as the default. This is then automatically

used when transferring logistics documents to a shipping processing order.

Description Here the group can be described.

Field Description

Item no. Filter This filter allows you to filter on a specific item number.

Packing prescription type

filter

This filter allows you to filter on a specific packaging prescription type. You can choose from

the following options: 

- Internal

- Debtor

- Vendor

- None

Packing instruction code

filter

This filter allows you to filter on a specific packing instruction code.

Packing instruction group This filter allows you to filter on a specific packing instruction group
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According to the filtering in the "General" section, the corresponding records will be displayed in the rows.

Consignment processing

If the "Consignment processing" field is set on a scheduling agreement, a transfer order is created instead of a sales order when

a delivery is made via Logistics. The following facilities are required in advance for this:

Delivery schedule facility

For this purpose, a transit storage location must be specified as a default in the "Default in Transit Code" field in the scheduling

agreement setup. Call this up via the user search.

Origin storage locations

Origin storage locations define different storage locations such as consignment stores. They are defined for debtors, creditors

and possibly for work center groups for external work and articles for the different business transactions.

Create logistics documents

Field Description

Packing

instruction type

Specifies the packing instruction type. The following are available for selection:

Internal

This group is used internally. There is currently no use for it.

Debtor

This group is used for debtors.

Vendor

This group is used for creditors

Load carrier type Specifies the type of load carrier. The following option types are available:

Single

Corresponds to a charge carrier and is used either individually in a group or several times in

combination with a master.

Master

Corresponds to a load carrier that represents the lowest unit, such as a pallet. Is defined only once for

a group.

Addition single

Corresponds to additional packaging for a single such as a lid on a KLT (small load carrier).

Addition master

Corresponds to additional packaging for a master such as a false bottom or wrapping the entire pallet.

Quantity This field contains the quantity of the charge carrier for the group.

Rounding factor

quantity

This field can be used to round the load carriers.

Example:

The quantity is 4, because 4 singles are placed on one pallet. However, up to three levels can be

placed on one pallet. To ensure that each level is always filled with 4 load carriers (and possibly also

empty load carriers) for stacking, the rounding factor Quantity is also set to 4. This means that there

are either 4.8 or 12 single load carriers on a pallet.

Item quantity per

load carrier

This field defines the quantity of items that a load carrier contains.

Label ID This field can be used to define the report for the label for exactly this regulation, in contrast to the

"Label ID" field of the load carrier.
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Logistics documents are always required for an outbound delivery on scheduling agreements. Depending on the settings of the

storage location, these are:

Warehouse picking

Outgoing goods

Outgoing goods and picking

The only difference from the standard is that the scheduling agreement is another source document for selecting origin

documents.

Shipping processing order

The shipping order does not replace the logistics documents goods issue and warehouse picking, it supplements them. It

primarily serves to enable a clean recording and presentation of the load carriers for a goods issue. Different load carriers can be

recorded and displayed for each item listed.

A new shipping order is entered by calling up "Shipping order" via the user search. After creating a new order, the logistics

documents can be transferred either via the function "Get goods issue" or "Get warehouse picking".

Then the delivery condition code is entered. The "Delivery code" and "Delivery transport code" selections are used to define the

shipping processing parameters. The "Pickup date" and the "Pickup time" can be entered under the "Additional information" info

tab.

The field "Pickup date" is used on the EDI labels for the goods tag. If this field is empty, it will also be empty on the labels.

If the quantity of the articles is corrected here again, the packing instructions must be recalculated and taken over via the

function "Determine packing instructions".

The actual dispatch then takes place via "Send order". The system first checks whether all requirements have been met. With the

EDI interface, the necessary numbers of package tracking numbers are now drawn from the number series for each load carrier.

If a label has a label report stored in the "Label ID" field, the label is printed out.

The logistics documents are then posted. If the source origin is still a scheduling agreement, either a sales order or, in the case of

consignment processing, a stock transfer order is created and posted as a delivery.

Finally, the shipment processing order itself is archived and, if necessary, the reports for the goods receipt/issue slip and bill of

lading/shipping order are printed.

Cumulative Quantity Management

Cumulative Quantities Management is used to manage cumulative quantities and thus extends the scope of delivery schedules.

The cumulative quantity management enables a transparent display of the current processing status of scheduling agreements.

Logistics can thus be controlled on the basis of the difference between the company's own cumulative quantity and the

customer's cumulative quantity. A reset or correction can be made at any time or periodically.

Progress figures Proposal

The cumulative quantities proposal shows the current statuses of scheduling agreements. The displayed scheduling agreements

can then be corrected or zeroed out. You can limit the display accordingly by using appropriate filter criteria. You can call up the

cumulative quantities proposal using the search term of the same name via the user search.

You can assign your own proposal names to indicate what type of proposal it is. The name will appear later in the journal. After

selecting the template, the actual proposal window appears.

Using the "Generate proposal" function, you can now filter out the scheduling agreements that need to be corrected. For this

purpose, another window is available in which you can set defaults accordingly.

On the "Options" tab, you can set a date filter. This takes into account all customers who have entered a zero date cumulative

quantity on the customer card under the "Scheduling agreement" info tab in the period entered.

• 

• 

• 

Note
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After corresponding input and acceptance with "OK", the scheduling agreements are displayed.

After editing the scheduling agreements, they must be registered. You can perform the registration via the menu item "Register".

Progress Notes Journals

All registered cumulative quantities are listed in the journals. You can access the individual cumulative quantity items by using

the LookUp function in the "From current no." and "To current no." fields.

PURCHASING DELIVERY SCHEDULE

Setup

Purchasing delivery schedule setup

In the Purchasing Supply Schedule Setup, the basic setups are made.

General

Information register numbering

User setup

In the user setup, the following settings related to the purchasing delivery schedule can be maintained per user:

Inforegister General

Master data

Vendor

field description

Plant In this field the plant number of the client can be stored. The value is used as default for the new creation

of a purchase delivery schedule.

Unloading

point

In this field the unloading point of the client can be stored. The value is used as default for the new

creation of a purchasing scheduling agreement.

Field Description

Supply plan numbers This field can be used to store the number series for the supply plans on the purchasing side.

Delivery schedule

numbers

This field can be used to store the number series for the delivery schedules on the purchasing

side.

field description

Purchasing delivery

schedule changed reset

If this facility is activated for a user, the user can manually override the "Changed" check mark

in the purchasing scheduling agreement.

Delete active purchase

scheduling agreement

items

In the purchase scheduling agreement, the function "Delete purchase scheduling agreement

lines" can be used to control whether all active purchase scheduling agreement items for this

purchase scheduling agreement should be deleted. This function can only be executed by users

who have been authorized to do so at this point.
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On the vendor card, the following must be defined for the processing of purchase scheduling agreements on the "Purchase

scheduling agreement" info tab:

Item

field description

Purchasing scheduling

agreement preview

quantity week

In the standard of Microsoft Dynamics 365 Business Central1, requirements are always defined

exactly to one day. In the preparation of delivery schedules, it is common to provide more distant

requirement dates with the specification of calendar weeks or month specifications. In the field

can be defined therefore with a classical date formula, starting from which date the requirements

are represented summarized on week level in the forecast delivery schedule.

The value of the field is inherited with the new creation of a purchase scheduling agreement after

selection of the vendor number and can be changed in the purchase scheduling agreement, if

desired, manually.

Purchasing Scheduling

Agreement Preview

Quantity Month

In the standard of Microsoft Dynamics 365 Business Central1, requirements are always defined

exactly to one day. In the preparation of delivery schedules, it is common to provide more distant

requirement dates with the specification of calendar weeks or month specifications. In the field

can be defined therefore with a classical date formula, starting from which date the requirements

are represented on month level summarized in the forecast delivery schedule.

The value of this field is inherited with the new creation of a purchase scheduling agreement after

selection of the creditor number and can be changed in the purchase scheduling agreement, if

desired, manually.

Production release

period

When delivery schedules are transmitted to a supplier, a so-called production release period is

specified.

The specification in Microsoft Dynamics 365 Business Central1 can be defined with a classic date

formula.

The value of the field is inherited when a new purchase scheduling agreement is created after the

vendor number is selected and can be changed manually in the purchase scheduling agreement if

desired.

The value of the field is inherited when a new purchase scheduling agreement is created after the

vendor number is selected and can be changed manually in the purchase scheduling agreement if

desired.

The value of the field is inherited when a new purchase scheduling agreement is created after the

vendor number is selected and can be changed manually in the purchase scheduling agreement if

desired.

Material release period When transmitting delivery schedules to a supplier, a so-called material release period is included.

The specification in Microsoft Dynamics 365 Business Central1 can be defined with a classic date

formula.

The value of the field is inherited when creating a new purchasing scheduling agreement after

selecting the vendor number and can be changed manually in the purchasing scheduling

agreement, if desired.

The value of the field is inherited when creating a new purchasing scheduling agreement after

selecting the vendor number and can be changed manually in the purchasing scheduling

agreement, if desired.

The value of the field is inherited when creating a new purchasing scheduling agreement after

selecting the vendor number and can be changed manually in the purchasing scheduling

agreement, if desired.
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On the item card, the following must be defined on the "Stock" info tab for the processing of purchase scheduling agreements:

Purchasing scheduling agreement

When creating a purchasing scheduling agreement, the following fields can be maintained or are visible.

field description

Quantity in Purchase

Scheduling Agreement

In this field it is possible to see on the item card if there are purchase scheduling agreement

lines for this item. The field displays the total of all purchase scheduling agreement lines with a

view to the "Remaining scheduling agreement quantity" field.
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General
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field description

No. The number for a purchasing scheduling agreement is taken from the stored number series

when it is created. If it is defined in the facility, the number can also be entered manually or

overwritten manually.

Depos. from credit no. In this field the vendor number is selected, with which a corresponding contract is defined.

Article no. This field is used to select the article number for which a corresponding contract is defined.

Article Description This field displays the article description from the article card.

Article Description 2 This field displays the article description 2 from the article card.

Article No. 2 If a second article number is maintained for the article, this number will be displayed here.

Purchase unit code The purchase unit code from the article card is displayed in this field.

Variant Code If variants are defined for the article, the appropriate variant for this purchasing delivery

schedule can be selected in this field.

Credit item no. In this field, the vendor article number required for this purchasing supply plan can be stored.

In this case it is necessary to refer to the article reference overview. I.e. only numbers defined

in the table can be selected.

Storage location In this field, the storage location can be stored for which the determined requirement is to be

assigned.

Storage bin code In this field the storage bin code can be stored, on which the goods receipt or the stock

placement is to be booked in. This value is only a template and can be overwritten in the

respective logistics documents.

Vendor Order No. The order number of the scheduling agreement on the supplier side can be stored in this field.

Plant The field "Plant" is preset when creating a purchasing scheduling agreement based on the

purchasing scheduling agreement setup. The value can be changed manually.

Unloading point The "Unloading point" field is preset based on the purchasing delivery plan setup when a

purchasing delivery plan is created. The value can be changed manually.

Status A purchasing delivery plan can have the following statuses:

New

The status "New" is automatically preassigned if a new purchasing delivery plan is created.

Open

The status "Open" must be selected manually using the "Change status" function. This is

necessary, for example, if subsequent changes are to be made to the purchasing scheduling

agreement. 

Released

The status "Released" must be selected manually via the "Change status" function. This is

necessary because only purchasing scheduling agreements with the "Released" status are

processed.

Note:

In the "Released" status, the fields in the purchasing scheduling agreement cannot be

changed. Two exceptions apply here. The "Locked" and "Problematic" fields can also be

changed in the "Released" status.

Exited

Purchasing scheduling agreements that are no longer to be processed by the system can be

set to the "Exited" status.
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field description

Language Code In the field, the language code "DEU" or "ENG" can be used to control whether the report for

the forecast delivery schedule is to be output in German or English.

Blocked A purchasing scheduling agreement can be manually set to "Blocked".

A purchasing scheduling agreement that is marked as blocked will not be considered in the

order proposal.

No forecast delivery schedule can be generated for a purchasing scheduling agreement that

is marked as blocked.

Requirements from a purchasing scheduling agreement that is marked as blocked will not be

included in the item availability.

Changed This field keeps track of whether there has been a change in the requirements after the last

delivery schedule creation. If so, the field is enabled.

This field can be manually changed, provided that a corresponding facility is enabled for users

in the user facility.

Note:

Manually overriding the field should only be done in exceptional cases and with caution.

Changed by This field keeps track of which user created a change for this purchasing scheduling

agreement.

Changed on This field keeps track of the day on which a change was created for this purchasing

scheduling agreement.

Problematic A purchasing scheduling agreement can be flagged as problematic. 

A purchasing scheduling agreement marked in this way will also receive a corresponding

marking in the processing in the order worksheet.

Production Release Period The value of the field is inherited when a new purchasing scheduling agreement is created

after the vendor number is selected and can be manually changed in the purchasing

scheduling agreement, if desired.

It is specified in Microsoft Dynamics 365 Business Central1 using a classic date formula.

Material Release Period The value of the field is inherited when a new purchasing scheduling agreement is created

after the vendor number is selected and can be manually modified in the purchasing

scheduling agreement, if desired.

The specification in Microsoft Dynamics 365 Business Central1 is made with a classic date

formula.

Date of Last Outbound

Delivery Schedule

This field records the date when the last delivery schedule was changed from "Shipped" to

"Shipped" status. 

Note:

A field is also available in the background in which the time is also recorded.

Purchaser Code The value of the field is inherited when a new purchasing supply plan is created after the

vendor number is selected and can be manually changed in the purchasing supply plan, if

desired.

Assigned User ID The value of the field is filled with the user ID when a new purchasing supply plan is created

and can be changed manually in the purchasing supply plan if desired.

Preview quantity (week)
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Lines

field description

The value of the field is inherited when a new purchasing supply plan is created after the

vendor number is selected and can be manually modified in the purchasing supply plan, if

desired. 

It is specified in Microsoft Dynamics 365 Business Central1 using a classic date formula.

Preview quantity (month) The value of the field is inherited when a new purchase delivery plan is created after the

vendor number is selected and can be changed manually in the purchase delivery plan, if

desired. 

The specification in Microsoft Dynamics 365 Business Central1 is done with a classic date

formula.

Creation Date This field records when the purchasing scheduling agreement was created.

Valid until In this field, a date can be stored until which the corresponding contract is valid.

Note:

This field has only an informative character. I.e. as long as the status is set to "Released", the

purchase scheduling agreement would continue to be considered in the purchase order

worksheet, even if this date has been exceeded.

Target Quantity This field can be used to store the target quantity for this contract.

Automatic release of

outgoing delivery

schedules

This field can be used to define whether a created delivery schedule should be released

automatically.
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The lines in the purchasing scheduling agreement are for user information only. Manual creation of lines is not provided for in the

purchasing scheduling agreement. Also a change on field level in the lines is not intended. The lines are created or updated, if

necessary, by processing in the purchase order worksheet.

Note

Field Description

Expected Goods

Receipt Date

This field displays the expected goods receipt date. The date will be passed from the purchase order

worksheet line to the purchase delivery schedule line.

Desired Goods

Receipt Date

This field displays the desired goods receipt date. The date will be transferred from the purchase order

worksheet line to the purchase scheduling agreement line.

Quantity This field displays the quantity. The quantity is transferred from the purchase order worksheet line to

the purchase delivery plan line.

Quantity collected The goods collected via goods receipt or stock placement with reference to the purchasing delivery

plan are offset against the purchasing delivery plan lines and displayed per line. Thus it can be

recognized per line whether the respective line was not delivered at all, partially or completely.

Remaining order

quantity

This field displays the remaining delivery schedule quantity. The field is calculated by the formula

"Quantity - Quantity delivered"

Target cumulative

quantity

This field displays the expected target cumulative quantity. This field is calculated line by line. The first

purchase scheduling agreement line calculates the value "Act. Cumulative Quantity + Remaining

Scheduling Agreement Quantity". In the following lines, the field is calculated as follows: "Target

cumulative quantity previous line + remaining delivery plan quantity".

Manually Created This field indicates whether the line has been created manually in the purchase order worksheet.

Note:

For lines that have been created automatically by the purchase order worksheet, this field will also be

checked if a manual correction has been made in the "Quantity" field.
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Delivery

These fields are required for scheduling due dates in the purchase order worksheet. The calculation is done as usual in the

standard of Microsoft Dynamics 365 Business Central1.

Infoboxes

The following infoboxes are available for a purchasing delivery schedule:

Purchase cumulative quantities.

The following fields are displayed in the infobox:

Price Information

field description

Incoming. Stock

lead time

This field is used to define the existing stock lead time.

The value of the field is inherited when a new purchasing delivery schedule is created after the

storage location code has been selected and can be changed manually in the purchasing delivery

schedule if desired.

The value of the field is inherited when a new purchasing delivery schedule is created after the

storage location code has been selected and can be changed manually in the purchasing delivery

schedule if desired.

Procurement time This field is used to define the procurement time.

The default value of the field is inherited after updating the fields: Item number, storage location,

variant and can be modified manually if desired.

Sec.-Zuschl.

Beschaff.

This field is used to define the safety surcharge procurement period.

The value of the field is inherited when a new purchasing scheduling agreement is created after the

article number has been selected and can be changed manually in the purchasing scheduling

agreement if desired.

The value of the field is inherited when a new purchasing scheduling agreement is created after the

article number has been selected and can be changed manually in the purchasing scheduling

agreement if desired.

Field description

Last Delivery No. This field displays the last delivery note number (posted purchasing delivery) that has been posted

to this purchasing scheduling agreement.

Last Ext. Delivery

No.

This field displays the last external delivery note number that has been posted to this purchasing

scheduling agreement.

Last Delivery Date This field displays the posting date from the associated posted purchasing delivery.

Last Delivery

Quantity

This field displays the last delivery quantity.

Current cumulative

quantity

This field displays the current cumulative quantity. This is the total of all quantities received for this

purchasing scheduling agreement, taking into account any manually maintained cumulative quantity

corrections.

Last cumulative

quantity sent

This field displays the cumulative quantity that was sent to the vendor with the last forecast delivery

schedule.
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The following fields are displayed in the info box:

For the determination of the values, the system creates a temporary purchase order for the combination vendor/article/variant with

the quantity 1 and on the work date.

The calculation or update is always done when the purchasing scheduling agreement is released.

Storage data

The following information of the inventory data card is displayed in the info box:

Management purchase delivery schedule

Status change

Field Description

EK-Price The EK-price is displayed.

Line discount % The percentage line discount is displayed.

Currency Code The currency code is displayed.

Stock The stock for the combination item/variant/storage location is displayed.

Note

Note

field description

Storage Location The stored storage location for this purchasing supply plan.

Stock level The stock level for this item or variant at the respective storage location.

Safety Stock The stored safety stock on the inventory data card.
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A status change can be called up via the "Change status" function in the menu ribbon. A purchasing scheduling agreement has

different statuses:

Uniqueness of scheduling agreements

When the status changes to "released", a uniqueness check is performed. According to the rule for forecast delivery schedules, a

forecast delivery schedule must refer to the following order terms

plant customer

Customer part number

Contract/order number

unloading point

be clearly identifiable.

The closing/order number is the number of the purchase scheduling agreement.

If an error is detected during this check, the following note message is issued: "Purchasing scheduling agreement xxxxx already

exists with the same uniqueness criteria. Finish the other one first."

Since requirements determination in Microsoft Dynamics 365 Business Central1 takes place on a storage location basis, if there are

different storage locations, there may be corresponding purchasing scheduling agreements for which the previously mentioned

ordering terms are identical.

status description

New A newly created purchasing delivery plan is initially given the status "New".

Open If a change is to be made to a purchasing scheduling agreement that already has the status "Released",

the status must be reset to "Open". Only then can changes be made.

Released In the "Released" status, the purchasing scheduling agreement is active. On the one hand, this means that

no changes can be made to the fields in this status. Two exceptions apply here. The fields "Blocked" and

"Problematic" can also be changed in the status "Released".

Further, the status "Released" is important for the interaction with the logistics documents. As with

conventional purchase orders, only purchasing scheduling agreements can be brought into a goods

receipt or warehouse putaway if the status is "Released".

The "Released" status is also important for requirements determination. Requirements determination in

the Purchase Order Worksheet only checks against purchasing scheduling agreements with the status

"Released". If no suitable purchasing scheduling agreement with the status "Released" is found for the

lines created in the purchase order worksheet, the requirements are not created as forecast delivery

schedules, but as "normal" purchase orders.

Finished If a purchasing scheduling agreement is no longer needed, the status can be set to "Finished".

Note:

A created purchasing scheduling agreement for which items already exist cannot be deleted. I.e. also such

purchase scheduling agreements must be set to the status "Finished".

Once a purchase scheduling agreement has been set to the status "Finished", the status can no longer be

changed back to one of the other statuses.

• 

• 

• 

• 

Note

Note
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Delivery schedule text

A delivery schedule text can be defined for a purchasing delivery schedule using the "Purchasing delivery schedule text" function

in the menu ribbon. 

Further processing or output of these texts is not provided for the time being.

Delivery schedule text

For the delivery schedules generated from a purchasing scheduling agreement, a delivery schedule text can be defined using the

"Delivery schedule text" function in the menu ribbon. 

This text will then be printed on the paper document "Purchasing delivery schedule".

A transfer of these texts to the EDI message "Delivery instruction" is not provided in the solution.

Purchasing Delete scheduling agreement lines

Requirements are only ever transferred to the purchasing scheduling agreement via the purchase order worksheet. There is no

provision for manual editing at line level in the purchasing scheduling agreement.

In rare cases, it may happen that the requirements are no longer needed. Provided users have the appropriate authorization, the

"Delete purchasing scheduling agreement lines" function can be used to delete all active scheduling agreement lines for this

purchasing scheduling agreement. The authorization can be controlled via the button "Delete active purchasing scheduling

agreement items" in the user authorization.

Outgoing documents

Via the call "Outgoing documents" in the menu ribbon, all created purchase delivery schedules for the respective purchase

delivery schedule can be displayed.

Dimensions

If dimensions are to be used on the purchasing side, the desired dimensions for the respective purchasing scheduling agreement

can be viewed or maintained via "Dimensions".

Change cumulative quantities

In some cases, it may be necessary to manually adjust the cumulative quantity of a purchasing scheduling agreement. For

example, a running cumulative quantity must be predefined if a purchasing scheduling agreement is newly created in the system

but has already been delivered to. Or a manual correction of the cumulative quantity must be made if incorrect purchasing

deliveries are made. The correction or pre-entry can be made using the "Change cumulative quantities" function.

Open purchase orders

The "Open purchase orders" call displays all purchase orders that have not yet been deleted and that exist for the selected

purchasing scheduling agreement.

Deliveries

The call "Deliveries" displays all posted purchase deliveries that exist for the purchase delivery plan.

Invoices

The call "Invoices" displays all posted purchase invoices that exist for the purchase delivery plan.

Active purchasing scheduling agreement items

Note

Note
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The "Active Purchasing Scheduling Agreement Items" call can be used to view detailed information about the current purchasing

scheduling agreement lines.

Non-active scheduling agreement items

The "Inactive Scheduling Agreement Items" call can be used to view all historical scheduling agreement items for the selected

purchasing scheduling agreement.

Purchase prices

The call "Purchase prices" displays the stored prices for the combination vendor/article/variant.

Purchasing line discounts

The call "Purchase line discounts" displays the stored line discounts for the combination vendor/article/variant.

Item availability by

From the purchasing delivery schedule, the "Article availabilities by" known from the standard of Microsoft Dynamics 365

Business Central1 can be called up.

Manage cumulative quantities

Cumulative quantity management

The cumulative quantity in Microsoft Dynamics 365 Business Central1 is automatically managed for each purchasing delivery

schedule. With each posted purchase delivery that references a purchase delivery plan, a cumulative quantity item is

automatically created for that purchase delivery plan. The total of all cumulative quantity items is displayed in the "Cumulative

quantity" field on the information page for a purchasing supply plan.

Corrections to cumulative quantities

From time to time, the cumulative quantity of a purchasing scheduling agreement may need to be adjusted. For example,

because the current cumulative quantity needs to be carried forward for an ongoing purchasing delivery schedule that is created

in Microsoft Dynamics 365 Business Central1. Or for a purchasing scheduling agreement that has been running for a long time,

the cumulative quantity is to be zeroed out on a key date. 

A manual correction of the cumulative quantity is also necessary for an accidentally posted purchasing delivery bill with reference to

a purchasing scheduling agreement. Even if it is still possible to cancel the line or lines in the posted purchasing delivery, the

cumulative quantity items formed are not automatically corrected.

Transfer of cumulative quantities

When a forecast delivery schedule is created for a purchasing scheduling agreement, the cumulative quantity valid at that time is

transferred to the forecast delivery schedule. The cumulative quantity is then (along with some other information) sent to the

vendor on the printed or EDI delivery schedule. The supplier then uses this information to determine the "goods in transit" and

can use the information to allocate the requirements in his ERP system.

Transfer requirements to the purchasing scheduling agreement via the purchase order worksheet

Determining requirements for the purchasing scheduling agreement via the purchase order worksheet

To determine current requirements, the purchasing scheduling agreement uses the standard purchase order worksheet. This

means that the determination is used via the replenishment procedures or replenishment parameters of the articles or the

inventory data card known in the standard system.

When calculating the current requirements, Microsoft Dynamics 365 Business Central1 takes into account the existing

requirements planners. The existing purchasing scheduling agreement lines naturally also represent requirement coverers.

Therefore, the calculations of the requirements have been changed so that the existing active purchasing scheduling agreement

items are also included in the calculation as requirement coverers.

Note
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However, since the standard of Microsoft Dynamics 365 Business Central1 does not recognize purchasing scheduling

agreements, the function has been extended in such a way that after the determination of the requirements per line, it is checked

whether a released purchasing scheduling agreement exists for the combination "vendor/article/variant/storage location". If this

is the case, a reference to the respective purchasing scheduling agreement is created for the line.

When the "Execute event notification" function is executed, no new purchase order is created or existing purchase order lines

are changed or deleted for this line; instead, new or changed lines are created for the specified purchasing scheduling

agreement.

Enhancements to the purchase order worksheet for the purchasing scheduling agreement.

The purchase order worksheet has been enhanced with respect to purchasing scheduling agreements as follows:

In the purchase order worksheet, the information page "Purchasing delivery schedule information" can also be called up.

In the info box, line information from the purchasing scheduling agreement is displayed for each selected order worksheet line.

The info box is only calculated if the selected line in the purchase order worksheet is a line with reference to a purchasing

scheduling agreement.

In the info box, the fields "Desired goods receipt date", "Quantity", "Quantity delivered" and "Remaining order quantity" of the

purchasing scheduling agreement lines are displayed.

Handling manual requirements

As previously described, manual maintenance is not possible at the purchasing scheduling agreement line level.

However, if desired, requirements can be manually adjusted and transferred to a purchasing scheduling agreement. In the

purchase order worksheet, all calculated requirements can be manually adjusted or requirements can be manually added. These

manually created purchase order worksheet lines are also checked by the system for reference to a purchasing scheduling

agreement and assigned.

As in the standard system, manual maintenance in the purchase order worksheet should only be used with caution, since the next

calculation of a purchase order worksheet usually results in these manual adjustments being suggested as cancellations.

"Execute event message" function

The function "Execute event message" has been adapted so that no purchase orders are created or changed for purchase order

worksheets with the reference type "Purchasing scheduling agreement", but new lines are generated in the purchasing

scheduling agreement or existing lines are adjusted or deleted.

Furthermore, when lines are changed in the purchasing scheduling agreement, the "Changed" indicator is activated in the

purchasing scheduling agreement header.

field description

Purchasing Scheduling

Agreement No.

The purchasing scheduling agreement number is displayed in the field if a purchasing

scheduling agreement is found for the line.

Ref. Order Type The field Reference Order Type has been extended by the entry "Purchasing Scheduling

Agreement", so that it can be recognized in the field whether the line is a purchasing scheduling

agreement.

Problematic If the line refers to a purchasing scheduling agreement that is marked as "Problematic", the

value "Yes" is entered in this field. This allows MRP controllers to filter on these rows and

manually check MRP suggestions.

Manually created If lines for a purchase delivery schedule are created manually, or if a calculated line is manually

changed in quantity or date, this is documented in the field "Manually created".

Note
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Handling reservations

As on the scheduling agreement page in sales, requirements cannot be reserved in the purchasing scheduling agreement. 

Therefore, items used for a purchasing scheduling agreement should not be planned with the "Order" replenishment procedure.

Even if an article has the "order" replenishment procedure, no reservations are generated for the purchasing scheduling

agreement lines.

Create and manage delivery schedules

Generate delivery schedule

The creation of a forecast delivery schedule is always done manually by the user. In doing so, users can choose whether a

forecast delivery schedule should be created for only one or for multiple purchasing scheduling agreements by using the filter

options known in Microsoft Dynamics 365 Business Central1. In practice, it is usually filtered to one vendor and all new purchase

delivery schedules are created for one vendor. 

Regardless of the filtering, new delivery schedules are only created for purchasing scheduling agreements for which the "Changed"

field in the header of the purchasing scheduling agreement is activated. This avoids that "new" delivery schedules are sent by

mistake, where the quantities and date information are identical to the previous delivery schedule.

If you want to deliberately create a new "identical" forecast delivery schedule, the "Changed" field in the purchasing scheduling

agreement must be activated.

If a new forecast delivery schedule is created for a purchasing scheduling agreement, the "Changed" field in the header of the

purchasing scheduling agreement is deactivated again afterwards.

Edit delivery schedules

The delivery schedule is referred to as an "Outgoing document". If the "Automatic release of outgoing delivery schedule" switch is

not activated in the purchasing scheduling agreement, the generated delivery schedule is first created with the status "Pending".

Among other things, fields are created in the forecast delivery schedule. Except for changing the status, no changes can be made in a

delivery schedule. The delivery schedule can be viewed like a "posted document" in Microsoft Dynamics 365 Business Central1.

Note

Note
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General
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field description

No. The number for a delivery schedule is drawn from the stored number series

when it is created.

Call date new This field is used to select the vendor number with which a corresponding

contract is defined.

Call-off no. The respective call-off number is mapped in this field for each purchasing

delivery schedule. I.e. the value is set to 1 with the first created call-off and

then always increased by the value "1".

Supply schedule number

In this field the purchase delivery schedule

number is recorded, to which this delivery

schedule refers.

Supplier

Order Address Code

Ind. of Name

Article No.

Variant Code

Article Description

Article Description 2

Article Unit Code

Vendor Article No.

Plant

Unloading Point

Your Reference

Target Quantity

The fields are taken from the respective linked purchasing delivery

schedule and displayed.

Status The status is changed manually. A delivery schedule has the following

statuses:

Pending

A newly created delivery schedule usually receives the status "Pending". 

Shipping

The forecast delivery schedule can then be manually set to the status

"Shipping".

In the status, the forecast delivery schedule can be sent as paper or a

transfer via EDI can be performed. 

Note:

Sending via EDI is to be implemented on a project-specific basis and is not

a component of the Scheduling Agreement Management module.

Sent

The forecast delivery schedule has been sent.

Rejected

If a forecast delivery schedule has been created incorrectly, the forecast

delivery schedule can be set to the "Rejected" status.

The forecast delivery schedule can be set to the "Rejected" status.

Created on The date when the delivery schedule was created is recorded.<br

Created by The user code that created the delivery schedule is recorded.

Status change on
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Lines

Delivery

The fields on the "Delivery" info tab are taken from the respective linked purchasing delivery plan and displayed.

Cumulative quantities

The fields are taken from the respective linked purchasing scheduling agreement and displayed when the delivery schedule is

created.

Manage delivery schedules

A delivery schedule can be manually changed to various statuses. To do this, the "Change status" function can be called up

manually.

field description

The date when the status of the delivery schedule was last changed is

recorded.

Status change from The user code that last changed the status of the delivery schedule is

recorded.

Sent on The date when the delivery schedule was sent is recorded.

Sent by The user code that sent the delivery schedule is recorded.

Field Description

Quantity The quantity of the delivery schedule line is displayed.

Requirement

type

The solution distinguishes the following requirement types:

empty

Any "normal" requirement receives the requirement type "empty". This means all requirements that are

in the future at the time of creation of the delivery schedule but are not defined as preview.

Backlog

All requirements that have an expected goods receipt date "smaller" than the work date at the time of

creation of the delivery schedule are marked as backlog. 

Immediate requirements

All requirements are marked as immediate requirements, which have an expected goods receipt date

equal to the work date at the time of creation of the forecast delivery schedule.

Preview (week)

At the time of creation of the forecast delivery schedule, it is checked whether the goods receipt date is

greater than the date from "work date + date formula preview quantity week from EK delivery schedule

". Further the date may not be however also larger than the date "work date + date formula preview

quantity month".

If this applies, the line is set to the requirement type "preview (week)". In this case, the requirements are

displayed totaled from the week.

Preview (month)

At the time of creation of the delivery schedule, it is checked whether the goods receipt date is greater

than the date from "Work date + date formula preview quantity month from EK delivery schedule ". 

If this applies, the line is set to the requirements type "Preview (month)". Thereby the requirements are

shown summed up from the month.

Requirement

date

This field displays the requirement date of the respective line.
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Send delivery call-offs

A delivery schedule in the status "in dispatch" can be printed out conventionally on paper or sent as a PDF attachment by e-mail.

Dispatch via EDI is provided for via the EDX module, but must be implemented on a project-specific basis.

Post goods receipt or warehouse storage

Analogous to the sales scheduling agreement, it is not possible to collect requirements for a purchasing scheduling agreement

directly in the purchasing scheduling agreement.

The collection must therefore take place via a standard logistics option in Microsoft Dynamics 365 Business Central1. The

determination of which method is to be used is made via the control indicators on the storage location map. 

This means that in both putaway and goods receipt, the "Scheduling Agreement Management" module has been extended so that

collection is also possible on the active scheduling agreement items.

When posting the putaway or the goods receipt, a suitable purchase order document with reference to the respective purchase

scheduling agreement item is created and posted in the same way as the sales scheduling agreement. Thus, the addition of the

items takes place via the standard routines of Microsoft Dynamics 365 Business Central1.

Process purchase invoices for purchasing scheduling agreements

Purchase invoices for purchasing scheduling agreements can be created and posted as usual either directly via the purchase

order or via the purchase invoices and the "Get goods receipt lines" function.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

1. 
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Calculation

GENERAL

With the help of the calculation you can make the following business evaluations and calculations directly in KUMAVISION

factory365:

Regular item costing with highlighting of variances.

Quotation costing

Development calculation

Co-calculation

Calculation up to the target price

Access protection of the calculation data

Separate reporting of costs

Calculation with planned values

Extension to include cost elements in the single-level as well as multi-level area (e.g. "material overhead")

You need separate licenses before you can use Calculation function.

Production costing

The production costing is primarily used to determine the production costs / cost of goods sold as well as the sales price for an

article. These values can then be transferred to the corresponding price fields on the article card. 

The result of this calculation can also be used for the valuation method "Standard" for the bearing valuation.

Furthermore, simulations can also be carried out in the cost of goods manufactured in the event of changes in purchase prices,

labor time prices or overhead rates.

Development calculation

When creating new products, not all parts list items or work plan items are always known or their prices have not yet been

determined. However, it is necessary to know the approximate manufacturing costs at an early stage and also to determine a

sales price.

To make this possible, a "Simulated production order (cost estimate)" can be created manually for such an article. The known

information from the routing and bill of materials is used. These values can then be changed as desired.

In addition, there is the possibility to manually. "Additional costs" with quantities, times and prices and, if required, the

"Overhead rates" can be adjusted or supplemented.

Quotation costing

For make-to-order manufacturers, the challenge is to perform calculations for individual customer orders as efficiently and

accurately as possible. Therefore, KUMAVISION factory365 can provide the calculations for similar projects or articles as a basis

via the Smart Start packages. Based on this, employees can calculate different variants without having to start from scratch. This

means a significant time saving compared to before. This also comes into play for old, already expired offers. A new calculation

can be created with just a few entries, as only the new prices need to be transferred. For contract manufacturers, transparency is

another important factor. With the old calculations stored, sales staff can explain to customers, item by item, why there is a price

difference compared to previous quotations. This is also important for projects that run over a longer period of time: If deviations

from the original quotation occur during the course of the project, the customer can be told in detail what the causes are at the

touch of a button. This is because the concurrent costing does not use the theoretical planned values, but the current actual

values.

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note
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Bearing evaluation

The material overhead costs can be entered separately with the use of the costing solution. This means that costing can now also

activate the material overheads based on consumption. This makes the inventory values transparent and traceable and also

ensures clarity in the balance sheet. Thus, these additions to the Microsoft Dynamics 365 Business Central1 standard not only

make the calculation of sales prices more comprehensible.

Cost types

In Microsoft Dynamics 365 Business Central1, there are a wide variety of cost types. These fields are visible in several masks.

The explanation of these will now take place at this point. Basically, Microsoft Dynamics 365 Business Central1 distinguishes

between single-level costs and multi-level costs.

Single level costs

Single-level costs are costs that are incurred only for this item. This means that for the calculation only the respective cost price

of articles from the bill of materials or the prices and overhead costs are taken directly from the routing. No structures are

exploded in the process.

Example:

An assembly in the bill of materials, is shown with the cost price in the material costs.

Multilevel costs

Multi-level costs, are costs that are broken down to the lowest level and then presented in the respective cost pools.

Example:

An assembly in the bill of materials is not shown with the cost price in the material costs, but is broken down further to the

purchase item. Only the purchase item is shown as material cost, the rest is capacity/external labor or production cost.

Consumption-capitalized material overheads

The material costs can be included directly in the cost price of the raw material at the time of stock receipt, but also as

consumption-capitalized material costs that are not included in the product until production.

The overhead and consumption capitalized costs can be mixed on the item card and in the costing condition lines.

Hierarchy of Consumption Capitalized Overhead:

a) Calculation conditions consumption activated

b) Calculation condition line

c) Article

Hierarchy Overhead:

a) Calculation conditions not consumption activated

b) Calculation condition line

c) Article

Overhead costs and consumption activated overhead costs can be used in parallel. The only difference is that you can only define

either a costing condition or a consumption activated costing condition. Both do not work.

Cost types

Note

1.2.2 factory365

- 387/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Below you will find an overview of the cost types that exist in Microsoft Dynamics 365 Business Central1 in connection with

KUMAVISION factory365:

The totals of the single-level and multi-level prices only match as long as no bookings or price changes are made. As soon as

bookings have taken place, these values diverge. They can then be made equal again by means of a new cost price calculation across

all levels. (Depending on the settings)

ESTABLISHMENT

Evaluation & calculation facility

In the "Valuation & Costing Facility", the basic facilities for controlling the operation of the costing facility are defined first.

Field Description

Single-level material costs All costs (cost price - overhead) that come from the bill of material.

Single-Level Material Overhead All overhead costs resulting from purchased items in the bill of material.

Single-level capacity costs All costs (cost price - overhead) that come from the routing.(No external labor operations)

Single-level capacity overhead All overhead costs that come from the item's routing. (No outside labor operations)

Single-Level Production

Overhead

Production overhead stored with the item being costed.

Single-level external labor costs All external labor costs (cost price - overhead) of external labor operations, from the

corresponding routing.

Single-level external labor

overhead

All overhead costs of external labor operations, from the corresponding routing.

Multi-level material costs All material costs (cost price - overhead) of purchasing items totaled over all levels.

Multi-level material overhead All material overhead costs of purchase items summed over all levels.

Multi-level capacity costs All capacity costs (cost price - overhead) from all routings summed over all levels.

Multi-level capacity overhead All capacity overhead costs of all operations summed over all levels.

Multi-level production overhead All production overhead costs of all items summed over all levels.

Multi-level external labor costs All external labor costs (cost price - overhead) of all external labor operations summed

over all levels.

Multi-level external labor

overhead

All external labor overhead costs from all external labor operations totaled across all

levels.

Note
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Inforegister General
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Field Description

Basic Std.price

calculation (make-to-

stock)

The selection you make here is only used for items with the production type "make-to-stock".

The following selections are available:

Cost price:

The value of the "Cost price" field from the item's master data is used.

Cost price (latest):

The value of the "Cost price (latest)" field from the item's master data is used.

Basic Std.price

calculation (order

production)

The selection you make here will only be used for items with the production type "order

production".

The following selections are available:

Cost price:

The value of the field "Cost price" from the master data of the item will be used.

Cost price (latest):

The value of the "Cost price (latest)" field from the item's master data is used.

Purchase price (purchase prices):

If the article has the procurement method "Purchase", first the purchase price valid for the

vendor no. of the article is determined from the table Purchase price and the valid line discount

% from the table Purchase line discount (both best price determination according to calculation

date and quantity to be calculated). The combination of both fields results in the cost price to be

used.

If the item has the procurement method "Production order", the determination of the cost price

to be used is based on the option value of the field "Basis Std. cost price calculation (make-to-

stock)" of the Valuation and Costing Setup.

Default Transfer of cost

price (fixed)/ target price

Adopt proposal

At this point, you can decide whether the results of these calculations are written back for the

respective articles. The following selection options are available:

One level:

The cost price (fixed) is only written back at the article for which the calculation was performed.

All levels:

The cost prices (fixed) are written back at all assemblies / components that were determined by

the calculation.

Unit price decimal places This is where you specify the minimum and maximum number of decimal places to be specified

for unit prices in the calculation.

Example:

2:5 means: minimum 2 decimal places and maximum 5 decimal places.

For further information, use the Microsoft Dynamics 365 Business Central1 Helpsite on the

topic "Unit price decimal places field".

.

Quantity Decimal Places At this point you define how many decimal places should be specified in the calculation

minimum and maximum for the quantities.

Example:

2:5 means: Minimum 2 decimal places and maximum 5 decimal places.
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Assuming that consumption-based items (make-to-stock) are procured on a regular basis, the cost price or delivered price

(latest) provides a good basis for costing because the prices usually represent realistic values.

The cost price is - except for the stock issue method standard - an average value over all cost prices of the quantities currently in

stock.

The Current price (latest), on the other hand, is not an average price. It refers to the last value at which the item was added. For

a more detailed definition of the cost price fields on the item card, please use the Microsoft Dynamics 365 Business Central1

Helpsite.

Items that are procured on an order basis (make-to-order production), on the other hand, can either also be costed on the

basis of the cost prices, or - and this makes sense especially for articles that are procured infrequently - on the basis of the

currently valid purchase prices. If there is no current purchase price for the article, a planned value can also be entered in the

preliminary costing. 

The cost prices are always "adjusted" prices, i.e. freight costs or precious metal surcharges entered per article surcharge/discount

are added, purchase discounts or similar are deducted. The purchase price, on the other hand, is the pure purchase price without

taking into account any surcharges, discounts or rebates. The final costing always calculates only with the cost prices.

A production type must be stored for each article - even for pure purchase articles, for which the production type is irrelevant by

default.

Field Description

For further information use the Microsoft Dynamics 365 Business Central1 Helpsite on the topic

"Unit price decimal places field".

Fixed costing sheet name

for costing proposal

(E+D)

This setting applies to the costing sheets matrix that can be called up from the costing proposal

(E+D) - i.e. via the production orders.

With this field you have the option of specifying a standard costing sheet. If you enter a schema

at this point, the user can only work with this schema and no longer select another (lock

function).

If the user should have the option to select other calculation schemas, then do not put anything

in this field.

Calculate E+D Order

(Sales)

This field refers to the calculation from a sales quotation or a sales order.

The following options are available:

Calculate only:

The system creates the calculation, but does not perform any further action afterwards. If you

want to display the newly created Simulated E+D Order, you must call it up manually.

Calculate+Display:

After the system creates the calculation, the created Simulated E+D Order is displayed directly

in a window.

Calculate+Apply:

If the calculation proposal could be created without errors, the value of the "New target price"

field of the executed calculation proposal will be applied to the "Sales price" field of the sales

line.

Note

Note
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Inforegister numbering

If you want to use more than one number series for this table, you can set up a connection between the corresponding series in the

"Connections" call in the number series. This way you can use one code for two or more number series.

Inforegister Assembly

Costing components plan

The costing components plan is the foundation of the costing and is comparable with a chart of accounts. It takes over the task of

standardizing and grouping the components of a cost estimate and thus ultimately making them comparable with each other.

This applies to both article costing and quotation costing. 

In principle, the costing sheet is structured in the same way as the chart of accounts in the Financial Accounting application

area. 

KUMAVISION factory365 can already provide you with a set up costing element plan via the Smart Start packages. You can

either use this directly in the form or further adapt it to the requirements of your company. Of course, you also have the option to

create your own complete component plan.

Field Description

Calculation Default

Numbers

Enter the code of the number series to be used to assign records to the Calculation Default

Numbers table.

Calculation Condition

Numbers

Enter here the code of the number series to be used to assign records to the Calculation

Condition Numbers table.

Note

Field Description

Costing item direct costs (resource

assembly)

Select here a costing item from the costing item plan to which the direct costs

incurred when a resource is used in an assembly order are allocated.

Description Costing element Direct

costs (resource assembly)

Specifies the description of the selection in the "Costing item direct costs

(resource assembly)" field.

Costing element overhead costs

(resource assembly)

Select a costing item from the costing item plan here, to which the overhead

costs incurred when a resource is used in an assembly order are assigned.

Description of costing element overhead

costs (resource assembly)

Specifies the description of the selection in the Costing Item Overhead (Assembly

Resource) field.
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If you want to use more than one number series for this table, you can set up a connection between the corresponding series in the

"Connections" call in the number series. This way you can use one code for two or more number series.

Note
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Field Description

No. The "No. " field is used to identify the costing element. You can enter up to 20 characters, both numbers

and letters. Each number may be assigned only once. You can set up as many costing items as you like.

Note:

Choose sufficient intervals between the numbers of the individual costing components. This will allow you

to insert additional costing items later if required. For example, you could assign only the end digits 00 to

all account groups and only the end digits 0 to all accounts.

Description Here you can enter any text to describe the content of the costing element.

Cost range Articles and capacities are later assigned to the costing items table via the costing conditions. The Cost

area field indicates the application area of the respective costing item. The following selection options are

available:

Cost of materials and material overheads:

The costing items with these options are used in costing conditions of the type "Material" (procurement

method of the item = purchase). Material costs describe the direct costs (from the field EK price (latest)).

Material overhead describes the indirect costs (from the fields Cost %, Overhead rate, Cost %

(consumption capitalization), Overhead rate (consumption capitalization)).

Capacity costs and capacity overhead:

The costing items with these options are used in costing items of the type "Capacity".Capacity costs

describe the direct costs (field EK price of the used work center or work center group). Capacity overhead

describes the indirect costs (cost %, overhead rate) of the work center or work center group used.

Outside labor costs and outside labor overhead:

The costing items with these options are used in costing items of the type "Capacity" if it is an external

labor work center group (or assigned external work center) (Vendor number field is not equal to ).

External labor costs describe the direct costs (field EK price of the used external work center group or the

assigned external work center). External labor overhead describes the indirect costs (cost %, overhead

rate) of the external work center group used or the assigned external work center.

Cost range Production Overhead:

The costing items with these options are used in costing conditions of type "Production" (procurement

method of the item = production order). Costing items of the cost area production overhead describe the

indirect costs (fields cost %, overhead rate) of the used article (production article or assembly).

Sales overhead, administrative overhead, risk/profit, commission, discount, rebate:

The costing items with these options are used in costing conditions of the type "markup". Costing items of

these four cost areas describe the non-capitalizable costs of an article, i.e. the difference between the

sales price and the cost price of the article.

Type With this field you specify the type of record. You can choose from the following:

Costing component:

This option is used for the actual calculation components. The later assignment is only done via these data

records.

Headline:

A heading for a group of costing components.

Sum:

The Sum option is used if you want the application to sum up individual costing items. Please then enter a

filter text in the Sum field to specify the costing components to be included.

From-total / To-total:

The From-total option marks the beginning of a continuous series of costing items to be totalized. The end
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You must assign a cost range to each record in the Costing item table with the type Costing item. For all other costing items

(headings, totals, from-totals or to-totals), the Cost range field remains empty.

Field Description

of this series is a costing item of the type To-Sum. In this case, please also enter a filter text in the

Totalization field to specify the costing items to be included.

Counting up Here you can now specify the interval or other filter specification of numbers of the costing elements. The

results of the specified costing elements are added to a total balance.

For the type "Calculation component", "From-total" or "Heading" this field must remain empty.

For the "To total" type, the field is automatically filled when the chart of accounts is indented (function in

the ribbon). Only the costing items that lie between a From total and a To total are added together.

For the "Sum" type, you must manually specify the costing items to be added together.

Note
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Supplied Costing Components Plan:
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No. Description Cost area Type Counting

1 Energy overhead Material overhead Costing item

10000 manufacturing costs from-total

10001 Material costs From-total

10010 Direct material costs Material costs Costing element

10011 Direct material costs 2 Material costs Costing item

10020 Special direct costs

material

Material overhead Costing item

10030 Material overhead Material overhead Costing item

10040 Material surcharges Material overhead Costing element

10045 Freight costs Material overhead Costing item

10046 handling costs material overheads costing element

10049 Total material costs To-total 10001 ..10049

10100 Capacity costs From-total

10110 individual costs elm capacity costs costing element

10120 Single cost worker Capacity cost Calculation item

10130 individual costs machine capacity costs costing element

10150 Overhead costs elm Capacity overhead Costing element

10160 overhead labor capacity overhead costing element

10170 machine overhead capacity overhead costing item

10180 electricity/buildings capacity overhead costing element

10210 Individual costs external

labor

External labor costs Costing item

10250 Overhead costs external

labor

External labor

overhead

Costing element

10299 Total capacity costs To-total 10100 ..10299

10300 Individual costs assembly

res.

Capacity costs Calculation

component

10305 Overhead assembly res. Capacity overhead Costing element

10310 Tools Production Overhead Costing Item

10320 Certifications Production Overhead Costing Item

10400 Total cost of goods sold To-total 10000 ..10400

10410 Shipping Sales overhead Costing item

10420 Quality Control Sales Overhead Costing Item

10430 Sales Sales overhead Costing item

10510 Administration Administrative

overhead

Costing item
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Actions via the ribbon Indentation of the component plan

By executing the "Component plan indentation" function, the filter text in the "Totalization" field is automatically determined by

the system for the costing components of the "To total" type.

Comments

Date-dependent information can be stored for the respective costing element via the remarks.

Calculation conditions

The costing conditions establish the link between the master data tables such as article, work center group, etc. and the costing

components, thus enabling the results of a costing to be assigned to an account. 

In the header of a costing condition the assignment to the costing element costs and the costing element overhead costs is made.

The lines of the costing condition allow you to define the costing costs more precisely over any number of lines. This applies to

both direct costs (field EK price) and indirect costs (fields Cost %, Overhead rate) of the respective master data table.

A distinction is made in the following calculation condition types:

Costing condition (material)

The calculation condition is used in records of the table Article calculation condition with the calculation type Material. That is,

you define here costing conditions that you subsequently assign to some of your articles. The condition is taken into account in

the calculation when it comes to the calculation of raw materials (purchase items).

No. Description Cost area Type Counting

10520 Special direct costs of

technology

Administrative

overhead

Costing item

10600 Selbstkosten Summe 10000..10599

10610 Risk/profit surcharge Risk/profit Calculation

component

10620 Special direct costs other Risk/profit Costing item

10700 Mindestrichtpreis Summe 10000..10699

10710 Commission Commission/Discount Calculation Item

10720 Discounts Commission/Discount/

Discount

Calculation Item

10730 Discounts Commission/Discount Calculation Item

10800 Richtpreis Summe 10000..10799

10810 Rounding income/costs Commission/discount/

discount

Calculation

component

10900 Guide price (rounded) Sum 10000 ..10899
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Inforegister General

Field Description

No. Number of the calculation condition

Description Description of the calculation condition

Costing element costs Select the appropriate costing item in the "Costing items costs" field. For the costing

condition "Material", this is usually the material direct costs.

Description costing element

costs

Specifies the description of the selected costing item from the Costing Item Cost field.

Costing element overhead

costs

Select the appropriate costing element in the "Costing element overhead" field. This is

usually the material overhead for the costing condition "Material".

Description costing element

overhead costs

Specifies the description of the selected costing item from the Costing Item Overhead

field.
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Inforegister lines

KUMAVISION factory365 can provide you with predefined costing conditions (material) for use or further individual additions via

the Smart Start packages:

Field Description

Description Here you enter a description of the content of your calculation condition line.

Costing item A costing item is assigned to each costing condition line. In principle, a costing item with any cost

range can be assigned to a costing condition line. However, you should make sure that you use a

costing item whose cost range corresponds to the intended application area of the respective costing

condition.

Calculation

Component

Description

This field is automatically filled by the selection of the costing component.

Heading no. The Rubric No. field is used to relate calculation condition rows to each other in order to define a

calculation base for percentage surcharges.

Calculation The field is a choice field and controls with its option value the meaning of the field Value:

Amount:

If you select Amount, then the specification in the field Value is understood as absolute number input.

So you have here the possibility to store fixed values, which will be taken into account in the

calculation. In addition, you can provide this line with a rubric number to refer to this line in another

line with the setting Percent - so, for example, to take into account an additional overhead.

Percent:

If you select Amount, then the specification in the Value field is understood as a percentage number

entry. If the line has been assigned a rubric no., then the basis of the percentage is the sum of all

calculation condition lines of the same calculation condition with the same rubric no. and calculation

amount. 

Note:

If the line is not provided with a rubric no., the application uses either the purchase price of the origin

line of the corresponding calculation value or (if available) the sum of all calculation condition lines of

the same calculation condition with the calculation value as basis for the percentage. The rubric no. of

these lines will then be ignored.

Value The meaning of the field depends on the value you have selected in the Calculation field. 

Amount:

In this case, the field contains an absolute amount. Depending on the selected costing element, this

amount is part of the EK cost or part of the overhead rate.

Percent:

In this case, the Value field contains a percentage value. The basis of the percentage value is the sum

of all calculation values with the same rubric no. If the row was not assigned a rubric no., the

application uses as a basis either the purchase price of the origin row of the corresponding calculation

value or (if available) the sum of all calculation condition rows with calculation value and specification

of any rubric no. (but only if these calculation condition rows were interpreted as part of a purchase

price).
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Material (single) and material (single2):

Material (complex) and material (complex2):

Calculation condition (production)

The calculation condition is used in records of the table Article calculation condition with the calculation type Production. This

means that you define calculation conditions here which you then also assign to some of your articles. The condition is taken into

account in the calculation if it is about the calculation of products (production items).

Field Material (simple) Material (simple2)

No. KK0000 KK0010

Description Material (simple) Material (simple2)

Calculation item costs 10010 10011

Description of costing element costs Direct material costs Direct material costs 2

Costing item overhead 10030 10030

Description Costing Item Overhead Material Overhead Material Overhead

Field Material (complex) Material (complex2)

No. KK0011 KK0001

Description Material (complex) Material (complex2)

Calculation item costs 10010 10010

Description of costing element costs Direct material costs Direct material costs

Costing item overhead 10030 10030

Description Costing Item Overhead Material Overhead Material Overhead

Field Material

(complex)

Description Handling Freight Overhead

costs

Special direct

costs

Material

surcharges

Kalkulationsbestandteil 10046 10046 10046 10046 10046

Costing Item

Description

Handling Costs Freight Costs Material

Overhead

Special Direct

Costs Material

Material

Surcharges

Heading no. R1+R2 R1 R2

calculation/value 7 .00 MW 6.00 % 4.00 % 5.00 MW 2.00 MW

Field Material (complex2)

Description Handling Freight Overhead costs

Kalkulationsbestandteil 10046 10045 10030

Costing Item Description Handling Costs Freight Costs Material Overhead

heading no.

Calculation / Value 1 .00 MW 6. 00 % 4.00 %

1.2.2 factory365

- 401/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Inforegister General

Field Description

No. Number of the calculation condition

Description Description of the calculation condition

Costing element costs Select the appropriate costing item in the field "Costing item costs". In the case of the costing

condition "Production", these are usually the direct material costs or the special direct costs of

production.

Calculation Item Cost

Description

Indicates the description of the selected costing item from the "Costing Item Cost" field.

Costing element overhead

costs

Select the appropriate costing item in the "Costing item overhead" field. In the case of the

costing condition "Production", this is usually the cost of tools, special direct costs, etc.

Description costing

element overhead costs

ISpecifies the description of the selected costing item from the Costing Item Overhead field.
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Inforegister lines

Field Description

Description Description of the calculation condition

Costing item A costing item is assigned to each costing condition line. In principle, a costing item with any cost

range can be assigned to a costing condition line. However, you should make sure that you use a

costing item whose cost range corresponds to the intended application area of the respective costing

condition.

Calculation

Component

Description

This field is automatically filled by the selection of the costing component.

Heading no. The field "Rubric no. " is used to relate calculation condition rows to each other in order to define a

calculation basis for percentage surcharges.

Calculation The field is a choice field and controls with its option value the meaning of the field Value:

Amount:

If you select the option "Amount", then the specification in the field Value is understood as absolute

number input. So here you have the option to enter fixed values that will be taken into account in the

calculation. In addition, you can provide this line with a rubric number to refer to this line in another

line with the setting Percent - so, for example, to take into account an additional overhead.

Percent:

If you select Amount, then the specification in the field "Value" is understood as a percentage number

entry. If the line has been assigned a rubric no., then the basis of the percentage is the sum of all

calculation condition lines of the same calculation condition with the same rubric no. and calculation

amount. 

Note:

If the row was not provided with a rubric no., the application uses as the basis for the percentage

either the EK price of the origin row of the corresponding calculation value or (if available) the sum of

all calculation condition rows of the same calculation condition before the current row with the

calculation value. The rubric no. of these lines will then be ignored.

Value The meaning of the field depends on the value you have selected in the Calculation field. 

Amount:

In this case, the field contains an absolute amount. Depending on the selected costing element, this

amount is part of the EK cost or part of the overhead rate.

Percent:

In this case, the Value field contains a percentage value. The basis of the percentage value is the sum

of all calculation values with the same rubric no. If the line has not been assigned a rubric no., the

application will use as a basis either the EK price of the origin line of the corresponding calculation

value or (if available) the sum of all calculation condition lines before the current line with calculation

value and specification of any rubric no. (but only if these calculation condition lines have been

interpreted as part of an EK price).
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KUMAVISION factory365 can provide you with predefined calculation conditions (production) for use or further individual

additions via the Smart Start packages:

No further information is defined in the calculation condition lines of the condition "Production (simple)".

Costing condition (capacity)

The costing condition is used in data records of the Work center costing condition table. This means that you define costing

conditions here which you then assign to your capacities (work center groups and work centers). The condition is taken into

account in the calculation as soon as a capacity is addressed (e.g. because a routing is stored for a production article).

Inforegister General

Field Production (simple) Production (complex)

No. KK1000 KK1001

Description Production (simple) Production (complex)

Calculation item costs 10011

Description of costing element costs Direct material costs 2

Costing item overhead 10310 10320

Description costing component overhead Tools Certifications

Field Production (complex)

Description Tool Certification

Calculation component 10310 10320

Calculation component description Certification tool

Category no.

Calculation / Value 2.00 % 5.00 MW

Field Description

No. Number of the calculation condition

Description Description of the calculation condition

Costing element costs Select the appropriate costing item in the field "Costing item costs". For the costing

condition "Capacity", this is usually the direct production costs.

Calculation Item Cost

Description

Gives the description of the selected costing item from the "Costing Item Cost" field.

Costing element overhead

costs

Select the appropriate costing element in the "Costing element overhead" field. This is

usually the production overhead for the costing condition "Capacity".

Description costing element

overhead costs

Indicates the description of the selected costing item from the "Costing Item Overhead"

field.
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Inforegister lines

Field Description

Description Here you enter a description of the content of your calculation condition line.

Costing item A costing item is assigned to each costing condition line. In principle, a costing item with any cost

range can be assigned to a costing condition line. However, you should make sure that you use a

costing item whose cost range corresponds to the intended application area of the respective costing

condition.

Calculation

Component

Description

This field is automatically filled by the selection of the costing component.

Heading no. The Rubric No. field is used to relate calculation condition rows to each other in order to define a

calculation base for percentage surcharges.

Setup time This field is only included in costing conditions of the type capacity or external labor. It can be used to

define costing elements that only refer to the setup time in their calculation.

Share % The content of the field is used as a percentage share in the formula for calculating the Costing price

field of the costing value.

Calculation The field is a choice field and controls with its option value the meaning of the field Value:

Amount:

If you select Amount, then the specification in the field Value is understood as absolute number input.

So you have here the possibility to store fixed values, which will be taken into account in the

calculation. In addition, you can provide this line with a rubric number to refer to this line in another

line with the setting Percent - so, for example, to consider an additional overhead.

Percent:

If you select Amount, then the specification in the Value field is understood as a percentage number

entry. If the line has been assigned a rubric no., then the basis of the percentage is the sum of all

calculation condition lines of the same calculation condition with the same rubric no. and calculation

amount. 

Note:

If the row was not provided with a rubric no., the application uses as the basis for the percentage

either the EK price of the origin row of the corresponding calculation value or (if available) the sum of

all calculation condition rows of the same calculation condition before the current row with the

calculation value. The rubric no. of these lines will then be ignored.

Value The meaning of the field depends on the value you have selected in the Calculation field.

Amount:

In this case, the field contains an absolute amount. Depending on the selected costing item, this

amount is part of the EK cost or part of the overhead rate.

Percent:

In this case, the Value field contains a percentage value. The basis of the percentage value is the sum

of all calculation values with the same rubric no. If the line has not been assigned a rubric no., the

application will use as a basis either the EK price of the origin line of the corresponding calculation

value or (if available) the sum of all calculation condition lines before the current line with calculation

value and specification of any rubric no. (but only if these calculation condition lines have been

interpreted as part of an EK price).
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KUMAVISION factory365 can provide you with predefined calculation conditions (capacity) for use or further individual additions

via the Smart Start packages:

No further information is defined in the calculation condition lines of the conditions "Capacity (energy)" and "Capacity (simple)".

Field Capacity (Energy) Capacity (Simple) Capacity (Complex)

No. 01 KK2000 KK2001

Description Capacity (energy) Capacity (simple) Capacity (complex)

costing item cost 10130 10130

Description of costing item cost Individual costs

machine

Individual costs

machine

Costing item overhead 1 10170 10170

Description of costing element

overhead costs

overhead costs

energy

overhead costs

machine

overhead costs

machine

Field Capacity

(complex)

description machine worker scrubber apprentice GK machine GK worker

Kalkulationsbestandteil 10130 10120 10110 10120 10170 10160

Costing component

description

Individual

costs machine

Individual

costs worker

Individual

costs elm

Individual

costs worker

Individual

costs machine

Individual

costs worker

Rubric No. M1 A A M1 A

armament Yes

share % 100.00 100. 00 100. 00 100.00 100. 00 100.00

calculation/value 2 .20 MW 1. 20 MW 1. 50 MW 0 .90 MW 20. 00 % 10.00 %

Field External labor (simple) External labor (complex)

No. KK2050 KK2051

Description Foreign work (simple) Foreign work (complex)

Costing item costs 10210 10210

Description of costing item costs individual costs external labor individual costs external labor

Costing item overhead 10250 10250

Description of costing element overhead costs Overhead costs external work Overhead costs external work
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No further information is defined in the calculation condition lines of the condition "External labor (simple)".

Calculation condition (markup)

The calculation condition is used in records of the table Article calculation condition (cannot be activated) with the calculation

type markup. This means that you define calculation conditions here which you then assign to some of your articles. The

condition will be taken into account in the calculation if it is the calculation of "end products". Here you no longer define the cost

price of the article, but the markup up to the target price.

Field External labor (simple) External labor (simple)

Description Freight Overhead costs

calculation component 10250 10250

Calculation Item Description Overhead Costs External Labor Overhead Costs External Labor

heading no.

armament

Share % 100 .00 % 100. 00 %

Calculation / Value 5 .00 % 15. 00 %
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Inforegister General

Field Description

No. Number of the calculation condition

Description Description of the calculation condition

Takeover guide

price

In an article calculation you can transfer the determined target price from a calculation proposal into the

master data of the calculated article. You specify here, in which field of the master data the determined

target price should be transferred:

None:

There is no transfer.

Target price:

The value is transferred to the field target price of the article (table article).

Sales price:

The value is taken over into the field Sales price (table article).

Sales price:

The value is taken over into the sales price table of the article. The entry is made taking into account the

sales type and sales code.

Price + Sales Price:

The value is transferred to both the Price field (Article table) and the Sales Price table record.

Sales Type This field is taken into account when entering the target price in the sales price table. The following

selection options are available:

• Debitor ,

• Debitor price group,

• All debtors

• Campaign

It can only be edited if the option "Sales price" or "Target price+sales price" has been selected in the

Transfer target price field.

Sale code This field is also taken into account when entering the target price in the sales price table. What you can

select here depends on what you have specified in the "Sales type" field. For example, if you have

selected customer price group there, all your customer price groups will be displayed for selection in the

"Sales code" field.

This makes it possible to define individual markup calculations for special customer groups, campaigns

or even for individual customers.
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Inforegister lines
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Field Description

Heading no. The field "Rubric no. " is used to relate calculation condition rows to each other in order to define a

calculation basis for percentage surcharges.

Description Here you enter a description of the content of your calculation condition line.

Calculation The field is a choice field and controls with its option value the meaning of the field "Formula/Code":

Empty:

If the field is left empty the line has no influence on the execution of the calculation. For example, it can

be used for a heading or explanation line.

Value:

If you select "Value", the "Formula/Code" field will contain an absolute number entry. In addition, you can

assign a heading number to this line to refer to it in another line with the Percent setting.

Formula:

If you select Formula, the Formula/Code field contains an arithmetic formula. The parts of the formula

refer to the heading no. of other costing condition lines.

Costing Item:

If you select Costing Item, the Formula/Code field contains a costing item. Thus, this setting allows you

to determine a markup line based on the costing values of a specific costing component. This costing

item can also be a to-total.

Project Planned Line:

If you select Project Planned Line, the Formula/Code field contains a project task number.

Formula/Code The meaning of the field depends on the value you have selected in the "Calculation" field.

Empty:

In this case, the "Formula/Code" field is also empty. The calculation condition line has no influence on the

execution of the calculation. For example, it can be used for a heading or explanation line.

Value:

In this case, the field contains a constant (decimal number). You can use this constant also, in which you

provide the line with a rubric no. and in another calculation condition line with the calculation formula

reference to this line.

Formula:

In this case the field contains an arithmetic formula. A rubric no. can also be used here to determine the

calculation basis. In the arithmetic formula, the basic arithmetic operations +, -, , /, multilevel brackets ()

and the two special characters % and § can be used.

% stands for "percent of one hundred".

Example:

5% A means "5 percent of the sum of all markup lines with rubric no. A". Suppose the total is 100, then

the markup is 5 (100/1005)

§ stands for "percent of one hundred".

Example:

5 § B means "5 percent from the total of all markup lines with rubric no. B". Let's say the total is 100,

then the markup is 4.76 (100/1055).

Calculation Item:*

In this case, a calculation item is selected. If this line is used in a calculation, the application will

calculate the calculated field "Multi-level amount per 1 unit". For example, the Costing Ingredient option

value allows you to calculate a markup line based on the costing values of a specific costing ingredient.

This costing item can also be a to-total.
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KUMAVISION factory365 can provide you with predefined calculation conditions (markup) for use or further individual additions

via the Smart Start packages:

Field Description

Rounding

Method Code

The field specifies whether the costing price of the costing value that will be created when applying the

costing condition in a costing proposal is to be rounded.The type and manner of the desired rounding is

thereby controlled with the help of a rounding method defined in the master data. This table is a

standard table. You have the option to always round up or down amounts or to round them up or down

commercially (in this case, amounts are only rounded up if the digit to be rounded is >=5. For further

explanations on how to set up the rounding methods, please use the Microsoft Dynamics 365 Business

Central1 Helpsite.

Costing item A costing item is assigned to each costing condition line. In principle, a costing item with any cost range

can be assigned to a costing condition line. However, you should make sure that you use a costing item

whose cost range corresponds to the intended application area of the respective costing condition.

Guide price Tick this field only in the line that should determine your guide price.

Bold The Bold field controls the visual highlighting of the row in the E+D Order markup calculation window.

Error text If you specify an incorrect formula, the corresponding error message appears in this field.

Field Impact Impact Calculation

No. AUFSCHLAG KK3000

Description Surcharge Surcharge Calculation

Takeover target price Target price Target price

Sale Debitor Debitor

sale code
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No further details are defined in the calculation condition lines of the condition "Surcharge".

Calculation scheme

The "Costing" application area allows you to evaluate the results of item costing and job costing in so-called costing sheets.

Costing schemes have the form of a matrix with a freely definable row layout and a freely definable column layout and are

comparable to the account schemes (Microsoft Dynamics 365 Business Central1 Standard).

A costing sheet can basically follow the structure of the costing sheet, but it is usually presented in somewhat less detail by

grouping certain items together. For example, you can display the total material costs in the chart of accounts; without

subdividing them into direct material costs and material overhead costs. This is possible because when you create a costing

proposal, the application automatically assigns each costing value to a costing item.

Any number of calculation schemes can be created. Two calculation schemas are already included in the basic setup of the

calculation - namely the standard calculation schema and the overview schema. Of course, these schemes can be further

customized according to your requirements. 

You can call up the overview using the search term "Kalkulationsschemanamen".

Heading no. Description Calculation Formula /

Code

Rounding

code

Lime.

Component

Lime.

Component

Description

Indicative

price

HK Manufacturing

costs

Calculation b . 10400

Shipping Formula HK * 0,5/100 10410 Shipping

Quality control Formula 00 .70% HK 10420 Quality control

Sales overhead Formula 03 .00 % HK 10430 Sales

Administration Formula 02 .50 % HK 10510 Administration

SEK d. Technik Calculation b . 10520

SK Self cost Calculation b . 10600

risk formula 02 .00 % SK 10610 Risk/profit

surcharge

Profit Formula 30 .00 % SK 10610 Risk / Profit

MRP Minimum

Indicative

Price

Calculationb . 10700

commission 1 formula 03 ,00 § MRP 10710 Provision

commission 2 formula 01 ,00 § MRP 10710 Provision

Saccount Formula 03 ,00 § MRP 10720 Account

Discount Formula 10 ,00 § MRP 10730 Discount

RP Guide Price Calculationb . 10800

RPG Directive price

rounded

Calculationb . 10800 PRICE

Rounding Formula RPG-RP 10810 Rounding

income / costs

Guide price

(incl.

rounding)

Calculationb . 10900 Yes
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Via "New" in the ribbon you can define a new scheme using the table below.

Field Description

Name In this field, assign a name for the calculation schema.

Description In this field, specify a description for the calculation schema.

Standard column

layout

The field "Standard column layout" is used to define the criteria for the calculation in the column view.

The column layout stored there will always be used as the basis for the calculation.
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Via "Calc. Edit scheme" in the ribbon you have the possibility to define the scheme in detail.
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Field Description

Heading no. Enter a rubric number for a unique description of the row or to be able to use this row later for a

calculation.

Description Here you specify a description for the line.

Totalization type and

totalization

The Totalization type field is a choice field. It determines which records will be included:

Ingredient Sum:

The sum is formed from the amounts taking into account the costing elements of the costing

element type. To do this, specify an expression in the Total field to filter the costing components to

be used.

Example:

The Total field contains the expression 10100..10299. Specifying this causes the costing sheet row

to display amounts resulting from the costing components in the range 10100 to 10299. Only

costing items of the type costing item are taken into account.

Total:

The total is formed from the amounts taking into account the costing items of the type total or to-

total. To do this, specify an expression in the Total field to filter the costing items to be used.

Example:

The Total field contains the expression 10100..10299. Specifying this causes the costing sheet row

to display amounts that result from the costing items in the range 10100 to 10299. Only costing

items of the type Total or To total are taken into account.

Formula:

The total is formed from the calculated amounts in other lines of the same costing sheet. To do this,

specify an arithmetic formula in the Total field. When doing this, use the Heading No. field to refer

to the other rows in the schema in the formula.

Example:

The Add Up field contains the expression A+B. The amounts from all other spreadsheet rows in the

same schema that have the value A or B in the Heading No. field are added together.

Display This field is relevant for the Costing Sheet report. You have the following choices:

Yes:

The row will be printed in the report. 

No:

The row will not appear in the report. For example, you can use this option to define a calculation

scheme row that contains subtotals of a longer calculation scheme.

If a column is not 0:

The row will only be printed in the report if it is not 0. Thus, rows without an amount will not be

printed at all.

New page If you mark the calculation schema line with a check mark, the report will make a page change at

this point.

Bold If you mark the calculation scheme row with a check mark, the row will be displayed in bold in the

report.

Cursive If you mark the calculation scheme line with a check mark, the line will be displayed in italics in the

report.

Underlined If you mark the calculation scheme row with a check mark, the row will be underlined in the report.

Reverse sign on
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Delete

You can delete the calculation schema via the "Delete" menu item.

Print

Via the menu item "Print" you have the possibility to print the calculation schema considering a defined column layout and the

specification of at least one calculation proposal line.

Set up account

The "Insert accounts" function transfers the records of the Costing item table to the present book sheet, creating exactly one

costing item row for each costing item. The no. of the costing item is then placed in the Totals field of the costing sheet row. 

You can select the costing elements to be transferred individually after starting the function. All costing elements are displayed

in an overview. Select the data records you want in the window and then click OK to start the transfer.

Set up column layouts

Via the menu item "Set up column layouts" you have the possibility to define a column layout for the defined calculation schema.

KUMAVISION factory365 can already provide you with two predefined calculation schemes for use or further individual additions

via the Smart Start packages:

Field Description

If the field of the calculation scheme row is checked, all calculated amounts of the row will be

displayed in the Calculation scheme matrix window with reversed sign.
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Calculation scheme standard:
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Heading no. Description Counting type Counting Advertisements

10010 Direct material costs Inventory total 10010 Yes

10011 Direct material costs 2 Inventory total 10011 Yes

10020 Special direct costs material Inventory total 10020 Yes

10030 Material overhead Inventory total 10030 Yes

10040 Material surcharges Component sum 10040 Yes

10045 Freight costs Inventory sum 10045 Yes

10046 Handling costs Inventory sum 10046 Yes

10049 Sum of material costs Sum total 10049 Yes

Component sum Yes

10110 Individual costs elm Component sum 10110 Yes

10120 Single cost worker Summary 10120 Yes

10130 Individual costs machine Inventory total 10130 Yes

10150 Overhead costs elm Component sum 10150 Yes

10160 Overhead labor Component total 10160 Yes

10170 Overhead machine Components 10170 Yes

10180 Electricity/Building Component sum 10180 Yes

10210 Individual costs external

labor

Individual costs 10210 Yes

10250 Overhead costs external

labor

Inventory total 10250 Yes

10299 Sum capacity costs Sum total 10299 Yes

Component sum Yes

10300 Individual costs assembly

res.

Component sum 10300 Yes

10305 Overhead assembly res. Component sum 10305 Yes

Component sum Yes

10310 Tools Components 10310 Yes

10320 Certifications Inventory 10320 Yes

Component sum Yes

10400 Total cost of goods sold Sum total 10400 Yes

Component sum Yes

10410 Shipping Inventory 10410 Yes

10420 Quality control Component sum 10420 Yes

10430 Sales Inventory 10430 Yes

10510 Administration Component total 10510 Yes

10520 Inventory total 10520 Yes
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Heading no. Description Counting type Counting Advertisements

Special individual costs

engineering

(Sales overhead) Inventory total 10400 ..10499 Yes

(Administrative overhead) Component total 10500 ..10599 Yes

10600 Self cost Sum total 10600 Yes

10610 Risk/profit surcharge Component sum 10610 Yes

10700 Minimum reference price Sum total 10700 Yes

10710 Provision Component sum 10710 Yes

10720 Discounts Inventory 10720 Yes

10730 Discounts Inventory 10730 Yes

(Commission/Discount/

Discount)

Cumulative total 10710 ..

10799;10810

Yes

10800 Guide price Sum total 10800 Yes

10900 Guide price (rounded) Sum total 10900 Yes

Component sum Yes

Component sum Yes

Summe Aufschläge Bestandteilsumme 10401..10499

10501..10599

10601..10699

10701.. 10799

10810

Ja
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Calculation scheme overview:

Article card

Article Calculation Conditions

The article calculation conditions can be called up via the article card. With this mask you can define the calculation conditions

specifically for a certain article or a species group for the later calculation. 

Heading no. Description Counting type Counting Advertisements

MAT Sum of material costs Sum of

components

10010 ..10048 Yes

KAP Sum of capacity costs Sum of

components

10110 ..10199 Yes

FREMD Total external labor costs Component total 10210 ..10298 Yes

PROD Total production overhead Inventory total 10300 ..10399 Yes

Sum of material costs Sum total 10049 Yes

Component sum Yes

10410 Shipping Inventory 10410 Yes

10420 Quality control Component sum 10420 Yes

10430 Sales Inventory 10010 Yes

10510 Administration Inventory 10010 Yes

10520 Special individual costs

engineering

Inventory total 10010 Yes

10600 Self cost Sum total 10600 Yes

10610 Risk/profit surcharge Component sum 10610 Yes

10700 Minimum reference price Sum total 10700 Yes

10720 Discounts Inventory 10720 Yes

10730 Discounts Inventory 10730 Yes

10900 Guide price (rounded) Sum total 10900 Yes

Component sum 10010 Yes

Summe Aufschläge Bestandteilsumme 10401..10499

10501..10599

10601..10699

10701.. 10799

10810

Ja

1.2.2 factory365

- 420/1545 - Copyright © 2018 - 2024 KUMAVISION AG



The "General" area of the article calculation conditions mask initially contains filters that you can use to control your view. When

you open the mask, the filters are initially always preset to the article from which you have called up the mask.

Field Description

Sales Type

Filter

Using the sales type filter, you can limit your view to lines of a specific costing type or none.

The following selections are available:

• Material

• Production

• None

Species filter Using the species filter, you can limit your view to rows of a specific type.

The following selections are available:

• Article

• Article category

• Product booking group

• Stock booking group

• All articles

• None

Code filter You can use the code filter to further restrict your view in addition to the species filter on a specific

article or similar.

Start date filter Use the start date filter to narrow your view to specific validity lines.
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Using the rows you can directly define the calculation conditions with the help of the table below.

Via "Manage" > "Delete" you can delete a selected calculation row.

Article calculation conditions (cannot be activated)

The article calculation conditions (not activatable) can be called up via the article card. This screen allows you to define the non-

activatable costs (costs that are not included in the cost price) specifically for a particular article or species group for later

costing.

Field Description

Calculation type In this field you define for which calculation type you want to define the line.You can choose

from:

Material:

The condition is taken into account in the calculation, if it is the calculation of raw materials

(purchase items).

Production:

The condition is taken into account in the calculation, if it is the calculation of products

(production items).

Type Using the "Type" field, you have the option of defining the condition line for an article or for

faster entry of a type group. The following options are available:

• Article

• Article category

• Product booking group

• Stock booking group

• All articles

Code You can limit each selection in the "Type" field to a specific article number or species group

number in this field.

Indirect Cost Rate Enter the indirect cost of the item as an absolute amount at this point.

Note:

If you are working with costing, it is recommended that you do not maintain the default field

on the item card.

Indirect costs % Indirect costs of the item as a percentage value.

Note:

This field is identical to the field on the item card. However, if you are working with costing,

it is recommended that you do not maintain the standard field on the item card, but only this

one instead.

Overhead Cost Rate

(Consumption

Capitalization)

Enter the consumption capitalized overhead as an absolute amount at this point.

Note:

Overhead and consumption capitalized overhead can be used in parallel. The only difference

is that only either a Costing Condition or a Costing Condition Consumption Activated can be

defined. Both do not work.

Cost % (Consumption

Activation)

Indicate the consumption-activated costs as a percentage value at this point.

Calculation Condition No. Enter the appropriate calculation condition.

Start date Indicates the date from which the calculation line is valid.

End date Indicates the date until when the calculation line is valid.

1.2.2 factory365

- 422/1545 - Copyright © 2018 - 2024 KUMAVISION AG



In the "General" area of the article calculation conditions (cannot be activated) mask, there are initially filters that you can use to

control your view. When you open the mask, the filters are initially always preset to the article from which you have called up the

mask.

Field Description

Sales Type

Filter

Using the sales type filter, you can limit your view to lines of a specific costing type or none.The following

selections are available:

• Markup

• Special Direct Cost

• None

Type filter Using the type filter, you can limit your view to rows of a specific type. The following selections are

available: 

• Article

• Article category

• Product posting group

• Stock posting group

• All articles

• None

Code filter You can use the code filter to further restrict your view in addition to the species filter on a specific

article or similar.

Start date filter Use the start date filter to narrow your view to specific validity lines.
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Using the rows you can directly define the calculation conditions with the help of the table below.

Via "Manage" > "Delete" you can delete a selected calculation row.

Calculation specifications

Field Description

Costing type In this field you define for which costing type you want to define the line. You can choose from:

Surcharge:

The condition is taken into account in the calculation, if it is the calculation of "end products".

You define here no longer the cost price of the item, but the markup up to the target price.

Special direct costs:

The condition is defined the costs that are incurred for a product, but are not quantity-

dependent.

Type Using the "Type" field, you have the option of defining the condition line for an article or for

faster entry of a type group. The following options are available:

• Article

• Article category

• Product booking group

• Stock booking group

• All articles

Code You can narrow down each selection in the "Type" field to a specific article number or species

group number in this field.

Calculation Condition No. Indicates the corresponding calculation condition.

Calculation Condition

Description

Gives the description for the calculation condition selected in the "Calculation Condition No."

field.

Calculation condition no.

(E+D)

Indicates the corresponding calculation condition (E+D).

Calculation Condition

Description (E+D)

Gives the description for the calculation condition selected in the "Calculation Condition No.

(E+D)" field.

Start date Indicates the date from which the calculation line is valid.

End date Indicates the date until when the calculation line is valid.

Special direct costs Indicates possible special direct cost values.

Quantity per unit Indicates the quantity per unit.

Special direct costs per

unit

Indicates the special direct costs per unit.

Costing item no. SEK Specifies the costing item for the special direct costs.

SEK Costing Component

Description

Indicates the description for the costing component selected in the "SEK Costing Component

No." field.

Project no. Indicates a possible project number.
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You can use the "Costing specifications" to specify different lot sizes in advance for the cost of goods manufactured simulations,

which are then taken into account in the subsequent costing. 

Job costing conditions

You call up the Costing conditions mask work center via the work center group card. Via this mask you can define the costing

conditions you want to assign to your capacities (work center groups and work centers). The condition is taken into account

during costing as soon as a capacity is addressed (e.g. because a routing is stored with a production article). 

In the "General" area of the Calculation conditions mask workstation, there are initially filters that you can use to control your

view. When you open the mask, the filters are always preset to the workstation group from which you called the mask.

Field Description

No. This is assigned automatically on the basis of a stored number series.

Item no. This is automatically assigned with the article number from which you started the call.

Description Corresponds to the item description.

Start date From when should this costing specification apply.

End date To when is this costing specification valid.

Lot size Indicates the lot size number.

Standard This field is queried when calculating the cost price.

If this is set and the checkbox "Only standard costing specifications" is also set in the function "Costing

price (fixed)/Calculate target price for item", then only lot sizes that have the checkmark set in the costing

specifications are used.

Field Description

Type filter Using the type filter, you can restrict your view to lines of a specific type or none.The following selections

are available:

• Department

• Workstation group

• Workstation

• Workstation line

• None

Code filter You can use the code filter to further restrict your view in addition to the type filter on a specific

workstation group or similar.

Start date

filter

Use the start date filter to narrow your view to specific validity lines.
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Using the rows you can directly define the calculation conditions with the help of the table below.

Via "Manage" > "Delete" you can delete a selected calculation row.

ARTICLE CALCULATION

The costing proposal is used for the cost of goods manufactured calculation. You can call this up directly from the respective

article card via the menu ribbon.

Field Description

Type Using the "Type" field, you have the option of defining the condition line for a workstation

group or similar. The following options are available:

• Department

• Workstation group

• Workstation

• Work plan lines

Code You can limit each selection in the "Type" field to a specific workstation group or similar in this

field.

Version code Specify the appropriate version code.

Operation No. Indicate a corresponding operation.

Indirect cost rate Enter the indirect costs as an absolute amount at this point.

Indirect costs % Enter the indirect costs as a percentage value at this point.

Calculation Condition No. Enter the appropriate calculation condition.

Calculation Condition

Description

Indicates the description for the calculation condition selected in the "Calculation Condition

No." field.

Start date Indicates the date from which the calculation line is valid.

End date Indicates the date until when the calculation line is valid.
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Calculation proposal

In the costing proposal lines, historically already preceding costings are displayed (if available).

Calculate set price (fixed)/direct price for article

Field Description

Warning Blank:

The proposal line does not contain any errors and can be accepted if necessary.

Errors:

The proposal line contains errors that can be viewed and corrected via the error log. After

correction, the proposal must be run through again.

Calculation Run Seq. No. Indicates a sequential number per proposal line. For proposal lines that contain different

article costing specifications (lot sizes), these are displayed with the same sequential number.

Calculation Run Description Indicates the description that has been specified for the respective calculation run.

Item no. Indicates the article number for which the suggestion line was calculated.

Description Indicates the description of the item.

Procurement method Indicates the stored procurement method of the item.

Status Indicates the status of the proposal line. A distinction is made here between:

• Empty

• Preferred

• Rejected

• Transferred

For more information, see the section "Change status".

Lot size Indicates the lot size on which the proposal line was costed.

Note:

Please note that the lot sizes on the item card as well as in the costing specifications can be

used for costing.

Calculation date Indicates the date when the proposal line was calculated.

Cost Price (Fixed) Indicates the deposited "Cost Price (Fixed)" on the item card.

New cost price (fixed) Specifies the new cost price (fixed) of the proposal line.

Cost % (Consumption

Activation)

Displays , (if available) the "Cost % (Consumption Activation)" determined from the costing

definitions.

Overhead rate

(consumption capitalization)

Displays, (if available) the "Overhead rate (consumption capitalization) determined from the

costing definitions.

Guide price Indicates the previous guide price.

New target price Indicates the recalculated target price.
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When this function is executed, the cost price for the corresponding item(s) is calculated.

Change status...

This function allows you to set the status of the costing proposal line according to the selection (Preferred or Rejected) in the

"Status" field.

The status is relevant for the function execution "Accept costing proposal (preferred)". Only costing proposal lines with the status

"Preferred" are adopted. 

When the price is accepted, the "Status" field is set to "Accepted".

Adopt costing proposal (preferred)

Using this function, the values from the costing proposal lines with the status=Preferred are taken and transferred to the article

card.

Field Description

Calculation date Specifies the calculation date. This is used to take into account the start and end dates of

purchase prices, costing conditions or even bills of materials and routings for costing.

Calculation Run

Description

This input is a mandatory input and defines what kind of calculation it is.

Standard costing

specifications only

Here it can be defined whether the lot size of the article to be calculated is to be drawn from the

article card or the calculation specification.

If the switch is not activated, the stored lot size of the costing specification (if available) is

treated with priority than that of the article card.

If the switch is set, only the stored lot size with the identifier=standard (if available) is treated

with priority than that of the article card. 

Note:

This applies only to the first level, that is, the article to be costed.

Costing Proposal Name

(Plan)

Specification of the costing proposal (plan) if simulations are performed.

Note:

In order to determine the correct cost price based on the structure, which is then also written

back to the item card, this field must not be filled in.
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When executing the function, it is also possible to perform a revaluation at the recalculated price for the items that are still open.

Article costing specifications

The "Article costing specifications" can be used to carry out manufacturing cost simulations with different batch sizes. As a rule,

these defaults are already defined in advance in the "Costing defaults" on the respective article card and displayed accordingly at

this point. If required, changes and/or entries can be made here.

Field Description

Posting date Required for the revaluation ledger sheet. Corresponds to the valuation date

Fill revaluation

book.sheet

Will be selected if you want to revaluate the currently still open article items.

Depending on the selection of the field "Transferred from" either the whole structure can be

revaluated or only the article from the calculation proposal.

The revaluation book sheet can still be controlled afterwards. It must always be posted manually.

Voucher no. Indicates which voucher number is to be written to the revaluation ledger sheet.

Article Book. sheet

template

Indication of the revaluation bookb sheet

Article Book. sheet

name

Revaluation book sheet name

Transfer from One level:

Only the prices from the item from the costing proposal line will be updated. The items in lower

levels will not be updated.

All levels:

All prices and price fields of all items that occur in the structure will be updated.
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This always only affects the article that is currently being costed. If costing specifications are also defined for assemblies in subset

levels, these are not taken into account. Here, the lot size is always taken from the article card.

If there are several valid entries, the system automatically creates a separate calculation for each valid entry.

Costing proposal (planned values)

With the costing proposal (planned values) you can simulatively calculate proposals with modified planned values and also

transfer them via batch processing. Since the basis for the cost of goods manufactured calculation is always the master data, the

exchange of the articles is not possible at this point. Only amount values and cost values can be changed (no times and no

component quantities).

Via the calculation proposal (plan values) mask you can first select an already created proposal for editing via the "Name" field or

define a new one via "New" by entering "Name" and "Description". 

You can use the function calls "Propose article costing condition", "Propose capacity unit price (costing)", "Propose article unit

price (fixed) (costing)" and "Propose costs according to structured BOM" to redefine the respective stored planned values in

batch processing.

The function call opens a mask on which you can define new plan values in the option areas and limit your change project to

certain criteria by means of the filter area.

Fixed factor:

These radio buttons allow you to define fixed values for your changes, which will be taken into account over the run and written

into the "New value fields" provided for this purpose. 

Correction factor:

You can use these option fields to specify factor values that are to be multiplied by the original values. Via the run, these results

are also written into the "New value fields" provided for this purpose.

Note

Field Description

No This is assigned automatically on the basis of a stored number series.

Article No. This is automatically assigned with the article number from the data record of the calculation proposal

line.

Description Corresponds to the item description.

Start date From when this calculation specification should apply. Reference date is the "Calculation date" when

executing the function "Calculate set price (fixed)/Directive price for article".

End date To when is this calculation specification valid. Reference date is the "Calculation date" when executing the

function "Calculate set price (fixed)/Directive price for article"

Standard This field is queried when calculating the cost price. If this is set and also at the function "Calculate cost

price (fixed)/Directive price for article" the hook "Only standard costing specifications" is set, then only lot

sizes are used, which have the hook set in the costing specifications.

Note:

Lot size from the article is not used, if valid costing specifications were found.

Remark Indicates whether a remark exists for this calculation specification. Remarks can also be stored here.

Corrected on Set by the system when the record is created or corrected.

Note
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Via the menu item "Accept costing proposal (plan values)" you can finally accept the new plan values.

Please note that only valid condition values are considered for replanning. For example, if an end date of an item calculation

condition is in the past, no change value will be written into the "New value field" for this record.

Costing proposal (planned conditions)

With the costing proposal (planned conditions) you can change the costing conditions defined in the system via batch processing.

The logic here corresponds to that of the costing proposal (planned values).

Retrieve error log

The error log lists all errors that occurred during the calculation. By clicking on the integrated lookups or the call "Display" in

the menu ribbon, the errors can be edited directly from the mask.

Please note that you will need to recalculate the costing after you fix the error.

Calculation values (matrix)

In this view the rows of the account scheme are superimposed with the columns of the column layout. According to the filters

entered, the values are displayed. By selecting a predefined column layout for comparison, a comparison of two calculation

proposals is possible at this point.

Costing values (structure)

In this view you see all considered costing values in a structure detailed on cost type level. Thereby you have the possibility to

view the origin documents on row level via the call of the same name.

Structure list

Using the structure list, you can view a costing proposal aggregated over all costed levels and their costs.

Structure list comparison

Note

Note

Field Description

Calculation proposal 1

Filter

Select a calculation proposal that you want to have displayed.

Including overhead costs Activate the check box if you want to consider the overhead costs included in the respective

costs.

Material only Activate the check box if you only want to view the material costs.

Cost selection You can use the cost selection to specify the BOM depth over which you want to display the

costs.

Single-level:

Displays the costs of the top level of the BOMs.

Multi-level:

Displays the costs multi-level, broken down to the last assembly/component.

Multi-level:

Displays the costs multi-level, broken down to the last assembly/component.
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With the help of the structure list comparison you can directly compare two costing proposals. This structure list comparison

allows you to see at a glance, through visualized representation in the "Symbol Deviation" fields, at which level a change to the

previous proposal has taken place.

After your selection, you then execute the "Compare" function in the ribbon to compare the values in the row display.

QUOTATION COSTING

In a quotation, you can transfer the corresponding article lines for customer-specific inquiries into a calculation in order to

modify them according to customer-specific requirements and to calculate them separately. The calculated cost price and sales

price can then be transferred to the offer.

Calculate manufacturing costs

With the "Calculate production costing" function, you first initiate the costing for the selected article line. When the function is

executed, a "Simulated production order" is automatically created. Depending on the setting in the "Valuation and calculation

setup", the production order will then also open automatically or not.

For item rows for which a calculation has already been created, the row in the "Calculation tracking rows available" field has the

"Yes" identifier. By clicking on the identifier, the costing lines can be viewed.

Field Description

Calculation Proposal 1

Filter

Select a calculation proposal that you want to compare with another proposal.

Calculation Proposal 2

Filter

Select another calculation proposal that you want to compare with the one already selected from

the "Calculation Proposal 1 Filter"

Including overhead Activate the check box if you want to consider the overhead included in the respective costs in

the comparisons.

Material only Activate the switch if you only want to compare the material costs.

Cost selection You can use the cost selection to specify the BOM depth over which you want to display the

costs.

Single-level:

Displays the costs of the top level of the BOMs. 

Multi-level:

Represents the costs multi-level, broken down to the last assembly/component.
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Calculation tracking lines

This call opens the costing trace lines. The links between the production order and the quotation/order are displayed in the

calculation tracking lines. Several production order lines can be linked to one quotation line.

Delete

By executing the "Delete" function in the ribbon, you can delete a calculation line. If there are no more calculation lines after

executing the function, the sales line will be marked with "No" in the "Calculation tracking lines available" field.

Display E+D order

With this call you can display the corresponding E+D order. At this point, the structure of the E+D order is omitted and only the

fields/calls relevant for the calculation are explained in more detail. Further information about the E+D order can be found here.

Additional costs

Additional costs" allows you to take into account customer-specific quotation requests for the calculation. In addition to general

additional costs, you can also include additional resources, articles or similar. Via the call "Costing condition" you establish the

connection between the additional cost line and the costing elements and thus enable an account assignment of the results of a

costing.

Components

Via the "Components" you have the possibility to change prices and quantities, exchange items and add overhead costs if

necessary.

Work plan

Through the "Routings" you have the possibility to change prices, swap operations and add overhead costs if necessary.

Add calculation tracking manually

With this function you can manually add already calculated E+D order lines and take them into account for the current sales line

if required.

E+D markup calculation

Field Description

Status Indicates whether the quote line is linked to a calculation. When selected, the calculation

tracking lines will be opened.

FA No. Displays the FA number. This can be an FA in "Simulated", "Firmly Scheduled", "Released" or

"Finished" status.

FA line number Indicates to which FA line number the offer / order line number is linked.

Project no. Indicates which project it is

Project task no. Indicates which project task no. is involved.

Project plan line no. The project plan line number is shown here.

E+D project no. Indicates which E+D project number was entered in the production order.

Production order type Displays the production order type from the production order.

Article No. Displays the article number from the production order.

Variants Code Displays the variant from the production order.

Description Display the description from the production order.

Number of costing

proposals (E+D)

Number of costing proposals (E+D) Indicates how many different costings have been carried out

for this production order. There is no differentiation between target and actual costing.
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If the customer asks for certain discounts, the function "E+D markup calculation" is especially helpful, this allows you to run

through possible markup calculations for an offer. 

Costing proposals (E+D)

The costing proposals (E+D) are structured in the same way as the conventional costing proposals. In addition, you can use them

to create a simultaneous cost estimate. 

To do this, you use the function "Calculate unit price/price for unit order" in the costing proposals (E+D). By specifying the

costing base, actual/actual (Posted quantity) and target/actual (Expected quantity) comparisons are available.

You can use the "Change status" and "Adopt costing proposal (Preferred)" functions to adopt the calculated values for the sales

line. 

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Plant Engineering

OVERVIEW

For plant and mechanical engineers, the "Plant Engineering" performance extension makes it possible to track the complex

production and scheduling processes in all phases of a project according to costs and deadlines. The function extension

KUMAVISION "Plant Engineering" describes supplementary performance points to the standard project of Microsoft Dynamics

365 Business Central1. The following is described in more detail:

Project plans with phases, milestones, tasks and responsibilities.

Project progress and commercial project evaluation available in real time

Clear management of internal and external resources

Diverse controlling: budget, material and time expenditure, schedule, quality

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

1. 
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RESOURCE MASTER DATA

Resources include employees or machines. Resource management allows you to plan capacity and deployment in detail and for

an unlimited period of time. 

Furthermore, resources can be grouped into resource groups. Purchase and sales prices can be recorded in detail and budgeted

and invoiced for resources and resource groups.

Establishment

To create a resource in KUMAVISION factory365, the following setups have to be done in advance:

Number series for resource

Set up the number series for the resources so that when a new resource is created, the system automatically assigns a sequential

identifiable number for the resource.

To do this, call up the "Number series" via the user search. You can create a new number series via "New" in the menu ribbon. 

Afterwards, the created number series is stored in the "Resources setup" in the "Resource numbers" field.

Further information can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Units

Set up the "Units" table according to your individual requirements to be able to make the assignment when creating a resource

(base unit code). 

Call up the "Units" via the user search and create the units according to your requirements (for resources it is recommended to

set up the unit "Hour").

Further information can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Basic calendar

The "Base calendar" can be used for several processes in KUMAVISION factory365. In connection with the resource, you can

store a corresponding base calendar, with the help of which, for example, the different holidays in a (federal) country can be

taken into account. 

Example:

In Germany, January 6 (Epiphany) is viewed completely differently - while in Baden-Württemberg and Bavaria, for example, this is

handled as a normal holiday, in North Rhine-Westphalia it is a normal working day. With the help of the stored calendar, resource

availability can be calculated accordingly.

To create a base calendar, call up "Base calendar" via the user search. You can create a new base calendar via "New" in the menu

ribbon.

The assignment of the possible different base calendars is done when the resource is created on the respective resource card.

Further information can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Qualifications

Qualifications can be stored in the resources according to your skills. To define the qualifications, first call them up via the user

search.

Via "New" in the ribbon you can create a new qualification with the help of the table below.

Field Description

Code Assign a meaningful abbreviation for the qualification.

Description Assign a description for the qualification.
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Further information can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Working Time Template

The working time templates allow you to store the different working time models of your employees in the system. Call up the

"Working time templates" via the user search.

Via "New" in the menu ribbon, you can define a new working time template that can be assigned to a resource when it is created.

Further information can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Capacity units

Resource management and capacity determination of production work with different unit tables. For linking the units, the

resource unit is assigned to the capacity unit.

To do this, call up the capacity units via the user search. Via the menu item "Edit list" in the menu ribbon you can edit already

existing capacity units and thus link the resource unit of the capacity unit in the field "Resource units".

Resources

To create a new resource in the system, first call up the "Resources" via the user search. Via "New" in the menu ribbon you can

create a new resource with the help of the table below.
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Inforegister General
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Field Description

No. Specifies the number of the resource according to the specified number series. Alternatively, a

manual assignment can be made.

Name Specifies the name of the resource.

Name 2 Specifies the name 2 of the resource.

Type Indicates what type of resource it is. Choice between "Person" or "Machine".

Base unit Specifies the base unit of the resource e.g. "hour", "piece".

Number of text

modules

Specifies the number of stored text modules.

The text modules are stored in the ribbon - Navigate - Text modules.

Further information on the topic of "Text modules" can be found in the section of the same name.

Search Keyword Specifies an alternative name / abbreviation that you can use to search for the record.

The system will automatically preset the field with the field content "Name", a manual change is

possible.

Res. group no. Specifies the resource group assigned to the resource.

Locked If active, the resource cannot be used in the processes

Privacy lock Specifies whether to restrict access to data of the data subject in daily operation.

Locked (user) Field that activates the lock of the master record (as before). However, the field can now no longer

be changed directly.

Care This indicates whether the record is currently in maintenance or not.

Status mandatory

field check

This field displays whether the mandatory field check was not performed (no check), completely

checked, or incompletely checked.

The lookup on the field can be used to view the missing mandatory fields.

Locked from This shows whether the record is locked by the mandatory field check or by the user.

Corrected on Date of the last correction.

Specific calendar Indicates that the base calendar was used, for a custom calendar.

Working Time

Template

By assigning a working time template, the capacity quantity per weekly working day is determined

when creating the resource capacity. If no working time template is assigned, this is skipped when

the capacity creation function is executed.

Use timesheet If the switch is activated, the resource is available for bookings via the timesheets.

User ID of the time

sheet owner

Specifies the user ID of the timesheet owner.

User ID of the

timesheet approver

Specifies the user ID of the timesheet approver.

Workplace type Defines the type of linking of the resource. The link is taken into account in the resource utilization.

The following options are available:

Workstation group

when the resource is linked to a workstation group.
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Field Description

Workplace

when the resource is linked to a workstation group.

Resource

if the resource is not linked.

Job no. Defines the linked workstation (group) depending on the workstation type.

External resource Marks the resource as External so that it can also be used in the procurement process.

Vendor no. Specifies the vendor to which the external resource belongs.

The system automatically determines the company contact number by entering the vendor number.

Company Contact no. Indicates the company contact to which the resource belongs.

People contact no. Specifies the person contact number to which the external resource belongs.
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Invoicing information register

Field Description

EK price Specifies the purchase price of a unit of the resource.

Indirect costs % Indicates the percentage of the last purchase price of the resource from which indirect costs

arise, such as freight/travel costs or similar associated with the purchase of the resource.

Cost price Indicates the cost of one unit of the resource.

VK Price / DB Calculation Indicates the relationship between the fields "Cost price", "Sales price" and "DB %".

The choices are:

• DB=VK-EP

• VK=EP+DB

• No reference

DB % Specifies the profit margin at which you want to sell the resource. You can enter a contribution

margin manually or have it entered according to the "VK Price / DB Calculation" field.

UK price Indicates the price of one unit of the resource. You can enter the price manually or have it

entered according to the "VK Price / DB Calculation" field.

Credit delivery valuation

group code

Specifies the item group code for the supplier rating.

Further information on the topic of supplier evaluation can be found in the section provided for

this purpose.

Product posting group Specifies the product type of the resource to perform transactions for this resource with the

corresponding G/L account.

VAT - Product booking group Specifies the VAT details of the involved resource to perform

transactions according to the posting matrix.

Standard Accrual

Template

Specifies how revenues and expenses are accrued from periods.

Automatic. Text module Specifies that a text module is added to the documents for this resource.

IC partner Deposit G/L

account no.

Specifies the number of the IC G/L account in your partner's company to which the amounts of

the respective resource are posted.

Product Commission

Group Code

Specifies the product commission group.

With the help of commission groups, resources can be grouped and commissioned separately.

This classification into commission groups is inherited in the sales process in the posted

documents.

For further information, please refer to the "Commission management" section.
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Inforegister Personal Data

Qualification

On the respective resource card, you have the option of assigning a qualification to the respective resource via "Qualifications" in

the menu ribbon. If no qualifications have been set up in the table of the same name, they must be created beforehand.

Depending on the "Projects setup" in the "Check resource qualification" field, the system checks whether the necessary

qualifications for an activity type are available when a resource is entered in the project plan lines.

Set capacity

The capacity of a resource is the amount of work that can be done within a defined period of time (one day). To calculate and

define the capacities of the resource, call up the "Define capacity" function via the menu ribbon in the "Navigate" menu tab.

The "Calculate Res. Capacity" mask opens on which the filtering of the resource is already preset. By specifying the start/end

date, the capacity items can be determined and defined.

The capacity is calculated on the basis of the assigned base calendar and the assigned working time template on the respective

resource card. 

If no allocation of one/both fields has been made, no calculation of capacity can be made.

If capacity items already exist for the calculated resource, the Calculate Res. Capacity application deletes them and creates new

items.

Resource capacity

By calling up "Resource capacity" via the user search, you have the option of viewing the capacity of the resources.

The "Set capacity" function is also available via the "Planning" menu selection on the "Resource capacity matrix" info tab. 

The difference between the call on the resource map and the call in the resource capacity is that when calling from the resource

map a pre-filtering is set on the resource. The call via the resource capacity is not, so that the capacity can be calculated over all

available resources.

Create timesheet

Via the function "Create timesheet..." in the menu ribbon under the menu tab "Actions" you can create a timesheet for the

respective resource.

Field Description

Function Specifies the function of the resource.

Address / Address 2 Specifies the address of the resource.

Location Specifies the location of the address of the resource.

Zip code Specifies the postal code of the resource's address.

Country/Region Code Specifies the country/region of the resource's address.

Social security no. Specifies the social security number of the resource (person).

Training Indicates the education of the resource (person).

Convention Specifies the convention for the resource (person).

Date of employment Indicates the date when the resource was hired.

Note

Note
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To do this, enter the start date from which the timesheet is to be created. As well as the number of periods.

Using the timesheets, the resource can record and submit for your projects, the corresponding project tasks and the times for

the corresponding period.

Further information on this topic can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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PROJECT SETUP

Projects in Microsoft Dynamics 365 Business Central1 are dynamic business transactions that extend over a longer period of

time. These can be planned, controlled and invoiced in detail with the help of activities and budgets.

You can track the use of working hours, machine running times and material for individual projects. This is managed via project

tasks and their associated project plan lines, via which the expenses and revenues are managed.

A project consists of a three-tier structure:

The development of a project can thus be traced down to the smallest detail.

In addition, with the help of integrated invoicing in the Accounts Receivable & Sales and Accounts Payable & Purchasing

modules, all related revenues and expenses are recorded.

The project structure and its processes are shown in a diagram below:

Stage Description

Project Bracket with the essential key data

Project tasks Project tasks subdivide the project into different tasks, such as project management, incidental project

costs, design and development, production, but also meetings, for example.

Project plan

lines

Project plan lines represent the means for task completion such as items, resources, or even item
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Establishment projects

In the "Project setup" the necessary settings for the later project creation and implementation are made. 

In the following the fields are explained to you on the basis of the table below:
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Inforegister General

Inforegister numbering

Inforegister plant engineering

Field Description

Automatic posting of project

item prices

Cost changes are automatically regulated as soon as the batch processing "Stock reg.

fakt. Sett. Prices" is executed.

Apply consumption link by

default

Specify whether project items are linked to project planning lines by default.

Allow budget/billed line

definition

Specifies whether the type of project lines can be "Budget and Billable" by default.

WIP Standard Method Sets the default method to be used for calculating the circulating stock.

Default WIP booking method Defines how to apply the default working capital method when posting the working

capital in the G/L item.

Default project booking group Sets the default booking group to be applied when creating a new project.

Logo position on documents Sets the position of the company logo on the business documents.

Field Description

Project numbers Specifies the number series to be used for assigning the numbers of a project.

Project WIP numbers Specifies the number series to be used for assigning the numbers of the project GDP documents.

Field Description

Project type Dimension If you define a dimension here, you can define in the project types which dimension value for

the dimension should be assigned to a project by the system when assigning the project type.

By setting project type dimensions, you can create analyses about your projects according to

the dimension value.

Check resource

qualification

When entering a resource in the project plan lines, the system checks whether the necessary

qualifications for an activity type are available.

The following selections are available:

No

check is made when resources are used

Planning onlyWhen

maintaining project plan lines, the resource is checked against the necessary qualifications

Booking onlyIt is

checked for the sufficient qualification at the time of booking

Planning and BookingCombination of

Planning Only and Booking Only

Sale position no. from

project plan lines

If the check mark is set, the project task is transferred to the sales document as item no.,

otherwise the item is calculated individually for each order.

Use dimensions from

project references

If the checkmark is set, the dimensions defined in the referenced project plan line are used

instead of the standard dimension line determination of the tables concerned.
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The switch takes into account the following tables:

purchase Row

FA line

FA Components

Stock transfer

Assembly order

Assembly order items

Information register production

Inforegister Logistics

Inforegister Outlook ToDos

• 

• 

• 

• 

• 

• 

Field Description

When the project status changes,

automatically change the FA status to

You can use this switch to specify whether any existing production order should also

be changed from status to status when the status of the project is changed, and if

so, to which FA status.

Field Description

Create project storage

location

For the procurement and logistics processes, you use this to specify whether the system should

create a project storage location for each project.

The project storage location hereby represents the place of performance of the project.

Stock entry entry storage location code For the procurement and logistics processes you define here a

warehouse from which the warehouse setup for the financial accounting is to be copied.

The field "Stock entry one location code" can only be maintained if the storage location creation is

activated ("Create project storage location").

Preferred transit code For the procurement and logistics processes, enter the transit code for the project warehouse

transfer route here.

The "Preferred transit code" field can be maintained only if the storage location creation ("Create

project storage location") is enabled.

Preferred delivery code For the procurement and logistics processes, enter the delivery agent code for the project

warehouse transfer route here.

The field "Preferred delivery code" can only be maintained if the storage location creation

("Create project storage location") is activated.

Preferred carrier

transport code

For the procurement and logistics processes, enter the delivery agent transport type code for the

project warehouse transfer route here.

The field "Preferred delivery transport code" can only be maintained if the storage location

creation ("Create project storage location") is activated.

Field Description

Step CRM task If you are working without a project outline, use this field to specify the increment for creating new

project tasks.

Separator CRM

task

If you work without a project breakdown, use this field to specify the separator for creating new

project tasks.

Counter CRM task If you work without project breakdown, set the counter for creating new project tasks in this field.
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Inforegister Commitment

Inforegister Version comparison

Project accounts

In the projects for plant construction, consumption and sales postings are displayed on a project chart of accounts, which is used

for project controlling. The selection of the corresponding project accounts is controlled via the project account setup.

Field Description

Smallest FA status for target cost

consideration

Define here from which FA status the target costs are to be displayed as

planned costs.

Field Description

First archiving

version no.

In this field, specify the first archiving number of a version number assignment.

If only in left

version,

If only in right

version,

If version identical,

If versions different,

If subordinate line differs You can use these fields to specify the visual display in the version

comparison. You can choose from:

None:

Display in black font color (serves as an identifier that no deliberate setup has been done yet)

Standard:

Display in black font color

StandardAccent:

Display in blue font color

Strong:

Display in black font color, bold

StrongAccent:

Display in blue font color, bold

Attention:

Display in red font color, italic

AttentionAccent:

Display in blue font color, italic

Favorable:

Display in green font color, bold

Unfavorable:

Displayed in red font color, italic, bold

Ambiguous:

Displayed in yellow font color

Subordinate:

Displayed in gray font color

Compare only set up

fields

With this switch you can globally define whether only set up fields should be compared or possibly

individual comparison setups should be allowed via the "Version comparison field setup".

If the switch is activated, individual comparison setups can be made via the "Version comparison

field setup" via the "Consider in field comparison" column.

If the switch is deactivated, the "Consider in field comparison" column is not editable.
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Project Chart of Accounts

The project chart of accounts is used for project controlling and contains all sales and cost accounts that are to be used for a

differentiated project view. The project chart of accounts is not dependent on the FIBU chart of accounts.

In the "Account type" field you can choose between five options:

After you have set up the project account, select "Actions" > "Indent Chart of Accounts" in the ribbon. Then select the "Yes"

option in the message window.

Project account setup

The procedure is almost identical to setting up the posting matrix in the financial accounting area.

The project account setup determines the project accounts to which consumption and revenue are posted or budgeted in plant

construction. The project account setup is a matrix that defines the consumption and sales accounts for product posting groups. 

The project type is taken from the project card when accessing the project account setup. The activity type, on the other hand, is

taken from the project task line.

If no match is found using the project type, activity type and product posting group, an error message appears.

Each project item is assigned either a consumption account or a sales account depending on its item type (consumption or sales).

The field contents of the project item are used to determine the project account.

Project Roles

The project roles define in the later projects which role (e.g. project manager) the resource takes in the respective project.

To define the project roles in advance, call them up via the user search. Via "New" in the menu ribbon you can create a new

project role with the help of the table below.

Service type

It is important for the later task planning in the projects to set up the activity types. To do this, call up the activity types via the

user search.

Field Description

Account A bookable account can be selected.

Headline Text line in which a heading can be entered as a structure feature.

Total A sum defined by the "Total" field.

From-Sum An initial marker for a totaling project account series that ends with the To Total account type.

To-Sum An end marker for a totalizing project account series that starts with the From Total account type. The

total is defined using the Totalization field.

Field Description

Code Assign a meaningful abbreviation for the project role.

Description Assign a description for the project role.

Type Assign an applicable type. You can choose from the following:

• Responsible

• Project Manager

• Sale to contact no.

• Invoice to contact no.
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Via "New" in the menu ribbon you can define a new service type with the help of the table below.
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Field Description

Code Assign a meaningful abbreviation for the activity type.

Description Assign a description for the service type.

Type Specifies the type that the record is. You can choose from the following:

• Account

• Headline

• Total

• From-Sum

• To-Sum

Counting up Here you can now specify the interval or other filter specification of numbers of the service type.

The results of the specified service type are added to a total balance. 

For the From sum or Heading type, this field must be left blank.

For the To-total type, the field is automatically filled when the chart of accounts is indented. Only

the types that are between a From total and a To total are added together.

Qualifications Indicates the number of qualifications required for the service type.

Via a LookUp on the number, qualifications can be assigned to the activity type and already

existing ones are displayed to you.

Further information on the subject of qualifications can be found in the section of the same name.

Usage NoneThere is

no task scheduling, the fields are not editable in the project task.

Task planningYou

can enter planning directly in the project tasks.

ForecastThere is

no task planning, the fields are not editable in the project task.

BothYou

can enter planning directly in the project tasks.

Type planning Via the type of planning you determine the type with which the task planning is to be entered in

the planning line.

You can choose from the following:

- Resource

- Article

- G/L account

Planning no. Via the planning no. you determine, depending on the type of planning, with which account the

task planning is to be displayed in the planning line.

Work type code Specifies the work type code for the activity type.

Art Forecast Specifies the type forecast for the service type.

You can choose from the following:

• Resource

• Article

• G/L account

Forecastnr. Specifies the forecast no. in the context of the "Type Forcast" field.
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Project types

When creating a new project, you can define the type of project by assigning a "project type". Here you can already enter some

data such as a project template, order type or similar. 

To define the project types in advance, call up the project types via the user search. Via "New" in the menu ribbon you can define

a new project type with the help of the table below.

Project breakdown

The project structure helps you to enter and maintain your project tasks quickly and efficiently with predefined numbering.

Call up the "Project outline" via the user search.

Field Description

Forecast work type

code

Specifies the forecast work type code.

Cross country skiing

articles

Identifies a project task with the assigned activity type as a "long-run item".

Stage Description

Code Assign a meaningful abbreviation for the project type.

Description Enter a description for the project type.

Project booking group Enter the project booking group for the project type to be used when assigning the project type.

Please note that if the "Template project no." is maintained (see below), this information is

ignored. (see below) this information will be ignored.

Project number series Specify the project number series for the project type to be used when creating a project and

assigning the project type.

Template Project No. Specifies the project no. to submit the project for the project type.

Project type Dimension

value

Specifies the dimension value for the project type.

Dimension code Specifies the dimension code.

Dimension Value Prefix Specifies the dimension value prefix.

Task breakdown Specifies a task breakdown for the project type.

Please note that if the "Template project no." is maintained (see above), this information is

ignored. (see above) this information will be ignored.

Reserve Specifies the reservation method for the project type.

The following are available for selection:

• Never

• Optional

• Always

Order type In the project type, you can set up an order type for the creation of sales documents, if required.

This will be used when creating the documents.
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Via "New" you can create a new project outline using the table and procedure below.

To define the outline for the created dataset, call up the "Outline structure" menu item via the ribbon.

Project Document Text Template

For easy editing/creation of the document texts in the projects, you can define project text templates in which you specify how

and when which data record is to be printed in which document.

Please note that pre- and post-texts on the project tasks are not passed on to subsequent documents. This is only possible with texts

on project plan lines.

To do this, call up the "Project document templates" via the user search.

Field Description

Code Define a unique code for the record here.

Description Define a short description for the outline here.

Status Indicates the status of the outline.

The following are available for selection:

• New

• Certified

• In development

• Expired

Note

Please note that only project members with the status "Certified" can be used in the processes.

Field Description

Level Level or indentation of the task.

Description Enter a description for the layer here

Increase Define with which intervals the system should assign tasks, 1 for one step, 10 for ten steps etc.

Based on the increment, the Counter field is initialized.

Counter Here you can define with which value the level should be started and how wide the level can be. For

example, enter 001 if the layer can reach a maximum value of 999. Please note that the Project task field

only has a maximum width of 20 characters.

Separator Define a separator here, e.g. period, comma, hyphen

Count type • Numeric

• Alphanumeric

please specify alphanumeric if your counter contains letters.

Bookable Specify whether it is possible to post on the level

Example Represents the current definition, as a project task.

Note
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Via "New" you can create a new project document template using the table below.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

Project table Use this field to specify for which table the definition is valid.

The following selection is available:

• Project Task

• Project planning line

Line type Use this field to specify for which line type the definition is valid.

The following selection is available:

• Budget

• Invoiceable

• Budget and Invoiceable

Position In this field, specify how the definition is valid for which position.

The following selection is available:

• Pretext

• Post text

Service Contract Offer Printing In this field, specify whether the text should be printed on Service contract offer.

Service contract printing Use this field to specify whether the text should be printed on the service contract.

Service offer printing Use this field to specify whether the text should be printed on the service offer.

Service Order Printing Use this field to specify whether the text should be printed on the service order.

Service Geb. Invoice Printing Use this field to specify whether the text should be printed on the service invoice.

Service Geb. Credit Print Use this field to specify whether the text is to be printed on the service credit note.

Service Geb. Delivery Print In this field, specify whether the text is to be printed on the service delivery.

Service work ticket printing In this field, specify whether the text should be printed on service work ticket.

VK offer pressure In this field, specify whether the text should be printed on VK offer.

VK Order Printing Use this field to specify whether the text should be printed on VK Order.

VK Geb. Invoice Print Use this field to specify whether the text should be printed on VK Geb. Rechnung.

VK Geb. credit print Use this field to specify whether the text should be printed on VK Geb. Gutschrift.

VK Blanket order printing Use this field to specify whether the text should be printed on VK Blanket Order.

1. 
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PROJECT PLANNING

In the following, you will be introduced to project planning. It will be shown how a project can be structured and how plan values

can be stored.

Project Assistant

For a quick and easy creation of a project KUMAVISION factory365 offers a wizard for project creation.

For this, it is first necessary that the user has assigned the role center "Project Manager" in the user customization.

On the start page of the "Project Manager" role center, the "New Project" call is located in the activities area.

After clicking on the call, the wizard will be started.

Creation progress

The "Creation progress" screen is used for the navigation/status overview of the project wizard.

This is divided into four sub-areas with their respective statuses:

Copy project

General project data

Sale to data

Invoice to data

Furthermore, the current processing step with the overall progress status is displayed.

In the lower area of the mask you have the following selection options:

• 

• 

• 

• 
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Copy project
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Field Description

Project type Specifies the type of project it is.

Template Project

No.

Specifies the project no. to submit the new project.

If a project template is already stored in the project type, it will be preset automatically.

Transfer from

project:

(Copy project

awards,

Copy quantity,

Copy milestones,

Copy document

texts)

From the "Template Project No.", if it is activated, the following data can be transferred from the

template to the new project:

• Copy project prices

• Copy quantity

• Copy milestones

• Copy document texts

Copy risks Here the risks from the "Template project" can be taken over for the project to be created.

The following selection options are available:

• No

• Risks only

• With values

• with probabilities

Project task no.

from

Here the project tasks can be taken over from the "Template project" for the project to be created.

Specification of the "Project task no. from" value.

Project task no.

until

Here the project tasks can be taken over from the "Template project" for the project to be created.

Specification of the "Project task no. to" value.

Start date / End

date

Specifies the scheduled start/end date of the project.

Origin Set:

None:

Do not create plan lines when copying

Project plan lines:

Project plan lines to be copied from the template project using the project plan lines

Project items:

Generate project plan lines based on the project items from the template project.

Line type Depending on the project plan line origin, you can define which line type(s) you want to

transfer:

Project plan lines:

- Budget + BillableAll 

project plan lines

- BudgetOnly budget 

marked project plan lines

- BillableOnly 

billable marked project plan lines.

Project item:

- Consumption+SalesAll 

project plan lines

- Consumption 
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General project data

Sale to data

If you have gone through the project wizard and have filled in all the necessary fields with the corresponding data, you can

create the project by clicking on "Create project".

The project map will be opened for you after creation in order to be able to enter further information. Alternatively, you can close

the project map.

Project map

Inforegister General

Field Description

Only consumption marked project items

- SaleOnly sale marked project items

Field Description

Unit of responsibility

code

This field can be used to assign the project to a unit of responsibility. The unit of responsibility is

copied from the customer to the project and is used for information purposes only. The field has no

effect on visibility control nor is the unit of responsibility inherited from the project to the

documents created from the project.

Responsible Specifies the person who is responsible for the job.

Project Manager Specifies the person who is responsible for project management.

Project description /

Project description 2

Specifies the project description

Start date / End date Specifies the start date / end date of the project.

New storage location

code

Specifies a new storage location code.

Field Description

Sale to contact Specifies the contact at the customer who is responsible for the order.

Sales to debtor Specifies the customer no. to which the cost of the project is to be charged.

If you have previously maintained the "Sales to contact" field, this field will automatically default to the

linked customer.
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On the "General" info tab, the general data of the project are defined first. These are explained in more detail below:
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Field Description

No. Specifies the number of the project of the correspondingly defined number series.

Description /

Description 2

Specifies the description of the project.

Project type Indicates what type the project is.

If the following data has already been stored in the project type, it will be transferred to the project

when the project type is assigned:

• Project booking group

• Project number series

• Template Project No.

• Project type Dimension code

• Dimension code

• Dimension Value Prefix

• Task breakdown

• Reserve

• Order type

Sell to deb. no. Indicates the number of the customer who usually bears the costs for the project.

Sell to deb.

template code

To create a project to a contact, the corresponding contact number is specified and the "Sales to deb.

template code" field is filled with the appropriate template.

Sell to contact no. Indicates the contact of the customer, who usually bears the costs for the project.

In the Planning and Offer statuses, it is also possible to work with pure contact addresses. When the

status changes to Open, a customer is created for the contact.

Note

Pleace note, that in case of using contacts, the field "Sales to deb. template code" or "Invoice to deb.

template code" must be maintained. To deb. template code" field must be maintained.

Sell to name /

name 2 / name 3

Specifies the name of the customer who usually bears the costs for the project.

Sell to address /

address 2

Specifies the address of the customer to whom you usually send the invoice.

Rech. to deb. no. Indicates the number of the customer who usually bears the costs for the project.

By assigning the "Sales to customer no." field, the "Invoice to customer no." field is automatically

preassigned with the "Sales. To customer no." field automatically.

If there is a different invoice recipient, the corresponding number must be changed manually.

Rech. to deb.

template code

Specifies the "Rech. an Deb. template code".

Rech. to contact

no.

Specifies the contact no. of the invoice recipient.

Rech. to Name /

Name 2

Specifies the names of the invoice recipient.

Rech. to address /

address

Specifies the address of the invoice recipient.

Rech. to zip code Specifies the postal code of the invoice recipient.

Rech. on site Specifies the location of the invoice recipient.
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Inforegister Tasks

On the "Tasks" info tab, the project tasks that are/will be planned in the project are first defined. This is the first "rough

planning" for the project.

Task breakdown

The task outline is used for the systematic and clear presentation of the project tasks and enables a uniform structure across the

projects by means of predefined outline structures. The task outline is assigned to the project in the "Task outline" field in the

project map. Using the following functions, you can insert the task outline into the project task lines.

Insert Outline Structure Function

You can call up the "Insert Outline Structure" function on the respective project card via the ribbon. This function inserts a

completely new outline structure at the end of the structure details.

Insert outline structure to postable function

You can call up the "Insert outline structure up to bookable" function on the respective project card via the ribbon. This function

inserts an outline structure up to and including the first bookable outline structure.

Project tasks

If you have previously inserted an outline structure in the project task rows, you have the option to insert a new row below an

outline structure level via the [...] Assist button. 

The system inserts a new line with the position numbering and description of the layers above.

Field Description

Rech. to country/

region code

Specifies the country/region code of the invoice recipient.

Rech. to contact Specifies the name of the customer who usually bears the costs for the project.

Phone no. / Mobile

phone no.

Specifies the stored phone number of the customer.

E-mail Specifies the deposited e-mail address of the customer.

Search Keyword Specifies the search term of the project. This is automatically pre-populated with the description of

the project and can be changed manually.

Unit of

responsibility code

This field can be used to assign the project to a unit of responsibility. The unit of responsibility is

copied from the customer to the project and is used for information purposes only. The field has no

effect on visibility control nor is the unit of responsibility inherited from the project to the documents

created from the project.

Responsible Specifies the person who is responsible for the job.

Locked Please transfer from the customer or other master data

Task breakdown Specifies the task breakdown to be used for the project.

Archived version Indicates the number of archived versions. A lookup makes it possible to view the versions.

Corrected on Indicates when the project data of the project map was last changed.

Project Manager Specifies the person who manages the project.
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Now enter the project tasks that occur / are planned in the project using the table below.
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Field Description

Project task no. Specifies the number of the project task

Description Specifies the description of the project task

Project Task Type Specifies the type of project task.

The choices are: 

• Account

• Headline

• Total

• From-Sum

• To-Sum

Service type In this field, assign the activity type for the project task in case of an

account.

With the activity type you influence the project account determination

and have the possibilities to influence the maintenance of the project

plan lines.

Previous milestone Indicates a dependency on a previous milestone.

Milestone Specify here that the task is a milestone. A task can only be set as a

milestone if type=total.

Due to the type=total, the values for a milestone can be easily tracked

using the flowfields for costs and revenues. Based on the flowfields,

the user can also dive into the plan lines or project items to analyze

the milestone situation.

Milestone date Set here when the milestone is due.

Belongs to Milestone Specify here to which milestone the task belongs.

Status Indicates the status of the project task.

If a project task is finished, the corresponding plan lines are set to

100% during task progress.

Cross country skiing articles The checkmark "Long run item" identifies a project task as a task for

long run items.

For more information on "cross-country skiing articles", see the

section with the same name.

Task See a possible CRM task created from this here

Task status Status of the task, see for details there

Distribution type Define here which distribution type should be used to distribute the

possibly created project plan lines between start and end time.

Maintenance is necessary if you carry out quick

planning directly via the project tasks and the

planning type is set to Resource.

Start date Specifies the start date for the project task.

If you have activated date maintenance at task level, you can change

the planning date of the start line via the task.

The system creates a new project plan line with the

type text and the default text code stored in the
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Field Description

setup. The date is transferred to the Planning date

field.

End date Specifies the end date for the project task.

If you have activated date maintenance at task level, you can change

the planning date of the end line via the task.

The system creates a new project plan line with the type text and the

default text code stored in the setup. The date is transferred to the

Planning date field.

Working days The number of working days between the start and end dates,

provided that the planning type is Resource and the resource capacity

has been defined for the resource.

Budget (cost price) Specifies the budgeted cost price for the project task depending on

the time period of the "planning date filter".

Actual cost amount Specifies the cost amount for the consumption of items, resources,

and expense line items posted to the project task depending on the

"Planning Date Filter" period.

Archived consumption Cost amount (MW) See consumption in an archived version for comparison.

Billable (sales amount) Specifies the billable sales amount for the project task depending on

the period of the "planning date filter".

Invoiced (sales amount) Specifies the billable sales amount for the project task depending on

the period of the "planning date filter".

Purchase commitments Amount (MW) See here the purchase order commitment (MW) (values of open

purchase orders) for the project task.

Actual messages (MW) See here the value for the production orders/articles already created

for the project task.

Capacity costs (MW) See here the value for the capacity costs (machine and personnel

costs) already paid for the project task.

Consumption costs (MW) See here the value for the material consumptions already done for the

project task.

Planned consumption costs production order (MW) Indicates the planned consumption costs (planned material

requirements) based on a generated production order.

Planned capacity costs production order (MW) Indicates the planned capacity costs (planned machine usage) based

on a generated production order.

Initial order Amount (MW) Represents the sales amount of the initial order.

Follow-up order(s) Amount (MW) Represents the sales amount of the follow-up order.

Variance(s) Amount (MW) Represents the amount generated via the forecast.

Actual progress % Indicates the actual progress of the project task in %.

Actual progress date Indicates the date of the actual progress of the project task.

Forecast (MW) If you set the forecast to "Project task", use this field to specify the

total costs you currently expect for the project task.

For the calculation of the forecast (MW), the system determines it as

follows:
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Engage/disengage

The function Project Tasks Move In and Move Out only works with defined task breakdown in the project map as well as project

task type Account.

You can call up the "Engage/disengage" functions via the "Tasks" info tab using the "Line" menu selection.

Indent:

When the function "Indent" is called, the current line is indented one level down and bracketed by a from-sum and a to-sum line.

The description of the indented line is assigned to the from/to sum line. The new project task gets the description from the

default. The already entered plan lines are also assigned to the new line.

Disengage

When the Move function is called, the current line is moved up one level. If it is not the last position of the task block, the next

number of the upper range is used. If it is the last position, the task block is deleted and the task number is assigned to the from

total.

Task numbering

Task determination is based on the outline structure and depends on the current position and project task type of the row.

If a line is inserted between existing positions, the system inserts a continuing line to the upper line.

If a line is inserted at the bottom, the next project task number is inserted based on the top line.

Document texts Project tasks

You can describe a project task in detail using a long text. This long text is printed on the documents you define.

To define a document text for a task, first select the desired task line in the "Tasks" info tab.

Using the "Line" menu selection on the "Tasks" info tab, you then select the "Document text" menu item.

You can now decide whether you want to enter a pre-text or a post-text for the line.

The project document text map opens.

Call up the "Format Editor" via the menu ribbon and enter your desired text in the editor text field. After confirming the entry

with "OK", your text will be displayed in the "Preview" field.

Please note that pre- and post-texts on the project header and on the project tasks are not passed on to subsequent documents. This

is only possible with texts on project plan lines.

Create tasks

Via "Create tasks" you can create tasks or Outlook tasks such as a meeting invitation.

When you create a task, a project task is created for you in the background. The project task is created within the From task you

selected.

Field Description

(Consumption (cost price)

Time commitment Amount (MW)

Purchase commitments Amount (MW)

Stock commitment Amount (MW)

Production commitments Amount (MW))

Actual progress %

Forecast(MW)

Note
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You can create the tasks in the project area using the Tasks call in the Project Map, Project Tasks as well as from the Project

Team.

Please note that the creation of an Outlook task is only possible with the corresponding setup. Further information about the

connection / setup can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

The plan lines can only be changed via the CRM task (contact tasks).

In the "Project setup" you define how the project task no. is created via the fields "Step size CRM task", "Separator CRM task" as

well as "Counter CRM task". Further information can be found here.

Alternatively, you can also create a task directly from a contact card by entering a project number.

Create activity

Via "Create activity" you can create activities and/or communications such as telephone calls from Microsoft Dynamics 365

Business Central1 and file associated documents. The time defined at this point is transferred to the timesheet.

You can call the "Create activity" function from the project map, project overview, project task, project plan line as well as from

the project team map.

Assign the activity type as well as description of the activity. The seller code is determined based on your registration.

In the project fields, specify to which project task the document should be assigned and to which plan item the times should be

recorded.

If you have selected the project plan position, the system will create an entry for you in the work time table (the prerequisite for

this is the use of working times).

For further information on the topic of "Creating activities", please refer to the Microsoft Dynamics 365 Business Central1

Helpsite.

Milestones

Milestones serve as intermediate goals within a project. Based on these goals, "smaller stages" can be logged as project progress

within a project or dependencies to further milestones or tasks can be defined.

In KUMAVISION factory365 you have the possibility to assign milestones to the project tasks.

Establishment

In the "Projects setup" you can globally control the behavior for all milestones via the "Milestone behavior" field. You can choose

from the following options:

Capture

Note

Note

Field Description

Behavior milestone Define here how the system should behave when maintaining milestones in the area of date violations:

NoneThe

milestone is ignored

WarningThe

system alerts you to a violation

ErrorThe

system prohibits you from a time violation
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A milestone is entered on the respective project card on the "Task" info tab in the respective task line via the "Milestone" field. In

the following, the relevant fields on the task line for the identification of a milestone are explained in more detail:

Milestone behavior

For maintenance start and end date

The maintenance of start and end date in the project task is checked against a possibly assigned milestone. See also description

for milestone date

For care status

If the status of a milestone is set to completed, the system will ask you whether all associated project tasks should also be set to

completed and will also execute this if confirmed.

If you also use KUMAVISION Down Payment Accounting, it will also check here if a down payment plan by milestone is maintained

and generate the down payment invoice assigned for it.

When care summation

You can assign the milestone to the project tasks defined in the "Filter criterion" by maintaining the "Total" field.

The same checks or updates are performed as for the assignment via the Belongs to milestone field.

For maintenance project task type

If the project task type is set to Account, the start and end dates will be processed, with all other settings any milestone

information will be deleted.

Cross country skiing articles

Field Description

Milestone In this field, specify that the task line is a milestone.

A task line can only be set as a milestone with type=sum.

Due to the type=total, the values for a milestone can be easily tracked using the flowfields for costs and

revenues. Based on the flowfields, the user can also dive into the plan lines or project items to analyze the

milestone situation.

When you mark a project task as a milestone, any maintained "Belongs to Milestone" field is cleared.

Field Description

Milestone date In this field you can set the due date of the milestone.

If you have not set the Milestone behavior to None in the project setup, the system checks:

• If the project task is marked as a milestone

• The project end date is not before the milestone date

• The project start date is not after the milestone date

• If the milestone has already been assigned project tasks, the milestone date also checks against

existing project plan lines as well as project items of the assigned tasks.

The milestone date of the associated project task is also updated with the milestone date of the

milestone in this process.

If a milestone date is not already maintained, this is initialized with the end date of the project.

When deactivating (unchecking) the "Milestone" field, the milestone date will be cleared.

Belongs to

Milestone

Specify here to which milestone the task belongs.

Maintaining the field updates the Milestone Summary field and the Milestone Date checks are run as

described there.

Note
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By means of the long run articles a long run planning and administration can be accomplished. Article items with a long

procurement time are created as project plan lines in the project. Later, these articles can be used as components in project-

related production orders. In this way, the requirements for these long-run items are triggered directly from the project, even

without a production order already existing or the position of the component in the production order being known. If the

production order is then created and the components are defined in the order, the requirements coverage of the component can

be linked directly to the long-run item in the project. 

Establishment

The cross-country items are set up in the project via the project tasks. For this purpose, separate tasks should be created in the

project for long-run items. The "Cross-country item" check mark identifies a project task as a task for a cross-country item. 

The checkmark "Long-run article" in a project task means that only project plan lines of the type "Article" and "Text" may be created

for this project task. The lines with the type "Article" represent the long-run articles. The lines with the type "Text" can be used for

groupings or notes. 

If now for the project task, project plan lines are entered, the items with the type "Article" are automatically provided with the

indicator "Long run article". 

Transferring project plan lines that are marked as "long-run items" to project book sheets or posting these lines is not allowed and is

intercepted by corresponding error messages.

After the project plan lines have been created for the corresponding long-run items, procurement documents / procurement

processes can be triggered for these project plan lines in order to achieve the corresponding coverage of requirements for these

long-run items. 

The created procurement documents should be compellingly reserved for the project plan lines. On the one hand, the quantity in the

procurement document is then considered reserved, and on the other hand, only reserved procurement quantities can be transferred

from the project plan line "Long-run items" to the corresponding FA component. Only the quantity that is already covered by the

procurement documents can be assigned to an FA component, regardless of the quantity of the project plan line itself.

Cross-country skiing articles as components in FA and E+D order

If a long-run item has been defined in the project, it can also be viewed in project-related production orders. In this case, the

"Long-run item" label is managed in the FA components in the "Long-run item" field itself. 

In order for a component to be recognized as a long-run item in the production order and in the E+D order, the following criteria

must be met:

Project number must be set as project reference in the FA component.

The article number, variant code and storage location code must match between the project plan line marked as a long-run

item and the FA component. 

In addition, the quantity that has already been linked / used for this FA component by a long-run item project plan line can be

viewed in the "Long-run item linked quantity (base)" field.

The fields "Long-run item" and "Long-run item linked quantity (base)" can also be viewed accordingly in the lines of an E+D

order. 

Note

Note

Note

• 

• 
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Although it is possible to display directly for an FA component or E+D order line whether it is a long-run item, the available

quantity of the long-run item cannot be displayed directly. This is due to the fact that it is calculated based on the reservations

for the long-run project plan lines, taking into account the due date of the FA component and the planning date of the project

plan lines. Further, there is the fact that a long-run article project plan line can serve several FA components, but there can also

be several long-run article project plan lines for one article. Therefore, the available quantity of a long-run article is always

calculated at runtime. This is done in the "Long-run article overview" screen. This overview can be called from the FA

components and E+D order lines respectively. 

To do this, call up the cross-country skiing article overview via the "Line" > "Line" > "Cross-country skiing article overview" info

tab.

By means of the "Long-run item overview" mask, not only the quantity available for allocations can be viewed. This screen is also

used to set or cancel links between FA components and long-run item project plan lines. In this way, the procurement quantity

already reserved for the project plan line is transferred to the FA component or, in the case of cancellation, written back from the

FA component to the project plan line. 

The "Long run item overview" screen can be called up not only for FA components or E+D order lines. It can also be displayed for the

entire production order / E+D order. The overview can also be used from the project. Here it can be called up for project plan lines,

project tasks and the entire project. The information and handling of the "Cross-country items overview" mask is described in the

following sections.

Structure of the cross country skiing article overview

The "Long-run item overview" screen shows the quantities available for links to the long-run item project plan lines for FA

components. Furthermore, this mask offers the possibility to directly set links between FA components and long-run article

project plan lines and thus to transfer the already reserved quantity from the project plan line to the FA component. It is also

possible to delete these links. 

The structure of the cross-country article overview, the individual calls and functions of the mask are described below. 

Data areas of the cross country skiing article overview Origin address

In the upper area of the long run article overview, the field "Called from" shows from where the long run article overview was

called. E.g. from the FA component, the production order or the project.

Overview post

The summary items are displayed in the rows area. The overview items are formed on the basis of FA components and project

plan lines and are created as main items and sub-items. If the long-run item overview is called up from a production order or

E+D order, the main items are created on the basis of FA components. The associated sub-items are created on the basis of the

project plan lines, which are possible requirement coverers for these long-run items. If, on the other hand, the long-run article

overview is called up from a project, the main items are created on the basis of project plan lines and the sub-items are created

by the FA components as possible requirements originators.

Note text

This area displays a short note text for the selected item. (If a note exists for this item).

Post details

In the info boxes area, the details of the respective item are displayed. The item origin (FA line / project plan line), the item type

(main item / sub-item), item and variant information as well as the due date and the storage location where the item is required

are displayed. In addition, the quantity information is displayed here and whether the item is to be considered "Available". The

quantity display in the overview items is explained below.

Quantity display in the cross country article overview

Note
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The aim of the long-run item overview is to show how FA components can be covered by the long-run item project plan lines

already in the MRP. For this purpose, the quantities of the long-run items must also be displayed accordingly. The display of the

quantities in the long-run item overview depends on whether they are main items or sub-items. In addition, there are separate

fields for each reference (FA component, project plan line) that represent the quantities. Basically, for each main item, the sum of

the sub-items is also calculated. 

Example:

If the main item is an FA component, the sum of the quantities of its sub-items (project plan lines) that can be used to cover the

requirements of the FA component is also formed for this main item. If the main item is a long-run project plan line, the FA

components that could be covered by this project plan line are displayed as sub-items.

Basically, the quantity fields have the following meaning: 

Quantity fields FA component

Quantity fields Project plan line 

For a main item (FA component or project plan line), sub-items can be displayed that have the "Unavailable item" checkmark set.

These items cannot be covered or used to cover requirements. 

An item is marked as "not available" if there is a date conflict between the FA component and the planning line. I.e. the FA

component cannot be covered in time based on the planning date of the project plan line. Another reason would be if the quantity of

the FA component is already completely covered (the remaining quantity is completely reserved) or if there is no available quantity in

the project plan line. These items are then no longer used for requirements coverage, but they are still displayed to show the

overview of the links that already exist between the project plan lines and FA components and to indicate date conflicts. These

positions are marked accordingly and provided with a note text.

Actions of the cross country skiing article overview

Field Description

Residual quantity

(base)

Displays the remaining quantity of the FA component line to the base unit. The remaining quantity

represents the portion of the expected component quantity that has not yet been consumed.

Reserved quantity

(base)

The quantity in base unit that has already been reserved for the component line from procurement

documents or warehouse stock is displayed here.

Linked quantity

(base)

This field displays the quantity in base unit that has already been linked to project plan lines for long-

run items.

Open quantity

(base)

The "Open quantity" for the base unit is displayed here. The open quantity is the quantity that still has

to be covered by reservations or links to long-run article project plan lines in order to ensure

procurement for the remaining quantity of the FA component.

Open quantity = Remaining quantity - Reserved quantity

Field Description

Quantity (base) This field displays the quantity of the project plan line as a long-run item for the base unit. This field is

purely informative and shows the planned quantity of the project plan line.

Linked quantity

(base)

This field displays the already linked quantity of the project plan line with FA components.

Available range

(base)

In this field the quantity of the project plan line available for links to the base unit is displayed. The

available quantity is the reserved quantity of a project plan line, because only the quantities that are

reserved on procurement documents or warehouse stock can be passed on to an FA component.

Note
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The mask "Long run article overview" has actions with which the view of the mask can be controlled, but also links between long

run article project plan lines and FA components can be created or deleted again. The individual actions are described below:

Setting and deleting long-run article links

Setting and deleting links between long-run article project plan lines and the corresponding FA components is triggered from the

long-run article overview. The actions "Set link" and "Delete link" are used for this purpose.

The setting and deletion of links is explained below on the basis of the call of the cross-country article overview for an FA

component. The reason for this is that the setting and deletion of links always starts from the FA component, regardless of how

the "Cross-country skiing article overview" screen was called up. Depending on the call, only the filtering of corresponding FA

components takes place, which are then processed one after the other, in which the links are set or removed accordingly.

Setting links

When setting a long-run article link for a FA component line, the system checks whether this component corresponds to a long-

run article in project plan lines. For this purpose, the system checks whether the component has a project reference and whether

these project plan lines marked as long-run articles have the same article / variant / storage location combination. If this is the

case, the corresponding project plan lines are used as possible default lines. In this case, the planning date of the project plan

lines is filtered so that they are before or the same as the due date of the component. The date filtering is important so that the

requirement-covering documents for the project plan line can also be used for the FA component line. The link can now be set

until the FA component "open quantity" is 0 (zero) or there is no more available quantity in the filtered long run item project plan

lines.

The link is set with the "Set Link" function for the FA component line.

After the link has been set, a corresponding "long-run article link item" is also created. This item records which FA component

was linked to which project plan line with which quantity. The fields "Linked quantity (base)" in the FA component and the

project plan line are also calculated on the basis of these items. 

The linking items can also be viewed in the cross-country article overview.

The link transfers the reservation (proportionate to the linked quantity) from the project plan line to the FA component. This also

results in a direct link of the requirement-covering document (e.g. a purchase order) with the FA component. 

However, the link also has a direct effect on the project plan line. In order to reduce the demand for the long-run article for the

project accordingly and to minimize redundancy of the demand between the FA component and the project plan line, the quantity

of the project plan line itself is also reduced. 

Delete shortcuts

The deletion of link items has two integrated steps. Firstly, resetting the existing link according to the long-run item link. The

other is the transfer of the reservation without the long-run item link.

In the first stage, using the long-run article link items, the link is undone by moving the reservation in the amount of the linked

quantity from the FA component to the project plan line listed in the item. 

In the second stage, the system checks whether there is still a reserved quantity for the FA component beyond the link. I.e. after

deleting the link, there is still a "Reserved quantity" for the FA component, which may have been set by manual reservations. If

this is the case, the reservation is also transferred to the first matching project plan line. The aim of this transfer is to always

Action Description

Recalculate By means of this action the data in the mask are recalculated and displayed. This action is used to update

the mask.

Set shortcut This action sets links between the long-run article project plan lines and the corresponding FA

components.

Delete link This action deletes the links between the long-run article project plan lines and the corresponding FA

components again.

Show post By means of this action, the already existing links between the project plan line and FA component can be

displayed for a position / item.
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concentrate the existing requirement coverage for the long-run items of a project at the long-run item project plan lines. If the

surplus reservation quantity were only cancelled in this way, it would then be available for other projects/consumption. However,

the transfer ensures that the demand cover remains reserved for the project.

The link for the FA component is deleted again using the "Delete link" function.

By deleting the link, the long-run article link item is deleted and therefore the linked quantity in the FA component and the

corresponding project plan line is also reduced / set to 0 (zero). 

Furthermore, the "Open quantity (base)" is also set high again in the FA component, since there is no longer any requirement

coverage for the remaining quantity of the FA component. 

On the other hand, the quantity and the available quantity in the project plan line and the available quantity in the project plan

line are set high. As a result, the reservation on the demand cover passes from the FA component to the project plan line and the

demand cover is still available to the project. 

Calls of the cross-country skiing articles overview from the production and project

As described in previous sections, the long-run article overview can be called for FA components and project plan lines. However,

it can also be called for FA lines, production orders as well as project tasks and the entire project. 

This section describes the calls and explains the structure of the summary items per call. 

Call for FA components / E+D order lines of the MRP type "warehouse part

The "Long-run item overview" screen can be called up for FA components and E+D order lines of the MRP type "Stock item"

using the action "Long-run item overview". 

In both cases, the long-run article overview for the respective referenced FA component is called. 

Here you can now view the possible, requirements-covering long-run article project plan lines for the component and create or

delete a link between the FA component and the project plan line. 

The individual actions for this can be taken from the previous section. 

Call for FA lines / E+D order lines of the MRP type "Production part

The "Long-run item overview" screen can be called up for FA lines and E+D order lines of the MRP type "Production part" using

the action "Long-run item overview".

In both cases, the long-run article overview is called for the referenced FA line.

The FA components of the respective FA line that have been identified as long-run items are displayed as the main items in this

call. 

As a sub-item, the project plan lines are shown for the respective FA components, which can serve as requirement cover if

necessary. 

If the actions "Set link" or "Delete link" are used for a FA line, the displayed FA components are run through one after the other

and the selected functionality is performed for the individual FA component.

Call for a production order / E+D order

The "Long-run item overview" screen can be called up for an entire production order or an E+D order. 

In both cases, the long run article overview for the referenced production order is called. In the case of the E+D order, it is the

production order that is listed in the header of the E+D order.

All FA components of the production order that have been identified as long-run items are displayed as main items in this call. 

As a sub-item, the project plan lines are shown for the respective FA components, which can serve as requirement cover if

necessary. 

If the actions "Set link" or "Delete link" are used for the entire production order, the displayed FA components are run through

one after the other and the selected functionality is performed for the individual FA component. 
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Call for a project plan line

The "Long-run item overview" screen can also be called up for a project plan line. For this purpose, the respective project plan

line must be marked as "Long-run item". 

In the called cross-country article overview, the corresponding project plan line is displayed as the caller. 

The corresponding project plan line is displayed as the main item in this overview. The FA components that could be covered by

this project plan line are displayed as sub-items for this project plan line. 

If the actions "Set link" or "Delete link" are executed from this view, they do not refer to the project plan line as the main item,

but to the individual FA components as sub-items. I.e. the individual FA components are gone through one after the other and the

selected action is executed there for each individual component. The assignment of the long-run item therefore always takes

place from the view of the component.

Call for a project task

The "Long-run item overview" screen can also be called up for a project task. For this purpose, the respective project task must

be marked as "Long-run item".

In the cross-country item overview, the corresponding project task is displayed as the caller. 

As main items, the corresponding project plan lines for this task are displayed in this overview, which are marked as "long-run

items". For each main item, the respective FA components that could be covered by this project plan line are then displayed as

sub-items.

If the actions "Set link" or "Delete link" are executed from this view, they do not refer to the project plan lines as main items, but

to the individual FA components as sub-items. I.e. the individual FA components are gone through one after the other and the

selected action is executed there for each individual component. The assignment of the long-run item is therefore always done

from the component's point of view.

Call for entire project

The "Cross-country item overview" mask can also be called up for an entire project.

In the cross-country article overview, the corresponding project is displayed as the caller. 

All project plan lines for this project that are marked as "long-run items" are displayed as main items in this overview. For each

main item, the respective FA components that could be covered by this project plan line are then displayed as sub-items. 

If the actions "Set link" or "Delete link" are executed from this view, they do not refer to the project plan lines as main items, but

to the individual FA components as sub-items. I.e. the individual FA components are gone through one after the other and the

selected action is executed there for each individual component. The assignment of the long-run item is therefore always done

from the component's point of view. 

Handling of long-run article links

This section describes the handling of long-run article links for different actions in the processing of production orders / E+D

orders and in the project. 

Within the framework of production order / E+D order processing Separating and reintegrating separate production orders

In E+D orders, individual subassemblies can be outsourced to separate production orders or reintegrated from a separate

production order. In this case, the noted requirements coverage (reservations) is also outsourced or reintegrated. Therefore, the

long-run article link items are also outsourced or reintegrated with the separate production order.

Deleting an FA component

When an FA component is deleted, the system checks whether it is a long-run item. If this is the case and there are reservation

items for the FA component, the reservation is transferred to the corresponding long-run item project plan line before the

component is deleted. 

For more information, see the section "Deleting cross-country article links".
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Deleting a production order/ individual FA lines

When deleting the entire production order or individual production order lines, the system checks for the entire production order

or the corresponding production order line whether it contains components that are marked as long-run items. If this is the case,

the reservations are transferred to the corresponding long-run article project plan lines before these components are deleted. 

For more information, see the section "Deleting an FA component".

Reducing the quantity in an FA component

If an FA component is marked as "long-running" and a quantity reservation exists for this component, then the existing

reservation is converted to a long-running article project plan line before the quantity is reduced. After the reduction of the

quantity, the system restores the reservation for the FA component according to the following scheme: 

If the new "Expected quantity (base)" is smaller than the originally reserved quantity, then the reservation is only made

according to the new "Expected quantity (base)". If, on the other hand, the new "Expected quantity (base)" still exceeds the

originally reserved quantity, the reservation is set back to the originally reserved quantity. 

This ensures that after the quantity reduction, the portion of the reservation that is no longer needed is assigned to a

corresponding project long-runner and the component retains its reservation again up to the maximum previously reserved

quantity. 

Cancellation of the reservation from a FA component

If an FA component is marked as a "long-run item", it is not possible to cancel the reservation for this component manually (call

the reservation reversal directly from the FA component). This is due to the fact that reservations for long-run items in the

production order are not simply cancelled and made available again for all consumptions, but are moved to the corresponding

long-run item project plan lines. As a result, the reserved requirements coverers still remain linked to the project.

The cancellation of the reservation for a FA component that is marked as a long-run item is therefore aborted by an error

message. Instead, the "Delete link" function in the "Long-run item overview" is to be used to transfer the existing reservation to a

corresponding long-run item project plan line. 

If the reservation was transferred to the project plan line, it can be cancelled there for the respective project plan line. This then

represents a conscious decision, so that the reserved requirement cover for the long-run article is to be decoupled from the

project. 

Cancellation of the reservation from the demand deck

If an FA component is marked as a "long-run item" and has a reservation for the requirement cover, the reservation cannot be

cancelled directly from the FA component. 

However, it is possible to cancel the reservation from the demand-covering document. This is due to the fact that changes to the

requirement-covering document must be possible. E.g. if the planned delivery date cannot be met. 

If a reservation is cancelled in a requirement-covering document that references an FA component for a long-run item, the long-

run item link for this component is also adjusted accordingly. 

Consumption posting of a FA component

After posting the consumption for a FA component that is marked as a "long-run item", the long-run item link is adjusted to the

reserved quantity again. This is due to the fact that the reserved quantity may be consumed with the consumption posting

(reservation to stock). Therefore, the long-run article link must also be reduced accordingly. 

Status change in the production order

When status changes are made in the production order, the long-run article links for this production order must also be taken

into account accordingly. There are two options that must be taken into account:

Change from "Firmly Planned" to "Released":

With this status change, the long-run article link items must also be moved from the firmly planned production order to the

released production order in parallel with the reservations.
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Change from "Released" to "Finished":

If a production order is terminated, all remaining (unused) reservations for long-run items that are linked to the production order

are distributed again to the corresponding long-run item project plan lines and are thus still available in the project. 

In the context of editing project plan lines

When editing project plan lines that are marked as "long-run items", the system must perform appropriate checks and actions

with regard to long-run item links (long-run item link items). These are described below. 

Creating book sheets for cross-country article project plan lines

It is not possible to create project book sheets for project plan lines that are marked as "long-running items". This is prevented

by a corresponding error message. The purpose of this is that project plan lines for long-run items must not be posted. A project

plan line for long-run items offers the possibility to generate requirements in advance for parts that are needed during

production and have a long procurement time. It serves the long-run article only as a trigger of the procurement, the actual

consumption takes place as a component in the production order.

Booking cross country article project plan lines

Posting project plan lines that are marked as "long-run items" is not permitted. A project plan line for long-run items offers the

possibility to generate requirements in advance for parts that are needed during production and have a long procurement time.

It therefore only serves as a trigger for procurement, the actual consumption of the component takes place in the production

order. 

Deleting long-run article project plan lines with link items

If a project plan line that is marked as a "long-run article" is deleted, the long-run article links of this project plan line to the

corresponding FA components are also deleted. However, the reservation that has already been transferred to the requirements

planner remains in the FA components. If it was the only long-run article project plan line for the article / variant / storage

location combination, then the "Long-run article" check mark is also removed from the corresponding FA components, since

there is no longer a reference to a long-run article in the project. 

Project plan lines

In the project plan lines you can define the "detailed planning" for the project. Per project task line you have the possibility to

define which items, resources and expense financial accounting items should be used.

To do this, first select the desired project task line and then call up the project plan lines via the "Tasks" info tab.

1.2.2 factory365

- 475/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Define the project plan line using the table below.
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Field Description

Project task no. Specifies the number of the associated project task.

Automatically preset by the system.

Line type Specifies the type of planning line.

The following are available for selection:

• Budget

• Billable

• Budget and billable

Order type Initial orderWhen the first sales order is created, the order type is set to initial order

Follow-up orderWhen

creating a follow-up order, the order type is set to Follow-up order

DeviationWhen

maintaining the forecast, the project plan lines created during the forecast release (archiving) are

marked as a deviation.

Plan lineInitial

value when creating a new plan line

Planning date The planning date of the plan line is initialized depending on the set working date with the working

date (working date <> today) or with the set start date of the project. If the start date is not set on

the project card, the working date is always assigned.

Planned delivery

date

Specifies the scheduled delivery date of the item associated with the project planning row. For a

resource, the scheduled delivery date is the date when the resource will be used for the project.

Desired delivery

date

Specifies the date when the customer wants the order to be delivered.

Promised delivery

date

Specifies the date on which you committed the delivery of the order based on the result of the

Delivery Date Commitment function.

Goods issue date Specifies the goods issue date.

Planned goods issue

date

Specifies the date when the goods should be delivered from the warehouse. If the customer requests

a specific delivery date, the application calculates the scheduled delivery date by subtracting the

transportation time from the requested delivery date. If the customer does not want a delivery date

or the requested delivery date cannot be met, the application calculates the contents of this field by

adding the transportation time to the delivery date.

Start date If you work with the "Distribute planned quantity" function, the specified day from which the times

were distributed is displayed in this field.

End date If you work with the "Distribute planned quantity" function, the specified day up to which the times

are distributed is displayed in this field.

Belongs to

Milestone

If the associated project task is assigned to a milestone, this is displayed in the field.

Document no. If the project plan line is created by the system, the document no. of the originating document is

specified here. The field can also be maintained manually if required.

Type Specifies the type of planning line.

The following are available for selection:

• Resource

• Article

• G/L account
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Field Description

• Text

As soon as you create a new project planning line with type=article as well as storage location, so a

new stockkeeping data card for the entered article no. and the storage location code of the project is

created by the system.

During the initial creation, the data is transferred from the article card to the inventory data.

No. Indicates the number of the item, resource or G/L account.

Note

In the "Nr" field, the Assist button is available to you for article/resource search in a simplified way.

Type=Article:

The characteristics for the search can be defined in the characteristic search. In the column Number

of result the number of articles with the defined characteristic are displayed.

Type=Resource:

Resource search based on qualifications. If qualifications have been stored in the specified activity

type, these are checked against the qualifications of the resources. If these match, the check mark is

set in the "Qualified" field.

Description Specifies the description of the item, resource or G/L account.

Cross country

skiing articles

If the associated project task is marked with Long run item=Yes, the marker is automatically set on

the project plan line.

Long-run article

Linked quantity

(base)

This field displays the already linked quantity of the project plan line with FA components.

Belongs to

Milestone

If the associated project task is assigned to a milestone, this is displayed in the field.

Article version code If you work with article versions, then you specify here the article version for the procurement.

Retrieval from

storage location

code

Will be pulled from the Invoice and Shipping info tab if the procurement method is set to "Retrieval"

in the plan line.

Storage bin code Indicates the storage bin where the items are picked/put away.

Quantity Specifies the quantity of units of the resource, item or G/L account.

Distribution type Specifies the distribution type for the "Distribute planned quantity" function.

The following selection options are available:

• Empty

• Forward

• Backward

• Manual

Belongs to line no. If you work with the function "Distribute plan quantity", the field "Belongs to row no." indicates to

which base row the "distributed" row belongs.

Distributed quantity If you work with the function "Distribute planned quantity", the field "Distributed quantity" shows

how much of the quantity has been distributed.

Distributed quantity

(Original)

If you work with the "Distribute planned quantity" function, the field represents the originally defined

quantity.

See here the cumulative cost amount of the distributed lines.
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Field Description

Distributed

purchase price

(MW)

Reserved from Specifies the reservation of.

Vendor no. For a quick procurement of your project requirements, the possibility was created to transfer

positions directly from the project plan lines into the planning proposal, inquiry, order, invoice as well

as credit note.

In this field, specify the vendor from which you want to procure this item.

Purchasing

document type

If you have transferred the plan line, you will see the document type of the purchasing document

here.

Purchase document

no.

If you have transferred the plan line, you will see the no. of the purchasing document here.

Cost price Maintain here in project currency the cost price of the position.

Calculation tracking

lines available

If a check mark is set here, an article calculation has already been created for the position.

Cost amount Indicates the cost amount of the position in project currency.

UK price Maintain here in project currency the sales price of the position.

Line amount Specifies in project currency the line (sales) amount of the item.

Quantity to be

transferred in book.

sheet

Specifies the quantity to be transferred to the project book. sheet.

Invoiced amount

(MW)

See here the already invoiced amount in client currency of the positions.

Actual progress % Indicates the actual progress of the project plan line in %.

Actual progress

date

Represents the maintenance date of the Actual Progress.

Forecast (MW) If you set the forecast to "Project plan line", use this field to specify the total costs you currently

expect for the project task.

For the calculation of the forecast (MW), the system determines it as follows:

(Consumption (cost price)

Time commitment Amount (MW)

Purchase commitments Amount (MW)

Stock commitment Amount (MW)

Production commitments Amount (MW))

Actual progress %

Forecast (MW)

Service type This field shows you the transferred activity type from the project task.

Sales account no. You will see the sales account determined by the system in this field.

Consumption

account no.

You will see the consumption account determined by the system in this field.

If you set the procurement method to stock transfer, the system creates a stock transfer route from

the standard storage location to the storage location of the project planning line if it is different.

1.2.2 factory365

- 479/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Document texts project plan lines

You can describe a project plan line in detail using a long text. This long text is printed on the documents you define.

Call up the project plan lines via the desired project task using the call of the same name on the "Tasks" info tab.

Select the project plan line for which you want to enter a document text. Then call up the "Document texts" menu selection via

the ribbon. You can now decide whether you want to enter a pre- or post-text for the line.

The entry of the pre- or post-texts is done in the same way as for the tasks. Further information can be found in the section

"Document texts for tasks".

The reports listed here print the project texts depending on the "Show additional text" switch:

Project plan lines Project analysis Budget comparison project Account proposal project *Project offer

Distribute plan quantity

It often happens that tasks take longer than one working day, for a more accurate resource planning it is now necessary to

distribute the estimated hours over the working days.

Before splitting, in the case of the Budget and Billable line types, it is necessary to clarify how billing is to be performed:

-Flat rate billing

The line must be divided into a billing and budget line beforehand on the project task via Functions\Split plan line. Billing is then

done via the original plan line.

-Resource statement

The line type remains unchanged and is then settled via the line item.

The prerequisite for the distribution is that the line type is Budget.

To distribute the planned quantity, call up the "Distribute planned quantity" function via the menu ribbon.

Field Description

Procurement

method

If a stock data card already exists, it will be updated based on the default.

With the procurement method simulation a calculation FA is created in the background.

If you want to trigger a purchase order for the item, set the procurement method to purchase, this

will update the inventory data for the item and storage location.

Sales document

Document type

Specifies the document type of the sales document.

Sales document no. Specifies the sales document no. of the sales document.

Note
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The Distribute Planned Set screen opens where you can specify the following distribution criteria:

Confirm your entry with "OK" to distribute the planned quantities.

The daily residual amount is calculated as follows:

Resource capacity * Quantity in order (Proj.) * Quantity in assembly order * Quantity in service order * FA time requirement

Remaining quantity available for the day

If the line to be distributed is a budget and billable line, the line will be split into a budget and billable line in the course of

quantity distribution. The billing line item is inserted before the original line item.

Field Description

Project no. Specifies the project no. of the project. The project no. is automatically preset by the system.

Task no. Specifies the task no. to be distributed. The task no. is automatically preset by the system.

Description Specifies the description of the task no. to be distributed. The description is automatically preset

by the system.

Type planning Specifies the planning type of the distribution. You can choose from the following

options:

EmptyNo distribution is made.

ForwardStarting from the

start date, the system compares the available resource capacity and creates a new project plan

line for

the capacity quantity until the quantity of the line to be distributed is distributed.

Backward

Starting with the end date, the system compares the available resource capacity and creates a

new project plan line for the capacity quantity until the quantity of the line to be distributed is

distributed.

Manual

Enter the quantity and date manually here.

Consider resource

group assignment

If you activate the switch, only resource assigned to the resource to be distributed will be

offered.

Start date Define here from which day the times are to be distributed.

End date Define here up to which day the times are to be distributed.

Resource selection Specify here how it wants to distribute:

NoneThe

system starts from the first resource and tries to distribute the quantity in the period until the

quantity is distributed.

ResourceThe

system considers the resource filter and distributes as for resource.

QualificationThe

system checks against the qualifications assigned to the activity type of the project task/project

plan lines and searches for those resources with matching qualifications and distributes the

quantity as under none.

Resource filter Set a filter here to specify under resource selection defined decision.

Quantity New line Set the quantity for the distribution here in case of manual distribution.

1.2.2 factory365

- 481/1545 - Copyright © 2018 - 2024 KUMAVISION AG



FA Calculation

The calculation in KUMAVISION factory365 has been extended so that also project plan lines can be calculated. New cost prices

can be calculated and taken over, however, deviating from the calculation for sales, no sales prices.

Establishment

Call up the "Evaluation & costing setup" via the user search. Via the info tab "General" you have the possibility to set up the

costing on project plan lines in the field "Cost E+D order (project)". 

The following selection options are available to you:

Preparation of a calculation

A prerequisite for creating a cost estimate is that a project plan line has the type "Article" and the procurement method

"Simulated".

To create the cost estimate, call up the function "Calculate production cost estimate" for the desired project plan line via the

menu ribbon > "Actions" > "Functions" > "Costing".

Please note that the project must not be in "Order" or "Finished" status.

Already when selecting the procurement method "Simulated", the calculation is performed automatically.

In addition, a cost estimate can also be created subsequently using the "Calculate production cost estimate" function.

Through the costing, a simulated FA is set up and a costing is performed depending on the setup, the FA is then also displayed or

the costing result is taken over as the cost price for the project plan line.

The calculation can be checked via the "Calculation tracking lines" action.

Transfer of the calculation into a sales quotation

If a project plan line is transferred to a quotation, a cost estimate existing for the project plan line is automatically linked to this

quotation line as well. 

From the quotation, you can view the reference to the simulated FA of the project plan line. To do this, select the "Functions"

menu item via the "Line" info tab and execute the "Costing tracking lines" function. 

Post calculation

If the cost estimate has to be changed subsequently or a new costing run has been carried out, the newly calculated cost price

can be adopted again in the costing proposals using the "Adopt costing proposal (preferred)" function. The price is also adopted

in any existing sales document.

Addition in simulated production order

Simulated production orders additionally have the identifier "FA used in calculation" on the info tab "General". This indicates

whether the respective production order is used in one or more calculations. 

A lookup on the identifier will display the "Calculation Tracking Lines (Sales + Project)" overview. 

Selection option Description

Calculate only A simulated FA is created and a calculation is generated.

Calculate+Advertise A Simulated FA and a calculation are created and the created FA is then opened via page 5232961

"Simulated E+D order (calculation)".

Calculate+Take

Over

A Simulated FA and cost estimate are created and the cost price is transferred to the project plan

line.

Note
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If a calculation is linked in project and sales in parallel, only the information for the project plan line is displayed in the

"Calculation tracking lines (sales + project)" overview, as this is the leading document.

Information register booking

Status

The course of a project is largely determined by the status. The individual options are described in detail below:

Planning:

In this project phase you can perform preliminary calculations. In addition, the project structure can be defined, i.e. you can

define project tasks as well as associated project plan lines. No bookings can be made yet.

Offer:

The project is offered to a customer. Preliminary calculations are also possible at this stage. You can also change the structure

and budget of the project. Postings cannot be made.

Open (=order):

Expenses from purchasing as well as from time recording are now recordable and postable. With the posting of sales invoices

and credit notes, project revenues can be posted to the project. Postings are only possible in this phase.

Completed:

You can no longer change the project structure and budgets. This status is used to perform recalculations The real costs of a

project can be compared with the budgeted amounts. Completed projects can no longer be posted.

Inforegister Invoice and Shipping

Field Description

Status Indicates the current status for the project.

Project booking group Specifies the booking group set up for the project according to the booking matrix setup.

WIP method Specifies the method used to calculate the working capital value for the project.

Allow budget/billable

lines

Here you can control whether you want to allow project plan lines of the type "Budget" or

"Billable".

Apply consumption link Indicates whether consumption items, e.g. from the project posting sheet or purchasing line, are

linked to project planning line.

% completed Indicates the percentage of the project's expected resource consumption that has been posted as

used.

% Invoiced Specifies the percentage of the project's invoice value that has been posted as invoiced.

% of overdue plan lines Indicates the percentage of the project's planning lines for which the planned delivery date has

expired.
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The Invoice and Shipping Inforegister is used to provide billing and shipping information about the customer.

Inforegister dates

Field Description

Storage Location

Code

The field is pre-populated from the Projects setup by the default project storage location (if any). If

no default project storage location is stored in the setup, a selection list on the regular storage

locations will appear at this point.

If "Create project storage location" is active in the Projects setup, the newly created storage location

will be entered in this field.

The field is used when creating a project plan line of type "Item" to fill the field "Storage location

code" in the project plan line.

The field is used when creating a project plan line of type "Item" to fill the field "Storage location

code" in the project plan line.

Relocation of

storage location

The field is pre-populated with the field of the same name from the Projects (if any) setup. If no

"Stock transfer from storage location" is stored in the facility, a selection list of all regular storage

locations (no project storage locations) appears at this point.

The field is used when changing the procurement method to "Stock transfer" in a project plan line to

fill the "Stock transfer from storage location" field in the project plan line.

Field Description

Start date Specifies the date when the project starts.

End date Specifies the date when the project should be completed.

Establishment date Specifies the date when the project was created.
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Foreign Trade Information Register

Field Description

Currency code Specifies the currency code for the project. By default, the field is empty. If you enter a foreign

currency code, the project will be planned and invoiced in this currency.

Invoice currency code Specifies the currency code to be applied when creating invoices for the project. By default, the

currency code is based on the currency code that has been stored on the customer card.

Exchange rate calculation

(cost price)

Specifies how project costs are calculated when you change the Currency Date or Currency

Code fields in a project plan row.

The choices are:

MW fixed

The project costs in the local currency are fixed. A change in the currency exchange rate

changes the value of project costs in a foreign currency.

FW fixed

The project costs in the foreign currency are fixed. A change in the exchange rate changes the

value of the project costs in the local currency.

Exchange rate calculation

(sales price)

pecifies how project sales prices are calculated when you change the Currency Date or

Currency Code fields of a project plan row.

The choices are:

MW fixed

The project prices in the local currency are fixed. A change in the currency exchange rate

changes the value of the project prices in a foreign currency.

FW fixed

The project prices in the foreign currency are fixed. A change in the exchange rate changes the

value of the project prices in the local currency.
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Inforegister WIP and revenue recognition

Inforegister Forecast & Commitment

On this Inforegister the Forecast & Obligo information of the project is presented. At this point, the Inforegister is mentioned for

the sake of completeness. 

For further information, please refer to the section "Forecast & Commitments".

Document texts project header

You can describe a project in detail using a long text.

To define a document text for a project, select "Pre-text" or "Post-text" in the ribbon.

The project document text card opens.

Call up the "Format editor" via the ribbon and enter your desired text in the editor text field. After confirming your entry with

"OK", your text is displayed in the "Preview" field.

Please note that pre- and post-texts on the project header and project tasks are not inherited by subsequent documents. This is only

possible with texts on project plan lines.

Project scheduling

With the help of project scheduling, you have the option of creating a rough schedule at any point in the project. Scheduling can

be defined at project level, project task level and project plan line level. Forward, backward and midpoint scheduling is possible.

Field Description

WIP posting date Indicates the posting date that was entered during the last execution of "Calculate

WIP project".

Total WIP invoice value Indicates the total WIP sales amount that was last calculated for the project.

WIP maintenance amount (total) Indicates the total WIP maintenance amount that was last calculated for the project.

Deactivated sales amount Indicates the amount of declared sales that was last calculated for the project.

Deactivated cost amount Indicates the declared cost amount that was last calculated for the project.

Disabled DB Specifies the disabled DB for the project.

Disabled DB % Indicates the deactivated contribution margin in percent for the project.

Posting date WIP to G/L item Indicates the posting date entered during the last execution of "Post WIP to G/L

Project".

Total WIP invoice value in G/L

accounts

Indicates the total WIP sales amount that was last posted for the project.

WIP balance for G/L accounts (total) Indicates the total WIP balance that was last posted to the project.

Deactivated sales amount in G/L

accounts

Indicates the total declared sales amount that was last posted for the project.

Deactivated cost amount on G/L

accounts

Indicates the total deactivated cost amount that was last posted for the project.

Deactivated DB on G/L accounts Indicates the contribution margin that will be realized for this project.

Deactivated DB (financial accounting)

%.

Indicates the contribution margin in percent that will be realized for this project.

Note
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Procedure Project tasks using predecessor and successor structure

Project tasks can be related by means of predecessors/successors. To create a predecessor/successor structure, click on the

number in the "Predecessor/successor" field of the respective project task line. The "Project task dependencies" page opens on

which you can assign the predecessors/successors to the project task via "New" in the "Project task dependencies" selection

field.

Set project task duration

Use the "Duration" field to specify the expected duration of the respective project task. You can enter T = day(s),WT =

weekday(s),W = week(s),M = month(s),Q = quarter(s) or Y = year(s), L = the current time unit based on the date.

Scheduling

The "Project scheduling" function in the ribbon allows you to calculate the planned start date and the planned end date of the

project tasks based on the predecessor and successor structure and the duration of the project task.

When you execute the function, the "Project scheduling" option window opens.

Confirm your selection to perform the calculation.

Scheduling does not shift any existing planned start or end date of project tasks with the "Milestone" indicator.

It is a good idea to create a project template for similar projects, which you can use to transfer a project task structure, a

predecessor and successor structure as well as the project task duration to a new project. Only a fine adjustment is then made in the

project. Only predecessors and successors that exist in the original project template are transferred. New relationships to existing

project task lines are not taken into account.

Procedure Termination direction

Forward scheduling

Starting from the scheduling fixed point, all project tasks are scheduled as follows:

Project task planned start date + duration = planned end date

Planned end date of predecessor = planned start date of successor tasks

Backward scheduling

Starting from the scheduling fixed point, all project tasks are scheduled as follows:

Project task planned end date - duration = planned start date

Planned start date successor = planned end date of predecessor

Feld Beschreibung

Termination

direction

Über das Feld können Sie die Terminierungsrichtung festlegen. The following options are available:

Forward, backward, center point termination.

Termination type The scheduling fixed point is selected in the field. The options "Project" or "Project task" are available.

If you select the "Project task" option, the additional "Scheduling task" field appears, which you can use

to select the corresponding task.

Scheduling task The field is visible as soon as you have selected the "Project task" option in the "Scheduling type" field.

You can select the corresponding task here.

Note

Tip
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Center point scheduling

Starting from the scheduling fixed point (only possible for project tasks), all successors are scheduled forwards and all

predecessors are scheduled backwards.

When scheduling on the basis of the project, the planned start date of all project tasks without predecessors is set to the project start

date.

Project tasks of the From total type receive the earliest planned start date of the subordinate tasks of the Booking type as the

planned start date and the latest planned end date of the subordinate tasks of the Booking type as the planned end date.

Only the self-contained predecessor and successor structure is calculated for a midpoint termination.

Project storage location

For the correct representation of the transfer of risk, goods are transferred from their production site to the construction site or

to the customer and not delivered directly and thus consumed. The project is then debited upon acceptance by means of a

deliberate consumption posting.

For this purpose, a project storage location is always created for a project. This can be a storage location for several projects or a

storage location explicitly for one project.

In the latter case, a new storage location is created based on the "Sales to customer no.".

Establishment

In the "Projects setup" you can control whether you want to create one project storage location per project or use one storage

location for multiple projects.

Project storage location per project:

If you decide to automate the creation of project storage locations per project, you also have the option to store a storage

location template from which the necessary facilities for the newly created project storage location will be preset. The following

facilities are copied from the template storage location:

Storage bins,

Stock posting facility, 

Stock transfer routes, 

storage location map (register)

For project specific extensions an event is available, which can be used to copy additional items like dimensions or warehouse staff if

required.

Note

• 

• 

• 

• 

Note
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It is recommended to create a storage location only for the templates and not to use the template location as actual location.

Project storage location for multiple projects:

If you decide not to automate the creation of a project storage location, you have the option to store an existing storage location

that will be used by default for the projects. 

This option is only available if you have decided against a project storage location per project.

Manual plant

In addition to the automatic creation of a project storage location, you also have the option to manually create a project storage

location per project.

To create a project storage location, click on the project map in the "Associated" > "Setup" > "Create project storage location"

ribbon.

If the function is executed, a query opens where you can decide whether you want to use the number for the storage location

from the number series from the Projects setup, or assign a manual number. 

Please note that this function is only available to you if the "Create project storage location" switch in the Projects setup is

deactivated.

Note

field description

Create Project Storage

Location

For the procurement and logistics processes, use this to specify whether the system should

create a project storage location for each project.

The project storage location hereby represents the point of delivery for the project.

Standard Stock Transfer

From Storage Location

This field is a drop-down list of all regular storage locations (not project storage locations). It

specifies the stock transfer route and is transferred to the "Stock Transfer From Storage

Location Code" field on the Invoice and Shipping info tab of the project map.

Note

Field Description

Standard project storage

location

The field is a selection list on the storage locations available in the system. 

It specifies the default project storage location for all projects and is automatically

transferred to the "Storage Location Code" field on the Invoice and Shipping info tab.

Note:

The field is only used when "Create Project Storage Location" is disabled.

Standard Stock Transfer From

Storage Location

The field is a pick list of all regular storage locations (not project storage locations).

It specifies the stock transfer route and is transferred to the "Stock Transfer From Storage

Location Code" field on the "Invoice and Shipping" info tab of the project map.

Project Storage Location

Number Series

Used when manually creating a new project storage location.

Note
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Stock data

When creating an article item in the project plan line, in the case of the storage location found, a stockkeeping data card is

directly created in the background for the article and the corresponding project warehouse.

In the project plan line, the procurement method can then be defined directly on the inventory data card via the "Procurement

method" field.

If the procurement method "Stock transfer" is selected, a stock transfer route is directly created in the background according to

the settings in the "Project setup" for the standard warehouse.

Project Team

A project team can be defined for each project. The definition takes place on the project card in the menu ribbon under "Project

team".
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Create the project team members using the table below:

Field Description

Project no. Specifies the number of the project to which the project team is assigned.

This field is filled in automatically.

Type Here you define which type the project member has. You can choose between resources (internal

and external employees) and contacts (project members of the customer or further project

participants).

In the case of the contact type, the system fills the Company no. field using the customer no. of the

project card, from which the company name is also derived.

No. Here you can select depending on the type of member.

Type=Resource: Selection of the respective resource no.

Type=Contact: Selection of the respective contact no.

Type=User: Selection of the respective UserID

Roll code Specifies the role of the project team member.

To assign code to the roles, roles must have been previously set up in the table of the same name.

Roll Specifies the name of the role.

Start date Specifies the start date for the deployment of the resource. The start date automatically defaults to

the project start date and can be changed manually.

Name Specifies the name of the resource, contact or user.

E-mail Specifies the e-mail address of the resource, contact or user.

Phone no. Specifies the phone number of the resource, contact or user.

Cell phone no. Specifies the cell phone number of the resource, contact or user.

End date Specifies the end date for the deployment of the resource. The end date automatically defaults to the

end date of the project and can be changed manually.

Company no. Specifies the company number of the contact as soon as the Type=Contact field.

Company name Specifies the company name.

Business

relationship

Indicates the business relationship

Seller code Specifies the seller of your company

People Contact No. Specifies the persons contact no.

Planned quantity Specifies the plan quantity of the project team member.

Quantity plan lines Specifies the amount of plan lines for the project team member.

Residual quantity

Plannable

Indicates the remaining quantity that can be planned by the project team member.

Amount of time Indicates the amount of time already recorded for the project by the project team member.

Project quantity Specifies the project quantity for the project team member.

Total consumption Indicates the total consumption of the project team member.

Rest plan lines Specifies the remaining amount of plan lines for the project team member.

Rest plan Specifies the remaining plan quantity of the project team member.
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If the fields "Responsible" and / or "Project Manager" are maintained on the project card, the project team records are also created

with the Responsible / Project Manager role.

If you maintain a resource in the project plan lines, data records are also generated for this project team.

Please note that when creating from the project plan line, the team record is not deleted when changing the resource or deleting the

record.

Archive project versioning and project status

The project planning in Microsoft Dynamics 365 Business Central1 is always supplemented and corrected, so that a comparison

of different plan statuses is not possible. In the plant engineering solution, you can carry out a versioning of the project planning

in order to have access to older planning statuses and to compare two planning statuses with each other.

Project version

To create a project version, execute the function "Release version" in the respective project via the menu ribbon. The current

version of the complete project status has thus been archived and can be viewed via the number of the "Archived versions" field

on the "General" info tab or via the menu ribbon under the "Project archive" menu item.

The archived project states contain a complete copy of the project map with the following additional information on the "Version"

info tab:

Project structure version

The project structure version can be viewed via the "Project structure" menu item in the project version ribbon. This corresponds

to the project structure at the time of archiving with the additional identifier of the version number.

When archiving from the project structure, the project map is also always archived.

Note

field description

Version number Indicates the version number of the archived project

state.

Archived by Indicates who created the version.

Archived on Gives the date when the version was created.

Archived at Indicates the time when the version was created.

Archiving comment If an archiving comment has been stored during

archiving, it is displayed at this point.

Last current no. project item Indicates the number of the last project item at the

time the version was created.

Last Item Sequence No. No. Specifies the number of the last item

at the time of version creation.

Last value item no. Specifies the number of the last value item at

the time the version was created.

Last no. of resource items Specifies the number of the last

resource item at the time the version was created.

Last no. of capacity item - Specifies the number of the last capacity

item at the time the version was created.

Note
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Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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RISK MANAGEMENT

Risk management allows you to calculate, monitor and counteract project risks. Using the task management within the risk line,

you can define preventive measures.
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To calculate and monitor the project risks, call up the "Risk management" via the menu ribbon. The corresponding fields are

explained in more detail below:
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Field Description

Comments This field indicates whether a comment of the risk line is deposited.

Risk no. This field must be filled. It controls the position of the risk line and thus the clarity of the entire

risk list.

Description This field can be used to store a description for the risk.

Risk type In this field you enter the type of risk.

This field offers the following options:

- RiskIndicates

the risk

- HeadingSpecifies

a heading

- SumWith

this option you can create a sum over several risk rows. You define the range using the "Total"

field.

- From-totalAs

in the chart of accounts, you can create a from-total - to-total over several rows in Risk

Management.

- To-totalAs

in the chart of accounts, you can create a from-total - to-total over several rows in Risk

Management.

Counting up This field specifies which risks are added together. This field works for the "From-total", "To-total"

and "Total" risk types. When using the "From-total" and "To-total" risk types, the system

automatically fills the "Add up" field of the row with the "To-total" risk type.

Number of open tasks Indicates the number of open tasks (measures) generated by the task creation.

Entry date In this date field, you store the date on which the risk may occur.

Responsible In this information field a user can be assigned as responsible for this risk.

Damage (MW) This field is used to specify the amount of damage.

Cum. Damage (MW) This field is automatically filled based on the "Damage (MW)" field and indicates the cumulative

damage.

Probability % In the "Probability %" field, the probability of the risk that could occur is indicated.

Cum. Damage assessed

(MW)

This field is automatically filled based on the calculation of the "Damage (MW)" and "Probability

%" fields.

Damage n. Completion

(MW)

This information field can be used to specify the damage after the completion of the project.

Cum. Damage n.

Completion (MW)

This field is automatically filled with the cumulative value of the field "Damage n. Completion".

Prob. n. completion % This information field can be used to indicate the probability of the risk after completion of the

project.

Cum. Damage assessed

n. closure (MW)

This field is automatically filled based on the calculation of the fields "Damage after completion

(MW)" and "Probability after completion %". It describes the assessed damage after completion of

the project.
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Field Description

Active This identifier controls whether the risk is active or not.

Identified by This field is automatically filled with the user name that entered the risk line.

Identified on This field is automatically filled with the working date on which the risk line was created.

Cause Description A description of the cause can be stored here.

Damage description A description of the possible damage can be stored in this field.

Measure costs (MW) The measure costs of the risk can be entered here.

Cum. Measure costs

(MW)

This field is automatically populated based on the "Measure Costs (MW)" field and indicates the

cumulative measure costs.

Damage Actual (MW) In this field you enter the actual damage.

Cum. Damage Actual

(MW)

Based on the "Damage Actual (MW)" field, this field is automatically filled.
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PROJECT EFFORT

In the following, the individual areas are explained in more detail, through which the project, effort and consumption can be

assigned.

Thus, on the one hand, the expenses of the resources are recorded in the form of working hours, and on the other hand, article

consumption is recorded via stock or project purchasing.

This results in the actual values of a project. Subsequently, these actual values are compared with the planned values.

Personnel / benefit expenses

The implementation of projects includes consumption as well as sales. Project consumption primarily includes the expenditure of

resources. Resources can be employees, machines and subcontractors.

Resource expenditures are always made in the resource base unit via the timesheet. All person resources should have this code

as the base unit on the resource card.

Record timesheet

Using the time sheet, the resources can record their expenses with a corresponding description on the projects. For each

resource, the time sheet must have been created beforehand for the corresponding period. For more information, see "Creating

timesheets" or the Microsoft Dynamics Business Central™ Helpsite (F1).

Release of the transmitted working times

The submitted working times of the employees are then approved by the timesheet approver.

To release the transferred working times, call up "Time sheet for manager" via the user search.

The time sheet for manager card opens on which the transferred working times are listed. Via the menu ribbon you have the

possibility to approve or reject the transmitted working times via the calls "Approve"/"Reject".

Further information on this topic can be found in the Microsoft Dynamics 365 Business Central1 Helpsite.

Project book sheet

The time sheet is used to record the project time consumption. To ensure that the projects are also debited with the posted

project time items, i.e. the project time items are transferred to so-called project items, the posted time consumptions must be

entered via the project book.sheet.

The project posting sheet is used to post project items of all types. For example, material from the warehouse can also be posted

here as project consumption. At this point, only the transfer of project items from the project time items will be discussed.

The menu item "Suggest project book. sheet lines" creates an input mask in which the filters for the retrieval can be set

specifically.

This function is used to retrieve project time items that have not yet been transferred to project items. As a rule, each project

manager retrieves the project time items for which he is responsible. For this purpose, each individual project can be edited or

the "Responsible" filter can be used.

The call fills the project book.sheet with all necessary data from the project time item. One book.sheet line is created per project

time item.

After updating, the project book sheet is empty again and the corresponding project items have been created.

External resources

External resources can be purchased via purchasing documents.

For external resources, a vendor can be specified on the resource card. This creditor is the invoicing party, e.g. a personnel

service provider. In the case of a freelancer, the freelancer must be created as a resource and as a vendor and linked accordingly.
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If an external resource is entered in the project plan lines, this vendor is transferred to the field of the same name in the project

plan line. Thus, a cost price determination can be carried out specifically for the combination resource / vendor. Also a creation

of a purchase order of the external resource from the project plan line takes place with the creditor of the project plan line.

In addition to cost prices, sales prices and purchase prices can also be defined for external resources.

Cost of materials

In addition to the time spent on resources, projects also have material costs. This is managed via articles. The demand is defined

and planned in the planning lines. The missing parts are ordered or produced via purchasing or production.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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PROJECT PURCHASING

Plant engineering allows you to trigger purchasing documents directly from the project plan lines. 

Create purchase request

Using the "Create purchase request" function, you can send the request to the supplier directly from the project plan line. 

The following requirements must be met:

it is not a position already transferred

for each line a vendor no. is maintained

the project is not in the "Locked" status

if it is an item without a planning date, it must be a comment line

Otherwise, a corresponding message appears.

After a successful check, a window will open where you can make the following decisions:

Confirm your selection with "Ok". 

Subsequently, all selected lines marked on the line type "Budget" or "Budget and Invoiceable" are transferred to the purchasing

request. In addition, the project no. in the header of the purchasing document is maintained with the project no. from the project

from which it was generated. The requested quantity corresponds to the remaining quantity of the project planning line minus

the quantity already reserved for it.

The document number of the generated request is displayed in the "Purchasing document number" field. By clicking on the

number you can open and view the document.

You can convert the purchase request to a purchase order later in the process. In doing so, the "Purchasing document number"

field in the project plan line is adjusted with the number of the purchase order.

• 

• 

• 

• 

Field Description

Create new

document

Specify whether you want to create a new document or attach the items to an existing purchase

request.

Document date Specify which document date the purchase request should receive.

Attach to document If you want to add to an existing purchase request (Create new document = No), you can specify the

document to be updated here.

Determine to which document you want to assign the selected lines. A list of possible documents is

displayed for this purpose.

Lines outline Specify here whether a row outline should be created when a new document is created.

When adding documents, you will not be offered the choice and the outline type of the existing

document will be kept.
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If one of the following fields is changed in the project plan line, the system tries to transfer the change to the purchase line as

well:

Description

Description 2

Type

No.

Work type

Variants code

Quantity

Unit code

Cost price

UK price (MW)

Line discount %

Planned delivery date

Storage location

Stockyard

Currency code 

Please note that the new currency code must match the currency code of the purchase document, if not, an error message will

appear.

Create order

Using the "Create Purchase Order" function, you can directly create a purchase order for the project plan line out.

The following requirements must be met:

it is not a position already transferred

for each line a vendor no. is maintained

the project is not in the "Locked" status

if it is an item without a planning date, it must be a comment line

Otherwise, a corresponding message appears.

After a successful check, a window will open where you can make the following decisions:

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note

• 

• 

• 

• 

Field Description

Create new

document

Specify whether you want to create a new document or attach the items to an existing purchase

order.

Document date Specify which document date the purchase order should receive.

Attach to document If you want to add to an existing purchase order (Create new document = No), you can specify the

document to be updated here.

Determine to which document you want to assign the selected lines. A list of possible documents is

displayed for this purpose.

Lines outline Specify here whether a row outline should be created when a new document is created.
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When adding documents, you will not be offered the choice and the outline type of the existing document will be kept. Confirm

your selection with "Ok". 

Subsequently, all selected lines marked on the line type "Budget" or "Budget and Billable" are transferred to the purchase order.

In addition, the project no. in the header of the purchasing document is maintained with the project no. from the project from

which it was generated. The quantity to be ordered corresponds to the remaining quantity of the project planning line minus the

quantity already reserved for it.

Depending on the maintenance of the field "Reserve", the order line will be created in such a way that the project no. as well as

the project task will be taken over from the plan line into the purchase line when reserving "Never". By posting the document,

the position is directly debited to the project. 

From Reservation "Optional" onwards, the fields (Project no. and Project task) are not filled and the project consumption must be

done manually.

The project line type is always set to Budget.

KUMAVISION factory365 specific referencing fields are filled in the background, so that the purchase order item is considered in the

project chart of accounts or also in the commitment consideration.

If one of the following fields is changed in the project plan line, the system tries to transfer the change to the purchase line as

well:

Description

Description 2

Type

No.

Work type

Variants code

Quantity

Unit code

Cost price

UK price (MW)

Line discount %

Planned delivery date

Storage location

Stockyard

Currency code 

Please note that the new currency code must match the currency code of the purchase document, if not, an error message will

appear.

Planning proposal

Alternatively, you can generate the purchase requisition/purchase order conventionally via the planning proposal. To do this,

select the "Planning proposal" function via the respective project plan line.

Note

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note
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PROJECT MANUFACTURING

As for project purchasing, plant engineering offers the possibility to trigger the manufacturing or assembly processes directly

from the project plan lines. The following options are available for this purpose:

Planning proposal

Using the "Planning proposal" function, you have the option of generating a production order via the planning proposal.

The production document number is displayed in the "Reserved by" field. By clicking on the number you can open and view the

document.

Assembly order

Microsoft Dynamics 365 Business Central1 enables an assembly order for an assembly item to be generated from a sales order

via the so-called "order assembly". In the course of the sales delivery, the corresponding assembly order is posted in the

background.

This functionality has been transferred to plant engineering. This means that you can enter the assembly item directly in a

project plan line and generate the assembly order accordingly via the fields "Quantity for order assembly" and "Quantity for

order assembly (basis)". The document number of the generated assembly order can be seen in the "Reserved by" field and the

document can be called up directly from this point.

If a sales order with the corresponding item already exists in the system, it can be viewed via the fields "Sales document type =

order" and "Sales document no. ".

Otherwise, they can be created from the project card via the "Tasks" > "Line" > "Documents" > "Create sales order..." info tab.

As soon as the sales line of the related assembly item is delivered via the order, the assembly order is posted.

Please refer to the Microsoft Dynamics 365 Business Central1 Helpsite for the maintenance and handling of assembly items.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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PROJECT ACCOUNTING

The sales document forms the commercial basis vis-à-vis the customer. From the project tasks, the sales calculation can be

transferred into a quotation and / or order. 

General behavior

Project type

In the project type, you can set up an order type for the creation of sales documents, if required. This will be used when creating

the documents.

Status

When creating documents, it should be noted that this is only possible from the project tasks / project plan lines if the project has

the required status:

Quotation can be created only with project status "Quotation" as well as "Order".

Order as well as complaint can be created only with project status "Order

An offer can only be converted into an order if the project status is "Order".

Only project plan lines with the Billing item "Yes" flag (line type "Budget and Billing" as well as "Billing") can be transferred to a

sales document.

Document quantity

The documents can be created from the project plan lines as well as from the project tasks. The system uses the field "Quantity

to be transferred to invoice" to determine the quantity of documents (offer, order, invoice, credit note and complaint).

Address data

The sales header takes over the address data from the project header. This means the sales to information of the project is

transferred to the sales to information of the offer or order the same with the invoice to data. The delivery address is derived

from the sales to address.

Position numbering

The item numbering in the sales documents depends on the creation of the plan lines as well as on the task breakdown.

Task planning

If you have used the task planning, the position number is filled with the planning project task.

Use of the project outline

The position numbering is based on the project task. The from line has the project task as item no., the plan line supplemented

by the extension of the next level of the project outline.

Consecutive numbering

If there is no project structure, the item number is determined on the basis of the project task no. '.' and the consecutive number.

If the maximum length of 20 characters is exceeded, the project task will be shortened so that the sequential number can be

added up to the maximum value of 99. When the consecutive number reaches 100, an error message appears.

Order type

The order type represents whether the order is the initial order or a follow-up order. If, when creating a new sales document, it is

determined that a document already exists, the system switches the order type to follow-up order.

Updating the vouchers

The project is the leading bracket in plant engineering and thus allows updating sales documents from within the project. 

An update from the sales documents and thus an indirect change of the project plan by the order department is not possible.

However, a maintenance of order specific data such as the assignment of the article tracking is allowed.

1. 

2. 

3. 

4. 
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The project plan is updated by posting results, which are made by the system in the background.

Posting result depending on the line type

Please note that only lines with the line type "Billable" and "Budget and Billable" will be included in the sales document.

Billable lines do not create any items in case of deliveries, in case of billing they create a project item with the item type "Sales".

Budgetable and billable lines also generate project items with the item type "Consumption" for deliveries.

Function support
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Below you will find the functional support for VK documents generated from a plant engineering project in tabular form:
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Function call via Function Support

Manage rows Attribute search Disabled

Lines Article availability according to Event Active

Lines Article availability according to Period Active

Lines Article availability according to Variant Active

Lines Article availability according to Storage location Active

Lines Article availability according to BOM level Active

Rows\Line\Related information Reservation item Reference to project plan

line

Rows\Line\Related information Item tracking lines Reference to project plan

line

Rows\Line\Related information Select replacement item Disabled

Rows\Line\Related information Dimensions Reference to project plan

line

Rows\Line\Related information Comments Active

Rows\Line\Related information Article Allocation of additions/

deductions

Disabled

Rows\Line\Related information Delivery date commitments Reference to project plan

line

Lines\Row\Linked information\Order

assembly

Program production lines Disabled

Lines\Row\Linked information\Order

assembly

Calculate multilevel price Disabled

Lines\Row\Linked information\Order

assembly

Calculate multilevel costs Disabled

Rows\Line\Related information Document line tracking Active

Line\Line Calculation tracking lines Disabled

Rows\Line\Related information Incoming orders Active

Lines\Row\Linked information\Document

texts

Pretext Active

Lines\Row\Linked information\Document

texts

Post text Active

ROW FEATURES Get price Disabled

ROW FEATURES Retrieve line discount Disabled

ROW FEATURES Unfold parts list Disabled

ROW FEATURES Insert text modules Active

ROW FEATURES Reserve Reference to project plan

line

ROW FEATURES Demand creator Reference to project plan

line
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Offer for sale

You can create a sales quotation directly from the project via the project plan lines. The function calls can be found on the one

hand on the project map via the "Tasks" info tab and on the other hand via the project plan lines.

If the document creation is triggered from the project plan line, the system tries to transfer all selected project plan lines to the

sales quotation.

When creating from the project tasks, all the billable lines of the tasks are transferred to the sales document.

If you want to create a sales quotation for all lines, the "Tasks" info tab can be used to call up the quotation. By means of the row

selection you can control which task rows are to be considered.

Please note that only project tasks of line type="Budget and Billable" or "Billable" can be transferred in a UK document

Sales documents are created at the project customers. For this purpose, the information stored in the project is used. Thus, sales

to customer, invoice to customer, the delivery address and the payment terms of the project are used to create the sales

documents.

After commissioning, the sales quotation can be converted into an order in the system as usual using the "Create order" function.

Sell order

If the customer has already ordered the project, you can also create a sales order directly from the project via the project plan

lines. The function calls can be found on the one hand on the project map via the "Tasks" info tab and on the other hand via the

project plan lines.

If you want to create the sales order over all lines, the call via the "Tasks" info tab is suitable at this point. By means of the row

selection you can control which task rows are to be considered.

Sales documents are created at the project customers. For this purpose, the information stored in the project is used. Thus, sales

to customer, invoice to customer, the delivery address and the payment terms of the project are used to create the sales

documents.

The order processing corresponds to the standard order processing.

Delivery

Maintain the quantity to be delivered in the "Quantity to be delivered" field. In case of an activated item tracking please maintain

the concerned serial no. or batch no. via the item tracking. Item tracking maintenance from the order is the same as item

tracking maintenance from the project plan lines.

Invoice

Maintain the quantity to be invoiced in the "Quantity to invoice" field. Please note that if item tracking is enabled, no item

tracking can be specified for the billing case.

Dimension expansion

For easy evaluation of the projects, the creation as well as assignment of dimensions has been optimized.

Function call via Function Support

ROW FEATURES Select catalog item Disabled

ROW FEATURES Calculate manufacturing cost estimate Disabled

Line order direct delivery Order Disabled

Line order special order Order Disabled

Note
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Dimension specification by the activity type

Dimension specifications can be assigned to the activity type, so that when the activity type is selected in the project task, the

dimension is assigned to the task.

Project type

In the project setup you can define that for reporting purposes a dimension Project type is maintained and assigned to the system

in parallel to Project type.

Project Chart of Accounts

For effective project controlling, all project movements can be assigned and evaluated via a separate chart of accounts.

Down payment accounting

Within financial accounting, KUMAVISION's "Down Payment Accounting" module enables the simple planning, creation and

management of down payment invoices. The add-on module is fully integrated into the standard processes of accounts receivable

and accounts payable, such as dunning and payment transactions, and can likewise be used for plant engineering in

KUMAVISION factory365.

Please note that the "Down payment accounting" module is an add-on module that requires additional licensing. If you do not have

this license integrated in your solution, the following functionality from this section will not be available to you.

The following adjustments were made for this purpose:

Down payment plan

The following fields have been added to the down payment plan in KUMAVISION factory365:

You can access the down payment plan for projects as well as project tasks via Down payment plan in the project card.

By maintaining the project task, you specify that you want to set the down payment schedule at the project task level.

Please note that if you select a project task defined as a milestone, the system will also activate the milestone billing functionality

(the Milestone field defined with a check mark). A combination of the source types Project as well as Project task is not allowed.

Down payment plan by milestone

If you have assigned a milestone for invoice creation in the down payment plan, the down payment invoice is created when the

status of the milestone changes to completed.

For more information, see "Down payment accounting".

Note

Field Description

Project task

no.

Contains the project task number you assigned.

Maintenance is possible only for projects.

Milestone Define herewith that when completing a milestone, the defined down payment invoice is generated by the

system in the background. The FiBu department then only has to post and send this.

Note
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PROJECT CONTROLLING

In this section, the possibilities of project controlling are presented. It will be discussed how project results with multi-level

contribution margin accounting can be presented in the Projects module with the help of the project chart of accounts. In

addition, the project information that can be called up immediately is presented.

Project controlling is basically based on budgeted and actual values. The realization should correspond to the planned values. In

order to be able to manage the project properly and promptly, a comprehensive evaluation of the planned values and the actual

values incurred, related to the stored time periods, is immensely important. Microsoft Dynamics 365 Business Central1 offers this

evaluation. 

The project items show the actual values that are charged to the project from daily work. These are usually goods or time

postings. The plan values are defined via the project tasks and its project plan lines. This enables a target/actual comparison of

certain cost types. On the basis of this project chart of accounts, evaluation schemas can be formed, with which, combined with

correspondingly generated column layouts, specific information can be formed from the values. The procedure corresponds to

the account evaluation in the financial accounting area.

Data basis and structure

The creation of the project account framework is fundamental for project controlling via Microsoft Dynamics 365 Business

Central1. This contains the most important areas (cost types and revenue types) that are important for the company for the

evaluation of projects. The level of detail of the accounts can be freely selected. Thus, a very compact or also a very elaborate

project chart of accounts can be the basis.

Based on this, the project items or plan values are formed. These items are combined using a project account scheme.

Project chart of accounts and project account setup

All project entries can be posted to project accounts via the project account setup, similar to the G/L items in financial

accounting. This enables evaluation possibilities to an undreamt-of extent.

The project account and the project chart of accounts have already been explained in the section "Project setup", so only the

project account setup will be discussed in detail here.

Project account determination is based on the combination of product posting group, project type and activity type. Each

combination is assigned a consumption and sales account from the project chart of accounts.

The information is used to determine the respective project account as follows:

With the above information can be e.g. 

the resource expenditure for project management on research projects with internal resources 

the cost of small materials for assembly on site 

the travel times of external employees on major projects

can be determined. 

Depending on what is to be evaluated later, the project chart of accounts and especially the matrix must be set up accordingly.

Project items = actual values

With each posting where a project is addressed, the system creates a project item. Project items form the basis for project

settlements (expense items) and reflect the revenues of these settlements (revenue items). Project valuation is also built on the

project item.

Field Description

Product posting

group

From the consumed or invoiced item, resource, G/L account. The product posting group is the only

mandatory field in the matrix.

Project type From the project

Service type From the addressed project task to which the consumption or revenue was posted or planned.

• 

• 

• 
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For project controlling, the project item provides all ACTUAL information from consumption and from sales.

As soon as a project booking is made, a project account is assigned to the resulting project items via the matrix mentioned above.

In this way, actual consumption and actual sales can be used directly for project controlling.

Down payment plan / payment schedule

Both options behave the same. The only difference is the data source. While the payment plan is a general payment plan for

projects, the down payment plan is a part of the down payment accounting module.

Project account schemeta

As soon as project plan lines and bookings are formed, projects can be evaluated. How and according to which criteria these

projects are evaluated on the basis of this data is mapped in the project account schemes. The thinking and procedure of these

project account schemes corresponds completely to the procedure in financial accounting with the account schemes on the basis

of the G/L accounts and G/L items there.

To set up the project account schemes, call up the "Project account schemes" via the user search.

Several structures can be defined via the project account schemes, which can be used to throw different views on the project

results. E.g. internal projects should be evaluated differently than customer projects. The project account scheme defines the

structure of the rows. In the following the setup fields are explained in more detail:

Project account schemes lines

A report structure is set up in the project account scheme itself, in which the corresponding project accounts are assigned to the

individual lines. Totals lines or formulas can also be entered.

The important fields are:

Field Description

Code Specifies a meaningful abbreviation of the project account scheme.

Description Specifies a description of the project account scheme.

Standard column

layout

In the field "Standard column layout" you can define the criteria for the evaluation in the column view.

The column layout stored there is always used as a basis when calling up a project account scheme.

However, it is possible to assign a different column layout at any time.

Field Description

Heading no. A logical line numbering is to be stored in the field "Rubric no.".

Description In the "Description" you have to enter which area you want to display in this line.

Counting type In the "Totals type" field, specify whether an account total, a grand total or a formula should be stored.

When specifying the account total, the values of one or more accounts are displayed.

If the Totals selection is activated, totals lines from the project chart of accounts can be taken into

account.

If the Formula type is selected, a formula can be defined within the project accounts scheme.

Counting up In the "Totals" field, according to the previously defined type, project accounts, totals rows or calculation

formulas can be specified.

Line type This field can be used to define whether the line is a main line or an auxiliary line.

Hide row This field can be used to control whether the line should be shown/hidden.

Line color By means of the selection it can be indicated whether the line is to be printed "black" or "blue".

Boldface The check mark can be used to specify whether the line should be printed in bold.
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Project account schemes column layout

When you call the "Set up column layouts" function, the Column layout project page is opened. Among other things, the column

layout TARGET - ACTUAL is stored in the database. 

Project account schemes matrix

You can call it up via the menu item "Matrix". It shows you the values resulting from the defined rows of the account scheme and

the columns of the column layout.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

Column no. In the "Column no. " an identification of the line is to be indicated.

Column heading In the field "Column header" you have to enter the name of the column as it should appear in the

printout.

Column type In the "Column type" it is possible to specify what will be done in the column:

Formula:

Calculations are performed between the columns.

Motion:

Pure transaction data is displayed.

Item type In the field "Item type" the respective item type (depending on the field "Column type=Movement)

must be specified.

Archive source Depending on the "Item type" field, the archive source must be specified if necessary.

Document type The type of document is defined in the Document type field. This field depends on the item type. E.g.

Item type=Purchase line can be defined as document type "Offer".

Amount type The "Amount type" field specifies what type it is, e.g. "Cost amount".

Assignment type

filter

In this field, a filter can further narrow down this line.

Comparison date

formula

In the "Comparison date formula" field, you can define which comparison period is to be displayed. The

entry is made in relation to the time period specified in the date filter in the report requests. Entries

can be made with the known time specifications (T, TW, W, M, Q, J).

Formula In the "Formula" field, the formula can be entered if the column type is the Formula selection.

Rounding factor In the "Rounding factor" field, you can specify whether and if so how to round. This allows large values

to be displayed clearly.

View The "Display" field can be used to define whether the column

• always,

• never,

• if positive

• If negative

is displayed.

Red color The display is in red color.

Green color The display is in green color.

1. 
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REKLAMATION UND GUTSCHRIFT

Complaint and credit note

Complaint

Should the case arise that a customer complains about the delivered goods, the complaint process can be started from within the

project.

To do this, select the corresponding project plan line and execute "Create sales complaint" via the menu item.

A window will open where you can make the following decisions:

Confirm your selection with "Ok". 

Credit

Detached from a complaint process, you also have the option to create a value credit note via a project plan line.

To do this, select the corresponding project plan line and call up the menu item "Create sales credit memo".

A window will open where you can make the following decisions:

Field Description

Create new document Specify whether you want to create a new document or attach the items to an existing claim.

Archive existing

document

If the document is to be attached to an existing document, it is recommended to activate the

"Archive existing document" button.

The existing document is archived again beforehand when activated.

Document date Specify which document date the complaint should receive.

Attach to document If you want to add to an existing complaint (Create new document = No), you can specify the

document to be updated here.

Determine to which document you want to assign the selected lines. A list of possible documents

is displayed for this purpose.

Lines outline Specify here whether a row outline should be created when a new document is created.

When adding documents, you will not be offered the choice and the outline type of the existing

document will be kept.

Field Description

Create new credit note Specify whether you want to create a new document or attach the items to an existing credit note.

Posting date Specify which posting date should receive the credit note.

Attach to credit memo

no.

If you want to add to an existing credit note (Create new credit note = No), you can specify the

document to be updated here.

Determine to which document you want to assign the selected lines. A list of possible documents is

displayed for this purpose.
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WORK IN PROGRESS (WIP) EVALUATION IN PLANT CONSTRUCTION

general

The following sections describe the Work in Progress (WIP) Valuation module. The determination of the valuation as well as the

execution and the posting process will be explained in short form. Finally, archiving and evaluation in project valuation are

addressed.

WIP Valuation can determine project values based on planned project budget items and posted project items. Project accounts

are used to assign these items to specific line items and are stored as information on the line items. The project accounts are

determined via a setup based on project type, activity type and product posting group separately for sales and consumption and

assigned to the items.

Via so-called project account schemes with variable column layouts, the values on these project accounts can be evaluated for

each project. The flexible structure of the schema makes it possible to display actual and planned values for the different project

accounts. Using formulas and if-then conditions, the values can additionally be linked or compared so that the relevant amounts

for the WIP evaluation can be displayed. Specially marked rows and columns determine which values are subsequently

transferred as a posting to financial accounting.

setup

This section gives an overview of the necessary setups. It explains which master data must be set up for project evaluation in

general so that projects can be evaluated automatically. The following master data must be set up in order to use project

evaluation:

WIP Valuation Setup

Fibu integration codes

Project chart of accounts

Project account scheme for WIP valuation

Column layout project account scheme for WIP valuation

In order to perform the valuation runs, some basic specifications and setups must be made in advance. This section describes

which setups need to be made.

wip evaluation setup

• 

• 

• 

• 

• 
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In the WIP Valuation Setup, general parameters for the project valuation are defined. The posting of the valuation figures is done

from the valuation proposal using a recurring Fibu Buch. sheet. 

wip fibu integration code

WIP Fibu integration codes are assigned in the project account schemes for the lines whose amount is to be posted to the

financial accounting. In the WIP Fibu integration codes the debit and credit accounts for the capitalization are defined.

For the different valuation items (e.g. expenses, down payments) and methods (e.g. Local GAAP, IFRS) separate WIP Fibu

integration codes must be set up for each posting record. The codes must be assigned to the respective lines in the project chart

of accounts.

project chart of accounts

A project chart of accounts must be set up so that the corresponding project values can be evaluated using a project chart of

accounts. For more information on the project account scheme, see here.

project chart of accounts

This section explains the specifics of the project account schema as it relates to WIP assessment. Basic information on setting up

project account schemas and the associated column layouts can be found here.

field description

Fibu Book Here the book. sheet template and name for the posting of the project valuation can be stored. The

ledger sheet must be a recurring ledger sheet.

Book Sheet Name Here you can define the accounting sheet template and name for posting the project evaluation.

The ledger sheet must be a recurring ledger sheet.

Prefix Document no. When posting the valuation proposal to the accounting system, the document number is composed

of this prefix and MM/YYYY of the valuation date.

Posting description Enter here a posting description for the posting to the financial accounting. The description will be

completed with MonthName/YYYY of the valuation date when posting the valuation proposal to the

Fibu.

Prefix Reversal When posting a new valuation proposal to the general ledger, the existing posting will first be

reversed. The document number for the reversal is composed of this prefix and MM/YYYY of the

valuation date.

Project evaluation

approved as of

Here you can specify the permitted posting period for project valuation postings.

Project valuation

allowed until

The allowed booking period for project valuation bookings can be specified here.

Repetition rate Since a recurring ledger sheet is used for posting the valuation proposal to the financial

accounting, you must specify here which recurrence applies. e.g. +1T+1M-1T

Field Description

Code Unique identifier of the Fibu integration code

Description Description of the accounting integration code

Debit account

activation

The debit amount of the relevant project account scheme line is posted to this account when the

activation is posted

Credit account

Activation

The credit amount of the relevant project account scheme line is posted to this account when the

activation is posted.
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A project account scheme must be set up for each of the valuations to be determined, e.g., one scheme each for IFRS and Local

GAAP. The fields in the project account scheme that are additionally relevant for the WIP valuation must be filled as follows:

project account scheme column layout

In the column layout assigned to the project account scheme, exactly one column must be marked as the relevant column for

determining and displaying the valuation amounts.

example of a wip valuation scheme

Field Description

Count A new option If can be selected here. This option can be used to compare row values using arguments

and conditions.

Argument 1 

Condition

Argument 2

Argument 3

Argument 4

These fields must be filled if the summation type, If is used.

The fields must be filled according to the following logic:

If Argument 1 Condition Argument 2,

then Argument 3

other Argument 4

Note

In the arguments, only rubric no. and arithmetic operators or numbers may be contained in the

arguments.

Options for condition:

- Empty

- <

- >

- =

- <=

- >=

For all other types of summation, the fields remain empty.

Fibu Integration

Code

A WIP Fibu Integration Code must be specified here if a posting to Financial Accounting is to be

generated for this row. For this entry, the accounts stored in the WIP Fibu integration code will be used.

Note

Only amounts from lines with the "Line value types" Valuation, Valuation correction and Received down

payments can be entered into the Fibu

Line Value Type This field specifies the line value heading in the WIP valuation proposal. Options are:

- Expenses

- Down Payment Invoices

- Revenues

- Valuation

- Down Payments Received

- Valuation Correction

Lines with the "Valuation Correction" option usually do not show a calculation, the line can be used later

in the valuation proposal for manual correction.

Calculation in

column

As values are displayed in different columns in the column layout, it can be defined here which value is

relevant in which row and column. For example, planned revenues are to be displayed in one row and

actual revenues in another, whereby it can only be defined in the columns whether the values are

planned or actual values.

field description

Column WIP Set a check mark here in the column that is relevant for the project valuation.

Note

Since planned and actual values - as well as revenues and costs - can only be displayed in different

columns, a totals column with the column type "Formula" is usually used to combine these values and is

also used as the column for the WIP.
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The following example is intended to show the structure of a WIP valuation scheme and to illustrate the options for calculating

and displaying the valuation.
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example of a project account scheme
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Rubric No. Description Counting up

value

Counting up Calculation

in column

Line value

type

Argument 1 Condition Argument 2 Argument 3 Argument 4 Fibu

Integration

code

R0010 Plan values Project

accounts

R0020 Revenue Project

accounts

No. of relevant

project

accounts

SP040

R0030 Expenses Project

accounts

No. of relevant

project

accounts

SP030

R0040 Planned

expenditure in

%

Formula R0030/R0020 SP050

Project

accounts

R0050 Actual values Project

accounts

R0060 Down payment

invoices

Project

accounts

No. of relevant

project

accounts

Down payment

invoice

R0070 Revenues Project

accounts

No. of relevant

project

accounts

SP020 Revenues

R0080 Sum of

services

Formula R0060..R0070 SP050

Project

accounts

R0090 Construction Project

accounts

No. of relevant

project

accounts

SP010

R0100 Production Project

accounts

No. of relevant

project

accounts

R0110 External

services

project

accounts

No. of relevant

project

accounts

SP010

R0120 Travel

expenses

Project

accounts

No. of relevant

project

accounts

SP010

R0130 Other

Expenses

Project

Accounts

No. of Relevant

Project

Accounts

R0140 Total Expenses Formula R0090..R0130 SP050 Expenses

R0150 Effort adjusted Formula R0140+

(R0040*R0070)

SP050
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example of the corresponding column layout

posting procedure project valuation

In this section, the posting flow of project valuation is explained in more detail. 

The following points are addressed:

What is the WIP valuation proposal.

How the valuation lines are calculated

Posting the WIP valuation proposal us effects on financial accounting.

fill valuation proposal

The actual valuation is done in the WIP valuation proposal. The function "Calculate valuation lines " is used to fill the valuation

proposal. 

Folgende Optionen müssen hier gesetzt werden:

Zusätzlich können die zu berücksichtigenden Projekte ausgewählt werden. So haben Sie die Möglichkeit bestimmte Projekte /

Projektgruppen mit einem anderen Projektkontenschema zu bewerten. Sollten Sie Projekte parallel nach unterschiedlichen

Rubric No. Description Counting up

value

Counting up Calculation

in column

Line value

type

Argument 1 Condition Argument 2 Argument 3 Argument 4 Fibu

Integration

code

R0170 HZ: Valuation

correction

Project

accounts

Valuation

correction

Valuation

CORR

R0180 HZ: down

payments

received

Project

accounts

No. of relevant

project

accounts

DOWN

PAYMENT

RECEIVED

column no. column

header

column type item type amount type amount type formula column WIP

SP010 Actual:

Expense

Movement Project item 1 Asset amount

(MW)

No

SP020 Actual:

Revenue

Movement Project item 2 Amount sold

(MW)

No

SP030 Plan: Expense Movement Project plan

line

1 Cost amount

(MW)

No

SP040 Plan: Revenue Movement Project plan

line

2 Sales amount

(MW)

No

SP050 Sum column Formula SP010..SP040 Yes

• 

• 

• 

Feld Beschreibung

Bewertungsperiode Hier muss das Startdatum der relevanten Buchhaltungsperiode ausgewählt werden. Für die Buchung

selbst wird anschließend der Monatsletzte der Periode verwendet.

Bewertungsschema Wählen Sie hier den Namen des Projektkontenschemas aus, mit dem Sie die Bewertung durchführen

möchten.

Vor der Berechnung der Werte wird geprüft, ob alle notwendigen Einstellungen im

Projektkontenschema vorhanden sind. Dies sind:

• Für jede "Zeilenwert Art“ muss eine Zeile im Schema vorhanden sein.

• Im Spaltenlayout muss eine Spalte als "Spalte WIP“ definiert sein.
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Bewertungsgrundsätzen bewerten (z.B. IFRS / Local GAAP), so muss die Berechnung je Projektkontenschema erneut aufgerufen

werden.

Es werden nur Projekte berücksichtigt deren Enddatum noch nicht gefüllt ist bzw. deren Enddatum nach dem Bewertungsdatum

liegt.

Bei jedem Aufruf der Funktion wird pro Projekt eine Zeile im WIP Bewertungsvorschlag erzeugt. 

wip valuation proposal

The fields in the "WIP valuation proposal" are filled as follows when calculating:

posting a valuation proposal

The following steps are performed when posting the valuation proposal:

First, the system checks whether a posted valuation already exists for the project with this valuation date and project chart of

accounts used to calculate the line. Already posted valuations are archived in the "WIP Valuation Archive" with a sequential

number.

If a valuation has already been posted under these premises, it is first reversed.

Subsequently, the valuation proposal is posted and stored in the archive with the next consecutive number.

Optionally, a printout of the valuation can be made.

field description

OriginNo. This field indicates the project to which this evaluation line applies.

Description This field displays the project description.

Valuation Date This is the date (last day of the month of the valuation period) that the entry will

be made in the financial accounting system.

Total Expenses Amount determined by the calculation of the project chart of accounts for this

project in the rows marked as "Expenses".

Total of down payment invoices Amount determined by the calculation of the project chart of accounts for this

project in the rows marked as "Down payment invoice".

Total of partial and final invoices Amount determined by the calculation of the project chart of accounts for this

project in the rows marked as "Revenues".

Valuation Amount determined by the calculation of the project chart of accounts for this

project in the rows marked as "Valuation".

Valuation correction A manual value for the valuation correction can be entered in this field. The value

must be positive and must not exceed the valuation amount.

Valuation Adjustment Integration Code The value from the Valuation Adjustment field will be posted to the accounts of

this Valuation Integration Code.

Adjusted valuation This field is calculated as follows:

- Valuation - Valuation correction

Prepayments Received Amount determined by calculating the project chart of accounts for this project in

the rows marked as "Prepayments Received".

passive accrual received down

payments

This field is calculated as follows:

- if "received down payments" is higher than "adjusted valuation":

"received down payments" - "adjusted valuation"

- _otherwise this value is 0

Fibu integration code passive accrual

received down payments

On the accounts of this Fibu integration code the value from the field "passive

accrual received down payments" is posted to the Fibu.

• 

• 

• 

• 
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The posting of the valuation proposal takes place via a recurring book. sheet with the repetition type "Reverse variable". This

means that the valuation is booked in on the valuation date and booked out again on the following day. Thus, with each new

valuation in the following month, the accumulated value is always posted. With the previous month's values already booked out

on the first of the month, the development of the amounts can thus be tracked.

A possible reversal cancels both the postings on the valuation date and the write-off postings on the following day.

Posted are the values from the following columns with the accounts of the respective WIP Fibu integration code of the assigned

project chart of accounts row:

Valuation Adjustment

Adjusted valuation

Liabilities accrual received down payments

The document no. and the description for the posting will be set according to these specifications:

Document no.: The respective prefix. 

Description: The posting description from the "WIP Valuation Setup" is completed with month name/YYYY of the valuation

date.

A new ledger is created with the corresponding G/L items and a new entry is created in the "WIP Valuation Archive". In the

archive all information from the "WIP Valuation Proposal" is available, in addition a sequential number is assigned per

combination of project no./valuation date/project account scheme. The valuation with the highest sequential number indicates

which are the currently posted values in the financial accounting.

print valuation proposal

The WIP Valuation module includes a report for printing and proving the valuation proposal.

Lines generated in the "WIP Valuation Proposal" can be printed in a report before or with posting. The values generated in the

valuation proposal are listed in tabular form. In addition, a total is calculated for all valuation lines.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

• 

1. 
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PDM-Interface

Description to follow.
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General Setup

MANDATORY FIELD CHECK

The mandatory field check allows to define customer-specific mandatory fields to support the creation of master or document

data. Certain values are specified, which are checked after the input is completed. 

At this point of the online help only the additional functionality of the mandatory field validation in KUMVISION factory365 will

be explained. The general scope of functions is described here.

Mandatory field check setup

At this point of the online help, only the additional setup options of the mandatory field check in KUMVISION factory365 will be

explained to you in more detail. The general setup options are described here.

Setup mandatory fields

The mandatory fields are defined via the user search "Mandatory fields setup tables".

When called up, the "Mandatory fields setup tables" are opened. In this list, the corresponding tests can be viewed for each

table.

Area Facility Field

G/L accounts Financial accounting institution mandatory field check G/L account

workstation groups

workstations

production setup mandatory field check workstation group

mandatory field check workstation

Delivery schedule headers

Delivery schedule setup Compulsory field check

Note
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You can define the mandatory fields for the corresponding exam record via the "Mandatory fields" menu item.
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Field Description

FieldNo This field contains the number of the field for which this check is intended

Field name This field contains the description of the field for which this check is intended and is automatically

filled when the "Field no." is assigned.

Comparison Type The Comparison Type field is used as a comparison operator to check the value of the field in the

record against the value from the Comparison Value and/or Maximum Comparison Value fields. Here,

the following comparison operators are available:

- <>

- =

- >

- <

- >=

- <=

- >=

Note

Depending on the definition of the "Comparison Value" and "Maximum Comparison Value" fields, the

selection of the comparison operator may be restricted

Comparison Value The "Comparison Value" field checks the value of the field in the record in dependence with the

"Comparison Type" field.

Reference Value

Text

Gives the description of the selection in the Comparison Value field

Maximum

comparison value

The field "Maximum comparison value" checks the value of the field in the record in dependence with

the field "Comparison type"

when selecting the comparison type ">=<=". Thus, it is possible to define from-to ranges.

In this case, the "Comparison Value" field takes the "from role" and the "Maximum Comparison Value"

field takes the "to role".

Note - This input is intended for computable operands only.

Maximum

Reference Value

Text

Specifies the description of the selection in the "Maximum Comparison Value" field.

Condition Field

No.:

Specifies the field on which the condition is to be checked.

Condition Field

Name

This field contains the description of the field for which this condition is intended and is automatically

filled when the "Condition Field No." is assigned.

Comparison Type The "Comparison Type" field is used as a comparison operator to check the value of the field in the

record against the value from the "Condition Value" and / or "Maximum Condition Value" fields. The

following comparison operators are available here:

<>

=

>

<

>=

<=

>=

Note

Depending on the definition of the "Value Condition" and "Maximum Condition Value" fields, the

selection of the comparison operator may be restricted

Value Condition
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At this point of the online help, only the setup of the check fields of the mandatory field check in KUMVISION factory365 will be

explained to you in more detail. The general setup is described here.

FLEXIBLE RESERVATION SYSTEM

With the help of the flexible reservation system, you can allow date conflicts in the reservation items, so that the links between

the requirement originator and the requirement coverer are basically preserved, contrary to the Microsoft Dynamics 365

Business Central1 standard.

The date conflicts are also taken into account within the planning and remain despite "date conflict". A date conflict occurs in a

reservation item as soon as the "Expected goods receipt date" is after the "Goods issue date".

Basically, date conflicts within reservations should only exist for a short period of time and should be resolved promptly by date

reconciliation and updating.

Company data

You can activate or deactivate the flexible reservation system function in the company data via the "Allow date conflicts" switch.

Field Description

The "Value Condition" field checks the value of the field in the record in dependence with the

"Comparison Type Condition"

Condition Value

Text

Provides the description of the selection in the Value Condition field

Maximum

Condition Value

The Maximum Condition Value field checks the value of the field in the record in dependence with the

Comparison Type Condition field when the comparison type ">=<=" is selected. Thus, it is possible to

define from-to ranges.

In this case, the "Comparison Value" field takes the "from role" and the "Maximum Comparison Value"

field takes the "to role".

Note

This input is intended for computable operands only.

Condition Option

Text

Indicates the description of the selection in the "Maximum Condition Value" field.

Action The "Action" field controls what type of check is involved. The following selections are available:

Note

if the check is defined as a "Note", users will receive a note message when processing the mandatory

field check. However, this hint message does not influence the release of master data or documents. It

is to be seen rather as information, with whose assistance the AnwenderInnen can supplement still

data, which are perhaps informative, but for processes not compellingly necessary.

Cancel

if a check is defined as "Cancel", then with the processing of the obligation field check an abort

message follows. This means that the release of master data or documents cannot be completed

because process-relevant information is missing.

Note

Note
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Please note that existing date conflicts must be cleared before deactivating the functionality.

For an individual extension (e.g. user authorization) corresponding event triggers are available in the TechDocs.

Rolecenter

The number of existing date conflicts is displayed in the Sales, Purchasing, Service, Projects and Production role centers. Via the

function call within the respective batch, the reservation items are displayed and the documents can be called up and edited via

the standard functionality of the reservations.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

Note

1. 
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1.2.3 healthcare365

KUMAVISION healthcare365

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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General Business Functionality

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Financial Management

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Sales

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Purchasing

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Assembly Management

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Manufacturing

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Warehouse Management

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Rezeptabwicklung Teil 1

RECIPE PROCESSING PART 1

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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DELIVERY SCHEDULE

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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BILLING SCHEDULE

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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PROCESSES

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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CONTRACTS

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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PURCHASE WITH RECIPE PROCESSING

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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FLATE RATE WITH RECIPE PROCESSING

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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CALORIE FLAT RATE

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note

1.2.3 healthcare365

- 544/1545 - Copyright © 2018 - 2024 KUMAVISION AG



REUSE

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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PROCESS EXTENSION

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note

1.2.3 healthcare365

- 546/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Rezeptabwicklung Teil 2

RECIPE PROCESSING PART 2

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note

1.2.3 healthcare365

- 547/1545 - Copyright © 2018 - 2024 KUMAVISION AG



ELECTRONIC COST ESTIMATE

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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ADDITIONAL FIELDS

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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ELECTRONIC BILLING TO §300

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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ELECTRONIC BILLING TO §302

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note

1.2.3 healthcare365

- 551/1545 - Copyright © 2018 - 2024 KUMAVISION AG



FAST ENTRY MASK

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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EBOX DOKUMENTENVERARBEITUNG

Die eBox ist in KUMAVISION healthcare365 eine zentrale Stelle zur Bearbeitung des aktuellen Arbeitsvorrates. So können hier

Team und personenbezogen die folgenden Prozesse bearbeitet werden:

Eingehende Dokumente (Rezept, Kostenvoranschläge und sonstige Dokumente)

Bearbeitung von Fehlern aus Stapelbuchungsvorgängen

Bearbeitung von manuellen Entscheidungen bei Verlängerung von Verträgen (Stapelverarbeitung)

Bearbeitung von Wiedervorlagen

Die eBox unterstützt Sie dabei mit der Bereitstellung aller benötigten Funktionen, Informationen und Verzweigungen in den

offenen Prozess, so dass Sie direkt aus der eBox Ihren Prozess starten/weiterbearbeiten können.

In diesem Abschnitt werden Struktur und Funktionen der eBox dargestellt. Da die eBox in andere Prozesse eingebunden ist,

werden einzelne Funktionen zum Teil im Rahmen dieser Prozesse beschrieben.

In der folgenden Grafik wird schematisch die Bearbeitung eines "Muster16" im Scanprozess dargestellt.

Dokument kommt ins Haus und wird auf der Rückseite mit einem eindeutigen Barcode versehen. An dieser Stelle kann eine

Sortierung für die entsprechenden Teams erfolgen. Nach der Sortierung erfolgt ein getrennter Scan nach Teams.

Nach dem Scannen der Muster16 erfolgt eine chronologische Ablage anhand der Barcodenummer. Dies ist notwendig, um die

Originalverordnung für die Abrechnung schnell wieder zu finden.

Wenn die Muster16 gescannt wurden, erfolgt im Hintergrund die Schrifterkennung und im Anschluss werden die Daten an das

System übergeben (DI-IM Dokument).

Vorbearbeitung in eBox "Dokument ungeprüft“ durch den /die erste/n SachbearbeiterIn -> Abschließen in der eBox

Abschließende Bearbeitung in eBox "Dokument“ durch den /die zweite/n SachbearbeiterIn -> Vorgang zuordnen / Vorgang anlegen,

archivieren, Vorgang bearbeiten.

Einrichtung

DI-Dokumententypen

• 

• 

• 

• 

1. 

2. 

3. 

4. 

5. 
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Das Einscannen erfolgt gemäß den festgelegten DI-Dokumententypen. In den "DI-Dokumententypen" sind die jeweiligen

Einrichtungsdetails enthalten. 

Das Feld "IM Dokument Status“ sorgt dafür, dass bestimmte Dokumente nach dem Einscannen direkt archiviert werden (sofern

der Barcode erkannt wird). Es erfolgt kein eBox-Eingang im "eBox-Status" offen und eine manuelle Bearbeitung ist nicht

erforderlich.

Der Dokumententyp "LS-Rückläufer“ setzt zudem die vorhandene Informationsanforderung auf den Status "Info OK“.

Vertriebsteams

BenutzerInnen, die, die Dokumente eines Teams bearbeiten sollen müssen diesem Team zugeordnet werden. Richten Sie hier

über die "Vertriebsteams“ zunächst die gewünschten Teams ein. Erstellen Sie einen neuen Eintrag über den Funktionsaufruf

"Neu“, ordnen Sie nun die gewünschten MitarbeiterInnen über den Aufruf "Benutzer“ im Menüband zu. Es öffnet sich die "Team

Benutzer“-Übersicht in der Sie die zugehörigen BenutzerInnen über die Benutzer ID auswählen können.

Ist ein/e BenutzerIn mehreren Teams zugeordnet, kennzeichnen Sie ein Team als primäres Team.

Kommunikationsbelege

Über die Einrichtung der Kommunikationsbelege definieren Sie welche Dokumententypen zu welchen Seiten (Debitor,

Informationsanforderung etc.) archiviert werden und ob sich nach dem Ausführen der Funktion "archivieren“ noch eine

Vorgangs- oder Kundenbezogene Seite für die Weiterbearbeitung öffnen soll.

Ablauf

Aufrufen der eBox

Über den Aufruf "eBox“ auf der Startseite, unter Aktionen, öffnen Sie die “eBox“. Es öffnet sich die Seite "eBox Arten“.

Wählen Sie die für die Bearbeitung gewünschte eBox Art aus und bestätigen diese mit "OK".

Für die hier geschilderten Fälle sind folgende eBox Arten relevant:

Dokument ungeprüft

Dokument

Mit diesen beiden eBox Arten werden im Prozess die gescannten Dokumente weiterverarbeitet und den weiteren Prozessen in

KUMAVISION healthcare365 zugeführt.

In der folgenden Abbildung wurde grafisch die Trennung der Bearbeitung von "Dokument ungeprüft“ und "Dokument“

dargestellt. 

Die erste Person macht die Vorbearbeitung, Kontrolle der Informationen und Datenvorerfassung. Die zweite Person kontrolliert

noch einmal die Daten, ergänzt diese und führt die weiteren Arbeitsschritte durch.

Hinweis
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Je nach ausgewählter "eBox-Art“ wird Ihnen, Ihre persönliche benutzerbezogene eBox angezeigt. Die Ansicht ist gefiltert auf die

eBox-Art und Ihren Benutzer. 

Sind noch keine Dokumente vorhanden so ist der Inhalt dieser Seite leer.

Abrufen von Dokumenten zur Bearbeitung

Unterhalb der Filter befindet sich die Funktion zum Abrufen von Dokumenten. Durch die Anwendung von "Abruf“ öffnet sich die

"Dokumenten-Auswahlliste. Es werden nun alle Dokumente angezeigt, die sich noch im eBox Status "offen“ befinden und somit

unbearbeitet sind. Die Ansicht ist auf Teamebene vorgefiltert.

Grundsätzlich werden Ihnen hier zum einen alle unbearbeiteten Dokumente angezeigt, die noch keinem Team zugeordnet sind

sowie die Dokumente für ein Team, welches Sie als Benutzer zugeordnet sind.

Einträge werden nicht angezeigt, wenn sie von einem/einer anderen BenutzerIn in dessen persönliche eBox gezogen wurde.

In der Dokumentenauswahlliste besteht die Möglichkeit, die Ansicht anders zu strukturieren. So ist es möglich die

Sortierreihenfolge zu ändern.

Suchbegriff, Scandatum

Scandatum, Suchbegriff

Es ist auch eine Filterung nach dem Zusatzfeld möglich. 

Markieren Sie die gewünschten Dokumente, die Sie bearbeiten möchten, und bestätigen die Auswahl mit "OK". Damit befinden

sich die abgerufenen Einträge in Ihrer persönlichen eBox und sind somit für andere UserInnen beim Abrufen nicht mehr

sichtbar.

Filtern von Dokumenten in der persönlichen eBox

Je nach Menge der zu bearbeitenden Dokumente oder Unternehmensprozesse, ist es Sinnvoll, die Dokumente entsprechend Ihrer

Dokumentenart zu filtern. Wählen Sie hierzu die gewünschte Dokumentenart im Filterfeld "eBox Unterart“ aus. Im Ergebnis

Hinweis
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werden Ihnen nur die Dokumente der ausgewählten Dokumentenart angezeigt. Dokumente einer anderen Art sind somit über

den Filter ausgeblendet. Gleiches gilt beim Abruf von Dokumenten.

Des Weiteren haben Sie neben den Filtermöglichkeiten im oberen Bereich zudem auch die Möglichkeit, sich die gewählten

Dokumente über die Sortierung zu einzelnen Spaltenüberschriften auf- oder absteigend zu sortieren um mehrere Dokumente zu

einem Debitor untereinander stehen zu haben.

Mit der Auswahl der eBox Unterart ändert sich auch die Darstellung der Seite da je nach Dokumentenart verschiedene Felder

relevant sind.

Dokument einem anderen Team zuweisen

Stellen Sie im Laufe der Bearbeitung fest, dass der Beleg zum falschen Team gescannt wurde, kann dieser einem anderen Team

zugewiesen werden. Hierzu gehen Sie wie folgt vor:

Datensatz auswählen

Aufruf "Anderes Team zuweisen"

Das gewünschte Team zuweisen

Mit "OK" bestätigen

Damit ist der Eintrag aus der persönlichen eBox entfernt und befindet sich wieder in der "Dokumentenauswahlliste“ mit dem

neuen Teamcode.

Dokument andere BenutzerInnen zuweisen

Stellt Sie im Laufe der Bearbeitung fest, dass der Beleg von einem/einer bestimmten BenutzerIn bearbeitet werden soll, kann

dieser direkt entsprechend zugewiesen werden. Hierzu gehen Sie wie folgt vor:

Datensatz auswählen

Aufruf "Anderen Benutzer zuweisen"

Benutzer zuweisen

Mit "OK" bestätigen

Damit ist der Eintrag aus der persönlichen eBox entfernt und befindet sich in der persönlichen eBox des neuen Benutzers.

Dokumente aus der persönlichen eBox löschen

Mit der Funktion "Löschen" kann ein Eintrag aus der persönlichen eBox entfernt werden. Damit wird der Eintrag nicht wirklich

gelöscht, sondern zurück in den Arbeitsvorrat gegeben. Andere BenutzerInnen können ihn dann wieder in die persönliche eBox

ziehen.

Dokumente "ungeprüft“ bearbeiten (Vorbearbeitung)

Die Bearbeitung in der eBox erfolgt in zwei Stufen.

Die erste Bearbeitungsstufe mit der eBox Art "Dokumente ungeprüft“ dient der Vorerfassung von Daten -> erste Bearbeitung bzw.

Kontrolle und Ergänzung der gelesenen Daten.

In der zweiten Bearbeitungsstufe mit der eBox Art "Dokumente“ findet die abschließende Bearbeitung statt -> Kontrolle und

weitere Vorgangsbearbeitung. 

Somit wird jedes Dokument zwei Mal bearbeitet, was Fehler vermeidet (vier-Augen-Prinzip).

Bearbeiten von Dokumenten Typ: MUSTER16 (Vorerfassung)

Abgleich der durch die OCR-Schrifterkennung gelesenen und an KUMAVISIOIN healthcare365 übergebenen Daten, ggf.

Korrektur. Bei A4 Rezepten ist keine Schrifterkennung möglich, hier müssen die relevanten Felder manuell im Rahmen der

Vorerfassung hinterlegt werden.

Hinweis
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Bearbeiten von Dokumenten Typ: SONSTIGE (Vorerfassung)

Im Viewer lässt sich erkennen, um was für eine Dokumentenart es sich handelt. Somit kann die gewünschte Belegart in der eBox

auswählt werden. Als nächsten Arbeitsschritt muss eine Belegnummer ausgewählt wählen. In diesen Fall handelt es sich um die

Kontaktnummer. Um welche Belegnummer es sich handelt, wird durch die Belegart vorgegeben. Dies ist in der Einrichtung der

Kommunikationsbelege hinterlegt und somit parametrisierbar.

Lieferscheinrückläufer

System Lieferscheine werden automatisch der Info. Anforderung zugewiesen. Dies geschieht unter Erkennung des Barcodes auf

dem Lieferschein. Der Barcode entspricht der Info.-Anforderungsnummer. Wurde der Barcode nicht erkannt, so ist eine

automatische Zuweisung nicht möglich und das Image wird als "nicht erkannt" in die DI-IM Dokument geschrieben und ist somit

in der "Dokumentenauswahlliste“ verfügbar.

Barcodevormerkung

Die Barcodevormerkung besteht aus drei getrennten Arbeitsschritten.

Barcodevormerkung erstellen, es entsteht eine leere "Dokumentenhülle“

Scannen der vorgemerkten Dokumente über den Stapel "Barcodevormerkung“

Es erfolgt die automatische Zuordnung des Dokuments, die "Dokumentenhülle“ wird befüllt. (Wird der Barcode nicht erkannt, wird

das Image des Dokumentes in die eBox übergeben und muss dort manuell weiter bearbeitet werden)

Vorverarbeitung abschließen

Wurde das Dokument in der ersten Stufe geprüft, wird die Vorverarbeitung des Dokuments über die Aktion "Geprüft“

abgeschlossen und der Eintrag wird aus der persönlichen eBox entfernt. Der Eintrag geht damit wieder in den Arbeitsvorrat und

steht nun für die eBox mit der eBox Art "Dokumente“ zum Abruf in der "Dokumentenauswahlliste“ zur Verfügung. 

Es ist nun nicht mehr möglich, das Dokument in die eBox mit der eBox Art "DOC UNG“ abzurufen.

Dokumente bearbeiten (Endbearbeitung)

Das Abrufen aus dem Arbeitsvorrat erfolgt analog zum Prozess des Abrufs für die eBox Art "Dokumente ungeprüft“. Siehe hierzu

Abschnitt" Abrufen von Dokumenten zur Bearbeitung".

Es öffnet sich die Seite "IM Dokumentenauswahlliste" (Arbeitsvorrat). Es bestehen die gleichen Filter- und Sortiermöglichkeiten

wie unter der eBox Art "Dokumente ungeprüft“.

Bearbeiten von Dokumenten (Endbearbeitung)

Gemäß dem Vier-Augen-Prinzip erfolgt der erneute Abgleich der Daten.

Je nachdem ob es bereits einen Rezeptvorgang gibt oder ob ein neuer angelegt werden muss erfolgt nun die weitere

Bearbeitung.

Neuen Vorgang und ggf. neuen Debitor anlegen

Ist der Vorgang noch nicht im System angelegt, so kann dieser direkt aus der eBox heraus angelegt werden. Eine

Vorgangsanlage ist nur möglich, wenn der Debitor ebenfalls im System vorhanden ist.

Die Neuanlage eines Debitors erfolgt direkt aus der eBox heraus über die Funktion "Neuer Debitor aus Kurzerfassung“. Nutzen

Sie hierfür, wenn vorhanden, ein Dokument des Typen "MUSTER16", da hier die meisten gelesenen Daten erfasst sind. Die

gelesenen Daten werden automatisch in den neuen Debitor übertragen und müssen nicht mehr manuell erfasst werden, ggf.

weitere zusätzliche Felder die Ihnen über die Pflichtfeldprüfung vorgeschlagen müssen manuell ergänzt werden.

Legen Sie analog dazu auch fehlende Verordner über diese Funktion an. Hier werden die Betriebsstättennummer sowie die

Arztnummer ebenfalls direkt an den neuen Debitor übergeben.

1. 

2. 

3. 
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Über die Funktion "Neue Vorgangsperiode anlegen“ legen Sie nun aus der eBox heraus einen neuen Vorgang an. 

Nachdem Sie den Vorgang angelegt und wieder geschlossen haben, erscheinen die zugehörigen Informationsanforderungen, an

welchen die Dokumente archiviert werden müssen.

Über die Funktion "Abrechnungsaufteilung Befreiung“ können Sie eine eventuelle Befreiung direkt zum Kunden hinterlegen.

Bearbeiten der Informationsanforderungen und Archivierung der Dokumente

Auf dem Inforegister "Info.-Anforderungen“ werden Ihnen die Informationsanforderungen angezeigt, zu denen noch Dokumente

fehlen. Diese Ansicht ist vorgefiltert auf den Dokumententyp sowie den "Anforderungsstatus“. Es werden nur die notwendigen

Informationsanforderungen angezeigt. Informationsanforderungen die bereits im Status "Info OK“ sind, werden durch den Filter

in der Ansicht ausgeblendet.

Wählen Sie anhand des Ihnen angezeigten Dokuments die entsprechende Informationsanforderung aus. Achten Sie hierbei

zwingend auf die "Anforderungsqualität“ und setzen den Haken im Feld "Hauptbeleg“ in der höchsten Qualität. Nach Auswahl

des Hakens im Feld "Hauptbeleg“ wird der Haken im Feld "Auswahl“ automatisch vom System mitgesetzt. Es ist an dieser Stelle

nicht notwendig einen weiteren Haken in der Informationsanforderungszeile mit der geringeren Qualität zu setzen, die

Verarbeitung der geringeren "Anforderungsqualität“ erfolgt automatisch.

Setzen Sie nun zunächst den entsprechenden Info-Anforderungsstatus über den zutreffenden Status "Info nicht OK“ oder "Info

OK“. Je nach Dokumentenart und Einrichtung öffnet sich eine neue Seite die zu prüfen und ggf. zu ergänzen ist. Mit "OK"

bestätigen Sie Ihre Eingabe. Der Status zur Informationsanforderung ist somit aktualisiert.

Archivieren Sie nun das Dokument zur Informationsanforderung über die Funktion "Archivieren“. Je nach vorgenommener

Einrichtung öffnet sich nach dem Archivieren des Dokumentes der Vorgang (dies ist individuell zu Parametrisieren).

Dokumente zum Debitor archivieren

Je nach erfolgter Einrichtung der Kommunikationsbelege, können Dokumente auch direkt zum Debitor archiviert werden

(Vorgangsunabhängig) und sind dann im Marketing Cockpit sichtbar. Dies empfiehlt sich z.B. für Befreiungsausweise,

Kundenbriefe oder nicht notwendige "überflüssige“ Rezepte.

Wählen Sie, entsprechend Ihrer Einrichtung, den Dokumententypen und die Belegart aus und wählen anschließend im Feld

"Belegnummer" den Kunden aus. Über den Funktionsaufruf "Archivieren“ wird das Dokument zum Debitor archiviert.

Funktion "zurück in die eBox"

Sollte in Folge der Scanbearbeitung das Dokument an einer falschen Stelle abgelegt worden sein, so besteht die Möglichkeit,

dieses Dokument für eine neue Zuordnung zurück in die eBox zu senden.

Die Funktion "zurück in die eBox“ steht auf verschiedenen Seiten zur Verfügung.

Die Funktion wird über den Aufruf "Zurück in die eBox“ gestartet.

Es öffnet sich die Seite "Auswahl der Archiveinträge“. Je nachdem ob die Funktion aus dem Rezeptvorgang

"Vorgangsperiodenkarte“ oder "Vorgangskarte“ ausführt oder aus dem "Marketing Cockpit“ des Debitors werden alle Belege

angezeigt, welche dem Vorgang zugeordnet sind oder welche dem Debitoren, Vorgangsunabhängig, zugeordnet sind. Aus dieser

Liste wählen Sie den gewünschten Beleg über das Aktivieren von "Auswahl“ aus.

Zu den einzelnen Datensätzen wird hier nicht das Image des Belegs angezeigt. UserInnen müssen den korrekten Datensatz anhand

der eingetragenen Werte identifizieren.

Anschließend wird der Dokumententyp ausgewählt, dem der Beleg entspricht. Dieses Feld ist gleichbedeutend mit der eBox

Unterart. Mittels setzen eines Hakens im Feld "Index übernehmen“ wird der Debitor im folgenden mit in die eBox übernommen.

Hinweis

Hinweis

1.2.3 healthcare365

- 558/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Führen Sie die Funktion "zurück in die eBox“ aus. 

Nachdem die Funktion ausgeführt wurde, ist das Dokument nicht mehr dem Vorgang oder Debitor zugeordnet. Das Dokument

findet sich nun in der persönlichen eBox des Users, welcher die Funktion aufgerufen hat. Eine erneute Zuordnung ist nun

möglich.

EKV Rücklauf verarbeiten

Sofern keine automatische Verarbeitung im System eingerichtet ist, erfolgt die Verarbeitung von Kostenvoranschlag-Rückläufern

zum EKV manuell über die eBox oder Alternativ bei abweichend genehmigten Einrichtungen. Siehe auch hierzu Abschnitt

"Rezept Ablehnungsgründe“ Einrichtung EKV.

Wurde der EKV vom Kostenträger abgelehnt, werden die zugehörigen Informationen wie Änderungen oder Textinformationen auf

dem Inforegister "EKV Änderungen“ angezeigt. Der Genehmigungsstatus wird in dem zugehörigen Feld "Status“ angezeigt,

eventuell seitens des Kostenträgers übermittelte Nachrichten werden Ihnen über das Feld "Textinformation“=Ja angezeigt. Sie

können mittels Klick auf das "Ja“ die entsprechende Textinformation einsehen.

EKV Ablehnung nachbessern und erneut einreichen

Die zugehörige Informationsanforderung über welche der EKV versandt wurde, ist automatisch markiert. Führen Sie die

Funktion "Info nicht ok“ aus. Je nach Einrichtung haben Sie im nachfolgenden Fenster "Komm. Status Vorlagenzeilen“ die

Möglichkeit, einen Ablehnungsgrund auszuwählen. Markieren Sie die zutreffende Zeile und bestätigen diese mit "OK". Der

Status der Infoanforderung ändert sich auf "abgelehnt“. Im zugehörigen Rezeptvorgang wurde eine neue Infoanforderung für

eine eventuelle Neueinreichung, erzeugt. 

Sie haben die Möglichkeit, über die Infoboxen auf die Vorgangsbeteiligten wie Versicherter, Kostenträger oder Verordner

zuzugreifen und evtl. fehlerhafte oder fehlende Daten zu erfassen wie z.B. die Versichertennummer. 

Auf dem Inforegister der Informationsanforderungen befinden sich die Aufrufe, um direkt den zugehörigen Vorgang bzw. Liefer-

oder Abrechnungsplan aufzurufen um dort eventuell erforderliche Anpassungen vorzunehmen. 

Unabhängig davon, ob Ihnen ein Dokument seitens des Kostenträgers mit übermittelt wurde, archivieren Sie den eBox Eintrag.

EKV Genehmigung verarbeiten

Es wird zwischen zwei verschiedenen Status-Meldungen für einen Genehmigungsrücklauf unterschieden:

Status "genehmigt“: Genehmigt wie eingereicht

Status "teilgenehmigt“: Genehmigt mit Änderungen

Das Genehmigungskennzeichen sowie Datum wird auf dem Inforegister "Antwort Details“ angezeigt. Der Genehmigungsstatus

wird im zugehörigen Feld "Status“ auf de, Inforegister "EKV Änderungen" ausgewiesen. Dort werden auch eventuell seitens des

Kostenträgers vorgenommene Änderungen ausgegeben. Sie sehen an dieser Stelle zum einen Ihre eingereichten Daten und zum

anderen die vom Kostenträger übermittelten Daten.

Das Genehmigungsdokument wird Ihnen über den Viewer angezeigt und kann hier nochmals verglichen werden.

Die zugehörige Informationsanforderung über welche der EKV versandt wurde, ist automatisch markiert. Führen Sie die

Funktion "Info ok“ aus. Je nach Einrichtung öffnet sich nachfolgend der Rezeptvorgang, über diesen Sie weiterführende Schritte

wie z.B. Anpassung von geänderten Daten wie z.B. Zuzahlung durchführen können. 

Archivieren Sie nun noch das Genehmigungsdokument über die Funktion "Archivieren“ in der eBox.

Weitere Funktionen in der eBox Betriebsstundenerfassung

Sie haben die Möglichkeit, direkt aus der eBox heraus die Betriebsstunden zu hinterlegen. Führen Sie hierzu die Funktion

"Betriebsstundenerfassung“ aus. Der Prozess zur Betriebsstundenerfassung ist separat beschrieben.

Zuzahlungsbefreiung hinterlegen

Hinweis
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Sie haben die Möglichkeit, direkt aus der eBox heraus die Zuzahlungsbefreiung für einen Debitoren zu hinterlegen. Führen Sie

hierzu die Funktion "Abrechnungsaufteilung Befreiung“ aus. 
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BATCH

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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BILLING SPLITS

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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INFORMATIONSMANAGEMENT (IRM)

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Rezeptabwicklung Teil 3

RECIPE PROCESSING PART 3

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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ADVANCED PRICING

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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ADDRESS MANAGEMENT / CONTROL

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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PROCESS REPLACE

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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SALESPERSON CONTROL

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note

1.2.3 healthcare365

- 568/1545 - Copyright © 2018 - 2024 KUMAVISION AG



CUTBACK DOCUMENTATION

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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HEALTH INSURANCE COMPANIES MERGE

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Consultation Supplies incl. Practice Supplies

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Customized Production

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Technology & Maintenance

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Document Characteristics

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Medical Device Regulation Document Control

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Workflow and notification manager

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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Web Order API

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a 

Note
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Administration

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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1.2.4 project365

KUMAVISION project365

Although project-centric businesses come in many shapes and sizes, their goals are always the same: They need to deliver on

time, on budget, and within scope, and be able to respond quickly to changes in the market.

Thanks to sophisticated workflows based on industry-specific, tried-and-tested functionality, KUMAVISION project365 can help

these companies—which operate in sectors as diverse as service and repair, IT, equipment rental, engineering, consulting, and

architecture—make the most of their resources and drive success.

Fully integrated into Microsoft Dynamics 365 Business Central1, project365 empowers you to:

keep track of your projects and resources with ease.

make decisions based on sound data.

identify risks early on and respond in time.

stay on top of things when working across departments and locations.

improve customer satisfaction thanks to reliable, effective scheduling.

control costs at every step of a project.

exchange data with Microsoft Office at a moment’s notice.

reduce administrative overhead.

record times and travel expenses online—in any internet browser.

Topics

HR Cockpit

About Resources

About Item

Project Setup

Create a Project

WBS and Scheduling

Guarantees

Time & Materials

Billings

Create Projects from Sales Documents

Service Package

Intercompany Work

Control Costs

Run a Forecast

Alternate Currencies

Earned Value

WIP Accounting

German HOAI Fees

Financial Management

Service

Price lists

General Setup

Administration

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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• 
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• 
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Get KUMAVISION project365 from Microsoft AppSource 

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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HR Cockpit

OVERVIEW

In Microsoft Dynamics 365 Business Central1, staff data typically needs to be stored in the Employee, Resource, and

Salesperson/Purchaser tables. Sometimes, however, data also needs to be available elsewhere in the app. For example, you might

need to add information to the Vendor table to reimburse employees for travel expenses.

Hiring a new staff member or updating staff data might therefore have a ripple effect throughout the app. The HR Cockpit was

designed to offer you an easy way to create and update information across all tables at once.

Information is stored in the cockpit temporarily so that you can add or update data in the tables that include a certain staff

member. For example, if you want to change an employee’s home address, changing the relevant HR cockpit field updates the

field in all tables linked to this employee. Removing data from the cockpit, however, doesn’t delete the information elsewhere.

After you added or updated the relevant data, you will be asked if you want to keep or delete the HR cockpit record. We

recommend that you keep it, but—as a precaution—run the Get Data action when you are about to perform the next update. This

function retransfers all data related to a certain staff member, ensuring that the cockpit also shows changes made to individual

tables in the meantime.

SETUP

You can set up default values for some staff-related fields. Choose the Search icon, enter HR Cockpit Setup, and then choose the

related link.

This opens a page where you can set up a general template or a distinct combination of values for each person working in HR.

These default values are then entered in the resource record that is created when you register new staff.

If you want to specify default values for vendor-related information, you need to have the Comsol2 Travel Expenses app installed.

Default no. series

You can also choose in HR Cockpit Setup what number series you want staff-related tables to use. For example, you can choose if

you want a field in the resource record to keep the number that you used to create the employee record.

For each table, two fields are available for setting up a series.

Resource No. Series Setup

Examples

Employee and resource number are identical. 

Employee=1235 and Resource=1235

Field Description

Resource No.

Series

Fill in this field if you want new data records to use a number from this series.

Resource Nos.

Prefix

Fill in this field if you want to add a prefix to the employee number when you set up new data records

with that number.

Resource No. Series

Resource Nos. Prefix
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The resource uses a number from another series. 

Employee=1235 and Resource R58456

Resource and employee number are identical, except for the prefix. 

Employee=1235 and Resource=R1235

HR Field Check

On this page, you can specify which cockpit fields must always be filled in. To open the page, choose the Search icon, enter HR

Field Check, and then choose the related link.

Turn on the toggle if you want the system to check whether employees can be assigned in sales.

As for the other fields, except for the Employee No. and Initials fields, which cannot be edited (considering the role they play in

creating master records), the options you can choose in each field are described in the following table.

Due to their use when creating master data, the fields "Employee No." and "Initials" are permanently set to "Required" and cannot be

changed.

HR COCKPIT CARD

The cockpit provides you with a central location to add and update staff data.

Register a new employee

Choose the Search icon, enter HR Cockpit, and then choose the related link. 

On the ribbon, choose New and fill in the fields as described in the following tables.

Resource No. Series ResourceNoSeries

Resource Nos. Prefix

Resource No. Series

Resource Nos. Prefix R

Option Description

Ignore Prompts the system to ignore the content of this field.

Required Requires the user to enter something in this field. If the field is left blank, no data is copied to tables

associated with the employee record.

Ask Asks the user whether to continue with processing information if the field is empty.

Note

1. 

2. 
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General

Contact Details

Here you can enter an employee's contact information.

Field Description

Type Shows the type of data record, for example, New.

Employee No. Serves as a unique reference to the new data record.

Numbers are assigned based on the series stored in HR Cockpit Setup.

To create a new cockpit record, go to any other field and choose Yes on the dialog page that appears.

A number is then assigned automatically.

Note

If you follow these instructions, an HR cockpit record is created before a new employee record.

User ID Choose an ID to link the employee to a user.

Note

The user must already exist.

Initials Specify initials for the employee.

Gender Specify the employee’s gender.

First Name Enter the employee’s first name.

Last Name Enter the employee’s last name.

Name Combines the First Name and Last Name fields.

Address

Address 2

Enter the employee’s (second) home address.

Post Code Enter the ZIP code of the location where the employee lives.

City Shows the city or town associated with the ZIP code.If the field is empty, fill in a location manually.

County Specify a county if necessary. You need to unhide this field before you can enter a value.

Country/Region

Code

Shows the country or region associated with the ZIP code. If the field is empty, fill in a code manually.

Birth Date Enter the employee’s date of birth.

Record Created On Shows the date on which the record was created.

Record Created By Shows the ID of the user who created the record.

Registered On Shows the date on which the employee was added.

Registered By Shows the ID of the user who added the employee.

Last Imported By Shows the ID of the user who last imported the data record.

Last Imported On Shows the date on which the data record was last imported.

Last Updated By Shows the ID of the user who last updated the employee record.

Last Updated On Shows the date on which the employee record was last updated.
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Employee

Base Data

Field Description

Status Select the employee’s status. You can choose between Active, Inactive, and Terminated.

Project Title Specify the employee’s role in the company.

Employee Posting

Group

Specify the group that will be used to post the employee’s business transactions to the relevant

account in the general ledger.

Project Manager Turn on this toggle if you want to create a project journal and assign it to the employee.

Separate Invoicing With the toggle turned on, a separate invoice suggestion is set up for the employee.

If the employee is specified as a project lead (see previous field), this toggle turns on automatically

(but you can turn it off again, if necessary).

Trainee Turn on this toggle if the employee is a trainee.

Social Security No. Enter the employee’s social security number.

Employment Date Specify the starting date of employment.

Inactive Date Enter a date in this field if the employee is unavailable for a relatively long period of time.

Cause of Inactivity

Code

Select a reason for the employee’s inactivity, such as parental leave.

Termination Date Enter a date in this field if the employee’s contract came to an end.

Grounds for Term.

Code

Select a code that explains why employment ended. For example, the employee might have been let

go or might have retired.

Emplymt. Contract

Code

Shows the type of contract stored for the employee with HR.

Field Description

Create

Salesperson

Turn on this toggle if you want to create a salesperson record for the new employee.

Salesperson Code Instead of creating a new data record, you can also enter the code of an existing salesperson here.

Create Resource Turn on this toggle if you want to create a resource for the new employee.

Resource No. Instead of creating a new data record, you can also enter the code of an existing resource here.

Create TE

Employee

Turn on the toggle to set up a staff member for whom you want to post travel expenses (known as a

TravelExpense Employee).

This field is only shown if you installed the Comsol2 Travel Expenses app.

TE Employee No. Instead of creating a new data record, you can also enter the number of an existing TE employee here.

This field is only shown if you installed the Comsol2 Travel Expenses app.

Create Vendor Turn on this toggle to link a vendor to the new employee.

This field is only shown if you installed the Comsol2 Travel Expenses app.

Vendor No. Instead of creating a new data record, you can also enter the number of an existing vendor here.This

field is only shown if you installed the Comsol2 Travel Expenses app.
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Resource

Bank

Here you can specify an employee’s bank account information.

Setup

Dimensions

On this tab, you can specify dimensions for the staff member. These are then copied as default dimensions to the Employee and

related tables (for example, Resource).

Depending on what you entered in General Ledger Setup, this FastTab includes up to eight fields: Global Dimension 1 and 2 and

Shortcut Dimension 3 through 8. You can add more default dimensions by selecting the Dimensions action on the ribbon.

TempVision

Field Description

Resource Group No. Fill in this field if you want to assign the employee to a resource group.

Base Calendar Code The code in this field determines how much capacity the resource has available.

If you want capacity to be calculated automatically, turn on the Create Capacity toggle (also found

on this card).

Available in Sales Turn on this toggle if you want to use the data record for sales documents.

Show on Schedule Turn on this toggle if you want to utilize the resource in planning.

Direct Unit Cost Specify the resource’s unit cost.

Unit Price Specify the resource’s unit price.

Work Hour Template Choose a template for the resource’s weekly working hours.

Product Commission

Group

This field helps group and commission products individually.

Blocked Turn on this toggle if you want to block use of the resource.

Create Capacity Creates resource capacity entries automatically. To use this feature, you need to choose a Base

Calendar Code, a Work Hour Template, a Capacity Starting Date, and a Capacity Ending Date.

Capacity Starting

Date

Specifies the starting date of capacity planning.

Capacity Ending

Date

Specifies the ending date of capacity planning.

Field Description

Gen. Prod. Posting Group Specify a general product posting group.

No. Series Vendor Specify a number series for vendors.

Vendor Posting Group Fill in this field if you want to map the resource to a G/L account for posting purposes.

Payment Terms Code Enter the agreed terms of payment.

Payment Method Code Select how payment is made, for example, by bank transfer.

Application Method Specify how you want to apply payments for items.

Gen. Bus. Posting Group Used to determine the relevant G/L account in VAT Posting Setup.

VAT Bus. Posting Group Used to determine the G/L account on the VAT Posting Setup page when you post the resource.

Responsibility Center Shows the responsibility center, such as a purchase office, to which the employee is assigned.
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Fill in this tab if you use the Tempras app for employee management.

Travel Expenses

Fill in this tab if you use Comsol2 or Continia for travel expense management.

To connect either solution to your system, you need what is known as a bridge app; for more details, please ask your KUMAVISION

contact.

Transfer Data

Use this action on the ribbon to create new data records in the Employee, Resource, and Salesperson/Purchaser tables, as well

as the Vendor and TE Employee tables if you installed the Comsol2 Travel Expenses app.

You can then choose to keep or delete the HR Cockpit data.

Update staff data

When you use the HR Cockpit card to register new staff members, data will be linked throughout the Employee, Resource, and

Salesperson/Purchaser tables—and the Vendor and TE Employee tables if you installed the Comsol2 Travel Expenses app.

When you close the card, you will be asked if you want to keep or delete the data that you created.

Keep the HR cockpit record

If you choose to keep the information, the card is retained in the system so that you can take another look at the data later. To

ensure that the information shown on the card includes all changes users made to related data in the Employee, Resource, and

Salesperson/Purchaser tables in the meantime, go to the ribbon and run the Get Data action before your next update.

Changes to employee data can be tracked by using the Type field. If the information related to an employee has been changed,

the field is set to Updated. The Updated By and Updated On fields show who last updated the fields and when this happened.

To replace what is stored in the associated tables with new information, reopen the relevant card and rerun the Transfer Data

action when you’re finished updating. You can then again decide if you want to keep or delete the cockpit record.

Delete the data record

If you decide to delete the data record, you need to retrieve all relevant information each time you want to look up an employee.

On the HR cockpit card, choose the New action.

In the Employee No. field, select the number of the data record that you want to update instead of having the system assign a new

number to the card.

When you choose an Employee No., the program will copy to the card all information related to the employee, that is, all data

stored for the staff member in the Employee, Resource, and Salesperson/Purchaser tables (and, if you installed the Comsol2

Travel Expenses app, the TE Employee and Vendor tables). At the same time, the Type field will be set to Updated.

To replace what is stored in the related tables with new data that you entered on the card, go to the ribbon, and select the

Transfer Data action. Following the update, you can again decide if you want to keep or delete the data record.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Comsol and the comsol logo are either registered trademarks or trademarks of Comsol Unternehmenslösungen AG. 

Note

1. 

2. 

1. 

2. 
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About Resources

OVERVIEW

Resources are the people and machines performing the activities of a project.

With the help of a budget, you can easily define their deployment and availability on multiple capacity-related pages within the

system. You can also record their impact on a company’s revenues and expenses, either independently or as part of projects and

sales (which creates a link to Finance).

Resources can be part of resource groups. You can use both resources and resource groups to budget and bill highly

sophisticated purchase and sales price structures.

As the resource and project functionalities are closely intertwined, the following sections will also cover some of the basics of

project management, with explanations of:

Resources and resource groups

Units and types of work

Unit costs and sales prices

Resource and project journals

Capacities

Flextime summaries 

• 

• 

• 

• 

• 

• 
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RESOURCES SETUP

Before you can register and post to resources, you need to set up the functionality.

Choose the Search icon, enter Resources Setup, and then choose the related link.

On the KUMAVISION project365 FastTab, fill in the fields as described in the following table.

You can now register your first resource.

Register a resource

Choose the Search icon, enter Resources, and then choose the related link.

On the ribbon, choose New > New to register a resource and fill in the fields as described in the following tables.

1. 

2. 

Field Description

Resource Calendar Type You can choose between two options in this field:

Base Calendar

The standard calendar. This calendar is only available if you have a Premium license and use the

Services functionality.

project365 Calendar

The calendar for users with an Essentials license, which precludes access to the standard

version.

project365 Calendar

Code

Fill in this field if you selected the project365 resource calendar.

The standard and the project365 calendar both offer the same features. The standard version,

however, is only included with a Premium license.

Resource Base Unit of

Measure

Specify a base unit of measure for resources. A typical unit is Hour.

Dimension Integration Enter a dimension that you want to link to new resources.

When you later enter a resource in the Person Responsible field on a project card, the dimension

is assigned as a project dimension to the resource.

This way, you can evaluate the work of project managers across projects.

Auto Close Res. Costs

Auto Close Res. Prices

Turn on these toggles if you want the system to fill in ending dates when you select another unit

cost or price with a more recent starting date.

This is only useful if you work with Extended Pricing (something that we strongly recommend)

and if the relevant tables include both starting and ending dates.

Resource Planner Start

Resource Planner End

Specify a period that you want to transfer to visual resource planning

Note

Specifying a period that is too small makes planning impossible. A period that is too large has a

negative impact on performance.

Example

-1W to 2M = one week back from the current week to 2 months into the future.

Night Differential 

Start

Night Differential End

Fill in these fields to calculate a night differential. For more information, see Flextime

Summaries.

1. 

2. 
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General
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Field Description

No. Serves as a unique number to identify the resource. Numbers are assigned from the series stored in

Resources Setup.

To assign a number to the resource automatically, go to any other field on the FastTab.

Name Enter a name for the resource.

Type Specify the type of resource. The Person option is used for employees and contractors alike. Machine

covers everything else, including vehicles and equipment.

External Select this field if the resource is not an employee of your company or a machine you own. Services

provided by external resources are added to a project by using a purchase order.

Base Unit of

Measure

Also specified in Resources Setup. The unit you choose must be the same for all resources. We

recommend you use Hour, even if you bill services on a per-day basis.

project365 

Calendar Code

Each resource can have its own calendar. The calendar is later used to set up capacity. If you leave

the field blank, the relevant calendar code is copied from Resources Setup.

Work-Hour

Template

Select a code to specify standard hours per workday in capacity planning.

Default Break Specify the length of the resource’s work break that is entered when you post times on CTC cards.

If you leave the field blank, the system copies the default break from the work hour template that you

selected for this resource.

Employee No. Shows the employee number associated with the resource.

Time Manager Specify who (instead of the project lead) should approve the time entries created from the resource’s

recorded hours. For more information, see Project Journals.

Substitute Time

Manager

Specify who (instead of the project lead) should approve the time entries created from the resource’s

recorded hours if the time manager is not available. For more information, see Project Journals.

No. of Extended

Texts

Shows the number of extended texts stored for the resource.

Search Name Enter a term that can be used to search for the resource, for example, an employee’s initials.

Resource Group No. Each resource can be assigned to a resource group. This assignment is how a group receives

capacity.

You can then use the group, for example, to create a rough project budget before devising a more

detailed schedule for individual resources.

A resource can only be part of one group at a time. You also cannot post an entire group but only

individual resources.

Billing Resource Turn on this toggle if you want to include the resource on sales invoices. A resource linked to billing

cannot be budgeted.

Available in Sales With the toggle turned on, the resource can be used on sales documents. Typically, this applies only

to billing resources.

Use in Resource

Planning

Turn on this toggle if you want to include the resource in planning. Turn it off if the resource is used

in billing or for other special purposes.

Default Project

Team Role

Specify a role that will be filled in automatically when the resource is added to a project team.

Note

Do not enter a role marked as Unique to Project in this field. If you do, an error message appears

every time you try to add to the team another resource whom the same default role has been

specified for.
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Field Description

Blocked Turn on this toggle to block use of the resource.

Blocked for New

Sale

In contrast to the previous switch, this block is limited to the entry in a sales line. This means that the

resource can no longer be used in new sales lines, but existing sales lines can still be invoiced.

Privacy Blocked Turn on this toggle to limit access to resource data in day-to-day operations.

Last Date Modified Shows the date on which the resource record was last modified.

Use Time Sheet Turn on this toggle if you want to use a time sheet. Leave it turned off for other methods of time

tracking.
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Invoicing
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Field Description

Personnel Cost Rate

Personnel Cost %

Personal Ovhd. Cost

These fields provide information on labor costs and determine the unit cost. All of them might be

empty, as the unit cost can also be filled in manually.

Direct Unit Cost Specifies the direct cost of one unit of the resource. This field has a lower priority than the same

field in the Resource Cost table. It is only used if the system cannot find a valid direct unit cost in

that table.

Indirect Cost % Specifies the indirect cost associated with the resource. This amount is added to the direct unit cost

to make up the unit cost.

Unit Cost Specifies the cost of one unit of the resource.

This is the cost budgeted and billed to a project when you post expenses.

Price/Profit

Calculation

Choose if and how you want to fill in the Unit Price or Profit % fields.

Profit % Shows the resource’s profit margin. You can enter a margin or have the field filled in automatically

based on the Price/Profit Calculation field.

Unit Price Shows the resource’s unit price. This field has a lower priority than the same field in the Resource

Price table and is only used if the system cannot find a valid price in that table.

Gen. Prod. Posting

Group

You must specify a general posting group before you can post to a resource. This also applies to

postings in project or resource journals, even if entries, as in the resource journal, include no

reference to Finance.

VAT Prod. Posting

Group

Select the VAT product posting group that you want to use for transactions.

Default 

Deferral Template

Select a template that governs how to defer revenues and expenses to the periods when they

occurred.

Automatic Ext. Texts Turn on this toggle to add an extended text to sales and purchase documents that include the

resource.

IC Partner Purch. G/L

Acc. No.

Select a G/L account in this field if you want to post intercompany invoices to a partner company.

For more information, see Intercompany Work Intercompany Work.

Product Comm. Grp.

Code

Select a code that you want to use for billing resources if salespersons receive commissions.

Vendor No. For an external resource, enter a vendor number in this field.

This number is then copied to budget lines in planning, where the vendor can be used to perform

price calculations and process purchase orders.

Use Purch. Invoice

Entries

If external resources post work hours in the same way internal resources do, you need to ensure

that a purchase invoice includes the times spent on a project only once.

A check for duplicate entries can be run with the help of the project ledger entries that are created

when you post time summaries.

To have this check performed automatically, turn on the toggle.

Service Package Turn on this toggle if you want to designate the resource as a service package. To help distinguish

these packages from human resources, we recommend that you select Machine in the Type field.

For more information, see Service Packages.

Service Work Type If the resource is designated as a service package, the work type that will be used for packages is

copied to this field automatically.
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For more information, see Service Packages.

Personal Data

Shows the personal data stored for an employee.

Employee Equipment

This kind of equipment (which includes software) is maintained on employee cards, to which many users have no access.

However, staff members should at least be able to view what has been distributed to them.

For this reason, a page named Employee Equipment can be opened from the Resources page and resource cards, describing the

equipment assigned to a resource.

Users can only see the devices and software given to them by their employer unless the Show All Staff Equipmt. field is selected on a

line in User Setup. Users for whom the field is selected can remove the equipment filter altogether or gain access to the devices and

tools assigned to another resource.

Units, work types, and alternate costs and prices

After you have entered key resource information, you can create units, work types, alternate costs, and alternate prices for the

resources you work with.

Field Description

Invoice Qty. Enter 1 in this field if the resource is designated as a service package, that is, the resource will be

billed based on time and materials.

Invoice Unit of

Measure

This field is filled in automatically if you mark the resource as a service package and cannot be

changed.

Planned Qty. If the resource is designated as a service package, that is, work will be billed by time and materials,

specify here—in hours—the effort required to complete it.

Planned Unit of

Measure

This field is filled in automatically if you mark the resource as a service package and cannot be

changed.

Unit Cost / Planned

Qty.

This field is also filled in automatically and indicates the estimated unit cost per hour for resources

designated as service packages—the result of dividing the cost of the chosen package by the

planned quantity.

Note
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Set up a unit of measure

Choose the Search icon, enter Units of Measure, and then choose the related link. 

On the ribbon, choose New to create a resource unit such as Hour.

Fill in the fields as described in the following table.

Work types

Work types describe various ways of rendering and selling services. They allow you to set up structures that, for example,

account for the difference in cost between an hour spent working on a project and an hour of travel.

All types are closely linked to alternate resource costs and prices. As part of a project or sales transaction, the work type has a

significant influence over both.

When you register a resource or a resource group, you can assign a cost and a price to each type of work.

A work type can also be assigned to more than one unit of measure to differentiate between the use and billing of resources. For

example, you can define that employees record times spent on a project in hours but that their work is billed on a per-day basis.

Set up a work type

Choose the Search icon, enter Work Types, and then choose the related link. 

On the ribbon, choose New to create a work type.

Fill in the fields as described in the following table.

Examples:

1. 

2. 

3. 

Field Description

Code Enter a code that uniquely identifies the unit of measure.

Description Enter a description for the unit.

International Standard

Code

Enter the code of the UN/CEFACT-Rec20 unit that you want to use when you submit sales

documents in electronic form.

Type Select a unit of time.

Time in Minutes Fill in this field so that you can convert between different units of time.

Inv. Qty. Rounding

Precision

Specify the decimal precision for invoice quantities.

1. 

2. 

3. 

Field Description

Code Enter a code that uniquely identifies the type.

Description Enter a text to describe the type of work.

Unit of Measure Code Specify the unit of measure used by the resource.

Invoice Unit of Measure Code Specify the unit of measure used to invoice work done by the resource.

Code Description Unit code Billing unit code

PROGRAM Software programming Hour Hour

INSTALL Network installed for customer Hour Hour

CONSULT_STD_D Consulting work billed in days Hour Day
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EXTENDED RESOURCE COSTS

General setup

If you want to work with the extended cost and price tables instead of the standard tables included with Microsoft Dynamics 365

Business Central1, you need to turn on the Extended Pricing feature.

Choose the Search icon, enter Purchase & Payables Setup, and then choose the related link. 

On the KUMAVISION tab, in the Extended Pricing field, choose Yes.

1. 

2. 
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Set up alternate costs

You set up alternate costs for resources and their groups on the Extended Resource Cost page. When you invoice items, the

values shown on this page take priority over those specified on resource cards.

Choose the Search icon, enter Extended Resource Cost, and then choose the related link. 

On the ribbon, choose New to set up a unit cost for a resource.

Fill in the fields as described in the following table.

1. 

2. 

3. 
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Field Description

Type You can choose between the following resource cost types:

Resource

The unit cost will be used for the resource entered in the Code field.

Group (Resource)

The unit cost will be used for the group of resources entered in the Code field.

All

The unit cost applies to all resources regardless of their resource group.

Code Based on the Type field, you can select a resource, a group, or nothing here.

Work Type Code This field plays a crucial role in cost and price calculations. It specifies both the resource’s unit of

measure, such as hours, and activity, such as travel or software development.

Examples

Line 1

Type = Resource

Code = MICHAEL

Work Type Code = INSTALL

Cost Type = Fixed

Direct Unit Cost (Base) = 80

Unit Cost (Base) = 120

Line 2

Type = Resource

Code = MICHAEL

Work Type Code = PROGRAM

Cost Type = Fixed

Direct Unit Cost (Base) = 100

Unit Cost (Base) = 150

Line 3

Type = Resource Group

Code = TECHNICAL

Work Type Code = INSTALL

Cost Type = Fixed

Direct Unit Cost (Base) = 110

Unit Cost (Base) = 160

Line 4

Type = Resource Group

Code = TECHNICAL

Work Type Code = PROGRAM

Cost Type = Fixed

Direct Unit Cost (Base) = 80

Unit Cost (Base) = 120

Line 5

Type = ALL

Code = " "

Work Type Code = CONS

Cost Type = Fixed

Direct Unit Cost (Base) = 90Unit Cost (Base) = 90

Fill in these fields if you want to set up period-specific costs.
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Find resource costs

Resource costs are retrieved in the following order:

From a resource in the Extended Resource Cost table if both the resource and its work type are valid within the specified period.

From a resource group if the group and its work type are valid in the specified period.

From a resource with the All option if the resource and its work type are valid in the specified period.

From the Unit Cost field on a resource card.

Work types and costs

Unlike customer billing, cost calculation doesn’t distinguish between activities, as it doesn’t matter what resources spent their

time on. Whether they travel or hold a workshop at a customer site, their pay is unlikely to change (at least when it comes to

your own staff members).

If no unit cost can be found for a work type and period, a universally applicable entry linked to a blank Work Type field will be

copied from a unit cost table.

This avoids having to specify the same unit cost in cost tables over and again. The entry will then use a resource’s base unit (the

typical unit being Hour). 

Prices for external resources

It should be noted that external resources can also be brought on for projects, and that they have their own, separate list of

costs. For more information, see External Resource Prices.

EXTENDED RESOURCE PRICES

You set up alternate prices for resources and their groups on the Extended Resource Prices page. You can specify multiple prices

per work type.

Field Description

Starting Date 

Ending Date

Cost Type Specify how you want the system to calculate the cost. Resource costs aren’t linked to a currency

code. The local currency is used instead.

You can select Fixed, % Extra, or LCY Extra.

Fixed copies the unit cost from the Extended Resource Cost table; the other options add charges to

the cost that you enter on resource cards.

Personnel Cost Rate Specifies the cost rate for work done by the resource.

Personnel Cost % Specifies the percentage of costs for work done by the resource.

Personnel Ovhd. Cost Specifies the labor overhead for work done by the resource.

Indirect Cost % Indicates the percentage of indirect costs for work done by the resource.

Direct Unit Cost

(Base)

Specifies the direct cost of a resource unit.

Unit Cost (Base) Specifies the cost of one unit of work performed by the resource.

Unit of Measure

(Work Type)

Shows the unit stored for the assigned work type code.

Direct Unit Cost

(Work Type)

Unit Cost (Work Type)

Shows the (direct) unit cost associated with the chosen work type.

1. 

2. 

3. 

4. 
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Resource prices are retrieved when you schedule resources, enter a price on a sales line, or post resource consumption (as a

time and materials entry might contain not only a unit cost but also a unit price that can be used to measure project progress or

bill work done on a project).

General setup

If you want to work with the extended cost and price tables instead of the standard tables included with Microsoft Dynamics 365

Business Central1, you need to turn on the Extended Pricing feature.

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the General tab, select Never in the Find Best Price field.

On the KUMAVISION tab, in the Extended Pricing field, choose Yes.

Set up alternate prices

Resource prices and costs are set up in similar ways, with prices being assigned to resources and work types on the Extended

Resource Prices page.

You can create alternate prices for individual resources, resource groups, or (most conveniently) all resources at once.

To add alternate resource or resource group prices:

Open the relevant resource card or the Resource Groups list. On the ribbon, choose Related > Prices > Prices.

If you don’t want to set filters on resources or groups, choose the Search icon, enter Extended Resource Prices, and then choose

the related link. 

This opens a list of all alternate prices stored for each resource and group. It’s also the only way to enter universally applicable

prices.

To specify validity periods for prices, fill in the Starting and Ending Date fields on the Extended Resource Prices page.

Examples

Pricing options

You have more than one option for setting up detailed unit prices for resources.

For one, you can create special project-specific prices by opening a project card and choosing Related > Prices > Resource.

What you see on this page—which looks almost exactly like the Extended Resource Prices page—has been copied from the

project card.

You can also turn on the Use WBS Res. Prices toggle on a project card. With the toggle turned on, a resource price isn’t retrieved

the usual way when you post project usage or create a sales line manually but is copied directly from the related WBS line.

Where to use resource prices

You can enter alternate unit prices for resources during various stages of a project.

Planning

You can run a function to fill in extended unit prices when you schedule resources with the help of a budget. You can then change

these prices manually if necessary.

1. 

2. 

3. 

1. 

2. 

Type Code Work Type Code Unit Price (Base)

Resource GUIDO CONSULT 90

Resource MARKUS INSTALL 80

Resource MICHAEL CONSULT 80

Resource MICHAEL INSTALL 100

Resource Group TECHNICAL INSTALL 75
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Sales

When you create a sales document such as a quote or an order in project planning, the resource prices on WBS lines are

transferred to this document alongside other project information.

Should you create a new sales line, however, the price on that line might be retrieved from elsewhere in the system.

Time tracking

When a resource posts hours spent on a project, the alternate unit price is added to the time and materials entries created

during this process.

The price can then be used to measure project progress or see an estimated price total for unbilled services.

Purchasing

For the same reason as in time tracking, a unit price is added to project ledger entries for an external resource when you post

consumption from a purchase document.

Find resource prices

Prices are added to a resource or resource group in the following order:

If you turned on the Use WBS Res. Prices toggle, unit prices are copied from a WBS. Based on the posting or link level, a price

might be copied from a budget line or a work package. It is, however, only retrieved if

• it is stored with a resource or a group (not an item).

• its work type and unit codes are identical to the those of the project.

This type of setup makes sense if there’s a certain latitude in how you can budget a project, that is, a unit price can be specified

during planning (on the spot) and isn’t copied from a list. Turning on the toggle ensures that there are no differences in price

between time and materials entries created for project usage, planning and sales.

If the toggle mentioned under 1) is turned off, the system will try to find a suitable price among the resource prices specified for a

project.

If no project-specific price is available for the given period, the system will try to find one in the Extended Resource Price table.

If that table contains no valid price either, the price will be copied from the resource card.

For any table, the system runs through the following sequence:

Find a price for a resource.

Find a price for a resource group.

Retrieve a universally valid price.

A price is considered valid if it has the same work type (a blank field is not taken to mean that a price is universally valid), uses

the same currency and is valid between the starting and ending dates specified in the table.

Sales transactions

As part of sales transactions, resources are billed according to their work types and relations to projects. The entry type created

in this context is always Sale, as resource postings on sales documents represent project revenues. Posting revenue for a project

doesn’t create consumption.

For the use of project-specific prices in sales, turn on the Use Project Prices on Sales Doc. toggle in Projects Setup. With the

toggle turned off, prices are retrieved from resource cards only.

If you want to enter a resource on a sales document, you must turn on the Available in Sales toggle on the relevant resource card.

RESOURCE CAPACITY

Resource capacity represents a resource’s work hours available for planning.

To limit these hours, you can use the calendar that you chose in Resources Setup. You can specify in this calendar the public

holidays, weekends, and other days on which employees aren’t at work.

1. 

2. 

3. 

4. 

1. 

2. 

3. 

Note
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You can also set up resource-specific versions to account for differences in the number of holidays observed in different states

and regions.

Alternate base calendar

The standard calendar functionality is part of the Microsoft Dynamics 365 Business Central1 Premium license. Customers with an

Essentials license can use the calendar that comes with KUMAVISION project365.

You must turn on the alternate calendar in Resources Setup before you can use it in place of the standard calendar on the setup page

and for individual resources.

To turn on the project365 calendar:

Choose the Search icon, enter Resources Setup, and then choose the related link. 

On the KUMAVISION project365 tab, in the Resource Calendar Type field, select project365 Calendar.

In the project365 Calendar Code field, choose a calendar. 

View and set capacity

To see the capacity of a resource, choose the Search icon, enter Resource Capacity, and then choose the related link.

This opens a page that lists capacities by day, week, and month. Capacities can be specified for several resources at once. Be

aware of filters applied to the list.

To specify resource capacity: 

Open the Resource Capacity page.

Go to the Resource Capacity Matrix section. On the ribbon, choose Planning > Set Capacity.

As a rule, capacity is scheduled for long periods in advance. No time sheet template needs to be specified if all filtered resources

have one when you run the function. A template is only needed for resources that don’t.

You can also set capacity for individual resources:

Open the Resource Capacity page.

Select a resource.

On the ribbon, choose Planning > Set Capacity for Resource.

Group capacity

Resource groups don’t have capacities, nor can you specify capacity for them.

Instead, the total number of hours that you can schedule for a group equals the capacities available for all resources within that

group.

Time summaries

Time summaries show you the monthly work hour totals of resources for whom you set up capacities.

These entries are mainly used for flextime arrangements but might also be linked to scenarios that involve night differential pay

or bonuses for working on holidays. 

Set up time summaries (flextime) Resources setup

If you want to add a premium for night shifts, fill in the Night Differential Start and Night Differential End fields in Resources

Setup.

Holidays

Note

1. 

2. 

3. 

1. 

2. 

1. 

2. 

3. 
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To set up holidays:

Choose the Search icon, enter Base Calendars, and then choose the related link. Select a calendar.

On the ribbon, choose Actions > Functions > Maintain Base Calendar Changes.

Select the Holiday checkbox for each day that you want to specify as a holiday.

Causes of absence

For flextime summaries to be calculated correctly, you must ensure that the Ignore for Flextime checkbox is selected on the

Causes of Absence page for lines that don’t affect time tracking in a negative way, such as lines used to record absence due to

illness.

Essentially, the checkbox must be selected for all kinds of causes, except for reductions in flextime. A code for reductions isn’t

strictly necessary, as work hours that aren’t posted to a project are subtracted from flextime summaries automatically.

Nevertheless, the reductions might need to be logged for documentation purposes.

Example

You set up sick leave, vacation, and flextime as causes of absence, flextime being the only category that the Ignore for Flextime

field isn’t selected for. You then post as many hours in the system as shown in the following table.

As said previously, registering flextime absence isn’t what causes a reduction. A lack of postings on certain days is. In other

words, the registration is for documentation purposes only, whereas the time staff members aren’t working due to vacation or

sick leave doesn’t affect the numbers at all.

Starting summaries

To use time summaries:

Choose the Search icon, enter Time Summary Journals, and then choose the related link.

Record all existing flextime summaries of employees. Each entry must start with the last day of the prior month—such as

11/30/2023—if summaries are implemented on 12/01/2023.

When you recorded all summaries, go to the ribbon, and choose Post to copy all entries to the Posted Time Summary Journals.

The last step is crucial, as you cannot create starting summaries if you have already set up individual summary entries for

employees. You also cannot reset a summary.

The starting summaries are then posted automatically when you choose the Create Time Summary Entries action on the Time

Summary Entries page.

Time summary entries

You can create time summary entries by running the Create Time Summary Entries function on the Time Summary Entries page.

To avoid inaccuracies in time tracking, we recommend that you generate these entries at the close of every month.

A time summary entry contains all information required to fill in the Flextime, Night, Saturday, and Sunday and Holiday

Summary fields per resource and month.

1. 

2. 

3. 

Day Daily

Capacity

Hours Posted Absence and

Quantity

Flextime

Hours

Flextime

Total

1 8 9.5 +1.5 1.5

2 8 0 Illness – 8 0 1.5

3 8 4 Flextime – 4 -4 -2.5

4 8 0 Flextime – 8 -8 -10.5

5 8 6 -2 -12.5

1. 

2. 

3. 
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But whereas a flextime summary is calculated regularly from the times recorded by a resource the prior month, the other fields

show mere snapshots of data. This means that they are used for informational purposes only; their contents aren’t incorporated

into other functions, such as updates of project estimates.

All totals are calculated from a resource’s (that is, an employee’s) capacity, posted work hours and periods of inactivity, with the

system using the calendar and related fields specified in Resources Setup to determine night shift and holiday totals from the

hours posted.

Once created, entries cannot be changed.

For later postings (of times recorded or periods of absence), you need to rerun the Create Time Summary Entries function.

Summaries are always created for the month prior to the work date.

Example

Work date = 05/02/2023 = System calculates summary for April 2023.

Corrective postings

To post adjustments to Saturday, holiday, nighttime, or flextime work hours:

Choose the Search icon, enter Time Summary Journals, and then choose the related link. 

Select the resource number of the relevant employee.

Fill in the Quantity field. In the Reason Code field, choose a reason.

On the ribbon, choose the Post action to post the journal.

For tracking purposes, the relevant journal is then copied to the Posted Time Summary Journals page. This creates an entry

combining a resource’s latest summary and the data you entered.

PROJECT TIME JOURNALS

Create a time journal template

Choose the Search icon, enter Project Time Journal Templates, and then choose the related link. 

On the ribbon, choose New.

Fill in the fields as necessary.

Select a template. On the ribbon, choose the Batches action.

You can now fill in resources and their user IDs. If you assigned a journal to a user in User Setup, the correct journal is chosen

automatically when you open the journal selection.

A journal must be created for each resource who needs it. An error message appears if a user cannot be assigned to a time journal.

Only users for whom the Other Res. in Time Tracking checkbox has been selected in User Setup can edit other resources’

journals, for example, to post times. When you assign a resource to a journal, the number of the resource is entered

automatically on all journal lines.

If employees and their resources are registered on the HR Cockpit, a time journal is created automatically. Although there are other

options available—specifically, time sheets and CTC time tracking—every resource should have a journal, as it is the only means by

which you can correct time postings.

Note

1. 

2. 

3. 

4. 

1. 

2. 

3. 

4. 

5. 

Note

Note
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EXTERNAL RESOURCE PRICES

To set up a price for an external resource:

Select the External option in the Type field on the relevant resource card.

Enter a Vendor No. so that you can open the Resource Purch. Prices page from the resource or the vendor card.

What external resource prices, resource unit prices and resource unit costs have in common is that they can only be retrieved if

the right work type has been specified.

You can specify external resource prices as early as creating budget lines for a project. This is because you can already store

basic vendor data for an external resource on a resource card. This data is then copied to a budget line when you enter a

resource on it, and a price is determined based on the vendor and work type specified on that line. When you later run the Create

Purchase Document function from the budget line, the pricing function enters a suitable price on the document—that is, unless

you entered a price manually or selected the Manual Purchase Price checkbox on the budget line, in which case the price on that

line is copied to the document instead.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

1. 

2. 

1. 
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About Item

KUMAVISION project365 extends the article master in Microsoft Dynamics 365 Business Central1 with a few extensions. 

These are described in this section. Further information on the article master can be found in the Microsoft Dynamics 365

Business Central1 Help or KUMAVISION base (BOOSTER).

SET UP ITEM

The following fields have been added to the article card:

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

Blocked for New Sale In contrast to the blocked field (which provides for a general block), this block is reduced to the

entry in a sales line. This means that the article can no longer be used in a new sales line, but

existing sales lines can still be invoiced.

Target Work Package

Code

When a WBS is created from a sales document, sales lines can be created that later serve as project

budget lines. In this field, the work package in which these new budget lines are to be created later

is already defined in the article master.

Qty. on Sales Order

without Project No.

Specifies the quantity in order lines without project reference.

Project Inventory Indicates how much stock is already assigned to a project. This stock is reserved for the project and

is created through project-related purchases (without immediate consumption) or through stock

transfers to the project warehouse stock (e.g. through the project budget line function "Warehouse

withdrawal").

Qty. on Project

Budget

Specifies the quantity in project budget lines.

1. 

1.2.4 project365

- 606/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://learn.microsoft.com/de-de/dynamics365/business-central/inventory-how-register-new-items
https://learn.microsoft.com/de-de/dynamics365/business-central/inventory-how-register-new-items
https://learn.microsoft.com/de-de/dynamics365/business-central/inventory-how-register-new-items


Project Setup

OVERVIEW

In Microsoft Dynamics 365 Business Central1, business transactions that occur over a relatively long period of time and might

involve frequent changes to requirements and expenditures are grouped into projects. With the help of budgets and line

activities, and phase, task, and step codes, you can plan, manage, and invoice these projects with ease.

At the heart of each project is a work breakdown structure (WBS). The structure is used to track sales and costs and provide the

project team with a highly granular view of past, present, and future staff, machine, and material needs. Work packages related

to a project can additionally be split into budget line activities, which you can assign as subtasks for specific resources to

complete.

Thanks to integrated billing, you can also record the revenues and expenses posted to a project in Sales and Purchasing.

However, to work with projects, you need to set up the functionality first.

BASICS

Projects Setup

This is where you specify number series and default values for projects.

Choose the Search icon, enter Projects Setup, and then choose the related link. 

Fill in the fields as described in the following tables.

General

Numbering

This FastTab stores the most important number series for managing projects. To set up a series, use the lookup next to a field or

choose Alt + Down Arrow. Both approaches will lead you to the No. Series table, where you can create a new series.

Number series required for processing projects, for example, in the purchase, sales, and resource areas, must be selected directly

from their setup pages.

1. 

2. 

Field Description

Automatic Update 

Project Item Cost

Turn on this toggle if you want usage costs in project ledger entries updated automatically to match

changes in negative inventory adjustments.

In other words, this field determines if cost changes are adjusted when you run the Adjust Cost –

Item Entries function. The adjustment process and its results are the same as when you run the

Update Project Item Cost batch job.

Document No. Is

Project No.

Specifies that the project number is also the document number in the ledger entries posted for the

project.

Like the No Project Journal Doc. No. Check, this field affects project journals. But unlike the other

toggle, it also affects item consumption postings to these journals.

Use Deferral With the toggle turned on, the system creates project ledger entries in addition to G/L entries when

you post a line with a deferral code and a project number on a purchase or sales invoice or in the

general journal.

Example

A sales invoice created for a project needs to be deferred over a period of three months.

Initially, the entire invoice revenue is added on the posting date. Afterward, the process is reversed,

and the amount that you billed is distributed over three months according to the deferral schedule.

Note

1.2.4 project365

- 607/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Project Management

1.2.4 project365

- 608/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Field Description

Project Posting in

Quote Status

Turn on this toggle if you intend to post consumption of time and material as early as the quote

stage. After the toggle is turned on, you can set the work status on WBS lines to In Progress or

Open while the project is still on Quote.

Leave the toggle turned off if you want to post expenses only after the status of the project has

been set to Open on both the project card and the relevant WBS lines.

Auto PTS Code With the toggle turned on, the system uses the internal number assigned to a WBS line to

designate a phase, task, or step. This might help to create a more unique line descriptor when a

work package is entered on multiple WBS lines.

All new WBS lines must be unique. A line is made unique by combining the codes of a work

package, a phase, a task, and a step.

Lock Auto PTS Code on

WBS

Turn on this toggle if you want to prevent manual changes to phase, task, or step codes that are

created by the system after you activate the Auto PTS Code toggle.

Leave the toggle turned off if turning on the Auto PTS Code feature is only meant to help speed

up code creation.The setting you make here also applies to project templates.

Budget Filter on Time

Posting

Sets a filter when you want to link budget lines to a time journal.

With the toggle turned on, only resources specified in the project budget can post to budget lines

when you choose Budget as the time posting level on a project card.

You must turn on this toggle if you want to use line activities.

Budget Filter on

Documents

Sets a filter when you want to link budget lines to purchase or sales lines.

Turning on the toggle limits posting to items and resources that are included in the project

budget when Budget is chosen in the Project Doc. Posting Level field on a project card.

Budget Filter in Project

Journal

Sets a filter when you want to link budget lines to project journal lines.

With the toggle turned on, only items and resources added to the project budget can be used to

post consumption when Budget is chosen in the Gen. Journal Posting Level field on a project card.

No. Project Journal

Doc. No. Check

Turn on this toggle if you do not want the system to check for document numbers when you post

to a project journal.

This way, project ledger entries can be created, for example, for work hours entered by a staff

member, without having to tie the employee to a document.

Check Team at Time

Release

Before time entries are released, they are copied to a journal for editing.

Turn on this toggle if you want the system to check if a user is authorized for this process.

Auto Resource Budget

Allocation

Turn on this toggle to have resource capacity determined based on a project budget, that is, have

the system distribute planned work in linear fashion between the starting and ending dates of a

budget line.

With the toggle turned off, you must trigger the process manually or run the relevant function.

Without allocation, the entire resource capacity is assigned to the starting date entered on the

line.

Default Budget

Allocation Period

Specify the default period for distributing project work. You can change this period when you run

the allocation function from a budget line.
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Field Description

Amounts can be distributed on a daily, weekly, or monthly basis throughout the planned duration

of a project.

Multi-Use Budget

Resources

Turn on this toggle if you want to assign a resource or a resource group to more than one budget

line on a WBS line. The toggle has no influence over how many activities you can assign to both

types of lines, however.

You must turn on this toggle if you want to use budget lines for completing activities. Items and

G/L accounts can be budgeted on any number of lines.

Auto Budget Relation

at Posting

Establishes a link to a budget line when you post project ledger entries if no link has been created

by a user or a function before posting.

The link can then be used for budget-to-actual comparisons on the budget line. For a link to be

created, the line must contain a unique type-number combination that is associated with certain

revenues or expenses on the related WBS line.

Calculate Work

Package BOM

With the toggle turned on, the budget assigned to a bill of materials is multiplied by the quantity

specified on a WBS line if you enter a work package related to the BOM on the budget lines that

have been set up for the WBS line.

Confirm WBS Update

from Budget

Turn on this toggle to request confirmation when a user attempts to copy new budget values to a

WBS line after changing the budget and closing the associated budget lines.

This confirmation dialog only appears if the WBS line is set up for storing a budget line total (that

is, the Copy Budget checkbox is selected on the line).

No JLE Posting Date

Check

Typically, project ledger entries can only be changed in the posting period that is specified in

General Ledger Setup. Turn on this toggle to forgo the posting date check.

Project Status Reset on

Final Invoice

With the toggle turned on, a project is no longer blocked when a final invoice has been created for

it.

No Project Accounts Turn on this toggle if you want to start working with the project365 industry solution but do not

have a clear idea of the kind of project accounts you want to use.

This prevents an error message about non-existent or incomplete accounts when you budget and

post to a project. After you create the accounts and set up the related matrix, you can use a batch

job to add any existing ledger entries and budget lines.

Project Field Check Turn on this toggle if you want users to fill in certain fields before they can proceed with a

project.

For more information, see Mandatory Field Check.

Guarantee Field Check With the toggle turned on, certain fields on the Projects page must be filled in before you can use

a guarantee.

For more information, see Mandatory Field Check

Project Completion

Reason Required

Turn on this toggle if you want users to specify a reason for why a project is set to Completed.

Auto Project vs.

(Advance) Pmt. Plan

Check

With the toggle turned on, the system checks if the amounts on a project-related payment plan

match the budgeted sales amounts.

To put it another way, the system checks if plan prices differ from the prices entered on the WBS.

This toggle is only relevant when you bill projects based on invoice suggestions. Turning it on

prevents situations in which the WBS related to a plan was changed (or a WBS line quantity
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Field Description

reduced) but the change was never copied to the plan (in other words, you would invoice too little

or too much by using the original payment schedule).

Project Budget Name

(Main WBS)

Select the name of a project budget if you want to specify an active WBS version linked to the

budget as the target structure to which to copy the results of calculations and change orders.

You must fill in this field before you can use the Main WBS feature.

Keep Invoice Qty.

Separate

With the toggle turned on, invoice quantities that have been entered on lines for transfer to a

main WBS are not totaled but replaced with a quantity of 1 each. The toggle does not affect fields

showing total costs and prices.

Work Type (Service

Package)

For more information, see Service Packages.

Sales Price List

(Service Package)

For more information, see Service Packages.

Auto Update Sales

Price List (Serv. Pckg.)

For more information, see Service Packages.

Purch. Price List

(Service Package)

For more information, see Service Packages.

Auto Update Purch.

Price List (Serv. Pckg.)

For more information, see Service Packages.

Disable Indicators in

Project List

With the toggle turned on, the budget and profit value fields and indicators on the Projects page

are deactivated.

Note

The Projects page needs to be closed for the toggle to take effect.

This option might be useful for performance reasons, for example, as turning on the toggle not

only hides the fields when they are not needed, but they are also not calculated when you open

the page.

Batch Copy Change

Requests from Sales to

WBS

With the toggle turned on, the Create WBS/Lines action that you can run from a sales document

adds lines to a work breakdown structure as a block, enclosed by a Begin-Total and an End-Total

line.

For a better overview, the number of the sales document is then entered on the Begin-Total line.
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Field Description

Fixed Sales Budget

when Ordering

With the toggle turned on, you can set a project to Open without affecting the sales budget of the

project's active WBS.

Use Project Prices on

Sales Doc.

With the toggle turned on, a price entered for a project also applies to sales documents that the

project is entered on.

This way, you can create quotes and orders both from a WBS and manually by using project-

specific unit prices.

Check Team at Invoice

Suggestion

Select this field to have the system check if a user has permission to create invoice suggestions

for a certain project. Only users that are part of the project team can create suggestions.

Sales Project Budget

Sync.

Turn on this toggle if you want data synchronized automatically to ensure that certain sales line

changes are also copied to project planning.

Sales Project Budget

Sync. Error Handling

If you turn on the synchronization feature (see the previous field), you can use this field to

specify what you want the system to do when synchronization fails.

Cancel

You see an error message while the process is canceled, that is, the sales line remains

unchanged. Choose this option to ensure the highest level of synchronization between projects

and sales, with the focus put on first correcting the issue you encountered.

Ask

You are asked if you want to change the sales line. Choose No if you want to cancel the entire

process and restore the original line.Choose Yes if you want the sales line changed but not the

project itself. At the same time, the problem is logged.

Notify

You are only informed about the problem, without synchronization, and the change is only made

on the sales line. The issue will be logged, however.

Sales Project Budget

Sync. Notification

Turn on this toggle if you want the system to tell you whether synchronization was successful.

With the toggle turned off, no feedback is provided, except in the form a log entry.

Performance Date

Formatting

When you bill services based on time and materials, the invoice includes a service period. This

period can have the following format:

• [month]/[year]

• [month]/[day]/[year]

• [month spelled out] [day], [year]

Setup Customer Change

Despite Revenue

Typically, the customer of a project can be changed only if project ledger entries of type Sale

have not been posted to the project yet. To be able to replace the customer even after posting

revenue, you need to change the value in this field. Options are:

No

Changes are not possible after project ledger entries have been created in the system.

All

Every authorized user can replace a customer.

Selected

Only those authorized for the process in User Setup can change customers.

Qty. to Invoice vs.

Invoice Entry Check

Turn on this toggle if you want to ensure that the invoice quantities on sales order and invoice

lines match those stored for the related invoice entries so that an invoice does not list quantities

other than those on the associated proof of performance document.
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Field Description

A quantity check, however, is only run if the Billing Type on a line is set to Time & Materials.

No Separate Pmt. Plan

Invoices

Turn on this toggle if you want the system to create one instead of two direct invoices from an

invoice suggestion by including invoice lines from a payment plan and lines marked for direct

billing.

If the toggle is turned off, direct invoices are created separately for payment plan lines, which

simplifies final invoice creation (if you are working with final invoices, that is).

Posting Date on Pmt.

Plan Invoices

Specify if the planning or work date should be used as the posting date when you create an

invoice from a payment plan line (whether by using the action on the payment plan ribbon or an

invoice suggestion).

Note

You cannot choose the Planning Date option if the No Separate Pmt. Plan Invoices toggle is

turned on, as invoices then contain suggestion lines for direct billing and payment plan lines, so

the posting date is set automatically to the work date.
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Purchase

Field Description

Default Purchase

Document Type

Specify the type of document that you want to create when you run the Create Purchase

Document function from a WBS.

You can change the type again on the related request page, if necessary.

Default Req. Wksh.

Template

Specify the template that you want to use when you run the function for creating requisition

worksheets from a project budget.

Default Req. Wksh. Name Specify the worksheet that you want to use when you run the function for creating requisition

worksheets from a project budget.

Type Filter to Create

Purchase Orders

Specify the default filter that you want to use when you run the Create Purchase Document

function from a WBS.

In most cases, the default setting, Item, is sufficient.

Note

Users can change the content of this field on the WBS at any time.

Purchase Request

Workflow Code

You must fill in this field if want to work with purchase requests.

The system then uses the value entered here when you create a request from a project.

For more information, see Create a Request.

Use Purch. Invoice

Entries

Turn on this toggle if you want the system to select the checkbox with the same name on the

cards of external resources (where you can also clear the field again manually).

With the field selected, resource-related purchase documents can only be posted with the help

of invoice entries.

The toggle is needed when external resources can post times to a project, as purchase receipts

might then lead to duplicate postings.

Copy WBS Descr. to

Purch. Line

Specify if and in what way you want to copy the description of a WBS or a budget line to a

purchase document when you run the Get Work Package function.

Always

The description is automatically copied to the purchase line for which the function is run.

Ask

When you run the function, you are asked if you want to replace the default description—a text

taken from, for example, the item master—with that of the related WBS or budget line.

(This is the most adaptive option, as it prevents the overwrite of line descriptions that you

entered manually.)

Never

WBS and budget line descriptions are never transferred to purchase documents.
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Manufacturing and Warehouse

Field Description

Project Purchase Incl.

Inventory

With the toggle turned on, an item is posted to inventory when you post its receipt. This doesn’t

cover consumption, which must be posted manually at the appropriate time.

Warning

This is an extremely sensitive toggle. Please contact your Business Central partner before changing

it.

Auto Assign Project

Inventory

Turn on this toggle if you want all item receipts linked to a budget line through order tracking or

reservations (assembly and production output, receipt and purchase, and transfers) to be posted to

the location and bin assigned to the line.

The relation to the line is then stored with the item ledger entry.

Post ILEs on Project

Correction

Turn on this toggle if you want to reclassify an item stored at a location without bins when you

remove the link between the related item ledger entry and project.

With the toggle turned off, the system will only delete project-related fields from the entry.

If a location has bins, the item will be reclassified regardless.

Default Location Non-

Project Inventory

Specifies the target location when reclassifying items from a cancelled project.

Default Bin Code

Non-Project Inventory

Specifies the target bin when reclassifying items from a cancelled project.

Default Prod. Req.

Wksh. Template

Specifies the worksheet template that will be used when you create a production order from a

budget line.

Note

This field is only available to users who have purchased the premium edition of Microsoft Dynamics

365 Business Central1.

Default Prod. Req.

Wksh. Name

Specifies the worksheet name that will be used when you create a production order from a budget

line.

Note

This field is only available to users who have purchased the premium edition of Microsoft Dynamics

365 Business Central1.

Prod. Order Status

for Budgets

Specifies the status of a production order created from a budget line for an item with a production

BOM.

Note

This field is only available to users who have purchased the premium edition of Microsoft Dynamics

365 Business Central1.

Return Shipments to

Project Inventory

This feature only applies to items. When you post a return shipment to a project—that is, when you

post negative consumption, credit the project, and then post the item back to inventory—the toggle

determines if an item is returned to the general inventory or to the inventory specific to the project.
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Dimensions

Team Roles

Field Description

Dimension Integration

(Project)

Specify the dimension that a value should be created for automatically when you set up a new

project, with the value matching the number of the project.

Example

To integrate the Cost Object dimension into project 1000, cost object 1000 will be created for the

project.

Dimension Integration

Prefix (Project)

The dimension specified for integration into projects can be given a prefix in this field.

Example

A project with the number 1000 will show a dimension value of P1000 if the prefix entered in this

field is P.

Dimension Integration

(Main Project)

Specify the dimension that a value should be created for automatically when you set up a new

main project, with the value matching the number of the main project.

Example

To integrate the Cost Object dimension into project 1000, cost object 1000 will be created for the

main project.

The dimension is then passed on to all projects assigned to the main project. Those projects,

however, will not be updated should you later decide to change the dimension.

Dimension Integration

Prefix (Main Project)

The dimension specified for integration into main projects can be given a prefix in this field.

Example

A main project with the number 1000 will show a dimension value of P1000 if the prefix entered

in this field is P.

Main Project as

Dimension Total

Turn on this toggle if you want the system to add a total line to the dimension entered in the

Dimension Integration (Main Project) field.

The Totaling field on the line then lists the numbers of all projects linked to the main project. With

this feature, you can easily analyze, for example, the cost objects assigned to a main project.

Note

Like most other setup toggles, this toggle does not apply retroactively. This means that total lines

will be created only after the toggle is turned on and another project is linked to the main project.

Use WBS Line Dim. as

Default

With the toggle turned on, the WBS line dimensions used in project planning are copied to (sales,

purchase, and project) documents and to (time, project, and G/L) journals when you assign a

unique identifier to a WBS line. This way, you can copy manual dimensions from planning to

ledger entries.

Leave this toggle turned off if you want dimensions entered automatically based on the project

number, the relevant work package, and other data, such as the number of a resource or an item.

Use Budget Line Dim.

as Default

Works in the same way as the previous toggle, the difference being that the system will copy

manually created dimensions from budget lines instead of WBS lines.

Update Project

Dimensions from

Resource

Turn on this toggle if you want the system to transfer to a project the dimensions stored for the

relevant project manager resource.

These dimensions are then copied to the project when you fill in the Person Responsible field on

the project card.

Project Type

Dimension Code

Specify the dimension that a value should be created for automatically when you set up a project

type, with the value matching the code of the type.
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Here you can specify up to 10 team roles that you want to show on the project list or project cards. This way, you can see

immediately who works on which project in what area or capacity (for example, as the architect or as someone in billing or cost

control).

The roles you specify need to be marked as Unique to Project (because roles that aren’t make it impossible for the system to choose

the name of a team member).

Contact Roles

Used to specify the roles that will be assigned to project contacts. If set up, a role is then filled in on the project card after the

contact associated with the customer is.

Measurement

For more information about the fields on this FastTab, see Project Measurement.

Indicators

Used to set up indicators that change color based on project performance. 

Time Tracking

Here you can set up your preferred method for recording time in the system. Many companies pick one method for all employees

to use.

Note

Field Description

Bill-to Project Customer

Contact Role

Specifies the organization contact assigned to the bill-to customer on a project.

Bill-to Project Contact Role Specifies a contact person if one is assigned to the bill-to customer on a project.

Sell-to Document Contact

Role

Specifies the contact assigned to the sell-to customer on a project sales document (see

Project No. field on the header).

Bill-to Document Contact Role Specifies the contact assigned to the bill-to customer on a project sales document (see

Project No. field on the header).

Buy-from Document Contact

Role

Specifies the contact assigned to the buy-from vendor on a project purchase document (see

the Project No. field on the header).

Pay-to Document Contact

Role

Specifies the contact assigned to the pay-to vendor on a project purchase document (see

the Project No. field on the header).

Field Description

Budget Indicator Green Specifies up to which consumption level the light in the Budget field will be green.

At higher consumption levels, the light will turn yellow.

Budget Indicator Yellow Specifies up to which consumption level the light in the Budget field will be

yellow. At higher consumption levels, the light will turn red.

Profit Indicator Green Specifies the margin up to which the light in the Budget field will be green. At

lower margins, the light will turn yellow.

Profit Indicator Yellow Specifies the margin up to which the light in the Budget field will be yellow. At

lower margins, the light will turn red.

Disable Budget & Profit Indicator

Calculation in Project List

Description to follow.
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Nevertheless, we recommend that you leave the project time journals turned on even if you opt for CTC time tracking or time

sheets. The journal is still the easiest way for you to post corrections to time entries.
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Field Description

Time Comments on

Customer Doc.

With the toggle turned on, the Print on Customer Doc. checkbox is selected automatically for

each comment created in time tracking.

Comments marked in this way are later printed on proof of service statements that need to be

sent to customers when billing by time and materials.

You can clear the checkbox again manually if you want to exclude certain comments from those

statements.

Use Project Time

Journal

Turn on this toggle to add project time journals to the role center page (recommended).

Check by Time Manager With the toggle turned on, resource hours must be approved by a time manager (not the project

lead). A time manager needs to be specified for each resource individually.

For more information, see Project Journals.

Team Filter on Time

Posting

Turning on this toggle limits the available resources in time tracking to members of the project

team.

Note

The Check Team at Time Posting toggle must also be turned on for the relevant project.

Strict Team Filter This toggle expands on the preceding field. If turned on, it prevents users who are not

authorized to post to a certain project from doing so even if they fill in the No. field manually.

Projects that the Check Team at Time Posting toggle is turned off for are commonly considered

shared projects. They do not require you to set up a team and can be posted to by all resources.

Auto Fill Unique Hit

from Project Search

With the toggle turned on, a project is entered in a time journal or on a CTC card by the system

when it is the only project found with the help of the Project Search feature.

With the toggle turned off, you need to select the project manually.

General Time Recording

Resource

Specifies a dummy resource for budget lines and budget line activities that are not tied to a

certain resource or group.

As a special resource, it is included automatically on all time tracking pages at budget line level

so that every user can post to it.

Use CTC Time Tracking Turn on this toggle to add CTC time tracking to the role center page.

CTC Posting As Specify how CTC card entries should be posted to projects.

Time Entry

Project leads must first post and release the card entries before project ledger entries can be

created.

Ledger Entry

Only project ledger entries are posted. Note: Without time entries, some resource-related

analyses will no longer be available.

Time and Ledger Entries

Both entries are posted at the same time. This means that project leads no longer need to

retrieve and release time entries from CTC cards, although the entries might still prove useful

when analyzing project performance, for example.

CTC Time Tracking Incl.

Start/End Times

With the toggle turned on, you need to specify a start and an end time instead of filling in the

Qty. field on a CTC line.
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Field Description

Check Break Total in

CTC

With the toggle turned on, the amount of time that is specified in the Break (Hours) field at the

top of a CTC card must be distributed across the lines by filling in the fields with the same name

there.

Deactivate Break

Minimum

Turn on this toggle if want the system to skip the check for minimum breaks.

New Invoice Qty. in

Time Tracking

Typically, the Invoice Qty. field is filled in from the Quantity field. A different invoice quantity can

only be entered if services are billed based on time and materials and this toggle is turned on.

Additionally, when time is posted to budget lines, the line you want to change the quantity on

must be billable in full.

In other words, the Billable checkbox needs to be selected on the line and the Invoice Qty. %

field cannot be filled in with a value other than 100.

If the time cannot be invoiced in full, the amount that you can bill will depend on the specified

line activity.

Confirm Invoice Qty.

Variance

Turn on this toggle if you want a user who runs time entry checks to have to approve any

variance between the quantity (=the amount of work performed) and the invoice quantity on

project journal lines before the lines can be posted.

This option is relevant only if you set up journal lines by running the Create Project Time Entries

function.

On WBS lines that are set to No Billing, the two quantities always differ (the Invoice Qty. being

0). As a result, these lines are released automatically.

Job Time Correction

Template

Specifies from which template for project time book sheets a book sheet is to be selected for the

temporary execution of ZDE line reversals.

Job Time Correction

Batch

Use Time Sheets Turn on this toggle to add time sheets to the role center page.

Time Sheet Mgt.

Approval

Turn on this toggle if you want an employee's time sheet released—that is, checked by a

resource manager—before a batch job can be used to post time or project ledger entries from

the time sheet.

Time Sheet Posting As Specify how time sheet entries should be posted to projects.

Time Entry

Project leads must first post and release the sheet entries before project ledger entries can be

created.

Ledger Entry

Only project ledger entries are posted. Note: Without time entries, some resource-related

analyses will no longer be available.

Time and Ledger Entries

Both entries are posted at the same time. This means that project leads no longer need to

retrieve and release entries from time sheets, although the entries might still prove useful when

analyzing project performance, for example.

Auto Archive Time

Sheets Older Than

Enter a formula to specify when you want the system to archive time sheets. For example, -1Y

means the system will archive all time sheets older than a year.

The actual process is performed by the Move Timesheets to Archive batch job in the task queue.
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CTC Calendar Colors

Stores colors and styles that are used in CTC time tracking to visualize the progress of time capture on different calendar days.

Archiving

Specify posting groups

Before you can include a project in your financial reports, you need to specify posting groups and accounts for it.

General Posting Setup

You record WIP and recognize revenues from a project by posting consumption and sales to different G/L accounts in Finance. To

set up two of these accounts:

Choose the Search icon, enter General Posting Setup, and then choose the related link.

Fill in the fields shown in the following table.

Of course, both accounts are also used when you recognize revenues and expenses by running the Post Project Recognition to G/

L function.

Project posting groups

Field Description

Post Neg. Time Sheet

Qty. as Correction

With the toggle turned on, an attempt is made to post a reversal entry when you enter a negative

quantity in a time sheet.

More specifically, the system will search for a reversal entry that matches the number, WBS line,

budget line activity, date, and quantity of the project for which the time sheet was created.

Alternatively, you can cancel quantities through the time journal.

Field Description

Autom. Archive

Completed Projects

If this switch is set, a project is automatically moved to the archive when it is set to "Completed"

status. 

Note

As archived projects are displayed separately from active projects (by filtering in the list), you are

no longer on the completed and archived project after automatic archiving, as it has been filtered

out of the view.

1. 

2. 

Field Description

Project Sales Adjmt.

Account

(Sales) In the context of the Post Project Work In Process to G/L batch job, the balancing (P&L)

account to the WIP Sales (balance sheet) account.

You post to this account income from services rendered but not yet billed during an accounting

period.

Project Costs Adjmt.

Account

(Consumption) In the context of the Post Project Work In Process to G/L batch job, the balancing

(P&L) account to the WIP Costs (balance sheet) account.

You post to this account items that were consumed during an accounting period but haven’t been

posted as expenses (through a purchase invoice).
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The project posting groups contain other accounts through which you can post project-related WIP and recognition amounts to

Finance. To add accounts to these groups:

Choose the Search icon, enter project365 Project Posting Groups, and then choose the related link.

Fill in the fields shown in the following table.

For more information, see Project Measurement.

Set up project types

You can use project types as filters on projects, for example, during measurement. The types are also crucial to setting up project

accounts and cost-only (that is, internal) projects, where services aren’t billed to customers.

To create a type:

Choose the Search icon, enter Project Types, and then choose the related link.

Specify default settings as necessary, including for posting levels, internal projects, and fixed time periods.

To specify additional default values, you need to create a project template, which you can then link to a project type.

Use project templates

By using project templates, you can have multiple fields filled in automatically during project creation.

You will want to set up at least one template for each kind of project you might work on. The template provides basic information

that will be entered on every new project you create from it.

Choose the Search icon, enter Project Templates, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

1. 

2. 

Field Description

WIP Costs Account (Consumption) Stores the costs of unfinished projects.

WIP Sales Account (Sales) The account to which unit prices are credited when you Post Work in Process to G/L and

debited when you Post Project Recognition to G/L.

When you record WIP, the Project Sales Adjmt. Account from General Posting Setup is used as the

balancing account to this account.

For revenue recognition, that role is assumed by the Project Sales Account.

Project Costs Account (Consumption) An income account to which unit costs are debited when you run the Post Project

Recognition to G/L batch job.

Project Sales Account (Sales) A P&L account to which unit prices are credited when you run the Post Project

Recognition to G/L batch job.

G/L Expense Account Used when posting to project-related G/L accounts. Amounts are credited to the account when

project usage is copied to sales lines.

WIP Profit Account Stores prorated profits according to the percentage of completion (POC) method as defined by IAS.

WIP Profit Applied

Account

Contra account to the WIP Profit Account.

1. 

2. 

1. 

2. 

3. 
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General

The remaining fields are described in other help articles (see Create a Project). 

Posting

The fields on this FastTab are described in other help articles (see Create a Project). 

Project Billings

The fields on this FastTab are described in other help articles see (see Create a Project). 

Field Description

Code Specify a code for the template.

Description

Description 2

Specify the description that will be copied to new project cards.

Language Code Specify the code of the language that should be used by default. If you do not, the system will

retrieve the code from the relevant customer card. The code determines, for example, the language

in which text appears on new sales documents and on items entered for a project.

No. Series Select the number series that will be used to create projects from the template.

Formula Sales

Project Acc.

Entries

Enter a formula for dates.

For example, entering +1M specifies that revenue estimates will be recorded for cost control

purposes one month after expected consumption of an item or a resource.

Start on Active WBS Turn on this toggle if any new project created from the template should start on an active WBS.

Because active structures do not need to be released, you can start posting to the project right away.

Project Type Choose the type that you want to assign to new projects by default (see Project Types).

Status Specify the status that projects created from the template will start in.

Dimension

Integration

Specify the default dimension that should be created and assigned to new projects automatically.

Dimension

Integration Prefix

Specify a prefix to distinguish the dimension integration value entered in the preceding field from the

number used for a new project.

For example, choosing IT as the prefix will create cost object IT2365 for project 2365.

ICP Ships to

Customer Address

Specify if the shipping address of a project created from the template should be copied as the

delivery site to the service company selected for IC transfers.

With the toggle turned off, services rendered will be delivered to the business billing them—in other

words, to the customer address that is entered in the company to which the project is transferred.

WBS Line Batch to

Auto Insert

If needed, specify another template that WBS lines should be copied from automatically and inserted

at the start or end of a WBS created based on the current template.

This way, general-purpose cost lines only need to be set up once for them to be entered by the system

on all other templates where they are required.

The line batch is then added when creating a WBS in the usual way, by using the relevant project

ribbon function, or when doing so from a sales document. In the latter case, this feature is useful if

the cost lines were not transferred to the document but must be included on the WBS.

WBS Line Batch

Position

Specify the position of the line batch, which can be put before or after the WBS lines copied from the

current template.
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Lines

On this FastTab, you can set up a WBS that you want to copy to new projects so that you can specify structural elements such as

begin- and end-totals early on. You can store one WBS per template.

As for the Expand Budget Lines field, you can use it to specify that when you run the Create Lines from Project Template function

to set up document lines in sales and one of the Copy to Sales Doc. Field on the relevant template is set to WBS Line, the system

should also copy the budget lines from the template to the new structure.

For more information on how to set up a WBS, see Work Breakdown Structure.

Project budgets

You can also create budget lines for work packages entered on a template WBS. But unlike actual projects, templates don’t

include a pricing function. This means that a work package line entered in a template isn’t updated when you create budget lines

for it.

To set up budget lines:

Open a project template.

Go to the Lines FastTab and select a WBS line.

On the ribbon, choose Line > Project Budget Lines.

For more information about the fields found on budget lines, see Budget Lines.

If you are using the activation module Rolling Planning (Distribution), you will find the descriptions of the associated fields in the

section Project templates - Lines.

Distribution

If you are using the activation module "Rolling planning (distribution)", this info tab is visible. Further information on the fields

can be found in the section Project templates - Distribution info tab.

Predecessors / Successors

You can link a WBS or a budget line to both preceding and following lines in a template. These relations are later retained when

you create work breakdown structures from the template.

See also Line Dependencies.

Actions Copy Template

Copies the template WBS, dimensions, extended texts, measurement methods, and other data from an existing to a new

template. This function can only be used, however, if you haven’t yet created a WBS for the new template.

Assign Position Nos.

Adds a position number to every line of the work breakdown structure.

Renumber Lines

All WBS lines are automatically given internal numbers in 10 000 increments so that you can insert more lines between them.

For example, the first line you add between 10 000 and 20 000 will be assigned internal number 15 000.

Done too often in one place, however, the line numbers will eventually go outside the integer range, and insertion will no longer

be an option. To create the space required for inserting more lines, you can use this action to reassign the numbers throughout

the work breakdown structure.

Create Template from Project

You can use this action, found on the ribbons of project cards and the project list, to copy a project and its work breakdown

structure to a new project template.

1. 

2. 

3. 
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When you run the function, a dialog page shows the project number and the active WBS version that are copied by default. You

can, however, choose another version if necessary.

You can then enter a unique template code on the page. The system will check whether this code already exists and will show an

error message if it does. You can also use multiple toggles here to specify the project-related data that you want transferred.

Example

The Copy Project Data option tells the system to transfer the contents of all fields that are—or can be made—visible on project

cards.

Specify project accounts

Consumption and sales that you post to projects are shown on a chart of project accounts. This chart provides you with both cost

estimates and analytical tools for monitoring project progress and performance. The accounts available on the chart are specified

in Project Accounts Setup.

When you start using the project365 industry solution but have yet to decide on the structure of your chart, turn on the No Project

Accounts toggle in Projects Setup. This will avoid an error message because of non-existent or incomplete project accounts when you

budget and post to projects.

After you created the accounts, and set up the related matrix, you can use a batch job to add ledger entries and budget lines that

already exist. For more information, please contact your Business Central partner.

Chart of project accounts

The account chart is used for cost control and provides you with a detailed view of all project-related revenue and expense

accounts. None of them are related to the chart in Finance. To set up the chart:

Choose the Search icon, enter Chart of Project Accounts, and then choose the related link.

Enter a number and name for the account.

In the Account Type field, select one of the options shown in the following table.

On the ribbon, select Actions > Indent Chart of Accounts.

You are then asked to confirm that you want to indent the chart. Choose Yes.

Comments

Allows you to add information not included in the Project Account card fields. To enter a comment, select a line, and choose

Related > Account > Comments on the ribbon. Each comment can have a maximum of 80 characters.

Project Accounts Setup

This page looks almost exactly like a posting matrix in Finance. Here you can assign revenue and expense accounts to general

product posting groups. You can then use these accounts to budget and post project usage and sales. 

Note

1. 

2. 

3. 

Option Description

Posting Specifies an account to which you can post.

Heading Specifies a line of text for structuring a chart.

Total Specifies a sum derived from totaling project account fields.

Begin-Total Specifies from where to start totaling account lines. Calculation extends from the Begin-Total to the End-

Total field.

End-Total Specifies the point up to which account lines should be totaled. Calculation starts in the Begin-Total field.

The overall sum is shown in the Total field.

1. 

2. 
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You can specify what accounts are selected for posting with the help of project types or work packages, or both. A project ledger

(or budget) entry is then assigned to an account according to its entry type (Sale or Usage). The following fields stored with all

entries are later used to find an account:

Gen. Prod. Posting Group

Shows the general product posting group of a posted resource or a posted item.

Project Type

Shows the type selected for a posted project.

Work Package Code

Shows the code from a posted WBS line.

Project operations

Project work is typically broken down into different sections called work packages. These packages are then assigned to stages

of a project by using phase, task, and step codes.

Work packages

Work packages (packages of services or material) are among the most important components of any work breakdown structure.

You can assign budget values to a work package, post to the package, or use it in cost control.

You can also split a work package into subtasks, known as budget line activities in project365.

Each time you enter a package on a WBS, the system copies the same basic data for fields with the same name from the Work

Package table. In most cases, you can then change their contents again if necessary.

• 

• 

• 
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For more information about work packages, see WBS Lines. The following table will describe only those work package fields that

you cannot find on the WBS.

Example:

Work package texts

Work packages can include additional text. To add text:

Choose the Search icon, enter Work Packages, and then choose the related link.

Select a work package. On the ribbon, choose Edit.

This opens a page where you can edit the package. On the ribbon, choose Extended Texts.

Field Description

Billing Base Specifies the base for billing a project. This base is used if the work package, that is, the WBS line, is

copied to a sales document, such as a quote or an order (with resource being the most common

choice here).

Blocked The work package code can no longer be used on WBS lines. The block, however, doesn’t affect lines

that already contain the code.

Billing No. Depending on the selected billing base, this field shows the number of a resource, an item, or a G/L

account that you want to use on sales lines.

Often, a special billing resource and not a person is entered here.

Info BOM Total Cost

(LCY)

If a bill of materials has been specified for the work package, this field shows the total unit cost value

of that BOM.

Info BOM Total

Price (LCY)

If a bill of materials has been specified for the work package, this field shows the total unit price

value of that BOM.

Last BOM

Recalculation

Shows when the work package BOM was last recalculated.

Use in Resource

Planning

Specifies if the work package is available in resource planning. With the toggle turned off, the

package contains only material costs.

Budget Type

Resource

With the checkbox selected, you can budget the work package on a WBS that includes resources.

Budget Type Item With the checkbox selected, you can budget the work package on a WBS that includes items.

Budget Type G/L

Account

With the checkbox selected, you can budget the work package on a WBS that includes G/L accounts.

Budget Allowed This checkbox needs to be selected if you want to assign budget lines to a WBS line created from the

work package.

Code Description Working type

code

Unit code Type for

billing

Billing no. Billing type

AP007 Training DL HOUR Resource BILL0001 Time &

Materials

AP008 Support (T&M) DL HOUR Resource BILL0001 Time &

Materials

AP009 Introduction DL HOUR Resource BILL0001 Time &

Materials

AP010 Services DL HOUR Resource BILL0001 Time &

Materials

1. 

2. 

3. 

1.2.4 project365

- 628/1545 - Copyright © 2018 - 2024 KUMAVISION AG



When you enter a work package with extended texts on a WBS, the texts are copied alongside other data to the relevant line.

When you later create sales documents, such as quotes and orders, from the WBS, the texts are copied to these new documents

as well. By selecting one of the Print checkboxes on extended text lines, you can specify on which kind of document you want to

print the text that you entered. 

Alternative sales texts

When you enter a work package on a WBS, the Description and Description 2 fields stored with the package are copied alongside

other data to the relevant WBS line, where they can be changed again manually if necessary.

Both fields are also copied to sales lines when you create sales documents. If you, however, want documents to show another

description than the one used in-house, you can specify an alternative sales text for the package.

To specify an alternative description:

Choose the Search icon, enter Work Packages, and then choose the related link.

Select a work package. On the ribbon, choose Edit.

This opens a page where you can edit the package. On the ribbon, choose Alternative Sales Texts.

All packages offer a default setting for alternative descriptions and support various language codes for texts relevant to sales.

These are then copied to the Description in Sales and Description in Sales 2 fields on WBS lines depending on what language is

used for the project.

Work package BOM

For each work package on the Work Packages page, you can specify a simple bill of materials that can be used as the default

BOM for detailed planning. This BOM is later copied to the budget lines that you set up for lines containing the package.

Work package info

You can track the consumption of work packages across projects and document types in the purchasing, sales, and projects areas

with the help of a FactBox. This FactBox indicates how often a package has been retrieved so that you can, for example, identify

and delete unused packages. To see the FactBox:

Choose the Search icon, enter Work Packages, and then choose the related link.

Select a work package. On the ribbon, choose Edit.

This opens a page where you can edit the package. On the ribbon, choose Related > Work Package > Info.

Phases, tasks, and steps

Project activities can be divided into phases, tasks, and steps. Additional levels can be set up for work packages on the WBS.

Phases and tasks specify inter-project structures. Steps group all activities specified for a certain project.

Project budget names

You can define several budget names and manage, side by side, several budgets for a project. However, only one of these budgets

can be active at any given time. To set up a budget:

Choose the Search icon, enter Project Budget Names, and then choose the related link.

Choose New to create a name for the budget.

Fill in the fields as necessary.

You can also select a default name here and block certain budgets across projects.

Journal templates

Project journal templates

Every project manager must be assigned a separate project journal. It is enough to use a project journal template named

PROJECT for this.

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 
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From the template, you can then create journals for employees who will post to projects. Creating one journal per project

manager and per person responsible for project-related HR matters should be sufficient. For more information, see Project Time

Journals.

To specify journals for users:

Choose the Search icon, enter Project Journal Templates, and then choose the related link. 

On the ribbon, choose New to create a template. After filling in the fields, use the Batches action on the ribbon to assign users.

You are then directed to the journal assigned to you when you open the Project Journals page. A user for whom no journal has

been created will see an error message.

Project time journals

Employees are assigned to project time journals in the same way as to project journals. The difference is that instead of a user

ID, resource numbers are used for the assignment process. These numbers are also added to journal lines when times are

recorded.

Project measurement journals

These journals are set up like journals in Finance, which also means that you cannot assign employees or users to them. Creating

a template is sufficient here.

Invoice suggestions

These are best created per person to bill. You cannot assign employees or users to suggestions. You need to use the Search icon

and go to the Invoice Suggestion page manually the first time you want to create a suggestion.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

1. 

2. 

1. 
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Create a Project

OVERVIEW

A detailed work breakdown structure (WBS) can be a great help in project management.

For this reason, you can enter both a work package code and a group of phase, task, and step codes on the WBS lines of a

project. Combined, the four codes not only provide you with a more granular view of your project but uniquely identify each WBS

line. As a result, you can enter the same package on more than one line if at least one of the other codes differ.

You can then create budget lines for WBS lines that store work packages and—if you need an even deeper breakdown of project

activities—use these budget lines to keep track of tasks assigned to individual resources.

If, on the other hand, you don’t want to work with budget lines (that is, with a budget view), you can schedule activities directly

on the work breakdown structure. You can also assign a project to a main project. The following chart shows you how projects

are structured within project365:

FILL IN BASIC PROJECT DATA

To set up basic project information:

Choose the Search icon, enter Projects, and then choose the related link.

On the ribbon, choose New > New to create a project.

Fill in the fields as necessary.

See the following tables for more information about the most important fields on project cards. Some are filled in automatically

when you use a project template (as noted in the Description).

1. 

2. 

3. 
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General
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Field Description

No. Uniquely identifies a project. You can enter both numbers and letters or have the system assign

a number from a series automatically.

(This field might be filled in from a project template.)

Customer No. Shows the number of the customer for whom you want to create quotes and orders (unless the

project has been specified as internal according to its project type, in which case this field

remains blank).

Sell-to Contact No.

(Cust.)

Shows the number of the person or company entered in the Customer No. field. If the project is

set to Quote, you can select a contact who hasn’t been made a customer yet.

As in the sales area, however, a contact must be turned into a customer before a quote can be

converted into an order.

Sell-to Customer

Template Code

If a project in the Quote stage is set up for a contact who has yet to be made a customer, the

code you select here will be used to fill in the fields that are needed to create quotes for the

project.

The code is also used when you turn a contact into a customer.

External Project No. Specifies a document number that refers to the customer's numbering system.

Note

This number is only available on the project card and isn’t copied to sales documents created

from the project.

External Document No. Specifies a document number that refers to the customer's numbering system.

When you create a sales document, this number is copied to the document field with the same

name.

Your Reference Specifies the customer’s reference.

When you create a sales document, the value in this field is copied to the document field with

the same name. It will also be printed on the document.

Status All projects require a status. You can choose between Planning, Quote, Open, and Completed.

The status must change in exactly that order.

If you created the project from a template, the only status in which you can bill customers is

Open.

(This field might be filled in from a project template.)

Final Invoice Created Part of the end stage of a project. Turned on, the toggle confirms you created a final customer

invoice so that the project can now be posted to G/L.

The project is then set to Completed.

Person Responsible Indicates who manages the project. When you fill in this field, the project is added to the My

Projects list of the person linked to the selected resource.

The system then copies to the project the dimension values entered for this resource in the

Dimension Integration field in Resources Setup, allowing you to evaluate cross-project

performance.

The resource in this field is also used as a filter when time entries are posted to the project

journal. This way, a change in who manages the project will only affect new time postings.

Fill-In for Person

Responsible

Enter the deputy project manager. This field has no functionality besides providing textual

information.
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Field Description

Project Type Enter a classification code for the project. The type plays an important role in setting up

accounts for monitoring project progress and performance.

For example, you can use the type to analyze the cost and profit margins of certain types of

projects.

(This field might be filled in from a project template.)

Use WBS Res. Prices With the toggle turned on, the resource prices stored on WBS or budget lines are used for

pricing.

For more information, see About Resources.

(This field might be filled in from a project template.)

Manual Update on

Opening WBS Lines

With the toggle turned on, fields on total lines aren’t updated when you open a work breakdown

structure. This might be necessary if the process is causing performance issues.

Responsibility Center Like selecting a responsibility center for a sales or purchase document, selecting a center for

projects limits a user’s view to projects that fall under the specified area of responsibility.

Blocked Prevents users from posting to the project in the following ways.

Posting

Blocks postings of both revenues and expenses but permits changes to basic project information

and planning data.

All

Blocks both postings and changes to project planning (WBS and budget).

Times

Blocks time recording, for example, in time journals and on CTC cards.

Allows postings elsewhere, including in project journals, on purchase credit memos, and on

sales credit memos. Also allows changes to basic data and work breakdown structures.

Main Project Assignment Shows the number of main projects that the project is assigned to or, if it is assigned to only

one, the description and code of the main project.

You can click the field to see the card of a main project or to set up one if none has been

assigned.

Contact No. for Time

Tracking

Specifies if and how contact numbers should be entered for recording time spent on sales and

marketing projects (which do not require that you fill in a customer number).

Options are:

(blank)

No support of time tracking and no requirement for filling in a contact number.

Optional

Partial support of data entry by showing you a list of all company contacts stored in the system

when you enter the number of the project. However, no requirement for picking a contact from

the list.

Required

Same as Optional, except you must choose a contact number; without it, times cannot be posted

to the project.

You can use this feature, for example, in combination with BI tools to analyze the sales and

marketing expenses allocated to a contact.
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Field Description

When hours recorded by a contact are posted to the project, the number of the contact is copied

along with other data to the time entries created for the project and from there to the project

ledger entries.
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Posting
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Field Description

Time Posting Level Specifies the level at which times can be posted by resources. This field is used on time sheets, CTC

cards, and intercompany orders.

WBS

Hours are posted at the work package level (via WBS lines) to an active work breakdown structure.

Budget

Hours are posted at the budget line level. Additionally, the related line activity numbers are

retrieved for use in budget-to-actual comparisons.

Note

When time is posted, the Budget option also posts the entries to WBS lines if no budget lines exist.

This is because some WBS lines, such as those to record travel times, are not fine-planned so that no

budget lines are available for them.

(This field might be filled in from a project template.)

Purchase Posting

Level

Specifies the level at which costs are allocated to purchase documents.

See the Time Posting Level field for an explanation of the options that you can choose here.

(This field might be filled in from a project template.)

Project Doc. Posting

Level

Specifies the level at which costs are allocated to a project document, such as a project (vendor)

shipment.

See the Time Posting Level field for an explanation of the options that you can choose here.

(This field might be filled in from a project template.)

Gen. Journal Posting

Level

Specifies the level at which postings are assigned to general journals. 

See the Time Posting Level field for an explanation of the options that you can choose here.

(This field might be filled in from a project template.)

Project Journal

Posting Level

Specifies the level at which costs are allocated in project journals.

See the Time Posting Level field for an explanation of the options that you can choose here.

(This field might be filled in from a project template.)

Sales Posting Level Do not worry if this field does not show. It is not strictly necessary, as every WBS line includes a

checkbox (Copy to Sales Doc.) to specify how the line should be posted to sales.

Check Team at Time

Posting

With the toggle turned on, only the team specified for the project can post to it. The project will also

be hidden from anyone who is not a member of the team.

This field becomes active after you turned on the Team Filter on Time Posting toggle in Projects

Setup.

If the toggle is turned off, the project is assumed to be shared so that all resources can post to it.

(This field might be filled in from a project template.)

Strict Time Budget With the toggle turned on, resources cannot exceed the time budgeted for them. Entering more than

the budget allows will result in an error message.

A crucial factor in this context is the level at which times are being recorded. The WBS budget is
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Field Description

used as the baseline when hours are recorded on WBS lines, that is, for work packages.

If they are not, the values on the budget lines (the line activities) are used to compare the amounts

budgeted to the amounts posted and the times captured but not yet posted.

Note

A check is only performed for budget or WBS line quantities greater than 0.

(This field might be filled in from a project template.)

Location Code Specifies the code of the location that items for this project should be removed (posted) from. The

code is copied to all WBS lines by default and from there to the related budget lines.

When you create a purchase document or a project (vendor) shipment from a budget line, the

location is retrieved from that line.

You can specify a location as early as creating a project template.

Bin Code Specifies, based on the location, the code of the bin that items for this project should be removed

(posted) from. The code is copied to all WBS lines by default and from there to the associated

budget lines.

When you create a purchase document or a project (vendor) shipment from a budget line, the

location is retrieved from that line. 

You can specify a bin as early as creating a project template.
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Invoice and Shipping

Field Description

Bill-to Shows the customer whom you want to invoice. This customer can be different from the person or

company entered in the Customer No. field.

The Bill-to field also determines the invoice currency that is copied to the project. However, you can

still change the currency manually if necessary.

Bill-to Contact No.

(Cust.)

Shows the customer contact to whom invoices are sent. This contact can be different from the

person or company entered in the Customer No. field.

If a project is set to Open, you can also choose a contact who isn’t a customer yet.

Payment Terms

Code

Filled in automatically based on the Bill-to field but can be changed manually. The code in this field is

also copied to sales documents created from the project.

Gen. Bus. Posting

Group

Filled in automatically based on the Bill-to field but can be changed manually. The group in this field

is also copied to sales documents created from the project.

VAT Bus. Posting

Group

Filled in automatically based on the Bill-to field but can be changed manually. The group in this field

is also copied to sales documents created from the project.

Payment Plan Level Creates a payment plan for an entire project or for individual WBS lines.

Ship-to Code Contains the code of a shipment address that you want to store with the customer.

[Other Ship-to

fields]

These fields show the exact address for project shipments. Nearly all of them can be changed

manually.

Invoice Currency

Code

Specifies the currency used to bill the project. Prices can then be budgeted on a WBS in local and in

invoice currency.

All sales documents, including follow-on invoices, however, only show amounts in the invoice

currency.

Note

As both currencies are already in use when you budget prices for time and materials entries, you can

no longer change this currency after project ledger entries have been posted.

Invoice Currency

Date

Specifies the date used to convert budgeted prices into the invoice currency.
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Duration

Field Description

Starting Date Indicates the date on which work on the project started.

This field must be maintained manually.

Fixed Starting

Date

With the toggle turned on, planning cannot occur before this date.

Ending Date Indicates the date on which work on the project is expected to end.

This field must be maintained manually.

Fixed Ending Date With the toggle turned on, you can no longer schedule something on the WBS after this date.

Ending Date on

Order

Shows when the project was set to Open. This makes it possible to check later if the originally planned

ending date changed throughout the duration of the project.

Creation Date Shows the date on which the project was created.

Closing Date Shows when the project was set to Completed.
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Planning

Field Description

Planning Direction Specifies the planning direction for automatic planning.

Sales Project Acc.

Entries From

When you monitor project progress and performance, project account entries represent the

budget of a project, with time and materials entries time-linked to this budget.

Sales budget values, on the other hand, can be linked to either the budget or a payment plan.

Choosing Payment Plan copies the plan stored with the project to cost control in the form of a

revenue plan.

Choosing Project Budget in this field copies the sales budget instead. You can then use the

following two fields to decouple sales from consumption over a certain period.

Base Sales Project Acc.

Entries

If you choose Project Budget in the preceding field, you can select in this field whether you want

the system to use the expected date of consumption to create analysis entries or a formula based

on that date.

Formula Sales Project

Acc. Entries

If you choose Project Budget in the Project Sales Project Acc. Entries From field, fill in this field

with a formula to decouple budgeted sales from consumption.

For example, if you’re expecting an item to be used in June, the revenue generated from it can be

moved to July by using the formula +1M.

The formula applies to an entire project; you cannot decouple consumption for individual entries.

Active Project Budget

Name

Shows the name of the project budget used for the active WBS.

Active Version No. Shows the version number of the active WBS.

Fixed Time Period With the toggle turned on, times posted by resources are checked against the periods specified on

the WBS or for the budget line activity (depending on which time posting level you selected).

If CTC cards are used to post time spent on projects, the check is performed when a card is

released.

Cost Status This field, set by the project manager, shows the project's cost performance. It is part of multiple

role centers, such as Project Accountant. The system uses the following colors to indicate

performance:

• On Budget = Green

• Warning = Yellow

• Alarm = Red

Time Status This field, set by the project manager, shows the amount of time spent on the project. The system

uses the following colors to indicate whether projects are on track:

• On Time = Green

• Warning = Yellow

• Alarm = Red

Scope Status This field, set by the project manager, shows how the project is progressing. The system uses the

following colors to indicate if projects are on track:

• In Scope = Green

• Warning = Yellow

• Alarm = Red
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Internal Information

Dimensions

Project Billings

On this FastTab, you can specify if and how you want proofs of services to be printed when you bill work based on time and

materials.

All fields on this tab also show up on sales documents such as orders and invoices. The values in these fields are copied there

from the project card.

Field Description

Cause of Absence Code Specifies for special projects to which codes users can post inactivity.

Last Date Modified Shows when the project was last modified.

Project Template Code When you create a project, you can select a project template to have several fields filled in

automatically. For more information, see Create Project Templates.

Copy WBS From Template Specify from which project template you want to create the WBS.

This field is filled in automatically with the template used to create the project. 

You can choose a different template in this field after you set up a project but before you

create a WBS.

IC Partner Ship-to

Customer Address

Description to follow.

Field Description

Global Dimension

Code 1

Specify a global dimension that will be posted to the lines.

Global Dimension

Code 2

Specify a second global dimension that will be posted to the lines.

[Other fields] All these fields contain other shortcut (default) dimensions from the Dimensions table.

Fill them in if you want to use certain dimensions and values from the standard table as the default

for making postings that include this project.

For more information about dimensions, see the Microsoft Dynamics 365 Business Central1

documentation.
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You can, however, edit them again in the sales area.

Intercompany

Field Description

Print Attachment With the toggle turned on, an attachment—which provides proof of services rendered—is printed

alongside an invoice.

Leave the toggle turned off if you want users to decide whether to print the attachment.

Print Hours

Worked

With the toggle turned on, documents show both the services rendered and the hours spent providing

those services.

Print Not Billable With the toggle turned on, documents show services that aren’t billed.

Print Grouping Specifies according to which criteria you want to group services rendered:

• Resource

• Resource/Line Activity

• Line Activity

• Line Activity/Resource

Print Document

No.

Turn on this toggle if you want printouts to show document numbers—for example, from purchase

invoices—together with the services rendered.

Print Item Lines Turn on this toggle if you want item lines printed on attached documents. Proof is often only

requested for services.

Print Resource

Name

With the toggle turned on, attachments show the names of employees who worked on the project.

Leave the toggle turned off if you want proofs of services to show only the resource numbers and

descriptions of activities.

Field Description

No. of IC Partners Specifies the number of IC partners to which the project was sent.

Source IC Partner Code Indicates if the project was created by another company and then copied from there.

Source IC Partner

Project No.

Shows the number given to the project by the company that set up the project. This field is blank

if the project wasn’t created by another company.

IC Review Status Projects transferred from other companies must still be processed by using the IC Review action.

This field shows if the review has already occurred.

IC Review Res. Prices

Open

Indicates if new resource prices were transferred from a partner and require review.

IC Review WBS Lines

Open

Indicates if new WBS lines were transferred from a partner and require review.

IC Review Budget Lines

Open

Indicates whether new budget lines were transferred from a partner and need review.

ICP Ships to Customer

Address

Specifies if you want the shipping address entered for the project copied as the delivery site to a

service company during IC transfers.

With the toggle turned off, the project is delivered to the business billing the service, that is, the

customer address entered in the company the project is copied to.

Note

This field might already be filled in from a project template.
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PROJECT STATUS

The status options are crucial to determining the next steps you need to take when managing a project.

Planning

Preliminary estimates can be created. You can also specify the project structure, that is, you can choose work packages and

phase, task, and step codes. You can then add budget lines to WBS lines of the work package type. You, however, cannot post

anything at this point. Strictly speaking, this status isn’t required, and most projects start on Quote.

Quote

Services can be offered to customers. Preliminary estimates are again possible as well. You can also change the structure and

budget of the project.

However, unless the Project Posting in Quote Status toggle is turned on in Projects Setup, you still cannot post anything to the

project.

Open (=Order)

When the project is set to Open, you can record and post times and purchase costs and use sales invoices and credit memos to

post revenues. WBS lines can also still be changed at this point. And if you didn’t turn on the Project Posting in Quote Status

toggle in Projects Setup, this is the only project stage in which you can post something.

Completed

You can no longer edit the project structure and budgets. This status is used to perform post-project calculations. Actual project

costs can then be compared to budgeted amounts. You cannot post to completed projects.

CREATE A PROJECT FROM A TEMPLATE

There are two ways to create a project from a template:

Choose the Search icon, enter Projects, and then choose the related link. On the ribbon, choose New > New. Alternatively, open a

project card and—on the ribbon—choose New.

Go to a project card or the project list. On the ribbon, choose New > Walkthrough.

Both methods are explained in the following.

Use the New action

Choosing the New action on the project list or card creates a new record with a blank No. field.

You can now enter a number from a series, or you can exit the field.

Exit the field. You are asked if you want to use a project template. Choose Yes and then choose a template so that a number can

be assigned automatically.

The template will also fill in multiple fields on the new project card. The rest needs to be filled in manually.

Additionally, if the Check Mandatory Project Fields toggle in Projects Setup is turned on, the project will be blocked until you

entered something in all fields required for new projects. For more information, see Mandatory Field Check.

Use the wizard

Choose the Walkthrough action on a project card or the project list if you want help in setting up a project.

A wizard will then guide you through the steps required to fill in basic project data. This includes when the project is set to start,

who will manage it, and who the customer will be.

For the wizard to work, a project template is required. At the end of the process, you’re asked whether you want to import the

work breakdown structure that has been set up for the template. You can forgo this step if you want to add the WBS later.

If you select a template that is specified as internal via the Project Type field, filling in a customer (or a contact in the quote stage)

isn’t required. It is, however, for creating any other kind of project.

1. 

2. 

Note
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Edit projects

Not every field can be changed at any point throughout the life of a project.

For example, you can no longer switch to another customer after revenues are posted (unless you allow this kind of alteration by

choosing the corresponding option in Projects Setup, in the Setup Customer Change Despite Revenue field).

A change in dimensions can also create issues. Because posted project ledger entries aren’t updated during this process, an

analysis by dimensions might no longer produce accurate results.

If the Projects Setup toggle Check Mandatory Project Fields is turned on, you need to select the Edit Project action (found on

project cards) before you can alter project information. Other users are then blocked from editing the data.

Delete projects

You can no longer delete a project to which you have posted something, for example, project ledger or project time entries. The

system also checks for cross-references to document lines before deleting the project.

Selected actions explained

Project responsibility centers

You can assign responsibility centers to projects just like you can to sales and purchase documents.

To assign a center to a project:

Choose the Search icon, enter User Setup, and then choose the related link.

Choose a code in the Projects Resp. Ctr. Filter field.

If you fill in one of the other fields but leave the Projects Resp. Ctr. field blank, you will see only sales, purchase, or service

documents associated with a particular center but all projects with and without a center.

The Project Resp. Ctr. Filter affects all pages related to a project and cannot be changed by users on those pages. The filter can

also be set on some cost control reports.

The responsibility center filter is unavailable for time tracking, given that members of one center might work on projects of another.

You can still restrict the selection by using the project team feature.

However, because of the special nature of project-related pages, users will not be able to open the project card or view other

data of a project from time tracking.

Advertising groups

Extended texts that you enter for an advertising group are copied to a project if the group is set up as a general-purpose group

or if it has been assigned to the customer of the project. This works in much the same way as when you copy extended

advertising group texts to sales documents.

You use extended texts to store general information such as notes on trade shows, special offers, and company holidays. 

Create WBS from Project Template

Creates a work breakdown structure for a project from the template stored in the Copy WBS from Template field. The field is

filled in automatically together with the Project Template Code field when you create a project from a project template.

You can no longer choose this action after you’ve added a WBS to the project.

If a WBS Line Batch is specified for the template, the batch (which consists of WBS lines from another template) is automatically

inserted at the beginning or end of the new structure, depending on your setup. See also Project Template.

Change Project

1. 

2. 

Note
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Opens a page that shows some of the fields available on a project card. The page can be used by those who aren’t authorized to

create projects but need to edit certain fields on a card (provided they ‘indirectly’ have permission to edit fields on project cards).

The Edit Project action on the ribbon has an entirely different purpose, namely to make the current project card available for editing.

This function is used mostly to set up mandatory field checks.

Create Interaction

Creates an interaction. This function mostly relates to customers and their contacts but might also cover marketing campaigns.

An interaction can be tailored to a specific project and work package.

Update Addresses

Updates the sell-to, bill-to, and ship-to addresses on a project card from base data. The relevant address is retrieved, for

example, from a second customer card if a different bill-to customer is specified or from the ship-to address list set up for the

customer of the project.

This function cannot be used for custom (bill-to and ship-to) addresses.

Copy Project to IC Partner

Copies a project to an intercompany partner. This function is used to review a project transferred by an intercompany partner.

Create User Task

Creates a user task associated with a project.

This function uses the Related Table and Related Record fields to connect a task to a project.

Change Project Budget Status

Opens a list of all budget lines of a project.

This action provides a way for you to edit the status of each line in the budget, for example, to set more than one task (line

activity) to completed at the same time, without having to drill down on the relevant WBS lines. 

Archive Completed Project

This function can be used to move completed projects to the archive. Archived projects are separated from active projects by

filters and can only be called up via menu items of the same name, which increases the clarity of the active projects. In terms of

data, active and archived projects remain in the same table, which has the advantage that evaluations (e.g. business intelligence)

do not have to access two tables.

Project Dimensions

The following options are available if you select Dimensions on the project list; else, the associated dimensions can be viewed on

the project card.

Dimensions-Single

Shows the dimensions entered for the selected project. You can also enter new ones or change and delete existing dimensions

here.

Dimensions-Multiple

Shows the dimensions that have been filled in for the selected projects. Also shows the dimension value codes, which are the

same for identical fields.

Note

Note
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Statistics

Shows the budgeted and actual amounts stored for a project, including budgeted values on the WBS.

Comments

Available for entering comments. These are used internally within a company and aren’t copied to subsequent documents

created from a project.

Beginning and ending text

Beginning and ending texts are copied to sales documents created from a project and can be printed there as well. As the name

implies, beginning texts are shown before, ending texts after sales lines on printouts.

Online Map

Opens the map service that you specified in Online Map Setup to show where a project is located.

Sales doc. project budget change log

Shows a log of all sales document changes copied to projects.

Interaction log entries

Shows a list of logged correspondence, such as printed cover sheets or sales orders, letters sent and received, phone calls made,

and meetings held. Entries are filtered based on the page on which you selected the action. For example, if you select the action

on a project card, the log contains all correspondence logged for this specific project.

User tasks

Shows all user tasks associated with a project.

Documents

Shows all documents available for a project. Purchase and sales documents are listed separately, as are open and posted

documents.

To view a document, select one and then choose Show on the ribbon. Alternatively, use the lookup on the selected line.

Opportunities

Gives you access to opportunities that were automatically or manually linked to a project through a sales quote.

Steps

Used to manage project-specific partial activities. Steps are set up for every single project, whereas phase and task codes are the

same for each of a company’s projects.

Contacts

Used to enter information about the people and companies you’re expected to be in frequent contact with during the duration of

a project. You can also assign one of them to a WBS line (for informational purposes).

When you set up a project, the customer selected for it will be entered on the Project Contacts page automatically. The same will

be done with contacts specified on sales and purchase documents if the number of the project is entered on the document

header.

Additionally, if all lines of a purchase document are assigned to the same line on a work breakdown structure, the WBS line will

be linked to the relevant project contact when you release the document.

You can also assign roles (such as customer and vendor) to project contacts. Some of them might be filled in automatically on the

project (see Projects Setup).

Project Team

For more information, see Project Teams.
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Budget line activities

Shows work package-related activities at the WBS line or work package level. For more information, see Budget Line Activities.

Project IC Partners

Shows a list of all IC partners related to a project. For more information, see Intercompany Work.

Project measurement

Shows the options for measuring project progress and performance.

For a true representation of a company’s scope of services in accounting, revenues and expenses must be compared from period

to period.

History

Shows project ledger entries, time entries, and posted invoice entries.

Payment plan

To specify under which conditions and at which times you want to invoice a project, go to the relevant project card and, on the

ribbon, choose Related > Project > Payment Plans > Payment Plan.

Billing can include fixed partial amounts or a percentage of the total. You can also invoice by milestones. Plan entries are used

when you create invoice suggestions.

Resource prices

Whereas item and resource costs are maintained independently of a specific project, the unit prices for items, resources, and

other expenses (overhead) can be stored for each project individually.

Unit prices can be set up for items, resources, and G/L accounts. For each, you can enter a distinct unit price or specify a

surcharge on unit costs in percent (=unit cost factor). You can also enter a percentage-based line discount.

Additionally, resources can have different unit prices depending on the type of work being performed.

As for unit costs, they aren’t typically maintained for G/L accounts. But you can still store costs you would typically expect for

them on the Project G/L Account Prices page. This can be useful in budgeting a project.

You can also specify resource prices per project and IC partner. When a project is later transferred to a partner, the prices are

copied to the partner’s Project Resource Prices page. When you then review the transfer, they are assigned to the budget fields

on copied WBS lines.

Likewise, they will be added to the times posted by IC partners so that the partners can later bill their services at agreed-on

prices.

Planning

Includes all options for project planning. For more information, see WBS and Scheduling.

WBS (Work breakdown structure)

Work breakdown structures divide a project into individual stages. They are used to plan, budget, manage, and monitor projects.

A WBS can be created from a stored project template and customized.

Budget line list

Lists all budget lines created for a project.

Budget line activities overview

Lists line activities (=budget lines set up for resources and resource groups) by work package.

Budgeted resources
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Lists all resources and resource groups set up for a project. Entries are aggregated per resource or resource group.

WBS scheduling

Used in project planning. For more information, see WBS Scheduling. 

Budget vs. actual

Performs a budget-to-actual comparison based on current project data.

Reports

Shows you a list of project reports. As a rule, these are filtered based on the current project.

Documents

Shows all documents for projects related to the main project.

Budget Line Activities

Shows the line activities that have been set up on the work breakdown structures of projects related to the main project.

Project teams

You can create a project team per project. To set up a team:

Open a project card.

On the ribbon, choose Related > Project > Project Team.

Project teams are formed by combining resources. A resource can be assigned to a project only once.

In the Job Title field, choose Project Manager, Deputy Project Manager, Secretary, Subproject Lead, or leave the field blank.

A project team is changed or amended when you:

Enter a project manager on a project card.

Fill in a deputy manager on a project card.

Enter a subproject lead on a WBS line (=work package).

Set up a resource budget line (=line activity).

In each case, a resource is added to the team and, if necessary, the role of (deputy) project manager is assigned or changed. The

Time Posting checkbox is selected for all members added automatically to the team.

When a team member is added as project manager, deputy PM, subproject lead, or secretary (by a user or automatically), the

Invoice Suggestion checkbox is selected as well. Besides providing details about members, the project team feature governs

access to:

Time entries (to post to a project)

Project ledger entries (to release posted times)

Billing (to create invoice suggestions for a project) 

For a quick and easy overview of who is a member of a certain team, you can unhide a FactBox on the project card or list.

Time entries

1. 

2. 

• 

• 

• 

• 

• 

• 

• 
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To control the posting of times through project teams, you must:

Turn on the Check Team at Time Posting toggle so that only certain resources can post to a project. 

With the toggle turned off, all resources can post to a project, as it is considered a general-purpose project.

Maintain a project team after turning on the Check Team at Time Posting toggle.

Set up resources who post times to a project as project team members and select the Time Posting field for them on the Project

Team Setup page.

Turn on the Team Filter on Time Posting toggle in Projects Setup.

This ensures that the filter on the project list in time tracking is tailored to the relevant resource (=user) and lists mainly projects

for which the resource has been authorized.

It also shows the projects to which all resources can post. If the toggle isn’t turned on, an employee can see all projects. A check

against the project team will only be carried out later, during posting.

Turn on the Strict Team Filter toggle in Projects Setup.

This ensures that when a project is set to Check Team at Time Posting, but a certain resource isn’t part of the project team, the

related user can’t enter a project number (that is, without using the projects list) in time tracking.

Any attempt to post resource hours to projects for which the user hasn’t been set up will then prompt an error message and

posting will be blocked.

Change project budget status

All budget lines of a project are displayed in this overview. The purpose of this overview is to make it easy to edit the status of

budget lines. For example, if tasks (budget lines) have been processed and must now be set to the status "Completed". This

overview makes it possible to do this without having to navigate from WBS line to WBS line.

Billing

To control which resource is allowed to start a billing proposal for a project, the following must be set up:

The general setup in the Proj.team field at Abr.proposal in the project setup must be set.

There must be at least one entry in the Project Team table for the project, otherwise each resource may perform billing!

Each resource (user) that is to create billing proposals for a project must be created as a project team member and the switch in

the Billing proposal field must be active.

During the check, the resource is matched to users who are part of the project team to determine if a user has permission to invoice

the project.

If the project is part of the team filter but the current user isn’t authorized to bill the project, a message appears when an

attempt is made to create a suggestion, noting the lack of permission. The user can then display the projects blocked for posting.

Resource teams

Not unlike a template, the resource team page allows you to add multiple resources to a project team at the same time.

Choose the Search icon, enter Resource Teams, and then choose the related link.

Choose New on the ribbon to create a resource team, and then choose New > Members to add members to the team.

To remove a member or an entire team, use the Delete function on the pages.

When you add a resource team to a team set up for the project, a note about the origin of each member of the resource team will

appear on the relevant project team lines.

1. 

2. 

3. 

4. 

5. 

1. 

2. 

3. 

Note

1. 

2. 

3. 
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Project team roles

The roles that you can assign to members of a project team are limited to the default project team roles available on resource

cards. An individual extension will be required if you want to add more role options.

There is, however, an alternative solution that can be used to customize a role:

Choose the Search icon, enter Project Team Roles, and then choose the related link.

Fill in the fields described in the following table for each role you want to assign to a resource.

For example, you can specify a role named Architect on the page and link this role to the Subproject Lead, one of the standard

options on the resource card:

Following on from our example, the role of architect is assigned to a resource. If added to a project team, the resource is then

filled in as not only the architect but also the subproject lead for this project.

In Projects Setup, you can specify up to 10 team roles that you want to show on the project list or on project cards. This way, you

can see immediately who works on which project in what area or capacity (for example, as the architect or as someone in billing

or cost control).

As invoicing is a crucial business process, you can use the Billing Responsibility Filter function on the Projects page to filter the page

to projects where a resource has been marked as being responsible for billing.

Team overview

To see what teams are assigned to certain projects, run the Project Teams action from the Project Lead role center. You can set a

filter on any field of the page. 

My Projects and profitability chart

The My Projects tab in the Project Lead role center can be maintained manually. But the tab is also filled in automatically when

you enter a resource as a Person Responsible (that is, as the project manager) on a project card.

Related to the My Projects tab is the Project Profitability chart. This chart shows all the projects listed under My Projects unless

their Exclude from Business Chart field is filled in.

1. 

2. 

Field Description

Code Specify a unique code for the role.

Description Enter a description for the role.

Responsible for

Billing

Select this field if you later want to filter invoice suggestions based on the people in charge of

billing.

Unique to Project Select this field if you want the role to be assigned no more than once to a project, Project Lead

being an example.

Only roles unique to a project can be selected on the Team Roles FastTab in Projects Setup.

Field Description

Default Project

Team Role

Shows the role that will be assigned by the system when the resource becomes a member of a

project team.

What you can choose here depends on how you set up the Project Team Roles page, where each new

role you create is linked to a standard team member role available in the system.

Tipp
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Main projects

Main projects sum up multiple projects. They are essentially a higher-order category. If you filled in the fields for main project

dimension integration in Projects Setup, the system creates and adds a dimension to a new main project automatically. It will also

copy that dimension to any project that you later assign to the main project.

A dimension assigned to a project through a main project will not change after replacing the dimension in the main project.

To see a list of all main projects:

Choose the Search icon, enter Main Projects, and then choose the related link.

On the ribbon, choose Related > Main Project and one of the following actions.

Statistics

Shows a budget-to-actual comparison for all projects assigned to the main project.

Comments

Used to enter notes about the main project.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

1. 

2. 

1. 
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WBS and Scheduling

WBS AND SCHEDULING

Overview

Each project requires at least one work breakdown structure (WBS).

You can use this structure, in conjunction with a graphical planning tool, to allocate staff to a project according to available

capacity and to budget the consumption of resources and items on its lines.

Work breakdown structure

A work breakdown structure organizes a project into smaller components, making it more manageable. The smallest element of a

WBS is often called a work package.

In some cases, a package might again be divided into subtasks, which are known as budget line activities in the system. These

are assigned to individual resources.

You can enter one package code on each line. The system then combines this code with a phase, a task, and a step code to create

a unique identifier for a line. You can therefore use a package multiple times for the same WBS if at least one of the other codes

differ. What you assign as a phase, a task, or a step code is solely a matter of company organization.

If you want the system to create phase, task, and step codes for you, you can turn on the Auto PTS Code toggle in Projects Setup.

Each WBS consists of a header, where you see the General FastTab, and lines. You can assign multiple structures to each project.

To view a WBS set up for a project:

Choose the Search icon, enter Projects, and then choose the related link.

Open a project. 

On the ribbon, choose Project > WBS or WBS Incl. Budget View.

Set up a WBS

There are several ways to set up a work breakdown structure for a project:

Copy a WBS

A convenient way for you to create a WBS is to copy a structure from another similar or sample project. The copy function is also

used to create new versions of a WBS. For more information, see Copy WBS.

Create a WBS from a template

Another easy way for you to create a WBS is to copy all relevant fields from a project template.

For more information, see Create Project Templates.

Insert a block from a project template

Block-type WBS lines can be used to copy a group of field values from a project template to any part of the structure. We

recommend that you set up special project templates for this purpose, as the entire WBS is copied as a block from the template.

After you selected Block on a WBS line, you can choose in the No. field the template from which you want to copy a structure.

You then explode (copy) the block by using the Explode Block function on the WBS Lines FastTab.

WBS header

On the header, you can see the number of the project for which you created the WBS, the name of the related project budget, and

the version of the work breakdown structure. All structures are managed based on these three fields.

1. 

2. 

3. 
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For a complete list of WBS header fields, see the following table.

Lines

The lines of a work breakdown structure are set up with certain project criteria, such as deliverables or phases, in mind. For

each line, you can specify whether to make it a Work Package, a Heading, a Begin-Total, an End-Total, or a Total. The Block

option, on the other hand, isn’t used as a structural element but is a function to copy a group of fields from a project template to

an active WBS.

A begin-total marks the beginning of a series of line values to be totaled, the result of which is given as the end-total.

Calculations enclosed by begin- and end-totals might be nested inside one another. The sum of all calculations is then shown on a

line of the total type. This line, in turn, is linked to the heading entered above the first begin-total. To budget and post revenues

and expenses to a project, you need lines of the work package type.

Field Description

Project Budget

Name

Shows the name of the project budget tied to the work breakdown structure.

This field is filled in with the default name specified on the Project Budget Name page, although you can

change the name here if necessary.

For each project, you can set up any number of work breakdown structures with different or identical

project budget names. A name included more than once in the same project will receive a version

number, which is incremented every time the name is reused for the project.

Version No. Shows the version number of the WBS. The number is assigned automatically.

Project

Description

Shows the content of the Description field from the project.

Description Shows a text that describes the WBS.

Blocked With the toggle turned on, the WBS is blocked for all users

Sales Budget

Blocked

Turning on the toggle keeps the current sales budget fixed.

Whereas unit costs can still be changed, budget lines can no longer be added to the project, as they

provide sales prices automatically.

If the Fixed Sales Budget when Ordering toggle is turned on in Projects Setup, this toggle is turned on

automatically when you set the project status to Open.

Active Specifies the WBS that is currently active. If the toggle is turned on, the WBS is in use. You must release

a WBS before you can set it to Active, and you cannot have more than one active WBS per project.

Budget Status Specifies if the work breakdown structure and its budget entries are pending approval, have been

released, or have been rejected.

Released By

Released On

These fields show who released the structure and when. Users can only post to a project and an active

WBS upon release.

Main WBS For more information, see Main WBS.
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The most important line fields are explained in the following table.
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Field Description

Position No. Shows the number of the WBS line.

When you create a WBS, you can use a series to have numbers added automatically by choosing Actions

> Functions > Assign Position Nos. on the ribbon.

Type Specifies the nature of the WBS line.

(blank)

The line contains text only.

Work Package

The No. Field specifies a work package for the project.

Heading

The Description field contains a heading, shown in bold on printouts.

Begin-Total

The line marks the starting point for totaling numbers and amounts.

End-Total

The line shows the result of adding up numbers or amounts starting from a Begin-Total.

Note

Begin-total and end-total calculations might be nested.

Total

The line shows the sum of all subtotals.

Note

Total fields cannot be nested. To have the system calculate a total, you need to run the Assign Position

Nos. function first.

Block

Fills in the line with a group of project template values.

No. Specifies a number if Work Package or Block is selected in the Type field.

Starting Date Shows, if Work Package is selected in the Type field, when the project usage budgeted on the line is

supposed to start.

This field is filled in automatically with the starting date of the project but can be changed, if needed.

Ending Date Shows, if Work Package is selected in the Type field, when the project usage budgeted on the line is

supposed to end.

This field is filled in automatically with the ending date of the project but can be changed, if needed.

Billing Type Indicates how services included in a work package are billed to customers.

(blank)

Treats the line as if it were set to No Billing. Used for lines structuring the WBS view (headings, begin-

totals, end-totals, and totals).

Time & Materials

Invoices the line based on unbilled costs, for example, because hours were posted to it. For each project

ledger entry, you can also enter an invoice quantity that is different from actual expenditures.

Fixed

Copies the value entered on the line as a fixed price to invoice suggestions. For installments, the price
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Field Description

suggested is a portion of the total price.

We recommend this option for WBS lines that are linked to sales lines or payment plans, but you can

also use it for other billing sources.

No Billing

Posts the line without billing a quantity.

Milestone

Bills the line at agreed-on rates as part of a milestone-based payment plan. The related plan line is

copied to an invoice suggestion when the Milestone Reached checkbox is selected on the payment plan.

You can set up milestone plans for individual WBS lines or an entire project.

POC

Bills the line at agreed-on rates based on the Project Completion % field. The suggested invoice total is

proportionate to measured progress, minus the amounts already billed for the project.

TE Flat Rate

Specifies a lump sum for travel expenses. You can only use this option if you installed and (set up) the

Comsol Travel Expenses app.

The line that contains the TE flat rate must show the total price on which you agreed with the customer.

You do not need to plan anything here.

The WBS might also contain other work packages with app-related travel expenses. However, these

should be set to No Billing unless, for example, you want to additionally invoice a customer for miles

travelled.

Posting travel expenses through the Comsol app posts the expenses to TE work packages and copies a

project ledger entry with no unit cost—but with the specified rate—to the TE Flat Rate package. When

you settle the associated invoice, this rate is then suggested for each business trip on an invoice.

Package Invoice

Bills the line based on work package costs whenever project effort is of a different nature.

This includes travel expense scenarios in which you cannot simply add up times and routes and multiply

them by a line amount but where you need to collect receipts, such as for parking fees and hotel bills.

During billing, all expenses you want to charge to the customer are entered in sum with a quantity of 1

on an invoice line. On the proof of performance document, however, the expenses are itemized, as usual.

Because expense items are often difficult to budget—as you do not know how many package invoices

you will need for a certain project and what price you will have to set on each invoice—having one order

line refer to the work package is enough in this context.

The line does not require a quantity or a price, as the invoice suggestion feature ensures that the correct

amount is billed.

Meanwhile, the quantity on the order is increased by 1 so that you can rebill the order as often as you

want.

Ignore Payment

Plan

If selected, decouples the line from being billed based on a payment plan.

For example, despite a payment plan covering the entire project, you can select this field to bill travel

costs on invoice suggestions based on the actual costs incurred. These costs are then excluded from the

final invoice.
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Field Description

This field is only relevant if you use a payment plan for the project and have set the Payment Plan Level

field on the project card to Project.

Suspend Billing Selecting the field removes the line from invoice suggestions temporarily but retains the original billing

type. This option is used in milestone billing.

Copy to Sales

Doc.

Specifies what information is copied to sales documents.

WBS Line

Copies the values stored on the current line.

Budget Lines

Copies the values stored on the budget lines related to the current line.

No Transfer

Ignores the line in transfers. This option is primarily selected for WBS lines that are used for

informational purposes only or that have been transferred previously.

Copy as Bundle If this checkbox is selected and the Copy to Sales Doc. field is set to Budget Lines, the system will

transfer all relevant budget values in the form of a bundle to sales documents instead of placing them

between a begin-subtotal and an end-subtotal on the lines.

If you select the checkbox on a WBS line of type Begin-Total, on the other hand, the bundle in sales will

consist of all values that were added directly to the structure (between the begin-total and the end-total

on the project document).

Billing

Integration

Specifies if a fixed-price entry was copied to a sales document from the WBS or from an associated

budget line so that the system knows at which level to include the entry in an invoice suggestion after

billing has occurred.

Essentially, the billing level is already indicated in the Copy to Sales Doc. field. The difference is that you

might set a filter there for when you create follow-on orders.

For example, when you create an order with only new WBS lines, you need to select No Transfer in the

Copy to Sales Doc. field on existing lines before running the Create Sales Document action.

This means, however, that information required for billing will be lost. The value in the Billing

Integration field, on the other hand, matches that of the Copy to Sales Doc. field unless you select the

No Transfer option.

You cannot edit this field manually.

Status Shows the status of the line. A line can be set to Quote or Open.

This field is inextricably linked to the Status field on the project header. If the status there is set to

Open, the status in this field changes to Open as well. But when the status on the header is Planning or

Quote, the status of this line cannot be Open.

When you create a sales order from a quote, the status of both the project and the WBS line is set to

Open. Lines with work packages must be filled in immediately.

Work Status Specifies the status of a work package.

Resource consumption can only be posted to a package that is set to In Progress. Purchase order and

inventory usage, on the other hand, can be recorded in any status.

Statuses only differ in the information that they provide to the project manager. They have no other

purpose.

Note
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Field Description

The work status can only be set to In Progress when the status of the project is Open.

The following options are available in this field:

(blank)

Used for lines that structure a WBS view. This includes headings, begin-totals, and end-totals.

Open

The line has been set up.

In Progress

The line can be filled in.

Postponed

The line has been filled in but put on hold for project-related reasons.

Finished

Work on the line has been completed.

Accepted

Work on the line has been accepted by the customer.

Canceled

The related work package has been canceled for project-related reasons.

Blocked If selected, the line is blocked, and budget values can no longer be changed. You can still post to the

line, however.

Deselect the field to unblock the line for editing.

Requisition Specifies if items on related budget lines are included in purchasing.

Select this field if you want the system to check to what extent these items are available for purchase or

up to when they are via an order.

Phase Code Already described structure level of work packages. The main activities are defined across all projects. If

the main activity has been defined as "Auto. Activity code" in the "Project setup", the field is filled in

automatically and may not be able to be changed manually depending on the configuration. Within a

WBS, the combination of work package code, main, sub and partial activity must be unique, as it serves

as a reference for all document lines and items. As soon as document lines or items with this reference

exist, it is no longer possible to change them. The only exception is that changes can also be transferred

to sales quotation or order lines if only such lines exist. This supports the process of creating a WBS

from a sales document.

Task Code Already described structure level of work packages. The sub-activities are defined across all projects. If

the sub-activity has been defined as an "Auto. Activity code" in the "Projects setup", the field is filled

automatically and may not be able to be changed manually, depending on the setup. Within a WBS, the

combination of work package code, main activity, sub-activity and sub-activity must be unique as it

serves as a reference for all document lines and items. As soon as there are document lines or items that

use this reference, changes are no longer possible. The only exception is if there are only sales quotation

or order lines; in this case, changes are also transferred to these lines. This supports the "Create WBS

from sales document" process.

Step Code Already described structure level of work packages. The sub-activities are defined on a project-specific

basis. Separate sub-activities can be defined for each project. If the sub-activity is defined as an "Auto.

Activity code" in the "Project setup", the field is filled automatically and may not be able to be changed

manually. In the WBS, the combination of work package code, main activity, sub-activity and sub-activity

must be unique, as it serves as a reference in all document lines and items. Changes are excluded as

soon as these references exist. There is an exception if only sales quotation or order lines exist; in this
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Field Description

case, a change is also made to these lines. This supports the "Create WBS from sales document"

process.

Copy Budget The Copy from Budget function transfers the sum of all unit costs and total prices from the project

budget to certain WBS lines.

Clear this field if the current line should not be part of that transfer. As a result, the unit price or unit

cost specified for the billing resource on the work package is not multiplied with a budget line value but

with the quantity or invoice quantity that you enter here.

Description

Description 2

These fields describe the line. Headings, begin-totals, and end-totals are shown in bold. Work package

descriptions (which are retrieved when you select a package) are displayed in normal font.

When you create a WBS from a project template, both descriptions are copied from the template but can

be changed manually, if necessary.

They are also copied to sales quotes and orders that you create from the WBS by running the Create

Sales Document function (unless you filled in the sales description fields as well).

Description in

Sales

Description 2 in

Sales

These fields contain alternate descriptions for use in sales.

They specify notes that are shown to customers so that you can use the standard description fields for

internal comments.

When you enter a work package on the line, translations that exist for the package are copied to these

fields by default. You can fill in the fields as early as creating a project template.

Project

Completion %

The project manager can use this field to specify how far the project on the line has progressed in

relation to overall project performance.

What you enter here has an impact both on the completion values in project statistics and on the

calculation of earned values and variances in budget-to-actual comparisons. The field is also used on

invoice suggestions for time and materials billing.

Posting Progress

%

Shows how much of the project budget has already been used. The calculation is based on the following

formula:

Posting Progress % = Usage Total Cost (LCY) * 100 / Unit Cost

You cannot change this field manually.

Line Activity

Progress %

If a work package includes budget line activities, an employee can report in time tracking how far a

certain activity has progressed.

This progress is weighted when a package contains more than one activity. The line then shows the

average value across all activities.

You cannot change this field manually.

Comments Indicates the number of comments that are stored on the line. This field cannot be changed manually.

To see or edit a comment, choose Related > Texts > Comments on the ribbon.

Beginning Text Specifies whether text lines have been created for the line. Beginning texts are used, for example, as

headings for work packages.

To create a text, choose Related > Texts > Beginning Text on the ribbon or use the drill-down option.

You can only create and edit text for the selected line. With the help of checkboxes, you can also specify

the types of documents you want to print this text on.
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Field Description

Ending Text Specifies whether text lines have been created for the line. Ending texts are used, for example, as

additional work package descriptions.

To create a text, choose Related > Texts > Ending Text on the ribbon or use the drill-down option.

You can only create and edit text for the selected line. With the help of checkboxes, you can also specify

the types of documents you want to print this text on.

Work Type Code Shows the work type of the line.

This field is filled in from the work package by default but can be changed manually. The code is also

copied to available budget lines for the detailed planning of resource budgets.

Work types are used to post consumption and sales, for example, to a project, a resource journal, or a

sales document. They specify the kind of work a resource can be tasked with, such as overtime or

transportation.

For example, you can link work types to prices for budgeting or for posting project usage based on the

kind of activity performed by a certain resource or resource group.

Each type comes with its own unit of measurement, although you can assign several units to a resource

or group.

Cost Center

Code

Specifies the first global dimension to which the line is assigned. The field is filled in with a cost center

code.

Choose the lookup next to the field to see the codes that you have set up for this dimension.

Cost Object

Code

Specifies the second global dimension to which the line is assigned. The field is filled in with a cost

object code.

Choose the lookup next to the field to see the codes that you have set up for this dimension.

Subproject Lead Specifies the subproject manager in charge of the chosen work package. This field is used for

informational purposes only.

After you enter a manager, the relevant project team is automatically expanded to include the new

resource.

Quantity Specifies the planned quantity per unit for a work package.

Multiplied by the cost and price per unit, the value in this field results in the amounts budgeted for the

line.

For a lump-sum amount, we recommend that you enter a quantity of 1, especially if you use the Copy

from Budget action to fill in the line with budget line values through detailed planning.

If the WBS and the budget lines use the same unit, such as hours, the function also transfers the

budgeted quantity to the WBS.

Unit of Measure

Code

Shows the unit of measure for the entered quantity.

If you need to set up multiple types of budget lines, such as resource group, item, and G/L account lines,

we recommend that you choose a unit that can be used to enter a line quantity of 1. Rerunning the Copy

Values from Budget action then refreshes the associated price data.

Location Code Specifies the code of the location where items shown on the line are stored. Choose the lookup to the

right of the field to select a code.
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This field can additionally be filled in with a default value to maintain item lines sourced from a project

budget.

Direct Unit Cost

(LCY)

Specifies the unit cost for the line if you use a work package to enter items or resources.

If you work with detailed planning, the direct unit costs are stored on budget lines and are not copied to

this line.

Unit Cost (LCY) Specifies the unit cost. This field can be filled in manually.

If you work with detailed planning and have entries copied to this line, the field is filled in with the

average unit cost, which is calculated by dividing the sum of the unit costs on the budget lines by the

WBS line quantity.

If detailed planning includes multiple units of measurement—such as hours and pieces—a quantity of 1

is entered for this work package line and the unit cost is equal to the cost amount.

Total Cost (LCY) Shows the result of multiplying the quantity with the unit cost.

Invoice Qty. The value in this field is copied from the Quantity field but can be changed manually, as the usage

quantity that has been budgeted might differ from what you quote or bill to the customer.

When you use detailed planning, the invoice quantity is copied from the budget lines after running the

Copy Budget action (provided the unit of measure stored there is identical to the quantity on this line).

Invoice Unit of

Measure Code

Specifies the unit of measure in which services are billed.

This unit might differ from the unit in which services are rendered. For example, work might be

recorded in hours but invoiced in days.

Note

The unit of measure is retrieved based on the work type entered for this line. You must change the work

type if you want to use another unit.

Billing Cap Specifies an amount by which you can exceed billing by time and materials.

Select this field if you agreed with the customer on a billing cap. This cap is then used on invoice

suggestions.

Billing Cap % Specifies the billing limit as a percentage.

If you enter 0, a bill cannot exceed the sales budget, that is, the total price on this WBS line. If you enter

10, invoices can include amounts that exceed the budget by up to 10%.

Cost Factor This field must be filled in manually. It is used by the system to modify the unit price.

Unit Price (LCY) Shows the unit price. This field can be filled in manually.

If you work with detailed planning and choose to copy budget values to a WBS, the total price is

averaged according to the following formula: total budget price / sales quantity on the WBS line.

If a work package is budgeted with a quantity of 1 because detailed planning includes differing units,

such as hours and pieces, the price for a unit equals the total price.

Total Price (LCY) Shows the result of multiplying the invoice quantity with the unit price and then subtracting the line

discount.

This field cannot be changed manually.

Line Discount % Shows the line discount in percent. This field is used to calculate the total price and is copied to a quote

or order line.
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If you use detailed planning and choose to copy budget values to the WBS, the field shows the

percentage average of all discounts on the associated budget lines.

Line Discount

Amount (LCY)

If you use detailed planning and choose to copy budget values to the WBS, this field shows the average

of all discounts on the associated budget lines.

Budget Lines

Quantity

Shows the total quantity budgeted (in detail) on the line.

This field cannot be changed manually. For more details, select the entry to open the Project Budget

Entries page.

Budget Lines

Total Cost (LCY)

Shows the total unit cost budgeted (in detail) on the line.

This field cannot be changed manually. For more details, select the entry to open the Project Budget

Entries page.

Budget Lines

Total Price (LCY)

Shows the total unit price budgeted (in detail) on the line.

This field cannot be changed manually. For more details, select the entry to open the Project Budget

Entries page.

Usage Qty.

(Base)

Shows the quantity consumed on the line so far.

This field cannot be changed manually. For more details, select the entry to open the Project Ledger

Entries page.

Usage Total Cost

(LCY)

Shows the total unit cost consumed on the line, that is, how much time and how many materials

budgeted for the project have been spent. The sum of all usage cost fields on a WBS equals total project

usage.

This field cannot be changed manually. For more details, select the entry to open the Project Ledger

Entries page.

Usage Total

Price (LCY)

Shows the unit price of project ledger entries consumed on the line.

This field cannot be changed manually. For more details, select the entry to open the Project Ledger

Entries page.

Sales Qty. (Base) Shows the quantity sold (billed) to the customer on outgoing invoices.

This field cannot be changed manually. For more details, select the entry to open the Project Ledger

Entries page.

Sales Total Cost

(LCY)

Totals the unit cost of sold quantities.

This field cannot be changed manually. For more details, select the entry to open the Project Ledger

Entries page.

Sales Total Price

(LCY)

Totals the unit price of sold quantities per line, that is, the sales generated on this line. The sum of all

WBS lines equals total project sales.

This field cannot be changed manually. For more details, select the entry to open the Project Ledger

Entries page.

Profit

Profit %

Shows in number and percent the profit margin expected for the line.

Current Profit

Current Profit %

Shows in number and percent the profit margin achieved on the line so far. This field is only relevant if,

in addition to consumption, sales are posted to the line.
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Rem. Total 

Price Calc.

Base

Specifies based on the billing type of the line how the system calculates the value in the Unbilled Work

field.

Basically, this field is only relevant if you bill by time and materials. For every other billing type, it serves

informational purposes only.

Fixed

Calculation base: Budget - Invoice

The total price stored on the work package, that is, the WBS line, is compared to the amount billed for

the package so far, with the difference between them shown in the Unbilled Work field. To compare the

values, the system retrieves the total price from a sales line linked to the WBS line. If none is available,

the budgeted total price entered on the WBS line is used.

No Billing

Calculation base: (blank)

The Unbilled Work field shows 0.

Time & Materials

Calculation base: Usage - Invoice or Invoice Entries

If you choose the first option, invoice entries will not be considered.

Choosing the second only makes sense if you do work with invoice entries; otherwise, the Unbilled Work

field will remain unchanged throughout the life of the project.

Invoice entries are meant to document on which invoice and when you billed a certain usage quantity so

that no entry is billed twice.

Calculation base: Usage - Invoice

Actual consumption for a WBS line (total price of a usage entry) is compared to the quantity for billing

to ensure that you bill neither too little nor too much.

In short, the value in the Usage Total Price (LCY) field is compared to that of the Sales Total Price (LCY)

field. If an invoice does not match the exact expenses, however, the field might never go down to zero.

Example

(a) Consumption of 10 hrs. at $100 = total price of $1,000

(b) Consumption of 10 hrs. at $120 = total price of $1,200

Invoice total: $1,960

Total price remaining = $240

Calculation base: Invoice Entries

The system checks every consumption entry included in a work package for whether an invoice entry

has been created for it, that is, if the entry denoting usage has been billed.

It does not matter in this context if the usage entry was invoiced at a higher or lower price (or based on

more or fewer hours) than previously recorded. Only project ledger entries without invoice entries are

added up in this field.

(a) Consumption of 10 hrs. at $100 = $1,000

(b) Consumption of 10 hrs. at $120 = $1,200

Invoice:

(a) Ledger entry of 10 hrs. at $100 = $1,000

(b) Ledger entry of 8 hrs. at $120 = $960 (changed on invoice)

Invoice total = $1,960

Total price remaining = 0
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The following fields on a begin-total line are filled in automatically on all subsequent work package lines until the end-total to help

ensure data consistency in your app: Work Status, Status, Phase Code, Task Code, Step Code, Copy to Sales Doc., and Billing Type.

For example, changing the work status on a begin-total line also changes the status on all other lines before the end-total line

(provided they contain work packages).

WBS functions Assign Position Nos

Adds a position number to every line of the work breakdown structure.

Renumber Lines

All WBS lines are automatically given internal numbers in 10 000 increments so that you can insert more lines between them.

For example, the first line you add between 10 000 and 20 000 will be assigned internal number 15 000.

Done too often in one place, however, the line numbers will eventually go outside the integer range, and insertion will no longer

be an option. To create the space required for inserting more lines, you can use this action to reassign the numbers throughout

the work breakdown structure.

Calculate Predecessors

Field Description

Milestone

Calculation base: Milestone

The payment plan set up for a WBS line is understood as a milestone plan. All plan lines that have not

been invoiced but that the Milestone Reached checkbox is selected on are considered billable and their

total is copied to this field.

Percentage of Completion

Calculation base: Budget * Percentage of Completion - Invoice

Calculates a value based on a formula that links the budgeted total price to project progress (the

percentage of completion) and then subtracts the amount billed so far.

The system retrieves the total price from a sales line related to the WBS line. If none is available, the

budgeted price from the WBS line is used.

TE Flat Rate

Calculation base: Invoice Entries

Calculates, based on invoice entries linked to a TE work package, what can still be billed using this work

package.

Package Invoice

Calculation base: Invoice Entries

Calculates, based on invoice entries, what billable costs remain.

Unbilled Work Shows the difference between consumed and billed amounts based on the Rem. Total Price Calc. Base

field.

Sell-to Customer

No.

Shows an invoice recipient who is not the customer of the project. A recipient can be entered but only if

you selected WBS Line in the Billing Integration field as the level at which to create sales documents.

Alternatively, you can fill in the field on the budget lines (if billing integration is available there).

If this field is filled in, the system creates separate documents when you set up a sales document or an

invoice suggestion for the WBS.

Note
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Requires the Milestone, No. of Predecessors and Predecessor Position Nos. fields, which specify WBS line dependencies.

Predecessors can be assigned to WBS lines that were selected as milestones, and you can enter more than one predecessor on

each line manually. Running this function then fills in the Predecessor Position Nos. field for informational purposes.

Update Totals and Unbilled Work

Refreshes the totals and the Unbilled Work value if, after opening the WBS, you have made changes to the structure—for

example, by posting something or by creating an invoice. Continuously updating the data stored on a WBS isn’t a sensible

strategy for performance reasons.

Entries are updated, however, each time the structure is reopened.

Create Sales Document

Creates a sales quote or order from the WBS.

You can specify the information you want transferred to the document in the Copy to Sales Doc. field on individual lines. You can

select there whether to copy values from the WBS line, transfer information from its budget lines, or ignore the line altogether.

Create Purchase Document

Helps with project purchases. You can create both requisition worksheets and purchase orders from the WBS to procure the

items and external services that you specified in the project budget. For more information, see External Resources.

Create Project Shipment

For more information, see Project Shipments.

Create Project Vendor Shipment

For more information, see Project Vendor Shipments. 

Create User Task

Creates user tasks associated with the current project. The function connects a task to the project through the TableRelation

property and Record.Relation method.

Copy WBS

Copies a structure from the same or another project.

Budget values from the WBS template can be copied as well. This function is mainly intended for the creation of new WBS

versions. We recommend that you set up new projects from a project template.

You can transfer an entire WBS or only selected lines. To copy a group of lines, turn on the Selected Lines Only toggle, and then

choose OK to specify the lines you want transferred. You can also use this option to copy part of the current WBS onto itself.

If you transfer to a WBS that already has lines, the new lines are moved to the end of the structure. However, you must turn on

the Auto PTS Code toggle in Projects Setup to ensure that the function creates unique work package lines in this case.

Copy WBS is most often used to create a new version of a work breakdown structure so that an ongoing project can be frozen.

The new WBS is based on the same up-to-date values as the old one—except for project budget entries, which need to be

managed separately. For posted ledger entries, only a relation is created.

A WBS line can no longer be deleted after you have posted something to it. For data security reasons, this remains true even if

the related work breakdown structure was copied by mistake, and the line must be set to Finished instead.

Copy from Budget

Copies to a WBS line the values from its budget lines, in effect totaling them at the work package level.

This function is only used on lines on which the Copy Budget field has been selected.

Update Project Account Entries
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Updates project account entries. If you change quantities or prices on WBS lines, the budget entries used to monitor the project

will change as well.

This action is also available unfiltered on the projects list.

WBS Incl. Budget View

Shows the entire WBS in detail. For more information, see WBS Incl. Budget View.

Statistics

Shows the WBS budget from two different perspectives.

The WBS Budget FastTab indicates the values stored on all WBS lines by adding up their Total Price and Total Cost fields.

The values entered on budget lines, on the other hand, are shown on the Detailed Planning FastTab, where they’re broken down by

budget type. Any WBS line without dedicated budget lines, that is, with no detailed plan, will not be included here. The values on

this tab are identical in content to the sum of the project's Budget Lines Total Cost and Budget Lines Total Price fields.

Comments

Shows comments about the WBS. You can also use this action to create new ones.

Documents

Shows all open and posted documents for the project.

You can view a document by selecting an entry from the list.

Budget vs. Actual

Compares project targets to actuals.

For more information, see Budget to Actual Comparisons.

Project Account Entries

All budget values entered in projects are turned into project account entries. Stored with the chart of accounts, these values can

be used to perform additional analyses based on a variety of criteria and your own methods of tracking project progress.

The function considers all account entries in each WBS version related to the current project. Like in finance, however, posting

procedures must be set up in advance.

Line actions Work Package Card

Provides detailed information about a WBS line. For a better overview, the data is arranged into FastTabs, with a subpage

showing the related budget lines.

The aim of the card is to make it easier for you to maintain the wide variety of field values available on each line of the structure.

The card also provides you with all the actions that can be run on single WBS lines (and not the structure as a whole) so that, for

example, you can see what texts and comments were added to the line or retrieve values from the project budget.

Move Line

Rearranges WBS lines. You need to select a line before you run this function. Once you have started the process, you need to

choose OK to see a list of all lines related to the current project.

On this list, you can then decide above which line you want to insert the one that you selected at the beginning. To move it,

choose Yes again.

Afterward, you must run the Assign Position Nos. function to ensure that all position numbers on the WBS are in the right place.

Change Dates

Moves the starting and ending dates of a WBS line by a period of your choosing. 

Formula Calculation

1. 

2. 
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Specifies what other WBS lines you want the system to use for determining budget values on the selected line automatically. You

can specify a formula as early as creating a project template.

Fill in the Use as Calc. Base and Use as Calc. Base (Total Price) fields if you want the calculation of the Budget Lines Total Cost

and Budget Lines Total Price on the line to be based on different sets of values.

You can then enter a percentage in the Share to Allocate % and Share in Total Price % fields, for example, to cover a scenario

where maintenance costs stored on a WBS line were determined to be 15 % of the total value that you entered on two other lines

representing the cost of production and procurement. 

You can also specify in the Auto Assign New WBS Lines to Purchase Calc. and Auto Assign New WBS Lines to Sales Calc. fields

whether you want to link every other part of the WBS in this scenario to a special line that you set up for this purpose while the

entered formula will be used on new lines automatically.

Skills

Stores qualifications needed to fulfill a work package. These can be set up as early as creating a project template.

The skills are later used to filter for suitable resources when you run the Assign Skill-Specific Resource function.

Dimensions

Shows the dimension values assigned to the selected WBS line.

Work Package Info

Shows the documents that contain the work package of the project.

To open a document, select an entry from the list.

Interaction Log Entries

Shows entries that are generated when you create interactions.

If you turned on the synchronization feature to update a project from sales documents, you can choose Related > Project > Sales

Doc. Project Budget Change Log to see a list of all changes made to interactions.

Texts

This action provides the following options:

Beginning Text / Ending Text

Beginning and end texts are copied to project sales documents, on which they can also be printed. Whereas beginning texts are

printed before sales lines, end texts appear after the lines.

Comments

Stores line-related comments.

None of these comments are copied to documents created from the WBS.

Budget lines

WBS lines help you create a project budget. You can later compare the target values on these lines to the actual numbers that

are being generated over the course of the project.

You can also budget a project in detail. This means that you can allocate the quantities required for project completion to the

lowest planning level, where you assign them directly to resources or resource groups, items, or G/L accounts.

Some of the values are then also used as a basis for scheduling capacity, for example, when you later assign a task to a certain

staff member.

Note
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Although each time you budget, only a single work package is involved, you can open a special page to get an overview of the

budget lines set up for all project-related packages. For more information, see WBS Incl. Budget View.

Use budget lines

To be able to use detailed planning in a meaningful way, you might need to adjust the WBS line that you want to create budget

lines from.

Copy Budget

Select this field on the WBS line so that you can copy to it the sum of all values from the Total Cost and Total Price fields on the

associated budget lines.

If the WBS and its budget lines use the same unit of measurement, the system also transfers all planned quantities from the work

breakdown structure to the budget view to show the average total cost or price.

Copy to Sales Doc.

Specify if the WBS line or one or more budget lines should be copied to a sales quote, a sales order, or a sales invoice.

Regardless of the option you choose in this field, you can still record expenses, for example, from time tracking, on the WBS and

the budget lines.

Set up budget lines

To create budget lines:

Open a project card.

Choose Project > WBS Incl. Budget View on the ribbon. If you’ve already opened a work breakdown structure without the view,

choose Related > WBS Incl. Budget View on the header.

You can also open a WBS without a budget view first and choose Related > Budget Lines on the WBS Lines FastTab.

1. 

2. 

3. 
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The fields found on budget lines are described in the following table.
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Field Description

Budget Type Specifies what is being budgeted on the line.

Resource

Includes in the budget a resource that is not a billing resource.

Item

Covers materials and finished goods.

Group (Resource)

Includes a resource group in the budget. This group can later be replaced with a specific resource.

G/L Account

All costs not covered by the previous categories are budgeted with the help of G/L accounts. You can

use any account for this provided the Direct Purchase on the related G/L account card is turned on.

No. Specifies the number of a resource or a resource group, an item, or a G/L account, depending on the

option selected in the preceding field.

Item Reference

No.

Contains a reference assigned by the customer to help you find a specific item.

Starting Date Shows the planned start of the line. This field is filled in from the WBS line but can be changed

manually.

Ending Date Shows the planned end of the line. This field is filled in from the WBS line but can be changed

manually.

Description

Description 2

These fields describe the item, resource, or account entered on the line. The descriptions are copied

from a table containing base data (for example, the Item table) but can be changed manually.

Both are also copied to sales or purchase quotes or orders that you create from the structure by

running the Create Sales Document or Create Purchase Document action—unless you also fill in either

the Description and Description 2 in Sales or Purchase fields.

Description in

Sales

Description 2 in

Sales

These fields contain alternate descriptions for use in sales.

They specify notes that are shown to customers so that you can use the standard description fields for

internal comments.

When you enter an item or a resource on the budget line, translations that exist for the item or

resource are copied to these fields by default.

You can fill in the fields as early as creating a project template or edit the descriptions here manually.

Description in

Purchasing

Description 2 in

Purchasing

These fields contain alternate descriptions for use in purchasing.

They specify notes that are shown to vendors so that you can use the standard description fields for

internal comments.

When you enter an item or a resource on the budget line, translations that exist for the item or

resource in the vendor’s language code are copied to these fields by default.

You can fill in the fields as early as creating a project template or edit the descriptions here manually.

Language Code

(Vendor)

Shows the language code of the vendor entered on the budget line.

The code is used to find item or resource translations for filling in the Description in Purchasing and

Description 2 in Purchasing fields.
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Field Description

If changing vendors also leads to a change in languages, the system will search for translations in the

new language. You can then decide which of these should be copied to the budget line.

Work Type Code This field is filled in from the WBS line if you select Resource as the budget type on the line. It cannot

be used for items or G/L accounts.

Work types are used to post consumption and sales, for example, to a project, a resource journal, or a

sales document. They specify the kind of work a resource can be tasked with, such as overtime or

transportation.

Depending on the work performed, the types can help you in setting up a variety of prices and units of

measure for the consumption and billing of resources and resource groups.

Copy Budget Text

to Purch.

If this field is selected, the system copies all budget text (lines) to purchase orders that you create

from this line.

Copy Budget Text

to Sales

If this field is selected, the system copies all budget text (lines) to sales documents that you create

from this line.

Customer Price

Group

Specifies the code of a customer price group.

Quantity Specifies the quantity planned for the line.

If you press Enter to confirm the quantity in this field, project budget entries are created

automatically.

Quantity (Base) Gives the quantity in the base unit of measure.

This field cannot be changed manually, as quantities are budgeted in the unit of measure specified for

the Quantity field.

Reserved Quantity Shows the item quantity reserved for this line.

The quantity is reserved through a purchase requisition workflow that includes all budget line items

the Requisition checkbox is selected for.

Requisition If this field is selected, the item on the line will be requisitioned during a planning run.

Buy-from Vendor

No.

Shows the vendor from an item card (or a resource card in the case of an external resource).

This field is filled in automatically if you select Item or Resource in the Budget Type field but can be

changed, if necessary.

It can later be edited again should you run the Create Purchase Order function from the WBS.

Qty. on Purch.

Quote (Base)

Shows the quantity available on purchase quotes related to this line (a link to the field is created when

you use the Create Purchase Document action to make project purchases).

Qty. on Purch.

Order (Base)

Shows the quantity available on purchase orders related to this line (a link to the field is created when

you use the Create Purchase Document action to make project purchases).

Qty. Received

(Base)

Shows the line quantity already delivered by the supplier.

Usage Qty. (Base) Shows the quantity consumed on the line.

Quantities from posted project ledger entries are shown in this field regardless of their source. This

means they might originate with a project purchase, stock consumption (for items), or a time posting

(for resources).
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Field Description

Outstanding Qty.

(Base)

Shows the result of subtracting the quantity planned for the line from the quantity consumed on it so

far.

Unit of Measure

Code

If you select Resource or Item as the budget type, this field is filled in with the base unit of measure

specified on a resource or item card.

The field can be changed for items but not for resources, as the unit of measure of a resource depends

on the work type that you choose for the resource.

Location Code Shows the code of the location where an item entered on the line is stored.

You can choose the lookup to the right of the field to select a code from the Location page.

Bin Code Shows the code of the bin where a possible line item is stored. To make use of this field, you must

select a location on the line.

Variant Code Specifies an item variant.

Direct Unit Cost

(LCY)

Shows the direct unit cost as calculated by the pricing functionality for a resource or a resource group,

an item, or a G/L account when the No. field has been filled in.

You can, however, change this field manually, if necessary.

Unit Cost (LCY) Shows the unit cost as calculated by the pricing functionality when the No. and Type fields have been

filled in.

You can, however, change this field manually, if necessary.

Note

If you change the Direct Unit Cost (LCY) on a resource line, the value in this field is recalculated based

on the group of indirect costs specified for the resource (if available).

Total Cost (LCY) Shows the result of multiplying the quantity with the unit cost.

This field is part of the Project Budget Entries page and is copied from there.

Invoice Qty. % If the Billable checkbox is selected and the associated WBS line is invoiced by time and materials, you

can specify here how much of the line activity you want to bill.

For example, instead of 100, you can enter 50 if you want to bill only half of the work performed on

this line to the customer.

After you fill in the field, the quantity to bill is determined from the value entered in the Quantity field.

Unlike clearing the Billable field on the line, setting this quantity to 0 means project ledger entries

that are not invoiced are still shown on proof of performance documents with the actual quantities

worked.

A later change in the value of this field will not affect ledger entries that already exist.

Billable Specifies whether the time and materials entries that you want to set up for the line can be invoiced to

the customer if the associated WBS line is billed by time and materials. This means that you need to

clear the field if you do not want the created project ledger entries included on proof of performance

documents.

A later change in the value of this field will not affect project ledger entries that already exist.

Invoice Unit of

Measure

Specifies the unit in which invoice quantities will be budgeted.
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The FactBox that appears on the page at the bottom (when you use the Budget Lines action) or on the right (when you choose

WBS Incl. Budget View) shows you the total resource, item, and budget line costs and prices that have been posted directly to G/

L accounts from the lines.

Calculate unit prices

Field Description

The base unit of the item is filled in automatically here, although you can change the unit, if necessary.

You cannot change it for resources, however, as theirs depends on a work type.

Invoice Qty. This field can be filled in if the customer receives sales quotes and invoices for quantities that differ

from budgeted expenses.

In all other cases, the line quantity and the quantity to invoice will be identical.

Invoice Qty. (Base) Gives the quantity to bill in the base unit of measure. You cannot change this field manually.

Note

The quantity is budgeted in the unit specified in the Invoice Unit of Measure field.

Unit Price Shows the unit price specified for a resource or a resource group, an item, or a G/L account as stored

on the relevant card or as set up for the project.

You can also fill in this field manually.

Line Discount % Like the Unit Price field, shows a value from a card or a project-specific price.

This field cannot be changed manually.

Line Discount

Amount

Filled in based on the line discount in percent. This field cannot be changed manually.

Total Price Shows the result of multiplying the invoice quantity with the unit price. The field is also used to create

in the background project budget entries that match the calculated value.

Custom Unit Price Specifies if a unit price has been changed manually.

This ensures that the price entered on the line is not replaced when a price-relevant field, such as Date

or Resource No., is changed.

You can select and clear the field to control when to update the price. However, some field changes

require a price update even if this field is selected. For more information, see Custom Unit Prices.

Cost Center Code Specifies the first global dimension to which the line is assigned.

This field is filled in automatically with the dimension specified for a resource, an item, a work

package, or the project itself. It is also renamed to match the name of the dimension that is chosen.

You can change the field, if necessary. To see the codes set up for the dimension, use the lookup to the

right of the field.

Cost Object Code Specifies the second global dimension to which the line is assigned.

This field is filled in automatically with the dimension specified for a resource, an item, a work

package, or the project itself. It is also renamed to match the name of the dimension that is chosen.

You can change the field, if necessary. To see the codes set up for the dimension, use the lookup to the

right of the field.

The FactBox that appears on the page at the bottom (when you use the Budget Lines action) or on the

right (when you choose WBS Incl. Budget View) shows you the total costs and prices for resources, for

items, and for budget lines posted directly to G/L accounts from the lines.
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Typically, a unit price is copied from a price list or entered manually on a budget line. The third option is to have the price

calculated based on the unit cost entered for the item. You can then add up to three surcharges or reductions to the total.

For this purpose, you need to unhide certain fields on the budget lines and fill them in as described in the following:

Field Description

Unit Cost (LCY) Specifies the base value that will be used to calculate the unit price. You can change the value

manually if necessary.

Calc. Extra 1 % Specifies the first calculated surcharge or reduction on the unit cost in percent.

Factor 1 Specifies the first calculated surcharge or reduction as a factor on the unit cost.

Calc. Extra 1 Specifies the first calculated surcharge or reduction in local currency.

Base Amount for

Calc. 2

Specifies the base of the second surcharge or reduction according to what is entered in the Unit

Cost (LCY) and Calc. Extra 1 fields.

Calc. Extra 2 % Specifies the second calculated surcharge or reduction on the base amount in percent.

Factor 2 Specifies the second calculated surcharge or reduction as a factor on the base amount.

Calc. Extra 2 Specifies the second calculated surcharge or reduction in local currency.

Base Amount for

Calc. 3

Specifies the Unit Cost (LCY) without surcharges or reductions as the base for the third calculated

charge.

Calc. Extra 3 % Specifies the third calculated surcharge or reduction on the unit cost in percent.

Factor 3 Specifies the third calculated surcharge or reduction as a factor on the unit cost.

Calc. Extra 3 Specifies the third calculated surcharge or reduction in local currency.

Unit Price (LCY) Shows the result of combining the Unit Cost (LCY), Calc. Extra 1, Calc. Extra 2, and Calc. Extra 3

field values.
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If the unit cost and unit price are retrieved by the price function, the difference between cost and price is entered as Calc. Extra 1 on

the budget line; manual changes to either will update the extra calculation value. See the following for an example of how all three

values are used:

Charges 1 and 2 are added one after another, whereas charge 3 is added independently.

If a budget line of type Item or Resource uses the same extra calculation values for a project, you can also fill them in on the Project

Budget Calculation Defaults page. If you enter a new item or resource line for the project, the Calc. Extra 1, 2, and 3 values stored

there are then entered on the line by the system. With the unit cost filled in, the automated unit price calculation is also started right

away.

Custom unit prices

The FactBox on the right of the page shows the total costs and prices for resources, for items, and for budget lines directly

posted to G/L accounts from the lines.

The resource section also includes the total number of hours spent on project activities, as seen on the related WBS line.

Note

Unit Cost (LCY) 100

Calc. Extra 1 % 10

Factor 1 1.1

Calc. Extra 1 10

Base Amount for Calc. 2 110 [100 + 10]

Calc. Extra 2 % 15

Factor 2 1.15

Calc. Extra 2 16.50[15 percent of 110]

Base Amount for Calc. 3 100

Calc. Extra 3 % 20

Factor 3 1.2

Calc. Extra 3 20

Unit Price (LCY) 146.50 [100 + 10 + 16.50 + 20]

Note

Budget Type Type No. Quantity Work Type Starting Date

Resource

Group

Type changes

from one

resource to

another: No

Changes to

item or G/L

account: Yes

No Yes No

Item Yes Yes No n/a No

G/L Account Yes No No n/a No
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Additionally, all sections show the discounts for the relevant budget type, the profit, the profit in percent, and the actual amounts

in local currency.

Line activities

For rough planning, budget lines can be assigned to resource groups. This kind of budgeting includes the expected number of

hours it will take to complete a certain work package.

However, budget lines can also be used to assign project activities to specific resources or their groups. By providing a detailed

structure for activities, these lines are then no longer just planning lines but also contain budgeted activities, which resources

and resource groups can use to record the time they spent on the project.

A unique number is assigned to each activity from the series that was chosen for this purpose in Projects Setup. This number

cannot be changed manually.

Basically, line activities provide you with a highly granular project budget. Whereas the rough planning capabilities provided by

the system might be sufficient in the early stages of a project (while quoting and costing), long-term projects in particular might

become increasingly difficult to manage over time.

In this case, you can use the Split Line action to create a resource-specific activity from a budget line that belongs to a resource

group. If you cannot assign a certain activity to a specific resource, it can also remain with the group.

To see all activities for a certain project:

Open a project card. 

Choose the Search icon, enter Budget Line Activities Overview, and then choose the related link.

1. 

2. 
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The fields required for line activities are described in the following table.
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Field Description

Line Activity No. Consecutive numbers are assigned to activities performed by a resource or a resource group on

budget lines. As a result, each activity number created within a company is unique.

This field is filled in with a number from the relevant series entered in Projects Setup and cannot be

changed manually.

Priority Indicates task priority. This field is used for informational purposes only.

Status Shows how far the line activity has progressed.

Each new activity is set to Not Started. The status changes to In Progress when you post to the

activity for the first time.

Employees can use only these statuses to post work hours; activities in a different status aren’t visible

to them in time tracking.

An activity is set to Completed when the resource working on the activity reports it as completed. All

other statuses are set by the project manager, who can also reset a task from Completed to In

Progress so that it can be posted to again.

Note

Budget lines of type Item or G/L Account are set to In Progress automatically when consumption is

posted for them. The project manager can also change their status manually.

When an attempt is made to set these budget lines to Completed, the system will check for unfulfilled

commitments (reserved and open quantities, as well as open purchase, time, and inventory

commitments) to ensure that the lines can still be posted to. If the check fails, the lines cannot be set

to Completed.

Completion % In time tracking, staff can record the progress of their activities in percent or by using the Qty. to

Complete field.

Filling in one of these fields will fill in the other field on the budget line, as well as the Estimated Total

Qty. and Estimated Total Amount (LCY) fields, based on the budgeted quantity and the hours posted

by staff, that is, the values in the Usage Qty. (Base) and Time Commitment Qty. (Base) fields.

Quantity Shows the quantity budgeted for the line activity.

Usage Qty. (Base) Shows the hours spent on the activity and released by the project manager.

Time Commitment

Qty. (Base)

Shows the hours posted to the project but not released by the project manager.

Qty. to Complete Shows a quantity that was calculated automatically, as in the Completion % field, or was entered by

an employee in time tracking.

Estimated Total

Quantity

Shows a quantity calculated automatically. See the Completion % field.

Estimated Total

Amount (LCY)

Shows a quantity calculated automatically. See the Completion % field.

Profit

Profit %

Shows the profit margin budgeted for the activity.

Current Profit

Current Profit %

Shows the current profit margin for the activity. This field is only used if, in addition to expenses,

sales are posted to the line.

Sell-to Customer

No.

Shows an invoice recipient who isn’t the customer of the project. A recipient can be entered but only

if you selected Budget Lines in the Billing integration field as the level at which to create sales

documents.
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Find Budget Line Activity

To find a budget task by its task number in all projects, use the budget task search. You can call up the search either via the user

search or the role center of project processing.

Enter the task number and start the search function, which will search in the active work breakdown structures of all projects. If

a match is found, the budget line card opens. If the inactive WBS versions are also to be searched, this can be activated via the

corresponding switch.

This is useful if different WBS versions contain different budget tasks, for example because completed tasks are not transferred.

If a budget task appears in several WBS versions of the project, a selection list is displayed.

Actions Explode BOM

Adds a line for each component of a bill of materials that has been assigned to the budgeted work package on the Work Packages

page.

You can use this function for more than one work package line at the same time by selecting multiple lines on the upper part of the

WBS Incl. Budget Lines page.

Explode Assembly BOM

Adds a line for each component of an assembly bill of materials assigned to an item on a budget line. This involves removing the

original budget line and distributing the component quantity across the new lines.

Allocate Qty

Distributes the line quantity evenly over the period between the starting and ending date entered on the line. You can choose

whether you want the quantity distributed across weeks, months, or a day. A default interval can be specified in Projects Setup.

The budget entries set up for the project are adjusted when you run this function. This means that a quantity of 20 is broken up

into quantities of 10 a month over a period of two months.

Split Line

Assigns to a resource part of a line activity that has been roughly budgeted for a resource group. In other words, you can use this

function to divide a task into two and distribute the quantity entered for it among different resources or change data in other

ways (by entering a new completion date, for example).

For a better estimate of how much work can be split off, the function will list all line-related quantities. After you have specified

in the New Type and New No. fields the resource or resource group to whom a portion of the task should go, you can enter a

quantity in either the Distributed Qty. New Line field or Remaining Qty. Old Line field, with the system filling in the value in the

other based on the total quantity budgeted on the line.

You cannot increase a line quantity in this way but must do so following the split.

To have the system assign identical numbers to both the old and the new line, turn on the Keep Line Activity No. toggle before

you choose OK. This might be useful, for example, if a line pairing needs to be considered in combination at some future date.

Field Description

If this field is filled in, the system will create separate documents when you create a sales document

or an invoice suggestion for the line.

Note

Note
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If you fill in another starting date, the Recalculate Prices toggle is turned on automatically on the new line so that the associated

unit costs or prices are recalculated.

If the resource or resource group on the new line differs from the resource or group entered on the source line, the unit costs or

prices are recalculated in any case.

Change Work Package

Copies the budget line, and entries posted to it, to another WBS line. To move more than one budget line, you can select multiple

lines on the upper part of the WBS Incl. Budget Lines page and run the Change Work Package Multiple function.

Moving a budget line in this way might lead to a change in prices.

Update Total Cost (=Moving Average)

The more time a budgeted task needs, the more likely it is that you will see an increase in the costs of items or services required

for its completion.

One solution to keeping costs up to date is to split the relevant line activity so that you can enter a new cost value on a second

budget line. As an alternative, you can also run the Update Total Cost function to change costs mid-project.

To be able to run this function, the budgeted quantity that you want to change the cost for needs to be available across the

planning period set on the budget line.

In other words, before you can update costs, you need to create project budget entries with the help of the Allocate Qty. or 

Allocate to Dates action so that the task quantity is distributed across the period between the starting date and the ending date

found on the budget line. You also must have entered the new unit cost with a starting date on all price lists related to the line.

When running the update function, you can then decide from when you want project entries to be updated. This field is set to the

work date by default so that the system updates all budget entries created on or after that date (but you can change the filter, if

necessary).

After you choose OK on the request page, the system recalculates the costs of all project budget entries in the filter period and

copies the new unit cost to the specified line.

Example

On 01/01, the cost of an item that you need for a year-long project is USD150. The item is budgeted with a quantity of 12

throughout the year, with one item expected to be bought per month. In total, that makes USD1800.

Starting on 10/15, however, the cost increases to USD170. But you’ve known about that increase since 05/08, so you enter

‘05/08..’ in the Date field.

When you run the function, the previously budgeted unit costs remain in effect from 01/01 to 10/01; only those specified for

11/01 and 12/01 are updated by the system to USD170. This results in a new total cost value of USD1840 and a unit cost of

USD153.3333, with the latter being copied to the budget line.

Note

Note
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Additionally, the following fields are updated on the line:

After the function is run, the unit cost on the budget line can no longer be changed manually.

Order Tracking

Checks if line demand is met, for example, by a purchase order.

Running this function opens the Order Tracking page, where you can see the supplier who meets demand originating from the

budget line. This line, in turn, can be seen by choosing Order Tracking on the related purchase order.

Search for Attributes

Searches for items based on certain attributes, a feature also available on purchase and sales documents.

Send to Calendar

Sends a line activity as an Outlook task to a staff member.

This function requires that a valid email address has been stored for the employee (resource) in User Setup. After you hit Send,

the employee receives an email with a calendar event and the relevant

Line Activity Description

Starting Date

Ending Date

Project No.

Line Activity No.

Project Manager Name

Customer Name

(Customer) Company Phone No.

If a line activity is canceled or put on hold, the calendar task is deleted from Outlook automatically.

Change Dates

Reschedules a budget line.

When you run this function, you are asked to specify by way of a formula the amount of time that the line should be moved up or

back.

The formula must include at least one mathematical operator and a time expression such as D = day(s), W = week(s), M =

month(s), Q = quarter(s), or Y = year(s).

A message appears if you make an incorrect entry, explaining the reason why.

Field Value

Moving Average Specifies whether the unit cost has been updated over the course of the project.

Unit Cost Updated

On

Specifies when the Update Total Cost function was last run.

Unit Cost Updated By Specifies who last updated the cost.

Last Unit Cost Shows, based on the starting date, the most recent unit cost that the budget entry was updated

with.

In our earlier example, the value in this field would be 170.

Note

• 

• 

• 

• 

• 

• 

• 

• 
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You can use this function, for example, to adjust a project budget because of a change in shipping dates for the project. The

starting and ending dates of the affected budget lines are then edited automatically to match the new schedule.

Allocate to Dates

Opens a matrix that shows the budget lines set up for the project, with activities broken down on each line based on the interval

you chose in the Period field on the header. All project work is initially put on the starting date.

You can use this matrix to budget quantities in detail, specifically at the budget entry level, that is, you can schedule quantities

for resource and item lines on the calendar in steps that go from 24 hours to a year.

Each time you assign a budgeted quantity to a resource or an item in a calendar field on the page, the system will create project

budget entries. These entries are the smallest elements of a project budget and the basis for planning resource capacity (see 

Capacity Planning).

Change Type & No

Allows some flexibility in planning. Typically, you can change the Type and No. fields until hours have been posted to a budget

line.

To move a resource from one line onto another, you can simply change the No. field on the lines themselves. However, to move a

line from a resource group to a specific resource, you must run this function for technical reasons.

After hours have been posted, you need to use the Split Line action to assign part of a quantity to a new line type and number.

Reserve

Creates a reservation on the line for tracked supplies, for example, from inventory or a purchase order.

Take

Assigns stock to the project from non-reserved quantities. Stock that has been assigned previously can be identified by its filled-

in Project No. field. This function can only be run from item-type lines.

Running the function opens a page on which you can see the project inventory items you specified on the line and assign new

item entries. Entries you want to remove from a location entered on the line must contain a positive value and be open.

Moreover, the entries cannot be reserved or assigned to a project. You can clear the project number filter should you want to

move items from one project to another.

You can then specify how many items you want to remove from the warehouse. The number of items you take can, of course, not

exceed the total number held onsite.

Choose OK to post the selected quantities to project inventory. A reference to the project (or, more specifically, to the budget line)

is then added to each item entry that you move in this way. Afterward, you need to create a project shipment to post consumption

of the item while removing it from the stock assigned to the project.

Assign Project Ledger Entries

Typically, when you post usage for a project, the number of the budget line from where consumption originates is assigned to the

related project ledger entries automatically.

Sometimes, however, a number might need to be assigned manually, for example, if you entered an item on more than one

budget line created from the same WBS line.

You can then use this function to assign all project ledger entries stored on the WBS line to the budget line provided one of the

following criteria is met:

If a resource has been stored on the budget line, consumption entries must refer to the same resource.

If a resource group has been stored on the line, consumption entries must refer to the same resource group (with the resource

for whom consumption is posted being a member of that group).

If an item has been budgeted on the line, all entries must refer to the same item number.

If a G/L account has been budgeted on the line, selected G/L account lines must refer to the same account.

• 

• 

• 

• 
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Connect

Assigns all selected entries.

Disconnect

Deletes existing assignments (as indicated in the Budget Line No. field).

Card

Opens the line activity card.

Item Availability

Provides multiple item availability lists designed for the same purpose and function as those used for sales documents.

Dimensions

Shows the dimensions assigned to the line.

Reservation Entries

Shows the items reserved for the line.

Predecessors / Successors

Assigns predecessors or successors, or both, to work scheduled on the line.

Beginning Text / Ending Text

Specifies line-related texts, which can be copied to sales or purchase documents.

Comments

Stores internal comments regarding the line.

Navigate to Line Activity

Indicates where a line activity is being used.

Line activity numbers are stored on purchase and sales documents, with project ledger and time entries, on CTC lines, and in

time sheets.

Resource by Project

Shows the budget entries created for the WBS and resource. Making another WBS the active structure will change these entries

on printouts.

Choose the lookup if you want to see more details on an entry. You cannot edit the entry on that page, however.

Resource Group by Project

Identical to Resources by Project, except that this function filters for resource groups, not individual resources.

Capacity Plan

Shows the capacities assigned to resources. You can fill in the fields on the Options FastTab to filter for a specific resource if

necessary. The page includes all capacity-related values stored on the active WBS. For more information, see Capacity planning.

Assign Skill-Specific Resource

Copies resources with certain qualifications to the budget.

This function requires that you have assigned skills to the relevant resources. These skills can then be assigned to work

packages, that is, WBS lines, or you can set them as filters manually. Resources are indicated with their capacity values,

including their overall capacity, their times of absence, and their quote and order entries.
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For a quick and easy way to include resources in a budget, you can select a resource, navigate to the Values FastTab, and then

choose Manage > Quick Assignment on the ribbon. Afterward, you can use the budget lines to plan a resource’s capacity in more

detail, for example, by entering quantities.

You can also choose Detailed Assignment on the same ribbon to open a page where you can budget resource hours per week.

WBS Incl. Budget View

This function shows the active work breakdown structure of a project in combination with the budget lines set up for the project.

Information about the structure itself can be found on the header, whereas the other parts of the page show text lines, comments

and, most of all, the budget lines set up for a WBS line. All entries always relate to the currently selected WBS line.

The line statistics on the right show the planned resource quantity, key values broken down by budget type, and the total cost

and price of the WBS line. Budget entries are added up under Budget Line Total. You can compare these to the values found

under WBS Line, which allows you to immediately spot differences in amounts between the work breakdown structure and the

detailed budget.

The Usage section, on the other hand, indicates usage based on total cost and price, whereas Billings shows the amount invoiced

so far and the amount that you have yet to invoice to the customer based on project progress and the billing type of the WBS line.

The actions on the WBS Incl. Budget Line page are the same as those described for the individual WBS and Project Budget

pages.

Main WBS

To track the impact of additive and deductive change orders on initial cost estimates, you can create what is called a main WBS.

This involves setting up non-active versions of a structure so that you can log negative and positive adjustments to a project.

When you release those versions, their values are then merged and transferred to a WBS version that serves as the main—and

active—structure for the project.

This feature can only be used to copy values changed on WBS lines; detailed schedules with budget lines must be created from the

main WBS.

Set up a main WBS

Choose the Search icon, enter Projects Setup, and then choose the related link.

On the Project Management FastTab, fill in the fields described in the following table.

Main WBS

This toggle shows whether a structure is used as a main WBS. Found on the WBS header, it turns on automatically if the budget

name specified for the project is identical to the name entered in the Project Budget Name (Main WBS) field on the Projects

Setup page.

Note

1. 

2. 

Field Description

Project Budget Name

(Main WBS)

Select the name of a project budget to specify an active WBS version linked to this budget as the

target structure to which to copy the results of calculations and change orders.

You must fill in this field before you can use the Main WBS feature.

Keep Invoice Qty.

Separate

With the toggle turned on, invoice quantities found on lines copied to a main WBS will not be

totaled but replaced with a quantity of 1. The toggle does not apply to sales amounts and unit

costs.
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You can only see the toggle if you filled in the Project Budget Name (Main WBS) field in Projects Setup.

Copy Structure Only

You can select this toggle when you run the Copy WBS function (found on the ribbon of work breakdown structures).

With the toggle turned on, the function copies the main WBS to a new structure but leaves the quantity fields blank so that you

can edit WBS lines that already exist (see the following example).

Example

You set up a new WBS, enter Default as the budget name, and perform a calculation in one or more versions. None has been

released yet.

After the customer places an order, you set up another structure with a budget called Main WBS, the name entered in the Project

Budget Name (Main WBS) field in Projects Setup. You release the structure and turn on the Active toggle on the header.

You then release the ordered version with the Default budget name so that its lines are copied to the main WBS. (You could have

also run the calculation on the main WBS, but that would have meant no version of the base calculation would have been

archived.)

The result is a released and active structure to which you can post.

Afterward, you set up a WBS for a change order, entering Additive as the budget name. You run the Copy WBS function from the

main WBS and, on the dialog page, turn on the Copy Structure Only toggle to copy the WBS lines without quantities to the new

version. You then specify the details of the change order:

You enter a quantity on an existing WBS line, with a positive quantity representing an increase and a negative quantity a

decrease in what is being ordered.

You add WBS lines and calculate their values.

You keep or delete the WBS lines that remain unchanged from the new version (lines deleted here aren’t deleted from the main

version).

You release the order. The adjustments you made will be copied to the main WBS as follows:

Quantities changed on existing lines will be adjusted.

Lines created on the non-active WBS will be added to the main WBS.

New descriptions will replace the old ones.

Changes to quantities and prices that you made to existing WBS lines will be copied as well. For example, if a line used to contain

100 hours at a rate of USD80, but the change order includes 20 hours at EUR100, the main structure will show 120 hours at an

average rate of USD83.33 following the update.

As a result, the latest changes to the project have now been incorporated into the main WBS. You can view the original estimate

by opening the Standard project budget and the adjustments through the Additive budget.

The Additive budget name can also be reused later to set up another non-active version for an additive change order.

When updating a main WBS, the system always includes all versions of the work breakdown structure. Therefore, none of them

should be deleted. Please also note that manual changes you make to the main WBS will be discarded during the next update.

Capacity planning

Capacity planning can help outline your company’s resource needs by setting limits on the time employees can spent on projects.

Note

• 

• 

• 

• 

• 

• 

Note
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Only after you have set a total number of hours that employees are available overall and assigned part of their daily, weekly, or

monthly capacity to one or more projects will you be able to draw meaningful conclusions from the data presented here.

For more information on how to specify resource availability at the resource (group) level, see View and Set Capacity. Each

resource, or collectively, each resource group, has a limited supply of hours, which you can assign to lines on a WBS. These

hours, the differences between resource availability and utilization, and the demand left for projects can then be shown on a

capacity plan.

Assuming you have specified enough capacity for all resources working on a certain project, setting up such a plan provides a

way for you to quickly implement changes to a rolling wave schedule. The feature also uses a base calendar to account for time

off, such as on weekends and holidays. You can open plans from:

Resources

Projects (Resources > Capacity Plan on the Project Budget FastTab)

Budget lines

Depending on where you run the function from, the Date Filter field might be filled in by default. Resources are shown on a plan

by resource group, with the total capacity of a group being displayed as well. Resources with no assignment to a group will be

the first on the list.

• 

• 

• 
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The following table describes the fields found on every capacity plan.

To export the plan values to an Excel workbook, choose Export to Excel on the ribbon and select a date filter.

Work sequence

Whereas project planning has so far been discussed only in terms of quantities and line values, the following paragraphs will

focus on the scheduling feature that is part of project365. This feature uses starting and ending dates, durations, fixed dates, and

task dependencies on WBS and budget lines to provide you with several options for indicating the time and sequence of project

activities. 

Line dependencies

The relationships between activities are the basis for project scheduling. They can be set up at either the work package or

budget line level.

Field Description

Capacity Shows the capacity entries available for the resource. Total lines are also created per resource group.

Absence Shows a resource's non-work hours based on absence registrations.

Net Capacity Specifies the net capacity of the resource.

Budget (Quote)

Budget (Order)

Show for which project the system has already created budget entries. All data is displayed at the

resource level.

A line added for each project shows how many hours the resource is expected to spend on a project. The

status of the project determines in which of the fields the budget value is entered.

Project Time

Posted

Shows how many hours spent on a project have been posted for the resource.

Utilization Shows the resource’s (target) utilization.

Variance Indicates available resource hours.

Based on how you set up the variance filter, the lower area of the page shows one of the following:

Net Capacity – Budget

Shows available capacity (total capacity less absence, for example, vacation or flextime) minus all

budget values.

Net Capacity – Time Posted

Shows the difference between net capacity and hours recorded so that you can determine whether a

resource is still expected to post time to a project.

Capacity – Time Posted

Same as before, except that you see the difference between how high the total capacity is for the

resource and the hours the resource worked on projects. Can be useful when posting certain kinds of

absence, such as vacation, to a special project.

Budget – Time Posted

Shows the total budget value minus the work hours recorded.

When you change the variance filter, you need to exit the page, choose OK, and then reopen the plan to

refresh the budget values. Reopening it also resets the filter so that values are again shown as described

for the first option.
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To specify how one line activity is related to another based on its type and duration in days, you can use the Assign Predecessor

and Assign Successor actions on the Project Budget or WBS Lines FastTab. The types are modelled after those used for task

dependencies in Microsoft Project.

Duration in Days

In addition to starting and ending dates, you can maintain a duration in days on both work package and budget lines. If you store

this information, starting and ending dates are calculated automatically from the workdays available over the course of a project.

For an example, see the following table, where red means changed by the user and green calculated by the system.

)

Fixed starting and ending dates

You can also set fixed starting and ending dates on both WBS and budget lines.

The values entered in these fields aren’t checked until they are included in a planning run.

Ignore in Planning

Shown on WBS lines, this field can be selected to exclude from project planning work packages that are used solely to collect

receipts, such as for travel expenses and license fees, that is, those for which capacity cannot be budgeted.

Scheduling Direction

In this field found on project cards, you can set the scheduling direction of a project to forward or backward.

WBS Scheduling

Actual scheduling is performed on a separate page. To view the page, open a work breakdown structure and choose WBS

Scheduling on the ribbon.

A schedule shows the WBS and budget lines created for a certain project, as well as the information required for indicating the

start and end of project operations. Activities are planned on both types of lines at the same time.

If a schedule already exists for a WBS, you see a message that asks if you want to overwrite current planning data. Choosing Yes

will delete all entries from the page.

The values shown are used to simulate a requested planning scenario. Following a review and potential revisions to the schedule,

you can choose Accept Planning on the ribbon to copy the data from the page to the related work breakdown structure.

Note
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The simulated entries are stored in the Planned Starting Date, Planned Ending Date, and Planned Duration (Days) fields on a

schedule and can be edited manually. You can identify the status of each entry by its color and style. The following indicators,

explained in the system by way of a legend, are available for this purpose:

Red and bold

Indicates that the scheduled values exceed the starting or ending date of the project (as specified on the project card).

Red

Indicates that, according to the schedule, the line should be in progress, but the work status is still set to Open.

Green

Indicates that the value was changed manually or during a planning run.

Blue

Indicates that the value can be changed neither manually nor during a planning run.

Scheduling a project manually only makes sense after the first automated planning run. However, you can already prepare for

manual entry on the relevant work breakdown structure by specifying the duration, fixed starting and ending dates, and line

activity relationships relevant to your situation, as every automated planning run is based on these WBS or budget line fields.

To start a planning run, choose Start Planning on the ribbon. This puts each WBS line and its budget lines onto the plan based on

the duration, the fixed dates, and the line dependencies set up for the line. The results of the simulation are then entered in the

Planned Starting Date, Planned Ending Date, and Planned Duration (Days) fields.

Depending on what option you selected in the Scheduling Direction field, the system will begin to schedule activities from the

starting date or the ending date entered for the project.

Graphical (line activity) planning

Line activities (budget lines) can also be scheduled by using the integrated graphical resource planner. In graphical planning,

line activities can be dragged on the timeline and onto other resources on Gantt charts.

However, before you can work with this feature, you need to make some settings on the pages described in the following.

Projects Setup

Select Day in the Default Budget Allocation Period field.

Resources Setup

In the Resource Planner Start and End fields, specify the period you want to copy to the chart. Choose a period that you’re

comfortable scheduling with. The longer this period is, the greater its drag might be on tool performance and resource

utilization.

Example

-1W / 2 M means that the data copied to the chart includes all information available for scheduling from the prior week until 2

months into the future.

Resource card

Only resources and resource groups for which the Use in Resource Planning toggle has been turned on will be copied to the

chart. To copy resource capacity, you also must specify at least a planning period.

Line activities

Budget lines must meet the following requirements for inclusion:

The project must have been set to Quote or Order.

The WBS line must have a work status of Open or In Progress.

The budget line must be of the resource or resource group type.

The budget line must be Not Started or In Process.

The budget line must have a starting and an ending date (and at least a 1-day difference between them).

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Absences

Absence registrations are automatically copied over, which means that additional settings aren’t required here.

Open graphical planning

To open the scheduling tool:

Choose the Search icon, enter Resource Planner, and then choose the related link.

Alternatively, open a budget line view. On the Project Budget FastTab, choose Resources > Resource Planner on the ribbon. 

Rough planning

Graphical resource planning starts on the Initial Planning page, with multiple weeks being visible at once.

For performance reasons, resource utilization isn’t shown at this point. Instead, you see an overview of all activities related to a

project. To show resource use, you need to switch to Detailed Planning and choose the refresh spinner.

Detailed planning

On the Detailed Planning page, you can see resource utilization per week. You can also use the ellipsis in the upper-right corner

to show resource deployment during other weeks.

Visual information

On the left of the chart, you can see a list of all project-related resources, broken down by resource group. On the timeline to the

right, bars in different shades of blue show the activities assigned to the related resource or group. Activities that have been

started are in dark blue. Line activities in parentheses belong to a project that is still in the Quote stage.

A yellow background indicates the degree of resource utilization on a given day. An example of an event that lowers daily

capacity is vacation, where yellow is filling out the day entirely.

By selecting a bar, its utilization values will be shown in a FactBox on the right-most side of the view. Areas of overscheduling are

displayed in red.

Hovering the mouse over an activity bar shows a FactBox that describes the activity.

Reschedule

To reschedule activities, you can drag them on the timeline or move them from one resource line onto another.

There is no preview for this function. As a result, the new schedule will be copied to the relevant budget line immediately.

Reduce / extend activity time

You can also use the mouse to reduce or extend the time that a resource will spend on an activity by dragging the ends of the

relevant bar to the left or right.

Filter project

By using the right mouse button on an activity bar, you can open a context menu to set a filter on the activity, limiting the

planning view to a certain project.

Split lines

The Split Line action works in the same way on the chart as it does on budget lines.

Resource planning (without line activities)

In an ideal world, resource schedules would align perfectly with the goals you have for your business. Unfortunately, experience

shows that allocating the right amount of capacity can be a very time-consuming task.

1. 

2. 

Warning
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This is because it might take a while before you can schedule resource hours at the budget line level, that is, at the level of line

activities, and it can take even more time to update these plans regularly.

To provide you nevertheless with a reasonable degree of control over the time that you have available, you can use an alternate

project-based plan that is decoupled from individual activities.

Requirements

Before you can schedule in this way, you must have

set capacities for the required resources.

created one or more projects on which you want them to work.

Setup

Besides the requirements already mentioned, only a few settings might need to be made before you can work with project-level

resource planning.

Resource Planning Setup

On this card, you can specify which fields must be filled in before you can schedule resources for a project. You can also turn on

one or more toggles on the Filter FastTab to set filters on the Resource Planning page. Additionally, you can choose if you or the

resource who will work on a resource request should be notified by email when the request is completed.

If you want to copy absences to planning, you need to fill in the Resource Absence Project Name field on the Planning FastTab.

You can enter any name in this field. The name of an actual project isn’t required, as the label is only used to group absences on

the Resource Planning page.

Planning Types

Planning types help you distinguish between different kinds of resource scheduling. For example, you can use them to separate

the hours budgeted for internal projects from those spent on customer projects.

They also make it easy for you to spot absence, such as the time a certain resource will be on vacation, immediately. You can

specify in which order entries appear on a resource schedule and assign a style to a type on the Planning Types page.

The styles you can choose on the page serve the same function as elsewhere in the system.

Copy absence to resource planning

Resources’ sick time or time off can be copied to scheduling with the help of the Planning Type field, which can be found on the

Causes of Absence page.

Each cause set up with a planning type is copied to the schedule. A shared type is often enough. You only need to create more

than one if, for example, absence due to vacation must be separated from other causes.

On the Resource Planning page, you can then use a ribbon function for the retrieval of non-working time.

This function, called Insert Absence Registrations, can only be found by users who are entered as resource managers in User Setup.

Overscheduling Setup

On this page, you can specify the resources for whom you want to display a warning message in the case of overplanning, that is,

if the work hours scheduled are greater than the resource capacity remaining. You set up the warning for every department to

which resources are assigned.

Resource Planning page

• 

• 

Note
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The core element of project-level resource scheduling is a matrix that shows the number of hours budgeted per week. On the

lines, a schedule can be broken down by project and planning type. The types are shown in different colors (and styles) to make it

easy to differentiate between them.

Options

For a better overview, filters can be set on the schedule. If the user who opens the Resource Planning page has been linked to a

resource, the department assigned to that user is filled in automatically, based on the assumption that schedules created by one’s

own department are of the most interest in this situation.

You can also turn on the No Date Filter field on the header if you want the system to show what resources aren’t included during

the selected period but have been in the past or will be in the future.

Values

This FastTab initially shows one line for each resource scheduled for a project. You can, however, expand the lines section to view

a more detailed breakdown of employees’ work schedules. The columns on the right indicate the number of hours allocated to

the resource for tasks per week.

Resource lines

The resource-type line represents the upper-most level of the section. At this level, the fields on the right show the quantity and

total capacity set for resources during the week specified in the relevant column. This helps you gain a quick overview of their

availability and detect overscheduling.

Planning types

The second level in the hierarchy covers scheduling by planning type. Ideally, these types can be distinguished by their color and

style (see Setup).

Projects

The lowest line level contains schedule items related to individual projects. The lines are in the same color as the planning type

to which they have been assigned.

Requests

The Requested By, Requested On, and Request Type fields at the bottom of the page can be used as a template to create more

schedules.

Actions and overview Insert Absence Registrations

Before you start planning your next project, we recommend that you use this action to copy all current absences to the Resource

Planning page.

Only resource managers see this feature (see User Setup). Transferred absences are updated automatically when you change them

or remove them altogether.

New

Before you choose this action, you need to ensure that you have selected the correct line on the page, as the resource related to

that line will be suggested for scheduling.

When you run the function, the values in the Default FastTab fields are copied to the new schedule automatically. The default

planning period is the current week.

You can then enter a number or a starting date to specify the week during which you want to add the resource to the schedule;

an ending date isn’t relevant here. You can also turn on the Fixed Date toggle if the starting and ending dates that you specified

on the tab should be included when you reschedule project activities. However, the fixed dates can be changed later if necessary.

Note
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On the Base Data tab, you must enter a type and project number; filling in the other fields is optional. A new schedule that leads

you to allocate too much work to a resource in a week will prompt a warning message if you chose this option when you entered

the resource’s department in Overscheduling Setup

Distribute

On this page, you can create several schedules at once. The total budget needs to be entered in the Distributable Hours field.

These hours are then reduced by the amount of time planned on the lines, and the result is shown in the To Distribute field.

Overplanning on this page will prompt a warning message. However, you can choose Yes on the dialog that appears to raise the

value in the Distributable Hours field.

Show Time Available

This function displays for each resource the available capacity per week, calculated by subtracting a resource’s total capacity

from the hours scheduled for the resource in that time.

(Planning) Overview

On this page, you can not only filter planning entries according to your requirements, but you can edit them as well, which

provides you with a quick and easy method for changing more than one entry in resource planning. You can also choose New on

the ribbon to draw up another schedule.

Alternatively, you can run the Overview function from a line on the Resource Planning page to filter entries for a specific week

and resource (and potentially planning types and projects).

General Planning

Creates a regular workload for resources over a longer period, for example, to offset unexpected events.

Planning Resource Matrix

Shows resource planning from the perspective of resources, that is, how many hours have been scheduled for a resource in a

certain week.

You can set filters on the Matrix Options FastTab to see, for example, only the projects a specific resource has been assigned to

work on and at what time.

Project Planning Matrix

Same, but from the perspective of projects. You can again use the filters on the FastTab to see who will work when on a project.

Plan own resource

As a rule, all those with read/write access to resource management can see and edit resource activities in the system. Typically,

however, the task of creating a plan for a week-by-week breakdown of these activities falls to one or more resource managers.

But there are also companies where at least some staff members can set their own hours. By selecting the Plan Own Resource

field in User Setup, these employees not only gain read/write access to scheduling but also prevent other users from adding them

to their resource schedules.

Where am I needed?

This page, which is built into the Project Lead role center, shows logged-in users to which project schedules they’ve been added

over the next three weeks.

Selecting a number on the page and drilling down will then open the planning entries related to a specific project.

Resource requests

Requests for resources are typically created by a project manager. Each request is then forwarded to a resource manager, who

will reserve the hours required based on available resource capacity.

Once scheduling is completed, an email will be sent to the resource scheduled for a project and the person who created the

request (if the relevant toggles have been turned on; see the following).
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Resource Planning Setup (resource requests)

If the project manager or the scheduled resource should be notified by email after a request has been handled by the resource

manager, you must use one or both of the toggles that can be turned on for this purpose in Resource Planning Setup.

Each email sent to the project manager or resource contains information about who has been scheduled to work on which project

task, as well as the effort estimated for completing the activity, and the starting and ending date of work.

Create a request

Project managers can only see requests they’ve created, whereas resource managers see all requests from every department. To

create a request:

Choose the Search icon, enter Resource Planning, and then choose the related link.

Choose Actions > New Resource Request.

Fill in the fields as necessary.

Field Description

Email User at Request Completion With the toggle turned on, the person who submitted the request will be notified by

email upon its completion.

Email Planned Resource at Request

Completion

Selecting Internal in this field will send an email only to internal resources after

requests have been handled.

Choosing All will do so for both internal and external resources.

Sender Address Specifies the email address from which notifications are sent.

1. 

2. 

3. 
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Key fields found on the request page are described in the following table.
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Field Description

Project No. Specifies the project for which a request is made.

Requested Resource No. Specifies the resource requested for the project.

If the field blank is left blank, the Requested Resource Group No. Field should be filled in

instead.

Requested Resource

Group No.

If the preceding field is left blank, a resource group should be entered in this field.

Planner Specifies a resource manager.

You don’t need to fill in this field, as planners retrieve open requests on their own (as described

later).

Planning Department

Code

This field is only filled in if you work with planning departments.

Planning Location Code This field is only filled in if you work with planning locations.

Line Activity No. Specifies a concrete line activity from the project.

However, when you work with resource planning decoupled from line activities, you don’t need

to select an activity here.

Work Package Code Specifies the number of a work package (WBS line) used in the project.

However, resource planning decoupled from line activities requires neither a concrete activity

nor a work package.

Planning Type Specifies the planning type.

This type determines where on the Values FastTab (on the Resource Planning page) the

resource schedule is inserted.

You can use planning types to distinguish between internal and customer projects, for example.

Estimated Effort in Hours

(Total)

The value in this field is probably the most important piece of information a resource manager

requires for scheduling.

Planning Comment This field is typically filled in by the resource manager but can also be used by the project

manager to recommend a certain resource.

Description Describes the requested work so that the resource manager knows what resource might be

suitable for the project.

From Week Specifies the week when a resource should start working on the project. The week is

determined automatically based on the current date.

Example

The current calendar date is part of CW49.

50 = CW50 of the current year

10 = CW10 of the following year

The system will enter the Monday of CW50 as the starting date.

Starting Date Specifies the Monday of the requested starting week.

The date is entered automatically when you fill in the From Week field. Changing the date

manually will also change the value there.
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Once all necessary fields have been filled in, a request can be submitted through the Release Planning function on the ribbon,

after which the data entered on the page can no longer be changed.

A request not yet handled by a resource manager can be cancelled by the project manager at any time through the Cancel

Planning function.

Handle a request

A resource manager (who might not yet be specified as one in the system) begins handling a request by opening it and choosing

Start Planning.

This fills in the Planner field with the resource manager’s user ID and assigns the schedule immediately to the manager’s page

views (by adding the plan to the relevant filter).

On the Lines FastTab, one or more resources can then be allocated throughout the requested period. One line is created per

resource and calendar week.

Example

A line activity is budgeted at 40 hours of work performed by two resources over two weeks, which results in a schedule as

described in the following table.

The page provides resource managers with ample information, including a resource’s current utilization status on calendar week

lines.

Field Description

Note

The starting date must be a Monday.

From Year Specifies the year of the starting week.

To Week Specifies the week when a resource should finish working on the project. The week is

determined automatically based on the current date.

Example

The current calendar date is part of CW49.

50 = CW50 of the current year

10 = CW10 of the following year

The system will enter the Friday of CW10 in the Ending Date field.

Ending Date Specifies the Friday of the requested end week.

The date is entered automatically when you fill in the To Week field. Changing the date

manually will also change the value there.

Note

The ending date must be a Friday.

To Year Shows the year of the ending week.

Fixed Date With the toggle turned on, the request needs to be fulfilled in the time stated.

Resource No. (Calendar) Week Quantity

R100 5 10

R200 5 15

R100 6 15
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The Planning in Requested Period FactBox on the page shows the availability of a resource in the relevant period if a resource

was specified in the request. Additionally, the Show Planning action can be used to open the Resource Planning page from a

request, with all lines already filtered for the staff member. 

After allocating hours to resources and calendar weeks, the resource manager can choose End Planning on the ribbon to finalize

the schedule. The system then creates resource budget entries from the lines and notifies the budgeted resource(s) and project

manager(s) by email.

To suspend planning temporarily and take it up again later, a resource manager can choose Cancel Planning on the ribbon.
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ROLLING PLANNING - DISTRIBUTION

General

The "Distribution" sub-module of rolling planning is explained below. This planning method allows you to see the current project

status and progress at a glance. At the same time, it provides an overview of the future planning process, which minimizes

uncertainties in the planning. The planning can be continuously updated and an automatic distribution proposal can be used if

required.

The distribution module provides an overview of the planned budgeting. You also have the option of customizing the proposed

distribution in order to design the budget control of your project according to your needs.

Rolling planning can be carried out in the same way as a work breakdown structure, both on the WBS line and on the budget

line.

The distribution sub-module can be used independently of the forecasting sub-module, but the two complement each other perfectly.

"Rolling planning (distribution)" is an activation module that can only be used with additional licensing and activation.

Note

Note
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Setup

Projects Setup Distribution
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Field Description

Distribution Active Activate the switch to use the distribution.

Invoicing Distribution Type Specifies the distribution of the billing quantity in relation to the planned quantity. You can

choose from the following options:

Proportional to quantity distribution

If a quantity of 10 and a billing quantity of 20 are planned and distributed, then a 1:2

distribution takes place.

Use up the budget

There is a 1:1 distribution of quantity and billing quantity.

(Adv.) Payment in

Distribution

If a payment plan exists in the project, this facility is used to define whether the billing

quantity in the distribution should be determined by the payment plan.

Color Planning

Color Actual

Color Distribution

Suggestion

The setup fields for the colors refer to the graphs that are currently hidden.

Distribution Chart Type This field determines the graphical representation of the values in the corresponding info

boxes in the quick distribution. The following display options are available:

- Line

- Bar

- Radar

Notification Planning This is used to define what should happen if over- or under-planning occurs. The following

options are available:

- None

- Notification

- Error

Notification excess

Capacity Planning

This field can be used to control what should happen in the event of overplanning. The

following options are available to you:

None

You will not receive any notification in the event of over-scheduling.

Notification

You will receive a notification in the event of overplanning.

Error

You will receive an error message in the event of overplanning. Overplanning is not possible

with this option.

Default Value Distribution

Finish PSP Line

When a WBS line is "Closed", a default value can be defined for the purely informative field

"Distribution of remaining budget", which is automatically filled when the WBS line is closed.

The following selection options are available:

Retrieval

The budget can be called up for requirements at a later date.

Not required

The budget is no longer required.

Redistribution

The budget has been/will be reallocated to other PSP lines.
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Field Description

Update Actual Default If the switch is activated, the actual values in the distribution are automatically updated via

the Codeunit  for the task queue.

Commit Interval Project

Queue Fill Gaps

Specifies how often the changes should be committed. The default value is 500, which means

that the changes are committed (written to the database) after every 500 checked project

budget items.

Archive Planning If the switch is activated, the planning of the project is archived cumulatively once a month

via the Codeunit  for the task queue.

Hide Negative Distribution

Suggestion and Invoicing

If the switch is activated, it is permitted to exceed the budget and plan negatively.

Distribution Entries Filter

WBS Work Status

The filter is used for all actions in which the distribution is updated for several WBS rows.

This allows, for example, terminated or canceled rows to be excluded in order to gain

performance at the point where fewer rows are calculated and updated.

Ignore Invoice Changes on

blocked Sales Budget

If the billing quantity is changed in the distribution while the sales budget is blocked, an error

message appears by default. The switch ensures that this message does not appear and the

changes to the billing quantity in the distribution are ignored.

This only applies if the billing quantity of the distribution differs from the billing quantity of

the budget line or WBS line. As long as the billing quantity remains the same, an error

message does not appear, whether the switch is activated or not.

WBS Work Status Filter in

Fast Distribution

The filter is applied in the quick distribution view.

This makes it possible, for example, to exclude completed or canceled lines in order to obtain

a better overview of the WBS lines to be distributed.

Budget Line Status Filter

Fast Distribution

The filter is applied in the quick distribution view.

This makes it possible, for example, to exclude completed or canceled lines in order to obtain

a better overview of the budget lines to be distributed at this point.

Unit Cost Period

Calculation

If the cost price changes in the budget line or WBS line, this should often not affect the entire

distribution. A “Fixed date” or a “Date formula” can be used to define which distribution

periods should be affected.

Unit Cost Update Starting

Date

If the "Fixed date" option has been selected in the "Cost price period calculation" field, this

field can be edited.

In this field you can enter a fixed date from which the cost price is to be changed.

Unit Cost Update Period

Start

If the "Date formula" option has been selected in the "Cost price period calculation" field, this

field can be edited.

In this field you can enter a date formula from which calculated date (outgoing from working

date) the cost price is to be changed.

Distribution Entries Period

Calculation

So that the distribution does not always have to check all actual postings, the date range can

be limited using a fixed date or a date formula.

Distribution Entries

Update Starting Date

If the "Fixed date" option has been selected in the "Actual distribution item calculation" field,

this field can be edited.

In this field, you can specify a fixed date from which the actual values in the distribution

should be updated.

Distribution Entries

Update Period Start

If the "Date formula" option has been selected in the "Actual distribution item calculation"

field, this field can be edited.

1.2.4 project365

- 703/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Field Description

In this field you can enter a date formula from which date (starting from the working date) the

ACTUAL values in the distribution should be updated.

Date range check actual

values

Specifies a date range that is to be checked beyond the ACTUAL distribution check period 

(previous fields).

For the check, the report "Check postings before date specification" Report 5548341  must be

executed in the task queue. Only projects in which the "Check distribution of actual values"

checkbox is activated are taken into account.

The lines to be checked are then visible in a tile in the Project Manager Role Center.

Update Project Queue

Interval

For large projects, you can specify that they should be updated via the task queue. The

interval specifies how often (e.g. every 2 weeks) this update should be triggered.

Archiving Duration Specifies the duration for which an archived distribution is to be saved.

Delete Archive after

Archiving Duration

Specifies whether the distribution archive should be deleted after the archive duration.

Archiving Interval Specifies the time interval between archiving.

Archiving Interval Past Specifies the period of time for which archiving is to take place in the past.

Archiving Interval Future Specifies the period of time for which archiving is to take place in the future.

Warning at Deviation

(Percent)

Specifies a percentage deviation value for the comparison of archived schedules via the task

queue. From this deviation, the value is output as defined in the "Style deviation warning"

field.

Note

Please note that you can only specify one deviation value (percentage or absolute) for the

warning.

Warning at Deviation

(Value)

Specifies an absolute deviation value for the comparison of archived plans via the task queue.

From this deviation onwards, the value is output as defined in the "Style deviation warning"

field.

Note

Please note that you can only specify one deviation value (percentage or absolute) for the

warning.

Critical Warning at

Deviation (Percent)

Specifies a percentage deviation value for the comparison of archived plans via the task

queue. From this deviation, the value is output as defined in the "Style crit. Deviation

warning" field.

Note

Please note that you can only specify one deviation value (percentage or absolute) for the

critical warning.

Crit. Warning at Deviation

(Value)

Specifies an absolute deviation value for the comparison of archived plans via the task queue.

From this deviation, the value is output as defined in the "Style deviation warning" field.

Note

Please note that you can only specify one deviation value (percentage or absolute) for the

critical warning.

Style Deviation Warning Specifies how a warning deviation is to be displayed in color (e.g. as an indicator for:

Deviation must be checked).

Style Deviaition critical

Warning

Specifies how a critical warning deviation is to be displayed in color (e.g. as an indicator for:

Deviation must be checked urgently).
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Rolling Planning

The other non-editable fields in the "Forecast" and "Distribution" groups show whether there are corresponding facilities. If

facilities are available, this is indicated by "Yes". Clicking on "Yes" or "No" takes you to this facility. The facilities for the

"Distribution" sub-module are as follows: Distribution formulas, distribution matrix work package assignment and distribution

template setup are relevant.

Distribution Calc. Formulas

You can call up the distribution formulas via a lookup using the "Distribution formulas setup" field in the "Projects setup" or via

the user search.

Field Description

Planning Type Default The selection of the planning type in the planning wizard is preset by default with the

entry from this field. The following selection options are available:

- Budget

- PSP lines

- Mixed

Skip Planning Type Selection If this switch is activated, the selection of the planning type is not displayed in the

planning wizard.

New Version Default If this switch is activated, the "New version" identifier in the planning wizard is set to

"Yes" by default.

Update Distribution Default If the switch is activated, the "Update distribution" identifier in the planning wizard is set

to "Yes" by default.

Distribute Difference This field defines which selection is to be preset for the "Distribute differences" field in

the planning wizard.

Update Actual Default If the switch is activated, the "Update actual values" identifier is activated by default in

the planning wizard.

Create New Version after Initial

Planning

If the switch is activated, a new WBS version is automatically created after the initial

planning via the planning wizard and this is marked as the active version.

Default Page for Planning

Wizard

Specifies which view of the WBS is opened in the "Plan customization".

Version Selection Editable Specifies whether the WBS version may be changed in the planning wizard.

Default PSP Version for

Planning Wizard

This is used to specify which WBS version is opened in the "Plan adjustment" of the

planning wizard.

Page Selection Editable Specifies whether the WBS view may be changed in the planning wizard.

Hide Update Distribution Specifies whether the "Update distribution" option should be hidden in the planning

wizard.

Rounding Precision for Item/GL

Account

Specifies the number of decimal places to which the distribution for budget lines of the

type "Article" and "G/L account" is rounded.

Rounding Precision for

Resource/Resource Group

Specifies the number of decimal places to which the distribution for budget lines of the

type "Resource" and "Group" (resource) is rounded.

1.2.4 project365

- 705/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Distribution formulas are transferred to projects and used there. If a distribution formula is subsequently changed, the "Update

projects" function can be used to update the distribution formula in the projects. Only projects with the "Distribution active"

indicator are updated.

If the "Test data (preview)" area is filled with corresponding test values, the progression of the formula can be seen in the info

box.

Chaotic Formulas

You can call up the "Chaotic formulas" via the user search.

The chaotic formulas combine several of the other formulas. To do this, the period is divided into any number of equal phases and

a proportion of the total quantity is defined. A distribution formula can then be stored for each phase.

General

Lines

Distribution Matrix Work Package Mapping

You can call up the "Work package assignment distribution matrix" via a lookup using the "Work package assignment distribution

matrix" field in the "Projects setup" or via the user search.

In this facility, the visibility of matrix row types in the distribution matrices is defined for each work package.

For example, the line types of the billing quantities etc. can be hidden for work packages that contain non-billable internal

services.

Field Description

Code

Description

Formula Type

Parameter 1, 2, 3,

Base

Influencing the progression. You can view the exact effects of the parameters via "Open formula

explanations" in the ribbon.

Start Value Here you can enter a fixed starting value with which the distribution should begin.

Use Request Page Specifies whether a query page should be opened when the distribution formula is selected, on which

the parameters of the distribution formula can be changed on a line-specific basis.

Chaotic Formula

Code

A chaotic formula can be stored here for the "chaotic" formula.

Field Description

Code Specifies a code to uniquely identify the formula.

Description Specifies the description of the formula.

Status Indicates the status of the formula. Only released formulas can be used. To release, the quantity must be

100% distributed. The formula is released via "Release formula" in the ribbon.

Distributed Shows the percentage already distributed in the rows.

Field Description

Phase No. Specifies a code to uniquely identify the phase.

Percentage Indicates the percentage share of the total quantity.

Distribution Calc. Formula Specifies the formula to be used in the phase.

1.2.4 project365

- 706/1545 - Copyright © 2018 - 2024 KUMAVISION AG



This setup data is transferred to projects and used there. This means that if an allocation is subsequently changed, this change

must be transferred to the projects using the "Update projects" function. Only projects with the "Distribution active" indicator

are updated.

Distribution Templates

You can call up the "Distribution templates" via a lookup using the "Distribution templates setup" field in the "Projects setup" or

via the user search.

Distribution templates can be used to define a distribution in projects for each work package code. These fields are used for this

purpose:

Update projects

This function can transfer subsequent changes in the "Distribution matrix work package assignment" and "Distribution formulas"

settings to the projects at the same time. The update function can be executed from the two setup pages; either only one of the

two or both can be updated at the same time. In general, the update only takes place in projects with the "Distribution active"

indicator set.

New PSP version option values

Setup for standard assignment of the WBS Copy report. See chapter Forecast

Project Templates

Important parameters for new projects can already be specified on the "Lines" and "Distribution" information tabs in the project

templates.

Field Description

Work Package Code Specifies the code of the work package for which the setup is to apply.

Work Package Description Specifies the description of the work package selected in the "Work package" field.

Distribution Calculation

Formula Code

Selection from the above distribution formulas.

Period Unit Type Specifies the period unit in which planning is to take place (week, month, quarter or year).

Distribution Level Type Specifies whether the distribution is to be made on WBS line (work package) or in the

individual budget line level.

Distribution Base Type Quantity distribution (e.g. resources) or amount distribution (e.g. G/L accounts).

Distribute Differences Specifies whether the differences are to be distributed automatically.

Keep Total Quantity If "Amount" is relevant for the distribution basis, e.g. if an amount is planned with quantity 1

and this is distributed, the quantity should be 1 again after the distribution.

Use Resource Capacity Relevant when distributing quantity for resources. See application tips

No Active Planning Specifies whether there is no active planning for the line in the distribution and only the

ACTUAL values are to be transferred to the planning.
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Lines

Distribution

Work Packages

Field Description

Distribution Calc.

Formula Code

Specifies the distribution formula for the row (e.g. "Linear distribution").

This specification overrides the calculation formula from the distribution formula template.

Further information on the calculation formulas can be found in the section "Priority of the setup

fields".

Period Unit Type Specifies the period unit in which planning is to take place (week, month, quarter or year).

Distribution Level

Type

Specifies whether the distribution is to be made on WBS line (work package) or in the individual

budget line level.

Distribution Base Type Quantity distribution (e.g. resources) or amount distribution (e.g. G/L accounts).

Keep Total Quant If "Amount" is relevant for the distribution basis, e.g. if an amount is planned with quantity 1 and

this is distributed, the quantity should be 1 again after the distribution.

Use Resource Cap Relevant when distributing quantity for resources. See application tips.

No Active Planning Specifies whether there is no active planning in the distribution for the line and only the actual

values are to be transferred to the planning.

Distribute Differences Specifies whether the differences are to be distributed automatically.

Field Description

Distribution Active Activate the switch if the distribution is to be used for the project.

Distribution

Template Code

Specifies a distribution template to be used for the distribution.

This can be used to define for each work package how the individual WBS lines are later distributed

over the planning period using calculation formulas (e.g. linear distribution). More on the distribution

templates below.

Period Unit Type Specifies the period unit in which planning is to take place (week, month, quarter or year).

Use Distribution

Setup on Lines

The above-mentioned fields (Distribution active, Distribution template code, Period unit) also exist on

the WBS lines and their templates; this switch defines that the distribution should only be based on

these fields. This makes it possible to exclude individual WBS lines from the distribution. See also

"Priority of the setup fields".

Check Distribution

Actual Values

Specifies whether this project should be checked to see whether there are ACTUAL postings outside

the set period. Further information can be found in the section "Setting up projects - ACTUAL fields".

Archive

Distribution

There is a codeunit  for the task queue. If the switch is activated, the planning of the project is

archived cumulatively once a month via the code unit.
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There are also setup fields for distribution in the work package master.

Priority of the furnishing fields

As described above, there are setup fields that can be defined in the work package master, in the WBS line and/or in the project.

How these are prioritized is described below.

Distribution always takes place per WBS line. The fields of the WBS line are checked first, then the project settings and finally

those of the work package master. With "Only use distribution fields of lines", the "Project" and "Work package master" levels can

be deactivated so that only the setup on the WBS line is taken into account. No distribution takes place without defined fields.

User Setup

Create project

When creating a new project using the wizard and a project template, rolling planning fields (e.g. Active distribution) can already

be checked in the wizard and adjusted for the new project if necessary. Of course, these fields can also be checked and adjusted

directly on the project card on the "Planning" info tab.

Due to aggregations in the course of evaluations, it is recommended to maintain the fields "Distribution formula template" and

"Period unit" in the project instead of controlling them exclusively via the WBS lines or the work package master. Ideally, these

two fields should therefore already be defined in the project template.

If the WBS is also generated from the project template, the distribution setup fields contained in this template are adopted.

However, these fields can be adjusted manually in each WBS line.

The "Distribution of remaining budget" field is not preset by the project template. This field determines how the remaining

budget is handled when a WBS line is completed but there is still a remaining budget.

Most of the distribution setup fields are also available in the budget lines and are pre-assigned with the values from the WBS

line.

Field Description

Distribution Calc.

Formula Code

Specifies the distribution formula for the row (e.g. "Linear distribution"). Further information on

the calculation formulas can be found in the section "Priority of the setup fields".

Period Unit Type Specifies the period unit in which planning is to take place (week, month, quarter or year).

Distribution Level Type Specifies whether the distribution is to be made on WBS line (work package) or in the individual

budget line level.

Distribution Base Type Quantity distribution (e.g. resources) or amount distribution (e.g. G/L accounts).

Keep Total Quantity If "Amount" is relevant for the distribution basis, e.g. if an amount is planned with quantity 1 and

this is distributed, the quantity should be 1 again after the distribution.

Use Resource Capacity Relevant when distributing quantity for resources. See application tips.

Rounding Precision Specifies the rounding precision used in the distribution of budget lines for this work package to

round the quantities in the planning periods.

No Active Planning Default value for the "No active planning" field in the WBS line.

Field Description

Edit Calc. Formulas Controls whether the calculation formulas may be changed.

Allow Edit Origin Budget Controls whether the WBS version marked as the original budget may be edited.

Allow Set Origin Budget Controls whether a PSP version may be marked as the original version.
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The following fields are available on the WBS line and the budget line for distribution control:

In the PSP on the "Distribution" info tab, the switch with the same name is activated for an active distribution.

Distribution View

In the ribbon of the project card, you have two distribution views analogous to the two WBS views ("Work breakdown structure"

and "WBS with budget view"). The views enable a detailed view of the work breakdown structure by adding a "distribution

matrix".

Distribution Matrix

The distribution matrix is the essential element of the distribution views.

In the "WBS distribution view", the distribution matrix refers to the active WBS line. In the "WBS distribution with budget", it

looks at either the active WBS or budget line, whereby budget lines are shown and hidden dynamically.

The distribution matrix shows values such as the planned quantity, broken down by planning periods, which are specified in

weeks, months, etc. depending on the period unit. Which rows are visible in the matrix depends on the settings in the "Work

package allocation distribution matrix".

The information contained in the individual rows of this matrix is essentially self-explanatory or will be discussed in more detail

later. Therefore, only the following will be explained in more detail here:

Function Distribution Matrix

In the distribution matrix, the following three functions should be used one after the other and in this order: 

update actual values 

transfer actual/distribution proposal to planning 

update order backlog 

The "Update distribution" function combines these tasks and executes them automatically in the correct order with a single call.

Update actual values

The actual values shown in the matrix are updated based on the project items. Unused residual budget is automatically

distributed to the next periods, which means that completed activity periods no longer contain any quantities in the distribution

proposal.

See also Sequence of an update after completion of a performance period.

Field Description

Quantity

distributed

Indicates the quantity that has been distributed. In the event of replanning and subsequent automatic

distribution, this quantity should correspond to the budget quantity. However, if the distribution was

adjusted manually, deviations may occur.

Quantity

undistributed

Indicates the quantity that has not yet been distributed.

Field Description

Planning line The top line is used for the actual planning and shows the current distribution values. It also contains

descriptive texts from the budget or WBS line that are the subject of the planning. The values within the

matrix are created by distribution items and can be adjusted manually. These adjusted values are later

transferred to the project budget as project budget items.

Distribution

proposal

Proposal for new planning created via the function. These values are also created with specially filtered

distribution items. These values cannot be changed manually. This proposal can be transferred to the

planning line via a function.

Ist The actual values from the project items can be updated for each planning period using a function.

1. 

2. 

3. 
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Transfer Distribution suggestion in Planning

Once the distribution proposal has been incorporated into the planning, the planned billing quantities can be updated on the

basis of the new planning.

See also "Sequence of an update after completion of a performance period".

A distribution to the current period does not take place; it only takes place in the following periods.

Update Invoicing

Once the distribution proposal has been incorporated into the planning, the planned billing quantities can be updated on the

basis of the new planning.

See also "Sequence of an update after completion of a performance period".

Update Distribution

Combines the three functions described above in a single call. This function automatically executes all three functions one after

the other.

Reset Planning

A manual distribution can be automatically redistributed using the "Reset planning" function on the basis of the distribution

settings; the manual changes are lost in the process.

Distribution Planning quantity

If a new budget line is created on the "WBS distribution with budget view" distribution page and the start and end date are

specified, the budget quantity entered is automatically distributed in the distribution budget matrix based on the selected

distribution setup. For example, from 01.11. to 30.06. there is a monthly linear distribution by quantity.

The top line in the distribution matrix (budget line description) shows the current planned quantity, which corresponds to the

distribution proposal line after automatic distribution. If necessary, the planning can be changed manually in the first row, while

the values in the distribution proposal row remain unchanged.

Planning amount

Distribution by amount also automatically takes the setup fields into account and distributes the planning automatically as soon

as all the data has been entered. In contrast to quantity distribution, however, the distribution here is based on the amount. A

typical example of this is costs that are assigned to a G/L account with a quantity of 1 and a cost price in the budget line. In this

case, it is not the quantity 1 that is distributed over the periods, but the amount. If the setting provides for the total quantity to

be retained, the quantity is divided up, taking into account the rounding precision, so that the sum of the distribution items is

again quantity 1. It is not the quantity that is relevant here, but the amount.

Automatic Update

If planning-relevant fields such as "Cost price" or "Start date" are changed, the distribution can be updated automatically after

consultation.

Distribution Entries

The distribution items are parallel to the project budget items. Budgeting can be generated from these distribution items,

making them the first planning stage from which the project budget items later emerge. The distribution items can be viewed, for

example, using a lookup in the "Quantity distributed" field.

Distribution entries transfer value

Note
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This function takes over a distribution in project budgeting by synchronizing the distribution items with the project budget items.

Existing budget items are replaced in the process. With this transfer, the application closes the loop to the range of functions

explained in the "Project planning" section.

Distribution transfer value

There are two versions of this function, one for the current PSP line and one for all PSP lines. All planning levels are updated.

The distribution items of the budget lines update the budget items and thus the planning in the budget lines. The planned values

are transferred from the budget lines to the corresponding WBS line.

Workflow

Distribution in project budget lines

(Initial planning according to bottom-up method)

Distribution level is the budget line

create budget lines with planning-relevant fields, especially the planned quantities 

a distribution proposal is created. 

transfer of the distribution proposal with the function "Transfer distribution proposal to planning" 

possible manual change of the planning (= distribution) 

transfer of the distribution quantity as new planned quantities in the budget lines with the function "Update values from

distribution items" 

transfer of the planning from the budget lines to the WBS lines.

Some of these functions can be executed automatically one after the other.

Distribution in WBS Lines

(Initial planning according to top-down method)

Distribution level is the WBS line

rough planning takes place on the WBS line 

a distribution proposal is created 

detailed planning (if desired)

Sequence of update after completion of performance period

An example will illustrate this update. In a budget line, 600 hours are distributed linearly over 6 months. The start month is

January, the end month is June. In the initial planning, a distribution was created and transferred to the budgeting that contains

the following values:

In January, 80 hours are booked (i.e. 20 less than planned). We are now in February. January will be completed and the planning

will be updated.

1. 

2. 

3. 

4. 

5. 

6. 

1. 

2. 

3. 

Jan 100

Feb 80

March 120

April 80

May 120

Jun 100
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With the "Update actual values" function, the 80 hours of actual values are transferred to the distribution matrix and a new

distribution proposal is created at the same time, which takes into account the completed month of January with 0 and

distributes the 20 hours not worked over the remaining months.

The distribution proposal can now be transferred to planning using the "Transfer distribution proposal to planning" function.

However, the new planning has not yet arrived in the project budget items. The planning can still be changed manually.

The "Update order backlog" function is used to adjust the planned billing quantities to the new planning.

The budget line function "Update values from distribution items" can now be used to update the project budget items from the

new distribution items.

Vert. Vorschl. Ist

Jan 80

Feb 85

March 122

April 85

May 125

Jun 103
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ROLLING PLANNING - FORECAST

General

The "Forecast" sub-module of rolling planning is presented below.

With the help of rolling planning, you can view the current status and progress of your project at a glance and at the same time

have access to the further planning process in order to minimize planning uncertainties. The planning can be updated on an

ongoing basis.

Versioning allows you to track project development at any time. Both the past and the expected future and, if necessary, the

present can be compared and reconciled.

The forecasting sub-module can be used independently of the distribution sub-module, but the two complement each other perfectly.

"Rolling planning (forecast)" is an activation module that can only be used with additional licensing and activation.

Note

Note
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Setup

Projects Setup Forecast
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Field Description

Forecast Active Activate the switch to use the forecast.

Style Addition Expenses

Warning

Style Addition Expenses crit.

Warning

Addition Expenses Warning

(Percent)

Addition Expenses crit.

Warning (Percent)

Addition Expenses crit.

Warning (Percent)

Style Deficit Expenses

Warning

Style Deficit Expenses crit.

Warning

Deficit Expenses Warning

(Percent)

Deficit Expenses crit.

Warning(Percent)

These fields make it possible to define the coloring and percentage thresholds for cost

overruns or underruns in the forecast views. This determines when and in which color the

figures are displayed.

Example:

If the cost overrun is 5%, the cost values should be displayed in light red (= Style Attention)

and in dark red (= Style Unfavorable) if the cost overrun is 10%.

Style Addition Expenses

Warning

Style Addition Expenses crit.

Warning

Addition Expenses Warning

(Percent)

Addition Expenses crit.

Warning (Percent)

Style Deficit Expenses

Warning

Style Deficit Expenses crit.

Warning

Deficit Expenses Warning

(Percent)

Deficit Expenses crit.

Warning (Percent)

These fields make it possible to define the colors and percentage thresholds for revenue

overruns or underruns in the forecast views. This determines when and in which color the

figures are displayed.

Allow edit Origin Values As soon as the switch is activated, the values of the original version may be changed in the

forecast view, and thus also the original version.

Style First Version Colored representation of the values of the first WBS version to be compared in the forecast

comparison matrix.

Style Second Version Colored representation of the values of the second WBS version to be compared in the

forecast comparison matrix.

Style Third Version Colored representation of the values of the third WBS version to be compared in the

forecast comparison matrix.

Style Additional Lines Colored display of transferred supplement lines (=WBS lines) in the original budget. This

allows the transferred supplements from a WBS version to the original version to be

distinguished from each other by color.

Comparision Sorting Specifies whether the comparison values in the "Forecast comparison view" should be

displayed side by side or grouped in departments.

Side by side means that the same fields of each version are displayed directly next to each

other (e.g. the actual quantities of all 3 versions).
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Rolling Planning

The other non-editable fields in the "Forecast" and "Distribution" groups show whether there are corresponding facilities. If

facilities are available, this is indicated by "Yes". Clicking on "Yes" or "No" takes you to this facility. For the "Forecast" sub-

module, the individual facilities are: "Comparison fields facility" and "New version facility".

Forecast Comparison Fields

On the "Forecast comparison fields" page, you determine which fields are to be displayed in the comparison matrix of the "WBS

forecast comparison view". A default configuration is created the first time it is used and missing fields can be added.

In addition, the fields can be assigned to a department; this is particularly relevant if the "Department" option has been selected

in the "Forecast comparison sorting" field in the "Projects setup". In this case, the fields in the comparison matrix are grouped

according to these departments.

The values in the "Sorting" column determine the order in the comparison matrix. This order is done in 10 steps so that new

fields can easily be inserted between the existing ones. The lower the number, the further to the left the field is in the matrix.

The "Cross-version" checkbox is used to define fields that are not displayed per version, but are displayed once across versions.

The "Description" field is a field that is well suited to being displayed across versions.

WBS new version report options

On the "New WBS version option values" page, you determine which selection fields are to be displayed on the query page when

the "Copy WBS" function is executed via the "Create new version" menu item.

It is recommended to keep the view as minimal as possible. Ideally, no fields appear on the query page, not even the field for

selecting the WBS version (source version) to be copied. Without this selection, the active version is automatically used as the

source.

User Setup

Create project

As soon as a project has been created, whether with or without a wizard, and optional budgeting has been carried out via the 

Distribution sub-module, there are two WBS versions: an unchangeable original version and an active version against which

postings are made.

Field Description

Department view means that all fields of the "Quantity" department (of version 1 then

version 2 then version 3) are displayed first, then all fields of the "Cost price" department 

(of version 1, version 2 and then version 3) are displayed, etc.

WBS Open Page After New

Version Creation Options

Specifies which version should be displayed automatically after executing the "Create new

version" function. You can choose from the following options:- previous version

- original version

- new version

In most cases, it makes the most sense to select the "new version" as it can be used directly.

WBS Page After New Version

Creation

Specifies which page is to be opened with the version defined in the above field after the

"Create new version" function has been executed. You have several pages to choose from.

Field Description

Allow Edit Origin

Budget

Controls that a PSP version marked as the original version may be modified, although this is not

normally possible.

Allow Set Origin

Budget

Controls that a WBS version may be defined as the original version by setting the field with the same

name on the WBS header. Original versions may no longer be changed.
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Forecast Views

In the ribbon of the project card, there are two forecast views available, analogous to the two WBS views ("Work breakdown

structure" and "WBS with budget view"). In addition, the "WBS forecast budget view" is also available as a filtered version for

active WBS lines (WBS forecast with budget lines (open work packages)).

In addition to the familiar fields from the conventional views, these forecast views also contain additional fields that are specific

to the forecast and are not available in the regular WBS views.

The fields also exist for the purchase amounts. Settlement quantities and sales amounts can also be viewed.

Create new wbs version

The "Create new version" function can be used to create a new version using "Copy PSP". Depending on the setup, the function is

called up with a very reduced view of the selection page. A source version does not have to be selected, the active version is

automatically the source version that is copied.

The new version is automatically set to active.

Open origin budget

Opens the PSP version marked as the original version.

WBS forecast comparison

The "PSP forecast comparison" allows you to compare up to three different PSP versions directly with each other. In the top

section of the "Forecast comparison" page, you can select which versions are to be included in the comparison.

The "Show costs" and "Show revenues" radio buttons can be used to specify whether "only quantities", "only amounts" or "both"

should be displayed in the comparison matrix for the costs or revenues.

The values from the WBS versions are compared with each other in the "Forecast comparison matrix" area. For better clarity, the

values of each version are shown in a separate color (see Setup).

The comparison takes place at WBS line level.

The consumption values and obligation values are displayed at the time of validity of the individual PSP versions.

Field Description

Quantity Displays the budgeted quantity of the open WBS version (corresponds to the field in the regular

WBS views).

Residual quantity Calculates the residual value from the budget of the currently opened PSP version minus the

consumption incl. already accrued commitment (quantity - quantity ACTUAL + commitment).

Quantity (expected) Indicates the budgeted quantity of the original version.

Time commitment

(quantity)

Indicates the number of time bookings already entered that have not yet been transferred to the

project items via the project book sheet (this corresponds to the corresponding field in the regular

WBS views).

Consumption (base) Displays the consumption quantity from the project items (corresponds to the field in the regular

WBS views).

Menge IST + Obligo Indicates the added quantity from the two fields "Time commitment (quantity)" and "Consumption

(basis)".

Note

Note
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Example:

Version 2 remains valid until 15.06.25, as version 3 was created and released on this date ("Create new version" function). Up to

15.06.25, a total of 120 hours were booked, and from 15.06.25 to the present date, an additional 30 hours have been added to

the commitment. A consumption of 120 hours is specified for version 2, while 150 hours are listed for version 3 under the column

heading "Actual quantity + commitment".

Addition

Supplements in the project business must also be regularly taken into account in the budget. These are created in the current

WBS version and can be transferred to the original version if required, where they are marked as supplements. Whether it makes

sense to transfer a supplement to the original budget depends on the individual case.

New WBS lines are regarded as supplements, while new budget lines within existing WBS lines are regarded as planning

changes. Therefore, supplements requested by the customer must always be represented by the creation of new WBS lines.

Transfer Addition

The "Transfer supplement" checkbox on the WBS line is automatically activated when a new WBS line is created in a version that

is not marked as the original version.

The "Transfer new WBS lines to original budget" function allows you to transfer these WBS lines together with the associated

budget lines to the original version. There is also the option "Transfer selected WBS lines to original budget", which allows the

targeted selection and transfer of specific new WBS lines.

Open original budget

If the original budget is then opened, the WBS lines transferred there can be recognized by the filled supplement fields:

Supplementary lines are set off in color from the original budget (the original WBS lines). This color coding is defined in the

"Setup projects" in the "Style supplement lines" field.

New WBS Version as original version

Instead of transferring the supplements to the original version, the customized version can also be used as the new original

version. This depends on the approach and the status of the respective versions.

WBS Versions in project controlling

The "Project financial reports" offer the option of creating flexible project controlling overviews that can also take the project

budget into account.

The WBS versions used intensively in rolling planning can be used flexibly by selecting from the "Active version", its "Previous

version" or the original version as the basis in the column layouts under "WBS version". For example, a comparison of budgeting

between the original version and the active version can be created. This setting in the column layouts is only effective if budget

values are to be displayed in the column to be defined, i.e. if the "Project account items" option is selected in "Type of item".

Field Description

Addendum on Indicates when the addendum was created.

Addendum from PSP description Specifies the description of the version from which this supplement was

transferred.

Supplement to PSP Project budget

name

Specifies the project budget name from which this supplement was transferred.

Addendum from PSP version Specifies the WBS version number from which this supplement was transferred.
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Guarantees

You store background information about letters of guarantee on the following pages:

Guarantee Types

Guarantee Status

Guarantee Posting Groups

The pages are for informational purposes only and don’t affect other areas of Microsoft Dynamics 365 Business Central1. You can

fill in the fields on them in any way you want.

SETUP

Before you can work with guarantees, you also need to set up a number series for them. To set up a series:

Choose the Search icon, enter Projects Setup, and then choose the related link.

On the Numbering FastTab, select the series that will be used for letters of guarantee.

• 

• 

• 

1. 

2. 
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REGISTER A LETTER OF GUARANTEE

To register a guarantee in the system:

Choose the Search icon, enter Guarantees, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

1. 

2. 

3. 
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Actions

To enter notes about a guarantee, select a line on the page and choose Related > Comments on the ribbon. To open the purchase

document or project related to a guarantee, select a line and choose Related > Open Purchase Order or Open Project.

Field Description

No. Exit the field to have a number assigned automatically from the series that you set up for this

purpose.

External Guarantee No. Specify the number that the bank uses on the letter of guarantee.

Description Specify a description for the guarantee.

Guarantee Type Select the type of guarantee.

Guarantee Type

Description

Shows the description of the type of guarantee.

Guarantee Posting

Group

Specify the posting group that will be used for the guarantee.

Guarantee Status Specify the status of the guarantee.

You can set up statuses on the Guarantee Status page.

Guarantee Direction Choose if you received a guarantee or had one issued for a certain vendor or customer.

Account Type Specify if the account that a bank guarantee was applied for was set up in the name of a

customer or vendor.

Account No. Specify the number of the account.

Account Name Shows whom the account belongs to.

Issuing Bank (Contact

No.)

Specify the name of the person who you can talk to at the bank that provided the guarantee.

Issuing Bank (Contact

Name)

Shows the name of the contact person.

Starting Date Specify from which date the guarantee will be valid.

Ending Date Specify when the guarantee will expire.

Amount (LCY) Specify the guarantee amount (in local currency).

Commission Amount

(LCY)

Specify the commission fee that the bank will receive for the guarantee.

Commission % Specify the commission fee in percent.

Project No. Specify the number of the project that the guarantee is for.

Note

If you want to see all guarantees registered for a project, open the relevant project card and

choose Related > Project > Guarantees on the ribbon.

Document Type Specify the type of the purchase that the guarantee is for.

Document No. Shows the number of the purchase document created from the project.

Note

If you want to see all guarantees registered for a purchase document, open the relevant

document and choose Related > Guarantees on the ribbon.
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Field Check

If the Guarantee Field Check toggle is turned on in Projects Setup, you need to release guarantees before you can use them for a

project.

Guarantees are released by running the End Guarantee Update action from the ribbon. The system then checks the fields that

must be filled in to proceed and shows an error message if they aren’t.

Only after all the required fields are filled in can the record be used. Afterward, you can no longer edit the guarantee. If you need

to, choose Edit Guarantee on the ribbon to reopen the record.

During editing, the record is blocked in the system. To make it available again, rerun the End Guarantee Update action.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Time & Materials

OVERVIEW

Project usage can be recorded in several ways. Whereas the hours worked on a project can be entered in time journals and on

CTC cards, the consumption of items can be specified through adjustments to inventory and project purchases.

By using budget-to-actual comparisons, you can then compare the amount of time and materials spent toward a project to the

number of hours and items budgeted for it.

STAFF COSTS

Following customer approval, you can start posting usage and sales for a project. Usage primarily refers to resource

consumption. Resources might be employees, machines, or contractors. This article will focus on time tracking for employees.

A resource’s work hours are entered in time sheets and on other time tracking pages in the base unit chosen in Resources Setup.

All resources representing actual people should have the same unit stored on their resource cards.

The most common base unit for these resources is Hour. For types of work typically billed in a different unit, such as Day, the

system will hold off on converting a posted time entry into the billing unit until the entry is released through a project journal.

This way, employees can continue to think and post in hours, and the system will do the rest.

TIME TRACKING LEVEL

In the Time Posting Level field on project cards, you can specify how time spent on a project will be recorded. The options are: 

WBS

A rough listing of tasks at the level of work packages.

Budget

A detailed capture of tasks at the budget line (or line activity) level.

This field might already be filled in from a project template.

Whereas no restriction is placed on WBS line resources (each resource can post to all WBS lines), the selection for budget

lines is limited to a user’s own resource or group. With the Strict Team Filter toggle turned in Projects Setup, you can even

prevent the filter from being removed under any circumstances. Neutral budget lines (that all resources can post to) can be set

up by using a general time recording resource.

A project might contain work packages that aren’t planned at budget level, as there’s no need to divide them into subtasks that

will be assigned to specific resources (travel cost being one example). However, for obvious reasons, you might still want to

post to these WBS lines despite the posting level being set to Budget, so they’ll be shown on the selection page regardless.

Both levels are valid for all time tracking methods explained in the following.

TIME JOURNALS

A project time journal records the time that a resource spends on a project. All resources require a journal of their own (see 

Resource Capacity).

For the correct time entries to be retrieved when a user opens the Project Time Journals page, the user must first be assigned to

a resource and to a journal in User Setup. The selected resource is then entered on all journal lines automatically.

Users whom the Other Res. in Time Tracking checkbox is selected for in User Setup can also edit other resources’ journals. A

message appears if a user cannot be assigned to a journal.

1. 

2. 

Note

• 

• 
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The following table describes the most important fields found in time journals.
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Field Description

Resource No. Shows the resource who records time.

This field is filled in by default, as each a journal is specific to a resource.

Posting Date Specifies the day that time is being recorded for.

Project No. Specifies the number of the project for which time is being recorded.

Project Search Finds projects based on common filter criteria provided with Microsoft Dynamics 365 Business Central.

This feature is meant as an alternative to drilling down on the value in the Project No. field.

Projects that match the text you entered are shown when you exit the field so that you can select the

project that you want to see filled in on the line. A second dialog page shows the WBS or budget lines

that you can post to.

Besides numbers and letters, you can use symbols such as * and @ to limit search results. For more

information about filter criteria, see Sorting, Searching, and Filtering Lists - Business Central.

Specifying a filter such as @ *introduc* would yield the following (case-insensitive) results, for

example:

Introducing Business Central; Reintroduction of CRM fields

Searches cover the Project No., Description, Description 2, and Search Description fields of projects.

Line Activity No. Shows the activity number of a budget line.

When filling in the Project No. field, a user can choose a budget line (=activity) if the time posting level

on the related project card is set to Budget.

This includes any line to which the user’s resource is assigned through the Person Responsible field or

the relevant resource group, unless the activity has been completed.

To record time for a completed activity, the status of the activity must be set back to In Progress.

When a budget line is selected, the work package and the phase, task, and step code fields on the

journal line are filled in automatically. This means that the work hours recorded by resources are

posted not only to the budget lines but to the associated WBS lines as well.

This field can also be used to switch to another activity or—if the time posting level is set to WBS—

another work package specified for the project.

Work Package

Code

Specifies the work package that is assigned to the WBS line to which time needs to be posted.

This field is filled in automatically when a line activity is selected.

Description Describes the activity that was performed by the resource. The description can have a maximum of 50

characters.

Project Time

Comment

Stores additional remarks about the time posting.

Start Time

End Time

Specifies when work on a certain activity started and ended. Filling in these fields is not required but

helps employees estimate the duration of a task.

Break (Minutes) Specifies a work break in between two time periods, in minutes. This field might be used by the system

to fill in the Break and Quantity fields.

Break Specifies a work break, in hours. This field might be used by the system to fill in the Break (Minutes)

and Quantity fields.
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Additional information about the project and the activity stored on a specific journal line is available in the lower-left section of

each journal. The progress and extent of time tracking on the line can be found to the right of that section.

Actions

Functions

Includes the Get Work Package function, which can be used on a journal line to fill in an activity and a reference to a WBS line.

If a project number has been entered on the journal line and the time spent on the project is tracked on budget lines, only

activities assigned to the resource or to no resource at all (=general tasks) can be chosen here.

However, if the Project No. field has been left blank, the window for selecting an activity includes all activities from all projects

so that staff members can find their tasks without needing to know the number of a specific project.

Selecting an activity then fills in a large part of the fields found on the journal line.

Post

Used to post the journal.

Related

Project

Field Description

Whichever break field is filled in last will be used to determine the length of the break taken by the

resource.

Quantity Shows the quantity of work performed by the resource, in hours. This field is filled in based on start,

end, and break times but can be changed manually.

Line Activity

Progress %

This field is only relevant if budget lines store time spent on activities.

To report the status of a line activity, a user can choose this field or the Line Activity Progress % field.

Either will be sufficient for the system to fill in the Estimated Total Quantity and Estimated Total

Amount fields on the selected budget line.

Billing Type Copied from the related WBS line. This field cannot be changed manually.

Invoice Qty. Typically, the Invoice Qty. field is filled in from the Quantity field. A different invoice quantity can only

be entered if services are billed based on time and materials and the New Invoice Qty. in Time Tracking

toggle is turned on in Projects Setup.

Additionally, when time is posted to budget lines, the line you want to change the quantity on must be

billable in full.

In other words, the Billable checkbox needs to be selected on the line and the Invoice Qty. % field

cannot be filled in with a value other than 100.

If the time cannot be invoiced in full, the amount that you can bill will depend on the specified line

activity.

Reverse Entry No. Used to cancel a posted time entry.

Contact No. Specifies a company contact.

This field is used to analyze on a per contact basis the costs linked to sales and marketing projects,

which do not require customer numbers.

This field is used to analyze on a per contact basis the costs linked to sales and marketing projects that

do not require customer numbers.

1.2.4 project365

- 727/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Choosing the Project Card action opens the card of the project that has been entered on the journal line. Choosing Ledger

Entries shows the associated ledger entries.

Resources

Choosing Resource Card opens the card of the resource assigned to the journal. 

Choosing Time Entries provides a user with a list of all time entries posted for a certain project.

The Budget Line Activities (Open) action, on the other hand, shows all current line activities.

Line

Used to open line-related dimensions and comments.

CTC TIME TRACKING

The time that resources spent on projects can also be recorded on CTC cards. The use of CTC (complete time capture) differs

from entering hours on a time journal in the following ways:

Internal checks prevent time postings from exceeding workday limits.

The system calculates a resource’s number of work hours from clock-in and clock-out times before allocating these hours to

projects.

Time recording includes default breaks and absence.

Only one CTC card is available per day and employee. Hours can be allocated on this card more than once, whereas you need

to create multiple lines in a project time journal to get the same result.

Inputs can be tracked at any time based on posted cards.

Time entries must be released before they can be posted.

CTC Time Tracking—the main page for entering and viewing resource hours—combines unposted and posted cards in a single

view. The Status field on the header indicates whether a card has or hasn’t been posted yet. The page also includes calendars

with status colors to help pick the days you want to record time on.

Indicate absence

As one visual aid, you can change the color of CTC calendar days to indicate when a certain resource isn’t available.

To initialize background colors indicating absence:

Choose the Search icon, enter Calendar Colors, and then choose the related link.

On the ribbon, choose New > Initialize to have the system specify RGB color values.

Assign colors to causes of absence

After setting up the colors, you can use them to visualize causes of absence.

Choose the Search icon, enter Causes of Absence, and then choose the related link.

Select a line. In the Calendar Background Color field, choose a color.

• 

• 

• 

• 

• 

• 

1. 

2. 

1. 

2. 
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Indicate status of time tracking

You can also visualize the status of time recording on a CTC calendar:

Choose the Search icon, enter Projects Setup, and then choose the related link.

Go to the CTC Calendar Colors FastTab and fill in the fields as described in the following table. 

Specify breaks

You can use one of two methods to specify CTC breaks:

Enter a default break on the Work-Hour Templates page. You can then fill in the Work-Hour Template field on a resource card to

copy the break to the card and the resource’s time tracking pages. However, as the name implies, the break is no more than a

default value. You can still change it on both the resource card and in time tracking.

Specify a break on the Break per Shift page. Breaks entered on this page have a higher priority than those stored with work-hour

templates. You can define both maximum work hours and minimum break times on the page.

Example

The work hours and breaks shown in the table have the following meaning:

At up to 4 hours, a break isn’t required so no time is suggested automatically. You can specify a break manually, however.

Working for over 4 hours but for less than 8 hours requires a break of at least 1 hour. This value is also entered automatically

on every CTC card. Changing the Break field, trying to make a break smaller, results in an error message, but you can increase

the length if necessary.

Over 8 and under 10 hours, resources need to take a break of least 1.25 hours.

Recording more than 10 hours in a workday isn’t possible.

You can turn on the No Break Minimum toggle in Projects Setup if you want to specify breaks that are smaller than those suggested

by the system.

Elements of CTC time tracking

To record time on a CTC card:

Choose CTC Time Tracking on the Time Recording (or Project Lead) role center. See also (CTC Card) Actions.

Fill in the fields as necessary.

1. 

2. 

Field Description

Neutral Specify a color for days, such as Saturdays, Sundays, and holidays, on which resources aren’t available.

Posted CTC Specify a color for days on which hours have been recorded and posted.

Released CTC Specify a color for days on which hours have been recorded and released but have yet to be posted.

Open CTC Specify a color for days on which hours have been entered but haven’t been released.

Missing CTC Specify a color for days on which hours have yet to be recorded.

Outside Month Specify a color for days that are outside the specified month.

1. 

2. 

Max. Work Time Break

4 0

8 1

10 1.25

• 

• 

• 

• 

Note

1. 

2. 
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CTC header

CTC lines

Field Description

Resource Resource no. of the recording resource

Description Shows the name of the resource.

Date Shows the workday for which time is being recorded.

Start Time Shows when the resource starts work on a given day.

End Time Shows when the resource leaves the office on a given day.

Break (Hours) For more information, see Specify Breaks

Quantity Shows the time spent on a project.

The value in this field is calculated based on the formula End Time minus Start Time minus Break.

Qty. Allocated Shows the total time allocated to projects on individual CTC lines.

To Allocate Shows time not yet allocated to a project.

Status Specifies the status of the CTC card.

Open

Card values can be changed at any time.

Released

All times have been recorded on the card, making it available for posting.

Last Card Posted On Shows when a card was last posted for the resource.

Cause of Absence Code Specifies a cause of absence (field must be displayed).
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(Nearly all fields found on project time journal lines are also available on CTC cards.)
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Field Description

Project No. Specifies the project to which time will be posted.

Project Search Used to find projects based on common Business Central filter criteria. This feature is meant as an

alternative to drilling down on the value in the Project No. field.

Projects that match the text you entered are shown as soon as you exit the field, and a project number

is filled in on the journal line after you choose a project from the search results. A second dialog page

shows the WBS or budget lines that you can post to.

Besides numbers and letters, you can use symbols such as * and @ to limit search results. For more

information about filter criteria, see Sorting, Searching, and Filtering Lists - Business Central.

Example

The filter @ *introduc* yields the following (case-insensitive) results:

Introducing Business Central; Reintroduction of CRM fields

Searches cover the Project No., Description, Description 2, and Search Description fields of projects.

Work Package

Code

Specifies the work package to which time will be posted.

Description Describes the activity that was performed by the resource.

The description is copied to time and project ledger entries and, for projects billed by time and

materials, to proof of performance documents as well.

Customer

Comment

Internal Comment

These fields can be used to describe the activity further. Both types of remarks are stored on comment

sheets.

However, whereas comments addressed to customers can be printed on proof of performance

documents for projects billed based on time and materials, internal comments cannot, because their

Print on Customer Doc. field is not selected.

Start Time

End Time

The values in these fields indicate when work on an activity started and ended. Both are logged on time

entries.

The CTC line quantity is then calculated automatically from them if the CTC Time Tracking Incl. Start/

End Times toggle was turned on in Projects Setup. If it was, you can also no longer edit the Quantity

field manually.

Start Time

(Break)

End Time (Break)

These fields specify when a work break starts and ends. The values of both are also logged on time

entries.

The system then calculates the length of the break automatically if the values entered here are within

the start and end times specified on the line and updates the Quantity field to show the actual number

of work hours.

Quantity Specifies the number of hours spent on the activity. You cannot enter a negative quantity in this field.

Line Activity

Progress %

Specifies how far the line activity has progressed.

Invoice Qty. Indicates how much of the project work can be billed to the customer. This is only a deciding factor if

work can be billed based on time and materials.

Billable With the toggle turned on, project effort can be billed to the customer. This effort is stored with the

activity.

Billing Type Copied from the WBS line. This field cannot be changed by the user.

Line Activity No.
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FactBoxes

FactBoxes on the right side of the screen provide you with additional information about time tracking.

For example, Time Statistics indicate for a given day the amount of work required based on the resource capacity set and the

hours posted for the day and month. If you installed the TempVision app, they also include flextime entered for the day.

Below this section are the current, previous, and following months in calendar form. These calendars are intended to help you

navigate time recording and show where resources have recorded hours and entered absence. You can select a calendar day to

view or enter time-related data.

The CTC Line Info FactBox lists project and activity data regarding the line you chose on the Lines FastTab.

The Color Legend shows you what colors are being used to indicate absence and the status of time recording.

Actions Create CTC Cards

Creates multiple CTC cards with the same information, an especially useful function for specifying absence.

Release CTC Cards

Releases all completed CTC cards that match the specified filters. During this process, a check is run on all data entered on the

cards. If the check fails, you see an error and any card containing incorrect information will not be released (which means that it

cannot be posted).

Release

Releases the current CTC card.

Reopen

Field Description

Shows the activity number of a budget line.

When filling in the Project No. field, a user can choose a budget line (=activity) if the time posting level

on the related project card is set to Budget.

This includes any line to which the user’s resource is assigned through the Person Responsible field or

the relevant resource group, unless the activity has been completed.

To record time for a completed activity, the status of the activity must be set back to In Progress.

After a budget line has been selected, the work package and the phase, task, and step code fields on

the CTC line are filled in automatically. This means that work hours recorded by resources will be

posted to not only budget lines but the associated WBS lines as well.

This field can also be used to switch to another activity or—if the time posting level was set to WBS—

another work package stored with the project.

Qty. to Complete This field is only relevant to time tracking at the budget line level.

To report the status of a line activity, a user can choose this field or the Line Activity Progress % field.

Either will be sufficient for the system to fill in the Estimated Total Quantity and Estimated Total

Amount fields on the selected budget line.

Contact No. Specifies a company contact.

This field is used to analyze on a per contact basis the costs linked to sales and marketing projects,

which do not require customer numbers.

By selecting the relevant option in the Contact No. for Time Tracking field in Projects Setup, you can

also make it mandatory to enter a contact number for this kind of project.
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Changes the current card’s status from Released to Open.

Copy to Today's Card

Copies the current CTC card to the card of today. This copies both the header and the lines and can only be used if the CTC lines

of the target card are still blank.

Copy from Existing CTC Card

Works in the opposite way to the Copy to Today’s Card action, as it copies data from the card you choose to the card you’re on.

Post / Post Batch

Posts recorded and released CTC cards.

Single time entries are released automatically. The Post Batch function, on the other hand, can only be run on released CTC cards.

Resource

Opens the card of the resource for which time is being recorded.

Unposted Cards

Opens the CTC Cards page, on which you can manage cards that haven't been posted yet.

Posted Cards

Opens the Posted CTC Cards page.

As mentioned, CTC time tracking shows both unposted and posted cards. Typically, only administrators might need to view them on

separate pages. 

Cancel Posted CTC Card

Cancels a posted card and deletes project time entries assigned to it.

If the entries have already been copied to a project, the project ledger entries created from them are deleted as well. This

requires that the user running the function be authorized to post project ledger entries.

Employees without this kind of permission must ask the project manager to cancel cards. Project ledger entries that have been

invoiced cannot be deleted in either case.

Cancel CTC line

Cancels a single CTC line instead of all hours posted on a given day.

Before you can run the action, you need to set up a project time journal batch that will be used exclusively for these kinds of

corrections. This batch cannot be assigned to a resource, which means the Resource No. field on the related Project Time Journal

Batches line must remain blank.

For more information, see Project Setup | Time Tracking.

As CTC cards are documents, where the values entered on the lines must match the total displayed on the header, reversing a line

requires a replacement for the original posting (like a corrective entry does).

Note

Note

Note
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Running the function on the selected CTC line opens a new time journal filtered to the prepared reversal posting. The correction

must also be entered here.

The project and work package numbers on the CTC line and the reversal entry don’t need to match; the date and the quantity,

however, do.

As an example, if the time specified on the line is minus 1.5 hours, the quantity for correction must be plus 1.5 hours. If needed,

you can divide up the amount and assign it to multiple entries. The one-and-a-half hours given as an example can therefore be

distributed across two entries, with one hour assigned to one entry and 0.5 hours assigned to the other.

The correction must be posted before you exit the journal page. Otherwise, the system will not save the changes you’ve made so

far.

The journal used to reverse time entries contains the start time, end time, and break fields from the relevant CTC line. You can

also view the comments that were made about the line or enter new ones in the journal, if necessary. If you want to keep the

existing notes, use the Copy Comments action on the ribbon.

After you’ve posted the reversal, a new CTC line containing a negative amount is inserted to offset the journal posting you’ve just

made. Offset values to keep the line and header quantities in sync are also added.

You can only cancel CTC lines that project ledger entries haven’t been created for. The action also cannot be run if the CTC

Posting As field in Projects Setup is set to something other than Time Entry, as line cancellations cannot be used to correct

project ledger entries.

Project Time Entries / Project Ledger Entries

Shows the project time or project ledger entries related to the card (provided that these entries have been created for the

project).

Absence Registration

Used to specify absence. You can only choose this option when you open a posted card. 

Dimensions

Shows the dimensions stored on the header of a card.

Record time

To store work hours, pick a day on the calendar. This creates a new time record, that is, an unposted CTC card, automatically.

You can also use the Create CTC Cards function to create a record.

Record activities

A resource’s work hours are allocated to individual project activities on CTC lines.

To enter the activity last worked on for a project, choose Functions > Get Last Activity on the Lines FastTab. This retrieves the

line activity or work package last opened by the relevant employee.

Release a record

Days on which you recorded work hours must be released before posting. Some plausibility checks are performed during that

process, for example, to see if the entire CTC card quantity has been allocated on the lines.

By using this action, you can release either a single day or multiple days at once.

Post a record

Released days must be posted. You can post a single day or multiple days.

Only when you post time does the system create time entries. These are then copied to the project as project ledger entries

following a review by the project manager.

1.2.4 project365

- 735/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Single time entries are released automatically. The Post Batch function, on the other hand, can only be run on released CTC cards.

TIME SHEETS

Time sheets are yet another method to specify how much time a resource has spent on a project. You can record usage in time

sheets in seven-day increments. Before you can work with time sheets, you need to set up the feature by registering the relevant

resources and turning on the Use Time Sheets toggle on their resource cards. You also need to create new, mostly blank sheets.

To create a batch of time sheets:

Choose the Search icon, enter Create Time Sheets, and then choose the related link.

Alternatively, open a resource card. On the ribbon, choose Process > Create Time Sheets.

Fill in the fields as described in the following table.

You can then use the fields on the Filter FastTab, for example, to set up sheets for specific resources or external employees.

Time sheets can only be created by a user for whom the Time Sheet Administrator checkbox has been selected in User Setup.

To see the newly created sheets, choose the Search function, enter Time Sheet List, and then choose the related link.

Like a CTC card, a time sheet can only be viewed by the resource linked to the sheet unless the Other Res. in Time Tracking

toggle is turned on for a user in User Setup. After the sheets have been created, you can report work hours on a weekly basis:

Open the Time Sheet List, select your sheet, and enter the work hours on the lines related to the current calendar week.

When all hours have been entered, choose Submit to release them for posting. 

The time you recorded is then converted into time entries, which can be done on a regular basis by using a job queue. If the

status of an entry is set to Submitted but the line hasn’t been posted—that is, it isn’t yet part of the Project Time Entries Created

—you can still reset the status to make changes to a work package, a line activity, or a quantity.

You can choose Budget Line Activities (Open) on the ribbon to see a list of unposted line activities assigned to the current

resource. This doesn’t include line activities for resource groups, however.

To copy all the lines from the previous week, use the Copy Lines from Previous Time Sheet action. You can do this week by week.

To add comments to a record, fill in the text fields next to the Quantity field on a line. This ensures that the data record is

assigned to the correct time entry when you post the line. The comments can also later be used on a proof of performance

document sent to the customer.

Related

If you want to see a list of all project ledger entries related to a time sheet line, select the line and, on the ribbon, choose Related

> Ledger Entries.

To open the related resource card or see more information about time entries stored on the line (like on a CTC card), choose

Related > Resources > Time Entries.

Note

1. 

2. 

3. 

Field Description

Starting Date Specify the first date of the batch.

No. of Weeks Enter the number of weeks the sheets should cover.

Note

1. 

2. 

1.2.4 project365

- 736/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Lines

To retrieve a work package, choose Line > Get Work Package on the Lines FastTab. You can now select a package from all work

packages set up for the resource or the related resource group.

PROJECT TIME ENTRIES

Time entries are created automatically when you record hours spent on a project (in whichever way possible).

You can use the CTC Posting As and Time Sheet Posting As fields in Projects Setup if you want to post project ledger entries instead

of time entries or post both at the same time.

Initially, the entries don’t affect project usage but represent the hours committed to a project. Times recorded but not posted can

later be analyzed, for example, in cost control.

Usage is generated only when you copy time entries to a project journal and post them there (see also Project Journals).

Important fields

See the following table for a more detailed explanation of the key fields found on the Project Time Entries page.

Note
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One option for viewing the page is to open a project and choose Related > History > Project Time Entries on the ribbon.
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Field Description

Posting Date The date in this field corresponds to the date of performance.

System Date Shows the exact date and time the entry was posted. Helps to see with what delay (if any) hours

are recorded in the system.

Resource No. Specifies the resource whom time entries were posted for.

Start Time

End Time

Only filled in if hours were entered with start and end times.

Project No. Specifies the project that time was recorded for.

Work Package Code You always post time entries to lines on an active WBS.

To which line the entry is assigned is shown in the Project No., the Work Package Code, and the

Phase, Task, and Step Code fields.

Line Activity No. Specifies a budget line activity if an entry was posted to a project at budget line level.

Reversed Selected if the time entry has been cancelled.

Reverse Entry No. Shows the associated reversal entry if the time entry has been cancelled. The reversal entry, on

the other hand, will reference this entry.

Qty. (Base) Time is always recorded in the base unit of measure assigned to the relevant resource. With the

most common unit in this context being hours, this field typically shows the hours worked.

Invoice Qty. (Base) Frequently corresponds to the value in the Quantity (Base) field.

Only if you post a line activity that you want to bill based on time and materials and the Invoice

Qty. % is not 100 does the value in this field differ from the value in the Quantity (Base) field.

Copied to Project Indicates if the time entry has been copied to a project journal and posted there.

After the entry has been posted, it can no longer be copied to another journal, even if the

project that it was posted to contains only part of the quantity assigned to the entry.

Copied to Project (Date) Shows the exact date and time the entry was posted to a project.

Copied to Project

(Ledger Entry No.)

Specifies the project ledger entry that was created when you copied the time entry to a project.

This field ensures that the project ledger entry assigned to the time entry is deleted if you

cancel the latter.

Qty. Copied to Project Typically, when a time entry is copied to a journal, the complete quantity entered for it is

retrieved automatically.

If necessary, however, you can track changes to the journal quantity by comparing the value in

this and the value in the Quantity (Base) field.

Total Cost (LCY) This amount is relevant to assess the time committed to projects. 

Note

When you copy time entries to a project journal, the total cost will be recalculated.

Comments Indicates if comments exist for the entry.

You can store these when recording work hours. You can also have them printed on proof of

performance documents.

Contact No. Shows the contact number entered during time recording.
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Actions

The following functions can be run from the Project Time Entries page.

Comments

Opens the comment sheet used for project time entries.

You can enter comments when you record hours in the system. You can also change them if necessary.

These comments will later be copied to the project ledger entry comments and to proof of performance documents.

Cancel Entries

Prepares time entries for cancellation.

When the action is run, a cancellation line (with a negative quantity) is inserted into the relevant resource’s time journal while

the journal is opened so that the reversal can be posted immediately.

To prepare a single entry for reversal, you can also fill in the Cancellation Entry No. field and use the Cancel Entries function to

add a line with a negative quantity.

Time entries can likewise be cancelled by using the relevant function on a CTC card or in time sheets.

When you cancel a time entry that has already been copied to a project, the ledger entry linked to the time entry is deleted as well.

You can, however, only delete entries that haven’t been invoiced yet. You also require the delete permission. 

If (for either reason) you cannot post a cancellation, you need to clear the reference to the project ledger entry in the time

journal. This turns the reversal entry into a simple correction posting that doesn’t cancel the time entry.

The quantity and value of both entries are the same whichever method is used. The difference is that cancellation links the entry

you want to reverse to the cancellation fields in the system.

Cancelled time entries also aren’t copied to project journals and, if they’ve already been turned into project ledger entries, the

ledger entries are cancelled as well.

MONITOR TIME ENTRIES

The following ease-of-use reports are available to either resources or time managers for checking time entries in the system.

Project Time Check

If run from the Time Recording role center, this report is already filtered to the user who opened it and you’re asked about the

month you want to check time entries for.

Afterward, the system opens the report request page, where you can see how entries are filtered in general (=per user and per

month).

Choosing Print or Preview & Close then creates a table that lists all posted and unposted hours recorded for project tasks and for

absence on each day of the week.

The Total Quantity field on the document shows the sum of all hours recorded on a certain day. The comparison of this value to

the expected (daily) capacity results in the difference shown in the Variance field.

At the bottom of the report, you can see a total line and flextime information, if available—for more details, see Set Up Time

Summaries (Flextime). 

Field Description

This field is used to analyze on a per contact basis the costs linked to sales and marketing

projects, which do not require customer numbers.

Note
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Proof of Performance

When run from the Time Recording role center, this report is also filtered to the user who opened it and you’re again asked about

the month you want to create a document for.

Prior to this request, you can choose the project for which you want to issue a proof of performance document.

You can then run the report from the request page to see the hours you spent on a project on different days, together with

information on the work package and the activity they were posted to. The total hours are shown at the bottom of the document.

The report can also be filtered to multiple resources. In this case, one list and subtotal are created per resource and the sum of

all resource hours recorded for the project in the specified period is displayed at the bottom.

Resource Capacity/CTC List

This special analysis is used to compare resource capacity to CTC values.

The report supports you in checking whether CTC cards have been posted for a certain workday or, at the very least, if they’ve

been released already.

It does not provide you with information about how many hours were actually posted and if these were above or below the hours

expected on a certain day.

The report only checks if a certain CTC card exists, if quantities are missing on CTC lines, that is, whether some hours haven’t

been worked yet, and if the time entries recorded on the card have been released or posted.

When a CTC card is released or when absence is registered for a day on which time was supposed to be recorded for on the card,

that day is deleted from the list. 

The purpose of this report is to give an overview of which workdays (days with available capacity) time has not been fully entered

on or absence has yet to be registered for.

PROJECT JOURNALS

Project time journals, CTC cards, and time sheets are all used to record worktime.

To ensure that projects include posted time entries—or, more specifically, that the entries are stored as project ledger entries—

the time spent on a project must be posted through a project journal.

Although this journal is used to post all kinds of entries, including those that cover the use of material taken from a warehouse,

the following paragraphs will focus on project time entries only.

To copy time entries to a project journal:

Choose the Search icon, enter Project Journals, and then choose the related link.

Select a journal. On the ribbon, choose Home > Get Project Time Entries.

You can then see the times that haven’t been added to the project ledger yet. Typically, as a project lead, you only need to copy to

the journal time entries recorded by resources who are under your management. You can therefore look at the entries for a

specific project or use the Person Responsible filter.

Alternatively, you can turn on the Check by Time Manager toggle in Projects Setup to have a time manager and a fill-in handle

the approval process. Either of them can then use the Time Manager filter in a project journal to view and edit entries by

resources they’re responsible for.

Projects can also be sorted according to the "Responsible for billing" filter. This ensures a smooth process, especially if the

person responsible for billing is also responsible for approving the time records.

Following approval, the journal is filled in with the required time data, and one journal line is set up for each time entry within

the specified filters.

This data also includes the quantity (=the amount of work performed) and the invoice quantity. Often, both values are identical,

although the invoice quantity can be changed if a service is billed by time and materials.

1. 

2. 
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The Manual Invoice Qty. field indicates whether the quantity to bill differs from the quantity entered by the system. When the

invoice quantity is changed—by the person recording time in the journal or by their manager in the Invoice Qty. % field on a

posted project budget line—the field is selected automatically and the new quantity is copied to the project journal.

Journal lines where the quantity and invoice quantity don’t match are marked in another color, and the difference between them

is shown in the Invoice Qty. Variance field.

If the Confirm Invoice Qty. Variance toggle is turned on in Projects Setup, you need to release project journal lines with this kind

of value difference prior to posting by selecting them and then running the Confirm Qty. Variance-Multiple action from the

ribbon.

Line values that aren’t supposed to differ from each other must be changed manually on each affected line. On lines set to No

Billing, the values always differ (the Invoice Qty. being 0). As a result, these lines are released automatically.

Posting the lines creates project ledger entries and clears the journal.

EXTRA PAY

Holidays and weekends

For holiday and weekend shifts, you can specify premiums that are calculated when resources record their hours worked in time

sheets, on CTC cards, or in time journals but which have an impact only after the time entered is copied to a project journal.

More specifically, a second batch of project ledger entries is created to cover extra pay when time entries are released and

posted through a project journal so that the premiums are available for billing.

Premiums and on-call or standby pay can only be used for entries that are posted in time tracking and through a project journal as

project ledger entries.

Note
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Setup Premium types

Choose the Search icon, enter Premium Types and Standby/On-Call Pay, and then choose the related link.

On the page, create a line for every type of premium that you want to set up, and then fill in the fields as described in the following

table.

project365 base calender

Following the creation of different kinds of premiums, you also need to specify on a certain resource’s calendar (or the shared

calendar stored in Resource Setup, at least) the days on which staff members typically do not work and the premiums that are

paid when they do.

Choose the Search icon, enter project365 Base Calendar, and then choose the related link.

Select a calendar, and then choose Maintain Base Calendar Changes on the ribbon.

In the Premium Type Code, select the kind of premium that you want to use when times are posted to the day specified on the line.

Time tracking

Initially, recording times that premiums need to be added for isn’t handled any differently by the system than if you recorded

time on normal workdays. When you select a date that a premium is entered for (see above), you’re asked if the specified

employee was requested to come in to work. Choosing Yes adds the premium to the times entered by the employee on that day.

Project journal

When time entries are copied to a project journal, the entries that premiums must be used for are marked in color (see Setup).

The only difference between these and other time tracking lines is the added premium type. Project leads can remove premiums

they don’t agree with and post the entries without them.

Premium entries

1. 

2. 

Field Description

Code Specify a code for the premium. The code must be unique.

Description Enter a description for the code, if necessary.

Invoice Qty. Factor Specify the factor that the quantity to bill should be multiplied with. A factor of 1.5 translates into

50% extra pay.

Example

On the weekend, a resource posts 4 hours of worktime (Invoice Qty. = 4), the premium being an extra

quantity of 2. Therefore, 6 hours will be billed to the customer.

Note

The unit prices for premium entries are the same as for their source entries.

Unit Cost Factor Specify the factor that the unit cost should be multiplied with. A factor of 1.5 translates into 50%

extra pay.

Example

On the weekend, a total of 4 hours is posted at a standard unit cost of USD50 an hour = USD200. The

premium entry has a cost of USD25 per hour so that the cost of the work performed amounts to

USD200 + (4 * USD25) = USD300.

Premium Type

Description

Enter a description that will be copied to all project ledger entries set up for the premium and to

proof of performance documents.

Type Specify if the premium is paid for work on weekends or holidays or for on-call or standby duty.

Style Choose a style if you want to set apart lines containing the premium from the rest of the project

journal lines.

1. 

2. 

3. 
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When hours that premiums have been added to are posted in a project journal, the system creates two project ledger entries, one

for the actual hours worked and another for the premium. Both are linked and show the same posting date and project number,

as well as the same work package or budget line.

The entry created for the premium is treated as a value correction. This means that the Value Correction checkbox is selected on

the entry, whereas the Quantity field isn’t filled in. Only the Invoice Qty. is entered, as the value in this field is later used when

billing the project.

The value correction (unit cost) and the invoice quantity are determined based on the factor specified on the Premium Types and

Standby/On-Call Pay page. The unit price for the premium and the source entry are identical. Additionally, the text you entered in

the Premium Type Description field is also retrieved.

On-call and standby times

Standby means that employees must be available to work and cannot use the time they’re in that status for other purposes. When

they’re on-call, they can—unless they’re needed.

Standby counts as worktime, on-call (typically) does not. This means that the time an employee is on-call isn’t included in the

quantity worked. Only if the employee is needed during on-call hours will the time be counted and posted in the same way as

regular worktime.
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Setup On call and standby

Choose the Search icon, enter Premium Types and Standby/On-Call Pay, and then choose the related link.

On the page, create a line for every type of premium that you want to set up, and then fill in the fields as described in the following

table.

Work packages

On-call and standby times are posted to special work packages. For each type of extra pay, another work package is needed.

Every project that time is posted to must also have this package entered on its WBS.

Work types and sales prices

The work package that you choose determines the work type of the entry. This type, in turn, is then used to calculate the unit

cost per hour. You need different work types for differing unit prices, and each work type also requires special prices for both on-

call and standby duty.

Unit cost

1. 

2. 

Field Description

Code Specify a code for the premium. The code must be unique.

Description Enter a description for the code, if necessary.

Invoice Qty. Factor Specify the factor that the quantity to bill should be multiplied with. A factor of 1.5 translates into

50% extra pay.

Example

A resource posts 4 hours of worktime (Quantity = 4). The quantity to bill might then be 6 because of

50% extra pay (factor 1.5).

However, a premium of 0 is also possible, depending on whether the time recorded is specified as on-

call or standby.

In the latter case, the factor remains at 1.0 and the line quantity and invoice quantity will be

identical.

Unit Cost Factor Specify the factor that the unit cost should be multiplied with. A factor of 1.5 translates into 50%

extra pay.

Example

A total of 4 hours is posted at a standard unit cost of USD50 an hour = USD200. The premium entry

has a cost of USD25 per hour so that the cost of the work performed amounts to USD200 + (4 *

USD25) = USD300.

However, a premium of 0 is also possible, depending on whether the time recorded is specified as on-

call or standby.

In the latter case, the factor remains at 1.0 and the line quantity and invoice quantity will be

identical. 

See also Unit Cost.

Premium Type

Description

This field remains blank, as no additional ledger entries are created.

Type You can choose between Standby or On-Call (for the differences between those two options, see

above).

Style Choose a style if you want to set apart lines containing the premium from the rest of the project

journal lines.
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You can specify unit costs per work type. For on-call duty, which doesn’t count as worktime, you can enter a unit cost of $0.00 so

that the time recorded for it doesn’t add costs to your project.

Time tracking

The process of recording hours for on-call or standby duty is the same as for entering regular worktime in the system, the only

difference being that a work package must be selected for the former.

Time entries

In contrast to standby time, on-call duty doesn’t count as worktime so that the Qty. field on entries specified as on-call remains

blank. Only the Invoice Qty. is filled in. To be able to see the time a resource spent on-call, a field called On-Call Qty. was added to

time sheets, cards, and journals. A work package code is also entered in the Premium Type Code field of each on-call entry.

Project journal

When time entries are copied to a project journal, the entries that premiums must be used for are marked in color (see Setup ).

You can see the factor specified for an entry in the Invoice Qty. or the Unit Cost field on the relevant project journal line. This is

because—in contrast to holiday and weekend premiums—extra pay for being on-call or on standby doesn’t lead to additional

project ledger entries in the system.

The sales price for an entry is copied automatically from the price table that is assigned to the specified work type.

For on-call duty, the hours worked are copied from the On-Call Qty. field on the entry.

Project ledger entries

On-call or standby entries don’t differ much from other time entries, except for their filled-in Premium Type Code fields.

BUSINESS REGISTRATION CERTIFICATES

A Freistellungsbescheinigung (often translated as a certificate of exemption) was introduced by the German government to

combat tax evasion, especially in the construction sector.

This business registration certificate is issued pursuant to Section 48b of the German Income Tax Act and provides proof that a

subcontractor pays its fair share of taxes.

If the certificate hasn’t been made available, companies doing business with the subcontractor will be required by law to

withhold 15% of all invoice totals to cover potential tax liabilities.

You can open a vendor card to check the status of registration based on the following (purely informational) fields:

You'll be notified if this kind of certificate is needed but hasn’t been provided yet when you enter a vendor on a purchase

document.

EXTERNAL RESOURCES

Set up an external resource

External resources can be procured through purchase documents.

All external resources require a vendor for billing services. This vendor might be a staffing agency, for example. For a freelancer,

you need to register both a resource and a vendor and link them to each other.

When you later enter the resource on the budget line of a project, the associated vendor is also copied to the line. This way, you

can have the system calculate unit costs for the resource-vendor combination and use the vendor to create purchase orders from

the budget.

Field Description

Business Registration Certificate Shows if a certificate is available.

Registration Certificate Valid Until Shows how long the certificate remains valid.
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External resources can have unit costs, unit prices, project-specific resource prices, and purchase prices. In contrast to standard

unit costs, prices and costs set up this way are always tied to a certain vendor, that is, the relevant vendor is retrieved when you

procure the external resource or include the resource in a budget.

If no unit cost is stored with the vendor, a unit cost is copied from the standard Unit Cost table. If no suitable cost is found there

either, the required value is copied from the associated resource card.

If you have a specific group of external workers in mind when you start working on a project, we recommend that you set up a

resource for each of them and assign a vendor, costs, and prices right away.

For external resources who record time like employees, you need to turn on the Use Purch. Invoice Entries toggle on their

resource cards. This will create invoice entries for them during billing so that projects aren’t posted to twice.

Procure a resource

You purchase a resource in the same way as you do items:

Open the WBS of a project.

On the ribbon, choose New > Create Purchase Document.

Fill in the fields as necessary.

This copies the resource to a requisition worksheet or a purchase order.

You can also create a purchase document manually. In this case, you need to enter the relevant project number on individual

document lines (if you’ve entered the number on the header, it is copied to new lines automatically) and use the Get Work

Package function to copy the number to a WBS line or a budget line, depending on the Purchase Posting Level specified for the

project.

Choose Yes on the dialog page that appears if you also want the description of the resource copied from the WBS or budget line.

If you choose No, the system will retain the description that you entered on the purchase line.

Typically, you would then post consumption from a purchase order when items have been received by adding their quantities and

prices to the project. In the case of external resources, however, the services rendered are often posted with receipt of a bill.

If, on the other hand, you want to post the acceptance of services immediately—that is, post project usage before you get a bill—

and the bill shows a different unit cost for the external resource, the project ledger entries created from the resource’s time

postings are adjusted automatically based on how much you need to pay.

Distribute purchased work

Typically, the system creates one project ledger entry for each posted purchase line or purchase invoice line related to a project.

Sometimes, however, you might want to post project expenses at a more granular level.

With the project distribution feature, you can, for example, distribute WBS line quantities onto multiple budget lines without

having to list every little aspect on the associated purchase document. This way, you can keep detailed project posting

information handy while streamlining your document.

When you use the distribution feature, you must always distribute the entire quantity; otherwise, you cannot post the document.

You’ll see a message if not everything has been allocated yet.

You can distribute a quantity on different WBS lines of the same project at the level of the work breakdown structure or its

budget lines.

Track resource costs

Like other resources, an external resource can post hours in a time journal. This isn’t a requirement; a purchase invoice that lists

the hours worked would be enough.

However, because a considerable amount of time might pass before the hours are billed, you might run into problems when

trying to invoice your own customers. For this reason, we recommend that external resources post their times immediately.

To avoid a situation in which expenses are posted to a project twice, the invoice you get from an external resource will later be

applied to the project ledger entries created from the resource’s time journal.

1. 
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Purchase invoices and invoice entries

When you post invoices for hours recorded by an external resource, you must apply the project ledger entries posted so far to

prevent billing a customer twice for the same work (once because of the time entries and once due to the invoice). If the resource

doesn’t post time, application isn’t needed.

To prevent the posting of invoices without invoice entries (which have already been recorded as time entries), you must turn on

the Use Purch. Invoice Entries toggle on the relevant resource card. After turning on the toggle, you can post neither receipts

nor invoices without these entries, and an error message appears if you try to do so.

Receipts and invoices are then posted in one go. Should you want to separate them, you need to assign invoice entries with the

delivery of services. Otherwise, project ledger entries will be posted as always.

Example:

An external resource uses a time journal to record a total of 6 hours. These hours are then posted to a project through its project

journal.

To settle the amount that you now owe the external service provider, you proceed by creating a purchase invoice from the project

and entering 6 in a Qty. to Receive field on a line. You also check if the Line Amount excl. VAT field there shows the correct value.

Afterward, you choose Line > Purch. Invoice Entries (on the Lines FastTab) to assign invoice entries to the line. This opens a new

page on which you select the resource’s unapplied project ledger entries and choose Add Entries on the ribbon.

You then choose OK to copy the ledger entries to the purchase line. The invoice entry totals and the Qty. to Receive field values

from the line can now be seen in a FactBox on the right-hand side of the Purchase Invoice page.

A difference in these amounts means that there’s something wrong with either the direct unit cost on the purchase line or the

unit cost on the resource card. If you don’t see an error message, you can start posting corrections to quantities or project ledger

entries, or both.

For technical reasons, deleting one or more invoice entries will not update the totals on a purchase line. Instead, you need to run the

Update Totals function. All totals are also updated when you reopen the invoice page or add project ledger entries.

Value or quantity corrections, or both, are only made when you post an invoice. The corrections are documented on a purchase

line in the Correction Project Amount (LCY) and Project Qty. Correction fields. After you posted updates to values or quantities

and acceptance of the services, project ledger entries can no longer be added to the invoice.

You can post multiple receipts to a single purchase order to gather invoice entries in one place. When you later post a bill for the

order, the Qty. to Invoice must match the combined value of the Qty. to Receive and the Qty. Received fields.

You cannot post partial invoices for the services you accepted, as you cannot assign invoice entries from a purchase line to more

than one invoice. The same is true for a correction you make to an entry.

Post corrections

Because of the use of invoice entries for bills received from external resources, you typically only need to post a project ledger

entry if you want to make a value or quantity adjustment. The following list shows what this kind of adjustment might look like.

Note
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Adjust quantities

You post quantity corrections as if you were posting project ledger entries to a purchase invoice without invoice entries. This

means that a change in quantity and a change in value always go hand in hand.

Adjust values

Value adjustments are also posted as project ledger entries but without a quantity. This adjusts unit costs in a project without

changing the quantity or even the invoice quantity. You can easily spot project ledger entries adjusted in this way by checking if

their Value Correction checkbox has been selected.

COST OF MATERIALS

Besides resources, a project might also require materials. Their costs are added to a project when you order items for it.

Whereas you use WBS or budget lines to specify and meet item demand, you usually replenish inventory via the supply chain

functionality.

However, you can also fill in a project number on a purchase line to purchase items for a project but not add them to inventory.

The items are then consumed immediately as you post their purchase.

Project Purchase Incl. Inventory

To decouple inventory management from item consumption, you need to turn on the Project Purchase Incl. Inventory

Management toggle in Projects Setup.

With the toggle turned on, items are added to inventory as you post their receipt but aren’t consumed right away. You must use a

project shipment to do so manually.

To link inventory items to budget lines, you can use the Create Purchase Document function on a WBS. Alternatively, you can

create a purchase order during a planning run and select the Reorder Qty. replenishment method for each item you require.

Both methods will assign items to the project budget through order tracking entries and the Project No., Work Package, Phase

Code, Task Code, and Step Code fields.

Manual and automated reordering

The requisition worksheet feature integrated into Microsoft Dynamics 365 Business Central1 provides you with a multitude of

options for estimating item demand. Based on how you set up supply chain and inventory management, a requisition worksheet

can then be used to calculate demand for an item and suggest a reorder quantity to you.

Requisition worksheets, however, typically ignore demand that goes directly to projects. To change the behavior of the app and

include project materials, you can use either the Requisition checkbox on budget lines or the Create Purchase Document function

on a work breakdown structure. The drawback of the function is that it doesn’t check stock or order levels but only informs about

them.

As using both options for project management might lead to purchases being made twice, we recommend you stick to one of

them for projects. If a decision on this can’t be made right away, you should at least clear the Requisition fields on budget lines

from which you want to order manually.

1.2.4 project365

- 749/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Automated reorder process

Automated ordering uses the Requisition checkbox on WBS lines to budget demand for items ordered through worksheets. To

automate ordering:

Choose the Search icon, enter Requisition Worksheets, and then choose the related link.

On the ribbon, choose Calculate Plan.

On the Options tab, fill in the Starting and Ending Date fields. The worksheet will ignore demand outside the planning window.

Fill in the Use Forecast field if you want a plan that already includes data about demand.

Fill in the Exclude Forecast Before field if you don’t want to include demand created before a specified date.

A worksheet you create in this way will then include all items that you entered on the budget lines set up for a project, but only if

the lines are part of on active WBS and if the Requisition checkbox was selected on all of them. All related WBS lines must be set

to Open as well.

Be aware that a worksheet also retrieves the settings you made on item cards. If the item you want to reorder wasn’t specified

well enough there, demand for it might not be estimated correctly or even not at all.

To create a purchase order from a line on the requisition worksheet, choose Process > Carry Out Action Message. To print the

order, turn on the Print Orders toggle.

Manual orders

As an alternative, you can create certain purchase documents directly from a work breakdown structure. To bypass automated

ordering, open a WBS and choose New > Create Purchase Document on the ribbon.

You can then fill in the filter fields on the request page. For the type filter, you can select Resource, Item, or G/L account (unless

you’ve already specified a default filter in Projects Setup), and in the Document Type field, you can choose Quote, Order,

Requisition, or Purchase Request.

Additionally, you can turn on the Ship-to Project Address toggle if you want the address entered for the project copied as the

delivery site to the new document, with the Ship-to field set to Custom Address there.

If you turn on the Ship-to Location Address toggle instead, the Ship-to field will be set to Location and the address from the

budget lines will be entered in the Location Code field on the purchase document so that only lines with identical codes will be

included in the transfer.

If both toggles are turned off, the Ship-to field will be set to Default (Company Address).

Afterward, you need to ensure that the Buy-from Vendor No. field is filled in on the lines. For item lines, the default vendor is

entered automatically but can be changed if necessary.

The system then suggests the budgeted quantity minus the quantity ordered or consumed as the quantity that you need to

reorder. For a better overview, you can also see all quote, order, and requisition line quantities associated with the line here, as

well as the quantities received or used.

If you want to copy only a certain number of lines, you must select the Copy to Purchase field at the beginning of each line you

want to include in the transfer. You can also select the Copy Budget Text to Purch. field on them to copy text entered on budget

lines to the new document.

You can then choose OK to create the purchase document. 

Purchase requests

A purchase request can be considered a pre-procurement document. You can use this feature—as a project lead—to send a

request for items, G/L accounts, or external resources to your organization’s procurement department.

1. 

2. 
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You need a valid license to work with purchase requests. You must also turn on the Purchase Request toggle in KUMAVISION Module

Setup.

This article describes the purchase request extension developed for KUMAVISION project365. For general information on how to set

up requests and how they work, see the Purchase Request section.

Pseudo items as used on requests in KUMAVISION base (Booster) are currently not supported by project budget functionality.

Projects Setup

Besides general purchase request setup, you can specify a workflow code that will be used exclusively for requests in

KUMAVISION project365.

Choose the Search icon, enter Projects Setup, and then choose the related link.

On the Manufacturing and Warehouse FastTab, fill in the following field:

Create a request

To create a purchase request for a project:

Open a project.

On the ribbon, choose Project > WBS.

Select the line for which you want to create a request.

On the ribbon, choose Create Purchase Document.

Choose Purchase Request in the Document Type field on the header.

Select the Copy to Purchase field on the budget lines that you want to transfer to a new request.

You can see in the Qty. on Purch. Request field on each line the quantity that has already been copied to purchase requests. The

value in this field doesn’t automatically reduce the quantity suggested for purchase, as requests aren’t tied to standard

procurement processes.

After selecting the relevant budget lines, choose OK to link the request to the current project and the request lines to the budget

lines.

You can find a list of all requests associated with the project by choosing Related > Documents on the ribbon.

When the request is approved, the purchase lines created from it will be linked to the same budget lines as those included

earlier.

Transfer orders

You can move items from one location to another by creating a transfer order. These orders are mostly used if the replenishment

method for inventory is set to Transfer.

Note

Note

1. 

2. 

Field Description

Purchase Request Workflow

Code

You must fill in this field if want to work with purchase request.

When you create a request from a project, the value in this field is then filled in

automatically.

For more information, see Create a Request.
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In KUMAVISION project365, you can move an item on a project budget line from the default location set up in the system to a

location that is assigned to the project (or, more specifically, to the line itself).

An item that is moved to a project location will be reserved for the line that it has been assigned to, as specified for the moved

item entry in the Project No., Work Package Code, and Line Activity No. fields.

As a result, you can post consumption of the item only on this one budget line. See the following articles for more information on

transfer orders:

Moving Items

Transfer Inventory Between Locations

Create a transfer

To create a transfer order:

Open a project.

On the ribbon, choose Project > WBS.

Select the line for which you want to create a transfer order.

On the ribbon, choose Create Transfer Document.

Select the Copy to Transfer field on the budget lines that you want to transfer to a new order.

The following fields on each line are of great import here.

What will be transferred is the Order Quantity on a line, which is calculated in the same way as for the Create Purchase

Document action. The value in the Order Quantity field is only a suggestion and can be changed if necessary.

The other fields on the page used for the Create Transfer Document function can provide you with information about, for

example, the quantities budgeted and consumed, and the following transfer-related values.

To get a quick overview of what items must be moved, the page only shows transfer-related budget lines. These lines must have:

A stockkeeping unit for this item and location with the Transfer replenishment method.

An item quantity that isn’t part of a transfer order.

• 

• 

1. 

2. 

3. 

4. 

5. 

Field Description

Location Code Shows the location specified on the project budget line. This location represents the target site for the

transfer (=project location).

Transfer-from

Code

Shows the place from where items should be moved.

This code is copied automatically from a stockkeeping unit if the item replenishment method has been

set to Transfer. Otherwise, you need to choose a code manually.

Field Description

Outstd. Qty. on Transfer

Order (Base)

Indicates the quantity that will remain after you posted the transfer.

Project Inventory (Base) When a transfer order has been fully posted (shipped and received), shows the quantity moved

as project inventory (that is, the quantity reserved for the selected project budget line).

General Project Inventory

(Base)

Contrary to the previous field, shows all reserved inventory at the location.

If necessary, you can delete a project reference from inventory (see Delete Item Entry

Reference).

Inventory Shows the total stock at the selected location, regardless of whether it has been reserved for

projects (=project inventory).

1. 

2. 
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A budget line isn’t suggested if the quantity specified on it is already part of a transfer order, has been moved to project

inventory—as might be indicated in the Project Inventory (Base) field—or has been consumed (from inventory).

For an unfiltered view on all budget lines, you can turn on the following toggles on the Create Transfer Doc. From WBS page.

Take from inventory

You can use the (Inventory) Take action to transfer available (unreserved) item inventory to budget lines. Inventory that has

already been assigned to a project can be identified by the project number stored for the relevant item entry.

On budget lines, the function is called Inventory Take and takes out items for a selected line. On planning worksheets, you can

only start the function for a line assigned to a project budget.

When you run the action, you’ll see the project inventory available at line level and a list of all unreserved, positive, and

unassigned item entries that are linked to the location specified on the line. On this list, you can then enter per item entry the

quantity that you want to take out of inventory—provided it doesn’t exceed the number of items left on the line. You can also

clear the Project No. filter if you want to transfer items from other projects.

When you close the page, you’re asked to confirm that you want to transfer the selected items. Choose Yes to move the quantities

to project inventory and assign them directly to the project (or, more specifically, the budget line) through a project reference on

the item entries created by the function.

Afterward, you need to use a project shipment to post consumption. Only then will the item be taken from the location and

consumed.

The result of the Transfer Order and Project Take functions is the same. Both create item entries that are directly linked to a budget

line so that consumption can be posted only on that line.

The difference is that the Inventory Take function uses entries that are already at the location they’re supposed to be (the location

specified on the relevant budget line), whereas transfer orders retrieve items from another location.

Stock commitment

As explained earlier, items can be linked to a project in multiple ways, for example, via project purchase, inventory removal, or

transfer from one location to another.

Their value entries make up what is known as stock commitment in the app. It indicates inventory that, for all intents and

purposes, has been put aside for a specific project and is shown as a flow field quantity at WBS and budget line level, as well as

on the project card.

You can track reductions and increases in these kinds of reservations by using the lookup next to a commitment field. This way,

you can see how the quantity committed to a project has changed with each inventory-related posting (such as when you post a

purchase receipt and later adjust the purchase price of the items on the associated invoice).

When you delete a project reference, you might also have to delete the reservation associated with the project. Otherwise, you

see an error message that not enough inventory is available. Afterward, you can delete the reference and transfer the quantity

remaining on the project. Because of the transfer, the stock commitment field is also cleared, as the value entry linked to the

item is no longer related to a project.

Delete a reference to a project

Toggle Description

Show Items If No

Order Qty.

Also shows items that have been fully consumed, have been moved, or are about to be moved so

that you can request additional transfers, for example.

Show Items If No SKU Also shows budget lines with items that have not been set up for transfer or have no stockkeeping

units.

Note
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When an item is moved via transfer order or taken out of inventory, the system creates at the target location (=line-specific

project inventory) an item entry based on this transfer or removal and includes a reference to the relevant budget line (by filling

in the Project No., Work Package Code, Phase Code, Task Code, Step Code, and Line Activity No. fields). The entry can then be

viewed on the budget line in the Project Inventory (Base) field.

The same is true for project purchases without immediate consumption (Project Purchase Incl. Inventory).

Should you determine that reserved project inventory is no longer needed, you can transfer the remaining quantity to item

ledger entries without a project reference.

If a project reference is created by a purchase receipt that isn’t consumed immediately, an error message appears, and you cannot

delete the reference before you invoice the receipt. You then need to post the invoice or move the item to general inventory.

Besides a relation to a project, an item ledger entry might also be linked to reservation entries on a budget line. In this case, you can

delete the reference only after you’ve manually deleted those entries.

This will clear any project reference and make the inventory accessible again.

Instant Consumption Posting (purchases)

As explained under Project Purchase Incl. Inventory, purchased materials are consumed immediately if you turned on the toggle

with the same name in Projects Setup.

If the toggle is turned off, you must use the Post action on a purchase order for this.

When a receipt is posted, consumption is then posted as well. In inventory, a positive adjustment is made at the same time, and

the item that you received is posted to the project instantaneously.

For correct posting, the Vendor Receipt No. and Vendor Invoice No. must be filled in, and the order must have been released. 

PROJECT DOCUMENTS

The following documents can help make posting consumption to projects faster and easier to track.

Project shipments

Project shipments, or, more specifically, shipping notes, offer your customers more information about the goods and services that

you deliver to them.

Often, the shipments made for a project aren’t linked to a specific sales order. But because they’re included in the project

budget, you can list the goods and services that you’ve shipped on special documents.

You can create shipping notes in one of two ways. To create a note manually:

Go to your role center.

Choose Project Documents > Project Shipments at the top of the page.

On the ribbon, choose New, and then fill in the lines.

The manual creation of shipping notes is very time consuming and prone to errors. We recommend that you only use this method

for editing and instead create new notes by running the Create Project Shipment action from a work breakdown structure.

Note

Note

Warning

1. 

2. 

3. 
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This action shows you all budget lines of the active WBS. Select the Copy to Project Shipment checkbox on each line that you

want to transfer to the new shipment, and then choose OK.

Afterward, you see a message that the shipment has been created and you can open the document immediately.

Like on purchase and sales documents, you can add standard and extended texts at the beginning and the end of a note.

Posting a shipment creates time entries or, if the project also involves items, item picks and project usage. You can change the

default shipping values by editing the Shipment FastTab fields on the Project Shipments page.

On the same page, you can also turn on the No Usage Posting toggle so that usage for projects isn’t posted in the background.

This is crucial if you want to use notes only as customer receipts—for example, if the items you bought for a project are

consumed right away and aren’t moved to inventory.

The toggle is turned on automatically when you create a note from a project so that the system doesn’t pick items and posts

consumption yet again.

You can post a note together with a warehouse shipment. For this purpose, the note must be released. To create a warehouse

shipment, you need to run the function with the same name on the Project Shipments page or on the shipping document itself.

Warehouse shipments are only created for project shipment lines that contain a storage location code. The No Usage Posting toggle

also needs to be turned off in this case.

Project vendor shipments

The vendor shipment feature provides a supplier with items needed to finish a purchase order. It is used both to pick items from

inventory and to send notes to suppliers.

The items picked are then posted as consumption to a project. Each shipment can be assigned to a vendor through a purchase

order.

The functions provided with project vendor shipments and project shipments are the same and either can be posted with a

warehouse shipment. Their only difference is the page where you fill in the data for each document.

To create a project vendor shipment from a WBS, open a structure and choose Home > Create Project Vendor Shipment on the

ribbon.

To create a shipment manually, open the Project Vendor Shipments page and choose New on the ribbon. This creates a blank

shipment card, where you can enter a vendor number and address. Alternatively, you can have the vendor assigned automatically

by filling in the Purchase Order No. field on the card.

Undo shipment

You can use the Undo Shipment ribbon action to reverse one or more shipped lines on a posted project document. You can only

reverse a line quantity in its entirety, however.

When you run the action, a corrective line with a negative quantity is added for each line you want to undo. For partially shipped

lines that a source document is still available for, the quantity is reset in full.

Example

You enter an item quantity of 10 on a vendor shipment line. You then post six of the line items as received, with four remaining.

When the line is reversed, the outstanding quantity on it is reset to 10. If the unposted line is no longer available, however, the

line cannot be reset and the system doesn’t create a replacement document (which must be done manually, if needed).

With the undo function canceling the entire shipping process (that is, unless you’ve turned on the No Usage Posting toggle), the

following happens:

1. When you reverse a quantity associated with a resource…

Warning
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a) …the related time entry is corrected as well. 

b) If the time entry has been copied to a project journal and posted as a project ledger entry, this ledger entry is also reversed.

Project ledger entries that are included on invoices or have been billed already can no longer be corrected.

2. When you reverse an item quantity…

a) …the related item ledger entry is corrected as well. 

b) With item tracking, this might affect several item ledger entries (that is, all entries created for a certain serial number).

c) …the associated bin entries are also reversed.

d) If the item was entered on a partially shipped warehouse document, the system additionally cancels the relevant line on this

document (in the same way as the project document line).

Corrected quantities remain ‘reserved,’ as every consumption entry that you want to reverse includes a project reference (such as a

project number or a work package code) and the reversal entry will also contain this reference. If you want to make the item

available again to all projects, you need to use the Delete Project Reference ribbon function.

If you reverse item consumption on a warehouse shipment document, the item will remain stored in the warehouse shipment bin

at the associated location.

PROJECT LEDGER ENTRIES

Regardless of the method you choose to post project expenses, each posting that you make creates project ledger entries of type

Usage. This includes posting times in a project journal, resource costs in purchasing, or lines on project shipments.

Project ledger entries are used to:

Assign costs to a project.

Bill by time and materials.

Provide proof of performance.

Analyze a project in cost control.

Measure the progress of work completed.

See the following table for a more detailed explanation of the key fields found on the Project Ledger Entries page.

Note

Note

• 

• 

• 

• 

• 
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Important fields
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Field Description

Posting Date Specifies the posting date of consumption, for example, as shown on a purchase document.

Performance Date Specifies when work was performed. Typically, this date is identical to the posting date.

However, the dates might differ, for example, when you post hours for a previous month.

Performance

Resource No.

Only filled in for posting the consumption of resource hours. Typically, the value in this and in the No.

field are identical.

But the numbers might differ, for example, if you’re using Comsol for posting travel expenses. The

expenses are then posted to dummy resources, whereas this field is used to assign a resource number

to the person who took the business trip.

Start Time

End Time

Only filled in if usage is the result of hours being entered for a project with start and end times.

Entry Type Shows either Usage or Sale.

Usage entries can come from a variety of sources (such as purchases, project journals, and project

shipments) and are used to allocate costs to a project (unless they are part of credit memos or

reversals).

Entries of type Sale are created by posting invoices or credit memos. They reduce the costs of a

project (unless they are part of credit memos or reversals).

Document No. Specifies the number of the document that is assigned to the entry.

Typically, this number originates from a posted document, such as a sales or purchase invoice, but it

might also have been retrieved from a posted project journal line.

You can configure the display of document numbers on journal lines by using two fields in Projects

Setup. For more information, see Project Setup.

Project No. Specifies the number of the project that the ledger entry was posted to.

Type Specifies the type of usage or revenue, resource, item, or G/L account stored with the ledger entry.

No. Shows the number linked to the usage or revenue, resource, item, or G/L account stored with the

ledger entry.

Work Package

Code

You always post (usage or revenue) to a project on the lines of an active WBS.

The ledger entry is linked to a WBS line through the project number and work package, as well as

phase, task, and step code fields.

Line Activity No. Specifies the number of a budget line activity if you posted to the project at budget line level.

Unit of Measure

Code

Indicates the unit of measure in which usage or revenue is shown.

Quantity For time and materials entries, specifies the usage quantity.

For revenues, the value in this field is copied from the associated sales invoice line.

Unit Cost For time and materials entries, specifies the unit cost of the usage entry.

For revenues, the unit cost is not relevant so that the field shows a value based on the Type and No.

fields on the sales invoice line.

Note

Project values are always measured in local currency, with the unit cost equaling the amount in the

Total Cost (LCY) field. It does not matter in this context in which currency project usage was posted or
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Field Description

if an invoice currency has been specified. KUMAVISION project365 does not support the use of

another currency in planning.

Total Cost For time and materials entries, specifies the cost of project usage as an amount.

For revenues, the cost amount is not relevant so that the field shows a value based on the Type and

No. fields on the sales invoice line.

Billing Type Shows the billing type of the associated WBS line.

If you change the billing type on that line, the new type will also be copied here.

Billable Indicates if the project ledger entry can be billed. Only used for time and materials entries.

If the field has not been selected for a time and materials entry, the entry will not be included when

you bill the project.

This is in contrast to a ledger entry where the field has been selected but the invoice quantity is 0 see 

(here).

Invoice Unit of

Measure Code

For time and materials entries, specifies the unit that should be used to bill the entry. In the case of

resources, the unit to be used depends on the work type.

For revenues, indicates the unit in which the invoice line was posted.

Invoice Qty. Only used for time and materials entries. Specifies the quantity that should be billed.

The value in this field might differ from the value in the standard Qty. field.

An entry with no invoice quantity but the Billable field selected will be copied as far as the proof of

performance document, for example, to show customers free-of-charge services.

Unit Price For time and materials entries, specifies the sales price for the entry. If no sales order is linked, this

price will also be suggested for billing.

For revenues, shows the unit price from the sales invoice line.

Note

In contrast to unit costs, unit prices can be displayed in a project-specific invoice currency. The price

in local currency is then shown in the Unit Price (LCY) field.

You should always bill entries in the invoice currency specified for the project.

Line Amount For time and materials entries, shows the result of multiplying the invoice quantity with the unit price.

For revenues, shows the quantity times the unit price.

Line Discount

Amount

For time and materials entries, shows the line discount that will be used in billing.

For revenues, shows the line discount specified on the associated invoice line.

Line Discount % For time and materials entries, shows (in percent) the line discount that will be used in billing.

For revenues, the field shows (in percent) the line discount specified on the associated invoice line.

Line Amount (LCY) Shows the result of multiplying the unit price with the line discount.

Invoice Currency

Code

Indicates the currency in which the project should be billed.

Sales amounts stored with project ledger entries are shown in both local and invoice currencies.
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Field Description

Invoice Currency

Factor

Copied from the project card. Indicates the factor used to convert the unit price in local currency to

the price in the invoice currency.

Invoice Entry Only used for time and materials entries.

When a project ledger entry is being prepared for billing (which means the invoice has not been

posted yet), the system assigns an invoice entry to the ledger entry and the sales (order or invoice)

line. This prevents project ledger entries from being billed twice.

Invoice entries have entry numbers identical to project ledger entries and can be printed on

preliminary proof of performance documents. For a more detailed explanation, seeBillings.

Posted Invoice

Entry

Only used for time and materials entries.

When you post a sales invoice, the system copies the invoice entries created for it along with other

data to the newly posted document.

This then closes the assigned time and materials entries so that they can no longer be copied to

another invoice.

A posted invoice entry is the link between a time and materials entry and a revenue entry. It has the

same entry number as the project ledger entry and can be printed on proof of performance

documents. For a more detailed explanation, see Billings.

Applies-to Sales Only used for time and materials entries.

Shows for an entry of type Sale how many time and materials entries will be billed with it. The time

and materials entries are connected to the sales area through posted invoice entries.

Sales Adjmt. Qty. Only used for time and materials entries.

Shows for an entry of type Sale the total time and materials quantity that will be billed with it. The

time and materials entries are connected to the sales area through posted invoice entries.

Purch. Invoice

Entry

Indicates for entries of type Usage linked to external resources (with time postings) if the entries were

prepared for billing on an unposted purchase invoice. For more information, see Purchase Invoices

and Invoice Entries.

Posted Purch.

Invoice Entry

Indicates for entries of type Usage linked to external resources (with time postings) if the entries were

billed with a purchase invoice. For more information, see Purchase Invoices and Invoice Entries.

Add. Purch. Entry

Link

Contains time and materials entries from a purchase invoice created for external resources (with time

postings) if the quantities on the invoice differ from those entered in time recording.

The new values are then posted to the project. For more information, see Purchase Invoices and

Invoice Entries.

Add. Purch. Value

Entry Link

Contains time and materials entries from a purchase invoice created for external resources (with time

postings) if the values on the invoice differ from those entered in time recording.

The new values are then posted to the project. For more information, see Purchase Invoices and

Invoice Entries.

Ledger Entry No. Shows the usage entries, that is, the resource, item, or G/L account entries linked to the project

ledger entry.

Entry No. Shows the (unique) number of the ledger entry.

Time Entry No. Shows an entry number if the ledger entry was created by retrieving and posting a time entry in the

project journal.
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Actions

The following functions can be run from the Project Ledger Entries page.

Edit Entries

What all ledger entries in Microsoft Dynamics 365 Business Central1 have in common is that once created, they can be changed

only to a limited extent. This is also true for project ledger entries.

For this function to work, the project ledger entry that it is used for must be of type Usage and cannot have been billed already

(that is, the Invoiced field cannot be selected). Entries that will or have been reversed cannot be changed.

Only the following fields stored with an entry can be edited at all:

Description and Description 2

Invoice Qty.

Billable

Unit Price

Line Discount %

Line Activity No. (for the same work package or WBS line by deleting the line activity filter on the Budget Line Activities page)

Most the of these will affect billing. But to correct costs specifically, you must reverse the project ledger entry and repost it with

the correct values.

Apply Entries

Assigns time and materials entries to an existing entry of type Sale. This will close the entries so that they cannot be billed again.

You can run this action after selecting either entry, which affects whether the system will suggest time and materials or revenue

entries for application.

When you bill by time and materials, posted invoice entries are used for application automatically. The business logic of

KUMAVISION project365 employs this method for time and materials entries only, although you can do the same manually for other

billing types.

Applied Entries

Shows the applied entries linked to the project ledger entry.

You can run this action from time and materials or from revenue entries. Your choice determines if you’re shown a revenue entry

closing time and materials entries or time and materials entries applied to a revenue entry.

Change Work Package

Field Description

WP Modified

[multiple fields]

Indicates for an entry whether, when, and by whom the work package entered for the project was

changed. Only used for unbilled time and materials entries.

Value Correction Belated corrective entry from a purchase invoice.

This entry is created for an external resource if a purchase receipt was posted with a differing unit

cost. The correction concerns only the unit cost, not the quantity or unit price.

Contact No. Shows the contact number entered during time recording.

This field is used to analyze on a per contact basis the costs linked to sales and marketing projects,

which do not require customer numbers.

• 

• 

• 

• 

• 

• 

Note
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Changes the work package assigned to a time and materials entry.

This function provides you with an easy way to correct postings in the system. The change in work packages—and potentially

work types—might also lead to repricing.

You can only change a time and materials entry before the entry is billed. You cannot use this function on revenue entries.

However, you can use the Change Work Package Multiple option on the ribbon if you want to select multiple time and materials

entries at the same time.

Suggest Account Transfer

The Suggest Account Transfer function goes a step further than the previous action.

When a time and materials entry is selected and the function is run, the entry is copied to a negative posting line on the project

journal for cancellation. At the same time, the action retrieves a new target project and a WBS line therein. This results in two

lines that must be posted in the project journal.

Correct Dimensions

Starts a correction for one or more selected dimensions.

This action serves essentially the same purpose as the function used to correct general ledger entries. For more information, see 

Troubleshooting and correcting dimensions - Business Central | Microsoft Learn.

Entry type for G/L account posting

he type of a posted document also determines the type of project entry created for it. Typically, sales documents create entries of

type Sale and purchase documents entries of type Consumption. You can, however, change the type, if necessary.

Choose the Search icon, enter General Journals, and then choose the related link.

Select an account, and then choose Related > Account > Card on the ribbon.

On the Projects FastTab, in the Project Entry Type field, choose one of the options described in the following table.

The original type is then replaced on the relevant document and in the general journal. You can make use of this feature in

situations such as the following:

During purchase: Negative revenue is billed by a supplier.

During sale: Foreign taxes need to be included on an invoice.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

1. 

2. 

3. 

Option Description

(blank) G/L posting works as in the standard app (see above).

Usage The ledger entry associated with the G/L account is posted as consumption (even on sales documents).

Sale The ledger entry associated with the G/L account is posted as revenue (even on purchase documents).

• 

• 

1. 
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Billings

OVERVIEW

The articles in this section focus on how you invoice projects and their work packages. All project work can be billed via direct

invoices or sales orders.

SALES & RECEIVABLES SETUP

Two fields have been introduced on the "KUMAVISION" FastTab in the "Sales & Receivables Setup", which affect the printing of

sales documents (quotation or order confirmation).

Disable Delivery Date Print List

On this page, you can specify whether the delivery date for G/L accounts, resources and items should not be printed in the sales

order confirmation lines.

If the delivery date is generally to be printed for a type (G/L account, item, resource), no entry is required on this page.

CREATE SALES QUOTES AND ORDERS

Sales documents are the foundation for customer-centered business transactions. 

To transfer project sales to a quote or an order, open a work breakdown structure and choose New > Create Sales Document on

the ribbon.

On each WBS line, you can select in the Copy to Sales Doc. field if you want to copy the line itself—as representing the total of

detailed budgeting—or transfer individual budget lines and their prices.

You will need to decide this on a case-by-case basis. For example, some customers might not require invoices that describe more

than a work package, whereas others might need to be billed for individual components or partial services.

If budget lines are transferred to a sales document, items stored on them are often copied automatically. Resources and resource

groups, however, must be converted to billing-neutral resources before transfer.

Field Description

Disable Deliverey Date Print

Existing

This field shows whether there are settings on the "Disable Delivery Date Print" page. A

lookup opens the page.

Suppress Automatically Set of

Shipment Date in Sales Quote

This switch prevents the "Delivery date" from being set automatically in the sales offer

header. It is useful if the delivery date is generally to be printed in the offer document

but has to be entered manually. 

Note:

KUMAVISION project365 does not provide for the printing of this field and requires a

customer-specific adjustment.

Field Description

Type Specifies the type for which the delivery date should not be printed. You can choose from the following: 

- G/L account 

- Item

- Resource

No. You can fill in the field to further limit the print suppression by specifying a specific number.

If you want the setting to apply to all G/L accounts, items or resources Ü, simply leave the field blank.

Note
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If a WBS line is copied instead, the system will create a sales line that contains the billing base and number of the relevant work

package. All sales documents are generated from customer information stored for a project. You can find this information in the

sell-to, bill-to, ship-to, and payment terms fields on a project card.

You can add other customers to WBS—and budget—lines based on what option you chose in the Copy to Sales Doc. field on a

WBS line. These customers then get their own documents so that you can offer and bill various kinds of services to different

companies. Every customer entered this way will be included in invoice suggestions.

When you run the Create Sales Document function, you can also specify a document number manually if necessary (and possible

for the number series).

Additionally, you can use the function to assign position numbers, calculate totaling lines, or release the newly created document

immediately.

Furthermore, you can update an existing quote instead of creating a new document. In this case, the quotation lines are

recreated, and you can archive the existing ones before the update.

Copy attachments to sales documents

Attachments available for a project can be copied to a new sales document by selecting the Copy from Project to Sales checkbox

on the Attached Documents page. To open the page, select the hyperlink for attachments on the right-hand side of a project card.

Link a sales document to a WBS

There is another way in Microsoft Dynamics 365 Business Central1 to create and link sales documents. Many of these documents

are generated before a project—and, consequently, a WBS—is set up. You can, however, link to them from a new work breakdown

structure as described in the following.

Open a sales document.

Select a sales line or multiple sales lines.

On the ribbon, choose Line > Functions > Get WP For Current Line or Get WP for Selected Lines. 

Based on what you chose in the Copy to Sales Doc. field, the function then creates a link at the work package or budget line level

—or no link at all.

This means that what you can choose might vary. Sometimes, both WBS and budget lines might show up. However, a WBS line

where values are copied at the budget line level cannot be linked to a line at the work package level and vice versa.

When you run an action to get work packages, all fields needed to set up the link to a sales line or to multiple sales lines are filled

in automatically. This includes the Work Package Code field.

Some fields are also checked for discrepancies, such as differences in work types or pricing. If a discrepancy is found, you are

asked to confirm that you want to copy the data.

A link can only be established if you entered a resource, an item, or a G/L account in the Type field on the sales line.

If you want to create an order from scratch, we recommend that you use the Create Sales Document action instead.

Link opportunities to projects

Turn quotes into orders

To make an order out of a sales quote:

Open the project assigned to the relevant quote.

Choose Project > WBS Incl. Budget View.

Choose Create Sales Document on the ribbon.

This deletes the quote, although the document is archived if you turned on the Archive Quotes toggle in Sales & Receivables

Setup. 

A project that is still in the Quote status can be changed to Open when you run the function. The status on WBS lines referencing

the quote then changes to Open as well.

1. 
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If the quote was sent to a contact, not a customer, the contact is converted to a customer based on the customer template code

that was used on the quote. The same customer is also entered on the project if it still contains the old contact information.

You can also copy only parts of a quote to an order.

Open the relevant quote.

Select the Ordered field on the lines you want to copy.

Choose Process > Make Order on the ribbon and select Only Lines on Ordered instead of Complete Quote.

The lines you didn’t select will remain in the quote so that they can be copied to another order later.

Alternatively, you can run the Attach to Sales Order (Project) action. This function doesn’t create a new order but adds lines

ordered from the quote (or the entire quote) to an order already available for the project and linked to it on the header.

Print Line and Print on Invoice

Although you might not want to bill everything on an order at once, the system typically copies the content of the entire

document to a posted invoice. However, you can prevent a posted invoice line with a quantity of 0 from showing up on printouts

by clearing its Print Line checkbox, which you can select or clear manually even after you posted the invoice.

You can also use the Print on Invoice field on the unposted lines of a document, such as a sales order or invoice, to exclude from

printing lines that are not part of the current bill before posting them. The checkbox is selected by default and can only be

cleared on lines where the Qty. to Invoice field is set to 0.

What ultimately goes on a printout is specified on each posted document in the Print Line checkbox. The Print on Invoice field, on

the other hand, gives you the option to specify, prior to posting, which lines you want printed.

Update sales documents

Sales documents and project budgets might change frequently, for example, when you’re still negotiating with a customer about

the price of a project. All you need to do then is to open the work breakdown structure to recalculate prices and create a new

offer from a previous quote.

The process might get more complicated when a sales order is involved, as multiple sales lines might have been shipped or

invoiced in the meantime—and can no longer be deleted. In that case, the easiest solution would be to make minor changes to

the sales document and run a separate function to synchronize data with the project.

1. 

2. 
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Set up synchronization

Choose the search icon, enter Projects Setup, and then choose the related link.

Fill in the fields as described in the following table.

Specify synchronization data

You then need to specify in the Sales Doc. Project Budget Change Matrix what you want to synchronize and how. For each

document type, you can specify what you want the program to do when you run synchronization.

Never

Sales lines aren’t synchronized with the project; no messages are shown on screen either.

Question

You are asked if you want to make the change. If you choose No, your reply will be logged.

Always

Sales line changes immediately trigger the update function.

The matrix also shows which kind of changes can be made:

Delete a sales line

Enter a new description on a sales line

Alter a sales price (including line discounts)

Reduce or increase quantities on a line

1. 

2. 

Field Description

Sales Project

Budget 

Sync. Active

Turn on this toggle if you want budgets and projects to be synchronized automatically.

Sales Project

Budget 

Sync. Error

Handling

Choose what happens if the system encounters an error during synchronization.

Cancel

The process is stopped, and no changes are made to the sales line. An error message pops up.

Select this option if you want sales to be as much in synch with projects as possible. Errors are then

corrected within projects only.

Ask

You see an explanation of the error and are asked if you want to continue with the change on the sales

line. Choose No if you want to keep the line as is. Choose Yes if you want to change the sales line but

forgo synchronization with the project. The error is logged.

Notify

You are informed about the problem, and the change is made on the sales line but isn’t copied to the

project. At the same time, the error is logged.

Sales Project

Budget 

Sync.

Notification

With the toggle turned on, you get a message that says the project was successfully synchronized. With

the toggle turned off, no feedback is given—except for a log entry that you can open later.

• 

• 

• 

• 

• 
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Requirements

The relevant sales line must be related to an active work breakdown structure.

The project mustn’t be blocked.

WBS lines mustn’t be blocked (even at the budget line level).

A plausibility check for type and No. has been performed at the budget line level.

In the case of line deletion

Nothing must be posted to the line in the project.

In the case of price changes

The invoice currency must be identical to the currency on the sales document. You can ensure this by using the Create Sales

Document function on the WBS.

The unit stored on the sales line must also be identical to the unit used for the project. You can again ensure this by running

the Create Sales Document function.

In the case of quantity changes

The quantity budgeted for the project must be the same as the quantity you plan to invoice. Otherwise, there would be no way

to know whether you want to keep or offset the difference, set up a fixed usage/consumption quantity, or change the invoice

quantity.|

In the case of quantity changes on budget lines The unit of measure stored on budget lines must be identical to the unit

shown on the sales document. To ensure this, run the Create Sales Document function from the WBS. Quantity changes on

WBS lines require the same type of unit for usage/consumption and billing.

In the case of quantity reductions on budget lines

Reductions can only be equal to or lower than what has already been consumed. The quantity consumed consists of actual

consumption, the in-stock quantity on the relevant budget line, and the quantity remaining on the associated purchase order.

In the case of quantity changes on WBS lines

A quantity change on a WBS line can only be made if no budget lines exist. Else, it would be unclear for what purpose the WBS

line was changed.

What can be synchronized Sales Document Types

Quote

Order

Changes

Deleting sales lines

Replacing descriptions

Altering prices or line discounts

Reducing or increasing quantities

Project Levels

WBS lines of type work package

Budget lines of any type

• 
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What cannot be synchronized

Insertions of new sales lines, as it would be unclear at which level. Also, to set up a new sales line, you would need to assign a

WBS line or a work package.

Deletions of sales documents, based on the assumption that you want to create new documents from a new project budget, not

remove an entire project.

Changes in structural elements, such as Begin-Total and End-Total lines.

Insertions of new sales lines, as it would be unclear at which level. Also, to set up a new sales line, you would need to assign a

WBS line or a work package.

Deletions of sales documents, based on the assumption that you want to create new documents from a new project budget, not

remove an entire project.

Changes in structural elements, such as Begin-Total and End-Total lines.

Log

The log shows successful and failed synchronization attempts, plus those canceled by a user. To see the log, open a sales

document, a project, or a WBS and choose Related > Project > Sales Doc. Project Budget Change Log on the ribbon.

INVOICE SUGGESTIONS

Invoice suggestions include all the data required to bill customers for expenses you incurred while working on projects for them.

However, before you can make the most of these suggestions, you need to set them up properly.

A suggestion is always created from an active work breakdown structure. Each line of the WBS is processed according a billing

type. You can select the Suspend Billing checkbox to block lines temporarily from appearing on an invoice. 

Set up suggestions

Suggestion templates

To be able to use the invoice suggestion feature, you need at least one template:

Choose the Search icon, enter Invoice Suggestion Templates, and then choose the related link.

Choose New on the ribbon or fill in a line to create a new template.

We recommend that you set up a separate template for every project manager who performs billing. This ensures that only those

working in a certain business unit can bill projects assigned to that unit.

Project data

An invoice suggestion requires an active WBS, and WBS lines of type work package require a billing type. For more information

about billing types, (see Work Breakdown Structure.

If the Billing Type field is left blank, a project is treated the same as if the field were set to No Billing. A type must be chosen on

the WBS; the field found on suggestions is used for informational purposes only.

When you create a suggestion, the system determines for each line of an active WBS if the line has already been billed. For time

and materials projects, this means a check on unbilled project ledger entries. For fixed-price projects, the sales budget needs to

be invoiced in full. Each expense left to bill is then included in the suggestion, together with a link to the WBS line on which the

expense is stored.

In the Rem. Total Price Calc. Base field on WBS lines, you can specify what you want to see in the Unbilled Work field. This field

is used for informational purposes only; it has no impact on the suggestion.

Project ledger entries

Project ledger entries are the basis for billing time and materials projects. They indicate project usage and tell you how much of

that usage is billed to customers. They also tell you if you’re still in the middle of billing a customer or have posted a final

invoice.

You can adjust the quantity that you want to bill during various stages of a project. For example, resources can adjust the invoice

quantity down from the total number of hours worked as early as creating project time entries.

• 

• 

• 

• 

• 
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When these entries are then copied to the project ledger, the project manager can again revise the quantity.

The invoice quantity can also be changed for project ledger entries themselves provided they haven’t been billed or are already

part of an invoice suggestion.

A quantity change can even be made on the invoice suggestion. However, if there is more to adjust than the quantity for billing, a

function will need to be run.

To specify an invoice unit of measure that differs from the unit for reporting project progress, use the Work Type field on WBS

lines. This way, times can be recorded in hours but billed in days.

You can specify conversions from one unit to another in the Units of Measure table so that values are calculated automatically

when you post progress. If, for example, project ledger entries show the hours spent on a project, but the effort is typically billed

per day, the entered quantity will be converted to the relevant unit for billing.

Sales orders

Invoicing a WBS line usually requires a sales line. Because every WBS line contains a unique combination of work package, and

phase, task, and step codes, these fields (as well as the Project No.) are also used to search for the sales line.

When you invoice time and materials projects, the budget remaining on a sales line must be large enough to bill and sales and

project values, such as the invoice unit of measure, need to match. For example, if a quantity on a WBS line is given in hours, the

quantity on the related sales line cannot be stated in pieces.

Open a suggestion

Choose the Search icon, enter Invoice Suggestion, and then choose the related link.

Select a name to see the latest suggestions. These are deleted automatically when you choose the Create Suggestion Lines action

on the ribbon.

Set filters if you want to create several types of suggestions. For example, you can use the Customer No. to filter for projects

related to a certain customer or the Person Responsible filter to see only projects managed by a specific project lead.

Fields and functions

Invoice suggestions have the following multi-level structure.

Level 0

The level at which suggestions are grouped by customer.

Level 1

The source type level, where suggestions for customers are grouped according to whether they originated with (sales and

purchase) orders or projects. The current focus of this level is on suggestions for projects. Suggestions for order lines represent

unbilled shipments and are used for informational purposes only.

Level 2

This level contains the projects for which suggestions are available.

Level 3

The fixed-price level. Based on the billing level, you see a WBS line or budget lines. For time and materials projects, only WBS

lines can be found here.

Level 4

This level is for time and materials projects only. It contains the project ledger entries that have been suggested for billing. These

can be changed before creating an invoice. For example, you might still want to adjust the invoice quantity.

1. 

2. 
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The most important fields used on suggestions are described in the following table.
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Field Description

Customer No. Shows the number of the customer whom you want to bill.

Name Describes the relevant invoice suggestion level.

Phase Code

Task Code

Step Code

The contents of these fields are copied from the WBS or project ledger entry.

Line Activity No. Shows the activity number stored on the budget line. The number is copied from the WBS or the project

ledger entries.

This field is only filled in if you plan, post, and bill at budget line level.

Billing Type Copied from the WBS line. The options are (blank), Time & Materials, Fixed, No Billing, Milestone, POC,

TE Flat Rate (that is, if you installed the Comsol Travel Expenses app), and Package Invoice.

Posting Date Shows the posting date of the project ledger entry.

Performance

Date

The date of performance might differ from the posting date, as there are some situations in which

services that were rendered the previous month can no longer be posted to that month.

Example

Services were rendered in December, making 12/15 the date of performance but are posted in January

(on 01/01) because the posting period for the prior month has ended.

As a result, the system will use the date given in this field—and not the posting date—for the Create

Suggestion Lines action.

Type Specifies whether you want to create the invoice for a resource, an item, or a G/L account. The (blank)

option is for lines structuring a view.

No. Shows the number associated with the Type field.

Description This field is copied from a project, a WBS line, or a project ledger entry based on the level chosen for

the suggestion. For resources, it shows a description of activities and for items, the item text.

Quantity Shows, based on the level chosen for the suggestion, the quantity stored for work packages or project

ledger entries. More specifically, the field indicates the quantity budgeted on the WBS line and the

quantity reported as finished.

Quantity

Invoiced

Shows the (WBS line or project ledger entry) quantity that has been billed so far.

Unit Price Shows, based on the level chosen for the suggestion, the unit price from the WBS line or project ledger

entry. This price is updated from the related sales line. If the price stored with the project ledger entry

or project budget is different from the price on the sales order, the price stored on the order takes

priority.

Total Price Shows the result of Quantity * Unit Price.

Amount Invoiced Shows the (WBS line or project ledger entry) amount that has been billed so far.

Remaining Amt.

to Cap

Shows the sales amount that remains on the WBS line and is still available for billing. This field is shown

at the WBS line level only.

Invoice Qty. Shows the billable quantity from the project ledger entry.

The value in this field can be changed at any time. If you invoice at the project ledger entry level

(typical of time and materials projects), you can change this quantity for individual entries. If you bill at

WBS level (typical of fixed-price projects), you can change it on the WBS line copied to the suggestion.

Line Base

Amount

Shows the result of Unit Price * Invoice Qty. Describes the non-discounted invoice total.

Line Discount %
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Based on the level chosen for a suggestion, suggestion lines store information about a WBS line or a project ledger entry. For a

WBS line, the data includes:

Budget values (Quantity, Unit Price, and Total Price)

Entries billed (Quantity Invoiced and Amount Invoiced)

The remaining budget amount (Remaining Total Price)

Current billing information (Invoice Qty., Invoice Total)—for fixed-price entries

The assigned sales line (Sales Order and Sales Line Cross-References)

The Quantity Invoiced is the result of dividing the Amount Invoiced by the Unit Price. This might be a theoretical quantity

because the invoiced amount is determined based on the sales project ledger entries related to a WBS line.

Field Description

Shows the line discount in percent, copied from the related sales line. You can enter a discount

manually if the suggestion line is not linked to a sales order.

Line Discount

Amount

Shows the result of Line Base Amount * Line Discount %.

This field cannot be changed.

Total Line

Amount

Shows the result of Invoice Qty. * Unit Price. This field is the basis for creating an invoice.

Cross-Ref. Sales

Order

Shows the sales order related to the suggestion line.

Cross-Ref. Sales

Line

Shows the sales line related to the suggestion line.

Invoice Error

Code

Shows a code if an error occurs when the suggestion is processed.

Invoice Error

Text

Shows a message that explains the data processing error. The error might prevent the line from being

billed.

Note Text Shows notes that are useful for processing the suggestion.

The selected line can still be billed.

Prepare for

Billing

If this checkbox is selected, the sales order related to the suggestion is prepared for billing but not

posted.

The system then creates unposted invoice entries and assigns them to the relevant lines on the

document.

The Qty. to Ship and Qty. to Invoice fields are also filled in on the order.

See also Prepare for Billing.

Invoice on Order Selected if the highlighted sales lines should be posted as shipped and copied to a new invoice for

billing.

The system then creates unposted invoice entries for the lines.

See also Invoice on Order.

Direct Invoice Specifies if a direct invoice should be created when no related sales line is found.

Note

You cannot use this option if the selected line is linked to a sales line.

See also Create direct invoices.

• 
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The same is true for the Invoice Qty., the result of dividing the remaining budget (remaining total price) by the unit price. The

quantity at the WBS line level is filled in only for fixed-price entries. For time and materials projects, work is billed at the project

ledger entry level.

For a project ledger entry, the data stored includes:

Consumption/usage values (Quantity, Unit Price, and Total Price)

Current billing information (Invoice Qty. and Amount Invoiced)—for time and materials entries

The invoice quantity can be used to determine the quantity you want to bill to the customer for time and materials projects. The

following formula applies: Invoice Qty. * Unit Price = Total Price (of an entry).

For a project ledger entry, a FactBox lists the type (that is, internal or external) and the contents of comments made. External

comments—that is, those for which the Print on Customer Doc. checkbox is selected—can later be printed on proof of

performance documents.

Actions Create Suggestion Lines

Creates new invoice suggestions. You can find the function on the ribbon itself or by choosing Actions.

Running this function deletes the lines on the suggestion you're editing.

The function, however, doesn’t create lines for projects that have been suggested elsewhere. You see a message if a project is already

part of another suggestion.

Set meaningful filters when you run the function, for example, to include only a single project, every project that is under the

management of a specific project lead, or all projects assigned to a certain customer.

If you’re working with the team role feature, you can also use the Responsible for Billing field to filter for team members in

charge of billing. Who is included in this case, however, doesn’t depend on whether the Invoice Suggestion field is selected—as

this field allows all members to create suggestions—but whether the correct role is assigned in the project (that is, the team

member is marked as Responsible for Billing).

To prevent the accidental retrieval of lines that were set up for projects not relevant to the current suggestion—which would block

their use elsewhere—you need to set a filter on at least one of the following fields: Customer No., Project No., Responsibility Center,

Person Responsible (=project lead), Responsible for Billing.

A filter set on the Performance Date field affects both the ledger entries that you want to bill and the related payment plan lines.

With the Project Ledger Entry Type and the No. filters on the request page, you can specify what ledger entries to include on a

time and materials invoice, for example, those set up for a certain item. Filtering also works if you don’t fill in the No. Filter field

so that you can create one invoice for all related resources or item ledger entries.

The WBS Line Status Filter field, which has the options Both, Quote, and Order, can be used to specify the WBS lines that you

want copied. Typically, these are in the Order (Open) status.

If you turn on the Delete Invoice Entries from Sales Orders toggle on the page, all invoice entries that haven’t been posted yet to

a project that the function is filtered to are removed from the associated sales document before an invoice is created.

Turning on the toggle therefore returns the project ledger entries prepared for billing those entries to the suggestion and might

be useful, for example, if you want to restart invoice creation and ensure that all unbilled time and materials entries are included

on the new document.

Comments

• 

• 

Note

Note
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Shows detailed information about the current invoice suggestion, including whether it has an invoice currency different from the

currency used for the project ledger entries, the payment plan, or the sales order.

The Comments page also shows employees who tried to bill projects but couldn’t. For the comments to appear, you must turn on

the Check Team at Time Posting toggle in Projects Setup.

Close Entries before Billing

Closes project ledger entries without making them part of an invoice. This is only useful for time and materials entries that aren’t

billed or visible to customers.

Edit Project Ledger Entry

Choose this action if you want to change a project ledger entry related to the suggestion. For more information, (see Edit Ledger

Entries

Switch Order

Replaces an order (or order line) that was assigned automatically with another order (or order line). The project number, work

package, and phase, task, and step codes (that is, the WBS line relations) must be identical.

This function is only intended for service (resource) lines invoiced based on time and materials. The function filters for activities

posted so that the time spent on a budget activity cannot be billed to a sales line related to another activity. In short, you need a

neutral sales line or one with the same line activity number.

Delete Sales Order Ref.

Deletes a relation automatically entered by the suggestion so that you can include a project ledger entry in a direct invoice.

Increase Sales Line

Raises the order quantity for entries that are billed based on time and materials and don’t have enough quantity left on a certain

sales line.

By raising the quantity, you can use the line to invoice the entire project effort.

When you run the function, you see a page that shows the current order quantity, the order amount that remains, and the invoice

quantity stored on the sales line. You can then overwrite the value in the Order Quantity field.

If an order has already been released, you can choose Open Order to reset the order status. When you exit the dialog, the order

is released again.

Report by Sales Order

Shows you the result of billing per sales order, that is, the page provides an overview of what remains of an order after the

current billing cycle.

Project Documents

Shows the documents related to a project.

Create Invoices

Creates invoices and readies them for posting or prepares orders for billing. This process generates unposted invoice entries.

When you run the function, all unbilled project ledger entries are entered in a new invoice suggestion. A suggestion should be as

specific as possible to avoid time-consuming corrections; this also means that ledger entries should be prepared for billing in

time.
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Key project ledger fields related to suggestions are described in the following table.

Related Show WBS

Opens the work breakdown structure of the project that you want to bill.

Card

Opens the card of a resource, an item, or a G/L account depending on what type of project usage or consumption is shown on the

suggestion line.

Show Project Ledger Entry

Shows the project ledger entry from which the selected suggestion line was created.

Project Ledger Comment

Shows a note about the project ledger entry (if one is available).

Edit suggestions

When you open a suggestion, you can change certain information yet again.

Change quantity

You can, for example, change the Invoice Qty. field of a project ledger entry. This field can be revised multiple times throughout

the billing process.

Field Description

Billable Indicates what billing type was chosen on the related WBS line.

• Not selected if the type is No Billing.

• Selected if the type is Fixed (Price).

• Typically selected if the type is Time & Materials, although the field can be cleared, for example, by

the project manager.

The content of this field is transferred from the Budget Line Activity Card when you post times for

activities.

Only project ledger entries for which this checkbox is selected are copied to a suggestion.

Billable entries are also copied if the invoice quantity is 0 so that you can close time and materials

entries that could be billed but aren’t for some reason and display them on an invoice. This might be

useful, for example, if the entries originate with a goodwill policy.

Invoice Qty. As explained, this field doesn’t play a role in what is copied to invoice suggestions. But it shows for how

much a customer is billed (only applies to time and materials entries).

Invoiced This field is only relevant to time and materials entries. If it is selected, the entries have already been

invoiced.

Invoice Entry

Posted Invoice

Entry

These fields show unposted and posted (that is, final) invoice entries. Unposted entries are used to block

project ledger entries that are copied from suggestions to unposted sales invoices or orders you want to

bill.

After billing, that is, when you posted the relevant document, the unposted entries are deleted, and

posted entries take their place.

If either field is filled in, an associated project ledger entry will be excluded from new invoice

suggestions.

When invoice entries are posted, the project ledger entries related to them are considered settled. That

remains true even if—for example, as a gesture of goodwill—you invoiced only part of the total quantity.
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You don’t need to do more than go to the field and replace its value. If you set the quantity to 0, the project ledger entry is still

suggested for posting. If you then send a detailed invoice to a customer, the line will show up on the invoice as well.

Edit ledger entries

To change other billing-related fields besides the Invoice Qty. (the work package especially):

Open an invoice suggestion and select a line.

Choose Actions > Edit Project Ledger Entry on the ribbon.

You are then asked if you want to edit the project ledger entry related to the line and have the entry included in the suggestion

again. Choose Yes.

You can now edit the fields described in the following table.

To replace the work package, choose Change Work Package on the ribbon. You are then asked to confirm your choice.

This is because changing the package might alter the unit cost (as the new package might have another work type), the project

account (used to control costs), or any of the dimensions. After you assigned a new package, the WP Modified By/On/At fields are

filled in automatically.

Choose OK to close the page. Changes in description, invoice quantity, or unit price are then copied to the relevant suggestion

line.

To delete a project ledger entry, clear the Billable checkbox on a line. The next time you open the suggestion, the entry will be

gone. If you cleared the checkbox by mistake, reopen the entry on the Project Ledger Entries page to correct the error.

In fact, all project ledger fields that you can edit on a suggestion can also be changed on this page. When you swap out a work

package here, you see a message that the line referencing the old package on the suggestion will be deleted.

As changes to project ledger entries might also change WBS line relations and package positions on a suggestion, you then need

to recreate the invoice suggestion to copy entries with changed work packages to the right lines.

If you open an entry via the Edit Project Ledger Entry function but choose Cancel to exit the page, you see a message that the

line related to the entry has been deleted from the suggestion. You then need to recreate the suggestion if you want to include

the entry again.

Delete individual lines / Delete level

You can use Ctrl+Del to delete lines from a suggestion at the project ledger entry level. If you then reopen the suggestion, the

lines are again suggested for billing because the related entries are still open.

If you want to delete entries at a higher level—for example, to remove an entire project— use the Delete Level function.

Close entries before billing

Excludes from consideration entries that aren’t billed and won’t ever be with the help of an invoice suggestion.

This means that these entries will no longer show up when you reopen a suggestion.

1. 

2. 
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Field Description

Description Shows a description. You can change this description at any time.

Line Activity

No.

Shows the number of a line activity. You can change that number here as well.

Invoice Qty. Shows the invoice quantity. You can adjust the quantity at any time.

Sales Price Shows the sales price. You might want to change the price, for example, because of new customer

agreements. However, if the price shown in this field is different from the one on the sales order, the

system will use the price on the related sales line for billing.

Billable At this stage, a project ledger entry can still be specified as non-billable. This will exclude the entry from

invoices and prevent application. If the entry is set to No Billing, it will also have an invoice quantity of 0.
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This action has the same effect as if you manually cleared the Billable checkbox for project ledger entries. If you cleared a

checkbox by mistake, open the relevant entry and re-select the checkbox. 

Billing procedures

On each suggestion line, you can choose one of three checkboxes to specify how you want a line copied to invoices. For these

options to be available, the line must meet certain requirements as described in the following.

Entries that you want to bill with the help of sales lines need to have the Prepare for Billing or Invoice on Order checkbox

selected on the related suggestion lines. Based on how you plan to bill the project, you need to select the checkbox at the fixed-

price or time and materials level.

Prepare for Billing Fixed price

If you want to bill an entry based on a fixed project price, select Prepare for Billing at the fixed-price level. Whether project

ledger entries already exist doesn’t matter. Entries can be billed (even partially) at any given time. The only requirement is for a

sales line to be linked to the relevant WBS line. 

Time and materials

Select the Prepare for Billing checkbox at the project ledger entry level to focus on actual project usage. Selecting or clearing

the field on work package lines also selects or clears the same field on related project ledger entries automatically.

However, the checkboxes on work package lines aren’t relevant to billing; only those at the project ledger entry level are.

Billing time and materials projects requires that a suitable sales line be found. The billing type on the line must match the type

specified for the work package. Typically, a billing resource is used for this purpose.

A resource’s invoice unit must also match the unit of measure stored for the relevant time and materials entries. This ensures

that no item is billed on a sales line that contains a quote for resource working hours. Additionally, the line quantity cannot be 1,

as this is a common value for flat rate payments.

Invoice error codes

Lines that show an error code cannot be selected for billing (if no error was found, the Invoice Error Code field shows 0). The six

possible codes are:

No valid sales line could be found.

The type stored with the project ledger entry doesn’t match the type found on the sales line.

What is left on the sales line is insufficient. You need to increase the quantity. (You can use the Increase Sales Line action to do

this.)

Fixed-price positions require the same unit of measure on the sales line and the WBS line.

The fixed price has already been invoiced in full. (The only option left is to close the line by issuing a final invoice.)

The sales order reference was deleted manually. 

Impact on orders

Prepare for Billing requires both a sales order cross-reference and a sales line cross-reference on invoice suggestion lines.

This is because the following changes are made to the referenced sales order when you create an invoice from a suggestion

where the Prepare for Billing checkbox is selected:

An invoice entry is added to an order line for each project ledger entry that you want to bill.

The total invoice quantity is entered in the Qty. to Ship and Qty. to Invoice fields. On lines that have no invoice entries, the

fields are set to 0 to prevent accidental billing.

Note

1. 

2. 

3. 

4. 

5. 

6. 

• 

• 
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To view a new invoice entry for a prepared line, open the related order, select the line, and choose Line > Related > Invoice

Entries on the ribbon. The number of the entry is shown in the Assigned Project Ledger Entry field.

You can then again update individual entries on the sales order.

Impact on project ledger and invoice entries

No more than a single invoice entry can be applied to a project ledger entry billed based on time and materials. It is for this

reason that we recommend you make necessary quantity and value adjustments as early as possible, that is, on invoice

suggestions.

As mentioned earlier, time and materials entries are considered settled when invoice entries are assigned to them, even if only

partial quantities have been billed.

When you post a shipment and an invoice from a sales order, the invoice entries on the sales lines are copied to the newly posted

invoice. Additionally, each now-posted invoice entry is linked to a time and materials entry.

Posting invoices also creates project ledger entries with filled-in Applies-to Sales fields. These fields show the number of posted

and applied entries—that is, billed project ledger entries—linked to a project ledger entry originating in sales.

Unlike time and materials entries, project ledger entries generated in sales can relate to multiple posted invoice entries, as a

sales project ledger entry often applies to more than one time and materials entry.

To see a list of the posted invoice entries, use the lookup in the Posted Invoice Entry or Applies-to Sales field. The relevant time

and materials entry can then be found in the Assigned Project Ledger Entry field. The Sales Project Ledger Entry field shows the

number of the series that you set up for creating project ledger entries in sales.

A posted invoice entry can be opened from the billed time and materials entry or the sales project ledger entry (and vice versa).

Delete invoice entries from order

If necessary, you can use the Delete Invoice Entries action on the ribbon of a sales order to remove invoice entries from the order

and reopen the related time and materials entries for transfer to a new invoice suggestion.

The Qty. to Ship and Qty. to Bill fields on the order retain their values when you delete invoice entries, and no posted invoice entries

are created if you posted something by mistake. Nothing applies to open time and materials entries either, although you can post

their application manually if necessary.

Invoice on Order

This option is based on the same program logic as Prepare for Billing. The difference is that the quantity that is invoiced on the

relevant sales order is posted as shipped immediately and the shipment is copied to an unposted invoice document.

Unposted invoice entries are then available on the document lines. However, an unposted invoice doesn’t mirror the structure of

a sales order. Instead, it contains only the lines you want to bill, which means you see only those that have been shipped

automatically. Additionally, structural elements and order fields used for informational purposes aren’t copied to the invoice.

Besides the lack of billing information compared to the first method, this option has the distinct disadvantage that if you need to

recreate an invoice due to a billing error, you must first delete the unposted document. Only in this way will the associated

project ledger entries be removed as well.

A further issue compounding the problem is that the deletion of invoice entries doesn’t affect the original shipment document,

nor does it remove the quantity already posted. This quantity—considered shipped but not invoiced—will instead be copied to a

new invoice created from another suggestion.

Changing the invoice quantity can then lead to unwanted results. If you raise the quantity, a second shipment needs to be posted

so that more than one is shown on the invoice, which might look confusing on printouts. If you reduce the quantity, only some of

what has been posted as shipped might be needed so that the remainder is kept and copied to a new suggestion.

Note
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The easiest way to deal with this is to delete the invoice document. This way, all shipments are canceled before you open a new

suggestion.

All other requirements for fixed-price and time and materials billing are the same as described earlier.

Impact on documents at invoice creation

When you run the Create Invoices function, you are first informed that sales lines still need to be shipped (unless none are

available).

You can now decide to post the lines as shipped or exit the page. Choose Cancel to leave for the invoice suggestion. Choose OK if

you want to post the lines and create a sales invoice.

You are then asked if you want to edit the invoice. Choose Yes to open the unposted document.

By using the lookup in the Invoice Entry field, you can see all unposted entries related to the invoice. The underlying order also

shows the invoice quantity as shipped.

With the shipped quantity copied to the invoice, each invoice line has been assigned to a posted shipment line. It is for this

reason that you cannot raise invoice quantities if you use this option—you simply cannot bill more than you delivered to a

customer.

Impact on project ledger and invoice entries

The impact on invoice entries, posted invoice entries, project ledger entries, and applied entries is the same as if you had

selected the Prepare for Billing option.

Create direct invoices

If no sales line exists for a project ledger entry, a suggestion line can be billed with the help of a direct invoice. Afterward,

posting a shipment will no longer be possible.

Direct billing is often used to pay for travel expenses, that is, for time and materials entries that aren’t related to sales lines.

Although typically part of a project agreement, a rate for these kinds of expenses isn’t included in the budget (even the sales

budget), as this is often considered unhelpful.

Entries you want to bill in this way must have the Direct Invoice checkbox selected. 

When you create an invoice suggestion based on project ledger entries with and without sales lines, the direct invoice lines, that

is, those without shipments, are added to an invoice after the order lines. If the current billing process includes only direct

invoice lines, however, a new invoice will be created.

If you want to bill various kinds of suggestion lines at the same time, use the Create Invoices action after selecting all lines. If

done separately, that is, if you mark Invoice on Order lines and create an invoice before you mark other lines for direct billing

and run the function again, lines not related to a sales order aren’t added to the unposted invoice, even if you started the process

from the same invoice suggestion.

During processing, project ledger entries are aggregated on a single direct invoice line if their Type, No., and Unit of Measure

Code fields match. One invoice entry is created per line to close a project ledger entry.

Impact on project ledger and invoice entries

A direct invoice includes one invoice entry for each line to bill.

When you post the invoice, the system then creates one posted invoice entry per line to establish a link between the time and

materials entries on one side and the project ledger entries in sales on the other. It also applies the posted invoice entry to the

other two entries.

Negatives invoice amounts

If the total amount on an invoice is negative, the system creates a credit memo instead, as negative invoice amounts cannot be

posted to projects in the app.

Budget line billing
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You can incorporate budget line activities into sales lines to create more detail-rich sales documents and invoices based on an

invoice suggestion.

The invoice suggestion function checks the Billing Integration field on each WBS line to determine the level at which to invoice

the relevant project.

If billing level = budget line…

WBS lines that are billed by time and materials are copied to a suggestion grouped by line activity, with unbilled project ledger

entries shown underneath. For fixed-price projects, a suggestion doesn’t show WBS lines but the budget lines that need to be

invoiced.

Regardless of whether you bill a WBS line or its activities, project sales are always visible on the WBS line when you post an

invoice. Revenues from line activities (if you bill at this level) can then be seen on the budget lines.

Ledger entries and application

In project billing, ledger entries of type sales offset ledger entries of type usage. That is, you bill customers for the time spent on

a project by creating sales project ledger entries.

An exact match between both types of entries is exceedingly rare. Usage entries are typically combined and billed on a single

sales line. This means that the number of entries and the quantities often differ on invoices created from a project.

As explained earlier, you can use invoice entries to post the application of project ledger entries automatically (on a suggestion)

or do so manually. The following paragraphs are only meant to sum up again how you achieve this.

Project ledger entries

With the help of invoice entries, project usage—that is, time and materials— entries are closed by project ledger entries created

in sales.

Invoice entries

Invoice entries link project ledger entries billed based on time and materials to sales project ledger entries.

Unposted invoice entries

Unposted invoice entries are created when you use the Invoice Suggestion function to prepare a sales order for billing or set up a

direct invoice. To see a list of all invoice entries, use the Invoice Entries function on a sales order or a direct invoice.

Posted invoice entries

A posted invoice entry represents the main link between usage entries and sales project ledger entries, as it is assigned to both a

time and materials entry and a ledger entry posted alongside an invoice in sales.

If you post an invoice from a sales order or from a direct invoice, all unposted invoice entries disappear and posted entries are

created and transferred with an Entry No. to project ledger entries billed based on time and materials. No more than one invoice

entry can be applied to this type of project ledger entry.

One project ledger entry in sales is then posted per line to bill. However, as multiple time and materials entries are typically

aggregated on one line, the posted invoice entries create a 1-to-n relationship between sales project ledger and time and

materials entries.

To see the project ledger entries, open a project card and choose Related > Ledger Entries on the ribbon. To see a list of all

posted invoice entries, use the lookup in the Posted Invoice Entry field.

Applies to sales

Shows for a sales project ledger entry the number of applied project ledger entries that were billed based on time and materials.

Check against qty. to invoice

If you turned on the Qty. to Invoice vs. Invoice Entry Check toggle in Projects Setup, the total amount stored for the (unposted)

invoice entries must match the value shown in the Qty. to Invoice field on the relevant sales line.
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The purpose of this check is to prevent proof of performance documents from listing quantities that differ from those billed to the

customer.

Manual application

Entries are applied automatically when you use invoice suggestions. However, you can do so manually as well.

Example

A customer is billed a flat rate for travel expenses. At the time of billing, the cost of the hotel that you stayed in hadn’t been

posted yet to Business Central. A few days later, the invoice is posted to the project and a project ledger entry is assigned to

close the ledger entry in sales.

To post application manually, you need to run the Apply Entries function from either a usage or a sales project ledger entry.

Running the function opens a dialog page where you can then choose from all open time and materials or sales project ledger

entries.

Select the relevant entry in the Set Applies-to ID field on the page. As more than one instance of project usage can be assigned to

a sales project ledger entry, you can assign multiple time and materials entries to an entry here. Apply the entries by pressing

F9.

Like automatic application, manual application closes the time and materials entries and creates posted invoice entries. These

are linked to the posted invoice via the project ledger entries in sales, which means that manually created invoice entries also

show up on posted sales invoices.

Reverse application

Project ledger entries can be unapplied at any time. This reopens the time and materials entries. 

To delete a relation between entries, select a posted invoice entry, and then choose Unapply Entries on the ribbon.

Invoice entry relations deleted by users are identified by the following description: “Unapplied manually on... by...”

To be able to track the changes users make, the values in the Assigned Project Ledger Entry and Sales Project Ledger Entry

fields are copied to the Old Project Ledger Entry and Old Sales Project Ledger Entry fields. However, after using the Unapply

function, data regarding work packages and budget line activities can no longer be restored.

Entry type for G/L account posting

The type of a posted document also determines the type of project entry created for it. Typically, sales documents create entries

of type Sale and purchase documents entries of type Consumption. You can, however, change the type, if necessary.

Choose the Search icon, enter General Journals, and then choose the related link.

Select an account, and then choose Related > Account > Card on the ribbon.

On the Projects FastTab, in the Project Entry Type field, choose one of the options described in the following table.

The original type is then replaced on the relevant document and in the general journal. You can make use of this feature in

situations such as the following:

During purchase: Negative revenue is billed by a supplier.

During sale: Foreign taxes need to be included on an invoice.

Print duration on invoices

To meet legal requirements, an invoice must indicate a delivery date. For invoicing services, delivery usually extends over a

period. This period is determined based on the invoice entries for services billed by time and materials.

1. 

2. 

3. 

Option Description

(blank) G/L posting works as in the standard app (see above).

Usage The ledger entry associated with the G/L account is posted as consumption (even on sales documents).

Sale The ledger entry associated with the G/L account is posted as revenue (even on purchase documents).

• 

• 
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For invoice printouts to show periods in the format you want, use the Performance Date Formatting field in Projects Setup.

When you open a project card, you will then see the period in the specified format on the Project Billings FastTab. You can again

change the format there.

BILLING CAPS

When you invoice a project by time and materials, you might see work hours exceed the number of billable hours a customer has

agreed to. Typically, this means you either cannot bill some of the work or you need to put in a change request.

However, many agreements contain a clause that, up to a point, grants exceptions to scheduled quantities.

For work packages

You can set a cap for time and materials billing as early as creating work packages.

In project templates

You can then make use of the cap when you create a project template. When you enter a work package on a project template line,

the billing cap values are copied to the line alongside other work package fields.

On WBS lines

Likewise, when you set up a new work package line, an available billing cap is copied automatically from the package to the line.

The same is true when you create a WBS from a template. You can also set up or change billing caps on WBS lines later.

Dimensionen

When a payment plan line is created, corresponding dimensions are generated. This simulates the dimension determination for

the future sales invoice line. As a WBS line can also serve as a dimension source, the target WBS line plays an important role in

such cases. In the sales line, this target WBS line is then decisive for dimension determination. The dimensions in the payment

plan line can also be changed manually. These changes are then transferred to the sales invoice line dimensions when a sales

invoice line is created.

On invoice suggestions

Billing caps mainly inform those who create customer invoices. FactBoxes show the total billing limit and the amount remaining

until that limit is reached.

Example:

An invoice suggestion includes a time and materials work package with a 10% cap. The package has the following data:

The work package has the following data:

Field Description

Billing Cap Select this checkbox to set a limit up to which usage recorded for the work package can be billed even

after the sales budget of a project is exhausted. This limit is determined by the total price stored on the

relevant WBS line.

Billing Cap % Specifies the limit for billing time and materials after exhausting a project's sales budget. This field can

only be filled in if you selected the Billing Cap checkbox. If you enter nothing, the field is set to 0 and you

cannot exceed the price specified on the relevant WBS line.

USD700.00 sales budget

- USD560.00 already billed

= USD140.00 remaining
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Based on a USD770.00 billing limit, this means:

Mark for cap

When you use a suggestion to invoice a work package, the related project ledger entries are marked for billing regardless of the

limit you specified. You can, however, see in the Remaining Amt. to Cap field at what point the limit will be exceeded.

For an invoice quantity to match the cap, you need to choose the Billing Cap action on the ribbon. This adds up the ledger entries

from the top until you reach the limit specified. The entry that would have otherwise exceeded the cap is then reduced in

quantity. All subsequent entries are set to 0.

Example:

As before, USD210 remain until the cap is reached. The following project ledger entries are now marked for billing: 

The entries add up to USD450 in total. After running the Billing Cap function, you see the following reductions in quantity to

match the cap:

The calculation might result in rounding differences, shown in the Rem. Amount to Cap field.

A proof of performance statement continues to show all project ledger entries, including those with a quantity of 0, as all of them are

still copied to billing as invoice entries.

Manual override

The person in charge of billing can edit project ledger entries manually to exceed the cap on purpose. However, the quantity

available on the related sales order would need to be adjusted in this case see [Invoice Error Code]

(ProjectAccounting.md#Handling-according-to-expenditure and Invoice Error Text

Manual billing

USD700.00 sales budget

+ 10% cap (USD70.00)

USD770.00 incl. billing cap

- USD560.00 already billed

= USD210.00 remaining until cap

Quantity Invoice Qty. Unit Price (USD) Total Line Amount (USD)

3 3 30 90

3 3 30 90

5 5 30 150

4 4 30 120

Quantity Invoice Qty. Unit Price (USD) Total Line Amount (USD)

3 3 30 90

3 3 30 90

5 1 30 30

4 0 30 0

Note
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If you don’t mark WBS lines but individual project ledger entries for billing, a cap will have no effect. Only the Remaining Amt. to

Cap field will be updated.

SALES CREDIT MEMOS

When you run the Copy Document action from a blank credit memo to correct an already posted sales invoice, you can turn on a

toggle on the request page to also copy the invoice entries from the posted invoice to the new document.

If you created the credit memo because you need to correct and re-send an invoice, we recommend that you keep the invoice

entries as they are. If the credit memo represents a discount, however, they should be deleted before posting.

If you use the entries to post a sales credit memo, the applied project ledger entries are unapplied but not deleted (only their

relations are).

Unapplied entries can be identified by their Unapplied Description field being filled in (on the posted invoice document). The

description reads: “Reopened by Credit Memo [no. of posted memo]).”

The Assigned Project Ledger Entry and Sales Project Ledger Entry fields are then cleared, and their values copied to the Old

Project Ledger Entry and Old Sales Project Ledger Entry fields for tracking purposes.

The posted invoice entries are also included on the credit memo. With the Old Project Ledger Entry and Old Sales Project Ledger

Entry fields now referring to unapplied entries, their values will be the same as the values on the unapplied invoice (see above).

The Sales Project Ledger Entry field, on the other hand, will contain the project ledger entry that the system created when you

posted the credit memo. Only the Assigned Project Ledger Entry field will remain empty, as no posted invoice entries are applied

to time and materials entries.

CORRECT A POSTED SALES INVOICE

Besides running the Copy Document action from the credit memo ribbon, you can choose one of the following actions on the

posted sales invoice itself to correct billing issues in different ways, with each using the invoice entries set up for the source

document.

For more information, see Correct or cancel a posted sales invoice - Business Central | Microsoft Learn.

Correct

Creates a credit memo with the invoice entries from the posted invoice and posts the new document automatically, resulting in a

complete reset of the billing process.

Also creates an unposted invoice with the existing entries so that the bill that was just canceled can be recreated. The new

invoice can then be edited (that is, you can change sales prices on it, add lines to it, or delete lines from it, for example) and

posted.

Cancel

Copies the invoice entries from the posted invoice to a new credit memo and posts the new document automatically. This results

in a complete reset, after which billing can (again) be restarted.

Create Corrective Credit Memo

Creates a credit memo with the invoice entries copied from the posted invoice. The result is the same as if you had run the Copy

Document action and turned on the Copy Project Invoice Entries toggle on the request page there.

This function also resets everything, which means billing can be restarted after the credit memo is posted.

PAYMENT PLANS

A payment plan provides a schedule for project billings, that is, it records times of cash inflow. Payment plans are used on invoice

suggestions and in cost control.

To work with payment plans, you must set up the feature. A plan can cover a whole project or single WBS lines. You choose your

preferred option in the Payment Plan Level field on a project card.

You can then run the Payment Plan function on a WBS to set up the plan. Depending on the plan level, the system will use the

sales budget stored for the entire project or for individual WBS lines to schedule payments.
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For projects

If you set the payment plan level to Project, payment plan lines refer to an entire project and no source work package can be

selected. The net amount stored for the plan is calculated automatically from the sales budget set up for the project.

You, however, need a target work package to use a plan on invoice suggestions or in cost control (the purpose of which will be

explained later).

For WBS lines

If the payment plan level is set to WBS Line, you must select a source work package. As the plan lines now refer to a specific line

on the WBS, a net amount is determined automatically based on the portion of the sales budget stored there.

Not every WBS line needs to be part of the payment plan if you want to use the plan only for invoice suggestions and need to bill

periodically for an item or a service.

For example, an expensive piece of equipment might have been budgeted on a WBS line. You then create a plan for this one line

together with the customer, whereas the rest of the project will be billed based on effort.

Unlike a payment plan for an entire project, this option requires that you specify a source WBS line in the Source Work Package

field or choose the Get Source Work Package action when you create a plan. The net plan amount is then calculated from the

WBS line budget with the help of the Pmt. Plan Amount % field.

Fill in a payment plan

Note
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Fill in the fields of a plan as described in the following table.

1.2.4 project365

- 786/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Field Description

Planning Type Choose Invoice if the plan refers to separate (partial) invoices or Final Invoice if this is the final billing.

When you use a payment plan on an invoice suggestion, the system determines the actual effort to bill,

suggests this amount on the relevant date, and applies it to invoices already created.

Date (Scheduled) Choose the date on which you want to bill. This date is included in all parts of the payment plan.

Pmt. Plan

Amount %

Used to calculate a net invoice amount. At the project level, the value is calculated in percent from the

budgeted total price of a project.

If you entered a value in the Net Amount field, this field is filled in automatically.

Net Amount Specifies the budgeted net invoice amount. You can fill in this field manually or have the system use the

Pmt. Plan Amount % field to calculate the value.

Currency Code Shows the currency stored for the project.

Billing Base

Billing No.

The billing base and number are retrieved based on the WBS line to which you post sales (see also the

Work Package field) and determine if a G/L account or a resource is entered on a suggestion line.

Often, these fields contain a G/L account and number. If you select a sales account, the system will

create a suggestion line based on this account—and not the billing base and number set up for the work

package.

You can override both values in payment plans.

Note

The standard procedure is to use the billing base and number from the target work package.

Payment Terms

Code

This field is copied from the customer but can be changed manually. The terms are used on invoices.

Description Enter a descriptive text that will later be shown on the relevant invoice line.

Milestone

Reached

Relevant to billing by milestone. This field indicates what payment plan lines—that is, lines available for

a milestone plan—have reached an agreed milestone.

If, based on the plan level, a project or WBS line is set up for milestone billing, an invoice suggestion

shows all lines for which the checkbox is selected but which haven’t been billed yet.

Copy to

Suggestion

Specify if you want a plan line included in an invoice suggestion. Otherwise, the line will only be used

for cost control and cashflow forecasts.

Copied to Sales If this checkbox is selected, the plan line was copied to an unposted invoice. A line can only be copied to

an invoice once.

Invoice No. Shows the number of an invoice if a payment plan line has been posted together with one.

Copied to Sales 

(Final invoice)

If this checkbox is selected, the plan line is used for a final invoice and has already been copied to a

credit memo. On the memo, the actual amount from the line is credited, not the amount stored in the

Net Amount field.

Document No. 

(Final Invoice)

Shows the number of a credit memo if a final invoice line has been posted together with one.

Work Package

Code

Shows the work package code of the WBS line to which you want to post sales. For revenue billed at the

project level, we recommend that you specify a WBS line that isn’t related to a budget and is intended

solely for storing sales from partial invoices.

You then need to ensure that you selected Fixed or Time & Materials in the Billing Type field on the line

if you want a payment plan included in an invoice suggestion. Which type you choose doesn’t matter, as

the amount stored on the plan line will also be used on the invoice.
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On invoice suggestions

Plan lines for which you selected the Copy to Suggestion checkbox are given priority on invoice suggestions. If a suggestion

contains open payment plan lines, the typical billing process used for projects and WBS lines is interrupted.

The following rules apply when you use payment plans on invoice suggestions:

The Copy to Suggestion field must be selected on the plan lines.

The scheduled posting date can be used as a filter so that the system suggests only partial invoices with even amounts.

Plan lines must relate to a valid WBS line. If there is no valid line, the plan lines will show an error message and cannot be copied

to a suggestion.

Only a final invoice can close a payment plan.

If there are open plan lines, standard project billing is suspended, and the next amount due (filtered by posting date) is suggested

instead.

Payment plans are always billed by direct invoice and not on an order.

Actual billing takes place with the final invoice. Depending on how you set this up, WBS lines will be suggested based on time and

materials or fixed-price billing. The invoice is then created from associated sales orders. A credit memo is applied to any partial

invoice.

This procedure can be used for an entire project or for specific WBS lines, as specified in the Payment Plan Level field on the

project card.

If a plan relates to specific WBS lines, standard billing will be used for all lines not connected to a plan.

If a plan relates to an entire project, a WBS line can be removed from the plan by selecting the Ignore Payment Plan checkbox so

that it is suggested for billing immediately.

Regarding rules 9 und 10, suggestions for billing a project might also include (besides payment plan lines that are due) WBS

lines that aren’t related to a payment plan. Plan lines are always billed by direct invoice (see rule 6).

If standard lines are marked for direct billing on one and the same suggestion, the system will create two different direct

invoices, one for payment plan lines and another for the remaining lines.

This facilitates the retracing of calculation steps if final invoices are used. If you don’t work with them, you can turn on the No

Separate Pmt. Plan Invoices toggle in Projects Setup to ensure that suggestion lines aren’t separated.

On credit memos

Full credit

If a credit memo fully settles a posted invoice created from a payment plan, that is, if the entire amount on a plan line has been

offset by a memo, the line is treated as if it had never been billed.

You can then delete, change, or recopy the line to billing unchanged.

Partial credit

If a credit memo only partly settles the amount on a posted invoice created from a payment plan, that is, only part of the line

amount is offset by the memo, the line is adjusted so that the amount on the line matches the amount on the invoice, minus the

value of the credit memo.

In cost control

To create project account entries for cost control, a project budget is used. This budget is distributed onto accounts according to

the account setup you specified when you turned on the cost control feature across projects.

Field Description

You can select WBS lines via the Work Package Code field or the Get Work Package function.

A warning message appears if you don’t select a line or if the WBS line you selected isn’t suitable for

billing.

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 
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The difficulty when budgeting project effort is how to estimate revenue on budget lines. The time spent on a project often doesn’t

translate into immediate sales but will show up later, on a fixed-price invoice.

A payment plan can rectify this problem by providing you with reasonable estimates of cash inflow in cost control. To use the

feature, you must choose Payment Plan in the Sales Project Acc. Entries From field on a project card.

When you now run the Update Project Account Entries batch job, a payment plan rather than the project budget will be used to

determine sales accounts. Finding an account is then a matter of matching it to the (target) work package to which you want to

post revenue. 
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MILESTONE BILLING

Overview

Milestones can be billed in multiple ways. Additionally, you can create milestone invoices per project or WBS line and invoice

work at a fixed price or by using a special billing method for each work package (that is, WBS line).
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For a project

The following paragraphs explain plan-based milestone billing for an entire project.

Billing level Billing type Payment plan Notes

On the project card,

the Invoice Project by

Milestones toggle is

turned on.

The payment plan

level is set to Project.

Fixed price on each

payment plan line.

A final invoice can be

used to bill every WBS

line and apply credit

memos to billed lines.

YES

Only lines on which the

Milestone Reached

checkbox is selected are

suggested for billing.

You can choose Final Invoice in

the Planning Type field to

schedule a final invoice.

When the invoice is due, the

invoice suggestion function will

include all relevant WBS lines,

their billing types, and the billed

fixed-price entries as credit

memos.

You can, at any time, delete WBS

lines and invoice them

separately (that is, parallel to

payment plan invoices).

This billing method posts, in

accordance with the payment

plan, revenues to a milestone

line of the work package type on

the WBS.

Work packages

The Invoice Project by

Milestones field is

turned off.

The payment plan

level is set to WBS

Line.

Fixed price on each

payment plan line.

A final invoice can be

used to bill every WBS

line and apply credit

memos to billed lines.

YES

Only lines on which the

Milestone Reached

checkbox is selected are

suggested for billing.

You can choose Final Invoice in

the Planning Type field to

schedule a final invoice.

When the invoice is due, the

invoice suggestion function will

include all relevant WBS lines,

their billing types, and the billed

fixed-price entries as credit

memos.

Work packages

No special setup is

required.

Instant billing per

package.

NO

No plan necessary (can be

set up to provide payment

info, but the Copy to

Suggestion checkbox must

be cleared).

Instant, one-time billing of WBS

lines related to a milestone line

when the milestone is reached.

A final invoice will not be

created.

This billing method uses a

milestone line of the blank type

to post sales to WBS lines

directly.

WBS line Fixed price YES This billing method uses a

milestone line of the work

package type to invoice a group

of WBS lines.

In other words, instead of being

invoiced separately, the WBS

lines are added to a payment

plan for billing.
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Project setup

WBS milestones

Lines for billing an entire project by milestones must be of the work package type, as they are later used to store revenue from

plan invoices. For lines to be processed on an invoice suggestion, their billing type must be set to Fixed (Price).

Milestone lines are highlighted in color.

For work packages specified as milestones, certain restrictions apply. The packages can neither have budget lines, nor can

quantities and prices be changed. A milestone line isn’t used for budgeting but is an element of time scheduling.

Work packages

To assign a milestone line to a work package, select a line, and then choose Line > Milestone Definition in the WBS Lines section.

You can choose only work packages that haven’t already been set as milestones.

Milestone plan

To set up or update payment plan lines for milestone lines, choose (Advance) Payment Plans > Update Project Milestone Plan in

the WBS Lines section.

With work packages already assigned to milestones on the payment plan, plan lines are then created from the total prices and

ending dates on the associated milestone lines.

Work breakdown structure

On the WBS, milestone lines are highlighted in color.

Payment plan

Payment plan lines where the Copy to Suggestion checkbox is selected can be used on invoice suggestions. As the payment plan

applies to an entire project, individual WBS lines aren’t included in the suggestion. With a project set to Milestone Billing, the

invoice suggestion also includes only lines for which Milestone Reached is selected.

Milestone Reached

When a milestone is reached, the work status on the WBS milestone line changes to Finished or Accepted (other statuses aren’t

possible in milestone billing).

The Milestone Reached field on the related payment plan line is also filled in, making that line available for billing on an invoice

suggestion. 

WBS lines without payment plan

If you don’t want to bill work packages based on a payment plan, as some expenses need to be invoiced regardless of whether

milestones are reached, select the Ignore Payment Plan checkbox on the relevant WBS line(s).

Invoice suggestions

A suggestion only includes plan lines on which the Milestone Reached checkbox has been selected.

Final invoice

A final invoice isn’t strictly necessary. If you want to use one to bill actual expenses on WBS lines, select Final Invoice in the

Planning Type field. The WBS lines are then included in a suggestion after every line on non-final invoices has been billed.

On the final invoice, the WBS is suggested for billing as if no plan existed. Each WBS line is also processed based on its billing

type.

Additionally, invoices created from the payment plan are added as credit memos to the invoice.

Field Description

Payment Plan Level Choose Project.

Invoice Project by Milestones Leave this toggle turned off.
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For a WBS line

The following paragraphs explain plan-based milestone billing for a WBS line.

Project setup

Work breakdown structure

No milestones are needed on the WBS, as the project as such isn’t billed by milestones.

Work packages that you want to bill according to a milestone payment plan require that Milestone be selected in the Billing Type

field.

Payment plan

Payment plans for individual lines are created manually. As you no longer specify plans for entire projects, the focus will be on

work package relations, that is, for which source work package you want to create a plan line.

As the same work package is invoiced, source and target packages are identical. You can use the Pmt. Plan Amt. % field to

establish a relation to a package. The value in this field is calculated from the total price shown on the related WBS line.

Milestone billing creates partial, fixed-price invoices at multiple stages of a project. The total price from the WBS line thus needs

to be included in the payment plan, and the planning type must be set to Invoice.

Don’t use the Final Invoice planning type here. This would create a final invoice and credit memos of already posted invoices.

For inclusion in suggestions, the Copy to Suggestion checkbox needs to be selected on the plan lines (done automatically). With

the Milestone billing type chosen on the WBS line, a plan line is only included in a suggestion if the Milestone Reached field is

selected. This must be done manually and corresponds roughly to the release of an invoice. 

Invoice Suggestion

To release a milestone for billing, select the relevant checkbox.

Without payment plan

A milestone plan can also be created from a WBS without the use of a payment plan. When a milestone is reached, the related

work package is then billed according to its billing type.

Project setup

No setup is needed on the project card.

WBS milestones

Not unlike the method described earlier, milestones are planned on the WBS. But this time, the Billing Type field needs to be

blank, as work packages—not milestones—are billed.

Work packages

To assign a milestone line to a work package, select a line, and then choose Line > Milestone Definition in the WBS Lines section.

You can choose only work packages that haven’t already been set as milestones.

Suspend Billing

If you don’t want to bill work packages related to a milestone until that milestone is reached, select the Suspend Billing checkbox

on each work package line to prevent invoice suggestions from including the package prematurely.

Field Description

Payment Plan Level Choose WBS Line.

Invoice Project by Milestones This field is not and cannot be turned on.

Note
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When WBS lines are assigned to a milestone line of the blank type, you are asked if you want to exclude these WBS lines from

billing. This way, billing takes place when the milestone is reached.

Milestone Reached

When a milestone is reached, its Work Status field is set to Finished. The system then checks if the Suspend Billing checkbox is

selected on related WBS lines, as these can now be released for billing with the help of a dialog.

Invoice suggestions

The rest follows standard billing procedures for WBS lines based on billing types. 

For multiple WBS lines

This billing method is different from the rest in that it only uses a milestone line to provide you with a convenient solution for

billing more than one WBS line with the same payment plan.

If the billing type specified for the group line wasn’t set to Fixed (Price) but to Milestone, the typical milestone billing process

would be run for the payment plan, and the subsequent invoice suggestion would only include plan lines on which the Milestone

Reached checkbox has been selected.

Project setup

WBS milestones

A milestone line intended for grouping must be of the work package type, as it is later used to store revenues from plan invoices.

For the line to be processed on an invoice suggestion, its billing type must be set to Fixed (Price).

If the billing type had been set to Milestone instead, the payment plan linked to the selected WBS line would be considered a

milestone plan and be used accordingly (as explained earlier). Milestone lines are highlighted in color.

For work packages specified as milestones, certain restrictions apply. You can neither create budget lines nor enter quantities or

prices for them. A milestone line isn’t used for budgeting but is an element of time scheduling.

Work packages

To assign a milestone line to a work package, select a line and then choose Line > Milestone Definition on the WBS Lines

FastTab.

You can only choose packages that haven’t been turned into milestones yet.

You must then select the Suspend Billing field on each WBS line linked to the milestone line so that those lines are excluded from

billing (as they should be billed through a payment plan).

Payment plan

To set up payment plan lines for the milestone line, you need to run the Update Payment Plan action.

You can then specify the number of plan lines onto which you want to evenly distribute the total price shown on the associated

WBS lines.

The plan must be edited after creation. At the very least, you need to specify the required posting dates. Usually, however, you

also need to adjust invoice amounts and edit their descriptions.

Work breakdown structure

On the WBS, milestone lines are highlighted in color.

Field Description

Payment Plan Level Choose WBS line.

Invoice Project by Milestones Leave this toggle turned off.
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The Total Price field on a milestone line used for grouping doesn’t contain the WBS line total, as this would double the budgeted

sales amount.

Payment plan

Plan lines on which the Copy to Suggestion checkbox has been selected can be included on invoice suggestions.

WBS lines without payment plan

As the Suspend Billing checkbox isn’t selected on WBS lines that you don’t want grouped with the help of a milestone line, you

can bill those lines the usual way.

Invoice suggestions

A suggestion only includes plan lines assigned to the milestone line. The associated WBS lines were excluded from invoicing

through the Suspend Billing checkbox.

STATEMENT OF SERVICES RENDERED

For time and materials entries, a statement of the services rendered is typically sent alongside an invoice. This statement

includes invoice entries from posted or prepared invoices. Proof of performance documents can already be printed when you are

about to bill an order so that you can make invoice corrections before posting. This eliminates the need for revising invoices not

accepted by a customer.

To print service statements alongside invoices:

Open a sales order.

On the Project Billings tab, turn on the Print Attachment toggle.

Even if the toggle isn’t turned on, you can still print a statement manually. This field and all other fields used for printouts can

already be preset on a project card.

The fields are later copied to posted invoices as well. You cannot change them there, but you can overwrite them on the request

page associated with a statement.

PERFORMANCE PERIODS ON INVOICES

You can have the period of performance, or a standard note about services rendered, printed on sales invoices in different

languages.

Format periods

To specify the formatting of invoice periods on printouts:

Choose the Search icon, enter Projects Setup, and then choose the related link.

In the Performance Date Formatting field, select an option described in the following table (includes two printout examples each):

Note

1. 

2. 

1. 

2. 

Option Example

YYYY-MM January 2023 

January 2023 to February 2023

YYYY-MM-DD 01-15-2023 – 01-25-2023

01-11-2023 – 02-14-2023

DD.MMM YYYY 15. Jan. 2023 – 25. Jan. 2023

11. Jan. 2023 – 14. Feb. 2023
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The performance period is entered on sales headers automatically when you choose to bill a project based on time and materials.

This type of billing requires invoice entries, each of which contains a date of performance. All these dates taken together then

constitute the performance period.

Print translations

To print notes about services rendered in the language spoken by a customer:

Choose the Search icon, enter Document Text Translation, and then choose the relevant link.

On each line, select a code in the Language Code field for a language that you want to use on printouts, and fill in the fields

described in the following table.

Set periods on sales documents

On sales headers and unposted invoices, you can change the Performance Date field whenever necessary.

Billing by time and materials fills in a period automatically based on the dates of the invoice entries that are created when you

prepare a bill. These dates will also be updated when you add or delete entries on invoice suggestions.

Posting an invoice will copy the contents of the Performance Date field to the posted sales invoice.

If the Performance Period field is used to print the period of services rendered on pro forma and (posted) invoices but the period

is left blank, the system will print a default note instead. Both are printed below all services listed on a bill.

BILLING REQUESTS

After a sales invoice or credit memo has been prepared, it is typically sent to an organization’s billing department, as the person

who prepared the document is most often not authorized to post it in the system.

With the Billing Request feature, project365 provides you with the means to simplify and standardize this process.

Create a billing request

To make a request:

Open a sales document.

On the ribbon, choose Home > Create Billing Request.

Specify a description for the request, if necessary, and choose OK.

A new entry is then added to the Billing Requests (Sales) page. Your decision of whether to specify a description manually

doesn’t affect the creation of this entry.

1. 

2. 

Field Description

Performance Date Text Enter a text that you want printed on an invoice if the Performance Period field on the relevant

sales header has been filled in. 

The text should contain placeholder %1 to indicate a performance period on the invoice.

Example

“This invoice convers services rendered in %1.”

If the period entered is January 2024, the note will look as follows: “This invoice covers

services rendered in January 2024.”

Default Performance Date

Text

Enter a text that will be printed when the Performance Period field is left blank.

Example

“Unless specified elsewhere, the date stated on this invoice is also the date of performance or

delivery.”

1. 

2. 

3. 
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Change a request description

You can also specify or change a request description later.

Open a sales document.

On the ribbon, choose Home > Update Billing Request Description.

Fill in the fields as necessary.

Open a request

To see a sales request:

Open a sales document.

On the ribbon, choose Related > Billing Request > Billing Requests.

The page is then filtered to the request created for this document. To see all requests, you can:

Go to your role center and choose Sales > Sales Billing Requests at the top.

Use the general search function to look for the Billing Requests (Sales) page.

The requests shown there represent a to-do list for your organization’s billing department, as the documents that you created

them for have been released and can now be posted by running the Show Document action from the page.

When the status of a request line is changed to In Progress, the user who is editing the line is entered as the Person Responsible

for it. You can see this status on the associated (unposted) document as well.

The request status can additionally be shown as part of the sales order, sales invoice, or sales credit memo list by unhiding the

Billing Request Created and Request in Progress fields on the relevant page (via the Personalize function).

If a request is no longer needed, for example, because it shouldn’t be posted after all, it can also be deleted or archived at any

time.

You can also check the status of the billing request in the lists for orders, invoices and credit notes. To do this, it is necessary to

show the fields "Billing Request Created" and "Billing Request In Progress".

Billing Requests Archive (Sales)

You can use the Archive Request action on the ribbon to move requests that are no longer required to the Billing Requests

Archive (Sales) page.

However, sooner or later, even active requests will be archived—without user involvement. This is the case when the related

sales invoice or credit memo is being posted, for example.

When requests are archived by the system, the number and the posting date seen on the related document are added

automatically to the archived record.

Entries in the archive are read only and cannot be deleted.

PROJECT SALES ENTRIES

Project ledger entries of type Sale are used to record project revenue. They’re created when you post sales documents.

For a project billed based on time and materials, one sales entry closes one or more entries of type Time & Materials. You can

see the number of closed T&M entries and the quantity that was billed for them in the Applies-to Sales and the Sales Adjmt.

Quantity fields.

Line discount amounts and percentages are also shown; an invoice discount, on the other hand, is distributed evenly among the

sales entries so that it can be applied to each Line Amount field in equal proportions.

See the following for examples:

1. 

2. 

3. 

• 

• 

• 

• 

Note
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Example 1 – Line discount on a project ledger entry

Example 2 – Invoice discount

Ledger entry 1

Ledger entry 2

Line and invoice discounts can also be posted and shown together.

Quantity 10

Unit Price 50.00

Total Price (LCY) 500.00

Line Discount % 10

Line Discount Amount (LCY) 50.00

Line Amount (LCY) 450.00

Invoice line 1 10 * 50.00 = 500.00

Invoice line 2 10 * 60.00 = 600.00

Invoice amount 1100.00

Invoice discount 10% = 110.00

Discount per line Line 1 = 50.00

Line 2 = 60.00

Quantity 10

Unit Price 50.00

Total Price (LCY) 500.00

Line Discount % 0

Line Discount Amount (LCY) 0.00

Line Amount (LCY) 450.00

(The line amount was reduced by the discount on the invoice.)

Quantity 10

Unit Price 60.00

Total Price (LCY) 600.00

Line Discount % 0

Line Discount Amount (LCY) 0.00

Line Amount (LCY) 540.00

Note
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Create Projects from Sales Documents

Whereas previous chapters have described, one after another, how to set up a project, calculate the effort that was put into it,

and create sales documents from it, the following chapter will explain how to do the reverse, that is, create a project from a sales

quote or order.

CREATE LINES FROM PROJECT TEMPLATE

This action can be run to create lines for a blank sales quote or order so that you don’t have to specify a project structure

manually when you later want to set up a project from the sales document.

For this reason, the function retrieves not only the work package lines from a project template but also, for example, the Begin-

Total and End-Total lines entered on it.

Whether template lines are added at the WBS or budget line level to the blank document depends on the option you selected in

the Copy to Sales Doc. field on each line. Additionally, Begin-Total and End-Total blocks are set up around the budget lines

assigned to the same template line, to keep them together on the new document as well.

As for the Expand Budget Lines fields on the template lines, you can use them to specify that when you run the function to set up

document lines in sales and one of the Copy to Sales Doc. Field on the template is set to WBS Line, the system should also copy

the associated budget lines to the new structure.

Although template lines for which the No Transfer option is selected in the Copy to Sales Doc. field aren’t transferred to the sales

document when you run this function, you can later add them manually to a WBS (when you’ve created a work breakdown structure

from the document) or set up new templates for them (from which you can then transfer them in blocks).

CREATE PROJECT AND WBS

This action, found on the ribbon of sales quotes and orders, opens a page on which you can use two functions and a toggle to

create a project from a sales document, as described in the following.

Create New Project

Running the Create New Project action from the page starts the project wizard. You then must specify a project template unless

the sales document was created from one (see Create Lines from Project Template), in which case the Project Template Code

field is filled in automatically. The template isn’t used to create a WBS, however, which is what you’ll do later with the help of

another function.

You can then choose OK to go to the next page, where all customer-related fields have already been filled in (and can no longer

be changed) and where the Status field has been set to Quote or Open (Order), depending on which document ribbon you ran the

action from. Neither field can be changed. The other fields on the page, including the Starting Date and Person Responsible, are

blank and need to be filled in manually.

When you exit the wizard, you’re asked if you want the new project number to be copied to the document lines that you’re using

to create the project. Typically, the answer to that question is Yes. Afterward, the system will:

create the project (so that you can open the project card for it).

link the sales document header and lines to the new project.

copy the dimensions of the project to the sales document.

You cannot run this function for a sales document that is already linked to a project.

Note

• 

• 

• 

Note
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Create WBS/Lines

You can now run the Create WBS/Lines function, found on the same page as the wizard, to create a work breakdown structure

for the new project by using from the sales document resource, item, or G/L account lines that aren’t already linked to a WBS or

budget line. You can, however, also complete this part later if necessary.

Document lines that you want recreated as service package lines on the WBS must already have a work type assigned to them, as it

is the only way to ensure that the new work breakdown structure contains valid package prices and units of measure.

You can, however, change a price later if necessary. Additionally, the work type that is copied doesn’t need to match the type

assigned to the WBS (considering you can also change this type on both WBS and budget lines later).

Copy to Project / Target Project No.

Only document lines where the Copy to Project field is selected are included when you run the Create WBS/Lines function.

If, when running the Create New Project action, you said Yes to the question of whether to enter on all sales document lines the

number of the project you just created, the Target Project No. is already filled in on the lines. Otherwise, the number is entered

after you select the Copy to Project field there.

Begin-total and end-total lines that were copied with the help of a function to the sales document from a project template—to

indicate the start and end of certain budget lines—cannot be marked for transfer to the project.

This is because the WBS/Lines function automatically creates a WBS line for each sales document line on which the target WBS

level is set to Budget Line, which prevents the creation of additional begin-totals and end-totals.

Target WBS Level

The target level specifies if you want a sales document line to be set up as a WBS or budget line on the new project. Budget lines

that contain the same work package (and potentially the same phase, task, and step codes) are grouped on projects.

Target Work Package Code

A work package must be filled in regardless of whether you want a document line copied at the WBS or budget line level.

If the target level was set to WBS, the billing resource entered on the document line must match the resource linked to the target

work package, as this resource is also required when you complete the process in reverse, that is, when you create a sales document

from a work breakdown structure.

If the document line was created with the help of a project template, the target package is filled in automatically for the function (not

on the sales line yet, however), as is the billing resource.

If the line includes an item and was added manually to the sales document, the work package is filled in based on the item category

or the item itself, as both might have work package codes entered for them. If the item isn’t assigned to a category or no package

code was linked to it, the code is retrieved from the relevant item card.

In all cases, however, the system will look for a suitable package, as you can specify in the work package master the types (items,

resources or resource groups, and G/L accounts) that you want to set up budget lines for. This means, for example, that you cannot

select a package of an item (category) if budget lines aren’t allowed for it.

Phase, task, and step codes

You don’t need to but can fill in the Target Phase, Task, and Step Code fields on the page as well. You cannot, however, use the

auto PTS code entered in Projects Setup here, as this code is filled in automatically during the creation of a WBS.

Note

Note
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The use of auto-activity codes is recommended for the "Create WBS from sales document" process. Once the WBS has been

created, these codes (e.g. by project managers) can be adjusted as long as there are no other documents (e.g. purchase) or

bookings (e.g. time bookings). The updated activity codes are transferred to the corresponding sales lines so that the reference

to the WBS line is retained.

Target Resource Type

If the target WBS level is Budget Line, you can choose another resource or resource group for transfer to the new project if

necessary. If you leave the field blank, the system will use the resource specified on the sales document line instead.

If the sales document line contains a billing resource, you need to specify another target resource here.

Target Billing Type

This field is filled in with the type stored on a project template if you’ve used the Create Lines from Project Template action but

can be changed if necessary.

For a sales document line created without a template, you can also fill in the field manually.

Work Status

This field is filled in from the project template but can be changed manually, if necessary.

Project Template Code / Project Template Line No.

These fields show the template that the lines on a sales document originate with if you’ve run the Create Lines from Project

Template function to set up the document.

The information they contain is then used for the Expand Budget Line feature.

Expand Budget Lines

This field tells the system whether to create budget lines from a project template when you run the Create WBS/Lines function.

It is selected automatically depending on how the template has been set up, although you can change the field manually if

necessary. Changing the field, however, is only possible for sales document lines on which the Target WBS Level is set to WBS

and is only useful for lines with project template codes.

Batch copy WBS lines

When sales lines are created from a project template that a WBS Line Batch is specified for, the batch (which consists of WBS

lines transferred from another template) is automatically entered into the new structure.

A line batch is useful when you want to add to the WBS internal cost lines that aren’t transferred to sales documents but need to

be part of the structure. For more information, see Project Template.

Other document line fields

All other field values, such as sales prices, line discounts, invoice quantities, and descriptions, will be copied to both WBS and

budget lines automatically.

Dimensions

For sales lines that were created in a sales document from a project template, the standard dimensions from the master data

(e.g. customer) are used first. As soon as a project is generated from the sales document with a project template, the default

dimensions of the template are transferred to the new project.

When the project number is written back into the sales document, the project dimensions are also transferred.

When creating the WBS lines from the sales lines, existing dimensions can be transferred from the WBS template lines and these

then also flow into the respective sales line.

Note
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Document texts

If the function for creating sales lines from a project template is used in a sales document, you are asked whether the additional

texts contained in the project should be transferred to the sales header. Existing texts are retained.

If there are additional texts for the WBS lines in the project template, these are always transferred to the new sales lines.

When creating a project from a sales document, the project template is used, but the texts from the sales header are transferred

to the new project instead of the additional texts.

If the WBS lines are generated from the sales lines, the additional texts are also transferred to the new WBS lines.

Create project prices

When you create WBS or budget lines, you can additionally set up one sales price list per project by turning on the Create

Project Prices toggle on the header of the Create Project and WBS from Sales Document page. Every price entered on the

relevant sales document lines is then added to this list.

If a list already exists, it is expanded to include those values. Available prices, however, aren’t replaced. You’ll be notified if a

price has already been entered for resources of a certain work type.

The feature only copies prices that already exist when you turn on the toggle and run the WBS/Lines function.

CHANGE REQUESTS

Change requests can be copied from a quote or an order to an existing project and its WBS lines by entering the number of the

project on a blank document header (that is, a header to which only a document number has been assigned so far).

Afterward, all available customer data is transferred automatically. To prevent manual overwrites, this includes the values

entered in the Your Reference and External Document No. fields (provided they were filled in). What exactly is being copied

depends on how the project has been set up.

The following happens in any case when you run the function:

Lines from a sales quote are transferred to the WBS as quote lines.

Lines from a sales order are copied to the WBS as order lines and can therefore only be transferred to projects that are set to

Open (Order).

A Begin-Total and an End-Total line, as well as a reference to the sales document, is added (provided the Batch Copy Change

Requests from Sales to WBS toggle is turned on in Projects Setup).

The change request gets its own WBS lines, even if the target work package that you select is already assigned to the WBS.

If you create a project from a sales document and have only some of the lines copied to a new, blank WBS, the lines that remain after

the transfer will be considered part of a change request when you have them copied later.

Note

• 

• 

• 

• 

Note
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Service Packages

A service package is defined as a group of services billed to a customer for a set price. The time spent on completing the package

is stated in hours, and a project is used to plan, post, and bill all related expenses and revenues.

The use of service packages requires the Microsoft Dynamics 365 Business Central price list functionality.

SETUP

Work type

To be able to use a resource as a service package, you need a work type with a unit of measure that matches the resource’s base

unit and a billing unit that reflects the nature of the work being done.

This way, you can record and post the time spent on completing and delivering the package in hours but, for example, invoice the

work by piece later.

Work package

To be able to add a service package to a WBS or budget line, you also need a work package that must be filled in as described in

the following table.

Note

Field Value

Budget Type

Resource

Turn on this toggle.

Billing Base Select Resource.

Billing No. Choose a billing resource that contains the units used for the specified work type (for example,

Piece and Hour).

Billing Type Select Time & Materials.

Work Type Code Enter the work type specified for service packages.

Copy to Sales Doc. Select Budget Lines.
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Projects Setup

The use of service packages requires the Microsoft Dynamics 365 Business Central1 price list functionality.

The Allow Default Settings Update field must be turned on for the specified price lists. This is because the price list lines associated

with a service package are created with a starting date and this date might be in contradiction to the data entered on the list header.

Selecting the field therefore prevents you from receiving error messages when maintaining price data for service packages.

SPECIFY A PACKAGE

Service packages are set up as resources in the system. The type you assign to a package doesn’t matter; still, we recommend

that you specify packages as machines to better distinguish them from human resources.

Field Description

Work Type 

(Service Package)

Specify the work type that will be used by default when a resource is designated as a service

package.

The base unit specified for the resource must be Hour and the billing unit a measurement that

reflects the nature of the package (for example, Piece).

Sales Price List 

(Service Package)

Select the project sales price list that you want to save unit prices for service packages to.

Auto Update Sales Price

List (Serv. Pckg.)

Turn on this toggle if you want the sales price list specified in the previous field to be updated

automatically when the price for a service package is changed.

Note

The list entry is created with the date set to today. To set your own date instead, you need to

run the Update Sales and Purch. Prices (Serv. Pckg.) action from the ribbon of the relevant

resource card.

Purch. Price List 

(Service Package)

Select the project purchase price list that you want to save unit costs of service packages to.

Auto Update Purch. Price

List (Serv. Pckg.)

Turn on this toggle if you want the purchase price list specified in the previous field to be

updated automatically when the cost of a service package is changed.

Note

The list entry is created with the date set to today. To set your own date instead, you need to

run the Update Sales and Purch. Prices (Serv. Pckg.) action from the ribbon of the relevant

resource card.

Note

Note
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You can then fill in the service package fields on the relevant resource card as described in the following table.

The other fields are set up in the same way as for standard resources.

Prices

All packages are sold at fixed prices. When you enter the price of a package in the Sales Price field, a new line is (automatically;

see note) created for it on the Project Sales Price Lists page, giving the amount in local currency. Prices in foreign currency must

be added manually to the list.

The cost per unit is calculated as follows:

Planned Qty. * average unit cost of all resources who contributed to completing the package.

The result is entered in the Unit Cost field. The Unit Cost / Planned Qty. field is also updated, and a new price list line is added to

the Project Purchase Price Lists page (by the system; see note).

If you turned on the Auto Update Purch. Price List (Serv. Pckg.) and Auto Update Sales Price List (Serv. Pckg.) toggles in Projects

Setup, prices are updated automatically, with the date set to today. If you didn’t, you can set your own date by running the Update

Sales and Purch. Prices (Serv. Pckg.) action from the ribbon of the resource card.

ON PROJECT BUDGET LINES

To be able to assign service packages to a project, you need lines with suitable work packages.

We recommend that for every project, you create a WBS line on which you collect the packages that you sell to customers. Each

package can then be stored on a new Resource-type budget line, where you enter the resource linked to the package.

After you’ve filled in the resource, the system copies—besides the description and units entered for it—the prices or costs

specified for the service package from the relevant price list.

You can then post to the line the time spent on completing the package, with billing set to Time & Materials at budget line level

(so that all packages are sold separately to the customer).

When all values are filled in, you can also perform a target-actual comparison to see in what amount of time you expected to

complete the service package and how long it actually took.

Field Description

Service Package Turn on this toggle if you want to mark the resource as a service package. To help distinguish these

packages from human resources, we recommend that you select Machine in the Type field.

Service Work Type If the resource is marked as a service package, the work type that is used for packages is copied to

this field automatically.

Invoice Qty. Enter 1 in this field if resource hours are combined into a service package, that is, the resource is

billed by time and materials.

Invoice Unit of

Measure

This field is filled in automatically if you mark the resource as a service package and cannot be

changed.

Planned Qty. If the resource is designated as a service package, that is, work is billed by time and materials, specify

—in hours—the effort required to complete it.

Planned Unit of

Measure

This field is filled in automatically if you mark the resource as a service package and cannot be

changed.

Unit Cost / Planned

Qty.

This field is also filled in automatically and indicates the estimated unit cost per hour for resources

designated as service packages—the result of dividing the cost of the chosen package by the planned

quantity.

Note
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ON SALES DOCUMENT LINES

You can use the Create Sales Document function to copy service packages to sales documents. But even without running this

action, you can add a package to a sales quote, for example, by entering it manually on a document line.

The line must be of type Resource. After you choose a resource in the form of a service package, the system copies to the line not

only the description of the package but also its unit price and billing unit.

RECORD TIME SPENT

If you want to add service packages to a project, the project must have been set up in a way that all hours spent on completing a

package can be recorded at budget line level.

To simplify the recording process, the time tracking page shows only budget lines assigned to the relevant resource or its

resource group and the lines of other service package resources stored in the system.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Intercompany Work

OVERVIEW

The intercompany management functionality is designed for users who have set up multiple independently operating business

entities, each aiming to cover a different region or territory or provide a distinct range of products and services to customers.

Called companies in the system, they typically manage their own data and finances. Sometimes, however, several of them might

need to supply products or services to the same customer at the same time. For example, a project might require that staff

members working for one company lend their expertise to another. This is where IC management can help coordinate and bill

work done on a project.

INTERCOMPANY FUNCTIONS AND ROLES

When a customer places an order for an intercompany project, one organization typically takes on the role of main contractor.

This business will be referred to in the following as the billing company.

The services and materials required for the project are then stored on WBS lines that you set up within that company. However,

to provide a specific service, the business now hires another to act as a subcontractor, which will be called the service company

for the purposes of this article.

The business relationship between both companies isn’t set in stone. For other projects, the roles might be reversed, and the

organization that used to supply a service might become the business entity that bills the project. A billing company can hire

multiple service companies for a project or complete work on its own.

All service companies are set up as vendors in the partner company that bills the project. The partner, in turn, is entered as the

customer in each service company. The actual customer is stored with the project that you set up in the billing company.

To transfer a resource task to a service company, you can then choose WBS lines in the partner business and use a function to

copy the entire project, including the selected lines, to the service company for processing the order.

Service companies always send invoices to a billing company and never directly to a client. The project ledger entries that are

created from posting these outgoing invoices—marked as inbound in the billing company—are assigned to a WBS and later

invoiced to the end customer according to a project-specific price agreement.

Billing and service companies might use different local currencies, which will affect how invoices are settled internally. For

example, a billing company might be sending invoices in EUR, whereas the business providing services for the project being

billed might have entered DKK as its local currency in Finance Setup.

SETUP

Register a billing company

Before you can copy project data from one business to another, you need to turn on IC management. The settings described here

only need to be made once.

Choose an IC partner

Each billing company must have a service company assigned as an IC partner. To assign a partner:

Choose the Search icon, enter Intercompany Partners, and then choose the related link.

On the ribbon, choose New to set up a partner.

Fill in the fields as described in the following table.

1. 

2. 

3. 
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General

Purchase Transaction

This FastTab shows the vendor assigned to the billing company’s IC partner.

To set up a vendor, open a vendor card and choose a company partner in the IC Partner Code field on the General FastTab. The

Vendor No. field is then filled in automatically. 

KUMAVISION project365

Filling in the fields on this FastTab is optional but provides you with a set of alternate numbers and codes when you transfer data

to a service provider. WBS and budget lines that you create in a billing company include primary keys, that is, numbers and

codes, for the following project information:

Resources and resource groups

Work packages

Phase codes

Task codes

Step codes

Work types

Because data records in service companies don’t need to have primary keys identical to those in a billing company, you can use

the options on this FastTab to specify new numbers and codes for them as described in the following table.

Example

In a billing company, a work package named Project Management with code AP001, shared code PL, and new number RAB001

was entered on a WBS line that you want to copy to one or more service companies.

Internal Code

Billing company code AP001 is copied as is to all service companies.

Field Description

Currency Code Specify the currency used by the service company.

Transfer Type Specify the type of data transfer.

Note

Intercompany project management in KUMAVISION project365 currently only supports data transfers

between billing and service companies stored in the same database. This field must therefore be set to

Database.

Company

Name

Enter the name of the service company.

Note

Intercompany project management in KUMAVISION project365 currently only supports data transfers

between billing and service companies stored in the same database.

• 

• 

• 

• 

• 

• 

Field Description

Internal Code (Internal No. for

resources)

The code (or number) is copied as is from the billing company to the service company.

Shared Code (Shared No. for

resources)

The code (or number) is copied from the Shared Code field in the billing company’s data

record to the service company.

Activity IC Partner Ref.

(Resource IC Partner Ref. for

resources)

The code (or number) is copied from the IC Partner Reference field in the billing

company’s data record to the service company.

A reference can be added to a data record wherever you can set up the numbers and

codes listed earlier.
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Shared Code

Shared package code PL is copied to all service companies instead.

Activity IC Partner Ref.

Work package code RAB001 is copied to service company IC1020.

As you can copy projects from one billing company to multiple service companies, the first two options apply to all existing

service providers.

The third features company-based code calculations for service companies, which makes it the most flexible but also the most

time-consuming setup solution.

For resources or resource groups, there also exists the option of converting a certain resource in the billing company into a

resource group in the service company as you copy data from one to the other.

This option is particularly useful if a certain resource is entered on a budget line in a billing company, but the partner company

only requires that the line be completed by a member of the related resource group, and the other way around.

To turn on the option, select Resource IC Partner Ref. in the Outbound Project Resource No. Type field on an intercompany card.

You also need to assign the resource to the relevant service company. To do this:

Open the relevant resource card.

On the ribbon, choose Related > Resource > IC Partner References.

Fill in the fields as necessary.

Another field on the FastTab is the Outbound Project No. field, which shows the number that you want to use for projects copied

to the partner company. The options in this field are described in the following table.

Register a service company

Service companies must also be configured before first use.

Choose an IC partner

1. 

2. 

3. 

Field Description

Type Specifies the type of record. In our example, the field is set to Resource automatically.

No. Specifies the number of the record. In our example, the number of the resource is filled in

automatically.

Cross-Reference

Type

Specifies the type of company reference. In our example, the type is set to Vendor.

Cross-Reference No. Specifies the number of the company reference. In our example, the vendor number is retrieved from

the service company.

New Type Select the type that you want to store in the service company, for example, Resource Group.

New No. Specify a new number based on the preceding field.

Description Enter a description of the intercompany reference.

Field Description

New No. Assigns to the project the next number from the default series that you set up for new projects in the

service company.

Shared Project

No.

Retains the number from the billing company so that the number will be the same in both companies.

No. Series Assigns a new number from a specific series that must exist in both companies. The number series is

selected in the Outbound Project No. Series field.
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Like a billing company, a service company must be assigned to an IC partner. To assign a partner:

Choose the Search icon, enter Intercompany Partners, and then choose the related link.

On the ribbon, choose New to set up a partner.

Fill in the fields as necessary.

General

Sales Transaction

This FastTab shows the customer assigned to the service company’s IC partner.

To set up a customer, open a customer card and fill in the IC Partner Code field on the General FastTab. The Customer No. field is

then filled in automatically.

In the Outbound Sales Resource No. Type field, you specify if you want the number of a billing resource to change when a sales

invoice is sent by the subcontractor to the billing company, where it is converted into a purchase invoice. Billing resources are

used by service companies to charge for work they have done on a project. The options available in the field are described in the

following table.

This field is not to be confused with the Outbound Project Resource No. Type field.

The Outbound Project Resource No. Type field is used to copy projects, including selected WBS and budget lines, from a billing

to a service company and is maintained by the billing company see Register a Billing Company.

1. 

2. 

3. 

Field Description

Currency Code Specify the currency used by the billing company that you want to assign to the subcontractor.

If the billing partner uses another local currency than the service company, the code specified for the

currency must be the same in both companies.

In our earlier example, where the billing company’s local currency is EUR and the service company’s is

DKK, EUR needs to be specified as a currency in the service company.

Transfer Type Specify the type of data transfer.

Note

Intercompany project management in KUMAVISION project365 currently only supports data transfers

between billing and service companies stored in the same database. This field must therefore be set to

Database.

Company

Name

Enter the name of the billing company.

Note

Intercompany project management in KUMAVISION project365 currently only supports data transfers

between billing and service companies stored in the same database.

Option Description

Internal No. Copies the number of the resource from the service company’s outgoing invoice to the billing

company’s inbound invoice.

Shared No. Replaces the number of the resource on the billing company’s inbound invoice with the value

specified in the service company on the card of the resource in the Shared No. field.

Resource IC

Partner Ref.

Replaces the number of the billing resource on the billing company’s inbound invoice with an IC

partner reference, which is stored as additional information on resource cards in service companies.

Note
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The opposite is true for the Outbound Sales Resource No. Type field, through which the system converts resource numbers on

sales invoices sent to billing companies. This field is updated only in service companies and extends standard functionality to

include IC transfers of resource-type invoice lines, which are needed to calculate project usage based on billing resources.

You can also use the Outbound Sales Resource No. Type field for other purposes, for example, when you don’t work on a specific

project but want to copy a sales invoice with resource lines between companies.

The Shared Type or New Type field must then be set to Resource, as only resources, not resource groups, can be copied to sales

and purchase invoices. 

COPY PROJECTS FROM BILLING TO SERVICE COMPANIES

As described earlier, you must set up an IC partner as a customer and another as a vendor if you want to copy a project from a

billing to a service company.

Before you can exchange information between them, you also must have specified how basic project information is converted

during transfers, including conversion rules for resources and resource groups, work packages, phases, tasks, steps, and work

types.

Create a project in a billing company

To use intercompany management, a billing company must be specified as the main contractor. You also need to create a project

with WBS lines and budget lines and select a customer for it.

Additional fields on the project card, on the Intercompany FastTab, then show the status of transfers between the billing

company and its subcontractors.

The No. of IC Partners is the only relevant field on this FastTab in a billing company. The field shows the number of service

companies to which the project has been copied. The other fields are required by service companies and are described later.

Before you can copy a project to a service company, you need to open the relevant WBS and assign a partner through the IC

Partner Code field to each line that you want to transfer. You can assign a different IC partner per line if necessary. All lines not

assigned to a partner contain work packages that will be provided by the billing company. Afterward, you need to run the Copy

Project to IC Partner function from the project card. 

The budget lines you set up for the project are then copied alongside their WBS lines to the service company. To prevent the

system from transferring a line, you must select the No IC Transfer checkbox there.

Example

Besides the services ordered, another budget line has been set up. This line must not be copied, as it is used for intercompany

reconciliations. To prevent the line from being copied, you select the No IC Transfer field there.

The Copy Project to IC Partner action requires the selection of an intercompany partner. Available are all partners specified as

such on the WBS lines of the project, which will make it easier for you to choose a partner if many companies have been stored in

the system. You then need to rerun the function for each partner that you want to send the project to.

If you’ve turned on the ICP Ships to Customer Address toggle on the project card (might already be filled in from a project

template), the address specified for the project is entered as the service company’s ship-to address. With the toggle turned off,

the project will be delivered to the business billing the services, that is, to the customer address entered there.

Specify resource prices

Besides WBS and budget lines, you can use prices that were agreed on by a service and a billing company to create invoices for

internal billing. Each price you enter on the Project IC Partner Resource Prices page applies only to a specific project.

When you copy a project, the price is then copied to the service company’s Project Resource Prices page. The fields on both

pages are identical.

Based on what option you selected in the Type field, you can enter price information for specific resources, resource groups, or

all resources.

A price that is stored in the Price (LCY) field is always shown in a billing company’s local currency. This is because the work

performed by subcontractors will be billed in the currency specified for the billing company.
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Copy a project to a service company

To copy a project from a billing to a service company:

Open a project card.

Choose Copy Project to IC Partner.

On the Options tab, choose the IC partner to which you want to copy the project.

Choose OK to start the transfer. The number of records copied is shown when the process is complete.

A project can only be copied if it set to Open and the WBS lines you want to transfer have the work status In Progress or Open.

Running the function increments the value in the No. of IC Partners field in the billing company (see the Intercompany FastTab

on the project card). This field specifies to how many partners a project has been copied so far. You can go to the field to open a

list that shows all IC partners assigned to the project and the number they gave the project.

As the same project can be copied to an IC partner multiple times to update information, the number of times a project was

copied to a single business is shown as well. To see a complete log of all transfers, select the No. of Transfers field.

A project is copied to only one intercompany partner at a time. However, you can run the Copy Project to IC Partner function as

often as you need. You can also use it repeatedly, for example, to copy additional WBS lines to the same IC partner or to add new

price agreements from the Project IC Partner Resource Prices page.

As mentioned, running the function more than once to copy data to the same project and partner increases the value in the No. of

Transfers field in the Project IC Partner table by one.

Each time, the function checks if the billing company contains all the data necessary for transferring resources and resource

groups, work packages, phases, tasks, steps, and work types to the relevant service company.

For example, if you select Shared No. as the outbound project resource number type on a resource card, the system checks

during transfer if this field has been filled in for each resource and group that you want to copy and then copies its value to the

subcontractor.

The same applies to conversions based on the Activity IC Partner Reference option. If you use this conversion rule, all data that

you want to copy must have a reference entry to an activity in the billing company, and the New No. field stored there cannot be

blank. However, the function doesn’t check if new values calculated according to the rule are valid in the service company.

Review data in a service company

Prior to an explanation of how to review project data, an example will demonstrate how much of a project stored in a service

company is copied from a billing company.

Scope of data transfer

A number is assigned to a project in a service company depending on what option you chose in the Outbound Project No. field on

the billing company’s project card.

In our example, the New No. option has been chosen on the project card. When the project is copied from the billing to the

service company, a new number is then assigned to the project automatically. This number is the same as the number that is

stored in the billing company’s IC partner list. 

In the service company, you can now see on the Intercompany FastTab on the card of the same project where the project

originates. The two projects are therefore linked—the prerequisite for copying invoices and assigning ledger entries between

companies.

1. 

2. 

3. 

4. 

Note
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Linking a service to a billing company also fills in other Intercompany FastTab fields relevant to the service company. They are

described in the following table.

The customer stored with the service company is the billing company, as the service company isn’t the end customer but the

subcontractor.

If a billing and a service company use different local currencies, we recommend that you already store the invoice currency for

the organization that bills services with the company that supplies them. Invoices sent between a service and a billing company

always appear in the currency set up for the billing company.

Copying project data to a service company also copies information from the project's WBS header and lines, including from its

budget lines. In our example, the work package ordered is transferred as well, with the rest of the packages to be completed by

the billing company on its own.

You can copy a project from a billing to a service company more than once. If you do so, the system will skip WBS or budget lines

that have been copied to the subcontractor in the past. For this reason, the IC review status of all budget lines is identical to that

of their WBS lines.

In the service company, you can then edit the copied WBS and budget lines or create new lines manually. You can also create

budget lines for a WBS line transferred from the billing company. This means that projects set up in service companies can have

both WBS and budget lines with and without a reference to a billing company.

Project transfers additionally include the headings and extended texts that were entered on WBS and budget lines to help

subcontractors provide required services. However, this again only occurs the first time you copy lines. Neither headings nor

texts will be updated during repeats. 

Similarly, comments entered for a project, WBS lines, or budget lines aren’t copied at all, as they’re considered internal

information intended only for employees of the billing company. Dimensions (on a project header, on WBS lines, and on budget

lines) typically aren’t copied either, as they’re recalculated in service companies depending on how you set them up there.

Field Description

Source IC Partner

Code

Specifies the code of the IC partner if a project is copied from a billing company. The field is empty

if the project is a standard project with no intercompany reference.

Source IC Partner

Project No.

Shows the number of a project stored with a billing company if the project has been copied from

there. This field is empty if the project is a standard project.

IC Review Status A project copied from a billing company must be reviewed in the current service company before it

can be posted. This field shows the status of the review.

(blank)

The project is a standard project that hasn’t been copied from a billing company.

Open

The project needs to be reviewed.

A project receives this status automatically after its initial transfer from a billing company. When

you repeat the transfer, the field is filled in again if new data is copied to the project.

Completed

The project has been fully reviewed.

IC Res. Price Review

Open

Shows if the transfer included project resource prices that still need to be reviewed.

IC WBS Line Review

Open

Shows if the transfer included WBS lines that still need to be reviewed.

IC Budget Line

Review Open

Shows if the transfer included budget lines that still need to be reviewed.
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Project IC resource prices, on the other hand, are transferred to the Project IC Prices page. Furthermore, some base data used

for project management is converted according to the rules specified in the billing company. This includes data regarding

resources and resource groups, work packages, phases, tasks, steps, and work types.

Still, after a project has been copied to a service company, multiple fields on the project header, the WBS lines, and the budget

lines remain blank. Examples are the address fields on the header and the price fields on the lines.

When you transfer a project, the system strictly applies the specified conversion rules to make changes to data in the service

company. However, it doesn’t check if a copied field value can be used in that company.

For example, although project usage might be assigned to a resource group, the system doesn’t check whether the group exists

in the service company. Because there might be other missing and partly non-validated information, the Locked toggle on the

card of a copied project is set to Post automatically after each transfer. You then need to review the project before you can post

to it.

Review a project in a service company

Sometimes, the conversion rules that you specified for intercompany transfers might not be enough. For example, the phase,

task, and step codes set up for a project might not exist in the service company to which you copied the job.

To check project data in a service company:

Open a project card in the company.

Choose Actions > IC Review on the ribbon.

On the Options tab, select for phase, task, and step codes if you want them created automatically or whether the review process

should be canceled with an error message when one of the codes doesn’t exist.

If a project transfer has created inconsistencies in other data, for example, in resource group records, the process will be canceled

regardless.

Choose OK to start the review.

The system then runs a check on all project-related data that was copied to the service company. If the process is canceled

because of an error, you can correct the error manually and rerun the function.

Following the review, some of the Intercompany FastTab fields on the project card are updated as described in the following

table.

The Locked toggle on the General FastTab is then turned off as well, which will allow you to post to the project again.

The status of the project, however, is still set to Quote. You can set the status to Open in the usual way, via the Status field, and

fill in the Person Responsible field thereafter.

To post consumption to a work package entered on the WBS, you need to set the work status of the package to Released. You can

also add more packages, if necessary.

Example

You set up a package for coordinating work with the business that placed the order you’re currently completing. Because the

package isn’t invoiced to your intercompany partner, you set the Billing Type field to No Billing. This way, the WBS line on which

you filled in the package in the service company will not be linked to a line in the billing company.

1. 

2. 

3. 

4. 

5. 

Field Description

IC Review Status The status of the review is set to Completed.

IC Res. Price Review Open The status that indicates if there are still resource prices to review is set to No.

IC WBS Line Review Open The status indicating if there are still WBS lines to review is set to No.
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You cannot delete budget or WBS lines that are copied to the service company in this way.

POST CONSUMPTION IN A SERVICE COMPANY

Before you can post time and material usage for a project in a service company, you need to ensure that the data pertaining to

the project is validated (see Review a Project in a Service Company).

The project is then treated like any other: Employees can record their hours on it, and the project manager can approve these

hours and post them to the project.

Sales invoices can also be created in the usual way, by using the suggestion feature. The differences to standard processes start

when you’re about to post an invoice to the billing company. Not only will it be submitted through an IC transfer, but it will be

recreated as a purchase invoice there as well.

Meanwhile, the project ledger entries created from item and resource consumption are aggregated into intercompany

commitments. For more information, see Billing Company Commitments. 

Post time

To post hours on a WBS line set up in a service company, you must change the work status on the line to In Progress. You can

then enter and post hours through your project time journal.

Example

You post two hours spent on coordinating work with an IC partner in the time journal. The remaining hours will go toward the

services requested by the partner.

Post project ledger entries

To convert posted hours into project usage, open a project journal and choose Process > Get Time Entries. This posts the journal

lines and creates project ledger entries.

BILLING COMPANY COMMITMENTS

Typically, invoices exchanged between a billing and a service company are based on project usage entries posted in the service

company. These, in turn, often originate from hours posted by the subcontractor’s employees.

As the intervals between posting project-related work hours, converting them into usage, and billing them might be relatively

long, it could prove helpful to be able to estimate the expenses incurred by a service company before an invoice is even created.

These estimates show up in billing companies as intercompany commitments. They represent either hours recorded for a project

in a service company but not yet posted as usage or project usage posted but not yet invoiced. Commitments consist only of

entries that can be invoiced and that originate from WBS lines included in an IC transfer to the service company.

To (periodically) collect and compile billing-relevant time and usage entries, you can run the Calculates Lines function from the

Project IC Commitment page. 

Show unbilled entries

Although the Project IC Commitment page looks like a journal, it’s not used to post but to collect project data from a

subcontractor and show that data in a billing company.

As a billing company can be linked to multiple service companies and data for each might be available at different times, every

company providing services gets its own intercompany commitment page, with the page bearing the name of the business it was

created for.

Note
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To copy data from a subcontractor to this page:

Open a billing company.

Choose the Search icon, enter Project IC Commitment, and then choose the related link.

Select an IC page in the Name field.

Choose Calculate Lines on the ribbon.

The page then shows the intercompany commitment values copied from the service company. If there are no unposted time

entries, the commitment will consist entirely of project ledger entries (see the Entry Type field).

The transfer includes only entries from ordered, billable work packages; non-billable packages aren’t copied from the service

company.

1. 

2. 

3. 

4. 
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The fields that can be found on the page are described in the following table.

1.2.4 project365

- 818/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Field Description

Project No. Shows the number of the project as specified in the billing company.

Project Description

Sell to Customer No.

Sell-to Customer

Name

Shows these fields as they appear in the project set up in the billing company.

WBS Line No. Shows the number of a WBS line set up in the billing company.

Type

No.

Phase Code

Task Code

Step Code

Shows these fields as they appear on the WBS line set up in the billing company.

Budget Line No. Shows the number of a budget line set up in the billing company.

ICP Project No. Shows the number of the project as specified in the service company.

ICP WBS Line No. Shows the number of a WBS line set up in the service company.

ICP No.

ICP Phase Code

ICP Task Code

ICP Step Code

Shows these fields as they appear on the WBS line set up in the service company.

ICP Budget Line No. Shows the number of a budget line set up in the service company.

Entry Type

Entry No.

The Entry Type field has two options: Time and Project Ledger (Unbilled Usage). A line on the

page thus refers to either a time or a project ledger entry copied from the service company.

The Entry No. field shows the number of the entry as specified in the service company.

Posting Date

Document No

Resource No.

Description

Start Time

End Time

Shows these values as specified for the time or project ledger entry set up in the service company.

Quantity

Unit of Measure Code

Qty. per Unit of

Measure

Quantity (Base)

Shows quantity and measurement values as specified for the time or project ledger entry in the

service company.

Unit Price (LCY)

Line Discount %

Total Price (LCY)

The first field shows the expected unit price that will be used for invoices sent from the service

company to the billing company.

Prices and amounts on IC invoices are always given in the billing company’s local currency.

If the line on the page refers to a usage entry in a service company, as determined by the Entry

Type field, the values in these fields are copied from that entry (with amounts given in the invoice

currency).

If the line refers to a time entry stored in the service company, the values in these fields are

transferred from a budget line—provided one is available. Otherwise, they’re set to 0.

Performance Date

Performance Resource

No.

Performance Resource

These fields also originate from either a time or a usage entry stored in the service company.

They’re used for informational purposes only, to provide a more detailed description of the services

rendered.

1.2.4 project365

- 819/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Running the Calculate Lines function as described earlier deletes all lines, even those copied previously, before retransferring

data from the service company.

This function is the only tool available to you for updating lines on an IC commitment page. Posting new time or project ledger

entries in the service company will not have the same effect.

In short, you need to run the function in the billing company on a regular basis and do so at the latest before you intend to

analyze the IC commitment with the help of fields calculated automatically on the company’s WBS lines.

Show on a WBS

Every WBS and budget line contains two fields for determining a billing company’s IC commitment. One shows the commitment

by quantity, the other by value. Both fields are sourced from the Project IC Commitment page.

As this page shows the WBS and budget lines of all service companies assigned to a specific project, we recommend that you

include the commitment fields in analyses only after you have updated the relevant IC commitment pages. Both fields are

described in the following table.

SEND INVOICES TO A BILLING COMPANY

A group of intercompany-specific outbound and inbound transactions is used to bill consumption posted in a service company to

the company invoicing the work to the end customer.

Create an outbound invoice in a service company

You create invoices in a service company in the usual way, through suggestions. To create an invoice that you want to send to a

billing company:

Open a service company.

Choose the Search icon, enter Invoice Suggestion, and then choose the related link.

On the ribbon, choose the Create Suggestion Lines function. This fills in the page with all consumption entries posted for the

services provided.

Select the Direct Invoice checkbox for entries that you want to bill.

On the ribbon, choose the Create Invoice action, and then choose OK to create an invoice from the suggestion.

Example of an outbound invoice

Following on from our earlier example, you run the Create Invoice function from the Invoice Suggestion page to create an invoice

with amounts given in EUR, the billing company’s local currency. In the service company, EUR is a foreign currency, as the local

currency set up there is DKK.

Running the function then creates a resource-type invoice line showing the number of the billing resource that you specified for

the Project Management work package.

The line also includes invoice entries. These are later used to close the project ledger entries stored on the line and provide proof

of performance.

Field Description

Name

Performance Unit of

Meas. Code

When the service company submits an invoice to the billing company, the values in these fields are

copied there alongside other project data.

The project ledger entries stored on the invoice will later be transferred to the bill sent to the end

customer (see the Sell-to Customer No. field).

Field Description

Qty. IC Commitment (Base) Shows the result of totaling the Quantity (Base) fields of all data records in the Project IC

Commitment Line table.

Total Price IC Commitment

(LCY)

Shows the result of totaling the Total Price (LCY)) fields of all data records in the Project IC

Commitment Line table.

1. 

2. 

3. 

4. 

5. 
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Post an outbound invoice

Posting an invoice in a service company creates a posted invoice, invoice lines, and invoice entries, as well as G/L, resource, and

project ledger entries of type Sale. As the customer entered on the invoice is set up as an IC partner, this process additionally

triggers an outbound transaction.

Standard intercompany transactions aggregate data for outbound documents such as invoices and credit memos on the

Intercompany Outbox Transactions page. The page is now also used to submit the posted (outbox) invoice from the service to the

billing company.

To see the document that you want to transfer, open the page, select the invoice, and then choose Outbox Transactions > Details

on the ribbon.

In our example mentioned earlier, the outbox transaction is used to transfer a posted sales invoice, with amounts given in foreign

currency EUR, from the service company to its IC partner. Standard functionality only transfers invoice lines through outbox

transactions if the lines you want to send are of type Item or G/L Account. Because of the use of billing resources in the

project365 industry solution, the functionality has been extended to give you the added option of sending resource-type invoice

lines to an IC partner.

Furthermore, fields were added to the standard outbox transaction lines to show you project information stored in billing

companies, for example, in the Source IC Partner Project No. and Source IC Partner Work Package Code fields.

Outbox transaction lines also have invoice entries. These are copied from the lines of a posted invoice when you set up an IC

transaction.

In the Comments and Comments (Project Ledger Entry) fields, you can view the internal and billing-related comments for the

project ledger entries you’re about to invoice. When a transaction is sent to a billing company, only notes relevant to billing are

copied to the company, whereas in-house comments are ignored.

The transaction in our example can now be transferred from the service to the billing company for further processing.

Send an outbound transaction

To transfer data on the Intercompany Outbox Transactions page:

Select the IC transactions that you want to send.

On the ribbon, choose Actions > Send to IC Partner. This sets the Line Action field of all selected transactions to Send to IC

Partner.

Choose Functions > Carry Out Line Actions, and then choose OK.

Based on our earlier example, this would copy the outbox transaction created in the service company—along with the posted

sales invoice—to the billing company.

Afterward, the document would be moved automatically from the Intercompany Outbox Transactions to the Handled

Intercompany Outbox Transactions page. 

INBOUND TRANSACTIONS AND PURCHASE INVOICES

Outbox transactions sent from a service company are received by a billing company as inbox transactions. The transaction

information then needs to be checked before it can be used to create a purchase invoice. This invoice is later posted in the billing

company to increase project usage relative to the amount of work performed by the service company.

Receive a transaction in a billing company

As the service and the billing company must always be stored in the same database, sending an outbox transaction will create an

inbox transaction in the billing company automatically.

Inbound transaction data

To see what kind of data was received through an inbox transaction:

Choose the Search icon, enter Intercompany Inbox Transactions, and then choose the related link.

Select a transaction. On the ribbon, choose Process > Details.

1. 

2. 

3. 

1. 

2. 
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On the header, the inbox transaction shows information about the intercompany partner and the vendor assigned to it. This

information was converted from the partner’s outbox transaction and is presented here from the vantage point of the billing

company to which the transaction was sent.

The lines transferred together with the transaction relate to the project and WBS lines to which you need to post in the billing

company.

When you initially sent this project to the service company, the number of the project, as well as the reference values on

transferred WBS lines, were copied to the WBS in the service company for informational purposes.

These key fields are now used to identify the project and WBS lines you want to post to. Both the project and the specified WBS

lines must exist in the billing company.

Existing invoice entries and, potentially, billing-related comments are also part of the transfer. Project ledger entry comments—

viewed as internal information—aren’t.

Additionally, the resource number on an outbox transaction line is copied as is to the corresponding inbox line. As the number

might later be converted when you create a purchase invoice, it doesn’t yet need to exist in the billing company.

Accept an inbound transaction and create a purchase invoice

When you’ve finished checking the transmitted data, you can use the information to create a purchase invoice from the

Intercompany Inbox Transactions page in a two-step process:

Choose the IC transactions that you want to accept. On the ribbon, choose Actions > Send to IC Partner. This sets the Line Action

field of all selected transactions to Accept.

Choose Process > Carry Out Line Actions, and then choose OK.

The system then creates a new purchase invoice from the selected transactions and moves them from the Intercompany IC Inbox

Transactions to the Handled Intercompany Inbox Transactions page.

POST PURCHASE INVOICES IN A BILLING COMPANY

View an invoice in a billing company

The vendor shown on the invoice is the vendor set up for the billing company’s IC partner, that is, the service company.

Going by our example mentioned earlier, the next field on the header, Currency Code, would be blank. This is because the invoice

sent by the service company would be in the billing company’s local currency, which is EUR.

The No. field on the invoice lines, on the other hand, would be filled in with the code of a billing resource. This code might

change before being transferred to an invoice, based on what conversion option you choose in the Outbound Purch. Res. No.

Type field on a service company’s IC partner card.

For example, if you choose the Internal No. option in the field, the resource number is converted according to the simplest of

rules—or, more specifically, it remains as is. 

To transfer a resource to a purchase line in a billing company, you need to set the resource to External.

Meanwhile, the invoice entries initially transferred to inbox transaction lines are now copied to the Purch. Line Project Dstrn.

page, where you can take a closer look at every invoice line created from the current IC transaction. To look at a specific line:

Choose the Search icon, enter Purchase Invoices, and then choose the related link.

Select a purchase invoice.

Go to the Lines FastTab and select a purchase line.

On the ribbon, choose Line > Purchase Line Project Dstrn.

1. 

2. 

Note

1. 

2. 

3. 

4. 
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Each line on the page might contain comments like those stored with invoice entries on inbox transaction lines. This means that

the data shown on a purchase invoice in a billing company closely matches what you see on the original sales invoice sent by its

service company partner.

Post an invoice

Prior to an explanation of how you post a purchase invoice in a billing company, some general notes about the Purchase Line

Project Dstrn. page mentioned earlier:

The purchase line distribution feature isn’t limited to the use case described in this article, that is, to transmit invoices between

service and billing companies. Instead, as the name implies, it can be used to store all kinds of information on a resource-type

purchase line if the line is assigned to a project and its work breakdown structure.

In short, the feature also allows you to store information about project-related subtasks on every purchase line on which a

resource has been entered. The distribution lines created from this kind of purchase line receive from it not only the resource

number and relation to a project and WBS line but also price specifications and line dimensions.

In turn, the quantity entered on all distribution lines combined must match the value specified on the purchase line.

But the feature can do more than provide you with an option to describe subtasks in purchasing. One notable benefit is its utility

in posting partial consumption when you post a purchase invoice, as a consumption entry will be posted for each distribution line

instead of one entry for the entire purchase line.

Posting a purchase invoice then copies the distribution lines (and the comment lines available for it) alongside other data to the

invoice and assigns them to invoice lines. 

Posting the invoice also creates G/L, vendor, resource, and consumption entries. The consumption entries are posted in a billing

company to the WBS line from which they were originally copied to the business supplying services.

Fields such as Performance Date and Billing Resource Name, both of which are part of every consumption entry, can additionally

be used to describe the work performed by the relevant service company in more detail.

INVOICE END CUSTOMERS IN BILLING COMPANIES

The end customer is invoiced in the same way as you would a customer for a non-IC project. The original source of the project

ledger entries that you want to bill isn’t relevant in this case.
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Control Costs

OVERVIEW

In essence, project cost control is concerned with the difference between a project's budgeted and actual values. It helps ensure

that the revenues you earn and the expenses you incur match estimates as much as possible. Comparing these figures over

multiple periods is crucial for timely, effective project management.

The cost control functionality in Microsoft Dynamics 365 Business Central1 uses project ledger and account entries to show you

how close your projects are to being cost-effective. Whereas project ledger entries record revenues and expenses related to day-

to-day operations, such as item consumption or hours spent on a project, the work breakdown structure and the budget contain

the expected sales and costs and form the basis for creating account entries from a chart of project accounts.

The accounts are linked to both the project ledger and the budget. This means that, like in Finance, you can use the account

chart to create budget-to-actual comparisons for multiple cost types and generate a variety of business insights.

For even more insights into project performance, you can set up views to analyze the dimensions stored with project ledger and

account entries. You can then set filters on budgeted and actual values, or on their variances, to specify what to include in a view.

BASICS

The chart of project accounts is the most important component of cost control. It covers the key values used for tracking cost

performance, that is, the types of revenues and expenses you might encounter, and can be as compact or large (detailed) as you

want.

Both the project ledger and the project account entries are created based on this chart. They are later consolidated in a financial

report.

Chart of project accounts and account setup

Not unlike G/L entries in Finance, entries related to projects are linked to accounts with the help of Project Accounts Setup.

All accounts are identified by their general product posting group, project type, work package, and phase code. Any combination

of these can be assigned to a sales and a cost account from the account chart. See the following table for more information.

You can use this information, for example, to determine

resource expenses when managing research projects with internal resources.

the cost of small items for onsite assembly.

travel times of external employees for major projects.

follow-on orders (=phase code) for customer projects.

You must set up the chart of project accounts and fill in the Project Accounts Setup page based on what you want to analyze

later.

Field Description

Gen. Prod. Posting

Group

Represents the general product posting group of an item, a resource, or a G/L account for which you

specified usage or consumption, budget values or revenues. This group is the only mandatory field on

the Project Accounts Setup page.

Project Type Specifies the type of project.

Work Package

Code

Specifies the work package from the WBS line on which you posted or budgeted usage or revenue.

Phase Code Specifies the phase code from the WBS line on which you posted or budgeted usage or revenue.

• 

• 

• 

• 
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Multi-use accounts

You can add an account more than once to Project Accounts Setup. To see if and how often an account is used:

Choose the search icon, enter Chart of Project Accounts, and then choose the related link.

Select an account. On the ribbon, choose Related > Account > Where-Used List.

The page that opens also shows where to find the account in templates created through the project measurement functionality.

Switch to setup with phase codes

Previous project365 releases didn’t include phase codes in Project Accounts Setup. You need to switch to a newer version to

make use of this feature. 

Choose the Search icon, enter KUMAVISION Module Setup, and then choose the related link.

On the ribbon, choose Actions > Setup > project365 App Setup.

Turn on the Use Phase Code in Project Accounts toggle. This opens a dialog. Choose Yes.

Existing entries are now copied to a new setup page and deleted from the old one.

The setup without phase codes has been discontinued. Newer versions no longer support this feature. 

Project ledger entries = actual values

Each posting that goes toward a project creates a project ledger entry. These entries are the basis for billing, that is, they show

project usage and consumption and store the revenues generated from invoices. They are also used to measure project progress.

When you post to a project, an account is assigned to the created project ledger entry based on what you entered in Project

Accounts Setup. This gives you access to the latest data on project usage and sales so that you can track revenues and expenses

throughout the lifecycle of a project.

Project account entries = budget figures

Project account entries store the quantities and values from planning. They are created based on the planning level of a WBS

line. They originate with budget line entries if you selected the Copy Budget checkbox on available budget lines or with the WBS

line itself if planning is set to that level.

You need to run a function to create project account entries: 

Choose the Search icon, enter Update Project Account Entries, and then choose the related link.

Set filters as necessary. If you don’t set filters, account entries are created for all projects.

You can also update entries for a single work breakdown structure. Open a WBS and choose Actions > Functions > Update

Project Account Entries on the ribbon.

If you rerun the function, the account entries are deleted and recreated from scratch. This gives you greater flexibility when

budgeting a project, as the dimensions, prices, and planning level of a project might be subject to constant change.

1. 

2. 

1. 

2. 

3. 

Note
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See the following table for an explanation of the Project Account Entries page. You can view this page by choosing Related >

Project Account Entries on a WBS, for example.

As explained earlier, the product posting group is crucial to identifying the correct project account for cost control. If an account

is retrieved based on budget lines, the system uses the group of the resource or item stored there to find the account.

If you plan at the WBS line level, the posting group related to the work package billing type and number is used. Typically, this is

the group of a billing resource. Because of how account entries are stored in the system, you need to run the update function

each time you change planning data.

If a project has more than one WBS, project account entries are created for all structures, but only the WBS that is currently

active is shown in cost control.

We recommend you use the job queue to update account data on a regular basis.

Account entries for revenues

Typically, cash inflow is recorded later than expenses. In fact, project work is often paid for only in subsequent accounting

periods.

However, to monitor projects accurately, the system needs to store expected sales prior to payment. This is what the Sales

Project Acc. Entries From field on the project card is for. You can find the field on the Planning tab. It has the following options:

Project Budget

Choose this option if you want project account entries to be created as described earlier. You can still use the Base Date Sales

Project Acc. Entries and Formula Sales Project Acc. Entries fields to change the workflow to some extent.

If you choose Planning Date in the Base Date Sales Project Acc. Entries field, the assumption is that you generate revenue when

you record project usage, and a date formula doesn’t apply.

If the field is set to Date Formula, the date on which sales are generated is calculated based on the budget date and a specified

formula.

Example

The budget line shows 05/15/21. The system then calculates 06/15/21 as the date that needs to be stored with the sales account

entry.

(Advance) Payment Plan

Payment and advance payment plans work in the same way. The only difference is their data source. For more information, see

the Advance Payment feature.

If you choose one of these options in the Sales Project Acc. Entries From field, you can no longer enter a base date or a date

formula.

Field Description

Date Uses the planning level to show the starting date of the relevant WBS or budget line.

Project Account No. Shows the number of a cost account from the chart of project accounts.

Sales Project Account No. Shows the number of a revenue account from the chart of project accounts.

Work Package Code Shows the relevant work package.

Quantity (Base) Shows the relevant quantity.

Total Cost (LCY) Shows the relevant cost.

Total Price (LCY) Shows the relevant price.

Entry No. This field is filled in automatically when a project account entry is created.
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From this point on, the project budget is no longer required. Instead, revenue is created according to the payment plan. The plan

is used to store all information needed for billing a project, such as posting dates and prices.

Allocating a sales account to a payment plan works in the same way as allocating a cost account when you create project account

entries from a WBS line. The system will use a work package, a billing type, and a billing number (usually of a billing resource) to

determine the correct account.

For cost control to capture the entire cash inflow, the final invoice must also be part of the plan. However, this invoice must

include only the amount that remains after all amounts from partial invoices have been subtracted from the total price.

When you create the final invoice based on an invoice suggestion, the total price is shown on the invoice in addition to the partial

amounts applied as credit memos.

If you want to use a payment plan in-house and remove it from billing, clear the Copy to Suggestion checkbox on the payment

plan lines. 

Set up financial reports for projects

You can now use the project ledger and account entries to set up financial reports for analyzing projects based on multiple

criteria. The reports have the same purpose and function as those for analyzing G/L accounts and entries in Finance.

Report setup

You can create more than one financial report, for example, to set up different reporting environments for internal and customer

projects. To create a new report:

Choose the Search icon, enter Project Financial Reports, and then choose the related link.

On the ribbon, choose New, and fill in the fields as described in the following table.

Row definition

1. 

2. 

Field Description

Name Enter a name for the report.

Description Enter a text that describes the report.

Row Definition Specify the criteria for analysis on the lines. The layout stored in this field is used when you open a

financial report but can be changed at any time.

Column

Definition

Specify the criteria for analysis in the columns. The layout stored in this field is used when you open a

financial report but can be changed at any time.
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The report itself is set up in a way that you can add accounts to individual lines. You can also specify formulas or enter lines that

total amounts or quantities.

Choose the Search icon, enter Project Financial Reports, and then choose the related link.

Select a report. On the ribbon, choose Edit Row Definition and fill in the fields as described in the following table.

Actions

To insert an account into a row, choose Actions > Functions > Insert G/L Accounts. The row can then be used immediately. 

1. 

2. 

Field Description

Row No. Specify a number to sort lines according to your requirements.

Description Specify the area that you want to show on the line.

Totaling Type Choose one of the following options:

Project Accounts

Shows the value of one or more project accounts.

Total Accounts

Includes total lines from the chart of project accounts.

Formula

Uses a formula on the schedule.

Set Base for Percent

Calculates percentages of a total.

Totaling Fill in this field based on what you selected as a totaling type.

Row Type Specify the purpose of the line:

Net Change

Shows only transaction data.

Balance at Date

Totals data up to a given date.

Beginning Balance

Shows the starting balance of accounts assigned to the line.

Line Amount Type Specify whether you want the line to show total prices or costs.

Show Opposite

Sign

Select this checkbox if you want to show negative amounts as positive and positive amounts as

negative.

Show Specify whether the line is shown on screen and on printouts.

Select If Any Column Not Zero, When Positive Balance, or When Negative Balance if you want to

include the line only under the specified circumstances.

Bold

Italic

Underline

Double Underline

Select one of these checkboxes if you want to see text in bold, in italics, underlined, or double

underlined.

New Page Select this checkbox if you want to insert a page break after the line.
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Column definition

Choose the Search icon, enter Project Financial Reports, and then choose the related link.

Select a report. On the ribbon, choose Actions > Functions > Edit Column Definition and fill in the fields as described in the

following table.

Financial report card

You can select Edit Project Financial Report on the ribbon to see the card related to the new report. Report values are shown in

the rows and columns according to the filters you set.

The header displays the names of the report and the row and column definitions. You can filter data there as well.

All default values on the page can be changed to meet your requirements. You can also use the lookup on a field to see how it

relates to the chart of project accounts. On the page that opens, you can then use another lookup if you want to know where an

entry originally comes from.

1. 

2. 

Field Description

Column No. Specify a column in this field.

Column Header Enter a name to describe the column on screen and on printouts.

Column Type Net Change

Shows only transaction data.

Balance at Date

Totals data up to a given date.

Beginning Balance

Shows the starting balance of accounts assigned to the line.

Year to Date

Shows all values created in the current year up to a given date.

Rest of Fiscal Year

Shows all values from a given date.

Entire Fiscal Year

Shows all values created during a full fiscal year.

Entry Type Specify if you want to show project ledger entries, project account entries, or one of two

commitments.

Value Base Specify if the entry represents an amount or a quantity.

Formula Fill in this field if you selected Formula in the Column Type field.

Show Opposite Sign Select this checkbox if you want to show debit amounts as negative and credit amounts as positive

values.

Comparison Date

Formula

Fill in this field if you want to specify a period for budget vs. actual comparisons in relation to the

period set in report requests. You can enter a common unit of time here (D, WD, W, M, Q, or Y).

Comparison Period

Formula

Fill in this field if you want to compare accounting periods. You don’t enter a unit of time here but a

formula.

For example, enter -1P if you want the system to retrieve the same range of dates one accounting

period earlier.

Show Specify if the column is always or never shown or only shown when values are positive or negative.

Rounding Factor Specify if and how to round for clarity.
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To switch from a report column (or analysis period) to another, choose Column (or Period) on the ribbon, and then choose

Previous Column (or Period) or Next Column (or Period).

To copy the financial report to a new Excel worksheet for further editing, choose Export to Excel.

ANALYZE DIMENSIONS

As an alternative, you can use the dimensions posted with project ledger entries to monitor projects. Dimension-based analyses

include both global dimensions—posted directly to project ledger entries—and additional dimensions linked to a project. For easy

filtering, they’re part of the following aggregated entries:

Project analysis view entries—created from project ledger entries—to represent actual values.

Project analysis view budget entries—created from project budget entries—to display budget figures.

Dimension sources

Before you start working with this kind of analysis, it might be helpful to get an overview of the potential sources of a dimension

linked to a project, a WBS line, or a budget line, as listed in the following.

For a basic overview of dimension capabilities, see Work with Dimensions.

Sources of project dimensions

With certain fields in Projects Setup filled in, the dimension (for example, a cost object) might have been automatically added

to the project, with the code of the dimension matching the number of the project.

The dimension might have been entered on the template from which the project was created.

The dimension might be assigned to a project type. You can set up one dimension per type of project in Projects Setup, with

the dimension value matching the type.

The dimension might have been copied when a customer was assigned to the project. Alternatively, it might have been

transferred from a contact or a customer template assigned to the project if the project was set to Quote at the time.

The dimension might have been added when a project manager was entered for the project provided you’ve turned on the

relevant feature in Projects Setup.

The dimension might have been copied from a main project linked to the project.

The dimension might be from a responsibility center that was entered for the project.

The dimension might have been copied from a salesperson if the code of that person was added to the project.

Sources of WBS line dimensions

The dimension might be among those that are inherited from the project to the WBS lines set up for the project.

The dimension might be from the work package master if a work package was validated on the WBS line.

Sources of budget line dimensions

The dimension might be among those that are inherited from the WBS line to the budget line during creation of the latter.

The dimension might have been copied from a resource (group), an item, or a G/L account when the No. field was validated on

the budget line.

Dimension sources during project postings

• 

• 

Note

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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A dimension that is stored with base data (such as a resource or a vendor) might be passed along to all kinds of documents and

journals in the system.

A project dimension is copied to a document or journal line when the project number has been validated on the line.

A dimension stored with a work package is copied to a WBS or a budget line when either line is selected for posting. What line

must be selected depends on the posting level specified for the project.

Even WBS or budget line dimensions created manually in planning are copied to project ledger entries if certain fields in 

Projects Setup are filled in.

On the Dimensions FastTab in Projects Setup, you can see the criteria that will be used for project-related dimension transfers.

You can also fill in or change fields on the tab to specify, for example, what dimensions the system should set up for project types

or for main projects and how it should copy dimensions from project manager resources.

Project analysis views

Project analysis views offer insights into project data based on analysis view entries and analysis view budget entries.

Analysis view entries can be set up on the project analysis view card. You can use four additional dimensions per card.

To open a list of all cards, choose the Search icon, enter Project Analysis View List, and then choose the related link.

Each line on the page shows if budget values will be created from the card, when the card was last modified, and what

dimensions are available.

Choose a card for editing and then fill in the fields as necessary.

• 

• 

• 
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General

Dimensions

On the Dimensions tab, choose the four additional dimensions you want to analyze on the card.

Actions

To store selected dimension values, choose Related > Analysis > Filter on the ribbon. This ensures that only certain values are

totaled on the card.

You can also choose Update to find all project ledger and account entries that match the filters you set and use them to create

project analysis view and budget entries.

If card changes affect existing analysis entries, the entries are deleted. For example, if you edit the Date Compression field or a

dimension filter, the project analysis view and budget entries are recreated at the next update. This step is necessary because the

criteria for creating entries have changed.

Entries created

Every time you update a view, the system creates data-rich project analysis view and project analysis view budget entries from

the project ledger and project budget entries that include the four dimensions you want to analyze.

Field Description

Code Specifies a code for the project analysis view. The code must be unique and can reflect the purpose of

the view.

Name Specifies the name of the view.

Project Account

Filter

Specifies the accounts that will be analyzed. If the field is left blank, the project analysis will include all

accounts.

Project Filter Specifies the projects shown in the view.

Date

Compression

Used to define for which period entries need to be merged, that is, how detailed a view will be.

For example, if you want a monthly summary, you can use this field to total the project ledger entries

created during a full month and combine them into a single entry.

The date of the first posted project ledger entry is then assigned to the entire period.

Entries are totaled in a way that no data required for analysis is lost. For example, entries included in

the analysis must have identical dimensions.

Starting Date Used to set a date from which entries are included in the view.

All project ledger entries posted on or after this date are then compressed to the level you chose in the

Date Compression field. Earlier entries are merged into one entry shown on the date immediately

preceding the starting date.

Last Updated On Shows when the card was last updated.

Last Entry No. Shows the number of the last project ledger entry that was posted before you updated the view. Entries

posted since the last update aren’t included in a view.

Last Budget Entry

No.

Shows the number of the last project budget entry that was entered before you updated the view.

Entries specified since the last update aren’t included in a view.

Include Budgets With the toggle turned on, project budget entries are also updated. This creates analysis view budget

entries automatically.

Blocked If this toggle is turned on, the view cannot be used at all.
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The analysis view budget entries contain the values shown in the view, the budget name, and the project account, followed by the

four dimensions, the posting date, the quantity, and the amount. In short, they represent the link between key data stored with

project account entries and the dimensions of a document.

The same is true for analysis view entries. In this case, dimension data is merged with data from project ledger entries.

In the Quantity and Amount fields, you can use a lookup to see where an entry originates.

Analysis views on financial reports

You analyze by dimensions in the same way you analyze by project ledger and account entries.

Open a row definition and use the Assist button next to the Name field at the top to look at the name of the assigned analysis

view. If you chose a view, the report will be filled in automatically with analysis view entries.

You can use the lookups on individual lines to identify what analysis view entry was used to fill in a certain line. Choosing the

lookup first opens a page that shows the project account chart related to the account used in a certain column.

When you then select a Quantity or a Cost Amount field, you can see the project analysis view entry and the dimensions stored

for the analysis view.

Difference to standard functionality

At a cursory glance, the added views might not seem to offer anything new. But you can now set flow filters on the four

dimensions described earlier.

You can already store these filters when you set up a row definition. To use them, unhide the four columns that show the relevant

dimension values.

The benefit of specifying filters on the report instead of each card individually is that analyses will all have the same design and

thus remain comparable over time.

Project analysis by dimensions

Project analysis by dimensions also uses the analysis view and analysis view budget entries described earlier.

Choose the Search icon, enter Project Analysis View List, and then choose the related link. This shows you list of all views that

have been specified so far.

On the ribbon, choose Analysis by Dimensions to open the setup and filter view. The date, project account, project, budget, and

responsibility center filters are included by default.

Choose the other four dimensions based on the selected analysis view. Each dimension can be assigned to a row or a column. You

don’t need to specify a default value for a dimension (as is required for a financial report). To link the dimension to an account, the

system will use the project accounts stored with the analysis view card, and you can set filters on them there.

The other fields shown on the card are described in the following table. 

Filters

1. 

2. 

3. 

Field Description

Date Filter Limits the period for analysis based on a posting date.

Project Filter Limits the number of projects shown.

Budget Filter Used to include a certain budget. You limit the display of budget values on the Options tab.

Responsibility Center Filter Limits analysis to a certain responsibility center.

1.2.4 project365

- 833/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Options

Actions

To swap line and column views, choose Related > Actions > Reverse Lines and Columns on the ribbon.

To open the analysis by dimensions matrix, choose the Show Matrix action. There, you can choose Export to Excel to copy the

analysis data to a new Excel worksheet.

Project analysis views vs. project analysis by dimensions

Both options create analysis view and analysis view budget entries based on a project analysis view card.

Project analysis uses a view that has fixed lines and columns, created from row and column definitions. For a more targeted

assessment of projects, you can set filters on up to four additional dimensions.

Field Description

Show Actual Amounts

Shows the actual values posted.

Budgeted Amounts

Shows the values allocated to the budget on the Filters tab.

Variance

Shows the difference between budgeted and actual values as a number.

Variance %

Shows the difference between budgeted and actual values in percent.

Index %

Shows the difference between budgeted and actual values as an index. An index of 100 means that the

values are identical. If the percentage is above or below 100, the actual values are greater or smaller

than the budgeted values.

Show Amount

Field

Two options are available in this field.

Quantity

Shows the values as quantities only. For usage entries, these are the actual posted quantities—changes

to invoice quantities not included.

Amount

Shows the amounts stored with the relevant entries.

Rounding Factor This field reduces large values If you want to see more than one column in a view.

None

Shows values unchanged and with all decimals.

1

Shows integer values without decimals.

1000

Shows values in units of thousands.

1000000

Shows values in millions.

Show Column

Names

Specifies if you want to show the names of individual columns. For example, you can use this field to

switch between project account numbers and descriptions.

Show Opposite

Sign

Specifies if you want to show negative values as positive and positive values as negative.
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However, project analysis by dimensions puts even fewer restrictions on how views can be structured. Both the lines and

columns can show default dimensions, such as the project account and period, and additional dimensions set up on the analysis

view card.

Moreover, you can swap the lines and columns and don’t need to create a layout for either. The drawback is that you can only see

what has been budgeted, posted, or the difference between those numbers. But, as an example, you cannot use this view to

compare budget to actuals by including all three values.

TRACK ONGOING PROJECTS

You can use multiple functions to assess an ongoing project at the push of a button.

Statistics

The statistics available for projects and main projects can provide you with key insights into project progress and performance.

They include budgeted and actual figures and the variance between both. To view the statistics:

Open a project card.

Choose Related > Project > Statistics on the ribbon.

You can now see a project's budgeted and actual values.

Budgeted

This tab shows you the budgeted values at the level of the WBS and the budget lines, that is, detailed planning.

Achieved

This tab shows you how far the project has progressed.

The fields of both tabs are described in the following table.

Budget vs. Actual

Compares project usage to budget figures.

Advance Payments

For more on this FastTab, see Track WIP and Advance Payment.

Project cockpit

1. 

2. 

Field Description

Budget (LCY) Shows the budgeted total cost based on WBS lines in local currency.

Earned Value (LCY) Shows the result of Budget (LCY) * Project Completion %.

Usage (LCY) Shows the usage total costs in local currency.

Cost Variance

(LCY)

Shows the result of Earned Value (LCY) - Usage (LCY). This tells you by how much a project deviates

from budgeted values because of the percentage of completion.

Cost Variance % Same calculation as for the Cost Variance (LCY) field, the difference being that this field shows the

deviation from the budget in percent.

Project Completion

%

Shows how much work has been completed compared to the total amount of work required to finish

the project. The value in this field is determined by comparing the WBS line values entered by the

project manager to the project budget.

Estimated Total

Cost (LCY)

Indicates the total cost of the project if work continues as before. This field is determined by

comparing the Usage (LCY) and Project Completion % fields.

Posting Progress % Shows how much of the total budget has been used.

Cost Efficiency Shows the ratio of earned value to usage. A value below 1 indicates a poor result.
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Both the project list and card contain elements of a project cockpit. In some cases, you need to use the Personalize function to

unhide these elements.

Except for the color indicators, the cockpit on the project card shows the same fields as the cockpit on the list.

The list cockpit is split into two areas. The indicators are shown directly on the list in the form of columns. Fact boxes that

describe the project can be found to the right.

Indicators

Two list indicators are available to visualize actual usage and profit in percent.

To turn on these indicators, you need to specify in Projects Setup when you want one of them to go from green to yellow and

from yellow to red. This setup will then be used for all projects.

The symbols you want to show can be imported as a JPG file to the Documents tab on the Company Information page.

Fact Boxes

The fact boxes provide you with a clear, concise overview of various kinds of project-related information. You can also personalize

them to meet your needs. All boxes are available on project cards as well.

Budget/Usage Incl. Commitment

On the first line below the heading, the project budget is given in local currency. Click this value to see the active WBS.

The remaining values are shown in the form of bars so that you can visually compare project budget and usage, that is, actual

usage and commitments.

Budget vs. Actual

Displays the same values as the previous box but shows them as numbers. Except for Stock Commitment and Remaining Budget,

which are determined automatically, you can open the source tables of all lines by clicking the relevant figure.

Project Documents

Broken down by sales, purchase, and project documents, this list shows the number of documents associated with the project.

Click a number to view the related documents.

Payment Plan

Indicates when the payment plan says you need to send the next invoice. This plan isn’t the same as an advance payment plan,

which would show in another box (advance payments are handled by a separate app). Besides a projected invoice date, the plan

includes the total price expected for the project.

Invoice Overview

Provides a visual update on billing. The bar on the left shows—in local currency—the budgeted total price according to the WBS.

The bar in the middle displays the total price invoiced so far and the open project ledger entries. It is the most important bar

regarding projects that are billed based on time and materials. The bar on the right shows what entries remain according to the

payment plan. As you can use plans for both fixed-price and time and materials projects, this bar is relevant in both cases.

Compare budget to actuals for work packages

To perform a budget-to-actual comparison at the work package level:

Select a project on the Projects page.

Open the active WBS of the project.

On the ribbon, choose Process > Budget vs. Actual.

On the General FastTab, you can now see the fields of the selected WBS. You cannot change them here. The fields required for

comparison can be found on the WBS Line Usage FastTab, near the end of each line. They include fields indicating project

progress and those showing the quantities and amounts budgeted and consumed for the project.

1. 

2. 

3. 

1.2.4 project365

- 836/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Regardless of which WBS version you open, that is, which version is used to fill in the budget figures, the actual values are

always the same. This means that you can open any version to compare budget to actuals.

As the Budget vs. Actual page is just another kind of WBS view, only fields that aren’t explained in the WBS portion of this

documentation are described in the following.

Field Description

Budgeted Quantity Shows the budgeted quantity totaled from all work packages assigned to the project.

Usage Qty. (Base) Shows the total quantity consumed by a specific work package. The field is related to the Project

Ledger Entries page and totals the quantities that are stored there.

Time Commitment (Qty.) Shows the quantities not yet copied from time entries to the project. This means that hours were

posted by staff but haven’t been transferred to the project by the project manager.

Outstanding Budg.

Quantity (Base)

Shows the result of Budgeted Quantity - Usage Qty. (Base) - Time Commitment (Qty.).

Budget Value (LCY) Shows the budget in unit costs.

Usage Cost (LCY) Shows the total quantity consumed by a specific work package. The field is related to the Project

Ledger Entries page and totals the unit costs that are stored there.

Purchase Commitment

(LCY)

Shows the outstanding amount from purchase orders that have been created from a specific

WBS line. This field is related to the Purchase Line table and totals the outstanding amounts that

are stored there.

Time Commitment (LCY) Shows the amounts not yet copied from time entries to the project. This means that hours were

posted by staff but haven’t been transferred to the project by the project manager.

Stock Commitment

(LCY)

Shows the item quantity that was procured for the project but is still in stock.

This field is only available if you turned on the Project Purchase Incl. Inventory toggle in Projects

Setup.

Variance (LCY) Incl.

Commitment

Shows the result of subtracting the usage cost and the purchase and time commitments from the

budget value.

Project Completion % Shows the project progress specified for a work package by the project manager.

Posting Progress % Filled in automatically based on the budget value and the usage cost.

Posting Progress % Incl.

Commitment

Filled in automatically based on the budget value, the usage cost, and the time and purchase

commitments.

Line Activity Progress % Weighted entry based on the progress fields of stored budget lines—or, more specifically,

activities—which resources enter in time tracking.

This field is only filled in if resources use both budget lines and the Line Activity Progress %

fields to record time.

Earned Value Filled in automatically based on the budgeted unit costs and the percentage of project

completion.

Shows what value a certain WBS line has achieved in unit costs so far.

Cost Variance Filled in automatically based on the earned value and the usage cost.

Cost Variance % Filled in automatically based on the earned value and the usage cost. Shows the cost variance in

percent.

Estimated Total Cost Filled in automatically based on actual figures and the percentage of project completion.
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A budget-to-actual comparison offers you an overview of an entire project. It not only shows you all work packages related to a

project with their budget and actual figures but also allows you to identify where current results differ from expectations.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Run a Forecast

OVERVIEW

The forecast functionality can help you predict the costs needed to complete a project (estimate at completion) and determine

the value of work finished thus far (earned value). A project forecast is based on current plans, expenses incurred, and the

project manager’s assessment.

For tracking purposes, the actual figures used to predict project outcomes must be frozen in time when you create a forecast.

The values can be retrieved from a WBS line or from detailed schedules that include budget lines. The functionality currently

only checks if budget lines are available for a WBS line and then uses those to give estimates. If there are none, the values from

the WBS line are used.

This condition could conceivably be replaced by one that relies on a checkbox (such as the already available Copy Budget field).

Selecting this checkbox on the WBS line could then tell the system to use the values stored on the budget lines.

SETUP

Before you can use forecasts, you need to set up a number series for them.

Choose the Search icon, enter Projects Setup, and then choose the related link.

On the Numbering tab, fill in the Forecast Nos. field.

WORK WITH FORECASTS

View forecasts

Choose the Search icon, enter Project Forecast List, and then choose the related link.

This opens an overview of the forecasts you created. Select an entry from this list to view the related forecast card.

Create a new forecast

Choose the Search icon, enter Project Forecast List, and then choose the related link.

On the ribbon, choose New. This creates an empty card. When you leave the No. field, a number is assigned automatically from the

series that you set up for this purpose.

Choose a project in the Project No. field. The current WBS version of this project is then copied to the new forecast. You can select

another version at any time.

The descriptions stored with the project and the WBS version are also copied to the new forecast. A forecast description can be

added manually.

Run a forecast

To run a forecast based on the budget and actual figures of a specific WBS version, choose Actions > Functions > Run Forecast

on the new forecast card. The actual values include posted project usage, posted project sales, and commitments.

The system then creates one forecast line for each WBS line, which includes any line that structures the WBS (such as Begin-

Total and End-Total). It also adds lines of the Work Package type with their budget and actual values.

Each forecast has five major areas as described in the following table.

1. 

2. 

1. 

2. 

3. 

Area Description

Hours Planned resource hours

PC Planned personnel (labor) costs based on hours specified

MC Planned cost of materials

TC All costs added together (no manual planning)

SR Planned sales revenue
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The PC, MC, and TC fields are described in more detail in the following table.
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Field Description

Estimated Total

Prev. Version

Shows the value of a previous forecast, that is, of the forecast specified in the Base Forecast No. field.

If no base version is available, this field is filled in with the value stored in the relevant Expected BAC

field.

For more information about working with base versions, see Forecast Status

.

Expected BAC The value in this field is copied from the WBS (or budget).

• If a WBS line is related to at least one budget line, this field is filled in based on budget lines. The

type of a budget line determines if a line value is assigned to PC (resources and resource groups) or

MC (items and G/L accounts).

• If no budget lines are available, the WBS line is used. The billing type chosen for the related work

package determines if a value is added to PC or MC.

(Lookup)

Shows the project budget or WBS line of the relevant WBS version.

Actual AC Shows costs already posted. This field is filled in based on project ledger entries.

(Lookup)

Shows, based on Historical FC Data, the key project ledger entry values that led to this value.

Commitment

[multiple fields]

Shows costs not yet posted to the project but recorded in the system. These result from the following

areas:

Hours Committed

Shows the number of hours that were posted by resources but haven’t been copied to the project.

Purchase Commitment

Shows purchase orders, including partial quantities, not posted as received.

Stock Committed

Shows receipts posted but not used by the project. This commitment only shows up if you selected

the Project Purchase Incl. Inventory checkbox in Projects Setup. Else, usage is posted automatically

when you post the receipt, and no commitment is created.

(Lookup)

Shows, based on Historical FC Data, the key project ledger entry values that led to this value.

Confirmed IC Shows the result of adding up the actual values and commitments.

Forecast ETC Shows the result of the following formula, which is used as a default after the forecast lines are

created:

Target - (Actual + Commitments)

This makes the remaining budget the default value. Planners can later change this field if it turns out

that the remaining budget is too small or too large.

Forecast values are entered in these types of fields in the following ways:

• Regarding material, planners can manually fill in the remaining amount (cost amount) they expect

will be needed for the project.
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Status options

A forecast can have the following statuses:

Open

Released

To change the status of a forecast, open the relevant card and choose Actions > Functions > Release Status or Reopen on the

ribbon. However, you cannot reopen a forecast version that has already been used to create another forecast. Only released

versions can be the basis for other (newer) versions. A released forecast is entered automatically as the base version when you

create a new forecast for the same project.

Base forecasts

If you fill in the Base Forecast No. field on a forecast card before you select the Run Forecast action (the field is filled in

automatically with the most recent forecast set to Released), the new prediction will use the values of this base forecast instead

of the estimated amounts from the project budget.

Earned values are still calculated based on the budget. Just because a budget isn’t met doesn’t mean that the project increases in

value.

Added effort

An increase in project effort can happen for multiple reasons. If caused by increased material consumption or extra work, the

costs of which the contractor must bear, the earned value of the project decreases, and the variance turns negative. Such a

reason for added expenses might be an incorrect calculation, needed rework, or bad pricing.

However, if the additional expenses can be billed to the customer, planning needs to reflect the increase in project value. This

requires raising the budget, typically by creating a new WBS version. Based on that, and the higher budget, you can then create

a new version of the forecast to adjust the earned value and the variance.

Historical entries

When you select the Run Forecast action, the program will copy all project ledger entries, time entries, item ledger entries, and

purchase lines related to the forecast to a list of historical forecast entries, essentially freezing them in time.

Field Description

• When it comes to labor costs, the following formula is used to fill in the field: Hours Forecast *

Hourly Rate.

This means that work is planned in hours. Planners then add the hours needed to finish a project. The

hourly rate is copied from the WBS line and cannot be changed.

Warning

in all cases, the remaining effort must be entered without commitments so that planning doesn’t

include values twice.

If you used a base version, the value in this field is copied from the forecast run for that version but

can now be updated by the planner.

Estimated Total

EAC

Shows the result of adding up actual and forecast values, plus commitments.

Earned Value

(Cutoff Date)

Shows the result of the following formula:

(Actual + Commitments) / Estimated Total * Expected

Variance Shows the difference between total and budgeted costs. A negative amount means costs are expected

to exceed the budget.

• 

• 

Note
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You can then use the Lookup in the Historical Entry No. field to identify, for example, changes to item ledger entries because of

recent inventory adjustments.

Print a forecast

You can print a forecast at any time.

Go to the relevant forecast card.

On the ribbon, choose Reports > Print.

For an easier overview, the report will show a reduced number of forecast columns, rearranged into a pattern of rows that are

printed below one another. Whereas the hours stored in the first area aren’t printed, each of the remaining four areas is

aggregated on a separate row. Because of limited space, commitments are combined into one column per area. You can then use

the Microsoft SQL Server Reporting Services to export the report to Excel or PDF.

1. 

2. 
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Alternate Currencies

OVERVIEW

You can use the invoice currency feature to bill projects in a foreign currency.

You can already store this currency when you set up a WBS for a project. Revenues are then shown in the invoice currency and in

local currency. Sales documents that you create from the WBS, however, will show amounts in the invoice currency only.

As the name implies, invoice currencies are used not only on quotes and orders but on all sales documents created for a project,

including invoices. 

A currency of this type cannot be changed during the later stages of a project. If you want to bill a project in different currencies,

leave the Invoice Currency Code field blank.

To provide sales estimates, a budget rate is used. Although specified on the project card, this rate might differ from one WBS

version to another. However, the rate isn’t copied when you post a sales document. All Total Price (LCY) fields are instead

recalculated based on the exchange rate available at the time.

You can change invoice currencies in the planning stage. You can no longer change currencies after project ledger entries have

been posted.

Usage entries contain budgeted sales amounts in both local and invoice currencies. Sales entries, on the other hand, contain

actual values only in the currency in which you want to bill the project. These are then converted into local currency when you

post the entries.

One area where invoice currencies aren’t used is the project budget. All projects are planned in local currency—even if you

intend to purchase goods from abroad. LCY is also the only currency used for cost control, that is, for charts of project accounts

and dimension analyses, as amounts stated in another currency might make it extremely difficult to compare costs across

projects.

ON PROJECT CARDS

As an example, you create a project from a template and select a customer you want to bill in Canadian dollars. You set the status

to Open and pick a starting date.

The Invoice Currency Code field on the Project Billings tab is then filled in automatically based on the Bill-to field, if you selected

a customer there, or a currency needs to be chosen manually from the Currency table.

Like on sales documents, you can now choose the Assist button next to the Invoice Currency Code field to modify the exchange

rate for the project.

Alternatively, you can fill in the Invoice Currency Date field. This field was introduced because projects lack the type of fields,

such as a Posting Date field, required to calculate exchange rates. If you enter a date in this field, the rate is determined based

on what is stored in the Currency Exchange Rate table.

The rate shown on the project card is only a default value. It will later be copied to the WBS versions, where it can be modified if

necessary.

You can no longer change the invoice currency on a project card after project ledger entries have been created. Only the exchange

rate can still be altered. A change in currency is copied to all WBS versions of a project, and total prices are recalculated as a result.

By contrast, modified rates aren’t copied to the WBS versions considering you might want to compute versions at different exchange

rates.

Note

Note
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FOR SALES PRICES

You can specify sales prices in several places throughout the app. Typically, these prices are given in local currency and are

converted into a different currency if necessary. If you want to bill a project in a foreign currency for which no general prices are

available, we recommend that you set up prices specific to a project.

To set up project-specific prices for resources, items, or G/L accounts:

Choose the Search icon, enter Projects, and then choose the related link.

Open the relevant project card. On the ribbon, go to Related > Prices and choose Resource, Item, or G/L Account. The invoice

currency you specify is then used as the default currency when you set up a new sales price.

FOR A WBS

Each work breakdown structure contains the following fields on the Billing tab:

Invoice Currency Code

Invoice Currency Factor

Invoice Currency Date

These fields match those shown on the project card considering their values are copied from there. Except for the invoice

currency, the values can be changed in each WBS version so that you can calculate projects at different exchange rates across

multiple versions.

Modifications you make to the Invoice Currency Factor field on the WBS header are copied to all related WBS lines. Total prices are

then recalculated.

ON WBS LINES

You reopen the project card set up in our earlier example. On the ribbon, you choose Actions > Create WBS from Project

Template.

You then see a message that says the project has an invoice currency and asks if you want to copy the currency from the project

card. You choose Yes.

Afterward, you unhide the Invoice Currency Date and Invoice Currency Factor fields on the WBS lines. The contents of these

fields are copied from the header. When a unit price is now calculated on a WBS line--that is, you didn’t select the Copy Budget

checkbox, as you don’t want to use budget lines for detailed planning—the price will be converted in one of two ways:

A price stored in local currency will be converted into the invoice currency.

A price specified in the invoice currency, for example, in the Project Resource Price table, will be converted into local currency

and entered in the Unit Price (LCY) field.

In our example, the system calculates a unit price (LCY) of EUR 70. This price is then converted into Canadian dollars by using

the currency factor found on the WBS line.

After calculation, you use the Assist button next to the Invoice Currency Factor field on the Project Billings tab and enter a factor

of 1.5 for the current WBS version.

You are then asked if you want the new factor to apply to all existing WBS lines and their budget lines (or only to new WBS lines).

You are also informed that the change has no effect on existing sales documents. You choose Yes.

The factor is now applied to all WBS lines, and the unit price is recalculated in CAD.

ON BUDGET LINES

You can also enter invoice currencies on budget lines. The use of project-specific unit prices in this context has already been

discussed earlier. Based on our previous example, you specify a price of CAD90 for resources of work type CONSULT and set up

a budget line for a resource. The pricing functionality then calculates a price of CAD90 and converts this amount into local

1. 

2. 

• 

• 

• 

Note

• 

• 
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currency. Although the price was determined based on the currency factor stored on the related WBS line, you can still change

the factor on the budget line. The following changes are also made on the budget line:

The Unit Price (FCY) checkbox is selected. This means that the price calculated for sales is stored in the invoice currency and

converted into LCY.

The Fixed Project Price checkbox is selected, which indicates that a project resource price was used.

ON SALES DOCUMENTS

As an example, you use the number of the project set up earlier to create a new sales order.

Customer data to fill in the sell-to and bill-to fields is then copied automatically. The invoice currency is also copied from the

project. In our case, it’s the currency stored for the customer, although that’s not always true. Attempts to enter a different

currency on the sales header will prompt an error message.

You then open the WBS. On the ribbon, you choose New > Create Sales Document. The status of the project must be set to Open.

After the status has been verified for all WBS lines, the Create Sales Document function is run.

You need to ensure you select the Order document type when you run the function.

The system now checks if all WBS lines and budget lines—including all unit prices—are stored in Canadian dollars on the sales

order.

The prices given in invoice currencies aren’t converted again when you create a sales document from a WBS. Instead, they are

copied as they are to guarantee that manual prices are transferred over as well. The budget rate stored on the WBS is also

copied to the document but can be updated there before you post an invoice.

The Unit Price (LCY) fields found on WBS and budget lines are only used to budget a project. These prices will be recalculated at

the available exchange rate when you post a sales invoice and will then be copied to the sales project ledger entries.

FOR PROJECT LEDGER / USAGE ENTRIES AND PURCHASE DOCUMENTS

At first look, invoice currencies have little in common with project usage. However, even project usage entries include unit prices

for services that need to be invoiced. This helps determine what to:

Include when measuring project progress.

Use for billing time & materials projects not related to a sales order line.

• 

• 

Note

• 

• 
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For this reason, the fields described in the following table have been added to the project ledger entries.

Coming back to our earlier example, you now want to create a purchase invoice for an external resource. You create a purchase

order for a vendor that bills in USD and purchase an external service, that is, a service rendered by an external resource.

As the purchase has been linked to a WBS line, the work type is already known to the system. This makes it easier to determine

on the purchase line a budgeted unit price in the invoice currency stored for the project. In our case, the price comes to CAD140.

This price is then converted into local currency at the latest exchange rate—1.4962 in our example. The Unit Price (LCY) field

now shows USD93.57. The rate entered on the budget line was 1.5, so the amount used to be USD93.33 only.

Field Description Means for Sales Entries Means for Usage Entries

Unit Price Shows the unit price in

the invoice currency.

All work was billed at this

price.

The unit price was copied from

the Project Resource Price

table, the WBS line, or the

sales line.

All work will be billed at this

price, also known as the

budgeted unit price.

Unit Price (LCY) Shows the unit price in

local currency.

All work was billed at this

price, now converted into LCY. 

Conversion occurs based on

the exchange rate that was

valid at the time of posting the

sales entries.

States the budgeted unit price

in local currency.

Total Price Shows the total price in

the invoice currency.

Shows the result of Qty. to

Invoice * Unit Price.

Shows the result of Qty. to

Invoice * Unit Price, which

equals the budgeted total

price.

Total Price (LCY) Shows the total price in

local currency.

Shows the result of Qty. to

Invoice * Unit Price (LCY).

States the budgeted total

price in local currency.

Line Discount

Amount

Shows the line discount

amount in the invoice

currency.

Contains the line discount

copied from the sales invoice

line.

Contains the expected line

discount, which equals the

budgeted line discount

amount.

Line Discount

Amount (LCY)

Shows the line discount

amount in local currency.

Contains the line discount

copied from the sales invoice

line in local currency.

States the budgeted line

discount amount in local

currency.

Line Amount Shows the discounted line

amount in the invoice

currency.

Shows the result of Total Price

- Line Discount Amount.

Contains the expected line

amount, which is equal to the

budgeted line amount.

Line Amount

(LCY)

Shows the discounted line

amount in local currency.

Shows the result of Total Price

- Line Discount Amount in local

currency.

States the budgeted line

amount in LCY.

Invoice Currency

Code

Shows the invoice

currency entered on the

project card.

Stores the currency used for

unit and total prices.

Stores the currency used to

budget unit and total prices.

Invoice Currency

Factor

Shows the currency

factor, that is, the

exchange rate at the time

of posting.

States the exchange rate at

which unit and total prices are

converted from the invoice

currency to LCY

Represents the exchange rate

for converting unit and total

prices from the invoice

currency to LCY.
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You need to ensure that the related WBS line has a valid posting status, that is, the status is set to Open or In Progress when you

purchase external services.

Before posting the purchase order, you alter the exchange rate to 1.3 in the Currency Exchange Rate table. You then post the

order.

Whether you choose Post or Post and Print, the system creates a project usage entry in both cases. Variations in price between

the receipt and the subsequent invoice only affect unit costs but not budgeted sales amounts.

A look at the project ledger entry created shows that usage is billed at the expected unit price of CAD140. At a 1.30 exchange

rate, this works out to USD107.69—but that is irrelevant to billing, where the price is kept at CAD140.

IN PAYMENT PLANS

Like sales documents, payment plans are created based on the currency specified for a project.

Following on from our earlier example, you set up a payment plan for the entire project. This will copy the code from the Invoice

Currency Code field on the project card to this payment plan, where it can no longer be changed.

When you choose a WBS line on the payment plan lines, you need to ensure that the line can be used for invoice revenue. The

Warning column must be blank. Lines that show a warning message aren’t copied to an invoice suggestion.

ON INVOICE SUGGESTIONS

If a payment plan is available, an invoice suggestion will include every payment plan line until all are posted as billed in full. Only

when you create a final invoice to bill the entire project can you turn invoices based on a payment plan into credit memos.

For a suggestion, choose the Search icon, enter Invoice Suggestion, and then choose the related link. On the ribbon, choose

Create Suggestion Lines.

You can set filters to limit the number of suggestions. For example, you can filter for a specific project.

Lines related to payment plans can only be copied to direct invoices.

Open the relevant invoice suggestion.

Select the Direct Invoice checkbox on the lines you want to bill.

On the ribbon, choose Actions > Create Invoice to create a partial invoice.

The invoice currency used for the relevant project is then included in both the suggestion and the direct invoice. The direct

invoice also applies the current exchange rate to all amounts.

Note

Note

1. 

2. 

3. 
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Earned Value

OVERVIEW

Earned Value Management (EVM) integrates project scope, schedule, and cost data to provide project management teams with

an advanced method for measuring and evaluating project progress and performance. EVM needs an integrated baseline against

which performance can be measured. The principles of the technique can be applied to projects in any industry.

The main tool of earned value management is earned value analysis (EVA). For each work package and control account, it tracks

the following dimensions:

Planned Value (PV)

Earned Value (EV)

Actual Cost (AC)

You can use these to identify where a project deviates from the approved baseline. The cost and schedule variances derived from

them can also be converted to efficiency indicators to help determine project status and provide a basis for estimating costs and

schedule outcome.

Abbreviations

• 

• 

• 

Acronym Description

PV Planned value

AC Actual cost

EV Earned value

CV Cost variance

SV Schedule variance

CPI Cost performance index

SPI Schedule performance index

BAC Budget at completion (expected costs)

EAC Estimate at completion (estimated costs)

ETC Estimate to complete (estimated costs to completion)

TCPI To-complete performance index
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SETUP

Turn on EVM

You need to set up earned value management before first use.

Choose the Search icon, enter EVM Setup, and then choose the related link.

Fill in the fields as described in the following table.

1. 

2. 

Field Description

Completion

Method

Specify the method for measuring project progress.

0:100

Shows 0% until work is complete.

20:80

After work has started, progress is set to 20%. When work is complete, progress will be set to 100%.

50:50

After work has started, progress is set to 50%. When work is complete, progress will be set to 100%.

+25

When employees post their times, they can choose to set progress to 0%, 25%, 50%, 75%, or 100%.

Custom

Employees can freely choose the level of progress when posting their times.

Calculation Base Specify if you want earned value analysis to use sales or purchase prices to calculate values. The field is

set to Purchase Price by default.

Default Calc.

Level

Specify at which level earned value analyses are run automatically.

WBS

Only include WBS lines in calculations.

Budget

Only include budget lines in calculations.

Custom

For each WBS line, the system checks the work package to determine whether to calculate at WBS or

budget line level.

SPI Warning Enter a value below which the time status of a project is set to Warning.

SPI Alarm Enter a value below which the time status of a project is set to Alarm.

CPI Warning Enter a value below which the cost status of a project is set to Warning.

CPI Alarm Enter a value below which the cost status of a project is set to Alarm.

CPI Tolerance CPI values that deviate downward from 1 to a greater extent than the value you enter in this field will

later be shown in red on certain pages. Variances in the opposite direction will be shown in green.

SPI Tolerance SPI values that deviate downward from 1 to a greater extent than the value you enter in this field will

later be shown in red on certain pages. Variances in the opposite direction will be shown in green.

TCPI Tolerance TCPI values that deviate downward from 1 to a greater extent than the value you enter in this field will

later be shown in red on certain pages. Variances in the opposite direction will be shown in green.

EAC Tolerance EAC values that deviate downward from 1 to a greater extent than the value you enter in this field will

later be shown in red on certain pages. Variances in the opposite direction will be shown in green.

1.2.4 project365

- 850/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Use EVM on a project

You also need to set up earned value management for the project that you want to track.

Open the relevant project card.

On the General tab, fill in the fields as described in the following table.

Use on work packages

For work packages, use the following fields to configure earned value management.

RUN EARNED VALUE ANALYSIS

All EVM functionality related to entire projects can be found on the project card. To see an overview of EVA calculations for a

specific project:

Open the relevant project card.

On the ribbon, choose Actions > Earned Value > Earned Value Analysis.

EVA fields and functions are explained in the following.

Validate an analysis

Open the relevant project card. On the ribbon, choose Actions > Earned Value > Earned Value Analysis.

1. 

2. 

Field Description

Use EVM Turn on this toggle if you want to use earned value management. With the toggle turned off, neither

manual nor automatic calculations are possible for this project.

Calculation

Level

Specify at which level you want to calculate earned value. If you leave the field blank, the value in this

field will be copied from EVM Setup.

Field Description

Ignore in EVA Specify whether to exclude WBS lines related to this work package from EVA calculations. This might be

useful if a package is called Miles Travelled, for example.

Calculation

Level

Specify for a WBS line related to this work package if you want to use the WBS line or one of its budget

lines for EVA calculation. This field is crucial if you set the default calculation level to Custom. The option

you choose in this field is copied to the WBS line but can be changed there.

Auto Progress

Calc.

If you select this checkbox, WBS line progress is calculated automatically. The calculation is based on the

following formula:

Line Activity Progress WBS % = Line Activity Progress % * (quantity planned on all budget lines or

quantity planned on WBS line)

If this checkbox isn’t selected, progress is copied from the Project Completion % field. If that field is

blank, the value from the Line Activity Progress % field is used.

A check mark in this field is transferred from the work package to the WBS line and can be changed

there.

1. 

2. 

1. 
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Another page opens. On the ribbon, choose Actions > Check Project to determine whether you have filled in the fields described in

the following table.

If all fields are filled in, you will see a message that earned value management is now available. Else, you will get an error

message that tells you what field has no value.

Analyze projects

You run EVAs from the Earned Value Mgt. Project page. To perform an analysis, you first need to validate all EVA fields as

described earlier.

Open the relevant project card. On the ribbon, select Earned Value > Earned Value Analysis.

Another page opens. On the ribbon, select Actions > Check Project to validate an EVA.

If validation is successful, choose New > Earned Value Analysis. This opens a dialog where you can choose if you want to run

calculations based on WBS or budget lines. Select your preferred method and click OK.

2. 

For Fields

Projects • Starting Date

• Ending Date

• Use EVM

• An active WBS

WBS lines • Starting Date

• Ending Date

• Work Status

(= In Progress, Open, or Finished)

• Duration (Days)

• Quantity (Base)

• Unit Cost (LCY)

Budget lines (if available) • Starting Date

• Ending Date

• Work Status

(= In Progress or Finished)

• Duration (Days)

• Quantity

• Unit Cost (LCY)

• No.

• Qty. to Complete

1. 

2. 

3. 
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The system then recalculates and updates all fields on the page. See the following table for more information about these fields.
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Field Description

Description Shows the name of the project.

No. Shows the number of the project.

Starting Date Shows the start of the project.

Ending Date Shows the end of the project.

Completion % Shows project progress in percent.

Calculation

Completion % = Earned Value / Estimate at Completion * 100

Person Responsible Shows the resource responsible for the project.

Calculation Date Shows the date on which EVA was calculated.

No. of Calculations Shows the number of EVA calculations performed.

Calculation Level Specifies if the calculation was performed based on budget or WBS lines.

Calculation Base Specifies if earned value analysis uses sales or purchase prices to calculate values.

PV Calculation Date Shows, up to the calculation date, the total planned project value, made up of all PV Calculation

Date fields on the budget or WBS lines.

Actual Cost Shows the total actual cost from all WBS or budget lines based on project ledger entries.

Calculation

Actual Cost = Usage (Total Cost) or Usage (Total Price) based on setup

Earned Value Shows the sum of earned values from all WBS or budget lines.

Calculation

Earned Value = Planned Value * Completion %

Schedule Variance Shows the result of comparing time entries for this project to the baseline. If the value is

negative, the project is behind schedule, whereas a positive value means the opposite is true.

Calculation

Schedule Variance = Earned Value - Planned Value

Cost Variance Shows how the project performs financially compared to the baseline. If the value is negative,

the project costs more than planned. If the value is positive, the opposite is true.

Calculation

Cost Variance = Earned Value - Actual Cost

Schedule Performance

Index

Shows the relation between the earned and planned value at a specific point in time. An SPI

greater than 1 means that more work than planned has been completed. A value smaller than 1

means the opposite.

Calculation

Schedule Performance Index = Earned Value / Planned Value

Cost Performance Index Shows the ratio of earned value to actual cost incurred as a result. The CPI is the most

important EVA metric, as it indicates the cost efficiency of a project.

A value below 1 means completed work exceeded cost estimates. If the value is greater than 1,

the opposite is true.
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Key figures are shown in the Cost Control section of the Project Lead home page. To see a list of all EVA calculations for a

project, go to the ribbon and choose Actions > Earned Value > Earned Value History.

You can then use the Show WBS Lines or Show Budget Lines action on the ribbon to see all lines included in a calculation.

Field Description

Calculation

Cost Performance Index = Earned Value / Actual Cost

Budget at Completion Shows the total estimated cost at the end of a project, that is, the total budget from all WBS or

budget lines.

Calculation

Budget at Completion = Quantity (Base) * Unit Cost (Base)

Estimate at Completion Shows a forecast of total project cost.

Calculation

Estimate at Completion = Actual Cost + (Planned Value - Earned Value)

Estimate to Complete Shows what you expect to pay until the project is complete, assuming that the remaining work

will be finished at the same rate as before.

Calculation

Estimate to Complete = Estimate at Completion - Actual Cost

To-Complete

Performance Index

Shows the projected cost performance you need to achieve to remain on budget and within the

scope set by project management.

There are two options for calculating the index. If total costs are in line with the costs that you

expect to remain, the calculation is as follows:

Calculation

To-Complete Performance Index = (Budget at Completion - Earned Value) / (Budget at

Completion - Actual Cost)

If the costs to completion are greater than the estimated total costs, the index is calculated

based on the following formula:

Calculation

To-Complete Performance Index = (Budget at Completion - Earned Value) / (Estimate at

Completion - Actual Cost)

Earned Schedule Provides an alternative calculation method for project progress. This method includes not just

monetary values but times as well.

The value itself has no significance but is the basis for alternative calculations of schedule

variances and the schedule performance index.

Calculation

(Calculation Date - Project Starting Date) + (Earned Value - Planned Value) / (Planned Value +1 -

Planned Value)

Schedule Variance

(ES Base)

See the Schedule Variance field.

Calculation

Earned Schedule - (Calculation Date - Project Starting Date)

Schedule Performance

Index (ES Base)

See the Schedule Performance Index field.

Calculation

Earned Schedule / (Calculation Date - Project Starting Date)
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Analyze WBS lines

You can analyze individual WBS lines as well.

Open the relevant project card. On the ribbon, choose Project > WBS.

In the WBS Lines section, choose the line you want to analyze.

On the ribbon, select Line > History > Earned Value Analysis.

The page that opens looks almost exactly like the one for projects. The actions available on the ribbon are Check WBS Line and

Earned Value Analysis.

The first checks whether the WBS line meets the requirements described earlier. The second action starts the analysis. Negative

variances of more than 10% are shown in red. Positive variances of more than 10% are shown in green.

For a list of all line-related EVAs, choose Line > History > Earned Value History.

Analyze budget lines

You can also analyze individual budget lines.

Open the project card. On the ribbon, choose Project > WBS Incl. Budget View.

In the Project Budget section, choose the line you want to analyze.

On the ribbon, select Line > History > Earned Value Analysis.

The page that opens looks almost exactly like the pages for analyzing projects and WBS lines. The actions available to you are

Check Budget Line and Earned Value Analysis. The first checks whether the budget line meets the requirements described

earlier. The second starts the analysis. Negative variances of more than 10% are shown in red. Positive variances of more than

10% are shown in green.

For a list of all line-related EVAs, choose Line > History > Earned Value History.

Calculate values automatically

If you don’t want to calculate EVAs manually for each project, you can create a report that can be added to the job queue and will

analyze projects for which Use EVM was turned on.

Evaluate overall performance

You can also use EVM to evaluate entire companies or project types.

Choose the Search icon, enter Projects, and then choose the related link.

On the ribbon, select Reports > EVA Company Overview. This opens a report where you can set filters on project types and dates. If

you don’t set filters, the report will include all projects to which EVM currently applies.

The No. of Projects line on the report itself indicates the number of projects included in the calculation, and the Calculate From

field shows the date filter if a filter was set. The project type filter, if available, is displayed above the No. of Projects field. The

values represent the average of all EVA calculations.

Evaluate projects

The following options are available for evaluating projects. 1. Open a project card. On the ribbon, choose Actions > Earned Value

> Earned Value History to see all calculations for the project. You can now also see differences in analyses over time. 2.

Alternatively, go to the Earned Value Mgt. Project page that relates to the project. On the ribbon, choose Report > Project

History to see detailed EVA information. The upper part of the report shows all current data from an earned value analysis. The

lower part contains a visual representation of key metrics.

Archive analyses

You can archive the EVA results of completed projects so that they are no longer included in the company overview, for example.

Open the Earned Value Mgt. Project page from the project for which you want to archive analyses.

On the ribbon, choose Actions > Archive Project. This opens a dialog that asks you if you want to archive the results.

Choose Yes. You will then see a message that the project has been archived successfully.

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

1. 

2. 

3. 
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To see the results of EVAs run for a project, open the project card, and choose Actions > Earned Value > Earned Value Archive on

the ribbon.
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WIP Accounting

OVERVIEW

The measurement functionality provides a way for you to record work in process and recognize project revenues and expenses so

that you can track the financial value of projects in the general ledger while the projects are ongoing.

SETUP

For automatic measurements, you need to set up the following features:

Measurement methods

G/L integration codes

Measurement templates

Resource pricing

Projects Setup

• 

• 

• 

• 

Field Description

Balance Filter

(Measurement)

Here you can select the G/L integration code that will be included in measurement statistics when

you record WIP or revenues.

Save on Posting Meas.

Templates

This toggle is only relevant when batch posting (that is, when you post more than one project-

related measurement at once).

If the toggle is turned on, data is saved after each check of a measurement in the batch so that all

(successfully) posted values are retained if an error is encountered.

With the toggle turned off, none of the measurements from the posting process will be stored

(resulting in a complete rollback) so that all of them must be reposted when an error occurs.
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Measurement methods

Before you can work with the functionality, you also must set up at least one method of measurement and create a separate page

for each. To set up a method:

Choose the Search icon, enter Measurement Methods, and then choose the related link.

Choose New on the ribbon.

Fill in the fields as described in the following table.

You can assign methods to a project template so that each project created from the template will have methods assigned to it

automatically. Projects created without the help of a template require manual intervention. To assign a method manually:

Choose the Search icon, enter Projects, and then choose the related link.

On the project list, choose Related > Project > Measurement > Measurement Methods.

Alternatively, open a project card from the list and proceed as described above.

If you opted for measuring project ledger entries, the default method for measurements will be used and a template will not be

created. In this case, you need to specify the relevant measurement accounts through project posting groups.

1. 

2. 

3. 

Field Description

Code Specify a code for the method. The code must be unique.

Description Specify a description for the method.

G/L Integration Select this field if you want measurements based on this method to be copied to Finance.

Project Posting

Group

Select a project posting group in this field if you want to measure project ledger entries.

Measurement

Template

Select this field if you want to use a measurement (that is, calculation) template.

Measurement Base Select a basis for estimating project values.

Project Ledger

Measures project ledger entries.

Completion

The system determines how far the project has progressed and uses that percentage for calculations

in a measurement template.

Template

Measures values according to custom criteria.

WIP Method Select a basis for estimating work in process:

• (blank)

• None

• Costs

• Prices

• HGB Costs

Calculate Specify if the system should use project ledger entries posted for usage or sales, or both, to record

WIP.

Recognition

Method

Specify if you want to recognize revenue according to the percentage of completion or the completed

contract method.

Computation Log Select this field if you want the system to log WIP calculations so that you can track measurement

amounts. To see the log, choose the Assist button on unposted or posted measurement lines.

1. 

2. 

3. 
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Project posting groups

Project posting groups store the accounts to which project costs are posted. To set up a group:

Choose the Search icon, enter project365 Posting Groups, and then choose the related link.

Fill in the fields as described in the following table.

The accounts used to post in Finance aren’t copied from a project posting group if you estimate the financial value of a project with

the help of a measurement template. Instead, the system will use the accounts specified through G/L integration codes.

G/L integration codes

G/L integration codes are assigned in measurement templates to line amounts that are posted to Finance. The codes specify the

debit and the credit accounts that you want to use to record WIP and recognize revenue.

You need to set up a different code for each measurement method and area covered (by setting up a code for measuring

reservations and another for measuring partially finished work according to either HGB or IFRS rules, for example). Afterward,

you can assign these codes to the template lines manually (see Set Up Measurement Templates).

1. 

2. 

Field Description

Code Specify a code for the group. The code must be unique.

Description Specify a description for the group.

WIP Costs

Account

(Consumption)

Choose the account to which unit costs are debited when you Post Work in Process to G/L and credited

when you Post Project Recognition. When you post WIP, the Project Costs Adjmt. Account shown in

General Posting Setup is used as the balancing account to this account. For revenue recognition, that

function is assumed by the Project Costs Account.

WIP Sales

Account

(Sales)

Choose the account to which unit prices are credited when you Post Work in Process to G/L and debited

when you Post Project Recognition. When you post WIP, the Project Sales Adjmt. Account shown in

General Posting Setup is used as the balancing account to this account. For revenue recognition, that

function is assumed by the Project Sales Account.

Project Costs

Account

(Consumption)

Choose the income account to which unit costs are debited when you run the Post Project Recognition

to G/L batch job.

Project Sales

Account

(Sales)

Choose the P&L account to which unit prices are credited when you run the Post Project Recognition to

G/L batch job.

G/L Expense

Account

Fill in this field if you intend to post to project-related G/L accounts. Amounts are credited to the

account when project usage is copied to sales lines.

WIP Profit

Account

Choose an account for storing prorated profits as specified by the IAS percentage of completion (POC)

method. This account is only required when you measure project completion.

WIP Profit

Applied Account

Choose the contra account to the WIP Profit Account. This account is only required when you measure

project completion.

Note
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To set up a code:

Choose the Search icon, enter G/L integration Codes, and then choose the related link.

Fill in the fields as described in the following table.

Measurement templates

You need a valid license to work with measurement templates.

1. 

2. 

Field Description

Code Specify a code for G/L integration. The code must be unique.

Description Specify a description for the G/L integration code.

Integration Type Select an integration type if you need access to posted measurement entries in a project

measurement template.

Example

Measurements according to HGB require a calculation of the balance sheet values that you posted

the previous year.

The following options are available in this field:

• (blank)

• Balance Sheet

• Cost of Materials

• Labor Costs 

• Advance Pmt. (Assets)

• Advance Pmt. (Liabilities)

• POC

• POC Project (Assets)

• POC Project (Liabilities)

• IFRS Prepmt.

Debit Account

(WIP)

Specify the account to which you want to add the debit amount stored for a certain measurement

entry when work in process is posted.

Credit Account

(WIP)

Specify the account to which you want to add the credit amount stored for a certain measurement

entry when work in process is posted.

Debit Account

(Recog.)

Specify the account to which you want to add the debit amount stored for a certain measurement

entry when revenue recognition is posted.

Credit Account

(Recog.)

Specify the account to which you want to add the credit amount stored for a certain measurement

entry when revenue recognition is posted.

Measure After Final

Invoice

Select this field if you want to continue creating measurement templates and entries for a project

that was settled in full. The integration code is then used to identify the entries that will be measured

even after the final invoice is paid.

Suggestions for recognizing revenue, on the other hand, show only entries that this field is not

selected for.

Note
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You need to set up a template for each method of measurement that you want to use. Examples are measurements based on IFRS

or HGB. To set up a template:

Choose the Search icon, enter Measurement Template, and then choose the related link.

Fill in the fields on the lines as described in the following table.

1. 

2. 
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Field Description

Row No. Specify a code for the template, such as R10. The code must be unique.

The value in this field can later be used to gain access to the Totaling or Argument and Condition

fields.

A code must be entered if you want to use G/L integration.

Description Specify a description for the measurement line.

Cost Line Select this field if the source table chosen on the line (see Source Table field) will be used to retrieve

project ledger entries or the remaining cost and should be filled only with cost amounts.

Auto Calculate Select this field if the line should be calculated automatically based on tables that contain certain

project-related entries.

Source Table Specify from which table data the line amount should be calculated. 

The following options can be chosen:

• G/L Entry

• Project Ledger Entry

• Project Account Entry

• Measurement Template

• Order Amount

• Measurement Entry

• Remaining Cost

• Completion

• Advance Pmt.

• Advance Invoices

Note

Please note that the Advance Pmt. and Advance Invoices options are only available if you installed the 

Advance Payment app.

Afterward, you can use the Totaling field to filter data even further.

Use Unit Costs Select this field to use unit costs even if you chose HGB Costs as the basis for measurement.

Advance Amt.

Type

Specify if you want Advance Pmt. or Advance Invoices entries (see Source Table field) to be shown as

gross or net amounts. For all other source tables, this field is left blank.

Totaling Type Specify the method for totaling measurements:

• Account (for G/L, project ledger, or project account entries)

• Formula

Totaling Fill in this field based on the option you selected in the previous field.

For project ledger or project account entries

Specify a project account number.

For measurement entries

Specify a G/L integration code.

For measurement templates

Specify a row number.

For G/L entries

Specify G/L account numbers

For totaling type Formula
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Field Description

Specify a row number and a mathematical operator

Leave the field blank if you chose another option than those listed.

Argument 1

Condition

Argument 2

Argument 3 

Argument 4

If you selected the If totaling type, you must fill in these fields according to the following rules:

If Argument 1 Condition Argument 2,

then Argument 3;else, Argument 4

Note

The arguments can only contain row numbers and mathematical operators or numbers 

Options in Condition fields:

• (blank)

• <

• >

• =

• <=

• >=

For all other totaling types, the field is left blank.

Date Filter

Calculation

If calculated table values are posted to a project automatically, you might need to set one of the

following options as a date filter:

• Previous Year

• Year to Date

• Current Period

• Balance at Date 

Otherwise, leave the field blank.

Show Select this field if you want the line printed on a gross profit and loss report.

G/L Integration

Code

Fill in this field if you want to create a measurement entry for the line. The code is then copied to the

accounts specified for it when you post to Finance.

You must fill in the Row No. field if you want to enter a G/L integration code.

Print Description Select this field if you want its value printed as a heading on a gross profit and loss report.

If the field is left blank, the default description will be used instead.
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Individual measurement values

Additionally, you can specify up to 10 values that will be shown on the Project Measurements page in accordance with certain

measurement methods. Each value will be displayed in a separate column on the page.

Choose the Search icon, enter Project Measurement Columns Setup, and then choose the related link.

On each FastTab, fill in the fields as described in the following table.

Resource prices

Besides standard unit costs, you can calculate direct unit costs on resource cards. The calculation is based on the following

formula:

Personnel Cost Rate + Personnel Cost % + Personnel Ovhd. Cost = Direct Unit Cost

Direct Unit Cost + Indirect Cost % = Unit Cost

Both the unit cost and the direct unit cost can be used to estimate the value of a project. 

You can also choose the Update Personnel Ovhd. Cost function to recalculate the unit cost and the direct unit cost of several

resources at once. 

The new overhead is entered on the Options FastTab. You can set filters on the Resource tab if you want to update only certain

resource records.

POST TEMPLATE-BASED MEASUREMENTS

One way for you to measure the value of a project is to use templates that contain rules specific to a certain accounting standard.

You need a valid license to work with measurement templates.

Create measurement

You create a template for measuring project values by using the Create Project Measurement function on the Project

Measurements page. 

On the Measurement Method FastTab, you can then specify for what projects you want to estimate a financial value. You also

need to select a month (for example, 01/01/25 for January 2025) on the Options tab.

Turning on the Post toggle on the Options tab immediately posts the template (as a project measurement entry, not in Finance) after

it has been created. Don’t turn on this toggle if you want to check templates before posting.

1. 

2. 

Field Description

Measurement Method Code Specify the measurement method that the value relates to.

Source Value Specify the value that should be shown. Options are:

• Amount

• Measurement Amount

• Measurement Base

• Posted Until Prev. Period

Description Enter a description for the column header.

Row No. Select a row number based on the measurement method that you entered.

• 

• 

Note

Note
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If you turn on the Data Transfer toggle, the template is marked as posted to Finance so that the values determined or posted for

the project are no longer copied to financial accounting.

This is especially relevant when you create a template to record the status of a data transfer. In Finance, measurement entries

are typically posted alongside other account balances so that posting the template to an account would create duplicate

measurement entries.

Review and post measurement

To see a measurement that you created before posting:

Choose the search icon, enter Projects, and then choose the related link.

Open a project card and choose Related > Project > Measurement > Project Measurement.

Alternatively, choose the Search icon, enter Project Measurements, and then choose the related link.

The template shows you all values measured for a certain accounting standard. For values that were calculated based on a

formula, you can run the Show Computation Log action from the Lines FastTab ribbon to see both the formula and the subtotals.

If necessary, you can also delete the unposted measurement and create it from scratch.

After you’ve reviewed the measurement, you can choose Post on the ribbon. This creates the entries required for posting

measurements to Finance.

To post multiple measurements at the same time, you can choose the Post Measurements function on the Project Measurements

page. You can set a filter on the function to limit what measurement to include.

View posted measurements

To see a measurement that you posted:

Choose the search icon, enter Projects, and then choose the related link.

Open a project card and choose Related > Project > Project Measurement > Posted Project Measurements.

Alternatively, choose the Search icon, enter Posted Project Measurements, and then choose the related link.

Afterward, you can choose Related > Posted Project Measurements > Measurement Entries on the ribbon to see the entries

created for a measurement.

The G/L Integration field there shows you the postings created in Finance by running the Post Project Work In Process to G/L

batch job, with the Measurement Amount field indicating the amount to post. The Posted Measurement Amount field is filled in

after the batch job is run.

For a measurement value calculated based on a formula, you can also run the Show Computation Log action on the Lines FastTab

ribbon to see both the formula and the subtotals on the posted measurement.

Post WIP

For posting to Finance, you need the Post Project Work In Process to G/L batch job. On the Project FastTab, you can set filters to

limit the projects for which you want to run the function.

On the Project Measurement Entry tab, you can then filter for a measurement method and a posting period. If you like to post

IFRS and HGB measurements separately, you need to enter a suitable filter in the Meas. Method Code field on the tab. The filter

in the Posting Date field should be set to the end of the month, for example 31/01/21.

On the Options tab, you can choose if you want to post per measurement entry or per project. Please note that the Project option

might result in totals being copied to Finance. 

You can then fill in a posting date, a document number, and a posting description (in which %1 is replaced with posting type WIP

or Revenue and %2 with a posting group, such as IFRS or HGB).

The Post toggle on the page determines whether entries are posted, previewed, and printed. Leaving it turned off will only

display and print the report without posting the entries.

Afterward, you can select the Preview button to check what you posted to Finance.

1. 

2. 

3. 

1. 

2. 

3. 
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With the Post toggle turned on, the standard Preview function isn’t really a preview either, as it is used to start posting to Finance.

To see the values posted to G/L Integration accounts in Finance, use G/L integration and select an entry there to open the journal

that you last posted to.

For more information about posting-related accounts and records, see Measurement Templates. 

If you filtered for a measurement method on the Project Measurement Entry FastTab, you must rerun the Post Project Work In

Process to G/L function for each new method. 

Close a project

To post revenue to Finance, the status of a project must be set to Closed. Alternatively, you can turn on the Final Invoice Created

toggle on the project card.

You can no longer post to completed projects, but you can post to projects for which a final invoice was created. However, you should

only post to these projects if necessary, such as when you need to settle warranty claims or perform rework, as they will no longer be

included in measurements.

This means that once a project is set to Completed or Final Invoice Created, it will no longer be part of new measurements for

calculating WIP.

Suggest measurement for revenue recognition

Completed projects or those for which final invoices have been created must have their revenues recognized through the Project

Measurement Jnl. page before they can be posted. You can use the Recognize Revenue function on the ribbon for this.

On the Project FastTab, you can set filters to specify the projects that you want to recognize revenue for. On the Project

Measurement Method tab, you can set a filter on a method if you want to provide separate revenue suggestions for IFRS and

HGB measurements, for example. On the Project Measurement Entry tab, you can set filters to suggest only certain WIP entries

for recognition.

On the Options tab, you enter a posting date, a document number, and a description (in which %1 is replaced with the posting

date). The function suggests for recognition all entries created from WIP measurements.

Posting the journal will not lead to postings in Finance, as the process creates only project measurement entries for revenue

recognition. You can see the entries for a project by choosing Posted Project Measurements or Measurement Methods on the

project card.

Post revenue recognition

Afterward, you must copy the measurement entries you want to recognize to Finance by running the Post Project Recognition to

G/L batch job.

On the Project FastTab, you can set filters to specify the projects that you want to recognize revenue for. On the Project

Measurement Method tab, you can set a filter on a method if you want to provide separate revenue suggestions for IFRS and

HGB measurements, for example. On the Project Measurement Entry tab, you can set filters to suggest only certain WIP entries

for recognition.

On the Options tab, you can choose if you want to post per measurement entry or per project. Please note that the Project option

might result in totals being copied to Finance. You can then fill in a posting date, a document number, and a posting description 

(in which %1 is replaced with posting type WIP or Revenue and %2 with a posting group, such as IFRS or HGB).

The Post toggle on the page determines whether entries are posted, previewed, and printed. Leaving it turned off will only

display and print the report without posting the entries. Afterward, you can select the Preview button to check what you posted

to Finance.

Note

Note
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With the Post toggle turned on, the standard Preview function isn’t really a preview either, as it is used to start posting to Finance.

To see the values posted to G/L Integration accounts in Finance, use G/L integration and select an entry there to open the journal

that you last posted to.

For more information about posting-related accounts and records, see Measurement Templates.

UNDO MEASUREMENTS

Posted project measurements can be reversed.

Cancel measurements

To undo a measurement:

Choose the Search icon, enter Project Measurements, and then choose the related link.

Select a measurement and choose Actions > Correct Posted Measurement on the ribbon.

Alternatively, choose the Search icon, enter Correct Posted Measurement, and choose the related link.

We strongly recommend that you set a filter on posted project measurements to specify which measurements you want to cancel.

Example

To correct HGB measurements from February 2025, you need to set at least the following filters:

When you choose OK, the function deletes all selected measurements (their headers and lines) and sets the measured amounts

stored with posted entries to 0. Additionally, the Corrected Amount field is filled in with the measured amount that was posted to

the relevant entry up to that point.

Cancel posted measurements in Finance

The corrected entries must now be retransferred to Finance so that the difference between the measured and posted amount is

included in financial accounting.

Having set the amount to 0, the amount previously transferred to Finance will then be corrected through a reversal posting. To

reverse a posting, you need to rerun the Post Work In Process to G/L batch job (see section Post WIP).

Example

For posting a correction regarding the cancelled HGB measurements from February 2025, you need to set at least a filter on the

measurement entries:

The filter should be the same as for canceling the posted measurements. If the document number or posting description are the same

in both instances, they might give an indication of why the measurement was cancelled.

Recreate measurements

Cancelled measurements can always be recreated, reposted, and recopied to Finance.

Note

1. 

2. 

3. 

Meas. Method Code: HGB

Posting Period: 01/02/25

Meas. Method Code: HGB

Posting Period: 01/02/21..28/02/25

Note
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POST PROJECT LEDGER MEASUREMENTS

Postings for project usage and sales aren’t automatically transferred to Finance but are only copied when you run the relevant

batch job.

When posting measurement entries, a distinction is made between posting WIP and recognizing revenue. A project is linked to

financial accounting, for example, to compare inventory consumption, salaries, and other amounts with work in process. At the

end of the period, the value of ongoing projects must be reported on a balance sheet for accounting purposes. A batch job is

available for both WIP and revenue recognition.

When a project is (partially) completed, work in progress needs to be recognized as revenue. Revenue recognition entries offset

the amounts posted to work in process accounts and copy them to the G/L accounts that store project sales and costs.

Measure project ledger entries

Project ledger entries are often the basis for HGB-compliant measurements. Based on unit costs, this measurement method

recognizes revenue at the end of a project.

Calculate WIP by project ledger entry

To use this method, you first need to open the relevant project ledger entries on the project measurement journal and create

measurement entries. You then need to copy and post these entries to Finance.

When you run the Measurement Suggestion function from the measurement journal to open the Project WIP Worksheet, you can

enter individual projects to be considered by the batch job in the No. field on the Project FastTab. If you leave the field blank,

WIP will be calculated for all measured projects.

You can then specify the method for measuring WIP on this worksheet in the Meas. Method code field on the Project

Measurement Method tab. If the field is left blank, all methods are included in the calculation.

On the Options tab, the Measurement From and Measurement To fields can be used to enter a period during which entries need

to have been posted to be considered for WIP measurement. You also need to enter a posting date, a document number, and a

posting description on this tab.

Placeholder %1 can be used in both the Document No. and Posting Description. It is later replaced with the posting date.

Choose OK to enter the measurement suggestion in the project measurement journal.

If a journal is filled in through this batch job, you typically don’t need to make manual changes to the data. But if the information

entered for the batch job is incorrect, you can manually delete lines from the journal and rerun the function.

An example of what a measurement method for posting WIP based on project ledger entries might look like can be seen in the

following table.

Note

Field Description

Code HGB-L

Description HGB (Ledger Entries)

G/L Integration Selected

Measurement Template Selected

Measurement Base Project Ledger

WIP Method Costs

Calculate Usage

Recognition method Completed Contract
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This method is used to measure project ledger entries of the usage type at unit costs. If necessary, the values are copied to

financial accounting.

The method ensures that only usage entries are copied to the journal. Ledger entries of type Sale aren’t considered in this

context. The measured amount will be retrieved from the Unit Cost field of a project ledger entry. The unit price serves only

informational purposes here.

Posting work in progress then creates measurement entries that you can see when you open the relevant project, as each

measurement entry is linked to the measured project ledger entry through the Project Ledger Entry No. field. The project ledger

entry also stores the WIP amount.

On the project card, you can choose Related > Project > Measurement > Project Measurement to open a matrix that shows you

the measurement status of the project. The posted entries are visible in the WIP column during the selected posting period. You

can use the lookup in each field to take a closer look at an entry.

Incorrect measurement base

You can perform a second measurement if a wrong measurement base was chosen. However, only project ledger entries not

included in the previous measurement are used for this. The measurement method that you used must also be changed

accordingly and reassigned to the project. Canceling posted measurements isn’t possible.

Post WIP to Finance

The measurement entries that were created through the measurement journal, which only affected the Project area, can now be

copied to Finance by using a batch job. In this context, it is important that the G/L Integration checkbox (specifying the method

and area of measurement) has been selected for all entries you want to copy.

The values are then transferred to Finance by entering Post Project Work In Process to G/L in the general search field and

choosing the relevant link. Individual projects can be selected for inclusion in the batch job on the Project FastTab. You can also

set filters on other fields of the project table here.

On the Project Measurement Entry FastTab, you can set filters on individual entries. We recommend that you limit only the

period for inclusion here, as the entries are already filtered through the journal.

On the Options tab, you select the method that you want to use for posting. You can create a G/L entry for each measurement

entry here or one G/L entry for all of them. You also need to enter a posting date to specify when entries should be transferred to

Finance, a document number, and a posting description.

The Post toggle is used to determine if you want to preview WIP calculation (toggle turned off) or whether the posting should

already be made.

Afterward, choose Print or Preview at the bottom of the page to start the posting or preview process. This will show you a report

listing the work in progress.

After WIP has been posted to Finance, you can open a project card and choose Project > Related > History > Measurement

Entries on the ribbon to see the postings. When you post work in progress, the system will update the Posting Date field for the

relevant measurement method. The project measurement entries included with the posting are updated in the Posted

Measurement Amount field.

In the Finance area, the individual records have been posted as well. As the posting method selected for Post Project Work In

Process to WIP was Per Project Meas. Entry, the system posted a great many records.

The posting process is identical when you measure project completion. You only need to first calculate completion values for the

period under consideration so that they’re included when you run the measurement suggestion from the journal page.

Posting to Finance also works in the same way despite completely different account assignments.

Recognize revenue by project ledger entry

For revenue recognition, it is important when revenue is recognized, that is, whether it is recognized based on the percentage of

work completed or at completion of the contract. If you use the Completed Contract method, the status of the project must be set

to Completed. You can then run the Recognize Revenue from the measurement journal.
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The date of revenue recognition is specified on the Options FastTab. You also need to enter posting date, a document number,

and a posting description there. On the Project tab, you can filter for specific projects or, if you leave the Project No. field blank,

use the function on all projects.

On the Project Measurement Method tab, you can set a filter on measuring methods or, as before, leave the field blank to include

all methods.

The Project Measurement Entries tab, on the other hand, can be used to filter for certain posted project measurement entries. In

the Entry Type field, you can select either Usage or Sale. If the field is left blank, all entries are considered for revenue

recognition.

As was done when posting WIP, the project measurement journal must now be posted. The recognized project ledger entries can

then be found in the project measurement matrix in the Recognition column.

Post revenue recognition to Finance

Following revenue recognition in the Project area, the entries still need to be posted to Finance. For this purpose, you can choose

the Post Project Recognition to G/L action.

If necessary, you can limit recognition to specific projects on the Project FastTab. On the Project Measurement Method tab, you

can specify for which method you want to recognize revenue.

On the Project Measurement Entry tab, you can select the measurement entries that you want to transfer to Finance for revenue

recognition.

On the Options tab, you can specify whether you want a G/L entry created for each measurement entry or if you want to

aggregate the measurement entries into one G/L entry in Finance. Additionally, you need to fill in the Posting Date, Document

No., and Posting Description fields on the tab.

With the Post toggle turned on, revenues are then posted to Finance. Leaving the toggle turned off will generate only a test

report.

As was the case when you posted WIP, the system creates numerous G/L entries in Finance when you recognize revenue.

Post progress measurements

Measuring progress is largely identical to measuring project ledger entries. For this reason, only the differences between them

are explained in the following.

Calculate project completion

Project progress is calculated by choosing Related > Project > Measurement > Completion on the project card ribbon. You then

use the Estimate Completion function on the page that opens to create completion lines.

Calculate WIP based on completion

For measurements based on project completion, a suitable measurement method must be created for projects. Crucial in this

context is the Measurement Base field, where you must select the Completion option.

As was the case for measuring project ledger entries, you first run the Measurement Suggestion function on the Project

Measurement Jnl. page. Note the filter set on the Posting Date field, as the focus has now shifted to completion values.

All subsequent steps (posting the project measurement as a project measurement entry and posting this entry to Finance [if the

relevant journal gives you the option of doing so], recognizing the entry and posting recognition to Finance) are the same as for

ledger entry-based measurement.

ANALYZE MEASUREMENTS

The measurement functionality also provides you with options of analyzing the data relevant to determining the current value of

a project.

Gross profit and loss report

This report shows you the lines and values for a posted measurement (for example, based on IFRS or HGB and a specific month).

A line is only included on the report if the Show checkbox has been selected for it in the measurement template.
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On the Project Dim. Value Report Buffer FastTab, you can first specify the dimension by which projects on the report are

grouped. In the Dimension Value field, you can then enter a value to show only projects where the value has been assigned as a

default dimension (such as range 30). You can also limit what projects you can see by setting a filter in the Project No. field.

On the Options FastTab, you need to enter a date so that you see only measurements valid in that month. In the Meas. Method

Code field, you need to enter the code of a measurement method that will be included on printouts.

Additionally, with the Preview toggle turned on, the report will show both posted and created but not yet posted measurements

on the report.
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German HOAI Fees

Despite being implemented decades ago, the German HOAI regulations on architects’ and engineers’ fees continue to have little to

no influence over fee schedules developed outside Germany.

The highly localized nature of HOAI is reflected in the online help articles by limiting the language used to describe the related

functionality to German.

Note
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Financial Management

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s finance department.

NON-DEDUCTIBLE VAT

For general information about the feature, see Set Up Non-Deductible VAT - Business Central. This article only describes the

additional pages, functions, and fields available for it in KUMAVISION project365.

VAT Setup

You can now also use dimensions to calculate percentages of non-deductible VAT.

Choose the Search icon, enter VAT Setup, and then choose the related link.

Fill in the fields as described in the following table.

The fields in this table are only visible if the Non-Deductible VAT toggle has been turned on.

Non-Deductible VAT Dimensions

Can be opened by choosing Actions > Non-Deductible VAT Dimensions on the ribbon.

If you selected the Dimension option in the Non-Deductible VAT Type field on the VAT Setup page, the non-deductible VAT

typically specified in VAT Posting Setup is stored with dimensions and dimension values instead. In that case, you specify on this

page the dimensions that you want the system to consider for calculating a percentage, as well as the order of priority in which

they should be searched for.

1. 

2. 

Field Option

Non-Deductible VAT

Type

(blank)

Indicates that this field hasn’t been filled in yet. To proceed, you must select one of the following

options.

Standard

Corresponds to standard functionality, which means the system posts lines by using the non-

deductible VAT percentage that has been specified for them on the VAT Posting Setup page.

Dimension

Determines a non-deductible percentage based on dimensions and dimension values (and,

potentially, a time frame, as will be explained later).

Non-Deductible VAT

Check

Show Notification

Shows a message if the current combination of VAT business and product posting groups entered on

a line allows for a non-deductible percentage based on dimensions, but none can be found.

You can still post the line, however.

Show Error

Displays an error message during posting.

Non-Deductible VAT

Date

Posting Date

Posting dates will be used to calculate non-deductible VAT.

Document Date

Document dates will be used to determine the percentage.

Hinweis
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You then need to specify for each dimension value from which date a percentage will be valid for them by choosing Dimension >

Dimension Values on the ribbon and filling in the fields as necessary.

Non-deductible VAT is only used for lines on which you stored a business and posting group combination that allows the use of

non-deductible input VAT via the Allow Non-Deductible VAT field in VAT Posting Setup (see the standard help for more details).

If you selected Dimension as the non-deductible VAT type, you cannot enter a percentage in the Non-Deductible VAT % field in VAT

Posting Setup, as the percentage from the dimension values should be used instead.

PROJECT DEFERRALS

For general information about the feature, see Defer Revenues and Expenses.

The following section only explains the additional pages, functions, and fields available for it in KUMAVISION project365. 

Projects Setup

The standard app doesn’t include a function to defer project ledger entries; they’re posted in sales and purchasing as if no

deferral took place, that is, one entry is created per posting date. To change that:

Choose the Search icon, enter Projects Setup, and then choose the related link.

On the General FastTab, turn on the Use Deferral toggle so that you can defer amounts on project ledger entries in the same way

as project revenue and usage.

FIXED ASSET INTEGRATION

This section describes the integration of project management into fixed asset accounting. For general information about the

functionality, see Manage Fixed Assets (contains video) - Business Central | Microsoft Learn.

Setup

A FastTab named Project Integration has been added to the Fixed Asset Setup page, containing a toggle called FA Project

Integration. Only if this toggle is turned on are you able to use the features described in the following. If it isn’t, nothing is

posted to a project when you post a fixed asset transaction.

Turning on the toggle then unhides the other fields on the tab. You can choose in the Depr. Book (Projects) field the depreciation

book for which FA ledger entries will be posted to projects. For each posting type—from acquisition cost to custom1 and custom2

—you can also choose the work package that specific FA values should be posted to automatically.

Fixed asset card

To link a fixed asset to a project, open a fixed asset card and fill in the Project No. field. This way, posting a fixed asset

transaction also posts the FA value to the specified project.

Post an FA ledger entry

When you post a ledger entry for a fixed asset linked to a project, a project ledger entry is created. This entry is posted to a WBS

line containing a work package of the same FA posting type as the package specified in Fixed Asset Setup. If none is found on the

current WBS, an error message appears.

However, the system must not create project ledger entries for asset purchases or sales at this point, that is, for fixed asset

ledger entries where the posting type is set to Acquisition Cost, Proceeds on Disposal, Salvage Value, or Book Value on Disposal,

or where the posting category is Disposal or Bal. Disposal.

The exception are internal projects, identified as such on the Project Type page. Their FA transactions must be set up manually,

which creates project ledger entries. But these don’t include amounts used to, for example, measure the financial value of a

project. They’re stored in the Fixed Asset Total Cost (LCY) field instead.

To create project ledger entries, project journal lines are set up and posted. What kind of project ledger entry is created during

this process depends on the posting type specified for the fixed asset. If that type is Gain/Loss, Proceeds on Disposal, Salvage

Value, or Book Value on Disposal, Sale is selected as the ledger entry type; else, the Consumption option is used.

Hinweis

1. 

2. 
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All project ledger entries are of type G/L Account, with the correct account being chosen based on the fixed asset group that you

specified for the relevant FA ledger entry type. The value of a project ledger entry corresponds to the FA value that is posted for

a project but with the sign reversed. The entry also contains the dimensions of both the project and the fixed asset it’s related to.

Financial reports

Financial reports set up for internal projects might include fixed asset-related consumption even if the specified FA type doesn’t

allow costs to be stored for them in the usual way.

For this purpose, you can select the Include Fixed Asset Total Costs checkbox in the column definition if you choose Project

Ledger Entry as the entry type. With the field selected, the report column will include not only the total costs of the relevant

project ledger entries but also those of the fixed asset based on the Fixed Asset Total Cost (LCY) field value stored with the

entries.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Service

For general information about this area, see Service Management. This article only describes the additional pages, functions, and

fields available for it in project365.

Service items

Assign a project for item shipments

You can fill in the Shipment Project No. field on a service item card to indicate the project that was used to ship the service item

to a customer.

This field is for informational purposes only and doesn’t have an impact on other service functionality.

Assign a service project to an item

You can also assign to a service item a service project and a work package from a WBS line of the project. When you enter the

item on a service line, postings that you made to service contracts and orders are then copied to this project and WBS.

Service contracts

Assign a service project to a contract

When you add a service item to a contract line, the associated service project, as well as the related work package from a WBS

line of the project, are copied to the contract header automatically.

A contract should include only service items that originate with the same project. You’ll see a message if you fill in an item used on

another service project.

Assign a project to a service invoice

When you bill a contract, the service project and work package assigned to it are copied to the invoice header and invoice lines

automatically while all revenue from billing is posted to the project.

Service orders

Assign a service project to an order

When you enter a service item on an order line, the associated service project, as well as the related work package from a WBS

line of the project, are copied to the service header and lines automatically.

All service items specified for an order must originate with the same project. You’ll see an error message if you enter an item used on

another service project.

Assign a project on service lines

When you create a service line, the associated service project and work package are copied from the related service order

automatically. The system then posts, besides service ledger entries, the time and materials consumed (and later, if applicable,

the revenue generated) to the project via project ledger entries.

Track times

Note

Note

Note
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You can record time spent on service orders both in a project time journal and on CTC lines (the fields for either might need to be

unhidden first, however).

To select a service line, use the Assist button that you see next to the Service Document No. field there; the Service Line No.

field, on the other hand, is filled in automatically. The project number and work package (=WBS line) are also filled in by the

system with what you specified on the assigned service contract line.

When you post time spent on a project, a project time entry is posted as well. This entry provides both data on the project and a

reference to the relevant service contract line.

Prevent project journal posting

Time entries with a reference to a service contract line can be excluded when you run the Get Project Time Entries action to

prevent them from being copied to a project journal.

To do this, enter the “ “ filter in the Service Document No. field on the request page for the report. The feature is then used only

on entries that the field isn’t filled in for.

The filter remains even after you exit the page so that it is already set for when you run the function the next time.

Copy time entries to service lines

You can run the Get Project Time Entries action from the ribbon of a service item worksheet or the service line list to copy time

entries that haven’t been copied yet to newly created service lines, on which other fields such as Resource No., Description, and

Quantity are filled in as well.

Posting the service lines then posts not only service ledger but also project ledger entries and the time entries are marked as

Copied to (the) Project.

The time entries can also be transferred to the project journal and posted to the project itself. In this case, however, the above filter

must not be set so that the time entries aren’t copied to the service order but to the project instead.

Note

Note
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Price lists

This article only describes the price list features implemented in KUMAVISION project365. For more information about the

extensions added to KUMAVISION base (BOOSTER), see Prices (Sales) and Prices (Purchasing).

For general information about the price list functionality, see Set Up Prices and Discounts - Business Central | Microsoft Learn.

The KUMAVISION project365 Price Sequence option that you can select along with a new pricing experience calculates sales and

purchase prices according to project priorities—without the system trying to find the best price. The following pages are

available for this purpose:

Purchase Price Lists

Purchase Project Price Lists

Sales Price Lists

Sales Project Price Lists

In project management, a price list linked to a specific project takes priority. Only if the system cannot find a valid price on it will

it look for a list that isn’t assigned to a project.

SETUP

Feature management

The new features must first be activated.

Choose the Tell Me function, enter Feature Management, and then choose the related link. 

On the line Feature Update: New Sales Pricing Experience, set the Enabled For field to All Users.

If the features aren’t turned on for you, please contact support. Do not try to turn on the functionality on your own.

By activating the new price lists, the previous tables are migrated, that is, replaced.

Sales & Receivables and Purchases & Payables Setup

The features are available in both sales and purchasing. When the new pricing experience is activated, the KUMAVISION

project365 Price Sequence option is turned on as well, ensuring that project prices are calculated according to a certain

sequence (and not the standard functionality best price option).

Standard resource prices

On each list, you can specify standard prices that will be valid for all resources. This simplifies data management, as the focus of

project sales pricing is typically on the activity performed (=work type), not on who performed it (=resource).

To set up a price that should be valid for all resources, open a price list, select Resource in the Product Type field, and leave the

Product No. field blank. The new price, however, has a lower priority than if assigned to a specific resource or resource group

(see Price Sequences).

Work types

Sales pricing

To be able to determine resource sales prices, a work type is needed for each resource. It not only describes the type of work

being performed but also the (consumption or billing) unit used. A sales price must always be linked to the correct billing unit.

• 

• 

• 

• 

1. 

2. 

Note

Note

1.2.4 project365

- 879/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://learn.microsoft.com/en-us/dynamics365/business-central/across-prices-and-discounts?tabs=new-experience
https://kumavision.com/en/Microsoft-Dynamics-365/apps/support-apps


Example

Project Lead (PL) type of work is recorded in hours but billed by day. This kind of work is also billed at a higher rate than time

that is recorded for Travel (TR). The latter is billed in hours.

You cannot specify a price as valid for all resources by leaving the work type on a sales price list blank. To set up standard prices, you

need to make actual use of the work types available.

Purchase pricing

A blank work type can only be used as a dummy value on purchase price lists. In this case, price units aren’t specified by work

type, so that any price is given in the resource’s base unit of measure.

Explanation

A resource costs a company the same whatever activity is being performed. If purchase prices followed the business logic that is

used to determine prices in sales, the same price would need to be stored for all resources and work types specified on a

company’s purchase price list.

To simplify data management, the purchase price list thus allows a blank work type to be used as a dummy value.

External resource hours, however, might be purchased at different rates based on the work that needs to be performed. Using

work types for these purchases could therefore make sense.

Work type Unit of measure Sales price

PL Day EUR 720.00

TR Hour EUR 50.00

Note
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PARAMETERS AND FILTERS

All values used in pricing are described in the following table.

All these are used as parameters or filters for price calculations. Examples of filters are the date and work type fields (the latter

in the case of resource sales prices), where alternatives don’t exist. This means:

If no price has been assigned to a work type on a sales price list, the system will not retrieve another price.

If a list price has expired, it can no longer be used.

Among the parameters that will be included in pricing are the project, resource (group), item (price group), G/L account,

customer or vendor (price group), and currency code. For more information, see Price Sequences.

PRICE SEQUENCES

Prices are determined based on what value ‘fits best.’ The standard best price principle doesn’t apply any longer. Instead, the

system follows a sequence of steps ranked by priority. If a price that matches the specified criteria is found, it is used as the best

price.

Price sequences in sales

Parameters and

filters

Description

Project Project-specific lists of prices take priority over other price lists. Only if no valid price can be

found on those lists will a standard price be used.

Date Typically means the posting date, except during project planning, where it specifies the starting

date.

The date is used as a filter criterion, as the basis for calculating a price might differ depending on

when the calculation is performed.

Note

If the date field on a line is blank, the price is valid indefinitely. You can, however, also fill in only a

starting or an ending date so that a price will be valid for an unspecified period starting on

01/01/2025, for example.

Work type Relevant only to resource pricing. For more information, see Work Types.

Resource, Item, or G/L

Account No.

Depending on posting and planning, resource, item, or G/L account numbers might be shown in

these fields.

Resource group Only relevant to resource pricing, where prices can be assigned to groups instead of individual

resources.

Item price group Only relevant to item pricing.

Customer or vendor Specifies if calculations result in unit costs or sales prices.

Customer or vendor

price group

Prices can also be specified at this level. However, those stored for individual customers or

vendors take priority.

Currency code Specifies the currency used to bill a project or the currency entered on purchase documents.

• 

• 
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Resource pricing

Source Priority

Project sales price list

1: Project-specific prices

Resource price

Resource group price

Standard resource price (=Resource No. field blank)

2: Standard project prices

Resource price

Resource group price

Standard resource price (=Resource No. field blank)

Sales price list

1: Customer-specific prices

Resource price

Resource group price

Standard resource price (=Resource No. field blank)

2: Group prices (customer)

Resource price

Resource group price

Standard resource price (=Resource No. field blank)

3: Standard customer prices

Resource price

Resource group price

Standard resource price (=Resource No. field blank)

Base data Price on resource card
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Item pricing

G/L account pricing

Source Priority

Project sales price list

1: Project-specific prices

Item price

Group price (item)

2: Standard project prices

Item price

Group price (item)

Sales price list

1: Customer-specific prices

Item price

Group price (item)

2: Group prices (customer)

Item price

Group price (item)

3: Standard customer prices

Item price

Group price (item)

Base data Price on item card

Source Priority

Project sales price list

1: Project-specific prices

G/L account price

2: Standard project prices

G/L account price

Sales price list

1: Customer-specific prices

G/L account price

2: Group prices (customer)

G/L account price

3: Standard customer prices

G/L account price

Base data n/a
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If no valid price is found for an item or a resource on a price list, the price stored on the item or resource card is used. This price is

in local currency and in the base unit of measure and can be converted if necessary.

If no currency code can be found for a price, you can convert the price from the local currency to the target currency. With sales

prices especially, we recommend that you maintain them in the billing currency.

Unit cost calculations

What has been written above also applies to calculating unit costs. But instead of customers, vendors and their price groups are

used. Work types of unit cost calculations also aren’t used as a filter but a parameter, that is, the system will look for a valid price

for the work type. If none can be found, it will search for a standard price (for which the work type is blank).

Note

Note
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General Setup

For general information about how to configure Microsoft Dynamics 365 Business Central1 for first use, see Overview of Tasks to

Set Up Business Central.

This article only describes the additional pages, functions, and fields available for configuration in project365.

SET UP A USER

Choose the Search icon, enter User Setup, and then choose the related link. 

Select a user and choose Edit.

1. 

2. 
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Fill in the fields as described in the following table.3. 
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Field Description

Projects Resp. Ctr. Filter Assign a responsibility center so that users only see projects that match their area of

responsibility.

Note

This filter does not apply to time tracking.

Employee No. Enter the employee number assigned to the user.

Resource No. Specify the resource associated with the user. If the resource is not an employee, enter a

number manually.

Filling in this field is crucial, for example, to assigning a resource to a time journal.

Other Res. in Time

Tracking

With the toggle turned on, a user can see other resources’ time sheets and CTC cards.

Note

Turn on this toggle for administrators only. This also includes controlling the recorded times in

various overviews and reports. If these rights are not to apply to all resources, but only to a

selection of resources, this can be set up via the "Resource management" page.

Time Manager Turn on this toggle to specify the user as a time manager, who, instead of the project leads,

should approve the time entries created from resource hours.

Note

The field is only used if the Check by Time Manager toggle is turned on in Projects Setup.

Plan Own Resource With the toggle turned on, users with the relevant read/write permissions can schedule their

own resources. Usually, only resource managers have these kinds of permissions; other

employees can do little more than read entries.

Turning on the toggle expands (and at the same time, limits) access to a resource by granting

write permission to the user who is linked to the resource.

Note

This field is only relevant when planning resources to whom no budget activities are assigned.

Planning Location Code Specify a resource manager’s default filter when handling resource requests. You can clear this

filter on the Resource Request page to see all requests made so far.

Note

This field is only relevant when planning resources to whom no budget activities are assigned.

Resource Manager Turn on this toggle if the user is a resource manager.

Resource managers handle requests posted by coworkers and distribute them among

employees with available capacity. A resource manager can see all requests; others only see

their own.

Note

This field is only relevant when planning resources to whom no budget activities are assigned.

Team Filter on Resource

Requests

Select a code that you want to set as a filter when you open the Resource Planning page from a

resource request.

The filter can help you sift through the resources and resource planning lines in the system if

their numbers are high.

The filter can later also be changed manually, if necessary.
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RESOURCE MANAGEMENT

The "Resource management" page allows users to assign time controlling rights for other resources. These rights make it

possible to view the time bookings of the assigned resources in various overviews and reports. The "Other Res. in Time Tracking"

button also allows access to the actual time recording (e.g. ZDE card) of these resources. Entries on this page are more specific

than the global "Other Res. in Time Tracking" button in the user setup.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

Note

This field is only relevant when planning resources to whom no budget activities are assigned.

Planning Department

Filter

Select a code that you want to set as a filter when a planner opens the Resource Request page.

You can clear this filter on the page if necessary.

Default Sales Doc. Type

for Creation from Project

Specify if the function used to create sales documents from a project should create quotes or

orders (for more information, see Create Projects from Sales Documents).

Show All Staff Equipmt. Typically, users can only see the equipment that is assigned to their resource (see above).

However, you can turn on this toggle for staff members who have been tasked with managing

equipment beyond their own so that they can remove the standard equipment filter and see all

devices (and software) issued to resources or employees in the system.

This way, they can change equipment data without needing to open the employee master—to

which only a handful of people typically have access to anyway.

Allow Customer Change

Despite Revenue

If you chose Selected in the Setup Customer Change Despite Revenue field in Projects Setup,

you can turn on this toggle to mark the user as someone authorized for the process.

Note

Even if authorized, the user can only change a customer if the Selected option is chosen in

Projects Setup.

1. 
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Administration

The following article will describe certain data maintenance actions and the conditions under which they can be run.

DELETE DEFAULT DIMENSIONS FROM WBS OR BUDGET

Dimensions are used on WBS and budget lines in the same way as on the lines of a document. This means they will be retrieved

from items, resources, or G/L accounts associated with the selected work package and project.

If the toggle Use WBS Line Dim. as Default or Use Budget Line Dim. as Default is turned on in Project Setup, or both are, these

planning dimensions can also be entered in journals and on document lines.

They’re then treated like dimensions stored in the item or resource master, for example. In other words, they’re temporarily

copied to the Default Dimensions page and will be deleted again from there when the required dimensions have been found.

Unfortunately, sometimes, the deletion process might not work as intended so that certain values are still listed as default WBS

or budget line dimensions. To rectify this situation and clean up the data, you can run the Delete Default WBS and Budget Line

Dimensions batch job, which you can find by using the general search function.

When run, the batch job shows (if available) the number of default dimensions that are currently stored in the system. You can

then delete the relevant values from this list immediately.
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1.2.5 project365 Real Estate

KUMAVISION project365 Real Estate

This app has been developed with the German market in mind. Because of the industry's differing rules and regulations across the

world, the development of app versions for use outside the country will not only require adjustments to some functions and fields but

also rewrites of the online help articles.

As a result, the web help describing the solution is currently available in German only.

Note
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1.2.6 project365 Architects

KUMAVISION project365 Architects

OVERVIEW

KUMAVISION project365 Architects provides engineers and architects alike with key functionalities they require for their work.

Tapping into a bundle of solutions built on top of KUMAVISION project365, the app features:

Work breakdown structures so you can monitor and track orders from a single location.

Customizable quotation and costing, contact management, and assessment of project success.

Improved time tracking for each project phase and task.

Billing based on payment plans or expenditures.

Project schedules as a basis for costing and cost control.

Cost control down to the task level.

Budget-versus-actuals comparisons.

Actuals trackable on individual documents.

Quote and order archives that you can use to share expertise.

HOAI and AHO cost and fee management for both internal and subcontracted orders.

Powerful advance payment accounting.

Available as a standalone solution in Microsoft1 AppSource, project365 Engineering consists of

Microsoft Dynamics 365 Business Central1

KUMAVISION project365

Advance Payment (including Bridge App)

HOAI Fee Management

Get KUMAVISION project365 Architects from Microsoft AppSource.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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1.2.7 project365 Engineering

KUMAVISION project365 Engineering

OVERVIEW

This app provides engineers with the following array of features specifically designed to integrate with KUMAVISION project365:

Work breakdown structures so you can monitor and track orders from a single location.

Customizable quotation and costing, contact management, and assessment of project success.

Improved time tracking for each project phase and task.

Billing based on payment plans or expenditures.

Project schedules as a basis for costing and cost control.

Cost control down to the task level.

Budget-versus-actuals comparisons.

Actuals trackable on individual documents.

Quote and order archives that you can use to share expertise.

Powerful advance payment accounting.

Available as a standalone solution in Microsoft1 AppSource, project365 Engineering consists of

Microsoft Dynamics 365 Business Central1

KUMAVISION project365

Advance Payment (including Bridge App)

HOAI-compliant fee management is also available (but requires an additional license).

Get KUMAVISION project365 Engineering from Microsoft AppSource.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

1. 

1.2.7 project365 Engineering

- 892/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://docs.microsoft.com/en-us/dynamics365/business-central/
https://appsource.microsoft.com/en-us/home


1.2.8 trade365

KUMAVISION trade365

With trade365 developed by KUMAVISION, wholesalers and distributors can fulfil customer expectations of exceptional service

and timely delivery—while keeping supply chains lean and costs to a minimum.

Built on top of Microsoft Dynamics 365 Business Central1, the solution supplies trade companies with a whole host of features to:

customize quotations, for example, by providing easy-to-edit layouts and space for individually negotiated terms and

conditions.

gain a quick overview of blanket and framework agreements.

fast-track order entry and calculate customer discounts in a flash.

scan in documents to prevent errors in warehouse handling and lot tracking (optional).

get notified immediately of impending credit limits.

increase customer retention by offering equipment rentals.

Topics

General Business Functionality

Sales

Purchasing

Manufacturing

Warehouse Management

Service

Subcontracting

Rent

Alloy Surcharges

General Setup

Get KUMAVISION trade365 from Microsoft AppSource

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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General Business Functionality

The following features expand standard Microsoft Dynamics 365 Business Central1 functions to provide additional options to

those using General Business Functionality.

RESPONSIBILITY CENTERS

Besides filling in the standard fields, you can add logos and translated footers to responsibility centers to replace the default logo

and footer specified on the Company Information page with another, or none at all, on sales and purchase documents associated

with a certain work area.

You can use this feature, for example, when you’re planning to ship white label or private label products to customers who intend

to sell them under their own brands or when you deliver items to companies based in other countries.

Choose the Search icon, enter Responsibility Centers, and then choose the related link.

Select a responsibility center.

On the right-hand side, use the Picture menu options to update the logo (or insert a blank image).

Choose Document Text Translation on the ribbon if you also want to add footer text in another language.

ITEMS

You can now see not only the Qty. on Sales Order and the Qty. on Purch. Order but also the Qty. on Sales Quote and Qty. on

Purch. Quote on item cards.

You can use a lookup on each field to navigate to the relevant document.

SKU DATA

In the standard app, stockkeeping unit cards show you both the Qty. on Sales Order and Qty. on Purch. Order.

In trade365, the cards also include the Qty. on Sales Quote and Qty. on Purch. Quote. You can use a lookup on either field to open

the related document.

ONE-DIMENSIONAL VARIANTS

To identify recurring variants with ease—for example, because many items are available in the same size—you can store variant

attributes in the item master.

To fast-track the creation of variants:

Open an item card.

On the ribbon, choose Actions > Functions > Create Variants (Matrix).

Fill in the fields as necessary.

You can, however, also specify all variant data manually.

TWO-DIMENSIONAL VARIANTS

Certain items might require you to assign not one attribute but two attributes to them, such as when a product is available in

different sizes and colors but needs to be grouped under the same item number.

In trade365, you can set up variants with two attributes in both the sales and purchasing areas.

Setup

Inventory Setup

When you create a variant with two attributes, the system will combine the descriptions entered for each attribute. To set them

apart visually:

Choose the Search icon, enter Inventory Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, fill in the Item Variant Descr. Separator field.

Variant attributes

1. 

2. 

3. 

4. 
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2. 

1.2.8 trade365

- 894/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://learn.microsoft.com/en-us/dynamics365/business-central/ui-across-business-areas


Two-level variants possess values originating with general variant attributes, such as size or color, to which you assigned

attribute values, such as red or blue. You can use variant attributes to create any number of items. To set up an attribute:

Choose the Search icon, enter Item Variant Attributes, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Afterward, choose Attribute Values on the ribbon to set up attribute values for the variant.

To display variant texts in another language, you need to set up translations for variant attributes and values together with the

relevant language code in the item master. They’re then filled in automatically during variant creation.

You can also block attribute values from being used so that they’re no longer visible when you set up another item variant. The

block doesn’t affect values that are already part of an existing variant.

Attributes are sorted on the Create Variant (Matrix) page (alphanumerically) by Code, although the order can be changed if

necessary. 

Item card

To set up an item variant with two attributes:

Open an item card.

On the Variants FastTab, fill in the Variant Attribute 1 Code and Variant Attribute 2 Code fields.

On the ribbon, choose Actions > Functions > Create Variants (Matrix).

Choose an attribute 1 and attribute 2 combination that will be used as a basis for creating new variants.

Choose OK.

Afterward, the variant is set up in the same way you would a variant by using standard (sales or purchase) functionality.

DEFAULT SALES VARIANTS

You can also set up default values, for example, if you use certain variants to denote different product versions.

Setting up default variants will reduce the amount of information that needs to be entered on sales documents.

Open an item card.

On the Prices & Sales FastTab, enter an existing variant in the Def. Variant Code (Sales) field.

The variant is then entered automatically on a document after you specify an item number. It can also be removed or replaced

manually if necessary.

QUICK ENTRY: VARIANTS

Often, items that come in many variants are also purchased in more than one configuration. To speed up variant creation in a

case like this, you can use the trade365 quick entry system.

1. 

2. 

3. 

Field Description

Code Specify the code that will be used for the attribute. The code must be unique.

Description Specify a description for the attribute.

Variant Description

2

Specify a description that will be used for the item variant in the Description 2 field.

Note

Placeholder %1 specifies what value is copied from this field to the Description 2 field.

For example, if you create an item called Blue XL T-Shirt, you need to enter Size %1 in this field for

variant attribute Size.
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5. 
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Setup

To set up quick entry:

Open an item card.

On the Variants FastTab, turn on one or more of the following toggles to specify the kinds of documents that you want to activate

the feature for.

Sales Variant Quick Entry

Quote

Order

Invoice

Cr. Memo

Blanket Order

Return Order

Framework Agreement

Purchase Variant Quick Entry

Quote

Order

Invoice

Cr. Memo

Return Order

Transfer Variant Quick Entry

Transfer Order

Journal Variant Quick Entry

Item Journal

When working with variants, we recommend that you select the Variant Mandatory field for each to ensure that items aren’t entered

without one.

Workflow

For example, if you select the quick entry option for purchase orders, you can specify a quantity for each variant when entering

an item number on an order before choosing OK to add the relevant lines to the document.

If you didn’t select the option for documents that require variants, you need to specify an item number and a variant manually.

However, you cannot choose more than one variant per document line.

Exclude from quick entry

The type and number of variants might change frequently. For example, a color might no longer be available, or you no longer

want to sell a specific configuration but will accept return orders containing the variant.
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Unless blocked, however, a variant can still be used everywhere in the system. To help ensure that only certain variants are

shown during quick entry:

Open the Items page.

Select an item and choose Related > Item > Variants on the ribbon. Alternatively, open the relevant item card and do the same

there.

Select a variant and choose Open Variant Card.

On the Warehouse FastTab, turn on the Exclude on Variant Matrix toggle.

VARIANT CARDS

Standard functionality provides you with a list view for the display of variants. With trade365, you’ll have even more features at

your disposal, such as a card view for easy tracking and editing. On these cards, you can add:

Translations

Manufacturers’ suggested retail prices

Extended texts

Requirements for complete shipment

Links to calculated unit costs, which you can edit and view here as well (regardless of where you’ve maintained variant data so

far).

For more information, see Calculated Unit Cost.

EXTENDED VARIANT TEXTS

In trade365, you can specify customized extended texts also for item variants. For more information about the topic in general,

see Extended Texts.

PURCHASING CODES: VARIANTS

Standard functionality gives you the option of storing a purchasing code on an item card if you only procure the items by drop

shipment or special order. This code is then copied to all sales transactions and can be changed during any such transaction (if

necessary), for example, if you must deliver goods via a certain warehouse.

Often, an item might, in theory, be available but some of its variants are only ordered when needed and will be sent directly to

the customer (variant drop shipment).

With trade365, you can specify purchasing codes for certain variants while delivering other variants from a warehouse. To limit a

code to a variant:

Open an item card.

Choose Related > Item > Variants on the ribbon.

Select a variant and choose Open Variant Card.

On the card, on the General FastTab, specify a purchasing code. If you can’t see the field, you might need to unhide it by using the

Personalize function.

The code is then copied to sales documents for variants to which it has been linked.

Purchasing codes that have been assigned directly on an item card apply to all variants of that item.

ITEM VARIANTS EXIST

The Item Variants Exist field has been added to item cards and the item list.

If a variant is set up for the first time, the value in this field changes from "No" to "Yes" on the relevant item card or item list line

so that you can determine at a moment’s notice whether variants exist for an item.

1. 

2. 

3. 

4. 

• 

• 

• 

• 

• 

1. 

2. 

3. 

4. 

Note

1.2.8 trade365

- 897/1545 - Copyright © 2018 - 2024 KUMAVISION AG



ITEM HISTORY

In trade365, in the item master, you can see a list of all documents that were created for items sold or purchased within the

system, sorted by their type:

Open the item list or a specific item card.

Choose Related > History > Sales or Purch. History.

ITEM LEDGER ENTRIES

To simplify ledger entry searches and expand the range of analysis options in this context, the following fields were unhidden on

or added to the Item Ledger Entries page:

This way, you can determine from a ledger entry, for example, what has been delivered to which supplier or customer and what

has been consumed by an assembly or production order.

GET SOURCE DOCUMENTS AND LINES

You can now see the customer or vendor name on a warehouse or inventory document after running the Get Source Document

Lines function.

Additionally, the For Name field has been added to the options menu.

SAVE ATTRIBUTE FILTERS

With standard functionality, you can set attribute filters on the Items page. In trade365, you can also save these filters for future

use:

Open the Items page.

On the ribbon, choose Attributes > Filter by Attributes.

Set the desired filters.

Turn on the Save Attribute Filter toggle. This will open a new page on which you can enter a code and a description.

Select Save Filter (Current User Only) if you want to link a filter to your user profile specifically.

You can then use the stored filter in the Attribute Filter Code field on the Filter Items by Attribute page.

DELETE POSTED DOCUMENTS

By default, deleting posted documents is not possible in trade365. To specify that documents can be deleted after a certain

period, you must fill in the Allow Document Deletion Before field. You can find the field on the General FastTab after opening one

of the following pages:

Sales & Receivables Setup

Purchases & Payables Setup

Service Management Setup

You also need to turn on the Allow Posted Document Deletion toggle on the trade365 FastTab there. Depending on what setup

you used, you can then delete sales, purchase, or service documents posted before the specified date.

• 

• 

Field Description

Source Type Specifies the source of the ledger entry (item, vendor, or customer).

Source No. Specifies the number of an assembly order, the number of a production order, a customer number, or a

vendor number.

Name Shows the content of the Name field as entered in the vendor or customer master if the ledger entry has

been sourced from either.
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ATTACH DOCUMENT ON PRINT OR SEND

If you want a document attached automatically in the form of a PDF when you use the Print or Send function, turn on the Auto

Attach Document via Print or Send toggle in Purchases & Payables or Sales & Receivables Setup. With the toggle turned off,

documents must be stored manually by running the Attach as PDF action from the ribbon.

COPY LINES FROM SALES OR PURCHASE QUOTES TO ORDERS

When you use the Create Purchase Order or Create Sales Order function on a quote, the system typically copies all lines of the

quote to a new order.

In trade365, you can also tell the system to transfer only a certain number of lines by selecting the Copy to Order field on each

before running the function.

SHIPPING AGENT SERVICES

A shipping agent might offer various services. For one of these to be specified as the default service:

Choose the Search icon, enter Shipping Agent, and then choose the related link.

Select an agent.

On the ribbon, choose Shipping Agent Services.

Select the Default field for the shipping service that will be automatically entered when the agent is selected on a sales, a service,

or an outbound warehouse document.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Sales

The following features expand standard Microsoft Dynamics 365 Business Central functionality to provide additional options to

those working in your organization’s sales department.

CREATE ITEM REFERENCES ON SALES LINES

Sales transactions in the trade industries typically involve two sets of item numbers, yours and those provided by your

customers.

You can use the Item Reference No. field when you create an order to specify that the number assigned to an item is sourced

from a customer, but only if it has already been stored in the item or customer master. In trade365, however, you can also set up

references on item lines during order capture.

Setup

To be able to use this feature:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Auto Add Item References toggle.

Workflow

Sales lines include the following fields:

If a reference for a certain customer-item number combination already exists, it will be entered in the Item Reference No. field

on a line when you’ve filled in and exited the Item No. field there.

Else, you can create a new reference when filling in the line. You can view and edit references on the Item References page,

which is available via the general search.

ORDER TYPES AND PAYMENT TERMS

To easily identify and manage orders within the system, you can now assign a category to them. They cover:

Sales (includes service orders)

Purchases

Transfers

Production

You can also set up subcategories, such as standard, rush, VMI, subcontract, or rework orders, on each Order Type page.

1. 

2. 

Type No. Item Reference

No.

Unit of Measure

Code

Variant Code

Item (number as stored

in the system)

(number as

specified by

customer)

(unit used when

selling the item)

(filled in with a code for

items that you set up

variants for)
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Sales order types

At this point, only the options added for sales order types in KUMAVISION trade365 will be explained in more detail. An explanation

of how to set up sales order types in general can be found here.

Assign reports by type

Besides assigning order types as identifiers and for the preset of dimensions, they can be used to specify the reports that should

be printed, for example, to confirm an order or announce a spare parts delivery:

Choose the Search icon, enter Report Selection – Sales, and then choose the related link.

In the Usage field, select the type of document that you want to set up reports for.

Besides filling in the Report ID field on a new line, you can choose Order Types on the ribbon to specify reports that you want to

use for a certain type of order. As can be done with standard functionality, you can store multiple reports here in sequence.

You can also adjust printouts based on what customer you’re using the report for. This way, you can have different kinds of

documents printed per customer and order type if necessary.

CALCULATE SALES PRICES FROM UNIT COSTS

In Microsoft Dynamics 365 Business Central1, you use worksheets to enter or edit prices or add them to price lists.

Note

Field Description

Exclude from Periodic

Billing

Turn on this toggle if you want orders of this type excluded from Periodic Billing.

No Order Minimum If selected, the system does not check whether these kinds of orders meet a certain value

threshold.
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Many of the software solutions developed by KUMAVISION also provide you with sales conditions. For general information about

the topic, see Prices. In trade365, they include a Calculated Unit Cost option as a basis for calculating sales prices:

Choose the Search icon, enter Price Worksheet, and then choose the related link.

On the ribbon, choose the Suggest Lines function.

Fill in the fields as described in the following table.

1. 

2. 

3. 

Field Description

Product Type Select the product type that you want to have lines suggested for. Options are:

• All

• Item

• Item Discount Group

• Resources

• Resource Group

• Service Cost

• G/L Account

• Item Price Group

The option you choose determines the lines for which the system will recalculate prices. If no unit price

or discount has been stored for the selected combination, no lines will be suggested, however.

Product Filter If necessary, set a filter, for example, on certain item or resource numbers, based on what option you

selected in the Product Type field.

Defaults Here you can use a lookup to choose one of the options that will be described later.

Minimum

Quantity

Fill in this field if you only want the system to recalculate prices that apply starting at a certain quantity

threshold. For quantities below the limit, no price will be suggested.

You can leave this field blank if you want to refresh all prices.

Exchange Rate

Date

Used to recalculate prices that are given in a foreign currency or are based on a sales condition for

which the Unit Cost or the Calculated Unit Cost option is selected in the Calculation Type field.

In this case, the unit cost in foreign currency is converted into local currency at the current exchange

rate.

Calculation Type You can choose between a corrective factor or a sales condition in this field.

By using a factor, you can, for example, increase the price by 5%.

By applying a sales condition, you can have the price recalculated based on a condition such as the unit

cost that is valid today.

Sales Condition

No.

Select the condition that will be used for calculating the price.

If you selected Adjustment Factor as the calculation type, this field cannot be filled in and will remain

blank.

Adjustment

Factor

Enter the factor that will be used to recalculate the price. The value must be entered as a factor for

multiplication, for example, 1.05 for a 5% increase.

If you chose Sales Condition as the calculation type, this field cannot be filled in and will remain blank.

Rounding

Method

If necessary, specify a rounding method that will be applied to the result of calculating the price. You

can, for example, specify that a price should be rounded to 0.05 from now on.

Starting Date Enter the date that will be used as the starting date for the new prices in price suggestions.

You can change the date again later on the price worksheet (but per line).
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For the Defaults field, you can choose one of the following options:

The Copy Lines action that you can run from a price worksheet copies new prices to the default price list stored in setup. Entries

added to this list are therefore not used as filters for source prices but as definitions for results. To see the list, use a lookup on the

Defaults field (found on the worksheet header).

All other worksheet settings are covered by standard functionality, except for when you use sales conditions. In this case, you can

check precisely how new prices have been calculated by selecting the relevant lines and choosing Price Calculation on the

ribbon.

SHIP-TO ADDRESSES

The following fields have been added to customers’ ship-to address cards:

VMI Location Code

Salesperson Code

Salesperson 2 Code

VAT Bus. Posting Group

Gen. Bus. Posting Group

VAT Registration No.

You can use these fields to customize ship-to addresses on sales documents, as the values entered here will overwrite those

stored in the customer master.

By filling in the VAT and Gen. Bus. Posting Group fields, as well as the VAT ID field, you can preset VAT values for goods shipped

outside the country but to domestic customers, for example. This removes the need for manual entry on orders on a case-by-case

basis, improving both the quality and consistency of your data.

Filling in one of the salesperson code fields, on the other hand, makes it easy to implement area-based commissions.

Field Description

Assign-to Type Specify for whom or what prices should be created. Options are:

• All Customers

• Customer

• Customer Price Group

• Customer Discount Group

• Campaign

• Contact

Assign-to No. Based on what option you selected in the Assign to Type field, you can further limit type assignment, for

example, to a certain customer, price group, or campaign here. Only if you selected All Customers will you

not be able to enter anything in this field.

If you want to limit assignment for more than one customer, campaign, contact or group, set filters in this

field according to the business logic of the standard app.

Currency Code Choose a code if you want prices suggested in a certain currency (see also the Exchange Rate Date field

above).

Starting Date Specify the starting date from which the new prices will be valid.

Ending Date Specify the ending date until which the new prices will be valid.

Defines Specify if you want to show new prices and discounts or only prices or discounts on price worksheets.

Note

• 

• 

• 

• 

• 

• 
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BILL-TO ADDRESSES

Often, the confirmation of an order is sent to a customer's primary address for approval, whereas the invoice needs to be

submitted to someone abroad or to a third party, such as a billing service.

With trade365, you can store more than one bill-to address in the system. Like ship-to addresses, they can be used on a wide

variety of sales documents. To store an alternative address:

Open a customer card.

On the ribbon, choose Related > Customer > Bill-to Addresses.

Choose New and enter a unique code that will be assigned to every billing address associated with this customer.

Enter the full address, including contact details and communication data. All other information will be copied from the customer

master when you create a shipment invoice.

Return to the customer card.

On the Invoicing FastTab, use a lookup on or manually enter a code in the Default Bill-to Code field. The new bill-to address that

you specify here is later entered on sales documents related to the customer. 

If you don’t set up a default address, all invoicing data will be copied from the customer master. If more than one billing address

has been stored there, you can choose the correct address when you create the relevant sales document.

Choosing Cancel on the selection page will copy the default address from the customer master to the document.

SHIP-TO ADDRESSES ON ORDER ENTRY

To minimize errors during data entry and streamline the entire process, ship-to addresses can be shown automatically when a

customer is entered for a sales transaction.

To turn on the automatic display of ship-to addresses:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION FastTab, turn on the Show Ship-to Addresses on Input toggle.

When you later fill in the Customer No. field on a sales document, the system will check if a ship-to address has been stored for

the specified customer. 

If it has, you’ll see a list from which you can select the correct address for the transaction. If none of the listed addresses are

suitable, choose Cancel to exit the page (and discard any changes).

• You can only choose a ship-to address after filling in the Customer No. field on the relevant sales header. If you create the

document through a customer card function, the selection window will not be shown.

• If you specified a code in the Ship-to Code field on the relevant customer card, an alternative address will not be available to you

when you fill in a document. Instead, the system will retrieve the default address.

BILL-TO ADDRESSES ON ORDER ENTRY

To minimize errors during data entry and streamline the entire process, bill-to addresses can be shown automatically when a

customer is entered for a sales transaction.

To turn on the automatic display of bill-to addresses:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION FastTab, turn on the Show Bill-to Addresses on Input toggle.

When you later fill in the Bill-to field on a sales document, the system will check if a bill-to address has been stored for the

specified customer.

If it has, you’ll see a list from which you can select the correct address for the transaction. If none of the listed addresses are

suitable, choose Cancel to exit the page (and discard any changes).

1. 

2. 

3. 

4. 

5. 

6. 

1. 

2. 

Note

1. 

2. 

1.2.8 trade365

- 904/1545 - Copyright © 2018 - 2024 KUMAVISION AG



If you specified a code in the Default Bill-to Code field on the relevant customer card, an alternative address will not be available to

you when you create sales documents. Instead, the system will retrieve the default address.

If you specified a code in the Ship-to Code field on the relevant customer card, an alternative address will not be available to you

when you fill in a document. Instead, the system will retrieve the default address.

SEPARATE COMBINED SHIPMENTS

Big corporate customers especially might use multiple customer cost centers, all with their own ship-to address, for incoming

deliveries. Invoices sent to this type of company might therefore need to be itemized by location.

For this purpose, you can use the Combined Shipments Per field (found on the Shipping FastTab of a customer card) to specify

that part of an invoice should be issued based on the Customer No. (for example, when you invoice work for associations) or the

Ship-to Code field.

When the Combined Shipments Per field is filled in, a new invoice document is created for each specified address.

SET UP EXTENDED SHIP-TO TEXTS

Working with multiple ship-to-addresses typically also requires differing ship-to address texts on sales documents. With trade365,

you can create them in the same way as standard document texts. To set up a text:

Open a customer card.

On the ribbon, choose Related > Customer > Extended Texts.

BILL-TO FACTBOX

Besides the standard sell-to customer history, you can now see all billing data associated with customers entered in the Bill-to

field on sales documents. You can get to a specific document by clicking one of the numbers in the new Bill-to Customer No.

FactBox, although the list might be limited by a date filter. Both boxes are available for all types of sales documents. However,

you might need to use the Personalize function to unhide them. For more information on the topic and on how to set up the

FactBox, click here.

CREATE REMINDERS FOR CONTACTS

Often, the contact details used to send reminders differ from those entered for other purposes. Standard functionality, however,

typically sends documents to the contact that is stored in the customer master. With trade365, you can now set up contact

information that will be retrieved during billing only:

Open a customer card.

On the Invoicing FastTab, in the Reminder to Contact No. field, select a contact who is stored in the system. This contact will be

copied to any reminder that you create from now on. 

Leave the field blank if you want reminders to be sent to the customer’s main contact person.

SALES RESTRICTIONS

In trade365, you can limit or block the sale of items to certain customers or customer groups (product restrictions).

Restrictions aren’t filters that can be removed at will. After setup, some items can simply no longer be sold or be sold only to a

certain group of customers.

Note

1. 

2. 

1. 

2. 

Note
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Setup

To set up a restriction:

Open a customer card.

On the ribbon, choose Related > Customer > Items Restricted for Sale.

Fill in the fields as described in the following table.

Restrictions additionally apply to all lower-level members of a hierarchy—even if that means they’re inherited across several

levels. At every level, you can add new restrictions or specify a new buy list.

You can also fill in the Hierarchy Type Restrictions Code field, found in Sales & Receivables Setup, to set up a different hierarchy

for item restrictions:

Pricing isn’t affected when you enter another hierarchy in this field. If pricing and restriction should be checked along the same

hierarchy, you must enter the same code in both fields.

The system only checks sales restrictions and customer-specific items for the code entered in the Hierarchy Type Restrictions

Code field so that you can, for example, supply an item to a select group of customers without this having an impact on pricing.

As another example, a company might place restrictions on an entire category of items, but its subsidiary might still sell be able

to some of the items in this category or restrict sales by other item categories that haven’t been set up yet.

1. 

2. 

3. 

Field Description

Type Choose Item for individual restrictions or Item Category to limit the sale of an entire group of items.

No. Based on your selection in the Type field, enter the item number or item category that you want

sales restricted for.

Variant Code If necessary, enter the code of the item variant that should be blocked for sale.

If you leave the field blank, the restriction set on the line will apply to all variants of the item.

Starting Date Specify from when the restriction should apply.

If you leave this field blank, the item (or items) will be blocked for sale immediately.

Ending Date Specify until when the restriction should apply.

If you leave this field blank, the item (or items) will be blocked until you enter an ending date or

delete the line.

Exclude from

Offerings

Specify if you want to create a buy list or block items from being sold.

A buy list means the customer can only procure the items listed, as is typical when doing business

with retail chains.

Turning on the toggle does the opposite, that is, create a list of items the customer is no longer

allowed to purchase.

Note

For each customer, items must be either on a buy or block list, although you might be able to

combine lists as explained in the following.

Field Description

Hierarchy Type 

Restrictions Code

Specifies a code for all item restrictions and customer-specific items set up in the system.

The code that you enter here does not affect the value in the Hierarchy Type Code Pricing field.
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All restrictions only apply to a single customer (and other customers along the same hierarchy). To check if the sale of an item is

restricted in some way:

Open a customer card.

On the ribbon, choose Related > Customer > List Item Restrictions.

You can then see what items and variants the customer can buy across all hierarchy levels.

Workflow

Once specified, restrictions are checked during the release of a document. If the document includes items or variants that cannot

be sold to the customer entered for it, the release will be blocked.

Checks might also be run when you reopen older documents. If a check should only be performed from a certain (order) date, you

must fill in the Starting Date field when you set up a restriction.

Optionally, a check can be run when filling in a document so that you see a message if an item or a variant that you’re trying to

enter cannot be purchased by the specified customer.

For an immediate check during order entry:

Open the Search icon, enter Sales & Receivables Setup, and then choose the relevant link.

On the KUMAVISION trade365 FastTab, turn on the Check Restrictions on Item No. Input toggle.

Regardless of whether performed on item entry, a check is always run before a document is released to ensure that the

restrictions you placed on the item haven’t changed in the meantime.

Customer-specific items

A customer-specific item is a special form of item restriction. It limits the sale of an item to certain customers, for example,

because of exclusivity contracts. Like all item restrictions, this kind of restriction also applies to every customer in a hierarchy.

An item or variant can be assigned to one customer only, which means that it is automatically blocked for sale to every other trade

partner in the system—unless that customer is part of the same hierarchy, albeit at a lower level.

Country prohibitions

Some items and variants cannot be sold to customers in certain countries, whereas other products might be available in a

predefined region only.

By specifying prohibitions for sale, you can block shipments to a country or a region, regardless of customer.

The system checks for sales prohibitions based on the ship-to address entered on a document, regardless of the customer's actual

address (Customer No. field).

1. 

2. 

Note

1. 

2. 

Note

Note
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To set up prohibitions for sale:

Choose the Search icon, enter Prohibited Sales Countries/Regions, and then choose the related link.

Fill in the fields as described in the following table:

As with general item restrictions and customer-specific deliveries, the system checks for country prohibitions when you create or

release a document based on what option you chose in Sales & Receivables Setup.

1. 

2. 

Field Description

Type Specify if you want to prohibit the sale of an individual item or a category of items.

Note

If you select the Item Category option, any item created at a later date but assigned to that category

will also be covered by the prohibition.

No. Based on what you selected in the Type field, enter the item number or a category for which you want

sales restricted.

Variant Code If necessary, enter the code of the item variant that should be blocked for sale in the specified country

or region.

If you leave the field blank, the restriction set on the line will apply to all variants of the item.

Country/Region

Code

Select the code of the country/region that you want to block shipments for.

County Specify a county if you want the country restriction to apply to a certain state or province only.

Note

Standard functionality does not provide a selection window for counties. What you enter in this field

must therefore be a precise match to the address data you were given.

Starting Date Specify the date from which the prohibition should apply.

If you leave this field blank, sales will be prohibited effective immediately.

Prohibitions are checked when an order is released provided the order date specified on the header is

the same as or later than the starting date of the restriction.

Ending Date Specify the date until which orders should be checked.
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RESERVE ITEMS

With trade365, you’ll get more than one function to simplify item reservations. To activate the new features:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, fill in the fields as described in the following table.

TIME-LIMIT BLANKET ORDERS

To prevent terms and conditions specified on a blanket order from being used after the order has expired, you can now set not

only a quantity but also a time limit there:

Open a blanket order.

On the FastTab, in the Valid Until field, specify up until when the order is valid.

You then see an error message if you try to use the order after the expiration date.

The field has also been added to sales lines (where it contains the value entered on the blanket order header) so that you can specify

the validity of blanket agreements at line level. However, the field is only unhidden on request.

SHOW QTY. REMAINING ON BLANKET ORDER

By clicking the highlighted number in the Qty. Rem. on Blanket Order field on a blanket order line, you can see the sales line

quantities that you still must ship to the customer.

A new field called Outstanding Qty. Excl. Order now also shows you the actual quantity that remains for call-off from the blanket

order. The field is calculated as follows:

Quantity - Qty. Shipped - Qty. Rem. on Order = Outstanding Qty. Excl. Order

1. 

2. 

Field Description

Check Lead Time on

Reservation

Turn on this toggle if you want the system to consider the lead time settings of items to minimize

inventory and cut costs for storage.

Example

Assume today is January 1. You create a new order you want shipped on 01/13. The item you need

for this order has a 10-day lead time so that it can be purchased right away and can be received on

01/10. In this case, you do not need to reserve items in inventory.

Note

If the toggle is turned on but no lead time has been specified, the item can never be reserved.

Unaffected by the setting are items for which you set the reservation status to Always (regardless of

their lead time).

You will be notified if the time until the shipping date entered on the sales line exceeds the reorder

period.

Auto Reserve on

Special Orders

Turn on this toggle if you want item lines to be automatically reserved on purchase orders linked to

special orders.

Can Reserve on

Quote

With the toggle turned on, you can reserve item quantities as early as the quote stage. These

reservations are then copied over when you create an order from a quote.

Can Reserve on

Blanket Order

With the toggle turned on, you can reserve items on blanket orders so that when you create sales

orders from them, the reservations are copied over as well.

1. 

2. 

Note
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CLEARANCE

Clearance items are items that you decided not to reorder or that your supplier has stopped providing. Your procurement

department will be notified that the item—or variant—in question is no longer available when they try to enter it on a new sales

order. To select an item or variant for clearance:

Open an item card.

On the Item FastTab, select the Clearance field.

Alternatively, select Clearance for each individual variant that will no longer be restocked.

If an item is selected for Clearance, its variants will no longer be restocked either, regardless of whether you’ve marked some of

them as well.

ADD SUGGESTED RETAIL PRICES

A manufacturer’s suggested retail price—also known as a list price—is often included in business transactions for purely

informational purposes but has no bearing on actual order pricing and is usually stated including VAT.

In trade365, you can store these prices for each item based on a certain time frame. You can also specify which customers they

should be shown to.

Setup

As can be done using standard purchase and sales pricing functionality, you can have a list price replaced automatically with a

new one. The previous list price is then valid until the day before the new price is:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Auto End MSRPs toggle.

The system now ensures that only one MSRP will be valid at a time unless you manually override the setting by replacing the

ending date of a price.

1. 

2. 

3. 

Note

1. 

2. 
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Assign list prices to items

To assign an MSRP to an item:

Open an item card.

On the ribbon, choose Prices & Discounts > MSRP.

Fill in the fields as described in the following table.

Print list prices

You can specify for every customer if you want to print a stored MSRP on the confirmation of an order:

Open a customer card.

On the General FastTab, turn on the Print MSRP on Order Cnfrm. toggle.

Like sales and purchase prices, the correct MSRPs are determined and printed based on the Order Date field.

SINGLE SHIPMENT PER ORDER

Some customers might want items they requested to be delivered as a single shipment and, if necessary, will reorder an

outstanding quantity later. For this purpose, trade365 offers you a new feature called Single Shipment per Order.

Setup

Customer

If a customer wants all its deliveries as single shipments only:

Open the relevant customer card.

On the Shipping FastTab, turn on the Single Shpt. per Order field.

Ship-to addresses

1. 

2. 

3. 

Field Description

Variant Code Fill in this field if you want to store an MSRP for a variant only. If you leave this field blank, the price will

be used for all variants of the item.

Currency Code Specify a currency for the list price.

Note

The list price will only be used if the currency code stored for the customer is identical to the code

specified for the MRSP.

Sales UOM

Code

Specify the unit of measure for which you want to state an MRSP. 

You can enter list prices for different packaging units by filling in a new line per unit that you want to

use.

Starting Date Specify the date from which the price will be valid.

Ending Date Specify the date until which the MSRP will be valid.

If you turned on automatic price replacement in setup, this field is filled in automatically with the last

date before the starting date of the new price.

Price Incl. VAT Enter the suggested retail price including VAT.

1. 

2. 

1. 

2. 
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If you’ve turned on the Single Shpt. Per Order toggle on a customer card, the setting will apply to all shipments to this customer,

regardless of the ship-to address. To block follow-on shipments to a specified address only:

Open the relevant customer card.

On the ribbon, choose Customer > Ship-to Addresses and select an address. Alternatively, use the lookup on the Ship-to Code field.

On the Shipping FastTab, turn on the Single Shpt. per Order toggle.

Workflow

Quantity shipped

When you create orders for a customer for whom the Single Shpt. per Order toggle is turned on, the setting is copied

automatically from the customer master to the new documents. You can, however, turn off the toggle there to allow for

exceptions to the rule.

When you post a sales order, the system then lowers the value in the Quantity field on sales lines where the amount to ship or

invoice is different from what you entered as the total line quantity before it sets the order to Invoiced. The quantity is also

reduced when you use the feature during standard warehouse and picking processes.

The original amount can still be viewed on the Lost Revenue page, in the Old Quantity field. Opened via the Tell Me function, this

page has been added for the purpose of analyzing transport capabilities.

An order shipped in a single run isn’t deleted after you post the invoice for it. To delete the order, you must run the standard

Delete Invoiced Sales Orders function (which you can find on the Sales Orders page).

The Completely Shipped Only and Single Shpt. per Order options exclude each other. For full deliveries, the ordered quantity needs

to match the quantity that needs to be shipped.

You cannot use the Single Shpt. per Order and Drop Shipment options at the same time. If you do, you see a message that both are

selected for the line and the single shipment feature is turned off.

Advanced warehouse management

If you want to make the feature part of an advanced warehouse configuration (which includes the Require Ship or and Require

Ship Require Pick settings), you must create an entry in the job queue so that the quantity that was originally filled in on an

order is reduced to the quantity delivered with the single shipment.

Choose the Search icon, enter Job Queue Entries, and then choose the related link.

On the ribbon, choose New.

In the Object Type to Run field, select Codeunit. In the Object ID to Run field, choose 5157136 – KVSTRDReduceSingleShptOrderQty .

On the Recurrence FastTab, specify how often the entry should be run.

For more details, see Use Job Queues to Schedule Tasks - Business Central | Microsoft Learn.

Lost revenue

The Lost Revenue report shows the revenue that was lost because a sales line was marked for single shipment.

It shows the quantity ordered and the quantity shipped, as well as the original and actual sales amount. To see the document

related to a line, select the line and choose Posted Document on the ribbon.

FULLY SHIPPED ORDERS

In the standard app, you can specify that items required for an order can only be picked after all of them have become available

for delivery. Turning on the relevant toggle on a customer card will affect all orders that you want to ship to this customer.

1. 

2. 

3. 

Note

Note

1. 

2. 

3. 

4. 
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With trade365, you can now also use the feature on individual lines of a sales order.

The trade365 setting only applies to sales orders that allow partial shipments. This means that you cannot specify different

requirements for sales orders that must be shipped in full.

You can specify by default that shipments to certain customers always need to be delivered in full. The same goes for items,

regardless of what customer they’re shipped to.

This default requirement is then copied to the sales orders that you create for a certain customer or item but can be changed

there if necessary. If you don’t specify a default requirement, you can set a requirement per line.

To mark an item for complete shipments only:

Choose the Search icon, enter Items Shipped in Full, and then choose the relevant link.

The fields on the header are used to filter existing lines. Fill them in as described in the following table.

Workflow

You can require that individual lines be delivered in full without having to turn on the feature that covers entire orders. For this

purpose, the Complete Shpt. Required field has been added to sales lines (unhide the field via Personalize if necessary).

If you’ve already set the requirement for a certain customer or customer group and item, the field will be selected automatically

on a sales line so that the line will only be considered for warehouse transactions if it can be delivered in full.

You can also turn the line field on or off manually unless the feature has been specifically turned on for a certain customer or

order.

Note

1. 

2. 

Field Description Note

Sales Type Specify whom the entry is valid for:

• Customer

• Customer Group

• All Customers

Example

You choose Customer and use the lookup in the Sales Code

field to select a customer for the sales line. The line setting

then applies to this customer but not to other customers.

Sales Code Depending on what you chose in the

Sales Type field, enter the code of a

customer or a customer group.

If you selected All Customers in the Sales Type field, the

line setting will apply to all customers in the system. As a

result, this field remains empty.

Ship-to Code Specify a ship-to address used by the

customer.

To select an address, the Sales Type field must be set to

Customer and a customer number must be entered in the

Sales Code field.

If you enter a ship-to address here, the line setting will

only apply to orders where you entered this customer and

ship-to address.

Item No. Enter the number of an item for which

the line must be shipped in full.

If all items should always be delivered in full, set up the

requirement on the customer card.

Variant Code If necessary, specify an item variant for

which a full shipment is needed.

For items with variants, you do not need to have the

setting apply to all variants.

If you leave this field blank, however, it will. Fill it in if you

want the requirement to apply to a specific variant only.
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The Complete Shpt. Required setting is also checked if you create shipments directly from a sales order.

PREPAYMENTS

Compress prepayments

If you want to compress prepayments on sales orders by default:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the Prepayment FastTab, turn on the Compress Prepayment toggle.

Invoice and credit memo details

The standard prepayment feature is used to bill part of or even the entire order value in advance. The amount that must be

prepaid can be arrived at in full (by compressing the payment) or per line.

However, compression will lose you information about the item, unit price, and unit of measure, as the standard app prints the

associated G/L account on the invoice document.

In trade365, you can add details to prepayment invoices and credit memos:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION FastTab, turn on the Details on Prepayment toggle.

On the relevant sales order, ensure that the Compress Prepayment field on the Prepayment tab isn’t selected.

Prepayment invoices posted and printed for customers then contain the same details as standard invoices.

VENDOR-MANAGED LOCATIONS

The VMI feature can be used to manage an external warehouse at a customer site.

As items stored at a customer location remain the property of the vendor until sold to end customers, they must still be allocated

to the relevant warehouses in Microsoft Dynamics 365 Business Central1.

Example

A site is initially stocked by transferring products, for example, from your main location (MAIN) to a customer-owned warehouse

(VMI).

The items are then consumed or sold there, with consumption reported to you through sales reports or new orders.

When you now create an order or invoice for these item entries and you filled in the VMI Location Code field on the relevant

customer card, you’re asked if you want to process a pick from the vendor-managed warehouse.

Choose Yes if you want to have the VMI location filled in on all sales lines. If you choose No, the customer’s default location is

entered instead.

You then post and bill the shipment (through a separate or combined invoice), which reduces the inventory level and goods value

at the specified site. At the same time, the feature lets you invoice item consumption to the customer and ensures the proper

handling of items that require lot or serial numbers.

When you post the shipment, you’re asked if you want to restock the VMI site. If you choose Yes, a new transfer order is created

by the system so that stock can be replenished without further manual or logistical intervention (as standard logistics procedures

can be followed).

Setup

Locations

Note

1. 

2. 

1. 

2. 

3. 
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To set up a vendor-managed location:

Choose the Search icon, enter Locations, and then choose the related link.

On the ribbon, choose New.

On the General FastTab, fill in the fields described in the following table.

If you leave the VMI Transfer-from Code field blank, items might be transferred from a site entered for the customer or from a

default location.

Customers

To assign a VMI location to a customer:

Open a customer card.

On the Shipping FastTab, enter the code of the warehouse in the VMI Location Code field.

Only one location can be assigned per customer unless you assign one to a specific shipping address:

Open a customer card.

On the ribbon, choose Related > Customer.

Enter the VMI warehouse in the VMI Location Code field there.

A VMI location assigned to a shipping address has a higher priority than any address specified on a customer card.

To see the VMI locations assigned to a customer:

Open the relevant customer card.

On the ribbon, choose Related > History > Item Inventory by VMI Location.

Transfer routes

To set up transfer routes for VMI locations:

Choose the Seach icon, enter Transfer Routes, and then choose the related link.

For more information, see the Microsoft Dynamics 365 Business Central1 Help.

Inventory Posting Setup

You also need to set up G/L accounts for the warehouse:

Choose the Search icon, enter Inventory Posting Setup, and then choose the related link.

For more information, see the Microsoft Dynamics 365 Business Central1 Help.

Items

1. 

2. 

3. 

Field Description

VMI Location (Sales) Turn on the toggle to mark the location for VMI.

VMI Transfer-from Code Specify the code of the location from where inventory will be transferred.

Note

1. 

2. 

1. 

2. 

3. 

Note

1. 

2. 

1. 

2. 

1. 

2. 
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To view the items stored in a VMI warehouse:

Open an item card.

On the ribbon, choose Related > Availability > Item by Location.

Turn on the relevant toggle.

You can now see all sites with VMI inventory on the Location List. In addition, you can set up inventory data as you do with

standard locations.

Customer-side workflow

When you fill in the Customer No. field on a sales order or invoice, the system checks if a VMI location has been assigned on the

relevant customer card. If one is available, you’re asked if you want to process a VMI pick.

If you choose Yes, the site is entered as the VMI location on the header of the document and in the Location field (outbound

warehouse) on all lines.

You see a message if you change the location in the Ship-to Code field. Also, like in the standard app, you can change a location on a

line manually.

When you enter an item, the system then checks its availability based on the inventory level at the specified warehouse. After

posting the shipment (from the order or the warehouse), the system also checks if at least one sales line to be delivered contains

the VMI location from the header. If so, you’re asked if you want to replenish the items consumed. Choose Yes to create a

transfer order for the VMI location with the shipped items entered on the transfer lines.

Additionally, when you create a transfer for a VMI location, the system checks if the location is assigned to one customer only. If

it isn’t, the entire process is cancelled with an error message.

If you want to create transfer orders, you must first set up transfer routes, as you’ll need the transfer-from codes that you set up for

these routes.

1. 

2. 

3. 

Note

Note
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The fields on the transfer order are sourced from the sales order as described in the following table.

REASONS FOR ARCHIVING

Sales documents can be archived for different reasons, which are included in the archive automatically.

Reasons for archiving quotes

Manual

Deletion

Printout

Quote to Order

Reasons for archiving (return) orders

Manual

Deletion

Printout

Posting

Reasons for archiving blanket orders

Manual

Deletion

Printout

PERIODIC BILLING

In the standard app, you can use the Combine Shipments checkbox to create an invoice covering multiple shipments. But to bill

customers in this way, you must manually limit the billing period based on posted shipment dates.

In trade365, on the other hand, you can use the Periodic Billing feature to bill customers through a variety of methods, such as

billing them in set intervals, with the last shipment of an order, or even immediately.

Field Description

Transfer-to Code Filled in with the VMI location on the transfer header and lines.

Quantity Filled in with the Qty. to Ship from the sales line (that is, the quantity just delivered) on the transfer

lines.

Transfer-from

Code

Determined in the following order:

1. SKU data is checked against the location code assigned to the VMI site. If a site is specified in the

Transfer-from Code field on the SKU card, it is copied to this field as the outbound location.

2. If no SKU-related location has been stored, this field is filled in with the site entered in the VMI

Transfer-from Code field.

3. If no code has been stored there either, the field is filled in with the VMI location assigned to the

customer.

If none of these checks yield a result, this field is filled in with the default location that is stored in the

system. 

If there is also no default location, no transfer line will be created. You will be notified of which transfer

lines could not be set up for the items shipped after you have completed the process.

If more than one order is created (because of differing transfer-from codes used for ordered items), you

see a message with the first and the last order number and the list of transfer orders is opened.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Periodic billing cannot be used in combination with the standard prepayment function. In this case, you must post invoices

manually.

Setup

You set up most of the periodic billing process on customer cards.

Combine Shipments (Period)

To combine invoice amounts for a certain period:

Open a customer card.

Fill in the fields as described in the following table.

Invoicing

Shipping

Shipments posted before the next billing date but within the period specified for periodic billing are then copied to a new invoice

when the function is run (see also Workflow).

The process is cancelled, however, if the next billing date hasn’t been reached.

Bill per Order (Period)

To set up this option, follow the instructions given under Combine Shipments (Period) but choose Per Order (Period) in the Billing

Type field.

During the billing run, all shipments made for an order are then included on a single invoice if shipped within the specified

billing period.

Bill per Order (on Last Shipment)

Like Bill per Order (Period), this option doesn’t cover multiple orders. However, an invoice is now being sent only after the order

has been delivered in full.

Invoicing

Shipping

Bill per Shipment

1. 

2. 

Field Description

Billing Type Choose Combine Shpts. (Period).

Billing

Frequency

Choose Periodic.

Billing Cycle

Code

Specify a billing interval, such as 2W (=2 weeks).

Next Billing

Date

Typically, this field is filled in automatically. Only when you set up the customer for the first time does it

need to be filled in manually so that the system can calculate the initial billing interval.

Field Description

Combine Shipments Turn on this toggle.

Field Description

Billing Type Choose Bill per Order (on Last Shpt.).

Billing Frequency Choose Once.

Field Description

Combine Shipments Turn on the toggle.
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This option corresponds to the use of the Ship and Invoice function, with an invoice created for each shipment that you manually

post for the customer.

Invoicing

Shipping

Workflow

To run periodic billing:

Choose the Search icon, enter Periodic Billing, and then choose the related link.

On the ribbon, choose Run Periodic Billing to create all invoices for today.

You can then set filters on the entries as described in the following table.

Options

Customer and Sales Order

The filters set on these tabs will be used during a billing run, for example, to invoice only orders placed by a certain customer or

those that don’t involve prepayments. After you’ve set the filters you need, choose OK to run periodic billing.

On the Periodic Billing page, you can see the documents created through the function, whereby lines in green indicate posted

and lines in yellow unposted invoices. Lines shown in red mark invoices that cannot be posted because of an error that occurred

during processing. Errors must be corrected manually, which includes posting the invoice by hand thereafter.

Field Description

Billing Type Choose Per Shpt.

Billing Frequency Choose Once.

Field Description

Combine Shipments Turn on the toggle.

1. 

2. 

3. 

Field Description

Posting Date Specify a posting date for the invoices you want to create.

Replace Posting

Date

Turn on the toggle if you want to replace the posting date on the invoices with the posting date

entered on this FastTab.

Replace Document

Date

Turn on the toggle if you want to replace the document date on the invoices with the posting date

entered on this FastTab.

Calculate Inv.

Discount

Select if you want the customer’s invoice discount calculated on the created documents.

Billing Date The date shown here will be checked against the dates on all periodically issued combined invoices

or invoices created per order. If the date in this field is equal to or later than the next billing date on

a customer card, no invoices will be created for this customer.

Update Next Cust.

Billing Date

With the toggle turned on, the next billing date is filled in for all customers within the filters

according to specified intervals— regardless of whether invoices will be created for them during this

billing run.

Post Invoice Turn on the toggle if you want the created invoices to be posted immediately.

Print Posted Invoice Turn on the toggle if you want the posted invoices to be printed on the default printer set in

Windows.

Shipment Date

Filter

Specify the period in which the system should look for posted shipments.
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You can open both posted and unposted invoices from the page. To see the postings that were cancelled with an error message,

choose Related > Show Logs on the ribbon. You can also choose Actions > Show Errors to view all error messages.

Additionally, you can choose Actions > Delete Entries Older than 30 Days to clear up log space.

To replace or reset the next billing date:

Open a customer card.

Choose Related > Change Periodic Customer Billing.

Choose Fixed Date in the Type field and fill in the New Billing Date field. Alternatively, choose Date of Last Invoice to have the

system calculate a date based on the specified billing interval and the latest invoice sent to the customer.

On the Customer FastTab, you can limit the number of customers for whom periodic billing should be used. The function,

however, creates invoices that aren’t posted directly from sales orders. This means that orders invoiced by using this function

aren’t deleted automatically when all items and services have been billed for them. They’ll only show as fully invoiced on the

Periodic Billing page.

To delete them from the system, you need to run the Delete Invoiced Sales Orders function on a regular basis.

ATTACH INVOICES TO REMINDERS

An end customer will have an easier time paying an outstanding amount if a copy of the invoice is attached when you send them

a reminder. This avoids requests for documents that might no longer be available.

In trade365, you can attach an invoice to a reminder in the form of a printout or a PDF (if the reminder is delivered via email).

Reminders and attachments are printed depending on how you set them up on the printer selection page. This means that when you

choose Save as PDF on the Print Preview screen, the reminder will be created as a PDF file, but the attachments will end up on the

default printer specified for the relevant user. This doesn’t happen if you use the in-program email option to attach the invoice

document.

SET FREIGHT CHARGES

In trade365, freight charges can be entered on sales documents in multiple ways. To activate the feature:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, fill in the fields as described in the following table.

1. 

2. 

3. 

Note

1. 

2. 

Field Options Description

Auto Add Freight

Charges on Release

- Never

- Sales Quote /

Order 

- Sales Order

Only

Choose if you want the system to add charges on quotes or orders

automatically.

Notify of Missing

Freight Charges

- Never

- Always

Choose if you want to receive a message if freight charges were

supposed to be added but could not be determined.

Auto Close Freight

Charges

Turn on this toggle if you want freight charge lines to expire

automatically. The lines are then ignored, if necessary, when you fill in

the same charges but a new starting date.
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The key fields for calculating freight costs are:

Shipment Method Code

Shipping Agent Code

Shipping Agent Service Code

Country/Region Code

Post Code

Weight

Goods Value (Carriage Paid Limit)

Shipment/Delivery Date (from document header)

• 

• 

• 

• 

• 

• 

• 

• 
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Setup

To set up freight charges:

Choose the Search icon, enter Freight Charges, and then choose the related link.

Choose New to open a blank freight charge card.

On the General FastTab, fill in the fields as described in the following table.

1. 

2. 

3. 

Field Options Description

Code Specify a code.

The code must be unique and meaningful. It is assigned to customers at a

later stage.

Description Specify a description for the charges.

Calculation Base None

Weight

Goods Value

Goods Weight and

Value

Select a base for having charges calculated automatically.

Choosing None while the Auto Add Freight Charges on Release toggle in setup

is turned on will create cost lines without references to certain quotes or

orders (if set up in this way in the customer master).

Choosing one of the other options will see charges determined based on the

relevant document lines.

Note

To be able to choose the Weight option, you already must have set up all

necessary item information in the system.

Starting Date Specify when you want the charges on the card to become available.

Ending Date Specify until when the costs should be valid.

Starting / 

Ending Date per

Line

Yes

No

Choose if you want to ignore the Starting and Ending Date fields on the

header and specify the validity of the charges per line.

Currency Code Select the currency that will be used for the freight charges.

Note

The code entered on this page must match the code stored with the relevant

customer.

Status New

Active

In Progress

Inactive

Specify the status of the freight charges. All cards are initially marked as New.

Only charges set to Active can be added to a sales document automatically.

In Processing is used to edit existing freight charges.

Inactive means that the charges aren’t used anymore. You can use a filter to

hide them from view.
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After filling in the fields on the header, you can break down each charge on the lines and, if necessary, specify limits for its

application:
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Field Options Description

Shipment Method

Code

Choose the shipping method that you want the freight charge line to be used

for.

If you leave this field blank, the line will apply to all methods.

Shipping Agent

Code

Here you can select a shipping agent.

Shipping Agent

Service Code

Here you can choose the code of a shipping service. You can use this field to set

up cost groups, such as for standard or express delivery. 

You must fill in this field if you entered a shipping agent.

Country/Region

Code

Specify the country that the cost line should be used for. 

During the automatic calculation of freight charges, the code refers to the

country that is part of the ship-to address.

This field must be filled in.

Post Code Filter Based on the selected country, you can set a filter here to specify one or more

post codes that the line should be valid for. You can use standard filters for this

purpose.

The post codes are then checked against the ship-to address that you specify.

Type G/L Account

Item

Resource

Charge (Item)

Specify the line type that will be used when the charges are inserted into a

document.

Choose G/L Account or Resource to have the charges posted to a G/L account

or a resource.

If you choose Item, you can only use items without inventory management.

With the Charge (Item) option, you can have a freight charge line added to a

document by the system. However, you need to assign the line within the

document manually.

No. Depending on what option you selected in the Type field, enter the number of

an account, an item, a resource, or a surcharge or deduction. The value is then

copied to the related document.

Variant Code You can only fill in this field if you selected type Item and entered an item with

variants in the No. field.

By filling in this field, the same item can, for example, be shipped by different

companies while you can continue to gather data on the shipments for analysis.

Description Initially shows the description of the data record selected in the Type field. You

can change the description manually, however.

The system later copies the content of this field to the associated document

line.

Description 2 Initially shows the description of the data record selected in the Type field. You

can change the description manually, however.

The system later copies the content of this field to the associated document

line.
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You might also need to fill in one or more of the following fields, depending on what options you chose on the header:

What you enter on a sales quote or order then determines which cost line will be used for calculation.

Field Options Description

Quantity Specify the quantity that will be inserted on the sales line (typically, this means

a quantity of 1).

If you want to assign another type of charge, possibly based on the value or

weight of the goods and a factor, you can enter 2 here, for example, to specify

that the charges should appear twice on a document.

Unit of Measure

Code

Filled in automatically with the base unit of measure specified for the chosen

account, resource, or item.

If necessary, you can specify another unit in this field, although the value you

enter must have been set up beforehand (as a resource unit or item unit of

measure, for example).

The system later copies the unit to the relevant document line during freight

charge calculation.

Unit Price Specify the price per freight charge unit.

Note

If the customer is a B2B trading partner, the unit price should be a net amount.

You then also need a separate freight cost list for any B2C transaction (that is,

for any customer for which you selected the Prices including VAT toggle on the

customer card).

Cost Price (LCY) Here you can enter, in local currency, a cost value so that you can later

determine actual costs on documents.

Field Options Description

Max. Weight …Weight or Goods

Weight and Value

(see Calculation Base

on header)

Specify the weight up to which the cost line should be valid. By specifying

more than one limit on multiple lines, you can assign costs by weight class.

Max. Goods

Value

…Weight or Goods

Weight and Value

(see Calculation Base

on header)

Specify the goods value up to which the cost line should be valid.

Do not create lines with higher values if you want shipments to be delivered

free of charge below a certain threshold.

Starting Date …Starting / Ending

Date per Line

(see toggle on

header)

Specify the date from which you want the line to be valid.

Note

If Auto Close Freight Charges is turned on in setup and you create another

line with the same values as before, the ending date on the existing line is

set automatically to one day before the new starting date.

Ending Date …Starting / Ending

Date per Line

(see toggle on

header)

Specify when the cost line is no longer valid.
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Assign costs to a customer or ship-to address

To be able to use freight charges on sales documents, you need to assign them to customers or their ship-to addresses:

Open a customer card. 

On the Shipping FastTab, choose a code in the Freight Charge Code field.

Assignments on customer cards are used for all ship-to addresses unless you enter another code for a specific customer address,

for example, because you need to deliver items to a location abroad. To specify charges for an individual address:

Open a customer card.

Use the lookup on the Ship-to Code field.

In the Freight Charge Code field, assign a code for freight charges.

However, the assignment will only take effect if the selected ship-to address is subsequently entered on a document.

Workflow

After being specified, the freight charge code is copied from a customer or, if available, from one of the customer’s ship-to

addresses to a sales quote or order. If necessary, you can go to the Shipping FastTab to change the code manually for a certain

transaction.

After filling in the document lines, you can run the Add Freight Charges action to have freight costs calculated automatically. If

freight charges apply to the document, a freight charge line is inserted. If you’ve turned on the Notify of Missing Freight Charges

in setup, you also see a message if costs cannot be calculated.

You don’t need to run this function if you’ve activated Auto Add Freight Charges on Release in setup. In this case, a line is added

each time another document is released. If you reopen a document, the line is deleted. You can recalculate and reinsert the line

when you release the document again.

LONG-TERM SUPPLIER DECLARATIONS

When you deliver orders throughout the European Union, you can prepare a long-term supplier declaration that certifies the

origin of the items you ship. The purpose of this is to receive a kind of preferential tariff treatment when exporting goods.

In trade365, you can create a declaration based on the items you’ve sold to your customers.

Setup

Before you can create a supplier declaration, you need to set up the feature.

Purchases & Payables Setup

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION FastTab, fill in the European Origin Country field with a text that will be shown on printed declaration

documents.

Countries/Regions

Choose the Search icon, enter Countries/Regions, and then choose the related link.

In the European Union field, select the countries that are part of the EU.

For all countries marked, the text you entered in the European Origin Country field in Purchases & Payables Setup is then

printed on supplier declarations.

Preferential countries

As the rules for the preferential treatment of items vary based on country, they need to be specified for each item individually.

Open an item card.

On the ribbon, choose Related > Item > Preferential Countries.

Select the countries where preferential treatment applies.

1. 

2. 

1. 

2. 

3. 

1. 

2. 

1. 

2. 

1. 

2. 

3. 
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Afterwards, these countries will be listed on the relevant supplier declarations.

Create a declaration

You use the Long-Term Supplier Declaration report to check what items have been supplied to a certain customer during a

specified period and create the necessary document following the check. To create a declaration document:

Choose the Search icon, enter Long-Term Supplier Declaration, and then choose the related link.

Fill in the FastTabs as described below.

Languages

Specify the language in which the supplier declaration should be printed.

Customer

Shipping Period

On this FastTab, you can set a filter on the posting period, to limit the number of sales entries to those of items shipped to a

certain customer between the From Date and To Date. These items are then listed on the declaration.

Validity Period

Here you can specify the validity of the declaration by filling in the Valid From and Valid To fields. Both are later printed on the

document.

Cumulation

Certain items might be subject to cumulation, for example, because some of their components were made in Morocco, but the

finished products originate from within the EU.

When you’ve filled in the request page of the Long-Term Supplier Declaration report, you can use the Preview & Close function to

see the declaration you’re about to create (or you can choose Send to or Print).

However, if you also turned on the Cumulation toggle for the report, you’ll first get to the Cumulated Items page, where you can

use a lookup on the Item No. fields to choose one or more items that require a note on their cumulation and fill in the necessary

originating countries.

If a customer purchased items with cumulation in the period specified on the report, they’re then marked accordingly, and the

cumulation notes are printed on the declaration.

If the Cumulation toggle is turned off, the Cumulated Items page is skipped.

PROFILE QUESTIONNAIRES

When you classify contacts, the profile questionnaire fields and functions that are part of Microsoft Dynamics 365 Business

Central1 might not be enough. As an example, if the number of potential answers to a question is high—because you’ve asked for

a specific year or the exact number of staff members instead of a range—usability might no longer be a given.

In trade365, CRM profiles have been extended so that you can not only select an answer but also record values along with it.

Additionally, the answers that were selected can be stored in a log so that you can track what for an answer was given and when.

You can look up the current answer value on the contact lines set up for a questionnaire.

Additionally, two fields have been added for creating questionnaires. One of them is called Answer Type and specifies the kind of

user input you want to see. So far, the only possible answers have been Yes or No. In trade365, you can also enter numbers (with

or without decimal places) or a body of text.

However, entering a value of, for example, 3.5 is not yet meaningful itself. But with the help of the new Answer UOM Code

column, you can specify what the number stands for, such as m³. This unit can then be used to preconfigure an answer line. You

can select only units that are already in the system.

1. 

2. 

Field Description

Customer No. Enter the number of the customer for whom you want to create the declaration.

Contact No. Specify the contact person that will be printed on the declaration.
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Otherwise, the profile questionnaire works as in the standard app. For Yes/No answers, you can simply select the corresponding

field.

For numbers or a text, you must choose the relevant option and then fill in the Answer field. If you select the Set field on this

kind of line, you see a message that a text or number must be entered instead. You can view the responses in a subsection on

contact cards.

When you create a segment for contacts, you can also filter the values you entered in this way. Just choose an address for a

profile questionnaire and enter the text you’re looking for on a line.

Archive profile answers

If profile answers change for a contact, you can archive the old data:

Open a contact card.

On the ribbon, choose Contact > Profiles.

Choose Related > Archive Answers.

When archiving, the work date and a version number is entered.

To see the most recently archived answers:

Open a contact card.

On the ribbon, choose Contact > Profiles.

Choose Related > Show Answers.

You can then use the Assist button next to the Version No. field to access all versions of the questionnaire.

CREATE SEGMENTS WITH REFERENCES TO SERVICE DATA

Segments are used to create address lists or add and remove contacts in the marketing area. Besides standard criteria, such as

contact, profile, and value entries, you can now also include service information in contact segments.

You can then use this information to create a list of customers who possess service items for which the warranty is about to

expire so you have an easier time offering them an extension or a new contract.

Workflow

Open a new segment.

On the ribbon, choose Add Contacts.

Turn on the relevant toggle (Include Contacts or Include Serv. Contracts) on the Options FastTab to gain access to service item or

contract data.

If you want to create segments based on contacts, you need to turn on the Include Contacts option here.

For the Include Serv. Items option, only contacts of the Company type will be added (that is, customer contacts). The Expand

Company option, on the other hand, works only in combination with Consider Contacts.

Turning on the Consider Serv. Contracts toggle will list all contacts used in the Contact No. field on a service contract header.

These can be of type Person or Company.
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CUSTOMER GROUPS

You can use the Customer Group field to specify a trading partner as an A, B, or C customer:

Choose the Search icon, enter Customer Groups, and then choose the related link.

On the ribbon, choose New.

Fill in the Code and Description field.

Optionally, you can run the Completely Shipped Items Only function to specify items that can only be delivered to customers in this

group as part of a single shipment.

The groups are then stored on customer cards, in the Customer Group field, and you can use them to filter reports.

You can also use customer groups as a filter in the warehouse and inventory area.

CUSTOMER GROUP DIMENSIONS

In Microsoft Dynamics 365 Business Central1, you can specify customer group dimensions in Sales & Receivables Setup, or, more

specifically, the codes that should be used for them. However, the dimensions aren’t shown on the pages that list customer, item,

or value entries.

In trade365, a posted dimension value will be displayed directly for an entry to facilitate ad-hoc analyses.

USE RECURRING SALES LINES FOR ALL CUSTOMERS

With standard functionality, you need to assign recurring sales lines to every individual customer. In trade365, by contrast, you

can make them accessible to all customers immediately:

Choose the Search icon, enter Recurring Sales Lines, and then choose the related link.

On the ribbon, choose Manage > Edit to get to the Standard Sales Lines Card for creating recurring sales lines.

Select the For All Customers field on the header.

GET SHIPMENT LINES

When you run the Get Shipment Lines function from a sales invoice or use the combined shipments feature, only the ship-to

number is copied to the lines as a reference. However, as this is not enough in many cases, you can now have the following field

contents copied over as well:

Shipment Date

Order No.

Order Date

Your Reference

External Document No.

To turn on this feature:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the relevant toggles in the Get Shipment Lines section.

CREDIT LIMITS

Standard functionality will warn you that a credit limit is being exceeded when you reach the limit on a sales document. To

specify when this warning should appear:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, select an option in the Credit Warning Frequency field.

a. Choose On Release if you want the message to appear only after releasing a document.

b. Choose Per Line if you want to be notified when you fill in a new line.
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RETURN REASON REQUIRED

To prevent sales return orders from being processed without knowing why they were created in the first place:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the trade365 FastTab, turn on the Return Reason Required toggle.

This way, a message is shown when a user tries to release this kind of order but gives no reason for the return.

SCRAPPED ITEMS

Sometimes, credit memos might be issued for items that were disposed of by customers instead of being returned. For the app to

be able to handle this kind of scenario, you need to make a few settings in the system.

Setup

Location

Set up a scrap location without configuring the site for warehouse or inventory processes.

Return reasons

Choose the Search icon, enter Return Reasons, and then choose the related link.

On the ribbon, choose New and specify a code and a description.

Select the Scrap Items checkbox on the line. The No Valuation field is then selected automatically.

Specify in the Default Location Code field the site you’ve set up earlier.

Exit the page.

Workflow

To process returns where items aren’t sent back to you but are disposed of by the customer:

Create a return order for the items you’ve sold. We recommend that you use the Get Posted Document Lines to Reverse function

for this.

Assign the return reason code used for scrap to the affected order lines. The system then copies the scrap location to each line and

sets the Unit Price field on it to zero.

If items are tracked, their tracking codes must be deleted from the document lines before you choose a return reason. Following your

choice, the relevant serial or lot numbers must be re-entered manually.

Afterward, you can release and post the sales return order, to have the system create item ledger entries for it.

Turning on the Return Reason Required toggle in Sales & Receivables Setup, on the trade365 FastTab, prevents the release of return

orders without giving a reason for why the items were returned.

MINIMUM ORDER VALUES

Wholesale businesses typically charge fees when orders fall below a minimum value. The Minimum Order Value feature provides

a way for you to mirror these situations in the system.

Setup

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the trade365 FastTab, turn on the Enable Minimum Order Value toggle.
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Select in the Order Minimum For field if the value threshold that you intend to set should apply to all lines of a sales document or

only to those that an (inventory) item is entered on.

Exit the page.

Open the Minimum Sales Order Values window by using the general search function or by running the Minimum Order Values

function in Sales & Receivables Setup, on a customer card, or on the customer group list.

If necessary, set filters on the header, and then fill in the fields on the lines as described in the following table.

It is not recommended to set the "Check Pos. Nos. on Sales Lines" field to "Check" and the "Enable Minimum Order Value" field to

"Yes". The minimum order value is only calculated when a sales order is released, which prevents the manual assignment of an item

number before release.

3. 

4. 

5. 

6. 

Note

Field Description

Sales Order Type If required, specify the type of sales orders that the order minimum should apply to.

Sales Type Select if the order minimum should apply to a certain customer, to a group of customers, or to all

of them.

Sales Code Depending on the option you select in the Sales Type field, you can fill in a customer or a

customer group here.

The field is grayed out if the value threshold applies to all customers set up in the system.

Currency Code If required, specify the exact currency the value threshold should apply to.

Starting Date Specify from when the minimum will be used.

Ending Date Specify until when the minimum will be used.

Minimum Value Enter the minimum value for customer orders of goods or services.

Below this value, a fee will be added when releasing quote, order, or invoice lines.

Billing Type Specify if the minimum order fee added to sales document lines should be determined based on a

G/L account, an item, a resource, or an item charge.

Note

Item charges must be added manually to document lines.

Billing No. Depending on the option you select in the Type field, enter a G/L account, an item, a resource, or

an item charge here.

Billing Description Shows the description of the G/L account, item, resource, or item charge entered in the Bill For –

No. field.

Billing Description 2 Shows the additional description of the G/L account, item, resource, or item charge entered in the

Bill For – No. field.

Billing Unit of Measure

Code

Shows the unit of measure used for the G/L account, item, resource, or item charge entered in the

Bill For – No. field.

Fee Type Choose whether the fee should be added in the form of a percentage calculated based on the total

order value or a fixed amount.

Fee Amount Fill in this field if the Fee Type is set to Amount.

Fee % Fill in this field if the Fee Type is set to Percentage.
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Workflow

When you now set up and release a sales document on which the order value falls below the minimum you’ve set, a line with the

specified fees is added to the document automatically.

Deactivation

You can restrict the use of minimum order values on multiple pages. You can turn on or select the No Order Minimum field on

the Sales Order Types page (such as for sample orders).

a customer card (on the General FastTab). 

the customer group list.

If you want to deactivate minimum value checks in general, you need to turn off the Enable Order Minimum toggle in Sales &

Receivables Setup again.

USING DELIVERY DATES IN CALENDAR WEEKS

In retail, goods are often sold for specific calendar weeks. Within the Microsoft Dynamics 365 Business Central1 standard,

calendar weeks can be entered using a date formula (e.g. M5 = Wednesday week 5).

In KUMAVISION trade365, it is possible to enter the calendar weeks in the fields provided for delivery date, requested delivery

date and confirmed delivery date. The calendar week for the delivery date is printed on the offer and the order confirmation.

Setup

To be able to use this functional extension, first open the "Accounts receivable and sales setup" and activate the "Show delivery

dates in calendar weeks" switch on the "KUMAVISION trade365" information tab.

If the switch is activated, the switch with the same name appears on the "Delivery" information tab on the customer card and can

be activated there.

The "Calendar week" area on the "Delivery and billing" info tab is only visible in sales documents for customers who have activated

this switch. In this case, the "Show delivery dates in calendar weeks" switch is activated by default when the sales document is

created and can be deactivated manually both for the document (on the "Delivery and billing" info tab) and for rows.

In addition, the following fields appear on the "Delivery and billing" info tab and in the rows: Delivery date (calendar week),

Requested delivery date (calendar week) and Confirmed delivery date (calendar week).

Workflow

The calendar weeks can be entered in the document in the following formats:

CW/YYYY 

YYYY/CW 

CWYYYY 

CW 

CWYYY 

CW/YYY

The original date fields are calculated on the first day of the calendar week entered.

• 

• 

• 
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Additional time requirements such as transportation or warehouse throughput times can be defined in the system. These times are

included in the calculation of delivery dates by default. As a result, the planned delivery dates can be postponed, which can lead to a

calendar week being displayed that is different from the one promised.

As in the sales order, the delivery dates can also be entered in calendar weeks in the blanket order.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

1. 
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Purchasing

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s procurement department.

BUY-FROM ADDRESSES ON ORDER ENTRY

To minimize errors during data entry and streamline the entire process, buy-from addresses can be shown automatically when a

vendor is entered for a purchase transaction.

To turn on the automatic display of buy-from addresses:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Show Buy-from Addresses on Input.

When you later fill in the Vendor No. field on a purchase document, the system will check if a buy-from address was stored for

the specified vendor. 

If it was, you’ll see a list from which you can select the correct address for the transaction. If none of the listed addresses are

suitable, choose Cancel to exit the page (and discard any changes).

You can only choose a buy-from address after filling in the Vendor No. field on the relevant purchase header. If you create the

document through a vendor card function, the selection window will not be shown.

CREATE ITEM REFERENCES ON PURCHASE LINES

Purchase transactions in the trade industries typically involve two sets of item numbers, yours and those provided by your

supplier.

You can use the Item Reference No. field when you create an order to specify that the number assigned to an item is sourced

from a vendor, but only if it has already been stored in the item or vendor master. In trade365, however, you can also set up

references on item lines during order entry.

Setup

To be able to use this feature:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Auto Add Item References toggle.

Workflow

Purchase lines include the following fields:

If a reference for a certain vendor-item number combination already exists, it will be entered in the Item Reference No. field on a

line when you’ve filled in and exited the Item No. field there.

Else, you can create a new reference when filling in the line. You can view and edit references on the Item References page,

which is available via the general search.

1. 

2. 

Note

1. 
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Type No. Item Reference

No.

Unit of Measure

Code

Variant Code

Item (number as stored

in the system)

(number as

specified by

vendor)

(unit used when

buying the item)

(filled in with a code for

items that you set up

variants for)
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DROP SHIPMENTS AND SPECIAL ORDERS

In Microsoft Dynamics 365 Business Central1, purchase orders are intrinsically linked to the drop shipments they’re created for.

This means that when you’ve created a purchase order for a shipment, you can no longer change quantities, units, or item

numbers on the document.

With offerings changing daily and lead times at a minimum, this might create headaches for trading companies, for example,

when items that they ordered aren’t available anymore, so suppliers must ship substitutes. In trade365, you can modify or delete

purchase orders created for drop shipments in the following ways:

Replace items (item A1 ordered, but all that the manufacturer can provide you with is item A2) and units of measure.

Change quantities (5 pieces of item A1 ordered, but the product is only available in packages of 3 or 6).

Delete links (drop shipment created, but the manufacturer needs to ship the goods to your company instead).

Post sales invoices before billing purchases.

Have the system create purchase orders for drop shipments.

Replace or change an item, quantity, or unit

To replace an item on a drop shipment purchase order or change the quantity or unit code on the document:

Open the order and make the changes on the relevant line.

After you entered another item number, adjusted the quantity, or edited the unit code, you’re asked if you want to update the

related sales order. Choose Yes.

Throughout this process, the link between the sales and the purchase line will remain intact. When the order is deleted, however,

the link to the sales line will be removed so that the sales document can be treated as a standard order, or a new purchase order

can be created for the drop shipment.

Delete drop shipment or special order link from purchase

To delete the link between a purchase order and a drop shipment or special order created for a sales line:

Open the relevant purchase order.

Select a line and choose Line > Order > Drop Shipment or Special Order.

On the ribbon, choose Delete Drop Shpt. (or Special Order) Link.

When you run either function, the link to the line currently selected in the order is deleted. Both the sales and the purchase line

can then be processed further like any other line in the system.

Create drop shipments automatically

In trade365, purchases for drop shipments can also be created automatically during the release of a sales order.

For this purpose, you only need to select the vendors or purchase orders for which you want drop shipments to be created by the

system:

Open a vendor card.

On the General FastTab, turn on the Auto Create Drop Shpt. toggle. 

Afterward, fill in the Vendor No. field on an item card, on the Purchase FastTab.

If you now enter the item on a sales order classified as a drop shipment, a purchase order is created during document release.

This function cannot be used for vendors stored in the item vendor catalog.
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Allow drop shipment billing prior to sales

If the purchase order created for a drop shipment needs to be billed before the sales order:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Can Bill PO Drop Shpt. Before Sales toggle.

REASONS FOR ARCHIVING

Purchase documents can be archived for different reasons, which are included in the archive automatically.

Reasons for archiving quotes

Manual

Deletion

Printout

Quote to Order

Reasons for archiving (return) orders

Manual

Deletion

Printout

Posting

Reasons for archiving blanket orders

Manual

Deletion

Printout

CLEARANCE

Clearance items are items that you decided not to reorder or that your supplier has stopped providing. Your procurement

department will be notified that the item—or variant—in question might no longer be available when they try to enter it on a new

purchase order. To select an item or variant for clearance:

Open an item card.

On the Item FastTab, select the Clearance field.

Alternatively, select Clearance for each individual variant that will no longer be restocked.

If an item is selected for Clearance, its variants will no longer be restocked either, regardless of whether you’ve marked some of

them as well.

The quote or order can still be processed, as the clearance message is only that: a message. The planned receipt of the item is

shown in the availability overview.

MINIMUM QUANTITIES AND INVENTORY MULTIPLES

If you’re working with requisition worksheets, you can enter in the item master or as SKU data the quantities in which products

can be ordered.

However, the standard app isn’t equipped to deal with situations in which you procure items from different vendors whose

requirements for minimum order size and quantities vary. And when you enter items on an order manually, you will not be

notified if what you specify is below the minimum threshold.
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In trade365, you can use a function for either. When working with this feature, the minimum quantity must be a multiple of the

order size used for purchases. If you also use inventory multiples, they need to correspond to minimum order sizes.

Minimum quantities

Minimum quantities are used in the item-vendor catalog to specify starting at which order size you can procure an item from a

supplier.

In contrast to what you enter in the Minimum Order Quantity field, how you fill in the Minimum Quantity field typically doesn’t

affect the values on requisition worksheets. Worksheets are checked for minimum quantities, however, if you fill in the Quantity

or Vendor No. field on them manually.

The system then issues a warning but will not cancel the process so that, if necessary, you can go ahead and order the lower

quantity without receiving any further notifications.

The check for minimum quantities is also performed when you create orders manually and one of the following fields is filled in:

Quantity

Variant Code (even if you fill in an item with a variant requirement on the relevant matrix).

Item Reference No.

Unit of Measure Code

Additionally, the quantity is checked when you create a purchase order for a blanket agreement.

Inventory multiples

The number of items purchased as one package can be found in the Inventory Multiple fields on item cards but for each vendor

individually. The value in this field doesn’t have an impact on requisition worksheets, where order sizes are determined based on

the standard Minimum Order Quantity field.

Overall, the multiples are used in purchasing in the same way as in warehouse and inventory management.

If you change the vendor on a requisition or a planning worksheet and the new quantity on a line doesn’t match the entered

inventory multiple, you’re asked if you want to round the entered quantity up or down.

When a purchase order is later created for this worksheet line, we recommend that the Planning Flexibility field be set to None

so the system doesn’t suggest a change to the purchase order following line recalculation.

When you then fill in an order manually or change the quantity on a worksheet line, you’re asked if you want to round that

quantity up or down to the closest inventory multiple. This way, you ensure that only multiples of what you’ve got in stock are

reordered.

When you enter an item with a specified inventory multiple on a blanket order, you’re notified if the quantity doesn’t match. The

check is performed again as you fill in the Qty. to Ship field for call-off from a blanket order.

If this quantity isn’t a multiple of the inventory size, the system will cancel the entire process and the purchase order cannot be

created. But if you fill in the Qty. to Ship manually, you’re again asked if you want to round the value up or down.

VOLUME AND WEIGHT PER VENDOR: REQUISITION AND PLANNING

To facilitate planning, you can have the system show for each vendor the total volume and weight entered on a certain requisition

or planning worksheet.

Open a requisition or planning worksheet.

Select a line to specify the vendor that you want to calculate values for.

On the ribbon, choose Volume / Weight (Vendor) to see the volume and net weight of the goods that are to be ordered from a

certain vendor on all worksheet lines.
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ADHERENCE TO DELIVERY DATES

You can analyze a certain vendor’s delivery schedule adherence based on the Requested, Promised, or Expected Receipt Date. To

select the date used as a basis for these statistics:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, select the relevant option in the Schedule Adherence Date field.

To see the statistics:

Open a vendor card.

On the ribbon, choose Vendor > Delivery Sched. Adherence.

Via the Deviation From, Deviation To, and Deviation Period Type fields, you can specify a period during which deliveries should be

counted as received in (or on) time. All receipts not within the period specified are shown in the Before or After column on the

lines.

REQUISITION WORKSHEETS WITHOUT DATE REFERENCES

In the standard app, items on requisition worksheets are ordered at the most opportune time—typically as late as possible—so

that when you, for example, postpone ordering an item, the system might suggest you cancel the original order and create a new

one with the correct date. But for wholesale and retail companies, this strict adherence to delivery dates can be more of a

hindrance than a help.

For customers who cannot change orders once they’ve been placed with a supplier and for whom it’s enough to have purchase

orders suggested and, after posting them, view their quantities without needing to see changes in outbound and inbound delivery

data, a new function called Simplified Plan Calculation was added to the ribbon on requisition worksheets in trade365.

Simplified quantity calculation

For simplified plan calculation, the required and the supplied quantities are each totaled, with the source values of both being

the same as on standard requisition worksheets, that is, Minimum Inventory and Safety Lead Time.

The period for planning is specified by filling in the Starting Date and Ending Date fields on the request page. If demand

outstrips supply during this time, the system will create a requisition worksheet line on which the work date is entered as the

order date.

The feature supports the following reordering policies:

Order

Lot-for-Lot

Fixed Reorder Qty.

Maximum Qty.

As in the standard app, the replenishment settings from stockkeeping units take priority over those on the item card. You can

also exclude open (that is, not yet released) sales or purchase orders or transfers from the calculation.

Workflow

Open a requisition worksheet.

On the ribbon, choose Home > Calculate Simplified Plan.

On the request page, fill in the fields as described in the following table.
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Options

Like during standard planning runs, you can filter for individual items or item groups on the Items FastTab. Additionally, you

must fill in the Location Filter field for each run.

Afterward, choose OK to have the requisition worksheet filled in automatically. In contrast to the standard Calculate Plan action,

safety stock isn’t added as a separate line to the worksheet. Like in the standard app, however, you can now decide on the lines

that you want to order.

RELEASED ORDERS ONLY: REQUISITION WORKSHEETS

To streamline your scheduling process, you can run the Calculate Plan action from a requisition worksheet ribbon to have the

system fill in current item demand on the lines according to the planning parameters you’ve set and the number of orders that

you’ve received from your customers.

What the standard function doesn’t consider, however, is whether these orders have progressed far enough in the system. To

limit demand calculations to sales orders that have already been released, turn on the Released Orders Only toggle when you see

the request page of the report.

MINIMUM ORDER VALUE AND FREIGHT LIMITS

Optimizing unit costs is key to a successful wholesale transaction. For this reason, you can now specify how much you must order

from a vendor at the very least and up to which amount transportation fees will be paid by the supplier.

Open the relevant vendor card.

On the Shipping FastTab, fill in the Minimum Order Value or Carriage Paid Limit field. The values entered in both fields must be in

the currency used by the vendor.

What you enter in these fields is then shown as part of purchase order statistics and on requisition and planning worksheets for

informational purposes.

Purchase order statistics

To see what you purchased:

Open a purchase order.

On the ribbon, choose Order > Statistics.

Field Description

Starting Date

Ending Date

Specify when planning should begin and end. Within this period, the number of items you require

is compared to what has been ordered so far, as on a standard requisition worksheet.

Include

Blanket Orders

In contrast to standard requisition worksheets, blanket orders are not included automatically on

simplified plans. Turn on this toggle to add them.

Released Orders Only On standard requisition worksheets, a planning run typically includes every sales order created in

the system.

Often, however, demand calculations should include released orders only, which is what turning on

this toggle is for.

Released Purch.

Orders Only

On standard requisition worksheets, a planning run typically includes every purchase order

created in the system.

Often, however, demand calculations should include released orders only, which is what turning on

this toggle is for.

Released Transfer

Orders Only

On standard requisition worksheets, all transfer orders created in the system will be part of

demand or demand coverage calculations.

Often, however, the calculations should include released orders only, so this toggle needs to be

turned on.
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The Minimum Order Value and Carriage Paid Limit fields that you can see on the Vendor FastTab of the page show amounts in the

currency used by the vendor, regardless of the currency specified on individual orders.

Requisition and planning worksheets

Minimum order values and carriage paid limits are also shown on requisition and planning worksheets.

Additionally, you can see in the Accepted Order Value (Vendor) field what has already been requisitioned from the vendor.

When you release a purchase order, the system then checks the current order value and fee system against the minimum value

and fee limit. You’re notified if what you entered on the document falls below either.

However, a check for a minimum order value is only performed if the currency that is specified on the order matches the

currency that you stored with the vendor. You see a message if they don’t but can decide to release the order anyway.

The line values that are being compared are gross or net, depending on whether you turned the Prices Including VAT toggle on

the General FastTab on or off. The toggle setting on the related vendor card must match the setting made here; otherwise, the

check isn’t run.

The same is true for requisition worksheets. However, because their lines don’t have Line Amount fields, the amount to compare

the minimums to is calculated based on the Quantity, Unit Cost, and Line Discount % values that you specified on each line. If

Prices Including VAT is turned on, the tax that you expect to pay is also added.

Invoice discounts aren’t part of the check.

If the values in the Buy-from Vendor and Pay-to Vendor fields differ here, the check will apply to the Buy-from Vendor settings.

Item Vendor Catalog Prices FactBox: requisition worksheets

This requisition worksheet FactBox provides a quick way for you to compare purchase prices for items without having to leave

the page. The box displays detailed price information about the line currently selected on the worksheet, including discounts,

unit costs, and calculated unit costs, provided an item is specified on the line. The box also remains blank if no price data is

stored for the item.

Assign blanket orders manually

When you fill in a purchase order manually, you can also copy over the terms and conditions of the related blanket agreement.

Open a purchase order, and then select a line.

Fill in the Blanket Order No. or Blanket Order Line No. field.

You’re asked if the unit cost and the line discount should be copied from the relevant blanket purchase line. Choose Yes if you want

the price copied. Choose No to keep the price from the purchase order.

TIME-LIMIT BLANKET ORDERS

To prevent terms and conditions specified on a blanket order from being used after the order has expired, you can now set not

only a quantity but also a time limit there:

Open a blanket order.

On the FastTab, in the Valid Until field, specify up until when the order is valid.

You then see an error message if you try to use the order after the expiration date.

Note

Note

1. 

2. 

3. 

1. 

2. 
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On request, the field can also be added to purchase lines so that you can limit the validity of a blanket order there. Currently, the line

option isn’t available for general use and line fields contain the date specified on the blanket order header.

SHOW QTY. REMAINING ON BLANKET ORDER

By clicking the highlighted number in the Qty. Rem. on Blanket Order field on a blanket order line, you can see the purchase line

quantities that you still need to receive from a supplier. With the Outstanding Qty. Excl. Order and the Qty. on Purch. Order

fields, you can now also see the quantity that remains for call-off from the blanket order.

MANAGE CONTAINERS

In international trading, goods are often transported by sea or air, with partial quantities from multiple orders shipped inside a

single container.

A container is also the unit by which vendors are billed for deliveries. This is because payments are often due when items are

loaded on a vessel and risk passes from seller to buyer.

In the standard app, you need to assign partial deliveries to a transfer order, for example, when the items are brought onboard,

when they’re moved to a bonded warehouse, when a vendor is invoiced, or when customs duties and freight costs must be

settled. With the container functionality, you only need to group those deliveries once.

Setup

Choose the Search icon, enter Containers, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Note

1. 

2. 

3. 

Field Description

Code Specify a unique code for the container.

You can enter a maximum of 20 characters in this field.

Description Specify a description for the container.

External Document

No.

Here you can specify, for example, a document ID. This ID is later copied to all documents on which

you enter the container.

Vessel Code Specify the vessel on which the container is transported. For more information, see Track a Vessel.

No. of […] Shows the number of headers or lines on which the container is used. Click a number to view the

associated documents.
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Track a vessel

This feature can bring even more transparency to your supply chain. To track a container vessel loaded with items that you

ordered:

Choose the Search icon, enter Vessels, and then choose the related link.

On the ribbon, choose New. Alternatively, open a line for editing.

Fill in the fields as described in the following table.

For the vessel tracking functionality to work, you need to maintain either the IMO or the MMSI field in the system.

You can then open the Containers page to assign a vessel to a container in the Vessel Code field.

Afterward, choose Ship Tracking on the ribbon to pinpoint the vessel’s current location and see a map of the area it is in.

Containers on orders

Containers can be assigned to a purchase order on the header or lines, which simplifies the creation of warehouse receipts that

consist of different (partial) deliveries.

To assign a container:

Open a purchase order.

On the General FastTab, fill in the Container No. field. If lines already exist, you’re asked if you want to enter the number on all of

them.

You can then enter another container number on a line, if necessary.

Set expected receipt date

As is not uncommon, shipments might get delayed. If this happens, you can run the Set Expected Rcpt. Date function from the

ribbon to change the date that a certain container will arrive on.

This will change the date not only on the Containers page but on every order and transfer line linked to the container.

The expected receipt date is no longer adjusted on order lines when a receipt has been posted. The date is then only changed on the

associated transfer order.

1. 

2. 

3. 

Field Description

Code Specify a code (abbreviation) that will be assigned to the vessel.

The code must be unique.

Name Enter the name of the ship.

IMO If available, specify an IMO number.

This number, preceded by the letters IMO (for example, IMO 8712345), is assigned by IHS Maritime &

Trade, often when the ship is registered.

MMSI If available, specify a Maritime Mobile Service Identity number.

This nine-digit number is used for communication by radio.

Note

1. 

2. 

3. 

Note
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Container receipts

Assign a container

You can also assign a container manually to a purchase order during receipt:

Create a warehouse receipt.

Fill in the container number on the header.

On the ribbon, choose Get Source Documents or Get Source Document Lines. The container number is then copied to the lines.

Additionally, when you post the receipt, the number is copied from the receipt lines to the posted document for further

processing.

Use a filter

As an alternative to manual assignment, you can enter the container number on the header or lines of an order and set a filter on

the header or lines when you use the Get Source Document or Get Source Document Lines function.

Create transfer orders

To create an order for transporting items to a bonded warehouse or the final storage location:

Choose the Search icon, enter Containers, and then choose the related link.

On the ribbon, choose Create Transfer Order.

Specify an outbound, an inbound, and a transit location, and then choose OK.

This also copies to the order the external document number that is assigned to the container, and the posted receipts are moved

via the order lines to the outbound warehouse that you specified.

To open the order, use the lookup on the No. of Transfer Order Lines field.

When you post the transfer, the container number is then copied along with other data to the posted document.

If you want to copy container data to a transfer order manually:

Choose the Search icon, enter Transfer Orders, and then choose the related link.

On the ribbon, choose New, and then fill in the fields as necessary.

Afterward, choose Prepare > Get Container to retrieve all purchase receipt entries for the container.

If you don’t have the container number handy, you can also use the purchase order or vendor shipment number for retrieval.

Copy a container to an invoice

To copy receipts from a container to a purchase invoice:

Create a purchase invoice.

Go to the Lines FastTab. On the ribbon, choose Get Receipt Lines.

Filter the posted receipts for a container number, and then choose OK.

Allocate charges to containers

When an invoice is posted for customs duties or freight charges, the costs of which should be allocated to the partial shipments

delivered with a container, you can again filter for the number of that container to specify allocation.

VENDOR SHIPMENT NUMBER: WAREHOUSE RECEIPT LINES

To improve delivery management, the Vendor Shipment No. field was added to the lines of receipt documents.

If you post a warehouse receipt, the value in this field is then copied from the corresponding field on the purchase or the

warehouse receipt header to the posted receipt lines.

The vendor shipment number is also available when you open warehouse receipt lines from invoices issued by a vendor, to make

it easier for you to assign a receipt to an invoice.

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 
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INVENTORY RANGE

In most cases, you can use standard planning functions to meet the needs of your wholesale business. But due to an ever-growing

item master, restocking warehouses might become quite a difficult task over time.

With trade365, you can specify average daily consumption rates for items you order and compare these rates to item lead times.

This way, you can specify a minimum stock level for each product, tying ebbs and flows in sales directly to the reordering

process.

To be able to work with this feature, you need a consumption schedule, where you can set date formulas to specify reorder

periods and priorities in percent.

Setup

A consumption schedule indicates usage based on item ledger entries of type Sale, Assembly Consumption, or Consumption 

(from production).

Entries posted for an item are thereby added together over a certain period, which you enter on the schedule lines. You can set a

period with the help of date formulas or fixed starting and ending dates.

The value in the Item Consumption % line field might differ in each period you specify. The total across all lines of the schedule,

however, must be 100%. To create a new schedule:

Choose the Search icon, enter Item Consumption Schedules, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

General

Lines

1. 

2. 

3. 

Field Description

Code Enter a meaningful abbreviation for the schedule.

Description Specify a description for the schedule.

Field Description

Line Type Select if you want to use a formula or fixed dates for calculating a scheduling period.

Starting Date

Formula

Specify a formula for calculating and filling in the starting date on the consumption line.

You can only fill in this field if you selected Date Formula as the line type.

Ending Date

Formula

Specify a formula for calculating and filling in the ending date on the line.

You can only fill in this field if you selected Date Formula as the line type.

Fixed Starting Date Enter a concrete date, such as 01/01/2025.

You can only fill in this field if you selected Fixed Date as the line type.

Fixed Ending Date Enter a concrete date, such as 01/01/2025.

You can only fill in this field if you selected Fixed Date as the line type.

Consumption % Enter (as a percentage) the consumption rate that you want to assign to the period specified on the

line. The total on all lines must equal 100%.

Description Specify a description for the consumption line.
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Assign a schedule

You can set up the schedule on the following cards (with data retrieved in the same order of priority):

Item Category

Item

SKU

Item categories

Choose the Search icon, enter Item Categories, and then choose the related link.

Select a category.

Fill in the Consumption Schedule Code field.

Items

Choose the Search icon, enter Items, and then choose the related link.

Select an item.

On the Planning FastTab, fill in the Consumption Schedule Code field.

SKUs

Choose the Search icon, enter Stockkeeping Units, and then choose the related link.

Select an SKU.

On the Planning FastTab, fill in the Consumption Schedule Code field.

• 

• 

• 

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 
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Workflow

To calculate an inventory range:

Choose the Search icon, enter Item Planning Suggestion, and then choose the related link.

Select a journal name. As with any other journal, you can create as many names as you like to set up different methods for

calculation.

On the ribbon, choose Calculate Lines to have the system check all items (filtered to a certain user, if applicable) and retrieve their

data for editing. The data can later be retransferred to the item master.

Fill in the request page as described in the following table to specify, for example, what type of variant and location information

should be included in the journal or whether one or more lines should be added per item.

You can also fill in the fields on the Items tab to limit the calculation of the range to certain products.

Step 1

With SKU data available for the item and the location and variant filter used on a line, the system will retrieve the schedule

assigned to the SKU.

If no relevant SKU data exists or consumption isn’t specified, the schedule you entered for the item will be used instead.

This means that the exact same code—not multiple codes—must be specified for the location filter on an item card. This applies

to item variants as well.

Whether stockkeeping unit data is available can also be seen in the SKU Data Exists field on a journal line.

Step 2

If no schedule is assigned to the SKU or the item, the system will check for an item category. If no schedule is assigned there

either, a line will not be added, as no inventory range can be calculated without the schedule.

The Inventory field shows the item’s inventory level after applying the used variant or location filter (or both) when you run the

Calculate Lines function. The Inventory field isn’t calculated. If needed, you can unhide fields showing up-to-date values, including

the current stock value.

1. 

2. 

3. 

4. 

5. 

Field Description

One Line per Location Turn on this toggle if a new journal line should be set up for each location.

One Line per Item

Variant

Turn on this toggle if a new journal line should be set up for each item variant.

Consump. Schedule Code Specify a weighting schedule.

If you leave the field blank, new values are calculated across all schedules.

Use Historical ILEs Turn on this toggle if field values should be calculated based on previously posted item ledger

entries, for example, because new ledger entries do not exist yet.

Reference Date Specify for which date journal values should be calculated.

Clear Safety Stock at 0

Consump.

Turn on this toggle if safety stock quantities should be removed for items or variants with a

consumption of zero.

Show Unchanged Lines This toggle is turned off by default.

With the toggle turned on, the system copies to the journal all lines, even those on which the old

and new values match.

Note
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The function then determines the Calculated Consump. Per Day based on the consumption schedule and the periods specified for

the journal. The range of current inventory is calculated from the reference date (found under the same name on the Options

FastTab of the report request page).

You can check the calculation in detail by drilling down on a field or choosing Line > Invt. Level Calculation (Item) on the ribbon

to see a diagram.

Besides determining an inventory range with the help of current stock levels and rated consumption, the item planning

suggestion includes new planning parameters based on those values.

You can change a parameter, if necessary. The previous parameters are also shown, albeit in read-only format. A new parameter

is determined as follows:

The new safety stock quantity is the same as the old, except if the value in the Calculated Consump. Per Day field on a line is

below or equal to 0 and you’ve selected the Clear Safety Stock at 0 Consump. field on the Options FastTab of the request page.

The new stock will then be 0.

The new reorder point is equal to the new safety stock quantity plus the item consumption specified in the Calculated

Consump. per Day field in the period consisting of lead time and safety lead time.

The new maximum inventory is equal to the new reorder point plus the consumption value from the Calculated Consump. per

Day field during the reorder period.

When you fill in the journal, you can decide whether you want to include only lines where the suggested parameter values differ

from existing values by turning on the Show Unchanged Lines toggle on the Options FastTab of the request page.

Additionally, you can, after potentially adjusting the new parameters yourself, copy them to the item or SKU master by running

the Copy Changes to Item or SKU action on lines selected in the journal.

• 

• 

• 
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CLEAR OUT STOCK

You can also use the range feature to clear out stock. The requirements for consumption schedules are the same as for

calculating inventory levels.

Choose the Search icon, enter Item Clearance Suggestion, and then choose the related link.

This journal shows the unit cost of, sales price for, and profit made with items marked for clearance. The unit cost of each is

determined based on the SKU fields associated with the item; the other two are calculated based on field values in the item

master.

Running the Calculate Lines action from the page ribbon then compares the read-only source data available for the items to

the values calculated by the function.

The old and new values will match initially but can be edited, if needed.

The Options tab on the Calculate Lines request page can again be filled in as described in the following table, while the Item

tab can be used to limit clearance calculations to certain products.

Afterward, you can run the Create Campaign action from the ribbon to create a sales campaign and transfer the new values

(including prices as sales prices) from the selected lines.

BMECAT CATALOG ITEMS

Typically, a wholesaler maintains between around 40,000 and 50,000 items in its item master, although it could supply up to

several hundred thousand. This is because the company can procure items from business partners.

For performance and maintenance reasons, a direct transfer of supplier item data to your item master isn’t a viable solution.

Instead, the standard catalog management function is used for this purpose.

Standard catalog items then become part of a ‘shadow item master,’ which is made up of all items that could be supplied but

have never been moved.

In Microsoft Dynamics 365 Business Central1, you can use a default interface to import item catalogs. But wholesalers might also

need to change the data of an item during this process, for example, because certain purchase prices have changed. This can be

done by using an interface such as BMEcat.

• 

• 

• 

• 

• 

Field Description

One Line per Location Turn on this toggle if a new journal line should be set up for each location.

One Line per Item

Variant

Turn on this toggle if a new journal line should be set up for each item variant.

Consump. Schedule Code Specify a weighting schedule.

If you leave the field blank, new values are calculated across all schedules.

Use Historical ILEs Turn on this toggle if field values should be calculated based on previously posted item ledger

entries, for example, because new ledger entries do not exist yet.

Reference Date Specify for which date journal values should be calculated.

Clear Safety Stock at 0

Consump.

Turn on this toggle if safety stock quantities should be removed for items or variants with a

consumption of zero.

Show Unchanged Lines This toggle is turned off by default.

With the toggle turned on, the system copies to the journal all lines, even those on which the old

and new values match.
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Workflow

With the help of a list, data is read from the input files and mapped so that, for example, items for which data has changed are

marked.

Alternatively, you can use an import suggestion, which provides certain default settings and options.

Data is then copied from the list to the catalog item master and, based on what template you selected for import, items that

are already in the system will be updated immediately.

trade365 Catalog Item Setup

To set up the feature:

Choose the Search icon, enter trade365 Catalog Item Setup, and then choose the relevant link.

Fill in the fields as described in the following table.

After you turned on the catalog item enhancements in trade365, you need to restart the app.

General

Numbering

Templates

Catalog interfaces

Catalog item interfaces are used to specify various import formats. To set up an interface:

Choose the Search icon, enter trade365 Catalog Item Interface Codes, and then choose the relevant link.

Specify a code and a description for the interface.

Assign a Microsoft Dynamics 365 Business Central1 object in the Object Type and Object ID field to ensure that the relevant data is

imported.

In trade365, a report for importing data through BMEcat is included by default. Alternatives that can be processed are, for

example, Excel, CSV, or XML-based file formats, as well as Datanorm, Eldanorm, or formats used by you internally (Report

5157138). Using any of them, however, requires that the relevant interface be set up first.

Item catalogs

• 

• 

• 

1. 

2. 

Note

Field Description

Use trade365 Catalog Items Turn on the toggle to use the trade365 item catalog.

Field Description

No. Format Specify how you want item numbers to appear on catalog item cards.

No. Format

Separator

Specify the character that will serve as a separator for the code and the number of the item if the

format uses both.

No. Series Here you can store an internally used number series for the items that you want to import.

Field Description

Default Item Creation Template Specify a template that will be used by default for the automated transfer of catalog

items to the item master.

Default Item Change Template Specify a template that will be used by default for the automated transfer of changes to

the item master.

Default Catalog Item Creation

Template

Description to follow

1. 

2. 

3. 
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You can assign different catalogs to each interface. They’re used to identify imported data and are saved with the import or

catalog item (data sources).

Via catalogs, you can specify different suppliers who use the same interface, or you can store annual import lists. To assign

catalogs to an interface:

Choose the Search icon, enter trade365 Catalog Item Interface Codes, and then choose the relevant link.

Select an interface.

On the ribbon, choose Catalogs.

Map import data

You can assign a mapping code to each catalog to specify the data mapping structure that will be used for importing items. This

includes the replacement of values, such as PCE for the unit of measure Piece, which is then converted into the unit used in your

system.

Choose the Search icon, enter trade365 Catalog Item Mapping, and then choose the relevant link.

Specify a code and a description for the mapping.

On the ribbon, choose Field Mappings to specify replacement values for individual fields in the structure.

Create a catalog item from a template

You can set up item templates for different import purposes. For example, you might want to use one to create and change base

data and another to transfer price changes only. To set up a template for import:

Choose the Search icon, enter trade365 Catalog Item Creation Templates, and then choose the relevant link.

Fill in the fields as described in the following tables.

General

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

Field Description

Code Specify a code for the template. The code must be unique.

Description Specify a description for the template.

Import Action Select if you want to add new catalog items to your catalog item master and update existing

item data.

Delete Catalog Import on

Completion

Turn on this toggle to have entries deleted from an import list after they are copied to the

catalog item master.

Can Edit Avail. Items Turn on this toggle to allow updates of not only catalog but also standard items.

Item Creation Template Choose a creation template that will be used for copying data to the item master. Click here

for more information on how to set up the template.
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Transfer

On the lines, you can specify what you want to copy for which field. By doing so, you can, for example, add missing item

information.

You can also run the Auto Fill Fields action from the ribbon to fill in line fields as described in the following table.

Create an item from a catalog item

Like on the previous template for creating items from catalog items, you can specify on the trade365 Catalog Item Item Creation

Templates page how you want items to be created from a catalog item import now or later.

Only fields that differ from those included in the earlier template are described in the following table.

Field Description

Copy Purch. Prices Turn on this toggle if you want purchase prices copied to the catalog item (and, if applicable, to a

standard item).

Copy Purch.

Discounts

Turn on this toggle if you want purchase discounts copied to the catalog item (and, if applicable, to

a standard item).

Copy Sales Prices Turn on this toggle if you want sales prices copied to the catalog item (and, if applicable, to a

standard item).

Copy Sales Discounts Turn on this toggle if you want sales discounts copied to the catalog item (and, if applicable, to a

standard item).

Copy Extended Texts Turn on this toggle if you want extended texts copied to the catalog item (and, if applicable, to a

standard item).

Note

You might need to check the extended text toggles that are available in the system and turn them on

manually.

Copy Variants Turn on this toggle if you want variants copied to the catalog item (and, if applicable, to a standard

item).

Note

You might need to turn on the variant requirement manually.

Field Description

Field No. Specifies the number of the field as stored with the catalog item.

Field Name Shows the name of the field.

Show Specifies if the field should be displayed.

Import Specifies how data should be copied to the catalog item and, if necessary, to a standard item during

import.

Default Value Shows a default value based on the Use Default Value field.

Use Default

Value

Specifies if a default value should be used at all and if so, under which circumstances. 

Note

You must fill in the Default Value field if you choose Always or If Import Blank or 0.
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Numbering

Blocking

Import an item catalog in BMEcat format

To import a catalog:

Choose the Search icon, enter trade365 Catalog Import Overview, and then choose the related link.

On the ribbon, choose Actions > Functions > Import.

Select a catalog, the file name for import, the directory for MIME data (such as for images and documents), and a vendor.

Choose OK to start copying items to import to the page.

To transfer items imported in this way to the catalog item master:

On the ribbon, choose Actions, and then choose Copy Catalog Item Import.

Select a template for import, and then choose OK.

Compare values

To get an overview of all items changed or created through an import:

Choose the Search icon, enter trade365 Catalog Import Overview, and then choose the related link.

On the ribbon, choose Reports > Print Comparison.

Set filters or options as necessary.

The report then checks the imported item entries. To view who imported what and when, choose Actions > Functions > Import

Log on the ribbon.

CALCULATE UNIT COSTS

In Microsoft Dynamics 365 Business Central1, you can use purchase prices and discounts when you write quotes for customers.

Unit costs are also calculated on an item-by-item basis, copied along to all subsequent documents, and used to determine

inventory levels.

Field Description

No. Format Specify how you want item numbers to appear on standard item cards.

Options are:

• Vendor Item No.

• Mfr. + Vendor Item No.

• Vendor Item No. + Mfr.

• Entry No.

• Catalog Item No.

• Other No. Series

No. Format

Separator

Specify the character that will serve as a separator for the code and the number of the item if the

format uses both.

No. Series Here you can store an internally used number series for the items that you want to import.

Field Description

Blocked on Deletion In some catalog formats, you will be notified of supply-side item deletion. If this occurs and the

toggle is turned on, the item will be blocked for use within the system.

Sales Blocked on

Deletion

Turn on this toggle if the item removed by a supplier should not be blocked for use across the

entire system but only for sales.

Purchases Blocked on

Deletion

Turn on this toggle if the item removed by a supplier should not be blocked for use across the

entire system but only for purchases.

1. 

2. 

3. 

4. 

1. 

2. 

1. 

2. 

3. 

1.2.8 trade365

- 952/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Besides the cost of procurement, they might include charges or deductions. A unit cost relates to posted transactions, which

means that you’re viewing price calculations ‘backward.’

Standard functionality offers little support when it comes to deciding where to order and what the actual price (including all

charges) is. In trade365, you can use the Calculated Unit Cost feature to set up various calculation templates to which you can

assign different vendor-item combinations.

Unit cost calculations can be triggered manually by running a function, or you can have the costs determined automatically. What

you’ll always have are up-to-date cost values in local currency to make informed choices.

The calculated unit costs aren’t determined based on postings in the system but on cost values stored in the purchase price and

discount master and on calculation template lines. Each calculation is archived so that you can track values at any time.

Additionally, calculated unit costs can be used in sales as a basis for minimum profit checks.

Setup

Inventory Setup

You need to activate the feature before you can use it.

Choose the Search icon, enter Inventory Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Use Calculated Unit Costs. Only after turning on the toggle will the related

fields show up on item cards and various other places in the system.

In the Replace Unit Cost with Calculated Cost field, you can specify if, and how, you want calculated unit costs to be used when 

checks on minimum profits are performed in sales, as described in the following table.

Adjust values

Additionally, you can use these types of surcharges or discounts to replace the charges available in the system and have the new

values copied to all calculation templates automatically. To set up a type:

Choose the Search icon, enter Calculation Value Adjustment Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following tables.

General

Calculation

1. 

2. 

3. 

Option Description

Never The checks will use standard unit costs.

On Non-Avail.

Invt.

The calculated unit cost will be used during a check if the available inventory is not enough for a sales

line quantity. 

If the quantity is sufficient, a check will be made against standard unit costs.

Always The minimum profit check feature will use the calculated unit costs in all cases.

1. 

2. 

3. 

Field Description

Code Specify a code for the value adjustment type. The code must be unique. You can use a maximum of 20

alphanumeric characters.

Description Enter a description for the type. The description can be up to 100 characters long.
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On this FastTab, you can specify what impact the surcharge or discount type should have on a calculation.

Auto-calculate costs

To have unit costs calculated automatically:

Choose the Search icon, enter Inventory Setup, and then choose the related link.

Turn on the Use Calculated Unit Costs toggle. 

You’re asked if you want the system to create a job queue entry. Choose Yes.

Open the job queue entries.

Make changes if necessary, and then activate the queue entry.

For more information, see Use Job Queues to Schedule Tasks.

Purchase Price Calculation

With this feature, you can calculate a unit cost for a relatively large purchase quantity. Calculated unit costs on item cards always

refer to the base unit of measure and purchase quantity that you entered for the relevant calculation template.

The feature can also help check unit costs that haven’t been assigned to a template yet.

Choose the Search icon, enter Purchase Price Calculation, and then choose the related link.

Fill in the fields as described in the following table.

Field Description

Value Adjmt.

Type

Specify if the calculation value should increase (surcharge) or decrease (discount) the unit cost.

Calculation Type If you choose Amount here, the calculation value is added or deducted as an absolute value.

Choosing Percent adds or subtracts the adjustment value from the base amount in percent.

Calculation

Value

Specify the absolute value or percentage that will be used for calculation.

Currency Code If a calculation value given as an amount is a value in foreign currency, choose the corresponding

currency in this field, for example, USD for a surcharge or deduction in US dollar.

The amount is converted into local currency with the help of standard app exchange rates, which are

updated daily.

1. 

2. 

3. 

4. 

5. 

1. 

2. 
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General

You can then run the Calculate action on the ribbon to determine the unit cost. The result is summarized on the right-hand side

of the page. Besides standard unit cost, you can see on that side the calculated purchase price and discount, as well as the

calculated cost value.

You can recalculate values before exiting the page—or compare them on the FastTabs described in the following. However, on

exit, all temporary data will be deleted.

Calculation

This FastTab shows all the calculations performed by the system, be they for different vendors or different quantities. You can

compare the values directly on the tab.

Calculation Details

This FastTab contains the calculation details of entries from the Calculations FastTab. This means that besides the actual price

factors, the tab also shows all surcharges and reductions stored on a certain calculation template.

Show calculated profit

The calculated profit is based on the expected profit, for which the sales price is reduced by the relevant discount on the

calculated unit cost, to indicate the profit you would make if the goods needed to be reordered today, which would change the

base for calculation.

The calculated profit is shown as a percentage on sales documents, or, more specifically, in the Calculated Profit % field on sales

lines, although you might need to use the Personalize function to unhide the field.

Additionally, you can see the standard unit cost, the calculated unit cost, the calculated cost amount, the calculated profit in local

currency, and the profit in percent in the Sales Line Profit Details FactBox.

Field Description

Vendor No. Specify the vendor who will be part of the calculation. This means that the prices and discounts stored

for the vendor will be used in calculating unit costs.

Item No. Specify the number of an item. The field is then used together with the Vendor No. field and the other

fields to determine the unit cost.

Variant Code If necessary, specify a variant for which you want the unit cost to be calculated.

Note

Based on the settings you made, the purchase prices and discounts assigned to certain variants might

differ so that conclusions cannot be drawn for all of them. Leave the field blank if the item has no

variants.

Location Code Specifies the location for which you want to procure items.

If no location-dependent purchase prices or discounts exist, you need to select a location here. The

business logic is the same as for calculating unit costs in inventory management.

Purch. Quantity Specify the quantity that will be used for calculating the unit cost. 

Based on this quantity, the system will calculate block prices and discounts (if these have been set up

beforehand).

Purchase UOM

Code

Select, based on the quantity, a unit of measure for purchases, for example, 5000 pieces or 5 pallets

(should a pallet consist of 1000 pieces).

Note

You must select a unit if a supplier quotes you different purchase prices or discounts for containers.

Template Code Select a template from which surcharges or discounts will be used when calculating the unit cost.
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For this piece of information to be shown, the calculated unit cost needs to be turned on across the entire system.

CHECK ITEMS IN VENDOR CATALOG

If, on a purchase document, you enter an item that isn’t part of the item-vendor catalog, you can now be notified of this. To set up

the notification:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, in the Notify of Missing Vendor Catalog Items field, select one of the options described in

the following table.

USING GOODS RECEIPT DATA IN CALENDAR WEEKS

In retail, goods are often purchased for specific calendar weeks. Within the Microsoft Dynamics 365 Business Central1 standard,

calendar weeks can be entered using a date formula (e.g. M5 = Wednesday week 5).

In KUMAVISION trade365, it is possible to enter the calendar weeks in the fields provided for the expected goods receipt date,

requested goods receipt date and confirmed goods receipt date. The calendar week for the goods receipt date is printed on the

request and the order.

Setup

To use this functional extension, first open the "Accounts payable & purchasing settings" and activate the "Show goods receipt

dates in calendar weeks" switch on the "KUMAVISION trade365" info tab.

If the switch is activated, the same switch appears on the "Delivery" information tab on the vendor card and can be activated

there.

The "Calendar week" area on the "Invoice details" info tab is only visible in purchasing documents for vendors who have activated

this switch. In this case, the "Show goods receipt dates in calendar weeks" switch is activated by default when the purchasing

document is created and can be deactivated both for the document (on the "Invoice details" info tab) and for lines manually.

In addition, the fields appear on the "Invoice details" info tab and in the lines: Expected Goods Receipt Date (calendar week),

Requested Goods Receipt Date (calendar week) and Committed Goods Receipt Date (calendar week).

Note

1. 

2. 

Option Description

None Items that are not in the supplier catalog can be entered without receiving an error message or

notification.

Notify If an item is entered that is not in the supplier catalog, you will get a notification.

Cancel Items that are not in the supplier catalog cannot be entered. You will receive an error message if you try

to enter an item like this.

Note
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Workflow

The calendar weeks can be entered in the document in the following formats:

CW/YYYY 

YYYY/CW 

CWYYYY 

CW 

CWYYY 

CW/YYY

The original date fields are calculated on the first day of the calendar week entered.

!!! note "Note" Additional time requirements such as transportation or warehouse throughput times can be defined in the system.

These times are included in the calculation of the goods receipt data by default. As a result, the planned goods receipt dates may

shift, which can lead to a different calendar week being displayed than the one agreed.

As in the purchase order, the goods receipt data can also be entered in calendar weeks in the blanket purchase order.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

• 

• 

1. 
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Manufacturing

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s production department.

RELEASED ORDERS ONLY: PLANNING WORKSHEETS

To streamline your scheduling process, you can run the Calculate Regenerative Plan action from a planning worksheet ribbon to

have the system fill in current item demand on the lines according to the planning parameters you’ve set and the number of

orders that you’ve received from your customers.

What the standard function doesn’t consider, however, is whether these orders have progressed far enough in the system. To

limit demand calculations to sales orders that have already been released, turn on the Released Orders Only toggle when you see

the request page of the report.

PRESET WORK PLAN TIMES IN THE STANDARD CATALOG

To simplify and standardize activities in production, standard catalogs can be defined in Microsoft Dynamics 365 Business

Central1 Standard and integrated into routings.

KUMAVISION trade 365 can also be used to define routing times. The "standard catalog code" in the routing enters these times

in the operation and uses them to calculate a production order. Deviating times can be subsequently changed manually in the

operation.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Warehouse Management

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s logistics department.

ITEM LIFECYCLES

All items follow a certain lifecycle, which starts with premarket development and ends with their discontinuation or replacement

by more recent offerings.

In trade365, you can use customizable statuses to detail the stages an item goes through at your company so that, at the right

time, it can be archived or blocked in sales or across the entire system, for example.

We recommend that you include lifecycles in your item requirement checks, as you cannot manually set a Blocked toggle (such as

Sales Blocked) on an item card if a lifecycle code is also stored on the card.

Setup

Create a lifecycle

Note
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Before you can assign a status to an item, however, you need to set up one or more product lifecycles.

Choose the Search icon, enter Item Lifecycles, and then choose the related link.

Fill in the fields as described in the following table.

Assign a cycle to an item

To assign a lifecycle code to an item:

Open an item card.

On the Lifecycle FastTab, fill in the Lifecycle Code field. The code must already be set up.

You can then specify starting and ending dates for the sale of the item provided the selected lifecycle code allows entries in the

sales area.

Specifying a starting date will have an influence on documents in that the item can only be entered on sales lines with shipment

dates on or after the starting date.

You can use this feature, for example, to prevent an order from being shipped before the product entered for it is even

introduced to the market. For ending dates, the shipping date on the document must be earlier than the last day on which the

item is to be sold. Items are checked when a document is released.

1. 

2. 

Field Description

Code Specify a meaningful lifecycle code. The code must be unique.

Description Specify an internal description for the lifecycle. The description can be up to 100 characters long.

Fully Blocked Select this field if, at the current lifecycle stage, you want the item excluded from all processes,

including posting.

Sales Blocked Select this field to exclude an item from sales transactions (except return orders and credit

memos) in the specified stage.

You can ignore this setting if the Fully Blocked field is selected.

Purchases Blocked Select this field to exclude an item from purchase transactions (except return orders and credit

memos) in the specified stage.

You can ignore this setting if the Fully Blocked field is selected.

Service Blocked Select this field to exclude an item from service transactions (except service credit memos) in the

specified stage.

You can ignore this setting if the Fully Blocked field is selected.

Production Blocked Select this field to exclude an item from manufacturing (production orders) in the specified stage.

You can ignore this setting if the Fully Blocked field is selected.

Prod. Consumption

Blocked

Select this field to exclude an item from component usage (on production orders) in the specified

stage.

You can ignore this setting if the Fully Blocked field is selected.

For Clearance With this field selected, you see a message if the item was marked for clearance by your company

or one of your suppliers.

Archived With this field selected, the item is hidden from view on all pages in the specified stage. You can,

however, unhide it again manually, if necessary.

To see an item without manual intervention, you need to open the relevant item card and select a

lifecycle code for which the field is not selected.

1. 

2. 

3. 
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If a lifecycle code is stored on an item card, the fields relevant to the cycle cannot be changed. For changes to the lifecycle, you need

to choose another code.

The "Locked (user)" indicator can be used to lock an item for all uses despite a defined life cycle. If it is released again, e.g. because

an internal check has been completed, the locks defined in the life cycle apply again from this point onwards.

Enter a date for checking

To specify the date against which the system should check the start and end of an item sales period:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, fill in the fields as described in the following table.

When you use warehouse and inventory documents, such as warehouse receipts and picks, you can perform picking regardless of

when sales of the item start or end. Still, you can only post the related warehouse shipment if the posting check is successful.

SPECIFY INVENTORY MULTIPLES

In trade365, you can decide if you want to maintain inventory and sales items in a certain size or a multiple of that size only. To

set up the feature:

Choose the Search icon, enter Inventory Setup, and then choose the related link.

In the Inventory Multiple Check field, choose one of the options described in the following table.

Both checks can be specified in relation to inventory. Although they have an impact on all locations, you can select a site as a

breakbulk location so that neither check will apply. For this feature to work, you must set the Breakbulk Storage toggle on the

Bin Check FastTab.

Note

1. 

2. 

Field Description

Item Lifecycle

Reference Date

Enter the date against which the check should be performed. For more information about date

fields and their relation to each other, click here.

Item Lifecycle Posting

Check

Specify if shipments can be posted only within the period allowed for sales.

None

When you post a shipment, the starting and ending dates are not checked.

Posting Date

You can only post if the posting date is within the specified sales period.

Work Date

You can only post if the work date is within the specified sales period.

Note

1. 

2. 

Option Description

None Ignores inventory multiples.

Sales Outbound Inventory multiples are checked for sales transactions.

End-to-End Multiples are checked for sales and purchases.
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To specify multiples for purchases and sales, you need to open an item card and fill in the Inventory Multiple field. With the field

filled in, the item can only be purchased or sold in the specified quantity or a multiple thereof (based on whether the relevant

Inventory Setup toggle has been turned on or off).

If an item has variants, differing multiples can be maintained at the variant. If no setting has been made for the variant, the

inventory multiple entered on the item card is used. Fixed lot sizes are only checked for sales lines that relate to non-breakbulk

locations.

You see a message if you enter on a sales line a quantity below the specified multiple and are then asked whether you want to

round that quantity up. The message appears when:

the Quantity field is filled in on a sales document (except on blanket orders).

the To Ship field is filled in on a blanket order line.

the Quantity field is filled in on a transfer order line.

When you fill in the Quantity field on a blanket order line, you see a message but cannot round the quantity up or down. This is

also true when you change one of the following fields on a line after filling in the quantity:

No.

Variant Code

Item Reference No.

Location Code

Unit of Measure Code

When you create an invoice for items shipped based on a blanket order, the system doesn’t check multiples when you post the

bill, as the shipment has already been sent. This also applies to credit memos set up for return order lines.

PURCHASING CODES: SKU

Standard functionality gives you the option of storing a purchasing code on an item card if you only procure the items by drop

shipment or special order. This code is then copied to all sales transactions and can be changed during any such transaction (if

necessary), for example, if you must deliver goods via a certain warehouse.

Often, an item might, in theory, be available but some of its variants are only ordered when needed and will be sent directly to

the customer (variant drop shipment).

With trade365, you can specify purchasing codes for stockkeeping units while delivering other units from a warehouse. To limit a

code to an SKU:

Open an item card.

On the ribbon, choose Related > Warehouse > Stockkeeping Units.

Open a Stockkeeping Unit Card.

On the General FastTab, fill in the Purchasing Code field. If you can’t see the field, you might need to use the Personalize function

to unhide it.

The code is then copied to all sales documents linked to the SKU.

Purchasing codes that have been assigned directly on an item card apply to all SKUs associated with the item.

SYNCHRONIZE VENDOR ITEM NUMBERS

In the standard app, you can store vendor item numbers in several areas but must maintain them manually, which can lead to

issues if they differ from each other.

In trade365, standard functionality has been extended by an update function to reduce the number of manual tasks and ensure

that you’ll always have up-to-date information.

• 

• 

• 

• 

• 

• 

• 

• 

1. 

2. 

3. 

4. 

Note
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Setup

You need to activate the feature before first use.

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Auto Add item References toggle.

You can then enter a number directly on a line, in the Item Reference No. field. Existing numbers can also be used for

transactions immediately.

If the system finds another item reference for one and the same vendor-item combination, you’ll be notified and can decide

whether to replace the number.

Another option is to synchronize item vendor numbers between the item, SKU, item reference, and item vendor records. You can

do this by opening Inventory Setup and turning on the Auto Update Item Vendor Catalog toggle.

Workflow

On an item card, you can store the main vendor and its item number (Vendor Item No.) on the Replenishment FastTab. If an item

reference doesn’t exist yet, the reference is created automatically. If you later change the number on the card or on the Item

References page, the entry is updated everywhere else in the system automatically.

But synchronization extends beyond one card and one page; the reference is also updated in available SKUs and item vendor

records (provided the basic parameters remain, that is, the same source vendor item number and vendor are specified). In this

case, it doesn’t matter where you make the changes, as all occurrences of the number are then updated by the system.

DELETE PARTIAL WAREHOUSE SHIPMENTS AND RECEIPTS

When you post or ship a partial quantity in the standard app, the documents showing the remaining quantity are kept in the

system. In the logistics area, this program behavior is often counterproductive, as you would recreate the documents for new

shipments or inventory.

1. 

2. 
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In trade365, you can specify if and how warehouse and inventory documents should be deleted.

Choose the Search icon, enter Warehouse Setup, and then choose the related link.

Fill in the fields as described in the following table.

You can also use the general search to open the Adjust Warehouse Receipts or Adjust Warehouse Shipment feature for cleansing

purposes. Alternatively, you can create entries for these reports in the standard task queue.

BLOCK LOCATIONS

You can now block locations that are no longer in use so that they cannot be posted to.

Choose the Search icon, enter Locations, and then choose the related link.

Open a location card.

On the General FastTab, turn on the Blocked toggle.

Link locations to items and users

Items that are always stored away in the same warehouse or can only be sold by certain staff members can be limited in

availability to a specific location or to a single location and user.

In sales

In the standard app, you can assign a second location to a customer if it is the site that this customer is typically supplied from.

In trade365, you can also link a location to a certain item or an item and a user so that the site will be copied to new sales

documents when the item (as well as the user, if available) is entered on a line, regardless of how you filled in the associated

customer card.

1. 

2. 

Field Option Description

Delete Whse. Shpt.

(Post)

Delete Lines Following partial shipment, only warehouse lines with remaining

quantities are deleted.

Delete Header

and Lines

After partial shipment, the entire warehouse document is deleted.

Delete Unavailable

Whse. Shpt. Lines

(Pick)

Turned on Warehouse shipment lines for which picks could not be created (that is,

no availability exists) are deleted after picking.

This function only applies to locations for which the following toggles are

turned on:

• Require Shipment

• Require Pick

Delete Pick on

Registration

Turned on An availability check is performed when a picking document is created. If

inventory accounting and physical inventory figures do not match, the

picking process cannot be completed in full. The picks that remain are

then deleted on registration.

This function only works for locations for which the following toggles are

turned on:

• Require Shipment

• Require Pick

Function Option

Adjust Warehouse Receipts Deletes all partial warehouse receipts.

Adjust Warehouse Shipments Deletes all partial warehouse shipments.

1. 

2. 

3. 
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To set up the feature:

Choose the Search icon, enter Sales & Receivables Setup, and then choose the related link.

On the trade365 FastTab, turn on the Enable Item-User-Location toggle.

Open an item card, and then choose Related > Item > Item-User-Location on the ribbon.

Fill in the Location Code field and, if needed, the User ID field. If an item is linked to a location but a user isn’t, the new

assignment will be valid for all users.

Alternatively, open a location card or User Setup, and then run the action from there.

Item-user-location assignments only apply if sales lines are created manually.

Afterward, sales document lines will be filled in with a location in the following order of priority:

The location is assigned to both the item and user specified on the line.

The location is assigned to the item.

The location is assigned to the user.

The location is assigned through standard methods (via a customer or center of responsibility card).

In production

You can also work with the item-user-location feature in manufacturing. To assign an item (and potentially a user) to a location:

Choose the Search icon, enter Manufacturing Setup, and then choose the related link.

On the trade365 FastTab, turn on the Enable Item-User-Location toggle.

Open a production order, and then run the Item-User-Location action from the ribbon.

Fill in the fields as necessary.

Afterward, the site will be copied to new production order components when the specified item (as well as the user, if filled in) is

entered on a component line. If a location is linked to an item but a user isn’t, the location will be valid for all users.

For all other settings and the order of priority in which locations are entered, see the previous section.

Item-user-location assignments are only relevant when you create component lines manually. If the Refresh Production Order

function is run, the location is determined according to the business logic used in the standard app.

PRINT BY LOCATION

In trade365, you can assign a printer to a location to tell the system to create and print warehouse documents automatically

when the location is selected. The following documents are printed in this way:

Movement

Picking List

Put-away List

Warehouse Receipt

Posted Warehouse Receipt

Warehouse Shipment

Posted Warehouse Shipment

You specify the printer on a location card (on the General FastTab).

1. 

2. 

3. 

4. 

5. 

Note

1. 

2. 

3. 

4. 
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3. 
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Note
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SHOW TRACKED ITEMS IN COLOR

A company's item master might contain multiple items with and without serial number or lot tracking. Identifying those

warehouse receipt lines that need an item tracking entry might not be an easy task for warehouse staff, especially if scanners

aren’t used.

In trade365, lines with items that require a serial or batch number are shown in color on the following documents:

Warehouse Receipt

Put-away

Inventory Put-away

Warehouse Shipment

Pick

Inventory Pick

Not all fields on each line will be shown in color, only the source document and document line type and number, plus the item

number and description fields. To set up the feature:

Choose the Search icon, enter Warehouse Setup, and then choose the related link. 

On the General FastTab, fill in the Serial & Lot No. Item Color field to specify how they should appear, as indicated by the following

chart.

• 

• 

• 

• 

• 

• 

1. 

2. 
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BLOCK PHYSICAL INVENTORY ITEM AND BIN POSTINGS

Under certain circumstances, standard functionality allows posting to items and bins in physical inventory journals or on physical

inventory orders.

As this might lead to complications in inventory management, you can block bins in trade365 from being used during physical

inventory.
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Items, by contrast, are always unavailable for posting when taking stock, even in two-stage picking.

Choose the Search icon, enter Warehouse Setup, and then choose the related link. 

On the KUMAVISION trade365 FastTab, in the Bin Movement if Physical Inventory field, choose one of the options described in the

following.

(empty)

Posting might be possible (default option).

Notify

You’re warned if a certain item is being counted and can cancel the posting process.

Cancel

When you try to post an item that is being counted, the process is canceled with an error message.

INDICATOR COUNT: PHYSICAL INVENTORY

The Counted field has been added to physical inventory journals so that staff members have an easier time processing inventory

lists during stocktaking.

The checkbox is selected automatically when you fill in a quantity on a journal line.

DEFAULT SORTING METHODS

On a location card, you can choose one or more field values that will be used by default to sort lines on warehouse documents,

such as pick documents, if the site is entered on them. You can also decide whether you want the Qty. to Handle filled in on the

lines automatically in this case.

Choose the Search icon, enter Locations, and then choose the related link.

Open a location card.

On the Warehouse FastTab, fill in the fields as described in the following table.

WAREHOUSE AND INVENTORY DOCUMENTS ON SALES AND TRANSFER ORDERS

A Warehouse Documents section has been added to sales and transfer orders under the General FastTab so that you can see

instantly how many warehouse lines are tied to the document.

1. 

2. 

3. 

4. 

5. 

1. 

2. 

3. 

Field Description

Sorting Method – Whse. Receipts Select by which field value warehouse receipts at this location should be sorted.

Sorting Method – Whse.

Shipments

Select by which field value the system should sort warehouse shipments from this

location.

Sorting Method – Internal

Movements

Select by which field value internal movements involving this location should be sorted.

Sorting Method – Put-aways Select by which field value the system should sort put-aways at this location.

Autofill Qty. to Handle – Put-aways Specify if the quantity to handle should be automatically filled in for put-aways at this

location.

Sorting Method – Picks Select by which field value the system should sort picks at this location.

Autofill Qty. to Handle – Picks Specify if the quantity to handle should be automatically filled in for picks at this

location.

Sorting Method – Movements Select by which field value the system should sort movements involving this location.

Autofill Qty. to Handle –

Movements

Specify if the quantity to handle should be filled in automatically for transfers involving

this location.
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To drill down on a document, click one of the highlighted numbers listed in the following table.

Field Description

No. of Whse. Shipment Lines Shows the number of warehouse shipment lines linked to the document.

No. of Posted Whse. Shpt. Lines Shows the number of posted warehouse shipment lines linked to the document.

No. of Pick Lines Shows the number of pick lines linked to the document.

No. of Registered Pick Lines Shows the number of registered pick lines linked to the document.

No. of Whse. Pick Lines Shows the number of warehouse pick lines linked to the document.

No. of Rgstrd. Whse. Pick Lines Shows the number of registered warehouse pick lines linked to the document.
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WAREHOUSE SETUP

In trade365, a variety of functional enhancements have been added to the warehouse area. To set them up:

Choose the Search icon, enter Warehouse Setup, and then choose the related link. 

On the KUMAVISION trade365 FastTab, fill in the fields as described in the following table.

1. 

2. 
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Field Description

Serial & Lot No. Item Color For more information about this field, see Show Tracked Items in Color.

Bin Movement If Physical

Inventory

Specify how to proceed when you want to post an item that is being counted. For more

information, click here.

Approval Reqd. for

Reservation

Specify if users can create or delete reservations. By default, all users can do both.

If you turn on this toggle, you should also specify the users for whom reservations must be

blocked.

To do this, open User Setup and clear the Can Create Reservation and Can Delete

Reservation fields on the relevant lines.

Use Internal Item Descr.

(Inbound)

Turn on this toggle if you want internal item descriptions used on receipts, put-aways, and

warehouse receipts.

With the toggle turned off, available descriptions will be copied from the Item References

page.

Use Internal Item Descr.

(Outbound)

Turn on this toggle if you want internal item descriptions used on shipments, picks, and

warehouse shipments.

With the toggle turned off, available descriptions will be copied from the Item References

page.

Whse. Shipment – Use Def.

Employee Location

Specify if the default location assigned to a warehouse employee should be retrieved when

creating a shipment.

You can assign a location to a staff member by opening the Warehouse Employees page and

selecting the Default field for a shipping site.

Delete Whse. Shpt. (Pick) Standard functionality typically copies all item lines on sales orders to a warehouse

shipment when you create the document.

Availability is not a factor here. After the available items are picked, those that cannot be

supplied remain on the document when the shipment is posted. As a result, the shipping

document is not archived automatically.

With the toggle turned on, lines that are not available are deleted from the shipment

document when you create a pick.

For more information, see Delete Partial Warehouse Shipments and Receipts.

Delete Whse. Shpt. (Post) When a warehouse shipment has been posted and some lines remain, you can delete them

if no unregistered pick lines exist either.

(blank)

No effect.

Delete Lines

Lines that meet the above conditions are deleted.

Delete Header and Lines

Lines that meet the above conditions are deleted and if no more lines exist, the entire

shipment is as well.

For more information, see Delete Partial Warehouse Shipments and Receipts..

Keep Whse. Shpts. for Open

Activities

With standard functionality, you can delete a warehouse shipment despite ongoing

warehouse activities. Turn on this toggle if you want to receive an error message when you

are about to delete a shipment like this.
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ASSIGN CUSTOMERS TO FORECASTS

You can now set up forecasts for certain customers or customer groups.

Choose the Search icon, enter Demand Forecasts, and then choose the related link.

On the ribbon, choose New.

Specify a code and description for the forecast, and then choose Edit Demand Forecast.

On the General FastTab, in the Sales Type Filter field, specify if you want to assign the forecast to a certain customer or a customer

group.

In the Sales Code Filter field, you can then enter the customer or group that the forecast should be assigned to.

Field Description

Assemble to Order - Set

Whse. Shpt. Qty. to Qty. to

Ship

This toggle only affects locations that warehouse shipments and picks are posted to.

If you register a pick for an assembly item for which you selected Assemble-to-Order in the

Assembly Policy field, standard functionality will not update the To Ship field on the

associated warehouse document.

If you turn on this toggle, the To Ship field will be filled in automatically with the picked

quantity after registration.

Whse. Receipt – Use Def.

Employee Location

Specify if the default location assigned to a warehouse employee should be retrieved when

creating a receipt.

You can assign a location to a staff member by opening the Warehouse Employees page and

selecting the Default field for a receipt site.

No Def. Receipt Bin Code for

Bin Content

Description to follow.

Notify If Whse. Pick

Completed

In the standard app, an availability check is performed when you pick from a warehouse

shipment. Only items with corresponding quantities are then suggested for a pick, if

available.

If you turned on this toggle, you receive a message if a pick cannot be created for the

entire shipment.

This function only applies to locations for which the following toggles are turned on:

• Require Shipment

• Require Pick

Assemble to Order - Reduce

Pick to Avail. Qty.

Turn on this toggle if you want component availability to be considered for assemble to

order and—if necessary—lower quantities for picks to what can be supplied.

Example

You create a warehouse shipment for a 10-bike order to assemble. A bike is made up of 2

wheels and 2 pedal components.

In total, 20 bikes are stocked but only 10 pedals. If the toggle is turned on, the quantity to

pick is reduced to 5 bikes.

Delete Pick on Registration When you create a pick, an availability check is run.

If inventory accounting and physical stock values differ, the pick cannot be registered. With

the toggle turned on, the pick is then deleted as well.

This function only applies to locations for which the following toggles are turned on:

• Require Shipment

• Require Pick

1. 

2. 

3. 

4. 

5. 
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Advanced demand forecasting

Although a must for wholesale items with long lead times, demand planning in the standard app requires a great deal of effort

and remains a manual process throughout.

A new feature therefore combines the potency of forecasts based on historical data with options for integrating demand-related

records that originate outside the Microsoft Dynamics 365 Business Central1 environment.

Setup Advanced demand forecast

As a first step, you need to set up a schedule for advanced forecasting.

Choose the Search icon, enter Demand Forecast Schedules, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following tables.

General

1. 

2. 

3. 

Field Description

Code Specify a code for the schedule.

Description Specify a description for the schedule.

Status Specify the status of the schedule. Options are:

• New

• Active

• In Progress

• Disabled
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Lines

Manufacturing Setup

After you’ve set up a calculation schedule for use in forecasting:

Choose the Search icon, enter Manufacturing Setup, and then choose the related link.

On the trade365 FastTab, fill in the fields described in the following table.

Inventory Setup

Field Description

Calculate By Select a basis for forecasting. Options are Day, Month, Week, Quarter, and Year.

Quarter Needs to be filled in if you selected Quarter in the Calculate By field.

Week Needs to be filled in if you selected Week in the Calculate By field.

You can enter a value between 1 and 52 here.

Month Needs to be filled in if you selected Month or Day in the Calculate By field.

Day Needs to be filled in if you selected Day in the Calculate By field.

Sales Type Specify if the line should be used for a specific customer or a group of customers or leave the field

blank for the line to apply to all customers.

Sales Code Depending on the selection you made in the Sales Type field, you can specify a customer or customer

group here. This field is grayed out if you left the Sales Type field blank, however.

Value Adjmt. Type Specify whether historical consumption values should be lowered or raised by a certain percentage.

Value Adjmt. % Specify the percentage by which historical consumption values should be lowered or raised in the

period shown on the page.

Qty. Rounding Type Specify if and by how much consumption values should be rounded.

(blank)

Values are not rounded.

Nearest

Values are rounded to the nearest integer.

Round Up

Values are always rounded up. (But see the Qty. Rounding Precision field.)

Round Down

Values are always rounded down. (But see the Qty. Rounding Precision field.)

Qty. Rounding

Precision

Specify how calculated consumption values should be rounded.

Examples

0.01: Rounds to two decimal places.

0.05: Rounds to a value that can be divided by 0.05.

1.00: Rounds to integer (no decimals and can be divided by 1).

10.00: Rounds to integer (no decimals and can be divided by 10).

1. 

2. 

Field Description

Use Advanced Demand

Forecasts

Turn on this toggle so that you can work with the advanced forecast functionality.

Default Calculation Schedule

Code

Select the calculation schedule that will be used by default to forecast demand. The

schedule must be in the Active status.
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As a next step, you need to configure the use of historical item ledger entries in demand forecasting.

Choose the Search icon, enter Inventory Setup, and then choose the related link.

On the trade365 FastTab, fill in the field described in the following table.

Demand forecast templates

You also need a template for forecast worksheets:

Choose the Search icon, enter Demand Forecast Templates, and then choose the related link.

Fill in the fields described in the following table.

Afterward, use the Worksheet Names function on the ribbon and again enter a name and description. You can then run the Edit

Worksheet action to open the worksheet page.

Workflow Import historical item ledger entries

Historical item ledger entries from previous or external systems can be copied to the app with the help of a configuration

package. For more information, see Set Up Company Configuration Packages.

1. 

2. 

Field Description

Historical Item Ledger Entries

Until

Specify up to when historical item ledger entries should be included.

Following this date, the functionality will use only current Microsoft Dynamics 365

Business Central1 entries.

1. 

2. 

Field Description

Name Enter a name for the template.

Description Specify a description for the template.
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On the relevant configuration package card, in the Table ID field, you can then select table 5157193

KVSTRDHistItemLedgerEntry (captioned ‘Historical Item Ledger Entry’) and choose Table > Fields on the Tables FastTab to

configure the fields of the table as shown in the following.

Afterward, exit the page and run the Export to Excel function. Enter the relevant historical data in a new Excel workbook, close

the file, and choose Import from Excel. As is standard when working with configuration package, you must then run the Get Data

function to retrieve the data you’ve entered in the workbook.

Demand forecast worksheets

Field ID Include Field Validate Field Processing

Order

Relation Table ID (Caption)

10 Yes Yes 1

20 Yes Yes 2

30 Yes Yes 3

40 No No 4

50 Yes Yes 5

55 No No 6 5157127

(KVSTRDCustomerGroup)

60 No No 7 5722 (Item Category)

70 Yes Yes 8 27 (Item)

80 Yes Yes 9 5401 (Item Variant)

90 No No 10

100 No No 11

110 Yes Yes 12 14 (Location)

120 Yes Yes 13

130 Yes Yes 14 5404 (Item Unit of Measure)
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To set up a new forecast worksheet:

Choose the Search icon, enter Demand Forecast Worksheets, and then choose the related link.

In the Name field, select a name for the worksheet.

On the ribbon, choose Calculate Plan to fill in the page with data. For a more detailed plan, you can also fill in the fields on the

request page as described in the following table.

1. 

2. 

3. 
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Field Description

Calculate By Specify how demand should be calculated and shown in the worksheet.

(empty)

With no option selected, demand is calculated per day.

Day

Demand entered on the worksheet is calculated for each day within the specified period.

Week

Demand entered on the worksheet is calculated for each week within the specified period.

Month

Demand entered on the worksheet is calculated for each month within the specified period.

Quarter

Demand entered on the worksheet is calculated for each quarter within the specified period.

Year

Demand entered on the worksheet is calculated for each year within the specified period.

Note

If a different calculation method is entered on the schedule that the demand plan is based on, the

calculated quantity is split up on the worksheet in the Quantity field (period = quarter 1) into equal

halves.

Example

You specify on a forecast schedule that first-quarter demand needs to be calculated with a 10% buffer

in mind. The item ledger entries that have already been posted in the stated period are:

30 touring bikes sold on Jan. 12

20 touring bikes sold on Feb. 20

10 touring bikes sold on Feb. 27

This means that 60 bikes have been sold so far; with a 10% buffer, this comes to 66 bikes for the

entire quarter.

On the worksheet, in the Calculate By field, you then choose the Month option. As a result, three lines

with the following values are added to the worksheet:

January quantity (in period) = 20; forecast = 22

February quantity (in period) = 20; forecast = 22

March quantity (in period) = 20; forecast = 22

Forecast Type Specify if you want to plan demand for sales items or components on the worksheet.

Item Filter Here you can filter for the items that must be filled in on the worksheet.

Forecast by

Variants

Turn on this toggle if you want to create a forecast line for each variant. With the toggle turned off,

the variant quantities are aggregated, and their total is shown as an extension of the main item.

Variant Filter Here you can filter for the variants that must be filled in on the worksheet.

Forecast by

Locations

Turn on this toggle if you want to use only certain locations for planning. With the toggle turned off,

forecast quantities are calculated for all locations available in the system.

Location Filter Here you can filter for the locations that must be filled in on the worksheet.

Review Period Start Specify from when past demand will be shown.

Review Period End Specify until when past demand will be shown.
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After running the Calculate Plan function to fill in the worksheet, you can check the data you’ve entered, especially the Forecast

Quantity values.

If necessary, you can then adjust the quantities manually. To approve forecast quantities, select the Accepted field on the relevant

lines or use the Accept All Worksheet Lines action on the ribbon. Otherwise, run the Reject All Worksheet Lines function if you

don’t want to take over any of the lines.

To restart planning, you can use the Clear Worksheet function.

As a next step, you can add the accepted forecast quantities to an existing demand forecast or create a new forecast.

Create a demand forecast

To set up a new forecast with accepted lines, choose Create Forecast on the worksheet ribbon.

Specify a name, a description and specify whether all, none, or the accepted or rejected lines should be deleted from the forecast

worksheet after running the action. The accepted lines are then copied to the new forecast.

Add to an existing forecast

To add worksheet lines to an existing demand plan, choose Add to Existing Forecast function from the worksheet ribbon.

Select the name of a demand forecast in the In Process status and specify if all, none, or the accepted or rejected lines should be

deleted from the worksheet after choosing OK. Each accepted line is then copied to the new forecast.

Demand forecast status

The Demand Forecasts and the Demand Forecast Overview pages have been extended to include the Status field, with the

options being In Process, Active, and Expired.

If you’re working with the advanced forecast feature, only one forecast can be active at a time. This plan in the Active status is

then automatically copied to the Current Demand Forecast field on the Planning FastTab in Manufacturing Setup to make it

available for use on requisition and planning worksheets.

SPECIFY REPLACEMENT ITEMS

Products are often redeveloped, with new versions of them put on the market at regular intervals. In the standard app, much

manual intervention is required to manage this process.

For this reason, trade365 provides you with a Replacement Item feature. The feature alerts staff members to replacement items

automatically so that they can choose whether to ship the original item stock or that of the new item.

Setup

Choose the Search icon, enter Inventory Setup, and then choose the related link.

Field Description

Use Historical ILEs Turn on this toggle if you want to use historical item ledger entries in addition to existing entries.

With the toggle turned off, only the ledger entries in your company are used.

Consider Lost

Revenue

Turn on this toggle if you want the forecast to consider potential revenue losses.

Sales Type Specify if you want to forecast demand for a certain customer or customer group only.

Leave the field empty if you want to consider all records within the period.

Sales Code Filter Depending on what option you selected in the Sales Type field, choose a customer or customer group

in this field.

Use Calculation

Schedule

Turn on this toggle if you want to use the calculation schedule that is stored in Manufacturing Setup.

With the toggle turned off, quantities are forecast as selected in the Calculate By field (see above). As

a result, the Quantity (Period) will be the same as the Forecast Quantity.

1. 
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On the KUMAVISION trade365 FastTab, turn on the Use Item Replacements toggle.

Open an item card. On the General FastTab, click the Assist button in the Item Replacement No. field to get to the Item

Replacement page. The fields on the General FastTab there are filled in with source item data.

Assign replacement items on the document lines as described in the following table.

We recommend that you block the source item in purchasing.

Sales

If an item is entered on a sales document and a valid replacement has been stored for the item, you’re notified of this after you

specify a quantity.

You’re also shown the quantity entered and the total available for the source item. To proceed, you then need to select one of the

options described in the following table.

Inventory range

Although the suggestions used in inventory range planning are based on past consumption, you can also use the feature for

replacement items.

The range is then calculated based on the consumption levels logged for the source item, which will significantly reduce the

complexity of planning.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

2. 

3. 

4. 

Field Description

Item No. Enter the number of the replacement item.

Variant Code Fill in this field if only a certain variant should be considered a replacement.

Description Enter a description for the replacement item.

Description 2 Here you can enter an additional description for the item, if necessary.

Replacement Qty. Specify the quantity by which the source item quantity is replaced.

Unit of Measure

Code

Specify a unit of measure for the replacement item.

Starting Date Specify when the item should replace another. Starting on that day, you might see a message during

document entry.

Note

Option Description

Use Item Qty.

Available

If the quantity available is smaller than the value entered, the system reduces the quantity that

you entered for the source item to what is available.

Use Qty. Available and

Replacements

If the quantity available is smaller than the value entered, the system reduces the quantity

specified for the original item to what is available and adds another line where the replacement

item is filled in together with the amount still outstanding.

Use Entered

Replacement Qty.

The original item line is deleted. The system then creates another line where it enters the

replacement item and the original quantity.

1. 
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Service

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s service department.

PURCHASING CODES: SERVICE ORDERS

Standard functionality gives you the option of storing a purchasing code on an item card if you only procure the item by drop

shipment, for example.

In trade365, you can also ship spare parts in this way, such as when you need to deliver replacement items directly from a

supplier to a customer (see Special Orders and Drop Shipments in Service):

Choose the Search icon, enter Service Management Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Copy Item Purchasing Code toggle.

Any purchasing code stored on an item card is then copied to service lines as well.

Purchasing codes aren’t entered on service quotes, however, but only on the orders that are created from them.

AUTO-CREATE SERVICE ITEMS ON PURCHASE

In the standard app, you can specify in a service item group that when selling a certain item, you can have a service item created

for it automatically.

In trade365, you can already create a service item when you buy a product for a sales order, for example, to prepare for

remodeling.

Choose the Search icon, enter Service Item Groups, and then choose the related link.

On the ribbon, choose Create Service Item (Purch.) for the item group for which items should be created as service items during

purchasing.

When you post a warehouse receipt, service items are then set up for all items assigned to the group. Information about the

vendor whom you purchased the items from is also copied to the service items and stored for later use in sales.

SHIP-TO ADDRESS FIELDS

To replace ship-to-address information on service documents, the following fields have been added to customers’ ship-to address

cards:

VAT Bus. Posting Group

Gen. Bus. Posting Group

VAT Registration No.

If nothing is specified in these fields on the ship-to address, the corresponding fields of the customer will be used for the service

documents.

By specifying a VAT Business Posting Group, General Business Posting Group, and VAT Registration No. for an address, you can

preset VAT values for goods that were ordered by a domestic customer but need to be shipped outside the country, for example.

This eliminates the need for manual entry on orders on a case-by-case basis, improving both the quality and consistency of your

data.

DOCUMENT TEXTS

In principle, you can store standard app texts on invoices created for service contracts. This method isn’t sufficient, however, if

you use the KUMAVISION text feature on a regular basis (for more information, see Extended Text.

1. 

2. 

Note

1. 

2. 

• 

• 

• 
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To print extended customer texts on service documents:

Open a customer card.

On the ribbon, choose Related > Customer > Extended Texts.

Choose a text, and then select the relevant print fields on the Lines FastTab.

Extended item texts cannot currently be retrieved on service quotes and orders.

SERVICE ITEM: POSTED INVOICES

Service items, and their serial numbers, are now available on posted service invoices. Drilling down on either of these fields then

shows the service order for which the invoice was created.

SERVICE ITEM FACTBOX

A Service Item Documents FactBox has been added to service item cards, as well as the service item list, to help you find all

documents on which a certain item is used.

You can click a highlighted number in the box to get to the relevant item lines, filtered by service orders or quotes, or the posted

service shipment lines.

NON-BILLABLE ENTRIES ON SERVICE LINES

The No Billing feature introduced in KUMAVISION base can also be used in the service area. For more information, see Non-

Billable Lines.

If you enter a line without an amount on a service document, you must choose an option besides No in the Not Billable field

there. Otherwise, you see an error message when you try to post the document later and the posting process will be canceled

altogether.

CREATE SERVICE ORDERS FROM SALES RETURNS

If a customer returns an item and, on closer inspection, you determine that the item can be repaired, you can now create a

service order from the sales return order.

Open a return order.

On the Line FastTab, select one or more lines of the Item type, and then choose Create Service Order.

You’re asked if the document should be opened. Choose Yes to prepare the service order for further editing.

The shipment of service items isn’t posted together with the related service orders. You can use standard functionality to post the

receipt of a return item—but without inventory valuation—and ship it back to the customer through a sales order.

CREATE ORDER WITH SERVICE ITEM OF ANOTHER CUSTOMER

In the standard app, you can specify on a service order only service items that you’ve already set up for the entered customer.

Creating an order that another customer might pay for is therefore not an easy task.

In trade365, on the other hand, you can create and process service orders for customers without having to change the owner of a

service item in base data. You can also replace owner information when you create a service order if, for example, the item has

changed hands in the meantime. To be able to use this feature:

Choose the Search icon, enter Service Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, turn on the Disable Cust. Check on Serv. Item Entry toggle.

1. 

2. 

3. 

Note

1. 

2. 

3. 

Note

1. 

2. 
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You can then use any service item on an order. If the customer doesn’t match the owner of the item, you’re asked if you want to

replace the information that is stored on the service item card.

Choose No if you want to process the order and nothing more. Choose Yes to change the customer for the service item to the

customer shown on the order. Afterward, you can process the service order as in the standard app.

CREATE PURCHASE RETURNS FROM SERVICE ORDERS

If, during repair, you determine that the service item should be sent back to the supplier, you can now create a purchase return

order from the service order.

Open the relevant service order.

On the Lines FastTab, select one or more lines, and then choose Line > Actions > Create Purch. Return Order-Multiple on the

ribbon. You must run the function once for each vendor.

Select the vendor so that the purchase return order can be opened on request.

To send an item back to a supplier based on a purchase return order, the item must be in inventory, that is, it must have already been

posted via a sales return order.

The action can also be run on installation component lines that you selected on a service item worksheet (provided, again, the

items to be returned are in inventory).

CREATE SERVICE ITEMS IN SALES AND PURCHASING

In trade365, you can also create a service item directly from a purchase or sales document.

Open a purchase or sales document.

Create a line with a quantity of 1.

On the Lines FastTab, on the ribbon, choose Line > Create Service Item.

The service item is then created automatically and the information from the purchase or sales document is copied to the service

item card.

To open a service item, select the relevant document line and choose Line > Show Service Item on the ribbon, or choose Delete

Service Item if you want to delete it. If no item is assigned to a line, both functions are grayed out.

MAINTENANCE PLANS

Maintenance plans are used as a convenience option for specifying recurring maintenance tasks and inspections in the service

area.

Setup

Types of maintenance

1. 

2. 

3. 

Note

1. 

2. 

3. 
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Maintenance types describe the activities that you can specify for a service item on a maintenance plan. To set up a type:

Choose the Search icon, enter Maintenance Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Plans for maintenance

You can create as many maintenance plans for a service item as you like. To set up a plan:

Choose the Search icon, enter Service Items, and then choose the related link.

Open an item card.

On the ribbon, choose Maintenance Plans, and then fill in the fields as described in the following table.

Required Components

1. 

2. 

3. 

Field Description

Code Specify an abbreviation for the type.

Description Specify a description for the type.

Maintenance Cycle Specifies at which interval service orders should be created for this kind of maintenance work. For

example, entering 6M means that an inspection is needed every six months.

Maintenance

Duration

Specify how much time maintenance usually takes.

Maintenance

Starting Time

Specifies when maintenance orders should be started.

Maintenance Ending

Time

Specify when maintenance orders should be completed.

1. 

2. 

3. 

Field Description

Maintenance Type Code Specify the type of maintenance work (or create a new type here).

Description Shows the description of the maintenance type.

Maintenance Cycle Shows the cycle in which this type of work is carried out.

You can enter another value in this field if the item must be maintained at a different interval.

Maintenance Duration Shows the typical duration of this type of work.

You can enter another value in this field if maintaining the item requires more or less time than

usual.

Maintenance Starting

Time

Shows when this type of maintenance work typically starts.

You can enter another value in this field if maintaining the service item requires a different

starting time.

Maintenance Ending

Time

Shows when this type of maintenance work typically ends.

You can enter another value in this field if maintaining the service item requires a different

ending time.

Starting Date Specifies from when maintenance plans should be created.

Ending Date Specifies until when maintenance plans should be created.
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Provided the components required for maintenance have already been set up in the system:

Open a maintenance plan.

On the ribbon, choose Components.

Fill in the fields as described in the following table.

All components you need must be entered here. They’re then copied from this page to the relevant order lines when service

orders are created by the system.

Maintenance orders

To set up orders for carrying out maintenance work:

Choose the Search icon, enter Create Maintenance Orders, and then choose the related link.

On the General FastTab, use the Starting Date and Ending Date fields to specify the period that maintenance orders should be

created for.

If you only want to create service orders for certain items, use the filters on the Filter: Service Item FastTab.

Choose OK to run the report.

Afterward, service orders and maintenance entries are set up automatically, and the orders are processed based on standard

business logic. For more information, see Service Management - Business Central | Microsoft Learn.

Maintenance Entries

For an overview of all maintenance entries created in the system, open the Maintenance Entries page (available via the general

search function).

As an alternative, you can open a service item card and then choose Show Document to see the service orders associated with

this item.

LOCATIONS ON SERVICE DOCUMENTS

At wholesale companies, the warehouse area where service items are stored is often run by another team than the rest of the

site.

1. 

2. 

3. 

Field Description

Type Specify the type of component. Options are:

• Item

• Resource

• Cost

• G/L Account

No. Based on the option selected in the Type field, enter the number of an item, a resource, or a G/L

account or a cost code here.

Variant Code If needed, select a specific item variant that should be maintained.

Description Shows the description of the item, resource, G/L account, or cost code.

Description 2 Shows the additional description of the item, resource, G/L account, or cost code.

Quantity Specify the item quantity needed for maintenance.

Unit of Measure

Code

Specify the unit that will be used for the maintenance item.

1. 

2. 

3. 

4. 
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To specify an area where service cases are processed:

Choose the Search icon, enter Service Management Setup, and then choose the related link.

On the trade365 FastTab, in the Default Location Code field, select the code that will be used by default when creating a document

in service.

If you leave the field blank, a location will be determined according to standard app logic.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

1. 

2. 

1. 

1.2.8 trade365

- 986/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Subcontracting

Outsourcing or subcontracting certain operations, in particular finishing and assembly, is a common practice in many industries,

for example, to prevent capacity shortages or to let in-house staff focus on core business functions.

To complete a job, a subcontractor is often supplied with materials, or semi-finished products even. In trade365, you can use

transfer orders to ship both to the vendor and print shipment notes based on the transfers you posted.

When you later post the subcontracted work as received, each item consumed during the completion of requested operations is

then taken from the vendor’s warehouse instead of your own.

SETUP

Before you can subcontract work on components and products, you must set up the manufacturing area. For more information,

see the Microsoft Dynamics 365 Business Central1 Helpsite. Only the differences to standard functionality will be explained in

the subsections of this chapter.

Production BOMs and BOM versions

Lines

You must fill in the Routing Link Code field for the relevant production BOM (or version), to specify parts as raw materials

supplied to a vendor. You also need to fill in the Type of Part Provided field (see the following table).

You can use a routing link code to tie a component supplied with an item BOM to a manufacturing operation. The code specifies the

operation the item is needed, that is, consumed for. Like in the standard app, you must first enter the operation before you can link

the part to the BOM. Otherwise, you see an error message when you try to certify the bill of materials.

We recommend that you use a separate routing link code for each subcontractor.

Option Description Note

(blank) Standard functionality will be used (no materials will be supplied to the

vendor).

In Advance Parts will be provided to the vendor when a production order or operation

is subcontracted.

Requires a routing link

code.

General The vendor will receive an item quantity regardless of whether work has

been subcontracted.

When it is, only the production order document will be sent, as the

required parts have already been delivered.

To able to use this option, the subcontractor’s site must be entered as the

outbound location on the related work center card (see the Posting

FastTab there).

Requires a routing link

code.

By Vendor The material or item is shown on the BOM in a FactBox, for informational

purposes. As all materials and items are purchased by the vendor, their

costs are included in the total subcontractor price.

This option is also used if the materials or items needed to finish

subcontracted work are provided by one of your customers, as no

inventory or warehouse postings must be made in this case.

Does not copy

information to

manufacturing.

Note

Tip
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Certify BOMs

To streamline data maintenance, you can select multiple bills of materials on the production BOM list page and run the Certify

Prod. BOMs-Multiple action from the ribbon.

The action then certifies all selected BOMs on which the status is set to New. Those that cannot be certified will be skipped and

their original status retained.

Routing and routing versions

Lines

Certify routings

To streamline data maintenance, you can select more than one routing on the routing list page and choose Certify Routings-

Multiple on the ribbon.

The action then certifies all routings on which the status is set to New. Those that cannot be certified will be skipped and their

original status retained.

Work center card

General

In the Department Code field, fill in the Subcontracting department.

Posting

Planning

Set the Unit of Measure Code to Day unless the contract between you and the vendor says otherwise. Typically, you also create a

new company calendar for subcontracted work.

Ribbon functions

To store subcontractor prices, choose Related > Work Ctr. on the ribbon.

Calculate subcontractor prices

In the standard app, the price for subcontracting, that is, the cost later used on a purchase order, can only be entered on this

card. You therefore cannot enter different prices per vendor, quantity, operation (standard task code), or period.

Field Description

Standard

Task Code

Fill in this field if a subcontractor takes over multiple operations, each with its own price tag. The code

is then used to separate tasks on the purchase order created for the vendor.

You do not need to fill in this field if only one operation is subcontracted per item.

Routing Link

Code

Specify a code for the routing link.

Field Description

Unit Cost Calculation If work is performed in the unit of measure Piece, set this field to Unit.

Specific Unit Cost As for taxation, you might need two groups, one for subcontractors who charge the full tax and

another for those whose work is subject to a reduced rate.

Subcontractor No. Fill in the vendor to whom you subcontract work.

Subcontractor Location

Code

Specify the location that will be used to transfer the item supplies.

Product Bus. Posting

Group

Specify the G/L accounts that you want to post to in sales and purchasing.

For an easier overview of the postings made in the system, we recommend that you set up a group

that will be used solely for subcontracted work.
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In trade365, subcontracted work has its own price table, for which data can be specified in various parts of the system. These

entries then replace the values stored for the work center. You can set prices by period, piece, or specific unit cost.

Subcontractor prices

Prices (and, potentially, block prices) for subcontracted work can be stored in combination with:

Work centers (required)

Items (required)

Vendors (required)

Standard task codes (subcontracted operations)

Starting and ending dates

Minimum quantities (block prices)

Price units (conversion factors based on weight)

You can filter for them on the following pages:

Item Card or Items

Work Center Card or Work Centers

Vendor Card or Vendors

To have ending dates assigned to subcontractor prices automatically when a new price is created, you need to turn on the Auto

Close Subcontractor Prices toggle in Manufacturing Setup. The ending date that is filled in will be one day before the new price

becomes valid.

Transfer routes

With the help of a transfer route, you can link a warehouse owned by a vendor (subcontractor) to your own. To set up a route:

Choose the Search icon, enter Transfer Routes, and then choose the related link.

On the Transfer Routes Matrix, go to the line containing the warehouse that you want to remove items from, and then click the site

(highlighted in blue) that the items should be moved to.

On the Trans. Route Spec. page, enter your warehouse in the In-Transit Code field. You must fill in this field. The other fields can

remain blank if no shipping agent has been specified.

You should also set up a transfer order type called Subcontract Transfer. For more information, see Order Types.

You can then exit the Trans. Route Spec. and Transfer Routes pages.

WORKFLOW

Example

You schedule production and release the production order. For tracked items, you also link the relevant tracking lines to the

components and the order itself.

Subcontracting worksheet

Calculate subcontracted work

Afterward, you open the Subcontracting Worksheets page.

To see the released order, set a filter on, for example, the work center, vendor, or production order number. The worksheet then

lists all pending subcontract work. The vendor is retrieved from the work center, whereas prices are shown based on how you’ve

set them up in the system.

Change a vendor

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

1. 

2. 

3. 

Note
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On the worksheet, you can change the vendor on each individual line (=order). The subcontractor prices you specified for the

new vendor are then retrieved automatically.

Carry out action message

To copy a subcontracting worksheet line to a purchase order, you can use the Carry Out Action Message and Accept Action

Message functions. Both can be found on the ribbon.

You can create the necessary transfer order by selecting the Create Transfer Order field on a line. Lines for which the field isn’t

selected remain.

Released production order

Track subcontracted work

You track subcontracting on production order lines as follows:

Open a production order.

Select a line. On the ribbon, choose Line > Track Subcontracting.

You can then see and open the documents linked to the line.

Purchase order

When you create a purchase order for subcontracted work, the components for production are provided by transfer. This also

means that the description of an item on a purchase line doesn’t include the name of the product but of the subcontracted

service.

Moreover, you can unhide the following production-related fields on purchase lines:

Subcontrd. Items

Subcontrd. Qty. at Subcontractor

Production Order No.

Production Order Line No.

Work Center No.

Operation No.

Item tracking information assigned to production will be printed as well.

The relevant order type is also set automatically if purchases originate with a subcontracting worksheet, although the type can

be changed, if necessary. It is used to prefill certain order data, including the terms of payment.

You need to set up a purchase order type called Subcontrd. Purchase Order for this purpose. For more information, see Order Types.

The associated operation is then reported when an order quantity is received.

Subcontractor reference

When you print a purchase order, the components provided on transfer lines to a vendor for completing operations are

referenced on the document. You also see the total price for the subcontracted work as specified earlier (see Calculate

Subcontractor Prices).

If a block price is assigned to the relevant work center, this price will be used (and updated) automatically.

Post shipment

After you post the purchase order, a warehouse receipt containing the items manufactured is posted. At the same time, the

inventory level at the vendor’s location is reduced by the component quantity provided (and then consumed) during

manufacturing.

1. 

2. 

• 

• 

• 

• 

• 

• 

Note
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You can see on a released production order when each associated purchase has been received. After all of them have, the

progress bar on the production order is set to 100%.

With the Check Rcvd. Not Invd. Subcontrd. Orders toggle in Manufacturing Setup turned on, a production order cannot be finished

before all subcontractor invoices related to the order have been posted in full. We recommend that you turn on this toggle so that a

unit cost statement always includes the subcontractor prices you specified and isn’t readjusted.

Transfers

On the General FastTab of a transfer order, in the Transfer Order Type field, you can see if an order is being used to move items

for subcontracting.

If you don’t receive separate receipts from a subcontractor, you can turn on the Auto Post Shpt. as Receipt toggle on the same

FastTab; else, the goods supplied to the vendor would remain in the specified in-transit location, and you would need to post the

inventory put-away for the vendor separately.

If an actual item, that is, a semi-finished product, is sent along, the amount shipped isn’t shown in the Quantity but the

Subcontractd. Qty. field. This is because the item hasn’t been put into inventory yet.

Materials provided to the vendor, on the other hand, are shown in the Quantity field, as they must be taken from the

subcontractor’s warehouse (with Type of Parts Provided set to For Order).

You can then ship the relevant components to the subcontractor via transfer.

Turn on the Auto Post Shpt. as Receipt toggle if you don’t expect a subcontractor to send a separate receipt. This is because when a

transfer order is posted, quantities are first posted to a transit warehouse along the specified route. If you don’t turn on the toggle,

you need to then post the receipt. For components that must be provided, you can create warehouse and inventory documents, such

as a warehouse receipt or shipment, from the transfer order.

SUBCONTRACTING AND AUTO POSTING

To be able to use automatically generated consumption postings, you need to set up the feature. You can also post consumption

manually, if necessary.

Setup

Set the posting method on the production BOM, and—consequently—the component, to Backward.

Requirements

If item tracking is turned on, store the tracking data with the components.

Workflow

When the items are shipped, consumption is now posted automatically.

Post consumption manually

In the production journal, you can see all consumption lines and post them manually, if necessary. The output line linked to a

subcontracted operation, however, isn’t shown here, as it must be posted through the purchase order.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Rental management

Fully integrated into the service and fixed asset areas of Microsoft Dynamics 365 Business Central1, the Rental Management

functionality provides you with the tools you need to rent out equipment, including a visual representation of rental schedules,

lists of accessories and surcharges (such as for insurance), and new pricing options.

You need a separate license before you can use this functionality.

SETUP AND BASE DATA

Role center

In trade365, equipment rentals are managed on a separate Role Center page. You can also run the graphical planner from there.

On the ribbon, choose the Settings icon, and then choose My Settings.

In the Role field, choose Rental Manager.

If you can’t find the role, you might need to add it first. For more information, see Manage User Profiles.

Setup

To configure the functionality:

Choose the Search icon, enter Rental Setup, and then choose the related link. Alternatively, open the Rental Manager role center,

and then choose Setup > Rental Setup on the ribbon.

Fill in the fields as described in the following table.

Note

1. 

2. 

1. 

2. 
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General

Rental Planner

On this FastTab, you can specify the colors that you want rental items and documents to be shown in when you work with the

visual planner. You can choose any RGB color you like.

Item categories

Item categories can be used to group and classify rental equipment and to prepare rental quotes. The pricing function also uses

these categories.

Choose the Search icon, enter Item Categories, and then choose the related link.

Select a category, and then fill in the fields described in the following table.

Feld Beschreibung

Base Calendar Code

(Rentals)

Select a calendar besides the base calendar if you want to rent (and invoice) equipment at times

that differ from your regular schedule, for example, on Saturdays.

Date Filter

(Upcoming)

Enter a formula to specify how you want dates filtered when you click a tile such as Upcoming

Pickups or Overdue Rental Orders on the role center.

For more information on how to set up a formula, see Work with Calendar Dates and Times.

Tip

Click a tile to see if the specified formula meets the needs of your business. You can then extend or

shorten the period for which dates are shown, if necessary.

Insurance % Specify a percentage for insurance. The value entered in this field will apply when you want

insurance fees calculated but have not assigned any to the rental item or the category that it

belongs to.

For more information on how to set up fees, see Additional Rental Lines Setup, Item Categories,

and Resources.

Unit of Measure

(Hour)

Specify the unit that will be used to rent out equipment per hour.

Unit of Measure (Day) Specify the unit that will be used to rent out equipment per day.

Use Rental Item

Dimensions

Turn on this toggle if you want resource or item dimensions copied to rental documents.

Check Inspection

Lists on Post

Turn on this toggle to ensure that the system checks during posting whether the relevant

inspection checklists are filled in.

Customer Location

Code

Specify where customers get their rental equipment from.

1. 

2. 

Field Description

Rental Resource

No.

Select the resource that rental income based on this category should be posted to. You can use

different resources to post income to a variety of accounts.

Use for Rentals Select this field to specify that the category is used for rental management (including for the visual

planner).

Rental Inspection

Code

Select the checklist that will be used for equipment handovers and returns, as well as maintenance.

Rental Insurance % Fill in this field if you want to specify a different insurance rate for this category than the rate

entered in setup.
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Set up additional rental lines

Additional rental lines can help you with filling in a rental document. You enter on them items and resources that should be

added automatically to any rental quote or order that you create.

The lines ensure that documents include, for example, an insurance policy, the sales items needed for machine rentals, and the

names of service technicians.

Additional lines are created based on the category that a rental item belongs to. You can specify standard items, G/L accounts, or

resources here. Unlike a rental component, an additional rental line is entered in the form of a new line on a document, typically

together with a calculation value. 

We recommend that you use components assigned to a rental item when you need to rent (and record) additional parts that, for

example, must be delivered during handover. This way, they are shown on documents but are not entered on separate lines (and can

then be used on instruction sheets or for tool setup).

Pricing

To set prices for renting equipment, open the Rental Prices page by using the Tell Me function, or choose Actions > Rental Prices

on the role center.

Rental fees are created based on item categories and rental price groups. A group contains, for example, corporate prices only.

Like in sales, this feature can be used to:

assign block prices and minimum quantities to item categories.

show amounts with or without VAT.

assign a sales type to a customer price group, a campaign, or a single customer.

specify price validity via starting and ending dates.

view historical price data.

Resources

Billing

You must create at least one resource for settling rental invoices.

Open the relevant resource card.

On the General FastTab, turn on the Billing Resource toggle.

Select Hours in the Base Unit of Measure field.

Add another measure for days so that the system can convert between units of time.

You can create more than one billing resource if you need to post an item category to different accounts depending on the

situation.

No prices are directly stored with a resource.

What resource is used to bill what type of item can be specified on the Item Categories page. To link a G/L account to rental

equipment:

Open the Item Categories page.

Fill in the Rental Resource No. field.

Insurance

Tipp

• 

• 

• 

• 

• 

1. 

2. 

3. 

4. 

Note

1. 

2. 
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To calculate added insurance costs (for example, to cover downtime or theft of machinery), you also need an insurance resource.

Open the relevant resource card.

On the General FastTab, turn on the Rental Insurance Resource toggle.

If insurance fees are billed as a lump sum, set the Base Unit of Measure field to Piece. If they’re calculated based on the number

of days that the item is to be insured, fill in the field with the unit set up for billing by day.

Rental items

To create a rental item:

Choose the Search icon, enter Rental Items, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following.

You must choose New; the other, similar-sounding action on the ribbon—New Item—is run to create standard, not rental items.

General

Because rental equipment and machinery must always be bought upfront, the relevant item is often already available in the

system so that it can be used as a template for the rental item. The rental item then inherits the categories, the description, and

the search terms from the standard item.

1. 

2. 

1. 

2. 

3. 

Note
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Rental items originate from standard service items. This means that they’re listed on the Service Items page as well. Like in the

standard app, you also cannot delete them after they’ve been posted.

Customer

On this FastTab, you can see the customer for whom service orders, or follow-up services, might be created when a rental item is

returned.

Vendor

Here you can add information about the vendor.

Details

On this FastTab, you can add fields for informational purposes.

Ribbon functions

The functions on the ribbon can provide you with more detailed information about the rental item, such as what standard items it

is related to, which checklists have been set up for it, when it is available, and what it looks like.

Show operating hours

Shows the current number of hours an item has been in operation. The value is updated when you post a return to a rental order.

Additionally, you can see here whether hour-counting has been reset.

Rental item bom

Shows where you can enter components for this item.

Note

Field Description

Rental Item Selected automatically to specify the item as a rental item.

Responsibility Center Select a location to specify who has access to the rental item. The location must be set up and the

relevant users must already be assigned to it.

Rental Calendar Code Specify a calendar for the rental item. This calendar might be different from the base calendar, for

example, because you want to rent and bill equipment also on weekends.

You only need to fill in this field if the period for which the item is rented out differs from your

usual schedule. As an example, a construction dehumidifier might need to run 7 days a week,

whereas other machinery is used only during work hours.

Capitalized

Fixed Asset No.

These fields are selected automatically when the item is capitalized. For more information, see 

Fixed Asset Capitalization.

Rental Insurance Cost

Amt.

Turn on this toggle if item insurance costs a certain amount per day covered and isn’t based on a

percentage of the total.

Rental Insurance Cost

Amt. (per Day)

If necessary, specify an amount that will be used to calculate item insurance per day.

Example

Although the item has been rented out from this Monday to Tuesday next week, the days it will

need insurance on might be fewer (9 calendar days in total, of which the machine will be in

operation on 7, that is, excluding weekends).

Your rental calendar determines how many days coverage will apply. The system copies this

number to rental orders automatically.
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In contrast to additional rental lines, components specify parts that will be supplied with the rental item in any case. Examples are

safety vests and similar gear.

Rental item capacity

Like resources, rental items require capacity for planning purposes. Capacity must be set up for each item individually.

Capacity settings also have an impact on general item availability. When you start up new equipment, you can, for example, fill in

the Starting Date field to specify that the machine should already be listed as available for rent. In the same way, you can use the

Ending Date to specify when certain items will no longer be in use.

Set capacity

On the role center, click Plan > Item Rental Capacity, or open the page by using the Tell Me function.

On the Matrix Options FastTab, in the View By field, specify the period for which rental items should be shown.

Select the rental item that you want to set capacity for, and then choose Create Capacity on the ribbon.

Specify a starting date and an ending date. If you’ve set up work-hour templates, you can select one here.

Specify for each weekday how long the item should be available.

Choose Set Capacity to fill in the Item Rental Capacity matrix.

By clicking the Avail. Rental Items tile on your role center, you can then see if a certain item can be rented out.

Handover reports and checklists

In trade365, you can create reports to document the handover and return of rental items. See also Rental Orders. To set up the

feature:

On the role center, choose Setup > Rental Checklists.

On the ribbon, choose New.

Specify a code and a description for the report, and then choose Report Q&A on the ribbon.

In the Type field, select Question, and then enter the checklist question.

On the next line, select Answer, and then fill in the Description field.

More than one line following a question can be set up as an answer line, and you can specify on each if multiple answers are

allowed.

Example

You create one line of the Question type where you enter Tank Capacity in the Description field. You then create three lines of

type Answer, with descriptions ranging from Full to Half-Full to Empty. You then specify that only one answer is allowed for the

question.

Follow-Up Service

This function can help with scheduling item availability and ensuring that your rental equipment stays in perfect condition.

You can also decide here whether to include fees for fuel service or damage repair on final invoices. Additionally, you can use the

feature to allocate time for cleaning and maintenance, for example.

A service order is then created automatically after equipment is returned to you.

You can also open Follow-Up Service Setup by choosing Setup > Rental Follow-Up on the role center.

Note

1. 

2. 

3. 

4. 

5. 
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WORKFLOW

Rental quotes

Rental quotes can only be created for actual customers; writing a quote for a contact isn’t possible. Quotes are typically created

at item category level, that is, assigning a quote to a certain device isn’t necessary at this point.

However, you must select a specific rental item if a quote should be included in capacity planning. Extended texts and alternative

addresses are entered in the sales area.

You need to ensure that the Long-Term Rental toggle is turned off on the document, as the toggle only applies to orders. You can use

the Personalize function to hide it.

Create a quote

Choose the Search icon, enter Rental Quotes, and then choose the related link.

On the ribbon, choose New.

On the General FastTab, specify a customer, and then fill in the other fields as necessary. If you’re using price groups for rental

management, you need to select a group here.

On the Lines FastTab, select the category of items you’re writing a quote for. The billing resource assigned to the category is then

copied to the line automatically.

Specify a rental period by filling in the Rental Starting and Ending Date fields. When you bill by day, the start and end times are set

to 00:00 and 23:59, respectively. However, you can change them, if necessary.

A page with rental lines opens if you’ve created any for the item category. Select Apply on the lines that you want to retrieve and

exit the page by choosing OK.

You can then add more rental item, sales item, or resource lines, if necessary. When you’ve entered them all, you can release the

quote and print or send it like any other document in the system.

Use the Personalize function to sort the columns on rental quotes so that the date and time fields are shown to the right of the item

category. 

This help section is still being expanded. More content will follow soon. 

RENTAL ORDER

Create a rental order

You can create a rental order in multiple ways:

Open an existing rental quote, and then choose Make Order on the ribbon to create a rental order from the information

entered on the quote. You can then change or enter new content on the order.

On the home page, choose Rental Orders, and then choose New to create a blank rental agreement.

Open the Rental Orders page by using the Tell Me function, and then choose New on the ribbon.

Most sales order fields and functions can also be found on rental orders, with a few exceptions.

For example, to rent a specific item, you need to fill in the Rental Item No. field on a line. If you use a lookup on the field, you’ll

see the items with the required availability and capacity for rental during the period specified on the order.

Note

1. 

2. 

3. 

4. 

5. 

6. 

7. 

Tipp
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After you’ve entered all items, you can release the order.

Long-term rentals

With the long-term rental feature, you can invoice rental orders periodically based on a certain date or a billing interval. To set

up a long-term contract:

Open a rental order.

On the General FastTab, turn on the Long-Term Rental toggle.

You can now edit the relevant fields on the header to specify a formula or fixed starting and ending dates.

Post a rental shipment

When an item is handed over to a customer, you must post a rental shipment.

Open a rental order.

Select the relevant item line.

On the ribbon, choose Rental > Post Rental Shpt.

If components are assigned to the rental item, you can now document any damage, as well as the handover process.

Under Comments, you can enter remarks or, if necessary, describe the condition that the rental item is in, as a basis for comparison

when the item is returned.

After handover, the Rental Shpt. Posted field is selected automatically on the line.

The checklists accessible from the Rental Order page are used as a receipt for the customer when rented equipment is handed

out or returned. To print them, choose Actions > Print on the ribbon.

The other items you hand over to the customer with a rental order are supplied with the help of warehouse shipments or picks.

The traffic light system on rental orders, on the other hand, only relates to item purchases created from the order.

Rental interruptions

Rental interruptions make it impossible to use rented equipment, for example, because extraordinary circumstances disallowed

its use, or because the item became defective during the rental period and had to be repaired on site.

To be able to document these situations on an order and therefore on the final invoice, trade365 provides you with the rental

interruption feature.

With this feature, you can set the criteria that must be met for an interruption period to be free of charge to the customer. The

feature only applies to rental fees, not insurance costs.

The interruption also doesn’t change the overall rental period. This means the ending date specified on the order remains. For

example, a customer rents an excavator from March to November, but winter strikes again in April.

Workflow

Open a rental order.

On the Lines FastTab, on the ribbon, choose Rental > Interruption.

Specify the period in which the rental item cannot be used (enter the exact times, if possible).

Specify the interruption quantity.

In the Comment field, include the reason for the interruption.

Choose OK.

You’re asked if the rental lines should be adjusted. Choose Yes to reduce the quantity on the lines by the Interruption Qty.

Extend or cut short a rental

For extending or cutting short a rental period, change the ending date on a rental order, and then confirm the rental lines to

adjust the insurance cover.

1. 

2. 

3. 

1. 

2. 

3. 

4. 

5. 

6. 

1. 

2. 

3. 

4. 

5. 

6. 

7. 
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CAPITALIZE ASSETS

Capitalization is used to depreciate an asset over its useful life. In trade365, assets can include rental items, for which equipment

must first be bought in Microsoft Dynamics 365 Business Central1.

If it hasn’t been, you need to set up and capitalize the equipment in the fixed asset area before assigning it to a rental item.

Consult with your financial department before making any changes to this area.

Setup for automatic capitalization

Choose the Search icon, enter Fixed Asset Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, fill in the fields in the Rental Item Capitalization section as described in the following

table.

Fixed asset posting groups

Additionally, specify an offset account for rental item acquisitions on the FA Posting Groups page.

The account is required if you use a G/L-integrated depreciation book to post, filling in a general fixed asset journal.

Item categories

You need to use the following category fields for a rental item to create a fixed asset and depreciation books:

Depreciation Book Code

FA Posting Group

No. of Depreciation Years

FA Class Code

FA Subclass Code

Depreciation Method

2nd Depr. Book (if you use two; otherwise, leave the field blank).

Note

1. 

2. 

Field Description

Item Journal

Template

Specify the journal template that will be used to remove the item from current assets.

We recommend that you create a separate template for this purpose. Only templates of the Item

type can be used.

Item Journal Batch Select the journal name from the template that you selected in the previous field.

We recommend that you create a separate journal for capitalizing rental assets.

Note

The journal must be set up in the system. As an alternative, you can create a new journal here by

choosing New on the ribbon.

Capitalization Nos. Specify a number series that will be used for item removal.

FA Journal Nos. Specify a number series that will be used to post rental assets through a fixed asset journal.

FA General Journal

Nos.

Specify a number series that will be used to post rental assets through a general fixed asset journal.

• 

• 

• 

• 

• 

• 

• 
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Source Code Setup

Choose the Search icon, enter Source Code Setup, and then choose the related link.

On the KUMAVISION trade365 FastTab, fill in the Rental Item Capitalization field.

Workflow

To capitalize rental equipment, you must run the Capitalize Rental Item action from the relevant rental item card.

Remove item from current assets

As a first step, the system checks if the item is part of current assets.

For this purpose, it searches for Purchase-type item entries that relate to the entered serial number.

If no corresponding entries are found, the process is cancelled.

If an entry exists, the item journal that you set up is filled in and the item is removed from the current journal.

Create and post an asset

After the item has been removed, the system creates a fixed asset card and the relevant depreciation books. Depending on how

they’ve been set up, one of the following journals is then filled in and posted to:

With G/L integration: Fixed Assets Journal.

Without G/L integration: Assets Journal

If you’ve set up two books, only the standard book is used automatically. For additional depreciation books, the system will create

a (general) fixed asset journal line, and you’ll be notified of this so that you can post the line (in the standard app, the journal is

filled in, but nothing is posted directly either).

Copy data to an item card

Following successful capitalization, fixed asset information is copied to the rental item card. The Capitalized field is then selected

on the card while the Fixed Asset No. field is filled in as well.

You can see the number of the asset and its current book value in the Service Item FactBox to the right.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Alloy/Metal Surcharges

With this feature, you can add alloy and other metal surcharges to sales and purchase documents in Microsoft Dynamics 365

Business Central1. You can also use an API to see the prices that alloys and other metals needed by your company are traded at

on certain exchanges.

Tracking exchange prices can carry additional costs beyond app licensing.

SETUP

Alloy Surcharge Setup

To be able to use the feature:

Choose the Search icon, enter Alloy Surcharge Setup, and then choose the related link.

Fill in the fields as described in the following tables.

General

Metals-API

Hinweis

1. 

2. 

Field Description

Enable in Sales Turn on this toggle if you want to use alloy surcharges in sales.

Enable in

Purchasing

Turn on this toggle if you want to use alloy surcharges in purchasing.

Web Service

Integration

Specify the API that will be used to retrieve metal prices.

None

An interface should not be used.

Metals-API

Prices are retrieved via the Metals-API.

If this option is selected, the Metals-API FastTab, as well as the Open Metals-API Web Service and

Map Metals-API Surcharges actions, are unhidden on the setup page.

Metals.Dev

Prices are retrieved via the Metals.Dev API.

If this option is selected, the Metals.Dev FastTab, as well as the Open Metals.Dev Web Service and

Map Metals.Dev Surcharges actions, are unhidden on the setup page.

Note

The costs incurred through the use of any such interface are not part of trade365 licensing fees.
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This FastTab is only shown if you selected Metals-API in the Web Service Integration field.

Metals.Dev

This FastTab is only shown if you selected Metals.Dev in the Web Service Integration field.

Note

Field Description

Metals-API URL Specify the URL for retrieving prices from an exchange.

By default, this field is filled in with the following internet address: https://metals-api.com/api/latest?

access_key=

Metals-API Key Enter the key you have received for commercial use of the API.

Metals-API Base

Currency

Specify the base currency that will be used for retrieving prices.

Job Queue Entry Turn on this toggle if you want to create a job queue entry for the daily retrieval of alloy prices via

web service integration.

You can adjust this entry later if prices should be updated, for example, in 10-minute or 60-seconds

intervals (depending on what options are available to you as per your API payment plan).

Note

Field Description

Metals.Dev URL Specify the URL for retrieving prices from an exchange.

By default, this field is filled in with the following internet address: https://api.metals.dev/v1/latest?

api_key=

Metals.Dev Key Enter the key you have received for commercial use of the API.

Metals.Dev Base

Currency

Specify the base currency that will be used for retrieving prices.

Job Queue Entry Turn on this toggle if you want to create a job queue entry for the daily retrieval of alloy prices via

web service integration.

You can adjust this entry later if prices should be updated, for example, in 10-minute or 60-seconds

intervals (depending on what options are available to you as per your API payment plan).
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Alloy surcharges

To assign surcharges to individual alloys:

Choose the Search icon, enter Alloy Surcharges, and then choose the related link. Alternatively, run the Surcharges function when

you’re on the Alloy Surcharge Setup page.

On the ribbon, choose New and then fill in the fields as described in the following table.

Exchange prices

Besides entering a base price for an alloy, you can choose Exchange Prices on the ribbon to maintain prices for a limited period.

If the web service integration is turned on, daily prices are stored on the page.

1. 

2. 

Field Description

Code Specify a unique code for the surcharge.

Description Specify an additional description for the surcharge.

Item Charge No. Choose a surcharge from the Item Charges page (or create one).

Unit of Measure Select the unit of measure that the surcharge will be based on. Options are:

• Gram (g)

• Kilogram (kg)

• Metric Ton (t)

• Pound (lb)

• Ounce (oz)

• Troy Ounce (oz t)

Base Price Specify a base price for the surcharge.

Procurement Costs % Specify the percentage that you want to add to the current (precious metal) price.

Field Description

Trading Date Specifies when the price was retrieved.

Trading Time Specifies at what time the price was retrieved.

Exchange Price Specifies the price at the date and time shown.

Unit of Measure Specifies the unit of measure that the price is shown in.

A unit that is maintained on the related Alloy Surcharge Card is automatically retrieved for this

price line.

Metals-API Metal Type

Metals.Dev Metal Type

Shows in connection with the price the type of alloy surcharge mappings.

Note

You can only see this field if you selected Metals-API in the Web Service Integration field in Alloy

Surcharge Setup.

Metals-API Exchange

Price

Metals.Dev Exchange

Price

Shows the price quoted for the specified metal.

Note

You can only see this field if you selected Metals-API in the Web Service Integration field in Alloy

Surcharge Setup.

Metals-API Base

Currency

Metals.Dev Base

Currency

Shows in connection with the price the base currency from alloy surcharge mappings.

Note

You can only see this field if you selected Metals-API in the Web Service Integration field in Alloy

Surcharge Setup.
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Auto-retrieve metal prices – exchange interface

If you want to use an interface to track the exchange prices for certain metals each day, select Metals-API or Metals.Dev in the

Web Service Integration field in setup, and then enter your password credentials for the commercial use of the API on the

relevant FastTab. You also need to turn on the Job Queue Entry toggle on the tab.

Map API prices to surcharges

For metal prices to be shown, you must tie the surcharges set up in Microsoft Dynamics 365 Business Central1 to the metals

traded on an exchange.

Open Alloy Surcharge Setup.

On the ribbon, choose Map Metals-API or Metals.Dev Alloy Surcharges.

Fill in the fields as described in the following table.

The price retrieved for the metal is then assigned to the relevant surcharge on the Exchange Prices page.

Assign surcharges to items

You also need to assign the surcharges to the corresponding items set up in the app.

Open an item card.

If the Alloy Surcharges Exist toggle is turned off on the Item FastTab, choose Related > Item > Other > Alloy Surcharges.

Fill in the fields as described in the following table.

1. 

2. 

3. 

Field Description

Alloy Surcharge Code Select one of the surcharge codes available in the system.

Metal Type Select the type of metal and the exchange it is traded on (as per your API).

Metal Type UOM Shows the unit of measure that this type of metal is traded in.

1. 

2. 

3. 

Field Description

Variant Code Specify the variant that the surcharge will be used for. If the item has no variants, this field remains

empty.

Alloy Surcharge

Code

Assign the relevant surcharge to the selected item.

Alloy Weight Enter the weight of the alloy item per base unit of measure.

Example

An alloy surcharge for copper is assigned to item Cable. Whereas the item is specified in meters, the

alloy is measured in grams. With one meter of cable containing 500 grams of copper, the weight that

needs to be entered in this field is 500.

Unit of Measure Specifies the unit of measure used for the selected alloy surcharge.

Use in

Purchasing

Specify for the selected line if the alloy surcharge should be used in the purchasing area.

Note

This toggle takes priority over the toggle in Alloy Surcharge Setup.

Use in Sales Specify for the selected line if the alloy surcharge should be used in the sales area.

Note

This toggle takes priority over the toggle in Alloy Surcharge Setup.
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Surcharges on customer cards

To set up different alloy surcharge calculations for customers.

Open a customer card.

In the Alloy Surcharge Per field, select one of the options described in the following table.

The default option for all customers is Day.

WORKFLOW

Alloy/Metal Surcharges in Purchase or Sales Documents

Following setup, you can use the surcharges in sales or purchasing, or both.

Create a sales or purchase document.

On a document line, choose an item that you’ve specified a surcharge for. When you enter a quantity for the item, the surcharge is

added to the line as specified in setup.

If you change the item or delete the line, the associated surcharge lines are also deleted.

During posting, alloy surcharges are treated by the system like any other item charges.

For more information, see Assign item charges to sales and purchases - Business Central | Microsoft Learn.

Alloy/Metal Surcharges quantity shipped

The automated allocation of alloy surcharges is taken into account for partial deliveries in sales. To ensure this, the "None"

option must be selected in the "Auto Post Non-Invt. via Whse." field in the "Sales & Receivables Setup". The "Attached/Assigned"

and "All" setup options are not supported.

As soon as the "One-time delivery per order" switch is activated in a sales order and a partial quantity of the item line is

delivered, the surcharge/discount quantity for the alloy surcharge is reduced by the same quantity as the item quantity.

The alloy surcharge is not taken into account in the "Lost sales" report.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

1. 

2. 

Option Description

Day Use the price for the current day to calculate alloy surcharges.

Note

The system retrieves the most recent price if none can be determined for the given day. If multiple prices

exist for the same day, they are averaged.

Last Week Uses last week’s average price as the basis for alloy surcharges.

Last Month Use last month’s average price as the basis for alloy surcharges.

Last 3 Months Use the last three month’s average price as the basis for alloy surcharges.

Note

1. 

2. 

3. 

Note

1. 
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General Setup

DEACTIVATE SALESPEOPLE AND PURCHASERS

By specifying salespeople or purchasers on documents within the system, you can, for example, decide which contact details

should appear on printouts. But if an employee leaves your company, their salesperson or purchaser code can no longer be

deleted from the relevant master table.

As a result, the number of salespeople or purchasers that are available in the system but cannot be selected on documents might

grow to untenable levels. To prevent this:

Choose the Search icon, enter Salespeople/Purchasers, and then choose the related link.

Open the relevant Salesperson/Purchaser Card.

On the General FastTab, turn on the Inactive toggle. 

The salesperson or purchaser is then not listed anymore when you use a lookup on documents, as overviews are filtered for

active staff members. If necessary, however, you can remove the filter on a view.

1. 

2. 

3. 
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1.2.9 medtec365

KUMAVISION medtec365

Fully integrated into Microsoft Dynamics 365 Business Central1, medtec365 empowers medical device companies to manage day-

to-day operations with ease by providing industry-specific production, sales, and service functions.

TOPICS

General Business Functionality

Financial Management

Sales

Purchasing

Manufacturing

Warehouse Management

Service

Batch Production

Subcontracting

Multi-Order Subcontracts

Equipment Tracking

Compliance

Complaints, Warranty Claims, and FMEA

Workflow and Notification Manager (WNM)

MDR Document Management

General Setup

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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General Business Functionality

The following features expand standard Microsoft Dynamics 365 Business Central1 functions to provide additional options to

those using General Business Functionality.

FOLLOW-UPS

With the Follow-Up feature, you can conveniently set up reminders for tasks in various places in the app and send each reminder

to a user or a whole team.

Setup

Teams

To be able to send a reminder to multiple staff members (users) at once, you must assign them to a team.

Choose the Search icon, enter Sales Teams, and then choose the related link.

On the ribbon, choose New, and then fill in the fields on the line.

Again, on the ribbon, choose Home > Users to add members to the team.

If a user is assigned to multiple sales teams, automatic assignment only works when one of them is selected as the user’s main team.

Task templates

To specify task templates for follow-ups:

Choose the Search icon, enter Follow-up Tasks, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Task groups

Multiple follow-up tasks can also be combined into groups.

Choose the Search icon, enter Follow-up Task Groups, and then choose the related link.

Fill in the fields on the header as described in the following table.

You can then add tasks to a group on the Lines FastTab. You can also specify here whether a certain team is responsible for

handling them.

Workflow

Create a follow-up

1. 

2. 

3. 

Note

1. 

2. 

3. 

Field Description

Code Specify a code for the task.

Description Specify a description for the task.

1. 

2. 

Field Description

Code Specify a code for the task group.

Description Specify a description for the group.
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You can create follow-ups on a variety of pages. To set up a reminder:

Open the relevant page.

On the ribbon, choose Create Follow-up.

This opens the Follow-up Card on which your user ID (and, potentially, a team code) is filled in automatically. You can then enter a

short description for the task in the Summary field.

On the Follow-up Tasks FastTab, choose the relevant task codes or fill in the lines manually. Alternatively, specify a group of tasks

on the header, and then choose OK.

The Description field always shows the next task that you created a reminder for.

Reassign tasks

If a task should be assigned to a(nother) team, turn on the Team Task toggle on the General FastTab. The current user is then

automatically deleted, and you can assign the task to a team. If the task should be completed later, you can adjust the follow-up

date on the tab as well.

Create follow-on tasks

A follow-on for a follow-up can be created for all or individual tasks.

Open a Follow-up Card.

On the header, choose Create Follow-on. Alternatively, select a single task on a line and choose the same option there.

If only a line is selected, the task is retrieved directly and, if specified, the new team is assigned to it immediately.

The original reminder is then set to Completed, and the number of the follow-on will be shown instead.

Complete follow-ups on role center

To open and edit reminders that you set up for your own tasks:

Go to the role center, and then choose the Own Follow-ups tile.

Select a follow-up.

On the ribbon, choose Edit. Again, on the ribbon, choose Under Review.

WARNINGS

In medtec365, you can store warning messages that will be shown in the marketing cockpit when you open certain contact or

customer cards.

Such a message might be needed because of the presence of an infectious disease at a customer’s premises, for example. Based

on how the warning has been set up, you’ll see it on the header of the card, in running text, or in a separate box.

To set up a warning:

Choose the Search icon, enter Marketing Cockpit List, and then choose the related link.

Open the relevant cockpit.

On the ribbon, choose Related > Contact > Warnings.

Assign a warning message from the list and select if you want the specified message shown in the Warning field or in running text.

Warning messages can only be assigned with the appropriate permissions in place, that is, the Edit Internal Information toggle on

the relevant User Setup Card needs to be turned on for this. You can find the toggle on the Cockpit View FastTab.

QUICK DATA CAPTURE WITH WIZARD

The Quick Contact Capture Card is a separate record that you can create base data from, including contact, customer, and

vendor information.

1. 

2. 

3. 

4. 

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 

4. 

Note
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The card is created before the actual contact is, which has the advantage that you can interrupt the process and resume it later.

For this reason, quick capture is also used to set up customers and vendors, for whom contacts will be added as well.

Overall, the feature lets you set up data for each faster than any standard function. Additionally, you can use a configuration

template to reduce the actual entry to the essentials.

Example

When you set up a customer from a contact based on a template, you can even add to the record fields that aren’t typically found

on contact cards (such as Transaction Code).

Setup

medtec365 Setup

To be able to work with the feature:

Choose the Seach icon, enter medtec365 Setup, and then choose the related link.

On the Contact Cockpit FastTab, fill in the field as described in the following table.

Configuration templates

Configuration templates are used to generate meaningful base data from captured contact information. You can specify on a

template any field that is relevant to your business and should be filled in during capture, such as Gen. Bus. Posting Group, so

that you no longer need to enter data for it manually.

All templates are processed in the sequence that you can see in the following chart.

1. 

2. 

Field Description

Contact Quick Capture Nos. Specify a number series for quick contact capture.
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Template for quick contact capture

On this template, you can specify the standard and additional fields that will be filled in during contact capture. The additional

fields will also be added to the new master records for contacts, and—potentially—customers and vendors later.

Additionally, you can specify here what other contact information you want to store and the template that this information should

be based on. For example, turning on the Create Customer toggle will also create a customer from the entered data while filling

in the Customer Templ. Code field specifies the template that will be used for setting up this new customer.

For contacts

Only fields specified on this template are filled in during quick capture, whereas the additional fields that might be assigned to

the relevant contact template are ignored. The additional fields specified for quick contact capture, however, will be transferred

to the new contact.

For customers

Only fields specified on this template are filled in during quick capture, whereas the additional fields that might be linked to the

relevant customer template are ignored. The additional fields specified for quick contact capture, however, will be transferred to

the new customer.

For vendors

Only fields specified on this template are filled in during quick capture, whereas the additional fields that might be assigned to

the relevant vendor template are ignored. The additional fields specified for quick contact capture, however, will be transferred

to the new vendor.

Additional fields are only inherited if they’ve been set up at the required places in the app. This means that if you want one of these

fields to be transferred from a certain template to quick contact capture, and to the contact and customer from there, the field must

be set up for the template, contact capture, the contact, and the customer.

Setup

Choose the Search icon, enter Configuration Templates, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

General

Lines

When a table has been selected, you can specify on the lines the field values that you want automatically copied from the

template to the table.

Other

On this FastTab, you can attach additional fields to the template. These are then also used in quick capture.

Note

1. 

2. 

3. 

Field Description

Code Specify a code for the template.

Description Specify a description for the template.

Table ID Specify the table that needs to be filled in from the template, for example, Contact Quick Entry (table ID

71076624).

Table Name Shows the name of the table entered in the Table ID field.

Activated Turn on the toggle to allow the template to be used.
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Additional fields are only inherited if they’ve been set up at the required places in the app. This means that if you want one of these

fields to be transferred from a certain template to quick contact capture, and to the contact and customer from there, the field must

be set up for the template, contact capture, the contact, and the customer.

Capture data

Quick capture can be run each time you want to set up a contact, a customer, or a vendor.

Open the marketing cockpit list.

On the ribbon, choose Quick Contact Capture.

Select the template that will be used to prefill and add fields to the relevant card, and then choose OK.

This opens the Quick Contact Capture Card, where a number will be assigned automatically. You can now fill in the other fields,

such as Name and Address.

On the ribbon, choose End Update.

Afterward, a mandatory field check is run and base data such as contact, customer, or vendor information is set up depending on

what you specified on the Create Data FastTab.

When exiting the page, the new record is selected on the Quick Contact Capture List and can be opened directly from there.

The field check is run for each record that you create.

Release data

If the mandatory field check is turned on for quick contact capture, base data such as contact, customer, or vendor information

can only be created if released—which depends on the status that is indicated in the Capture Update field, as described in the

following table.

You can run the End Quick Capture action to complete data maintenance and release the captured entry. If the required data

wasn’t filled in, a wizard page appears so that you can make the necessary adjustments.

After maintenance of the captured entry is complete, the Quick Contact Capture Card becomes non-editable.

To be able to edit data again, choose Edit Quick Capture on the ribbon to set the card status to In Progress.

List of captured entries

To see a list of all records that have been created through quick capture, choose the Search icon, enter Quick Contact Capture

List, and then choose the related link. Here, you can also capture new contact data or edit existing entries. 

Note

1. 

2. 

3. 

4. 

5. 

Note

Option Description

No Field

Check

The mandatory field check is not turned on for quick capture.

This means that data maintenance does not need to be completed. You can also enter more information, if

necessary.

In Progress The mandatory field check is turned on. However, data maintenance has not yet been completed.

As a result, more base data cannot be created.

Completed The field check has been run and maintenance has been completed.

More base data for contacts, customers, and vendors can now be added.
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Manual Capture

Additionally, you can create a record manually via quick capture mode.

Choose the Search icon, enter Quick Contact Capture List, and then choose the related link.

On the ribbon, choose New.

This opens the Quick Contact Capture Card. The card is empty, as no data from a template is copied to the entry.

Click any field to create a record. This assigns a number from the number series stored in medtec365 Setup. All other fields can be

filled in manually.

In this context, we recommend you consider the base data that you want to create from the captured entries and the templates

that you want to use for them. Or you can choose Apply Template on the ribbon and specify a configuration template for filling in

the information.

ITEM TRACKING

On installation, medtec365 provides you with a variety of tracking methods that are commonly employed across the industry and

can be used for all items set up in the system.

Color indicators

Line quantities might be shown in a different color if they relate to tracked items.

This applies to quantities on open purchase and sales documents, on warehouse shipments and receipts, and on item, transfer,

and inventory journals, as well as to quantities entered in manufacturing and assembly.

You can also use the lookup next to a quantity field to see the tracking code that is assigned to the associated item. The meaning

of each line color is explained in the following table.

Warranty dates for external lots

You can now specify manufacturing dates based on item tracking codes.

On the Item Tracking Code Card, on the Misc. FastTab, you can also fill in a variety of new fields relating to maintenance and

repair services. As an example, you can enter customer-side and vendor-side warranty periods in the Customer Warranty Until

and Vendor Warranty Until fields on the tab.

Serial No. Information Card

This card has been extended to include the fields described in the following table.

General

Vendor

This FastTab is required to provide maintenance and repair services.

1. 

2. 

3. 

4. 

Color Description

Red Lot or serial numbers are available but have yet to be assigned.

Blue Lot or serial numbers are available but only some of them have been assigned.

Green Lot or serial numbers are available and have all been assigned.

Field Description

Description 2 Filled in automatically with the Description 2 from the item or variant.

Registration No. Specifies the number assigned by a health insurance company to the medical equipment.

Field Check Status Indicates if a mandatory field check has been run.

Blocked By Shows if data is blocked by the field check or a user.
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You need to enter a vendor on the tab if a device has been acquired via a purchase order outside the scope of existing contracts

or from a competitor.

Customer

This FastTab is required to provide maintenance and repair services.

The fields on the tab specify who provided the instructions on how to use the device.

Other

Ownership & Rent

Field Description

Previous Owner

Previous Owner Search

Descr.

Specifies the contact or the search term for the contact who used to own the device.

Last Invt. Movement On Specifies when the item was last posted to inventory.

This field is updated with every movement of the item.

Last Invt. Mvmt. Location

Last Invt. Mvmt. Bin

Specifies where the device is stored.

These fields are updated with every movement of the item.

Last Variant Invt. Mvmt. Specifies the device variant.

This field is updated with every inventory movement.

Status Specifies the status of the device.

This field needs to be filled in manually.

Warranty Period

(Customer)

Specifies a warranty period based on a date formula.

This field is filled in when the device is posted as shipped.

Customer Warranty Until Filled in automatically based on the warehouse shipment date and the customer warranty

period.

Device Class Can be used to classify the serial number card.

You can enter any code you want.

Startup Date Filled in automatically when the device is shipped for the first time.

Vendor Warranty Until Filled in automatically based on the warehouse receipt date and the vendor warranty period.

Warranty Period (Vendor) Specifies a warranty period based on a date formula.

This field is filled in when the device is posted as received.

Repair Warranty Until Filled in when repairs are carried out.

Estimate Needed Specifies if the customer wants a cost estimate.

The field is automatically filled in with information supplied by the customer after sale.

Estimate Limit Specifies the value starting from which the customer wants a cost estimate for repairs.

This field is also filled in following a sale.

Scrapped If selected, the device is considered scrapped. You can only select this field after the device has

been removed from the item journal.

With the checkbox selected, the Blocked toggle is turned on automatically as well, and the

Scrapped By and Scrapped On fields will be filled in to log by whom and when the checkbox

was selected or cleared.

Maintenance Interval

(MPG Appendix 1)

Filled in with the information from the item card.

Additional Information This subpage lists the fields added to the serial number card and the related item card.
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This FastTab specifies who owns the device.

Provided the whereabouts of the device can be traced, the transaction code and the Location and Bin fields are filled in with the

values that were specified with the most recent warehouse posting.

If a device is sold only to one customer, the fields will be blank, but the Legal Owner and Legal Possessor fields will be filled in,

with the transaction code inserted in the correct way automatically.

Ribbon functions: Home

Ribbon functions: Customer Service

Ribbon functions: Actions

Field Description

Last Transaction

Code

Indicates whether the device has been loaned to someone. This field is refreshed with each

movement of the item.

If the field is blank, the device was sold without leaving a trace in the system.

Legal Owner Specifies the owner of the device.

If the field is blank, the device is owned by your company.

Legal Possessor Indicates the customer who is currently in possession of the device.

Field Description

Edit Serial No.

Info

End Update

Turns on the editing mode for the card or triggers the mandatory field check.

Inventory

Overview

Shows the inventory related to the item tracking code.

Equipment

Entries

If Equipment Tracking is used in the manufacturing area, shows the components linked to the device.

Also lists all expenses and spare parts incurred as part of servicing.

Attributes Shows the parameters specified for the device.

Item Ledger

Entries

Shows the movements of the device.

Find entries Shows all items, and purchase and sales documents referring to a serial number.

Field Description

New Case Creates a new case for the device.

Open Cases Shows all open cases for the device.

Completed Cases Shows all completed cases for the device.

Field Description

Edit Serial No. Info

End Update

Turns on the editing mode for the card or triggers the mandatory field check.

Attribute Search Used to search for device parameters based on the serial number.

Find entries Shows all items, and purchase and sales documents referring to the serial number.

Bar Code

Reservation

Specifies a barcode to which documents have been assigned in the document management system

(DMS for short).
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Ribbon functions: Related

BLOCK ITEMS WITHOUT VARIANTS

Typically, when the Variant Mandatory if Exists toggle is turned on in Inventory Setup, you’re blocked from posting transactions

for which an item variant isn’t specified.

This setting, however, doesn’t apply to items that don’t have variants. You can also change the requirement for individual items

by choosing No in the Variant Mandatory if Exists field on an item card.

Conversely, if the setup toggle is turned off but the Variant Mandatory if Exists field is set to Yes on an item card, transactions for

this item cannot be posted when variants exist but none is specified during a transaction.

To also block transactions from being posted if the item requires a variant but none has been set up for it yet in the item master,

you can create a field check that uses the Variant Exists field from the item card.

The Variant Exists field is hidden on the card.

Workflow

Inventory Setup

Ensure that the Variant Mandatory if Exists toggle is turned off on this page.

Item card

Set the Variant Mandatory if Exists field to Yes for items that require a variant.

Field check

Create a field check for table Item (27) that will result in an error message (as well as the cancellation of the posting process) if

certain fields are filled in on an item card as described in the following.

Compliance (optional)

Field Description

Item Tracking

Entries

Documents the movements of the device.

Comment Used to enter comments about the serial number.

Item Tracing Shows the serial number or component history (where included).

This field is only required for manufacturing.

Attributes Shows the parameters specified for the device.

Equipment Entries If Equipment Tracking is used in the manufacturing area, shows the components linked to the device.

Also lists all expenses and spare parts incurred as part of servicing.

Item Ledger

Entries

Shows the movements of the device.

Note

Operator Field Source Field No. Field Caption Condition

Type

Condition

Value

IF Table 122 Variant

Mandatory if

Exists

= Yes

AND Table 71076593 Variant Exists = 0
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We recommend that you also set up a compliance check to block the deletion of variants whenever the Variant Mandatory if

Exists field is set to Yes for an item that has already been released.

For this purpose, you must add the following line to the compliance tables:

Additionally, you need to fill in these fields on the Compliance Fields page:

You need a valid license to work with the Compliance functionality. For more details, see Compliance.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Code Table No. Table Caption Sorting Description No. of Field

Filters

Status

VARREQ 27 Item 0 Variant

Mandatory

1 Released

Field No. Field Caption Field Value

122 Variant Mandatory if Exists 2

71076593 Variant Exists 1

Note

1. 
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Financial Management

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s financial department.

ACCOUNTS RECEIVABLE DUNNING

Based on the dunning system of Microsoft Dynamics 365 Business Central[^1], the following fields and functions have been

added to KUMAVISION medtec365.

Consider payments until

When creating the reminder proposal, it is possible to enter a date in the "Take payments into account until" field up to which

date the posted incoming payments (account statements) have been taken into account. This date is taken into account when the

reminder is printed.

In addition to the existing variables in the dunning texts, the date value for the text "Payments taken into account until" can be

used with the variable %13.

Print dunning document

Report selections

To use the function described below, the report "Reminder 5048915" should be selected in the "Report selections - Reminder/

interest invoice" for reminders.

Dunning level in dunning lines

If different dunning levels have been used in a dunning notice, the highest dunning level is displayed in the header area and the

respective dunning levels of the documents are displayed for the individual items.

BOOKING LOGIC AND VALUE FLOW

Booking Codes

In KUMAVISION medtec365, the valuation type can be defined by booking codes depending on the booking process in order to

map the different ownership structures of the item stocks. During the posting process, the valuation type is determined internally

by the posting code and displayed in the posted item in the "Valuation type" field.

The following ownership structures can be shown:

Fixed assets which are moved via merchandise management 

Leased property which is permanently rented out by the customer 

Third-party property from cash registers which is shipped, stored / retrieved and maintained 

Current assets 

Current assets which are permanently rented out or used equipment

In KUMAVISION medtec365, a booking code is required for every item movement in the processes.

The use of the warehouse issue method "average" in the article master data is not intended in connection with the valuation type

"non-valuated" in KUMAVISION medtec365.

Booking Groups change to orders

On the "Purchase order types" page, you can use the "Booking groups" in the menu ribbon to open the "Order type dep. booking

groups" page. and set a specific redirection of the booking groups from the master data for a specific order type.

• 

• 

• 

• 

• 

Note
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Booking groups in order / service order

No booking group change can be pre-assigned in the sales order types. Booking groups can be changed manually in the order

line if required.

There is also no pre-assignment for a booking group change in service order types. Booking groups can be changed manually in

the service order line if required.

Posting groups change to item book sheet

For special postings via item ledger sheets, such as scrapping or own requirements write-off, separate item ledger sheets can be

created. Different parameters can be defined for these bookings via the book sheet names: 

Cause code ➔ Evaluation criterion 

Product posting group ➔ Possibility to control a separate warehouse correction account for scrapping; a dedicated product

posting group, e.g. "Scrapping", must be created for this purpose. The posting matrix must be supplemented accordingly for

this combination.

SYSTEM CAPITALIZATION

The system activation is an activation module that can only be used with additional licensing and activation.

Booking code for asset capitalization

The following setup parameters have an influence on the system activation:

Transfer of devices from current assets to fixed assets

Device access

When equipment is purchased, it is generally not known in which further processes, e.g. sales, rental, etc., it will be used.

The purchase is therefore usually made using a valued posting code such as UV (current assets). Further information can be

found under "Booking codes".

Activation criterion

• 

• 

Note

Field Description

Asset posting type The "Capitalization" option ensures that current assets can only be capitalized as fixed assets

from this posting code. This option is also used for posting codes for a data transfer.

The posting codes: UV-AKT, DÜ-AV always get this option.

Default code for accesses As a rule, the default booking code is UV (current assets). If no other code is entered, a

booking code with this marking is always pre-assigned.

Access only possible via

system activation

This field is only set to "YES" in posting codes that are linked to asset accounting through

capitalization (e.g. AV (fixed assets)).

This facility helps with reconciliation between asset accounting, general ledger accounting

and articles as well as in subsequent processes such as asset sales or asset scrapping.

Field Value

Booking code UV

Description Current assets

Valuation type Rated
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If a device has to be transferred in asset accounting because it is intended for long-term rental, it is usually transferred to the

customer via an order.

With this transfer posting, the posting code is changed from UV to UV-AKT (current assets to capitalization) via a delivery

hierarchy. Further information can be found under "Posting logic and value flow | Posting codes".

Only devices for which a purchase invoice has already been posted should be activated. This can be ensured if a filter is set to

"Purchase invoice no." not equal to empty in the "Attachment article book sheet" before posting.

Item Attachments Booklet

The serial number information card and the assignment of the respective device class (KUMAVISION Miscellaneous information

register) on the article card are required for the activation of serial number devices.

For the capitalization of devices (asset swap current assets -> fixed assets), the capitalization proposal "Fixed assets article book.

sheets" is available. It is possible to create several capitalization proposals via the book sheet names. Please note, however, that

a corresponding filter (e.g. for a specific booking code) must be entered when creating the proposal.

The report "Calculate article assets for capitalization" only takes into account article items with posting codes that have the

option Asset posting type = "Capitalization" in the posting code setup.

When calling up the report from the asset/article book sheet, filtering is carried out on the respective booking code "UV-AKT".

There may be other booking codes, e.g. "Buyback".

During activation, the start date for depreciation is always proposed as the first of the month of activation, but can be changed in

the proposal.

The notes in the "Warning" field are displayed in the info box for each line. Activation can take place despite a warning.

Errors in the "Warning" field are displayed in the info box for each line. Activation is not possible.

To ensure that the error messages in info boxes are displayed correctly, the object type Codeunit 71076692 

KVSMTCFAItemJnlCheckLine  must be stored on the "Application log batch run types" page for the code

"ANLAGENARTIKELBUCHBL".

After checking the lines, they are to be posted.

Posting the lines from the asset item book. -sheet create the asset master with the asset depreciation ledger and post the

acquisition costs. The serial number information list can be accessed via the info box for the asset master. Parallel to the

capitalization in asset accounting, a stock transfer takes place in the article items. When the capitalization is posted, the value is

derecognized in current assets and added to fixed assets.

Field Value

Booking code UV

Description Current assets

Asset posting type Activation

Note
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When the item is transferred, the posting code is changed from UV-AKT to AV (fixed assets).

Access via system activation is also controlled via the "Access book. for all booking codes" switch in the user setup.

Investment card

If the base article number or serial number in the system card is changed manually by a user, an activation message appears.

Device class

The specifications for activating the serial number item are defined in the device classes.

The device classes must be assigned to the articles that can be activated.

Most important parameters for activation:

Device class assignment

Since not all devices within a device class necessarily have the same value, but the value of the SNR device is decisive as to

whether a device should be capitalized as a low-value asset or not, there is the "device class assignment", which can be called up

via the device class.

The page is also helpful if the GWG limit should change.

Field Value

Booking code AV

Description Fixed assets

Valuation type Unrated

Access only possible via system activation Yes

Note

Field Description

Destination booking code AV

AFA book code E.g. HGB, tax, IFRS

Asset posting group Important for account determination

AFA method Ex. Linear

Useful life i. Y Plant axle group

Activate AFA book copying process Only relevant if two depreciation books are used.

2. automatically post AFA book on sale Only relevant if two depreciation books are used.

2. asset posting group Only relevant if two depreciation books are used.

2. AFA-Methode Only relevant if two depreciation books are used.

2. AFA book useful life i. Y Only relevant if two depreciation books are used.

2. AFA-book Only relevant if two depreciation books are used.
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If there are entries on the page, the activation proposal takes the entry into account and, if necessary, changes the device class in

the proposal so that the SNR device is activated with the correct settings. The "Device class" and "Subsequent device class"

fields are shown in the activation proposal so that they can be checked before activation.

Cancel asset capitalization

In medtec365, you can also reverse the capitalization of a fixed asset.

Open a fixed asset card.

Go to the FactBox on the right-hand side, and then choose FA Item Tracking > Cancel Line on the ribbon.

If you turn on the Delete Fixed Asset toggle when you run the action, the card of the fixed asset will be deleted, as will the (item,

value, and G/L) entries related to it.

If the toggle is left turned off, the card will be kept whereas the (item, value, and G/L) entries related to the asset will be

canceled.

Should you decide to capitalize the fixed asset again later, the existing card will be linked to it by using the serial number previously

assigned to the asset.

Analyze items in transit

The Items in Transit analysis shows you all shipped but unbilled items—information that might be particularly helpful at the close

of a month or year. In-transit analyses are mainly based on the value entries assigned to a certain item, enriched with data from

multiple fields found on the item card and on item and general ledger entries.

To run the analysis:

Choose the Search icon, enter Items in Transit, and then choose the related link.

On the Options FastTab, set filters as needed.

To update the analysis, run the Fill Value Entries action. The entry data is then copied to Excel, where you can use one or more

filters to customize each workbook (that is, the appearance of the pivot tables it contains).

Sell activated devices

Sales of capitalized SNR devices (cash register sales, sales to private individuals, etc.) can also occur as part of transaction

processing from the prescription processing area. The equipment sale is carried out via the sales order; the equipment is booked

out directly in the warehouse and in the fixed assets with the invoice.

Field Description

Activation start date When should the assignment take effect?

Activation end date

Operator Amount >=

Reference amount 800.01

Operator Amount <=

Reference amount 99999

Follow-on device class F>800

Note Example depreciation 4 years

Device class device class from the article master

1. 

2. 

Note

1. 

2. 
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It is also possible that such devices are debited via an item ledger sheet as part of an inventory or stock correction (loss,

scrapping, etc.) during the year.

If a device capitalized in asset accounting is sold, an associated asset is also sold, either directly or indirectly.

Direct asset retirement takes place if the "Automatic warehouse posting" switch has been activated in the warehouse setup.

Indirect asset retirement takes place if the "Automatic warehouse posting" switch has been deactivated in the warehouse setup

and the "Post warehouse adjustment to asset" batch run has subsequently been executed.

An entry is made for the process in the "Article tracking attachments" info box.

Return of sold av activated devices

The "Retrieve posted voucher lines to be canceled" function cannot be used for the return of sold AV equipment. These devices

may not be returned to fixed assets.

In the case of redemption on UV-AKT, the system already sold may not be used for activation.

The "Allow access booking for all booking codes" switch in the user setup must not be switched on without careful consideration. No

system is created and the device can no longer be sold. It is only possible to sell via an article booking sheet.

Scrap activated devices

A device with the booking code "AV" can always be retired directly via an article booking sheet. The associated asset is also

debited on this retirement.

The asset is debited automatically if "Automatic warehouse posting" is activated in the "Warehouse setup".

If "Automatic warehouse posting" is not active, the following reports must be run so that the asset is also debited:

Storage regulation fact. Inst. Prices 

Book stock adjustment 

Book stock adjustment in system

A corresponding entry is made for the process in the "Article tracking attachments" info box.

Report derecognition of scrap stock

Appliances that are to be scrapped can also be collected in a separate storage location and booked out using the "Scrap

warehouse write-off" report.

The setup for this process can be carried out via the "Warehouse setup".

By filtering on the booking code "AV", all activated serial number devices in the scrap warehouse are transferred to the article

book sheet.

If the "Post" checkbox is not set for the "Write-off scrap warehouse" report, the disposals are transferred to an item ledger sheet

that was defined in the "Warehouse setup".

Note

• 

• 

• 

Field Description

Scrap Storage location filter Here you can define a storage location from which the "Scrap warehouse write-off" report

should carry out the write-off.

Derecognition of book page

template

Here you can define the item book sheet template that the "Scrap warehouse write-off"

report uses to write off the item.

Derecognition of book page

name

Here you can define the article ledger sheet name that the "Scrap warehouse write-off"

report uses to carry out the write-off.

1.2.9 medtec365

- 1024/1545 - Copyright © 2018 - 2024 KUMAVISION AG



It is advisable not to activate the "Post" button directly when running the "Scrap warehouse clearing" report, so that the postings

can be checked in the book sheet beforehand.

When goods are removed from the "Scrap warehouse", the corresponding asset is also automatically posted, provided that

"Automatic warehouse posting" is activated in the "Warehouse setup".

If "Automatic warehouse posting" is not active, the following reports must be run so that the asset is also debited:

Storage regulation fact. Inst. Prices 

Book stock adjustment 

Book stock adjustment in system

A corresponding entry is made for the process in the "Article tracking attachments" info box.

If the "Post stock adjustment in system" report is run without the "Post" button, only a report output is created.

As part of the processes, it must be ensured that capitalized devices are also booked out to fixed assets on an accrual basis using

the "Post stock adjustment to fixed assets" report. This must be run regularly (at least as part of the month-end closing). The

report takes into account article items with the type "Retirement".

Report post warehouse settlement in system

If a device activated in asset accounting is booked out (sale or disposal), an associated asset is also booked out directly or

indirectly.

Direct asset retirement takes place if the "Automatic warehouse posting" switch has been activated in the warehouse setup.

Indirect asset retirement takes place if the "Automatic inventory posting" switch was deactivated in the warehouse setup and

the "Post inventory adjustment to asset" batch run was subsequently executed.

Activation of existing assets in data transfer

Devices that have already been capitalized in Asset Accounting must be given special consideration in the data transfer. The

following steps should be taken into account:

Devices should be transferred individually per serial number via the inventory to a booking code DÜ-AV (non-valuated).

Assets should be set up with reference to the "Base article no." and "Serial no." of the device 

After assets have been set up and the acquisition costs and depreciation have been transferred, an activation should be carried

out for the booking code DÜ-AV.

POSTING IN GENERAL LEDGER

Chart of accounts - In use

The "In use" field can be displayed in the chart of accounts. A filter on this field allows you to quickly determine which accounts

are used in other tables, such as the posting matrix.

• 

• 

• 

Note

• 

• 

• 

Field Value

Booking code DÜ-AV

Description Data transfer for activation

Valuation type Unrated

Asset posting type Activation

• 

• 
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NOTE VAT EXEMPTIONS ON SALES DOCUMENTS

Pursuant to Section 14, Paragraph 4.8 of the German Value Added Tax Act (UStG), invoices for tax-exempt deliveries across the

European Union must contain a note informing about the exemption while citing Section 4 Subsection 1 Paragraph ‘b’ in

conjunction with Section 6 UStG.

For this purpose, you need to set up a footer text and specify the language code and the general and VAT business and product

posting groups required for showing this statement.

Choose the Search icon, enter Footer Setup (Sales), and then choose the related link.

Fill in the fields as described in the following table.

You can then enter the statement that should be shown in the footer on the Footer Text FastTab.

The footer text will only be shown on documents that contain the specified language code and general and VAT business and product

posting groups.

COMBINE SHIPMENTS ON CUSTOMER LEDGER ENTRIES

You can now store numbers for combining shipments in the Combine Shpts. Billing No. and Detailed Combine Shpts. Billing No.

fields on customer ledger entries, to be used for ledger entry application in the OPplus app.

1. 

2. 

Field Description

Entry No. This number is assigned automatically when a text is created.

VAT Bus. Posting Group Specify the VAT business posting group that you want to show the statement for.

VAT Prod. Posting Group Specify the VAT product posting group that will be required for showing the statement.

Gen. Bus. Posting Group Specify the general business posting group that you want to show the statement for.

Gen. Prod. Posting Group Specify the general product posting group that will be required for showing the statement.

Language Code Specify the language that the statement should be used for.

Standard Text Code Assign a standard text code to the statement.

Mark Specify the reference mark for the footnote.

Note
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Sales

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s sales department.

BACKLOG

With this feature, you can specify for each customer how you want backlog printed on a shipment note.

Open a customer card.

On the Misc. FastTab, in the Print Backlog field, select one of the options described in the following table.

SHIPMENT MULTIPLES

If necessary, you can specify that items or item variants entered on sales document lines can only be shipped in multiples of a

certain lot size.

Setup

Sales order types

On the Sales Order Types page, you can decide for each order type whether you want to use the feature by turning the Ignore

Shpt. Multiples toggle on or off.

Items

On an item card, on the Misc. FastTab, you can specify in the Shipment Multiple field the multiple that will be used for the given

unit of measure.

For items sold in more than one unit, the multiple is adjusted based on the unit of measure that you enter on the relevant document.

As an example, if the typical unit an item is sold in is 15 pieces, selling the item in a package of ten results in a 1.5 multiple.

Variants

On a variant card, in the Shipment Multiple field, you can specify a multiple that will be used for this variant instead of the

default value entered for the item.

1. 

2. 

Option Description

No (Current

Shpt.)

Only item, resource, and G/L account lines with a quantity <> 0 are shown on the note.

Yes (Current

Shpt.)

Only item, resource, and G/L account lines with a quantity <> 0 are shown on the note.

Besides the line quantity and unit of measure, the following information is also printed: order quantity,

quantity shipped, and backlog.

No (All Lines) All lines are shown.

Yes (All Lines) All lines are shown. 

Besides the line quantity and unit of measure, the following information is also printed: order quantity,

quantity shipped, and backlog.

Note
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Workflow

The following checks are run if you enter on a sales order an item that you specified a multiple for:

Is the quantity smaller or greater than the multiple?

If you entered a quantity that doesn’t match the multiple specified on the item or variant card, you’re asked if you want to round

the quantity up or down.

Is the item being sold in another unit of measure?

When you change the unit of measure, a new shipment multiple is automatically suggested to you.

Is a multiple specified for the selected variant?

If a multiple is specified for the item variant that you want to sell, this multiple is used instead of the value on the item card.

ALTERNATE ADDRESS ON QUOTES

You can now change the address that will be printed on sales quotes.

Open a quote.

On the General FastTab, in the Address on Quote field, choose whether the sell-to, ship-to, or bill-to address should appear on

printouts of the quote. If you select Ship-to or Bill-to, the shipment address entered on the quote will not be shown at the

bottom of the printed document.

The field is also copied along when a quote is archived.

SELECT TO ORDER

You can use the Copy to Order field on quote lines to convert only part of a quote to an order.

By default, the field is selected for all lines but can be cleared manually. Running the Make Order function from the ribbon then

creates an order based on the lines where the Copy to Order field is selected. The prices and discounts from the quote are also

copied.

NO CREDIT MEMO INVOICE

In medtec365, a sales credit memo can be created without having to assign it to an invoice. To allow a user access to this feature:

Choose the Search icon, enter User Setup, and then choose the related link.

Select the relevant user.

Select the Allow Standalone Cr. Memos field on the line.

EXTENDED SALES HISTORY

The sales history available in the standard app has been extended to show archived sales quotes, sales orders, blanket orders,

and return orders as well.

COLOR INDICATORS

The indicators that can be shown in the Sales Header Status FactBox provide you with a quick overview of the inventory,

warehouse and posted shipments, and invoices available for an order.

Each indicator gives you an aggregated view of the individual line values. That is, if the indicator is set to Green on one line but

to Red on another, it will show as Yellow in the box. To see the status of a specific line, you can choose Sales Line Statuses on the

sales order ribbon.

To use this feature, you need to ensure that an image is assigned to represent each indicator color:

Choose the Search icon, enter Company Information, and then choose the related link.

On the Documents FastTab, select the plus sign next to Red, Yellow, or Green, and then choose the image that you want to see

when this color applies.

1. 

2. 

3. 

• 

• 

1. 

2. 

3. 

1. 

2. 
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Flag insufficient demand on multiple orders

If the item quantity in inventory isn’t enough to meet demand from more than one sales order, the Pickable Status field will

nevertheless be set to Green on all documents where the item is entered. To avoid any issues during shipping, you can add the

Invt. Availability Status indicator to the Sales Order page and other types of sales overviews.

Setup

Choose the Search icon, enter medtec365 Setup, and then choose the related link

Fill in the fields on the Sales FastTab as described in the following table.

Workflow Example - Quantity on sales orders > Quantity in inventory

You create two sales orders that pick from a location storing 1000 pieces of the item you need to ship.

The Pickable Status field is then set to Green on both. Without turning on the extended indicator view, no status light will make

you aware that the quantity in inventory is insufficient to meet demand from two orders.

After turning on and setting up the extended view, the Invt. Availability Status indicator will become visible on multiple sales

pages and change color based on the quantity and delivery date entered on a line.

When the same item is entered on the second order but with a delivery date outside the period defined in setup and the quantity

at the specified location isn’t enough for both, the Invt. Availability Status will be set to Green on the order (line) that needs to be

delivered first and to Yellow on the other. If the orders need to be shipped in the same period, the indicator on both will turn

Yellow.

Any sales line will also be set to Yellow if the quantity at the location entered on it can only be fulfilled in part, regardless of the

period entered in setup.

This also holds true for lines set to Red, for example, when the items you need aren’t stored at the site you’ve entered.

Calculate statuses manually

With the Show Inventory Availability (Extended) toggle turned on, you can run the Calculate Invt. Availability action from the

sales order ribbon to ensure all availability indicators are up to date, as not every change that you make to an order will trigger

an automatic recalculation of these statuses.

Pages

When turned on, the status of inventory will be shown on the following pages:

Sales Order (Sales Header Status FactBox)

Sales Status List (via the general search function)

Sales Line Statuses (on the Sales Order or Sales Status List ribbon)

1. 

2. 

Field Description

Show Inventory

Availability

(Extended)

Adds the Invt. Availability Status indicator to the relevant pages.

Inventory Availability

Formula

Can be used to specify a formula, such as 3M (for 3 months).

This formula is then used to determine which color is shown in the Sales Status Header FactBox

and on the Sales Line Statuses page after accounting for demand from other sales orders placed in

the specified period (provided that the outstanding quantity on at least one of them is still greater

than zero).

If you leave the field blank, the availability of inventory is calculated based on the item’s shipment

date.

• 

• 

• 
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ITEM RESTRICTIONS

You can restrict what items can be delivered to a certain customer, invoice recipient, or country by specifying restriction codes.

These codes are used to assign (include) or block (exclude) items for shipping. The system then checks for these restrictions

when you enter an item on a sales line.

Create restrictions

To restrict the sale of an item:

Choose the Search icon, enter Item Restrictions Overview, and then choose the related link.

On the ribbon, choose New.

Enter a code in the Restriction Code field, and then fill in the Description field. The code must be unique.

On the Condition Lines FastTab, enter the relevant source fields and set field filters as necessary.

On the ribbon, choose Create Restrictions to have the restrictions entered on the Restricted Items FastTab.

Assign restrictions

To limit what can be sold to a certain customer:

Open the relevant customer card.

On the Shipping FastTab, fill in the Restriction Code field.

Restrictions that have already been assigned can be opened by choosing Related > Sales > Restricted Items on the ribbon.

As for shipments to a certain country or region, you can restrict their delivery on the Countries/Regions page, by filling in the

Restriction Code field on a line there.

Use restricted items

If items are shipped to a country they shouldn’t or if you enter a restricted item on a sales order even though the restrictions

apply to the customer you created the order for, you see a message stating that the item is blocked.

EXTENDED QUESTIONNAIRES

The CRM profiles have been extended so that you can not only select an answer but enter values as a response to a question. The

system will also create a history of all selected answers.

LOT RECALL AT COMPONENT LEVEL

You can now use item tracking to recall a product while also creating segments and bulk letters for specific recall campaigns.

CLEARANCE ITEMS

Clearance items are items that you decided not to reorder or that your supplier has stopped providing. Your procurement

department will be notified that the item—or variant—in question is no longer available when they try to enter it on a new sales

order. To select an item or variant for clearance:

Open an item card.

On the Item FastTab, select the For Clearance field.

Alternatively, select For Clearance for each individual variant that will no longer be restocked.

If an item is selected for Clearance, its variants will no longer be restocked either, regardless of whether you’ve marked some of

them as well.

An order that clearance items are entered on isn’t shown on availability lists; planned receipt, meanwhile, is set to 0, as it cannot

be guaranteed that the order is still going to be delivered.

1. 

2. 

3. 

4. 

5. 

1. 

2. 

1. 

2. 

3. 

Note
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A purchase order created for clearance items will not be included in availability overviews if the receipt date set for the purchase is

earlier than the date that the associated sales order is to be shipped on.

If the requested delivery date that is entered on the purchase order is earlier than the planned receipt, an Earliest Availability

Date will be shown.

TIME LIMITS ON BLANKET ORDERS

To prevent terms and conditions specified on a blanket order from being used after the order has expired, you can now set not

only a quantity but also a time limit there:

Open a blanket order.

On the FastTab, in the Blanket Order Until field, specify up until when the order is valid.

You then see an error message if you try to use the order after the expiration date.

ADDITIONAL FIELDS

For additional customer fields, you can specify if you want to make them available in the sales area and have them copied to the

headers of posted documents; additional item and resource fields will be included on the lines.

On the Additional Field Setup page, you can also specify whether these fields can be changed manually. The system then logs the

time they were modified and the ID of the user who edited them.

CREDIT MEMO VALUES

On a credit memo card, you can now turn on the Value Posting toggle on the General FastTab to specify that no items are moved

in a warehouse with this credit memo. If the toggle isn’t turned on, the system will create a sales return order and therefore an

item entry in the background when you post the document.

MOVEMENT TYPES

Standard sales documents can be used to post the receipt and shipment of items in the system, whereas transfer orders move

goods from one place to another.

Sometimes, however, items might need to be presented to a customer and returned. Using standard functions to mirror this

process can be very time-consuming, as two types of documents need to be created. For this reason, a Movement Type field has

been added to all sales lines so that you can post both transfers and standard sales transactions.

Setup

Sales order types

You can set up movement types on the Sales Order Types page so that when you create item lines assigned to a certain order

type, the Movement Type field will be filled in automatically on the lines of the relevant sales document.

Locations

To specify a receiving location and bin for transfers based on a movement type:

Open a location card.

On the medtec365 FastTab, fill in the fields as described in the following table.

Customers

Note

1. 

2. 

1. 

2. 

Field Description

Receiving Location

Code

Specify a code that will be automatically assigned to the field with the same name on sales lines if

Transfer has been selected as the movement type.

Auto Assign Customer

Bin

Turn on this toggle for the receiving location if a bin is required and you want one created

automatically based on the customer number.
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You can also fill in a location (and a bin) separately for each customer.

Open a customer card.

On the Shipping FastTab, fill in the fields as described in the following table.

Workflow

You can post transfers on item lines of both sales and return orders.

Open a sales or sales return order.

Select Transfer in the Movement Type field on an item line (that is, unless the field has already been filled in from a sales order

type).

In the Receiving Location Code field, specify the destination that you want to transfer the items to. If this site requires bin

assignment, fill in the Receiving Bin Code field as well.

Some of the Receiving Location and Receiving Bin Code fields might already be filled in if default values have been specified for

them on the relevant location or customer cards.

For transfer lines, the Unit Price field is set to zero automatically, as ownership of the items doesn’t change. A minimum profit

check isn’t performed either. After the items have been shipped, they’re marked as invoiced; no Qty. Shipped Not Invd. remains.

This means that an order might be completed just by shipping the items. However, it isn’t deleted from the system. You can then

delete the order manually or you can run a batch job to have it removed by the system.

Posted documents

You can view the movement type, as well as the receiving location and bin, on posted shipping documents. The system creates

application entries of type Transfer for the shipment and a corresponding bin entry for each location that requires bins.

Cancellations

Cancelling a transfer automatically reverses the entries associated with the transfer.

Returns

On a sales return order, lines should be created by running the Get Posted Document Lines to Reverse action, as it shows, for

example, what posted shipment lines can be selected. The window also displays the Cancellation Qty. and Movement Type fields.

Compared to the original order, the location and receiving location are now reversed. This means that a return receipt you

created based on a transfer from bin 001 at the main warehouse to customer 20000 then shows a transfer from customer 20000

to main warehouse bin 001.

Warehouse

Overall, posting from the sales document should lead to the same result as posting from a warehouse document (shipment or

receipt).

There are no differences to standard functionality when it comes using the Transfer movement type on sales orders. As for sales

returns, the difference is that the roles of inbound and outbound location will be reversed.

1. 

2. 

Field Description

Receiving Location

Code

Specify a code that will be automatically assigned to the field with the same name on sales lines if

Transfer has been selected as the movement type.

Receiving Bin Code Specify a code that will be automatically assigned to the field with the same name on sales lines if

Transfer has been selected as the movement type.

1. 

2. 

3. 
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DISCOUNT REASONS

You can now also specify the reason for granting a line discount on a document.

Choose the Search icon, enter Discount Reasons, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

To assign a reason:

Open a sales document.

Select the relevant sales line, and then fill in the Discount Reason field.

Discount reasons can also be used for transactions in kind.

For this purpose, you need to create a discount reason = 100% and assign it to the relevant document line. After selecting the

reason, the associated line discount is then filled in automatically.

A discount only applies to a single line and is subtracted from the line amount there.

Microsoft, Microsoft Dynamics und Microsoft Dynamics 365 sind Marken der Microsoft-Unternehmensgruppe. 

1. 

2. 

3. 

Field Description

Code Specify a code for the reason. The code must be unique.

Description Specify the reason. The description will not be included in the item text.

Type Specify the kind of discount that should be granted for this reason on a document line.

Fixed

The amount entered in the Line Discount % field is fixed and cannot be changed manually on document

lines.

Maximum

The amount entered in the Line Discount % field is the maximum amount that can be granted. The

discount can therefore still be changed on lines that you enter the reason on unless it exceeds the value

specified here.

Line Discount

%

Specifies the line discount in percent. This field is related to the Type field.

1. 

2. 

1. 
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Purchasing

MINIMUM EXPIRATION DATES

To prevent the purchase and sale of perishable goods that are close to expiring, you can specify a minimum shelf life for each

item that you ship or receive. The shelf-life fields then need to be filled in as described in the following table.

Based on your needs, you can specify minimum expiration dates for shipments and receipts on location, item, item category, item

reference, or stockkeeping unit cards, or do so on the Warehouse Setup page.

Workflow

When you post an item, the system searches for its expiration date in the following order:

Item references

Item master (item card)

Item category (as specified on the item card)

Stockkeeping units

Warehouse Setup

You then see an error message if an item is about to expire (or has expired already).

Inbound or outbound expiration dates that you fill in for an item category are copied automatically to any item that you create based

on this category.

By user

If a certain user still needs to be able to post items with low shelf lives, you can turn on the Ignore Min. Expiration Dates toggle

on the relevant line in User Setup.

With the toggle active, the user is informed during posting that the entered items are below the minimum and is asked whether

to post them regardless. Choosing No will cancel the posting process.

By location

You can also add expired inventory to certain warehouses (such as scrap locations) by turning on the Ignore Min. Expiration

Dates toggle on the relevant location cards.

TIME LIMITS ON BLANKET ORDERS

To prevent terms and conditions specified on a blanket order from being used after the order has expired, you can now set not

only a quantity but also a time limit there:

Open a blanket order.

On the FastTab, in the Blanket Order Until field, specify up until when the order is valid.

Field Description

Min. Expiration Date

(Outbnd.)

Specify the formula that will be used to determine if an item can be shipped on a certain day.

To be able to ship the item, the expiration date entered for it must be greater than the planned

shipping date plus the time span calculated by the formula in this field.

Min. Expiration Date

(Inbnd.)

Specify the formula that will be used to determine if an item can be received on a certain day.

To be able to receive the item, the expiration date entered for it must be greater than the planned

receipt date plus the time span calculated by the formula in this field.

1. 

2. 

3. 

4. 

5. 

Note

1. 

2. 

1.2.9 medtec365

- 1034/1545 - Copyright © 2018 - 2024 KUMAVISION AG



You then see an error message if you try to use the order after the expiration date. If the field isn’t filled in, the blanket order will

be valid indefinitely.

EXTENDED PURCHASE HISTORY

The purchase history available in the standard app has been extended to show archived purchase quotes, purchase orders,

blanket orders, and return orders as well.

DELIVERY SCHEDULE ADHERENCE

The Schedule Adherence FactBox shows you vendors’ compliance with requested or confirmed delivery dates, that is, how many

of their deliveries arrived too late—or too early—and by how much.

Setup

You can analyze a vendor’s schedule adherence based on the Requested, Promised, or Expected Receipt Date on purchase

orders. To select the date that will be used as the basis for analysis:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION FastTab, select the required option in the Schedule Adherence Date field.

The system then checks if the field with the same name is filled in when you create a purchase order. You see an error message if

it isn’t.

Evaluate schedule adherence

To analyze a vendor’s adherence to delivery schedules:

Choose the Search icon, enter Vendors, and then choose the related link.

Select a vendor, and then choose Find entries > Schedule Adherence. You can also open a vendor card, and then choose History >

Schedule Adherence.

On the General FastTab, set filters as necessary, the purpose of each being as described in the following table.

1. 

2. 

1. 

2. 

3. 

Field Description

Vendor No. Filled in automatically with the vendor whose card you ran the action from.

Item No. Can be used to filter for a specific item.

View by Specifies the interval in which values on the Lines FastTab should be shown. Options are:

• Day

• Week

• Month

• Quarter

• Year

• Accounting Period

View as Specifies what should be shown per line and interval.

Net Change

Shows the total for each interval.

Balance to Date

Shows the average per interval.

Analyzed From Specifies by how many days or weeks (see Period Type) a delivery can arrive too early but still be included

in the analysis.

Analyzed To Specifies by how many days or weeks (see Period Type) a delivery can arrive too late but still be included

in the analysis.

Period Type Specifies the period that will be shown on the Lines FastTab.
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OPTIMIZED PURCHASES

With this feature, you can raise the quantity on a requisition or planning worksheet to meet, for example, a minimum order value,

cubage, or weight.

On the Optimized Purchase page, vendors will be listed with their inventories, as well as their receipts and shipments, over the

past few months so that you can adjust any quantity required and then copy it to the relevant worksheet.

Setup

Item Vendor Catalog

Before you can use the feature, you need to ensure that the items that you want to change quantities for have been linked to the

specified vendor on the Item/Vendor Catalog page.

medtec365 Setup

The period that enhancements should be made for can be specified in medtec365 Setup, in the Inventory Level Period field on

the Inventory FastTab. You see an error message if you try to adjust worksheet quantities without the field being filled in.

Item units

To be able to see the cubage and weight of an optimized purchase, you must also fill in the Cubage and Weight fields for the

relevant item units of measure.

Optimize worksheets

View optimizations

To see how quantities have been adjusted:

Open a requisition or planning worksheet.

On the ribbon, choose Home > Optimized Purchase.

Only quantities that originate with unblocked items and the same supplier (according to the item/vendor catalog) will be shown

on this page.

Statistics

The following statistics fields are also shown on the page:

Qty. on Order

Inventory at Location

Total Inventory

Lead Time

Inventory Level (Weeks)

Avg. Pos. Adjmt. per Week

Avg. Neg. Adjmt. per Week

Add items

To help you select the right items and quantities so that you can achieve the cubage required for a certain container or the

amount needed to get an invoice discount, the line amount, cubage, and weight of all items shown on the Optimized Purchase

page are totaled in the footer.

When you adjust a quantity or add a new item, these fields are then updated and the system runs the pricing function (that is, if

weight and cubage values have been filled in for the relevant unit of measure and prices have been set up as well).

Manage certificates and declarations

File a certificate or declaration

1. 

2. 

• 

• 

• 

• 

• 

• 

• 
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You can now store and monitor the validity of certificates and declarations from a vendor card. To set up the feature:

Choose the Search icon, enter Certificates and Declarations, and then choose the related link. 

Fill in the fields as described in the following table.

You can then see the certificates and declarations stored for the vendor in the Long-Term Supplier Decl. and Short-Term Supplier

Decl. fields, found on the Foreign Trade FastTab of the vendor card.

Using the lookup on either field will take you to the Vendor QM Data page, where you can choose New on the ribbon and fill in

the fields as described in the following table to add a declaration or a certificate.

Search for valid certificates

As certificates are only in use for a limited period, their validity must be checked at regular intervals.

For this purpose, you can run the Vendor QM Notification report, where you can set filters on the Notification Date field, for

example.

Additional purchase fields

For additional vendor fields, you can specify if you want to make them available in purchasing and have them copied to the

headers of posted documents; additional item and resource fields will be included on the lines.

On the Additional Field Setup page, you can also specify whether these fields can be changed manually. The system then logs the

time they were modified and the ID of the user who edited them.

The values in additional fields that you didn’t change manually will be retrieved again from the master records when you run an

action such as Copy Document or Post.

1. 

2. 

Field Description

Code Specify a code for the certificate.

Description Enter a description for the certificate.

Field Description

Code Select a certificate stored in the system.

Starting Date Specify when the certificate becomes valid.

Ending Date Specify when the validity of the certificate ends.

Notification Date Specify when you need to ask the vendor about the certificate.

File Path Specify where the certificate is stored.

Note

1.2.9 medtec365

- 1037/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Copy items (ease-of-use function)

The standard Copy Item function has been extended to include copying the following records:

Stockkeeping units

Packing types

Item substitutions

Related items

Item label information

Alternate prices

Additional item fields

Additional variant fields

Additional unit of measure fields

Attributes

For more information, see Copy Item Function (KUMAVISION base).

Minimum order value and freight limits

Optimizing unit costs is key to a successful wholesale transaction. For this reason, you can now specify how much you must order

from a vendor at the very least and up to which amount transportation fees will be paid by the supplier.

Open a vendor card.

On the Receiving FastTab, fill in the Minimum Order Value and Carriage Paid Limit fields. The amounts in both fields must be in the

currency specified for the vendor.

What you enter in these fields is then shown as part of purchase order statistics and on requisition and planning worksheets for

informational purposes.

In statistics

To see what you purchased:

Open a purchase order.

On the ribbon, choose Order > Statistics.

The Minimum Order Value and Carriage Paid Limit fields that you can see on the Vendor FastTab of the page show amounts in the

currency used by the vendor, regardless of the currency specified on individual orders.

On worksheets

Minimum order values and carriage paid limits are also shown on requisition and planning worksheets.

Additionally, you can see in the Accepted Order Value (Vendor) field what has been requisitioned from the vendor.

When you release a purchase order, the system then checks the current order value and fee system against the minimum value

and fee limit. You’re notified if what you entered on the document falls below either.

However, a check for a minimum order value is only performed if the currency that is specified on the order matches the

currency that you stored with the vendor. You see a message if they don’t but can decide to release the order anyway.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note

1. 

2. 

1. 

2. 

Note
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The line values that are being compared are gross or net, depending on whether you turned the Prices Including VAT toggle on

the General FastTab on or off. The toggle setting on the related vendor card must match the setting made here; otherwise, the

check isn’t run.

The same is true for requisition worksheets. However, because their lines don’t have Line Amount fields, the amount to compare

the minimums to is calculated based on the Quantity, Unit Cost, and Line Discount % values that you specified on each line. If

Prices Including VAT is turned on, the tax that you expect to pay is also added.

Invoice discounts aren’t part of the check.

If the values in the Buy-from Vendor and Pay-to Vendor fields differ here, the check will apply to the Buy-from Vendor settings.

VARIANT MASTER

The variant master provides you with the option of specifying a list of potential item variants, to prevent the creation of a random

(that is, unstructured) series of variant codes.

Setup

medtec365 Setup

To ensure variants can only be created for items entered in the variant master:

Choose the Search icon, enter KUMAVISION medtec365 Setup, and then choose the related link.

On the Inventory FastTab, turn on the Variant Master Reqd. toggle.

Item categories

If you don’t want the variant master requirement to apply to every category of items, don’t turn on the toggle in setup.

Instead, choose the general search function to open the Item Categories page and then select the Variant Master Reqd. field for

each category that you want variant creation to be restricted for.

Variant master

On the Variant Master page, you can also create lists of potential attributes, for example, to prevent people from using different

spellings for the same variant.

A clear-cut structure that is easy to follow will help users choose the correct variants, considering that variant codes might be used

for pricing as well.

Item card

You can restrict variant creation even further by filling in the Variant Cat. Code Filter field on an item card (on the Misc.

FastTab). The field specifies the code range available for selection from the variant master.

Workflow

For items that require you to select a new variant from the variant master, you can choose the lookup in the Code field on the

Item Variants page to pick one of the available options.

The exact number of variants that you can choose from depends on whether you also put a Variant Cat. Code Filter on the items.

Consignment items

The standard reordering policy Order is typically based on consignment transactions. For this reason, the configuration

templates have been extended to include a field for specifying how consignment items will be stored.

Note

1. 

2. 

Note
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Setup Item

To specify the storage method for a consignment item:

Open an item card.

On the Warehouse FastTab, fill in the field described in the following table.

medtec365 Setup

Bins

You must also set up a bin for consignment items at each location they’re assigned to. This bin is specified for the warehouse in

the same way as a standard bin, except for the field described in the following table.

Workflow Create a consignment item

If you’re using a template to create a consignment item or applying the template to an existing product, stockkeeping units are

created in one of the ways described in the following sections. What all of these have in common is that on each SKU card

created through this process, the Reordering Policy field will be set to Order.

Local procurement

Stockkeeping units with the Purchase replenishment system will be created for all sites included in the Other Consignment

Locations Fltr. (see medtec365 Setup).

Centralized procurement

Stockkeeping units with the Transfer replenishment system will be created for all sites included in the Other Consignment

Locations Fltr. (see medtec365 Setup).

Only for the warehouse selected in the Main Consignment Location Code field (also found in medtec365 Setup) will the system

create an SKU card with replenishment system Purchase.

Procure an item

When you enter a consignment item on a sales order, a purchase order or a transfer that includes a purchase order are then

suggested automatically on the associated worksheet depending on the location and stockkeeping units involved.

The purchase order is linked to the sales order by reserving items on the sales lines. As a consignment item typically has no

inventory available, you’re notified about the consignment when you enter this kind of item.

If non-reserved inventory exists, however, you see a message that you might need to reserve the item manually.

1. 

2. 

Field Description

Consignment

Type

Specifies whether and how an item will be used for consignment. 

Depending on whether you choose Local or Central, stockkeeping units are then created automatically

for the item at a main site or multiple locations.

Field Description

Main Consignment

Location Code

If you’re using an item template, identifies the location for the centralized procurement of

consignment items.

Other Consignment

Location Fltr.

If you’re using an item template and selected Local or Central as the consignment type for an

item, you can set a filter in this field to specify the locations stockkeeping units should be created

for.

If you leave the field blank, stockkeeping units will be created for every location set up in the

system.

Field Description

Consignment Type

(Bin)

Specify what bin will be used for consignment items. You can choose between (blank), Default,

and Other.
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Confirm an order

You can run the Create Purch. Order Cnfrmn. function from the Lines FastTab ribbon on a purchase order to enter a number and

a date for a confirmation document. The number is then copied to the Current Cnfrmn. No. fields on the selected lines.

For a better overview, the field was also added to sales lines. Clicking the field there opens a page that shows the confirmation

note. On this page, you can:

Run the Show action to see the purchase order.

View the type and number of the order.

Identify the sales order by the Sales Order No. and Sales Line No. fields that have been added to the confirmation lines.

As for bullet point 2 and 3, the fields are automatically filled in when a confirmation line is created provided the relevant item

was reserved on the sales document (or indirectly via a transfer).

Another field that was added to order confirmation lines is the Source field. It is filled in with the Manual option when you create

a confirmation note manually. 

A source entry with the Whse. Receipt option selected is also created on receipt of a delivery. The entry links a purchase line to

the sales line that the purchase order was set up for (provided an item reservation exists) and will remain even after the item is

no longer reserved.

Change a quantity

Typically, you cannot change the quantities on purchase and sales orders that you reserved items from.

However, for consignment items, you can adjust the quantities at any time (that is, prior to receipt) both on purchase and sales

orders, with the changes copied to all relevant reservation entries and document lines.

What you still cannot do is change a quantity mid-transaction (=during transfer) or after you’ve shipped or received part of the

delivery.

Specify a default bin

As the default bin for consignment items, the CONS bin is automatically suggested on receipt of a delivery if it hasn’t already

been specified by a user or through a two-step logistics process using warehouse bins.

Change an item or a variant on receipt

On the Warehouse Receipt page, you can run the Change Consignment action on the Lines FastTab to change an item number or

a variant, or both.

Clear backlog

On the Warehouse Receipt page, you can also use the Clear Backlog action to create warehouse shipments after a receipt has

been posted.

Before the function can be run, you must turn on the Can Clear Backlog toggle for the relevant user in User Setup. A default

purchase order type for clearing backlog needs to have been set up as well.

Print a label (incl. reservation data)

To print a label for an item on receipt and create a corresponding ledger entry:

Open an item card.

On the ribbon, choose Related > Item > Label Information.

Fill in the fields as necessary.

A label is then printed when you post a warehouse receipt that includes the specified item. If the item was reserved from a sales

order, the system also prints the number and name of the customer and the number of the sales order on the label.

Create a purchase return

• 

• 

• 

1. 

2. 

3. 
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You see a corresponding message when you enter a consignment item on the Sales Return Orders page manually. You can then

create a purchase return order from that page by using the Create Return Document function on the ribbon.

Afterward, the reservations made for consignment items from purchase lines will be copied to the relevant sales lines.

Discount reasons

You can now also specify the reason for granting a line discount on a document.

Choose the Search icon, enter Discount Reasons, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

To assign a reason:

Open a purchase document.

Select the relevant purchase line, and then fill in the Discount Reason field.

Discount reasons can also be used for transactions in kind.

For this purpose, you need to create a discount reason = 100% and assign it to the relevant document line. After selecting the

reason, the associated line discount is then filled in automatically.

A discount only applies to a single line and is subtracted from the line amount there.

REQUISITION WORKSHEETS (EASE-OF-USE FUNCTION)

You can now open item and SKU cards from requisition worksheets.

Choose the Search icon, enter Requisition Worksheets, and then choose the related link.

Choose a worksheet from the list.

Select a line, and then choose Related > Line > Item Card or SKU Card on the ribbon.

You can also choose Related > Line > Item/Inventory Turnover on the ribbon to see the movements of an item, as well as the

priority texts, block prices, minimum order values, and carriage paid limits specified for it.

STOCKKEEPING UNITS

To simplify inventory management, medtec365 provides you with suggestions for minimum inventory levels based on historical

data, and the option to directly copy them to stockkeeping units.

A new ease-of-use function also lets you add this information to multiple records at once. However, you can only create or change

an SKU if the status of the associated item card is set to Pending.

1. 

2. 

3. 

Field Description

Code Specify a code for the reason. The code must be unique.

Description Specify the reason for the discount. This description will not be included in the item text.

Type Specify the kind of discount that should be granted for this reason on a document line.

Fixed

The amount entered in the Line Discount % field is fixed and cannot be changed manually on document

lines.

Maximum

The amount entered in the Line Discount % field is the maximum amount that can be granted. The

discount can therefore still be changed on lines that you enter the reason on unless it exceeds the value

specified here.

Line Discount

%

Specifies the line discount in percent. This field is related to the Type field.

1. 

2. 

1. 

2. 

3. 
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Furthermore, you can now enter transaction codes on stockkeeping unit cards so that they can be grouped by type of warehouse

transaction.

medtec365 requisition

The medtec365 Requisition option has been added to the Reordering Policy field for quantities you need to reorder. You can

select the policy on the Planning FastTab of a stockkeeping unit card.

The medtec365 policy is focused on quantities, not dates, when looking for reorder points.

If you select this option, the Reorder Point and Order Multiple fields can be changed on the card. Standard business logic is then

used to restock. This means that:

Demand will be calculated according to the filters set on the relevant item.

The working date is entered as the starting date on the purchase order.

Standard blanket orders and forecasts might be included in the calculation.

In medtec365 Setup, you can also fill in a default planning period that the system can use to calculate an ending date for

reordering.

Afterward, standard functionality would go through all stockkeeping units set up for the item, with an eye on transfers as the

first option to meet current demand.

The medtec365 best practice process, on the other hand, determines how much of demand can be supplied by a certain SKU. If

this results in an inventory level below the reorder point specified for the unit, a reorder quantity will be created.

This quantity is then rounded up based on the order multiple entered for the relevant item, as well as the purchase unit of

measure if the item is typically received in a unit greater than 1.

Afterward, the quantity is copied to a planning line, where the Order Date field is filled in with the specified starting date and the

Expected Delivery Date is calculated based on the lead time of the item.

When you use this reorder policy, no safety stock warnings are shown, and no order tracking entries are created. The document

status (open or released) doesn’t play a role either. Additionally, return receipts and return shipments that will not be part of the

reordering process should each be sent to a separate location.

MRP data

Depending on the reorder policy selected, you need to maintain various data sources with an impact on requisition worksheets.

Example

The medtec365 Requisition best practice process is chosen as the reorder policy. In this process, only the Reorder Point and

Order Quantity fields are relevant. When the quantity of an item falls below the reorder point, the system replenishes inventory

up to that point based on the quantity ordered.

For more information about standard reorder policies, see Setup Best Practices - Reordering Policies - Business Central |

Microsoft Learn.

Option Description

medtec365

Requisition

If a quantity falls below the reorder point, the system will replenish inventory up to that point based

on the quantity ordered.

Note

• 

• 

• 

Note
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Weighting schedule

On this schedule, you can specify the time span and weightings for viewing historical data. Besides a date formula, you can also

enter fixed dates.

To create or open a schedule, choose the Search icon, enter Weighting Schedule List, and then choose the related link.

Schedules can be stored in the following places (and will be searched for in that order of priority):

medtec365 Setup – Purchasing FastTab

Item category cards – Weighting Sched. Code (Usage)

Item cards – Purchasing FastTab

Stockkeeping unit cards – Purchasing FastTab

If the DEFAULT schedule is entered for a certain item and WEIGHTED for its SKU, the schedule assigned to the SKU will be used

in subsequent calculations.

Create SKUs

You can run the Create Stockkeeping Unit action from an item card to create multiple stockkeeping units at once (or use the

general search function to find the feature). 

• 

• 

• 

• 
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The purpose of each field found on the request page of the report is described in the following table.

Item planning suggestions

To monitor stockkeeping units, you can use an item planning suggestion.

Calculate planning parameters

Field Description

Create Per Specifies if stockkeeping units should be created per location, per variant, or for both locations

and variants.

Inventory Items Only With the toggle turned on, stockkeeping units are created only if the associated item is available

in inventory.

Replace SKU Data If this toggle is turned on, previously created stockkeeping units are replaced with the units set

up by this function.

Replenishment System Specifies how the Reorder Policy field is filled in on the units. Options are:

• From Item

• Purchasing

• Prod. Order

• Transfer

• Assembly

Reorder Policy Specifies the replenishment system for the SKUs:

• (blank)

• Fixed Order Qty.

• Maximum Qty.

• Order

• Lot-for-Lot

• medtec365 Requisition

Transfer-from Code If Transfer is chosen as the replenishment system, you can enter in this field the location you

want to remove items from (provided a transfer route has been set up for it).

Weighting Sched. Code

(Usage)

Specifies the schedule that will be used to weight the SKUs.

[Item Filter FastTab] Filter for items

Here you can set filters on the fields in the item master, including the new Default Inventory

Level field.

Filter totals by

Here you can set filters on total fields, such as transaction code, but also the new Auto Create

SKUs field.
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To identify parameters for monitoring:

Choose the Search icon, enter Item Planning Suggestion, and then choose the related link.

On the ribbon, run the Calculate Planning Parameters action to fill in the fields as described in the following table.

Besides calculating current inventory levels and weighting item usage, the system will also suggest new parameters for both

processes. These suggestions can then be edited manually, if necessary.

For this purpose, the old parameters will be copied from the master records in read-only format. The calculation of new

parameters is done in the following way:

The new reorder point equals the consumption that would result from totaling the usage per day in the specified period and

adding it onto the lead time and safety stock quantity.

The new maximum inventory equals the new reorder quantity added onto the consumption that would result from totaling the

usage per day in the reorder cycle period.

Edit a suggestion

1. 

2. 

Field Description

Location Filter Specify a location.

If the field remains blank, planning parameters will be calculated for all locations, with one line being

created for each.

Item Variant Filter Specify a variant.

If the field remains blank, planning parameters will be calculated for all variants.

One Line per

Variant

Turn on this toggle if you want to create a line for each item variant.

Transaction Code

Fltr.

Filled in with transaction code CA (current assets).

If no code is entered, planning parameters will be calculated for all transaction codes.

Weighting Schedule

Fltr.

Specify a weighting schedule.

If no schedule is entered, planning parameters will be calculated for all transaction codes.

Reference Date Specify the date that will be used for parameter calculation.

Show Unedited

Lines

With the toggle turned off, the system will show only the lines where the parameters that are

suggested by this function differ from those already entered on the relevant item journal.

Period Choose the period that the statistics fields should be calculated for. Options are Day, Week, Month,

Quarter, and Year.

[Item Filter

FastTab]

Set filters to specify the items that you want to calculate parameters for.

• 

• 
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After a suggestion has been calculated, you can review the results and, if needed, adjust the values in the page fields. All fields

are described in the following table.
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Field Description

Item No. Specifies the number of the item.

Description

Description 2

Specifies the (additional) description of the item.

Transaction Code Specifies the transaction code that is used on the planning line and served as the basis for

calculating the parameters.

Location Specifies the location entered for the selected line.

Weighting Sched. Code

(Usage)

Specifies the weighting schedule used to calculate consumption.

Reference Date Specifies the date that the calculation was performed for.

Usage per Day Specifies usage per day based on the weighting schedule. You can use the lookup next to the

field to see the calculation base.

Total Inventory Specifies the inventory level for the item at the entered location.

Invt. Level (Date) Shows the date until when current inventory will last based on item usage per day.

Invt. Level (Days) Shows how many days current inventory will last based on item usage per day.

Replenishment System Specifies the replenishment system entered for the related SKU.

Reorder Point Specifies the reorder point entered for the related SKU.

New Reorder Point Here you can choose another reorder point, if necessary.

Lead Time Shows the time needed to procure the item according to the Microsoft Dynamics 365 Business

Central1 hierarchy:

1. Stockkeeping unit

2. Vendor/item catalog

3. Item

4. Vendor

Old Safety Stock Qty. Specifies the previous reorder quantity.

New Safety Stock Qty. Here you can enter another reorder quantity, if necessary.

New Invt. Level (Date) Specifies the date until when inventory will last according to the newly reordered quantity.

New Invt. Level (Days) Specifies the number of days that inventory will last according to the newly reordered

quantity.

Purchase UOM Specifies the unit of measure in which the item is purchased.

Old Reorder Qty. Specifies the order quantity stored on the stockkeeping unit card.

New Reorder Qty. Here you can enter a new order quantity.

The system then checks if the order quantity is a multiple of the purchasing unit so that whole

units are always suggested.

New Parameters Differ Specifies whether the new planning parameters on the line differ from the old values.

Calculated On Shows when the calculation was performed.

Calculated By Shows who ran the calculation.

Modified On Shows when the line was changed.

Modified By Shows who changed the line.
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Statistics

The page also provides you with various statistical sources to help you decide what data to create or change.

Item Details – MRP: FactBox

This FactBox shows you the stockkeeping data that is available for the selected line.

Item Details – Usage: FactBox

This FactBox shows you, based on the selected weighting schedule, all movements of the item during the specified period.

Item/Inventory Turnover: ribbon function

To see the past movements of an item, select a line, run the Item/Inventory Turnover action on the ribbon, and then choose Show

Matrix.

Availability by Event: ribbon function

Shows all receipts entered for the selected item line.

Copy Changes to SKU: ribbon function

When all parameters have been reviewed, they can be copied to the stockkeeping units linked to the items. To copy data, select

the lines you want and run the Copy Changes to SKU function on the ribbon. You’re then asked to confirm the transfer.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

SKU Updated On Shows when the related stockkeeping unit was updated.

SKU Updated By Shows who updated the related stockkeeping unit.

1. 
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Manufacturing

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s production department.

REPORTS AND DOCUMENTS

To assist you in your manufacturing tasks, medtec365 provides route sheets and barcodes matching the numbers that you

assigned to production orders, components, and operations in the system. To set up the feature for first use:

Choose the Search icon, enter Report Selections Production Order, and then choose the related link.

In the Usage field, choose Project Card.

On a line, in the Report ID field, select report 5007239 (Route Sheet).

Afterward, you can add route sheets to your production processes. When you run the report to create a sheet, you can also

choose on the Options FastTab whether you want to have additional information printed on the document, as described in the

following table.

EASE-OF-USE IMPROVEMENTS

To increase traceability and transparency, you can now turn production order numbers into lot numbers so that you can continue

to track items even when the status of a production order changes.

Choose the Search icon, enter KUMAVISION medtec365 Setup, and then choose the related link.

On the Manufacturing FastTab, turn on the Prod. Order No. as Lot No. toggle.

See the following table for an explanation of the other fields on the tab.

1. 

2. 

3. 

Option Description

Incl. Bar Code Turn on this toggle to have a bar code printed on the sheet.

Incl. Materials Turn on this toggle to have the materials required for each production step printed on the document.

No. of Copies Specify the number of sheets you need.

1. 

2. 

Field Description

Default Scheduling

Period

Here you can specify a date formula that will be used to refresh the ending dates on requisition

and planning worksheets. The result of the calculation is added onto the value in the Starting Date

field when you fill in a worksheet.

Example

You enter 12M. This means that the next time you fill in a requisition or planning worksheet, the

Starting Date field will be filled in with the work date, whereas the Ending Date field will show the

same day and month, only a year later (unless that day is not a workday).

Default Run Time Turn on this toggle if you want the system, and not staff members, to fill in run times.

Default Setup Time Turn on this toggle if you want the system, and not staff members, to fill in setup times on

production and output journals.

All Flushing Methods

for Tracked Items

Turn on this toggle if you want production order components that require item tracking and a

flushing method other than Manual to be posted automatically to production and consumption

journals.
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DEFAULT ITEM LOCATION AND BIN

If you’ve set up a location and a bin on an item card (on the Replenishment FastTab), they’re filled in automatically when the item

is entered…

…on a production order (in the Source No. field) during manual order creation, with both the location and bin filled in on the

header.

…as a component on a BOM.

…manually on the components of a production order.

Microsoft, Microsoft Dynamics und Microsoft Dynamics 365 sind Marken der Microsoft-Unternehmensgruppe. 

• 

• 

• 

1. 
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Warehouse Management

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s logistics department.

ADVANCED LOGISTICS PARAMETERS

Overview

In medtec365, you can use multiple advanced logistics parameters to decide on, for example, the methods used for picking items,

whether lot tracking is required for outbound goods, and what the minimum expiration date should be for products that you ship

or receive.

As the choice of settings might vary depending on storage conditions or agreements with customers or vendors, the parameters

are available in several places in the app. The following sections will show you where you can find them in the system and how

you can customize them to your needs.

Setup Parameter Descriptions

Parameter Description

Pick Method Specifies the method that will be used for picking items from your warehouse. Options are:

(blank)

A method has not been set up yet.

FIFO

The items with the earliest receipt or manufacturing dates are picked first.

LIFO

The items that were received or manufactured last are picked first.

FEFO

The items with the earliest expiration dates are picked first.

Note

If FEFO is selected but expiration dates are not maintained, the method is replaced with the

FIFO option automatically.

Custom

Warehouse employees decide on their own what items (in which lots or with which serial

numbers) to pick for shipments.

Note

When you use this pick method, the system does not check if the items can be shipped at all.

Single-Lot Pick With the toggle turned on, all items will be picked from the same lot.

Note

This parameter is only relevant to lot-tracked items.

Min. Expiration Date

(Outbnd.)

Specifies a formula that will be used to calculate the minimum shelf life for items that you

want to ship.

Note

If expiration dates are not maintained, this parameter is ignored.

Min. Expiration Date

(Inbnd.)

Specifies a formula that will be used to calculate the minimum shelf life for items that you

expect to receive.

Note

If expiration dates are not maintained, this parameter is ignored.
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The parameters are only considered by the system if you’ve also turned on the Advanced Logistics toggle on the relevant master

record (such as a location card).

Parameter Locations

You can use the parameters in various places in the app for different purposes, from mirroring individual agreements with a

certain customer or vendor to making general warehouse settings.

The following list shows you all configuration options in order of their retrieval.

Item references

Here you can specify parameters for items and variants based on special agreements with certain customers or vendors, for

example.

Stockkeeping units

On stockkeeping unit cards, you can set up parameters for locations that are linked to certain items, variants, or transaction codes.

Items

On an item card, you can make warehouse settings regardless of where the item is shipped to or from and who should receive or

supply it.

Item categories

On the Item Category page, you can make settings for categories without having to link to a specific item, location, customer, or

vendor.

Locations

Parameters you set on a location card relate to this location regardless of the items shipped from or received at the site and the

vendors or customers they’re intended for.

Warehouse Setup

The Warehouse Setup page represents the lowest level in the parameter hierarchy, with the parameters being available for all

locations and items tied to the warehouse functionality.

Validation

The system looks for parameters in master records in a certain order (see Parameter Locations). This is to ensure that the sales

and purchase agreements you negotiated individually with a customer or vendor take priority over general settings, such as the

configuration found in Warehouse Setup.

First, the system checks whether the logistics parameters are activated at all (that is, the Advanced Logistics toggle is turned on

for the record) and if the parameter—for example, Min. Expiration Date (Outbnd.)—is filled in. If the relevant field is blank, the

system will look for the required value in the remaining app locations as described in the previous section.

Additionally, the system searches for all parameters independently of each other. As an example, it might retrieve lot pick

settings from the item references but minimum expiration dates from an item card.

You can also store the parameters on master records that have no direct relation to an item or a tracking code. This includes item

categories, locations, and Warehouse Setup, where you can choose pick method FEFO, turn on Single-Lot Pick, or fill in the Min.

Expiration Date (Inbnd.) and Min. Expiration Date (Outbnd.) fields.

The settings then apply to items with lot or expiration date tracking. If you’re working with items that these options aren’t set up

for, FEFO automatically changes into FIFO while the other parameters are ignored.

FULFILL BACKLOG ON RECEIPT

With this feature, you can fulfil sales backlog, that is, overdue deliveries or transfer shipments, automatically when a receipt is

posted to your warehouse.

You can also track item movements on the Sales Backlog page and intervene if, for example, the number of items that you receive

isn’t enough to satisfy demand. The page provides an easy-to-use overview of all open sales and transfer lines that you can

complete by filling in items from the delivery.

Note

1. 

2. 

3. 

4. 

5. 

6. 
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Building on standard cross-document functionality, the feature offers you a way to automate order fulfillment while streamlining

your logistics, as no storage space is required for items that you can ship immediately.

Depending on how backlog fulfillment has been set up, items are reserved on sales orders, warehouse shipments are created, or

the shipments are already posted and printed.

This feature can only be used if the relevant site is set up as a warehouse location.

Setup

User Setup

To specify if and how a user can automate order fulfillment:

Choose the Search icon, enter User Setup, and then choose the related link.

Select a line.

In the Can Clear Backlog field, choose one of the options described in the following table. 

Purchase order types

Note

1. 

2. 

3. 

Option Description

No The user cannot open the Fulfill Backlog page.

Warehouse receipts are therefore posted without the feature being turned on.

Reserve Only The user cannot see the Fulfill Backlog page.

The backlog is cleared by using the quantities already reserved.

Custom The user can see the Fulfill Backlog page.

The backlog is cleared by using the quantities already reserved and the quantities allocated by the user.
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Whether the sales backlog can be fulfilled when you post a receipt also depends on the type of order you’re working on.

Choose the Search icon, enter Purchase Order Types, and then choose the related link.

In the Fulfill Backlog field, select one of the options described in the following table.

Based on the option that you select and the type of order you’re handling, you might see a dialog box where you can choose the

type of fulfillment that will be used when you post a receipt.

The field on the page is filled in by default with the option specified for the order on the Purchase Order Type page but can be

changed manually for each posting (that is, if the relevant toggles are turned on for your user ID on the User Setup page).

Workflow

When a warehouse receipt is posted, the system first checks whether the items that are specified on the warehouse receipt lines

are needed to meet demand from sales, transfer, or service lines, production order components, or purchase returns. To limit the

period that demand needs to be met for:

Choose the Search icon, enter Purchases & Payables Setup, and then choose the related link.

On the KUMAVISION FastTab, in the Fulfill Backlog (Days) field, specify the formula that will be used to find based on today’s date

demand lines within the calculated period.

If one or more demand lines are then found during receipt, you see a dialog box that you can specify in how current backlog

should be fulfilled. If what you’ve received is too little to cover what’s needed according to the demand lines in the system, you’re

informed that you need to allocate items to them manually. If no demand exists, you don’t see this box.

Backlog isn’t cleared if you select No on the request page of the Fulfill Backlog report. If you select any of the other options, you see

a page that lists all sales, purchase, transfer, service, production order, and purchase return order lines that demand must still be

met for.

Based on the shipment date entered on a demand line, the system then suggests the part of the receipt that hasn’t been reserved

yet in the Qty. to Allocate or Qty. to Allocate (Base) field. The line with the earliest shipment or due date has the highest priority

here. You can change the value and distribute the quantity across individual demand lines, however, before confirming your

choice. Afterward, the quantities that you entered in the Qty. to Allocate (Base) field will be reserved.

1. 

2. 

Option Description

Reserve The allocated quantities are reserved for the demand lines.

Create Outbnd.

Docs.

The quantities that should be distributed across the demand lines are first reserved. Afterward, a

warehouse shipment is set up for each sales order that demand should be met for, with the reserved

quantities filled in on the shipments. If picking is required, the system then creates a pick document that

it transfers the reservations and the bins to, if needed (unless directed pick and put-away is used).

Note

Warehouse shipments are only created when the Shipping Advice field is set to Partial Shipment, or

when all remaining quantities can be delivered in a single shipment. The system also checks whether the

credit limit will be exceeded because of the reservations.

Post Outbnd.

Shpts.

The first steps in the process are the same as with the other two options. Afterward, the pick is

registered, if necessary, and the shipments posted.

If you turned on the Require Put-away toggle on the location card, the put-away that is created is also

registered automatically.

No No backlog is cleared.

1. 

2. 

Note
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REPLACE CONSIGNMENT ITEMS

The Replace Consignment action has been added to the Lines FastTab ribbon on the Warehouse Receipt page.

Running the action opens the Choose Item & Variant page, where you can change the item number or, if applicable, the variant

code on a line.

GET BIN CONTENT: RECLASSIFICATION JOURNAL

You can run the Get Bin Content function from an item reclassification journal to move the content of one or more bins to another

bin stored at the same location.

The function uses the transaction codes set up in medtec365 to specify who owns the items that you move with the help of the

journal. When you transfer them, their tracking information is copied as well.

This action is only available on the transfer journal ribbon.

To move items within your warehouse:

Choose the Search icon, enter Item Reclassification Journals, and then choose the related link.

Select the relevant line, and then choose Get Bin Content.

On the request page, set filters as necessary to calculate and fill in the journal.

The Quantity Type field plays a major role in the transfers. You can select one of the following options in this field:

The impact of each option is also described to you in a text box below the field. User Setup controls if you can choose between all

three (Can Get Bin Content is selected for your ID) or whether you can only have available quantities calculated (the field in User

Setup is deactivated).

The New Location Code and New Bin Code fields aren’t filled in automatically on the transfer lines. Instead, you must manually

specify the location and the bin that you want inventory to be moved to. Item tracking codes can only be shown after you’ve entered

a new location.

When you’ve specified a target location and bin for the lines that you created, choose Post or Post and Print on the ribbon to

transfer the items.

POST SHIPMENTS AS RECEIPTS: TRANSFER ORDERS

You can use the Auto Post Shpt. as Receipt toggle—found on the General FastTab of a transfer order—when you have no staff

member who could confirm item receipts at a certain location, for example.

Note

1. 

2. 

3. 

Option Description

Overall

Quantity

All pick lines that have not yet been registered and all allocation entries related to the bin content are

deleted.

Moveable Qty. All allocation entries related to the bin content are deleted. Quantities in picking or blocked quantities

are ignored.

Available Invt. Only available quantities are used during transfers. Allocated, blocked, or picked quantities are ignored.

Note
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To set up the feature:

Choose the Search icon, enter Inventory Setup, and then choose the related link.

On the Numbering FastTab, in the Direct Transfer Setup field, select the option you want to use (Microsoft Direct Transfer or

KUMAVISION base Direct Transfer).

In the Direct Transfer Posting field, select Direct Transfer for standard functionality. For the KUMAVISION base extension, select

Receipt and Shipment.

However, for the function to work, you must also turn on the feature for the relevant location:

Open a location card.

On the General FastTab, turn on the Auto Post Transfers toggle.

The toggle is then set automatically on transfer orders that the location is assigned to.

INVENTORY OVERVIEW

In this overview, you can filter inventory, including its tracking information, by custom criteria.

To open the overview, use the general search function or run the Inventory Overview action from the Items page or an item card.

The following fields must be filled in on the header:

Location Code

Item No.

Transaction Code

When you choose Inventory > Calculate on the Lines FastTab ribbon, the inventory is then calculated and shown according to the

filters that you’ve set.

To specify the FactBoxes that should be shown for a line, go to the ribbon, and then choose Show FactBox > Line Details to see

information such as item availability for the current line, Total (Factors) to see total availability—limited by the filters entered on

the page header—or Totals to analyze data by location, item, variant (if available), and transaction code.

Because items that are stored in a bin such as QM aren’t available for picking, they will be marked accordingly and can be

viewed by drilling down on a location field.

Additionally, the Total Qty. (Base) field shows you how many items are in inventory, regardless of availability. The Qty. on

Inventory (Base), on the other hand, indicates how many have been put away.

These quantities might not match, for example, when some items have been picked. Subtracting the Qty. Picked (Base) from the

Qty. on Inventory (Base) will get you the Available Qty. (Base) shown in the FactBox.

DAMPENER PERIODS

In the standard app, you can add a dampener period to a purchase order to mark the time span in which supply orders aren’t

rescheduled if they arrive earlier than needed (for example, to meet demand on a sales order).

Although you initially need to fill in the dampener period field in Manufacturing Setup, you can later enter another period on a

specific item or stockkeeping unit card.

In medtec365, the field Dampener Period (Delay) has been added to both these cards and Manufacturing Setup so that you can

now specify buffer times in both directions during lot-for-lot reordering.

If you want to use this feature, you also need to set up a lot accumulation period (which is typically greater than the dampener

period).

1. 

2. 

3. 

1. 

2. 

• 

• 

• 

Note
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ASSIGN PERMISSIONS BY LOCATION

Overview

One of the things you must do when you add a new company to the app is to specify who can use or post to locations on

documents created in the system. The following setup is therefore required for every user to whom you haven’t assigned one or

more locations on the Warehouse Employees page.

Setup

Location permissions

To assign a non-warehouse employee to a location (and bin):

Choose the Search icon, enter Location Permissions, and then choose the related link.

On the ribbon, choose New, and then fill in the fields as described in the following table.

You can assign permissions either by role or user. Assigning a location to both isn’t possible. If you specify permissions for a role, the

Role Permissions checkbox needs to be selected on the relevant location card.

Own bin only setup

To limit a user’s access to their own bin, the following must be true:

Warehouse employee

The user isn’t specified as a warehouse employee for the location.

User Setup

1. 

2. 

Field Description

Role ID Specify the role that permissions should be granted to.

User ID Specify the ID of the user whom permissions should be granted to.

Location Specify the location that permissions should be granted for.

Purchase

Sale

Pos. Adjmt.

Neg. Adjmt.

Transfer

Output

Consumption

As for each of these checkboxes, you can decide whether to select it—and allow the user or role to run

the function—or clear it to block use of the feature.

Note

You can also choose Yes or No in the All Functions field to select or deselect every checkbox at the

same time.

Own Bin Only Restricts the user to the bin that is linked to their customer number (which is determined based on

their salesperson code and contact; for more information, see Own Bin Only).

Customer No. Bin Limits the user’s permissions to the bin that a customer number is entered for in this field.

Note

The bin must be assigned to this number at the specified location.

Applies to All Bins With the toggle turned on, the settings on this page apply to all bins at the location.

The value in this field is only considered by the system if the Own Bin Only and Customer No. Bin fields

are blank.

Bin Permissions

Exist

Specifies if bin permissions are maintained for the selected line.

Note
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On this page, the All Locations Allowed checkbox, which you can find on the General FastTab, isn’t selected. The Salespers./

Purch. Code field, however, is filled in.

If the user hasn’t been added as a salesperson or a purchaser yet, you must set them up as one.

Employee (Salesperson/Purchaser)

On this card, the contact specified for the user is entered in the Contact No. field.

If a contact doesn’t exist, you need to set one up before continuing.

Contact

The contact specified for the user is assigned to a customer.

Location

The location contains a bin that is linked to this customer.

Restrict to existing bins

To allow a user or role to post only to an existing bin that isn’t assigned to them or a customer, choose Find Entries > Bins on the

ribbon and specify the required permissions.

If Own Bin Only or Applies to All Bins is selected, or the Customer No. Bin field is filled in, you can safely ignore the bin permission

settings described in the following section, as you don’t need to maintain data for individual bins in this case.

Workflow

Location lookups

In most cases, the Location Code and New Location Code fields show only locations that the current user is allowed access to.

This concerns the following records:

Sales documents (headers and lines)

Purchase documents (headers and lines)

Transfer records (headers)

Item journals

Requisition and planning worksheets

Inspection orders

Production orders

Permissions check (in three stages)

a) Post

Each time you post to inventory—whether from a document, a journal, or somewhere else—the system checks what permissions

are required for posting and cancels the process if you aren’t allowed to post to the specified location.

Note

Note

Note

• 

• 

• 

• 

• 

• 

• 
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b) Release

A check might already be run one step before (a)—if the record that you release is a purchase, sales, or production document—

but only on document lines that you want to post.

Theoretically, posting the lines might then lead to more inventory postings, although these cannot be checked in advance.

Consequently, the system only runs a check if at least one line leads to inventory being moved, that is, some quantity still needs

to be shipped.

c) Lookup

Further upstream, the view provided by location lookups on documents and journals is limited to locations that you have

permissions for given the settings made for the document or journal line (for example, during a transfer).

The feature was designed as a usability improvement, which means that all locations remain available when you type in the name

of a site manually. Additionally, the view isn’t restricted when you create base data or want to set a filter on an analysis or the

Possession / Ownership field.

The following records are excluded from permission checks:

Invoices and credit memos that don’t lead to a change in inventory levels.

Report 71076607, which is used to create fixed assets.

Roles and users

Users can have permissions superior to those of the roles assigned to them. They can also have fewer permissions if some rights

aren’t granted to them. All a user's roles are checked, one after another, for the extent of their permissions. If none of those, nor

the user’s individual permissions, allow access to a certain location, the user cannot post to the location at all.

Transaction codes and movement hierarchies

Transaction codes specify the type of possession or ownership over an item and are automatically entered when you post a

warehouse shipment.

By using the associated movement hierarchy, the system then selects, depending on setup and availability and according to a

predefined sequence, the fixed, current, and third-party items that need to be shipped.

You can change this configuration on the Transaction Codes page, which is available via the general search, by replacing the

transaction codes and movement hierarchies filled in there by default. This way, you can ensure that, for example, used goods

(=current assets) are always shipped first.

If no inventory is assigned to a transaction code, the system will search for available inventory based on the next transaction

code set up in the system.

PRINT ITEM LABELS

You can have the system print labels for items that you post a receipt for. To set up the feature:

Choose the Search icon, enter Items, and then choose the related link.

Select an item or open the associated item card.

On the ribbon, choose Related > Item > Label Information, and then fill in the fields as necessary.

You can specify in the Print on Receipt field whether the label should be printed when the item is received. In the Packaging Size

field, you can specify the size of the outer packaging as a factor. As an example, entering 5 in this field would tell the system to

print three labels if a receipt contained 15 of the same items.

The barcode information that will be printed on the label consists of the item number and information for tracking the item (such

as a lot or a serial number). You can also enter a short text that should be shown on the label.

• 

• 

1. 

2. 

3. 

1.2.9 medtec365

- 1060/1545 - Copyright © 2018 - 2024 KUMAVISION AG



VERIFY INVENTORY

You can create a verification request in the system to ask customers to confirm how many items that aren’t their own are held by

them at their warehouses. The basis for verification is the quantity that is posted with warehouse shipments of type Transfer.

Choose the Search icon, enter Physical Inventory Journals, and then choose the related link.

Select a journal.

On the ribbon, choose Customer-Held Inventory to fill in the journal.

You can then compare the numbers entered in the journal to those provided by your customer.

INVENTORY: EASE-OF-USE FUNCTIONS

Besides offering year-end counts, medtec365 provides you with multiple functions for handling ongoing inventory control with

ease.

For example, with the new count fields available in physical inventory journals, you can quickly identify the parts of a location or

bin where you still need to take a physical inventory of your items. Additionally, you can now exclude an area from a count, if

necessary.

Setup

To be able to take stock, you must first complete all related transactions that involve some kind of inventory movement. This

means that you need to:

Take the items you want to ship from their bins and post their costs to the associated general ledger accounts.

Make sure that transferred items aren’t still at the in-transit location.

Adjust inventory as necessary and then post the adjustments.

Physical Inventory Location Setup

On this page, you can specify how you want a warehouse area to be divided among the physical inventory journals you’ve set up.

You can open the page by running the Phys. Invt. Location Setup action from the ribbon of a journal.

This way, you can speed up inventory calculations, especially if the number of items in inventory is comparatively large.

To assign certain rows and aisles of a location to a journal, you only need to fill in the Location, From Bin Code, and To Bin Code

fields on the page.

Block inventory posting

In medtec365 Setup, you can specify on the Inventory FastTab if you want to:

block all locations when a physical inventory journal is filled in.

block only the locations entered in the journal.

don’t block posting at all.

The setting that you choose will apply to all items entered on physical inventory journals. With the first two options, posting

inventory transactions (movements) will be blocked in sales and purchasing and on item journals.

Year-end counts

Calculate inventory

To do a year-end count:

Choose the Search icon, enter Physical Inventory Journals, and then choose the related link.

Use the Assist button to the right of the Batch Name field to select a journal.

On the ribbon, choose Prepare > Calculate Inventory, and then fill in the fields as necessary.

As for the field values that you can specify on the request page, the posting date and document number you fill in are later

copied to the journal lines so that you can track exactly when and what items were counted during physical inventory.

1. 

2. 

3. 
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• 

• 

• 

• 

• 

1. 

2. 

3. 
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You can also filter for certain locations and bins on the page to specify the areas that the journal should cover.

If the Calculate per Serial No./Lot/Expiry toggle is activated on the request page, the system creates (among other things) a line for

each lot that items are in inventory for. Turning on the toggle is therefore essential to proper stocktaking.

After you run the function, the Qty. (Calculated) field on a journal line shows the total quantity that is available in inventory for

the item entered on the line. If the Calculate per Serial No./Lot/Expiry toggle was turned on before you ran the Calculate

Inventory function, you also see a new line for each serial number assigned to the line item, for example. Meanwhile, the Qty.

(Phys. Inventory) field shows the number of items that were expected to be in inventory, as well as their tracking information.

Record count

Afterward, you can choose Print on the ribbon to print the list you need for a physical count. On the request page, you can then

specify if you want the quantity determined for each item on the list to be printed with the relevant tracking information and if

the print or count date should be added as well.

Enter inventory

When you’ve done the count, you can manually copy the quantities written in the Qty. (Phys. Inventory) column on the list to the

fields with the same name in the physical inventory journal.

You don’t need to fill in the field for every item but only for items where the quantity that you have on hand differs from the quantity

calculated earlier.

For items that use serial numbers, tracking must be removed before you can enter a quantity in the field and then reassigned

after you make the entry. For an item with a serial number, you must add a new line and tracking information manually.

Recount

When you need to do a recount, you can set filters on the lines to restrict the journal view to certain values, such as Difference

<15 or Quantity <> 0.

Ongoing inventory counts

Calculate inventory

For ongoing inventory control, only a limited number of bins are typically counted.

Choose the Search icon, enter Physical Inventory Journals, and then choose the related link.

Use the Assist button to the right of the Batch Name field to select a journal.

On the ribbon, choose Prepare > Calculate Inventory.

On the Filter: Item FastTab, specify a range of bins for calculation.

In the Inventory Type field, select the type of stock that you want to count. You can choose among the following options:

a. Year-End

Calculates the entire inventory (as of the balance sheet date).

b. Excl. Ongoing Inventory

Calculates inventory quantities for all item lines where the Counted On and Count Document No. fields aren’t filled in.

c.Only Ongoing Inventory

Calculates inventory for each line a count date and document number are filled in on.

Turn on the Ongoing Phys. Invt. toggle. This activates the Block Bins and Incl. Non-Inventory Items toggles as well so that no one

can post to the bins you’ve specified and that empty bins are included on the list.

Fill in the other fields as necessary.

Note

Note

1. 
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4. 

5. 

6. 

7. 
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Record count

For ongoing inventory counts, you again need a list for recording item quantities. For more information, see Year-End Counts >

Record Count.

Enter inventory

Ongoing counts are subsequently entered into the system in the same way as year-end counts. For more information, see Year-

End Count > Enter Inventory.

However, before you post a journal line, you need to choose Actions > Functions > Include in Regular Counts on the ribbon. This

opens a dialog box in which you can specify the number of the relevant count document and the count date.

This data is then copied to all calculated lines, as well as to the physical inventory entries and the bin content created for the

journal.

If you later add an item to a bin where the content has been counted before and the data pertaining to that bin is entered in the

box, only new items (=quantities) will be copied to the journal lines (provided you select Excl. Ongoing Inventory when using the

Calculate Inventory function).

Recount

The recount process used for ongoing inventory control is the same as for year-end counts. For more information, see "Year-End

Count > Recount“.

Special features: physical inventory journal

Specify possession and ownership

For third-party property, you can specify in the Possession / Ownership field whether the legal possessor or owner must be

recorded during counts.

Capitalize fixed assets

Fixed assets should be posted by using CA-CAP or another transaction code.

If you’re using a separate code, your financial department and the customer need to agree whether it should be set to Valued or

Not Valued. For CA-CAP, you need to run the capitalization function when you acquire the item.

When you dispose of an asset, the fixed asset number is recorded in the background so that you can check the asset schedule

later.

The FA transaction code should never be used to post positive adjustments to, for example, physical inventory or item journals.

INVENTORY VALUATION

Many companies also need to manage items that aren’t their own. This includes:

Items delivered by a customer for repair, with some also forwarded to suppliers before being returned to the customer.

Products managed and rented to customers but provided by a third party. 

Goods sold on consignment.

Rental equipment that counts as a fixed asset (although it will again be considered an item for the purposes of repair and

refurbishment).

What all these examples have in common is that they shouldn’t increase the value of your regular inventory or show up as such

inventory on your general ledger.

Additionally, the handling of these items must not have an influence on the average unit costs determined for them under normal

circumstances.

Note

• 

• 

• 
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In short, whatever way is used to ship or receive goods and move them through your warehouse, they must always, or in the case

of consignment, at least, temporarily, be excluded from inventory valuation.

With a new feature, you can use standard logistics processes to move items without changing the value of your inventory—but

still be able to arrive at the expected costs for consigned stock when ownership over it is transferred in purchasing. This

concerns the following posting processes:

You remove goods from a consignment delivery.

Products that you’ve sold are returned to you for rental or repair purposes.

You rent out items (which are recorded as fixed assets on your balance sheet).

You sell rental equipment that was capitalized as a fixed asset.

You buy back stock that was returned to you for storage or rental purposes.

You cancel one of these transactions.

Depending on the process, you can use transaction codes to set a valuation method manually. You can specify a code for each

method that you want to use. The correct method is then determined based on the type of transaction that occurs (as entered in

the Valuation Method field on posted item ledger entries). 

While this procedure works for posting quantities, you see an error message if the method shown on the invoice and the type

specified on the associated item ledger entry don’t match.

You can unhide and fill in the Transaction Code field on all types of purchase documents, except blanket orders, quotes, and item

journals. You can also set up default transaction codes for certain documents and lines on the Purchase Order Type page. For

more information, see Purchasing.

The valuation method is determined for each process separately and is then copied to the item ledger entry created by the relevant

posting.

A valuation method is also filled in on application entries if you apply an item that the field was specified for (that is, was set to

Valued, Variable, or Not Valued).

Output reported is always posted with a value.

Variable valuation

The delivery of consigned goods is typically posted as a purchase receipt in the app, with the Valuation Method field set to

Variable when you post them. The value of the items is then specified in the system not as a Cost Amount (Expected) but as a

Cost Amount (Not Valued) and the item quantity is copied to the ILE Qty. Not Valued field. Additionally, the valuation method on

the item ledger entry created during posting is specified as Variable.

When you later post an outbound transaction, like a sale, a disposal, or consumption, the system checks if Variable is selected in

the Valuation Method field on the applied ledger entry. Should the option have been selected, the system creates inbound item

ledger entries and—sorted by application date—value entries for expected costs, as if standard functionality had been used.

Afterward, the balancing quantity is entered as the ILE Qty. Not Valued.

The Cost Amount (Not Valued) in this scenario is calculated based on the following formula: ILE quantity not valued times cost

per unit, with the expected cost amount representing the opposite value.

If you want to cancel an entry, another value entry will be used to post the reversal.

Example

You have a purchase order of 20 items with expected costs of USD200, which works out to a unit cost of USD10 on the associated

item card.

• 

• 

• 

• 

• 

• 

Note

Note
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You then receive consigned stock that the Variable valuation method is selected for. The delivery consists of a total of 10 items

that are valued at USD110. Standard unit costs aren’t affected by the receipt, however.

Afterward, you transfer the items to another location. Posting the movement creates a value entry but has no impact on unit

costs either.

As a next step, six items are consumed. This means that another value entry must be created to change their valuation and

calculate expected costs.

You sell the remaining four items. As a result, the system creates yet another value entry based on the original document and

again calculates the expected costs.

If for whatever reason you need to cancel the consumption posting made for the first six items, the system identifies them as

items variable valuation was used for so that they’re returned to the non-valued status on the source document.

Reposting consumption for three of the items later will add values to them again, as shown in the following image.
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Non-valued inventory

In the case of repairs, items are posted to the warehouse from a sales return order. As they’re owned by someone else, however,

no inventory value is assigned to them, as indicated by their valuation method.

Consequently, the Unit Cost (Expected) and (Actual) fields on the item ledger entry that is created during the posting process

remain blank and only the Unit Cost (Not Valued) field is filled in.

If the entry is applied (for example, through a purchase return order used for repairs made by a supplier or via a sales order

when you ship the repaired items back to the customer), the valuation method is copied over to the applied entry and the number

of items is entered in the ILE Qty. Not Valued field, to prevent them from influencing standard unit cost calculations.

When the supplier returns the repaired items to you, the Valuation Method must then be set to Not Valued so that the items are

treated like on sales return orders.

You need to make the same settings for cancellations, with the valuation method set to Not Valued so that the ILE Qty. Not

Valued field is filled in.

Example

You have a purchase order of 20 items with expected costs of USD200. Ten of those are sold at USD100, which comes out to a

unit cost of USD10 on the associated item card.

You now accept five of them for repair, with the valuation method on the item ledger entry set to Not Valued during the posting

process. Even if you later adjust the costs by using exact cost reversal, the Cost Amount (Expected) and Cost Amount (Actual) are

then not filled in on the entry, only the Cost Amount (Not Valued) field is, and the unit cost entered on the related item card isn’t

affected by the postings either.

For repairs, items must be sent to the relevant supplier by creating a purchase return order; the valuation method Not Valued is

copied along when the entries are applied. The method also specifies that no changes must be made to the goods on the sales

document that they were originally entered on (as would be the case with consigned stock).

After the repaired items are returned by the vendor, you put them away by creating a purchase order and mark the receipt

posting as Not Valued.
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As a last step, you ship the items back to the customer; the result of this transaction is shown in the following image:

Manage third-party property

The posting processes used for repairs also apply to items that are owned by a third party but are stored in your warehouse for

other purposes.

Transfer ownership to third parties

In some industry solutions, ownership over items might change not by selling them directly to a customer but by creating a

transfer order, for example, if the items are paid for much later.

They’re then still treated as being owned by a third party, although no function has been implemented to cover this exact

scenario.

Convert to third-party property

You have a purchase order of 20 items with expected costs of USD200. Ten of those are shipped at a value of USD100 via a

transfer order, which comes out to a unit cost of USD10 on the associated item card.

A third party agrees to buy the items to assume ownership over them. But because they’re still held by you in any case, as they

were only transferred to another one of your locations, you need to post a negative and then a positive cost adjustment in the

system.

Afterward, you post the item quantity again as non-valued third-party property:
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Buy third-party property

Buying back items you sold is typical for handling return orders. However, because of their current status as third-party property,

you first need to post a negative cost adjustment for them as well.

Revalue inventory

If variable valuation is used, revaluation should only be possible for items that you decided to include in the value of your

inventory.

As the standard app allows the revaluation of expected costs only to a limited extent, it is excluded in variable valuation to

reduce complexity. This means that item ledger entries can only change in cost if the valuation method is set to Valued.

LOCATIONS AND BINS

Receiving location and customer bins

The name of the default receiving location is OFF (offsite).

Each bin at the location is named for a customer so that you can quickly identify who is in possession of the items stored in it. A

bin is created automatically when you set the movement type on a sales order to Transfer.

To set up the feature:

Open a location card.

On the medtec365 FastTab, in the Receiving Location Code field, select the site that you want to use for transfers from this

location.

On the same tab, turn on the Auto Assign Customer Bin toggle.

This setup can be useful for a site that patients are supplied from, for example.

Post outbound transfers as inbound

With the Auto Post Transfers toggle on a location card turned on, a receipt is posted automatically for a transfer order when the

order is posted as shipped at the source location. This can be useful, for example, when you have no staff member who could

confirm receipt at the destination.

Warehouse type: bins

You can specify the following warehouse types on the Bin page:

On Hand

Receipt

Shipment

Production

QM

You must assign a type to each bin when it is created. Picking is only performed for bins of type On Hand.

SHIPPING AND PICKING: EASE-OF-USE FUNCTIONS

A page combining warehouse shipment and picking functions has been added to the app, showing you only the take lines for

picks and keeping them aligned with the put-away lines.

1. 

2. 

3. 

• 

• 

• 

• 

• 
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Print pick list

After you’ve pulled source document lines to a warehouse shipment document, you can choose Print/Send > Print Pick List on

the document ribbon to print out a list of all the items that must be picked from the warehouse.

Delete shipment

Sometimes, a warehouse shipment might need to be deleted because the customer who ordered the items no longer requires

them (or, for example, an employee forgot to remove the pick code before posting the warehouse shipment).

Pick lines are automatically registered when you post a warehouse shipment, even if an error occurred during posting (for

example, because of the code used for picking).

When lines are registered, the items specified on them are posted from their source bin to the default OUT warehouse bin and

you can no longer see the lines on the Warehouse Shipment page.

Now, before you can delete a shipment, you need to reopen it by choosing Release > Reopen on the ribbon.

You then see a message that shows you the items that were picked and are asked if you want to move them back to their source

bins. Choose Yes. You’re informed that transfer journal lines have been created (provided the Own Jnl. Template Name field is

filled in for your user ID in User Setup) and are asked if you want to see the journal.

Choose Yes again to open the journal. Afterward, you’re told that the picked items will remain in the OUT bin, that is, the

shipping area, unless transferred and are asked whether you want to delete the warehouse shipment.

Choosing Yes a third time deletes the shipment and the only thing left to do is to put the items back to where you want them.

TRACK SLOW-MOVING INVENTORY

To see which of your items aren’t selling, use the general search function to open the Slow Movers page. The following actions

are available on the ribbon:

Refresh: ribbon function

This action is run to look for all open item ledger entries, that is, all entries for which a quantity remains in inventory.

Function Description

Refresh Recalculates all lines.

Resolve Opens the Take Action page for the selected line.

All

Problem Items

At-Risk Entries

Problem Entries

Follow Up Entries

Filters the page view based on the specified value.
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One line is then created per open entry. Entries that already exist are updated; those that have been closed are deleted. Overall,

the following line fields are filled in by the function:
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Field Description

Entry No. Specifies the number of the item ledger entry.

Item No.

Variant Code

Location Code

Transaction Code

These fields identify the item on the line and are used to calculate its quantity on hand and

consumption.

Description

Description 2

These fields show the description and additional description stored on the related item card.

Posting Date Is filled in from the item ledger entry.

Sched. Consumption

Code

Specifies how consumption of the item is calculated.

Qty. on Hand Indicates how many items remain in storage.

Remaining Quantity Is filled in from the item ledger entry.

Serial No.

Lot No.

Warranty Date

Expiration Date

Manufacturing Date

External Lot No.

The values in these fields are copied from the item ledger entry as well.

Sold Until Is filled in with a value that the system extrapolates from the item quantity on hand and sales of

the item per day.

Minimum Expiration

Date

Is filled in according to setup.

Problem Item Selected if the date shown in the Sold Until field is later than the minimum expiration date.

Problem Entries Selected if there is at least one problem with the item.

Sales per Day Shows the result of applying the consumption schedule.

Amount Shows the remaining quantity multiplied by the unit cost.

Comment

Comment (Whse.)

Used to enter remarks about the item.

Customer Count indicates how many customers have bought the item. You can see them by using the lookup in

the field.

Modified By

Modified On/At

Shows by whom and when the record was last changed.

Follow-up By

Follow-up On

These fields are set on the Take Action page.

Shelf Life on Sale

(Months)

Specifies, in months, the difference between the Sold Until and Minimum Expiration Date

values.

Best-By (Sale) Is filled in according to setup.

Entries at Risk Selected if the date shown in the Best By (Sale) field is later than the minimum expiration date.

Statistics Main Group

Statistics Group

Statistics Subgroup

These fields are filled in from the related item card.

CG Statistics Main

Group

These fields are filled in from the related customer card.
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Colors

Lines where no problem has been encountered are displayed in green, at-risk entries in black, problematic entries in blue, and

problem items in red.

Resolve: ribbon function

Running the Resolve action opens the Take Action page for the current line.

At the top of the page, you can see detailed information about the item. You can then enter the solutions you’ve tried. You can

also specify here if you want to follow up on this issue or all issues with the item and when you want to do so.

The Follow-Up Date field is copied to the line when you select an action on the page. After a date is set, you no longer see the

record when you filter for problem items, for example.

Selecting the Exp-DATE-2M option on the page sets the date for following up on the issues with the item to two months before

the item is shown to expire. With the Set-Multiple action, you can apply the setting to all ledger entries that are created for the

item. Set-Single means that the formula applies only to the selected entry.

In the Action Reason field, you can describe the reasons for taking action, and in the Solution field, how to solve the issues you

have. Choose Return here, for example, if the item should be returned to the vendor.

The remarks that you enter in the Comment and Comment (Whse) fields are shown on the Slow Movers page later. One such

warehouse remark might be: “Please move to restricted location.”

The Follow-up Date field is only used to deal with issues arising from slow-moving inventory and isn’t part of the medtec365 follow-

up feature described elsewhere in these articles.

PICK FROM MULTIPLE ORDERS

You can now set filters to combine picks for multiple shipments, which will help you save time and optimize your pick paths.

Before you can work with this feature, however, you must set up multiple warehouse shipments and register picks for them in the

system.

You then use the general search function to open a new pick worksheet and choose Get Multi-Order Lines on the ribbon. On the

request page, you can set the maximum number of lines that a shipment can have for it to be included in multi-order picking.

This ensures, for example, that a large outbound delivery isn’t split up before leaving your warehouse. Additionally, you can

specify if you want to pick items not only from warehouse shipments but also from production or assembly orders.

As a next step, choose OK so that the system can copy all lines that a pick document hasn’t been printed for to the worksheet.

Following retrieval, you need to select the Include in MOP checkbox on the lines that you want included in the multi-order pick

process.

If you exclude a certain sales line from the multi-order pick, the other lines of the sales order will be excluded from it as well.

Field Description

CG Statistics Group

CG Statistics Subgroup

Note

Note
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Afterward, choose Create Multi-Order Pick on the ribbon. You can make a variety of settings on the request page of this function

to customize the new pick documents to suit your needs, as described in the following table.

Pick lines where the Include in MOP field has been cleared must be processed manually on the pick worksheet.

After the picks have been created and the pick documents printed, you can continue with picking, packing, and posting the

shipment in the usual way.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Option Function

Per Whse. Document Creates pick documents for worksheet lines with the same warehouse source document.

Per Cust./Vend./Loc. Creates pick documents for each customer, vendor, and location.

Per Item Creates pick documents for each item on the pick worksheet.

Per From Zone Creates pick documents for each zone.

Note

This function is only used for directed pick and put-away.

Per Bin Creates pick documents for each bin.

Per Due Date Creates pick documents for source documents that have the same due date.

Max. No. of Pick Lines Creates pick documents that have no more than the specified number of lines on each

document.

Max. No. of Pick Source

Docs.

Creates pick documents that each cover no more than the specified number of source

documents.

Assigned User ID Creates pick documents only for worksheet lines that are assigned to the selected warehouse

employee.

Sorting Method for Pick

Lines

Specifies how the created pick documents should be sorted.

Print Pick Document Prints the pick documents created by the multi-order pick.

Note

1. 
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Service

The following features expand standard Microsoft Dynamics 365 Business Central1 functionality to provide additional options to

those working in your organization’s service department.

SETUP

Role center

A role center called medtec365 Service has been added to the standard service area, providing you with an overview of ongoing

tasks and an easy way to select and open pages relevant to your work.

You can find the role under the My Settings page.

Work with tiles

The medtec365 Service role center contains multiple cue tiles, each filtered to one or more of the repair statuses specified on

service item lines. You can therefore use the tiles alone to finish most tasks in the service area.

The statuses can be changed in Service Management Setup.

Service Orders – Open

Service Activities – Technicians

Service Orders – Estimates

Cue Description

New Service Shows all orders that were created manually or based on receipts at the warehouse but have yet to

be processed.

This includes every order where the repair status is set to New Order, Sales Return Posted, or

Receipt Checked.

To Inspect Shows all orders that must still be assessed (repair status To Inspect).

Inspected Shows all orders that have already been assessed (the repair status is set to Inspected).

Customer-Held

Items

Shows all item ledger entries.

Cue Description

To Inspect Shows all orders that still need to be assessed (repair status To Inspect).

Service

Released

Shows all orders on which items must still be repaired (the repair status is set to Scheduled, Service

Released, or Service Started).

Cue Description

To Estimate Shows all orders that cost estimates are required for but have not been created yet (repair status

To Estimate).

Estimated Shows all orders that cost estimates have been created or sent for (the repair status is set to

Estimated or Estimate Sent).

Estimate Rejected Shows all orders where customers did not accept estimates (the repair status is set to Estimate

Rejected).

Estimate Accepted /

Not Reqd.

Shows all orders that cost estimates have been accepted for or where you do not need to create

estimates in the first place (the repair status is set to Estimate Accepted or Estimate Not Reqd.).
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Service Orders – In Process

Service Orders – Custom

The four tiles in this section can be customized in Service Management Setup to suit your needs.

Service Management Setup

General

Cue Description

Service at

Vendor

Shows every order where the Current Place field is set to At Vendor (that is, for which a purchase return

order has been posted).

Service

Released

Shows all orders on which items must still be repaired (the repair status is set to Scheduled, Service

Released, or Service Started).

Service OK Shows all orders that repairs have been successfully carried out for (the repair status is set to Service

OK).

Service Not OK Shows all orders that repairs could not be carried out for (the repair status is set to Service Not OK).

Delivered Shows all orders where something has been or needs to be sent to the customer (the repair status is set

to Sent to Customer or Confirmed by Cust.).

Field Description

Order Type –

Repairs

Specify the order type that will be automatically entered on a service order when you run the New

Case function on a customer, marketing cockpit, or serial number information card and classify the

order as a repair case.

Order Type –

Maintenance

Specify the order type that will be automatically entered on a service order when you run the New

Case function on a customer, marketing cockpit, or serial number information card and classify the

order as a maintenance case.

Order Type –

Receipt

Specify the order type that will automatically be entered on a service order when you post a service

receipt.

Archive Orders Specify whether service orders should be archived.

Archive Service

Quotes

Specify when you want service quotes archived. Options are Never, Question, and Always.
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Defaults
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Field Description

Location Code

(Service)

Bin Code (Service)

Specify the location and bin that will automatically be filled in on the header of a service order

that you create.

Both fields are also filled in by the system on receipt headers when they are created.

Loan Location Code

Loan Bin Code

Specify the location and bin that will be automatically filled in when you enter a loaner on a

service order.

Substitution Location

Code

Substitution Bin Code

Specify the location and bin that will be automatically entered on a service order when you ship a

substitution item from the order.

Service Consump.

Location Code 

Service Consump. Bin

Code

Specify the location and bin that will be automatically filled in when you enter items of activity

type Service Consumption on the service lines.

Customer Location

Code

Specify the location that will be automatically filled in as you transfer items to a customer, with

the name of the bin matching the customer number.

Vendor Location Code Specify the location that will be automatically filled in as you transfer items to a vendor, with the

name of the bin matching the vendor number.

Discount Reason Specify the reason for a discount granted during repairs, such as a discount on spare parts.

Logistics Discount

Reason

Specify the reason for a discount granted for logistics-related activities. Examples are returns in

sales and purchasing.

Transaction Code TPP Select a transaction code for items posted in connection with repairs.

To prevent the posting of costs, we recommend that you treat most items that are specified in the

service area as third-party property.

Transaction Code CA Select a transaction code for items added to service lines.

In service management, sales and consumption are usually posted as current assets. As a result,

the system considers both to belong to this asset category if the field is left blank.

Current Place Specify what option should be selected by default in the field with the same name on new service

orders. Options are:

• (blank)

• Onsite

• Inhouse

• At Vendor

The setting that you make here is automatically copied to all service item lines that you create

(although you can change the option there manually, if necessary).

Place of Servicing Specify what option should be selected by default in the field with the same name on new service

orders. Options are:

•(blank)

• Onsite

• Inhouse

• At Vendor

The setting that you make here is automatically copied to all service headers and item lines that

you create (although you can change the option there manually, if necessary).
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Activities

On this FastTab, you can specify the actions that will be added to the Lines FastTab ribbon above service item lines and service

lines.

Scrapping

Cue Filter

Here you can remove or add the repair status filters set on each cue tile on the role center.

Free to Use

On this FastTab, you can customize four tiles that you can then filter for their repair status.

Field Description

The value in this field is also changed by the system when you post certain documents, such as

purchase return shipments.

Destination Doc. Type Specify the document type that will be used when you enter an item or a resource manually on

service quote or order lines.

If this field is left blank, the type is retrieved from the standard service code that is assigned to

the selected BOM. For more information, see Destination Doc. Type on Service Quotes and

Orders.

Claim Call Type If a complaint is created from a service order, the stored call type is automatically stored in the

field of the same name in the complaint.

Complaint Call Type If a complaint is created from a service order, the stored call type is automatically stored in the

field of the same name in the complaint.

Field Description

Activity Grp. – Repair BOM Store the activities used for spare parts supply.

Activity Grp. – Service Store the activities used for repairs.

Activity Grp. – Estimate Store the activities used for estimating costs.

Activity Grp. – Sales Return Store the activities used to process return receipts.

Activity Grp. – Sales Shpt. Store the activities used to process sales shipments.

Activity Grp. – Purch. Return Store the activities used to process return shipments.

Activity Grp. – Scrapping Store the activities used for handling scrap.

Operation Group Claim Complaint Deposit of the activity group for the complaint and claim.

Field Description

Scrap Location Code

Scrap Bin Code

Specify the location and bin that will be used for two-stage disposal.

This involves transferring the item to a special scrap location and then manually posting the removal

of the item from this location.

Scrap Serial No.

Status

If needed, specify the status that will be entered on the relevant Serial No. Information Card when

you post an item as scrapped.

Scrap Source Code If needed, specify the source code that will be entered on the relevant Serial No. Information Card

when you post an item as scrapped.
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Service order types

You can use service order types to categorize orders by the type of service provided and store different settings for each. To set

up a type:

Choose the Search icon, enter Service Order Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

You can also choose Actions > Service Activity Templ. Setup on the ribbon to specify for each order type one or more service

item group codes that should be linked to an activity template code.

The template codes are then stored on the relevant item lines, whereas the activities from the template are added to the Service

Activity Groups FactBox.

When you choose New Case on the ribbon of a customer, marketing cockpit, or serial number information card, the system copies

the service order type entered in Service Management Setup to the new document provided the case was set up for repairs or

maintenance purposes (see Service Management Setup – General).

However, if no default value is specified, the Service Order Type field remains empty on the service order.

When you create an order for inbound services, the order type is also retrieved from Service Management Setup (again, provided

the type is specified there). When you create an order from a complaint registered in sales, the system fills in the type that was

selected as the default type.

When a service order is created in the maintenance cockpit, the order type is copied from the associated service contract.

Order types and payment terms

You can assign payment terms to a service order type, to replace those stored in the customer master. To assign terms to a type:

Choose the Search icon, enter Service Order Types, and then choose the related link.

On the ribbon, choose New. Alternatively, choose Edit List to edit a type that already exists.

Fill in the Payment Terms Code field.

When you create a service order, it is initially filled in with service order type Default. The system then checks if payment terms

are available for the order type. If so, the terms are used. If none exist, the terms are copied from the relevant customer card.

1. 

2. 

3. 

Field Description

Code Specify a code for the order type. The code must be unique.

Description Specify a description for the type.

Sales Order Type

Pricing

Specify the related sales order type if you agreed on a different pricing structure for a certain

type of service.

Default Specify the default order type that will be used when you create a service order manually.

Note

Only one service order type can be selected as the default type.

Service Order Type Here you can assign a classification to the order type. Options are:

• (blank)

• Repairs

• Maintenance

This classification is automatically entered in the Case Category fields on service case documents

that you create.

1. 

2. 

3. 
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When you edit a service order type, the system runs the same check again to update the payment terms, if necessary. The same

applies when you change a customer on an order. If no payment terms are assigned to the new type, the terms will be copied

from the customer, as mentioned earlier.

Service activity groups

Service activity groups are used to set up the activities (such as the creation of cost estimates, the loan of equipment, and

scrapping) that might occur during repairs.

You can store different settings for each activity so that multiple activities might be possible, which will depend on, for example,

the location where services are carried out. A group consists of standard service codes (=activities) assigned to it.

When you run an activity group, the system automatically limits the pool of available activities based on the circumstances of the

case you’re working on or allows you to select a suitable code. With the help of service activity templates, the groups can be

combined into a sort of a work schedule.

In Service Management Setup, you can also specify groups that can be run from the ribbon of service (item) lines (see Service

Management Setup – Activities).

Service activity templates

These templates specify the individual steps for repairs and maintenance.

Each template is linked to a service order type and a service item group so that it is automatically filled in on the relevant item

lines when you create a service order. All steps are also listed in the Service Activity Groups FactBox. To set up a template:

Choose the Search icon, enter Service Activity Templates, and then choose the related link.

On the ribbon, choose New.

Fill in a code and a description for the template.

Choose View on the ribbon to open the Service Activity Template Card.

Choose New Line to fill in an activity group code, and then repeat the process as necessary.

Service Activity Template Setup

Field Description

Code Specify the code of the activity. The code must be unique.

Description Specify a meaningful description for the activity.

Service Activity Type Assign an activity to the code. Options are:

• Repairs

• Maintenance

• Substitution

• Loan

• Service

• Scrap

• Estimate

• Logistics

Item No. Required Specify if an item number is required for the activity. Options are:

• No

• Optional

• Always

Text Required Specify if a text is required for the activity, for example, for labeling. Options are:

• No

• Optional

• Always

1. 

2. 

3. 

4. 

5. 
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On this page, you can specify per service order type one or more service item group codes that should be linked to a service

activity template. When you later enter an item on a service order, the system checks the service order type and the item group

code for a link to an activity template.

If a link exists, the activity template code is automatically entered in the field with the same name on the relevant service item

line. Additionally, the steps that make up the activity will be listed in the Service Activity Groups FactBox.

Standard service codes

These codes are used to assign certain settings to service activities, such as BOM or cost estimate creation, equipment rental, or

item returns and scrapping.

Each standard service code can be assigned to an activity group. Based on a variety of parameters, the system then determines

the relevant activity from the context of the case or allows you to manually select a suitable code.

The values that you specify on service code cards are filled in on a service order or a service line automatically when you start an

activity from there.

Standard Service Code Card General

Field Description

Service Order

Type

If available, specifies the type of service order.

The code is only visible on orders that are of the same service order type.

Service Activity

Grp.

Specifies the group that the service code belongs to.

Onsite

Inhouse

At

Vendor

These fields are relevant to handling service orders. Only activities with the same location specified on

the standard service code record can be started on the service order.

Example

For standard service code REPLACEMENT, you choose Inhouse and At Vendor. This means that the

REPLACEMENT activity cannot be run on a service order where Onsite has been specified.
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Lines
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Field Description

Selected Only used if the related activity group is set to Service BOM.

Item or resource lines that the field is selected for on the BOM are then filled in automatically on

service quotes and orders.

Print Line Specifies whether a line containing this code should be printed.

The setting is later copied to the Print Line field on each service line that you create with this service

code.

Relation Options are:

• (blank)

• Service Item

• Substitution

• Loaner

A blank field means that no relation has been specified, as in the case of BOMs. The setting is later

copied to the Relation field on each service line that you create with this service code.

Type This setting is later copied to the Type field on each service line that you create with this service code.

No. Specifies the number linked to the service code.

With the Relation field filled in for a service, loaned, or substitution item, the item number specified on

the service item line will be used and this field should remain empty.

The setting is later copied to the No. field on each service line that you create with this service code.

Discount Reason Specifies a discount reason, if available. This reason is copied to the associated service order

automatically when the specified activity is performed.

Not Billable Shows No if an item value should be calculated. Otherwise, the No Cost option is selected in this field.

The setting is later copied to the field with the same name on each service line that you create with

this service code.

Destination Doc.

Type

When you run a service line linked to this service code, the system will create the document specified

here and fill it in with what you entered on the line. Options are:

• Service Consumption

• Service Sales

• Service Quote

• Sales Quote

• Sales Order

• Sales Invoice

• Sales Cr. Memo

• Sales Return Order

• Sales Transfer

• Sales Return Transfer

• Purch. Quote

• Purch. Order

• Purch. Invoice

• Purch. Cr. Memo

• Purch. Return Order

• Transfer Order

• Item Jnl. Pos. Adjmt.

• Item Jnl. Neg. Adjmt.

• Item Journal Transfer
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Field Description

The setting is later copied to the field with the same name on each service line that you create with the

service code.

Direction Specifies the direction of the flow of goods.

When you post service equipment, the direction should be specified so that the current location of the

equipment can be updated on the relevant service item lines. Options are:

• (blank)

• Cust. -> Serv.

• Serv. -> Cust.

• Vend. -> Serv.

• Serv. -> Vend.

• Cust. -> Vend.

• Vend. -> Cust.

The setting is later copied to the field with the same name on each service line that you create with

this service code.

Location Code

Bin Code

These fields only need to be changed manually in rare circumstances, as the values from setup are

filled in by default.

Lines where the Service Item relation is selected typically contain the location that was entered on the

associated service item line.

For substitutions and loaned items—and for lines with consumption and transfers from and to a

customer or a vendor—the location and bin specified in Service Management Setup are entered here.

The settings are later copied to the location and bin code fields on each service line that you create

with this service code.

Transaction Code This field only needs to be changed manually in rare circumstances, as the value from setup is filled in

by default.

Lines where the Service Item relation is selected typically contain the transaction code that was

entered on the associated service item line.

For consumption, the code that is assigned to third-party property in Service Management Setup is

used.

The setting is later copied to the field with the same name on each service line that you create with

this service code.

Auto Create

Document

After an activity is inserted, the first service line where this field is set is run, that is, a document is

created and, if needed, a tracking number.

The setting is later copied to the field with the same name on each service line that you create with

this service code.

Auto Show

Document

Specifies whether the system should show new documents created for the service line.

The setting is later copied to the field with the same name on each service line that you create with

this service code.

Repair Status

Code

If available, specifies that the status of repairs is updated when you post a document added to the

lines.

Order Type This field is used on purchase and sales documents created from the related service order, for

example, on sales return receipts, but has no function on service documents.

1.2.9 medtec365

- 1084/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Standard service item groups

With the help of standard service item group codes, you can set up BOMs for repair and maintenance purposes. Items and

resources that are relevant to either are therefore entered on standard service code cards. If necessary, you can also specify a

quantity on every card.

To see the standard service item group codes, choose the relevant function on the ribbon.

You can assign one service type (such as repairs or maintenance) to each standard service item group and then store the group

in the field with the same name on the relevant item card.

The Service Order Type field has no function and is shown for informational purposes only.

Standard Service Item Group Setup

On the Standard Serv. Item Gr. Setup page, you can link standard service item groups to standard service codes. If no link is

specified, an activity applies to all groups.

We recommend that you link each service BOM to a service item group; otherwise, all existing BOMS are shown on service orders

and quotes.

Repair Status Setup

Each service item line contains a repair status code, showing the status of the line. The tiles on the medtec365 role center are

also filtered to the statuses available in the system.

Field Description

The type is later copied to the field with the same name on a service line created with this service

code.

Depending on whether the target document type involves a purchase, sale, warehouse, or service

transaction, the specifications entered for this type of order apply.

Work type code Work type for each resource.

By assigning a work type to each resource, it is possible to set different prices for the same resource.

Note

Field Description

Code Specifies the code of the standard service group.

Description After you enter a code, the description is filled in automatically.

Service Type Specifies the service type assigned to each item group. Options are:

• (blank)

• Repairs

• Maintenance

Copy to Serv. Line This field currently has no function.

Service Order

Type

Specifies the type of service order.

The service order type has no effect on processes in the system and is used for purely informative

reasons.

Tip

1.2.9 medtec365

- 1085/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Depending on setup, some statuses automatically change when you post a certain document. You can, however, also set or

change a status manually at any time.

The Status menu item on the Lines FastTab ribbon above service item and service lines provides additional statuses that can be

set by users.

You specify all required repair statuses in Repair Status Setup, where you can enter codes and descriptions for the services that

are rendered. To see the page, use the Search icon, enter Repair Status Setup, and then choose the related link.

To ensure that the status of repairs is correctly set on a line, you also need to assign an activity status to each code in setup.

Options are:

(blank)

New Order

Receipt to Check

Receipt OK

Items OK

To Inspect

Inspected

New Purch. Order

Estimate Sent

Send Estimate

Estimate Not Reqd.

Estimate Accepted

Estimate Rejected

Service Released

Service Started

Service OK

Service Not OK

Shipment OK

Scrapped

Finished

For more information, see Set Up Statuses for Service Orders and Repairs.

Service inspection groups

On service item lines and service lines, you can use a two-stage process for ordering items so that you can store any number of

technical inspections on the top level, the Service Inspection Group. To set up a group for technical inspections:

Choose the Search icon, enter Service Inspection Groups, and then choose the related link.

On the ribbon, choose New.

Fill in a code and description for the group.

On the ribbon, choose Inspections, and then enter all potential settings that you want to make available for later.

Service Inspections Setup

All potential defects that might result from the service inspections in a group are specified on this page. You can store multiple

types of inspections per group.
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An inspection group cannot currently be assigned to an item card.

Service Contract Setup

On this page, you store the service agreements that you enter into with customers.

The values that you specify here are automatically filled in on service orders in the fields with the same name.

Solution codes

These codes can be used to specify individual agreements made after consulting with a customer. You store the codes on the

Service Contract Setup page. They’re then shown on service item lines automatically.

You can also store activity template codes on the Solutions page, as an alternative option for having the template codes filled in

on item lines later.

Attribute Classes

The characteristic classes can be used to define parameters and settings for devices in the system (so-called device parameters).

Furthermore, patient characteristics and measurements are also stored here (customer parameters). The entry is made with

date, user, so that the historical values are saved. The characteristic class values of a serial number are thus displayed directly in

the serial no. information list (overview) and serial no. information card in an info box.

The characteristic classes are called up via the user search.

The "Code" and "Description" of the characteristic class are also defined here at the beginning. The "Belongs to feature class

type" field is used to control whether this feature class is to be used as a device parameter, customer parameter or both.

Note

Field Description

Contract Type Specify the type of contract that you entered into. Options are:

Estimate

Fills in the Estimate Limit field.

Solution Code

With this option selected, you can fill in the Solution Code field.

You can enter any code you want. The code is used, for example, to specify that an item can be

scrapped if it can no longer be repaired.

Both fields are visible on service item lines.

Customer No. If necessary, specify the customer number that will be used for this type of contract. If the field

remains blank, the type will be used for all customers.

Ship-to Code If the Customer No. field is filled in, this field can be filled in as well.

Service Item Gr.

Code

Specify the code of the service item group code that will be used for this type of contract.

If the field is left blank, the type will be used for all service item groups.

Service Order Type Specify the order type that will be used for this kind of contract. If the field remains blank, the

contract type will be used for all types of service orders.

Estimate This field can be filled in if Estimate is selected as the contract type.

Solution Code This field can be filled in if Solution Code is selected as the contract type.
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An image can also be stored for a feature class. The individual parameters/characteristics are assigned to the characteristic class

on the "Characteristic class additional fields" information tab. The characteristics are mapped in KUMAVISION medtec365 using

additional fields.

An example is the "Wheelchair" feature class, which is set to "All" in the "Belongs to feature class" and could contain, for

example, the seat width, seat height, brake design and equipment in the "Feature class additional fields".

Customer parameters

The customer parameters record the dimensions and values of a customer according to which a tool or device is to be set. These

can be stored in the Marketing Cockpit (alternatively also on the customer card) on the "Contact info" info tab under

"Characteristic classes".

The characteristic class code must be entered in the upper part of the screen. The user who entered and changed the feature

class is also recorded here.

The corresponding additional fields for the parameters are listed in the lower section on the "Characteristic class values"

information tab. The value of the feature is entered in the "Value" field. It is also possible to maintain an image for the respective

feature class here.

Device parameters on the item

The characteristic classes can also be stored on the article card in order to record the properties and parameters of the devices.

The call is located in the menu ribbon under "Characteristic classes".

The feature classes are selected in the upper part of the screen. If the same feature class is stored again in another line, the

"Historical" check mark is automatically set in the previous line in order to be able to keep track of the various parameters of a

device in this way. The user who created and, if necessary, changed the data record is also recorded here.

In the lower information tab "Characteristic class values", as with the customer parameters, default values can be preset if there

are settings that are the same for all devices.

On the article card, you can also control whether an article is subject to device parameters or not. If the "Device characteristic

obligation" switch is activated on the "Article tracking" info tab, the device parameters must be filled or confirmed for each

goods receipt posting.

Device parameters in goods receipt

When devices are delivered, the item tracking is recorded in the goods receipt line. To do this, either the "Quantity" field is used

or the "Line" button is used to open the item tracking lines.

In the item tracking lines, the characteristic classes can then be maintained on the "Start" info tab after entering the serial

number.

If the device characteristic requirement is activated for the item and nothing is entered here, but the goods receipt is posted with

missing device characteristics, an error message appears and the posting is not carried out.

The characteristics must now be maintained in the item tracking lines under "Quantity current delivery" or "Line" "Item

tracking". The familiar screen opens again, on which the data must be maintained according to the corresponding additional

fields.

The goods receipt can then be posted and the parameters are now written to the serial no. information card.

Device parameters on the serial number information card

Once the goods have been received, the device parameters of an item are transferred to the respective serial number, taking into

account any default values on the item or the characteristics recorded in the goods receipt.

For this purpose, the "Characteristic classes" is also called up on the serial no. information card and the characteristics screen

opens.

The parameters can now be viewed both in the characteristic class screen and in the info box.

Parameters in goods issue
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The customer parameters are displayed in the info box in the order or goods issue.

The customer parameters are also printed on the picking slip

If a serial number is entered in the picking lines of the goods issue, the associated device parameters can be viewed. To do this,

call up the "Picking lines > Article attributes" info tab.

If a device is or has been set, it is also possible to copy the customer parameters to the device parameters in the goods issue. To

do this, the "Copy customer attributes to device" function is executed in the picking lines.

Search for characteristics

The feature search can be used to search for matching serial numbers or devices at various points using the feature classes.

Tolerances (-+=) can be specified. Only hits from devices in stock are displayed. A filter for the storage location and booking

code can now also be specified for the search.

The characteristic search can be carried out in the following places:

Picking lines in goods issue

Overview of the serial number information list

The characteristic class and customer are entered in the upper area of the screen. As a result, the customer parameters are

displayed in the "Customer characteristics" info box. It is also possible to filter on the storage location and booking code in this

tab in order to further restrict the search for devices.

The individual characteristics of the characteristic class are displayed on the "Search parameters" information tab. The value of

the parameter is now entered in the "Value" field. The tolerance in the search result can be controlled via the tolerance type and

the tolerance.

After entering the values and, if necessary, the tolerance, the feature search is carried out via "Search". The serial numbers that

match the criteria, including the exact storage location and storage bin, are listed in the "Characteristic classes search result"

information tab below. In addition, the parameters of the respective device are displayed in the "Item characteristics" info box.

If the screen is confirmed with "OK", the selected serial number is transferred to the goods issue.

SERVICE RECEIPTS

On this page, you store all warehouse receipts used for rendering technical services.

You can store any item on this page, regardless of whether it is tracked or whether it has already been set up in the system. This

means that if a customer sends multiple items back for repair, all of them can be entered here.

Unexpected receipt

To register a receipt:

Choose the Search icon, enter Service Receipts, and then choose the related link. 

On the ribbon, choose New.

Like on a service order, the quantity on each line is 1 and cannot be changed. You therefore must create one line for each item you

want to record a receipt for (even if all of them are from the same lot).

The location and bin codes are filled in automatically but can be changed per line, if necessary.

As for the External Document No. field, you can set up whether the number is required by turning on the relevant toggle in

Purchases & Payables Setup. Filling in the Your Reference field is optional.

The relevant customer number can be entered manually or selected by using the Assist button next to the field. The same goes for

the serial, lot, and item number fields. You can also choose a ship-to code, if necessary.

When you enter a serial, a lot, or an item number on a line, you see a dialog box with the fields related to the record already

filled in if the number is set up in the system.

When you enter the serial number, the system also checks whether the customer on the associated serial number information

card is identical to the customer specified on the line. If the serial number isn’t set up for the combination of item and customer
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number you’ve entered, you see a message about it and are asked whether you want to continue. Choosing Yes and posting the

receipt will replace the customer number on the serial number information card automatically.

If the entered serial or lot number isn’t available, you can specify an item number and (potentially) a variant code, an expiration

date, a manufacturing date, and a customer number in the dialog box during posting and a new serial or lot number information

card will be set up by the system.

If the tracking code assigned to the item requires that you enter a variant code or an expiration date or a manufacturing date,

you can edit the fields in the box. Otherwise, they’re grayed out.

After you choose OK, the information you entered in the box is automatically filled in on the Service Receipet Lines FastTab.

When you post the receipt, a return order is posted by the system and a new service order is created. You see a message if the

data that you specified is incomplete, for example, because the customer or the item is blocked.

The posted return order is also automatically linked to a case document so that you can view it again at any time.

You might see another message if the receipt cannot be used because an item with this serial number is already in inventory. You

can then repost the item in the service area, regardless of whether the related service order has been completed.

You can also specify accessories on each line. For more information about the topic, see Add Accessories.

Additionally, you can use the Inspection Codes action on the ribbon to enter a code for inspections on each line. The codes are

then copied to the related service order when you post receipt lines and can be used to, for example, record damage that

occurred during transportation. For more information, see Service Inspection Groups.

At present, the service receipt feature doesn’t check the run hour requirements of items.

Expected receipt

If a customer tells you upfront that they will send in one or more items for repair, you can also create a service order and—from

there—a sales return order prior to receipt.

You can change the location and bin on this return order, if necessary. The order must then be released. Afterward, you can

register the expected receipt by using one of the following methods.

Option 1: Post to the return order

The most straightforward option is to post the service receipt by running the Post > Receive and Invoice function from the sales

return order.

Option 2: Create a service receipt from the return order

Alternatively, you can use the Create Whse. Receipt action on the return order to have the data shown on the document copied to

a new service receipt, to which the system then adds the relevant case, service order, and return order numbers.

Locations and bins that are copied to the receipt in this way cannot be changed manually. The header values are copied from

Service Management Setup, those on the lines from the return order. The values that are relevant when posting the receipt will

be on the lines.

If an item needs to be tracked, the line where it is entered is marked in red. You can add tracking data to the line by using the

Assist button in the Quantity field. After the tracking information has been entered, the line will be green.

When everything is filled in, the receipt can be posted.

Option 3: Get source document lines

As a third option, you can create a service order from the return order, release the service order, and register receipt of the item

when it is delivered for repair.

On the receipt, you then enter the customer who delivered the item to you and run the Get Source Doc. Lines function from the

ribbon.

Note
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With this action, you can see all released but not yet posted return orders that are assigned to the entered customer. You select

the relevant orders and choose OK, which will copy their values to the receipt lines.

If an item needs to be tracked, the line where it is entered is marked in red. You can add tracking data to the line by using the

Assist button in the Quantity field. After the tracking information has been entered, the line will be green.

When everything is filled in, the receipt can be posted.

Repair company-owned devices

Another purpose of creating service orders is to record repairs or other types of servicing performed on machines and

equipment.

This section only explains the medtec365 adjustments to the general repair feature in KUMAVISION, with the underlying

functionality being described here.

To set up a service order for repairs done in-house, you can choose New on the service order list. Alternatively, you can run the

New Case function from a serial number information card or a customer card.

As for the customer whom you want to enter on the service header, you need to ensure that the Internal toggle is activated for

them on their customer card (see the Invoicing FastTab there). With the toggle turned on, the transaction codes on the relevant

service item lines are set by the system to the code that you’re using for current assets while the Place of Servicing is changed to

Inhouse.

Meanwhile, on the service lines, the destination document type changes to Serv. Consumption and the NO COST discount reason

is filled in from the Warehouse – Discount Reason field in Service Management Setup, together with a 100% line discount.

You can only post the order as a whole. Posting individual service lines isn’t possible.

Repair external devices

Loaned, consigned, and demonstration devices are typically shipped via sales orders, with a sales return order used to receive

back each item.

But machines and equipment can also be returned through service orders if they need to be inspected, with the customer being

charged for any repairs that might be required.

To bill for a service like this, you need to manually create a service order, specify the customer from whom you expect to receive

an item in need of inspection or repair, and enter the number of the item, as well as its tracking data, on a service item line.

You can also set up a service order type for the sole purpose of handling service returns.

The third-party code in the Transaction Code field must be manually changed to a code that is used for current assets.

As a next step, you run the Create Sales Return action from the service item line ribbon or the Service Activity Groups FactBox.

For the correct information to be displayed on the sales return order, a standard service code is required.

Note

Note

Note

Note
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When running the function, you might need to select a standard service code (if more than one is available). Afterward, the

return order is filled in automatically and you can post the order. You can also create a service receipt from the return first and

post the return document from there.

The service order and its lines are then used to record repairs to the machine or equipment and, if needed, create an invoice to

send to the customer. Following repairs, you can also use the service lines to have the item moved to a different warehouse and

bin.

Loaned, consigned, and demonstration devices can only be returned via an expected delivery. You cannot post them as unexpected

receipts.

External Document No.

When you store an external document number on receipt of service items, the number is copied automatically to the service item

lines during posting and to the service quote and posted service shipment.

If available, you can already fill in this field when you create an order manually. The number is then copied to all subsequent

documents, for example, when a service order is converted to a sales return and then to a service receipt.

If you create an order manually and fill in the field later, that is, on subsequent documents such as the sales return order or the

service receipt, the number is still copied automatically to the service item lines after posting.

The External Document No. field isn’t shown on service invoice and credit memos.

Create a sales return from a service order

On the service order, you can use the Create Return Orders function to have a sales return order created based on service item

lines.

Sales Line Details: FactBox

On a sales return order, the No. of Service Item Lines field in the Sales Line Details FactBox shows how many open service

orders exist for the customer and item that you entered on the selected line.

You can see the field at any time. You can also open the related service order via a lookup on the field, if necessary.

The No. of Service Item Lines field is filtered by customer and item numbers, not by tracking information.

TRACK ITEMS ON SERVICE LINES

The Lot No. field has been added to service items. If a service item is automatically created during a sale because you’ve selected

the Create Service Item checkbox on the associated service item group record, the lot number is entered as well.

You can open the lot number information list from a service item card by using the Assist button next to the Lot No. field.

At present, you can assign only serial or lot numbers that are already set up in the system.

No distinction is made between serial and lot numbers on a service item line, where item tracking information is stored in the

Item Tracking No. field.

Note

Note

Note

Note
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The system automatically recognizes if a serial or lot number is stored for the item.

You can open the serial number or lot number information card from a service item line by using the relevant line function on the

FastTab ribbon.

DESTINATION DOC. NO. ON SERVICE QUOTES AND ORDERS

On standard service code records, you can create the BOMs that you want to open on service quotes and orders and specify per

line if the destination document type should be Service Sales or Service Consumption. You can also select the Print Line

checkbox on a line, if necessary.

When you insert the BOM into a service quote or order, the standard service code configuration is then copied to the document

but can be changed there manually.

When you enter an item or a resource on a service quote or order line manually, the system retrieves the target document type from

Service Management Setup.

SERVICE ORDER

General

A new field called Place of Servicing has been added to service order documents, to the General FastTab. It is filled in from

Service Management Setup when you create an order but can be changed manually, if needed. The field is also later copied to

the service item lines.

The fields on the service item lines aren’t updated when you change the place on a service header.

Note

Note
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Lines

All fields that have been added to service item lines are described in the following table.
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Field Description

Activity Template

Code

This field might already be filled in based on the service order type and item group code specified

for the order that you created.

However, you can change the field manually, if necessary. When you fill in a code, the activities

specified on the template will be added to the Service Activity Groups FactBox.

No. of Previous

Services

Shows how many times the item on the line has been repaired or has undergone maintenance.

Note

As for items that are tracked by serial number or not at all, the field shows all items with the same

item number, including the same lot number.

Note

Only services carried out inhouse (a sales return and a shipment are posted) are shown. Onsite

repairs are not included but can be viewed by opening the Equipment Entries page.

Service Status Automatically set to In Process when you create a service order but can be changed manually.

The status also changes following the start of certain activities. It is used both for informational

purposes and for controlling a variety of workflows. Options are:

• In Process

• Rendered

• Not Possible

• Scrapped

Place of Servicing Is filled in from the field with the same name on the service header.

The field indicates where repairs should be carried out. Options are:

• (blank)

• Onsite

• Inhouse

• At Vendor

Current Place Is filled in with the value from Service Management Setup when you add an item but can be

changed manually, if necessary.

The field indicates where the item on the line is currently located. Options are:

• (blank)

• Onsite

• Inhouse

• At Vendor

The field is updated by the system if, for example, the item is shipped to a vendor for repairs.

Repair Status Code

Repair Status

Changed On/At

This field is also used in the standard app but has been extended in functionality to include a log

that is automatically filled in each time the status of the line changes.

Shows the date and time when the repair status was last changed. You can click the field to see a

history of all the changes.

Item Tracking No.

Substitution Item

Tracking No.

Loaner Item

Tracking No.

These fields are filled in with a serial or lot number, depending on the tracking information specified

for the item on the line.

The first field contains the serial or lot number of the current item, the second the number for a

substitution item. The third is filled in with a loaner number.
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Ribbon functions

Accessories

Run by choosing Lines > Line, shows the accessories entered during receipt of the service item on the selected line.

Serial No./Lot No. Info Card

Used to drill down to the relevant serial or lot number information card.

Status

The actions on this menu set the repair status of the selected lines to the specified status:

Checked

Inspected

New Estimate

Estimate Sent

Estimate Accepted

Estimate Rejected

Service Released

Service Started

Service OK

Service Not OK

Other Status

The Other Status action opens a list of all available repair statuses so that you can change the status for one or more selected

lines.

If you set the repair status to Service OK, the Service Status field changes as well, to Finished; with the status set to Service Not

OK, the Service Status field changes to Not Possible.

Field Description

The fields are used in both directions. This means if one of these tracking numbers is known in

advance, you can fill in the relevant field so that subsequent processes can incorporate it.

If item tracking information is added later in warehouse handling, it is automatically retrieved when

posting a document with a case number so that the information can be used thereafter.

If the item has a serial number, the system checks if a warranty date for repairs is specified on the

related serial number information card and retrieves it if the value in the Warranty Date (Repairs)

field is not later than the order date.

Estimate Limit Is filled in from Service Contract Setup but can be changed manually.

Solution Code Is filled in from Service Contract Setup but can be changed manually.

Vendor No.

Vendor Item No.

These fields are required when you ship an item to a vendor.

When you enter the item, both fields are automatically filled in on the line with the numbers from

the related item card but can be changed manually, if necessary.

External Document

No.

If available, is filled in by the system when you post a service receipt.

When you create a service order manually, you can already fill in this field in an earlier stage of

processing.
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If you set the repair status to Estimate Sent, the system checks the amount entered on the service quote against the limit for cost

estimates. If the amount is below the limit, the status is set to Estimate Not Reqd. and the quote line linked to the service line is

set to Finished.

Activities

The actions available on this menu were designed to give you quick access to the most important functions in the service area.

Choosing a function runs one of the activity groups specified in Service Management Setup.

The impact of the Create Service action depends on where repairs are carried out. If a vendor repairs the items, you must first

set up a purchase return order. Options are:

Create Sales Return

Create Purch. Return

Create Estimate

Create Service

Create Shipment

Create Review

You can also select more than one service item line before you run the function to have the activity performed for multiple lines

at once.

Inspection Codes

Found by choosing Line > Service, you can use this action to see the inspections stored for the selected line.

Service Lines

Opens the card for the selected line.

Lines

• 

• 

• 

• 

• 

• 
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The fields that have been added to service lines are described in the following table.
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Field Description

Print Line Specifies if the line is shown on printouts.

Service Activity

Step

Used to sort and uniquely identify the activity on the line.

Relation Specifies the data that is updated on the line during posting.

• (blank)

• Service Item

• Substitution Item

• Loaner

Destination Doc.

Type

Specifies the document that is created and filled in with the data from the line when it is run. Options

are:

• Service Consumption

• Service Sales

• Service Quote

• Sales Quote

• Sales Order

• Sales Invoice

• Sales Cr. Memo

• Sales Return Order

• Sales Transfer

• Sales Return Transfer

• Purch. Quote

• Purch. Order

• Purch. Invoice

• Purch. Cr. Memo

• Purch. Return Order

• Transfer Order

• Item Jnl. Pos. Adjmt.

• Item Jnl. Neg. Adjmt.

• Item Journal Transfer

Direction Specifies the direction for updating the current location on the line when you post to the service

item.

You can have the field filled in by default based on a standard service code.

Destination Doc.

No.

Shows the number of the target document if one is created. The number is automatically removed

when the document is deleted.

This field should not be edited unless absolutely necessary.

Destination Doc.

No.

Shows the number of the target document if one is posted.

This field should not be edited unless absolutely necessary.

Item Tracking No. Is filled in from the service item line and is used to create destination documents.

Service Vendor No. Is filled in with the vendor number stored on the related item card and is used to create purchase

documents.

Finished Is selected automatically when you post the line.

Order Type Specifies the default value for document creation.

Depending on the destination document type, the order type settings for a purchase, sales,

warehouse, or service document apply.
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Ribbon functions Delete

Deletes the service line.

If you’re about to manually delete a line that has been completed or that includes a Destination Document No. or To Posted

Document No., you’re asked to confirm the deletion request. The Destination Document No. field is cleared automatically if the

specified document is removed from the system.

Status

Sets the repair status on the selected lines to the specified value. You can choose from the following statuses:

Checked

Estimate Accepted

Estimate Rejected

Service Released

Service Started

Service OK

Service Not OK

If you set the repair status to Service OK, the Service Status field changes as well, to Finished; with the status set to Service Not

OK, the Service Status field changes to Not Possible.

Activities

Field Description

Auto Create

Document

After an activity is inserted, the first service line where this field is set is run, that is, a document is

created and, if needed, a tracking number.

Auto Show

Document

Selected if a new document is created for the service line.

Service Activity

Type

Classifies the activity on the line. Options are:

• Repairs

• Maintenance

• Substitution

• Loan

• Other Service

• Scrap

• Estimate

• Logistics

• 

• 

• 

• 

• 

• 

• 
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The actions available on this menu were designed to give you quick access to the most important functions in the service area.

Choosing a function runs one of the activity groups specified in Service Management Setup.

Transfer items on service lines

If you want to transfer an item during repairs, you can do so directly from the service line by setting up an activity or filling in

the line fields manually. Should you decide to use the second option, you need to fill in certain fields on the line as described in

the following table.

Service

Found by choosing Line > Service, you can use this action to see the inspections stored for the selected line.

Posting

Choose Post Consumption to post all lines that aren’t related to a service, loan, or substitution item, regardless of whether the

destination document type is Service Sales or Consumption.

Choose Post Sale to post all lines that need to be invoiced and where the document type is Service Sales.

Factboxes

The FactBoxes are identical to those on standard service orders.

Service order: FactBoxes

Service Item Line Status

This FactBox provides you with a quick overview of the selected line, including:

Case No. and Case Line

Place of Servicing

Current Place

Repair Status

Estimate Limit

Function Description

Create Service Depends on where repairs are carried out. If a vendor repairs the item, a purchase return order should be

set up first.

Start Line Creates the target document specified on the current line if it does not exist yet.

If the target document is of type Service Sales or Service Consumption, the document already exists and,

if necessary, the item tracking data is copied from the service item line to the service line.

In all cases, the (created) document number is entered in this field.

End Line Completes the line, regardless of whether the document has been posted.

This function should only be run under special circumstances.

Field Description

Service Activity

Type

Logistics

Relation Service Item (specifying the relation fills in the item that is to be repaired on the rest of the lines)

Destination Doc.

Type

Transfer Journal

Location Code

Bin Code

Location and bin that the item should be transferred to. By default, the system fills in both from the

related item card.

• 

• 

• 

• 

• 
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Service Activity Groups

This FactBox is linked to the selected service item line. Activity groups are entered by the system based on the relevant service

activity template code but can also be added manually to each line.

You can add, delete, or start activities from the box:

Go to the box and then select the relevant activity.

Click Service Activity Groups.

In the dialog box that appears, select one of the actions described in the following table.

Activities that have been carried out will be highlighted in green.

Service Activities

This FactBox shows the activities that have been created, posted, or specified for the selected service item line. Their status is

indicated by one of the following colors:

You can add, delete, or start activities from the box: 1. Go to the box and then select the relevant activity. 2. Click Service Activity

Groups. 3. In the dialog box that appears, select the action that you want to run.

Activities that have been carried out will be highlighted in green.

Case Documents

Every document started and posted from a service order is automatically stored with a case document. To see a document, click

the number in the No. of Records field.

Case documents don’t refer to individual service lines but to the entire service order.

Change a ship-to code

You can edit the Ship-to Code field, found on the Shipping FastTab, when you create a service order manually. After you edit the

field, all service item lines and service lines filled in on the order are deleted. For this reason, we recommend that you enter a

new code before you fill in everything else.

The field can no longer be changed when you’ve posted a sales return for the service order.

Complete an order

A service order that is set to Finished isn’t automatically deleted from the system but must be removed manually.

1. 

2. 

3. 

Function Description

New Shows a list of all activity groups from which you can select a group. New groups are never run

automatically.

Delete Deletes the selected group.

Run Depending on your current configuration, adds the activity to the list of service activities and runs it

immediately thereafter.

Color Description

Green The relevant document has been posted.

Red The document has been created but not yet posted.

Black The document has been added to the FactBox but has not been created yet.

Note
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Before you delete the order, make sure that the Finished checkbox is selected on all service lines. If it isn’t, the service order is

only archived.

After the field is selected on all lines and the order is deleted (while being archived), you can choose Closed Cases (instead of

Open Cases) on the associated customer or serial number information card to see the case document set up for the order.

SERVICE QUOTE

You can create a service quote from the Service Activity Groups FactBox.

However, as data displayed in the Service Activity Groups and the Service Activities FactBoxes relates to a single line, the quote

will be set up only for the item that was selected last.

If you want to create a quote for multiple items, select all of them and run the Activity – New Estimate function from the Lines

FastTab ribbon. This opens the Service Item Lines page, where you can see all quotes that items have been entered on, except

for quotes in the Finished status.

To copy the new items to an existing quote, select them and choose OK. To set up a new quote for them, choose Cancel.

You can, at any time, manually delete a service quote that was created by accident.

When you set the status of a quote to Estimate Accepted, the Finished checkbox on the relevant service lines is selected

automatically.

When the quote is set to Estimate Rejected, on the other hand, the checkbox is left blank so that you can edit the quote, if

necessary. Alternatively, you can select the checkbox manually and create another quote.

If a quote isn’t required, you should also select the checkbox, as you can only delete service orders where Finished is selected on

all lines.

General

When you create a quote from a service order, the values in the Service Order Type and Case No. fields are automatically

retrieved from the service header.

Lines

When you convert a service order to a quote, the field values on the relevant service lines are copied to the quote as well.

Status

Estimate Sent

Send Estimate

Estimate Accepted

Estimate Rejected

Service Released

Other Status

The Other Status action opens a list of all available repair statuses so that you can change the status for one or more selected

lines.

Service quote

Note

• 

• 

• 

• 

• 

• 
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The following fields have been added to service quote lines:

Ribbon functions Status

Sets the repair status on the selected lines to the specified value. You can choose from the following statuses:

New Inspection

Estimate Sent

Send Estimate

Estimate Accepted

Estimate Rejected

Other Status

The Other Status action opens a list of all available repair statuses so that you can change the status for one or more selected

lines.

If you set the repair status to Estimate Sent, the system checks the amount entered on the service quote against the limit for cost

estimates. If the amount is below the limit, the status is set to Estimate Not Reqd. and the quote line linked to the service line is

set to Finished.

Other functions available on the ribbon are:

Field Description

Service Activity

Step

Used to sort and uniquely identify the activity on a service item line.

Destination Doc.

Type

Is automatically filled in from the BOM.

The first line on the quote is the service repair line, with a target document type of Service Quote.

The other lines can be of type Service Sales or Service Consumption.

You can change this field manually, if necessary.

Destination Doc.

No.

Is filled in automatically when an item or resource is retrieved from the BOM.

If you enter or select an item or a resource yourself, you also must fill in a destination document

number, for example, by using the Copy to Estimate function.

The value in this field represents the service order number.

Item Tracking No. Is filled in automatically with the tracking information of the item that you want repaired (as entered

on the service order).

External Document

No.

Is filled in when you post a service receipt provided the number was entered on the Service Receipts

page.

• 

• 

• 

• 

• 

• 

Function Description

Copy to Estimate When you add items or resources to service quote lines via a BOM, the Destination Document No. on a

line is filled in automatically.

You can then use the No Estimate Lines function to delete the number, except for when it is assigned to

the item to be repaired.

With this function, you can enter the number on all lines.

No Estimate

Lines

Deletes the destination document number on all quote lines, except for the line that is assigned to the

item you want repaired.

After you have deleted the number, you can no longer copy the lines to the related service order.
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Activities

The actions available on this menu were designed to give you quick access to the most important functions in the service area.

Choosing an option here runs one of the activity groups specified in Service Management Setup.

The impact of the Create Service action depends on where repairs are carried out. If a vendor repairs the items, you must first

set up a purchase return order. Options are:

Create Sales Return

Create Purch. Return

Create Estimate

Create Service

Create Shipment

Create Review

You can also select more than one service item line before you run the function to have the activity performed for multiple lines

at once.

Service BOM

Here you can specify the items and resources required for the service BOM by using the Selected checkbox. You also need to

enter a quantity and can choose a variant if one is set up for the relevant item.

You can have a quantity filled in automatically as well. With the quantity already filled in, the Selected checkbox is also set by the

system.

Additionally, you can choose Select All or Deselect All to specify what lines to run an action on.

Inspection Codes

Found by choosing Line > Service, you can use this action to see the inspections stored for the selected line.

KEY SERVICE ACTIVITIES

Transportation

Transportation activities typically relate to the movement of items that you intend to process in the service area.

To transport devices from, around, and to your locations, you need to select Item and Service Item in the Type and Relation fields

on a standard service code line.

Afterward, the system copies the transaction code entered on the associated service item line to the service code line, where you

can change it manually.

As posting transportation activities doesn’t lead to changes in item value, you should set the Not Billable field on the service code

line to No Cost. If you fill in the Direction field, posting the movement of the item also updates the item’s current location (and its

repair status code, if needed).

Typical document types

Sales return receipts, on which you post the receipt of customer-owned items.

Service orders for shipments to customers. Alternatively, you can create sales orders for this purpose.

For subcontracted repairs

Purchase return shipments, on which you post item shipments to vendors.

Purchase orders for returning items from vendors to your premises. However, these orders can also be classified as service

activities and incorporated into the relevant activity groups.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Loans

Loans are also transportation related. However, in this case, it’s not the service items that are being moved but additional items

(typically equipment that is owned by your organization). The Relation field on the relevant standard service line must therefore

be set to Loan.

As a loan often involves more than one item movement, you can use a template to cover inbound and outbound transportation.

Alternatively, you can set up two, with each covering one direction.

The location that you enter on a standard service code line has priority over all other locations, which provides you with a way of

entering an additional location for rental equipment here. What’s more, you can add a placeholder such as a resource line, for

billing the use of a loaner based on time and materials.

Cost estimates

Cost estimates are based on your evaluation of service cases and are supplemented by price data stored in the system. They can

be created in the form of service quotes from service orders.

On the lines of a quote, you can then not only enter inspection codes but also specify planned consumption and sales, as well as

retrieve values from a service BOM.

For creating a quote, the relation on the relevant standard service line must be set to Service Item and the destination document

type to Service Quote. As every estimate contains prices, the Not Billable field also needs to be set to No.

Repairs and maintenance

Of all service activities, these are the activities that depend on the largest variety of outside factors. As a result, more than one

template will certainly have to be set up.

For example, services can be provided onsite or inhouse, or the equipment might be sent to a vendor, and the type of service

order that you create can play a role as well.

The result of this might be that a different service BOM will be required for each job, based on the inspections you carried out

and the estimates customers accepted, or a purchase order must be created to have equipment repaired by a supplier.

Scrapping

To scrap an item, the Relation field on the relevant standard service line must be set to Service Item.

For single-stage disposal, you also need to select the Item Journal Removal option in the Destination Doc. Type field on the line.

For a two-stage scrapping process, the type must be set to Item Journal Transfer so that the item can be transferred to the scrap

location that you’ve specified in Service Management Setup before its removal from that location must be posted manually.

Item substitution

Typically, substitution means the receipt of new items, recognized as current assets.

You can use a template to decide whether a substitution item should be procured in the usual way—from inventory—or, if the

item isn’t in stock, be purchased directly via a supplier or through the replenishment methods available in the system.

In either case, the Relation field on the relevant standard service line must be set to Substitution.

Other services

Additionally, you can use resources to integrate other services such as sterilization, labeling, or quality control management into

service workflows.

SERVICE CASES

When you create a service order, the system also creates a service case document and classifies it according to the service order

type entered on the order, indicating whether the services consist of repairs or maintenance.

A case classification can be stored for each type of service order that you set up in the system. If the field is left blank on the

Service Order Type page, each new order that you create with this type is set automatically to Repairs. When you change the

service order type, for example, from repairs to maintenance, the classification also changes.
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The number of the case document is copied by the system to both the header and lines on a new service order. To see a certain

case document, choose Open Cases on a customer, marketing cockpit, or serial number information card.

Each service line linked to a case is automatically filled in with all information that you need to render services, including the

related item and lot number, description, variant code, and quantity.

If you create another document from a service order, such as a service quote, sales order, or purchase return order, the relevant

case number is automatically copied to it. This way, you can see if a purchase or sales document is linked to a certain order and

which documents are assigned to each other.

A case provides you with a quick overview of service order information and can be used, if needed, to create follow-ups, open a

customer card, or see the documents that you’ve created or posted based on the service order.

For the system to create a case automatically, you must set up a number series for service cases in Service Management Setup.

The case document serves to collect information and therefore cannot be processed further.

LINK SERIAL OR LOT NUMBERS TO SERVICE ITEMS

On every service item group, you can select the Create Service Item checkbox. When you sell an item, the system then checks if

this checkbox is set for the group on the related item card. If it is, a service item is created automatically after you’ve posted the

sales item as shipped.

If the item is tracked, the system also transfers the item’s serial or lot number to the service item, linking them to each other.

Afterward, you can drill down on the service item card to open the associated serial or lot number information card.

When you enter the service item on a service order, the linked serial or lot number is also copied to the order, and you can again

use a drill down to open the serial or lot number information card from there. At the same time, the Item No. and Serial or Lot

No. fields are filled in on the order.

Additionally, the system checks whether the combination of (sales) item and serial or lot number already exists for a service item.

If so, the existing number is inserted. If not, you can create a new service item from the order.

You can assign only one existing serial or lot number to each service item.

You can open a service item card by drilling down on the Service Item No. field in the serial number information list or on a serial

number information card. You cannot do the same on the lot number list or a lot number card, as the service item number isn’t

copied to either.

PRICING FOR SERVICE CONTRACTS

Service contract pricing (labor and parts) has been extended to include the selected service order type and contract number. This

way, you can specify customer-specific prices for the following service activities:

Maintenance and repairs that a service contract was set up for (via the Contract No. field).

Service orders that are created without reference to a contract.

Setup

To be able to use the feature, you need to open the following pages (unless you’ve already specified the relevant records):

Sales Order Type

On the ribbon, choose New.

Fill in a code and a description. All other fields have no impact on pricing.

Note

Note

• 

• 

1. 

2. 
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Service Order Type

On the ribbon, choose New to set up the service order type that you want to use contract pricing for.

Fill in the Sales Order Type Pricing field to assign a sales order type (such as the kind you’ve just created on the Sales Order Type

page) to this type of service order.

Price List

If you want to work with customer price or discount groups, you need to set them up here.

Fill in a group in the Assign to Type field on the price list header, and then specify, in percent, the required order type and

discount on the lines.

Service Contract Card

On the contract, fill in the Service Order Type field (and, possibly, the Customer Price Group or Customer Discount Group field).

Price update

The Price Update % field, found on the Price Update FastTab on a service contract, can be used to store different price update

percentages for contracts set up in the service area.

To configure the feature:

Choose the Search icon, enter Update Service Contract Prices, and then choose the related link.

On the request page, in the Update Contracts field, choose one of the options described in the following table.

Prices are always updated for the entire contract, regardless of the starting dates entered on individual lines. If you want to

recalculate the price for a single line, you need to do so manually.

Workflow

When you create a new service order, the system then enters on each service line the specified customer price or discount group

and, in the Sales Order Type Pricing field, the sales order type linked to this type of service order.

If the system calculates a 100% discount based on the specified customer discount group, the Not Billable field is automatically set to

No Cost.

1. 

2. 

1. 

2. 

Option Description

No – % on Report Updates the line percentages on all service contracts where the Price Update % field has been

blank so far.

This option requires that you fill in the Price Update % field on the request page.

Yes – Ignore % on

Report

Updates the line percentages on all service contracts where the Price Update % field is filled in.

The new value is retrieved from the contract specified on the request page.

Allows leaving the Price Update % on the request page blank, as the field has no impact on the

process.

All – Include % from

Report

Updates the line percentages on all service contracts, regardless of whether the Update % field on

a contract is filled in.

Requires that you fill in the Price Update % field on the request page, as the report copies the

percentage from the page, ignoring the values on the contracts.

Note

Note
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MAINTENANCE SCHEDULE AND COCKPIT

To improve the scheduling of service operations, the maintenance cockpit has been implemented as a link between service

contracts and service orders. The cockpit can be used to show and schedule all maintenance work that is due and create the

required service orders.

Setup

Inspection types

Before you can use this feature, you need to set up different inspection types. Each type represents a way of doing work in the

service area, such as maintenance. You can create any number of inspection types.

Choose the Search icon, enter Inspection Types, and then choose the related link. 

Fill in the fields as described in the following table.

Schedule templates

These templates specify the intervals at which maintenance should be performed.

You can use the inspection types that you’ve set up to specify exactly what kind of servicing needs to be done. To fill in a

template:

Choose the Search icon, enter Maintenance Schedule Template List, and then choose the related link.

On the ribbon, choose New.

Enter an inspection type. The Scheduled Interval and Interval Type fields are then filled in by the system.

1. 

2. 

Field Description

Code Specify a code (abbreviation) for the inspection type. The code must be unique.

Description Specify a description for this type of inspection.

Calculation Type The default value of the field is "Interval", as this represents the previous calculation type.

The second option is the value Counter. The value "Counter" is stored if a counter type code and

a counter interval are also stored.

Scheduled Interval Specify the time span that will be filled in as the interval on service contract lines.

Interval Type Specify how the next servicing date should be calculated. Options are:

• Scheduled Serv. Date

• Actual Servicing Date

Counter Type Code If the Calculation type field contains the value "Counter", the counter type from the page of the

same name can be stored here.

Counter Unit of Measure

Code

This calculated field automatically displays the unit from the meter type.

Counter Interval A default value for the meter interval can be stored here, which is later transferred to the

service contract line.

When a meter has reached this meter interval, maintenance is due.

Service Order Type This field is set as a filter on the service contract field with the same name to determine the

correct customer contracts.

If the type selected here is not identical to the service order type on a contract, you cannot

enter this type of inspection on the document.

If you leave this field blank, the inspection type is entered irrespective of the service order type

specified on the contract.

1. 

2. 

3. 
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Item Card

To link a template to an item, open the relevant item card and fill in the Maintenance Schedule Template field there.

Vehicles, Drivers, and Technicians

You can create any number of technicians on this page and link them to a resource, device, location, or responsibility center.

The location or the user ID filled in for a technician is copied to all service orders that you enter the technician on.

You can also specify a technician on a service item card, with the selection window already filtered to this type. When you create

entries in the maintenance cockpit, the Technician field on each entry that is linked to the service item is then filled in by the

system, although you can still edit the field, if necessary.

Schedules on service contracts

When you post a sales shipment, the system checks whether the item specified on the document is linked to a service item group

that a service item is automatically created for in this case. If so, a valid service contract is determined and a line with EUR 0.01

is added per inspection type.

As a result, the same service item might appear on a contract more than once.

The Service Order Type field must be filled in on the relevant contract; otherwise, you cannot create it from the maintenance cockpit.

Field Description

Type Specifies the type of record. Options are:

• Vehicle

• Driver

• Technician

Note

At present, only records of type Technician can be entered on service orders or in the maintenance

cockpit. The Vehicle and Driver types have no impact on the system.

Code Specifies a unique code (that is, abbreviation) for the vehicle, driver, or technician.

Description Specifies the name of the vehicle, driver, or technician.

Employee No. If available, shows the number of the employee who is linked to the record.

Resource No. If available, shows the number of the resource linked to the record.

Shelf No. Might contain a description but has no impact on any process in the system.

Fixed Asset No. If available, shows the fixed asset that is linked to the record.

Responsibility

Center

Specifies the location or branch office responsible for the record.

Location Code If available, shows the code of the location assigned to the record.

User ID If available, shows the ID of the user who is linked to the record.

Blocked With the field selected, the record is blocked and cannot be used.

Blocking Reason Specifies the reason for blocking the record.

Note
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The line values need to be adjusted manually after creation.

Service contracts in the Canceled status aren’t included in the check.

On each contract line, you can then see the starting date of the line, the inspections that are carried out, and the interval at

which maintenance is performed, as well as when the equipment was last serviced, when it was scheduled to be serviced again,

and when the next servicing date is.

The values in the Starting Date fields are retrieved from the posted shipment but can be changed manually, if necessary.

At present, you cannot fill in contract lines with an interval that is later than the billing period.

At any time, you can add a line to the contract manually. You can also delete it if the New Line checkbox on the line has been

selected and the status of the contract has been set to Open. You can no longer do so if the Lock Contract checkbox is selected.

To end the line, you must fill in the Contract Expiration Date field.

At present, the Annual Amount field on the Invoice Details FastTab must be set manually to the value specified in the Calcd. Annual

Amount field.

The Change Status field is automatically set to Open and must be manually set to Blocked if you want to block a line.

Maintenance cockpit

This cockpit helps you plan upcoming service cases. To open it, choose the Search icon, enter Maintenance Cockpit, and then

choose the related link.

Afterward, you can use the Create Cockpit Entries function on the ribbon to retrieve all service lines that are due until a certain

date. To narrow down their number even further, you can set a variety of filters on service contract header fields.

Items that don’t contain an inspection type on contracts aren’t retrieved by this function.

Each line on the cockpit then shows the most important information from a contract, including the items involved, the customer

who has them, the types of inspection used, and the last and next servicing date. Any technician specified on a service item card

is also automatically entered on the relevant lines.

To finish a line, fill in the Schedule On and Scheduled Technician fields and select the Planned checkbox on it.

Note

Note

Note

Note

Note

Note
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The Schedule On and Scheduled Technician fields aren’t mandatory. The Planned checkbox, however, must be set if you want to

create a service order for a cockpit line.

You can also select multiple lines and run the Enter Values for Filtered Recs. Action on the ribbon to copy to them the Planned,

Schedule On, and Scheduled Technician field values that you enter on the request page.

Running the Delete Records in Filter action, on the other hand, deletes all selected lines from the cockpit.

You can then run the Create Service Docs. action to create service orders from the lines. On the request page, you can turn on

the Split by Technician toggle or select one of the options in the Combine Lines field to copy, by service item or customer,

multiple contract lines to a new service order.

Based on your setup, the orders will look as described in the following table.

When the orders are created, the document numbers linked to them are entered on the maintenance cockpit entries so that you

can later open an order by drilling down on the relevant Document No. field.

Additionally, the contract numbers are entered on the new service headers and lines. The service order type is also copied from

each contract, as is the location and user ID you’ve filled in when you set up the Technicians page; the same goes for the type of

inspection.

The date entered in the Schedule On field in the cockpit is copied to the Starting Date field on the relevant service order, or,

more specifically, to the service item line that it was specified for. If different starting dates are filled in on an order, the Starting

Date field on the Details FastTab remains blank.

The work date, on the other hand, is copied to the Posting Date and Document Date fields on the Invoicing FastTab. You can

change them manually, as you can all other fields, except for the Response Date field.

Note

Combine

Lines

Split by

Technician

Result

No Turned off One service order is created per line.

If available, the technician is then copied to the service item lines.

No Turned on One service order is created per line and technician.

If available, the technician is shown on the service header and the service

item lines.

By Service Item Turned off One service order is created per service item number.

If available, the technician is then copied to the service item lines.

By Service Item Turned on One service order is created per service item number and technician.

If available, the technician is shown on the service header and the service

item lines.

By Customer Turned off One service order is created per customer (independent of the items

specified).

If available, the technician is then copied to the service item lines.

By Customer Turned on One service order is created per customer (independent of the items

specified).

If available, the technician is shown on the service header and the service

item lines.

1.2.9 medtec365

- 1112/1545 - Copyright © 2018 - 2024 KUMAVISION AG



When you delete a service order, the data entered on the maintenance cockpit line is deleted as well; when you post an order, the

line is also deleted.

When a service shipment is posted, the Last Planned Service Date and Next Planned Service Date fields on the service contract

are recalculated, whereas the Last Service Date field on the General FastTab is updated on the service item.

CONSUMPTION-DEPENDENT INTERVALS IN SERVICE CONTRACTS

This functional extension allows you to efficiently manage meters that are installed in devices. You can define any number of

meters for an object and set the timing (such as time, volume, unit, distance, etc.) as required.

The following statuses can be defined and documented for each meter: commissioning, meter recording and decommissioning.

The meter data is available to the service via the maintenance plan and for internal or external billing

Setup

KUMAVISION medtec365 Setup

In the "KUMAVISION medtec365 setup", you can specify in the "Counters" information tab whether a window for entering the

counter data for devices with counters should be displayed automatically when a booking is made. This setting can be made

separately for purchasing, sales, service, goods receipt and goods issue.

The following options are available to you:

Meter types

On the "Meter types" page, you have the option of specifying the required meter types, such as meters for recording the number

of uses, operating hours or consumption. These meter types are then added to the respective meter templates.

Counter templates

You use the counter templates to determine the types of counters that are installed in an item. The meter templates are then

assigned to the corresponding items.

Option Description

Never When booking, a window for entering meter data for devices with meters is never opened automatically.

If data is

missing

The window for entering meter data for devices with meters is only opened if at least one meter reading

is required (mandatory).

Always When booking, a window for entering meter data for devices with meters is always opened automatically.

Field Description

Code Assignment of a unique abbreviation for the meter type.

Description Description of the meter type.

Unit code Specifies the counting unit of the meter type.

Incoming meter reading mandatory Indicates whether the meter must be read for an additional booking.

Outgoing meter reading mandatory Indicates whether the meter must be read for a direct debit.

Internal counter no. mandatory Activate the checkbox to make the internal meter number a mandatory field.

External meter no. mandatory Activate the checkbox to make the external meter number a mandatory field.

Field Description

Code Assignment of a unique abbreviation for the counter template.

Description Description of the counter template.
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The "Edit" action opens the meter template card to store the meter types.

Assignment

A corresponding template can be stored on the relevant item card on the "Other" information tab using the "Counter template

code" field.

Maintenance templates

Use the maintenance templates to determine the inspection types that are due for an item.

The following fields have been added to the check types so that maintenance can be triggered by different meter data: Calculation

type, Meter type code, Meter unit code, Meter interval, Time interval

Assignment

A corresponding template can be stored in the "Maintenance plan template code" field on the relevant item card on the "Other"

information tab

Workflow

Device counter

When a "serial no. information card" is created, the system checks whether a counter template code exists on the item card. If

this is the case, corresponding device counters are generated for the "Serial no. information card" for each counter type on the

template. The meter template code from the item card is also displayed in the field of the same name on the "Serial no.

information card" on the "Other" info tab.

The device counters can be called up via the map and list view on the following pages:

Item

Serial no. information card 

Debtor

If a counter template is subsequently changed in a "Serial number information card", existing device counters without associated

counter items are removed and the missing device counters are then created in accordance with the counter template.

Field Description

Counter type code Specifies the abbreviation of a selected meter type.

Description Specifies the description of a selected meter type

Note

• 

• 

• 
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Only the master data is managed via the "Device counters". The physical meter is managed on the "Meter" page.

Counter

Note

Field Description

Item no. Specifies the article number of the device from the serial no. information card.

Variant code Indicates the variant (if available) of the device from the serial no. information card.

Serial no. Specifies the serial number of the device from the serial number information card.

Counter type code Specifies the associated meter type.

Description Specifies the description of the meter type.

Counter value Indicates the gross meter value. This corresponds to the real counter value, regardless of the

initial value.

Total counter value Indicates the total counter value.

Open total counter

value

Indicates the open total counter value.

Counter Unit code Specifies the counter unit code.

Customer no.

Customer name

Specifies the associated customer number and the customer name.

Start date Indicates the start of the counter.

End date Indicates the end of the counter.

Internal counter no. Indicates the internal meter number.

External counter no. Specifies the external meter number.
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The "Meter" page is used to manage the physical meters in the devices. A meter can be created either during commissioning via

the "Meter booking sheet" or by meter readings for incoming and outgoing bookings (via purchase and sales documents, service

or article booking sheet). If a meter does not yet exist, it is automatically booked during commissioning.

A meter item is also generated during commissioning.

Counter item

Field Description

Counter no. Specifies the meter number. The meter number is automatically assigned by the system.

Item no. Specifies the article number of the device from the associated serial no. information card.

Variant code Indicates the variant (if available) of the device from the associated serial no. information card.

Serial no. Specifies the serial number of the device from the associated serial number information card.

Counter type code Specifies the connection to the meter type.

Description Specifies the description of the meter type.

Counter value Indicates the gross meter value. This corresponds to the real counter value, regardless of the initial

value.

Total counter value Indicates the net meter value. This corresponds to the counter value, adjusted by the initial value.

Open total counter

value

Indicates the open net meter value. This corresponds to the open meter value, adjusted by the initial

value.

Counter Unit code Specifies the unit of the meter type.

Start date Specifies the commissioning date.

End date Specifies the decommissioning date.

Active Displays the active counter.

Internal counter no. Specifies the internal meter number. Depending on the configuration in the KUMAVISION

medtec365 setup, this may be a mandatory entry.

External counter no. Specifies the external counter number. Depending on the configuration in the KUMAVISION

medtec365 setup, this may be a mandatory entry.

Note
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Each meter has a history that can be viewed on the "Meter items" page. This page lists all booking transactions for the respective

meter.

Meter reading Process-related recording

If the posting of a purchase or sales document contains serial numbers with meter types, an input window with all available

meter types appears, if specified in the setup. The values can be checked or added here. After closing the window, all mandatory

fields are checked, which may prevent the posting.

The counter entry can also be called up via item tracking. If an entry is required, the fields for identifying the device are

displayed in red.

Field Description

No. Specifies a unique consecutive number of the respective item.

Counter no. Indicates the associated meter number.

Item no. Specifies the article number of the device from the associated serial no. information card.

Variant code Indicates the variant (if available) of the device from the associated serial no. information card.

Serial no. Specifies the serial number of the device from the associated serial number information card.

Counter type code Specifies the connection to the meter type.

Booking type Indicates the type of posting for the item. A distinction is made between "Commissioning", "Meter

reading" and "Decommissioning".

Booking date Specifies the date of the booking.

Reading date Specifies the date of the meter reading (document date).

Description Indicates the entry according to the user from the meter entry or the meter book sheet.

Document no. Specifies the document number from the meter entry or the meter book sheet.

Counter value Indicates the entry according to the user from the meter entry or the meter book sheet.

Executing person Indicates the entry according to the user from the meter entry or the meter book sheet.

Cause code Indicates the entry according to the user from the meter entry or the meter book sheet.

Internal counter

no.

Indicates the entry according to the user from the meter entry or the meter book sheet.

External counter

no.

Indicates the entry according to the user from the meter entry or the meter book sheet.

Cancellation Indicates whether the item has been canceled.
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There is no check for the unit.

Functions in the ribbon

Process-independent recording

In principle, each booking can also be made manually via the "Counter book. sheet". A counter ledger sheet template can be

defined beforehand, which can be selected via the "Posting sheet name" field in the ledger sheet.

Alternatively, the book. sheet template and the book. sheet name are generated automatically when the counter book. sheet is

opened.

The fields correspond to those of the counter entry, except that the posting date, document number and posting type can be

changed here.

The following booking types can be entered:

Commissioning

Commissioning is always carried out with a meter number. A new meter is always generated automatically. It is not possible to

commission an appliance meter with an active meter. The active meter must first be deactivated by decommissioning.

Meter reading

In the case of a meter reading without a meter number, a commissioning with the same data is automatically booked beforehand.

A new meter is always generated automatically. No meter reading can be taken for a device meter with decommissioning.

Decommissioning

Decommissioning is always carried out with the meter number. Only one decommissioning can be carried out for an active meter.

Note

Field Description

Item no. Specifies the article number of the device from the associated serial no. information card.

Variant code Indicates the variant (if available) of the device from the associated serial no. information card.

Serial no. Specifies the serial number of the device from the associated serial number information card.

Booking type Specifies the booking type. A meter reading is always a "meter reading".

Counter type

code

Specifies the meter type concerned. A device can have several meters and therefore several meter

types.

Reading date Specifies the date of the actual meter reading. This is a mandatory field.

Counter value Indicates the meter reading. This is a mandatory entry.

Description Specifies the description is transferred to the counter items. (optional)

Executing person Specifies the person entering the data record. This does not necessarily have to be the user. It is

therefore possible to enter a seller code here.

Cause code Specifies the cause code. The cause code is transferred to the counter items.

Internal counter

no.

External counter

no.

Depending on the device's specifications, the internal and/or external meter number may be optional or

mandatory for the initial entry. In any case, the number is saved in the device and automatically

suggested for future entries.

Function Description

Serial no. Info card Opens the corresponding serial no. information card.

Transferred to

further lines

With this action, the values (meter reading date, meter value, description, person carrying out the

meter reading) are transferred to all meter entry lines for the same document line
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Cancellation

A cancelation can be created directly via "Cancel" in the menu ribbon of the meter item. A confirmation prompt must be

confirmed again before the reversal is actually carried out.

Alternatively, the booking can also be made via the "Counter booking sheet", in which case the "Cancellation" field must be

displayed and activated.

In general, only open meter items can be canceled. Meter items that have already been billed or included in service contracts can no

longer be canceled and would also have no effect.

Integration of service contracts

In the service contracts, the "Calculation type" field can be set to the value "Meter" via the inspection type or manually. The

additional "Meter interval" field specifies the meter value at which maintenance is due.

The "Open total counter value" field from the associated device counter can also be seen here. This value is the net total of all

device items that have not yet been processed (i.e. adjusted for the initial stock) and forms the basis for integration into the

service contracts.

Service contract line

The "Update counters in service contracts" action is available in the maintenance cockpit.

This action runs through all service contract lines with the "Meter" calculation type and checks whether the "Open total meter

reading" has already reached the meter interval. If so, the "Next scheduled service on" field is set to the current date. 

EQUIPMENT ENTRIES

When you choose Post > Ship or Post > Ship and Consume on the ribbon of a service order, the system creates a posted service

shipment and checks if the items that are specified on it are tracked via serial numbers. If they are, the consumption calculated

for them will be copied to the service ledger entries and the equipment entries linked to the relevant serial number information

card.

Note

Field Description

Calculation type The default value of the field is "Interval", as this represents the previous calculation type. The second

option is the value "Counter". 

The field can be preset from the check type.

Counter type

code

If the Calculation type field contains the value "Counter", the counter type from the page of the same

name can be stored here.

The field can be preset from the check type.

Counter Unit

code

This calculated field automatically displays the unit from the Meter type page.

Counter interval When a meter has reached this meter interval, maintenance is due.

The field can be preset from the check type.

Time interval The time interval is the basis for calculating the date of the next scheduled service. In case of doubt, the

date can also be set very high, but should help to ensure that maintenance is not forgotten if there is no

or only very low meter feedback.
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In version 22.3, only consumption posted by running the Post > Ship and Consume function is copied to the equipment entries. From

the next version, both options can be used.

You can cancel equipment entries manually by running the Change Cancellation Qty. action on the Equipment Entries page. This

opens a page where you can see the full quantity of the line in the New Cancellation Qty. field and can change it manually.

To have the Cancellation Qty. set automatically, you must fill in the Equipment Entry No. field on an entry so that the quantity is

filled in by the system when you post the relevant line.

The process only marks an entry as canceled; nothing is posted in connection with the entry.

INVOICE A SERVICE CONTRACT

When you invoice a contract, the system copies to the unposted invoice all contract lines where the ending date of the billing

interval is later than the line’s starting date.

Example

The next invoice is due in September. Two lines show a starting date of 10/01/2023. These lines will not be included on the

current but the next invoice (sent in October).

ADD ACCESSORIES

When a customer sends accessories along, you can record them even if they’re not known to the system.

On service receipts

On service receipts, you can run the Accessories action from the Lines FastTab and choose an existing item, resource, or G/L

account to specify auxiliary equipment—or fill in a text line if the equipment you’ve received isn’t in the system yet.

The descriptions can be replaced as well. If available, you can also enter serial or lot numbers or expiration dates here.

When you post the receipt, each accessory is then assigned to a certain service item line and can be changed there, if necessary.

On a service order

If you create a service item line for a service order manually, you can again use the Accessories action to add auxiliary

equipment.

Accessories can also be shown and entered on service item worksheets. When you delete a service item line, the related

accessories are deleted as well.

When you post a shipment, you can run the Accessories action on an equipment line of the posted document to see the

accessories that are being shipped together with the equipment. You can no longer edit them, however.

LINK TO EQUIPMENT

With the Equipment Entries function, you can create a link to equipment specified on a sales or purchase document when you

post to an item, a resource, or a G/L entry.

During posting, the information pertaining to the equipment is then copied from the related serial number information card to

the Equipment Entries page, which you can get to from the document.

When you post the document, the system checks if the new item ledger entries meet the following criteria:

The posting can be traced to a sales or purchase order.

The entries contain serial numbers.

Sale or Purchase is selected as the ledger entry type.

Note

Note

• 

• 

• 
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If one of these criteria isn’t met, the process is canceled.

If the Positive checkbox is selected for an item ledger entry of type Sale or Purchase, the process is canceled as well. In this case, it

is a reversal that must be posted by running a different function (Undo Shipment).

If the criteria are met, the system checks whether equipment entries exist for the document (a sales or purchase order) and, if

available, copies them to the serial number information card.

Consumption or similar, for example, from a production order, isn’t posted in this context. In the case of sales and purchase

orders, the important thing is to ‘carry along’ and visualize the information required to identify the items posted (with or without

serial numbers).

However, this means that when you ship or receive items tracked by serial number with a quantity greater than 1, the system

cannot tell which number is assigned to what equipment entry, as the entries are created by document line. All of them can

therefore be assigned only to the first serial number that is posted.

As a result, the system also cannot check the availability of certain numbers or the quantities on partial shipments. With no BOM

assigned either, it can also not check whether the selected items correspond to the required product.

The feature uses only serial numbers, not lot numbers.

When you post a line of the document (whether shipped partially or completely), the equipment entry linked to the line is

deleted.

SOURCE, WHEREABOUTS, AND USE OF EQUIPMENT

On the Serial No. Information Card, you can now see the manufacturer, the supplier, and the current location of a piece of

equipment.

To be able to use this feature, however, you need to choose Info Card Required on an item card ribbon. A serial number

information card is then set up automatically when you post to the item.

WARRANTY TIMES

Multiple warranty fields have been added to the Item Card page. They’re filled in during the following processes:

When posting a receipt

The Vendor Warranty Until field, found on the serial number information card created by the system, is filled in based on the

item’s receipt date.

When posting a shipment

A date is entered in the Customer Warranty Until field, also found on the serial number information card, based on when the item

was shipped, and this value is then copied to the Startup Date field as well.

When creating a service item

The end of the warranty period (if available) is transferred from the Customer Warranty Until field on the serial number

information card.

When you specify a service item on a service item line, the warranty dates set up for the item are filled in automatically. If this

type of item isn’t entered, the dates are copied from the serial number information card associated with the line item, with the

required ending date retrieved from the Customer Warranty Until or Warranty Repairs Until field, whichever is later.

When returning an item to a customer

The Warranty Repairs Until field, found on the serial number information card related to the line item, is updated with the

document date that is specified on the shipping document (provided the Item Repairs Warranty field was filled in).

Note

Note
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When repairing an item covered by warranty

For item repairs covered by a warranty, the discount reason (which is retrieved from the Default Discount Reason field in Service

Management Setup) is copied from the specified components at a line discount of 100% to all service lines.

POSTED SERVICE SHIPMENTS

Rendering services might require you to post during multiple processes. This, in turn, leads to the creation of multiple service

shipments for a single item in need of repair.

To be able to distinguish between them, the system will add to each shipment one of the posting types described in the following

table.

You can also use the Inspection Codes action on the Lines FastTab to see the inspection codes linked to the selected shipment

(although they can no longer be changed at that point).

ARCHIVE DOCUMENTS

Despite archiving capabilities in sales, the standard app doesn’t keep a record of service quotes or orders after they’ve been

completed. But considering that archived documents might still be of some help to you, you can tell the system in medtec365 to

keep them around.

Like in sales, you can use a toggle to specify how quotes and orders should be archived:

Choose the Search icon, enter Service Management Setup, and then choose the related link.

On the General FastTab, in the Archive Service Quotes or Archive Service Orders field, select if you want quotes or orders archived

automatically or run a function to do this.

If set to Always, a quote is archived when it is printed, deleted, or posted. When set to Never, you need to run the Archive action

on the ribbon.

You can see the number of versions a document has been archived in the No. of Archived Versions field on the document itself,

and in the Sell-to Customer Service History FactBox, in the Arch. Quotes or Arch. Orders field. Clicking the highlighted number

in any of these will get you to a specific document.

Besides the document, the system will archive the comments, beginning texts, and ending texts stored for it.

Like in sales, you can also restore an archived version if it is linked to a service order that hasn’t been completed yet.

SERVICE CLAIMS AND COMPLAINTS

With the integration of Complaints Management into the service area, claims and complaints can now also be registered on

service orders. The claim or complaint is then linked via case number to the order that it was registered on.

You need additional licenses before you can use Complaints Management and FMEA functions.

Setup

Service activity groups

Option Description

Consumption The target document type of the items and resources on the relevant service lines is Consumption.

Component Sale The target document type of the items and resources on the relevant service lines is Sale.

Service Sale This is the actual shipping note used for the repaired item.

1. 

2. 

Note
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You must first set up a service activity group for claims and complaints handling:

Choose the Search icon, enter Service Activity Groups, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

You can set up a group for both claims and complaints or one for each.

Standard service codes

To register claims and complaints on service orders, you must also create one or more standard service codes.

Choose the Search icon, enter Standard Service Codes, and then choose the related link.

On the ribbon, choose New.

In the Service Activity Grp. field, specify the group you set up for claims or complaints (or both).

Fill in the standard service lines as described in the following table.

You should create one standard service code for claims and another for complaints.

Service item group setup

After you’ve created one or more service codes, you can use the general search function to open the Standard Service Item

Group Setup page, select the activity group that you’ve set up for claims or complaints (or both) and further fill in this page, if

necessary.

1. 

2. 

3. 

Field Value

Code CNC

Description Claims and Complaints

Activity Type Misc.

Item No.

Required

Not Selected

Text Required Specify if you want the user who sets up a claim or complaint to add a description to the case during

registration.

1. 

2. 

3. 

4. 

Field Value

Relation Service Item

Type Item

Discount Reason NO COST

Line Discount % 100

Not Billable Free

Destination Document Type Choose Claim or Complaint.

Repair Status Code Claims and Complaints Status

Auto Create Document (Can be selected if needed.)

Auto Show Document (Can be selected if needed.)

Order Type Specify a case subtype.

Note
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Service management setup

On the Service Management Setup page, which you can also open via the general search action, you can fill in the Complaint

Case Type and Claim Case Type fields on the Defaults FastTab to create case types. Subtypes can only be specified for service

codes for which a case type exists as well.

Additionally, on the Activities FastTab, you can fill in the Activity Grp. - Claims and Complaints field to specify a default group for

handling claims and complaints.

Repair status

When a claim or complaint is registered, the repair status is transferred from the relevant standard service line to the service

item line as the active repair status.

For this reason, we recommend that, on the Repair Status Setup page, you set up one status for warranty claims and a separate

one for complaints.

Service activity templates

If the warranty claims and complaints functionality is an integral part of your service processes, we additionally recommend that

you create templates for both types of documents.

Workflow: Register a claim or complaint

You can register warranty claims and complaints directly on a service order.

If you’ve created activity templates, you can register the claim or complaint in the Service Activity Groups FactBox. If you

haven’t, you can choose New in the box to add and run an activity manually.

Based on how you set up the relevant service activity group, you can then enter a text that will be shown in the Service Activity

Groups FactBox, in the Details field, and on the Registration FastTab of the claim or complaint.

Alternatively, you can use the Create Review action on the service item or service line ribbon to see all activities set up as

services and then choose one. If multiple activity groups are available for handling claims and complaints, you see a dialog box

where you can select the activity you want to use.

Afterward, a service line is created based on the standard service code specified on the order, the claim or complaint is

registered, and both documents are linked.

If you register a claim or complaint by running the Create Review action but the Service Activity Groups FactBox doesn’t include a

claims and complaints group, you don’t see a dialog for entering text but need to fill in the Registration Text FastTab on the claim or

complaint document.

If a claim or complaint document is deleted, the number of the document is also deleted from the service line. If either is

archived, the number is copied to the To Posted Doc. No. field and the line is set to Completed.

Note
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Additionally, the following information is entered on the claim or complaint:

The customer number is retrieved from the related service order.

If available, the case type is filled in from Service Management Setup and the case subtype from the associated standard

service line.

The Case No. field is filled in with the number assigned to the related service order (to facilitate access to claim and complaint

documents after registration).

If the current user is assigned in User Setup to a salesperson with a contact number, the data available for that contact is filled

in on the Reported By FastTab.

The registration text that might have been specified when running a service activity group is copied to the Registration Text

FastTab.

The service item is added to the Reported For FastTab, together with the information that is specified for the case on the

service line.

Claims and complaints on multiple lines

If a claim or complaint already exists on one service item line but a new claim or complaint is added on another, the system

checks whether the status set for the current document is set to Open or Released.

If the status is on Open, the item is included on the document. If the status is set to Released, a new document will be created.

When you add an item to an existing document, you must also enter a new registration text. You cannot use a previously created text

for this.

To register a claim or a complaint for multiple lines, select them and then run the Create Review ribbon action. This opens the

Standard Service Codes page for all selected lines so that you can choose whether to create a claim or complaint for them.

More process details

Changes in case classification are automatically transferred to the service lines. Archived claims and complaints are stored with

their case files.

Claims and complaints can be seen on the case document lists available in the system, as the case number assigned to a service

order is also added to the claim or complaint that you registered on it.

Alternative integration option

If claims and complaints aren’t part of your service processes or if they should or can only be added later, you can also manually

register each document and copy lines from the service area on demand.

Two ribbon actions are available for that purpose, Service Item Lines and Service Shpt. Item Lines, found under the Select Lines

menu item on the document.

However, before you run either, ensure that you’ve entered a customer number on the claim or complaint so that you only see

lines that belong to relevant orders or shipments in the selection window.

When you create a claim or complaint in this way, a case number isn’t specified on the document header, nor is it shown on the

Reported For FastTab.

• 

• 

• 

• 

• 

• 

Note

Note

Note
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Batch production

With the Single-Source Lot functionality, you can limit material usage for production components or split or reduce the quantities

on production orders to ensure that all items delivered with an order were made from the same batch (lot) of raw materials.

As an additional benefit, you save time by not having to assign components to a lot manually.

You need a separate license before you can use this feature.

WORKFLOW

Create a firm planned order

To work with the feature, you first need to set up a firm planned production order in the manufacturing area.

Go to the role center, and then choose Firm Planned Prod. Orders.

On the ribbon, choose New.

On the lines, specify the items that you want to manufacture in the Source No. fields, and then fill in the Qty. fields.

This retrieves the relevant components from the (active) item BOMs and the (active) routings, including the necessary

operations.

Edit the components

Afterward, select a production order line and run the Line > Components action on the ribbon to open the components specified

for it. The production quantity will be shown in red to indicate that item tracking is required.

Find lots

To create the right lot size while considering the expiration date of each lot, you can then use one of the following actions on the

ribbon:

You can run the Find Single-Lot Qty. action even after using the Find Single-Lot FEFO function without affecting lines where

components can fully meet order demand.

However, the system will recalculate all lines on which lots and expiration dates have been given and adjust both if necessary.

As for orders that should always use only single-source batches of raw materials (if possible), run only Find Single-Lot Qty., not

Find Single-Lot FEFO, to look for a single-lot component quantity in inventory while ignoring other lots that are about to expire

and supply less than the quantity needed in production.

This way, the system assigns lots that meet the relevant quantity requirements, not those that simply expire first.

Adjust quantities

Running one of the functions described in the previous section initiates checks for component availability and expiration dates,

potentially revealing that certain components aren’t available in the numbers required on the production order.

Note

1. 

2. 

3. 

Function Description

Find Single-Lot

FEFO

Assigns tracking codes to all component lines where expiration dates are reached first, with line

availability being checked as well. Order demand might not be fully met in this way, which means that

the order will need to be split (see Change Quantities).

Find Single-Lot

Qty.

Assigns item tracking codes to all component lines on which demand could not be covered entirely. The

codes assigned to other lines will remain in place.

Even then, not all items requested might be manufactured so that you need to lower the total quantity

that will be produced with the order.
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The Find Single-Lot FEFO function assigns the lot with the nearest expiration date to components with corresponding tracking

codes and determines how much of the batch could be produced with the stock available. You’ll see a message if this means that

the order cannot be fulfilled in its entirety.

When you choose OK, the system shows the lot components that are short in supply. You can then run the following functions to

adjust the quantity on the order:

On the production orders that are created by the Split Qty. function or that you create manually, you can again use the Find

Single-Lot FEFO or Single-Lot Qty. action.

Here, too, the quantity resulting from the production order might not be available in full. You can then run the Adjust Qty. action

another time, to reduce the quantity to what is still in inventory and reorder by using MRP data.

Change order status and release

When you use the Change Status function (Ctrl+F9) on a firm planned production order, you’re asked if you want the items

required for the order to be picked and a pick document to be printed immediately.

If the pick is created and registered without modification, the lots suggested for the components are then assigned to the order

as lots for consumption. Afterward, the production order is released and can be processed in the usual way until you set its

status to Finished.

Function Description

Split Qty. Splits the production order to ensure that a single raw material lot is used for the order by adjusting

component quantities, component availability in percent, and the quantity of the production item. 

A second firm planned order is then created automatically and filled in with the missing quantity.

Adjust Qty. Lowers the order quantity so that the number of components matches the inventory available, updating

components, routings, and the relevant order lines in the process.

To cover the remainder, you might then need to create another production order manually.
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Subcontracting

Outsourcing or subcontracting certain operations, in particular finishing and assembly, is a common practice in many industries,

for example, to prevent capacity shortages or to let in-house staff focus on core business functions.

To complete a job, a subcontractor is often supplied with materials, or semi-finished products even. For this reason, medtec365

provides you with a way to post transfers from subcontract purchase orders so that you can ship supplies to vendors and have

the system print receipt documents based on these transfers.

When you later post this kind of order as received, the items supplied and consumed for the completion of requested operations

are then removed from the site set up for subcontracted work.

You need a separate license before you can use this functionality.

SETUP

Before you can subcontract work on components and products, you must set up the manufacturing area. For more information,

see the Microsoft Dynamics 365 Business Central1 Helpsite. Only the differences to standard functionality will be explained in

this article.

Production BOMs and BOM versions

Lines

Before you can subcontract work on components and products, you must set up the manufacturing area. For more general

information about this subsection, see Create Production BOMs - Business Central | Microsoft Learn.

Note

Option Description Note

(blank) Standard functionality will be used (no materials will be supplied to the

vendor).

In Advance Parts will be provided to the vendor when a production order or

operation is subcontracted.

Requires a routing link

code.

General The vendor will receive an item quantity regardless of whether work has

been subcontracted.

When it is, only the production order document will be sent, as the

required parts have already been delivered.

To able to use this option, the subcontractor’s site must be entered as the

outbound location on the related work center card (see Source

Locations).

Requires a routing link

code.

By Vendor All materials and items are purchased by the vendor.

They’re therefore shown on the BOM page only in a FactBox, for

informational purposes.

This option is also used if the materials or items required for

subcontracted work are provided by customers, considering you don’t

need to post to inventory or the warehouse then either.

Does not copy

information to

manufacturing.
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You can use a routing link code to tie a component supplied with an item BOM to a manufacturing operation. The code specifies the

operation the item is needed, that is, consumed for. You must first enter this code on the operation before you can set up the

component on the BOM. Otherwise, you see an error message when you try to certify the bill of materials.

We recommend that you use a separate routing link code for each subcontractor.

Routing and routing versions

Before you can subcontract work on components and products, you must set up the manufacturing area. For more general

information about this subsection, see Create Routings - Business Central | Microsoft Learn.

Lines

Work center card

Before you can subcontract work on components and products, you must set up the manufacturing area. For more general

information about this subsection, see Set Up Work Centers and Machine Centers - Business Central | Microsoft Learn.

General

In the Department Code field, fill in the Subcontracting department.

Posting

In the Vendor No. field, fill in the vendor to whom you subcontract work. If work is performed in the unit of measure Piece, you

also must set the Unit Cost Calculation field to Units.

Product business posting groups are used to specify G/L accounts that you post to in sales and purchasing. For an easier overview of

the postings made in the system, we recommend that you specify another group for subcontracted work.

Additionally, turn on the Special Unit Cost toggle if you’ve agreed with the subcontractor on a special price for each operation.

Planning

Set the Unit of Measure Code to Day unless the contract between you and the vendor says otherwise. Typically, you also create a

new company calendar for subcontracted work.

Ribbon functions

To store subcontractor prices and source locations, choose Related > Work Ctr. on the ribbon.

Calculate subcontractor prices

In the standard app, the price for subcontracting, that is, the cost later used on a purchase order, can only be entered on this

card. You therefore cannot enter different prices per vendor, quantity, operation (standard task code), or period.

Note

Tip

Field Description

Standard

Task Code

The code from the standard app is used in this field.

Routing Link Code Specify a code for the routing link.

Note
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In medtec365, subcontracted work has its own price table, for which data can be specified in various parts of the system. These

entries then replace the values stored for the work center. You can set prices by period, piece, or specific unit cost.

Subcontractor prices

Prices (and, potentially, block prices) for subcontracted work are specified for:

Work centers (required)

Items (required)

Vendors (required)

Standard task codes (subcontracted operations)

Starting and ending dates

Minimum quantities (block prices)

Price units (conversion factors based on weight)

You can filter for them on the following pages:

Item Card or Items

Work Center Card or Work Centers

Vendor Card or Vendors

Source locations

The Source Locations feature is used to designate the locations that should be used for the goods supplied for an order. You can

specify items per work center or select All Items on a source location line. You can open the Source Locations page from a work

center card or the work center list.

Source Type: Choose Work Center.

Source Code: Enter the code of a work center.

Type: Select All Items or Item.

Code: Enter an item number if Type = Item.

Location Code: Enter the code of a storage site.

Transfer routes

With the help of a transfer route, you can link a warehouse owned by a vendor (subcontractor) to your own. To set up a route:

Choose the Search icon, enter Transfer Routes, and then choose the related link.

On the Transfer Routes Matrix, go to the line containing the warehouse that you want to remove items from, and then click the site

(highlighted in blue) that the items should be moved to.

On the Trans. Route Spec. page, enter your warehouse in the In-Transit Code field. You must fill in this field. The other fields can

remain blank if no shipping agent has been specified.

You can then exit the Trans. Route Spec. and Transfer Routes pages.

WORKFLOW

Example

You schedule production and release the production order. For tracked items, you also link the relevant tracking lines to the

components and the order itself.

Subcontracting worksheet

Calculate subcontracted work

Afterward, open you open the Subcontracting Worksheets page.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

1. 

2. 

3. 
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To see the released order, set a filter on, for example, the work center, vendor, or production order number. The worksheet then

lists all pending subcontract work. The vendor is retrieved from the work center, whereas prices are shown based on how you’ve

set them up in the system.

The vendor is retrieved from the work center, whereas prices are shown based on how you’ve set them up in the system.

If subcontracted work already exists for a production order, another work order will not be calculated.

Change a vendor

On the worksheet, you can change the vendor on each (order) line. The subcontractor prices that you specified for this vendor

are then retrieved automatically.

Carry out an action message

To copy a subcontracting worksheet line to a purchase order, you can use the Carry Out Action Message and Accept Action

Message functions. Both can be found on the ribbon.

You can create the necessary transfer order by selecting the Create Transfer Order field on a line. Lines for which the field isn’t

selected remain.

Released production order

Track subcontracted work

You track subcontracting on production order lines as follows:

Open a production order.

Select a line. On the ribbon, choose Line > Track Subcontracting.

You can then see and open the documents linked to the line.

Purchase order

When you create a purchase order for subcontracted work, the components for production are provided by transfer. This also

means that the description of an item on a purchase line doesn’t include the name of the product but of the subcontracted

service.

Moreover, you can unhide the following production-related fields on purchase lines:

Subcontrd. Items

Subcontrd. Qty. at Subcontractor

Production Order No.

Production Order Line No.

Work Center No.

Operation No.

Item tracking information assigned to production is also printed on the purchase order.

Additionally, the relevant order type is set automatically if purchases originate with a subcontracting worksheet, although the

type can be changed, if necessary. It is used to fill in certain order data automatically, including the terms of payment.

You need to set up a purchase order type called Subcontrd. Purchase Order for this purpose. For more information, see Order Types.

The associated operation is then reported when an order quantity is received.

1. 

2. 

• 

• 

• 

• 

• 

• 

Note
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With the last operation completed on the production order, the order itself might be completed as well.

Subcontractor reference

When you print a purchase order, the components provided on transfer lines to a vendor for completing operations are

referenced on the document. You also see the total price for the subcontracted work as specified earlier (see Calculate

Subcontractor Prices).

If a block price is assigned to the relevant work center, this price will be used (and updated) automatically.

Post a shipment from a purchase order

After you post the purchase order, you need to post a warehouse receipt containing the manufactured items. At the same time,

you need to reduce the inventory level at the subcontracting location manually or automatically by the component quantity

provided (and then consumed) during manufacturing and store the tracking codes specified for the items.

You can see on a released production order when each associated purchase was received. After all of them have been, the

progress bar on the order is set to 100%.

Post a warehouse receipt

As an alternative to posting directly to a purchase order or via a purchase invoice, you can set up and post subcontract purchase

orders like other orders created for vendors provided you’re using the warehouse functionality.

In this context, the color used to code the quantity isn’t relevant to item tracking. Tracking data for subcontracted work also isn’t

shown on printouts of posted warehouse receipts.

Because the standard app tracks items on production but not subcontract purchase orders (receipts), an action called Prod.

Order Item Tracking has been added to the Lines FastTab on purchase orders and warehouse receipts so that you can open the

relevant item tracking cards from there.

Transfers

On the General FastTab of a transfer order, in the Transfer Order Type field, you can see if an order is being used to move items

for subcontracting.

If a subcontractor doesn’t provide you with receipt documents, you can turn on the Auto Post Shpt. as Receipt toggle on the same

FastTab; otherwise, the goods supplied to the vendor would remain in transit and you would need to repost the inventory put-

away.

If the (semi-finished) product is also shipped, its quantity is shown in the Subcontrd. Quantity field, not the standard Quantity

field, as the transfer is only being simulated and the item isn’t in inventory yet.

The number of supplied materials, on the other hand, is shown in the Quantity field, as they must be taken from the

subcontracting location (if the Part Provided field is set to In Advance).

Afterward, you can enter the materials you want to move by transfer and send them to the subcontractor.

Turn on the Auto Post Shpt. as Receipt toggle if you don’t expect a subcontractor to send a separate receipt. This is because when a

transfer order is posted, quantities are first posted to a transit warehouse along the specified route. If you don’t turn on the toggle,

you need to then post the receipt. For components that must be provided, you can create warehouse and inventory documents, such

as a warehouse receipt or shipment, from the transfer order.

Note

Note

Note
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For direct transfers, the medtec365 functionality requires that you’ve configured the Direct Transfer Posting and Direct Transfer

Setup fields in Inventory Setup. For more information, see Post Shipments as Receipts: Transfer Orders.

AUTO POST CONSUMPTION

To be able to use automatically generated consumption postings, you need to set up the feature. You can also post consumption

manually, if necessary.

Setup

Set the posting method on the production BOM, and—consequently—the component, to Backward.

Requirements

If item tracking is turned on, store the tracking codes on the components.

This feature is only supported if you turn on the Allow Any Flushing Method for Tracked Comp. field in medtec365 Setup.

Workflow

When the items are shipped, consumption is now posted automatically.

Post consumption manually

In the production journal, you can see all consumption lines and post them manually, if necessary. The output line linked to a

subcontracted operation, however, isn’t shown here, as it must be posted through the purchase order.

You can fill in the consumption journal manually or have it filled in by the system.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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Multi-Order Subcontracts

Multi-order subcontracting is used to assign items from different production orders jointly to one or more carriers. You can then

create subcontract purchase orders for these carriers and bill the items stored on them per carrier or production order.

Example

For sterilization purposes, you put parts of multiple orders on the same pallet. You then use the functionality to have each item

that you stored on it transferred to the same subcontract purchase order. Afterward, you can decide if you want to bill the entire

carrier to the customer or include on the invoice each item based on the cost of production operations.

You need a separate license before you can use this feature.

SETUP

Manufacturing Setup

To be able to work with this functionality, you need a number series for both multi-order subcontracts and for carriers.

Choose the Search icon, enter Manufacturing Setup, and then choose the related link.

On the Numbering FastTab, fill in the Multi-Order Subcontract and Carrier Nos. fields.

On the General FastTab, in the Carrier Price Base field, you can also choose how you want costs to be calculated, that is, by

Carrier Unit or the Cost of Operation. For more information, see Invoice a Purchase.

Carrier price unit

If you choose Carrier Unit as the basis for cost calculation, you must set up a carrier code and price unit in the system.

Choose the Search icon, enter Carrier Price Units, and then choose the related link.

Choose Edit on the ribbon to edit or add a unit. Alternatively, choose New to create a unit and enter a meaningful code, a

description, and a unit price on the new line.

WORKFLOW

Multi-order subcontracting requires that the relevant production orders be released.

Create carriers

To create a carrier:

Choose the Search icon, enter Carriers, and then choose the related link.

On the ribbon, choose New; the Carrier No. field on the new card is filled in automatically.

Enter a carrier code on the card, as well as a released production order in the Prod. Order No. field, and a quantity. Afterward,

choose OK.

When you add a production order, the remaining quantity and, if available, the lot, are filled in automatically. You’ll see a message if

the quantity you specify is greater than the quantity remaining on the production order.

For this type of subcontracting, you can use only released production orders that are linked to certain work centers. The items

that have been specified on each order can be distributed onto more than one carrier.

Print carrier labels

To create a labeling document for a carrier, choose Print on the ribbon.

The Combined and Checked fields on the lines are used for internal documentation purposes.

Note

1. 

2. 

1. 

2. 

1. 

2. 

3. 

Note
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Create a subcontract

To create a multi-order subcontract:

Choose the Search icon, enter Multi-Order Subcontracts, and then choose the related link.

On the ribbon, choose New, and then fill in the subcontractor’s work center or vendor number on the General FastTab.

If you enter a work center, the other fields required for the subcontract will be filled in automatically from the vendor card linked

to it.

Assign and remove carriers

To add carriers to a multi-order contract:

Choose Assign Carrier on the ribbon.

Select the carrier you want, and then choose OK.

The system only suggests carriers that aren’t linked to other contracts. Each carrier must be assigned individually and be linked to

an operation that corresponds to the work center used for multi-order subcontracting.

You’ll see a message when the carrier has been added. To remove a carrier from a contract, select it, and then choose Delete

Carrier on the ribbon. Afterward, choose OK.

Only assigned carriers are displayed in the selection window.

If, in Manufacturing Setup, you choose Carrier Unit as the basis for calculating costs, the General FastTab of the subcontract will

also contain the following fields:

Quantity

Price per Unit

Amount

These fields are filled in and calculated automatically when a carrier is assigned.

Print multi-order subcontracts

Print Carrier Label

Prints the carrier document. Running the function opens a route card where you can turn on the Incl. Prod. Order Lines toggle to

print these lines as well.

However, the advantage of not printing production order lines is that only absolutely necessary information is transmitted to the

subcontractor.

Print by Item

Run from the same ribbon, prints route sheets for multi-order subcontracts sorted by item.

Create and release subcontract purchases

When you’ve assigned all carriers, you can run the Make Order action from the ribbon to create a purchase order based on the

created subcontract.

1. 

2. 

1. 

2. 

Note

Note

• 

• 

• 

Note
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After the order has been filled in, the contract is released automatically; data about the carrier remains on the lines, however.

You can see if a certain purchase order is linked to a contract by checking the Purch. Order Exists field.

You can then choose Yes in the dialog box that appears to open the corresponding order and edit it further. The status of

purchases is automatically set to SUBC. The quantity on the purchase lines is added per order-item combination.

Print a subcontract purchase

To print the contract, choose Print on the ribbon. Alternatively, you can use the Post and Print action system to print a receipt.

Price a purchase

If you choose Carrier Unit in setup, the total price of the order is calculated based on the total price of the assigned carriers. If

you select Cost of Operations, costs will be calculated based on the operations involved in manufacturing the items.

Receive a purchase

To receive the order, choose Post on the ribbon. Alternatively, you can post the receipt when the goods are delivered to your

warehouse. This opens a dialog box where the Receive field has already been selected. Choose OK.

Following receipt, the order shows the delivered quantity in the Qty. Received field, whereas the Quantity field indicates what

must be received overall.

On the associated multi-order subcontract, two additional references are then shown automatically, one to show full order

delivery and another used for the shipment.

To track an item, run the Prod. Order Item Tracking action from the ribbon.

Invoice a purchase

To invoice multi-order subcontracts:

Open a contract.

On the ribbon, choose Post.

In the following dialog box, select the Invoice field, and then choose OK.

When invoicing is complete, the subcontract purchase order is copied to the list of posted documents and you’re asked if you

want to open the invoice document.

You can also open the document later by choosing the Search icon and entering Posted Purchase Invoices. The subcontract, too,

contains a reference to the fully invoiced order.

Archive a subcontract

A multi-order subcontract is automatically archived after release. However, before you delete a contract, we recommend that you

archive it again manually to ensure that you have the most current version available.

To archive a contract manually, you need to run the Archive action from the ribbon. You’re then asked if you want the subcontract

header to be archived. Choose Yes.

To see all archived subcontracts, choose the Search icon, enter Archived Multi-Order Subcontract List, and then choose the

related link.

Once archived, contracts must be deleted manually from this list by selecting them and using the Delete action on the ribbon.

Certain contracts might also be removed when you run the Delete Invoiced Purchase Order function.

Example

You don’t use the Post action to create an invoice but open the Purchase Invoices page and choose New on the ribbon. This

means that the related order will not be deleted. Instead, you must run the Delete Invoiced Purchase Order report for this.

Note

1. 

2. 

3. 

1.2.9 medtec365

- 1137/1545 - Copyright © 2018 - 2024 KUMAVISION AG



If a production order is deleted via this report, the system checks if the items to be produced are linked to a multi-order

subcontract. If they are, the contract is deleted as well. If, however, an order is deleted manually or when using the Post action,

the relevant contract must be removed manually.

A multi-order subcontract can only be deleted if fully invoiced.

Automatically archives documents if the Archive Multi-Order Subcontracts toggle is turned on in Manufacturing Setup.

Note

Note
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Equipment Tracking

With Equipment Tracking, you can link the serial numbers of components used on a production order to the numbers specified

for the manufactured goods. As a result, you can no longer set an order to Finished until all components that were consumed in

the manufacture of each item are entered on its serial number card.

You need a separate license before you can use this feature.

SETUP

Item card

Item Tracking

On this FastTab, you must enter an item tracking code of type Serial No. so that you can trace an item on an order throughout its

production lifecycle. On the associated Item Tracking Code Card, you also need to turn on the SN Info Must Exist (under Inbound

and Outbound) and Create SN Info. on Posting toggles.

Other

On this FastTab, you must turn on the Track Prod. Order Serial Nos. toggle.

Before you can reset (that is, turn off) this toggle, you need to delete all serial numbers that have already been assigned in

production.

WORKFLOW

Example

You’ve completed production planning and released an order to make 5 packages of electronics. Each package requires multiple

components.

As you’ve also posted consumption for all components needed for the order, you can now link the serial numbers of the

components to those of the items you’re making.

Link consumption entries

You can assign tracking numbers in multiple ways.

Option 1

Open a released production order.

Select a line, and then choose Line > SN Tracking on the FastTab ribbon.

This option requires that a tracking code be set up for the production item, for example, via a corresponding number series.

Option 2

If you’re used to specifying tracking data manually or entering custom serial numbers, you can instead choose Line > Item

Tracking Lines (CTRL+Shift+I) on the FastTab ribbon to open the Item Tracking Lines page.

After filling in the lines, you then need to choose Component Tracking on the ribbon so that you can link the components that

were used during production of the item to the item itself.

Note

Note

• 

• 

Note

• 

• 
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Option 3

You can also use the Lookup button next to the Quantity field of a production order line to open the Item Tracking Lines page.

As with Option 2, you must then fill in the tracking lines and choose Actions > Functions > Component Tracking to link the

tracking information available for consumed components to the item that is being manufactured.

Assign entries on production orders

To assign consumption entries to item tracking lines on a production order:

Open a released production order.

Select an item, and then choose Line > SN Tracking on the FastTab ribbon.

On the Equipment Tracking Lines FastTab, select the line that you want to assign entries to, and then choose Assign to Prod. Order

Consump. on the ribbon.

On the page that opens, choose one or more lines that specify components consumed during production of the item.

Choose OK to see the line information copied to the Production Order Links FastTab. The related items and quantities are then

removed from the Prod. Order Consump. Entries FastTab shown underneath.

Consumption entries that should have been assigned to more than one item in production can still be reassigned on the SN Tracking

page (see Adjust Quantities).

Adjust quantities

On the SN Tracking page, you can modify any quantity that was allocated in full to components of one item as actual

consumption but should have referenced other items as well.

To recalculate consumption entries, edit the Quantity field on the Production Order Links FastTab, and then run the Update

action (F5). However, the quantity that you want to change to cannot exceed the quantity remaining on the entries. Else, you’ll

receive an error message.

One time assignment

You can only assign item tracking lines to components once. After the information has been assigned, it’s no longer displayed in

the form of consumption entries and therefore cannot be assigned to any other item in production.

If the item quantity on a production order is no more than 1, you can run the Auto Assign Consump. Entries function to assign

tracking lines to consumption entries automatically, as it is clear from the context for which item the consumption was posted.

Assign to item tracking lines

On the Production Order Links FastTab on the SN Tracking page, select the tracking lines of the components consumed when

producing a certain item.

On the FastTab ribbon, choose Assign to Item Tracking Line.

Select the line that you want the consumed components to be linked to, and then choose OK.

This copies the line values to the Production Order Links FastTab on the SN Tracking page. At the same time, the components

and their quantities will be deleted from the Prod. Order Consump. Entries FastTab there.

You can adjust component quantities even before you link their serial numbers to an item. If consumption entries should have been

assigned to more than one production item, you can also reassign them on the SN Tracking page later (see Adjust Quantities).

Adjust quantities

• 

• 

1. 

2. 

3. 

4. 

5. 

Note

1. 

2. 

3. 

Note
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If the components used to manufacture an item must be linked to more than one item tracking number, you can change their

quantity even before you link tracking lines to the item in production.

Go to the Production Order Links FastTab and adjust the component quantity in the Quantity field.

On the ribbon, choose Assign to Item Tracking Line.

Select the line that you want the consumed components to be linked to, and then choose OK.

This copies the line values specified for the adjusted entries to the Production Order Links FastTab on the SN Tracking page. At

the same time, it removes them from the Prod. Order Consump. Entries FastTab there.

To ensure the correct assignment of consumed components, you also need to run the Update function by pressing F5. If you

enter a component quantity greater than the quantity remaining on the entries, you’ll receive an error message.

Delete links

On the ribbon of the SN Tracking page, you can additionally reset or delete links to lines or components.

Delete all links

Deletes all links between the production order and equipment tracking lines so that all consumption entries are available again

for reassignment.

Delete selected

Only deletes the links between the production order and the selected tracking lines. All components that assignments have been

deleted for are then available again on the Prod. Order Consump. Entries FastTab.

Production output

Even after all production order output has been reported, you can create and change the links to consumption entries before

setting the order to Finished.

Assignment by output

Links to item tracking lines remain available even after output has been reported for a production item and its components so

that you can still delete, add, or change consumption entries at this time.

Order status Finished

With the Track Equipment on Prod. Order toggle turned on for the production item on its card, the status of production orders

where the item is being used can only be set to Finished if all consumption entries posted to the order have been assigned to

item tracking lines. Otherwise, you’ll see an error message.

Item

Equipment entries

This action, found on the ribbon of both the Serial No. Information List and Serial No. Information Cards, shows the component

tracking information assigned to items for which you set the status of the associated production order to Finished.

Item tracing

By selecting Usage -> Origin in the Trace Method field on the Item Tracing page, you can trace the component serial numbers

that were included as part of the serial number specified for the completed item on a certain production order.

The Origin -> Usage trace method, on the other hand, shows you all entries that were posted after output was reported for the

order.

1. 

2. 

3. 
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Compliance

OVERVIEW

The Compliance functionality helps you design processes that can fulfil regulations such as FDA 21 CFR 11. It supplies, for

example, the operational system checks you need for properly certifying BOMs and routings, releasing items, vendors,

customers, and validation plans, and providing feedback on manufacturing operations.

You can specify individual regulatory requirements through table and field filters. If, following a change in data, you want to re-

release a record that must meet some of those requirements, a compliance document will be generated. This document then

needs to be approved by certain staff members prior to release.

You need a separate license before you can use this functionality. If you’re working with KUMAVISION medtec365 and the Workflow

and Notification Manager, you can also specify a workflow for handling approvals.

For general information about the feature, see Compliance (KUMAVISION base). This article only describes the additional pages,

functions, and fields available for it in medtec365.

SETUP

Compliance User Setup

This page specifies the users who are authorized to manage compliance checks. To set up a user for compliance procedures:

Choose the Search icon, enter Compliance User Setup, and then choose the related link.

Choose New on the ribbon to insert a line for a new user.

Fill in the fields on the line as described in the following table.

For general information about the feature, see Compliance (KUMAVISION base). This article only describes the additional pages,

functions, and fields available for it in medtec365.

Note

Note

1. 

2. 

3. 

Field Description

Follow-up Assignment Shows the content of the field with the same name in standard user setup.

Follow-up Team Assignment Shows the team of reviewers that the user is assigned to (if available).

Follow-up Team Filter Here you can set a filter on review teams if the user is assigned to more than one.

Note
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Compliance tables

You can specify in these tables the changes to data records that approval is required for.

Choose the Search icon, enter Compliance Tables, and then choose the related link.

Choose New on the ribbon.

Fill in the fields on the new line as described in the following table.

You can specify compliance requirements (=filters) for standard and additional fields per table. To set a filter on a field:

Select a table.

Choose Compliance Fields on the ribbon.

Proceed as described in the following.

If you don’t set filters, all fields of the table are checked with any change made to it. If you do, the system will run a check or

create a compliance document if the values specified here do not match those given elsewhere in the system.

For general information about the feature, see Compliance (KUMAVISION base). This article only describes the additional pages,

functions, and fields available for it in medtec365.

MANAGE COMPLIANCE

For a better overview, medtec365 offers multiple role centers from where you can open documents relevant to your daily work,

including a homepage that is tailored to the needs of compliance managers.

Trigger compliance

Changing and releasing a record or completing data maintenance in a table will have the system check values based on the

conditions specified on the Compliance Tables page.

For general information about the feature, see Compliance (KUMAVISION base). This article only describes the additional pages,

functions, and fields available for it in medtec365.

When versioning item records

The use of versioning for item records means that you can continue to use an item after modification but prior to approval of the

changes made to it. In this case, changes must be made to a copy of the item to trigger compliance. The source item is then

updated with the release of the compliance document.

1. 

2. 

3. 

Field Description

Versioning Select this field if you want items to remain available even while they are being modified.

For more information, see Versioning Item Records.

Workflow Templ. Code Only relevant to users who work with the Workflow and Notification Manager.

Workflow Templ. Version Code Only relevant to users who work with the Workflow and Notification Manager.

1. 

2. 

3. 

Field Description

Additional Field Code Enter the code of a table field.

Add. Field Value Specify the value that the entered field should be filtered for.

Note

Note
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Warranty claims, complaints, and FMEA

The Complaints Management functionality helps you handle warranty claims and customer complaints that concern products or

services provided by your organization.

Based on ISO 9001:2015 and ISO 13485:2016, claim and complaint have the following meaning when used in medtec365:

Claim

Refers to a specific product or service and grants legal remedies should the product or service not be up to standard.

Complaint

States displeasure with the quality of a product or service.

When you receive a claim or complaint, you can enter in the system the people and products or services written on the document

and the staff members who will investigate or review the matter. Staff can also look at the purchase, sales, service, or production

documents that might be relevant to the case.

The claim or complaint can then be reviewed, with the aim of taking preventive or corrective actions to remedy or mitigate

failures. The effectiveness of these measures can later be evaluated as part of a failure mode and effects analysis (FMEA).

You need separate licenses before you can use Claims and Complaints Management and FMEA functions.

For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

SETUP

Claims and complaints

Warranty Claims & Complaints Setup

To be able to enter claims and complaints in the system, you must turn on the functionality first.

Choose the Search icon, enter Warranty Claims & Complaints Setup, and then choose the related link.

Fill in the field as described in the following table.

General

For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

Case types and subtypes

Both are used on warranty claims and complaints for classification purposes.

Note

Note

1. 

2. 

Field Description

Default

Transaction Code

Specify the code that will be assigned to issues named in a warranty claim or complaint if the system

cannot determine, for example, the ownership of equipment or the allocation of services (to internal

and external resources) from posted entries.

Note
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For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

You can set the types as filters when you want to assign a workflow template to a case.

A Workflow and Notification manager license is required for this feature.

However, you can enter them only for main claim or complaint workflows and they must match the type and subtype stored on

the relevant workflow card. If no type is available, you’ll see every template stored in the system. Be aware that the system will

not run a check to validate the chosen template.

The case type and subtype codes are also included on all archived claims and complaints, although they cannot be edited there.

Action setup

Mitigation and remedial measures can be maintained in the system as stand-alone actions or in the context of specific claims,

complaints, or FMEAs. For this reason, they cannot be specified in Warranty Claims & Complaints Setup.

For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

Field checks

Table 5488142 (Action) can be included in checks for mandatory field values.

Choose the Search icon, enter Action Setup, and then choose the related link.

On the General FastTab, turn the Action Data Check toggle on or off.

This will activate or deactivate the check throughout the app.

COMPLAINTS

Complaints are recorded on cards that contain every bit of information (such as contact details and item specifications) entered

for a certain case.

To see a list of all ongoing and completed complaints, choose the Search icon, enter Complaints, and then choose the related

link.

For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

Note

Note

Note

1. 

2. 

Note
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General

Workflow

Warranty claims are recorded on cards that contain every bit of information (such as contact details and item specifications)

entered for a certain case.

To see a list of all ongoing and completed claims, choose the Search icon, enter Warranty Claims, and then choose the related

link.

WARRANTY CLAIMS

Warranty claims are recorded on cards that contain every bit of information (such as contact details and item specifications)

entered for a certain case.

To see a list of all ongoing and completed claims, choose the Search icon, enter Warranty Claims, and then choose the related

link.

For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

General

Workflow

This FastTab lists the processes tied to the claim. To see this tab, you need a Workflow and Notification Manager license. As it is

an integral part of WNM, it will be explained in more detail in the relevant article.

To run the main processes that link a claim to the WNM app, choose Pick Workflow on the ribbon.

ACTIONS

Actions are recorded on cards that contain every bit of information (such as contact details and item specifications) entered for a

certain case. A Failure Modes and Effects Analysis and a risk matrix can be created based on them as well.

For more information about the latter, see FMEA Risk Matrices.

To see a list of all ongoing and completed actions, choose the Search icon, enter Actions, and then choose the related link. You

can also create an action from this list or can do so later from a card.

For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

Field Description

Workflow Templ. Code If you’re working with the Workflow and Notification Manager, shows the code of the template

that will be used to automate processes.

Workflow Templ. Version

Code

If you’re working with the Workflow and Notification Manager, shows the version code of the

template that will be used to automate processes.

Note

Field Description

Workflow Templ.

Code

If you’re working with the Workflow and Notification Manager, shows the code of the template that

will be used to automate processes.

Workflow Templ.

Version Code

If you’re working with the Workflow and Notification Manager, shows the version code of the

template that will be used to automate processes.

Note
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Action card

Actions

Register claims and complaints

Registration via contact, customer, or vendor is the only way to add a warranty claim or complaint. You cannot choose New on

the ribbon of a list for this.

For general information about the functionality, see Warranty Claims, Complaints, and FMEA. This article only describes the

additional pages, functions, and fields available for it in medtec365.

SERIAL NUMBER INFORMATION

These cards show each device, machine, or industrial equipment identified by a serial number. You can also register a complaint

or claim from the Serial No. List or a card.

Choose the Search icon, enter Serial No. Information List, and then choose the related link.

Select a line or open a card, and then choose New Case on the ribbon.

Turn on the relevant toggle on the Select Case Classification page, and then choose OK.

Afterward, the system registers the document, and copies all serial number data to it for processing.

Registering a complaint or claim based on lot number information is currently not supported. If lot-tracked items should be

included in a claim or complaint, you can open the marketing cockpit, or a vendor or customer card, and create a case there.

After the case has been registered, the tracked items need to be entered manually on the Reported For FastTab on the card.

CLAIMS AND COMPLAINTS IN SERVICE

With the integration of Complaints Management into the service area, claims and complaints can now also be registered on

service orders. See Service Claims and Complaints for more on this topic.

Function Description

Create Follow-up Creates a follow-up document for the current action card.

Note

1. 

2. 

3. 
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Workflow and notification manager

The workflow and notification manager (WNM) tool provides you with templates that can be used to handle frequently recurring

business operations. The status of each operation is recorded in a series of process steps so that you can monitor work until

completion.

You need a separate license before you can use this functionality.

SETUP

Role center

The WNM comes with a separate role center, found on the My Settings page.

Process Setup

To set up the WNM:

Choose the Search icon, enter Process Setup, and then choose the related link.

Fill in the fields as described in the following table.

Process User Setup

Here you can assign the users who will be using the tool, as only they can create, run, and release workflows and notifications

later. This also includes linking each user to a salesperson and storing users’ digital signatures for case management.

Note

1. 

2. 

Field Description

Default Transaction

Code

Specify the transaction code that will be used for WNM processes.

Contact Creation Specify if you want the system to create a contact card when a process is started for a new contact.

Update Contacts Specify if you want the system to update the relevant contact card should the contact details

provided at the start of a process differ from those entered in the system.

Process Nos. Specify a number series that will be used for WNM processes.
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To grant process permissions to a user:

Choose the Search icon, enter Process User Setup, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Process Permission Groups

On this page—which you can open by using the Permission Groups action in Process User Setup or the general search function—

you can assign any number of permission groups to a user. What exactly the user is authorized to do is covered by the individual

permissions within the relevant group.

For example, if permission A is needed for a certain process, the user must have this permission according to at least one

assigned permission group.

Process Groups

Here you can group process templates, to help with searching and filtering for them.

Create a template

What you enter on a process template will later be available for managing day-to-day operations. If no template can be found for

a certain operation or if only a minor part of the template can be used, you must set up a new template:

Choose the Search icon, enter Process Templates, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following.

1. 

2. 

3. 

Field Description

User ID Specify the ID of the user that you want to grant permissions to.

Salespers./Purch.

Code

Corresponds to the field with the same name in User Setup.

Follow-up

Assignment

Corresponds to the field with the same name in User Setup.

Follow-up Team If available, select the follow-up team that the user is part of.

Follow-up Team

Filter

If the user is part of more than one follow-up team, you can filter for certain teams by filling in this

field.

Digital Signature Specify the user's digital signature.

Signature Blocked With the toggle turned on, the user's signature is blocked. This happens automatically if it was

entered incorrectly three times, but you can also turn on the toggle yourself.

Signature Fail Count Shows the number of times the user has entered the wrong digital signature.

Signature Blocking

Reason

Shows why the digital signature is blocked.

Reset Signature With the toggle turned on, the signature needs to be updated before it can be used again.

1. 

2. 

3. 
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General

Lines

The workflow for the business operation is specified on the Lines FastTab, with each line representing a step in the process. You

can assign documents to the lines, mark a line as essential to the process, or have lines start or end automatically.

Field Description

Code Specify a code for the template. The code must be unique.

Description Specify an internal description for the template.

Version Code Shows the app version at the time you created the template.

Class Specify the document type that the template can be used for.

The options available in this field are derived from case management classifications (complaint, claim,

compliance, or stand-alone).

Usage Specify whether the process is a main or follow-on operation.

Main

The initial process, which can be visualized and contains the follow-on processes.

Follow-on

Occurs in the course of a main process.

Follow-on operations cannot be run on their own and will be shown as part of the main process in the

document viewer.

Group Code Specify the code that should be used when you want to search or filter for a certain template.

Case Type Code 

Case Subtype

Code

Specify a case type and subtype if you need to refer to a specific claim or complaint process.

Status Shows the status of the process.

Open

In this status, the template can be changed, but no processes can be created from it.

Released

Only in this status can the template be used to create a process (but can no longer be changed).
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After you’ve filled in the header fields and specified a series of steps, you need to run the Release action before you can create a

process from the template.
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Field Description

Type Specify the type of action performed with this process step.

Options are:

• Create

• Release

• Reopen

• Notify

• Post Pos. Adjmt.

• Post Shpt.

• Post Invoice

• Shpt. + Inv.

• Cancel

• Archive

• Text

• Hyperlink

• Decision

The specific action that is taken is determined in combination with the selected document type.

Document Type Specify the type of record that will be used during this step.

Options are:

• Item

• Serial No. Info

• Lot No. Info

• Contact

• Customer

• Vendor

• Item Journal

• Transfer Journal

• G/L Account

• G/L Journal

• Sales Quote

• Sales Order

• Sales Invoice

• Sales Cr. Memo

• Blanket Sales Order

• Sales Return Order

• Purch. Quote

• Purch. Order

• Purch. Invoice

• Purch. Cr. Memo

• Blanket Purch. Order

• Purch. Return Order

• Transfer Order

• Pstd. Shipment

• Pstd. Sales Inv.

• Pstd. Return Rcpt.

• Pstd. Sales Cr. M.

• Pstd. Receipt

• Pstd. Purch. Inv.

• Pstd. Return Shpt.

• Pstd. Purch. Cr. M.

• Segment

• Maintenance

• Repairs

• Complaint
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FastTab functions Conditions

Field Description

• Claim

• Return

• Compliance

• Process

• FMEA

The specific action that is taken is determined in combination with the option selected in the Type

field.

Description Specify an internal description for the process step.

Auto Start Select this field if you want the process step to start automatically after the previous step has been

completed.

Auto End Select this field if you want the process step to end automatically.

Required Specify whether the step is mandatory.

(blank)

The next process step can be started before this step is successfully completed.

Yes

The step must be completed before the next can be started.

Condition

Depending on the condition you set up, this step might need to end before the next can start.

For more information, see Conditions.

Condition Exists Indicates if a condition is stored for the step. For more information, see Conditions.

Show Page Select this field if you want the page for the specified record to be opened after the step has been

started.

Page ID Specify the ID of the page that is related to the document type.

This field is filled in by the system but can be changed manually.

Print Select this field if you want to run a report for the specified document after the process step has

been started.

Report ID Specify the ID of the report that is related to the document type.

This field is filled in by the system but can be changed manually.

Permission Type Specify the type of permission required for the step.

(blank)

No special permission is needed, except for being a case management user.

Digital signature

The user must have special permission, which is verified by their digital signature.

Permission Group

Code

Here you can specify the code of a permission group so that users who are not members of the

group cannot start this step.
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Used to specify conditions for starting process steps on the template lines. As an example, emails should only be generated for

items that require serial numbers.

Afterward, you need to run the Link action on the ribbon to tie the fields in the source table to those in the target table.

Alternatively, if the source table is the same as the target table, you can set a filter on the field that you want the system to check

and then select the relevant field value.

Insert Line

Inserts a new line above the selected step.

Delete Line

Deletes the selected line (after you’ve confirmed the action).

Process Step (Template): FastTab

This FastTab shows different fields depending on the type of step that you specified on the associated template line—provided the

Type, Document Type, and Description fields have been filled in there (see Lines).

If Type = Create

With the Type field on a line set to Create, you must select one of the following order types on the Process Step (Template)

FastTab.

For sales documents

Field Description

Source Table ID Specify the table that the document type assigned to the step should relate to.

Source Table Caption Shows the caption of the table entered in the Source Table ID field.

Destination Table ID Specify the table that you want to check the condition against.

You must fill in this field even if the target table is the same as the source table.

Destination Table Caption Shows the caption of the table entered in the Destination Table ID field.

Document Type

(on Lines FastTab)

Order Type

Customer/Vendor/Contact Sourced from the template list.

Shipment Sourced from the sales order types.

Receipt Sourced from the purchase order types.

Transfer Order Sourced from the transfer order types.

Item Journal Sourced from the item journal batches.

Transfer Journal Sourced from the item journal batches.

Maintenance Sourced from the customer service types.

Repairs Sourced from the customer service types.

Process Sourced from the process templates.
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For type Create and a document of type sales, the following fields must be filled in on the Process Step (Template) FastTab

besides setting up the order type.

For purchase documents

For type Create and a document of type purchase, the following fields must be filled in on the Process Step (Template) FastTab

besides setting up the order type.

For document types Transfer Order and Transfer Journal

For type Create and document type Transfer Order or Transfer Journal, the following fields must be filled in on the Process Step

(Template) FastTab (whereas the order type only needs to be set up for a transfer order).

If Type = Notify

Field Description

Movement Type Specify the type of item movement.

(blank)

No invoice will be created (in the case of sales orders with discounts, for example).

Transfer

Items will be shipped to a vendor-managed or an external warehouse.

Location Code Specify the location that you want to ship from.

Bin Code Specify the bin that you want to ship from (can be left blank).

Discount Reason Specify a discount reason if the sale should be discounted (can be left blank).

Field Description

Location Code Specify the location that you want items delivered to.

Bin Code Specify the bin that you want items delivered to (can be left blank).

Discount Reason Specify a discount reason if the purchase should be discounted (can be left blank).

Field Description

Location Code Specify the location that you want items delivered to.

Bin Code Specify the bin that you want items delivered to (can be left blank).
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For type Notify, the following fields must be filled in on the Process Step (Template) FastTab.

If Type = Decision

For type Decision, you must fill in the following fields on the Process Step (Template) FastTab.

If Type = Hyperlink

Field Description

Type Specify if and how to remind a user of a process.

(blank)

No follow-up will be sent.

Follow-up

A follow-up can be assigned to a document, which can be opened by the recipient (or by clicking it).

Email

A document can be attached to an e-mail—either a document attribute that matches the document

type on the Lines FastTab or an external document.

Recipient Specify the kind of recipient based on the selected notification type.

For follow-ups

Enter an inhouse contact (= user) or a team (= group of employees).

For emails

Enter a contact or specify an e-mail address in the Recipient Code field.

Recipient Code Specify a code for the selected recipient.

For inhouse personnel

Select a salesperson or a purchaser stored in the system.

For an inhouse team

Select a team set up in the system.

For a contact

Select a contact whose email address will be entered automatically.

Other

Use a custom email address.

Notification Text Enter a subject line for follow-ups and emails.

Date Formula Specify a period (such as 3W) after which a notification is resent.

Document Attribute

Code

Only used for notification type Email.

Specify a document attribute and send it as an attachment. The attribute must correspond to the

document type selected on the Lines FastTab, as this type will determine the source document.

File Name Here you can attach a file for all notification types.

Field Description

Template (Yes) Specify the template that will be used if you choose Yes.

Template (No) Specify the template that will be used if you choose No.
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For type Hyperlink, the following field must be filled in.

Ribbon functions Release

Sets the status of the template to Released. Only a released template can be used to create a process.

Reopen

Resets a released template to the Open status. Only open templates can be edited.

Create Process

Creates a process based on the released template.

Copy Template Lines

Used to copy steps from an existing process template. To be able to use this action, you need to set up a new, blank template. You

can then run the function to select the template from which steps should be copied.

CREATE AND CHANGE A PROCESS

To set up a new process:

Go to the medtec365 WNM role center.

Choose the Process Templates - Released tile. Alternatively, choose the Search icon, enter Process Templates, and then choose the

related link.

Select a template.

On the ribbon, choose Create Process.

You can only create a process from a template that has been released.

Process Card

A new, blank process card is automatically opened after you run the Create Process action on a process template. The fields on

the card need to be filled in as described in the following table.

Field Description

Hyperlink Enter the URL that will be used for the hyperlink.

1. 

2. 

3. 

4. 

Note
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General

Contacts

Field Description

No. This field is filled in automatically with a number from the series that you set up for process cards.

Description Shows the name of the process (is retrieved from the process template).

Type Specify for whom you want to set up a workflow. Options are Customer, Vendor, or Contact.

Vendor No. Depending on what option you selected in the Type field, you can choose here the vendor whom you want

to create the process for.

Customer No. Depending on what option you selected in the Type field, you can choose here the customer whom you

want to create the process for.

Contact No. Depending on what option you selected in the Type field, you can choose here the contact whom you want

to create the process for.

Status Shows the status of the process.

Open

In this status, the process can be edited but not run.

Released

The process can be run but not changed.

Rejected

This status is part of the Compliance functionality.

Completed

The process was run once and has therefore been completed.
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The lines on this FastTab are used to specify the people involved in completing the process.

If a phone number has been stored for a person and medtec365 is connected to an internal communications system, you can call

the contact by using the Call Landline or Call Cell function on the ribbon.

The New Line or Delete Line action can be run to add or delete entries to or from the lines.

Pick Document Lines: function

You can insert document lines into the process by running the Pick Document Lines action on the ribbon or enter them manually

on the Document Lines FastTab.

Based on whether the business process has been set up for a customer, vendor, or contact, different actions can be run. If you

selected Customer in the Type field, for example, sales document functions will be available to you; for vendors, the actions

relate to purchase documents, for contacts to internal production documents.

Completed technical, claim, or complaint cases are also available for all three.

Process Steps: FastTab

Field Description

Type Specify the type of person associated with the process. Options are customer, vendor, or contact.

No. Specify the number of the customer, vendor, or contact associated with the process depending on the

option selected in the Type field.

Name Shows the name of the customer, vendor, or contact. The name is shown automatically for people

specified in the system; otherwise, you must enter a name manually.

Address Shows the address stored for the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.

Post Code Shows the ZIP code stored for the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.

Location Shows the location stored for the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.

Country/Region

Code

Shows the country/region stored for the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.

Phone No. Shows the phone number stored for the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.

Mobile Phone No. Shows the cell phone number stored for the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.

Email Shows the email address stored for the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.

Salesperson Code Shows the salesperson linked to the contact.

This field is filled in automatically for existing contacts but must be filled in manually otherwise.
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This FastTab displays the steps that will be performed when a process is run. Which steps these are depends on the selected

process template; the steps in that process can then no longer be changed.

A step can be run by choosing Previous Line or Next Line on the ribbon. To start the first step, choose Next Line. Afterward, the

action must be rerun multiple times: with the following click, the system will jump to the next line; with another, that step will be

started (the Started checkbox selected).

The final click will end the current step. The system then checks if the step could be successfully completed. If so, the Completed

field is selected.

Ribbon functions

The actions shown on the ribbon depend on whether a process relates to a customer or a vendor. To view the vendor or customer

that the process was set up for, choose Home or Related > Customer Card or Vendor Card on the ribbon.

To open and copy from a document associated with the vendor or customer, choose Select Document on the ribbon and then the

document that you want to retrieve lines from.

To change the status of the process, choose Status and the relevant function.

Before a process can be run, it must be released.

COMPLETE A PROCESS

You can complete a released business process by running the Close Case action on the ribbon.

The system then checks if open documents exist for steps in the process. If they do, the action will be canceled with an error

message and the process remains in the list of released processes.

However, if the process can be completed, it will be archived so that it can no longer be changed. You can open an archived

process on the medtec365 WNM role center by choosing the Processes – Archived tile.

All documents related to the process will also be archived. To view them, choose the Process Documents – Archived tile on the

medtec365 WNM role center.

CREATE A PROCESS FROM A CASE

You can create a process from a case, that is, not start it on its own.

Field Description

Description Shows the description of the process step.

Required (blank)

The step is not mandatory and can therefore be skipped.

Condition

The step becomes mandatory under certain conditions, as specified on the process template.

Yes

The step is mandatory and cannot be skipped.

Condition Met Indicates whether one of the conditions set up on the process template applies in this context.

Started Specifies if the corresponding step has been started.

Completed Specifies if the corresponding step has been completed.

Document Type Specifies the document type that will be used for the step.

Source ID If available, shows the number of the document that will be created when the step is processed.

Note

1.2.9 medtec365

- 1160/1545 - Copyright © 2018 - 2024 KUMAVISION AG



The case must be classified as a process so that all released process templates are available for selection. The steps that were

entered on the template are then copied to the process automatically and can be edited. To create a process from a case:

Open a contact card.

On the ribbon, choose New to open the call classification.

Select the Process checkbox, and then choose OK.

Choose a template from the list.

Afterward, the process is run automatically, and the contact details of the selected contact are copied as well. To be able to run a

process, it must have been released.

1. 

2. 

3. 

4. 
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MDR Document Management

With this functionality, you can organize in a document management system (DMS) the Medical Device Regulation (MDR)

documents that should be linked to Microsoft Dynamics 365 Business Central1 master records. The feature separates storage

and assignment in a way that you can file and open MDR documents in the DMS but link each of them to multiple records in

medtec365.

For every link set up between an external document and a header or a line in the app, another MDR document entry will be

created—even if setup would allow for more than one entry to be assigned to the same part of a master record. You can, however,

have different entries linked to different lines on the record.

When you create follow-on documents, such as posted sales documents, the entries will be linked to them as well. They will also

be assigned, for example, to item ledger entries when you post journals for a production order.

By contrast, when you simulate the creation of MDR document entries, you see every entry that could theoretically be created

according to setup—regardless of whether it will result in an actual entry later.

You need a separate license before you can use this functionality. 

SETUP

MDR conversions

To set up conversions for master records:

Choose the Search icon, enter MDR Conversion List, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Note

1. 

2. 

3. 
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General

Field Description

Item No. Specify the item that base data should be converted for.

If this field is left blank, no other field can be filled in and the lines cannot be edited either. When the field

is filled in, the description of the specified item appears as a heading on the conversion card.

Note

If you want to create an entry for an item that a compliance check must be run on and that data

maintenance has been completed for, you see a message stating that no conversion can be created.

You then need to choose Edit Item on the ribbon to change the status of data maintenance to In Progress.

When you set the status to Completed again, the conversion for the item remains but can no longer be

changed and the text ‘Update Completed’ is shown on the conversion card header next to the item

description.

Conversion

Date

Specify when the conversion should be carried out.

Status You can set this field to In Progress or Certified. Other statuses are set automatically (New, Converted,

Error). You see an error message if you try to select a status that should be assigned by the system.

New

Set by the system when a new conversion record is created.

Certified

Set manually so that the item is included during conversion. A certified record cannot be edited.

You see an error message if you try to select this status without having filled in a conversion date or a

field ID on any of the lines.

In Progress

Set manually so that you can edit a record.

Converted

Set by the system after the item is successfully converted.

Error*

Set by the system if an error occurred during item conversion.

Converted By Shows the ID of the user who had the item converted.

Converted On/

At

Shows the time and date when the item was converted.

Error Text Specify the text that will be shown if the conversion failed.

You can enter a maximum of 250 characters in this field.
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Lines

Conversion process

An item is only converted if the conversion date specified for it is the same as or earlier than the work date.

You can convert items by running the relevant function from the ribbon or have them converted automatically by adding the task

to the job queue. If you convert manually, you can set a filter on the Item No. field.

If the conversion is carried out by the NAS via the job queue, a dialog box isn’t shown and all certified items are converted at

once.

Manual

To start conversion manually:

Choose the Search icon, enter Convert MDR Item from MDD, and then choose the related link.

Use the Assist button next to the Item No. field to select an item from the list.

Only conversions in the Certified status can be seen on the list. Additionally, the conversion date cannot be later than the work date.

You can set any type of filter value in the Item No. field, including <>ITEM_0422, >A and ITEM_0422|ITEM _0509. In the latter

example, ITEM_0422 and ITEM _0509 will be converted. If the Item No. field on the request page is left blank, every item in the

Certified status and with a conversion date smaller than or equal to the current date will be converted.

If you specify an item number that is stored in the system but that isn’t certified, that includes a later conversion date, or that no

record exists for in conversion setup, you see an error message and the process is canceled.

At the time of certification, no Old MDD Field Value exists on the lines, as the field is filled in during conversion with a value from

the item card.

Field Description

Field Source Specify the source of the field to be converted. Options are Item Base Data or Add. Item Field.

Field ID Specify the unique key of the item to be converted. Depending on the Field Source, it is a value taken

from table 27 (Item) or the code of an additional field retrieved from table 71076604 (Additional Field

Base Data).

The No. field in the item table must not be selected here. You see an error message if it is.

Field Caption Shows the caption of the field selected via the Field Source and Field ID.

Field Type Shows the type of the field selected via the Source Field and Field ID.

Field Length Shows the length of the field selected via the Source Field and Field ID.

New MDR Field

Value

Specify the new value that should be assigned to the selected field during conversion.

If the field is of type Option (but does not depend on another field value) or Boolean, you can drill down

to choose a value. You can do the same if the selected table references another, which means that the

value will be taken from there.

You are notified if you specify a value that cannot be used right now and can choose whether to enter

another.

This way, you can set values that might not be valid at present but will be at the time the item should be

converted, for example, due to a change in setup.

Old MDD Field

Value

Shows the old field value from the master record.

1. 

2. 

Note
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When you choose OK to start the conversion, you’re asked to confirm your choice. If you don’t choose OK again here, the process

will be canceled altogether.

If conversion fails, the conversion status is automatically set to Error. You then see a message in the Error Text field. In the same

vein, you’re also notified if conversion is successful, with the status set to Converted and the Converted By and Converted On/At

fields filled in. The old MDD field values are also entered on the lines and a message appears, stating how many items have been

converted.

The new values can then be found on the item card according to conversion setup.

Job Queue

For values that you want converted automatically with the help of the job queue, you must set up an entry in the queue for

codeunit 71076791 (MDR Job Queue Handler) with the ‘convert mdd to mdr’ string.

When the queue is run, the system then converts all certified records that include a conversion date on or before the work date.

If the process is successful, the values on the conversion cards are updated in the same way as during manual conversion.

If processing encounters an error, the status of the conversion record is set to Error and the Error Text field is filled in. The

system then continues with the next item that needs to be converted.

Item

You can use the Check Approval Reqs. Field, found on the Misc. FastTab in the item master, to specify whether the system should

check for approval requirements in an MDR context (where they’re called ‘authorizations’).

medtec365 Setup

Option Description

No No check is run.

Sales Verifies approval requirements on sales documents only.

Purchasing Verifies approval requirements on purchase documents only.

Sales & Purchasing Verifies approval requirements on sales and purchase documents.
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To set up DMS integration for MDR documents:

Choose the Search icon, enter medtec365 Setup, and then choose the related link.

On the DMS Integration FastTab, fill in the fields as described in the following table.

MDR DMS Structure Setup

Here you can specify the areas, groups, and names required for the structure of the DMS. To specify the structure:

Choose the Search icon, enter MDR DMS Structure Setup, and then choose the related link.

Fill in the fields as described in the following table.

MDR DMS Document Types

1. 

2. 

Field Description

DMS Document

Nos.

Specify the series that will be used to assign numbers to MDR documents.

DMS Sales/Purch.

Doc. Check

Specify when approval requirements should be checked on sales or purchase lines and when MDR

document entries should be created.

An MDR document that is linked to a header in the system is always created during the release of an

internal document, without approval requirements being checked.

Release

Approval requirements are checked and entries are created after the relevant document is released.

New Line

Approval requirements are checked and entries are created on filling in a line on the relevant

document, that is, when the system validates the item number, variant code, and the warehouse

shipment date (for a sale) or expected receipt date (for a purchase) on the new line.

Use Document

Viewer

Turn on this toggle if you want to see MDR documents on sales and purchase documents.

Field Name (MDR

Link)
Specify the field that will be used for linking the DMS to Microsoft Dynamics 365 Business Central1.

1. 

2. 

Field Description

Type Specify the type of the structural element (area, group, or name).

Code Specify a code for the structural element. The code must be unique.

Description Specify a description for the structural element.

Approval Reqs. Specify the approval requirements for elements of the Name type.
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On this page, you can specify the document types that will be used in the DMS.

Choose the Search icon, enter MDR DMS Document Types, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

MDR DMS Document Control

1. 

2. 

3. 

Field Description

Code Specify a code for the document type.

If the type is later renamed via a code change, the system will update the field with the same name on

every MDR document and document assignment page automatically.

Description Specify a description for the document type.

Status Specify the status of the document type. Only records in the Certified status can be used for the DMS.

New

Set when the record is created. You can change the type in this status.

Certified

Set so that the document type can be used on a DMS document. You cannot change the record in this

status.

In Progress

Set to reopen a certified document type.

Expired

Set so that the current record cannot be used or edited.

Area Choose an area from DMS structure setup.

Group Choose a group from DMS structure setup.

Name Specify the name of a DMS structure.

Renewal Date

Formula

Specify the date formula that will be used to calculate the value in the Renewed On field when the

Valid To field is validated on DMS documents.

You see an error message if the date calculated based on the formula is not in the past, that is, if it

does not start with a minus sign (-).

Paper Size Specify what paper size to use for printouts (A3 or A4).

Print Orientation Specify the orientation of printouts (Portrait or Landscape).

Created By Filled in with the ID of the user who created the record.

You cannot change this field manually.

Created On/At Filled in with the date and time when the record was created.

You cannot change this field manually.

Modified By Filled in with the ID of the user who edited the record.

You cannot change this field manually.

Modified On/At Filled in with the date and time when the record was edited.

You cannot change this field manually.
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Here you can specify the conditions that must be met for the system to create the entries that link Microsoft Dynamics 365

Business Central1 to MDR documents.

Choose the Search icon, enter MDR DMS Document Control, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

1. 

2. 

3. 
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Field Description

Document Required Specify if approval requirements should be checked on the selected document line.

The check is run if the line relates to a sales or purchase document and the Check Approval Reqs.

field for the item on the line is set to Sales, Purchasing, or Sales & Purchasing.

The check is successful if the system finds a valid MDR document with a document type where the

Name field value corresponds to the approval requirements specified in MDR DMS Structure Setup.

Print Document Select this field if you want the associated MDR document printed together with the main document

as supporting documentation on the Print Portal.

The setting is retrieved from the relevant print configuration when a document entry is created and

is later copied to entries that you create for follow-on documents.

Values Inherited Specify if the source document will be used to create MDR entries when follow-on documents are set

up, for example, when you:

• Post a sales document that includes a shipment.

• Post a sales document that an invoice was created for.

• Post a purchase document that shows a receipt.

• Post a purchase document that an invoice was created for.

• Post a journal on which order type Production and an order number was specified.

• Post an assembly order.

Document Type Specify the type of the document.

Error Level (Doc.

Required)

Specify what you want to see happen if the approval requirements check fails.

(blank)

No action will be taken.

Log

A log entry will be created in the background, but you can continue with the transaction you started.

Warning

You see a warning message, but you can continue with what you were doing by choosing OK in the

dialog box.

Error

You see an error message and the process will be canceled.

Status Shows the status of document control.

New

Set by the system when a record is created.

Certified

Set via the status actions on the ribbon. Only certified records are used by the DMS. They cannot be

edited, however.

In Progress

Set via the status actions on the ribbon. Allows to reopen certified and expired records.

Expired

Set via the status actions on the ribbon. Records that are no longer valid cannot be changed and are

not included in the DMS.

Item No. Specify the number of an item.
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Documents

On this FastTab, you can turn on one or more of the following toggles to specify the types of documents that document control

should apply to:

Sales Quotes

Sales Orders

Blanket Sales Orders

Sales Invoices

Posted Shipments

Posted Sales Invoices

Purch. Quotes

Purch. Orders

Blanket Purch. Orders

Purch. Invoices

Prod. Orders

Subcontract Orders

Assembly Orders

Repairs

Alternatively, you can use the Select All action on the Options FastTab to turn on the toggles for all documents listed. Select None

will cancel the current selection.

Document Type Details

This FastTab shows the description, area, group, and name of a document type. For more information, use the lookups available

for the fields on the tab.

MDR DMS Document List

To see the list of current MDR DMS documents or create a new document:

Choose the Search icon, enter MDR DMS Document List, and then choose the related link.

To create a new document, choose New on the ribbon and fill in the fields as described in the following table.

Field Description

Variant Code Specify the code of a variant, if available.

Item Version Code (As version codes have not yet been added to document lines, this field cannot currently be edited.)

Country/Region

Code

Fill in a country or region.

Customer No. Specify the number of a customer.

Vendor No. Specify the number of a vendor.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

1. 

2. 
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General
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Field Description

No. This field is filled in automatically with a number from the series set up for MDR documents.

Document Type Specify the type of the MDR DMS document.

Filling in this field also fills in the description of the document type, the area, the group, the name, and

the approval requirements.

Description

Description 2

These fields can be used to describe the document.

Status When the document is created, this field is automatically set to New.

You can change the status of the record manually. Documents in the New status will not be used in the

DMS, and you can only change the status by running one of the actions mentioned earlier.

Additionally, certified or expired documents cannot be deleted from the system.

External

Reference

Specify an external reference, if available.

Bar Code Shows the bar code that will be used for the Reserve Bar Code action.

You cannot change this field manually.

Valid From Specify the date when the document becomes valid.

If you decide to move up the date later, when assignment lines exist, the system will check whether an

earlier date was entered on one of the lines of the MDR document. If so, you will see an error message.

Valid To Specify until when the document should be valid.

If you decide to move up the date later, when assignment lines exist, the system will check whether a

later date was specified on a line of the MDR document. If so, you will see an error message.

After you filled in this field, the system will calculate the value in the Renewed On field based on the

formula specified for the document type.

You can change this field manually, if necessary. You see a message when you change it after the

Renewed On field has been filled in.

Renewed On This field is filled in automatically when you fill in the Valid To field but can be changed manually, if

necessary.

Renewed This field shows if a document entry exists for MDR DMS document renewal in status New or

Requested.

Document Type

Descr.

The value of this field is taken from the Description field of the MDR DMS document type after the type

has been entered.

You can use a lookup to see the related document type record.

Area Shows the area assigned to the MDR DMS document type after the Document Type field has been filled

in.

You can drill down into the field to get to MDR DMS Structure Setup.

Group Shows the group assigned to the MDR DMS document type after the Document Type field has been

filled in.

You can drill down into the field to get to MDR DMS Structure Setup.
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Field Description

Name Shows the name assigned to the MDR DMS document type after the Document Type field has been

filled in.

You can drill down into the field to get to MDR DMS Structure Setup.

Paper Size Specify what paper size to use for printouts (A3 or A4).

Print Orientation Specify the orientation of printouts (Portrait and Landscape).

Approval Reqs. Shows if approval requirements exist.

The setting in this field is retrieved from MDR DMS Structure Setup.

Created By Filled in with the ID of the user who created the record.

You cannot change this field manually.

Created On/At Filled in with the date and time when the record was created.

You cannot change this field manually.

Modified By Filled in with the ID of the user who edited the record.

You cannot change this field manually.

Modified On/At Filled in with the date and time when the record was edited.

You cannot change this field manually.
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Assignment
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Field Description

DMS Document

No.

This field is filled in automatically with the number of the assigned document.

Status Specifies the status of the document assignment.

New

Set by the system when a new record is created.

Certified

Can be set manually so that the item is included in the DMS. A certified assignment cannot be edited.

You see an error message if you try to select the status without having filled in the Valid From and Valid

To fields.

In Progress

Can be set manually so that you can reopen a certified record for editing.

Expired

Cannot be edited and is not used by the DMS.

Item No. Specify the item that needs to be available on a document line for the assignment to apply.

With the field left blank, the document is only assigned to headers.

You see an error message if you try to enter an item that compliance checks still need to be run on or

for which data maintenance has been completed and the item has been released.

Variant Code Specify the variant that needs to be available on a document line for the assignment to apply.

With this field and the previous field left blank, the document is only assigned to headers.

Item Version Code Specify the item version code that needs to be available on a document line for the assignment to apply.

Note

The field cannot be changed at present, as the item version code requirement has not been

implemented yet.

Country/Region

Code

Specify the country code that needs to be available on a document line for the assignment to apply.

Customer No. Specify the customer who needs to be available on a document line for the assignment to apply.

You see an error message if you try to enter a customer number that compliance checks still need to be

run on or for which data maintenance has been completed and the number released.

Vendor No. Specify the vendor who needs to be available on a document line for the assignment to apply.

You see an error message if you try to enter a vendor number that compliance checks still need to be

run on or for which data maintenance has been completed and the number released.

Valid From Specify the date from when the assignment should be valid.

You see an error message if you fill in this field with a date that is earlier than the date specified in the

Valid From field on the DMS document header.

Valid To Specify the date until when the assignment should be valid.

You see an error message if you fill in this field with a date that is later than the date specified in the

Valid From field on the DMS document header.
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Home: Ribbon Functions

Set to Certified

Sets the document to Certified. Only certified records are included in the DMS but cannot be edited (except for their assignment

lines) and cannot be deleted.

With the status set to Certified, the compliance process for MDR documents will be started after you enter a compliance message

(provided the functionality is set up).

You will also see an error message if the date entered in the Valid To field is earlier than the work date and certification will be

canceled.

To be able to use this feature, you need a license for the Compliance functionality.

Set to In Progress

Sets the status of the document to In Progress.

Documents in progress can be edited but aren’t used for document control.

Set to Expired

Sets the status of the document to Expired.

Expired documents cannot be edited (except for their assignment lines). Additionally, they aren’t included in the DMS and cannot

be deleted either.

Copy Document

Copies selected data to a new DMS document, with an option to include assignment lines and comments.

Comments

Used to enter comments about the document.

Reserve Bar Code

Reserves a bar code for the document.

Factboxes

ELO

Can be used to drag and drop an MDR document into, to see the information stored on the document.

Field Description

Created By Filled in with the ID of the user who created the record.

You cannot change this field manually.

Created On/At Filled in with the date and time when the record was created.

You cannot change this field manually.

Modified By Filled in with the ID of the user who edited the record.

You cannot change this field manually.

Modified On/At Filled in with the date and time when the record was edited.

You cannot change this field manually.

Note
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Compliance status

Shows the compliance status and history.

To be able to use this feature, you need a license for the Compliance functionality.

MDR documents: compliance

When you set up the Compliance functionality, you can also choose Table 71076686 (MDR DMS Document) as a compliance

tables.

Table 71076684 (MDR DMS Document Assignment) has been added as a subtable.

You need a separate license before you can use this feature.

Job queue: compliance

If you want document renewals checked and created automatically with the help of the job queue, you must set up an entry in the

queue for codeunit 71076791 (MDR Job Queue Handler) with the ‘check renewals’ string.

LISTS

MDR assignments

MDR assignment lines can be displayed without filters or filtered by item, customer, or vendor.

To see all links available in the system, choose the Search icon, enter MDR DMS Doc. Assignment List, and then choose the

related link. The fields on the page correspond to those on the Assignments FastTab of MDR DMS document cards.

Alternatively, open an item card, a customer card, or a vendor card, and then choose Actions > MDR > MDR Assignments on the

ribbon to see the links filtered by type of base data.

Note

Note

1.2.9 medtec365

- 1177/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Document entries

To see a list of all MDR document entries, choose the Search icon, enter MDR DMS Document Entries, and then choose the

related link. See the following table for a more detailed description of some of the fields that you can find on the page. For an

explanation of the other fields, see MDR DMS Document List and MDR DMS Document Control.

Log

You can use the general search function to open the MDR Log page.

WORKFLOW

Overview

Throughout this section, a variety of examples will be used to describe the process of document control, covering the review and

renewal of MDR documents and their assignment to one of the following records in the system:

The difference between purchase orders and subcontract purchase orders is that the Prod. Order No. field is filled in on the lines of

the latter.

Repairs, on the other hand, are represented by one or more service lines on which the CSR Case No. field is filled in with a

repair-related case.

Field Description

Entry No. Shows the unique number of the document entry.

Entry Type Specifies the process that the entry was created for.

Source Type Shows the ID of the table that the entry is assigned to. The assignment is determined based on this and

the Source Subtype, Source ID, and Source Ref. No. field.

Source

Subtype

For entries of source type 36 (Sales Header), 37 (Sales Line), 38 (Purchase Header), and 39 (Purchase

Line), shows the number of the document type option as specified in the table that is assigned to the entry.

Entries linked to other source types have a value of 0 in this field.

Source ID Shows the number of the document that the entry is assigned to.

Source Ref.

No.

Shows the number of the document line that the entry is assigned to.

Entries linked to document headers have a value of 0 in this field.

Record ID Contains all the key field values from the document header that the entry is assigned to.

This means that the key values stored on the document header can also be found on the entries assigned

to the document lines.

Source Event Shows the event that led to the creation of the entry.

Sales Purchasing Miscellaneous

Quotes Quotes Production orders

Orders Orders Subcontract purchase orders

Blanket orders Blanket orders Assembly orders

Invoices Invoices Repairs

Posted shipments

Posted invoices

Note
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Find DMS documents

As a first step to finding MDR DMS documents related to a document header in the app or a document line on which a certain

item was specified, the system searches document control for records that meet the following criteria:

Criterion A

For a sale

The Customer No. field in the record is blank or the number in the field is the same as the sell-to customer number on the sales

document.

For a purchase

The Vendor No. field in the record is blank or the number in the field is the same as the buy-from vendor number on the purchase

document.

For production or assembly

Customer and vendor numbers aren’t available.

Criterion B

For a sale

The Country/Region Code field in the record is blank or the code is the same as the ship-to country/region code on the sales

document.

For a purchase

The Country/Region Code field in the record is blank or the code is the same as the buy-from country/region code on the purchase

document.

For production or assembly

A country/region code isn’t available.

Criterion C

The status of the document control record is set to Certified.

Criterion D

The Item No. field in document control is blank (for a header) or the number in the field matches the item number entered on the

standard document line.

Criterion E

The Item Version Code field in document control is blank (for a header).

As version codes haven’t been implemented yet on document lines, this criterion is always fulfilled at line level.

Criterion F

The Variant Code field in document control is blank (for a header) or the code in the field matches the variant code entered on

the standard document line.

Criterion G

The type of the associated document (such as Sales Order or Purchase Order) has been selected in document control.

As a next step, the system checks each DMS document linked to the records it finds for an assignment line that fulfils the

following conditions:

Condition 1

The document type set for DMS assignment matches the type selected in document control.

1. 

2. 

3. 

1. 

2. 

3. 
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Condition 2

For a sale

The Customer No. field on the assignment line is blank or the number in the field is the same as the sell-to customer number on the

sales document.

For a purchase

The Vendor No. field on the assignment line is blank or the number in the field is the same as the buy-from vendor number on the

purchase document.

For production or assembly

Customer and vendor numbers aren’t available.

Condition 3

For a sale

The Country/Region Code field on the assignment line is blank or the code is the same as the ship-to country/region code on the

sales document.

For a purchase

The Country/Region Code field on the assignment line is blank or the code is the same as the buy-from country/region code on the

purchase document.

For production or assembly

A country/region code isn’t available.

Condition 4

The status of the assignment line is set to Certified.

Condition 5

The Item No. field on the assignment line is blank (for a header) or the number in the field matches the item number on the

standard document line. 

Condition 6

The Item Version Code field on the assignment line is blank (for a header).

As version codes haven’t been implemented yet on document lines, this condition is always fulfilled at line level.

Condition 7

The Variant Code field on the assignment line is blank (for a header) or the code in the field matches the variant code on the

standard document line.

Condition 8

1. 

2. 

3. 

1. 

2. 

3. 
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The Relevant Document Date is in the period specified by the Valid From and Valid To fields on the assignment line.

An assignment line found in this way then shows in the DMS Document No. field the MDR records linked to a standard document

header or line in the app.

Meet approval requirements

An approval requirements check is performed on a sales or purchase document line if the Check Approval Reqs. field for the item

specified on the line was set to Sales or Sales & Purchasing (for selling the item) or to Purchasing or Sales & Purchasing (for

buying it). This check succeeds if:

The line is linked to a valid document control record that the Document Required field was selected for.

The MDR document found with the help of document control and DMS assignment is of a document type that the Approval

Reqs. field was selected for in the Name part of MDR DMS Structure Setup.

Copy documents

You can also create an MDR document from an existing document:

Open an MDR document.

On the ribbon, choose Copy Document.

Fill in the fields on the request page as described in the following table.

The status of the MDR document and the assignment lines is set to New when you run this function.

For Date options

Sales header Order Date or Posting Date

Sales line Shipment Date or Work Date (the latter if approval requirements need to be checked

prior to posting)

Purchase header Order Date or Posting Date

Purchase line Expected Receipt Date or Work Date (the latter if approval requirements need to be

checked prior to posting)

Production order header Due Date

Production order line Due Date

Item journal line of order type

Production

Posting Date

Assembly header Due Date or Posting Date

Assembly line Due Date

• 

• 

1. 

2. 

3. 

Field Description

Copy Links Specify if you want to copy the assignment lines set up for the document.

This toggle is turned on by default.

Copy Comments Specify if you want to copy the comments stored for the document.

This toggle is turned off by default.

New Validity Date

(Formula)

Enter the formula that you want the system to use to calculate the Valid From and Valid To dates

(as well as the renewal date) on the MDR document and the assignment lines.

If the field is left blank, the old validity field values will be kept.
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Check for required documents

If an approval requirements check is run (see Meet Approval Requirements) and the check fails, the system takes measures to

remedy the situation.

What these measures look like depends on the option that you selected in the Error Level (Doc. Required) field in document

control.

The check is also performed before a document is posted, the only difference being that if you set the error level to Warning in

this context, you will not be notified when a process doesn’t pass the check—so that you will not be inundated with messages

when posting more than one document at once.

No MDR document entries will be created during the check.

Error levels

In all examples found in this subsection, an approval requirements check is run for an item that you want to enter on sales

documents. However, before you can enter the item, the Check Approval Reqs. field on the associated item card must be set to

Sales (or Sales & Purchasing).

Log Level

On the Log level, an entry is made in the MDR log, and you see a message describing the error that occurred during the check

but can continue with the transaction.

Example

You certify a document control record. This record includes a document requirement for sales orders on which the item

referenced at the beginning of the section is filled in and document type DRAWING is selected. Afterward, you set the error level

to Log. A certified document assignment doesn’t exist.

When you create and release an order on which the item is entered, the order is then recorded in the MDR log, but you will not

be informed about any requirements check.

Warning Level

On this level, you see a message, and an entry is made on the MDR document. After you’ve confirmed seeing the note, you can

continue, however.

If you had selected this option in the example situation described earlier, you would now see a message on trying to release the

order, telling you about the missing approval requirements.

By choosing OK in the dialog box, you would nevertheless be able to release it while the system would create a log entry for it.

Exit Level

With the level set to Error, the system shows an error message before canceling the transaction altogether.

Choosing this option in the previous example would show a message describing the error if an attempt were made to release the

order, and the order would remain open after confirming the note. A log entry wouldn’t be created.

Print MDR documents

You can use the Print Document field on the MDR DMS Document Control to specify how you want the system to print MDR

documents. Two different approaches can be used. MDR printouts can be added as supporting documents (for example, when

you want to sell an item) or by running an action (such as on production orders).

Example

You certify a document control record that includes print settings used for sales and production orders of document type

DRAWING.

Afterward, you certify an MDR document that is stored in the DMS (see ELO FactBox) and that is assigned to the item mentioned

earlier.

As a result, the MDR document will consist of a text that reads DRAWING.
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As Supporting Documentation

If you want MDR documents printed in the form of supporting documentation, the system searches all DMS document entries

referencing the selected document in the app for entries where the Print Document field has been selected.

As an example, you create and release a sales order on which a line is linked to an MDR document with the help of a document

entry (which you can see by using the Show MDR Doc. Entries action on the ribbon).

Among other things, this entry shows the standard document header in the Record ID or the relevant line in the Source Ref. No.

field, as well as the number of the MDR record and the item number (if available). The Source Event field, on the other hand,

specifies the event that led to the creation of the entry, and the Print Document field if the DMS record should be printed as

supporting documentation.

When you run the Print Confirmation function on the order, the linked MDR document is then printed together with the

confirmation note.

Through use of a function

As an example, you assign four MDR documents to a production order (one to the header and three to the lines) for when the

Refresh Production Order action is run; you can view them by using the Show/Print MDR Docs. function on the ribbon.

Unlike on sales orders, printouts of supporting documentation aren’t available here. Instead, you choose Show/Print MDR Docs.

to open or save an MDR record (or exit the dialog box) or Open to view the documents in your default PDF reader and print them

there as well.

Prevent more printouts

Only one MDR document entry can be assigned to each header or line in the system, although more than one can be assigned to

the same standard document (that is, to the header and multiple lines). This is to ensure that every MDR document is printed

only once. The MDR document entries remain unchanged during this process.

Example

You store the following certified document control records in the system:

Document Type Print Document / 

Values Inherited

Item No. Sales Order

SALES-QUO Yes Yes

SALES-QUO Yes ITM01 Yes

SALES-QUO Yes ITM02 Yes

DRAWING Yes ITM01 Yes

DRAWING Yes ITM02 Yes

COMPATIBILITY Yes ITM01 Yes

COMPATIBILITY Yes ITM02 Yes
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Additionally, you make the following MDR assignments for the document types:

For CUST01, you also create and release a sales order that includes two lines where ITM01 and ITM02 have been entered.

When you simulate the creation of MDR document entries for order headers (which no item numbers are entered for), customer

CUST01, and country code DE, you then see that two valid document assignments exist for MDR document MDR-28.

Simulating the creation of entries for all order lines with item 01, CUST 01, and DE will get you five valid assignments (one for

MDR-28 and two each for MDR-18 and MDR-38).

Performing the simulation for lines with ITM02, CUST01, and DE will also result in five assignments (one for MDR-28, two for

MDR-18, and two for MDR-38).

When you release the order, an MDR document entry will be created from each valid DMS assignment simulated for a standard

document header (Source Ref. No.= 0) or line (Source Ref. No.= Line No.).

However, the system will prevent entries from being assigned more than once to the same MDR header or line. For example, it

will create a single entry from the two valid header assignments for MDR-28 (but all entries for the lines).

When you print the confirmation document as described in an earlier example, each MDR document header and line assigned to

an MDR document entry will be printed once, although the confirmation will end up on the first page. This means that MDR-28

(type SALES-QUO) will be printed on page 2, MDR-18 (DRAWING) on page 3 of 4, and MDR-38 (COMPATIBILITY) on the last

page.

Inheritance

Inheritance of DMS information mainly occurs when you post or archive records in the system. Whether document information

will be inherited can be specified in the Values Inherited checkbox in document control.

When you post sales or purchase documents or assembly orders for which the field has been selected, their links to MDR

documents are copied to the records that you create from them (such as posted shipments, receipts, or invoices).

On production orders, information is inherited when you post journal lines on which the order type Production Order, a

production order number, and a production order line number have been specified.

When you archive sales or purchase documents (quotes, orders, and blanket orders), MDR documents will also be copied to the

relevant document archives.

Post an assembly order

Document Type DMS Document No. Item No. Country/Region Code Customer No.

SALES-QUO MDR-28 DE

SALES-QUO MDR-28 CUST01

DRAWING MDR-18 ITM01 DE

DRAWING MDR-18 ITM01 CUST01

SALES-QUO MDR-18 ITM01

COMPATIBILITY MDR-38 ITM01 CUST01

COMPATIBILITY MDR-38 ITM01 DE

DRAWING MDR-18 ITM02 DE CUST01

DRAWING MDR-18 ITM02

SALES-QUO MDR-28 ITM02

COMPATIBILITY MDR-38 ITM02 DE

COMPATIBILITY MDR-38 ITM02 CUST01
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As an example, you create and release an assembly order. Two MDR documents are found for it, with one each assigned to the

order header and a line. You then pick and post the order so that the MDR documents are linked to the posted record as well.

Afterward, you can choose Show MDR Doc. Entries or Show/Print MDR Docs. on the ribbon to either view the MDR entries set up

for the posted document or to view and print the assigned MDR documents.

When you run the Show MDR Doc. Entries action, the entries linked to the document header and lines set up in the app will be

displayed in list form, with the Source Ref. No. field showing the line number from the internal document. If the value in the field

is 0, the MDR entry has been assigned to the header.

If a document entry is created for a tracked item (that is, an item with a serial or a lot number), the document count on the MDR

DMS Entry Hierarchies page is set up and updated in reference to not only the standard document line but also a serial number

(source type 6504) or a lot number (source type 6505).

As a result, you can see in the MDR Documents FactBox on the relevant serial or lot number information card how many DMS

records have been assigned to it via MDR document entries.

Archive a quote

As another example, you create and release a sales quote that includes two lines with items on them and have seven document

entries created for the header and lines of the document.

Afterward, you use the Archive Document action on the ribbon to archive the quote as version 3 and run the Show MDR Doc.

Entries action to have the MDR document entries copied to the archived quote—except for the Source Type and Source Event

values, which are updated instead.

Running the Show/Print MDR Docs. function then shows you the MDR documents assigned to the document entries (SALES-QUO

MDR-28, COMPATIBILITY MDR-38, and DRAWING MDR-18).

Renewals

With this feature, you can log rejections of MDR documents that are about to expire, as well as requests for and receipts of new

documents.

When you open the MDR DMS Document Renewals page, it is filtered for documents in the New/Requested status. You can

change the filter via drill down so that you can see what renewals you have or haven’t received.

The MDR DMS Assignments FastTab, on the other hand, shows the assignment lines available for the currently selected MDR

document.

See the following tables for an explanation of individual tab fields.

Filters

Field Description

Status Used to show the status of document renewals. Options are:

• New/Requested

• Received/Not Rcvd.
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Field Description

Entry No. Shows the number of the record.

You cannot change this field manually.

For New Doc. Specifies if a copy should be created for the current document when you run the Create Documents

action (see Create MDR Documents).

Document No. Specifies the number of the MDR document that a new version has been requested for.

You cannot change this field manually.

Document Type Specifies the type of the MDR document.

You cannot change this field manually.

Status See Filters.

Requested By Specifies the ID of the user who requested a new MDR document.

Requested On Specifies when a new MDR document was requested.

Received On Specifies when a new document was received.

Checked By Specifies the ID of the user who checked the renewal information.

This entry must be filled in for the status to be set to Received or Not Rcvd.

New Document No. Specifies the number of the new MDR document.

Reason Not Rcvd. Specifies why no new MDR document has been received (yet).

New Valid From Specifies the Valid From date entered on the new MDR document and the new approval requirement

lines.

New Valid To Specifies the Valid To date entered on the new MDR document and the new approval requirement

lines.

Created By Shows the ID of the user who created the record.

You cannot change this field manually.

Created On/At Shows when the record was created.

You cannot change this field manually.

Modified By Shows the ID of the user who last changed the record.

You cannot change this field manually.

Modified On/At Shows when the record was last changed.

You cannot change this field manually.

Document Type

Descr.

Shows the description of the associated document type.

You cannot change this field manually.

Area Filled in with the area specified for the associated document type.

Group Filled in with the group specified for the associated document type.

Name Filled in with the name specified for the associated document type.

Shows the description entered on the related MDR document.
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Create a renewal

You can create document renewals in two ways, namely by running the Check MDR DMS Renewal function or adding document

renewal to the job queue.

If you use the ribbon function, you need to choose OK in the dialog box that appears before renewals can be checked. The system

then searches for all MDR documents that meet the following conditions:

The Renewed On field is filled in.

The date in the Renewed On field is earlier than or equal to the work date.

The Renewed checkbox isn’t selected.

Afterward, a renewal is created for each document found, and the Renewed field on the document is selected automatically.

Change a status

On the lines, you can change the renewal status from New to Requested, Received, or Not Rcvd. Depending on the status

selected, the system checks which fields must be filled in on a line, as described in the following table.

You see an error message if you try to change the status field although one or more mandatory fields haven’t been filled in yet.

The message is updated when you enter the missing values.

When all required fields are filled in and the status of the line is set to Received, you must set the Status Filter field to Received/

Not Rcvd. if you still want to see the line.

Changing the status clears the Renewed checkbox. To prevent another renewal from being created, the Renewed On checkbox is

emptied as well.

When you change to Not Rcvd., you need to decide whether to delete the current MDR document from monitoring. Only if you

choose Yes will the renewal date be deleted from the document so that no other renewal is created.

You can no longer change a renewal record that is set to Received or Not Rcvd.

Create MDR Documents

For each renewal that you receive, you can create a new MDR document from the old one by running the Create Documents

action on the ribbon.

Field Description

DMS Document

Descr.

DMS Doc. Valid

From

Shows the Valid From date entered on the related MDR document.

DMS Doc. Valid To Shows the Valid To date entered on the related MDR document.

DMS Doc. External

Ref.

Shows the external reference entered on the related MDR document.

1. 

2. 

3. 

New status Mandatory fields

Requested Requested By

Requested On

Received Received On

Checked By

New Document No.

New Valid From

New Valid To

Not Rcvd. Checked By

Reason Not Rcvd.
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When you run the function, the status fields on the new document are set to New and the New Valid From and New Valid To

dates specified for the renewal are copied to it as well. The other field values are transferred from the old document.

New MDR documents can be created for all renewal lines on which the For New Doc. field is selected. To be able to select a line,

the following conditions must be fulfilled on it:

The New Document No. field must be blank.

The Received On field must be filled in.

The Checked By field must be filled in.

The New Valid From field must be filled in.

The New Valid To field must be filled in.

You cannot select a line that doesn’t meet these conditions.

Afterward, you can run the Create Documents action for the selected lines and specify whether you want to copy the comments

stored for the old documents.

You see a message when the process is complete. The number of new documents is then entered on the renewal record.

Document compliance

If MDR document control is integrated into your company’s compliance procedures, the compliance process is started when an

attempt is made to change the status of an MDR document to Certified.

You must then enter a compliance text. Afterward, you’re notified that the document cannot be certified until completion of the

approval process, which is described here. 

To be able to use this feature, you need a license for the Compliance functionality. 

Simulate document entry creation

On the Simulated MDR DMS Entries page, you can simulate the creation of document entries to check your current document

control configuration.

After you run the simulation, you will see the entries that could be created according to current setup on the Simulated DMS

Document Entries FastTab.

Setup

To specify filters and documents for the simulation, you must first select a simulated event.

What documents you can select depends on the Customer and Vendor No. fields. If both are blank, you can select only documents

from the Miscellaneous category here (production, subcontract, assembly, or repair orders; see Overview), as you need customer

numbers for sales and vendor numbers for purchase documents.

Filters

1. 

2. 

3. 

4. 

5. 

Note

Field Description

Simulated Event Specifies the event to be simulated.

If the event that you enter here is different from the event specified in the DMS Sales/Purch. Doc. Check

field (see medtec365 Setup), the system will not create MDR entries for sales and purchase document

lines.

Options are leaving the field blank (no simulation possible), Release, and New Line.

Perform

Simulation

When you run this action, the selected filters and documents will be used to simulate the specified event

and the subsequent creation of document entries.
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On this FastTab, you can specify the field values that should be used to simulate the creation of MDR document entries on

release of a document or document line in the app or the addition of a new standard document line.

If you don’t fill in the Item No. field on the tab, the system will simulate entry creation for document headers.

Apply Simulated Values to Document Selection

Simulated MDR DMS Entries

For an explanation of the other fields on this FastTab, see Document Entries.

Workflow

Field Description

Customer No. Specify the number of the sell-to customer that should appear on the document.

Vendor No. Specify the number of the buy-from vendor that should appear on the document.

Country/Region Code Enter a sell-to or buy-from country code, depending on what type of transaction you want to

simulate.

Item No. Specify the number of an item that should appear on the document line.

Variant Code Specify the item variant that should appear on the document line, if necessary.

Relevant Document

Date

The work date is entered in this field automatically as the date for assessing MDR document

validity.

You can change the date, if needed, but the field must not be left blank.

What document or document line date can be entered is listed in an earlier section of this article

(see Relevant Document Dates).

Function or Field Description

Select All Selects all documents that can be edited.

Select None Removes the selection from all documents.

Sales Quotes

Sales Orders

Blanket Sales Orders

Sales Invoices

Purch. Quotes

Purch. Orders

Blanket Purch. Orders

Purch. Invoices

Production Orders

Subcontract Purch.

Orders

Assembly Orders

Repairs With the relevant toggle turned on, simulates the creation of MDR document entries for

this document type.

Field Description

DMS Doc. Link Line

No.

Specifies the line number of the MDR DMS document assignment that will be used as a basis to

simulate the creation of the current document entry.

Clicking the field value will open a filtered version of the MDR DMS Document Links page.

DMS Document No. Specifies the entry number of the MDR DMS control record that will be used as a basis to simulate

the creation of the current document entry.

Clicking the field value will open a filtered version of the MDR DMS Document Links page.
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As an example, you select Release as the event to simulate and a production order document thereafter. You don’t fill in an item

number so that the simulation applies to document headers in the app.

After you run the simulation, the entries that could be created for MDR records MDR-28 and MDR-33 are shown on the

Simulated MDR DMS Entries FastTab. The number of simulated entries is shown as a heading.

You then use the lookup on the Entry No. (Doc. Control) field. You see that document type SALES-QUO has been assigned to the

production order header on the document control record found for the simulated field values.

Afterward you use the lookup on the DMS Doc. Link Line No. field. This time, you see document MDR-28 linked to type SALES-

QUO on the related MDR assignment record.

With the next lookup on the DMS Doc. Link Line No. field, you see document MDR-33 is also assigned to document type SALES-

QUO.

Now you rerun the simulation with ITM02 entered in the Item No. filter field. You see that a document entry was created for

MDR document MDR-18.

In summary, the simulations show that when a line containing ITM02 and a due date of 08/31/2024 (Relevant Document Dates) is

released as part of a production order, MDR documents MDR-28 and MDR-33 would be created for the header and another MDR

document, MDR-18, for a line.

If the MDR documents determined in this way do not match your expectations, you need to adjust the setup.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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General Setup

For general information about how to configure Microsoft Dynamics 365 Business Central1 for first use, see Overview of Tasks to

Set Up Business Central

This article only describes the additional pages, functions, and fields available for configuration in medtec365.

MEDTEC365 ADMINISTRATION

To assist you in setting up the software solution, the medtec365 Administration node has been added to the Role Explorer. To see

the node:

Go to your role center.

On the ribbon, choose the Menu button, and then choose Explore More Roles.

Alternatively, you can use the medtec365 Administration role on the My Settings page for general setup. Both the node and the

role cover the following areas:

Additional fields

Claims and complaints

FMEA

Actions

MDR document management

ADDITIONAL FIELDS

In medtec365, you can create custom fields for various base data. These fields can then be used to provide additional information

or be copied alongside other data to purchase and sales documents, where you can decide whether you want to display them.

With this feature, you can therefore create custom records that include, for example, another set of item numbers, without

having to make major adjustments to the app.

You can decide if a field should have a set number of options or can be filled in with only certain types of values, such as decimals

or text, and whether you want to limit the field to a specific length or predefined content.

You can also set up a variety of output formats for both documents and processes.

medtec365 Setup

Before you can work with additional fields, you must specify a default language code for them. For this purpose, choose the

Search icon, enter medtec365 Setup, and then choose the related link. Afterward, fill in the Default Language Code field.

When you create or edit an additional field, the description you specify for it is copied to the Translations (Additional Fields) page

under the default language code set for the app so that it can be printed on reports. Other languages can be added manually.

1. 

2. 

• 

• 

• 

• 

• 
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Add a field

To set up an additional field:

Choose the Search icon, enter Additional Fields, and then choose the related link.

Fill in the fields as described in the following table.

To store the choices for an additional field of type Option, choose Related > Option Values on the ribbon, and then fill in the page

as necessary.

Specify a category

The categories that can be specified for base data are used to sort and group related information in master records. You can

assign a category during field setup.

Set up field levels

You can also specify three levels of dependency between categories of base data.

For example, you can use levels to assign customers to a main statistics group and a subgroup. To set up levels:

Choose the Search icon, enter Additional Field Levels, and then choose the related link.

Fill in a line, and then choose Related > Level Values on the ribbon if you want to further limit option values at a certain level.

Output formats

For field types Text, Decimal, and Date, you can choose Output Format on the ribbon to specify how additional fields should

appear on printouts or within the system. For example, different formats might be required for invoicing and shipment.

If no format is specified for a certain type of output, such as for printouts, the default format will be used. If none has been

specified either, the text or numbers will appear in the same format in which they were entered.

1. 

2. 

Field Description

Code Specify a code for the field.

Description Specify a description for the field.

More Details Enter more details about the field, if necessary.

Field Type Specify the type of the field. You can choose between Text, Date, Option, Checkbox, Ext. Checkbox,

and Decimal.

Input Check If you choose Text as the field type, specify in what format the text needs to be entered. Options are

A=alphanumeric, N=numeric, and B=letters.

Example

To check user input for 9-digit numbers, enter NNNNNNNNNNN.

Category Code Specify a field category. The category is used to sort output in master records. For an explanation,

see Base Data Categories.

Copy to Sales Doc.

Allow Changes to

Sales Doc.

Copy to Lines

Copy to Purch. Doc.

Allow Changes to

Purch. Doc.

Copy to Info Cards

Print Description

Select one of these checkboxes if you want the additional field to be printed during a certain process

or on a certain document. You can later run the Output Format action on the ribbon to specify in even

more precise terms how the field should appear on pages.

Active Select to use the additional field in master records.

1. 

2. 
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Create a format

Choose the Search icon, enter Output Formats (Additional Fields), and then choose the related link.

Specify a format according to the following tables.

Date

Decimal

Only # is recognized as a placeholder. When you set up a decimal format, you can specify not only how numbers are shown,

including how many decimal places they should have, but also whether you want to insert a separator for thousands.

Text

Text can also be formatted by using # placeholders. The system will process them from left to right, ignoring those that are

redundant. If text is longer than the pattern or the number of placeholders specified, the output will be truncated.

Examples

Base tables

To link additional fields to a table:

Choose the Search icon, enter Base Data Tables, and then choose the related link.

On the ribbon, choose New if you don’t see the table you want on the list, and then fill in the fields on the line.

All tables that you want to include the additional fields in must have been set up with one of the following combinations of key

field types:

Code20

Code20, Code20

Code20, Code20, Integer

The system will check for these combinations of primary key fields each time you’re trying to enter a table on the page. You’ll see

an error message if the type of primary key doesn’t match.

Afterward, you can choose Related > Additional Fields on the ribbon to assign fields to the table.

1. 

2. 

Wildcard Description Example 08/03/21

Day D Single digit, if possible. 3

Day DD Two digits. 03

Month M Single digit, if possible. 8

Month MM Two digits. 08

Month MMM Abbreviated. Aug

Month MMMM Spelled out. August

Year YY Two digits. 21

Year YYYY Four digits. 2021

Additional Field Code Value Output Format

DOCNO A1212 A1212 #####

DATE 08/06/55 August 06, 1955 MMMM.DD YYYY

IK NO 223344556 IK 22-33-44-55-6 IK ##-##-##-##-#

1. 

2. 

• 

• 

• 
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When you’re done, choose Home > Initialize Add. Fields & Search to initialize the new fields so that they become available in the

master records for editing.

Prefill field values

For each additional field, you can choose if the field should be filled in automatically when a new record is created. You can then

specify a value that should be copied to the record by default.

MANDATORY FIELDS

To support the creation of base and document data, you can have the system run a check for mandatory fields in the following

places:

Master records

Quick Contact Capture

Contacts

Customers

Vendors

Items

Resources

Serial No. Information Card

Work Center Groups

Work Center

Documents

Sales documents based on tables 36 (Sales Header) and 37 (Sales Line)

Purchase documents based on 38 (Purchase Header) and 39 (Purchase Line)

Warehouse receipts based on table 7316 (Warehouse Receipt Header) and 7317 (Warehouse Receipt Line)

Warehouse shipment based on table 7320 (Warehouse Shipment Header) and 7321 (Warehouse Shipment Line)

Service documents of document type quote and order based on table 5900 (Service Header) and 5901 (Service Item Line) and

5902 (Service Line)

Dispatch documents based on table 5049203 (Dispatch Handling Header) and 5049204 (Dispatch Handling Line)

Purchase requisitions based on 5488139 (Order Quote) and 5488136 (Order Quote Line)

Note: The purchase requisition module is licensed and activated in the KUMAVISON module setup.

For all actions based on table 5488142 (Action)

Note: The "Complaint management" module is licensed and activated in the KUMAVISION module setup. The mandatory field

check is called up via the "Complete" function.

With this feature, you can specify fields that need to be filled in when a master record or a document is created or modified. Only

when a value has been entered in each of the mandatory fields will the record be marked as Updated or the document released

(to post a shipment, for example).

Fields are checked for completion when you choose End Update on the ribbon of the card or document. Afterward, the record

can no longer be changed (although related records, such as comments, can). At the same time, the Update field on the header is

set to Completed.

To be able to change the record again, you need to choose Edit on the header.

Setup

Configure field check parameters

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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To specify the parameters that will be used for field checks:

Choose the Search icon, enter medtec365 Setup, and then choose the related link.

On the Field Checks FastTab, fill in the fields as described in the following table.

1. 

2. 
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Field Description

Check Quick

Contact

Capture

Specify whether to turn on and when to run a contact capture check.

(blank)

The check is deactivated.

On Release

The check is run when the contact capture card is released.

On Start & Release

The check is run when you start quick capture and when the contact capture card is released.

Check Contacts Turn on this toggle to activate the check for contacts.

Check Customers Turn on this toggle to activate the check for customers.

Check Vendors Turn on this toggle to activate the check for vendors.

Check Items Turn on this toggle to activate the check for items.

Check Resource Turn on this toggle to activate the check for resources.

Check Serial No.

Info

Turn on this toggle to activate the check on serial number cards.

Check Sales Turn on this toggle to activate the check on sales documents.

Check Purchases Turn on this toggle to activate the check on purchase documents.

Check Order

Quote

Turn on this toggle to activate the check on order quote documents.

Check Dispatch Turn on this toggle to activate the check on dispatch documents.

Check Service

Documents

Turn on this toggle to activate the check on service documents.

Check Warehouse

Receipt

Turn on this toggle to activate the check on warehouse receipt documents.

Check Warehouse

Shipment

Turn on this toggle to activate the check on warehouse shipment documents.

Check Machine

Centers

Turn on this toggle to activate the check for machine centers.

Check Measures Turn on this toggle to activate the check for measures.

Wizard Repeats Specify how often the wizard can be used in a single process run.

This means that the system will ask if the wizard should be run when data maintenance has not been

completed.

Entering 5 in this field, for example, will let a user close the wizard five times. Each time, the system

will again ask if editing is to continue. If the wizard is closed for the sixth time, the update status of the

relevant record will be set to In Progress, and the user would have to restart the check on the

corresponding card (such as on a customer card).

Note

A 0 in this field means that the wizard will only be opened once, and no further message will be shown.

Afterward, the user must run the check manually from the relevant page if certain fields still need to

be filled in.

Action Repeats
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View table checks

To see what checks have been set up for a table:

Choose the Search icon, enter medtec365 Mandatory Fields Setup, and then choose the related link.

Select a table.

On the ribbon, choose Checks or press Ctrl+P.

Create a check

To set up a field check:

Choose the Search icon, enter medtec365 Mandatory Fields Setup, and then choose the related link.

Select a table, and then choose Checks on the ribbon to open the Mandatory Fields page.

On the ribbon, choose New and fill in the fields as described in the following tables.

General

Field Description

Specify the number of levels on which actions should be carried out. In this context, an action

describes the automated filling-in of fields under certain conditions.

For example, entering 5 in this field would—after the actions are run the first time—make the system

repeat the check another five times or until it determines that no more actions can be carried out

(according to the conditions specified).

Note

What you enter in field has a major impact on the performance of the feature. We therefore

recommend that you keep the number of levels on which actions are nested as low as possible.

The condition lines should also always provide a way to exit the loop.

1. 

2. 

3. 

1. 

2. 

3. 

Field Description

Table ID Specifies the ID of the table that the check is intended for. This field is filled in automatically.

Code Specifies a unique code to identify the check. This field is also filled in automatically.

Description Here you can describe the purpose of the check.

Action Choose what happens if fields are not filled in.

Notify

You’ll see a message if the field check fails. Users, however, can still release the document or master

record.

Cancel

In contrast to the previous option, the document or record cannot be released until all mandatory fields

are filled in.

Prefill

Hides the check from users’ view and automatically fills in fields based on specified criteria.

Sequence No. Specify the order that individual checks are performed in and are processed with the help of the wizard.

Action

Message

Specifies the message that is shown to the user when the field check is processed.

Status Specifies if the check can be used; only checks in the Certified status are.

Conditions Specifies if conditions have been set up for the check.

Default Values Specifies if Prefill option values are available.
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Conditions

On this FastTab, you can enter the criteria that must be met for the field check to be seen as successful.

Conditions should need to be met only in certain situations and not every time that a record is opened. The fewer checks need to be

run, the better the performance of the feature.

Default values

Field Description

Line No. Shows the number of the condition line.

Check Type Specify whether the field condition represents an IF or AND statement.

An IF statement serves as the initial condition to be fulfilled, AND as a supplement. A check is only

valid, however, when both the IF condition and the AND statement (or statements) are true.

Multiple IF statements can also be grouped under the same check. Each is then treated as an OR

statement, that is, to validate the check, at least one condition starting with IF must be true.

Source Field Indicates if the field to be checked originates with a table or the list of additional fields.

Field ID Specify the ID of the field that you want the system to check.

Note:

Conditions on primary key fields are not supported for technical reasons.

Field Name Shows the name of the field to be checked.

Condition Type Specify the operator that will be used to compare the field value on the record and the value that you

entered for the condition.

The following operators can be used: =, <>, <, >, <= and >=.

Based on the field type, some of them might not be available, however.

Condition Value Specify what the value in the relevant field will be compared against.

If this field is blank, the system compares the initial value on the record against the initial value

specified for the condition.

If the condition field is of type Date or Time, you can also use a formula to query the current time or

date. For Date type fields, the options are system date, work date, or another formula-based value in

relation to the system date.

Example

<-10Y>: Returns the work date from 10 years ago.

Attached to Line

No.

Links one condition to another. This is typically the case with AND statements.

Note
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On this FastTab, you can select the field users should be able to edit in the wizard if the action type is Notify or Cancel. With

Prefill, you can specify on this tab the fields and values that should automatically be entered on a record without manual

intervention.

Certify a check

To add default values to mandatory field checks, choose Certified on the ribbon.

A check that is certified can no longer be changed. To edit the check again, you need to change the status to Under Review on the

ribbon.

Field check wizard

Run the wizard

The wizard is run when you choose the End Update action on the ribbon after editing a master record or releasing a document

(provided that certified check routines exist and that their conditions apply in this case). On the wizard page, you’ll see the

results of the checks that have been run and can correct any field value, if necessary.

The page is divided into two sections:

The Message FastTab lists all check routines of type Notify and Cancel, with the first message that might require a response

highlighted in red and italics.

Field Description

Line No. Shows the number of the line where the default value should be entered.

Field Source Specifies if the field to be checked originates with a table or the list of additional fields.

Field ID Specify the ID of the field that you want the system to check.

Field Name Shows the name of the field to be checked.

Field Value Specify the value that the field to be checked should be filled in with.

With Notify or Cancel selected as the action type, the value entered here is shown as the default value in

the wizard, where it must be confirmed. If you selected Prefill, the value is entered automatically on the

record.

Note

If no value is entered, the field will be empty in the wizard for the Notify and Cancel options. You must

then decide what value you want to assign. If the Prefill option is chosen, the field on the record will be

emptied. You can also, as on the Conditions FastTab, enter a formula here.

Replace Value Specify if an existing value should be replaced. With this checkbox selected, the field to be checked is

shown in the wizard if the action type is Notify or Cancel, even if the field has already been filled in. You

must then confirm its value or enter another one.

With Prefill, the field value is replaced when you select this checkbox. If the checkbox is not selected and

the field has already been filled in, the system will keep the original field value.

Check Value Specify if you want the field to be validated when the wizard is run or when changes are copied back to

the related record.

Lookup Table

ID

Shows the table number entered on the check header.

Lookup Field

ID

Shows the field ID associated with the line on the tab.

Note
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The Field Checks & Values FastTab, on the other hand, lists all fields associated with a certain check routine. To replace what you

see in the field currently selected by the program (and, again, highlighted in red and italics), fill in a New Value in the group on

the right-hand side of the page.

Navigate entries

Choose Next Set or Previous Set on the ribbon to navigate to another field or, when the last field that can be edited in relation to

a certain message is shown, to call up the fields associated with other messages.

After you fill in the New Value field, the system automatically jumps to the next field (or message).

Enter field values

The only field that can be edited on the wizard page is New Value.

The Default Value on the right-hand side indicates if you’ve specified a default value for the field currently under review. You can

choose Adopt Default to fill in this value in the field instead of entering one manually.

If the field that is under review has already been filled in through some other means, the system shows the current value in the

Current Value field. You can choose Adopt Current to keep this value instead of entering another manually.

When a value has been entered, the field is set to Reviewed and can be hidden. The system then automatically moves on to the

next field that is shown on the list. If all fields related to a message have been edited, the message is marked as Reviewed too

and hidden from the list of checks on the page. Afterward, the system jumps to the next message that is available.

Messages and fields that have already been processed can be reopened for editing by choosing Show Reviewed on the ribbon. To

put the view back to open messages only, you need to run the Hide Reviewed action.

Finish editing

The wizard closes on its own when the results of all checks have been reviewed. To stop processing any time before this, you can

choose End Review on the ribbon.

When the wizard is closed, all checks of type Notify and Cancel are run again. If any of them haven’t been reviewed yet, you’ll be

asked if you want to edit them.

You can then choose Yes to restart the wizard or No to end processing and see the original master record, with information

already entered in the wizard copied to it. If certain reviews are still pending, the Field Check Status is set to Incomplete and the

Data Update field on the record remains on In Progress.

If all messages have been reviewed and no further checks of type Notify or Cancel are found when the wizard is closed, the Field

Check Status and Data Update fields on the record are set to Completed so that it becomes available for use throughout the

system.

TRANSACTION CODES

These codes provide you with insights into asset ownership and valuation at your company’s premises. They’re also used to

create a fixed asset from inventory and dispose of it later. In short, they’re essential to managing receipts, shipments, and

transfers of items in the system.

Setup

Codes

Note

1.2.9 medtec365

- 1201/1545 - Copyright © 2018 - 2024 KUMAVISION AG



To specify a code:

Choose the Search icon, enter Transaction Codes, and then choose the related link.

On the ribbon, choose New, and then fill in the fields as described in the following table.

Movement hierarchies

1. 

2. 

Field Description

Code Specify a code for the transaction. The code must be unique.

Description Specify a description for the transaction.

Valuation Type Specify how the system should calculate the value of an item that was posted to inventory with the

help of this transaction code.

Valued

Classifies the item as a current asset (which is regularly bought or sold).

Variable

Indicates that the item is stored by you but still owned by a vendor until consumed or taken out of

inventory for other purposes. Value entries for the item are therefore calculated on removal, not

earlier.

Not Valued

Marks the item as a fixed asset or third-party property (provided for the purpose of repair or reuse).

In either case, the item is not owned by you.

Ownership Type Specify who owns the item. This information is then copied to MRP, that is, to requisition and

planning worksheets (unless the item is a fixed asset).

You can choose Fixed Assets, Third-Party Property, or Current Assets here (with the last being the

default option) to have FA and TPP fields filled in automatically on stockkeeping unit cards, for

example.

The option selected in this field also determines the kind of inventory (such as Item or TPP Inventory)

shown on SKUs.

FA Transaction

Code

Specify a transaction type in this field if the item is a capital asset.

Default Inbound

Code

Specify the default code that will be used when a warehouse receipt is posted.

Note

The code must be set to Valued.

Movement

Hierarchy

Shows if a movement hierarchy is available for the transaction code. 

You can choose Movement Hierarchy on the ribbon to view and edit a hierarchy.

Pos. Adjmt. If

Capitalized

Turn on this toggle if receipt of an item can only be posted following capitalization.

No Transact. Code

Change

With the toggle turned on, the transaction code cannot be changed.
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A movement hierarchy is used to specify how items will be taken out of inventory as part of a transaction and if the transaction

code that you entered on the related sales order should be converted following shipment.

Choose the Search icon, enter Transaction Codes, and then choose the related link.

Select a code, and then choose Movement Hierarchy on the ribbon.

Fill in the fields as described in the following table.

Movement hierarchies can be entered only on sales orders; all other records and documents use ‘standard’ transaction codes.

For sales order types

1. 

2. 

3. 

Field Description

Transaction Code Shows the transaction that the hierarchy will be created for.

Hierarchy Code Together with the Transaction Code, uniquely identifies the record in the hierarchy.

Note

We recommend that you specify a meaningful abbreviation in this field so that the user can recognize

each transaction immediately.

Description Enter a description for the hierarchy.

Hierarchy No. Specify the order in which you want to process multiple hierarchies set up for a transaction code.

The number in this field is used to determine the inventory (that is, stock adjustment code) that will be

picked for shipments from the warehouse.

Movement Type Specify if items are sold as part of a sales order or transferred to a customer’s warehouse.

Ignore Whse.

Shipments

Turn on this toggle if you do not want the system to use a hierarchy automatically to ship from a

warehouse.

Stock Adjmt.

Code

Enter a code that will be used to offset item removal from inventory (for sales orders).

Note

This field must be filled in.

New Transaction

Code

For transfers

Items are removed from inventory by using the stock adjustment code and are immediately posted to a

customer warehouse with the code in this field, creating transfer entries in the process.

Note

The new code must correspond to the stock adjustment code when it comes to the valuation type. In

short, a transaction code of type Not Valued cannot be used together with a stock adjustment code of

type Valued or Variable, as item ownership cannot change hands through a transfer.

For sales

The stock adjustment code is used to sell an item from a warehouse (=negative adjustment). Receipt

(=positive adjustment) is then posted to the customer’s warehouse based on the code in this field.

Note

Leave the field blank if you do not want to use a new transaction code for sales transactions.

Note
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If you’re working with sales order types, you can specify transaction codes for them as well. They are then used as default codes

when you set up lines on an order.

Choose the Search icon, enter Sales Order Types, and then choose the related link.

Fill in the fields described in the following table.

For purchase order types

You can also specify transaction codes for types of purchase orders. The codes are then used as default codes when you set up

lines on an order.

Choose the Search icon, enter Purchase Order Types, and then choose the related link.

Fill in the fields described in the following table.

On positive adjustment

Filling in a transaction code is mandatory for positive adjustments to inventory. If no code is entered as part of a transaction, the

default code that might have been set up for it is used instead. If none is specified either, you see an error message.

Positive adjustments include:

Receipts

Sales returns

Production orders

Positive adjustments in item journals

On negative adjustment

Filling in a transaction code is also mandatory for negative adjustments to inventory. You see an error message if no code has

been entered. Negative adjustments include:

Shipments

Purchase returns

Consumption in manufacturing and assembly

Negative adjustments in item journals

On transfer

For inventory transfers, filling in a transaction code is mandatory as well. If no code is entered during one of the following

transactions, you see an error message:

Inventory movements specified on transfer orders

Transfers in transfer journals

On sales orders

When you edit a sales order, you can use—besides a transaction code—a movement hierarchy to specify the inventory that can be

withdrawn for the order.

1. 

2. 

Field Description

Transaction Code Specify a code for the order type.

No Transact. Code Change Select to prevent changes to the code on sales lines.

1. 

2. 

Field Description

Transaction Code Specify a code for the order type.

No Transact. Code Change Select to prevent changes to the code on purchase lines.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Entering the transaction code linked to the hierarchy on a document line then fills in the highest-level hierarchy automatically.

You can replace the hierarchy with another set up for the specified transaction, if necessary.

You can also delete the hierarchy on a line. It is then no longer used when removing items from a warehouse (only the

transaction code on the sales line is).

For picking, the movement type of a hierarchy level must match the type on the sales line. This means that when you pick items for a

transfer line, only the hierarchy levels of movement type Transfer are used by the system.

You also need to fill in a hierarchy if you specified a transaction code with one on the sales line but cannot change the code there.

On removal from inventory

The impact of movement hierarchies varies depending on whether you’re using the warehouse functionality to take items out of

inventory.

Remove inventory (no warehouse functions)

If a sales order is shipped from a location for which no warehouse shipments and picks are set up, you must check available

inventory on the sales line yourself and specify the relevant hierarchy for which enough inventory is available. You can run the

Inventory Overview action on the Lines FastTab to view current stock levels.

Remove inventory (warehouse functions)

If you’re using the warehouse functionality, item availability is checked automatically when you create a shipment to pick items

for a sales order so that you don’t have to manually change the hierarchy on the order lines.

On code changes

If you’re using a hierarchy for a shipment that you change the transaction code on, the system will record the change on the item

ledger and bin entries set up for the shipment. The item ledger entries are created based on the movement type entered on the

relevant sales lines, as illustrated by the following examples.

Example 1 – Transfer

You ship items to your customer’s warehouse by using a movement hierarchy. As part of the transfer, you specify a new

transaction code that will be used when the items are received.

The historical data for the shipment can be viewed on the Item Ledger Entries page.

The inventory is then transferred according to the stock adjustment code specified for the hierarchy. However, the transfer entry

that is used for the positive inventory adjustment at the destination will already have the new transaction code assigned.

Example 2 – Sale

You move items that will become third-party property at the customer’s warehouse. A hierarchy is used for selling and shipping

them.

The historical data for the shipment can be viewed on the Item Ledger Entries page.

The first ledger entry shows the transaction with the customer, including the current asset being valued and removed from the

warehouse. The second indicates that the third-party property led to a positive inventory adjustment on receipt at the customer

site. It doesn’t contain value entries but tells you where the sold equipment is stored.

On canceling shipments

For the return of items that you sold, you have two ways of using transaction codes.

Note

Note
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Cancel on return

For one, you can create a return order. The transaction codes on the order document must match those entered for the shipment,

including in movement hierarchies.

For the correct codes to be selected, the lines of the document must then be linked to the shipment lines. This link is set up

automatically when you run the Get Posted Document Lines to Reverse action from the ribbon.

After you have selected the shipment lines that you want to cancel and chosen OK, the system creates cancellation lines on the

return and links each item ledger entry that you want to reverse to a cancellation line or the item tracking code on the line.

Based on this entry, it then determines the transaction code that will be used on the reversal document. For more information on

how transaction codes for cancellation lines are determined, see On Canceling Lines.

Cancel on shipment

You can also use the Change Cancellation Qty. action to enter offset quantities on a shipment per document line. For more

information, see Undo Posted Shipments.

During posting, the shipped items are then automatically marked for application. The application entries are then used to

determine the transaction code on each line that should be canceled (see also On Canceling Lines).

On canceling lines

The transaction code that will be entered on a cancellation line is based on the type of movement that needs to be cancelled.

Movement type blank (Sale)

The following checks are performed to determine the code:

Link between return order line and application entry

A cancellation line is linked directly to an application entry if the item on the line isn’t tracked. The code specified for the item

(that is, application) entry is then filled in on the line as the transaction code and the stock adjustment code.

If a hierarchy is used on the original document line, the receipt entry that might have been specified together with a new transaction

code for the customer site will be canceled as well. See also Movement Hierarchies.

Link between tracking code and application entry

If the cancellation line contains a tracked item, the system checks the tracking lines associated with the cancellation line for a

link to an application (item) entry. If a link exists, the transaction code that is stored with the item ledger entry is copied as the

transaction code and the stock adjustment code to the relevant tracking line.

If no entry is linked to an item tracking line, the default transaction code that is used for positive adjustments is filled in instead.

If a hierarchy is used on the original document line, the receipt entry that might have been specified together with a new transaction

code for the customer site will be canceled as well. See also Movement Hierarchies.

No link

If an application entry isn’t linked to the relevant cancellation line (neither on the line itself or via item tracking), the default

transaction code used for positive adjustment is specified as the transaction code and the stock adjustment code.

Movement type Transfer

The following checks are performed to determine the code:

Link between cancellation line and application entry

Note

Note
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A cancellation line is linked directly to an application entry if the item on the line isn’t tracked. The code on the related item

ledger entry, as specified by the Transfer From field, is then filled in on the line as the transaction code and the stock adjustment

code.

Afterward, the system checks whether a hierarchy was used to post the associated shipment and if the transaction codes

specified for the Transfer From and Transfer To entries differ.

If they do but were valued in the same way, the code assigned to the Transfer From entry is entered as the new transaction code

on the cancellation line. This new code ensures that, for example, items that are transferred to a customer warehouse from

current assets and to which the Items to Capitalize transaction code is assigned are linked to the transaction code for current

assets again when they’re reversed.

Fixed assets that have been capitalized at a customer location will be reversed using the original transaction code.

Link between item tracking code and application entry

If the cancellation line contains a tracked item, the system checks the tracking lines associated with the cancellation line for a

link to the corresponding application (that is, item) entry. If a link exists, the transaction code is determined in the same way as

for the direct link between cancellation line and application entry.

No link

If an application entry isn’t linked to the relevant cancellation line (neither on the line itself or via item tracking), the default

transaction code used for positive adjustment is specified as the transaction code and the stock adjustment code.

On selecting tracking codes

When you choose an item tracking code, the system checks if the code matches the transaction code on the document line that is

being tracked. If it doesn’t, you see an error message.

Similarly, when you select a tracking code by using the Assist button in the Serial No. or Lot No. field on a page, the system

shows on the inventory overview only lines that are available and where the associated transaction code has been entered.

On Serial No. / Lot No. Info Cards

When you register the movement of an item that requires a lot or serial number, you can see in the Last Transaction Code field,

on the related Lot or Serial No. Info Card, the code that was entered for the most recent transaction.

When you post a transaction that includes moving inventory—such as during receipt, shipment, transfer, purchase, or sale—you

must fill in a transaction code. The code is then copied to the Lot or Serial No. Info Card that you posted the transaction for.

INTEGRATION WITH DOCUMENT MANAGEMENT

medtec365 Setup

On this page, you can specify the DMS settings that are required by MDR Document Management and other parts of the app, as

described in the following table.

Note
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DMS Integration

Field Description

IM Document Nos. Specify a number series that will be used to create entries in a DI-IM document.

DMS Resp. Center Description to follow.

Use printing with

image utils service

Turn on this toggle if you want to use the Print Portal service.

Every document that is printed with this service will be linked and archived in the system.

You can also set up event messages to customize the process.

Note:

Simultaneous use of ImageUtils printing and UniversalPrint is currently not possible.

Letterhead Available If the toggle is turned on, a letterhead has been stored in setup so that it can be printed on every

page of a main document.

Watermark on Main

Document

If the toggle is turned on, a watermark has been stored in setup so that it can be printed on every

page of a main document.

The standard watermark consists of the word Copy only. It is used to ensure that no originals are

reprinted from the archive.

Watermark on

Supporting Documents

If the toggle is turned on, a watermark has been stored in medtec365 Setup so that it can be

printed on each page of a supporting document.

Delete Log on Print An entry for the DMS print job is set up during preview, PDF creation, and printing. With the

toggle turned on, the entry is deleted when the job is completed without errors.

If an error occurs, the entry remains. We recommend you turn on the toggle for standard projects.

Otherwise, you will need to delete older entries manually.

Template Field for

Supporting Docs.

Specify the DMS template field that should be used to distinguish between printouts archived with

and without supporting documents. The default name of the field is FIXED ASSET.

Two entries are created in the archive when you use supporting documentation. One contains the

main document, the other the main and supporting documents, with the former containing an

empty template field and the latter a filled-in one.

You can fill in this field, for example, to attach an invoice from the DMS archive to payment

reminders without the system printing all documents assigned to the case.

Show Print Portal

Reports

Lists the reports that the Print Portal service is used for. Only these reports are then linked or

archived later.

Letterhead Used to import or delete your company’s letterhead template.

Watermark (Main) Used to import or delete the watermark for main documents.

Watermark

(Supplemental)

Used to import or delete the watermark for supporting documentation.
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Ribbon functions (Actions > DMS)

PrintPortal Reports

KUMACONNECT

Together, KUMAconnect ELO4BC and KUMAconnect Output Link provide you with an interface to integrate ELO2 Digital Office

(Professional and Enterprise) DMS/ECM into Microsoft Dynamics 365 Business Central1.

For this purpose, the ELO2 Integration Client has been added to multiple FactBoxes and pages so that you can run the program

in medtec365. You can then use drag & drop to archive the files and documents associated with the program.

The KUMAconnect Output Link also archives and transfers documents set up in the system, including confirmation notes and

invoices, to ELO2 DMS/ECM automatically.

All files and documents come equipped with corresponding metadata, and—thanks to the integration client—you can see them in

the ELO2 filing structure separated by business process or transaction.

Via a KUMAconnect solution added to ELO2 DMS/ECM, the system also makes use of state-of-the-art web services for exchanging

data.

Standard templates are provided as well. They contain the complete makeup of the integration client, the outgoing documents,

the metadata, and the archive structure, including references, with a permission management tool rounding off the package.

ELO2 is set up in the ELO2 Administration Console, where you can specify metadata, as well as storage and reference paths. You

can contact your ELO2 vendor for more information on how to set up the program.

You need a separate license before you can use KUMAconnect.

For general information about the feature, see KUMAconnect. This section only explains the additional pages, functions, and fields

available for the functionality in medtec365.

Setup DMS Setup

Before you can see the integration client fields and exchange data with the ELO2 archive, you need to set up the feature.

Choose the Search icon, enter DMS Setup, and then choose the related link.

Fill in the fields described in the following table.

Function Description

Show Print Portal

Reports

Lists the reports that the Print Portal service is used for. Only these reports are then linked or

archived later.

Letterhead Used to import or delete your company’s letterhead template.

Watermark (Main) Used to import or delete the watermark for main documents.

Watermark

(Supplemental)

Used to import or delete the watermark for supporting documentation.

Note

Note

1. 

2. 
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medtec365

For more general information, see DMS Setup. This section only explains the additional pages, functions, and fields available for the

functionality in medtec365.

Ribbon functions

Import DMS Template

Imports the ELO2 template specifications, making the template fields and values available in the system. See also Template.

Template

Shows the template that was copied by running the Import DMS Template function.

The information is read-only and cannot be changed in the app.

Document type

Used to store all possible values for a document type, making them available for selection elsewhere in the system (such as for

barcode reservation).

Assign folder options

Provides two settings that can be used for different document types, such as sales and purchase documents. One of the settings

lets you specify a folder for archiving based on the type of document you’re handling. The system determines what folder to use

by looking in the following areas, in that order:

Assign Folder Options

Field mapping

DMS Setup

With the help of the document type, you can also specify pages that ELO2 should be able to import more data from. What page is

picked by the system depends on how you filled in the following areas (in that order):

Assign Folder Options

Field mapping

Field mapping list

Specifies the field mappings that will be used for the integration client and API. For more information on how to set up a

mapping, click here.

Field mapping functions

Specifies the functions that can be run for the field mappings. With the help of event triggers, the functions can also be

customized.

Page table links

Used to enter default values on ODATA pages that are linked to the specified tables. The pages are used by ELO2 to import

medtec365 data independent of field mapping functions.

Field Description

Default

Template
Used to select the ELO2 configuration. Currently, the default configuration is KumaMed.

Default Folder Indicates where documents are stored unless otherwise specified via field mapping. On the KumaMed

template, the field is empty, as every document is stored at the top level.

Note

Note

1. 

2. 

3. 

1. 

2. 
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For more general information, see DMS Setup. This section only explains the additional pages, functions, and fields available for the

functionality in medtec365.

Field mappings

With these mappings, you can specify the fields that should be filled in or imported when data is exchanged through

KUMAconnect.

Note
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General

Field Description

Action Specify an action that should be run for the mapping.

Query

With this option, you can use the API, for example, to retrieve supporting documents from the DMS.

Archive

Lets you archive documents via the API by drag & drop.

Report

Allows archiving outgoing documents.

Template Specify a template for the mapping. Currently, KumaMed is the only template used. Other templates

can be added on request.

Folder Name Only shown if you choose Archive as the action.

The folder stores the DMS documents that you create. You can also specify subfolders here (such as

‘Sales/Other Documents’).

Currently, you do not need to enter a folder name on the template.

Folder Assigned If the toggle is turned on, a folder is assigned to the table that you want to map.

Table ID Specify the table that field mapping will have access to.

The fields of the table are then accessible on the mapping lines. For access to fields from another

table, you must create a field mapping function.

Table Name Shows the name of the table entered in the Table ID field.

Page ID Every exchange of data with KUMAconnect requires the transfer of a page through which ELO2 can

show additional data if needed or from which the program can open a record in medtec365.

The page can be linked to the mapped table via a folder or table-page assignment. Else, the drilldown

page from the table specifications will be used.

Page Name Shows the name of the page entered in the Page ID field.

Description Specify a description for the field mapping.

Default Table

Mapping

With the toggle turned on, this mapping will be used for the specified table and action when no other

mapping can be found.

There can only be one default mapping for each table and action.

Custom ELO2

Config

Specify whether archiving works as in the standard app or if a custom behavior was specified for the

mapped table in ELO2.

With the standard configuration in place, documents are automatically stored in a folder named after

the description in the Doc. Type field (for example, IM Document) when you archive them via the API.
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Field Mapping Lines

Bridge App DMS & ECM Interface

The Bridge app integrates the "DMS & ECM Interface" module into KUMAVISION medtec365. This section of the online help

describes the enhancements to the "DMS & ECM Interface" module and KUMAVISION medtec365.

The following adaptations relate to both the Microsoft1 SharePoint Online archive system type and Hyland Saperion[^6] ECM.

General Setup in medtec365 Factbox Documents

Field Description

Template Field Specify the field that the action is used on.

The value in this field is retrieved if you choose the Query action. If you choose Archive or

Report, you need to fill in the field within the DMS.

Business Central Field

No.

Here you can select a field from the specified table.

If you leave the field blank, you need to set up a mapping function or an Alternative Value.

Business Central Field

Caption

Shows the caption of the field.

Alternative Value Used if no Business Central Field No. is available. You can specify a mapping function or a value

here.

Read-

Only

The value in this field is retrieved from the ELO template2 (when the Import DMS Template

function is run).

Template fields marked as Read-Only cannot be used for mappings that the Archive or Report

action will be used on.

Required The value in this field is retrieved from the ELO template2 (when the Import DMS Template

function is run).

Template fields marked as Required are automatically inserted into mappings that the Archive

or Report action will be used on.
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The following pages have been extended with the document info box from the "DMS & ECM Interface" module:

Dispatch Orders

Posted Dispatch Orders

Inspection Equipment

Inspection Plan

Inspection Plan Version

Inspection Order

Inspection Order Archive

FMEA 

FMEA Archive

Claims 

Claims Archive

Complaints

Complaints Archive

Actions

Marketing Cockpit

MDR Documents

Visit Report

Issued Purch. Order Cnfrmn. Rmdr. 

Barcode Reservation

The "Mark barcode" action has been added to some pages for subsequent scanning of documents. This creates an entry in the

"DMS barcode" table. When calling up the function, the barcode on the document to be scanned must be entered and a document

type selected.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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The action is inserted on the following pages:
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Bank Account Card

Customer Card

Vendor Card

Item Card

Contact Card

Marketing Cockpit

Visit Report

Sales Quotes

Sales Order

Sales Credit Memos

Blanket Sales Orders

Sales Return Order

Sales Invoice

Sales Order Archive

Sales Quote Archive

Posted Sales Shipment

Posted Sales Invoices

Posted Sales Credit Memos

Posted Return Receipts

Purchase Quote

Purchase Order

Purchase Credit Memos

Purchase Invoices

Blanket Purchase Orders

Purchase Return Order

Purchase Quote Archives

Posted Purchase Receipts

Posted Purchase Invoices

Posted Purchase Credit Memos

Posted Return Shipments

Warehouse Receipts

Warehouse Shipment

Dispatch Orders

Service Orders

Service Order Archives

Service Quote Archives

Serial No. Information Card

Lot No. Information

Resource Card

FMEA 

FMEA Archive

Claims 

Claims Archive

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Complaints

Complaints Archive

Actions

MDR Documents

Routing

Routing Version

Production BOM

Production BOM Version

Firm Planned Prod. Orders

Released Production Orders

Finished Production Order

Specification of subdirectory for barcode marking

For manual barcode markups, a subdirectory can also be specified if this is stored in the storage definition for the corresponding

data record. When the scanned document is archived, the corresponding subdirectory is then added to the directory stored in the

filing definition.

Automatic creation of barcode earmarks

There is an input field for the barcode in KUMAVISION medtec365 on the following pages: 

Goods receipt 

Unposted purchase invoice 

Unposted purchase credit note

The field is used to enter a barcode that is applied to paper documents by the supplier (e.g. via a keyboard scanner) and then to

scan these paper documents at a later time. As these processes have already been booked in KUMAVISION medtec365 in the

meantime, the HC DMS/ECM Bridge creates a barcode flag for the booked document with the entered barcode when the above

document types are booked. The scanned document is then automatically assigned to the posted document.

Extension KUMAVISION medtec365 Setup

Fields have been added to the setup which can be used to store the name of the index field in the DMS/ECM. The HC-DMS/ECM

bridge provides a lookup for the fields so that the value can be selected.

Extension in DMS & ECM Interface Extension Document Filing Setup

The "Standard filing definition" field has been added to the document filing setup. A filing definition must be stored. The

document library is used from this filing definition to determine the page and library name if no filing definition can be

determined via the interface when archiving.

Customization autom. report archiving

Automatic report archiving" is only used in KUMAVISION medtec365 for the specification of filing definitions for reports. For this

reason, all fields except: Report ID, Report name and Filing definition code have been hidden.

Extension of filing definition

The filing definition has been extended by the field "Lfd. No." field. This sequential number is required because in KUMAVISION

medtec365 the filing definitions are addressed via an integer value.

The field is filled automatically when a new filing definition is created. In addition, you can use the function "Current file". Fill

serial numbers" function can also be used to subsequently fill in missing values.

Determining the filing definition

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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The filing definition is determined according to the following hierarchy: 

In the "Autom. report archiving" (table: KVSDMSAutoReportArchiving) it is checked whether an entry exists for the current

report and whether a filing definition is stored there. If so, this is used. This only applies to the archiving of reports. 

A filing definition with the switch "Only for background uploads"=yes is searched for using the standard functionality of the

DMS/ECM interface. 

A search is carried out using the standard functionality of the DMS/ECM interface, whereby the value of the "Only for

background uploads" switch is not taken into account.

Search definition extension

The search definition has been expanded to include the field "Lfd. No." field. This sequential number is required as the search

definitions are addressed via an integer value in KUMAVISION medtec365. The field is filled automatically when a new search

definition is created.

In addition, you can use the "Current" function. Fill serial numbers" function can also be used to subsequently fill in missing

values.

New functions for filing definitions Contact search debtor

For the tables: Sales Shipment Header, Sales Shipment Line, Sales Invoice Header, Sales Invoice Line, Sales Cr.Memo Header,

KVSMEDInfoRequestHeader and KVSMEDInfoRequestHeaderArchive, an assigned contact number is determined based on the

respective customer number in the data record on the business relationship for customers.

Vendor contact search

For the tables: Return Shipment Header, Purch. Inv. Header and Purch. Cr. Memo Hdr. tables, an assigned contact number is

determined based on the respective vendor number in the data record on the business relationship for vendors.

Contact Search

Using the table field with the field number 1, an attempt is made to determine a contact via the business relationship for

customers. If this is not possible, an attempt is made to determine the contact via the business relationships for vendors.

Original number

For the tables: Sales Header, Sales Shipment Header, Sales Invoice Header, the system checks whether the "Offer number" field

is filled. If so, this is returned. Otherwise, the content of the "Order number" field is returned. In the "Sales Invoice Header"

table, the content of the "No." field is returned if the order number is empty. Analogously for the tables: Purchase Header, Purch.

Rcpt. Header and Purch. Inv. header.

Docart

Based on the communication documents, the "eing. DMS document subtype" is returned.

Docart print

On the basis of the communication documents, the "exg. DMS document subtype" is returned.

Customizations for Microsoft SharePoint online archive system type DCM & ECM Interface Microsoft SharePoint Extension of filing

definition keywords

For correct formatting of date values, all entries in the "Formatting" field on the "Filing definition keywords" page must have the

value "Date" if they are set up as a date field in the DMS system. This ensures that the content of the field is formatted correctly

when archiving.

Further information can be found under "Filing definition of keywords - fields and information".

• 

• 

• 

1.2.9 medtec365

- 1218/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Customizations for Hyland Saperion ECM DMS & ECM Interface Hyland Saperion

You can find further information on the setup under "Document storage setup".

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

ELO, ELOprofessional, ELOenterprise, ELOoffice and ELO ECM-Suite are registered trademarks of ELO Digital Office GmbH in Germany
and/or and other countries. 

Field Description

Index field for the

archiving date

If an index field is specified here, it is filled with the current date for each archiving and thus

marked as the archiving date. If the first or last archive entry is searched for during the search, this

is also done via this index field.

Index fields area, file

and category

To map the folder structure of customers who used ECMBridge in a previous version, the

corresponding index fields must be specified here. The two-level folder structure is then created

here. Area is the top level and File is the second level. The complete folder structure is saved in

Category.

1. 

2. 
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1.3 Apps

1.3.1 KUMAVISION Applications

KUMAVISION provides numerous applications that can be implemented in addition to the individual industry solutions via the 

Microsoft App Source.

The use of the following applications is only possible with corresponding purchased licenses and their activation.

Additional Items

Advance Payment

Change Log Quick Access

Core

Credit-Check App powered by Creditsafe

DMS & ECM Interface

Electronic Data eXchange (EDX)

Electronic Data eXchange (EDX) AddOn Warehouse Management System (WMS)

GAEB Interface & Calculation

Item Costing

KUMAconnect

Power BI Sales Activator

Quality Management (QM)

Sales Order Status

Sanction Check

Split by Picking Area

Vendor Rating Management

Note

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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1.3.2 Additional Items

Overview

The Additional Items (Cross-Selling) app provides an easy way to assign additional items, spare parts, and services to your item

master data. For the assignment, various parameters can be considered and defined:

When you create a document, the additional item or service might be displayed as mandatory or optional.

Define a fixed quantity for quantity calculation or specify the quantity to be output automatically based on a factor applied to

the selected main item (including quantity rounding setting).

Automatic generation of cross-selling references including the specification of a minimum quantity

Introduction

Additional Items | KUMAVISION App from KUMAVISION on Vimeo.

Get KUMAVISION Additional Items from Microsoft AppSource

Setup

ADDITIONAL ITEMS SETUP

First, specify some basic settings for the Additional Items app. This is done on the Additional Items Setup card. The following

fields are available on the setup card:

Additional Items FastTab

SPECIFY ADDITIONAL ITEMS

Additional items can be specified on the Item Card of the base item. If desired, configure the additional items per variant.

To do so, first open the Item List via the Tell Me function. Then, open the desired base item.

• 

• 

• 

Field Description

Max. Number of Cross-Ref. Hits Specifies the maximum number of additional items to be created automatically.

Min. Number of Cross-Ref. Hits Specifies the minimum number of relations required for automatic item creation.

Open Page for Additional Items

Automatically

Specifies if the list of additional items should be opened automatically.

Insert Mandatory Additional Items

Automatically

Specifies if additional items that are marked as mandatory should be inserted

automatically.

Sales Document Type Filter Specifies the types of documents that the item list should be opened for or that the

additional items should be entered on automatically.

If this field blank is left blank, both processes will be used for all document types.

Purchase Document Type Filter Specifies the types of documents that the item list should be opened for or that the

additional items should be entered on automatically.

If this field blank is left blank, both processes will be used for all document types.
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On the ribbon, select Related > Item > Additional Items to specify the additional item for the base item. The table contains the

following fields:

Once the base item is added to a document (e.g., quote or purchase order), an overview card displays, showing the configured

additional items. Depending on the configuration, these can be adapted and then copied to the document.

Field Description

Type In the Type field, specify the type of the line. The following options are available:

• G/L Account, 

• Item, 

• Resource, 

• Fixed Asset

• Surcharge (Item)

No. Depending on the setting in the Type field, you can select the number of the corresponding line here 

(item number, resource no., …)

Variant Code Displays the variant of the item in the corresponding line, depending on the contents of the Type and

No. fields.

Description Once you select a number, the system automatically populates the description, which is not editable.

Sales By enabling this checkbox, you can specify that the corresponding line will be used in sales documents.

If this line is to be used for purchases only, disable this checkbox. The lines will be filtered accordingly

when displayed later on the overview card during document input.

Sales Sequence

No.

You can define a sequence for the additional item in Sales.

Purchase By enabling this checkbox, you can specify that the corresponding line will be used in purchase

documents. If this line is to be used for sales only, disable this checkbox. The lines will be filtered

accordingly when displayed later on the overview card during document input.

Purch. Sequence

No.

You can define a sequence for the additional item in Purchase.

Mandatory

(Sales)

Using this field, you can control whether the cross-reference item is selectable or is used automatically

in Sales documents.

Mandatory

(Purchase)

Using this field, you can control whether the cross-reference item is selectable or is used automatically

in Purchase documents.

Qty. Calculation This field defines whether the quantity is calculated using a factor applied to the quantity from the

document or specified as a fixed quantity.

Qty. / Factor Depending on the setting of the Qty. Calculation field, you can enter a factor or a fixed quantity.

Qty. Rounding Specifies whether the quantity should be rounded.

Qty. Rounding

Type

Specifies how the quantity should be rounded.

Sales UOM In addition to the Sales unit of measure and the unit of measure of the base item, you can define other

Sales units of measure.

Purch. UOM In addition to the Purchase unit of measure and the unit of measure of the base item, you can define

other Purchase units of measure.

Automatically

created

Using this field, you can control whether the additional item is created automatically or manually by the

user.
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Use additional items in your processes

Now, you can use the configured base item in your processes. To do so, create a new sales / purchase document.

The following example illustrates this using a customer order:

First, create a new sales order by entering any required information on the General tab. Then, enter an item line for the

configured base item. After verification of the desired quantity, the system opens an overview card with the configured additional

item lines.

If you change the quantity of the base item, the overview card with the configured, updated additional items will be redisplayed.

If you delete the base item from the document, the system will prompt you to confirm that the related lines should also be

removed.

You can add the associated items later by selecting Line > Functions> Select Additional Items.

Generate additional items automatically

The Generation of Additional Items report can be used to assign additional items to an item automatically.

This is only possible if you maintained the Max. Number of Cross-Ref. Hits and Min. Number of Cross-Ref. Hits on the Additional

Items Setup card.

To use this feature, open the Generation of Additional Items report via the Tell Me function.

A filtering screen opens where you can specify the following filters:

When this report is run, all additional item lines where the Automatically Created field is selected will be deleted and then

recreated as follows:

The system evaluates the sales and purchasing history to determine the number of combination sales / purchases. If the number

of hits exceeds the value specified in Additional Items Setup, respective entries will be generated in the Additional Items table.

The number of entries generated can be restricted by setting the value of Max. Number of Cross-Ref. Hits as desired.

What happens after the free trial has expired?

What happens after the free trial? from KUMAVISION on Vimeo.

Note

Field Description

From Date / To

Date

Select a period for the generation of combination sales / purchases.

Direction Specify the direction for which the system should check the combinations. The following options are

available: 

• Sales

• Purchase

• Sales and Purchase

No. Specify the number of a (base) item for which the system should evaluate the combination sales /

purchases.

1.3.2 Additional Items

- 1223/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://vimeo.com/630099904
https://vimeo.com/kumavision
https://vimeo.com


1.3.3 Advance Payment

General

The "Advance Payment" application is a special ISV solution based on Microsoft Dynamics 365 Business Central1. This is a

special function extension of the standard solution Microsoft Dynamics 365 Business Central1. It enables you to manage down

payments in sales and purchasing correctly and reliably in accordance with legal requirements.

Link to Microsoft App Source "KUMAVISION Advance Payment"

APPLICATION AREAS

The Advance Payment application enables the planning, creation and management of down payment invoices in the sales and

purchasing area. Based on orders or purchase orders, all relevant documents and postings can be created and tracked via so-

called down payment strings. Down payment accounting is completely integrated into standard processes, e.g. down payment

invoices can flow into the dunning process and payment transactions. Data is entered and managed using the standard interfaces

and documents. Down payment strings can be managed and analyzed centrally via new menu items.

OVERVIEW

The Advance Payment application can be used in both sales and purchasing.

The down payment string forms the basis for the down payments. It specifies the business transaction for which down payments

are to be made and posted. In sales, the basis for a down payment string is either the order, an individual order line or even a

project; in purchasing, it is the purchase order or an individual order line.

A down payment plan can be stored for each down payment strand, in which it is defined at which time and in which amount

down payments and final invoices are to be made.

Requested down payments are posted as down payment invoices. As no sales tax / input tax may be reported at this point in time,

down payment invoices are posted with unrealized tax. Only when the payment is received is the tax realized and the requested

down payments transferred to down payments received / made.

Receivables or payables from advance payments made are also shown in separate accounts so that they can be presented

separately from actual receivables and payables.

Corrections to requested down payments can be posted using down payment credit memos.

With the invoice of the order / purchase order requested and made / received down payments can be cleared. A final invoice

deduction can be created and posted automatically.

The current status of the transactions can be viewed at any time via the down payment strings. Detailed down payment statistics

provide information on all related postings. Special views on the customer / vendor items allow to view the open or not final

invoiced amounts for each down payment.

Establishment

To use the application, some setups must be made. In this section you will learn what they are and how to configure them.

DOWN PAYMENT FACILITY

If the Advance Payment application is to be used, it must first be activated for the sales and purchasing areas. Only then will all

relevant fields and buttons be displayed in the existing interfaces, and new menu items will be offered for selection. Activation is

made in the down payment facility.

In addition, it shows which installations have already been completed or are still to be carried out.

Inforegister General

Field Description Sale active Indicates whether the down payment functionalities are enabled for the sales documents.

Purchasing active Indicates whether the down payment functionalities are enabled for the purchasing documents.
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Inforegister settings

Inforegister facilities completed

This info tab gives you an overview of which relevant areas have already been set up or have not yet been set up.

Support information

On this info tab you will be presented with information about the app.

Menu call "Manual setup

The Manual setup button can be used to branch to the relevant setup tables. These are described in more detail in the following

sections.

G/L ACCOUNTS AND POSTING GROUPS

Financial accounting facility

Down payment invoice must be posted with unrealized tax. This means that the tax is not due until the payment is received.

In order for this situation to be taken into account, the fields "Unrealized VAT" and "Unrealized VAT Prepayment" must be

activated in the financial accounting setup. Prepayment" fields must be activated on the "General" information tab.

Accounts Receivable / Accounts Payable Groups

The collective accounts for down payments and the accounts for unrealized down payments must be defined in the customer /

vendor posting groups:

Customer posting groups

Field Description

Allow directly

realized tax

Specifies whether down payment invoices can be posted with directly realized VAT, depending on the

setting in the VAT posting matrix setup. Without this setting, all down payment invoices must be

posted with unrealized VAT.

Field Description

Deb. Collective account

down payments

Specifies the G/L account to be used when posting receivables from customer down payment

documents in this posting group.

Corresponds to the customer collective account for receivables from standard documents.

Deb. Unrealized

prepayments

Specifies the G/L account to be used for postings in down payment documents for requested

down payments from customers in this posting group. This account is automatically proposed

when creating down payment documents.

Since the account is used in the down payment documents in the line items, the account must be

directly postable (Direct to G/L account field). In addition, the G/L account must show a VAT

product posting group with unrealized VAT.

When posting the payment clearing for a down payment document, unrealized down payments

and tax are transferred to the accounts for realized down payments and tax. The account for

Real. Down payments is stored in the VAT posting matrix.

For more information on how to set up the VAT posting matrix and the real. Accounts can be

found in the section "VAT product posting groups and VAT posting matrix“.
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Vendor posting groups

VAT product posting groups and VAT posting matrix

For the correct tax treatment of down payment documents, new VAT product posting groups must be created, with which new

rows for unrealized VAT treatment will be added to the VAT posting matrix.

A separate VAT product posting group should also be created for the transfer of unrealized down payments to down payments

received / paid.

Example of new VAT product posting groups:

The VAT product posting group AZ19 is used for postings with the Unreal. Down payment account (see Accounts Receivable/

Vendor Posting Group). The REAL_AZ19 posting group is used for down payment transfer postings.

Example of VAT posting matrix setup:

Field Description

Kred. Collective

account down payments

Specifies the G/L account to be used when posting payables from down payment documents from

vendors in this posting group. Corresponds to the vendor general ledger account for payables

from standard documents.

Credit. Unrealized

prepayments

Specifies the G/L account to be used when posting to down payment documents for requested

down payments from vendors in this posting group. This account is automatically proposed when

creating down payment documents.

Since the account is used in the down payment documents in the line items, the account must be

directly postable (Direct to G/L account field). In addition, the G/L account must show a VAT

product posting group with unrealized VAT.

When posting the payment clearing for a down payment document, unrealized down payments

and tax are transferred to the accounts for realized down payments and tax. The account for

Real. Down payments is stored in the VAT posting matrix.

For more information on how to set up the VAT posting matrix and the real. Accounts can be

found in the section "VAT product posting groups and VAT posting matrix".

Code Description

AZ19 Unr. down payments 19%

REAL_AZ19 Real. Down payments 19%
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In the VAT statement, the New Combinations for unrealized tax from the VAT posting matrix must be included.

Non-deductible VAT

For the processing of "Non-deductible VAT" the following settings in the VAT. Posting matrix to be taken into account.

In the rows for the calculation "Unreal. VAT." (Field: "Unreal. VAT Type" = percentage) the following settings must be made:

The "Non-deductible VAT %" field must be filled with the value "0" (also not allowed in Microsoft Dynamics 365 Business

Central1 Standard).

In the field "Non-deductible VAT. Purchase account" no account must be set up.

In the "Allow non-deductible VAT" field, the "Allow" option must be set.

From the rows with the "VAT. Business entry groups" and the "VAT. Product posting groups" that are transferred to the purchase

orders, the "Non-deductible VAT %" is transferred to the down payment plan line via the purchase order lines and from there to the

down payment invoice.

ADVANCE PLAN TEMPLATE

To simplify the management of down advance plan, down advance plan templates can be set up.

Field Description

Deb. Real. Down payment

account

Specifies the G/L account that is addressed when posting the payment of a down payment

invoice in sales. When clearing a down payment invoice, the unrealized down payment amount

is transferred to the realized down payment account. In the case of partial payments, this is

done accordingly on a pro rata basis.

The account is found via the VAT combination of the down payment invoice line. This account is

also needed to create the final invoice deduction lines.

Kred. Real. Down

payment account

Specifies the G/L account that is addressed when posting the payment of a down payment

invoice in Purchasing. When clearing a down payment invoice, the unrealized down payment

amount is transferred to the realized down payment account. In the case of partial payments,

this is done proportionally.

The account is found via the VAT combination of the down payment invoice line. This account is

also needed to create the final invoice deduction lines.

VAT product posting

group down payment

realizations

Specifies the VAT product posting group that will be used for the realized down payment

account when the payment is received and when the final invoice is deducted. If this field is

empty, the VAT product posting group of the Real. Down payment account is entered.

Note

• 

• 

• 

Note
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Based on the fields from the customer or vendor master and the documents, criteria can be defined when a down advance plan

template should be used.

Any number of down advance plan lines can be defined per down advance plan template.

The lines of a down advance plan template can be inserted in the down advance plan by a function call. A list of available

templates is displayed. 

The call for editing the advance plan templates is made via the call with the same name via the user search. A new down advance

plan template can be created via "New" in the menu ribbon. 

Inforegister General

Field Description

Code Indicates the unique code of the down advance plan template.

Description Indicates a freely definable description for the down advance plan template.

Active Indicates whether this down advance plan template is currently enabled for use.

Source Account

Type

Indicates whether this template is intended for use with accounts payable or accounts receivable

down payments.

Source Account

Filter

Specifies a filter to narrow down for which customers/vendors this down advance plan template

should be used.

For Table ID Specifies the ID of the table for which this down advance plan template is to be used.

For Table Caption Specifies the caption of the table for which this down advance plan template should be used.

Table Filters Specifies a filter to narrow down for which records this down advance plan template should be used.
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Inforegister Lines

RETENTION SETUP

To map withholdings in the down payment accounting, the types of withholdings are to be set up. You can call up the

"Retentions" by means of the search term of the same name via the user search.

Field Description

Planning type Indicates what type of down payment plan line it is. It can be a planned down

payment or a final invoice

Invoice Date Formula Indicates the scheduled date for creating and posting an invoice using a date

formula. The date formula is added to the start date/document date of the

down payment string to determine the respective invoice date.

Part Amount % Indicates the percentage of the base amount to be settled with this down

payment plan line.

Payment Amount Indicates the amount to be invoiced with this down payment plan line.

Cum. Percentage Amount Indicates the cumulative percentage of the base amount to be invoiced with the

down payment plan lines. This amount includes all previous down payment

plan lines.

This field is only displayed if the "Cumulative down payment planning"

parameter is enabled in the "Accounts Receivable & Sales Setup" or "Accounts

Payable & Purchasing Setup"

Automatic cancellation of previous AZ

invoices in case of cumulative down

payment. Down Payment

Indicates the cumulative amount to be settled with the down payment plan

lines. This amount includes all previous down payment plan lines.

This field is only displayed if the "Cumulative Down Payment Planning"

parameter is enabled in the "Accounts Receivable and Sales Setup" or

"Accounts Payable & Purchasing Setup"

Down payment condition code Indicates the payment condition on which this down payment plan line is

based.

Description Indicates an optional, freely definable description for this down payment plan

line. This will be used in the documents generated from it.
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The fields of the withholdings are explained in detail below:

About the menu item "Dimensions" can be stored per retention, default dimensions.

Via the menu item "Translations", translations for the fields "Description" and "Description 2" can be managed for the illustration

of multilingual vouchers.

field description

Code Indicates a unique code for the withholding.

Description Indicates a description for the withholding, which will be shown in the documents.

Description 2 Indicates an additional description for the retention, which will be shown in the documents.

Supported account types This is an option field. It specifies whether the retention can be used in the purchase and/or

sales documents.

The following selection options are available:

- Customer

- Vendor

- Both

Supported Document

Types

This is an option field. It specifies whether to use retention for down payment invoices and/or

regular invoices (no down payment invoices).

The following selection options are available:

- Down payment invoices,

- Regular invoices,

- Both

Suffix for Withholding

Invoice Numbers

Specifies a suffix to be added to the invoice number to generate the invoice number for

withholding documents.

Withholding Payment

Condition

Specifies a payment condition that will be used for the generated withholding documents.

Wait for Withholding

Invoice

Specifies whether a wait flag should be automatically attached to the generated withholding

document to exclude it from the payment processes.

Unrealized Account Specifies a G/L account to which the retention amounts of down payment invoices should be

posted. For regular invoices, the specification is made in the "Realized Account" field.

Realized Account Specifies a G/L account to which retentions from regular invoices will be posted.

Note:

For down payment invoice payments, this account will also be used.

1.3.3 Advance Payment

- 1230/1545 - Copyright © 2018 - 2024 KUMAVISION AG



DEBIT FACILITIES

Accounts Receivable & Sales Facility

In the Accounts Receivable & Sales setup the basic settings for down payments in sales are made. All necessary parameters and

defaults are set on the "Down payment" info tab. These are explained in more detail in the table below:
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Field Description

Geb. Down Payment Invoice

Numbers

Specifies the number series used when posting down payment invoices for the posted

documents.

Geb. Down payment credit

memo numbers

Specifies the number series used when posting down payment credits for the posted

documents.

Geb. final invoice deduction

numbers

Specifies the number series used when posting final invoice deductions for the posted

documents.

Document No. Allocation

Final Invoice Deduction

Reversal

Specifies whether either the document number of the posted final invoice deduction

supplemented by a suffix (Suffix option) or a separate document number series (Number

series option) should be used as the document number when reversing final invoice

deductions.

Reversal of final invoice

deduction Document no.

supplement

Specifies the suffix to be added to the document no. of the posted final invoice deduction

during reversal.

Reversal final invoice

deduction number series

Specifies the number series of the unposted invoice document for the cancellation of the final

invoice deduction.

Geb. final invoice deduction

cancellation numbers

Specifies the number series for the posted invoice document for the cancellation of the final

invoice deduction.

Down payment document

description

Specifies the name that will be displayed on printed down payment invoices and credit

memos.

Automatic creation of AZ

strings for orders

Specifies whether to automatically create down payment strings for the documents when

creating orders.

Message No. amount

greater than base amount

Specifies whether a message should be issued when creating down payment invoices if the

sum of the down payments made exceeds the order total.

Compare Invoice Amount

with Adv. Plan

Specifies, when posting the down payment invoice, whether to compare the amount of a

down payment invoice with the respective down payment plan.

The following selection options are available:

blank

no changes. 

Update Advance Plan

When posting an invoice, all down payment plan lines contained in it will be updated with the

respective amounts from the invoice.

Error on deviation between Plan and Invoice

When posting an invoice, the system checks if it is for the same amount as the down payment

plan. If this is not the case, an error message appears and the posting is stopped.

If the parameter "Plan down payment amounts cumulatively" is set, the setting "Match

invoice amount with down payment plan when posting" is automatically set to "Update AZ

plan" and cannot be changed.

Release required for down

payment plan rows

Indicates whether down payment plan rows in the down payment plan must be marked as

released before they can be transferred to an invoice.

If the parameter is activated, the columns "Technical release" and "Release by" are displayed

in the down payment plan rows and down payment invoices can only be created if the release

in the column "Technical release" has been made by activation. 

When the parameter is activated, in the "Accountant" role center, in addition to the "Planned
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Field Description

down payments" tiles, released down payments are also displayed in the "Released down

payments" tile.

Cumulative down payment

planning

Specifies whether amounts in the down payment plan should be specified in cumulative form 

(including all previous down payments) or in non-cumulative form (only the respective

invoice amount).

If the parameter is activated, the columns "Cum. Proportion Amount %" and "Cum. Anz.

Amount" are displayed.

The column "Cum. Anz. Amount" can be filled manually. In this case, the system calculates

the "Down payment amount" column. Alternatively, the "Down payment amount" column can

be filled in the other way round, so that the system calculates the "Cum. The system

calculates the "Cumulative down payment amount". Basis for the reciprocal calculations are

all other down payment plan lines with a date smaller than that of the current line.

If a down payment invoice is created from the down payment plan, the "Down payment

amount" is automatically updated. For this, the system subtracts from the "Cum. Anz.-

Amount" the invoice amounts posted so far, which have not been cancelled.

Automatic Reversal of

Previous Down Payment

Invoices for Cumulative

Down Payment

Specifies whether posting a cumulative down payment invoice automatically reverses all

previous unpaid down payment invoices. Down payment

Final invoice for down

payment invoices

Use this parameter to specify whether only the down payment invoices already paid by the

customer (Paid option) or all down payment invoices (All option) should be taken into account

for clearing during a final invoice deduction.

If the option "All" is set, then not only the down payment invoices already paid by the

customer, but all down payment invoices will be taken into account in the final invoice

deduction. In this case, the down payment invoices that have not been paid yet will not be

cleared via a credit note, but with a later incoming payment that clears open down payment

invoices and final invoice.

If the "Paid" option is selected, only down payment invoices that have already been paid will

be included in the final invoice deduction.

Automated posting of final

invoices

This parameter sets the automatic posting of the final invoice deduction. When a final invoice

with order reference is posted, the system checks if there are any down payment invoices

that have not been settled yet. Depending on the parameter setting, the system can create a

final invoice deduction (Create option) or create and post it directly (Create+Post option).

If no automatic creation (and posting) of a final invoice deduction is to take place, this field

remains empty.

Final invoice for several AZ

strands

This parameter is used to control how to proceed if the parameter Autom. posting of final

invoices is set to Create or Create+Post and several down payment strings are included in

the final invoice.

If no final invoice deduction is to be created, the "No final invoice" option must be selected.

The "Error message" option means that the normal invoice posting will stop with a

corresponding error message.

The "Post final invoice" option specifies that the final invoice deduction will be handled as

defined via the Autom. posting of final invoices parameter.

Automatic posting of

remaining amount credits

This parameter defines how to proceed with the down payment invoices that have not been

paid. 

The prerequisite for this parameter is that Autom. posting of final invoices has been set to

Create or Create+Post.
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Debtor

Further additional settings can be made on the customer card on the "Invoicing" info tab. These then apply specifically to this

one customer.

Field Description

The Create or Create+Post options define whether down payment credit memos will be

created for the unpaid or only partially paid down payment invoices and eventually posted

automatically.

If it has been defined in Final Invoice for Down Payment Invoices that all down payment

invoices will be retrieved to the final invoice deduction, the creation of realized invoices may

still be triggered when posting the down payment credit memo (see Autom. Posting of

Realization Invoices).

Final invoice deduction

max. in the amount of the

invoice

Specifies whether the final invoice deduction should be limited to the amount of the final

invoice.

If the received down payments exceed the final invoice amount, this setting makes it possible

to create credit notes later for overpayments.

Voucher No. Allocation

Realization Invoices

Specifies whether to use either the document number of the posted down payment invoice

supplemented by a suffix (Suffix option) or a separate document number series (Number

series option) as the document number when posting realization invoices.

Real. Invoice document no.

suffix

Specifies the suffix to be added to the document no. of the posted down payment invoice

during the realization posting.

Real. Invoice numbers Specifies the number series of the unposted invoice document for the realization posting.

Geb. realization invoice

numbers

Specifies the number series for the posted invoice document for the realization posting.

Max. Credit amount of

overpayments

Specifies the maximum amount for which credit memos can be automatically created for

overpayments.

Document No. Allocation of

Overpayment Credits

Specifies whether to use either the document no. of the posted down payment invoice

supplemented by a suffix (Suffix option) or a separate document no. series (Number series

option) when posting credit memos for overpayments.

Overpayment credit memo

document no.

suffix Specifies the suffix to be added to the document no. of the posted down payment

invoice during the realization posting.

Overpayment credit memo

numbers

Specifies the number series of the unposted credit memo for the overpayment.

Geb. Overpayment credit

memo numbers

Specifies the number series for the posted credit voucher for the overpayment.

Field Description

Cumulative

prepayments

Specifies whether to create down payments as cumulative invoices for this customer. In case of

cumulative down payment invoices, down payments already made will be included in new

invoices.

Down payments at

document line level

Specifies whether down payments are to be created for this customer on the basis of the entire

order or individual order items. If this parameter is set, down payments and final invoices with

final invoice deduction can be created for individual document lines.
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CREDIT FACILITIES

Accounts Payable & Purchasing Setup

In the Accounts Payable & Purchasing setup the basic settings for down payments in purchasing are made. All necessary

parameters and defaults are set on the "Down payment" info tab. These are explained in more detail in the table below:
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- 1235/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Field Description

Geb. Down Payment Invoice

Numbers

Specifies the number series used when posting down payment invoices for the posted

documents.

Geb. Down payment credit

memo numbers

Specifies the number series used when posting down payment credits for the posted

documents.

Geb. final invoice deduction

numbers

Specifies the number series used when posting final invoice deductions for the posted

documents.

Document No. Allocation

Final Invoice Deduction

Reversal

Specifies whether either the document number of the posted final invoice deduction

supplemented by a suffix (Suffix option) or a separate document number series (Number

series option) should be used as the document number when reversing final invoice

deductions.

Reversal of final invoice

deduction Document no.

supplement

Specifies the suffix to be added to the document no. of the posted final invoice deduction

during reversal.

Reversal final invoice

deduction number series

Specifies the number series of the unposted invoice document for the cancellation of the final

invoice deduction.

Geb. final invoice deduction

cancellation numbers

Specifies the number series for the posted invoice document for the cancellation of the final

invoice deduction.

Down payment document

description

Specifies the name that will be displayed on printed down payment invoices and credit

memos.

Automatic creation of AZ

strings for orders

Specifies whether to automatically create down payment strings for the documents when

creating purchase orders.

Message No. amount

greater than base amount

Specifies whether a message should be issued when creating down payment invoices if the

sum of the down payments made exceeds the order total.

Compare Invoice Amount

with Adv. Plan

Specifies, when posting the down payment invoice, whether to compare the amount of a

down payment invoice with the respective down payment plan.

The following selection options are available:

blank

no changes. 

Update advance plan

When posting an invoice, all down payment plan lines contained in it will be updated with the

respective amounts from the invoice.

Error on deviation between Plan an Invoice

When posting an invoice, the system checks if it is for the same amount as the down payment

plan. If this is not the case, an error message appears and the posting is stopped.

If the parameter "Plan down payment amounts cumulatively" is set, the setting "Match

invoice amount with down payment plan when posting" is automatically set to "Update AZ

plan" and cannot be changed.

Release required for down

payment plan rows

Indicates whether down payment plan rows in the down payment plan must be marked as

released before they can be transferred to an invoice.

If the parameter is activated, the columns "Technical release" and "Release by" are displayed

in the down payment plan rows and down payment invoices can only be created if the release

in the column "Technical release" has been made by activation. 

When the parameter is activated, in the "Accountant" role center, in addition to the "Planned
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Field Description

down payments" tiles, released down payments are also displayed in the "Released down

payments" tile.

Cumulative down payment

planning

Specifies whether amounts in the down payment plan should be specified in cumulative form 

(including all previous down payments) or in non-cumulative form (only the respective

invoice amount).

If the parameter is activated, the columns "Cum. Proportion Amount %" and "Cum. Anz.

Amount" are displayed.

The column "Cum. Anz. Amount" can be filled manually. In this case, the system calculates

the "Down payment amount" column. Alternatively, the "Down payment amount" column can

be filled in the other way round, so that the system calculates the "Cum. The system

calculates the "Cumulative down payment amount". Basis for the reciprocal calculations are

all other down payment plan lines with a date smaller than that of the current line.

If a down payment invoice is created from the down payment plan, the "Down payment

amount" is automatically updated. For this, the system subtracts from the "Cum. Anz.-

Amount" the invoice amounts posted so far, which have not been cancelled.

Automatic Reversal of

Previous Down Payment

Invoices for Cumulative

Down Payment

Specifies whether posting a cumulative down payment invoice automatically reverses all

previous unpaid down payment invoices. Down payment

Final invoice for down

payment invoices

Use this parameter to specify whether only the down payment invoices already paid to the

vendor (Paid option) or all down payment invoices (All option) should be taken into account

for clearing during a final invoice deduction.

If the option "All" is set, then not only the down payment invoices already paid to the vendor,

but all down payment invoices will be taken into account in the final invoice deduction. In

this case, the down payment invoices that have not been paid yet will not be cleared via a

credit note, but with a later incoming payment that clears open down payment invoices and

final invoice.

If the "Paid" option is selected, only down payment invoices that have already been paid will

be included in the final invoice deduction.

Automated posting of final

invoices

This parameter sets the automatic posting of the final invoice deduction. When a final invoice

with order reference is posted, the system checks if there are any down payment invoices

that have not been settled yet. Depending on the parameter setting, the system can create a

final invoice deduction (Create option) or create and post it directly (Create+Post option).

If no automatic creation (and posting) of a final invoice deduction is to take place, this field

remains empty.

Final invoice for several AZ

strands

This parameter is used to control how to proceed if the parameter Autom. posting of final

invoices is set to Create or Create+Post and several down payment strings are included in

the final invoice.

If no final invoice deduction is to be created, the No final invoice option must be selected.

The Error message option means that the normal invoice posting will stop with a

corresponding error message.

The Post final invoice option specifies that the final invoice deduction will be handled as

defined via the Autom. posting of final invoices parameter.

Automatic posting of

remaining amount credits

This parameter defines how to proceed with the down payment invoices that have not been

paid.

The prerequisite for this parameter is that Autom. posting of final invoices has been set to

Create or Create+Post.
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Vendor

Further additional settings can be made on the vendor card on the "Invoicing" info tab. These then apply specifically to this one

vendor.

Field Description

The Create or Create+Post options define whether down payment credit memos will be

created for the unpaid or only partially paid down payment invoices and eventually posted

automatically.

If it has been defined in Final Invoice for Down Payment Invoices that all down payment

invoices will be retrieved to the final invoice deduction, the creation of realized invoices may

still be triggered when posting the down payment credit memo (see Autom. Posting of

Realization Invoices).

Final invoice deduction

max. in the amount of the

invoice

Specifies whether the final invoice deduction should be limited to the amount of the final

invoice.

If the down payments made exceed the final invoice amount, this setting makes it possible to

create credit notes later for overpayments.

Voucher No. Allocation

Realization Invoices

Specifies whether to use either the document number of the posted down payment invoice

supplemented by a suffix (Suffix option) or a separate document number series (Number

series option) as the document number when posting realization invoices.

Real. Invoice document no.

suffix

Specifies the suffix to be added to the document no. of the posted down payment invoice

during the realization posting.

Real. Invoice numbers Specifies the number series of the unposted invoice document for the realization posting.

Geb. realization invoice

numbers

Specifies the number series for the posted invoice document for the realization posting.

Max. Credit amount of

overpayments

Specifies the maximum amount for which credit memos can be automatically created for

overpayments.

Document No. Allocation of Overpayment Credits Specifies whether to use either the document no. of the

posted down payment invoice supplemented by a suffix (Suffix option) or a separate

document no. series (Number series option) when posting credit memos for overpayments.

Overpayment credit memo

document no. suffix

Specifies the suffix to be added to the document no. of the posted down payment invoice

during the realization posting.

Overpayment credit memo

numbers

Specifies the number series of the unposted credit memo for the overpayment.

Geb. Overpayment credit

memo numbers

Specifies the number series for the posted credit voucher for the overpayment.

Field Description

Cumulative

prepayments

Specifies whether to create down payments as cumulative invoices for this vendor. In case of

cumulative down payment invoices, down payments already made will be included in new invoices.

Down payments at

document line level

Specifies whether down payments are to be created for this vendor based on the entire purchase

order or individual purchase order items. If this parameter is set, down payments and final

invoices with final invoice deduction can be created for individual document lines.
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CASH FLOW SETUP

Posted down payment documents and down payment plans may not be included in the cash flow accounts of regular receivables

and payables, but must be shown in separate cash flow accounts. For this purpose, the following cash flow accounts must be

defined in the "Cash Flow Setup":

ORIGIN CODES

Separate origin codes can be set up for down payment accounting documents in the "Origin code setup".

REPORT SELECTION

For down payment accounting, you can use your own documents, which must be entered accordingly in the report selection for

sales and purchasing.

The following reports can be used for sales:

The following reports can be used for purchasing:

Field Description

Adv. Receivables CF Account No. Specifies the account number to be used for receivables by down payment documents.

Sales Order Advance Plan CF

Account No.

Specifies the account number to be used for sales order down payment schedules.

Adv. Payables CF Account No. Specifies the account number to be used for payables by down payment documents.

Purchase Order Advance Plan CF

Account No.

Specifies the account number to be used for purchasing purchase order down

payment plans.

Project Down Payment Plans -

Cash Flow Account No.

Specifies the account number to be used for project down payment plans.

Note

Analogous to "Project - Cash Flow Account No.", a net representation of amounts is

also made on the "Project Down Payment Plans - Cash Flow Account.

Field Description

Sales down payments Specifies the code associated with items posted in connection with down payment invoices and

down payment credit memos in sales.

Purchasing down

payments

Specifies the code associated with items posted in connection with down payment invoices and

down payment credit memos in Purchasing.

Usage Report ID Report name

Down payment invoice 1306 Sale - Invoice

Down payment credit 1307 Sale - credit note

Final invoice deduction 70260236 Sale - Final Invoice

Usage Report ID Report name

Down payment invoice 406 Purchase - Invoice

Down payment credit 407 Purchase - credit note

Final invoice deduction 70260267 Purchasing - final invoice
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Down payment strands

The down payment string forms the basis of down payment accounting. In the standard system, down payment strings can be

created for the following sources:

Sell orders

Sales order lines

Projects (sales side)

Purchase orders

Purchase order lines

As described in the setup, down payment strings can be generated automatically with the new creation of documents. If the

parameter "Automatic creation of AZ strings for orders" is set in the Accounts Receivable & Sales setup (or "Automatic creation

of AZ strings for orders" in the Accounts Payable & Purchasing setup), a down payment string will be created when creating a

new document (or a new document line - setting per customer or vendor in the field "Down payments on document line level").

You can call up the down payment strings via the user search using the search term of the same name. 

• 

• 

• 

• 

• 

1.3.3 Advance Payment

- 1240/1545 - Copyright © 2018 - 2024 KUMAVISION AG



In the following, the fields from the overview are explained in more detail:

Field Description

Lfd. No. Specifies the unique number of the down payment string.

Description Specifies a freely definable description for the down payment line. The description is initially specified

with the corresponding document type and document number of the document, but can be changed

individually.

Completed Indicates whether this down payment string has been closed. Down payment strings are marked as

closed when all linked down payment documents have been closed and final cleared. Even after

closing, down payment documents can be posted again for the down payment string, the flag is then

automatically removed again.

Source account

type

Indicates whether the down payment string belongs to a customer or a vendor.

Source account

no.

Specifies the number of the customer or vendor to which this down payment string belongs.

Source account

name

Specifies the name of the customer or vendor to which this down payment line belongs.

Source table

name

Specifies the name of the table to which this down payment string belongs.

Options are: Sales header, Sales line, purchase header, purchase line

Currency code Specifies the currency in which the source document for this down payment string was created.

Cumulative down

payment

Specifies whether to create down payment invoices for this down payment string as cumulative down

payment invoices. Cumulative down payments include the down payment invoices that have already

been posted.

Prices incl. VAT. Indicates whether the prices of the source document are specified including VAT. If this is the case, the

prices in the down payment plan of the down payment string must also be specified gross.

Zlg. condition

code

Specifies the payment terms for the source document. In the down payment plan, other payment terms

can be specified for individual plan lines.

Project no. Specifies the No. of the default project to which this down payment string is linked. Depending on the

type of source document, this project number can be changed per down payment document.

Project

description

Specifies the name of the default project to which this down payment string is associated.

Responsible Indicates the person responsible for the project to which this down payment string belongs.

Project task no. Specifies the project task to which this down payment string belongs. Depending on the type of source

document, this can be overridden per down payment document.
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Use the buttons in the menu bar to maintain or retrieve additional information:

The down payment plan stored for the down payment line is displayed in the info box area of the window.

CREATE DOWN PAYMENT STRINGS MANUALLY

If down payment strings are not created automatically when creating documents, they can be created manually from within the

documents. 

In the "Down payment string" field of the sales order or purchase order (or one of its lines) you can click "Link to down payment

string".

The subsequent query must then be confirmed with the option "Create down payment string for this document".

If the document is to be linked to an existing down payment string, the option "Link to down payment string" can be selected.

If the document is already linked to a down payment line (a line number is displayed in the Down payment line field of the

document), further actions can be performed via the link in this field.

Down payment plans

The down payment plan defines which down payment invoices have to be issued and when. Final invoices can also be planned in

down payment plans. Down payment plans are stored per down payment line.

This section describes how to create a down payment plan. 

A down payment plan can be mapped based on a down payment string. The down payment plans can be accessed either from the

source document (via the Down Payment String field) or from the Down Payment String window.

Button Description

Dimensions Here you can define dimensions for the down payment string. When creating the down payment

string, the dimensions of the source document are taken over. If the dimensions of the source

document are changed, they will also be updated subsequently for the down payment string.

Source document This button allows you to branch directly to the source document (sales order or purchase order) on

which this down payment string is based.

Down payment

plan

Here you can call up the down payment plan for this down payment line. There you can plan down

payments and generate the corresponding invoices.

Display debit/credit

items

The customer or vendor line items for the down payment line show additional information about the

status of the down payments.

Display unposted

documents

Here you can display the unposted documents for this down payment line.

Down payment

statistics

Via this button you can call up the down payment statistics. This shows a detailed overview of all

business transactions posted in connection with this down payment strand (see chapter 6.1).
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In the header of the down payment plan, information about the down payment string is shown. The following fields can be

changed:

Field Description

Cumulative

prepayments

Specifies whether to create down payment invoices for this down payment string as cumulative down

payment invoices. Cumulative down payments include the down payment invoices that have already

been posted.

Note

No down payment plan lines can be created for "Accumulated down payments" using the "Create lines

for order items" function (see "Buttons in the ribbon" table below).

Description Specifies a freely definable description for the down payment line. The description is initially specified

with the corresponding document type and document number of the document, but can be changed

individually.
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The rows in the down payment schedule map the individual planned down payment invoices and the final invoice. The fields must

be filled as follows:
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Field Description

Plan type Indicates the type of down payment plan line. Down payments and final invoices can be

planned

Invoice date Specifies the date of the planned invoice.

Amount % Specifies the percentage of the base amount to be settled with this down payment plan line.

The base amount is equal to the value of the source document.

Payment Amount Indicates the amount to be billed with this down payment plan line.

Note:

If the total of all lines in the down payment planning type exceeds the base amount, a message

will appear, if specified in the setup.

Cum. Proportion Amount

%

Indicates the cumulative percentage of the base amount to be settled with the down payment

plan lines. This amount includes all previous down payment plan lines.

This field is only displayed if the "Cumulative down payment planning" parameter is activated

in the "Accounts Receivable and Sales Setup" or "Accounts Payable & Purchasing Setup"

Automatic cancellation of

previous AZ invoices for

cumulative down payment.

Down payment

Indicates the cumulative amount to be settled with the down payment plan lines. This amount

includes all previous down payment plan lines.

This field is only displayed if the "Cumulative down payment planning" parameter is enabled in

the "Accounts Receivable and Sales Setup" or "Accounts Payable & Purchasing Setup"

Down payment amount Indicates the amount in client currency to be settled with this down payment plan line.

Payment Term Code Specifies the payment term code to be used to create the scheduled invoice. It will initially

default to the code of the source document, but can be modified.

Description Specifies an optional, user-definable description for this down payment schedule line. The

description will be used as posting description in the document line of the generated

document.

Job No. Specifies the project to which this down payment plan line is linked.

Job Task No. Indicates the project task to which this down payment plan line belongs.

Release for Invoicing Indicates whether this down payment plan line may be transferred to an invoice.

This field is only displayed if the parameter "Release for down payment plan lines necessary" is

activated in the "Setup Customer and Sales" or "Accounts Payable & Purchasing Setup".

Release by Indicates which user has released the down payment plan line for invoicing.

This field is only displayed if the parameter "Release for down payment plan lines necessary" is

activated in the "Setup Customer and Sales" or "Accounts Payable & Purchasing Invoice".

This field is only displayed if the parameter "Release for down payment plan lines necessary" is

activated in the "Setup Customer and Sales" or "Accounts Payable & Purchasing Invoice".

Unposted Invoice No. Indicates the document number of the unposted sales or purchase invoice created for this

down payment plan line. If a document was created for the down payment plan line, this line

cannot be retrieved again into a document.

Down Payment Invoice No. Specifies the document number of the posted sales or purchase invoice created for this down

payment plan row. If a document has been posted for the down payment plan row, this row

cannot be recalled into a document.

Posting Status Indicates the posting status for this down payment plan line.

Options are: 
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The following actions can be performed using the buttons in the ribbon:

Advance payments in sales

This section shows a typical posting history of down payments in the Sales area. The basis for the down payment string is a sales

order. A down payment plan has already been defined. The procedure for down payments at order line level or based on projects

is analogous - the starting point is always a down payment string.

Field Description

- Open,

- Booked,

- Partially paid,

- Paid,

- Partially credited,

- Credited,

- Partially finalized,

- Finalized

Non-deductible VAT % Indicates the current identical percentage from the purchase order for the down payment plan

line. For down payment plan lines created for a complete purchase order, this is a weighted

percentage across all purchase order lines in the source document. For down payment plan

lines created using the "Create lines for order items" function, the percentage is taken from

the relevant purchase order line. Through the down payment invoice creation function, the

"Non-deductible VAT %" is taken from the down payment plan line to the invoice line.

Warning Warnings are displayed here if any information is missing. There must be no warnings if a

document is to be generated.

button description

Create down payment invoices

(for selected lines)

This function allows you to create an unposted down payment invoice for selected down

payment plan lines of the down payment planning type.

Create lines for order items Here you can create down payment plan lines based on document lines contained in the

source document.

Note

No down payment plan lines can be created for "Accumulated down payments" using the

"Create lines for order items" function. (see "Accumulated down payments" above).

Insert Template Opens the list of available down payment plan templates to insert several predefined

lines.

Withholdings Views the list of withholdings to assign them to the respective down payment plan lines.

Display Generated Invoice Allows you to view the generated, unposted invoice for this down payment plan line. This

is only possible if a document number is specified in the "Unposted invoice no." field.

Remarks This button can be used to store remarks for the down payment plan lines.

Dimensions Shows the dimensions for the down payment plan line. The dimensions can be revised

here.

Delete Down Payment String Here the current down payment string including the down payment plan can be deleted.

This is only possible if no documents have been posted for this down payment line yet.

Down payment statistics Use this button to call up the down payment statistics. This shows a detailed overview of

all business transactions posted in connection with this down payment strand.
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CREATE AND POST A DOWN PAYMENT INVOICE

The individual down payment plan lines that have not yet been retrieved can be retrieved in down payment invoices. This can be

done in two different ways:

Creating a down payment invoice from the down payment plan

Create a sales invoice and call off the plan lines From the down payment plan, a sales invoice can be created automatically for

one or more down payment plan lines of the planning type "Down payment". To do this, the desired lines must be selected,

then the function "Create AZ invoice (f. selected lines)" is executed.

The created document will be opened directly afterwards.

In addition to the already known fields, the following fields are important for documents with reference to down payment strings:

Customer and posting date are taken from the down payment plan line. The down payment indicators are also set and the

document is linked to the down payment line.

The down payment plan lines are copied to the lines of the document. The G/L account from the field "Deb. Unrealized Down

Payments" field from the customer's posting group. It is important that this G/L account has a VAT product posting group with

unrealized tax. Otherwise an error message will appear.

The sales price without VAT is filled with the down payment amount of the down payment plan line. If the "Prices incl. VAT" field

is activated in the down payment line, the amount from the down payment plan is transferred to the "Sales price incl. VAT" field

instead.

In the down payment plan, the "Unposted invoice no." field is filled after the invoice is created. The "Display created invoice"

button can be used to return to the created A/R down payment invoice.

When posting, the next sequential number of the number series from the field Dept. down payment invoice numbers of the

Accounts Receivable & Sales setup is used as the document number. Corresponding G/L items are created.

The receivable for this invoice is posted to the G/L account "Deb. Collective account down payments" from the customer's

customer posting group. 

The VAT items show the facts of the unrealized tax.

Additional information about the down payment is shown on the customer item.

If an A/R down payment invoice is created directly, the fields for the down payments must be set manually in the document

header. If a down payment line was selected for which a down payment plan was also maintained, a function can be used to copy

the plan lines that have not yet been called into the document.

Via the menu item "Prepare" > "Get down payment plan lines" in the ribbon, the down payment plan can be opened.

There, the relevant lines can be marked and the selection confirmed. The lines will then be inserted into the sales invoice.

In documents marked as down payment, only texts and G/L accounts can be used in the lines.

If an A/R down payment invoice is to be created for which no down payment plan has been defined, the document lines can also

be entered manually. If a line with the type "G/L account" is created, the no. with the G/L account "Deb. Unrealized down

payments" from the customer posting group.

• 

• 

Field Description

Down payment Specifies whether this document should be posted as a down payment document. This has an influence

on the handling of the posted document in the further posting process.

Post final invoice This field can be used only for final invoice documents (documents without down payment indicator).

Down payment

string

Indicates to which down payment line this document is linked. The specification is necessary for down

payment documents as well as for final invoices, so that the posting can be assigned accordingly.
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PAYMENT OF A DOWN PAYMENT INVOICE

When paying a down payment invoice, the same options exist as when paying a normal sales invoice:

Posting of a payment via a ledger sheet with specification of a clearing 

Posting a subsequent clearing in the accounts receivable item

When clearing a down payment invoice with a payment, the following transfer postings are made:

Unrealized tax to sales tax 

Unrealized down payment to down payment received

The account for down payments received is drawn from the VAT posting matrix (Deb. Real. Down Payment Account field).

Normal receivables account to receivables account for down payments

These accounts are determined from the customer posting group. Clearing for down payment invoices can also be canceled

again. The transfers posted with the clearing are then reversed again, so that the down payment is again managed as posted but

not paid.

If down payment invoices are issued in foreign currency, there may be discrepancies between the requested down payment amount

and the amount actually received due to exchange rate differences during payment.

These exchange rate differences are posted to the realized prepayment account when payment is made, so that the prepayments

received correspond to the amount actually received.

ADVANCE PAYMENT CREDITS

The following section shows how to credit an incorrect or overstated down payment invoice.

A credit memo is necessary if a down payment invoice was posted incorrectly. A down payment credit memo can also be created

in the event that the down payment invoice is no longer required because a final invoice has been issued in the meantime.

An A/R down payment credit memo is initially recorded as a normal A/R credit memo, for which additional down payment

information is then set:

If a down payment string is selected, the open down payment invoices for this down payment string are automatically proposed

for selection. The "Customer item clearing" window opens. After selecting an invoice document, the "Clear with document no."

field is filled and the document lines from the posted invoice are copied to the down payment credit memo. 

Alternatively, the function "Call up AZ invoice for credit memo" can be executed under the menu item "Prepare" in the menu

ribbon. Here, too, the list of open down payment invoices is displayed, which can be canceled with the credit memo.

• 

• 

• 

• 

• 

Note

Field Description

Down payment document

type

Indicates whether this document is a down payment credit memo.

Down payment string Specifies the down payment string to which this down payment refers.

Clearing with voucher no. Specifies the document number of the posted down payment invoice to be reversed with the

credit memo.
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The procedure for down payment credit memos differs from that for normal credit memo documents_ in the following respects.

Only exactly one down payment invoice can be cleared with an A down payment credit.

It is not possible to subsequently clear down payment invoice and credit note, the credit note must be cleared directly with the

invoice when posting.

Clearing between down payment credits and invoices cannot be canceled.

POSTING THE FINAL INVOICE

When the final invoice is posted, the down payments must be cleared or reversed. The clearing of the down payment takes place

in the form of a credit note as a so-called final invoice deduction. Requested down payments can either be cleared with the final

invoice deduction or credited. This is regulated by the setting "Final invoice for down payment invoices" in Accounts Receivable

& Sales Setup. The other settings here control the creation of the necessary follow-on documents (Auto Post Final Invoices, Auto

Post Remaining Amount Credits, Auto Post Realization Invoices fields). These documents can be automatically created and, if

necessary, posted when the final invoice is posted. If this is not the case, the down payments must be cleared manually via

documents.

If the final invoice is posted and the fields for automatic creation of follow-on documents are set, corresponding messages (or

corresponding messages for creating and posting the follow-on documents) will appear.

Final invoice deduction

With the final invoice deduction the down payments are cleared with the final invoice. The final invoice deduction refers to a

down payment string, which means that only down payments for this down payment string can be cleared, even if other down

payments may exist for the customer.

The final invoice deduction reduces the receivables from the final invoice issued by the cleared down payments and clears them.

For this to be mapped, the following fields in the document are relevant:

For the final invoice deduction, after the "Down payment document type", the field "Clearing with document no." must be filled

first, if the document is created manually. The document number of the final invoice is specified here. In the "Down payment

string" field, you can then select from which down payment string down payments are to be cleared. After selection, the down

payments that have not yet been cleared appear automatically.

The selected lines are then transferred to the credit memo as document lines. As G/L account the account "Deb. Real. Down

payment account" is taken from the VAT posting matrix. This is the case even if the cleared down payment is one that has not yet

been paid. Made down payments that have not been received are then credited and re-posted as received down payment (see

following section).

Final invoice deductions can also be created manually in this way.

When the final invoice and final invoice deduction are posted, customer items are created, invoice and final invoice deduction

were cleared with each other.

Via the interface "Down payment string" this fact can be traced in further interfaces. 

The down payment debit items show in detail the transactions posted to the down payment string and indicate which amount was

invoiced, whether the invoice was paid or credited and whether it has already been finally cleared.

Note

• 

• 

• 

field Description

Payment document type Indicates whether this document is a final invoice deduction.

Payment String Indicates the down payment string to which this document relates.

Clearance with Document

No.

Specifies the document number of the posted final invoice with which the down payments are

to be cleared.
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The down payment statistics also provide information on the current status of the down payment string.

Treatment of unpaid down payment invoices

Unpaid down payment invoice must be credited with the final invoice. There are two cases, depending on the setting of the "Final

invoice for down payment invoices" parameter in the Accounts Receivable & Sales setup:

Unpaid down payment invoices are not cleared against the final invoice deduction (option: Paid): a down payment credit must

be posted.

Unpaid down payment invoices are cleared with the final invoice deduction (option: all): a down payment credit must be posted

as well as a realized invoice for the down payments received.

The down payment credit memo is created in the same way as the reversal procedure (section "Down payment credit memo").

When the down payment credit memo is posted, the requested down payments are cleared again.

This also occurs when the unpaid down payment invoices have been offset against the final invoice deduction. However, as this

has already reduced the down payments received, they must be reposted as realized.

This document is a normal sales invoice made with the account for down payments received from the VAT posting matrix (Deb.

Real. Down Payment Account field). This clears the final cleared down payment of the final invoice deduction.

CANCELLATION OPTIONS

Cancellation of a down payment invoice

Down payment invoices that have not yet been paid can be cancelled via down payment credit notes (see section "Down payment

credit note").

Cancellation of a down payment

If a down payment invoice has already been cleared with a down payment, the reversal of the posted down payment is done via

the cancellation of the clearing and a subsequent write-off via a ledger sheet or the reversal of the payment transaction.

When clearing is cancelled, the transfer of down payments, receivables and VAT from unrealized to realized is reversed again

(see also section "Payment of a down payment invoice").

Reversal of a final invoice deduction

Cancellation of posted final invoice deductions is done by cancelling the clearing of final invoice and final invoice deduction.

Thereby the opened final invoice deduction is automatically charged off via an invoice (with down payment document type final

invoice deduction). The document number assignment for this reversal is defined in the Accounts Receivable & Sales setup (field

Document number assignment final invoice deduction reversal and following).

When the clearing is cancelled, the reversal document is created automatically, a message about the created document appears.

The following picture then appears in the customer items: the final invoice was reopened in full, the final invoice deduction was

reversed and cleared with the reversal.

If the final invoice deduction was also used to clear unpaid down payment invoices and create realized invoices, it is necessary to

the realized invoice is manually charged off (=cancelled) via a credit note.

The original unpaid down payment invoice that was reversed with a down payment credit memo to be manually re-posted via a

new down payment invoice.

OVERPAYMENTS

It may happen that the amount of the deposit received exceeds the amount of the final invoice. Thus, more than 100% of the final

invoice has been paid.

In the down payment debit items, such a case can be recognized by a negative open down payment amount after final clearing.

• 

• 

Note

• 

• 
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This amount can be automatically charged off via an overpayment credit note. Relevant for this are the settings in the Accounts

Receivable & Sales setup (Max. credit amount of overpayments field and following).

To do this, select the item with the overpayment and call the "Overpayment credit memo" function. A credit note will be created

and opened.

The credit note shows a reference to the down payment line. The G/L account for realized down payments is entered in the lines

as well as the open, overpaid amount.

When the credit memo is posted, the overpaid down payment is cleared and an open item is created for the customer. This can

now be used for a refund or for clearing with another invoice.

If an error occurred when creating a credit note, the credit note can be transferred to an invoice using the Copy document

function ("Including header" must be activated in the options) and then posted. 

CALCULATION CASH FLOW PLANNING

When transferring cash flow planning information to the cash flow worksheet, the following origin types to be included can be

selected when calling the "suggest worksheet lines" function:

Sales Order Advance Plans

Purchase Order Advance Plans

Job Advance Plans

to define which down payment plans should be included in the cash flow planning. When considering the respective payment

plans, sales order lines, purchase order lines and projects with down payment transactions are not included in the cash flow

planning.

Even if the payment plans listed above are not included in cash flow planning, down payment invoices flow into cash flow

planning and reduce the values for sales orders, purchase orders, and projects.

The account assignment to origin types is based on the cash flow setup.

Retentions

In order to manage retentions for down payment and final invoices, it is possible to define any number of retentions for invoices.

When creating down payment invoices, negative lines are listed for the retentions in the respective invoice, so that the retentions

amounts are deducted from the invoice amounts.

When posting invoices that contain retention amounts, an additional invoice document with the respective retention amount will

be posted for each retention amount. 

ALLOCATION OF RETENTION AMOUNTS IN THE DOWN PAYMENT PLAN

If retentions are stored in the system, the call "Retentions" appears in the down payment plan on the info tab "Lines". If there are

no retentions, the call is automatically hidden by the system.

The menu item "Retentions" opens a view in which all suitable retentions (matching "Supported cost type" and "Supported

document type") are listed for the currently selected down payment plan line. Per withholding, a percentage of the down

payment amount or a fixed amount can now be specified. 

If a down payment invoice is created from the down payment plan, an additional line is inserted in the invoice document for each

selected down payment.

The line contains the specified amount with a negative sign. The amount 1, is keyed to the "Unrealized account" of the Retention

setup and takes into account the description from the retentions or their translations.

If there are additional dimensions stored on the "Retentions", they will be added to the line as well.

• 

• 

• 
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Retentions for final invoices in the down payment plan are for information purposes only. In order for withholdings to take effect in

the final invoices, they must be set up in the respective document (sales order, purchase order, invoice) (see following section).

ASSIGNMENT OF RETENTIONS IN ORDERS / INVOICES

For sales orders, purchase orders or invoices that are not created via the down payment plan, down payments can be entered in

the document via the menu item "Insert down payments".

When the menu item is called up, the same view appears as when it is called up from the down payment plan, so that the

amounts for the desired retentions can be stored there.

When closing this view, the lines for retentions are inserted directly in the respective document (sales order / purchase order /

invoice). 

Retentions for final invoices are not mapped for this process. Setting up withholds for final invoices in the down payment plan is for

informational purposes only (see section before).

DOCUMENT POSTING

When a document is posted, the system automatically checks whether it contains lines with withholdings. If this is the case, an

additional invoice is generated and automatically posted for each line with a retention amount.

The document gets the same document/ and posting date and the same document number as the original document, only

supplemented by the suffix from the Retention setup.

In addition, the payment term from the "Retention" is stored on the document.

If the original document is a down payment invoice, the newly created document for the retention will also be marked as a down

payment invoice.

The document contains a line about the selected G/L account of the retention, the corresponding amount with positive show and

the quantity 1. Here, too, any additional dimensions of the retention are taken into account.

When the document is posted, the "code" of the retention amount is transferred to the vendor/customer item, as well as to the

generated project items or down payment project items. This serves the later evaluability.

PAYMENT ON DOWN PAYMENT INVOICES

When a down payment invoice created for a retention is paid, a transfer of the net amounts, tax and payables/receivables from

the "Unrealized" to the "Realized" accounts takes place analogously to regular down payment invoices.

Here, in contrast to regular down payment invoices, the net values of goods are transferred from the "Unrealized account" to the

"Realized account" from the "Retentions".

EVALUATIONS

In the reports "Vendor items per" and "Customer items per", the field "Retention filter" can be used to control whether retentions

should be included in the result or not.

Evaluations

The following interfaces can be used for evaluations or an overview of the current status for a down payment string:

Down payment statistics

Down payment debit item / down payment credit item

Note

Note

• 

• 
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DOWN PAYMENT STATISTICS

The down payment statistics show a detailed overview of all business transactions posted in connection with this down payment

line.

In the header, the Display amounts as field can be used to select whether net or gross amounts are to be displayed.

In the matrix, all planned and posted vouchers are listed on the left. The columns to the right of it show the individual vouchers

and amounts per posting date.

DOWN PAYMENT ITEM

The customer or vendor items for the down payment line show additional information on the status of the down payments. In

addition to the amount and remaining amount, separate columns show whether an amount has been paid or credited or whether

it has been cleared via a final invoice deduction. The column "Open down payment amount (paid, not cleared for closing)"

provides information about outstanding postings.

The buttons can be used to perform the following actions:

CASH FLOW

In the "Cash flow planning statistics" and "Cash flow availability by period" presentations, the following types of origin are

shown:

Advance payment receivables

Advance payment plans

Down payment liabilities

A/P down payment plans

Project down payment plans 

Note

Analogous to projects, project down payment plans are also shown with net amounts (see also cash flow setup).

Button Description

Item

Set/remove filter for

open AZ

Selects whether this list should show only items with open down payment amounts.

Down payment

statistics

Shows a detailed overview of all posted transactions linked to the down payment line of the

current item (see section "Down payment statistics").

Navigate Searches all items and documents that exist for the posting date and document number of the

current item.

Detailed items Time all posted items and corrections to the current customer item.

Show receipt Opens the posted document for the current item.

Overpayment

Overpayment credit Creates a credit memo document for a down payment item with an overpayment (see the 

"Overpayments" section).

Realization calculations

Real. Invoices Opens the posted realization invoices linked to this item (see the section "Treatment of unpaid

down payment invoices").

Real. Credits Opens the posted realization credits associated with this item (see the "Overpayments" section).

• 

• 

• 

• 

• 
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In the Cash Flow Date Summary report, amounts for the down payment accounting source types listed above flow into the

following standard source types:

Receivables

Payables 

Sales orders

Purchase orders 

Projects

Down payments in purchasing

For down payments in purchasing, down payment strings can be created based on purchase orders or purchase order lines.

The posting procedure and the corresponding documents are analogous to the procedure in the Sales area (see section "Down

payments in Sales").

NON-DEDUCTIBLE VAT

In the down payment accounting, the Microsoft Dynamics 365 Business Central1 Standard function of "Non-deductible VAT" is

supported in down payment accounting.

In addition to enabling the "Non-deductible VAT" feature in the standard Microsoft Dynamics 365 Business Central1, the setups

described in the "VAT product posting groups and VAT posting matrix" section must be made in Down Payment Accounting.

As stated in the "Down-payment-plans" section, the "Non-deductible VAT %" is transferred from the purchase order to the rows of

the down-payment plan and from here to the down-payment invoice and the other down-payment accounting documents.

What happens after the free trial

What happens after the free trial? from KUMAVISION on Vimeo.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

• 
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1.3.4 Change Log Quick Access

Overview

The Change Log Entries function in Microsoft Dynamics 365 Business Central1 Standard can only be called via the main

Administration menu and displays all data in an unfiltered and unstructured way.

With the KUMAVISION Change Log Quick Access app, this functionality has been extended so that the change log can be opened

from any master data card. Preset filters display just the log entries of the record you require without you having to make further

adjustments.

Multiple filters can be set for all views.

Benefits of the Change Log Quick Access app:

Information provided quickly

Overview of old/new values as well as date and time of change and user who made the change

Time savings thanks to preset filters

Introduction

KUMAVISION Change Log Quick Access | KUMAVISION App from KUMAVISION on Vimeo.

Get KUMAVISION Change Log Quick Access from Microsoft AppSource

Change Log Setup

ACTIVATE THE CHANGE LOG

After successful installation of the app, you need to activate the change log first. To do so, first open the Change Log Setup card

via the Tell Me function. The Change Log Setup card opens. Toggle on the Change Log Activated switch.

LOG TABLES AND TABLE FIELDS

Click Setup > Tables in the ribbon to specify the tables and fields to be included in the log.

• 

• 

• 
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First, select the desired table. Use the Log Insertion, Log Modification, and Log Deletion fields to specify whether and when

changes are to be logged by the system.

Field Description

Log Insertion Controls whether the insertion of new data is to be logged. The following settings are available:

Blank:

Insertions are never logged.

Some Fields:

Insertions for the selected fields will be logged. 

You can select the fields by clicking the AssistButton […] to open the field list. Enable the checkbox in the

Log Insertion column for each field to be logged.

All Fields:

Insertions will be logged for all fields.

Log

Modification

Controls whether modifications made to the data will be logged. The following settings are available:

Blank:

Modifications are never logged.

Some Fields:

Modifications of the selected fields will be logged.

You can select the fields by clicking the AssistButton […] to open the field list. Enable the checkbox in the

Log Modification column for each field to be logged.

All Fields:

Modifications will be logged for all fields.

Log Deletion Controls whether deletions of data will be logged. The following settings are available:

Blank:

Deletions are never logged.

Some Fields:

Deletions of the selected fields will be logged. You can select the fields by clicking the AssistButton […] to

open the field list. Enable the checkbox in the Log Deletion column for each field to be logged.

All Fields:

Deletions will be logged for all fields.
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Use change log entries

QUICK ACCESS TO THE CHANGE LOG

Once configured, you can now use quick access on the following pages to view the change log:

Customers / Customer Card

Vendors / Vendor Card

Items / Item Card

Insurance Policies / Insurance Card

Machine Centers / Machine Center Card

Fixed Assets / Fixed Asset Card

Bank Accounts / Bank Account Card

Stockkeeping Units / Stockkeeping Unit Card

Projects / Projects Card

Contacts / Contact Card

Service Items / Service Item Card

Comments (Sales)

Comments (Stockkeeping Units)

Production BOMs / Production BOM

Prod. BOM Version List

Routings / Routing

Routing Version List

Work Centers / Work Center Card

Comments (BOM)

Comments (Routing)

Comments (Production Order)

Comments (Operation – Production Order)

Comments (Component – Production Order)

Chart of Accounts / G/L Account Card

Resources / Resource Card

Sales Price and Line Discounts

Item References

Blanket Sales Orders / Blanket Sales Order

Posted Sales Credit Memos / Posted Sales Credit Memo

Sales Invoices / Sales Invoice

Sales Orders / Sales Order

Sales Quotes / Sales Quote

Sales Return Orders / Sales Return Order

Blanket Purchase Orders / Blanket Purchase Order

Purchase Credit Memos / Purchase Credit Memo

Purchase Invoices / Purchase Invoice

Purchase Orders / Purchase Order

Purchase Quotes / Purchase Quote

Purchase Return Orders / Purchase Return Order

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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To open the change log for a particular master data card, open the respective card and select Related > History > Change Log.

If no changes are displayed in the change log, sign out from the system and sign in again. This might be necessary when using this

functionality for the first time after installation of the app. Later on, the changes are written to the log automatically.

CHANGE LOG ENTRIES

As an alternative, you can display a list of change log entries. To do so, open the Change Log Entries card via the Tell Me

function.

What happens after the free trial has expired?

What happens after the free trial? from KUMAVISION on Vimeo.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note
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1.3.5 KUMAVISION Core

Overview

This app doesn’t provide features for end users but serves as a basis for all KUMAVISION functionality.

Module Setup

On this page, you can manage the licensing and activation data required for each vertical solution. To see the information:

Choose the Tell Me function, enter KUMAVISION Module Setup, and then choose the related link.

Alternatively, go to the role center, choose Advanced Settings on the ribbon, and then select KUMAVISION Module Setup.

Afterward, you can update your license or buy additional app licenses through the actions on the page. You can also specify the

(parts of) each solution that can be used in the current company by turning the relevant toggles on (or off).

The option to buy packages is only available in SaaS environments. Please contact your Microsoft partner if you’re using Business

Central on-Prem.

To verify app registration in on-premises environments, the following URIs must be accessible without restrictions:

https://kvssappreg001.azurewebsites.net/

https://businesscentral.dynamics.com/

If they aren’t, you need to adjust your firewall and proxy settings.

Connection tests

These tests are used to check if certain basic services needed for the proper functioning of the system are available at present.

To run a test:

Choose the Tell Me function, enter KUMAVISION Module Setup, and then choose the related link. Afterward, run the

corresponding action from the ribbon.

Alternatively, open the KUMAVISION Module Setup page and run the test from there.

If an error occurs, you can learn more about it by choosing Details on the dialog box that appears.

To better understand what went wrong, you can also export the test result.

Setup and Demo Data

This page allows you to easily import data packages containing both setup and demo data. Each KUMAVISION AG app can

contain such packages. To import the data, simply select one or more data packages and click on "Create setup data" or "Create

setup and demo data".

Your data already in the system could be overwritten without further inquiry.

• 

• 

Note

Warning

• 

• 

• 

• 

Warning
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As a rule, demo data should not be imported into production systems.

Frequently asked questions

This issue typically occurs in on-Prem environments when no user experience is set, such as when you add an empty company. To fix

the issue:

Open the KUMAVISION Module Setup page.

Open the Company Information page from the dialog box that appears.

On the User Experience FastTab, configure the user experience based on your licensing model.

Note

My role center is empty. What can I do?

1. 

2. 

3. 
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1.3.6 Credit-Check App powered by Creditsafe

Overview

With the Credit-Check App powered by Creditsafe you can check the solvency of your (future) customers, partners or service

providers, reduce your credit risk and thus build long-term successful business relationships. KUMAVISION Credit-Check App

powered by Creditsafe gives you easy access to the world's most widely used credit report "Creditsafe", directly from Microsoft

Dynamics 365 Business Central1.

The Credit-Check App powered by Creditsafe offers you the following advantages:

Daily updated creditworthiness reports incl. inquiry logging

Queries from Business Central incl. direct contact creation

Company monitoring

Automatic data update cycle

Address validation for matching and updating of company & address data in Business Central

Pre-built workflows for setting credit limits or blocking a contact based on the credit rating

Cost control and budget security through fixed price model

You reduce your processing times and identify risks at an early stage to avoid bad debt losses. Outdated data and double entries

are a thing of the past - always work with validated debtor/creditor and contact data with correct company name and address.

Introduction Credit-Check App powered by Creditsafe

See the following playlist for more videos explaining the app's functions:

Link to Microsoft App Source "KUMAVISION Credit-Check App powered by Creditsafe"

More learning resources

Besides this article, you can consult the following user-friendly resources to learn more about the Sales Order Status feature:

Product videos

To see all videos about the app, use the general search function in Microsoft Dynamics 365 Business Central1 and enter Product

Videos. Pick a video from the page and run it.

Tours

You can also take a tour explaining the app’s most important features. When you’re on a page that includes Sales Order Status

content, go to the ribbon at the top, choose the Help icon, and then select Take a Tour in the first About… FactBox.

Setup

In order to use the Credit-Check App powered by Creditsafe, some settings have to be made in advance. On the one hand, this

concerns the setup and assignment of users and authorization sets and the basic setup of the "Creditsafe Global Gateway

Services" for credit reporting. The individual setup steps for the connection are listed and explained in more detail below.

REGISTRATION

After successful installation, the app must be registered for use free of charge. Please return to the Business Central Role Center

and confirm the pop-up prompt for registration.

• 

• 

• 

• 

• 

• 
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USER AUTHORIZATION

In order to use the Credit-Check App powered by Creditsafe, some settings have to be made in advance. On the one hand, this

concerns the setup and assignment of users and authorization sets and the basic setup of the "Creditsafe Global Gateway

Services" for credit reporting. The individual setup steps for the connection are listed and explained in more detail below.

WIZARD CREDITSAFE CREDIT CHECK

In order to make the setup of the connection as comfortable as possible for the users, a wizard has been developed to guide you

through the individual steps. This wizard can be accessed via the start page "Assisted Setup" / "Facilities to the Creditsafe Global

Gateway Service / Creditsafe Connect API". Alternatively, users can also set up the facilities via the individual application areas.

The information that can be stored in each case is identical.

Authorization record Description

CRS Setup This authorization set grants the respective user full access rights to the connection. I.e.:

• set up the connection

• create new queries

• View credit reports

CRS Edit This permission set grants the user the following access rights:

• create new queries

• View credit reports

CRS View This permission set grants the user the following access rights:

• View credit reports
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The wizard is started. The individual steps are explained in more detail below:
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Wizard step Description

Welcome

screen

A welcome message appears at the beginning.

Click on "Next" to continue.

Query

Creditsafe

Account

If you already have a Creditsafe account, click "Next" to continue.

You do not have an account yet? Please click on the following link to activate your free trial account with

Creditsafe:

Link to Creditsafe Belgien

Link to Creditsafe Germany

Link to Creditsafe France

Link to Creditsafe Italy

Link to Creditsafe Netherlands

Link to Creditsafe Great Britain

Link to Creditsafe United States of America

Connection

information

Enter the connection information in this window. Click on "Next" to proceed to the next installation step.

Service URL At this point the URL to the Creditsafe web service is stored.

By default, this field is filled with the URL, which is common in Germany:

https://connect.creditsafe.com/v1

Setup user You can create a new user via the "Setup user" button. The corresponding fields are explained below:

Creditsafe User Name:

Enter here your personal username for the connection, provided by Creditsafe. This field is mandatory.

Creditsafe Password:

Enter here your personal password for the connection, provided by Creditsafe. The password is stored

encrypted in the database.

Close the "User Setup" window and click "Next" in the wizard to proceed to the next installation step.

Modify

Countries
In Microsoft Dynamics 365 Business Central1, as in Creditsafe, country codes are used. Since the codes

used in both systems do not necessarily have to match, the Business Central country codes have to be

mapped to the Creditsafe country codes. When the action "Modify countries" is called, the country codes

are queried from Creditsafe and stored in Microsoft Dynamics 365 Business Central1. To query the data a

connection to an external service of Creditsafe is necessary. Allow the app to access the external service

once or always, if you have not already granted this permission. After retrieving the countries from the

Creditsafe service, the current list of countries is displayed in a Business Central window. In this list you

will see all the Creditsafe countries for which you are activated. If there is a matching Business Central

counterpart for a Creditsafe country code, the assignment in the "Country code" column is already

suggested automatically. Please check the automatic assignments at this point and change them if

necessary by selecting a Business Central-internal country code. Furthermore, you can select the desired

language for a credit report from the respective country via the Preferred language field using the

assist button. Only the languages that are possible in the Creditsafe API for queries for the respective

country are listed here. This field is only visible when using the Creditsafe Connect API, but not when

using the Creditsafe Global Gateway Service.

Then confirm the "Creditsafe Countries" window with "OK" to return to the setup wizard. Click "Next" in

the current step of the setup wizard to proceed to the next installation step.

Basic settings In the "Basic settings" window you can make various settings as well as defaults.

Default E-Mail address for Offline Report:

If a report cannot be requested online, you have the option within the app to request an offline report

from Creditsafe. To ensure that this report can be sent to you easily by e-mail and for any queries on the

part of Creditsafe, please use the "Default e-mail address for offline report" field to specify which e-mail
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Wizard step Description

address should be used for this purpose.

Default Language:

Use the "Default language" field to specify the language in which you would like to receive the

creditworthiness reports. If the report is available in the selected language, it will be retrieved

accordingly.

Default Language (secondary):

Use the "Default language (alternative)" field to specify the alternative language in which you would like

to receive the creditworthiness reports. If the report is not available in the default language, the

alternative default language will be used for retrieval. If there is no report in the alternative language

either, the available language of the report will be used.

Note:

Please note that the languages stored here only have an effect if you use the Creditsafe Global Gateway

Service for the query. When using the Creditsafe Connect API, it is possible to make language settings for

the reports to be called up in the respective country settings of the Creditsafe countries.

Default Country:

Select as default country the Creditsafe country code through which a company search should be

performed by default. In the company search, you can search for companies that are not yet created in

your database as contacts, customers or vendors. In this case, as well as in cases where the "Country

code" field of the contacts, debtors or creditors is empty, the country specified here will be suggested for

the search, but can be overwritten in the search window.

Default Matchtype:

When you search for a company on Creditsafe, specifying the company name, the search is performed for

the entire term or partial words. Specify here the search mode you want to use to search for companies

by default. You can override this field again in the company search. The value specified here is only a

suggestion and to simplify the search. Possible values are:

MatchBeginning:

Searches at the beginning of the company name for the exact term specified Example: "Testfirma GmbH

& Co. KG" will be found by "Test", "Testfirma", "Testfirma Gmb" etc.

MatchBlock:

Searches for a partial text within the company name Example: "Testfirma GmbH & Co. KG" is found by

"estfirm", "GmbH", "irma" etc. 

MatchAnyPars:

Searches for text blocks in the company name - One block per search term Example:

"Alpha Bravo charlie Co. KG" is found by "alph ravo", "lpha harl" etc. 

MatchWords:

Searches for whole words regardless of the order Example: "Testfirma GmbH & Co. KG" is found by

"gmbH Testfirma", "KG GmbH" etc

MatchBlockOrWords:

ombination of MatchBlock and MatchWords Searches partial texts as well as whole words regardless of

the order.

ExactValue

Searches for the entire exact partial text Example: "Testfirma GmbH & Co. KG" is found by "testfirma

gmbH & co. kg".

ClosestKeywords

Searches for any keyword using a "fuzzy" logic (similar to fuzzy search) Example: "Alpha Bravo charlie

Co. KG" is found by "brava", "brawo" etc. 
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Wizard step Description

The possible search modes vary depending on the country used. If you have any questions about this,

please contact your Creditsafe representative. 

The default setting for Germany is "MatchWords".

Default DE

Reason Code

In Germany, it is mandatory that a cause code for the query is transmitted in the course of a

creditworthiness query. In this field, specify the default DE cause code to be used by default. You can

override the DE cause code within the company search. The code specified here is used only as a default

value.

Possible values are:

• Credit decision

• Credit assessment - future business relationship (with default risk)

• Credit assessment - Existing business relationship (with default risk)

• Realization check for debt collection

• Purchase agreement - intention to sign a purchase agreement (with risk of default)

• Capital goods credit insurance (with default risk)

• Contract - intention to sign a lease or rental agreement (with default risk).

• Insurance contract - intention to sign an insurance contract (with risk of default). 

The default setting is "Credit check - Existing business relationship (with default risk)". 

Click "Next" in the current step of the setup wizard to proceed to the next installation step.

Advanced

settings

In the advanced settings you can define which automation steps should be executed by the connection

and how the application should react to changed data.

Modify Name & Address

Use this field to specify how the application should handle changed company or address data in the

course of retrieving creditworthiness reports.

The possible options are: 

Prompt User

Unless the query is run in the background, if name or address information is changed, a window will open

prompting the user to accept individual or all of the changed data. 

Always

Changed company name or address information is always automatically transferred to the address master

by the application. There is no separate query to the user! 

Never

Changes to the company name or address data will not be accepted. 

The default value of the application is: User query.

Regular Update Interval

The application provides a batch run that is used to update the existing creditworthiness reports at a

regular interval. This run is executed every day and, depending on the date formula stored here, checks

whether the last successfully retrieved creditworthiness report is out of date. If this is the case, a current

report is automatically retrieved. 

The default value of the application is: 6M. This will automatically update credit reports every 6 months.

Request Report with Job Queue

Provided that this field is activated, creditworthiness reports for known Creditsafe addresses are queried

in the background. The advantage of this method is that the user does not have to wait for the query and

the processing of the result, but can continue working in parallel.
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Wizard step Description

The prerequisite for background processing is that the contact/debtor/creditor to be queried already

contains an assigned Creditsafe ID. If this is not the case, the company search is started and the query

cannot be performed automatically in the background due to the required selection of the correct

company.

Job Queue Category Code

Provided that the task queue is to be used for querying creditworthiness reports in the background, you

can specify a category for grouping the queue items here.

Notify On Success

Check this box to be informed about the notifications after a background check has been performed and a

new credit report is available. 

The system automatically generates a notification, the link to which allows you to branch directly to the

master record of the contact/customer/vendor.

Click "Next" in the current step of the setup wizard to proceed to the next installation step.

Portfolios Via portfolios, it is possible in Creditsafe to group selected companies and, for example, to enable

monitoring of a group. 

Select the "Modify Portfolios" function to retrieve the portfolios already stored in Creditsafe and save

them in a Microsoft Dynamics 365 Business Central1 table. Once retrieved, the portfolios will be

displayed in a Microsoft Dynamics 365 Business Central1 screen.

For more information on managing portfolios, please refer to the chapter "Managing Portfolios“. Click

"Next" in the current step of the setup wizard to proceed to the next installation step.

Job queue

entries

Job queue entries allow you to manage automations that perform time-based or change-based updates to

credit reports in conjunction with the Creditsafe connection.

Select the Open Task Queue Item action to open the Task Queue Item page.

In this window, two tasks have been integrated by "Credit-Check App powered by Creditsafe", but not

activated. Thus, you can decide for yourself whether automatic updates should occur or not. 

Codeunit 70259982 - KVSCRSJobUpdatePortfolio

This task is called by default once a day on each weekday and updates the companies named in a portfolio

if they have undergone a change by Creditsafe. The batch automatically queries the portfolios and if

changed companies are named by the query, the updated creditworthiness reports for these companies

are obtained in the background. 

Codeunit 70259981 - KVSCRSJobIntervalUpdateReport

This task is called by default once a day on each weekday and updates the companies whose last

successfully retrieved creditworthiness report is older than the date specified due to the date formula in

chapter "Update cycle" in combination with the current date. The batch checks the date of the last report

for all assigned Creditsafe companies in the master data and performs the creditworthiness queries for

the corresponding companies in the background. 

Click "Next" in the current step of the setup wizard to proceed to the next installation step.

Workflows Workflows can be used to perform actions in Microsoft Dynamics 365 Business Central1 depending on

events or record changes. This logic has been extended by "Credit-Check App powered by Creditsafe" to

include the event of a new successful credit report retrieval.

Select the "Open workflows" action to get to the list of workflows where you can create new workflows

based on workflow templates. Two workflow templates have been created automatically:

• Block a debtor/creditor on the basis of a credit report

• Set credit limit based on credit report 
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Wizard step Description

Both workflow templates are assigned to the new category "Creditsafe" and can be used to set the credit

limit or block a debtor/creditor based on the values of a new credit report. Click on "Next" in the current

step of the setup wizard to proceed to the next installation step.

Assign contacts The action "Assign contacts" can be used for the first assignment of Creditsafe IDs to already created

contacts. Before the creditworthiness reports of a contact/debtor/creditor can be retrieved, an assignment

to a Creditsafe ID is mandatory. While this step is done automatically for the selected master record in the

course of the individual retrieval of a report from the contact/debtor/creditor card, an assignment can be

made at this point for all already created contacts via the action "Assign contacts". If a contact is linked to

a customer or vendor, the Creditsafe ID will also be assigned to the linked record. 

After calling the action, a Creditsafe company search will be executed with the default parameters for the

search mode (see chapter "Default search mode") and the DE cause code (see chapter "Default DE cause

code"). You can still narrow down the contacts to be searched within the call by setting appropriate filters

on the contacts.

For example, in the following screen shot, only the contacts with a country/region code "DE" for Germany

are retrieved. Likewise, other arbitrary filters are possible for restriction.

Since this process makes a query to the Creditsafe system for each record, this process takes a

corresponding amount of time. 

After the search has been completed, a mask is displayed with all contacts that have not yet assigned a

Creditsafe ID. In the column "Number of found Creditsafe companies" you can see how many companies

were found for the search entry. By clicking on the number, you can view the different companies.

Using the action "New" -> "Assign unique IDs", you can automatically include all IDs that could be

uniquely assigned ("Number of found Creditsafe companies" = 1) in the assignment. 

For all contacts for which more than one entry was found, you have to make an assignment manually by

clicking on the number in the column "Number of found Creditsafe companies" and a subsequent

selection of the corresponding company entry. 

If no company can be assigned to a contact ("Number of found Creditsafe companies" = 0), you can open

the company search by clicking on the number and adjust the transferred search parameters for a new

individual search. 

After adjusting the search parameters (e.g. by removing the address and/or the postal code) and calling

up the search again (shortcut: Ctrl+F), the company can be found and is assigned by clicking on "OK". 

Click "Next" in the current step of the setup wizard to proceed to the next installation step.

Vendor Rating

Connection

This setup step is only available if the app "Vendor Rating Management“ of KUMAVISION AG is installed

parallel to this app!

Vendor Rating Authentication Type

This field is only visible in on-premise environments! The field can be used to control whether the

authentication of the API connection should be done via OAuth2 authentication or Basic

Authentication.

Vendor Rating User ID

This field is only visible in on-premise environments! In this field, the user ID must be entered, via which

data is passed on to the Vendor Rating Management module.

Password

This field is only visible in on-premise environments! The user's password must be entered in this field to

ensure connection via the API interface.
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If you subsequently want to change setup parameters, you can restart the setup wizard at any time or alternatively open the

"Setup Creditsafe Service" window via the Role Explorer (under "Setup and Extensions" / "Manual Setup") or the search

(magnifying glass). In the setup area, the following individual setup steps can

also be performed: 

Setup Creditsafe service 

User setup 

Creditsafe countries (update and assign) 

Creditsafe Portfolios 

Task queue post 

Workflows 

Vendor Rating Connection (provided that the app "Vendor Rating Management" of KUMAVISION AG is also installed in

parallel.)

VENDOR RATING CONNECTION

If the module for vendor rating (KUMAVISION "Vendor Rating Management“ is installed in parallel to the Credit-Check powered

by Creditsafe app, these two applications can be set up in such a way that credit checks are automatically included in the vendor

Wizard step Description

Vendor Rating AAD-Application

This field is only visible in SaaS environments or when selecting the Vendor Rating Authentication Type

OAuth2! In this field, select the "Azure Active Directory Application" to be used for authentication against

the API.

Vendor Rating Connection Client Secret

This field is only visible in SaaS environments or when selecting Supplier Rating Authentication Type

OAuth2! The "secret key" (Client Secret) of the Azure AD App registration must be stored in this field.

Use Vendor Rating Connection

This field controls whether to establish an API connection to the Vendor Rating Management (VRM)

module. This field contains the following options:

Undecided:

No decision has been made yet whether to establish a connection between this app and the VRM module.

This value is the initial value of the setup.

Yes:

A connection between this app and VRM module is to be established. In this case, the other fields in the

interface setup must be filled in.

No:

The interface between this app and VRM module should not be used.

Vendor Rating Type Code

This field is used to set the rating type from the vendor rating module for credit checks.

The "Assist" button for this field can be used to reference an existing rating type with the code 

CREDITSAFE. If no corresponding rating type exists yet, it will be created automatically.

Note:

If there is not yet an rating type with the code CREDITSAFE, it must be created via the Assist button. A

corresponding rating type is necessary to pass the information between the module Credit-Check

powered by Creditsafe and the VRM module.

Finish setup

wizard

This completes the setup of the "Credit-Check App powered by Creditsafe".

Click the Finish action to exit the Setup Wizard and close the window.

• 

• 

• 

• 

• 

• 

• 

1.3.6 Credit-Check App powered by Creditsafe

- 1269/1545 - Copyright © 2018 - 2024 KUMAVISION AG



rating. Communication between the two modules takes place via an API connection, with API calls generally being authenticated

via service-to-service authentication. Only in an on-premise environment, a basic authentication by means of user ID and web

service access key can be used as an alternative.

For the general setup of a Service-to-Service (S2S) authentication for API access, please refer to the standard guidance from

Microsoft. https://learn.microsoft.com/en-us/dynamics365/business-central/dev-itpro/administration/automation-apis-using-s2s-

authentication However, when assigning user permissions in the Business Central page (Azure Active Directory application map),

additively add the user permission record KVSVRMSETUP!

To activate the interface to the supplier rating, the following setups must be made:

Action "Test vendor rating API connection"

This action can be used to test the API connection to the Vendor Rating Management (VRM) module. The system issues a

corresponding message here whether the connection could be established or not. 

Note

Field Description

Vendor Rating

Authentication Type

This field is only visible for On-Premise environments! Using this field you can decide, whether to

use OAuth2-Authentication or Basic Authentication for API connection.

Vendor Rating User ID This field is only visible for On-Premise environments! This field must be used to enter the user

through which the API interface passes data to the vendor rating module.

Password This field is only visible for On-Premise environments! The password of the selected user must be

entered in this field to secure the connection via the API interface.

Vendor Rating AAD-

Application

This field is only visible in SaaS environments or when selecting the Vendor Rating Authentication

Type OAuth2! In this field, select the "Azure Active Directory Application" to be used for

authentication against the API.

Vendor Rating

Connection Client

Secret

This field is only visible in SaaS environments or when selecting Supplier Rating Authentication

Type OAuth2! The "secret key" (Client Secret) of the Azure AD App registration must be stored in

this field.

Use Vendor Rating

Connection

This field controls whether to establish an API connection to the Vendor Rating Management

(VRM) module. This field contains the following options:

Undecided:

No decision has been made yet whether to establish a connection between this app and the VRM

module. This value is the initial value of the setup.

Yes:

A connection between this app and VRM module is to be established. In this case, the other fields

in the interface setup must be filled in.

No:

The interface between this app and VRM module should not be used.

Vendor Rating Type

Code

This field is used to set the rating type from the vendor rating module for credit checks.

The "Assist" button for this field can be used to reference an existing rating type with the code 

CREDITSAFE. If no corresponding rating type exists yet, it will be created automatically.

Note:

If there is not yet an rating type with the code CREDITSAFE, it must be created via the Assist

button. A corresponding rating type is necessary to pass the information between the module

Credit-Check powered by Creditsafe and the VRM module.
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Functionality

Through the API interface between the Credit-Check powered by Creditsafe (CRS) and Vendor Rating (VRM) modules, vendor

rating items are formed based on the credit reports, which can be processed by the vendor rating functionality. 

The rating classification (A - E) from the credit report is used as the basis for the vendor rating item. If a rating score is stored

for the classification, this is transferred to the vendor rating item. 

Within the interface between the modules Credit-Check powered by Creditsafe and Vendor Rating, one vendor rating entry is

generated for each credit check.

Use credit check

QUERY CREDIT REPORT

Two different ways are offered for retrieving the creditworthiness information. The use of the respective step depends, for

example, on whether a business relationship already exists with the company to be queried and thus the data record has already

been created as a customer, vendor or contact, or whether it is a matter of initiating a new business relationship and thus no

master data record exists yet. 

While it is possible to retrieve current creditworthiness information from the respective master record for existing data records,

the company search is used for new companies.

Credit rating retrieval via the Creditsafe Company Selections

To find a company via the Creditsafe Company Selections and retrieve a credit report, open the "Creditsafe Company Selections"

card via the User Search.

In the Creditsafe Company Selections, search information can be entered and a search based on the Creditsafe company

database can be started. 

Use the "Name", "Address", "Post Code", "City", "Country", "Creditsafe ID", "Creditsafe SafeNumber" and "VAT ID" fields to

narrow down the results accordingly. 

Use the "German Reason Code" selection field to specify the reason for the query. In Germany, a legitimate interest in a credit

report is legally required. Therefore, please use the selection field to specify the reason for the query. 

Note
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The "Search type" field is used to define the basis on which entries are searched. The search types are available here:

Please note that due to restrictions on the part of Creditsafe services, not all search types are available in every country! For detailed

information, please contact your local Creditsafe contact person.

After entering the search criteria, you can start the company search via the "Find" action.

The companies found are displayed in the hit list. If a company has already been created in your database as a master data

record (customer, vendor or contact), then the corresponding hit is displayed in color.

In addition to the basic company information, you can also see from the list whether the online report, monitoring, basic report

or complete report options are available.

This information is based on the country-specific settings and your individual contract information with Creditsafe.

If a master data record already exists for a hit and the entry is highlighted in color, you can open the respective master data card

via "Open".

If the respective entry does not yet exist as a master record, you can create the corresponding master record via "Create as".

By clicking on "Get report" you can call up a creditworthiness report for the respective match the respective hit without having

to create the data record as a master data record.

In this case, however, the creditworthiness report cannot yet be "anchored" to a master data record and is therefore offered for

download.

Creditworthiness retrieval from the master data

Info boxes have been integrated within the contact card, customer card and vendor card, which directly display the most

important creditworthiness information for the respective master record.

If you have opened a master data record for which no credit report has been created yet and to which no Creditsafe-Id has been

assigned, this info box is without content.

Search type Description

MatchBeginning The beginning of the text must match.

Example: "Alpha Bravo Charlie" is found by specifying "alph", "alpha", "alpha bra" etc.

MatchBlock A block of text must match.

Example: "Alpha Bravo Charlie" is found by specifying "ravo" "ha bra", "ha bravo char" etc.

MatchAnyParts Text blocks must match - one block per "token".

Example: "Alpha Bravo Charlie" is found by "alph ravo arl", "lph harl" etc.

MatchWords Match whole words regardless of order. 

Example: "Alpha Bravo Charlie" is found by "alpha", "alpha bravo", "bravo alpha" etc.

MatchBlockOrWords Match a textblocked or whole words regardless of the order. In some countries an independence

from the order is not possible! 

Example: "Alpha Bravo Charlie" will be found by any text from MatchBlock or MatchWords.

ExactValue All text must match. 

Example: "Alpha Bravo Charlie" will only be found by "alpha bravo charlie".

ClosestKeywords Each word in the query is checked against a list of keywords that describe a company. 

Example: "Alpha Bravo Charlie" is found by any text from MatchWords plus "brava", "brawo" etc.

Note
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To retrieve a credit report for this contact, click on the heading "Last Credit Check" in the info box and select the action "Do

Credit Check".

If no Creditsafe ID has been assigned yet, the "Creditsafe Company Search" will open first. Select the corresponding hit in order

to assign the unique ID.

The creditworthiness report is then retrieved. In addition to the creditworthiness data, the complete address data is also

included in the Creditsafe report, so that if there are any differences between the data already stored and the results of the

creditworthiness report, the "Creditsafe address comparison" is displayed. Here you have the possibility to transfer single or all

changed field information into the current master record.

Subsequently, the data record is automatically updated and the infobox "Last credit report" is displayed with the valid data of the

credit report.

View credit information

Infobox data

Info boxes have been integrated within the contact card, debtor card and creditor card, which directly display the most

important creditworthiness information for the respective master record. 

The values displayed are:

Rating 

Rating Description 

Creditworthiness index 

Creditworthiness index Description 

Proposed credit limit 

Date / time of the last report call-off 

Creditsafe ID 

Creditsafe safe number 

Number of portfolios in which the master record is listed with link to the portfolios 

Reference to changed address data due to the last creditworthiness report with link to the changed address data (see Update

address data). 

View credit report

Select the action "Last credit report" / "Show credit report" to display the PDF report of the last credit query.

Show XML data file

In addition to the transferred creditworthiness data and the PDF report, by calling the action "Last Credit report" / "Show XML

data file" to call up the underlying data file. Here contains all the information about the company that is also displayed in the

PDF report. This file ensures that, for example, at a later point in time, further information on the companies can be imported

and interpreted in Business Central tables.

In addition to the allocation to industries, current employee figures and balance sheet information, this also concerns Notes on

management / shareholder structure and positive/negative changes.

For an exact representation and description of the data included, please contact your Creditsafe contact.

RESET CREDITSAFE ASSIGNMENT

If an incorrect Creditsafe ID has been assigned to a company by mistake, the company must be informed accordingly. To remove

the link again. To do this, the incorrectly assigned contact / customer / vendor is called up.

If you call up the "Delete creditworthiness information" action within the "Last creditworthiness report" info box, the assignment

is cancelled.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Creditworthiness reports that have already been retrieved are marked as "Invalid" and are no longer used for the display.

Consequently, the new company search can be started and the correct company assigned via the "Last credit report" / "Query

creditworthiness" call.

No retrieved reports or log entries are deleted!

UPDATE ADDRESS DATA

In addition to the pure creditworthiness data, the connection to the Creditsafe WebService is also able to return the current,

validated address data to Microsoft Dynamics 365 Business Central1. This ensures that no outdated address data exists in the

address master.

Depending on the setup, you can specify whether changed address data should be applied automatically, by user query or not at

all. 

If this setting has the value "User query", the user is informed of the changed values with a change mask depending on the

processing type of the query. If background processing ("Query report via task queue") is disabled or if the query is from the

company search, a change of address window is displayed immediately after the report has been retrieved. 

If background processing is activated, the "Changed address data" field in the "Last credit report" info box for the contact/

debtor/creditor is displayed with the value "Yes". In this case, the identical window opens only after clicking on the value "Yes".

Within the window the existing address from the data master is displayed.

You can transfer any individual value from the master record or the Creditsafe record to the resulting record in the above display

by clicking on the value. 

If you want to apply all values of a record, you can click the "Apply All" button either in the "Database" or "Creditsafe" column. 

Furthermore, the values in the "Resulting record" area can also be edited manually. After data maintenance has been completed,

you can transfer the values from the resulting data record to the master record using the "Update customer" or "Update vendor"

or "Update contact" action.

Afterwards the selected data will be taken over into the master data record. The window "Creditsafe address matching" closes

and the value "Changed address data" within the infobox is reset to the value "No".

If you do not want to perform any update, you can simply close the "Creditsafe Address Matching" window. In this case, no

changes will be made to the master record and the value "Changed address data" within the info box will remain with the value

"Yes".

MANAGE PORTFOLIOS

In portfolios at Creditsafe, companies can be grouped in order to be able to monitor them and to start actions depending on

events. 

The portfolios are exchanged bi-directionally between the (protected) Creditsafe website and your Business Central system, so

that a group created in Business Central is also visible from the website access and the contained companies can be seen and

edited from both systems.

To create a portfolio in Microsoft Dynamics 365 Business Central1 or check the existing portfolios, open the "Creditsafe

Portfolios" window from the "Creditsafe Service Setup".

Update portfolios

Since, in principle, portfolios can be created not only via "Credit-Check App powered by Creditsafe", but additionally via the

Creditsafe web interface, they must be compared against each other. 

While portfolios created in Microsoft Dynamics 365 Business Central1 are automatically transferred to Creditsafe in the

background, the Creditsafe website cannot automatically write to the Business Central database. 

Note
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In order to nevertheless transfer the portfolios created there to Business Central, the action "Update portfolios" has been

developed. After calling this function, a connection to the Creditsafe service is established and the portfolios stored there are

retrieved and compared with the portfolios already created in Business Central.

Create portfolio

To generate a new portfolio from Microsoft Dynamics 365 Business Central1, create a new record in the "Creditsafe Portfolios"

window via the "New" action. After you have given the new portfolio a name and the record has been inserted, it is automatically

transferred to the Creditsafe service in the background and created there as a new portfolio as well.

Delete portfolio

To delete an existing portfolio from Microsoft Dynamics 365 Business Central1, switch to the corresponding record in the

"Creditsafe Portfolios" window and start the "Delete" action. The portfolio will be deleted in the Business Central database and

the delete command will be passed to the Creditsafe service in the background.

Include companies in portfolio

In order for a company to be monitored within a portfolio, it must be assigned to the portfolio. There are two different ways to do

this, which can be used from the respective starting point of the call.

Please note that only companies can be assigned to a portfolio if the property "Monitoring possible" is activated for the

corresponding data set. This property depends on the respective data set as well as on your Creditsafe contract. If you have any

questions, please contact your Creditsafe advisor.

Portfolio list - add company

Provided that you have called the portfolio list from the "Setup Creditsafe service", you can call the list of companies assigned to

this portfolio by selecting a record and calling the action "Companies". 

Within the opened list "Creditsafe Portfolio Companies" you can create a new assignment via the action "New" and add the

related company to the portfolio by specifying the corresponding Creditsafe ID.

Company card - Add to portfolio

If you have opened the contact / accounts receivable or accounts payable card of a company that you have assigned to a Portfolio,

you can add a portfolio to the info box by clicking on the item "Number of Portfolios" to open the "Creditsafe Portfolio Company"

window.

Within the opened "Creditsafe Portfolio Companies" list, you can create a new assignment using the "New" action and add the

company to the respective portfolio by specifying the corresponding portfolio.

Remove company from portfolio

To remove a company from monitoring within a portfolio, there are two different ways that can be used starting from the

respective starting point of the call.

Portfolio list - remove company

Provided that you have called the portfolio list from the "Setup Creditsafe service", you can use Selecting a record and invoking

the "Company" action will bring up the list of companies that are are allocated to this portfolio.

Within the opened "Creditsafe Portfolio Company" list, you can use the "Delete" action to delete remove an existing assignment.

The change is sent directly after the action to the Creditsafe service forwarded, so that the assignment is also removed on the

Creditsafe website.

Company card - Remove from portfolio

If you have opened the contact / accounts receivable or accounts payable card of a company that you want to remove from a

portfolio, within the info box you can use the link of the item "Number of Portfolios" to open the "Creditsafe Portfolio Company"

window.

Note
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Within the opened "Creditsafe Portfolio Company" list, you can use the "Delete" action to delete remove an existing assignment.

The change is sent directly after the action to the Creditsafe service forwarded, so that the assignment is also removed on the

Creditsafe website.

CHECK PROTOCOL

In the Creditsafe log, every query made against the Creditsafe web service is procollated. You can reach the log via the user

search, the role center or the navigation menu as "Creditsafe request log". 

In the subsequent list, all performed queries are listed chronologically. The query parameters are displayed as well as the date &

time and the user ID of the querier. Furthermore, the response data as well as the response date and time are listed. The status

and the status description are also included, so that in the event of an error, the status description can be used for

troubleshooting. 

Depending on the query type, the actions can be used to display the creditworthiness report or the response XML data structure.

SET UP TASK QUEUE ITEMS

Two task queue items have been automatically created via the "Credit-Check App powered by Creditsafe" setup. The list of task

type queue items can be opened via the user search or the role center via the term "Task queue items".

Update run due to update cycle

The task queue item "KVSCRSJobIntervalUpdateReport" is based on the code unit 70259981 and can be used to trigger a regular

update of the creditworthiness reports depending on the setup parameter "Update cycle" (see Update cycle). The task start time

is set to "04:00" by default and can be customized.

The update run only takes into account companies for which online report retrieval is possible. If only an offline report is available

for a company due to company or country restrictions, it will not be automatically re-requested.

Update run due to portfolio update

The item "KVSCRSJobUpdatePortfolio" is based on code unit 70259982 and is used to query the created portfolios at regular

intervals and to automatically update the creditworthiness reports for the changed master data in the event of changed data. The

start time of the task is set to the value "02:00" by default and can be customized. 

Via the creation of the task queue items, both tasks are created as "Recurring tasks" with a "Number of minutes between

executions" of 1440, which corresponds to a daily run. If a different rotation is desired, the parameters of the task queue items

can be changed here.

The update run only takes into account companies for which online report retrieval is possible. If only an offline report is available

for a company due to company or country restrictions, it will not be automatically re-requested.

SET UP WORKFLOWS

About the setup of "Credit-Check App powered by Creditsafe" two workflow templates have been created, which are can be used

to create workflows that react in the background to changes in creditworthiness data. react.

Workflow template KVSCREDITSAFE-BLOCK - "Block a customer/vendor due to a credit report"

The workflow template "KVSCREDITSAFE-BLOCK" / "Create a customer/vendor based on a credit report Block" is set up by

default in such a way that when a new creditworthiness report is created for a debtor or creditor, if the valuation of the report

shows the value "D" or "E", first the credit limit is set according to the proposed credit limit of the credit report and then the

Master record is locked.

Note

Note
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Workflow template KVSCREDITSAFE-LIMIT - "Set credit limit based on credit report"

The workflow template "KVSCREDITSAFE-LIMIT" / "Set credit limit based on credit report" sets on the basis of a newly prepared

creditworthiness report for a debtor, the credit limit is increased to the level set by Creditsafe proposed value unless the

valuation of the debtor corresponds to the value "D" or "E".

What happens after the free trial

What happens after the free trial? from KUMAVISION on Vimeo.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 

1.3.6 Credit-Check App powered by Creditsafe

- 1277/1545 - Copyright © 2018 - 2024 KUMAVISION AG

https://vimeo.com/630099904
https://vimeo.com/kumavision
https://vimeo.com


1.3.7 DMS & ECM Interface

DMS & ECM Interface

UNDERSTANDING THE DMS & ECM INTERFACE

The DMS & ECM interface creates a generic interface between the ERP system Microsoft Dynamics 365 Business Central1 and

various DMS and ECM systems.

In the first step, the systems Microsoft1 SharePoint Online and Hyland Saperion ECM2 will be connected. This is followed by

the integration of ELO Digital Office3. By providing an interface structure, the interface is generally able to connect other

systems and thus provide the integration generically.

The interface can be used to display structured document displays in the master and transaction data of Microsoft Dynamics 365

Business Central1, as well as to store data-related documents in a structured way in a simple and convenient way. Furthermore,

any documents and reports from the ERP system can be automatically stored in the document management system.

SUPPORTED DMS & ECM SYSTEMS

Currently, the following systems are supported:

Microsoft1 SharePoint Online (using the MS Graph API)

Hyland Saperion ECM2

ELO Digital Office3 (using either the "Indexserver REST Interface" or the "REST API Service")

STRUCTURE & BASIC PRINCIPLES OF THE INTERFACE

Since the interface was created generically and therefore no manufacturer-dependent features of the DMS & ECM systems had

to be taken into account, the basic structuring of the setup parameters as well as the use of the interface is always identical

regardless of the DMS/ECM system.

In order to better understand the processes and structures, the basic principle of the different definitions to be set up is

explained below. The setup of the connection itself will follow in the chapter Installation & Setup.

Storage Definitions

Storage definition, as the name suggests, describes the type and properties of how documents for each Microsoft Dynamics 365

Business Central1 record are to be stored.

On the one hand, this refers to document storage via "Drag & Drop" and on the other hand to the automatic archiving of

documents from Microsoft Dynamics 365 Business Central1 (e.g. via report archiving).

The storage definitions are always based on an underlying table from Microsoft Dynamics 365 Business Central1 (for example,

table number 18 for customer records). For further limitations, filters can be set to the respective table, so that different

definitions can be created for overarching tables (e.g. table number 36 - sales header) in which different data is stored. If

required, several storage definitions can also be created for each table in order to be able to cover certain sub-areas.

In the storage definitions, the directory or directory path for storing the data is also stored. In addition, a folder structure for the

manual selection of subdirectories can be stored during storage.

Finally, the storage definition includes the assignment of the index terms from the DMS / ECM system to the fields or functions

from Microsoft Dynamics 365 Business Central1. This is where you can specify which index terms are to be assigned

automatically or manually by the user for each document.

Search Definitions

The search definitions are used to store a dynamic assignment of the search criteria and the settings for the document search.

The search definitions are also always based on an underlying table from Microsoft Dynamics 365 Business Central1 (for

example, table number 18 for customer records).

• 

• 

• 
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In addition to the basic settings, the index fields for filtering and the directories to be searched are set up here.

Display Definitions

In addition to the general display settings, the display definitions determine which index terms are to be displayed in the

document list in Microsoft Dynamics 365 Business Central1. Furthermore, groupings for the hierarchical classification of

documents can be defined here.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

All Hyland product names are registered or unregistered trademarks of Hyland Software, Inc. or its affiliates in the United States and
other countries. 

ELO, ELOprofessional, ELOenterprise, ELOoffice and ELO ECM-Suite are registered trademarks of ELO Digital Office GmbH in Germany
and/or and other countries. 

1. 

2. 

3. 
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Installation & Setup

SETUP IN BUSINESS CENTRAL

Activation of the module

Before the module can be used, it may need to be replaced. in the KUMAVISION Module Setup. To do this, go to the 

KUMAVISION Module Setup page, e.g. via the Tell-Me functionality, and check whether the module is activated on the page

within the Settings section.

Assisted Setup

You can use the Assisted Setup to set up the DMS & ECM Interface. To do this, call up the Assisted Setup page, e.g. via the

Tell-Me function. Here you will find the entry Setup the uploading and viewing of documents in external DMS or ECM system.

under the heading Connecting to other systems. The Assisted Setup guides you through setting up the interface in a step-by-step

guide.

Alternatively, you can use the Manual Setup function, which can also be used to set or modify all setup parameters.

When using the Assisted Setup, we recommend using the maximized windowed mode to display all the necessary information,

especially with regard to table representations.

Step 1: Storage Type and Language Code

In this step, you can decide which type of archiving system you want to connect.\ The following options are currently available by

default:

Microsoft1 SharePoint Online

ELO Digital Office - REST API Service3

ELO Digital Office - Indexserver REST Interface3

Hyland Saperion ECM2

You can also set the default language code in this setup step.

This is required, among other things, when calculating option or enumeration values if a user accesses the environment from a

different region or with a different language code.

Since the index terms are generated in the user's context, without the central language code, there would be different index

labels for the same value!

Step 2: Authorization

Depending on the DMS or ECM system used, different authentication procedures for the API connection are provided by the

manufacturers. For example, logging in to the Hyland Saperion WebService2 is done using Basic Authentication, whereas the MS

Graph API, which is used to connect to Microsoft1 SharePoint Online, requires the OAuth2 login process.

For this reason, 2 selection fields are used for the Authorization Type as well as the Authorization Type for Job Queue. Choose

from the different types of authentication.

In general, there does not have to be a distinction between Authorization Type and Authorization Type for Job Queue. However,

especially in the area of OAuth 2.0, a distinction between application authentication and delegated authentication is possible. For

example, for SharePoint Online login, delegated authentication using OAuth 2.0 - Authorization Code Flow is normally used

as the authorization method, whereas login via the job queue is normally done via application authentication and thus via the 

OAuth 2.0 - Client Credentials flow.

Depending on the authentication method selected, the required setup fields are displayed.

Authentication via OAuth 2.0 - Authorization Code Flow

An OAuth 2.0 authorization code flow requires you to set up an app registration for delegated access in Azure AD.

• 

• 

• 

• 
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Then, in the OAuth 2.0 Authorization Code Flow Settings section, provide the following information:

Authentication via OAuth 2.0 - Client Credentials

To use OAuth 2.0 client credentials, you need to set up an app registration for application permissions in Azure AD.

Then, in the OAuth 2.0 Client Credentials Settings section, provide the following information:

Basic Authentication

At this point, central credentials can be stored. These are used unless individual user-related credentials are stored in the user

settings of the application.

Step 3: Central Settings

Field Description

Client ID Enter the "Application ID (Client)" here, which will be displayed in the overview within the app

registration.

Client Secret Here, paste the client secret that you created and copied in step 3 of app registration setup.

Scopes Here you can pass additional API permissions (scopes) for the Graph API. In the background, the value 

https://graph.microsoft.com/.default is always transmitted as the default scope, so that this field can

normally remain empty.

AAD Tenant Id If Microsoft Dynamics 365 Business Central1 and SharePoint Online are running in the same Azure AD,

there is no need to transfer an AAD Tenant ID at this point and the field can be left blank. However, if the

two environments are in different Azure AD, the unique GUID of the Azure AD in which SharePoint Online

is operated must be entered here.

Field Description

Client ID Enter the "Application ID (Client)" here, which will be displayed in the overview within the app

registration.

Client Secret Here, paste the client secret that you created and copied in step 3 of app registration setup.

Scopes Here you can pass additional API permissions (scopes) for the Graph API. In the background, the value 

https://graph.microsoft.com/.default is always transmitted as the default scope, so that this field can

normally remain empty.

AAD Tenant Id If Microsoft Dynamics 365 Business Central1 and SharePoint Online are running in the same Azure AD,

there is no need to transfer an AAD Tenant ID at this point and the field can be left blank. However, if the

two environments are in different Azure AD, the unique GUID of the Azure AD in which SharePoint Online

is operated must be entered here.

Field Description

Default

Username

At this point, enter the default user name that is to be used for authentication using the Basic

Authentication procedure. If a separate user name is stored for the connection in the user-specific

settings, the value stored there will be used instead of the name stored here.

Default User

Password

At this point, enter the password of the default user for authentication using the Basic Authentication

procedure. If a separate user name is stored for the connection in the user-specific settings, the

password stored there will be used instead of the one stored here.
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The central settings define basic setup steps that must be completed before the interface can be operated.
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Field Description

Host Name First of all, the hostname (the web address) of your DMS environment must be stored. You can

view the hostname by opening any page of your DMS environment in the browser. Now copy the

address from your browser's address bar into this field.

In terms of connection to Hyland Saperion2, the service is usually accessible by the name followed

by the application identifier "/ecmservice/api".

Always show files by

search definitions

The files to be displayed can be selected in two ways. Either the system can retrieve a specific

directory in the archive and display the files contained therein, or the system searches for the

corresponding entries by means of keywords via the archive.

By default, both options can be used.

If this setting is enabled, however, the selection by directory is prevented.

This is recommended if the archiving solution you are using does not support directory structures

or manages directories independently, e.g. Shareflex or Saperion.

Otherwise, the setting should not be enabled.

Document Factbox

Display Type
The infobox "Documents" in the Microsoft Dynamics 365 Business Central1 records can be created

in different forms, depending on your wishes or the archive system used.

The display type stored here can be overridden per display definition, so that this value is only a

basic setting.

By default, the following display types are available:

Standard (Microsoft Dynamics 365 Business Central1 page)

In this case, a standard page is used to display the hits. The advantage lies in the near-standard

display. A disadvantage is the space requirement of the control due to non-adjustable spacing and

formatting as well as the currently limited possibility of opening and closing the tree structure.

(default BC error)

Custom Control AddIn

The Control add-in displays a simple tree structure as a TreeView-Javascript Control add-in.

Common standard mechanisms from web development are used here, so that it leads to a simple

and fast display type.

Web-Link of DMS

In the case of web linking, the DMS system used can itself transmit a display as a web page to the

interface and thus display it as an independent frame. This solution is not currently implemented

by either Saperion or SharePoint and is not expected to be used until the connection to ELO Digital

Office3.

Document Link

Display Type

If a document is opened for display, you can use the "Document Link Display Type" to specify which

viewer is to be used for the display.

The display type stored here can be overridden per display definition, so that this value is only a

basic setting.

By default, the following display types are available:

Internal Document Viewer

In the internal document view, the data stream of the document is "packaged" into an HTML5

display and displayed using the standard BC WebBrowser AddIn. Depending on the type of

document, different integrations are possible, so that, for example, image documents are

interpreted differently than PDF documents.

External Hyperlink

In the case of external link linking, the link that is transmitted via the DMS system is called instead

of the document itself. For example, the document opens externally in SharePoint instead of BC.

It is important to note that authorizations must be stored accordingly, especially with regard to

cross-domain systems!

When documents are posted, document archiving can be used to ensure that the corresponding

documents created are automatically archived. Use this switch to specify whether archiving is to
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Field Description

Archive posted

Documents by Job

Queue

be carried out via background processing of the task queue in this case. If this switch is not

activated or if it is not possible to create tasks in this session, archiving takes place as part of the

foreground session.

Auto. update Files on

Sales-Post

Specify what to do with documents if a sales posting is made and the original document (for

example, the sales order) is subsequently deleted.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record is then

deleted from Microsoft Dynamics 365 Business Central1, the index terms can be updated with the

current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new document type (for example, posted sales invoice), this

option moves the documents from the source document to the directory of the target document

and updates the index terms at the same time.

Thus, for example, the documents that were assigned to an order are automatically included in the

resulting invoice via background processing.

Important: Moving documents requires that the DMS system allows it!

Auto. update Files on

Sales-Release

Specify what to do with documents when releasing sales documents.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

When using this option, the index terms are updated after they are released.

Auto. update Files on

Reminder-Issue

Specify what to do with documents if a reminder is issued and the original document is

subsequently deleted.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record is then

deleted from Microsoft Dynamics 365 Business Central1, the index terms can be updated with the

current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new document type (issued reminder), this option moves the

documents from the source document to the directory of the target document and updates the

index terms at the same time.

Thus, for example, the documents that were assigned to the reminder are automatically included in

the resulting issued reminder via background processing.

Important: Moving documents requires that the DMS system allows it!
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Step 4: Select Pages

In the course of this step, the interface queries all pages from the DMS and displays them here as a list. Within the list, it is now

possible to define which pages should be used for the interface.

Field Description

Auto. update Files on

Purch.-Post

Specify how documents are to be handled if a purchase transaction is made and the original

document (for example, the purchase order) is subsequently deleted.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record is then

deleted from Microsoft Dynamics 365 Business Central1, the index terms can be updated with the

current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new document type (for example, posted purchase invoice),

this option moves the documents from the source document to the directory of the target

document and updates the index terms at the same time.

Thus, for example, the documents that were assigned to a purchase order are automatically

included in the resulting invoice via background processing.

Important: Moving documents requires that the DMS system allows it!

Auto. update Files on

Purch.-Release

Specify how documents are to be handled when purchasing documents are released.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

When using this option, the index terms are updated after they are released.

Auto. update Files on

Prod. Order Status

Change

Specify what to do with documents when the status of a production order changes. Because the

status of an FA is part of the primary key of the operation, documents from BC may not be

retrievable after the state change.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record from

Microsoft Dynamics 365 Business Central1 is then renamed, the index terms can be updated with

the current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new status (e.g. Released FA), this option moves the

documents from the source document to the directory of the target document and updates the

index terms at the same time.

Thus, for example, the documents that were assigned to a planned FA are automatically

transferred to the resulting released FA via background processing.

Important: Moving documents requires that the DMS system allows it!
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Since there are no pages related to the Hyland Saperion ECM2 system, the static "page" labeled "Saperion" is displayed on it.

Step 5: Select Document Drives

In step 5, the document drives / archives are related to the respective page and displayed for selection. At this point, you can

select which libraries / archives are intended for the interface.

Furthermore, a unique Document Drive Code must be stored for each selected data set at this point. This serves as a unique key

for administration and assignment in further processing within BC.

Step 6: Keywords

In this step, select all keywords that you want to populate by data from Microsoft Dynamics 365 Business Central1 or use to

search for documents.

In addition, a unique code must be stored for each selected keyword, which is used to reference the corresponding keyword

within Microsoft Dynamics 365 Business Central1.

Additionally predefined keywords such as Customer No. or Project No. can be assigned in the corresponding column. The

predefined keywords are used in the following steps of the wizard for additional setups. Please select the appropriate predefined

keyword for each of the selected keywords - if none of the predefined keywords fit, do not enter one.

You may see problems in the Warning column, such as The tag does not exist in the libraries: xxx. This is just an indication

that you have used keywords that are not available in every library and therefore may not be used across the board.

Step 7: Set up display definitions

Display definitions can already be defined in this step. To do this, the step is divided into the following paragraphs:

Grouping

By default, the list of documents displayed in Microsoft Dynamics 365 Business Central1 is sorted and grouped according to the

folder structure of the archiving system. Alternatively, keywords can be defined to sort and group the documents.

Additional Columns

The list of documents within the infobox always displays the file names of the documents when using SharePoint Online. At this

point, you can already specify additional columns to display in the lists.

If you are using a system other than SharePoint Online for archiving, columns must be selected because the file name is not yet

available there at the time of display.

More Display Definitions

If you want to use different settings for different types of data, you can already define other display definitions here that can be

used in the other facilities. Further settings of the display definitions can be found in the Display Definitions setup step.

Step 8: Selecting the Storage Definitions

The storage definitions specify where uploaded documents should be stored and which keywords should be assigned to them.

In the list of the setup step, a set of prepared file definitions appears from which you can select the storage definitions with

which documents are to be stored. This list is not exhaustive, but can be supplemented by your own storage definitions, which

can be added in the next step of the wizard.

Step 9: Maintain the storage definitions

The list lists the selected storage definitions. For each entry, the desired document drive for archiving and, depending on the

DMS system used, the directory for filing must be stored.

Note

Important
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The directory can contain placeholders that are automatically populated with the data from the BC record when a document is

uploaded. Some suggested placeholders have been auto-supplemented. If necessary, any additional placeholders can be added

and used.

Furthermore, any other settings of the storage definitions can also be changed. If keywords are used without a predefined

keyword type, they must be manually supplemented and provided with the respective data sources.

When the settings for a storage definition are complete, they can be activated with the "Active" marker. In order to be able to use

a storage definition, the "Active" switch must be set.

For more details on creating and customizing the storage definitions, see the chapter Storage Definitions.

Step 10: Set up your search definitions

By default, this app displays the files for each record that are directly linked to that record. In many cases, however, other files

are also of interest. For example, if the files for a customer are viewed, not only the files directly linked to this customer are

relevant, but also those that are linked to invoices or projects of the customer. In order to be able to view them, search

definitions can be set up. They use the keywording via the index terms to search for all files, e.g. by displaying all files tagged

with a specific customer number.

The following list displays all tables for which there is a storage definition. One keyword can be entered per table to search for

files - if this is not desired for a table, the keyword can simply be left blank. In addition, the "Standard" column can be used to

specify whether the files should be searched by the keyword by default - in this case, Microsoft Dynamics 365 Business Central1

will automatically display the files based on this search definition when a page is opened. If you want to use more than one

search definition for a table, you can create additional search definitions yourself in the next step of the wizard.

Step 11: Maintain search definitions

In this setup step, the search definitions are finalized.

The list of created search definitions can be used to change the default settings if necessary.

If keywords have been stored without a predefined keyword type, the data source must be specified for each of them.

Once the settings for a search definition have been finalized, it can be activated via the "Active" column. In order to be able to

use a search definition, the "Active" switch must be set.

For more details on how to create and customize search definitions, see the chapter Search Definitions.

Step 12: Automatic Report Archiving

In addition to manually uploading documents to a master record or process, documents can also be automatically integrated in

the course of creation from Microsoft Dynamics 365 Business Central1. This applies, for example, to the documents and reports

that are generated from Microsoft Dynamics 365 Business Central1.

In this setup step, documents and reports can be selected from a prepared list, which will be used for an automatic upload to the

DMS system as soon as the respective document is generated.

Additional reports can be added as needed in the next setup step.

Step 13: Automatic Report Archiving Setups

For each selected report, a storage definition can be assigned, which defines, for example, with which keywords the report is to

be saved in the DMS system. If no storage definition is assigned at this point, the best possible storage definition based on the

sorting sequence and any table filters used is used at report runtime based on the respective data record.

In addition, an entry for the storage of the document can be selected from the list of subdirectories of the respective storage

definition. Furthermore, the desired file name must be stored. In this case, it is possible to use placeholders of the respective

storage definition for the dynamic generation of the file names.

This step completes the Assisted Setup. In general, this Assisted Setup can be called again and again. Each individual step of the

setup can also be accessed via the Manual Setup.
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Manual Setup

The manual setup of the DMS & ECM Interface can be found via the Advanced Settings as well as via the Manual Setup page

and selecting the entry Setting up the DMS and ECM interface or via the Tell-Me search for Document Storage Setup.

Document Storage Setup

In the document storage setup, the basic settings for the connection of the DMS or ECM system used in each case are made. All

the individual components of the facility are described below.

General
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In the "General" area, basic settings for the DMS / ECM system used and for connectivity are stored.
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Field Description

Storage Type Specify here which type of archiving system you want to connect.

The following options are currently available by default:

Microsoft1 SharePoint Online

ELO Digital Office3

Hyland Saperion ECM2

Host Name The hostname refers to the web address of your DMS environment through which a connection is

made. If you are using Microsoft1 SharePoint Online as your archive system, you can view the host

name by opening any page in your DMS environment in the browser. Now copy the address from your

browser's address bar into this field.

In relation to the connection to Hyland Saperion ECM2, the address of the ECMService API is entered

at this point. The service is usually accessible via the name of the server followed by the application

identifier "/ecmservice/api".

Language Code The language code stored here is required, among other things, for the calculation of option or

enumeration values, if a user accesses the environment from a different region or with a different

language code.

Since the index terms are generated in the user's context, without the central language code, there

would be different index labels for the same value.

Authorization

Type

Specify the type of authorization to be used to authenticate users to the DMS/ECM system. Depending

on the authorization method chosen, the required setup fields are displayed in separate areas.

By default, you can choose from the following values:

No Authentication

In this case, the requests to the archive system are not enriched with authentication. This option

should be used if access to the archive system is secured by other approaches and not protected by

login.

OAuth 2.0 - Authorization Code Flow

Use this option to enable a delegated login to the archive system via authorization code flow. By

default, this procedure is used for per-user access to Microsoft1 SharePoint Online. For this purpose, a

so-called bearer token is obtained from the authorization office via an authorization query, by means of

which the actual query is carried out.

For more information on this procedure, please refer to the following link: \<https://

learn.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-auth-code-flow>

OAuth 2.0 - Client Credentials

The OAuth 2.0 Client Credentials Flow is a process in which it is not the actual user, but an application,

such as a web service, that is authorized to log on to another application. By default, this procedure is

used for application-side access to Microsoft1 SharePoint Online without direct user interaction. In this

procedure, too, a so-called bearer token is obtained from the authorization office via an authorization

query, by means of which the actual query is carried out.

For more information on this procedure, please refer to the following link:\<https://

learn.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-client-creds-grant-flow>

Basic Authentication

In this procedure, a user name and a corresponding password are given in a Base64-encoded text in a

header information of the web request and used to log on to the target system. For example, this

procedure is used by default for authorization to the Hyland Saperion ECM2 API service.

Specify the login procedure to be used for authenticating background processes to the DMS / ECM

system. This information is only used for actions taken through the task queue that do not allow for
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OAuth 2.0 Authorization Codeflow Settings

The area is only visible if the Authorization Type or the Authorization Type for Job Queue has been set to the value OAuth 2.0 -

Authorization Code Flow!

An OAuth 2.0 authorization code flow requires you to set up an app registration for delegated access in Azure AD.

Then, in the OAuth 2.0 Authorization Code Flow Settings section, provide the following information:

OAuth 2.0 Client Credentials Settings

The area is only visible if the Authorization Type or the Authorization Type for Job Queue has been set to the value OAuth 2.0 -

Client Credentials!

Field Description

Authorization

Type for Job

Queue

interactive user intervention. Depending on the authentication method chosen, the required setup

fields are displayed in separate areas.

By default, you can choose from the following values:

No Authentication

In this case, the requests to the archive system are not enriched with authentication. This option

should be used if access to the archive system is secured by other approaches and not protected by

login.

OAuth 2.0 - Authorization Code Flow

Use this option to enable a delegated login to the archive system via authorization code flow. By

default, this procedure is used for per-user access to Microsoft1 SharePoint Online. For this purpose,

a so-called bearer token is obtained from the authorization office via an authorization query, by means

of which the actual query is carried out.

For more information on this procedure, please refer to the following link:\<https://

learn.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-auth-code-flow>

OAuth 2.0 - Client Credentials

The OAuth 2.0 Client Credentials Flow is a process in which it is not the actual user, but an application,

such as a web service, that is authorized to log on to another application. By default, this procedure is

used for application-side access to Microsoft1 SharePoint Online without direct user interaction. In this

procedure, too, a so-called bearer token is obtained from the authorization office via an authorization

query, by means of which the actual query is carried out.

For more information on this procedure, please refer to the following link:\<https://

learn.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-client-creds-grant-flow>

Basic Authentication

In this procedure, a user name and a corresponding password are given in a Base64-encoded text in a

header information of the web request and used to log on to the target system. For example, this

procedure is used by default for authorization to the Hyland Saperion ECM2 API service.

Field Description

Client ID Enter the "Application ID (Client)" here, which will be displayed in the overview within the app

registration.

Client Secret Here, paste the client secret that you created and copied in step 3 of app registration setup.

Scopes Here you can pass additional API permissions (scopes) for the Graph API. In the background, the value 

https://graph.microsoft.com/.default is always transmitted as the default scope, so that this field can

normally remain empty.

AAD Tenant Id If Microsoft Dynamics 365 Business Central1 and SharePoint Online are running in the same Azure AD,

there is no need to transfer an AAD Tenant ID at this point and the field can be left blank. However, if the

two environments are in different Azure AD, the unique GUID of the Azure AD in which SharePoint Online

is operated must be entered here.
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To use OAuth 2.0 client credentials, you need to set up an app registration for application permissions in Azure AD.

Then, in the OAuth 2.0 Client Credentials Settings section, provide the following information:

Basic Authentication Settings

The area is only visible if the Authorization Type or the Authorization Type for Job Queue has been set to the value Basic

Authentication!

This area is where the settings for basic authentication are made. These are used unless individual user-related credentials are

stored in the user settings of the application.

Show Files

Field Description

Client ID Enter the "Application ID (Client)" here, which will be displayed in the overview within the app

registration.

Client Secret Here, paste the client secret that you created and copied in step 3 of app registration setup.

Scopes Here you can pass additional API permissions (scopes) for the Graph API. In the background, the value 

https://graph.microsoft.com/.default is always transmitted as the default scope, so that this field can

normally remain empty.

AAD Tenant Id If Microsoft Dynamics 365 Business Central1 and SharePoint Online are running in the same Azure AD,

there is no need to transfer an AAD Tenant ID at this point and the field can be left blank. However, if the

two environments are in different Azure AD, the unique GUID of the Azure AD in which SharePoint Online

is operated must be entered here.

Field Description

Default

Username

At this point, enter the default user name that is to be used for authentication using the Basic

Authentication procedure. If a separate user name is stored for the connection in the user-specific

settings, the value stored there will be used instead of the name stored here.

Default User

Password

At this point, enter the password of the default user for authentication using the Basic Authentication

procedure. If a separate user name is stored for the connection in the user-specific settings, the

password stored there will be used instead of the one stored here.
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This section is used to make basic settings for displaying files.

Archiving Files

Field Description

Always show files by

search definitions

The files to be displayed can be selected in two ways. Either the system can retrieve a specific

directory in the archive and display the files contained therein, or the system searches for the

corresponding entries by means of keywords via the archive.

By default, both options can be used.

If this setting is enabled, however, the selection by directory is prevented.

This is recommended if the archiving solution you are using does not support directory structures

or manages directories independently, e.g. Shareflex or Saperion.

Otherwise, the setting should not be enabled.

Document Factbox

Display Type
The infobox "Documents" in the Microsoft Dynamics 365 Business Central1 records can be created

in different forms, depending on your wishes or the archive system used.

The display type stored here can be overridden per display definition, so that this value is only a

basic setting.

By default, the following display types are available:

Standard (Microsoft Dynamics 365 Business Central1 page)

In this case, a standard page is used to display the hits. The advantage lies in the near-standard

display. A disadvantage is the space requirement of the control due to non-adjustable spacing and

formatting as well as the currently limited possibility of opening and closing the tree structure.

(default BC error)

Custom Control AddIn

The Control add-in displays a simple tree structure as a TreeView-Javascript Control add-in.

Common standard mechanisms from web development are used here, so that it leads to a simple

and fast display type.

Web-Link of DMS

In the case of web linking, the DMS system used can itself transmit a display as a web page to the

interface and thus display it as an independent frame. This solution is not currently implemented by

either Saperion or SharePoint and is not expected to be used until the connection to ELO Digital

Office3.

Document Link

Display Type

If a document is opened for display, you can use the "Document Link Display Type" to specify which

viewer is to be used for the display.

The display type stored here can be overridden per display definition, so that this value is only a

basic setting.

By default, the following display types are available:

Internal Document Viewer

In the internal document view, the data stream of the document is "packaged" into an HTML5

display and displayed using the standard BC WebBrowser AddIn. Depending on the type of

document, different integrations are possible, so that, for example, image documents are

interpreted differently than PDF documents.

External Hyperlink

In the case of external link linking, the link that is transmitted via the DMS system is called instead

of the document itself. For example, the document opens externally in SharePoint instead of BC.

It is important to note that authorizations must be stored accordingly, especially with regard to

cross-domain systems!
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In the Archiving Files area, you can make basic settings for automatic archiving and for the behavior of certain business

processes.
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Field Description

Archive posted

Documents by Job

Queue

When documents are posted, document archiving can be used to ensure that the corresponding

documents created are automatically archived. Use this switch to specify whether archiving is to

be carried out via background processing of the task queue in this case. If this switch is not

activated or if it is not possible to create tasks in this session, archiving takes place as part of the

foreground session.

Auto. update Files on

Sales-Post

Specify what to do with documents if a sales posting is made and the original document (for

example, the sales order) is subsequently deleted.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record is then

deleted from Microsoft Dynamics 365 Business Central1, the index terms can be updated with the

current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new document type (for example, posted sales invoice), this

option moves the documents from the source document to the directory of the target document

and updates the index terms at the same time.

Thus, for example, the documents that were assigned to an order are automatically included in the

resulting invoice via background processing.

Important: Moving documents requires that the DMS system allows it!

Auto. update Files on

Sales-Release

Specify what to do with documents when releasing sales documents.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

When using this option, the index terms are updated after they are released.

Auto. update Files on

Reminder-Issue

Specify what to do with documents if a reminder is issued and the original document is

subsequently deleted.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record is then

deleted from Microsoft Dynamics 365 Business Central1, the index terms can be updated with the

current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new document type (issued reminder), this option moves the

documents from the source document to the directory of the target document and updates the

index terms at the same time.

Thus, for example, the documents that were assigned to the reminder are automatically included in

the resulting issued reminder via background processing.
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Document Drives

Field Description

Important: Moving documents requires that the DMS system allows it!

Auto. update Files on

Purch.-Post

Specify how documents are to be handled if a purchase transaction is made and the original

document (for example, the purchase order) is subsequently deleted.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record is then

deleted from Microsoft Dynamics 365 Business Central1, the index terms can be updated with the

current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new document type (for example, posted purchase invoice),

this option moves the documents from the source document to the directory of the target

document and updates the index terms at the same time.

Thus, for example, the documents that were assigned to a purchase order are automatically

included in the resulting invoice via background processing.

Important: Moving documents requires that the DMS system allows it!

Auto. update Files on

Purch.-Release

Specify how documents are to be handled when purchasing documents are released.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

When using this option, the index terms are updated after they are released.

Auto. update Files on

Prod. Order Status

Change

Specify what to do with documents when the status of a production order changes. Because the

status of an FA is part of the primary key of the operation, documents from BC may not be

retrievable after the state change.

The following options are available:

"" (Empty)

In this case, the documents remain unaffected by the "former" data record in the DMS. No further

action was taken.

Update Tags

If you use this option, the index terms will be updated again. Since the original record from

Microsoft Dynamics 365 Business Central1 is then renamed, the index terms can be updated with

the current transaction information for the last time.

Move Files & Update Tags

If there is a storage definition for the new status (e.g. Released FA), this option moves the

documents from the source document to the directory of the target document and updates the

index terms at the same time.

Thus, for example, the documents that were assigned to a planned FA are automatically

transferred to the resulting released FA via background processing.

Important: Moving documents requires that the DMS system allows it!
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From the Document Storage Setup you can call up the Document Drives action via the Setups action group. The document drives

or archives that have been stored and set up are listed there. If a new document drive is to be added, a new entry with a unique

code can be stored in the list and the Site Name and Drive Name columns can be used to refer to the archive system.

Archiving Tags

From the Document Storage Setup you can call up the Archiving Tags action via the Setups action group. The list displays all

tags from the archives that have been set up to be transferred from Microsoft Dynamics 365 Business Central1. If a new keyword

is to be used for the interface, a new record can be created in the list. The keyword must be unambiguous. The fields Pre-defined

Type, Table No. and Field No. can be taken here to make a preliminary definition of the keyword, but are not mandatory. On the

other hand, it is important to select the corresponding index term to be assigned from the archive system using the DMS Field

Code field. This is where the field from the archive system is stored, which is to be linked to the respective keyword.

From the SharePoint Refinable Property column, you can use a "refinable" variable (for example, "refinableString01") to be used

for cross-search properties if too many hits for filtering have been found. Detailed information on this is explained in the section 

Crawled Properties vs. Managed Properties.

In the Multiple value field column, you can specify whether the corresponding metadata information in the DMS supports the

storage of multiple values. If this is the case, you can activate this field to allow an assignment using multiple table records in the

storage definition.

Storage Definitions

From the Document Storage Setup you can call up the Storage Definitions action via the Setups action group. For general

information on storage definitions, see the corresponding chapter Storage Definitions.

General - Fields and Information
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This area displays general basic information for the storage definition.

Directory - Fields and Information

Field Description

Code This field identifies the unique code of the file definition.

Description The Description field can be used to store a description of the storage definition for easy assignment

and explanation.

For Table ID The For Table ID defines the unique table number from the Microsoft Dynamics 365 Business Central1

object list, which is to serve as the source data range for the corresponding storage definition. If, for

example, the storage definition is to be used for documents of a customer, the For Table ID must be set

to the value 18 for the customer table. The LookUp button can be used to open the object list for tables

to enable convenient selection of the desired table.

For Table Caption The For Table Caption field contains the object caption of the table selected in the For Table ID field.

For this reason, the value of this field cannot be changed manually.

Table Filters The Table Filters can be used to store filters, for example, to differentiate between storage definitions

for one and the same table in more detail. For example, the "Quote" and "Order" sales documents are

based on the same table (36).

The documents are differentiated by the Document Type field of the table. If different storage

definitions are to be used for quotes and orders, a corresponding filter can be stored here. In the case

of the quote, the filter dialog would be opened via the button of the field and a filter would be stored on

the field Document Type with the value Quote.

No Document

Upload allowed

You can use this field to deactivate an upload via the infobox for the corresponding storage definition.

The upload functionality in the infobox of the data set is thus prevented, so that only read-only access

to the archived documents is possible.

Only for

background

uploads

If this field is enabled, the corresponding storage definition is not available within the Documents

infobox of the record. Instead, this storage definition is only used to transfer documents to the archive

system in the background, e.g. when documents are printed or when a document is posted.

Display Definition

Code

At this point, you can select the display definition that is to be used as part of the storage definition for

column display and sorting. For more information on display definitions, see the chapter Display

Definitions.

Sorting No. Several storage definitions with different characteristics and facilities can be stored for a table. About

the sorting no., you can specify how the definitions are sorted when searching for a valid storage

definition for a specific scenario.

Active The Active switch indicates whether a storage definition is enabled for use. If changes are to be made

to the settings, the definition must first be disabled. After changes have been made, however, the

definition is activated and is thus also available for use in background processes.
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This area stores information about the archive and directory that is to be used for the documents of this storage definition.
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Field Description

Document Drive

Code

The Document Drive Code field specifies the archive in which files are to be stored based on the current

storage definition. The LookUp button displays the document drives that have been set up for selection

Document Drive

Name

The Document Drive Name field contains the name of the drive selected in the Document Drive Code

field. For this reason, the value of this field cannot be changed manually.

Directory Path The Directory Path contains the individual path within the archive system for storing documents. It is

only required if the underlying archive system supports the use of directories.

Wildcards can be used within the path specifications to dynamically map values based on the field values

from the Microsoft Dynamics 365 Business Central1 record. For example, a placeholder can be used for

the customer number, which creates a directory with that information. Nesting directories and dynamic

placeholders is also supported.

The available placeholders can be entered and viewed via the Placeholders field.

Placeholders Wildcards are used to dynamically map directory paths based on field values of a record in Microsoft

Dynamics 365 Business Central1. In order to be able to design these placeholders variably, the AssistEdit

button of the field can be used to call up the page Storage Definition Placeholders.

Within this page, any number of placeholders can be defined, whereby the following information is

available for definition:

No.

At this point, enter the number under which the respective placeholder should be described. This is

sequential numbering, which means that it is used in the directory path via %1, %2, %3....

Data Source

Select the data source for dynamic assignment of the placeholder. Depending on the selected data

source, different additional field information is possible or required.

The following options are available:

- Own Table

When using this option, the logic obtains the information from the base table of the storage definition.

When using this option, specifying a Field No. is mandatory.

- Related Table

With this option, the data for the placeholder is not obtained from the base table of the storage

definition, but from a table linked to it. The link is done using the standard logic of table relations in

Microsoft Dynamics 365 Business Central1. These can be expanded if necessary.

If you have selected this option, the selection of a Table No. as well as a Field No. is required.

- Function

This wildcard option returns values at runtime that are calculated based on the framework of the

process and are not based on table information. For example, this could be client, date, or user

information.

If you have selected this option, you will need to select a Data Source Function.

- Fixed Value

Select the Fixed Value option if you want the placeholder information to be static. In this case, it is

necessary to specify a value in the Fixed Value / Parameter field.

- Manually

Selecting the Manually option is not possible at this point, as it would require user interaction that is not

present within the process.

Data Source Function

This field is only editable if the Data Source has a value of Function. At this point, select the internal

processing function, such as the current date or the user ID, to define the information.

Table No.
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Subdirectories - Fields and Information

Field Description

Use this field to specify the unique number of the table from which you want to obtain the data for the

current record, if the Data Source is set to the Related Table value. If you select the desired table

relation via the field, the Table No. will automatically be inserted.

Table Caption

This field shows the name of the one selected in the Table No.. For this reason, the value of this field

cannot be changed manually.

Table Relation Chain

If the Data Source option is set to Related Table and the Table No. was selected on the basis of a table

relation, the description of the concatenation is automatically displayed in this field.

Field No.

Enter the Field No. which, depending on the data source from your own or the linked table, should be

used as information for the current data set.

Field Caption

This field shows the caption of the field selected by Field No.. For this reason, this value cannot be

changed manually.

Fixed Value / Parameter

If the Fixed Value option has been selected as Data Source, this field can be used to store the

corresponding value, which should always be used for the respective placeholder.

In addition, this field is used to store the desired number of characters if the value Left-sided text is used

as the Transformation Rule.

Transformation Rule

Transform rules can be used to specify that a calculated value should be converted before it can be used

as a placeholder. In addition to textual transformations, such as conversion to upper or lower case

letters, the conversion of date information or the handling of special characters is also possible.

If necessary, select the appropriate Transformation Rule to reshape the placeholder value before use.

When using the Transformation Rule Left-sided Text, please enter the number of characters required in

the Fixed value / parameter* field.
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This pane displays settings for document storage subdirectories and user choices.

Storage Definition Tags - Fields and Information

Field Description

Allow upload to

root folder

By activating this field, you can specify that files may also be stored in the root directory of the

respective storage definition. If this field is deactivated, it is only possible to store it in a subdirectory.

If the DMS or ECM system used does not work with directory structures, this switch is obsolete and

will not be evaluated.

Allow select

custom

Subdirectories

If this field is enabled, a query of the existing directory structure in the main directory is carried out

before a selection dialog for the directory selection is displayed. This makes it possible to select

folders that have not been created via the interface, but via alternative filing mechanisms in the DMS

system. If the DMS or ECM system used does not work with directory structures, this switch is

obsolete and will not be evaluated.

Storage Definition

Subdirectories

The tabular listing of subdirectories ensures that files and documents are always stored in a defined

structure and that the user can only choose from the subdirectories that are predefined here. If a user

uploads a file manually, the subdirectories specified here will be taken into account accordingly.

These directories are also available for selection in the report archiving settings.

Description

This field can be used to freely describe the subdirectory. If there is no Subdirectory Path at the time

of entry, the value entered here is also provided as Subdirectory Path by default but can be changed

independently of this specification.

Subdirectory Path

This field contains the path that can be used. This is always to be regarded as a subdirectory of the 

Directory Path from the respective storage definition.

Default

By activating this field, it can be defined that the respective path to a subdirectory is a desired default

path, which will be displayed accordingly in selection dialogs. The list of subdirectories for a storage

definition can only have one default value.
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In this area, the keywords of the respective archive are mapped to the fields or functions from BC. This assignment defines the

values that are to be used as index terms for keywording when documents are stored.
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Field Description

Code The Code field defines the respective keyword that is to be provided

for the storage definition. Not every existing keyword needs to be

included in a storage definition. Select the respective index term from

the LookUp list in order to provide it for storage and to determine the

assignment of the data.

Description This field contains an explanatory description for each keyword. By

default, after selecting a Code, the Description is automatically

prepopulated with the keyword description. However, the value can be

adjusted as needed and is used to clarify the respective assignment.

Data Source Select the data source for the dynamic mapping of values to the

respective keyword. Depending on the selected data source, different

additional field information is possible or required.

The following options are available:

Own Table

When using this option, the logic obtains the information from the base

table of the storage definition.

When using this option, specifying a Field No. is mandatory.

Related Table

With this option, the data for the tag is not obtained from the base

table of the storage definition, but from a table linked to it. The link is

made using the standard logic of the table relations in Microsoft

Dynamics 365 Business Central1. These can be expanded if necessary.

If you have selected this option, the selection of a Table No. as well as

a Field No. is required.

If the keyword selected in the Code field itself has the property 

Multivalue field, all linked data records in the table are used for the

metadata information. If it is not a "Multivalue field", only the first

data record found is used instead.

Function

This data source option returns values at runtime that are calculated

based on the framework conditions of the process and are not based

on table information. For example, this could be client, date, or user

information.

If you have selected this option, you will need to select a Data Source

Function.

Fixed Value

Select the Fixed Value option if you want the keyword information to

be static. In this case, it is necessary to specify a value in the Fixed

Value / Parameter field.

Manually

Selecting the Manually option defines that the value of the tag

assignment is to be selected via a manual user interaction. There are

various procedures for this purpose in order to make it easier for the

user to specify a valid value. If the value Manually has been selected

as the Data Source, further settings can be made using the fields 

Manual Data Type, Manual Selection List, Manual Required and 

Manual Substitution Value for background Processes.

For more information on these fields, see the relevant paragraphs.

Data Source Function
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Field Description

This field is only editable if the Data Source has the value Function.

At this point, select the internal processing function, such as the

current date or the user ID, to define the information.

Fixed Value / Parameter If the Fixed Value option has been selected as the Data source, this

field can be used to store the corresponding value, which should

always be used for the respective assignment to a keyword when

storing a document. 

In addition, this field is used to store the desired number of characters

if the value Left-sided text is used as the Transformation Rule.

Table No. Use this field to specify the unique number of the table from which you

want to obtain the data for the current record, if the Data Source" is

set to the Related Table value. If you select the desired table relation

via the field, the Table No. automatically inserted.

Table Caption This field shows the name of the one selected in the Table No.. For this

reason, the value of this field cannot be changed manually.

Table Relation Chain If the Data Source option is selected as Related Table and the Table

No. was selected on the basis of a table relation, the description of the

concatenation is automatically displayed in this field. The value of the

field is therefore not editable.

Field No. Enter the Field No. which, depending on the Data Source from your

own or the linked table, should be used as information for the current

data set.

Field Caption This field shows the caption of the field selected by Field No.. For this

reason, this value cannot be changed manually.

Manual Data Type If the "Data Source" field has a value of "Manually", this field can be

used to define the type of data that the manual value should be. This

information is used to enable a corresponding selection dialog and to

be able to validate the values before they are transferred to the DMS

system.

You can choose from:

Free Text

Specifies that it is a text field that can be filled with any information

entered manually

Date

Specifies that the manual value is a date that can be assigned in the

entry mask via a date selection dialog.

Number

Specifies that the value represents a number, either as an integer or as

a decimal.

Selection List

Specifies that the field is an entry from a drop-down list. In this case,

the corresponding selection list must be defined using the Manual

Selection List field. Selection lists can only be used to allow the user to

make a pre-made selection and to prevent free texts.

This option allows you to select a single option from the drop-down

list.

Selection List (Multiple allowed)
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Actions

The following actions are available within the storage definitions:

Copy

Calling the Copy action creates a copy of the selected storage definition. After selecting this action, a window appears in which,

in addition to a unique code for the new definition to be created, you can specify whether the copy should also copy the list of

subdirectories and keywords to the new record. Only after this window has been confirmed with OK will the copying process take

place.

Field Description

Specifies that the field is an entry from a drop-down list. In this case,

the corresponding selection list must be defined using the Manual

Selection List field. Selection lists can be used to allow the user only to

make ready-made selections and to prevent free texts. 

This option allows multiple selection of options from the drop-down

list. The selected values are transferred to the DMS system in a

comma-separated manner.

Manual Selection List If the Data Source Manually has been selected and the option 

Selection List or Selection List (Multiple allowed) is stored as the 

Manual Data Type, this field must contain the respective selection list

for the assignment. Any number of selection lists can be stored in the

system, each of which can contain any number of individual entries.

Further detailed information on selection lists can be found in the

chapter Selection lists.

Manual Required By activating this field, it can be ensured that an input is made and

that a record is not stored without the required information. When

entering the manual values, the keyword dialog box cannot be

successfully closed until all the required information has been entered.

By deactivating this field, it can be ensured that the corresponding

index term is optional information that is not mandatory.

Manual Substitution Value for background

Processes

When storing documents via background processes, it is not possible

to manually enter values via a dialog system. Therefore, it is absolutely

necessary to use this field to define the values that are to be used as a

replacement value in the course of a background process.

Transformation Rule Transformation rules can be used to specify that a calculated value

should be converted before it can be used as a keyword. In addition to

textual transformations, such as conversion to upper or lower case

letters, the conversion of date information or the handling of special

characters is also possible.

If necessary, select the appropriate 

Transformation Rule to reshape the value before

use. If the Format Value value is used as 

Transformation Rule, the corresponding

formatting statement can be passed via the 

Format String field.

When using the Transformation Rule Left-sided

Text, please enter the number of characters

required in the Fixed value / parameter field.

Format String If the Format Value value is used as the Transformation Rule, the 

Format String field can be used to pass the corresponding formatting

statement.

Further information on the use and storage of format instructions can

be found in the standard documentation (https://learn.microsoft.com/

en-us/dynamics-nav/format-property).
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Batch update File Tags

If changes or changes are made to storage definitions after documents have already been stored using this definition, the Batch

Update File Tags action can be used to update the stored documents in the archive system. This is explicitly only possible if the

archive system used supports an update option for the corresponding documents! 

After selecting the action, a window is displayed in which, in addition to the default storage definition, a table filter can be

defined in order to be able to further narrow down the documents to be updated. Once the window is confirmed, the records are

filtered in Microsoft Dynamics 365 Business Central1 according to the file definition and the table filter. For each individual data

record, the stored documents are then retrieved and an update is made for each retrieved document based on the stored

keywords.

In addition, the following actions are available in the view of the Storage Definition Tags:

Copy Tag to selected Storage Definitions

If a keyword with assignment of the data source is to be integrated into other storage definitions along with other settings, the

row can be copied using this function.

After selecting the function, a list of storage definitions opens, in which one or more entries can be selected. If this window is

confirmed, the keyword will be included in all selected file definitions.

If the keyword is already included in one of the selected storage definitions, the existing entry remains valid and will not be replaced

by the copy run!

Search Definitions

From the Document Storage Setup you can call up the Search Definitions action via the Setups action group.

General information on search definitions can be found in the corresponding chapter Search Definitions.

General - Fields and Information

Note
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This area displays general basic information for the search definition.

Search Definition Tags - Fields and Information

Field Description

Code This field denotes the unique code of the search definition.

Description The Description field can be used to store a description of the search definition for easy assignment and

explanation.

For Table ID The For Table ID defines the unique table number from the Microsoft Dynamics 365 Business Central1

object list, which is to serve as the source data range for the corresponding search definition. For

example, if the search definition is to be used for documents of a customer, the For Table ID must be set

to the value 18 for the customer table. The LookUp button can be used to open the object list for tables

to enable convenient selection of the desired table.

For Table Caption The For Table Caption field contains the object caption of the table selected in the For Table ID field.

For this reason, the value of this field cannot be changed manually.

Table Filter Filters can be stored using the Table Filter, for example to differentiate between search definitions for

one and the same table in more detail. For example, different search definitions should be used for

different customers due to a customer grouping, even though they are based on the same table (18).

The customers are differentiated, for example, by the Customer Posting Group field in the table. If

different search definitions are to be used for different posting groups, a corresponding filter can be

defined here.

Find Documents

with single Match

By activating this field, you can define whether the search terms should be an "AND" or an "OR" link. If

this field is enabled, hits corresponding to the individual search terms will be displayed, so that an "OR"

link is applied. If this field is disabled, all search terms must be included, so that it is an "AND" link.

Display Definition

Code

The hits that are found via a search definition and the associated search should normally be displayed

in a list afterwards. By mapping a display definition at this point, a link can be created so that the

results are used with the display definition selected here and the fields used in it.

Sorting No. Several search definitions with different characteristics and settings can be stored for a table. The sort

no. can be used to define how the definitions are to be sorted when searching for a valid search

definition for a specific scenario.

Default This app basically offers various options to query and display hit lists and search results. On the one

hand, this can be done via folder structuring in all DMS systems that work with directory structures.

On the other hand, search definitions can be used. Furthermore, it can be useful to create several

search definitions for individual data ranges in order to allow the user to select the appropriate search

definition according to the respective requirement. By activating the Default field, you can specify that

the corresponding search definition is the definition that should be used by default in the list and map

views of the respective table.

Active The Active switch indicates whether a search definition is enabled for use. If changes are to be made to

the settings, the definition must first be disabled. After changes have been made, however, the

definition is activated and ready for use.
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In this area, the search assignment of the desired keywords of the respective archive to the fields or functions from BC is carried

out. This mapping defines the links that are to be used as filters for the index terms when searching for documents.
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Field Description

Code The Code field defines the specific keyword that should be used for the search definition. Select the

respective index term from the LookUp list in order to provide it for the search and to determine the

assignment of the filter data.

Description This field contains an explanatory description for each keyword. By default, after selecting a Code, the 

Description is automatically prepopulated with the keyword description. However, the value can be

adjusted as needed and is used to clarify the respective assignment.

Data Source Select the data source for the dynamic mapping of values to the respective keyword filter. Depending on

the selected data source, different additional field information is possible or required.

The following options are available:

Own Table

When using this option, the logic obtains the filter information from the base table of the search

definition.

When using this option, specifying a Field No. is mandatory.

Related Table

With this option, the data for the keyword filter is not obtained from the base table of the search

definition, but from a table linked to it. The link is made using the standard logic of the table relations in

Microsoft Dynamics 365 Business Central1. These can be expanded if necessary.

If you have selected this option, the selection of a Table No. as well as a Field No. is required.

Function

This data source option returns values at runtime that are calculated based on the framework conditions

of the process and are not based on table information. For example, this could be client, date, or user

information.

If you have selected this option, you will need to select a Data Source Function.

Fixed Value

Select the Fixed Value option if you want the keyword filter to be static. In this case, it is necessary to

specify a value in the Fixed Value / Parameter field.

Manually

It is not possible to select the Manually option at this point.

Data Source

Function

This field is only editable if the Data Source has the value Function. At this point, select the internal

processing function, such as the current date or the user ID, to define the information.

Fixed Value /

Parameter

If the Fixed value option has been selected as the Data source, this field can be used to store the

corresponding value, which should always be used for the respective assignment to a keyword when

storing a document. 

Additional parameters can also be specified here for other functions. For example, it is possible to use a

dynamic date filter to search for documents. This can be set up using the Date formula function. If this

data source function is selected, this field is used to store the date formula to be used for filtering. The

date formula should correspond to the filtering mechanism from the standard and cover a date range.

Furthermore, when using formulas, care should be taken to ensure that these are stored directly in

multiple languages in order to be independent of region and language. A possible formula for filtering

documents from the previous year would be <-CY-1Y>..<+CY-1Y>. To filter all documents since the start

of the current year, however, the formula <-CY>.. would have to be set up. Further information on the

use of date formulae can be found in the standard documentation:

https://learn.microsoft.com/en-us/dynamics365/business-central/dev-itpro/developer/methods-auto/

dateformula/dateformula-data-type

In addition, this field is used to store the desired number of characters if the value Left-sided text is

used as the Transformation Rule.

Table No.
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Search Directories - Fields and Information

In this area, the document drives to be searched are assigned to the search definition. This list determines which libraries /

archives within the DMS structure are to be used in a search using the current search definition.

Actions

Within the search definitions, the following actions are available:

Copy

Calling the Copy action creates a copy of the selected search definition. After selecting this action, a window appears in which, in

addition to a unique code for the new definition to be created, you can specify whether the copy should also copy the list of

search directories and keywords to the new record. Only after this window has been confirmed with OK will the copying process

take place.

Display Definitions

From the Document Storage Setup you can call up the Display Definitions action via the Setups action group.

For general information on display definitions, see the corresponding chapter Display Definitions.

General - Fields and Information

Field Description

Use this field to specify the unique number of the table from which you want to obtain the data for the

current record, if the Data Source is set to the Related Table value. If you select the desired table

relation via the field, the Table No. automatically inserted.

Table Caption This field shows the caption of the table selected in Table No.. For this reason, the value of this field

cannot be changed manually.

Table Relation

Chain

If the Data Source option is selected as Related Table and the Table No. was selected on the basis of a

table relation, the description of the concatenation is automatically displayed in this field. The value of

the field is therefore not editable.

Field No. Enter the Field No. which, depending on the Data source from your own or the linked table, should be

used as information for the current data set.

Field Caption This field shows the caption of the field selected by Field No.. For this reason, this value cannot be

changed manually.

Transformation

Rule

Transformation Rules can be used to specify that a calculated value should be converted as a keyword

filter before it can be used. In addition to textual transformations, such as conversion to upper or lower

case letters, the conversion of date information or the handling of special characters is also possible.

If necessary, select the appropriate Transformation Rule to reshape the value before use. If the Format

Value option is selected, the Format String field can be used to pass the appropriate formatting

statement. 

When using the Transformation Rule Left-sided Text, please enter the number of characters required in

the Fixed value / parameter field.

Format String If the Format Value option is assigned as Transformation Rule, the Format String field can be used to

pass the appropriate formatting statement.

Further information on the use and storage of format instructions can be found in the standard

documentation (https://learn.microsoft.com/en-us/dynamics-nav/format-property).

Field Description

Document Drive

Code

The field specifies the unique code of the document drive to be included in the search. Use the

LookUp button to select the document drives/archives to be included in the search.

Document Drive

Name

This field displays the name of the archive selected in the Document Drive Code field.

Since the value is calculated automatically, it is not possible to change it.
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This pane displays general basic information for the display definition.

Display Options - Fields and Information

This area displays fields that reflect the general display options of each display definition.

Show File No. per Directory

If this field is selected, the Infobox Documents will display the number of documents in each folder displayed. This is done in

Field Description

Code This field denotes the unique code of the display definition.

Description The Description field can be used to store a description of the display definition for easy assignment

and explanation.

Active The Active switch indicates whether a display definition is enabled for use. If changes are to be made

to the settings, the definition must first be disabled. After changes have been made, however, the

definition is activated and ready for use.

Document Factbox

Display Type
The Documents infobox in the Microsoft Dynamics 365 Business Central1 records can take a variety

of forms, depending on the display definition.

This field is pre-assigned by the settings in the Document Storage Setup, but can be overridden

individually for each display definition.

By default, the following display types are available:

Standard (Business Central page)

In this case, a standard page is used to display the hits. The advantage lies in the near-standard

display. A disadvantage is the space requirement of the control due to non-adjustable spacing and

formatting as well as the currently limited possibility of opening and closing the tree structure.

(default BC error)

Custom Control AddIn

The Control add-in displays a simple tree structure as a TreeView-Javascript Control add-in. Common

standard mechanisms from web development are used here, so that it leads to a simple and fast

display type.

Web-Link of DMS

In the case of web linking, the DMS system used can itself transmit a display as a web page to the

interface and thus display it as an independent frame. This solution is not currently implemented by

either Saperion or SharePoint and is not expected to be used until the connection to ELO Digital

Office3.

Document Link

Display Type

If a document is opened for display, you can use the Document Link Display Type to specify which

viewer is to be used for the display.

This field is pre-assigned by the settings in the Document Storage Setup, but can be overridden

individually for each display definition.

By default, the following display types are available:

Internal Document Viewer

In the internal document view, the data stream of the document is "packaged" into an HTML5 display

and displayed using the standard BC WebBrowser AddIn. Depending on the type of document,

different integrations are possible, so that, for example, image documents are interpreted differently

than PDF documents.

External Hyperlink

In the case of external link linking, the link that is transmitted via the DMS system is called instead of

the document itself. For example, the document opens externally in SharePoint instead of BC.

It is important to note that authorizations must be stored accordingly, especially with regard to cross-

domain systems!
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parentheses next to the folder name. This makes it immediately clear how many documents the directory contains. If this field is

deactivated, the number of documents per folder is not displayed. A display is a little faster, because the documents contained do

not have to be counted.

Tags to display as columns - fields and information

This pane shows the list of keywords to be displayed in the Documents infobox per document. Each keyword specified here will

also be queried via the search and displayed here.

If, either in general or for this display definition, the Display type for infobox documents has the value Custom Control AddIn and

an archive system without a direct file display (such as Hyland Saperion ECM2) is used in parallel, the keywords named here will be

displayed as a comma-separated list in the control add-in instead of in a column display!

Tags to group documents by - Fields and Information

Instead of displaying documents in directory structures (if the archive system used supports this), they can also be grouped by

keywords within the Documents infobox. To do this, you can create one or more rows in the Tags to group documents by pane if

necessary. The keywords mentioned here are then used for a grouping.

Automatic Report Archiving

From the Document Storage Setup you can use the Setups action group to select the action Automatic Report Archiving. 

The Automatic Report Archiving lists the various documents and reports that are to be used automatically or manually for

document storage.

Fields and Information

Note

Field Description

Tag Code This field is used to select the keyword for display in the info box. In general, any number of rows can be

selected for display.

Tag

Description

This will automatically display the description of the keyword selected in the Tag Code field. Therefore,

this field is not editable.

Field Description

Tag Code This field is used to select the keyword for the grouping in the infobox.

Tag

Description

This will automatically display the description of the keyword selected in the Tag Code field. Therefore,

this field is not editable.
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Report-dependent information must be stored within the list in order to map the process of integrated document storage

effectively and intuitively for the user.
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Field Description

Report ID This field specifies the unique object ID of the respective report for which the corresponding settings

are to be made. By selecting the LookUp button, the desired entry can be selected from the list of all

report objects.

Report Caption As soon as a report has been selected via the Report ID, the corresponding description of the

respective object appears in this field. Therefore, this field is not editable for the user.

Storage

Definition Code

The Storage Definition Code can be used to select the storage definition that is to be used for the

document storage of the respective report. The storage definition defines directories, properties, and

keywords with which the stored report is automatically enriched. The LookUp button can be used to

open the list of all existing storage definitions for easy selection. If no storage definition is assigned at

this point, the best possible storage definition based on the sorting sequence and any table filters used

is used at report runtime based on the respective data record.

Subdirectory

Entry No.

If documents based on this report are to be stored in a specific subdirectory of the storage definition,

the respective subdirectory can be selected here. The LookUp button displays a list of all subdirectories

that are assigned to the corresponding storage definition selected via the Storage Definition Code field.

Subdirectory

Description

As soon as you click on the field Subdirectory Entry No. if a subdirectory has been selected for the

storage, the description associated with the subdirectory is displayed in this field. Therefore, this field

is not editable for the user.

File Name When creating a file based on a document print in Microsoft Dynamics 365 Business Central1, only the

data stream with the content is generated. A file name must be stored individually for storage. To

ensure that a unique assignment is possible for each report object, even using variable values, the file

name for storing the document without extension must be specified in this field. It is also possible to

use placeholders (%1, %2, %3 ...) for the dynamic specification, which are assigned at runtime via the

values defined in the Placeholders field. The specification of a file extension (e.g. ".pdf") is not

necessary at this point, but is done dynamically.

Placeholders Placeholders are used to dynamically map file names based on field values of a record in Microsoft

Dynamics 365 Business Central1. In order to be able to design these placeholders variably, the

AssistEdit button of the field can be used to call up the page Storage Definition Placeholders.

Within this page, any number of placeholders can be defined, whereby the following information is

available for definition:

No.

At this point, enter the number under which the respective placeholder should be described. This is a

sequential numbering, which means that the use in the File Name field of the Autom. Report archiving

via %1, %2, %3....

Data Source

Select the data source for dynamic assignment of the placeholder. Depending on the selected data

source, different additional field information is possible or required.

The following options are available:

- Own Table

When using this option, the logic obtains the information from the base table of the storage definition.

When using this option, specifying a Field No. is mandatory.

- Related Table

With this option, the data for the placeholder is not obtained from the base table of the storage

definition, but from a table linked to it. The link is done using the standard logic of table relations in

Microsoft Dynamics 365 Business Central1. These can be expanded if necessary.

If you have selected this option, the selection of a Table No. as well as a Field No. is required.

- Function

This placeholder option returns values at runtime that are calculated based on the framework of the

process and are not based on table information. For example, this could be client, date, or user
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Field Description

information.

If you have selected this option, you will need to select a Data Source Function.

- Fixed Value

Select the Fixed Value option if you want the placeholder information to be static. In this case, it is

necessary to specify a value in the Fixed Value / Parameter field.

- Manually

Selecting the Manually option is not possible at this point, as it would require user interaction that is

not present within the process.

Data Source Function

This field is only editable if the Data Source hais set to Function. At this point, select the internal

processing function, such as the current date or the user ID, to define the information.

Table No.

Use this field to specify the unique number of the table from which you want to obtain the data for the

current record, if the Data Source is set to the option Related Table. If you select the desired table

relation via the field, the Table No. will automatically be inserted.

Table Caption

This field shows the name of the table selected by field Table No.. For this reason, the value of this field

cannot be changed manually.

Table Relation Chain

If the Data Source option is set to Related Table and the Table No. was selected on the basis of a table

relation, the description of the concatenation is automatically displayed in this field.

Field No.

Enter the Field No. which, depending on the Data Source from your own or the linked table, should be

used as information for the current data set.

Field Caption

This field shows the caption of the field selected by Field No.. For this reason, this value cannot be

changed manually.

Fixed Value / Parameter

If the Fixed value option has been selected as the Data Source, this field can be used to store the

corresponding value, which should always be used for the respective placeholder.

In addition, this field is used to store the desired number of characters if the value Left-sided text is

used as the Transformation Rule.

Transformation Rule

Transformation Rules can be used to specify that a calculated value should be converted before it can

be used as a placeholder. In addition to textual transformations, such as conversion to upper or lower

case letters, the conversion of date information or the handling of special characters is also possible.

If necessary, select the appropriate Transformation Rule to reshape the placeholder value before use.

Automatic archie

on Document

Posting

If this field is activated, the corresponding document is automatically executed in the background when

a transaction is posted and stored in the archive system. This field cannot be edited by the user, but is

automatically assigned if the report is a document that is used in one of the following areas in the

"Report Selection - Sales" * or "Report Selection - Purchasing corresponds to:

Sale

- Shipment

- Return Receipt

- Invoice
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Actions

Within the "Autom. Report Archiving", the following actions are available:

Batch print separated files

Especially if the app is only used at a later point in time in an existing Microsoft Dynamics 365 Business Central1 system, the

problem arises that historical documents are to be transferred to the archive system in a single launch. In this case, it is not

possible to use a standard report directly, as it would export several documents to a file and not divide them by document

number if several documents were selected. For this reason, the Batch print separated files action has been integrated. This

action is carried out on the basis of a selected data record and opens the options page for the corresponding report in order to

make filters and settings. Once the parameters have been specified and confirmed by clicking "OK", the report is automatically

recursively recalled in the background for each data record it contains, so that each individual document is generated and stored

in the archive system.

User Settings

From the Document Storage Setup you can call up the User Settings action via the Setups action group.

Field Description

- Credit Memo

Purchase

- Receipt

- Return Shipment

- Invoice

- Credit Memo

Archive PDF files The Archive PDF files field combines two functionalities in one field. Among other things, this has to do

with the fact that the use of PDF files has proven to be optimal for archiving in the IT sector.

On the one hand, this field is used when a document with the respective report ID is printed within a

user interaction. If the user chooses the PDF format for printing/saving, the document will only be

archived if this field is also activated.

Furthermore, this field is used in background processing, e.g. for automatic archiving of document

postings. Since the user cannot decide on the format of the output, it is always checked for creation

and archiving whether this field is active. If this field is deactivated, the report will not be used for

automatic archiving.

Archive Word

Files

A user can decide within a print interaction whether he wants to create a document as a PDF, Word file

or Excel file. If a user chooses the Word File option, the corresponding document will only be archived

if this field is enabled.

If this field is disabled, no Word files that are printed during a user interaction will be archived.

Note: Please note that the long-term archiving of Word documents in particular may be problematic

due to changing formats and the fact that they cannot be displayed consistently in future versions!

We therefore recommend using the PDF format for archiving.

Archive Excel

files

A user can decide within a print interaction whether he wants to create a document as a PDF, Word file

or Excel file. If a user chooses the Excel File option, the corresponding document will only be archived

if this field is enabled.

If this field is disabled, no Excel files that are printed during a user interaction will be archived.

Note: Please note that the long-term archiving of Excel documents in particular may be problematic

due to changing formats and the fact that they cannot be displayed consistently in future versions!

We therefore recommend using the PDF format for archiving.

Overwrite

identical file

name

SharePoint automatically versions identical file names by adding a counter at the end of the file name.

If it is not desired that, for example, an invoice is saved again when it is printed repeatedly, this option

should be activated.

Only available for SharePoint.
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User-specific settings can be stored via this page. In detail, the following settings are possible:

Selection Lists

From the Document Storage Setup you can call up the Selection Lists action via the Setups action group.

Selection lists can for example be used in storage definitions for manual values in order to use a structured and error-free input

of fixed terms. Selection lists consist of a unique Code and a Description that can be used to represent usage. Any number of 

Entries can be stored per selection list. These designate the values that can be selected within the process of manual

maintenance of keywords via the respective selection list and thus used for the assignment of the index value.

Test Connection

To test basic connectivity to the archive system specified in the Host Name field, the Test Connection action can be used.

Depending on the archive system used, different endpoints are contacted when the action is executed in order to determine

whether the basic connection to the respective set system is possible. Therefore, in addition to the selected Storage Type and the 

Host Name, the Authorization Type and the associated settings are also required.

The following endpoints are contacted with the respective archive systems:

Hyland Saperion ECM2\ http---Get on \/archives\ This will retrieve all created base archives.

Microsoft1 SharePoint Online\ http---Get on \/sites/root\ This refers to the organization's default SharePoint page.

ELO Digital Office3 - REST API Service http---Get on \/api/system/masks/_ids\ This will retrieve the ids of all created archive

masks.

ELO Digital Office3 - Indexserver REST Interface http---Post on \/IXServicePortIF/createSord with usage of a Json

content body\ This will retrieve the ids of all created archive masks.

A success or error message then indicates to the user whether the connection was successful or not.

Export/Import Setup Data

In order to be able to export and save setup data of the app DMS & ECM Interface, or to be able to use it for the basic setup of

another client or an additional instance, the action Export / Import Setup Data can be used.

After calling up the action, a dialog box can be used to select whether the data should be imported or exported. If the Export

option is selected, the file with all setup data will be created and downloaded as an XML file after the dialog box has been

confirmed.

If the Import option is selected, a file dialog will be displayed after the dialog box has been confirmed, in which the desired XML

file with the setup data to be imported will be provided either via drag\'nDrop or via a search using File Explorer.

Field Description

User ID Enter the unique ID of the user for whom you want to make the settings. The LookUp button can be

used to select the corresponding entry from the list of existing users.

Disable Document

Infobox

By default, users automatically see the info boxes in the various pages that display the document

viewer and the document storage upload area. For individual users, the display may not be desired

or disturbing, so that the display can be deactivated globally for the user.

Basic Authentication

- Username

This field is only visible if the Basic Authentication procedure has been selected as Authorization

Type or Authorization Type for Job Queue in the Document Storage Setup.

In this case, specify the valid credentials for authentication to the archive system for each user. If no

user-specific information is provided at this point, the central information from the document

storage setup is automatically used.

Basic Authentication

- Password

This field is only visible if the Basic Authentication procedure has been selected as Authorization

Type or Authorization Type for Job Queue in the Document Storage Setup.

In this case, enter the valid password for authentication to the archive system for the user that

matches the Basic Authentication - Username field. If no user-specific information is provided at this

point, the central information from the document storage setup is automatically used.

• 

• 

• 

• 
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File Packages

From the Document Storage Setup you can call up the File Packages action via the Related action group.

File packages are used to automatically collect files and make them available as zip folders for download. For example, you can

define a file package that compiles all invoices in a reminder or a file package that collects the specifications for all items in a

sales order. Once a file package has been defined, it can be created at any time using the button of the same name from the

document infobox.

General - Fields and Information
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Within the area, general information about the file package definition must be stored.
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Field Description

Code Each definition of a file package must have a unique code. To do this, provide a code that describes how

to use the file package.

Description To describe the usefulness and usage of the file package, a short text can be captured in this field.

Storage

Definition

The storage definition provided here is used to describe the basic record for which a file package is to be

created. Based on the storage definition defined here, the fields For Table No. and For Table Caption

automatically mapped.

For Table No. This field represents the table number for the base record to which this file package definition should

apply. The field is automatically set by the underlying Storage Definition and cannot be changed manually.

For Table

Caption

This field specifies the caption of the table, selected in field For Table No. and is therefore not editable.

Filename When used, a file package always results in a ZIP file. In order to be able to store this file under a specific

file name, the file name per file package can be defined at this point. Specifying a file extension is not

required, but is automatically appended within the creation process. In order to be able to use dynamic

content based on the underlying data set in the file name, Placeholders are possible, which can be

assigned in the file name via the respective referencing (e.g. %1, %2, %3...).

Placeholders Placeholders are used to dynamically map file names based on field values of a record in Microsoft

Dynamics 365 Business Central1. In order to be able to design these placeholders variably, the AssistEdit

button of the field can be used to call up the page Storage Definition Placeholders.

Within this page, any number of placeholders can be defined, whereby the following information is

available for definition:

No.

At this point, enter the number under which the respective placeholder should be described. This is a

sequential numbering, which means that it can be uses in the Filename field via %1, %2, %3....

Data Source

Select the data source for dynamic assignment of the placeholder. Depending on the selected data source,

different additional field information is possible or required.

The following options are available:

- Own Table

When using this option, the logic obtains the information from the base table of the storage definition.

When using this option, specifying a Field No. is mandatory.

- Related Table

With this option, the data for the placeholder is not obtained from the base table of the storage definition,

but from a table linked to it. The link is done using the standard logic of table relations in Microsoft

Dynamics 365 Business Central1. These can be expanded if necessary.

If you have selected this option, the selection of a Table No. as well as a Field No. is required.

- Function

This placeholder option returns values at runtime that are calculated based on the framework of the

process and are not based on table information. For example, this could be client, date, or user

information.

If you have selected this option, you will need to select a Data Source Function.

- Fixed Value

Select the Fixed Value option if you want the placeholder information to be static. In this case, it is

necessary to specify a value in the Fixed Value / Parameter field.

- Manually

Selecting the Manually option is not possible at this point, as it would require user interaction that is not

present within the process.
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File Package Lines - Fields and Information

Field Description

Data Source Function

This field is only editable if the Data Source hais set to Function. At this point, select the internal

processing function, such as the current date or the user ID, to define the information.

Table No.

Use this field to specify the unique number of the table from which you want to obtain the data for the

current record, if the Data Source is set to the option Related Table. If you select the desired table

relation via the field, the Table No. will automatically be inserted.

Table Caption

This field shows the name of the table selected by field Table No.. For this reason, the value of this field

cannot be changed manually.

Table Relation Chain

If the Data Source option is set to Related Table and the Table No. was selected on the basis of a table

relation, the description of the concatenation is automatically displayed in this field.

Field No.

Enter the Field No. which, depending on the Data Source from your own or the linked table, should be

used as information for the current data set.

Field Caption

This field shows the caption of the field selected by Field No.. For this reason, this value cannot be

changed manually.

Fixed Value / Parameter

If the Fixed value option has been selected as the Data Source, this field can be used to store the

corresponding value, which should always be used for the respective placeholder.

In addition, this field is used to store the desired number of characters if the value Left-sided text is

used as the Transformation Rule.

Transformation Rule

Transformation Rules can be used to specify that a calculated value should be converted before it can be

used as a placeholder. In addition to textual transformations, such as conversion to upper or lower case

letters, the conversion of date information or the handling of special characters is also possible.

If necessary, select the appropriate Transformation Rule to reshape the placeholder value before use.
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This section defines the settings to be considered for the contents of the file package. This includes the different tables to be

searched and their attachments included in the zipped file.
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Field Description

Data Source The Data Source is used to define where the corresponding rows for the file package are to be obtained.

If the data to be taken into account is contained in the same table as the basic data record, the option 

Own table must be selected here. If the file package rows to be considered are contained in another

linked table, select the Related Table option.

Table No. If the Related Table option is selected as the Data Source, the table relation for the link must be

selected at this point. After selecting the LookUp button, a selection appears over all linked tables based

on the stored table relations. After selecting a row, closing the dialog box will move the corresponding

row into the Table No. inherited.

Table Caption This field automatically displays the corresponding caption of the table, selected in the field Table No..

Therefore, this field is not editable.

Table Relation

Chain

After selecting a Table No., this field displays the description of the table relation. Therefore, this field is

not editable.

Search all

related records

If this field is checked, the documents will be returned to all found records. If the field is disabled, only

the first record found is used.

Storage

Definition Code

This field is used to define the assigned storage definition for the selected table. This is used, among

other things, to filter the possible search definitions as well as the subdirectories.

Search

Definition Code

The Search Definition Code is used to search for the documents for the individual file package lines. If

no search definition is specified here, the documents are retrieved based on the directory structure of

the assigned storage definition. By specifying a search definition, on the other hand, the documents are

obtained via this definition and thus via filtering by keywords.

Subdirectory

Entry No.

If documents for the file package lines are not to be fetched by search definition, the list is always based

on the directory structure. By specifying a subdirectory, the search tree for the documents to be

integrated can be restricted at this point by fetching only those documents that are stored in a defined

subdirectory. If you want to restrict the file structure with a subdirectory, use the LookUp button to

select the appropriate subdirectory from the storage definition.

Subdirectory

Description

This field contains the description of the subdirectory selected in the field Subdirectory Entry No. and is

therefore not editable.

Directory Path in

Package

Directory structures can also be used within a ZIP archive. If you want to store the documents of the

respective file package line in a specific subdirectory within the ZIP archive, enter the desired directory

path in the ZIP in this field.

To ensure a dynamic directory structure, you can use placeholders (e.g. %1, %2, %3...) in the directory

path, which are filled at runtime using the logic specified in the Placeholders field.

Include original

Directory

If the documents retrieved in the course of creating the file package have already been stored in a

directory structure, the directory structure of the original directories can be adopted if required. If this

field is enabled, the original directory structure will be appended to the path mentioned in the Directory

Path in Package field!

Placeholders Placeholders are used to dynamically map directories or parts of a directory path based on field values

of a record in Microsoft Dynamics 365 Business Central1. In order to be able to design these

placeholders variably, the AssistEdit button of the field can be used to call up the page Storage

Definition Placeholders.

Within this page, any number of placeholders can be defined, whereby the following information is

available for definition:

No.

At this point, enter the number under which the respective placeholder should be described. This is a

sequential numbering, which means that the use in the field Directory Path in Package via %1, %2,

%3....

Data Source

Select the data source for dynamic assignment of the placeholder. Depending on the selected data
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Field Description

source, different additional field information is possible or required.

The following options are available:

- Own Table

When using this option, the logic obtains the information from the base table of the storage definition.

When using this option, specifying a Field No. is mandatory.

- Related Table

With this option, the data for the placeholder is not obtained from the base table of the storage

definition, but from a table linked to it. The link is done using the standard logic of table relations in

Microsoft Dynamics 365 Business Central1. These can be expanded if necessary.

If you have selected this option, the selection of a Table No. as well as a Field No. is required.

- Function

This placeholder option returns values at runtime that are calculated based on the framework of the

process and are not based on table information. For example, this could be client, date, or user

information.

If you have selected this option, you will need to select a Data Source Function.

- Fixed Value

Select the Fixed Value option if you want the placeholder information to be static. In this case, it is

necessary to specify a value in the Fixed Value / Parameter field.

- Manually

Selecting the Manually option is not possible at this point, as it would require user interaction that is

not present within the process.

Data Source Function

This field is only editable if the Data Source hais set to Function. At this point, select the internal

processing function, such as the current date or the user ID, to define the information.

Table No.

Use this field to specify the unique number of the table from which you want to obtain the data for the

current record, if the Data Source is set to the option Related Table. If you select the desired table

relation via the field, the Table No. will automatically be inserted.

Table Caption

This field shows the name of the table selected by field Table No.. For this reason, the value of this field

cannot be changed manually.

Table Relation Chain

If the Data Source option is set to Related Table and the Table No. was selected on the basis of a table

relation, the description of the concatenation is automatically displayed in this field.

Field No.

Enter the Field No. which, depending on the Data Source from your own or the linked table, should be

used as information for the current data set.

Field Caption

This field shows the caption of the field selected by Field No.. For this reason, this value cannot be

changed manually.

Fixed Value / Parameter

If the Fixed value option has been selected as the Data Source, this field can be used to store the

corresponding value, which should always be used for the respective placeholder.

In addition, this field is used to store the desired number of characters if the value Left-sided text is

used as the Transformation Rule.
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Actions

Within the File Packages the following actions are available:

Report Selection Usage Assignment

In certain cases, it may be desired that file packages are automatically obtained and attached to the process when a report or

document is created. For example, a functionality could be used in this context that automatically creates a file package with

the invoices individually assigned to the reminder and attaches it as an attachment when a reminder is sent by e-mail. For this

purpose, an assignment can be defined using the Assignment report selection.

Due to the wide range of creation options and intervention options of sending e-mails, the integration into the e-mail process is

currently not implemented on the product side and may have to be implemented. can be implemented individually by the supervising

project partner.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

All Hyland product names are registered or unregistered trademarks of Hyland Software, Inc. or its affiliates in the United States and
other countries. 

ELO, ELOprofessional, ELOenterprise, ELOoffice and ELO ECM-Suite are registered trademarks of ELO Digital Office GmbH in Germany
and/or and other countries. 

Field Description

Transformation Rule

Transformation Rules can be used to specify that a calculated value should be converted before it can be

used as a placeholder. In addition to textual transformations, such as conversion to upper or lower case

letters, the conversion of date information or the handling of special characters is also possible.

If necessary, select the appropriate Transformation Rule to reshape the placeholder value before use.

• 

Note

1. 

2. 

3. 
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Usage of the DMS & ECM Interface

DOCUMENT SEARCH / RESEARCH

Once the basic setup of the application has been completed, it can be used immediately.

In the various pages in Microsoft Dynamics 365 Business Central1, the Documents infobox is displayed. This infobox is basically

divided into 3 sections:

Drop Zone

Documents can be stored via "Drag & Drop" or by searching

List of documents

in which the various existing document entries for a data set are displayed in a structured manner

Actions

which can be used partly via the document list, but mainly via the heading "Documents" of the infobox

The drop zone is used for archiving documents, so this will be discussed in more detail in the chapter Manual / "Drag & Drop".

List of documents

The document list is displayed in different forms depending on the settings in the Document Storage Setup or the respective

display definition. As a basis, however, the document entries that are assigned to the respective selected data set via the search

definition or the directory structure are always shown.

The keywords selected in the respective display definition are displayed as column information. The grouping used is also based

on the setting in the display definition.

Display with "Standard" display option

If the option Standard (Microsoft Dynamics 365 Business Central1 Page) has been selected as the Display type for Infobox

Documents in the Document Storage Setup or for the respective display definition, the document list is presented in a standard

page. The keywords selected in the display definition are used as columns.

Above the listing, you can click on My Documents or Search - Documents for ... and switch between the search by directory

structure or via the various search definitions to the respective table.

The Search action opens the separate document search, where different search methods can be selected and applied. Details on

how to use the document search can be found in the corresponding chapter.

For each displayed record, the action menu can be opened within the document list, which can be used to perform the following

actions:

Download File

Downloads the currently selected file and saves it to the local download directory.

Open File

Opens the file in an internal document viewer or via the external application, depending on the setup. The setting of which

procedure is to be used is defined by the Document Link Display Type field of the current display definition or the document

storage setup.

Open Folder

The action opens the directory containing the currently selected document in the archive application. This action is only

available if the archiving system used supports the use of directory structures.

Edit manual Tags for file

This action makes it possible to edit the keywords that have the value Manually as Data Source in the storage definition. A

dialog box opens, in which the manual keywords including the existing values are displayed. New values can be entered here.

By confirming the dialog box with "OK", the changed keywords are transferred to the archive system and saved.

• 

• 

• 

• 

• 

• 

• 
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Actions

The button next to the infobox title Documents opens the action menu for the application in relation to the current record. The

following actions are available at this point:

Upload File

This action opens the Import a New File dialog box, where a new file can be uploaded using "Drag & Drop" or a file selection

dialog. If subdirectories are defined for the respective storage definition, a dialog for selecting the subdirectory is then

displayed. If keywords with Data Source Manually have been assigned to the storage definition, the dialog box for assigning

the manual tags then appears. The file is then transferred to the archive system with the automatic and manual keywords and

saved.

Download File

Downloads the currently selected file and saves it to the local download directory.

Create File Package

This action can only be selected if a file package has been defined for the underlying table of the current data record. For more

details on file packages, see the corresponding chapter.

This action creates the appropriate file package for the current record and downloads the created ZIP file.

Open File

Opens the file in an internal document viewer or via the external application, depending on the setup. The setting of which

procedure is to be used is defined by the Document Link Display Type field of the current display definition or the document

storage setup.

Open Folder

The action opens the directory containing the currently selected document in the archive application. This action is only

available if the archiving system used supports the use of directory structures.

Update autom. Tags for all files

This action uses the list of documents and, if allowed by the archive system, updates all automatically generated keywords. For

example, if the basic information of a record, such as a customer name, has been corrected, this action can automatically

update all of the customer's documents with the new name.

Edit manual Tags for file

This action makes it possible to edit the keywords that have the value Manually as Data Source in the storage definition. A

dialog box opens, in which the manual keywords including the existing values are displayed. New values can be entered here.

By confirming the dialog box with "OK", the changed keywords are transferred to the archive system and saved.

Show Storage Definition

Calls the entry from the storage definitions that is used for the current record.

Show Search Definition

Gets the entry from the search definitions that is used for the current record.

Search Documents

The document search can be called up pre-assigned from the infobox of a data record, as well as separately, e.g. via the TellMe

functionality.

The site provides complex search and filtering options for searching for archived documents in the archive system. Depending on

the Search Mode used, different parameters are possible, so that the search modes, including the available options, are listed

individually below:

Search Mode: Related to Record

The Search Mode Related to Record accesses the directory structure that has been stored in the storage definition for the

respective table and queries the documents based on this folder structure.
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After selecting this mode, the following information is required:

Table

Select the table from the list of objects for which documents are being searched. If, for example, customer documents are to be

searched, the table "18 - Customer" must be selected here.

Related to Record

After selecting a Table, the Related to Record field can be used to open the list of records from that table in order to select a

valid record for the document search.

After entering a Table and a Related to Record, the Search action starts the document search and returns a list of the found

documents.

Search Mode: Search Text

The Search Mode Search Text uses a Search Text to be specified for the search.

After selecting this mode, the following information is required:

Search text

Enter the text you want to search for.

In terms of SharePoint Online search using the Graph API, this method does not search for the search text in all keywords, but only

applies the search to the file name!

After entering the Search Text, the Search action starts the document search and returns a list of the documents found.

Search Mode: Search Definition

The Search Mode" Search Definition** ** uses a search definition to be specified as well as a record for filtering the documents

based on the search definition.

After selecting this mode, the following information is required:

Search Definition

Select the search definition that you want to use for the current search.

Record to search for

After selecting a Search Definition, the Record to search for field can be used to open the list of records from the underlying

table in order to select a valid record for the document search.

After entering a Search Definition and a Record to search for, the Search action starts the document search and returns a list of

the documents found.

Search Mode: Tags

The Search Mode Tags lists all available keywords and allows you to search by these index terms.

• 
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After selecting this mode, the following information is required:

Find Documents with Single Match

This can be used to determine whether the various keyword filters should be concatenated via a logical "AND" or "OR" link. If

this field is enabled, the keyword filters are applied independently of each other. If this field is disabled, a hit must match all

the filters specified here.

Display Definition

The Display Definition field selects the specific display definition to use for the display. This contains the keywords to be

retrieved as well as the grouping settings.

Tags

All available keywords are listed here. The Search Text column can be used to list the respective values for each desired

keyword filter.

After entering the options, the Search action starts the document search and returns a list of the documents found.

Files - Fields and Functions

Depending on the assigned display definition, the columns for the document list are dynamically sourced. Likewise, the grouping

of the entries is done dynamically based on the settings of the display definition.

The following actions are available for each document found:

Download file

Downloads the currently selected file and saves it to the local download directory.

Open File

Opens the file in an internal document viewer or via the external application, depending on the setup. The setting of which

procedure is to be used is defined by the Document Link Display Type field of the current display definition or the document

storage setup.

Open Folder

The action opens the directory containing the currently selected document in the archive application. This action is only

available if the archiving system used supports the use of directory structures.

ARCHIVING OF DOCUMENTS

Manual / "Drag & Drop"

In the various records in Microsoft Dynamics 365 Business Central1, the Infobox Documents is available. This includes a "Drag &

Drop"-area where a file can be designated using "Drag & Drop" or via the file selection dialog for archiving to the corresponding

record. If subdirectories are defined for the respective storage definition, a dialog for selecting the subdirectory is then

displayed. If keywords with Data Source Manually have been assigned to the storage definition, the dialog box for assigning the

manual tags then appears. The file is then transferred to the archive system with the automatic and manual keywords and saved.

Photo upload (mobile client only)

When using the mobile client on a mobile phone or smartphone, it is possible to select the Photo upload action within an info box

of a record. This will launch the camera application and the resulting photo will be saved as a file for archiving. If subdirectories

are defined for the respective storage definition, a dialog for selecting the subdirectory is then displayed. If tags with Data

Source Manually have been assigned to the storage definition, the dialog box for assigning the manual tags then appears. The

file is then transferred to the archive system with the automatic and manual keywords and saved.

Automated archiving of reports during printing

If a document or report is printed or generated as a PDF, Word or Excel file, automatic archiving can take place. Appropriate

facilities required for this purpose can be found in the chapter Autom. report archiving.

Automated archiving of reports during posting

When purchasing and sales transactions are posted (delivery, return, invoice, credit note), the documents can be automatically

transferred to the archive system.
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Appropriate facilities required for this purpose can be found in the chapter Autom. report archiving.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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Tips, tricks and hints

SHAREPOINT ONLINE

Document storage in SharePoint Online uses the standardized interface architecture of the Microsoft1 Graph API for connectivity.

This can lead to differences in the connection compared to the SharePoint API.

The search for keywords is always done with a set http header "prefer" with the value

"HonorNonIndexedQueriesWarningMayFailRandomly" in order to be able to search over index terms that are not mapped in an

index.

Documents are always stored in SharePoint Online with conflict handling for renaming. As a result, a document of the same name,

which is stored with identical index terms, never overwrites the existing document, but receives an automatically numbered,

customized file name. This is done automatically using the URL parameter \@microsoft.graph.conflictBehavior=rename

Setting up app registrations

In order to access SharePoint Online using OAuth 2.0 authentication using the Graph API, app registrations must be created that

are designed for delegated access or application permissions. In the following chapters, a brief overview is given of which

settings and procedures can be used for creating app registrations.

Set up an app registration for delegated access in Azure AD

In order for users to authenticate to the Microsoft1 Graph API from within BMicrosoft Dynamics 365 Business Central1 to use

SharePoint access, an app registration for delegated access must be set up.

For details on how to set up an app registration, see the Microsoft1 documentation.

Open the app registrations in Azure AD, create a new app registration, and give it a unique name.

Under Authentication, specify the address https://businesscentral.dynamics.com/OAuthLanding.htm  as a redirect -URI of type Web.

Under "Certificates & Secrets", create a new client secret key and reserve it. 

Attention! After closing the pop-up window, this key can no longer be copied!

Under "API Permissions" for SharePoint access, assign "Delegated permissions" to the Microsoft1 Graph scopes:

Files.ReadWrite.All

Sites.ReadWrite.All

User.Read.All

Set up app registration for application permissions in Azure AD

If, for example, a service is to log on to SharePoint Online for background processing and store or query documents, it may be

necessary to use SharePoint Online. Create an app registry with application permissions.

For details on how to set up an app registration, see the Microsoft1 documentation.

Open the app registrations in Azure AD, create a new app registration, and give it a unique name.

Under Authentication, specify the address https://businesscentral.dynamics.com/OAuthLanding.htm  as a redirect -URI of type Web.

Under "Certificates & Secrets", create a new client secret key and reserve it. 

Attention! After closing the pop-up window, this key can no longer be copied!

Under "API Permissions" for SharePoint access, assign "Application permissions" to the Microsoft1 Graph scopes:

Files.ReadWrite.All

Sites.ReadWrite.All

It is also possible to work with Sites.Selected instead of Sites.ReadWrite.All. However, setting up selective authorizations is only

possible via APIs and not via a graphical user interface. 

Crawled Properties vs. Managed Properties

In the SharePoint structure, a basic distinction is made between "crawled properties" and "managed properties".
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Crawled properties are created by adding new columns to a SharePoint list, for example. If necessary, an index can be placed on

top of these columns, so that these columns can also be directly indexed and filtered. However, the disadvantage arises with

regard to the Graph API as soon as an index term is used across lists in several thousand documents (e.g. the customer number).

Here, the filtering mechanism of the Graph API can no longer perform structured filtering and accordingly returns an http error

422 "The request is unprocessable because it uses too many resources".

The "DMS & ECM Interface" offers the possibility to automatically switch to a search query (graph query) if there are too many

hits and to obtain the documents via it. However, there are the following limitations that must be taken into account:

For a graph query, properties must be marked as "Refinable". This is only possible via the already supplied properties with the

names "Refinable\\ (example "RefinableString00"! So, in order to make your own property searchable and make it available for

return, managed, "refinable" properties must be mapped to the searchable properties. How to do this is explained in the next

section.

Managed properties are not available until after indexing. Indexing in SharePoint Online is automated in a time cycle between

5 minutes and 2 hours and cannot be controlled by the user or administrator. As a result, it can happen that a document that

has just been filed cannot yet be found via the search!

Assignment of "Refinable" properties

Open the Microsoft1 365 admin center and select SharePoint under "Admin centers" in the left navigation tree.

In the "SharePoint admin center" in the left navigation tree, select "More features" and then select the "Open" button in the

"Search" tile in the main area to open the search settings.

Then, on the following screen, select the "Manage Search Schema" list item.

Now, assign to the Managed Properties with the Refinable the individual crawled properties that you created from the columns of

the Document Library.

Corresponding data types for the Refinable properties are:

RefinableDate (00-19)

RefinableDateFirst (00-04)

RefinableDateInvariant (00-01)

RefinableDateSingle (00-04)

RefinableDecimal (00-09)

RefinableDouble (00-09)

RefinableInt (00-49)

RefinableIntFirst (00-04)

RefinableString (00-219)

RefinableStringFirst (00-39)

RefinableStringLn (00-09)

RefinableStringWbOff (00-49)

RefinableStringWbOffFirst (00-49)

RefinableYesNo (00-04)

An overview of the various properties and their characteristics can be found in this link: Microsoft1 documentation

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 
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1.3.8 EDX - Electronic Data eXchange

General

EDX - Electronic Data eXchange stands for the document exchange module of KUMAVISION 365. EDI documents are sent in

different formats, e.g. EDIFACT, VDA, OpenTrans etc.. A converter handles the conversion from the external format to the EDX

internal XML format.

EDX then processes the converted messages and imports them into Microsoft Dynamics 365 Business Central. Required message

acknowledgements are automatically sent within the internal document exchange. In the case of external EDI (electronic data

interchange), message acknowledgement must be coordinated with the EDI service provider.

Incoming messages are validated by the EDX module. This means that the message content is loaded into the EDX document and

checked for correctness, discrepancies and completeness. The user can manually correct the data in the EDX document and

subsequently create the associated Business Central document.

For incoming messages, mapping is often required between the external item units and those stored in Business Central. For this

purpose, the EDX module provides appropriate mapping tables.

The following diagram should clarify which task EDX takes over in the electronic document exchange:
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BUSINESS PROCESSES

The EDX module enables internal as well as external document exchange. Microsoft Dynamics 365 Business Central1 documents

can be exchanged within a group of companies as well as with external EDI partners.

Area Description

1st

communication

In this area the communication of the data exchange parties takes place. 

For the transmission different protocols are used. The transmission protocols are usually specified by the

data sender. Automotive, for example, uses the OFTP2 protocol. The trade sector tends to use X.400 or

AS2. 

It is not always necessary to use a service provider for document exchange. For X.400 transmission, for

example, FileWork from Telekom can be used. However, if the OFTP½ protocol is required, then it makes

sense to delegate the task of document exchange to a service provider

Message

converter

The incoming messages are converted from the source format to the EDX target format using a

converter. For example, EDIFACT messages are converted to EDX in-house format. For outgoing

messages, the message is converted from the EDX in-house format to the respective target format.

EDX Inhouse

Format

The Inhouse Format maps the documents of the Business Central business processes in a defined

format. EDX uses the XML format for this purpose. The documents are described in the "KUMAVISION

EDI Guideline".

4. EDX Business

Logic

In this area the previously converted documents are transferred into intermediate documents. With the

"Business Logic" all relevant process steps are served, which are necessary for the examination of the

document, creation as well as processing of the Business Central document. If it is possible by the

document, an automation of the business process takes place.
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Internal document exchange

If there is a hierarchical company structure with several companies, then the document exchange can be implemented with the

EDX module. Here, the documents of the individual companies can be exchanged among each other.

Prerequisites for the internal document exchange:

Main company and companies are in one database

In this case, the internal document exchange can be set up directly with the wizard.

Main company and companies are in separate databases

In this case, document exchange must be set up manually.

There is a common network structure and all participants can access a shared network path.

The following figure shows the document flow between customer and supplier in conjunction with the EDX module:

Main Company = Customer

Company = Supplier

External document exchange

If documents are sent to an external partner (EDI) this is described below as external document exchange.

The external document exchange contains message types that have been developed for use with EDI service providers. The EDI

service provider receives the EDX messages, transforms them into the target format and transmits the messages to the recipient.

It is not mandatory to use an EDI service provider. Depending on the requirements, the transformation and transmission can also

be implemented as an in-house solution with appropriate middleware.

Available vouchers

The following documents are already available in XML format after installation:

• 

• 

• 
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Purchase

Order outgoing

Order change outgoing

Order confirmation incoming

Incoming purchase delivery

Incoming purchase invoice

Purchasing complaint outgoing

Sale

Sales order received

Sales order change received

Order confirmation outgoing

Sales quotation outgoing

Delivery bill outgoing

Sales invoice outgoing

Sales credit note outgoing

Sales complaint outgoing

Subsequent changes to purchase order / sales order

If a purchase order has already been sent via EDI and an order line is no longer required, this line must not be deleted. In this

case, the quantity of the line is set to 0 and an order change is sent. This procedure can also be used if an ordered item is to be

exchanged for another item. As described above, the quantity of the original item is set to 0. A new order line is created for the

new item.

If a sales order line has been received via EDI and the item cannot be delivered, the quantity of the line must be set to 0. The line

should not be deleted here either.

Establishment

The module has numerous configuration and customization options, which will be explained in more detail in the following

sections. The first part of the documentation covers all topics concerning administration and configuration. The second part

describes the operation of the data exchange.
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ENTITLEMENT RATES

Via the installation of the EDX Apps, different authorization sets are automatically integrated in your Business Central

application. Assigning these permission sets to your users or user groups ensures that the respective users have access to the

connection and can execute the functions depending on the assigned set.

ROLL CENTER

The EDX Role Center represents the central work platform for the entire EDX module. All necessary information regarding

documents (incoming/outgoing), items (incoming/outgoing) and configurations are displayed with corresponding stacks in the

role center.

Incoming and outgoing documents are displayed as links in the Purchasing, Sales and Logistics overviews, indicating the number

of each. Clicking on the link opens the relevant document or an overview of the documents. It is therefore possible to navigate

from the role center to all EDX relevant documents.

Furthermore, all settings as well as error entries and system messages are displayed in additional overviews.

EDX SETUP

In the EDX Setup, settings can be made that are valid for the entire module. The EDX Setup can be called up via the Facilities

and extensions > Service connections > KVSEDX Setup start page.

In the register Interface directory the directories for documents, test as well as the productive have to be defined. 

Further entries are not necessary for the time being, since these are made with the EDX Setup Wizard. Further information can

be found in the section of the same name.

For completeness, all fields of the EDX setup are explained in more detail below.

Inforegister General

Authorization

set

Description

EDX ALL Permissions to read the EDX setup.

This role must be assigned to the users.

EDX SETUP Permissions to read, write, modify as well as delete records for all EDX tables.

This permission set allows EDX setup as well as access to all EDX objects.

This role must be assigned to the Microsoft Dynamics 365 Business Central1 Administrator as well as

the task queue user.

EDX SALES Permissions to read, write as well as modify records related to the sales business process.

This role must be assigned to the sales users.

EDX PURCHASE Permissions to read, write as well as modify records which are related to the business process

purchasing.

This role must be assigned to users from the purchasing area.

field Description

Test

environment

This flag controls whether the messages are processed in the subdirectory for the production or test

database.

see "Inforegister interface-directory"

database name name of the current SQL database
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Inforegister interface directory

Inforegister Azure Storage

The Azure service connection is registered when the setup dialog is closed. Before the Azure Connection Test action can be

executed, the setup dialog must be closed and reopened.

After that, the Azure Connection Test action can be executed.

Depending on the setup, either the connection to the Azure Storage Container or to the Azure File Share can be tested.

The following actions are performed during the test:

Create Readme.txt file in the container.

List files in the container

Read in file "Readme.txt

Delete file "Readme.txt".

Information register partner

field Description

Document directory (UNC) Base directory for electronic document exchange.

The path must refer to a network share and be written according to UNC notation.

Example: \server name\EDX

Subdirectory Test Environment Subdirectory for Test Environment.

Subdirectory productive

environment

Subdirectory for productive environment.

field Description

Storage Account

Name

Name of the created Azure storage account.

See Azure Environment: All Resources-> Storage Account

Shared Access Key Access key for the storage account

After selecting the storage account in the Azure environment, the access key (key1) can be retrieved

and copied to the Shared Access Key field.

Container Name of the blob container in the storage account.

Azure subdirectory

Prod

Subdirectory for productive data.

Azure subdirectory

Test

Subdirectory for test data.

Activated When activated, the Azure Storage interface is registered as a service connection and can be used.

File Share Name of the Azure file share.

• 

• 

• 

• 

field Description

Extension Vendor EDX

Partner Code 

Extension Customer

EDX Partner Code

Within the EDX module the EDI partners are created based on a customer or vendor. The partner

codes are composed of the respective Microsoft Dynamics 365 Business Central1 vendor or

customer number and the extension specified here

Example:

Creating an EDX partner based on vendor 1000. The EDX partner is managed as V1000. 

The extension codes are freely selectable. Both extension codes must be filled in

.
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Inforegister numbering

All incoming EDX documents are first stored in EDX intermediate tables. For these EDX documents number series are necessary.

If the EDX module is used exclusively for outgoing documents, then the specification of number series is not necessary.

Information register web service

Field Description

EDX Order Number Incoming order from customer.

EDX Order Change Number Incoming order change from customer.

EDX Purchase delivery number Incoming sales delivery from supplier.

EDX Purchase Invoice Number Incoming sales invoice from vendor.

EDX Order Confirmation Number Incoming order confirmation from supplier.

field Description

Log incoming web service data Specifies logging of incoming web service calls. Logging takes place in the EDX inbox.

Log outbound web service data Specifies logging of outbound web service calls. Logging takes place in the EDX outbound.
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Inforegister error handling

Inforegister XML

Inforegister GS1

field Description

The parameter "Time period until e-mail is sent" can be used to

control the time period for which the errors are collected. Only

after this time span has expired, the mail dispatch of all occurred

errors takes place.

Error mail address Mail address to which error messages are sent. Only

error messages are sent, which occur within the

server processing. 

The following list shows a few examples of when error

mails are sent automatically: 

An error occurs when reading an XML file.

Possible error causes: 

- General errors within the XML file (Wellformed) 

- The XML file does not match the expected schema

An error occurred during automatic further

processing "Receiving a sales order". 

Possible causes of error: 

- Within the sales order, a reference is made to a

Business Central master data record (e.g. article

number, article unit) which does not exist. 

- When the sales order is created, queries are made

which must be confirmed by the user (e.g. credit

limit). These queries are not allowed in a background

process. 

An error occurs when sending an XML file. 

Possible error causes: 

- No permission to write the outbound directory.

In the error mail, a link to call the related Business

Central Page is provided. For further information,

please refer to the section "Setting up e-mail

dispatch".

field Description

Disable XML Byte Order

Mark

This switch can be used to control whether the XML message to be output should contain the

byte order mark.

field Description

Weight Unit

code

A unit code is required for the weight within the GS1 messages. As the weight is specified in Microsoft

Dynamics 365 Business Central1 without a unit, the unit code can be defined in this field.

Volume Unit

code

A unit code is required for the volume within the GS1 messages. As the volume is specified in Microsoft

Dynamics 365 Business Central1 without a unit, the unit code can be defined in this field.

1.3.8 EDX - Electronic Data eXchange

- 1341/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Inforegister Reorganization

Inforegister BC Configuration

Inforegister Facility Overview

The fields on the Setup Overview info tab give an overview of which items are already set up in EDX.

EDX Setup Wizard

To make the setup of the connection as comfortable as possible for users, a setup wizard has been developed to guide you

through the individual steps. This setup wizard can be called up via the EDX Setup menu ribbon (More Options > Action >

Setup > EDX Setup Wizard).

Furthermore, the EDX Setup Wizard can also be started via the "Supported Setup".

The EDX setup wizard is started.

During the first EDX configuration, the "Communication" function should be started.

With the selection "Communication" the parameters for the file transfer (OnPrem) as well as the parameters for the Azure

Storage can be entered.

The General selection is used to create the message types as well as number series for incoming messages.

If you want to send purchase orders, delivery bills or invoices to another client, then select the Internal document exchange

function. For more information, see the "Internal document exchange" setup section.

EDX DOCUMENT TYPES

When installed, the EDX module already has some message types which can be used for internal and external document

exchange.

Establishment

The EDX message types are created with the action "EDX Setup Wizard" within the EDX setup.

field Description

The date formula in the "Archive outputs/inputs that are older" fields can be used to specify the date from

which EDX inputs/outputs will be moved to the archive. Only outgoing items for which no transmission

error has occurred will be moved to the archive. 

Outgoing items with transmission errors can be manually moved to the archive using the Archive

outgoing items with transmission errors action. 

For inbound items, only completed acknowledgement messages are moved to the archive. The archiving of

other input messages, such as EDX sales orders is controlled via the respective EDX document.

field Description

Job Queue V3 Indicates that the new version of the EDX task queue is being used. With version 3.0, tasks can

be executed at one-second intervals. In addition, transactions such as message receipt, document

creation and dispatch take place directly one after the other, which minimizes delays.

Task queue items in

seconds interval

As soon as the switch is active, all EDX task queue items except for the parameters

"Reorganization" and "Send Mail" will be executed in seconds interval.

Use interval for

incoming/outgoing

messages

Specifies that the interval in the message setup is also used for sending or receiving messages.

If the switch is activated, incoming and outgoing message setups are executed when the "Earliest

start date" according to the message setup has been reached. Further information can be found

in the section "Message facility - Information register processing".
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You can view the "EDX message types" using the call of the same name via the user search. The individual fields are explained in

more detail below: 

Distribution of EDX document types

All EDX message types have a prefix with which an area assignment can be made.

Field Description

Document Name of the EDX message.

Description Description of the EDX message.

Document Direction Inbound/Outbound Message.

GS1 Business Message

Standard

Indicates if this is a GS1 Business Message Standard message.

Intercompany Role Role of the document within the intercompany message exchange (customer/vendor).

Processing order Default value for the processing order.

This ensures that a purchase order confirmation is processed before the purchase delivery.

Field setting active Default value for the field setting.

If the message supports the field setting, then the field setting can be called after the message

has been assigned to an EDX partner.

Collective mail allowed Default value for collective mail.See "Processing".

Include PDF allowed Indicates to include the associated Business Central PDF document as a base64 string in the

message.

Message Encoding Sets the message encoding.

Web Service Function The EDX message can be accessed via SOAP web service.

Webservice Function

Name

Name of the associated webservice function.
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The areas are subdivided as follows:

Area Description

IC Internal message exchange.

GS1 GS1 Message.

CC External message exchange.

Documents reconciled with Clearing Center. 

These messages are used from EDX version >= 10 for external message exchange.

See also KUMA EDI Guideline.

PEPPOL BIS

3.0

PEPPOL Business Interoperability Specification (BIS) 3.0.

EDX provides the standard Microsoft Dynamics 365 Business Central1 messages for PEPPOL BIS 3.0.

Adjustments to these messages are only.
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Message Description Message direction

BASE CUSTOMER Basis Debitor Export Starting from

BASE ITEM Basic Item Export Starting from

BASE VENDOR Basis Vendor Export Starting from

CC PURCHASE ORDER Send purchase order Starting from

CC PURCHASE ORDER

CHANGE

Send purchase order change Starting from

CC PURCHASE

RETURN ORDER

Send purchase complaint (CC) Starting from

CC PURCHASE

RETURN ORDER CHG

Send purchase complaint change (CC) Starting from

CC PURCHASE

INVOICE

Receive purchase invoice (CC) Incoming

CC PURCHASE

RECEIPT

Receive purchase delivery (CC) Incoming

CC PURCHASE ORDER

CONF

Receive purchase order confirmation (CC) Incoming

CC SALES INVOICE Send sales invoice (CC) Starting from

CC SALES ORDER Receive sales order (CC) Incoming

CC SALES ORDER CHG Receive sales order change (CC) Incoming

CC SALES ORDER

CONF

Send order confirmation (CC) Starting from

CC SALES SHIPMENT Send sales delivery (CC) Starting from

CC DESPATCH ADVISE Send sales delivery (CC)

This message can only be used in conjunction with the 

"KUMAVISION Dispatch processing". The message contains the

assigned load carriers and their hierarchy.

Starting from

CC SALES CR.MEMO Send sales credit memo (CC) Starting from

CC SALES RETURN

ORDER

Send sales complaint (CC) Starting from

CC SALES RETURN

ORDER CHG

Send sales complaint change (CC) Starting from

CC SERVICE INVOICE Send service invoice (CC) Starting from

CC SERVICE CR.MEMO Send service credit note (CC) Starting from

CONFIRMATION

RECEIVE

Receive confirmation of receipt Incoming

CONFIRMATION SEND Send confirmation of receipt Starting from

GS1 APP REC ACK IMP Receive confirmation of receipt

EDI application recommendation GS1 XML 3.4.1. Application

Receipt Acknowledgement 

Incoming

GS1 APP REC ACK IMP Starting from
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Message Description Message direction

Receive confirmation of receipt

EDI application recommendation GS1 XML 3.4.1. Application

Receipt Acknowledgement 

GS1 SALES CRMEMO

EXP

Send sales credit note

EDI application recommendation GS1 XML 3.4.1. Invoice

Starting from

GS1 PURCHASE

CRMEMO EXP

Send purchase credit

EDI application recommendation GS1 XML 3.4.1. Invoice

Incoming

GS1 SALES DESADV

EXP

Send sales delivery

EDI application recommendation GS1 XML 3.4.1. Despatch Advice

Starting from

GS1 PURCHASE

DESADV IMP

Receive purchase delivery

EDI application recommendation GS1 XML 3.4.1. Despatch Advice

Incoming

GS1 SALES INVOIC

EXP

Send sales invoice

EDI application recommendation GS1 XML 3.4.1. Invoice

Starting from

GS1 PURCHASE

INVOIC IMP

Receive purchase invoice

EDI application recommendation GS1 XML 3.4.1. Invoice

Incoming

GS1 PURCHASE

ORDCHG EXP

Send purchase order change

EDI application recommendation GS1 XML 3.4.1. Order

Starting from

GS1 SALES ORDCHG

IMP

Receive sales order change

EDI application recommendation GS1 XML 3.4.1. Order

Incoming

GS1 PURCHASE

ORDER EXP

Send purchase order

EDI application recommendation GS1 XML 3.4.1. Order

Starting from

GS1 SALES ORDER

IMP

Receive sales order

EDI application recommendation GS1 XML 3.4.1. Order

Incoming

GS1 SALES ORDRSP

EXP

Send sales order confirmation

EDI application recommendation GS1 XML 3.4.1. Order Response

Starting from

GS1 PURCHASE

ORDRSP IMP

Receive purchase order confirmation

EDI application recommendation GS1 XML 3.4.1. Order Response

Incoming

GS1 SERVICE

CRMEMO EXP

Send service invoice

EDI application recommendation GS1 XML 3.4.1. Invoice

Starting from

GS1 SERVICE INVOIC

EXP

Send service credit note

EDI application recommendation GS1 XML 3.4.1. Invoice

Starting from

PEPPOL To 3.0 Verkaufsrechnung Starting from
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EDX PARTNER

In order to be able to exchange documents, one or more partners must first be defined in the EDX module. These partners can be

created based on existing accounts payable or accounts receivable.

EDX partners are managed under a code that consists of the respective Business Central vendor or customer number and a

defined prefix.

Before creating the EDX partner, the field "Our account number" must be defined in the vendor/customer.

Example of "Our Account Number":

Vendor Role: For customer 1000, 61000 is entered in the "Our Account Number" field.

Role of Customer: For vendor 61000, 1000 is entered in the "Our account number" field.

Partner type debtor

A new EDX partner is created directly from the partner overview. To do this, first call up the "EDX partner" via the user search.

With the action "Create customer" a new EDX partner is created on the basis of a customer.

For the EDIFACT UNB segment to be created, the fields: GLN, Data sender as well as Recipient Id. can be used for the EDIFACT

UNB segment to be created.

The fields data sender and recipient ID are not subject to a format check. Accordingly an ODETTE-Id, DUNS-No etc. can be

entered.

Message Description Message direction

PEPPOL 3.0 SALES

INVOICE EXP

PEPPOL 3.0 SALES

CR.MEMO EXP

PEPPOL To 3.0 Verkaufsgutschrift Starting from

PEPPOL 3.0 SERVICE

INVOICE

EXP PEPPOL To 3.0

Servicerechnung

PEPPOL 3.0 SERVICE

CR.MEMO

EXP PEPPOL To 3.0

Servicegutschrift

IC PURCHASE INVOICE Receive purchase invoice (IC) Incoming

IC PURCHASE ORDER Send purchase order to vendor (IC) Starting from

IC PURCHASE ORDER

CHG

Send order change (IC) Starting from

IC PURCHASE ORDER

CONF

Receive order confirmation (IC) Incoming

IC PURCHASE

SHIPMENT

Receive purchase delivery (IC) Incoming

IC SALES INVOICE Send sales invoice (IC) Starting from

IC SALES ORDER Receive sales order (IC) Incoming

IC SALES ORDER CHG Receive sales change (IC) Incoming

IC SALES ORDER

CONF

Send order confirmation (IC) Starting from

IC SALES SHIPMENT Send sales delivery (IC) Starting from

IC SALES DELFOR Receive delivery call-off (FACTORY only) Incoming
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For the transmission of XInvoices to an EDI service provider the "Routing Id." is required. see "Coordination Office for IT

Standards".

Basically all above mentioned fields have to be coordinated with the EDI service provider. The fields are transmitted within the

CC messages invoice, credit bill as well as delivery bill in the element "Routing".

Units mapping

A unit mapping is necessary to change the customer's unit code to your own unit code. 

Example:

A customer orders 5 PCS, the unit code in Microsoft Dynamics 365 Business Central1 is Piece. In this case, a mapping must be

created for the translation from PCS to Piece.

The unit mapping is accessed from the "EDX Partner Overview" via the ribbon.

It is not necessary to store a unit mapping for each EDX partner and article. As a rule, the unit "PCS" must be converted to the

Business Central unit "Piece" for all EDX partners and articles. 

The following sequence is used to determine the unit mapping:

mapping with EDX partner, article and reference code search.

mapping with article and reference code search

search mapping with EDX partner and reference code

mapping with reference code search

Unit mapping is used with the following documents:

Sales orders

Sales order changes

Purchase order confirmations

Purchasing deliveries

Purchasing invoices

For outgoing documents, unit mapping is only performed in the "Clearing Center Messages".

born sales delivery

born sales invoice

purchase order

order confirmation

ADDITIONS/DETRACTIONS MAPPING

In EDX additions/deductions mapping, additions and deductions can be assigned to articles, resources, G/L accounts and fields in

the document header. 

Examples:

G/L account for surcharge advertising costs 

Item as freight costs

Amount incl. VAT field from the sales header as an insurance surcharge.

Only fields from the sales header can be used. Amounts and percentages can be specified. These two fields are disabled for lines

surcharges/discounts. The field "Position" is filled automatically and is only an information for the user. 

The addition and deduction codes are selected from a separate table. 

1. 

2. 

3. 

4. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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The surcharge/deduction mapping is only used for external outgoing document dispatch with Clearing Center. This includes the

following documents:

Order Confirmation

Posted sales invoice

Posted sales credit memo

SERVICE GTIN MAPPING

With the "EDX Service GTIN Mapping" resources, G/L accounts etc. can be provided with a GTIN. The stored GTIN is sent within

the service invoice as well as credit note.

GTIN/REFERENCE MAPPING

The GTIN/reference mapping can be used to assign a GTIN to resources, G/L accounts, etc.

The selection of the business relationship determines whether the mapping is used for purchase or sales messages. A reference

can also be entered in the mapping. This is necessary if the resource does not have a GTIN but the message recipient has defined

a different code for the resource.

Example:

For outgoing messages for customer 30000, the resource LIFT with the reference no. H58 to the message recipient. The

surcharge/discount V-RABATT is reported with the reference E-RABATT.

GTIN/reference mapping is supported for EDX GS1 messages and for Clearing Center messages for service invoices and credit

notes.

GTIN14

With the introduction of EDX GS1 messages, a 14-digit GTIN is supported.

Further information can be found at: GTIN (Global Trade Item Number).

EDX OCCUPANCY DEVICE

Different message types can be defined for each EDX partner. With the "EDX message setup" the documents are assigned to the

EDX partner as well as configured.

Via "New" an EDX message is assigned to a previously created EDX partner. In the following, the fields of the EDX message card

will be explained in more detail.

• 

• 

• 

Business

relationship

Relationship

no.

Typ No. GTIN Referenz-No.

customers 30000 Resource LIFT H58

customers 30000 Surcharge/

discount (item)

V-DISCOUNT E-DISCOUNT

vendor 30000 Resource H58 LIFT

vendor 30000 Surcharge/

discount (item)

E-DISCOUNT V-DISCOUNT
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Inforegister General

field Description

Partner No. Selection of EDX partner.

Only active EDX partners can be selected.

EDX Message Selection of the EDX Message.

By default, the following messages are included: 

- Order outgoing 

- Order confirmation incoming 

- Order change outgoing 

- Sales order incoming 

- Sales order change incoming 

- Order confirmation outgoing 

- Delivery bill outgoing 

- Sales invoice outgoing

EDX Message

Description

A freely selectable description can be entered here. This is for information only

EDX Message

Direction

Indicates the direction of the message (incoming or outgoing).

EDX transmission

from
Microsoft Dynamics 365 Business Central1 documents are received or sent from the date specified

here.

Receipt

Confirmation

Check

Receipt confirmation check can be used to control whether a message confirmation should be

requested. 

Example:

Sending a purchase order with receipt confirmation check. 

Upon receipt of the purchase order on the receiving end, a receipt confirmation is sent to the message

sender. The EDX status within the purchase order will automatically change to "Recipient Received".

After the Business Centrals sales order is created at the recipient's end, another acknowledgement is

sent. The EDX status within the order automatically changes to "Recipient accepted". 

If the recipient rejects the EDX sales order, then an acknowledgement is also sent. The EDX status in

the sent order will change to "EDX Rejected". 

Acknowledgement check should be enabled on outgoing as well as incoming message.

Outgoing acknowledgement messages e.g. for receiving an EDX sales order will now be sent via EDX

outgoing. 

The "Source record" field now always refers to the associated document. The acknowledgement check

is now supported by all EDX messages, sales deliveries, sales invoices as well as sales credit notes. 

In case of external EDI, the acknowledgement messages may have to be coordinated with the EDI

service provider.

Test Indicator Identifies the incoming or outgoing messages as a test message 

See section Productive/Test Database.
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Inforegister transfer
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Field Description

EDX

transmission

type

Intercompany

If both clients are in one database, the transmission type "Intercompany" can be used.

The EDX Intercompany setup must be carried out via the EDX setup wizard. 

API V2.0 Intercompany

Prerequisite: see section "OAuth setup".

If both clients are in different SaaS databases, the "API V2.0 Intercompany" transfer type can be

selected. The EDX Intercompany setup must be done via the EDX setup wizard.

Azure Storage

Prerequisite: Set up an Azure storage and container. See section "Inforegister Azure forwarding"

All messages are stored or retrieved on the specified Azure Storage container.

This transfer type can be used in the following scenario:

Messages are to be stored on an FTP or SFTP server for the interface operator.

An Azure Logic App must be created in the customer project.

The Azure Connector "FTP" is used for message transfer within the Azure Logic App. 

Note:

The Azure Logic App is not part of the EDX module.

Azure Fileshare

Prerequisite: Set up an Azure storage and fileshare.

All messages are stored or retrieved on the specified Azure fileshare.

This transfer type can be used in the following scenario:

Messages are to be stored in the file system of the interface operator. A Powershell script is made

available to the interface operator for the Azure fileshare set up. The interface operator can use this

script to integrate the Azure fileshare as a network drive in their infrastructure.

Null

Prerequisite: none

Outgoing messages: 

The "Null" communication interface marks outgoing messages as sent. A transmission does not take

place. 

The outgoing message can be downloaded with the "Download message" action.

Incoming messages:

No processing. Incoming messages can be imported in the EDX inbox with the "Upload message" action.

This transmission type can be used in the following scenarios:

The interface operator sends the messages directly to the EDX inbox via the "EDX API Inbound" web

service.

In this case, the associated EDX message must be assigned to the EDX partner with the "Null"

transmission type.

The incoming/outgoing EDX messages should already be tested, although the communication

parameters have not yet been determined. 

E-mail

Prerequisite: Set up an e-mail account in Microsoft Dynamics 365 Business Central1.

The messages are sent as an attachment to an e-mail. 
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Inforegister Azure / File Transfer

Inforegister Azure Forwarding

The forwarding parameters are sent to an Azure Logic App or Power Automate.

The Azure Logic App is not part of EDX. A corresponding "Azure Logic App" or "Power Automate" must be created in the

customer project to process the parameters listed below. For the creation of the "Azure Logic App" the template

"EDX_Outbound_Message" can be used.

When using the forwarding parameters, the GS1 messages "GS1 APP REC ACK IMP" as well as "GS1 APP REC ACK EXP" must

be assigned to the EDX partner.

Example:

CC Invoice message is to be forwarded to EDI service provider EDI1 via SFTP. The message is to be placed on the destination

FTP server in the /inbound directory.

Field Description

This transmission type can be used in the following scenarios:

A supplier would like to receive the Microsoft Dynamics 365 Business Central1 article, purchase order,

etc. as an xml message attached to an email.

Note:

Additional transmission types can be implemented in the customer project. It makes sense to extend the

transmission type if the interface operator provides web services for receiving messages, for example.

Messages from the interface operator to Microsoft Dynamics 365 Business Central1 can be sent to the

"EDX API Inbound".

field Description

EDX file path Input/output path for files.

In this field either an absolute or dynamic path can be entered. The dynamic path is stored with the

placeholder %ROOT_DIR%.

This placeholder is exchanged at runtime for the base directory from the EDX setup.

Thus, when moving a directory share, it is sufficient to change the new directory in the "Directory

Documents (UNC)" field within the EDX setup. 

In the above example, %ROOT_DIR% is exchanged for \kvsdodc01\temp\EDX\Test10\Prod\ . 

Once the "Test Environment" switch is enabled, the following directory applies to %ROOT_DIR% \

\kvsdodc01\temp\EDX\Test10\Test\

The same rules apply to the placeholder %AZURE_CONTAINER%

In this case, the Azure container set up is used.

Field Description

Forwarding type This parameter can be used within the Logic App to decide which Azure Connector is used.

Forwarding ID Determines the EDI party.

Forwarding Destination Determines the destination of the message.
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Specify the following forwarding parameters:

FTP information register

No longer supported.

For FTP as well as SFTP transfer, an Azure Storage in connection with an Azure Logic App is required.

Inforegister e-mail

field description

Forwarding type SFTP

Forwarding ID EDI1

Forwarding destination /inbound/

field Description

Recipient Email Address Email address of the message recipient.

Email Subject Indicates the subject of the e-mail.

Email Text (HTML) Indicates the text of the e-mail.
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Information register processing

In this info register the processing parameters for the incoming as well as outgoing messages are defined.
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Field Description

Automatic

processing

EDX incoming document: 

The received EDX document is automatically checked. If there are no errors during the check, the

Business Central document is created. 

If an error occurs during the review or creation of the Business Central document, an error email is

automatically sent.

This feature is currently available for EDX sales orders. 

See section: "Automatic processing"

EDX Outbound Document: 

So far, the following outbound documents can be sent automatically: 

- Sales delivery

- Sales invoice

- Sales credit memo

- Purchase order

- Purchase order changes

See section: "Automatic processing".

Automatic

processing steps

This option can be used to specify which processing steps are to be carried out during automatic

processing.

The following options are available:

• Check and process

• Check only

Note:

This option can only be selected for incoming EDX standard messages.

Processing order Specifies the processing order of incoming messages.

Do not add

transmission ID

If this option is enabled, the "EDX Transmission ID" element is not transferred to the XML file. 

The EDX module basically assumes that the "TransmissionID" element is present in the incoming XML

document. This element, for example, is used for document navigation within EDX. 

If the incoming XML document does not contain the TransmissionID, then this is automatically added

as the first element. 

Note: 

The setting of this switch should only be changed if described in the respective application

documentation (customer project).

Invoice ignore zero Invoices with a value of 0 € will not be transferred if this option is enabled.

The setting of this switch should only be changed if it is described in the respective application

documentation (customer project).

Ignore zero credit

notes

Credit notes with a value of 0 € will not be transferred if this option is enabled.

Automatic

archiving

Determines that the associated EDX receipt is archived after EDX receipt processing.

Direct Purchase

Invoice

Disabled:

When processing an incoming purchase invoice, the purchase delivery information is expected. Based

on the purchase delivery number, the associated purchase order is determined.

The purchase delivery as well as the purchase order are then used for plausibility checks.
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Field Description

Switched On:

The EDX purchase invoice data is transferred directly to an unposted purchase invoice. Plausibility

checks are performed with regard to the "purchase from vendor" as well as the articles. 

Note

This option is not available with EDX Intercompany.

Include the

associated PDF

document

In the case of outgoing messages for the Clearing Center, the associated PDF document can be

included directly in the message. The PDF document is transmitted as a base64 encoded string.

If the created Business Central documents (sales delivery bill, sales invoice as well as sales credit bill)

should not be sent immediately when posting, then a document collection can be activated with this

option. 

This option is currently used by the EDX documents: Sales Delivery (CC), Sales Invoice (CC), Sales

Credit Memo (CC) supported. 

The time for sending the document can be set by the processing time window.

Next list number When sending collective shipments, a list number is usually required. In the "Next list number" field,

the list number can be specified which will be used for the next transmission. 

Note: 

Sales deliveries can be transmitted as collective consignments. There is no provision for assigning a

list number.

In general, a forwarding order number must be transmitted within the delivery note message. This is

currently not supported by the EDX CC delivery note message.

BC Release

document

This setting controls that a scanned document is automatically released after creation.

BC Post Document Determines whether an incoming EDX document should be posted or not.

Use Posting Date Specifies which date should be used for incoming EDX vouchers. 

The following options are available:

- Posting date

- Current date

- Work date

- Incoming document date.

Show BC document Specifies whether the associated Microsoft Dynamics 365 Business Central1 document should be

displayed after processing an incoming message.

User query

As before, a query is displayed asking whether the associated Microsoft Dynamics 365 Business

Central1 document, e.g. sales order, should be displayed.

Display automatically

The associated Microsoft Dynamics 365 Business Central1 document, e.g. sales order, is displayed

without a query.

Do not query/display

There is no query and the Microsoft Dynamics 365 Business Central1 document is not displayed.

Use article

references

Since in the rarest cases there is a consolidated article master between the partners, it is necessary

to ensure a reliable assignment of the article numbers. The setting "Use article references" controls a

check of the transmitted article number, as well as the transmitted reference number. The article/

reference number check is based on the Microsoft Dynamics 365 Business Central1 article master >
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Field Description

References. 

When using this function, the following requirements are necessary: 

- The partner must necessarily transmit the GTIN or reference number.

- The article references of the partner must be maintained in the article master.

When transmitting a GTIN, the Microsoft Dynamics 365 Business Central1 article is determined based

on the GTIN field in the article master. If no matching article is found, then a search is performed

using the article references with type "Barcode". With the article reference search the reported

article unit is used.

If also this search should lead to no result, then the search takes place on the basis the article

references with type "debtor" and/or "creditor". The reported article reference number from the

message is used.

Use article unit

mapping

This setting controls an automatic mapping of the article units. 

Example:

The EDX partner transmits for any article the article unit "PCS" which is managed in Microsoft

Dynamics 365 Business Central1 as "Piece". If the corresponding mapping table is maintained and the

"Article Unit Mapping" setting is maintained, the unit will be changed accordingly upon receipt.

.

EDX Automatic

Archiving

If an EDX document is processed, this setting can be used to control that the corresponding incoming

item is archived.

Processing Time

Window

For outgoing documents, the processing time window controls when the document is sent. For

incoming documents, the processing time window controls the review and creation time.

Example for outgoing sales invoices:

Sales invoices are to be collected by Saturday and sent at 10:00 p.m.

In this case, the "Execute Saturday" option is enabled in the processing time window. All other days

will be disabled. The start time is set to 22:00 and the end time is set to 23:00. The earliest start date

will be calculated automatically. Once the specified time window is reached, all invoices that have not

yet been sent will be sent. 

Incoming sales order example:

Sales orders should be processed automatically at 22:00 every day. In this case, every day will be

activated in the processing time window. The start time is set to 22:00 and the end time is set to

23:00.

Note: 

Once the specified time window is reached, all unprocessed EDX sales orders will be checked and

created as Microsoft Dynamics 365 Microsoft Dynamics 365 Business Central1 order.

Intervall Specifies that incoming EDX intermediate documents are automatically processed at the interval

specified here. Outgoing BC documents are also transferred to the EDX outbox at the interval

specified here. If the "Use interval for incoming/outgoing messages" parameter is activated in the

EDX setup, messages are also sent and received at the interval specified here.

Example:

No start/end time has been set. The weekdays from Monday to Friday are activated. Interval is set to

30 minutes. "Earliest start date/time" is empty or less than the current date/time. EDX processing is

executed. After execution, "Earliest start date/time" is recalculated with the current date/time +

interval.

Example:

Start/end time from 12:00 to 15:00. The weekdays from Monday to Friday are activated. Interval is
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Info tab Advanced

Field Description

set to 30 minutes. "Earliest start date/time" is empty or less than the current date/time. EDX

processing is executed. After execution, "Earliest start date/time" is recalculated with the current

date/time + interval. After the end time is exceeded, "Earliest start date/time" is recalculated with the

current date/time + 1 day.

field description

Partner Type Indicates whether the displayed EDX partner is a customer or vendor.

Partner BC No. Displays the Microsoft Dynamics 365 Business Central1 customer or vendor no. depending on the

"Partner type" field.

Message Type Displays the Microsoft Dynamics 365 Business Central1 message type associated with the EDX

document setup.

Document Table No. Displays the Microsoft Dynamics 365 Business Central1 Table No. associated with the EDX

Document Setup.

Object Type

Object ID

Indicates the XML port or code unit responsible for message processing.

Message Encoding Specifies the message encoding. This parameter has no effect on EDX standard messages. Within

project specific messages this parameter can be used for the message encoding.

Webservice Function Specifies the message for use within internal webservice functions.

Webservice Function

Name

Sets the name of the internal webservice function.
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Inforegister parameters

Transmission

type

Parameter Description

Azure File

Share

These parameters can be used to override the Azure file

share parameters from the EDX setup.

Example

1. In the EDX setup, the Azure storage account

"PartnerA" and the file share "Transfer" is set up. No

different parameters are entered on the selected

message.

In this case, the message transfer is to the Azure storage

account "PartnerA" / "Transfer".

2. As described in point 1, the Azure storage account as

well as the fileshare is set up in the EDX setup. 

For the selected message, the Azure storage account

"PartnerB" and the fileshare "Interface" are specified via

the parameters.

In this case, the message transfer will be to the Azure

storage account "PartnerB" / "Interface".

AZURE_FILESHARE_ACCOUNT_NAME storage account name

AZURE_FILESHARE_ACCESS_KEY Storage account access key

AZURE_FILESHARE fileshare name

AZURE_FILESHARE_DIR_PROD Directory for Prod. environment

AZURE_FILESHARE_DIR_TEST directory for test environment
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Function "Field settings document check "

The function "Field settings for document check" in the ribbon defines which fields of the EDX document are checked or

transferred to the Microsoft Dynamics 365 Business Central1 document.

SET UP TASK QUEUE ITEM

Automated message sending/receiving is done by setting up the task queue items. These are created using the EDX setup wizard.

See "EDX Setup".

Field Description

Validation sequence The data from the EDX intermediate document is transferred to the Microsoft

Dynamics 365 Business Central1 document in accordance with the defined

validation sequence.

Use default values The "Use default value" option can be used to pre-assign fields within the EDX

document that are not contained in the message, for example.

Default value For example, you can set the due date in the sales header so that this field is

always initialized with the working date. Constant values or placeholders can

be used within the default value. When using a constant, care must be taken to

ensure that the value is entered in XML format. 

A fixed date must therefore be entered in the format YYYY-MM-DD. For decimal

values, the dot must be used as a separator. The XML format was chosen to

avoid translation errors in different languages. If employees set the date:

15.01.2023 as the default value and then English-speaking employees check

the message, the default date cannot be converted.

The default values are initialized when the EDX document is checked. 

List of placeholders:

%WORKDATE = Work date

%TIME = Current time

%TODAY = Current date

%COMPANYNAME = Client name

@Fieldname = Reference to another field in the current table

%CLEAR = Clear target field

This indicator controls whether the field

content from the EDX document is to be

checked and transferred to the Microsoft

Dynamics 365 Business Central1

document.
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Process distribution within the task queue items

The following task queue items are created using the EDX Wizard: CodeUnit: 5487951 EDX Job Queue

GLN FACILITY

For the creation of an EDIFACT message, further GLNs are required in addition to the GLN (Global Location Number) in the

customer. With EDIFACT the message recipient is transmitted in the UNB segment. The GLN of the message recipient can differ

from the GLN of the customer.

According to EDIFACT GLN's are mapped in the following segments:

Parameter Description

INBOUND_TRANSMISSION Read data according to the specified transfer type (e.g. file transfer) and make it

available in "EDX Inbox".

INBOUND_TO_EDX_DOCUMENT Process all EDX input items with status "Unprocessed".

INBOUND_POST_EDX_DOCUMENT Check all created EDX documents (sales order, purchase order confirmation, etc.)

that have been configured with the "Automatic processing" flag and create the

corresponding Microsoft Dynamics 365 Business Central1 document if necessary.

OUTBOUND_SEND_NAV_DOCUMENT All created Microsoft Dynamics 365 Business Central1 documents (sales delivery,

sales invoice, etc.), which are configured with the "Automatic processing" flag, are

transferred to the "EDX outbox".

OUTBOUND_TRANSMISSION Send all EDX outgoing items with status "Unprocessed" according to the defined

transmission type.

SEND_MAIL Send processing errors by mail.

REORGANIZATION Archive the EDX outputs. Time of archiving is defined in EDX Setup.
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The GLN's are entered in the following Microsoft Dynamics 365 Business Central1 master data:

Message receiver (UNB)

The GLN for the message recipient/sender (UNB) is entered directly at the EDX partner in the "GLN" field.

Debtor (NAD segment)

The GLN for the customer (NAD segment) is entered directly on the customer card in the "GLN" field in the "Invoicing" info tab.

Message

Segment

Description Identifier

UNB Interchange Header (Message Sender/Receiver).

If the "Invoice to Customer" belongs to a federation, then GLN of the

federation customer, otherwise GLN of the "Invoice to Customer".

Special case: The message receiver requires a GLN, which does not belong to

the above master data. In this case the GLN of the EDX partner is used.

NAD Name and address data SU = Supplier

BY = Buyer

DP = Delivery

address

IV = Invoice

address
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GLN of location

Location for the delivery can be defined within a Microsoft Dynamics 365 Business Central1 purchase order. If this location has a

different GLN to the company data, this GLN can be entered in location.

This setting only applies to EDX GS1 messages.

Delivery to address (NAD segment)

The GLN for the delivery to address (NAD segment) is entered directly on the customer card > delivery to addresses in the field

"GLN" in the info tab "General".

The transmission of the above mentioned GLN's is supported by the XMLPorts for EDI service providers (prefix CC).

SET UP E-MAIL DISPATCH

As described in the previous sections, EDX sends mails automatically if, for example, an error has occurred during processing.

The following items must be set up for sending mails:

SMTP mail setup

An SMTP account must be set up via "E-mail accounts". With the action "New" the setup wizard is displayed. Then "SMTP" is

selected. After completing the SMTP setup, the scenario "EDX" must be assigned to the created account.

BC Administration (Management Console)

Mail is usually sent using the Microsoft Dynamics 365 Business Central1 instance JOBQUEUE01. Since this is a process without

client service, it is necessary that the base URL is entered.

In the field "Windows Client Base URL" the URL of a Microsoft Dynamics 365 Business Central1 instance must be entered, where

the option "Enable Client Services" is activated.

Example:

DynamicsNAV://srvnav:7246/NAVProd01/

This base URL is then used, for example, for the PageLinks within the error mail.

INTERNAL DOCUMENT EXCHANGE

Set up with the EDX Setup Wizard

The internal document exchange can be set up completely via the EDX Setup Wizard if both clients are present in one database.

Before starting the wizard, the EDX setup must be set up in both clients. Further information can be found under "EDX Setup".

Afterwards, the action "EDX Setup Wizard" can be started in the EDX Setup.

The setup for the internal document exchange can now be started with the action "EDX Setup Wizard".

After starting the wizard, the following parameters must be set:

Set the function of the wizard to "internal document exchange".

Set the role of the current client.

Selection of the communication interface.

Use purchase price as sales price. 

The price will be transferred from the sent purchase order to the sales order. (See Field Control)

Selection of the client with which messages are to be exchanged.

Assignment of customer as well as vendor according to the clients.

Note

• 

• 

• 

• 

• 

• 
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After executing the "Finish" action, the matching of the "Our account number" field between the customer and vendor takes

place. In both clients, the required EDX partners and the related intercompany documents are assigned.

API V2.0 INTERCOMPANY

As described above, the oAuth setup must be carried out in both databases.

Example:

Current environment DE: When setting up with the wizard, the value "DE2CH" is entered in the "Current database.OAuth

code" field.

The value "CH2DE" is entered in the "Target database.OAuth code" field.

Manual setup

If the clients exist in different databases, then the setup must be done manually.

The following messages have to be set up on the client side:

Environment oAuth Code

DE DE2CH

CH CH2DE

partner no. EDX document EDX

document

direction

EDX document

description

partner type partner BC

no.

EDX

transmission

type

V10000 IC PURCHASE

ORDER CHG

Outgoing Send order

change

Vendor 10000 File transfer

V10000 IC PURCHASE

ORDER CONF

Outgoing Receive order

confirmation

Vendor 10000 File transfer

V10000 IC PURCHASE

ORDER

Outgoing Send order Vendor 10000 File transfer

V10000 IC PURCHASE

SHIPMENT

Outgoing Receive purchase

delivery

Vendor 10000 File transfer

V10000 IC PURCHASE

INVOICE

Incoming Receiving

purchase invoice

vendor 10000 file

transmission

V10000 CONFIRMATION

RECEIVE

Incoming Acknowledgement

Received

Vendor 10000 File

Transmission
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The following messages are to be set up on the vendor side:

When setting up the intercompany documents manually, the EDX file paths must be configured manually. 

In doing so, the outgoing message is configured first. The corresponding path must be stored temporarily. Afterwards the

incoming message can be configured. Here, the path from the previously configured outgoing message must be used.

The message recipient and sender can thus communicate via the same directory. 

Using the example "IC PURCHASE ORDER", the following steps must be carried out. The EDX basic setup must already have

been carried out and partners must have been created. This procedure must be carried out for all incoming messages:

Open client "Customer".

Create EDX message setup for document "IC PURCHASE ORDER" and save path temporarily.

Switch to the "Supplier" client.

Create EDX message setup for document "IC SALES ORDER" and use the path of the outgoing document.

OAUTH SETUP

If the intercompany setup is to be done via different SaaS databases, then the OAuth setup must be performed in both databases.

For this purpose, the action "OAuth connections" is called in the EDX setup. Within the OAuth setup, the new connection is

started with the action "New->Microsoft Dynamics 365 Business Central1 Connection". The setup wizard requires the following

parameters from the Azure App registry:

Tenant Id

Client Id

Secret

Environment name

SHIPPING ORDER / LOAD CARRIER

For the use of the outgoing message "CC DESPATCH ADVISE" (DESADV) the setup of the shipping orders including the load

carriers is required.

The general information for setting up the shipping orders and load carriers can be found in the corresponding section "Shipping

processing". In the following, you will only find notes on the relevant settings for the outbound message mentioned above.

Partner No. EDX Document EDX

Document

Direction

EDX Document

Description

Partner Type Partner BC

No.

EDX Transfer

Type

C10000 IC SALES

ORDER CONF

Outgoing Sending order

confirmation

Customer 10000 File

transmission

C10000 CONFIRMATION

SEND

Outgoing Message

acknowledgement

Customer 10000 File transfer

C10000 IC SALES

ORDER

Incoming

Receipt of

sales orders

Customer 10000 File transfer

C10000 IC SALES

ORDER CHG

Incoming Receive order

change

customer 10000 File transfer

C10000 IC SALES

SHIPMENT

Outgoing Send Sales

Delivery

Customer 10000 File Transfer

C10000 IC SALES

INVOICE

Outgoing Send Sales

Invoice

Customer 10000 File Transfer

• 

• 

• 

• 

• 

• 

• 

• 
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Setup storage location

In order for an assignment of the load carriers/packages in the shipping order to take place, the option "Shipping order" must be

selected in the "Shipping processing" field in the storage location or must remain free.

Shipping order setup

Via the menu item "Shipping and Load Carrier Setup" you set up your shipping orders. If you want to send load carriers with

information on the NVE/SSCC, the fields "Company ID" must be filled with the base number (GLN) of the company, as well as

"Load carrier ID numbers" with a number series. Instead of storing the number series here in general, these can also be stored

specifically for individual load carriers. In addition, the option "Create check digit for carrier ID" must be activated so that the

check digit specified by GS1 can be calculated and added for the NVE/SSCC.

In the field "Company ID" a reserve digit (see GS1 specification) must be prefixed before the base number, so that a correct NVE/

SSCC can be generated.

In order for a NVE/SSCC to be generated automatically, the option "Assign load carrier ID on order release" must also be

activated.

The NVE/SSCC has a total length of 18 digits (see GS1 specification). Therefore, the combination of company ID with reserve

digit, number series of the load carrier and check digit must be exactly 18 digits long. If this is not the case when a shipping

order is released and the "Assign load carrier ID on order release" option is activated, a corresponding note appears.

Load carrier setup

The required load carriers can be set up via the menu item "Load carrier". If load carriers including NVE/SSCC are to be

transferred, the option "ID mandatory" should be set here. If no number series is stored in the "Load carrier ID number" field in

the shipping order or if a different number is to be used for the respective load carrier, a previously created number series can

be selected here.

Please note the information on the NVE/SSCC from the "Shipping order setup" section.

Create DESADV

The outgoing message "CC DESPATCH ADVISE" is generated from a booked dispatch order with EDX partner.

So that a valid DESADV file can be created and, if necessary, processed further by an EDI converter, the following requirements

must still be met when creating shipping orders:

the shipping order must refer to a booked sales delivery, otherwise no valid EDX partner can be transferred to the booked shipping

order.

each line with packaging materials/cargo carriers must be assigned to at least one delivery line.

EDX Monitor

The EDX Monitor is used to map the entire process associated with an incoming or outgoing message.

In the following example, an EDX sales order was received and a Microsoft Dynamics 365 Business Central1 sales order was

created.

An EDX order confirmation was sent for the Microsoft Dynamics 365 Business Central1 sales order. The delivery and invoice were

then posted and sent.

Note

1. 

2. 
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Display in the EDX Monitor:

Message-/

Document

Date

Direction Source

Record

Partner No. Document

Description

Status Confirmation

Reason

27.11.2023

11:45

Inbound Sales Invoice

Header

103052

C10000 GS1 Application

Receipt

Acknowledgement

Import

EDX Document

created

Accepted

27.11.2023

11:45

Inbound Sales

Shipment

Header

102063

C10000 GS1 Application

Receipt

Acknowledgement

Import

EDX Document

created

Accepted

27.11.2023

11:40

Inbound Sales Invoice

Header

103052

C10000 GS1 Application

Receipt

Acknowledgement

Import

EDX Document

created

Received

27.11.2023

11:40

Inbound Sales

Shipment

Header

102063

C10000 GS1 Application

Receipt

Acknowledgement

Import

EDX Document

created

Received

27.11.2023

09:46

Outbound Sales Invoice

Header

103052

C10000 Verkaufsrechnung

senden (IC)

Transmitted Accepted

27.11.2023

09:46

Outbound Sales

Shipment

Header

102063

C10000 Verkaufslieferung

senden (IC)

Transmitted

24.11.2023

09:56

Inbound Sales Header

Order, 1026

C10000 GS1 Application

Receipt

Acknowledgement

Import

EDX Document

created

Accepted

24.11.2023

09:54

Inbound Sales Header

Order, 1026

C10000 GS1 Application

Receipt

Acknowledgement

Import

EDX Document

created

Received

24.11.2023

09:54

Outbound Sales Header

Order, 1026

C10000 Auftragsbestätigung

senden (IC)

Transmitted Accepted

24.11.2023

09:54

Outbound EDX Sales

Header Sales

Order,

00000037

C10000 GS1 Application Receipt Acknowledgement

Export

24.11.2023

09:54

Inbound EDX Sales

Header Sales

Order,

00000037

C10000 Verkaufsauftrag

empfangen (IC)

EDX Document

created

24.11.2023

09:26

Outbound EDX Sales

Header Sales

Order,

00000037

C10000 GS1 Application

Receipt

Acknowledgement

Export

Transmitted Received
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Incoming documents

Incoming documents are first temporarily stored in EDX documents.

DATA FLOW OF AN INCOMING DOCUMENT

The incoming message is first read into the EDX inbox. The system creates an EDX inbox item and saves the message in the item.

Then the EDX intermediate document is created from the EDX inbound item. Within the EDX intermediate document, users can

intervene and correct data. Furthermore, users can reject the EDX intermediate document if necessary or create a Microsoft

Dynamics 365 Business Central1 document from it.

EDX INPUT ITEMS

All incoming documents are first stored in the EDX Inbox table. When the business process for this document is completely

finished, the item is automatically transferred to the transferred to the "EDX Inbox Archive".

EDX Edit and reprocess incoming items

The "View file" function can be used to download the XML message of the selected EDX input item and edit it if necessary. The

"Save files" function downloads the XML message from all selected input items and saves it in a selected folder.

Currently this action "Save file" is not available in the WebClient (.NET Framework).

Field Description

EDX Status Indicates the current status.

Unprocessed

The document has been transferred to the EDX module and an EDX Inbound item has been formed.

The item has not yet been sent.

Error

An error occurred while processing the item. 

The "Error" field displays the number of errors that occurred. 

Using the look-up of the "Error" field, the associated error items can be retrieved.

EDX Document Created

An EDX intermediate document was created from the incoming item.

BC Document Created

A Microsoft Dynamics 365 Business Central1 document was created from the EDX intermediate

document created. The associated EDX inbound item has now been completed and will be moved to

the "EDX Inbound Archive".

EDX Message If there are system messages for this item, they can be retrieved via the look-up.

EDX Error If there are processing errors for this item, they can be retrieved via the Look-Up button.

Action "Display file" This action displays the document contained in the item.

Action "Manual

Processing"

If an error has occurred during automatic inbound processing and this error has been corrected in

the meantime, then the inbound item can be processed again using the action "Manual Processing".

See section "EDX Edit and Reprocess Incoming Items".

Action "Archive

processing errors

The following conditions must be met for the action to archive an incoming item:

- The incoming item has a valid "Transfer GUID"

- An archiving period is entered in the EDX setup, section "Reorganization"

Note
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The file must be stored with the action "Show file" and then save.

If an EDX inbox item runs into an error, for example because a field length in the EDX intermediate document is exceeded or the

XML structure is incorrect, the XML message can be downloaded from the EDX inbox, edited and uploaded again for new

processing. 

Using the "Upload message" function, the XML message can be uploaded again to the document directory on the server.

After the successful upload, the message will be processed again. 

The new EDX input item does not appear immediately after calling the function, but only when the message has been retrieved again

from the task queue.

MANUAL PROCESSING OF AN EDX DOCUMENT

For the processing of EDX documents, a basic distinction is made between two cases.

Incoming EDX document, the Microsoft Dynamics 365 Business Central1 document has not yet been created. 

Example:

A sales order is received. The corresponding Microsoft Dynamics 365 Business Central1 document has not yet been created. If

the incoming EDX document is created, it results in a new Microsoft Dynamics 365 Business Central1 sales order.

Incoming EDX document, the Microsoft Dynamics 365 Business Central1 document already exists. 

Example:

An incoming EDX order confirmation relates to an existing Microsoft Dynamics 365 Business Central1 purchase order.

Before a Microsoft Dynamics 365 Business Central1 document can be created from an incoming EDX intermediate document, the

incoming EDX document must first be checked. After a successful check, the EDX document receives the status "Ready for

creation". All EDX documents with this status can be transferred to a corresponding Microsoft Dynamics 365 Business Central1

document.

EDX Intermediate document

The EDX intermediate documents contain partly identical fields as the Microsoft Dynamics 365 Business Central1 documents (see

EDX sales order). Specific EDX fields and associated functionality are described below.

EDX messages/errors

. If there are any system messages or errors specific to this document, they can be retrieved via the Look-Up.

Note
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EDX Status

EDX Voucher Check

During the verification, the system performs a validation of the data. In the process, the field contents are checked. The check of

the field contents is based on the settings made in the message setup.

If errors are determined, the EDX document receives the status "Error". The number of errors that occurred is indicated in the

"Error" field on the document header or lines. You can open related error items using the Look-Up button.

If errors are detected, then they can be corrected directly in the EDX document. Each field change in the EDX document is

logged. By means of Lookup on the field "EDX Note" these changes can be called up.

After manual correction in the EDX document, the action "Check" must be executed again. After all errors have been corrected,

the Microsoft Dynamics 365 Business Central1 document can be created using the "Create" action.

Processing of EDX documents with status "Inconsistent data"

During the check, the data of the EDX document is compared with the data of the Microsoft Dynamics 365 Business Central1

document. This is the case, for example, with an incoming order change.

To avoid having to manually compare the existing Microsoft Dynamics 365 Business Central1 sales order with the EDX order

change, EDX checks the discrepancies and displays them clearly.

If any discrepancies are found, the EDX status is set to "Inconsistent Data". Clicking on the lookup field "EDX Error" will display

all discrepancies.

Example:

An order change for an item with a quantity increase from 20 pieces to 30 pieces has been received.

The EDX status is set to "Inconsistent Data."

By clicking on the EDX error number (line), a dialog is displayed in which the discrepancies are shown.

The selection "Apply changes" determines whether the displayed change is to be applied to the Microsoft Dynamics 365 Business

Central1 document. The column "Value EDX" shows the currently transferred value. The column "Value BC" shows the current

value of the Microsoft Dynamics 365 Business Central1 document.

Once it has been determined which changes are to be adopted, the "Accept changes" action must be executed.

Status Description

Unprocessed The EDX document was created automatically. No further processing steps have been performed yet.

Error An error occurred during the processing of the document.

Ready to create The EDX document has been checked and can be created.

BC voucher

created
A Microsoft Dynamics 365 Business Central1 voucher has been created from the EDX voucher already

created. This item is now done and will be moved to the "EDX Incoming Archive".

Unmatched data An existing Microsoft Dynamics 365 Business Central1 document already exists for the incoming EDX

document.

Rejected The incoming document has been rejected.

Manual

processing
If it is not possible to create an incoming EDX document as a Microsoft Dynamics 365 Business Central1

document, it will be given the status "Manual processing".

Archived EDX documents that have already been archived.

Deleted EDX vouchers that have been deleted by users.
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Delete EDX document

Deleting an EDX document depends on the status. If the EDX status contains one of the following values, deletion is not possible:

BC Document created

Rejected

Manual processing

Archived

If the document is not in this status, the EDX document can be deleted with the action "Delete EDX document".

After executing the action "Delete EDX document", a dialog box appears with a note that a deletion reason must be specified and

whether you actually want to delete the document. This query must be confirmed with "Yes".

Subsequently, the reasons that led to the deletion of the message can be entered.

Create EDX document

The "Create" action transfers the EDX intermediate document to the associated Microsoft Dynamics 365 Business Central1

document.

Reject EDX document

It is possible to reject incoming EDX documents.

The rejection is sent to the message sender if the "Receipt confirmation check" field has been activated in the EDX message

setup.

Rejection reasons must be recorded before completing the action.

EDX document with "Manual processing" status

EDX documents with the status "manual processing" indicate that the EDX document cannot be created or confirmed as a

Microsoft Dynamics 365 Business Central1 document. This may be due to the following reasons:

The existing document has already been delivered

Reservations exist

A unique assignment of the document is not possible

A unique assignment of the lines is not possible

There are discrepancies that cannot be processed automatically

Since these EDX documents cannot be processed by the system, further processing must be done by the user. 

The EDX document is closed by archiving it.

AUTOMATIC PROCESSING

Within the "EDX Message Setup" the "Automatic Processing" can be activated. The received document will be checked

automatically. If there are no errors during the check, the Microsoft Dynamics 365 Business Central1 document is created.

Up to now, incoming sales orders are processed automatically.

Outgoing document

Outgoing EDX documents are not transferred to an EDX intermediate document. When the EDX message is created, an EDX

outgoing item is created directly.

EDX INFORMATION

Each outgoing document contains information which is required for the transmission. This information is displayed in the "EDX"

info tab.

• 

• 

• 

• 

• 

• 

• 

• 

• 
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The fields of the info tab that are required for the transmission are explained in more detail below:

MANUAL PROCESSING

Send EDX document manually

Manual document dispatch takes place directly from the associated Microsoft Dynamics 365 Business Central1 document with

the action "Send EDX document".

field description

EDX Document Yes

The document has been recognized as an EDX document by the document device. Transmission of the

document is possible.

No

No document facility exists for the document. Transmission is not possible.

EDX Status Indicates the current status:

Unprocessed

The document has been transferred to the EDX module and can be sent.

Processed

The EDX outgoing item has already been created.

Sent

The EDX outgoing item has been sent. 

Receiver received

The receiver can use a message acknowledgement to signal that the message has arrived in the target

system.

Error

An error occurred during processing. This can be looked up in the EDX system error log.

Ignored

Documents with the status "Ignored" will not be sent.

The status "Ignored" will be set automatically if the following conditions are met:

If a sales invoice that has not yet been sent is cancelled, then both documents (invoice/credit note) will be

set to the status "Ignored". 

If a sales delivery that has not yet been shipped is cancelled by a complaint, then the status of the sales

delivery is set to "Ignored". 

Sales delivery, invoice as well as credit memo.

In the sales order it can be defined that certain documents should not be sent during the next posting.

If a posting number for delivery bill or invoice is reserved via the sales order and the sales order is deleted

without using this posting number, then according to Microsoft Dynamics 365 Business Central1 standard

a posted document is created with the note "deleted document". These documents will not be transferred.
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EDX output items

All sent documents are first saved in the "EDX Outbox" overview. When the process is complete, the system automatically

transfers the item to the EDX Outbox Archive overview.

AUTOMATIC PROCESSING

So far, the following outgoing documents can be sent automatically:

Sales delivery

The dispatch takes place when posting.

Sales invoice

The dispatch takes place when posting.

Purchase order

Shipment takes place upon release.

Purchase order changes

Shipping occurs when released. If the purchase order is released and has been previously sent via EDX, then the automatic

dispatch of an order change takes place. There is currently no check for quantity or date change.

Automatic dispatch of Microsoft Dynamics 365 Business Central1 documents can be controlled within the EDX message facility.

The following conditions apply to the EDX message facility:

The EDX partner must be of type "Customer" or "Vendor".

The EDX "Transfer Date From" must be greater than or equal to the Work Date.

The following conditions apply to Microsoft Dynamics 365 Business Central1 documents: delivery bill, invoice as well as purchase

order:

The "EDX Partner" field has a value.

The document date is greater than or equal to the "EDX Transmission from".

The "EDX Status" is "Unprocessed".

The following condition applies to the Microsoft Dynamics 365 Business Central1 delivery bill:

The "Sale to Customer" field must match the "BC Partner No." from the EDX message setup.

The following condition applies to the Microsoft Dynamics 365 Business Central1 Invoice:

The "Invoice to customer" field must match the "BC Partner No." from the EDX message setup.

EDX Status Description

Unprocessed The document has been transferred to the EDX module. This item has not been sent yet

Error An error occurred while processing the item. Please refer to the "Error Log" field for details. If the error

occurred due to insufficient file permissions, then the EDX document can be processed again after

correcting the permissions. To do this, select the "Reprocess" action.

Sent The item has been sent to the partner. With the columns "Messages" as well as "Error" information about

the outgoing item can be retrieved.

Actions Description

Display file This action displays the document contained in the item.

Display BC Document This action displays the Microsoft Dynamics 365 Business Central1 document contained in

the item.

Display archived BC

document

Displays the archived document.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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RESET EDX STATUS

With the action "Reset EDX status" documents can be sent again.

Enhancements in "Internal document exchange

PURCHASING DELIVERIES WITHOUT GOODS RECEIPT

In the case of purchasing deliveries, it was previously always assumed that the storage location used was posted by goods

receipt. The processing of purchase deliveries has been changed so that now also storage locations without goods receipt can be

used. In this case, the field "Quantity current delivery" is initialized with the reported delivery quantity in the respective order

line. 

The document must be posted by the user.

PURCHASE DELIVERIES WITH BATCH / SERIAL NUMBER

Batch/serial numbers are supported for purchase deliveries.

The batch/serial number to be delivered is entered in the sales order. The batch is then transferred to the recipient with the

posted sales delivery.

The transmitted batches/serial numbers can be retrieved in the "EDX Purchase Delivery" with the line menu.

After checking/creating the EDX purchase delivery, the item tracking data is transferred to the purchase order.

After posting the purchase order, the item/batch is available in the storage location.

ADDITIONS/DEDUCTIONS IN "INTERNAL DOCUMENT EXCHANGE"

Surcharges/discounts can now be used in internal document exchange. The prerequisite is that the "Sales price without VAT"

field is activated in the field control for the sales order received. Otherwise, the order line will be created without a sales price.

ITEM VARIANTS IN "INTERNAL DOCUMENT EXCHANGE"

The item variants are supported in the internal document exchange.
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ORDER DATE IN "INTERNAL DOCUMENT EXCHANGE

When sending the order, the "planned goods receipt date" is transmitted from the purchase order. The further processing looks

as follows:

REMARK TEXTS

During internal document exchange, the "remarks" are transferred from the Microsoft Dynamics 365 Business Central1 order,

header as well as line. On receipt, the remarks are stored in the EDX sales order.

Likewise, remarks can be reported back with the EDX Purchase Order Confirmation. In this case, remarks are stored in the EDX

Purchase Order Confirmation.

Received remarks are not transferred to the Microsoft Dynamics 365 Business Central1 sales order or to the Microsoft Dynamics

365 Business Central1 purchase order. Otherwise, it would no longer be possible to distinguish between remarks entered by the

user and remarks from the other party.

RECEIVE DELIVERY SCHEDULES

In the internal document exchange, previously sent purchase orders/framework orders can be received as delivery schedules.

The setup for sending purchase orders can be done as described above. On the receiver side the message "IC SALES DELFOR" is

set up.

When a delivery schedule is received, a delivery schedule and a scheduling agreement are created for each purchase order/

article.

This functionality is only available within KUMAVISION factory365.

DIRECT DELIVERY

When sending a purchase order with reference to a sales order (direct delivery) the data of the sales order will be transmitted as

well.

On receipt, the data of the direct delivery is transferred to the EDX intermediate document for sales orders. 

Further processing of this data must be implemented in the customer project.

Process Field Description

Send Purchase Order "Scheduled Goods

Receipt Date"

Send Date

Receive Sales Order "Desired Delivery Date" Validate "Planned Goods Receipt Date" from Purchase Order in

"Desired Delivery Date" field.

The validation automatically calculates the "Planned Delivery Date",

"Planned Goods Issue Date" and "Goods Issue Date" fields in the

sales order.

Send order

confirmation

"Committed delivery

date" as well as

"Planned delivery date"

Send date

Receive Purchase

Confirmation

"Committed Goods

Receipt Date"

"Planned Goods Receipt

Date"

Validate "Committed Delivery Date" from Order Confirmation to

"Committed Goods Receipt Date" of Purchase Order 

"Validate Planned Delivery Date" from Order Confirmation to

"Planned Goods Receipt Date" of Purchase Order

Send order change "Planned date of

receipt of goods"

Send date

Receive order change "Desired delivery date" As for "Receive sales order"
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Productive -/Test database

When copying the production database to the test database, overlaps may occur in the interface directory area. Furthermore, it

should be ensured that test messages do not get into the productive system.

The steps required to secure the production database are explained in more detail in the following sections.

BEFORE THE COPY

Before copying the production database to the test database, all task queue items (all clients) should be set to "Wait".

AFTER COPYING THE PRODUCTION DATABASE TO THE TEST DATABASE

When the production database is copied to the test database, there is usually an overlap of the interface directories. The

document directories in the production and test database are identical. This can lead to the fact that current EDI documents are

not imported into the productive but into the test database. 

For this case a security query was integrated, which is displayed when opening the test database.

If the query is answered with "Current database is the test database", the option "Test environment" is automatically activated in

the EDX setup.

All clients with active EDX setup should be opened once after copying the database. Furthermore, the interface directories must

be copied from the "Prod." subdirectory to "Test".

EDX VOUCHER SETUP (FTP)

FTP transfer is no longer supported. An Azure storage is required. The test and production path must be defined for this storage.

TASK QUEUE ITEMS

Task queue items can now be reactivated in both databases.

TEST INDICATOR

The "Test Indicator" is used to identify incoming and outgoing messages during the EDI test phase. For EDIFACT messages this

indicator is contained in the UNB segment (Interchange Header). The message recipient can use this indicator to control

whether the message is transferred to the production or test system.

However, this "Test Indicator" is not available in all message formats (VDA, OpenTrans etc.). 

In the EDX message setup it can be set whether the message (order, delivery bill, invoice etc.) is a test message.

Effect of the test indicator on processing in Microsoft Dynamics 365 Business Central1:

Receiving a sales order with test indicator

. The test indicator is transferred from the Microsoft Dynamics 365 Business Central1 sales order to the delivery as well as

invoice. This means that if a Microsoft Dynamics 365 Business Central1 sales order was received as a test message, then the

outgoing delivery/invoice messages will also be marked as a test message.

Direction Description

Document received

in BC:

Sales order

Sales order change

Purchase order

confirmation

Purchase delivery

Purchase invoice

If the test indicator is enabled within the incoming message or in the message setup, then the EDX

document will be marked as a test document. 

This allows the test to be enabled for messages even if the original message (e.g. VDA) does not

support the test indicator.

EDX documents with the test indicator enabled will only be processed automatically if the "Test

Environment" option is enabled in EDX Setup at the same time. Otherwise, an error will be

generated and sent by mail.

Document sent from

BC

The test indicator from the message setup is transferred to the outgoing document.
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Azure FileSync

Azure FileSync can be used to exchange files between networks. The synchronization between source and target directory can

take up to several minutes.

If time-critical messages have to be exchanged, which is the case, for example, when messages are provided for a label printer,

then the switch should be made to the "Azure Fileshare" file transfer.

EDX MasterDataExport

EDX master data export can be used to export the following master data:

Item

Subtables: Item variants, Item units as well as Item references.

Customer

Subtables: Contacts

Vendor

ESTABLISHMENT

The setup is done with the EDX setup.

EDX Setup

At the beginning, the necessary setups are done via the setup wizard. This setup wizard can be called up via the EDX Setup menu

ribbon ("More options" > "Action" > "Setup" > "EDX setup wizard"). The EDX setup wizard is started. Via the selection "General"

the required document types as well as number series are created.

EDX Document types

After setup via the setup wizard, the following document types are available:

Setting up the document types

For each EDX partner different voucher types can be defined. With the "EDX voucher setup" the previously created voucher

types are assigned to the EDX partner as well as configured.

Field settings

The "Field settings for document verification" function in the EDX document setup card ribbon allows you to configure which

fields are to be exported from the associated master data table.

• 

• 

• 

Document Description Document direction

BASE CUSTOMER Basis debtor export Based on

BASE ITEM Base article export Based on

BASE VENDOR Base Vendor Export Based on

Field Description

Table name Specifies the table name for which the master data is to be transferred. For example, "Article" or a sub-

table of the article, such as "Article variant".

Field name Specifies the respective field name for which the master data is to be transferred.

Validation

sequence

The validation order sets the element order in the XML output message.

Default value This option is not available for the master data export

Create field

content

Specify which fields will be exported.
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MASTER DATA EXPORT

The master data export takes place automatically as soon as a change is made to the master data record. Here, only field

changes that were specified in the field settings are monitored.

Example:

The article description has been changed for an article. After the data record has been saved, the export takes place.

The output file contains the following elements:
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Calculated fields

Currently, only the calculated field "Stock" is provided. Calculated fields of the debtor or creditor are not provided by this AddOn,

but can be implemented in the project.

Bulk data export

At the beginning of a project, a function is usually needed to export all records of a table.

This can be controlled via the "Collective item" option within the document setup.

As soon as you activate the switch, all records of the table will be exported during the next data export. Afterwards, the

"Collective export" option will be deactivated automatically.

EDX OpenTrans 1.0

With the EDX AddOn OpenTrans 1.0 the following OpenTrans messages are provided:

DISPATCHNOTIFICATION (shipping notification)

INVOICE (Invoice)

ORDER (sell order)

ORDERRESPONSE (order confirmation)

ESTABLISHMENT

The setup is done with the EDX setup.

EDX Setup

At the beginning, the necessary setups are done via the setup wizard. This setup wizard can be called up via the EDX Setup 

("More options" > "Action" > "Setup" > "EDX setup wizard") menu ribbon. The EDX Setup Wizard is started. Via the selection

"General" the required message types as well as number series are created.

EDX Document types

After setup via the setup wizard, the following message types are available:

Setting up the document types

The message types listed above are then assigned to an EDX partner.

Field settings

The field setting is only available for the OpenTrans message "OT1.0 SALES ORDER". See "Document check field setting".

PROCESSING

The processing of OpenTrans 1.0 messages is done in EDX standard. Incoming sales orders are provided as "EDX sales order".

The order confirmation can be created via the associated Microsoft Dynamics 365 Business Central1 sales order. The sales

delivery as well as sales invoice can be sent manually or automatically.

GS1 Messages

The existing EDX ClearingCenter (CC) messages largely meet the requirements for the retail industry.

Requirements from the electrical industry and the healthcare sector are only covered to a limited extent.

• 

• 

• 

• 

Document Description Document direction

BASE CUSTOMER Base Customer Export Outgoing

BASE ITEM Basic Article Export Outgoing

BASE VENDOR Basic Vendor Export Outgoing
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The GS1 Business Message Standard (BMS) includes requirements from the healthcare and electrical industries. Corresponding

schema and sample messages are available for all GS1 BMS messages. The section "Distribution of EDX message types" lists the

GS1 messages supported by EDX with a link to the respective guideline.

Further information on GS1 messages can be obtained directly from GS1 under the following link: GS1 XML

However, the use of the GS1 message format does not mean that new requirements for a business process are covered by GS1

messages.

Example:

A marketplace transmits an order to EDX using the GS1 ORDERS message. According to a marketplace rule, the Microsoft

Dynamics 365 Business Central1 sales order may only be delivered once the marketplace has reported the release for delivery to

EDX. In this case, an extension of the business process is required.

The GS1 messages implemented in EDX contain all mandatory information and are validated against the respective xml schema. If

optional information is required within the GS1 messages, an extension is necessary.

Within the GS1 invoice message, it is not intended that several deliveries are invoiced with one invoice line. However, if several

deliveries are invoiced with one invoice line, the deliveries are mapped as additional data (see Attribute Value Pair List) in the

GS1 message. This must be agreed with the EDI service provider/message recipient.

In principle, the GS1 messages only provide lines of the type "Article" for delivery, invoice lines, etc. All Microsoft Dynamics 365

Business Central1 line types are exported within the EDX GS1 messages. The respective line type is mapped in the additional

data. This must be agreed with the EDI service provider/message recipient.

TECHNICAL DESCRIPTION

Default business document header

All EDX GS1 messages have a standard business document header. 

The Sender element is always initialized with the data from the company setup. 

Depending on the business transaction (order, send sales invoice etc.) the Receiver element is initialized with the data of the

"Purchase from vendor" or "Sale to customer". 

The document identification is currently set to GS1 version 3.4.1.

Attribute value pair list

The avp List is additional data that is sent for a GS1 xml element. Within the customer project, further additional data can be

defined and extended with the avp List.

Note

• 

• 

• 

• 
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The following additional data is transmitted with the EDX GS1 messages:
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Message Range Element

Attributname

Description

All Messages header invoice

base64, .pdf

In the EDX message setup, you can set that the

associated PDF document can be sent with the

message as a base64 character string. The table

name depends on the respective message. When

sending purchase orders, the table name is

"Purchase Header". When sending an order

confirmation, the table name is "Sales Header" etc.

Line TransactionalItemData

KVSEDX Qty. per Unit of

Measure

Unit of Measure

lineItem

KVSEDX Line Type

Line-Typ

0=Text

1=G/L account

2=Item

3=Resource

4=WG/Anlage

5=Zu-/Abschlag (item)

9=Heading

10=From subtotal

11=End Intermediate/Bundle

12=Bundle,300=Cost

lineItem

KVSEDX Line No.

Line number assigned by EDX, e.g. if a purchase

order is sent, the EDX line number may differ from

the Microsoft Dynamics 365 Business Central1 line

number. The EDX line number must be reported

back with the order confirmation for

synchronization with the Microsoft Dynamics 365

Business Central1 line.

lineItem

KVSEDX Position No.

Position number of the line.

ORDER lineItem

KVSEDX DSSO…

Additional data for orders with direct delivery /

special orders.

INVOIC header invoice

KVSEDX Invoice List

Total Amount

Total sum of all items on the invoice.

KVSEDX Invoice List

Total Amount Including

VAT

Total sum of all items incl. VAT.

KVSEDX Invoice List

Total VAT Amount

Total amount of VAT for all items.

KVSEDX Invoice List

Total Discount Amount

Total sum of additions/deductions for all items

KVSEDX Invoice List

Total VAT

List of value-added tax rates used.

<?xml version="1.0" encoding="utf-8"?>

<TotalsVAT>'<br>'<VAT>

<Percent>19</Percent>

<Line_Amount>21500</Line_Amount>

<VAT_Amount>4085</VAT_Amount>

<Amount_Including_VAT>25585</Amount_Including_VAT>
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Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Message Range Element

Attributname

Description

</VAT>

<VAT>

<Percent>7</Percent>

<Line_Amount>900</Line_Amount>

<VAT_Amount>63</VAT_Amount>

<Amount_Including_VAT>963</Amount_Including_VAT>

</VAT>

</TotalsVAT>

1. 

1.3.8 EDX - Electronic Data eXchange

- 1384/1545 - Copyright © 2018 - 2024 KUMAVISION AG



1.3.9 EDX - Warehouse Management System Integration

General

The EDX AddOn WMS provides a basic WMS (Warehouse Management System) interface.

With the WMS interface, logistics companies can be connected to Microsoft Dynamics 365 Business Central1. The message

exchange is bidirectional. This means that goods receipts/issues can be reported to the logistics company and confirmations

processed accordingly in Microsoft Dynamics 365 Business Central1. Inventory reconciliation is possible via the inventory

message.

The EDX WMS intermediate documents can be retrieved via the user search with the term "WMS".

REQUIREMENTS EDX VERSION

At least:

EDX 21.0.46734.0

EDX WMS 21.0.46590.0

In the version EDX WMS Addon V14.1.0.11 the following functions are not available:

- Send / receive GS1 acknowledgement of receipt

- Transfer of PDF files, e.g. proforma delivery bill, within the instruction messages as Base64 coded docment

Establishment

EDX SETUP WIZARD

After the app installation, the setup is performed with the EDX setup wizard. This setup wizard can be called up via the EDX

Setup menu ribbon ("More options" > "Action" > "Setup" > "EDX setup wizard"). The EDX setup wizard is started. Via the

selection "General" the required document types as well as number series are created. see EDX manual chapter "EDX setup

wizard".

• 

• 

Note

1.3.9 EDX - Warehouse Management System Integration

- 1385/1545 - Copyright © 2018 - 2024 KUMAVISION AG



EDX SETUP WMS

In the WMS info tab, the following parameters can be set for the interface:
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Area Parameter Description

Goods issue confirmation from WMS to

Microsoft Dynamics 365 Business

Central1 (Outbound Notification)

Transfer deliverer to

goods issue

To:

Indicates that the deliverer is to be transferred from

the sales order to the goods issue. The transfer of the

deliverer is done before posting the goods issue.

Off:

When posting the goods issue, the set deliverer of

the goods issue header is used.

Delivery and Invoice On:

When posting the goods issue, the delivery and

invoice will be created. 

Off:

Only the delivery is posted.

Goods Issue from BC to WMS 

(Outbound Instruction)

Send Item Bill of

Materials

On:

If an assembly order exists for the item, then the

components of the assembly order are transmitted in

the outbound message.

Off:

The components are not sent with the outbound

message.

Inventory from WMS to BC (Inventory

Notification)

Read blocked items On:

If the inventory notification contains a blocked item,

then it will not be processed.

Off:

Processing will be aborted with an error as soon as a

blocked item is reported back.

Note

Message processing will be aborted completely. This

is also valid for the following parameters from the

area "Stock from WMS to BC"

Read over missing

items

To:

If the stock message contains an item that does not

exist, then this item will not be processed. 

Off:

Processing will be aborted with an error as soon as

an article is reported back which does not exist in the

Microsoft Dynamics 365 Business Central1 article

master.

Missing serial

number/batch

overread

On:

If the stock report returns an item requiring serial

number/batch without serial number/batch, then this

item will not be processed.

Off:

Processing will be aborted with an error if an item

requiring serial number/batch without serial number/

batch is reported back.
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EDX PARTNER

An EDX partner must be created for the data exchange between Microsoft Dynamics 365 Business Central1 and the logistics

company.

The EDX partner is created e.g. of the type "Contact". Within this documentation the EDX partner "WMS" is used.

EDX DOCUMENT TYPES

The following EDX documents are assigned to the previously created EDX partner:

KUMAVISION Inhouse Format

Document Description Document direction from

Microsoft Dynamics 365

Business Central1 point of

view.

WMS INVENTORY

IMP

Inventory from logistics company to Microsoft Dynamics 365

Business Central1 see KUMA WMS Guideline "WMS Inventory

Notification"

Incoming

WMS WHSE

RECEIPT EXP
Inbound from Microsoft Dynamics 365 Business Central1 to

logistics company see KUMA WMS Guideline "WMS Inbound

Instruction"

Outbound

WMS WHSE

RECEIPT IMP

Goods receipt from logistics company to Microsoft Dynamics

365 Business Central1 see KUMA WMS Guideline "WMS

Inbound Notification"

Inbound

WMS WHSE

SHIPMENT EXP
Goods issue from Microsoft Dynamics 365 Business Central1

to logistics company see KUMA WMS Guideline "WMS

Outbound Instruction"

Outgoing

WMS WHSE

SHIPMENT IMP

Goods issue from logistics company to Microsoft Dynamics

365 Business Central1 see KUMA WMS Guideline "WMS

Outbound Notification"

Incoming

WMS WHSE

SHIPMENT

STATUS IMP

Goods outbound status from logistics company to Microsoft

Dynamics 365 Business Central1 see KUMA WMS Guideline

"WMS Outbound State Notification"

Incoming

GS1 APP REC ACK

EXP

GS1 Application Receipt Acknowledgement Export The

assignment is only required if an acknowledgement of receipt

is to be sent for an incoming message (see section "GS1

Application Receipt Acknowledgement").

Outbound

GS1 APP REC ACK

IMP

GS1 Application Receipt Acknowledgement Export. The

mapping is only required if an acknowledgement is to be

received for an outgoing message (see section "GS1

Application Receipt Acknowledgement").

Ingoing
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GS1 Warehousing Messages (Subset Raben)

The following GS1 messages may differ from the original GS1 messages as they contain adaptations for the logistics company

RABEN.

After the test phase is completed, all EDX documents should be set to automatic processing.

STORAGE LOCATION

The EDX partner set up must be entered in the associated storage location.

Within this documentation, the EDX partner "WMS" is assigned to the storage location "YELLOW".

This will report goods receipts as well as goods issues for the storage location "YELLOW" to the logistics company "WMS".

The selected storage location should have the following options:

In the storage location the vendor, which corresponds to the logistics company, can be stored.

The customer number assigned by the logistics company must be entered in the "Our account number" field of the vendor.

LOGISTICS FACILITY

For the posting of goods receipt/goods issue, it is necessary to change the goods receipt/goods issue posting method in the

"Logistics setup" to "Cancel and show first posting error".

If the posting method is set to "Posting errors will not be processed" and an error occurs during posting, then it will not be

registered by EDX and all related interface records will get the status "NAV document created", although no posting has taken

place.

Document Description Document direction from Microsoft

Dynamics 365 Business Central1

point of view

GS1V3.2R

INVENTORY IMP

Inventory from logistics company to Microsoft

Dynamics 365 Business Central1 s. GS1 Logistics

Inventory Report.

Incoming

GS1V3.2R WHSE

RECEIPT EXP

Goods receipt from Microsoft Dynamics 365

Business Central1 to logistics company see GS1 

Warehousing Inbound Instruction.

Outbound

GS1V3.2R WHSE

RECEIPT IMP

Goods receipt from logistics company to Microsoft

Dynamics 365 Business Central1 s. GS1 

Warehousing Inbound Notification.

Inbound

GS1V3.2R WHSE

SHIPMENT EXP

Goods issue from Microsoft Dynamics 365 Business

Central1 to logistics company s. GS1 Warehousing

Outbound Instruction.

Outgoing

GS1V3.2R WHSE

SHIPMENT IMP

Goods issue from logistics company to Microsoft

Dynamics 365 Business Central1 s. GS1 

Warehousing Outbound Notification.

Inbound

Logistics State

Goods receipt required Yes

Goods issue required Yes

Picking required No
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Goods issue from BC to WMS (Outbound Instruction)

GENERAL

Excerpt from Microsoft Dynamics 365 Business Central1 Online Help: 

[...] If you ship items from a storage location that has been set up to require goods issue processing, you can only enter the goods

issue based on origin documents that other departments in your company have approved for processing.

Normally, the employee responsible for the delivery creates a goods issue. The following procedure describes how to create

shipping manually in the standard version of Microsoft Dynamics 365 Business Central1.

Select the icon, enter Goods Issue, and then select the associated link.

Select the New action. Fill in the fields on the General info tab. When retrieving the origin document lines, some of the

information is copied to each line..

*Select the Get origin documents action. The Origin Documents page opens. From a new or open goods issue, you can use the

Get Origin Document Filter page to get the rows of the released origin document that specify which items are to be delivered.

PROCEDURE USER/EDX

After entering the storage location code "YELLOW" in the General info tab, the fields in the EDX info tab are initialized. 

For the automatic EDX document dispatch the following conditions must be fulfilled:

• 

• 

• 

Field see EDX info register in goods issue Description

External WMS = Yes The initialization is done according to the selected storage

location

Released = Yes

EDX Status = Unprocessed

EDX Partner = Partner no. from storage location

facility
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The following origin documents are supported by the EDX WMS interface:

Sales orders

Outgoing stock transfers

Purchasing complaints

Service orders

After the goods issue is released, the message is sent to the logistics company.

If the document "WMS WHSE SHIPMENT EXP" is not configured for automatic processing, then the goods issue can be sent

manually with the action "Send EDX goods issue".

When sending the message, one message is created in the EDX Outbox for each origin document/origin number.

The created EDX outbox can be retrieved with the action: "Line > EDX > Outbox ".

In a further transaction the transmission of the outgoing item takes place.

SERIAL NUMBER/BATCHES

The serial / batch numbers are reported back by the logistics company.

It is generally not necessary to record them in the outgoing goods department.

If serial or batch numbers are recorded in the outgoing goods department, they are reported to the logistics company.

ASSEMBLY OF THE FINAL ARTICLE IN THE LOGISTICS COMPANY

If the assembly of the final article takes place in the WMS, then the article BOM can be sent to the logistics company with the

WMS interface.

The BOM is exported if the "Send article BOM" switch is activated in the EDX setup and the current article has an assembly or

production BOM.

PROFORMA DELIVERY BILL / INVOICE

Within the interface PDF files can be transmitted as base64 encoded characters.

The transmission is currently only possible for sales orders.

For the transmission, the switch "Include the associated PDF document" must be activated in the EDX message setup (WMS

WHSE SHIPMENT EXP). In the "Report selection sales" the reports to be transmitted must be marked with the switch "Use for

WMS".

The reports "Proforma delivery bill" as well as "Proforma invoice" are not part of the WMS interface.

STORAGE LOCATION / STORAGE PLACE

When using the app "KUMAVISION Quality Management", location bins are used. The WMS interface reports the goods issue

storage bin to the logistics company.

WMS ORDER NUMBER / TRANSPORT NUMBER

The order number and transport number used by the logistics company are displayed in the EDX info register.

SEND GOODS ISSUE FROM BC TO WMS AGAIN

If it is necessary to send a goods issue to the WMS again, this can be done with the action "Reset EDX status".

If the document "WMS WHSE SHIPMENT EXP" is not configured for automatic processing, then the goods issue can be sent

manually with the action "Send EDX goods issue".

• 

• 

• 

• 

Note
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The renewed message dispatch should be coordinated in advance with the WMS.

If the WMS has already started picking, usually no more changes are possible.

EXCLUDE GOODS ISSUE FROM TRANSMISSION

In some cases, the created goods issue may not be sent to the WMS. This is the case, for example, if the goods issue was only

created for internal processing purposes.

For this purpose, the status of the goods issue must be set to "Open". Then the switch "External WMS" in the EDX info register

can be set to "Off". When switching over, the following query is displayed:

When the goods issue is released, there is no transmission to the external WMS. Are you sure?

ASSEMBLY ORDER

If there is an assembly order for the goods issue line, then the components of the assembly order are transferred to the logistics

company with the "Outbound Instruction" message.

The transfer takes place according to the following conditions:

Goods issue status from WMS to BC (Outbound State Notification)

GENERAL

With the message "WMS WHSE SHIPMENT STATUS IMP" the status confirmations are processed by the logistics company.

The message can be processed with the WMS intermediate document "WMS Goods issue status".

Currently the following status confirmations are available:

Note

condition description

EDX Setup The configuration switch "Transmit bill of material" must be switched on

Sales lines The sales line in the goods issue must be linked to an assembly order.

Status Description

0 = Preparation for picking The goods issue message has been transmitted to the WMS. Picking should take place

shortly.

1 = Picking has been started.

2 = Picking has been

completed

Delivery should take place shortly.

3 = Picking has been aborted The WMS has aborted picking. Consultation with the WMS required.
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WMS INTERMEDIATE DOCUMENT

Check action

The following checks are performed:

Update action

The confirmed status is transferred to the goods issue line.

OUTGOING GOODS

The reported WMS processing status is displayed in the goods issue line with the "WMS Status" field.

Goods issue from WMS to BC (outbound notification)

GENERAL

With the message "WMS WHSE SHIPMENT IMP" the deliveries are processed by the logistics company.

The message can be processed with the WMS intermediate document "WMS Goods issue".

PROCEDURE USER/EDX

The following diagram shows the automatic message processing sequence.

Prerequisite EDX message setup:

Automatic processing is enabled.

BC Release document is activated.

Post BC Document is enabled.

The posting date should be set to "Receipt document date". In this case the posting date is used by the logistics company.

Status Description

Goods issue no. Logistics document must exist.

Goods issue line

number

Logistics document line must exist.

Origin number If transmitted, then the origin number must match the origin number from the logistics document

line.

• 

• 

• 
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WMS INTERMEDIATE DOCUMENT

Serial number/batches

The serial / batch numbers assigned by the logistics company can be retrieved using the "Article tracking" action within the

rows.

Assembly order

If the logistics company carries out the assembly of the finished article, then the components used by the logistics company can

be retrieved with the action "Bill of material" within the lines.

Currently, the associated production order in Microsoft Dynamics 365 Business Central1 is not automatically posted by the interface.

Packing material

The packing materials used by the logistics company can be retrieved with the action "Packing materials" within the lines.

The overview contains the SSCC/NVE and the respective package tracking number.

The packing materials are transferred to the corresponding sales delivery when posting the goods issue. In the posted sales delivery

the packing means can be retrieved with the action "EDX packing list".

Packing list

With the packing list, the returned packaging materials are displayed in hierarchical form.

Note

Note
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For this representation, the logistics company must report back which packaging material is contained in which packaging

material.

If outer packaging is used for several origin documents, then it is sufficient to report the outer packaging when it is first used.

For subsequent origin documents, only the corresponding outer packaging is referenced (Contained in SSCC/NVE).

Example:

Storage location / storage place

When using the app "KUMAVISION Quality Management", storage bins are used.

The storage bin reported back by the logistics company is not processed.

Within the interface it is assumed that the storage bin specified in the goods issue corresponds to the delivery storage bin.

Check action

The following checks are performed:

Action booking

Posting date of the logistics document is set according to EDX message setup.

WMS order number / shipment number is taken over into the logistics document.

Quantity to be delivered is taken over in logistics document line.

Serial number/batches are taken over in origin document.

Goods issue is posted if this is set in the EDX message setup.

Packing material is transferred to the booked sales delivery.

Type Package Tracking No. SSCC/NVE Contained in SSCC/

NVE

Package

Description

Outer 202103090000000001 CONTAINER

Outer DHL12334457563233 202103080000000000 202103090000000001 PALLET 1

Inner DHL12334457563234 202103080000000001 202103080000000000 KLT

Inner DHL12334457563235 202103080000000002 202103080000000000 KLT

Additional 202103080000000002 BLISTER

Additional 202103080000000002 BLISTER

Status Description

Goods issue no. Logistics document must exist.

Goods issue line

number

Logistics document line must exist.

Origin number If transmitted, the origin number must match the origin number from the logistics document

line.

Item number Item number must exist and match the logistics document line.

Variant Variant must exist and match the logistics document line.

Quantity to be delivered Must be <= remaining quantity of the logistics document line.

Serial Number/Batches Must exist if the item is subject to batch or serial number requirements.

• 

• 

• 

• 

• 

• 
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OUTGOING GOODS

WMS order number / transport number

The order number and transport number used by the logistics company are displayed in the EDX info register.

Goods receipt from BC to WMS (Inbound Instruction)

GENERAL

Excerpt from Microsoft Dynamics 365 Business Central1 Online Help: 

[...]When items arrive at a warehouse that has been set up to process goods receipt, you must retrieve the rows of the released

origin document that triggered their goods receipt. If you are using storage bins, you can either accept the default bin entered

or, if the item has never been used in this warehouse before, enter the bin into which the item is to be placed. You will then need

to enter the quantities of the items received and post the goods receipt..

The following explains how items are received with a purchase order. The steps for sales complaints and stock transfer orders

are similar.

*Select the icon, enter Goods Receipts, and then select the associated link.

*Select the New action. Fill in the fields on the General info tab. When retrieving the origin document lines, some of the

information is copied to each line. For warehouse configurations with managed putaway and picking: if the storage location

has a default zone and bin for goods receipts, the Zone Code and Bin Code fields are automatically filled in, but you can

change them if necessary.

Select the Get Origin Documents action. The Origin Documents page opens. From a new or open goods receipt, you can use

the Filters to Get Origin Documents page to get the rows of the released origin document that determine which items to

receive or ship.

a) Select the filters to use to get orig. documents action.

b) To set up a new filter, enter a descriptive code in the Code field and click Edit Actions.

c) Specify the type of origin document lines you want to retrieve by filling in the respective filter fields.

d) Select the Execute action.[...]

PROCEDURE USER/EDX

After entering the storage location code "YELLOW" in the General info tab, the fields in the EDX info tab are initialized. 

• 

• 

• 
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For the automatic EDX document dispatch the following conditions must be fulfilled:

The following origin documents are supported by the EDX WMS interface:

Purchase orders (not outside labor)

Incoming stock transfers

Sales complaints

After the goods receipt is released, the message is sent to the logistics company.

If the document "WMS WHSE RECEIPT EXP" is not configured for automatic processing, then the goods receipt can be sent

manually with the action "Send EDX goods receipt".

When sending the message, one message is created in the EDX Outbox per origin document/origin number.

The created EDX outbox can be retrieved with the action: "Line > EDX > Outbox".

In a further transaction the transmission of the outgoing item takes place.

SERIAL NUMBER/BATCHES

The serial / batch numbers are reported back by the logistics company. Recording in the goods receipt is generally not necessary.

STORAGE LOCATION / STORAGE PLACE

When using the app "KUMAVISION Quality Management", bin locations are used. The WMS interface reports the goods receipt

storage bin to the logistics company.

SEND GOODS RECEIPT FROM BC TO WMS AGAIN

If it is necessary to send a goods receipt to the WMS again, then this can be done with the action "Reset EDX status".

If the document "WMS WHSE RECEIPT EXP" is not configured for automatic processing, then the goods receipt can be sent

manually with the action "Send EDX goods receipt".

The renewed message dispatch should be coordinated in advance with the WMS.

If the WMS has already started processing the goods receipt, usually no more changes are possible.

EXCLUDE GOODS RECEIPT FROM TRANSMISSION

In some cases, the created goods receipt may not be sent to the WMS. This is the case, for example, if the goods receipt was only

created for internal processing purposes.

For this purpose, the status of the goods receipt must be set to "Open". Then the switch "External WMS" in the EDX info register

can be set to "Off". When switching, the following query is displayed:

"When releasing the goods receipt, there is no transmission to the external WMS. Are you sure? ".

Field see Inforegister EDX in goods receipt Description

External WMS = Yes The initialization is done according to the selected storage location

Released = Yes

EDX Status = Unprocessed

EDX Partner = Partner no. from storage location

• 

• 

• 

Note
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Goods receipt from WMS to BC (inbound notification)

GENERAL

With the message "WMS WHSE RECEIPT IMP" the goods receipts are processed by the logistics company.

The message can be processed with the EDX intermediate document "WMS Goods Receipt".

PROCEDURE USER/EDX

The following diagram shows the automatic message processing sequence. Prerequisite EDX message setup:

Automatic processing is enabled.

BC Release Document is enabled.

Post BC Document is enabled

The posting date should be set to "Receipt Document Date".

In this case, the posting date is used by the logistics company.

WMS INTERMEDIATE DOCUMENT

Serial number/batches

The serial / batch numbers assigned by the logistics company can be retrieved using the "Item tracking" action within the rows.

Packing material

The packing materials used by the logistics company can be retrieved with the action "Packing materials" within the lines.

The overview contains the SSCC/NVE and the respective package tracking number.

• 

• 

• 
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Currently the packaging materials are not transferred to the posted document when posting the goods issue.

Packing list

With the packing list, the returned packaging materials are displayed in hierarchical form.

For this representation, the logistics company must report which packaging material is contained in which packaging material.

If outer packaging is used for several origin documents, it is sufficient to report the outer packaging when it is first used. For

subsequent origin documents, only the corresponding outer packaging is referred to (Contained in SSCC/NVE).

Example:

Storage location / storage place

When using the app "KUMAVISION Quality Management", storage bins are used.

The storage bin reported back by the logistics company is not processed. Within the interface it is assumed that the storage bin

specified in the goods receipt corresponds to the delivery storage bin.

Check action

The following checks are performed:

Action booking

Posting date of the logistics document is set according to EDX message setup.

WMS order number / shipment number is taken over into the logistics document.

Note

Type Package Tracking No. SSCC/NVE Contained in SSCC/

NVE

Package

Description

Outer 202103090000000001 CONTAINER

Outer DHL12334457563233 202103080000000000 202103090000000001 PALLET 1

Inner DHL12334457563234 202103080000000001 202103080000000000 KLT

Inner DHL12334457563235 202103080000000002 202103080000000000 KLT

Additional 202103080000000002 BLISTER

Additional 202103080000000002 BLISTER

Status Description

Goods receipt no. Logistics document must exist.

Goods receipt line number Logistics document line must exist.

If transmitted, the origin number must match the origin number

from the logistics document line.

Article number Article number must exist and match the logistics

document line.

Variant must exist and match the logistics document line.

Quantity delivered Must be <= remaining quantity of logistics

document line.

Serial Number/Batches Must exist if the item is subject to batch or serial

number requirements.

• 

• 
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Quantity delivered is taken over in logistics document line.

Serial / batch number is taken over in origin document.

Goods receipt is posted if this is set in the EDX message setup.

Packing material is transferred to the booked sales delivery.

GOODS RECEIPT

WMS order number / transport number

The order number and transport number used by the logistics company are displayed in the EDX info register.

Stock from WMS to BC (Inventory Notification)

GENERAL

The message can be processed with the EDX intermediate document "WMS Stock".

Excerpted from Microsoft Dynamics 365 Business Central1 Online Help: 

[...] You can use the Inventory Order and Inventory Entry documents to take inventory of items. The Inventory Order page is used

to organize the full inventory collection project, for example, one per location. The Inventory Capture page is used to

communicate and record the actual count of items. You can create multiple records for one order, such as distributing groups of

items to different employees..

The Inventory Entry report can be printed from any entry and includes blank quantity fields for entering counted inventory. When

a user is finished with the entry and the quantities have been entered on the Inventory Entry page, select the Finish action. This

will transfer the quantities to the appropriate lines on the Inventory Order page. This feature ensures that no item count can be

entered twice. [...]

PROCEDURE USER/EDX

The following diagram shows the automatic message processing sequence.

Prerequisite EDX message setup:

Automatic processing is enabled.

BC Release Document is enabled.

Post BC Document is enabled

The posting date should be set to "Receipt Document Date".

In this case, the posting date is used by the logistics company.

• 

• 

• 

• 

• 

• 

• 
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CONFIRMATION OF THE ARTICLE STOCK FOR ALL STORAGE BINS

The logistics company must report back the stock of an item for all storage bins.

The inventory order reconciles the stock between the logistics company and Microsoft Dynamics 365 Business Central1. If the stock

of a storage bin is not reported back by the logistics company, then this stock will also be deleted in Microsoft Dynamics 365

Business Central1.

WMS INTERMEDIATE DOCUMENT

Serial number/batches

The serial numbers/batches assigned by the logistics company are displayed directly in the line.

Check action

The following checks are performed:

Action booking

Creation of an inventory order

Note

Status Description

Storage location Storage location must exist. 

If no storage location is returned, then the storage location that was

assigned to the EDX partner is used.

Storage location Storage location must exist.

Article number Article number must exist (see WMS setup regarding blocked articles).

Variant must exist and match with logistics

document line.

Serial number/Batches Must exist if the article is subject to batch or serial number.

• 
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Posting date of the inventory order is set according to EDX message setup.

Create inventory for all items.

Inventory order is posted if set in EDX message setup.

GS1 Application Receipt Acknowledgement

GENERAL

With the message "GS1 Application Receipt Acknowledgement" a receipt confirmation can be transmitted back to the message

sender. The receipt acknowledgement can be used bidirectionally.

Example: Message from WMS to Microsoft Dynamics 365 Business Central1

. WMS sends the stock level. Microsoft Dynamics 365 Business Central1 sends the receipt confirmation after receiving the stock.

Example: Message from Microsoft Dynamics 365 Business Central1 to WMS

Microsoft Dynamics 365 Business Central1 sends the goods issue. WMS sends after receipt of the goods issue the

acknowledgement of receipt.

All messages from Microsoft Dynamics 365 Business Central1 to WMS contain the TransmissionId element with a unique GUID.

For messages from WMS to Microsoft Dynamics 365 Business Central1, the TransmissionId element is optional.If the

acknowledgement of receipt from Microsoft Dynamics 365 Business Central1 to WMS is to be used, then the messages from WMS

must contain a unique TransmissionId.

ESTABLISHMENT

As described in section "EDX Message Types" the message "GS1 APP REC ACK EXP" must be assigned to the WMS partner. Then

the option "Receipt Acknowledgement" is activated in the EDX message setup.

GUIDELINE FOR GS1 APPLICATION RECEIPT ACKNOWLEDGEMENT

The message description can be retrieved directly from GS1.

Application Receipt Acknowledgement - XML Application Receipt Acknowledgement | GS1

EXAMPLE ACKNOWLEDGEMENT OF RECEIPT FROM BC TO WMS

In the following example, the stock was received by the WMS with the transmission ID {B7E627FD-C00F-4826-93ED-

B2D32D9F48E2}. The receipt confirmation was sent to the WMS with the transmission id {8415449F-E9BB-40DF-

A459-5170F20E9AB4}.

Excerpt from the XML message:

• 

• 

• 

Note
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EXAMPLE ACKNOWLEDGEMENT OF RECEIPT FROM WMS TO BC

In the following example, the goods issue was sent from Microsoft Dynamics 365 Business Central1 to the WMS with the

transmission ID {970cd006-f6f5-4aff-b152-c2d92f29a661}. The receipt confirmation was sent with the transmission id 

{897D7F20-265F-4A16-8D32-17565A62FFE4} from the WMS.

Excerpt from the XML message:

WMS API Reference

The following sections describe the EDX-WMS events and their functionality.

For the EDX WMS Integration Events, the "Sender" is always transmitted as the first parameter. In the following description this

parameter is not listed, because the documentation is from the point of view of the event publisher.

For all following events, the Event Publisher CodeUnit "EDX WMS AddOn" can be used.

INTEGRATION OF PROJECT-SPECIFIC WMS MESSAGES

The registration of project-specific messages is to be implemented according to the "EDX API Reference".

The registration can be carried out according to the examples listed below. "Object Type" and "Object ID" are to be changed to

the project-specific object accordingly.

When using an XMLPort for exporting goods in/goods out, it must be ensured that the XMLPort has a table element for goods in/

goods out line. If this element is not present in the XMLPort, then an error will occur during the export.

When using a CodeUnit for exporting goods in/goods out, the field KVSEDXOutbound. "Record Id" can be used to determine

which goods in/goods out is currently being exported. With the field KVSEDXOutbound. "KVSEDX WMS Detail RecordId" the

current origin document (sales order, purchase order etc.) is reported.

Note

Attention
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ONBEFOREINITIALIZEWAREHOUSESHIPMENTHEADER

The event is triggered before the WMS data (External WMS, EDX Partner) are initialized in the goods issue.

ONAFTERINITIALIZEWAREHOUSESHIPMENTHEADER

The event is triggered after the WMS data (External WMS, EDX Partner) has been initialized in the goods issue.

ONBEFOREINITIALIZEWAREHOUSERECEIPTHEADER

The event is triggered before the WMS data (External WMS, EDX Partner) are initialized in the goods receipt.

ONAFTERINITIALIZEWAREHOUSERECEIPTHEADER

The event is triggered after the WMS data (External WMS, EDX Partner) has been initialized in the goods receipt.

ONAFTERPOSTSALESDOCPACKAGES

The event is triggered after the sales delivery is posted and the packages are transferred to the sales delivery line.

ONAFTERPOSTPURCHASEDOCPACKAGES

The event is triggered after the purchase delivery is posted and the packages are transferred to the purchase delivery line.
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ONBEFORECREATEWAREHOUSERECEIPT

The event is triggered before the intermediate document "EDX goods receipt" is processed.

ONAFTERCREATEWAREHOUSERECEIPT

The event is triggered after the intermediate document "EDX goods receipt" has been processed.

ONBEFORECREATEWAREHOUSESHIPMENT

The event is triggered before the intermediate document "EDX goods issue" is processed.

ONAFTERCREATEWAREHOUSESHIPMENT

The event is triggered after the intermediate document "EDX goods issue" has been processed.

ONBEFORECREATEINVENTORY

The event is triggered before the intermediate document "EDX Stock" is processed.

ONAFTERCREATEINVENTORY

The event is triggered after the intermediate document "EDX Stock" has been processed.

ONBEFORECREATEWAREHOUSESHIPMENTSTATE

The event is triggered before the intermediate document "EDX goods issue status" is processed.

ONAFTERCREATEWAREHOUSESHIPMENTSTATE

The event is triggered after the intermediate document "EDX goods issue status" has been processed.

ONBEFORECHECKWAREHOUSERECEIPT

The event is triggered before the intermediate document "EDX goods receipt" is checked.

ONAFTERCHECKWAREHOUSERECEIPT

The event is triggered after the intermediate document "EDX goods receipt" has been checked.

ONBEFORECHECKWAREHOUSESHIPMENT

The event is triggered before the intermediate document "EDX goods issue" is checked.

ONAFTERCHECKWAREHOUSESHIPMENT

The event is triggered after the intermediate document "EDX goods issue" has been checked.

ONBEFORECHECKINVENTORY

The event is triggered before the intermediate document "EDX Stock" is checked.

ONAFTERCHECKINVENTORY

The event is triggered after the intermediate document "EDX Stock" has been checked.

ONBEFORECHECKWAREHOUSESHIPMENTSTATE

The event is triggered before the intermediate document "EDX goods issue status" is checked.

ONAFTERCHECKWAREHOUSESHIPMENTSTATE

The event is triggered after the intermediate document "EDX goods issue status" has been checked.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 1. 
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1.3.10 GAEB Interface and Calculation

Overview

With the app "GAEB Interface & Calculation" you can optimize the participation in a tender by importing the received GAEB files

for the preparation of the offer into your Business Central at the push of a button. You can then easily make the created offer

available to your customer again in GAEB format.

The app offers you the following advantages:

Simple and clear quotation costing in the planning book sheet

One-click creation of inquiries, quotations and orders from the planning ledger sheet

Continuous presentation of the contribution margin and the project success during costing

Maximum time savings through data import and export at the click of a mouse

No transmission errors due to elimination of manual entries

Accurate and simple costing including overhead, overhead and profit margins

Clear version management of tenders and offers

Introduction GAEB Interface & Calculation

GAEB Interface & Calculation | KUMAVISION App from KUMAVISION on Vimeo.

Link to Microsoft App Source "KUMAVISION GAEB Interface and Calculation"

GAEB Setup

In order to be able to use the functionalities of the app "GAEB Interface & Calculation", some settings on the GAEB Setup Card

are required in advance. In the following, the setup options of the fields are explained in more detail.

• 

• 

• 

• 

• 

• 

• 
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GENERAL

SURCHARGES

Field Description

Unit Price Fraction Field to enable/disable unit price breakdown.

GAEB Format Specifies the standard GAEB format for import and export.

Map Manufacturer Item

No.

If the switch is set, it is checked whether the item number in the GAEB file corresponds to a

vendor item number in the system.

Change Prod. Order

Status when released

If the indicator is set the system will change the Prod. Order Status of each Production Order

related to a GAEB Position to the Value set in the following field "Prod Order Status" after the

GAEB Quote has been confirmed.

Prod. Order Status The Status the Prod. Order will change to if "Change Prod. Order Status" is set.

Transfer Longtext in

Documents

Transfer Longtext in Sales Documents

Transfer to Sales Quote Defines the way Groups are transferred to the Sales Quote. If the value is set to Bundle only the

prices of the highest level Groups will be printed. Otherwise all lines will have prices.

Heading Line in Sales

Quote

Sets wether a Heading Line with the Project Description should be created.

Default Quantity Default Quantity

Automatic BOM List

Calculation

Activate automatic calculation of items with BOM List for first Level.

Default OZ Mask Defines a Default OZ Mask for manual Calculations.

Automatic Position

Numbering

If Activated the lines will be automatic numbered when OZ Mask is filled and the Calculation

Page is closed.

Lock Level Defines the Level of locks. If more user calculate one Calculation "Lines" should be used, to

prevent overwriting.

Calculation Base Defines wether the Production Order or the GAEB BOM Structure should be used.

Hours Workday Hours per Workday

Incomplete Check Set this Indicator to add an manual check for lines if changes are made.

Field Description

Reveal Surcharges If the identifier is set, the surcharges will be shown during export.

Default Surcharge Default value for the Surcharge (%) field when the line type is Item and no other surcharge is

set up.

Standard Surcharge 2 Default value for the "Surcharge 2 (%)" field if the line type is Item and no other surcharge is

set up.

Surcharge 2 (%) Base Basis for the calculation of surcharge 2 (%)

Default Surcharge (Res.) Default value for the Surcharge (%) field when the row type is Resource and no other surcharge

is set up.

Default Surcharge 2

(Res.)

Default value for the "Surcharge 2 (%)" field if the line type is Resource and no other surcharge

is set up.
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NO. SERIES

The number series for the GAEB documents are stored on the "Number series" info tab.

ARCHIVE

On the "Archiving" information tab, the descriptions for the archiving reason are stored in the "Archiving reason" field in case of

the respective document archiving.

COLORS CALCULATION

FUNCTIONS IN THE RIBBON

Default Setup

The function call restores the default setup.

UNIT MAPPING

To avoid having to select items for each row individually, the "Unit Mapping" function is available in the ribbon.

The "Unit of Measure" and "Descriptionfilter" fields can be used individually or in combination. If you create a row without a

filter, it will always be used as long as no other row matches the unit mapping settings.

Field Description

Style position Specifies color and style for items in the project spreadsheet.

Style note Specifies color and style for notes in the project spreadsheet.

Style group Specifies color and style for groups in the project spreadsheet.

Style alternative Specifies color and style for alternative items in the project spreadsheet.

Style Incomplete Specifies color and style for incomplete items in the project spreadsheet.

Style locked Specifies color and style for locked items in the project spreadsheet.

Field Description

Unit of Measure Unit from the tender.

Descriptionfilter This filter searches the description of a GAEB line when the lines are imported.

Type Type, which should be filled in the GAEB documents, if the assignment achieves a hit. (Combination of

the GAEB unit and the description filter).

Item Copy

Template

Item number to be filled in the GAEB documents if the assignment results in a hit. (Combination of the

GAEB unit and the description filter).

Resource/

Resource Group

Resource group/resource to be filled in the GAEB documents if the assignment gets a hit.

(Combination of the GAEB unit and the description filter).

G/L Account G/L account to be filled in the GAEB documents, if the assignment gets a hit. (Combination of the

GAEB unit and the description filter).

Item Import Specifies how to proceed with the item from the Item Template field. If the value is set to Use, the item

will simply be used. If Copy is selected, the item will be copied with the number series from the

"Number series" field. There is an option to lock the items after copying to prevent them from being

used in planning or orders until they are released.

No. Series Number Series for the copied items if the "Item Import" field is equal to "Copy".
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CALC. JOURNALS

At this point you can create a spreadsheet for each user. This is especially useful for later editing of the calculation.

CALCULATION SURCHARGES

To make your work easier, there are several places in the system where you can assign a default overhead for the "Overhead"

and "Overhead 2" fields. 

This can be done at three different levels, which equally represents the hierarchy for determination:

Customers

Customer price group

GAEB Setup 

The fields are explained in more detail below:

UNIT PRICE SHARE

In the table "Unit price share" the unit price shares can be defined. These can then be stored in various master data. In addition,

it is defined in the calculation into which unit price shares are to be divided. If unit price shares are defined, the calculated offer

price is split into the shares based on the assigned unit price shares of the master data.

Process

IMPORT BIDDING

To import an Bidding, first call up the "Calculations" via the user search.

Via the menu item "New" > "Import Bidding" or "Import GAEB XML Bidding" you have the possibility to perform the import.

After a successful import, the Bidding will be opened immediately and you can start with the calculation.

QUOTATION COSTING

By calling up the "Calculations" you can easily carry out the offer calculations. To do this, select the desired offer via the

Calculations overview.

The offer itself is divided into the following info tabs:

Field Description

Journal Template Name Specifies the name of the journal.

Description Specifies the description of the journal.

User ID Specifies the user for whom the journal is intende.

• 

• 

• 

Field Description

Type 2 Here you can specify the type of element to which you want to assign the surcharge.

No. Here you can enter the number of the group or record to which you want to apply the surcharge. The

selection depends on the type chosen in the previous field.

Description 2 Description of the group or record.

Surcharge (%) Default value of the surcharge (%)

Surcharge 2

(%)

Default value of surcharge 2 (%)

Starting Date Date from which the surcharge is applicable.

Ending Date Date by which the surcharge is levied.
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General

On this info tab you will be presented with general information such as the description and closing date of the Bidding.

Field Description

Description Specifies the description of the calculation.

Description Project Specifies the description of the associated project.

Related Project No. Specifies the project number of the associated project.

related Quote Specifies the number of the most recent quote created from this calculation.

related Order Indicates the number of the latest sales order created from this calculation.

Sell-to Customer No. Specifies the customer number of the customer for which the calculation was created.

Salesperson Code Indicates the salesperson in charge.

Purchase Quotes Indicates the number of purchasing requests for this RFP. Clicking on the number takes you to the

view of purchasing requests.

Purchase Orders Indicates the number of purchase orders for this RFx. Clicking the number takes you to the

purchase order view.

Document Date Indicates the date of the alert.

Quote Valid Until

Date

Indicates the date until when the offer is valid.

Locked by Indicates who is currently working on the calculation. If the value is not empty or corresponds to the

own ID, no changes can be made.

VAT Specifies the value added tax of the calculation.

VAT Bus. Posting

Group

Specifies the VAT business posting group for the sales quotation.

Import Filename Specifies the filename of the imported file.

Surcharge (%) Indicates the percentage surcharge (discount) for this RFP.

Surcharge Indicates the amount of the award (discount) for this tender.
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Lines

On the "Lines" info tab, the positions of the Bidding are displayed in hierarchical order.

In the Totals area, the totals of the calculation are displayed as follows:

Description

On the "Description" info tab, the long texts of the individual bidding items are displayed.

Field Description

Position No. Specifies the position number resulting from the definition of the OZ mask.

Quantity Indicates the required or the offered quantity of the item.

Type Indicates whether the row contains a resource, resource group or item.

Item No. Specifies the number of the resource group, resource or item depending on the "Type"

field.

Description Specifies the description of the resource group, resource or item.

Unit Cost Indicates the cost price per unit of the line.

Surcharge (%) Specifies the percentage surcharge for the line.

Unit Cost increased by

Surcharge (%)

Indicates the cost price increased by the percentage markup.

Surcharge 2 (%) Specifies the second percentage surcharge. The basis of the surcharge can be set up in

the GAEB Einrichtung.

Einstandspreis (inkl. Zuschl. 2) Indicates the cost price increased by the surcharge (%) and surcharge 2 (%).

Line Amount Indicates the price offered for all units.

Text Specifies the description of the line depending on the line type.

Surcharge/Discount Specifies the absolute surcharge. Cannot be used with surcharge (%) and surcharge 2

(%).

Linetype Indicates what type of line it is.

Buy-from Vendor No. Specifies the vendor for a possible purchase request.

Field Description

Subtotal Specifies the total without taking into account the surcharges.

Surcharges Specifies the sum of the surcharges ("Surcharge (%)" and "Surcharge 2 (%)").

Sum Surcharges/Discounts Indicates the sum of the Deduction/Surcharge field.

Total Sum Indicates the total amount including surcharges.

Total Sum (excl. Alt.) Indicates the total amount without alternatives.

Surcharge (%) Indicates the percentage surcharge/discount for this RFP.

Surcharge Indicates the amount of the award/discount for this RFP.

Total Sum (incl. Bidding. Surch.) Indicates the total amount incl. tender surcharge/discount.

VAT sales tax for this tender.sales tax for this tender.
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GAEB

GAEB specific information is displayed on this info tab.

Field Description

Version Specifies whether the short or long version should be used.

Placing No. of Purch. Indicates the number of the award of the contracting authority.

DV No. Purch. Specifies the DV number of the orderer.

Bidding No. Purch. Indicates the bidder number of the contracting authority.

Placing No. Cust Indicates the number of the contractor's award.

DV No. Cust Specifies the DV number of the contractor.

Bidding Date Indicates the date of the alert.

Offer Date Specifies the date of the offer.

Offer Time Indicates the time of the offer.

Acceptance Ending Date Indicates the deadline by which feedback on the offer must be provided.

Description Purchaser Specifies the name or company of the client.

Description Bidder Specifies the name or company of the contractor.

Skip Price Check If the identifier is set, lines can be offered without line amount.

OZ Mask The OZ mask specifies how the positions and groups are to be numbered.

Position Item Specifies the position of the material portion.

Position Wage Specifies the position of the wage share.

Currency Code Specifies the currency of the alert.

Description Currency Specifies the description of the currency.

Cashback (%) Specifies the percentage discount.

Terms of Payment (days) Specifies the payment terms in days to discount.

Payment Date Specifies the date by which the payment must be made to receive the discount.

Type of Days Specifies whether the payment term is weekdays, calendar days, or working days.

1. Level

2. Level

3. Level

4. Level

5. Level

Specifies the length of the respective layer.

Position Specifies the length of the position plane.

Indexing Specifies whether indexing is used.

Indexing Length Specifies the length of the indexing.

1. Fraction

2. Fraction

3. Fraction

4. Fraction

5. Fraction

Here you can define which unit price parts are used and in which order.
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Dimensions info tab

On the "Dimensions" info tab, the associated dimensions are displayed.

Ribbon > Actions > Quote Price Comparison List

Opens a listing to compare all offers for this RFP.

Archive Calculation

With this function call you can archive the calculation manually.

Unlock Calculation

You can use the function to unlock the cost estimate. For more information, see "Lock".

Restore

With the function call you can restore an older version of the calculation.

Reset Active Journals

With this function call you can reset the active book sheets.

Confirm Quote

Here you can confirm the offer manually. For more information on this topic, see "Confirming a sales offer".

Calculation

Within a quotation, you can use this to open the "Project costing sheet". For more information, see "Projekt

Kalkulationsbuchblatt“.

Copy Calculation

Creates a copy of the selected calculation.

Ribbon > Actions > GAEB Interfaces

Export Excel Overview

Exports an overview of the current calculation.

Import Quote(s)

Imports a quote for the current RFx.

Import Quote

Here you can enter an offer manually.

Export Quote / Export XML Quote

With "Export quotation" or "XML export quotation", you can export the quotation to GAEB90 format or GAEB-XML format. For

more information, see "Export quotation costing".

Export Bidding

Exports the current alert.

Import Order Confirmation / Import XML Order Confirmation

If an order confirmation is available in GAEB format, it can be imported with the function. For more information, see 

"Confirmation of a sales quotation".

Transfer to Sales Quote
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You can use the function to transfer the cost estimate to a conventional sales quotation. For more information, see "Transfer to a

sales quotation".

Transfer to Purchase Quote

Transfers selected lines into a purchase request.

Ribbon > Actions > Expenditures

Create Expenditures

Creates a sales quote for supplements.

Confirm Expenditures

Confirms the offer of sale for supplements.

Ribbon > Actions > Print

Print Group Summary

Prints an overview of the LV groups with prices.

Print Sales Quote

Prints the current sales offer.

Ribbon > Related > Dimensions

Displays the dimensions for the current calculation.

Ribbon > Related > Information

Contract Information

Displays the contract pretexts from the service directory.

Orig. Bidding

Here you can view the original tenders. 

Please note that it is not possible to edit the RFP from this view.

Open Unit Price Fraction Matrix

Using the "Unit price share matrix" view, you can view and manually adjust the breakdown of unit prices.

Document Extendet Text

Here you can define document texts for the press proof.

Versions

Via the versions you get to the overview with all archived versions that are linked to this RFx. You can use this, for example, to

restore an archived sales quotation. For more information, see "Archiving and versioning".

Open Quote

Opens the current sales offer.

Open Expenditures

Opens the sales offer to the most recent supplement.

Open Order Confirmation

Note
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Opens the associated order confirmation(s).

related Quotes

Opens the related offers.

Price Sheet

The price sheets for the calculation can be called up here. New price sheets can be created, updated or edited. A wizzard

supports you when creating a new price sheet. If required, the wizzard can also be used to calculate the surcharges applicable to

the calculation. In addition, you can print out the price sheets as form sheets 221 or 223.

Job Calculation Journal

Within a quotation, the "Job Calculation Journal" can be opened. To do this, select the menu item "Actions" > "Quote" >

"Calculation" via the menu ribbon.

Lock

To prevent data from being overwritten, you can set various locks in the "GAEB Setup".

If the lock is set at user level, the quote will be locked by the user who opens the calculation. The quote can only be unlocked by

the same user by executing the "Unlock Line(s)" function in the ribbon.

A prerequisite for this functionality is that a calculation journal has been created for each user in the GAEB setup.

On the other hand, if the lock is set up at row level, multiple users can edit a calculation at the same time without overwriting

each other's input. As soon as a user creates a new row or edits an existing row in the book sheet, the "Locked by" field is

automatically filled with his user ID.

Selected rows can also be locked manually using the "Lock row(s)" function. Likewise, the "Unlock row(s)" function can be used

to unlock them again.

If it is necessary to unlock rows by a user who, for example, is absent and cannot perform this function, the "Force Unlock

Row(s)" function is available. Make sure that you use this function carefully, as this can lead to data loss. 

Color representation

The opened job calculation journal displays the items according to the bidding. In the GAEB Setup, different colors can be

assigned to the different lines to improve their display.

Infoboxes

On the right side of the map you will see additional information:

Add. Information

. This infobox shows the total duration of the required resource for the selected row. It also shows the average unit cost of the

resource and the last date it was used.

Job Evaluation

This infobox displays the unit cost, the unit cost including the first overhead, and the unit cost including the second overhead,

broken down by resource and material.

Description

You can add notes (hints) before and after each line by using the "Insert Note" function. The "Description" info box displays the

long and/or short texts as well as the notes (hints) for each line.

Additional information

Note
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This infobox displays the total duration of the required resource for the selected row. In addition, the average unit cost of the

resource and the last date of use are displayed.

Job evaluation

This infobox presents unit costs, unit costs including the first overhead, and unit costs including the second overhead, broken

down by resources and materials.

Prices

To obtain a price, you can fill the items with items from the Business Central master data or with dummy items (items without

inventory value) and enter the unit costs and up to 2 overhead rates. In addition, you can enter fixed costs, which are then

independent of the quantities in the lines.

Surcharges

If the offer contains a position with a "free quantity", it is possible to adjust the quantity. In all other cases, the quantity values

are not editable. The "Distribute surcharge" function allows you to change or set the surcharges for several or all lines.

Select Distribution type="Set" on the request page of the report if you want to overwrite the old overhead value with the

overhead in the Value field. Select "Change" to increase or - in case of a negative value - decrease the current overhead in the

rows by the value from the Value field. 

You can use the overhead field to specify whether this should affect the first or second overhead.

Notes

The Show/Hide Hints action can be used to show or hide the notes in order to reduce the number of displayed lines and get a

clear overview of the calculation.

Multilevel calculation

Production BOM

If you want to use production orders, select "Prod. Order" as the "Calculation Base" in the GAEB setup.

Please note that if this setting is selected, the steps in the following section can only be performed by a Microsoft Dynamics 365

Business Central1 Premium user.

If the item has been setup as a production item, you can set up a background structure for costing to get a more detailed

overview of the costs. To do this, select the "Unfold Bill of Materials" call to open a new journal. It shows the items from the bill

of materials that are linked to the current item, as well as the routing from the master data.

In this view you can select the "Insert row" function to add new rows or the "Delete" function to delete existing rows. The

purpose of the book sheet is to specify the cost of the offer item in more detail.

If the journal also contains a production item, you can use the "Unfold BOM" function again to go one level deeper. This allows

you to define any number of levels.

Closing the sheet takes you one level higher again.

Please note that closing the book sheet will not transfer the prices and changes to the higher level.

Run the "Transfer prices" function to transfer the prices and changes to the higher level. 

Note

Note
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Also in this book sheet you can distribute the surcharges as described in the previous section. The data maintained in this book

sheet will not be included in an export, as it is only internal information that will be used for detailed costing and, if desired, for

demand planning.

GAEB Calc. BOM

If you do not use the production orders from the calculation, select in the "GAEB Setup" the "GAEB Calc. BOM" as calculation

basis. 

No premium user is required for this procedure. Without the setting "GAEB Calc. BOM" the steps in the following section cannot be

performed.

Manage GAEB Calc. BOM

On the item card you can create a new BOM with the call "GAEB BOM" or, if a BOM is already assigned to the item, edit an

existing BOM.

To enable editing of the BOM, its status must be "Open". If this is not the case, you can use the "Reset status" function to reset

the status to "Open". When you have finished editing the BOM, change its status to "Release BOM" to make it available again.

When the BOM is no longer needed, you can archive it using the "Close BOM" function.

Use GAEB BOM

If the item has a GAEB BOM, you can build a background structure for costing to get a more accurate overview of the costs.

Select the "Unfold BOM" function to open a new journal. It shows the items from the BOM that are associated with the item, as

well as the resources and resource groups from the master data. In this view, you can select the "Insert row" function to add new

rows or the "Delete" function to delete existing rows.

The purpose of the journal is to specify the cost of the bid item in more detail. By selecting the work to be performed and the

material to be used, and adding overhead (if applicable), planning can be done at a more detailed level. 

If the journal also contains an item with a GAEB BOM, you can use the "Unfold BOM" function again to go one level deeper. This

allows you to define any number of levels.

Closing the sheet takes you one level higher again.

Execute the "Transfer prices" function to transfer the prices and changes to the higher level. 

Also in this journal you can distribute the surcharges as described in the previous section. The data maintained in this book sheet

will not be included in an export, as it is only internal information that will be used for detailed costing and, if desired, for

demand planning.

EXPORT QUOTATION COSTING

To export a quotation, you must first open the map that belongs to the quotation. To do this, call up the "Calculations" via the

user search and open the desired card.

Via the menu item "Actions" > "GAEB Interface" > "Export Quote" or "Export XML Quote" in the menu ribbon, you can export

the offer into the GAEB90 format or into the GAEB XML format.

MANUAL QUOTATION CALCULATION

To create a manual calculation, call up the "Calculations" via the user search. You can create a new calculation manually via

"New" > "Create Calculation".

After you have created the manual price calculation, the calculation journal opens automatically. In this journal you can insert

new lines with the functions "Insert line before" and "Insert line after". 

You can define the line accordingly via the "Line type" field. To avoid manual numbering, execute the "Perform position

numbering" function in the menu ribbon.

Note
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You can export the offer via the "Actions" > "Export" > "Export Quote" menu item in the ribbon.

TRANSFERRED INTO A SALES OFFER

To submit the calculation or the created quotation not only in GAEB format, but in a conventional commercial format, select the

menu item "GAEB Interfaces" > "Transfer to Sales Quote" in the ribbon on the quotation card. The quotation lines will now be

transferred to a Microsoft Dynamics 365 Business Central1 standard quotation.

CONFIRMATION OF AN OFFER FOR SALE

There are two ways to confirm a sales offer. The first variant is used when the sales offer has been confirmed by phone or in

writing and there is no order confirmation in GAEB format. To confirm the offer, open it and select the "Import Order

Confirmation" function.

If the offer was confirmed by an order confirmation in GAEB format, call up the "Order confirmation" via the user search and

execute the "Imported order confirmation" function via the menu ribbon. 

Regardless of the variant used, the ordered lines are transferred to a Microsoft Dynamics 365 Business Central1 standard sales

order. From the sales order, you can control its execution.

ARCHIVING AND VERSIONING

Sales offers are archived in the following cases:

When preparing an offer for sale 

When confirming the offer 

When confirming an addition 

Manual according to choice 

When restoring a previous offer

Under GAEB Settings, you can enter a code in the Archiving reason field that specifies the reason for archiving. 

There are two ways to restore an archived sales quote.

Recovery from the offer:

In the RFx, you can select the "Related" > "Information" > "Versions" function. This opens an overview with all archived versions

associated with this RFx.

To restore a previous version, select the "Restore Calculation" function. During this process, the current version is archived.

Recovery from the archive:

Call up the GAEB → Arch. Quotations via the user search. For this overview the same function "Restore calculation" is available. 

Please note that closing the book sheet will not transfer the prices and changes to the higher level.

WHAT HAPPENS AFTER THE FREE TRIAL

What happens after the free trial? from KUMAVISION on Vimeo.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

• 

Note

1. 
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1.3.11 Item Costing

Overview

Fully integrated into Microsoft Dynamics 365 Business Central, the Item Costing app provides you with:

Consistent, highly precise, and reliable data to inform your decision-making processes in manufacturing and sales.

Fully customizable cost schedules and automated workflows to streamline your business operations and minimize errors.

Different valuation scenarios based on unit, direct unit, and last unit costs.

Options for specifying custom surcharges, overheads, and lot sizes, adding list prices to the item master, and comparing

calculation results.

A history of every calculation ever performed and a powerful log function to correct calculation errors immediately.

You can create both setup and demo data with the app and use the calculations that you perform during standard posting

processes, for example, to recognize the costs of material consumption by your production department or a subcontractor on

your company’s balance sheet. You can also specify context-dependent overhead rates, if needed.

Setup

COSTING & VALUATION SETUP

To set up the costing functionality:

Choose the Search icon, enter Costing & Valuation Setup, and then choose the related link.

Fill in the fields as described in the following table.

• 

• 

• 

• 

• 

1. 

2. 
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General
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Field Description

Cost Base (Raw

Mat./Purchases)

Specify the cost base that should be used to calculate prices for raw materials and purchased

components.

Unit Cost

Uses the unit cost specified in the item master.

Last Unit Cost

Uses the last unit cost specified in the item master.

Direct Unit Cost

With the replenishment system set to Purchase, uses the unit cost that you specified for the item’s

vendor (on the Unit Cost page) and the currently valid discount in percent (from the Purchase

Discount Line page) to determine a value according to the best price method and based on the date

of calculation and quantity entered.

Unit / Direct Unit / Last Unit Cost

Uses the direct unit cost, if available, or the last unit cost if it is not—or the unit cost stored in the

item master if neither of the other two is in the system.

Note

The field can also be found on item cards, where it serves the same purpose but takes priority over

the default option selected here.

Copy from Std. Cost/

List Price Wksh.

This field is relevant to assemblies or components with more than one item.

Specify if the cost calculations performed for each item should be entered in the item master before

the values are added up to arrive at the final cost.

Single-Level

The standard cost is copied only to the item that the calculation is performed for.

All Levels

The standard cost is copied to all assemblies and components that the system found during

calculation.

Decimals - Unit/Cost

Amt.

Specify the number of decimal places that will be used for cost and unit amounts of, for example,

items, work centers, and resources (in local currency per unit).

The default setting is 2:5, that is, amounts are shown with at least two and at most five decimal

places.

You can also fill in just one number here to tell the system how many decimal places should be

shown each time.

Decimals -

Quantities

Specify the number of decimal places that will be used to display a quantity in the system.

The default setting is 2:5, that is, quantities are shown with at least two and at most 5 decimal

places.

You can also fill in just one number here to tell the system how many decimal places should be

shown each time.

Explode Costing

BOM

Specify how you want a cost structure to appear when opened. The costing BOM provides you with a

condensed view of the values that you enter on cost worksheets.

Single-Level

Only shows level 0.
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Unless you select the Standard costing method, the unit cost represents the average cost of an item across all available

inventory.

The last unit cost, on the other hand, isn’t an average value but refers to the item’s most recent cost. The field is updated when

you post documents that include the item. For more information about the costs that can be entered on item cards, see About

unit cost calculation - Business Central | Microsoft Learn.

Assuming you replenish items that are consumed for make-to-stock or assemble-to-stock in regular intervals, we recommend the

use of the unit or the last unit cost for cost calculations. Typically, either comes close to the actual cost posted later.

Although the cost of items that you need to buy only for a specific order can also be calculated in this way, using current

purchase prices as a basis for calculation might be advisable, especially if the items are rarely ordered.

In Microsoft Dynamics 365 Business Central, unit costs are calculated based on the formula Unit Cost (LCY) = (Direct Unit Cost –

(Discount Amount / Quantity)) x (1 + Indirect Cost % / 100) + Overhead Rate.

In other words, the unit cost includes item charges, such as freight and precious metal fees, and discounts. The direct unit cost, on

the other hand, is what you would pay for purchasing the item prior to taking charges and discounts into account.

Numbering

Assembly

Create Demo Data – ribbon function

Creates sample costing data from the records in the CRONUS demonstration company.

Field Description

Rolled-Up

The BOM is completely exploded, down to the level of purchased items.

Note

Field Description

Costing Default

Nos.

Specify the number series that will be used for cost calculation defaults.

Cost Condition

Nos.

Specify the number series that will be used for cost conditions.

Note

You can use the same code for two or more series and then run the Relationships action on the No.

Series page to assign them to each other.

Field Description

Direct Cost

No. Select from the chart of cost elements the element that will be used to assign direct costs to assembly

orders.

Description Shows the description of the direct cost element.

Overhead

Cost

No. Select from the chart of cost elements the element that will be used to assign indirect costs to assembly

orders.

Description Shows the description of the overhead cost element.
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The function not only fills in base data and sets up process workflows for items ICO-0001 to ICO-0008 (which can then be used

for costing and on production orders, for example) but also specifies the following:

No. Series

Rounding Methods

Costing & Valuation Setup

Chart of Cost Elements

Cost Conditions

Cost Schedules

Extended Item Overhead Conditions

(with the Cost Condition No. field filled in for all items)

Extended Capacity Overhead Conditions

(with the Cost Condition No. field filled in for all routing lines)

Item Charge Conditions

(with the Cost Condition No. field filled in for all items)

When you run the Create Setup Data action under the same menu item, only the data included in the bulleted list is created.

CHART OF COST ELEMENTS

The chart of cost elements is the basis for cost calculations and similar in form and function to the chart of accounts in the

Finance area. It is used to save, standardize, and group cost elements for comparison.

A filled-in chart is already part of the demo data provided with the Item Costing app. You can use the chart as provided or customize

it so that it better suits the needs of your company.

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note
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To set up the chart:

Choose the Search icon, enter Chart of Cost Elements, and then choose the related link.

Fill in the fields as described in the following table.

1. 

2. 
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Field Description

No. Specify a unique number to identify the cost element.

You can enter a maximum of 20 characters in this field, both numbers and letters.

Note

We recommend that you specify a large enough gap between numbers so that you can add more elements

later. For example, you could add a zero to the end of each account number and two zeros to the end of all

account groups.

Description Enter a text to describe the calculation.

Cost Group Specify the area that the cost element will be used in when you assign an item or a capacity to the chart of

cost elements based on condition statements.

Material Cost or Material Overhead

Select one of these two options if the element should be used for cost conditions of type Material (that is,

if the item’s replenishment system is set to Purchase).

Material costs can be direct costs, as specified in the Last Unit Cost field, or overhead costs, calculated

based on the value in the Indirect Cost %, Overhead Rate, Indirect Cost % (Consumption), or Overhead

Rate (Consumption) field.

Capacity Cost or Capacity Overhead

Select one of these two options if the element should be used for cost conditions of type Capacity.

Capacity costs can be direct costs, as specified in the Direct Unit Cost field on a machine or work center

record, or indirect costs, calculated from the Indirect Cost % or Overhead Rate value entered on the

record.

Subcontracted Cost or Subcontrd. Overhead

Select one of these two options if the element should be used for cost conditions of type Capacity in

combination with a subcontracted work center (or a machine center assigned to it).

This means that the Vendor No. field must be filled in on the relevant item card. Subcontractor costs are

either direct costs, as specified in the Direct Unit Cost field on the work center or related machine center

record, or indirect costs, calculated based on the Indirect Cost % or Overhead Rate field filled in there.

Mfg. Overhead

Select one of these two options if the element should be used for cost conditions of type Manufacturing

(that is, if the item’s replenishment system is set to Prod. Order).

Manufacturing costs are indirect costs, which can be specified in the Indirect Cost % or Overhead Rate

fields on the card of a (production or assembly) item.

Sales Overhead

Admin Overhead

Markup

Commission/Pmt. or Inv. Discount

Select one of these options if the cost element should be used for cost conditions of type Item Charge.

All describe costs that cannot be recognized on the balance sheet, that is, they represent the difference

between an item’s sales and unit price.

Type Specifies the type of record.

Cost Element

Select this option for an actual cost element that you later want to assign a calculation result to.
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You must assign a cost group to each record of type Cost Element on this page. For all other lines (headings, totals, begin-totals, and

end-totals), the field remains empty.

Ribbon functions

Indent Element Chart

Sets a filter for elements of type End-Total in the Totaling field.

Comments

Used to store comments about a cost element. You can also specify a date for each comment.

COST CONDITIONS

The result of each cost calculation is assigned to a cost element based on certain conditions.

Choose the Search icon, enter Cost Conditions, and then choose the related link.

On the ribbon, choose New and then select one of the options for creating a condition – Material, Production, Capacity, or Item

Charge.

Fill in the fields as described in the following subsections.

When you’ve specified the general settings for a type of direct and overhead costs on the condition header, you can use one or

more condition lines to set up exactly how you want costs to be calculated.

After you’ve set up the condition, it will be shown on the Cost Conditions page with the selected cost group specified in the Type

field. You can then run one of the following functions to assign the condition to a master record (such as an item or a work

center) based on that group.

Field Description

Heading

Select this option to specify a description for a group of cost elements.

Total

Select this option and set a filter on the Totaling field to add up certain elements.

Begin-Total or End-Total

The first option indicates where the totaling of cost elements should start, the second where it should end.

In the latter case, another filter should be set on the elements themselves.

Totaling After you specify an interval or another type of filter to limit the number of cost elements included in a

calculation, the remaining elements are totaled and shown in this field.

This means that the field must be blank for lines of type Cost Element, Begin-Total, and Heading.

For lines of type End-Total, the field is filled in automatically when you run the Indent Element Chart

action from the ribbon. The elements to total are enclosed by a Begin-Total and an End-Total field.

If you select the Total option, you must manually specify the elements to add up.

Note

1. 

2. 

3. 

Ext. Item Overhead Conditions Material or Manufacturing

Ext. Cap. Overhead Conditions Capacity

Cost Condition – Item Charge Item charges
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Conditions entered on the lines have a higher priority than those specified by the Ext. Item Overhead Conditions and Ext. Cap.

Overhead Conditions functions. This is true for direct costs (entered in the Direct Unit Cost field) and indirect costs (entered in

the Indirect Cost % or Overhead Rate field) specified for a master table.

A set of fully functional cost conditions is already part of the demo data provided with the Item Costing app. You can use them as

provided or adjust them to better suit the needs of your company.

Cost Condition – Material

On this page, which opens when you run the Create Condition – Material action from the Cost Condition ribbon, you can specify

conditions of type Material.

Afterward, you can run the Ext. Item Overhead Conditions action on the page to link each condition to an item so that it can be

used to calculate the cost of (purchased) raw materials.

General

Note

Field Description

No. Specify the number of the condition.

Description Enter a description for the condition.

Direct Material Cost

No. Select from the chart of cost elements the number that will be used for direct material costs.

Only elements of group Material Cost can be selected in this field.

Description Shows the description of the selected element.

Material Overhead Cost

No. Select from the chart of cost elements the number that will be used for indirect material costs.

Only elements of group Material Overhead can be selected in this field.

Description Shows the description of the selected element.
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Lines

Cost Condition – Production

On this page, which opens when you run the Create Condition – Production action from the Cost Condition ribbon, you can

specify conditions of type Manufacturing.

Afterward, you can run the Ext. Item Overhead Conditions action on the page to link each condition to an item so that it can be

used to calculate the cost of finished (that is, processed) goods.

Field Description

Description Enter a description for the condition line.

Cost Element Specify the cost element that the line should be assigned to.

Only elements of group Material Cost or Material Overhead can be selected in this field.

Note

If you assign an element of cost group Material Cost to the line, the system uses the direct material

costs (unit cost, direct unit cost, or last unit cost) specified on the line for costing, not the cost values

entered in the item master.

Cost Element

Description

Is filled in automatically when you select a cost element.

Row No. Fill in this field if you want to link condition lines to each other to create a valuation base for

percentage charges.

Costing Type Specify what is shown in the Value field. Options are:

Percent

The number in the Value field represents a percentage.

If the Row No. field on the line is not filled in, the percentage is calculated based on the direct material

cost (see also Chart of Cost Elements).

If the Row No. field is filled in, costing is performed based on the sum of all lines on which the same

row number is specified and the costing type is set to Amount.

Amount

The Value field represents an amount.

You can store a set amount for inclusion in costing (see also Chart of Cost Elements). Additionally, with

the Row No. field filled in, this line can be linked to another where the Costing Type is set to Percent

so that you can, for example, add more overhead charges.

Value The value in this field depends on the costing type that you selected.

Percent

Shows a percentage value.

If the Row No. field on the line is not filled in, the percentage is calculated based on the direct material

cost (see also Chart of Cost Elements).

If the field is filled in, the valuation base is the total of all lines with the same row number.

Amount

Shows an amount.

Depending on the kind of cost element this field is filled in for, the amount is part of the direct material

cost or of overhead (see also Chart of Cost Elements).
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General

Field Description

No. Specify the number of the condition.

Description Enter a description for the condition.

Direct Mfg. Cost

No. Select from the chart of cost elements the number that will be used for direct material or other direct

manufacturing costs.

Only elements of group Material Cost can be selected in this field.

Description Shows the description of the selected element.

Mfg. Overhead

Cost

No. Select from the chart of cost elements the number that will be used for indirect manufacturing costs,

such as tool costs.

Only elements of group Mfg. Overhead can be selected in this field.
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Lines

Cost Condition – Capacity

On this page, which opens when you run the Create Condition – Capacity action from the Cost Condition ribbon, you can specify

conditions of type Capacity.

Afterward, you can run the Ext. Cap. Overhead Conditions action on the page to link each condition to a work or machine center

so that it can be used to calculate the cost of capacities (for example, because of routings stored for processed items).

Field Description

Description Enter a description for the condition line.

Cost Element Specify the cost element that the line should be assigned to.

Only elements of group Material Cost or Mfg. Overhead can be selected in this field.

Note

If you assign an element of cost group Material Cost to the line, the cost associated with this element

is excluded from overhead calculations.

Cost Element

Description

Is filled in automatically when you select a cost element.

Row No. Fill in this field if you want to link condition lines to each other to create a valuation base for

percentage charges.

Costing Type Specify what is shown in the Value field. Options are:

Percent

The number in the Value field represents a percentage.

If the Row No. field on the line is not filled in, the percentage is calculated based on the direct unit

cost specified on the source line (that is, the system adds up the material and capacity costs).

If the Row No. field is filled in, costing is performed based on the sum of all lines on which the same

row number is specified and the costing type is set to Amount.

Amount

The Value field represents an amount.

You can store a set amount for inclusion in costing (see also Chart of Cost Elements). Additionally, with

the Row No. field filled in, this line can be linked to another where the Costing Type is set to Percent

so that you can, for example, add more overhead charges.

Value The value in this field depends on the costing type that you selected.

Percent

Shows a percentage value.

If the Row No. field on the line is not filled in, the percentage is calculated based on the direct unit

cost specified on the source line (that is, the system adds up the material and capacity costs).

If the Row No. field is filled in, costing is performed based on the sum of all lines on which the same

row number is specified and the costing type is set to Amount.

Amount

Shows an amount.

Depending on the kind of cost element this field is filled in for, the amount is part of the purchasing

cost or of overhead (see also Chart of Cost Elements).
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General

Field Description

No. Specify the number of the condition.

Description Enter a description for the condition.

Direct Capacity Cost

No. Select from the chart of cost elements the number that will be used for direct manufacturing

costs.

Only elements of group Capacity Cost or Subcontracted Cost can be selected in this field.

Description Shows the description of the selected element.

Capacity Overhead

Cost

No. Select from the chart of cost elements the number that will be used for indirect manufacturing

costs.

Only elements of group Capacity Overhead or Subcontrd. Overhead can be selected in this field.
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Lines

Field Description

Description Enter a description for the condition line.

Cost Element Specify the cost element that the line should be assigned to.

Only elements of group Capacity Cost, Capacity Overhead, Subcontracted Cost, or Subcontrd.

Overhead can be selected in this field.

Note

If you assign an element of cost group Capacity Cost or Subcontracted Cost, the system will use the

direct capacity or subcontracted cost entered on the line for costing, not the cost values specified in

the work or machine center master.

Cost Element

Description

Is filled in automatically when you select a cost element.

Row No. Fill in this field if you want to link condition lines to each other to create a valuation base for

percentage charges.

Setup Time With the toggle turned on, the calculation for the selected interval only includes the setup time.

Share % Specifies the percentage used to determine the unit cost based on the calculated value.

Costing Type Specify what is shown in the Value field. Options are:

Percent

The number in the Value field represents a percentage.

If the Row No. field on the line is not filled in, the percentage is calculated based on the direct capacity

cost (see also Chart of Cost Elements).

If the Row No. field is filled in, costing is performed based on the sum of all lines on which the same

row number is specified and the costing type is set to Amount.

Amount

The Value field represents an amount.

To arrive at a line total, the entered value is then multiplied with the time scheduled for the relevant

operation. Additionally, with the Row No. field filled in, this line can be linked to another where the

Costing Type is set to Percent so that you can, for example, add more overhead charges.

Value The value in this field depends on the costing type that you selected.

Percent

Shows a percentage value.

If the Row No. field on the condition line is not filled in, the percentage is calculated based on the

direct capacity cost (see also Chart of Cost Elements).

If the field is filled in, the valuation base is the total of all lines with the same row number.

Amount

Shows an amount. 

To arrive at a line total, the entered value is then multiplied with the time scheduled for the relevant

operation.

Depending on the kind of cost element this field is filled in for, the amount is part of the purchasing

cost or of overhead (see also Chart of Cost Elements).
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Cost Condition – Item Charge

On this page, which opens when you run the Create Condition – Item Charge action from the Cost Condition ribbon, you can

specify conditions of type Item Charge and then assign each condition to an item so that it can be used to calculate the cost of

processed goods.

In other words, you no longer specify an item’s manufacturing cost, but the charges added to arrive at its list price.

General

Field Description

No. Specify the number of the condition.

Description Enter a description for the condition.

Copy Price Specify where in the item master to store the item price calculated on a cost worksheet.

No

The price will not be copied.

List Price

Copies the value to the List Price field on the relevant item card.

Unit Price

Copies the value to the Unit Price field in the item master.

Sales Price

Copies, based on the sales type and sales code, the value to the sales price table related to the item.

List Price & Sales Price

Copies the value to the List Price field and the sales price table.

Sales Type Used when a list price is copied to the sales price table. Options are:

• Custom

• Customer Price Group

• All Customers

• Campaign

This field is grayed out unless the List Price or List Price & Sales Price option is selected in the Copy

Prices field.

Sales Code Used when a list price is copied to the sales price table.

What you can select here depends on the sales type associated with the record.

For example, if you select sales type Customer Price Group, you can choose any customer price group

available to you. This way, you can specify charge calculations for each customer group, campaign, or

individual customer stored in the system.
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Lines
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Field Description

Row No. Fill in this field if you want to link condition lines to each other to create a valuation base for

percentage charges.

Description Enter a description for the condition line.

Costing Type Specify, if available, what is shown in the Formula/Code field.

Amount

Shows an amount. Additionally, with the Row No. field filled in, this line can be linked to another

where the Costing Type is set to Percent so that you can, for example, add more overhead charges.

Cost Element

With this option, you can specify an item charge line based on the value of a cost element. The

element can also be an end-total line.

Formula/Code The value in this field depends on the costing type that you selected.

(empty)

The condition line has no influence on calculations. This option can be used, for example, for headings

or descriptive lines.

Amount

Shows a number with decimals. Additionally, with the Row No. field filled in, this line can be linked to

another where the Costing Type is set to Percent.

Cost Element

The line represents a cost element. Using it in a calculation will fill in the Rolled-Up Amt. per UOM

field automatically.

With the element option, you can, for example, determine an item charge from the value of a certain

cost element. This element can also be an end-total line.

Formula

Contains an arithmetic formula. You can include a row number in this formula, for example, to

calculate a valuation base. Available operators are +,–, *, and /, plus nested parentheses () and special

characters % and §.

Example

5% A means 5 percent of the total of all item charge lines with row number A. Assuming the total is

100, the charge would be 5, that is, 100/100*5.

§ is short for ‘percent as a fraction of 100.’

Example

5 § B means 5 percent of the total of all item charge lines with row number B. Assuming the total is

100, the charge would be 4.76, that is, 100/105*5.

Rounding Method

Code

Specify if you want to round the values that are calculated based on cost conditions on a cost

worksheet.

The way values are rounded is determined by the rounding method selected in the item master.

You can choose to round every calculated number up or down or round to the nearest value, that is,

round up only when the decimal is equal to or greater than 5.

Cost Element Specify the cost element that the line should be assigned to.

While a line can, in principle, be assigned to an element of any cost group, we recommend that you

ensure each is associated with the group that you want to use the condition for.
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COST SCHEDULES

One way to analyze the results of the cost calculations you’ve performed is to set up a cost schedule, which is similar in form and

function to the account schedules that are available in the standard app and provides you with freely customizable row and

column definitions.

Sometimes, the schedule might look the same as the associated cost element chart; often, however, it contains fewer details

because certain data has been aggregated.

For example, you can set a filter on a schedule so that you only see the total cost of materials, without the amount being broken

down into direct and indirect costs. This is possible because the system automatically assigns a value to each element of a

calculation when you set up a new cost worksheet.

You can create as many schedules as you like.

Two fully functional schedules (a default schedule and a cost value overview) are already part of the demo data provided with the

Item Costing app. You can use them right away or customize them to better suit the needs of your company.

To set up a schedule:

Choose the Search icon, enter Cost Schedule Names, and then choose the related link.

On the ribbon, choose New.

Fill in the fields as described in the following table.

Field Description

Cost Element

Description

Is filled in automatically when you select a cost element.

List Price Select if the price on the line should be used as the list price.

Bold Select whether the line should appear in bold. This can be useful, for example, to visually set apart

certain types of costs (such as manufacturing costs) from those on the rest of the lines.

Error Text Contains the error message that will be shown when you enter an incorrect formula.

Note

1. 

2. 

3. 

Field Description

Name Specify the name that will be used for the schedule.

Description Enter a description for the schedule.

Default Column Layout Specify the criteria based on which values should be calculated in the schedule columns.
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Afterward, you can use the Edit Schedule action on the ribbon to add calculation details.
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Field Description

Row No. Specify a number that will be used to uniquely identify the line and allow its inclusion in cost

calculations.

Description Enter a description for the line.

Totaling Type 

Totaling

In the Totaling Type field, specify the records that you want included in costing and shown in the

Totaling field. 

Element Amount

Totals amounts calculated for cost components of type Cost Element.

To be able to use this option, you must set a filter on the elements that you want to include in the

calculation.

Example

You enter 10100..10299 in the Totaling field. As a result, the line shows you the total of all amounts that

have been specified for cost elements within the 10100 to 10299 range.

Total Amount

Totals amounts calculated for Total or End-Total elements.

To be able to use this option, you must set a filter on the elements that you want to include in the

calculation.

Example

You enter 10100..10299 in the Totaling field. As a result, the line shows you the total of all amounts that

have been specified for Total and End-Total elements within the 10100 to 10299 range.

Formula

Totals amounts calculated on other lines of the schedule.

To be able to use this option, you must enter a formula in the Totaling field. The formula must contain

row numbers so that you can link the current line to other lines within the schedule.

Example

You enter A+B in the Totaling field. This adds up the amounts from all schedule lines where the Row

No. field contains A or B.

Show Relevant to running the Cost Schedule report. Options are:

Yes

Shows the line on the report.

No

Hides the line on the report. This might be useful, for example, if the line contains a subtotal.

If Any Column Not Zero

Only shows the line if the amount on it is not zero. This prevents lines without amounts from showing up

on the report, for example.

Bold If selected, bolds the line on the report.

Italics If selected, uses italics for the line on the report.

Underline If selected, underlines the line on the report.

Show Opposite

Sign

If selected, uses the opposite sign for line amounts on the report.

New Page If selected, inserts a page break on the report after this line.
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Ribbon functions

Delete

Deletes the cost schedule.

Print

Prints the cost schedule based on the specified column definition.

To be able to use this function, you need to enter at least one cost schedule line on the request page.

Insert Elements

Copies the records on the Cost Element page to the current schedule, with one line set up for each element. The numbers of the

elements are displayed in the Totaling column.

On the request page, you can choose from a list what cost elements to copy, and then choose OK to transfer them.

Edit Column Definition

Specifies a column definition for the schedule. When you open a schedule, you can use the Assist button next to the Name field to

select a definition. If none has been set up yet, choose New instead, and then fill in the Name and Description fields.

Afterward, you can fill in the fields on the page as described in the following table.

Extended overhead conditions

These conditions are used to:

Assign cost elements to master records, such as items or work centers.

Make it easier to maintain overhead rates.

Field Description

Column No. Specify the number of the schedule column. The number is later used during cost calculations.

Column Header Specify a heading for the column.

Column Type Choose one of the following options:

Amount

Shows the amount specified for the column in the Amount Type field.

Formula

Shows the amount that results from using the formula in the Formula field.

Amount Type Select an option in this field if the Column Type field is set to Amount.

Formula Fill in this field if the Column Type field is set to Formula.

Show Opposite

Sign

Select this field if you want to show debit amounts as negative and credit amounts as positive values.

Show Specify if the column should always or never be shown or only shown when values are positive or

negative.

Rounding Factor Specify if and how values should be rounded for clarity.

Rounding

Precision

This field is used when you calculate new cost values.

The number of decimal places shown for each value is determined by the options selected in the

Decimals - Unit/Cost Amt. and Decimals - Quantities fields in Costing & Valuation Setup.

1. 

2. 
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They have a higher priority than the default overhead fields…

Indirect Cost %

Overhead Rate

Indirect Cost % (Consumption)

Overhead Rate (Consumption)

…on master records such as items or work centers.

Besides being a valuation base for item costing, the extended conditions are the basis for overhead calculations in standard posting

processes (for example, when posting purchases or output).

The following types of overhead conditions are available:

Extended Item Overhead Conditions

Extended Capacity Overhead Conditions

ITEM OVERHEAD CONDITIONS

These conditions can be assigned per item or item group.

To open the Ext. Item Overhead Conditions page, use the general search function or the relevant ribbon action (found under the

same name on item cards).

A fully functional set of extended cost conditions is already part of the demo data provided with the Item Costing app. You can use

them right away or adjust them to better suit the needs of your company.

The General FastTab shows the filters available for customizing the page view. All are initially set to include only the item record

that you opened the page from.

• 

• 

• 

• 

Note

• 

• 

Note

Field Description

Cost Group Filter Used to limit the view to a certain cost group. Options are:

• Material

• Production

• None

Type Filter Used to limit the view to certain types of lines. Options are:

• Item

• Item Category

• Gen. Prod. Posting Group

• Inventory Posting Group

• All Items

Code Filter Can be used to further limit a view after the type and cost group filters have been set.

Starting Date Filter Restricts the lines you can see to a certain date range.
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The cost conditions themselves are set up on the Lines FastTab.
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Field Description

Cost Group Specify the type of cost element that the line should be used for.

Material

The condition is used to calculate the cost of raw materials (purchased items).

Production

The condition is used to calculate the cost of processed goods (manufactured items).

Type Specify the relation of the line to an item or use the field for the quick entry of a line type.

Options are:

• Item

• Item Category

• Gen. Prod. Posting Group

• Inventory Posting Group

• All Items

Code Depending on the option that you selected in the Type field, enter the number of an item or a line

type here.

Overhead Rate Enter the item’s overhead as an amount.

Note

This field is identical to the field on the item card but has a higher priority.

If there is more than one extended overhead condition for the item, a condition is assigned based

on the hierarchy level that you specified for it in the Type field.

Indirect Cost % Enter the item’s indirect cost as a percentage.

Note

This field is identical to the field on the item card but has a higher priority.

If there is more than one extended overhead condition for the item, a condition is assigned based

on the hierarchy level that you specified for it in the Type field.

Overhead Rate

(Consumption)

Enter an amount that specifies the item’s overhead cost based on consumption.

Note

This field is identical to the field on the item card but has a higher priority.

If there is more than one extended overhead condition for the item, a condition is assigned based

on the hierarchy level that you specified for it in the Type field.

Indirect Cost %

(Consumption)

Enter a percentage that specifies the indirect cost based on consumption.

Note

This field is identical to the field on the item card but has a higher priority.

If there is more than one extended overhead condition for the item, a condition is assigned based

on the hierarchy level that you specified for it in the Type field.

Cost Condition No. Specify the relevant cost condition cost condition.

Cost Condition

Description

Shows the description of the condition that you selected in the Cost Condition No. field.

Starting Date Specify from when the line should be valid.

Ending Date Specify until when the line can be used.
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To delete a line, choose Delete on the ribbon.

CAPACITY OVERHEAD CONDITIONS

These conditions can be assigned to capacities and are included in cost calculations performed for a machine or work center (for

example, because a routing is stored with a manufacturing item).

To open the Ext. Cap. Overhead Conditions page, use the general search function or the relevant ribbon action (found under the

same name on work and machine center cards).

A fully functional set of extended cost conditions is already part of the demo data provided with the Item Costing app. You can use

them right away or adjust them to better suit the needs of your company.

The General FastTab shows the filters available for customizing the page view. All are initially set to include, for example, only

the work center that you opened the page from.

Note

Field Description

Type Filter Limits the view to certain types of lines. Options are:

• Routing Line

• Machine Center

• Work Center

• Work Ctr. Group

• All Routing Lines

Code Filter Can be used to further limit a view (to a certain work center, for example) after the type filter has

been set.

Starting Date

Filter

Restricts the lines you can see to a certain date range.
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The cost conditions themselves are set up on the Lines FastTab.

To delete a line, choose Delete on the ribbon.

Item Charge Conditions

On this page, you can assign a charge calculation to an item (see Cost Condition – Item Charge) to determine costs that aren’t

recognized on the balance sheet (=that aren’t part of the item’s unit cost).

You can also enter other direct costs on the lines of the page, which can be opened from item cards.

Field Description

Type Specify the type of record that the line should be used for. Options are:

• Routing Line

• Machine Center

• Work Center

• Work Ctr. Group

• All Routing Lines

Code Depending on the option that you selected in the Type field, enter the number of a certain record

here if you want to further limit what work center, for example, the condition line should be used for.

Version Code Specify the relevant version code.

Operation No. Specify the relevant operation.

Overhead Rate Enter the capacity’s overhead cost as an amount.

This field is identical to the field on the work or machine center card but has a higher priority.

If there is more than one extended condition for the work or machine center, a condition is assigned

based on the hierarchy level specified for it in the Type field.

Indirect Cost % Enter the capacity’s indirect cost as a percentage.

This field is identical to the field on the work or machine center card but has a higher priority.

If there is more than one extended condition for the work or machine center, a condition is assigned

based on the hierarchy level specified for it in the Type field.

Cost Condition No. Specify the relevant cost condition.

Cost Condition

Description

Shows the description of the condition that you selected in the Cost Condition No. field.

Starting Date Specify from when the line should be valid.

Ending Date Specify until when the line can be used.
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The General FastTab shows the filters available for customizing the page view. All are initially set to include only the item that

you opened the page from.

Field Description

Cost Group Filter Limits the view to a certain cost group. Options are:

• Charge

• Other Direct Cost

• None

Type Filter Limits the view to certain types of lines. Options are:

• (blank)

• Item

• Item Category

• Gen. Prod. Posting Group

• Inventory Posting Group

• All Items

Code Filter Can be used to further limit a view (to a certain item, for example) after the type filter has been set.

Starting Date Filter Restricts the lines you can see to a certain date range.
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The cost conditions themselves are set up on the Lines FastTab.

To delete a line, choose Delete on the ribbon.

Costing Defaults

You can run this function from an item cost worksheet to set up (and edit) a variety of lot sizes for cost calculations. The values

that are used by this action can already be specified on the relevant item card (by running the function with the same name

there).

Field Description

Cost Group Specify the type of cost element that the line should be used for. Options are:

Charge

The condition is used when you calculate the cost of a processed item. The valuation base in this

context is therefore not the item’s cost of production but the charges added to its list price.

Other Direct Cost

The condition is included as part of the landed costs that are not based on quantities sold or

manufactured.

Type Specify the relation of the line to an item or use the field for the quick entry of a line type. Options

are:

• Item

• Item Category

• Gen. Prod. Posting Group

• Inventory Posting Group

• All Items

Code Depending on the option that you selected in the Type field, enter the number of a record here if you

want to further limit what item, for example, the condition line should be used for.

Cost Condition No. Specify the relevant cost condition.

Cost Condition

Description

Shows the description of the condition that you selected in the Cost Condition No. field.

Starting Date Specify from when the line should be valid.

Ending Date Specify until when the line can be used.

ODC Code If available, enter the relevant additional direct cost.

Qty. per Unit of

Measure

Enter the quantity for the item’s unit of measure.

ODC per Unit Specify the item’s other direct cost per unit.

ODC Element No. Specify the cost element for the item’s other direct cost.

ODC Description Shows the description of the other direct cost selected in the ODC Element No. field.
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The defaults only apply to the item that is currently being calculated on the cost worksheet. Defaults that might have been specified

for an assembly at a lower level are ignored, which means that the assembly’s lot size is retrieved from the relevant item card

instead.

If more than one default value is found for a worksheet line, the system sets up a calculation for each value specified as being valid at

the time.

Item cost worksheets

This worksheet is used to determine the cost of manufacturing certain goods. It can be opened from the ribbon of an item card.

Note

Field Description

No. Is filled in automatically from the number series that you set up for this purpose.

Item No. Is filled in automatically with the item number entered on the worksheet.

Description Specifies the description of the item.

Starting Date Specifies from when the default value can be used.

The date of reference in this context is the date on which you run the Calculate function on the worksheet.

Ending Date Specifies until when the default value can be used.

The date of reference in this context is the date on which you run the Calculate function on the worksheet.

Lot Size Specifies the lot size that you want to calculate costs for.

Default If you turn on the Only Default Costing Values toggle when running the Calculate function, only lot sizes

that this field is selected for are used.

Note

The lot size that is entered on the item card is not used if valid costing defaults are found during

calculation.

Comment Shows whether comments exist for the default value.

You can also use this field to enter comments, if needed.

Note
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WORKSHEET LINES

On the worksheet lines, you can see (if available) the calculations that have already been performed for the item.

Ribbon functions

Calculate

Field Description

Warning (blank)

The line is free of errors and can be retrieved, if required.

Errors

The line shows one or more errors. You can open the error log to view and resolve them one by

one. After each has been corrected, you must refresh the worksheet.

Costing Entry No. Shows an entry number for the line.

Lines with different item costing defaults (=lot sizes) use the same entry number.

Costing Description Shows the description entered for the completed calculation run.

Item No. Specifies the item that costs were calculated for.

Description Shows the description of the item.

Replenishment System Specifies the item’s replenishment system.

Status Specifies the status of the line.

• (blank)

• Preferred

• Rejected

• Implemented

For more information, see Change Status.

Lot Size Specifies the lot size that costs were calculated for.

Note

Depending on the circumstances, the system might use the lot size entered on the item card or

the size specified as part of the costing defaults.

Calculation Date Shows when the worksheet line was calculated.

Standard Cost Shows the standard cost entered on the associated item card.

New Standard Cost Shows the new standard cost for the item.

Indirect Cost %

(Consumption)

If available, shows (in percent) the indirect cost calculated from posted consumption.

Overhead Rate

(Consumption)

If available, shows (as an amount) the overhead calculated from posted consumption.

List Price Shows the item’s previous list price.

New List Price Shows the item’s adjusted list price.
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Calculates the costs of the selected items.

Change Status

Sets the status of the worksheet line to Preferred or Rejected.

The status is used for the Adopt Preferred Entries action, as the function copies only lines in the Preferred status. Cost values

that have been copied are set to Implemented automatically.

Get Error Log

Lists all errors that occurred during calculation. You can work on the errors by using the lookups next to the relevant fields or by

running the Show action on the ribbon.

You need to refresh the calculation after correcting the errors.

Adopt Preferred Entries

Field Description

Calculation Date Shows when the calculation is performed.

The date in this field is then compared against the starting and ending dates of the specified direct

unit costs, cost conditions, production BOMs, and routings to determine their validity when running

the function.

Calculation Run

Description

Specify the type of calculation. You must fill in this field.

Only Default Costing

Values

Specify if the lot size of the item that you want to calculate costs for should be copied from the item

card or the costing defaults.

With the toggle turned off, the system retrieves the lot size that was specified as part of the costing

defaults. If none exists, the size is copied from the item card.

With the toggle turned on, only a valid lot size that the Default field is selected for takes priority over

the size entered on the item card.

Note

The setting applies only to the first level, that is, the item to calculate.

Note
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Copies the worksheet lines in the Preferred status to the relevant item card. You can also use this function to revalue item ledger

entries that have not been posted yet.

Costing Defaults

Simulates the costs of manufacturing items in different lot sizes.

Typically, these costs have already been entered as costing defaults on the relevant item card. If necessary, you can change them

here or set up new entries.

For more information, see Item Costing Defaults.

Cost Values (Overview)

Creates a cost schedule based on the specified column and row definitions, showing you the costs calculated on the worksheet

according to the filters you set. You can also choose a second column definition here if you want to compare one worksheet to

another.

Cost Values (BOM)

Shows all calculation values broken down by cost group.

You can open the source documents associated with each line by running a ribbon function.

Explosion of BOM

Field Description

Posting Date Corresponds to the valuation date. This field is required for the revaluation journal.

Fill Revaluation

Journal

Turn on this toggle if open item ledger entries should be revalued.

In the Copy From field, you can also specify if you want to revalue the entire cost structure of each

line or only the item entered on it.

The revaluation journal can be checked following calculation, as it needs to be posted manually in

any case.

Document No. Specify the number of the document that the revaluation journal should be copied to.

Item Journal Template Specify the revaluation journal template that you want to use for the function.

Item Journal Batch

Name

Specify the revaluation journal name that you want to use for the function.

Copy From Single-Level

Updates only the costs of the item entered on the worksheet line and ignores items on lower levels.

All Levels

Updates all item costs and cost fields within a cost structure.
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Lists all levels and costs calculated for a worksheet in aggregated form.

Compare BOM Explosion

With this function, you can compare two item cost worksheets. The comparison is visualized so that you can easily identify the

differences to the previous worksheet.

Field Description

Item Cost Wksh. 1 Filter Choose the worksheet that you want to see.

Include Overhead Turn on this toggle if you want overhead included in the totals.

Material Only Turn on this toggle if you want to see only the costs of materials.

Explosion Level Specify across how many BOM levels costs should be shown.

Single-Level

Explodes the costing BOM only for the top level.

Rolled-Up

Shows costs exploded to the last assembly or component.

Field Description

Item Cost Wksh. 1 Filter Choose the worksheet that you want to compare to another.

Item Cost Wksh. 2 Filter Choose a second worksheet that you want to compare against the first.

Include Overhead Turn on this toggle if you want overhead included in the totals.

Material Only Turn on this toggle to compare only the cost of materials.

Explosion Level Specify across how many BOM levels costs should be shown.

Single-Level

Explodes the costing BOM only for the top level.

Rolled-Up

Shows costs exploded to the last assembly or component.
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1.3.12 KUMAconnect

General

With the APPs "KUMAconnect" and "KUMAconnect Output Link" you have an integration interface that connects the DMS/ECM

of ELO Digital Office GmbH (professional and enterprise) directly with Microsoft Dynamics 365 Business Central1. 

For this purpose, an ELO2 client, the "ELO2 Integration Client", is directly integrated into numerous fact boxes and / or page

parts of Microsoft Dynamics 365 Business Central1. This allows working directly in Microsoft Dynamics 365 Business Central1

with the ELO2 DMS/ECM. Files and documents can be archived by drag & drop.

With the "KUMAconnect Output Link", documents created in Microsoft Dynamics 365 Business Central1, e.g. order

confirmations, invoices, etc. can be archived directly in ELO2 DMS/ECM without further intervention. All files and documents are

automatically tagged with appropriate metadata. For a business process or a transaction in Microsoft Dynamics 365 Business

Central1, these are then displayed by the Integration Client directly in the filing structure in ELO2.

The app communicates with an ELO2 DMS/ECM system using modern web services. For this purpose, a KUMAconnect APP is

also installed in ELO2 DMS/ECM so that the two systems can communicate directly with each other.

In addition, standard templates are provided that contain a complete configuration of the Integration Client, the outgoing

documents, the metadata and the archive structure including the reference structure. An authorization concept rounds off the

templates. The functional scope and operation of the ELO2 Integration Client can be accessed via the link. 

Facilities for ELO2 are set up in the ELO2 Admin Console. Here the metadata is defined, the storage paths and reference paths.

Please contact your ELO2 partner for this.
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Setup

DMS SETUP

Before the Integration Client is displayed in the Fact Box or in the Page Part, the app requires the following settings in order to

be able to communicate with the ELO2 archive. This setting is first made in the "DMS General Setup" page.

If you have KUMAVISION medtec365 in use, you have further setup options and functions available at this point. You can find more

information about this topic here.

field description

ELO Rest API URI Here the URI of the REST API of the connected ELO2 system is stored. The rest API is

used to archive documents in the background in ELO2.

Example:

http<s>://<server>:<<port>/rest-<<archive name>/

ELO username name of the ELO2 service user through which the Rest API is allowed to communicate.

ELO Password Password for the ELO2 service user

KUMAconnect Fact Box

activated

This switch activates or deactivates the KUMAconnect interface. If it is active, the

Integration Client is displayed in the Fact Boxes or the Page Parts

Display of the client in lists The Integration Client can also be displayed in many list pages.

Here it should be noted, however, that scrolling within the list may be somewhat delayed

if the Integration Client is active in the list pages. 

This can be turned off across the board using this switch

Use Single Sign On With this switch the Windows credentials are transferred to ELO2 for automatic login

when the Integration Client is called.

ELO Integration Client URI The base URI of the ELO2 Integration Client is stored here.

Example:

http<s>://<SERVER>:<PORT>/ix-<ARCHIV>/plugin/en.elo.ix.plugin.proxy/wf/apps/app/

elo.integration.Client/

Auth with oAuth2 Logging in to ELO2 can also be done via OAuth, this can be enabled here.

ELO oAuth2 URI Here URI of the OAuth authorization point is stored.

Example:

login.microsoft.com/common/oauth2/v2.0/authorize?

Fact Box Height What height should the fact box be in all pages or page parts? 

Default: 500px

Info: the width cannot be configured.

KUMAconnect archiving of

outgoing documents activated

Here you generally activate whether documents created in Business Central should also

be transferred to the ELO DMS/ECM. Which documents these are is set in the following

"Document setup".

Note
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USER SETUP

Users who are to use KUMAconnect must be assigned an ELO2 profile in the "User setup". The profile is configured in the ELO2

archive. Here, for example, it can be configured that the ELO2 web client and not the ELO2 full client is called up for the function

"Open in ELO". Or that the function "Edit in Office" is available to the user. So open the "User Setup" in Microsoft Dynamics 365

Business Central1 and go to the row of the corresponding user. If the user does not already exist in this setup, simply add him/

her.

In the column "ELO Profile" (often on the far right of the table) you can then select the ensptechende user profile. If no "ELO

profile" is entered in the cell, this user cannot use KUMAconnect and the integration client is not displayed.

If the column "ELO profile" is not displayed, the general setup is not yet complete.

DMS DOCUMENT SETUP

You can open the DMS Document Setup via the call "Configuration of Report Archiving" in the menu ribbon of the DMS Setup.

Via the "DMS Document Setup" you can control at which event the source document should be uploaded to the ELO2 archive in

the background. The events are taken into account, if the archiving of the source documents is activated in the "DMS General

Setup".

Please note that the call is only available to you if the switch "Use report ID to identify documents in ELO" is deactivated. This

function switch is available from KUMAVISION KUMAconnect version 2.1 or higher on ELO2 side.

Note

Note

Validity area The department can be set here. Depending on the department, other outgoing documents can be

configured.

Possible validity areas: 

- Warehouse

- Purchasing

- Sales

- Service

- Reminder

.

Table of

records

A record is related to an outgoing document. 

For each output document, the field "Archiving on event" can be used to control when and whether it

should be archived.

Possible values are:

- Do not archive

- Processing outside of KUMAconnect

(Only relevant for Special Industry Solutions)

- When printing

- When sending e-mail

- When printing or sending e-mail

- When releasing

- When posting
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The following output documents are configurable:
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Range Table ID Table name Document type

Sale 36 Sales header Offer

Sale 36 Sales header Order

Sale 36 Sale header Invoice

sale 36 sales header credit

sale 36 sales header Blanket order

sale 36 sales header complaint

Sale 36 Sales header Draft Invoice

Sale 36 Sales header Proforma invoice

Sale 110 Sales delivery header Output

Sale 112 sales invoice header invoice

Sale 114 Sales credit memo header Credit memo

sale 6660 returns header returns

Purchase 38 Purchase header Inquiry

Purchase 38 Purchase Header Order

Purchase 38 Purchase header Invoice

purchase 38 purchase header credit note

purchase 38 purchase order header framework order

Purchase 38 Purchasing header Complaint

purchase 120 purchase delivery header receipt

purchase 122 purchase invoice header invoice

purchase 124 purchase credit memo header credit memo

purchase 6650 return delivery header return delivery

Service 5900 Service header Quotation

Service 5900 Service header Order

Service 5900 Service header Invoice

Service 5900 Service header Credit note

Service 5900 Service header Output

Service 5965 Service Contract Header Contract Offer

Service 5965 Service Contract Header Contract

Service 5992 Service Invoice Header Invoice

Service 5994 Service credit memo header Credit memo

warehouse 7316 goods receipt header goods receipt

warehouse 7318 goods receipt header goods receipt posted

Warehouse 7320 Goods issue header Delivery
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DMS REPORT SETUP

You can open the "DMS report setup" by calling "Configure report archiving" in the DMS setup menu. The DMS report setup can

be used to control which event should cause a report to be uploaded to the ELO2 archive in the background. The events are

taken into account if in the "DMS Setup" the switches "Archive outgoing documents" and "Use report ID to identify documents in

ELO" are activated.

Please note that the call is only available if the switch "Use report ID to identify documents in ELO" is activated. This functionality is

available from KUMAVISION KUMAconnect version 2.1 or higher on ELO2 side.

After installing the app, all reports supported by KUMAconnect by default are already preconfigured. Further reports can be

added individually. It should be noted that these must also be configured on the ELO2 side.

INTEGRATION CLIENT ACTIVATION

In this setup you can select whether the ELO2 Integration Client should be displayed in the Fact Box or in the Page area or not at

all on this page.

Range Table ID Table name Document type

Warehouse 7322 Goods issue header Posted delivery

Dunning notice 295 Dunning notice header Dunning notice

Dunning notice 297 Registered dunning header Dunning notice

Note

Table with records A record is related to a report.

For each report you can control when and if it should be archived via the field "Archiving on event". 

Possible values are:

- do not archive

- processing outside of KUMAconnect

(Only relevant for special industry solutions)

- when printing

- when emailing

- when printing or emailing

- when releasing

- when posting

- when posting asynchronously.
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In pages of type List the ELO2 Integration Client can only be displayed as Fact Box. 

Note

field description

Page ID ID of the page where the ELO2 Integration Client should be embedded

Page Name Name of the page on which the ELO2 Integration Client should be embedded

Enabled The following selections are available:

- Disabled

- Factbox

- Page Party

- Factbox and Page Part
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The Integration Client can be activated on the following pages:
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Pages ID Pages Name

20 Personal account

21 Accounts Receivable

26 Accounts Payable Card

30 Article card

39 Fibu book.sheets

41 Sales quotation

42 Sales order

43 Sales Invoice

44 Sales credit note

49 Purchase request

50 Purchase order

51 Purchase Invoice

52 Purchase credit note

88 Project card

130 Sales delivery charge

132 Sales invoice

134 Sales credit note

136 purchase delivery charge

138 purchase invoice

140 Purchase credit memo

254 Purchase ledger sheets

434 Reminder

438 Registered Reminders

507 Frame order

509 Frame order

1171 User task

5050 Contact card

5159 Sales order archive

5162 Sales quotation archive

5164 Purchase request archive

5167 Purchase order archive

5600 Purchase order archive

5768 Goods Receipt

5900 Service order
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If you have KUMAVISION medtec365 in use, you have further setup options and functions available. You can find more information

about this topic here.

Document buffer

If an error occurs during the transfer of documents created in Microsoft Dynamics 365 Business Central1, this document is

temporarily stored in the "Document Buffer" table.

Possible causes are that the ELO2 system is not accessible, e.g. it is being maintained, or there is an error in the configuration of

the archive structure in ELO2. If the transfer event "on release" is used for a document, this document is always stored

temporarily in this table. The background is a locking behavior of Microsoft Dynamics 365 Business Central1.

Pages ID Pages Name

5933 Service Invoice

5935 Service credit note

5964 Service quotation

5972 Posted service credit note

5975 Posted service delivery

5978 Posted service invoice

6050 Service contract

6053 Service contract quotation

6620 Frame order archive

6623 Frame order archive

6630 Sales complaint

6640 Purchase complaint

6650 Posted return delivery

6660 Posted return delivery

7330 Posted goods receipt

7335 Goods issue

7337 Posted goods issue

Note
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Normally, the table should be empty. If this is not the case, the background job that performs the processing may not have been

activated. This table will be filled if there was an error or a block during the transfer of the source documents to the ELO2. 

SETTING UP A BACKGROUND JOB FOR THE DOCUMENT BUFFER

The background job to be set up via the task queue items monitors the DMS document buffer. If there are entries here and the

background job performs a new processing. 

The following settings must be entered for the new job:

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

ELO, ELOprofessional, ELOenterprise, ELOoffice and ELO ECM-Suite are registered trademarks of ELO Digital Office GmbH in Germany
and/or and other countries. 

field description

Mode Type of record

No. consecutive number

Number of

errors
Number of attempts to resend the faulty document to ELO2 using the task queue.

If there is always a 1 here, the task queue is probably not set up for this. (See Setup background job)

Last Error which error occurred during the last transmission. Here can be for example the following messages:

- getArchivingSubFolder ...

"the ELO2 filing structure is missing in the ELO2 software"

- preparePrintout ...

"data record for the structure could not be determined by ODATA"

- no document service found ...

"no document was defined for the usage in the document service in KUMAconnect"

Table ID Transfer came from table

Record ID Transfer was made for the record with the ID

Page ID Transfer came from the page with the ID

Parameter

string
What other parameters were used in the transfer to enable archiving in ELO2. 

Example:

{"tenant": "kumaconnectqs", "company": "CRONUS AG", "systemId": "Warehouse Shipment Header:

{B95B9BD8-33FD-EC11-9949-9087C1D55CB9}", "objectId": "Table Warehouse Shipment Header",

"referenceId": "Page 7335", "usage": "KVSDMS Whse. Shipment", "keys":{"No":"AUSG000005"}}

field description

Type of object to be executed Please select code unit

ID of the object to be executed Please select here the code unit with the number 5593405

Label of the object to be

executed

KVSDMSSendFaultedDocuments

Description A free description can be entered here

... further fields Further fields are described in the help of Microsoft Dynamics 365 Business Central1

Online Help

1. 

2. 
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1.3.13 Power BI SALES activator

Turn the wealth of sales data from Microsoft Dynamics 365 Business Central1 into valuable KIPs.

Increase the success of your sales! Structured sales work requires valid data in real time. Activate previously unused potential of

your employees and organization.

With the "Power BI SALES activator" from KUMAVISION and EOS, you can collect, structure and visualize data from your

Microsoft Dynamics 365 Business Central1 at the touch of a button. Score points in the next meeting in front of the management

with resilient and graphically prepared data. This way you create transparency for your employees and colleagues!

General

The "Power BI SALES activator" provides answers to your essential questions:

Which items are my top sellers?

Which salespeople generate the most revenue?

How does incoming orders compare to the previous month/year?

In which countries and regions are which articles selling particularly well?

Which articles and article groups have an above-average contribution margin?

Which customers generate which sales?

Where are the opportunities? Where are risks hidden?

How can I optimally deploy my sales staff?

Your advantages:

Put an end to time-consuming research in your ERP system, error-prone calculations in Excel and outdated data. With the "Power

BI SALES activator" you make sure that all data is always and at any time up-to-date at your disposal. This enables you to better

analyze, control and plan sales activities.

Target group:

Sales, Management, Controlling

Installation "EOS PowerBI connector"

Navigate to the “Extension Marketplace” in Microsoft Dynamics 365 Business Central1.

Search for “EOS PowerBI connector” and click on “Get it now” 

Directlink to Microsoft AppSource

Complete the Microsoft basic profile form and click the “Continue” button 

Select your language and click on the "Install" button

Installation "KUMAVISION Power BI SALES Activator"

After the installation of the “EOS PowerBI connector” in Business Central you can install the “Power BI SALES activator” from

KUMAVISION.

Go to the Power BI service, navigate to the app menu, and click the button “Get Apps” to go the Power BI Marketplace

Search for the “Power BI SALES activator”

Click the button “Get It Now” and install the Power BI app

After that you have a new app named “Power BI SALES activator”

• 

• 

• 

• 

• 

• 

• 

• 

1. 

2. 

3. 

4. 

1. 

2. 

3. 

4. 
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Connect the “Power BI SALES activator” with your own data

After the installation of the apps “EOS PowerBI connector” in Business Central and the “Power BI SALES activator” you can

connect the Power BI SALES activator with your own data. 1. Open the app “Power BI SALES activator” and click on the link

“Connect your data” 2. Now you are prompted to enter the required parameters:

After entering the parameters, you need to click the button “Next”

Now you have to choose the authentication method to connect to your Business Central. Set it to “OAuth2” and the privacy level to

“Organizational”.

Click the button “Sign in and connect” and sign into your work Microsoft account.

After this check the refresh of the dataset and set up a refresh schedule to keep your data up to date.

After refreshing the dataset, you can use the reports of the “Power BI SALES activator” from KUMAVISION with your own data and

validate the data.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Field Description

Company Is the company you want to connect to your Microsoft Dynamics 365 Business Central1 instance. This

must be the company name and not the display name. You can find the name of the company in Microsoft

Dynamics 365 Business Central1 in the "Companies" list. Microsoft Dynamics 365 Business Central1

Environment Is the environment name of your Microsoft Dynamics 365 Business Central1 instance. Normally, the

environment of the production instance is "Production", however, you can look up the exact name in the

Microsoft Dynamics 365 Business Central1 Admin Center.

1. 

2. 

3. 

4. 

5. 

1. 
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1.3.14 Quality Management

The Quality Management Module (QM) is integrated with the base modules of Microsoft Dynamics 365 Business Central1. It

supports manufacturing, warehouse, and batch tracking processes as well as financials.

.

The following section of the online help is intended to assist you in completing quality assurance tasks using the QM module.

. QM allows you to manage test equipment and its calibration. With the help of defined inspection plans, you can perform and

document inspections via incoming, intermediate and final inspections. Furthermore, the quality assurance module gives you the

possibility to create a supplier evaluation taking into account the performed quality inspection. 

The use of this module can be set up only for storage locations that do not work with controlled putaway and picking. (Field

"Controlled storage and picking" in the storage location card).

The module does not support project related procurement. I.e. goods, which are procured in connection with a project number, do

not trigger test orders. The background is that in the context of the project procurement the receipt is debited directly as project

consumption / project sales. As a result, there is no stock in the system that can be inspected in the inspection order. 

Establishment

QUALITY ASSURANCE FACILITY

Before you can use the QM quality assurance module in Dynamics 365 Business Central, you must go to QM - Quality Assurance

> Administration > Quality Assurance Setup make basic settings.

Note

Note
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Inforegister General

Inforegister numbering

Inforegister Vendor Rating Connection

If the module for vendor rating (KUMAVISION Vendor Rating Management) is installed in parallel to the Quality Management

module, these two applications can be set up in such a way that entries from the quality management automatically flow into the

vendor rating. The communication between both modules is done via an API connection, where an authentication of the API calls

is generally done via a service-to-service authentication. Only in an on-premise environment can a basic authentication by means

of user ID and web service access key take place as an alternative.

Field Description

Print exams

automatically

This is used to specify whether a test order is to be printed out directly when it is created.

Do not show in

availability

Use this field to control whether item stocks that are in check should not be considered as

"Available" in the availability check. This affects the availability check in the sales document or stock

transfer order, as well as the display in the "Sales line details" info box.

Envelope Book

Sheet Template

Name

You define the stock transfers to and from the QA test storage bin that are carried out in the

background using a separate article ledger sheet template of the type Stock transfer.

Note:

In the background, the system automatically uses the article book. sheet name "QK (Auto)". Because

of this, no book. sheet name with the same name may be created in the system.

Obligation to check

for release

If the inspection requirement for release is set to "Yes", all specified inspections must be recorded in

accordance with the number of samples in the inspection results matrix or in the inspection data

when an inspection order is released. If the inspection obligation is set up with "No", a finding can

also be set without recording inspection data.

Inspection

Mandatory On

Failure

Description to follow.

Testing with locked

test equipment

This field is used to define how to proceed with locked test equipment in test orders. The following

options are available:

-> Display warning and decide with special release

If the test equipment in the test order is not exchanged for a released test equipment, the test order

can only be released via a special release.

-> Display faults and replace test equipment

If the test equipment in the test order is not exchanged for a released test equipment, the test order

cannot be released, not even via a special release.

Single-batch

incoming inspection

Here you can control whether the incoming inspections for incoming deliveries (purchasing) and

returns (sales) are created in batches. If the switch is activated, an incoming goods inspection is

created for each batch.

The calculation of the sample quantities is based on the respective quantity of the batch.

Minor error factor

Main error factor

Critical error factor

These fields are used to set up the weighting factor of the defect classes for the calculation of the

quality score. The sum of the factors must be 100.

Field Description

Test order numbers,

Test plan numbers,

Test equipment numbers,

Test Equipment Group Numbers,

Sample numbers

The number series for the documents and master data are set up in these fields.
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For general setup of Service-to-Service (S2S) authentication for API access, please refer to Microsoft Dynamics 365 Business

Central1 standard guidance. However, when assigning user permissions in the Business Central page (Azure Active Directory

Application card), additively add the user permission set KVSVRMSETUP!

To activate the interface to the Vendor Rating Management, the following settings must be made:

Action "Test vendor rating API connection"

This action can be used to test the API connection to the Vendor Rating Management (VRM) module. The system issues a

corresponding message here whether the connection could be established or not. 

Functionality

Through the API interface between the Quality Management (QM) and Vendor Rating (VRM) modules, vendor rating items are

formed based on the inspection orders, which can be processed by the vendor rating functionality. 

Note

Field Description

Vendor Rating

Authentication Type

This field is only visible for On-Premise environments! Using this field you can decide, whether to

use OAuth2-Authentication or Basic Authentication for API connection.

Vendor Rating User ID This field is only visible for On-Premise environments! This field must be used to enter the user

through which the API interface passes data to the vendor rating module.

Password This field is only visible for On-Premise environments! The password of the selected user must be

entered in this field to secure the connection via the API interface.

Vendor Rating AAD-

Application

This field is only visible in SaaS environments or when selecting the Vendor Rating

Authentication Type OAuth2! In this field, select the "Azure Active Directory Application" to be

used for authentication against the API.

Vendor Rating

Connection Client

Secret

This field is only visible in SaaS environments or when selecting Supplier Rating Authentication

Type OAuth2! The "secret key" (Client Secret) of the Azure AD App registration must be stored in

this field.

Use Vendor Rating

Connection

This field controls whether to establish an API connection to the Vendor Rating Management

(VRM) module. This field contains the following options:

Undecided:

No decision has been made yet whether to establish a connection between the QM module and

the VRM module. This value is the initial value of the setup.

Yes:

A connection between the QM and VRM module is to be established. In this case, the other fields

in the interface setup must be filled in.

No:

The interface between the QM and VRM modules should not be used.

Vendor Rating Type

Code

This field is used to set the evaluation type from the supplier evaluation module for quality

evaluation.

The "Assist" button for this field can be used to reference an existing evaluation type of the

"Quality" evaluation group. If no corresponding evaluation type exists yet, it will be created

automatically.

Notice:

If there is not yet an evaluation type for the quality evaluation, it must be created via the Assist

button. A corresponding evaluation type for quality is necessary to pass the information between

the QM module and the VRM module.
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The basis for the supplier evaluation item is the "Quality score" field in the header of the inspection order. This quality score

reflects the points that are written to the supplier evaluation item when the inspection order is completed. 

As part of the interface between the modules for quality management and supplier evaluation, a supplier evaluation item is

generated for each inspection order.

The interface to the Vendor Evaluation module (VRM) only takes into account the inspection order types that have a reference to

the vendor. These are the following inspection order types:

Receipt check vendor

Intermediate examination for external work

Final inspection (with external work as the last operation)

STORAGE LOCATIONS

For those storage locations in which quality inspections are to be carried out, the necessary facilities must be provided. The basic

prerequisite for storage locations with quality inspection is the setup and use of storage bins at the storage location. It is

therefore only possible to set up the fields in the Quality Assurance tab if the Storage bin necessary field is set up with Yes in the

Logistics tab.

Note

• 

• 

• 
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Storage Location Setup in Inforegister Quality Assurance for Single-Level Logistics

Storage Location Setup in Inforegister Quality Assurance for Two-Stage Logistics

If the two-step logistics for goods receipt is set up in the storage location, i.e. if the fields Goods receipt required and Putaway

required in the Logistics tab are set to Yes, additional facilities must be taken into account and are necessary.

It is mandatory that the storage location to be set up is also used as storage location blocked storage and storage location

destroyed articles. In the case of an inspection decision in a goods receipt inspection, the stock transfer from the inspection

storage bin initially takes place in total to the goods receipt storage bin (inspected). Depending on the inspection result, the

stock placement from this storage bin takes place to the storage bin blocked storage and storage bin destroyed articles as well as

to the putaway bin for the released inspection quantity via a putaway document. 

Field Description

Perform quality inspection

from purchasing

This field indicates whether incoming inspection for vendors is possible in the storage

location.

Perform quality check out of

sale

This field indicates whether incoming inspection for customers is possible in the storage

location.

Perform quality inspection

from production

This field specifies whether intermediate and final inspections are possible in the storage

location during production.

Perform manual inspection This field specifies whether the storage location allows manual inspections.

Storage bin quality inspection Enter the storage bin for quality inspection in this field. An automatic posting is made to

this storage bin for processes that are relevant for inspection. 

- Goods receipt (purchase / sales)

- Actual message from production 

- Manual inspection

On completion of the inspection, the debit from this storage bin.

Blocked storage location In this field, enter the storage location to which blocked goods are to be automatically

transferred during

inspections. This storage location can be different from the storage location to be set up at

the moment

.

Blocked storage bin Enter the storage bin for the blocked storage bin in this field.

Write off destroyed items Select Yes to set up this field if you want to write off destroyed items

directly in a check. In this case, the fields Storage location

destroyed articles and Storage location destroyed articles will remain empty.

The field can only be set to “Yes” if it is a storage location in which putaway is not used 

(Putaway required = No).

storage location destroyed

articles

In this field, enter the storage location to which goods destroyed during an inspection are

to be automatically transferred. This

storage location can differ from the storage location to be set up at the moment.

Bin Code Destroyed Item In this field, enter the storage bin to which goods destroyed in the course of

checks are to be automatically

transferred.
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For storage locations with two-tier logistics in goods receipt, the following fields must also be set up in the Quality Assurance

tab:

Field Description

Goods receipt storage

bin (checked)

This field defines the storage bin to which the items in incoming inspection are automatically

transferred after the inspection decision.

This transfer takes place independently of the test decision and the quantities to be released,

blocked and destroyed. From this storage place subsequently takes place the storage:

-> Quantity to be released Goods storage bins->

-> Quantity to be blocked->Storage place Blocking storage according to facility

-> Quantity->destroyed Storage location destroyed articles acc. to facility

Automatic storage This field is used to set up which actions are to be preset in the

dialog mask in the event of an inspection decision:

Option value <empty>

In the dialog mask in the event of an inspection decision, the two values ...

- Create storage = No

- Display document = No

are displayed. These can be set in the dialog mask if necessary on Yes

.

Option value "Create":

If this value is set, an option value must be set in the field Autom. storage at

Test result. In the dialog mask are

the two values ...

- Create storage = Yes

- Register storage = No

shown. These can be changed in the dialog mask if necessary

.

Create & Register option value:

An option value must be set in the "Autom. putaway on check result" field so that an option can be

selected in this field.

For the quantities (Blocked, Destroyed or Blocked & Destroyed) that are set in the "Autom.

putaway on check result" field. Putaway on Check Result", this field is used to set up the option on

how to proceed with the putaways:

- Create

(A separate putaway will be created for the defined quantities)

- Create & Register:

(A separate putaway will be created for the defined quantities and registered automatically)

Automatic storage in

case of test result

This option value is empty if the automatic storage is empty. This option value must not be empty

if the automatic storage is not empty. This parameter is used to define the quantities for which

direct storage lines are created from the test decision.

Option value <empty>

A putaway line is automatically created for each of the released, blocked and destroyed quantities

Option value Locked

The automatic putaway is applied only to the quantity to be blocked.

Option value Destroyed

The automatic storage is applied only to the quantity destroyed.

Option value Locked & Destroyed

The automatic storage is applied to lock the quantity and destroy the quantity.
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Storage bin type code with the property

USE OF THE STORAGE BINS FOR QUALITY ASSURANCE IN LOGISTICS PROCESSES

The setup of the storage bins for quality assurance on the storage location map is strongly influenced by the selected logistics

level for the storage location. The selected logistics level also determines what the QA process looks like when an item is

received. Basically, two types of QA process are distinguished here:

QA process for no warehouse logistics / single-stage warehouse logistics 

QA process for two-stage warehouse logistics The following sections describe the two QA processes and explain how the QA

storage bins are set up and used in each process.

QA process for no warehouse logistics / single-stage warehouse logistics

Here we show the setup and use of the QA storage bins, which come into play in the case of single-level logistics, as well as

bookings without warehouse logistics.

"No warehouse logistics" is defined by not using warehouse documents such as goods receipt, putaway, etc.

"Single-level warehouse logistics" is defined by the fact that only the warehouse documents of the first level are used. In this

case, only the goods receipt without putaway and goods issue without picking.

If no warehouse logistics or only single-stage warehouse logistics are used, the receiving process for items that must undergo QA

inspection looks like this:

Goods receipt Outgoing

goods

Storage Picking

Storage bin Quality inspection YES NO NO NO

Goods receipt storage bin

(checked)

YES NO NO NO

Storage place

blocking storage

NO NO YES NO

(optional YES)

Storage place destroyed items NO NO YES NO

(optional YES)

• 

• 
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Therefore, the following setup of QA storage bins is recommended for the two storage logistics options mentioned above:

Establishment Description

Storage bin Quality

inspection

A specific storage place within the storage location, which is used only for the inspection of the

goods.

Storage location

blocking storage

Here it is recommended to determine a separate storage location so that blocked goods do not flow

into the stock of the main storage location.

Storage place

blocking storage

When using the QM app, even if a separate storage location for blocked goods is used, it is

mandatory to specify a corresponding storage location for blocked goods in this storage location.

Storage location

destroyed items

Here it is recommended to determine a separate storage location, so that destroyed goods do not

flow into the stock of the main storage location. Alternatively, the "Debit destroyed items" option

can be used.

Storage place

destroyed items

When using the QM module, even if a separate storage location for destroyed goods is used, it is

mandatory to specify a corresponding storage location for destroyed goods in this storage location.

Alternatively, the "Debit destroyed items" option can be used.
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If no storage logistics is used or only single-level logistics is applied, then the following setup fields of quality assurance must not be

used in the storage location map:

-Goods receipt storage bin (checked)

-Automatic storage system

-Autom. storage at test result

The storage bin for quality inspection must not be used in incoming and outgoing documents. If the storage bins for destroyed items

and blocked items are created in the same storage location as the storage bin for quality inspection, they also run into the inventory

quantity of the item in this storage location. These storage bins can be used in the inbound and outbound documents. No further

inspection is performed for this purpose.

QA process for two-stage warehouse logistics

Here we show the setup and use of QA storage bins when using two-tier logistics.

Two-level warehouse logistics is characterized by the fact that both the documents of the first storage level, such as goods

receipt and goods issue, are used, and the documents of the second level, such as putaway and picking, are used.

The receiving process for items that need to go through QA inspection is as follows:

Note

Note
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Notes General setup

If the parameters of the QM app are set for a storage location with two-level logistics (See QM setup in the storage location

map), all storage bins set there must refer to the same storage location. This is important because the inspected goods from an

inspection order can be moved to respective storage bins within the warehouse by means of putaway (logistics document level 2).

These include the stock storage bins for released goods, the blocked storage bin for blocked goods, and the destroyed storage

bin for destroyed goods.

Furthermore, it is necessary to define the "Goods receipt storage bin (inspected)", as this is the storage bin in which the goods

will be transferred after the inspection has been completed and will be ready for withdrawal for corresponding stock transfers.

Notes Handling of QA storage bins in logistics documents

The QA storage bins (storage bins for the QA inspection itself, for inspected goods, and for blocked and destroyed goods) are all

components of one and the same storage location. However, since these storage bins are not intended to manage available stock,

but rather to support the processes in quality assurance, the following restrictions apply to these storage bins in connection with

two-level logistics:

"QS" storage bin (field "Storage bin quality check"):

It is the storage bin where goods are moved for inspection. The goods are checked in this storage bin. This bin must not be used

in the logistics documents (putaway, picking, etc.).

"QA checked" storage bin (field "Goods receipt storage bin (checked)"):

It is a storage yard used as part of two-stage logistics in test orders. The goods from the QA inspection are moved to this storage

bin when the inspection is completed. This storage bin is then used as a transit storage bin to store the inspected goods in

accordance with the inspection result, in which it serves as a withdrawal storage bin for the stock placements from the

inspection order. In connection with logistics documents, this storage bin may only be used for stock placements as a withdrawal

bin (take) in order to place the goods into stock storage bins and the blocked/destroyed bin.

"QS Blocked" storage bin (field "Blocked storage bin"):

It is the storage bin to which the blocked goods are transferred when the inspection order is completed. In connection with

logistics documents, this storage bin may only be used in a putaway as a putaway bin (place) if the blocked goods are put away in

the blocked storage bin after an inspection order. 

"QS Destroyed" storage bin (field "Storage bin destroyed items"):

It is the storage bin to which the destroyed goods are transferred upon completion of the inspection order. In connection with

logistics documents, this storage bin may only be used in a putaway as a putaway bin (place) if the destroyed goods are

transferred to the destroyed bin after an inspection order. 

These storage bins may also not be used in other logistics documents.

To ensure that the stocks in the storage bins listed above are not included in the "Available quantity for order picking" in the

picking worksheets. Quantity for picking" in the picking worksheets, the "Dedicated" checkbox must be activated in the storage

bins.

They are also not taken into account when creating a pick. On the one hand, these storage bins are excluded from the creation of

the picking (withdrawal lines of a picking), on the other hand, these storage bins may not be used as target storage bins in the

putaway lines of a picking.

Although the QA storage bins are not intended for managing the available stock, they are also not excluded from the available

stock of the storage location. Therefore, it is important to check the blocked and destroyed stocks from the QA inspections

regularly and, if necessary, to remove them to a separate storage location.

Notes Management of blocked / destroyed stocks in two-tier logistics

Stocks in the "Destroyed goods" and "Blocked goods" storage bins should be transferred to a separate storage location using a

stock transfer ledger sheet. 

This is a manual process. (For this, it is recommended to use the "Get bin contents in stock transfer journal" function). This

corrects the stock in the main storage location by removing the unusable stock in the "Blocked" and "Destroyed" storage bins to

a separate storage location. Return documents for the blocked goods can then be triggered from this separate storage location.
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This is not possible in the main warehouse because the QA storage bins are ignored when using two-level logistics in the creation

of a pick.

The QA storage bins (including the storage bin for blocked goods and storage bin for destroyed goods) are ignored during

picking so that in normal operation only inspected/released goods from the stock storage bins are used during picking.

Notes Automatic return creation with two-stage outbound logistics

Automatic returns creation for two-tier logistics in the goods issue area is not supported. 

In this case, the stock must be transferred from the blocked storage bin to a separate storage location (the "Get storage bin

contents in stock transfer journal" function is recommended for this). A return document can then be created manually from this

separate blocked storage location. 

The direct creation of a return for the blocked storage bin from a storage location with two-level outbound logistics is not

possible, since the goods issue here also requires picking and the blocked storage bin is not taken into account during picking.

Notes on the creation of putaways for two-stage logistics

The Quality Management module limits the standard Microsoft Dynamics 365 Business Central1 functionality for creating

putaways.

Putaways for a posted goods receipt can only be created for lines whose goods are not in an open inspection order. You can view

this in the posted goods receipt line via the "Quantity to be inspected (base)" and "Open inspection order no." fields.

For goods that are in inspection, putaways are automatically created when the inspection order is completed.

This restriction ensures that goods in inspection are not transferred from the QA storage bin to an inventory storage bin by a

separate putaway.

It also prevents the inspection order from not being completed due to a lack of the appropriate stock of goods to create putaways

from the inspection order.

In such cases, if a putaway created from the test order is accidentally deleted by the user, the following should be noted:

If the quantity of the posted goods receipt line has been completely checked and there is no longer an open inspection order for

this line, a corresponding putaway can be created using the standard functionality for creating putaways. However, it must be

taken into account that in this putaway the quantities of the goods are not differentiated according to released goods or blocked

goods and are therefore not distributed to the corresponding storage bins. This differentiation must be done manually. If there is

still an open inspection order for the posted goods receipt line, because only a partial quantity was released from the inspection,

the standard functionality for creating a putaway can only be used when the open inspection order has also been completed. 

When using putaway worksheets for a storage location, it is possible that a posted goods receipt is displayed during the action "Get

logistics document", even if all items in this posted goods receipt have a link to the open inspection order. This is due to the fact that

the standard "Get logistics document" functionality takes into account all posted goods receipts whose items have not yet been

completely put away. Since a putaway is not created for items subject to inspection until the inspection order is completed, the

corresponding posted goods receipt is also displayed in the logistics document overview. However, items from a posted goods receipt

that are linked to an "open" inspection order cannot be dragged into the putaway worksheet lines. At this point, a message may

appear stating that no putaway worksheet lines could be created. This ensures that for goods in inspection, putaways can only be

created by completing the inspection order. 

QUALITY EMPLOYEE

You must define the employees who are assigned to a test order or who are set up in the test equipment card as the person

responsible or deputy as "Quality assurance employees". 

To do this, first call up the "Quality assurance employees" page via the user search.

You can create new quality assurance employees via "New" in the ribbon. Use the "No." field to select an employee from the

"Employees" page. The other fields are then automatically transferred from the employee card.

Note on working with putaway worksheets
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Further information can be found at: "Recording an employee".

USER SETUP

Inventory processing

When organizing inventory processing at storage locations where quality inspections are carried out, it must be taken into account

that the storage bins "Storage bin quality assurance" and "Goods receipt storage bin (inspected)" can only be posted to by selected

users.

It must be checked whether a separate inventory is to be carried out in these storage bins.

REPORT SELECTION

In the "Report selection", the corresponding report must be set up for the respective use (inspections). Report 5483763 -

"Inspection order" is available in the QM and can be used for all inspections. Report usages for which customized reports can be

created and assigned if required are:

Incoming inspection

Intermediate inspection operation

Intermediate examination external work course

Final inspection

Manual test

EXAMS FACILITY

Test characteristics

Recurring inspection characteristics can be set up via the "Inspection characteristics overview". These inspection characteristics

form the basis for creating inspection plan lines. The Code and Description fields identify and describe the inspection

Field Description

No. Selection of an employee number to work as a quality assurance employee for the activities listed above.

First Name Display of the field with the same name from the employee card.

Last Name Display of the field with the same name from the employee card.

Company Email Display of the field with the same name from the employee card.

Job Title Display of the field with the same name from the employee card.

Status Display of the field with the same name from the employee card.

Field Description

Manual Quality

Bin Posting

In order to achieve the necessary security for the bookings in the quality inspection process, the

storage bins "Quality assurance storage bin" and "Goods receipt storage bin (checked)" can only be

booked manually by selected users. Further information can be found under "Storage locations".

By activating the "Manual QA storage bin booking" button, users are authorized to make manual

bookings to the storage bins listed above.

Note

• 

• 

• 

• 

• 
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characteristic. The Attribute field defines whether the characteristic is to be inspected attributively or whether it is a

characteristic with measured values to be recorded.

Additional lines with a further description of the inspection characteristic can be created for an inspection characteristic. If an

inspection characteristic is specified in an inspection plan line, these additional description lines of the inspection characteristic

are transferred to the inspection plan lines below the selected inspection characteristic. 

Via Further options > Navigate > ActionGroup2 > Translations, a translation for the required language codes can be set up for

each inspection characteristic. The translations are accessed when an inspection order is printed for a vendor with the

corresponding language code.

Error category

Error categories can be assigned to the detailed test errors and serve as a grouping element of the test errors. To create a defect

category, first call up the "Defect categories" via the user search. Via "New" in the menu ribbon, you can define a new defect

category with the help of the table below.

Via Further options > Navigate > Translations, a translation for the required language codes can be set up for each error

category. The translations are accessed when a check order is printed for a vendor with the corresponding language code.

Test error

When recording the test data of a test order, a defined test defect can be assigned if defects are detected. Test errors are used to

evaluate and group the test data. To define the test errors, call up the "Test errors" via the user search. Via "New" in the menu

ribbon, you can define a new test error with the aid of the table below.

Via Further options > Navigate > Translations, a translation for the required language codes can be set up for each check error.

The translations are accessed when a check order is printed for a vendor with the corresponding language code.

Field Description

Code Assignment of the unique code of the inspection characteristic

Description The description of the inspection characteristic

Attribute Setup of the type of inspection characteristic

-> Yes

For an attributive inspection characteristic, the inspection result is to be recorded as Yes (attribute

fulfilled) or No (attribute not fulfilled).

-> No

A measured value is to be recorded for a non-attributive inspection characteristic

Field Description

Code Assignment of the unique code of the error category

Description The description for the error category

Field Description

Code Assignment of the unique code of the test error

Description The description of the test error

Error category code Assignment of a defect category as grouping element for test defects
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Test Equipment Group

A test equipment group can be assigned to a test equipment. To define a test equipment group, call up the "Test equipment group

overview" via the user search. Via "New" in the menu ribbon, you can create a new test equipment group using the table below.

Via the test equipment group list, remarks can be stored for a test equipment group via further options > Navigate > Test

equipment groups > Remarks.

Sampling regulations

Both standardized and freely defined regulations can be set up as sampling regulations. A sampling regulation is a basic element

of the inspection plan. For each inspection plan, 3 sampling regulations must be assigned: * Sampling rule Code (Normal) *

Sampling requirement code (Tightened)

-> Sampling rule Code (reduced)

Therefore, it makes sense to set up three sampling rules with the respective inspection severity for a basic sampling rule.

To set up the sampling regulations, call up the sampling regulation overview via the user search. You can define a new sampling

regulation via "New" in the menu ribbon.

Sampling regulations consist of a header (info tab "General") and the sampling regulation lines (info tab "Lines"). 

Inforegister General

Field Description

No. Assignment of the unique number of the test equipment group. The number series for the test equipment

groups must be set up in the quality assurance facility.

Description The description of the test equipment group. The value from Description is automatically transferred to

the Search term field.

Description 2 The description 2 to the test equipment group.

Search

Keyword

The search term for the test equipment group

Built on

Built by

These non-editable fields show when and by which user the record was created.

Modified on

Modified

These non-editable fields show when and by which user the record was last modified.

Field Description

Code Assignment of the unique code of the sample. The number series for the samples is to be set up in the

quality assurance facility.

Description The description to the sampling rule.

Test severity This field is used to set up the inspection severity of the sampling requirement. Possible option values are:

• Normal

• Reduces

• Tightened

In a goods receipt inspection, a skip instruction can be set up for an inspection plan. This is used to

dynamically determine the inspection severity. Therefore, it can make sense to set up three sampling

instructions for a basic sample such as AQL 25 II:

• AQL 0.25-II normal test

• AQL 0.25-II reduced test

• AQL 0.25-II tightened test

Skip lot

number

The Skip lot number field is used to specify how many tests are to be skipped after a test has been

performed and ended with a "Release" test decision
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Inforegister lines

Jump instructions

The jump instructions can be used to set up dynamic modification of the sample size for goods receipt inspections. The jump

instructions can be set up ...

1) ... for a specific item and vendor

The Article no. field is filled with the respective article no. The Vendor no. field is filled to the respective vendor

2) ... for a specific vendor - regardless of the item.

The Item no. field remains empty The Vendor no. field is filled to the respective vendor

3) ... for a specific item - regardless of the respective vendor.

The Article no. field is filled with the respective article no. The Vendor No. field remains empty 

4) ... for generally valid for all articles and creditors

The fields Item no. and Vendor no. remain empty

The system checks in the sequence listed above whether a jump instruction is set up for the combination of article and vendor

and accesses the first set up found. According to the jump instruction found and the previous inspection decisions in the goods

receipt inspections, the current goods receipt inspection is created with the corresponding sample size. The history of the goods

receipt inspections can be found in the skip lot history overview.

When an incoming inspection is first created for a specific supplier and specific item, an incoming inspection is always created

with the Normal sampling rule.

Field Description

From batch size This field is used to set up the lot size (delivery or production quantity) for which the subsequent

parameters are used.

Sample size in

%

This field specifies what percentage of the delivery or production quantity is used for sampling. The

system calculates the

Sample size This field is to be filled with a fixed value that will be used as the sample size. If this field is filled, no

entries are allowed in the Sample size % and Skip item count fields.

Skip item

quantity
This field is used to control how many test items are to be skipped within the sample. If every 5th part is

to be inspected, 4 parts of the batch size are to be skipped. In this case, the skip item number must be

set to 4.

Assumption % The acceptance number is the maximum number of defective specimens in the sample at which the

inspection may be released. This value can be specified as a % value in relation to the sample size. This

value is purely informative. It is not checked by the system in the inspection decision.

Acceptance

number

The acceptance number is the maximum number of defective specimens in the sample at which the

inspection may be released. As an alternative to the acceptance %, an absolute acceptance number can

also be set up. This value is purely informative in the inspection order. It is not checked by the system in

the inspection decision.
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To define the jump instructions, call them up via the user search. Via "New" in the menu ribbon you can set up a new jump

instruction with the help of the table below.

Tolerance classes

The tolerance classes are used to create the individual dimensional categories for the free size tolerances. Common tolerance

classes are: * f (fine) * m (medium) * c (coarse) * v (very coarse)

To define the tolerance classes, call them up via the user search. Via "New" in the menu ribbon you can create a new tolerance

class with the help of the table below.

Tolerances of free dimensions

Via the free size tolerances, the free size tolerance ± is set up for the respective tolerance class and the nominal dimension

range above ... / to ... . Tolerances are used in inspection plan lines. The minimum nominal value and the maximum nominal value

of the inspection characteristic are automatically calculated from the nominal value of the inspection characteristic and the

tolerance of the inspection characteristic. Nominal value of the inspection characteristic.

To set up the tolerance, call up the "Tolerances" via the user search. Via "New" in the menu ribbon you can define a new free size

tolerance with the help of the table below.

Field Description

Item no. Enter the article no. for which a jump instruction is to be made in this field. If the field remains

empty, the condition applies to all articles.

Creditor no. Enter a vendor in this field for which a jump instruction is to be made. If the field remains empty,

the condition applies to all vendors

Tightened to Normal Enter in this field the number after how many consecutive released inspections the sampling

requirement should change from Tightened to Normal.

Normal to Reduced Enter in this field the number after how many consecutive released inspections the sampling rule

should change from Normal to Reduced.

Reduced to Normal Enter in this field after how many consecutive blocked inspections the sampling rule should

change from Normal to Reduced.

Normal to Tightened Enter in this field after how many consecutive blocked inspections the sampling rule should

change from Normal to Tightened.

Max, number of

reduced tests

Enter in this field the maximum number of inspections with reduced sampling requirement before

an inspection with the normal sampling requirement is to be created again.

To be able to use inspection orders with reduced sample size, a value <> 0 must be set up in this

field.

Field Description

Code The unique code of the tolerance class is created in this field

Description The description of the tolerance class is created in this field

Field Description

Tolerance class Code This field is used to specify the tolerance class code.

Nominal dimension

above

This field indicates the lower nominal dimension

Until nominal dimension This field indicates the upper nominal dimension

Tolerance ± In this field, the permissible tolerance of the tolerance class and the nominal dimension range is

specified
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The table for limit dimensions for linear dimensions ...

Limit dimensions in mm for nominal dimension range in mm

... are to be set up in the table of free size tolerances as follows as an example:

Fit tolerances

To set up the fit tolerances, call them up via the user search. Fit tolerances are used in inspection plan lines. The nominal value

of the inspection characteristic and the fit tolerance of the inspection characteristic automatically result in the min. nominal

value and the max. nominal value of the inspection characteristic. Nominal value of the inspection characteristic.

Fit tolerances can only be created with the tolerance abbreviations for outer dimensions (lower case) and inner dimensions

(upper case) if a distinction between upper and lower case is technically activated in the database for primary key fields. If this is

not the case, no distinction is made between a fit tolerance h13 and H13 and the creation of the second fit tolerance leads to an

error: 

"The record already exists in the Fit Tolerance table. Identifying fields and values: Fit='H13'.

In such a constellation, the fit tolerances must be created with unique code, such as:

H13 (A) ... for outside dimension fit tolerance H13 (I) ... for inside dimension fit tolerance

The table of fit tolerances (example: h6) must be created as follows

Tolerance

class

over 0.5 to 3 over 3 to 6 over 6 till 30 over 30 till

120

over 120 till

400

over 400 till

1000

over 1000 till

2000

over 2000 till

4000

over 4000 till

8000

f (fine) ± 0,05 ± 0,05 ± 0,10 ± 0,15 ± 0,2 ± 0,3 ± 0,5 - -

m (medium) ± 0,10 ± 0,10 ± 0,20 ± 0,30 ± 0,5 ± 0,8 ± 1,2 ± 2 ± 3

c (coarse) ± 0,20 ± 0,30 ± 0,50 ± 0,80 ± 1,2 ± 2,0 ± 3,0 ± 4 ± 5

Field Description

Fit This field is used to specify the fit code

Nominal dimension

above

This field indicates the lower nominal dimension

Until nominal

dimension

This field indicates the upper nominal dimension

Lower tolerance in µm In this field, the lower tolerance of the fit and nominal dimension range is specified. The value

must be specified as a negative value

Upper tolerance in µm In this field, the upper tolerance of the fit and nominal dimension range is specified. The value

must be specified as a positive value
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External dimensions (shafts): Limiting dimensions in µm (1 µm = 0.001 mm)

Example setup of the fit tolerance h6

Testing equipment

Call up the "Test equipment overview" via the user search to access the test equipment list. Test equipment is the equipment that

is used in the test to determine measured values. A piece of test equipment can be assigned to the respective test plan line with

which the characteristic in question is to be measured. Within the inspection plans and inspection orders, a check is performed

to determine whether the specified test equipment has the status Released or Not subject to calibration in order to be used in the

inspection line. However, there is no check whether the technical specifications in the test equipment card, such as unit code,

reading accuracy or measuring range, match the characteristic and value range to be measured. 

TEST EQUIPMENT CARD

The TEST EQUIPMENT CARD consists of the GENERAL, USE, CALIBRATION and CALIBRATION LINES tabs. These are

explained in more detail below.

Nominal

dimension

range

in mm

f6 f7 g6 h3 h4 h5 h6 h8 h9 h15

from 1 -6 -6 -2 0 0 0 0 0 0 0

Until 3 -12 -16 -8 -2 -3 -4 -6 -14 -25 -400

over 3 -10 -10 -4 0 0 0 0 0 0 0

to 6 -18 -22 -12 -2,5 -4 -5 -8 -18 -30 -480

over 6 -13 -13 -5 0 0 0 0 0 0 0

Until 10 -22 -28 -14 -2,5 -4 -6 -9 -22 -36 -580

over 10 -16 -16 -6 0 0 0 0 0 0 0

Until 18 -27 -34 -17 -3 -5 -8 -11 -27 -43 -700

over 18 -20 -20 -7 0 0 0 0 0 0 0

Until 30 -33 -41 -20 -4 -6 -9 -13 -33 -52 -840

over 30 -25 -25 -9 0 0 0 0 0 0 0

up to 50 -41 -50 -25 -4 -7 -11 -16 -39 -62

over 50 -30 -30 -10 0 0 0 0 0 0 0

up to 80 -49 -60 -29 -5 -8 -13 -19 -46 -74 -1200

over 80 -36 -36 -12 0 0 0 0 0 0 0

up to 120 -58 -71 -34 -6 -10 -15 -22 -54 -87 -1400
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Inforegister General

In the GENERAL INFO tab, enter the master data of the test equipment. 
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Field Description

No. This field contains the unique number of the test equipment. The number series for test equipment

must be set up in the quality assurance facility.

Description The description of the test equipment

Units code This field is used to enter which unit of measurement the test equipment measures. This field

accesses the Units table. If necessary, suitable units must first be created in this master data table.

Test equipment

group no.

This field is used to set up the assignment of the test equipment to a test equipment group.

Reading accuracy The smallest distinguishable reading value of the test equipment is entered in this field.

Measuring range The measuring range of the test equipment is entered in this field.

Search Keyword This field contains the search term for alternative selection next to the number. The entry in the

Description field appears here as the default.

Manufacturer no. The manufacturer no. of the test equipment is entered in this field.

Serial no. The serial number of the test equipment is entered in this field

Date of receipt The date of receipt of the test equipment is entered in this field

Status This field displays the current status of the test equipment. The option values for Status are:

Locked

Locked test equipment cannot be used in the test order line or can only be used to a limited extent. If

necessary, the test equipment specified in the test plan must be replaced in the test order by an

unlocked test equipment. See also Quality assurance setup, Inspection with locked test equipment

field.

Under test

This status indicates that the gage is currently in inspection. When a new piece of test equipment is

created, the status is automatically In test.

Release

This status indicates that the test equipment can be used for tests. In this status, the test equipment

cannot be edited

Not subject to calibration

This status indicates that the test equipment does not need to be calibrated. It is available for quality

tests.

Created on This field is filled automatically. It indicates when this test equipment was created.

Created by This field is filled automatically. It indicates which user has created this test equipment.

Corrected on This field is filled automatically. It indicates when this test equipment was last processed.

Corrected from This field is filled automatically. It indicates which user last processed this test equipment.

Number of test plan

lines

This field shows how many inspection plan lines the gage is assigned to. If the Released status of a

piece of test equipment must be reset, the affected test plans can be displayed via the drilldown of

this field and opened for revision in order to exchange the current test equipment for a released piece

of test equipment.

Number of open

test order lines

This field shows how many open test order lines the gage is assigned to. If the Released status of a

piece of test equipment has to be reset, the affected test orders can be displayed via the drill-down of

this field and opened for revision in order to exchange the current test equipment for a released piece

of test equipment.
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Inforegister Use

In the USAGE info tab, you can additionally specify which persons are responsible for the test equipment and to which

department of the company the test equipment is assigned.

Inforegister Calibration

In the Calibration tab, you can store the regulation, location, cycle, etc. according to which the calibration takes place.

Inforegister Calibration Lines

The calibrations performed are documented in the calibration lines. The calibration lines are created automatically from the

calibration specifications when a new calibration is created. See Calibrating test equipment.

Field Description

Responsible This field can be used to assign an employee responsible for this test equipment from the Employees

table.

Deputy This field can be used to assign a deputy responsible for this test equipment from the Employees table.

Department

code

This field can be used to assign a department from the Departments table

Field Description

Calibration

specification

A calibration specification can be entered in this field.

Calibration location This option value is used to set up the calibration location. Option values are:

<empty>

Calibration location is not defined or the test equipment does not require calibration

Internal

Calibration takes place in the company

External

The calibration takes place outside the company. With this radio button a vendor can be entered in

the following field

Calibration Vendor

no.

If the calibration location is External, the vendor who performs the calibration of the test equipment

as a service provider can be entered in this field.

Calibration cycle This field is used to set up the calibration cycle using a date formula.

Next calibration

date

This field is calculated automatically and is not editable. After the completion of a calibration, the

next calibration date is calculated based on the calibration cycle.
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Right-click in the Calibration Date column heading to expand or collapse all rows. Click on a Calibration Date value to collapse or

expand just those calibration rows.

Test equipment Remarks and translations

Additional data can be maintained via the menu ribbon using Further options > Associated > Test equipment: Comments

This form can be used to record internal remarks about a piece of test equipment 

Translations

In this form, a translation for the required language codes can be set up for each piece of test equipment. The translations are

accessed when an inspection order is printed for a vendor with the corresponding language code.

CALIBRATE TEST EQUIPMENT

The module enables you to schedule necessary calibrations and to record and thus document calibrations that have been

performed.

When you create a new piece of test equipment that requires calibration, you should record an initial calibration in order to have the

next calibration date calculated after the test equipment has been released.

Create calibration presets

Before you can document a calibration for a piece of test equipment, you must enter calibration specifications. To do this, go to

the Calibration specifications call in the test equipment CARD IN the menu ribbon. In the CALIBRATION SPECIFICATIONS form

Field Description

Calibration date This field is filled with the current date when the calibration was created.

Calibration type This field contains the measured variable that is to be calibrated.

Feature This field describes the calibration type.

Attribute This field indicates whether the characteristic is qualitative or not.

All right Check this field if the actual value is within the setpoint specifications.

Set point This field contains the nominal value if it is a quantitative characteristic.

Min. set point This field contains the smallest permissible measurement if it is a quantitative characteristic.

Max. Set point This field contains the largest permissible measurement if it is a quantitative characteristic.

Actual value In this field you enter the actual value for calibration.

Units code This field contains the unit of the measurand.

Note
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that opens, you can enter the measured quantities and conditions to be inspected for the test equipment. The following table

describes the fields of the CALIBRATION SPECIFICATIONS FORM.

Document calibration

To perform a new calibration, you must first set the status of the test equipment to "In test". Note that test equipment with the

status "In test" cannot be used in test orders, or can only be used to a limited extent. 

A new calibration is created via the "Create new calibration" function. Here, the current calibration specifications are copied into

the calibration lines. The working date is used as the calibration date. The calibration date can be changed manually if required.

For calibration lines to be measured, enter the respective measured value in the Actual value field. If the actual value is within

the limits specified in the calibration specification, Min. Setpoint, the indicator OK is automatically set. No actual value can be

entered for attributive calibration lines. In these lines, the OK indicator must be set manually.

Once all calibration lines are acquired, the overall result must be set on the calibration date line.

Finally, the status of the test equipment must be set. If all lines including the overall result line are marked with OK, the status of

the test equipment can be set to Released. By setting the status, the next calibration date is automatically calculated using the

calibration date of the calibration line and the date formula from the Calibration cycle field.

If not all lines are marked with OK, the status of the test equipment must be set to Locked.

COPY TEST EQUIPMENT

To create similar test equipment, an existing test equipment can be used as a copy template. Proceed as follows when copying a

piece of test equipment:

First create a new empty data set. Then call up the Copy from function from the menu ribbon of the test equipment card. Select

the test equipment that you want to use as a template from the test equipment overview that opens. Confirm the selection with

OK. The copy function copies all fields from the test equipment selected as the source as well as the calibration specifications.

The Next calibration date field is also copied. If you create a new gage that requires calibration, you should record an initial

calibration in order to have the next calibration date calculated after the gage has been released.

Test plans

Call up the "Test plan overview" via the user search to access the test plan list. The test plan is the basis from which test orders

are created. The test plan contains the parameters relevant for the test order. The characteristics to be inspected are also

defined in the inspection plan. Which inspection plan is to be used in which process by the system is defined in the inspection

plan usage. 

Via "New" in the menu ribbon you can define a new test plan using the tables below.

Field Description

Calibration

type

In this field you define the method of calibration.

Feature In this field you define the characteristic to be checked

Attribute If the characteristic is to be tested purely attributively, mark the line with Yes. If, on the other hand, a

measured value is to be recorded for this characteristic during calibration, mark this line No.

Set point If the characteristic is not to be assessed attributively, the nominal value of the calibration specification is

specified in this field.

Min. set point If the characteristic is not to be assessed attributively, the minimum target value of the calibration

specification up to which the result is OK is specified in this field.

Max. Set point If the characteristic is not to be assessed attributively, the maximum target value of the calibration

specification up to which the result is OK is specified in this field.

Units code The unit code of the characteristic to be assessed is entered in this field
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When a new inspection plan is created, it initially receives the status New. The status can be changed to In development,

Certified or Expired using the functions in the test order header menu. Only with the status Certified can an inspection plan be

used as a default for creating inspection orders. In the Certified status, no changes can be made in an inspection plan. To change

a certified inspection plan, the status must be reset to In development. Changes are also possible in the New or Expired status.

CREATE TEST PLANS

Inforegister General

In the GENERAL info tab you will find general information such as description, status and version. 

Field Description

No. This field contains the unique number of the test plan. The number series for test plans must be set up in

the quality assurance facility.

Description

Description 2

A description of the test plan can be set up in these fields. The description is transferred to the test order.

Test type If the test plan includes destructive tests, select the Destructive option value for the test type. This option

value is transferred to the inspection order. Only in the case of inspection orders with the Destructive

inspection type is it possible to specify a destroyed quantity in the inspection and to transfer or clear it

during the inspection.

Search

Keyword

You can use the Search term field to search for a specific test plan whose test plan no. you do not have

present. The entry from the Description field appears as the default.

Drawing This field can be used to import a file, such as a drawing, for the item to be inspected. Unlike file links,

the specified file is imported into the inspection plan. The file is transferred to the inspection order.

Status This option value defines the status of the test plan 

New

This status is set automatically when a new test plan is created. With this status, changes can be made in

the test plan.

In development

This status is set via the Reset status function. With this status, changes can be made in the test plan.

Certified

This status is set via the Certify function. With this status, no changes can be made in the inspection plan.

Only with this status can inspection orders be created from the inspection plan.

Expired

This status is set via the Exit function. This status indicates that the test plan has expired and is no longer

used for test orders.

Version

numbers

A test plan can be versioned. If this is intended, the number series for the version numbers must be

stored in this field. For more information on versioning the test plan, please refer to the corresponding

chapter.

Active version In this field you can see the active certified version of the test plan depending on the working date. If you

have not created a certified version, this field remains empty.
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Inforegister lines

The Lines info tab lists the characteristics to be inspected with detailed information such as description, inspection equipment,

nominal values and inspection notes, etc.
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Field Description

Position An item number must be entered in this code field. The way you assign position numbers is up to you.

This field is mandatory for the certification of an inspection plan.

Inspection feature

code

The inspection characteristic to be inspected in the inspection order must be entered in this field. The

Lookup button can be used to select an inspection characteristic from the inspection characteristic

overview. After selection, the description and the value of the Attribute field are transferred to the

inspection plan lines.

For certification of an inspection plan, there must be at least one line with inspection characteristic

code.

Attribute After selecting the inspection characteristic code, the Attribute Yes/No indicator is taken from the

inspection characteristic. The indicator can be changed in the inspection plan line.

Description After selecting the inspection characteristic code, the description of the inspection characteristic is

transferred to the inspection plan line. The description can be changed in the inspection plan line.

Test equipment

groups No.

In this field, a test equipment group can be selected from the test equipment group overview using the

Lookup button. The use of a test equipment group no. is not mandatory in the test plan line and in the

test order.

Test equipment

no.

In this field, a test equipment can be selected via the Lookup button. All test equipment within the test

equipment group specified in the previous field is displayed here. If you have not entered a test

equipment group, all available test equipment that has been created without a test equipment group

no. will be displayed via the lookup button. The use of a test equipment no. is not mandatory in the test

plan line and in the test order.

Test equipment

designation

After selecting the test equipment no., the description is automatically transferred to this field. You can

change the description individually.

Manual free size

tolerance class

Here you can select the free size tolerance class from the previously set tolerance classes via the

Lookup button. The minimum setpoint value and the maximum setpoint value are then automatically

calculated from the tolerance class and the setpoint value to be specified for the characteristic.

Nominal value. Only one free size tolerance class or one fit can be specified in the line.

Fit Here you can select a previously set up fit via the Assist button. The min. setpoint and the max.

setpoint are then automatically calculated via the fit and the setpoint to be specified for the

characteristic. Target value. You can only ever enter either a free size tolerance class or a fit in the

line.

Min. set point If the inspection position has a quantitative size, then you can enter a value for the smallest

permissible dimension here. If a free size tolerance class or a fit is entered in the line, this value is

automatically calculated from the nominal value.

Set point If the test position has a quantitative value, you can enter a nominal value here. If a free size tolerance

class or a fit is entered in the line, the min. nominal value and the max. nominal value are

automatically calculated from this value. Nominal value are calculated.

Max. Set point If the test position has a quantitative size, then you can enter a value for the largest permissible

dimension here. If a free dimension tolerance class or a fit is entered in the line, this value is

automatically calculated from the nominal value.

Units code In this field, specify the reference unit for the entered dimensions.

Test note You can enter an additional test note as free text in this field.

Specification In this field, a file, such as a specification for the characteristic to be inspected, can be imported.

Unlike file links, the specified file is imported into the inspection plan line. The file is transferred to the

inspection order line.
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Inforegister sampling requirement

The SAMPLING REGULATION info tab contains the sampling regulations to be used in general if no other sampling definitions

are shown in the rows. 

A sampling specification must be entered in the Sampling specification field, otherwise the inspection plan cannot be released

and a corresponding message is issued.

Sampling rules used must have at least one row with "Sample Size">0, "Sample Size %">0 or "Skip Item Count">0.

Inforegister Management

In the ADMINISTRATION tab, you will find information about who created or modified the test plan and when. 

Test plan remarks / test plan notes

Test plan remarks

You can store any number of remarks for each test plan. Click on the test plan card in the "Related>Test plan>Remarks" menu

band. The "Remarks" window opens in which you can enter your remarks.

The remarks can be viewed and also changed via the same path.

Test plan notes

The test equipment notes are recorded in the "Notes" info box and are also displayed there with date and user name after "Save".

TEST PLAN USES

Call up the "Inspection plan usages" via the user search. In the inspection plan usage, you must set up in which processes which

inspection plans are to be accessed in order to create the process-relevant inspection orders. 

The "Inspection plan usage" can also be opened directly from the inspection plan map or the inspection plan overview.

Furthermore, this can also be called up in the vendor, customer, article, work center groups, work centers, operation filtered to

the respective data record.

The USAGE TEST PLAN page is divided into a header and a row area. The header area is used to filter the usage lines.

Field Description

Sampling rule

Code (Normal)

In this field, you store the sampling specification for the normal inspection severity. The inspection

quantity is calculated on the basis of this sampling specification as soon as the system classifies an

inspection as a normal inspection severity by means of jump instructions.

Sampling pres.

Code

(Tightened)

In this field, you store the sampling specification for the tightened inspection. The inspection quantity is

calculated on the basis of this sampling specification as soon as the system classifies an inspection as

tightened by means of jump instructions.

Sampling pres.

Code (Reduced)

In this field, you store the sampling specification for the reduced inspection severity. The inspection

quantity is calculated on the basis of this sampling specification as soon as the system classifies an

inspection as a reduced inspection severity by means of jump instructions.

Note

Field Description

Built on Date of the test plan installation

Built by User of the test plan system

Modified on Date of last change

Modified from User of the last change
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Test plan Use filter area

You can perform the following filtering for the test plan usage lines:

Test plan use lines

The test plan usage is set up in the lines described below. Mandatory fields for the complete setup of a test plan usage are: 

-> Type of origin

Depending on the selected origin type, further fields are to be filled differently.

-> Type

Depending on the selected type, further fields are to be filled differently

-> Test plan

Field Description

Origin type filter /

Origin code

filter This can be used to set a filter on one of the origin type options. If a unique data source is defined

by the origin type filter, such as vendor, an additional origin code filter can be set. In this case, a

specific vendor can be selected from the list of vendors as the origin code filter, or an origin code filter

can be entered manually. In this case, a filter string such as <>'' or 1* etc. can also be used.

If no unique data source is defined by the origin type filter, no additional origin code filter can be set.

Selecting the Origin type filter None will remove the filtering on a specific origin type. All origin types

are displayed.

Routing version

filter

This can be used to set a filter on the version of a routing for production.

Working aisle

filter

If you have selected an intermediate inspection operation as the origin type and the routing in the

Origin code field in the next step, you can finally filter to the specific operation.

Type filters /

Item no. Filter

Here a filter can be set on the option value article. If this type of filter is set, an article no. filter can

also be set. A certain article can be selected from the list of articles as article no. filter or an article no.

filter can be entered manually. In this case also a filter string like <>'' or 1* etc. can be used.Likewise,

a kind of filter on All articles can be selected. This filters the use of the test plan to those lines that are

generally valid for all articles. Selecting the Type Filter None will remove the filtering on the type.

Test plan filter In this field, a test plan can be selected from the selection list of test plans to which the usage list is to

be filtered. Likewise, a filter on the test plan can be entered manually. In this case, a filter string such

as <>'' or 1* etc. can also be used.

Start date filter The Start Date Filter can be used to set a filter on the usage lines with a specific start date In this field,

in addition to an exact date, a date filter string, such as a period, can also be used.
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The inspection plan to be used for the combination of origin type and species, which is used to create the respective inspection

order.
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Field Description

Type of origin Enter here for which tests the test plan is to be used. The following options are available:

Receipt check vendor

Here, an incoming inspection for goods of the creditors takes place.

Receipt check customer

An incoming inspection for goods from the debtors takes place here.

Receipt check transfer order

An incoming goods check is carried out here for goods from the transfer orders.

Receipt check vendor and customer

Here, an incoming inspection for goods from creditors and debtors takes place.

Intermediate examination workplace

Here, an intermediate inspection takes place in the manufacturing process for a specific workstation

(KVS Manufacturing Quality Control).

Intermediate examination workplace group

Here, an intermediate inspection takes place in the manufacturing process for a specific workstation

group (KVS Manufacturing Quality Control).

Intermediate exam Both

Here, an intermediate inspection takes place in the manufacturing process for specific workstations and

workstation groups (KVS Manufacturing Quality Control).

Final inspection

Here, a final inspection is performed after the actual message of the last operation (KVS Production

Quality Control).

Manual test

Here, manual inspection takes place independently of the business and manufacturing process.

Intermediate inspection operation

Here, an intermediate inspection takes place in the manufacturing process for certain operations (KVS

Manufacturing Quality Control).

Note: An intermediate inspection at the last operation is not possible (see final inspection).

Origin code If a unique data source is defined by the origin type filter, such as Vendor, an additional origin code filter

can be set. In this case, a specific vendor can be selected from the list of vendors as the origin code filter

or an origin code filter can be entered manually. In this case, a filter string such as <>'' or 1* etc. can

also be used. If no unique data source is defined by the origin type filter, no additional origin code filter

can be set.

Working aisle

no.

If you have selected an intermediate inspection operation as the origin type and the routing in the Origin

code field in the next step, you can finally determine the specific operation.

Type In this field you can enter whether the inspection plan should be applied to one item or all items.

Code If you have entered the Article option in the Type field, you must select an Article No. in this field.

Test plan Here you enter the inspection plan no. to be used for the specified origin type and species. If the TEST

PLAN USES form is called up via a test plan, this field is preassigned with the test plan no..

Start date/ End

date

Here you enter the date values for which the test plan usage is active/valid. This is not a mandatory field

for the system to create checks.

Work plan

version code

If checks are to be used in production and routings with versions are maintained, this field shows the

active version.
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Test plan

Inspection plan usages can be set up for the following processes. Which inspection plan is used to create the inspection order

depends on the following hierarchy:

Incoming inspection use priorities{ #incoming-inspection-testplan-use-priorities }

Example: A goods receipt is posted for vendor 10000 and item 70011. The inspection plan usage is run through in the following

hierarchical order to determine the valid inspection plan for creating the inspection order:

If the test plan usages are managed with start date and end date, the entry with the most recent start date is used within the

same priority. The sorting is therefore ascending within the priority level according to the start date. The last entry of the test

plan usage is accessed.

If test plans are managed with versions, the version with the most recent start date is used within the same priority.

Intermediate exam

Example: A routing 1001 is available for the article 1000 "Touring bike" to be produced. In operation 40 at work center 110, an

intermediate inspection is to be set up before the touring bike is packed.

In the inspection plan usage, the trigger for creating the intermediate inspection with the required inspection plan can be set up

in different ways. The priority rule is "from the most accurate assignment to the most general assignment": 

If the test plan usages are managed with start date and end date, the entry with the most recent start date is used within the

same priority. The sorting is therefore ascending within the priority level according to the start date. The last entry of the test

plan usage is accessed.

If test plans are managed with versions, the version with the most recent start date is used within the same priority.

Priority Type of origin Origin code Type Code

1 Receipt check vendor 10000 Article 70011

2 Receipt check vendor Article 70011

3 Receipt check vendor 10000 All articles

4 Receipt check vendor All articles

5 Incoming inspection Both Article 70011

6 Incoming inspection Both All articles

Priority Type of origin Origin code Operation Type Code

1 Intermediate

inspection

operation

1000 40 Article 1000

2 Intermediate

inspection

operation

1000 40 All articles

3 Intermediate

examination

workplace

110 Article 1000

4 Intermediate

examination

workplace

110 All articles
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Test plan usage Incomplete data records in the test plan usage

An incomplete data record in the test plan usage is ignored by the system. Mandatory fields are marked with a red star

depending on the line type.

Incoming inspection

Example:

A data record exists in the inspection plan usage for the vendor 01254796 and the article 70000. This data record does not

contain an assigned inspection plan. A goods receipt is posted for vendor 01254796 and item 70000.

In this case, the goods receipt is posted without creating an incoming inspection or issuing an error message.

Intermediate exam

Example:

A work plan with the following operations is available for item 1000:

Intermediate tests for article 1000 are set up in the test plan usage with

-Intermediate inspection Operation with operation no. 20 without inspection plan assignment

-Intermediate test workstation 120 with test plan PP-00004

When the production order is released, the first line of the inspection plan usage is ignored, an intermediate inspection is created

according to the (less relevant) second line for work center 120 via the stored inspection plan PP-00004.

COPY TEST PLAN

You have the possibility to copy an existing test plan. To do this, proceed as follows: 

1.) Create a new test plan with a new test plan number under Planning > Test plans using the New button.

2.) Click the Copy test plan function in the ribbon.

3.) In the TEST PLANS form, select the test plan to be copied.

4.) The header and row information of the selected test plan will be copied to the current test plan.

The newly created inspection plan must be assigned in the inspection plan usage to the business transactions in which the

inspection orders are to be created from it. (See also Inspection plan usage)
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VERSIONING THE TEST PLAN

You can create any number of versions for an existing test plan when making changes to the test plan. A prerequisite for the

versioning of inspection plans is the assignment of a number series in the inspection plan header in the Version numbers field. To

avoid working with a consecutive version number for all inspection plans and their versions, create a number series with purely

manual number assignment. This number series can be used in every inspection plan. When creating a new test plan version, you

can now manually assign the respective version number of the test plan version (V-001, V-002, V-003 ...). 

An inspection plan version does not have to be set up in the inspection plan usage. The test plan usage accesses the stored test

plan and the latest certified version available for it. (See Test plan usage)

To create a new version for an existing test plan, proceed as follows: 1. From the test plan list or from the test plan map, you can

call up the test plan version overview using the Versions function. 2. In the test plan version overview, call up the New function.

3. Depending on the setup of the number series in the test plan header for the version numbers, a new test plan version number

is assigned automatically or must be assigned manually by the user. 4. You can manually fill all header and row fields in the new

test plan version as described above. Likewise, you can use the inspection plan header as the basis for a new version or use an

existing inspection plan version as the basis for a new version. To do this, use the Copy test plan or Copy test plan version

function. The header and line information will be copied from the selected source to the new test plan version. 5. Use the Start

date field in the test plan version to specify from which working date this version should be automatically used by the system.

The most recent certified version of a test plan is always accessed. 6. Finally, you use the functions to define the status of the

current test plan version:

-Certify

The version receives the status Certified. From the inspection plan usage, the most current inspection plan version according to

the work date is accessed for creating inspection orders. 

-Reset status

The version receives the status In development. In this status, changes can be made to the version. The test plan usage does not

access this version when creating test orders.

-Exit

The version receives the status Expired. The test plan usage does not access this version when creating test orders.

Quality checks

The QM module creates quality inspections in the various business and manufacturing processes. The chapter describes how

quality inspections are created on the basis of inspection plans and sampling regulations. The quality inspections can be

subdivided as follows: * Incoming inspection * Intermediate exam * Intermediate examination external work course * Final

inspection * Manual test

QM also supports quality inspections in production in interaction with external work (intermediate inspections and final

inspections).

INCOMING INSPECTION

The incoming goods inspection is intended for the purchasing, sales and stock transfer process. 

The incoming inspection in purchasing is intended for the inspection of purchase deliveries. Purchasing deliveries can be posted

directly via the purchase order or the goods receipt, depending on the setup of the storage location. If "Perform quality

inspection from purchasing" is activated for the storage location in question and an inspection plan has been set up in the

inspection plan usage for the combination of article and vendor, the system automatically creates an incoming inspection for the

posted purchasing delivery. 

Receipt check in sales is intended for checking incoming postings from posted returns due to a sales complaint. Returns can be

posted directly from the complaint or the goods receipt, depending on the setup of the storage location. If "Perform quality

inspection from sales" is activated for the storage location in question and an inspection plan has been set up in the inspection

plan usage for the combination of article and customer, the system automatically creates an incoming inspection for the posted

return.

The incoming inspection for transfer order is intended for the inspection of transferred items. The incoming inspection from

transfer order is created automatically if “Perform quality inspection from stock transfer” is activated for location (field

“Transfer-from Code”) of the stock transfer order and an inspection plan with the origin type “Incoming inspection from stock
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transfer” has been created for the item to be transferred in the inspection plan usage. The inspection order from a stock transfer

order is identical to an inspection order from a purchase order or a sales complaint.

The list of incoming inspections to be processed from purchase deliveries, sales complaints or transfer orders can be called up

directly via the corresponding tile in the “Quality Management (QM)” role center. You can also open the list of incoming

inspections to be processed from the ribbon of the role center via “Tasks > Inspection orders > Incoming inspection”. 

The list of incoming inspections to be processed can be opened from the purchase order, sales complaint and transfer order via

the relevant document line and the call “Line > Inspection orders”. In this case, the list is filtered to:

the origin number (order number / sales complaint number / stock transfer order number)

the origin type (purchase line / sales line / stock transfer line)

the origin line number

By displaying the filter area and removing the filter on the origin line number, the list view can be expanded so that all incoming

inspections to be carried out for the relevant purchase order / sales complaint / stock transfer order are listed.

INTERMEDIATE EXAM

Intermediate inspections are created automatically when production orders are processed. If "Perform quality inspection from

production" is activated for the storage location in question and if an inspection plan has been set up in the inspection plan usage

for a combination of article and work center, work center group or operation in the routing, the system creates the respective

inspection order for the intermediate inspection. This means that several intermediate inspections can exist for different work

steps in a production order.

Intermediate checks are created automatically when a simulated or firmly planned production order is transferred to a released

production order via the status change. 

If a released production order is created directly, the execution of the function Update production order triggers the creation of

the intermediate inspections. If changes are made to a released production order for which interim inspections already exist,

executing the Update production order function again causes existing interim inspections to be deleted and new interim

inspections to be performed based on the current data of the released production order.

The list of interim inspections to be processed can be called up directly in the role center QM - Quality Assurance via the

corresponding tiles. There are two tiles, one tile for intermediate inspections from in-house production operations and one tile

for intermediate inspection of external operations. You can also open the respective list of interim inspections to be processed

from the role center ribbon via Tasks > Inspection orders > Interim inspection or Interim inspection (external).

From the production order, the list of intermediate inspections to be processed can be opened by calling Line > Inspection order. 

FINAL INSPECTION

The final inspection for a production order is created automatically if "Perform quality inspection from production" is activated

for the storage location of the production order and an inspection plan is set up in the inspection plan usage for the origin type

final inspection for the article to be produced. A final inspection is created automatically when the last operation is posted via the

production ledger sheet or the actual message ledger sheet. 

If the last operation is an external work, the final inspection is generated by posting the delivery of the external work order.

The list of final inspections to be processed can be opened in the QM - Quality Assurance role center directly via the

corresponding Final inspections tile. You can also open the list of final inspections to be processed from the role center menu via

Tasks > Inspection orders > Final inspection.

MANUAL TEST

The QM quality assurance module allows you to create manual checks.

To do this, go to the menu Departments > Quality assurance > Manual inspection and select the menu item Create manual

inspection.

By means of the Stock transfer book sheet you can transfer an article to the storage location or storage bin of the quality

inspection. The stock transfer creates a manual inspection.

• 

• 

• 
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The following table describes the fields of the CREATE MANUAL CHECK form.

To fill the Book. sheet and create a manual check, proceed as follows on the CREATE MANUAL CHECK form: 

Navigate to the function Get bin contents in the menu.

Enter a posting date and document number.

In the request window you can make further restrictions so that only the desired items appear.

After you have executed the Get bin contents function, the book.sheet will be filled automatically.

For the New storage location code and New storage bin code fields, make sure that the storage location has been set up for quality

inspections and that the new storage bin code corresponds to the set up QA storage bin on the storage location map.

You can use the Post & Create Check Orders function to create a Manual Check for the generated rows.

Via Departments > Quality assurance > Manual inspection > Manual inspections, you can perform the generated manual

inspection.

For the treatment of the dimensions: When fetching the bin contents, the dimensions are NOT written to the rows. This is a known

limitation of the Microsoft Dynamics 365 Business Central1 standard, not of the product. If you go via "Select item" the dimensions

are taken over correctly.

When creating a manual inspection, it can basically come to the state that the quantity to be inspected is fetched from several

different item items, each of which can have its own dimensions. However, because this is not clear, no dimensions are seen on

the inspection order. If dimensions are stored at the test order, only these are written to the incoming article items, the outgoing

dimensions compensate for the old items. Important: The check order does not add any dimensions to the article item, but

replaces them, if they exist. However, if no dimensions are stored in the check order, then the dimensions of the existing item are

passed on to the new item.

TEST ORDER

Test orders have an identical structure, regardless of their origin. A test order is divided into a test order header and the

associated test order lines. The basis for the test order is the test plan described in the basic setup. 

Field Description

Book. sheet name Use Lookup to select the book sheet you want to use.

Item no. Enter in this field the item no. for which the bin contents are to be retrieved.

Article variant If there is an article variant, you can enter it here.

Storage location In this field, enter the storage location from which you want to retrieve the content.

1. 

2. 

3. 

4. 

5. 

6. 

Note
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Field Description

No. The unique number of a test order. The assignment of the number is defined to the quality assurance

facility via the number series in the Test order numbers field

Test plan no. This non-editable field contains the test plan number of the test plan that was accessed to create this

test order.

Test plan version

no.

If test plan versions exist for the test plan, this non-editable field shows the test plan version number

that was accessed to create this test order.

Inspection plan

description/

Inspection plan

description 2

These non-editable fields are automatically filled with the test plan descriptions.

Test severity Depending on the sampling rule and the jump instructions, the field is automatically filled by the

system. The field is not editable.

Possible test severities are

• Normal

• Reduces

• Tightened

The inspection severity was used to determine the relevant sampling requirement in the inspection

order and the required inspection quantity was calculated based on the document quantity.

Test type If the test plan used allows destructive testing, this is indicated here. The field is not editable.

Drawing If a drawing (file) has been stored in the test plan, it is available here in the test order and can be

opened. The field cannot be edited.

Item no. This field contains the article number of the item to be checked. Depending on the origin type, this is

the item from the goods receipt, from the production order or from the manual inspection.

Article description/

Article description

2

Search Keyword

These fields are taken from the article master. The fields are not editable.

Document quantity This field is filled with the document quantity. This is either the total goods receipt quantity, the total

production quantity or the selected total stock of a manual inspection. This field is not editable.

Required test

quantity

The document quantity and the sampling requirement result in the required inspection quantity, i.e.

the number of inspection items to be inspected in the inspection order according to the rules and

regulations. This field is not editable.

Quantity to check This field indicates the actual quantity to be checked. For items without item tracking, this quantity is

preset with the required check quantity. For items with item tracking, the quantity to check must be

defined by assigning corresponding serial and/or batch numbers. The quantity to check can be

reduced to the required check quantity. Likewise, the quantity to check can be increased up to a

maximum of the document quantity. Since the "Quantity to check" determines the number of checks

in the check matrix, a whole number without decimal places must always be entered here. If the

document quantity contains decimal places and a check of the total quantity is required, the

document quantity rounded up to a whole number can be entered in the "Quantity to check" field.

(See "Perform check")

Quantity to lock The quantity to be blocked must be entered in this field before the check is completed. (See "Perform

check")

Quantity destroyed The quantity destroyed during the test must be entered in this field before the test is completed. (See 

"Perform check")

Storage location

release

This field displays the storage location used from the origin document and is not editable.
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Field Description

Storage bin release This field shows the used bin from the origin document. The field is editable.

Storage location

blocking storage

This field is filled with the default from the Storage Location Setup Quality Assurance tab and is not

editable.

Storage place

blocking storage

This field is filled with the default from the Storage Location Setup Quality Assurance tab and is not

editable.

Storage location

destroyed items

This field is filled with the default from the Storage Location Setup Quality Assurance tab and is not

editable.

Storage place

destroyed items

This field is filled with the default from the Storage Location Setup Quality Assurance tab and is not

editable.

Justification special

release

A reason must be entered in this field in the case of a special release (See "Perform check").

Quality number This field is calculated from the number of inspections, the number of deviations and the findings of

the inspection plan line (OK, minor defect, major defect, critical defect) and defect factors (weighting)

stored in the quality inspection setup according to the following formula:

Quality number =

101- (Total number of exams

+ Weighted minor error deviations

+ Weighted main error deviations

+ Weighted Critical Error Deviations)

/ Total number of tests

(see example for the calculation of the quality number)

The quality number can assume a value between 0 and 100.

This field is not editable. The value of the quality number of an incoming inspection is included in the

supplier rating.

Built on This field is automatically filled with the date once the test has been set up.

Built by This field is automatically filled by the system with the logged-in user who triggered the check.

Modified on This field is automatically created by the system when entries or changes are made in the test order.

Modified from This field is automatically filled in with the user logged in to the system as soon as a field is changed.

Employee no. In this field, a responsible employee for this check can be selected from the previously set up

employee table.

Employee first

name

Displays the first name of the employee from the employee table. The field is not editable.

Employee name Displays the name of the employee from the employee table. The field is not editable.
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Field Description

Origin reference

area

In the "Origin reference" group, fields are displayed that represent the document / operation from which

an inspection order was created. Clicking on the Assist button in the "Document type" field will take you

to the corresponding reference.

Document type The document type of the document that caused the test order is displayed hereFollowing options are

possible:

• Purchasing / Order

• Sale / Complaint

• FA line (This type is used for final checks)

• Routing line (This type is used for intermediate checks)

• Item book. Sheet

• Transfer Order

Note:

With the origin reference "Item-book.sheet", no document can be displayed via the Assist button, since

the book sheet was only used to generate a manual check and does not represent an independent

document.

Document no. This field contains the number of the document of origin.

Document line

no.

This field contains the line number of the origin document.

Work plan no. This field is used only for intermediate checks. The number of the task list that caused the intermediate

check is entered here.

Working aisle

no.

This field is used only for intermediate checks. The number of the operation that caused the intermediate

check is entered here.

Booking limit

area

In the "Posting reference" group, fields are displayed that form a reference to the posted document.

However, the posting reference is filled only if there is a corresponding posting transaction in the system

that caused the check order. This happens in the following cases:

• Receipt inspection from posted purchase delivery

• Receipt check from posted sales return

• Final inspection from a production order

Note:

The posting reference remains empty for manual checks and checks for operations, since no posted

document is stored by the system for these check types.

Document type Specifies the type of document of the posting reference. The following options are possible:

• Booked purchase delivery

• Booked return

• Item journal (for actual messages from the production order)

• Posted transfer input 

Clicking on the Assist button in the "Document type" field will take you to the corresponding reference

Document no. Specifies the number of the posting reference document.

Document line

no.

Specifies the line number of the item in the referenced posting document. For the document type "item

journal", the field remains empty, since the item journal is already uniquely determined by the document

number.

Logistics

reference area

In the group "Logistics reference" fields are displayed that form a reference to the posted goods

receipt.In the area "Logistics reference" only the reference to a posted goods receipt is displayed. This is

only managed if the underlying storage location has been set up in such a way that putaways have to be

created as part of the goods receipt. Only then does the logistics reference also make sense in an
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The documents caused by the external work (purchase order / delivery) are not kept in an inspection order. Even in the case of

external work, the production order for which the external work was requested is the primary document for the inspection order. The

reference to the corresponding ACTUAL message (final inspection) or to the operation (intermediate inspection) is then kept in the

inspection order. 

Inforegister lines

The test order lines are filled from the specifications of the test plan when the test order is created. In addition, the results of the

individual tests are displayed in the test order lines. A final test result must be set in each test plan line. The following table

describes the fields of the test order line.

Default fields

Field Description

inspection order, because only in this case are putaways created from the inspection order that must

have a reference to the posted goods receipt.

Document type Indicates the type of document of the logistics reference. Here always a posted goods receipt. Clicking

on the Assist button in the "Document type" field takes you to the corresponding reference.

Document no. Indicates the number of the logistics reference document.

Document line

no.

Specifies the line number of the item in the referenced logistics document.

Note

Field Description

Position The item number according to the inspection plan line.

Inspection feature code The inspection characteristic code according to the inspection plan line.

Attribute The inspection type according to the inspection characteristic or inspection plan line.

Description The description of the inspection characteristic.

Test equipment groups No. The test equipment group number according to the test plan line.

Test equipment no. The test equipment number according to the test plan line.

Test equipment status The status of the test equipment existing at the time of creation of the test order.

Test equipment designation The designation of the test equipment group or test equipment according to the test plan

line.

Manual free size tolerance

class

The manual clearance tolerance class according to the test plan line

Fit The fit according to the test plan line.

Min. set point The minimum target value of the characteristic according to the inspection plan line

Set point The setpoint according to the test plan line.

Max. Set point The maximum setpoint according to the test plan line

Units code The reference unit for the entered dimensions according to the test plan line.

Test note The inspection note according to the inspection plan line.

Specification The file attachment, taken from the test plan line.

Required test quantity The calculated inspection quantity. This is calculated from the sampling specification and the

document quantity.
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Fields filled when performing the check

Example for the calculation of the quality number

With the setup for the weighting of the defect findings shown above and the adjacent illustration of the test results, the formula

...

Quality number = 101 - (Total number of tests 

+ Weighted minor error deviations 

+ Weighted main error deviations 

+ Weighted Critical Error Deviations) 

/ Total number of tests

Quality number = 101 - ( 15 + ( 2 x 10) + (0 x 30) + (1 x 60) ) / 15 = 94.67

Perform quality check

The following sections explain how a quality inspection is performed. The execution of an inspection is identical for all inspection

order types. Completed quality inspections of the type incoming inspection (vendor) are included in the supplier evaluation. The

inspection result can be made available as a document to the supplier in the event of justified complaints. Within production, the

intermediate inspections performed and the final inspection performed can be used as proof of quality for documenting the

production process. 

SET QUANTITY TO CHECK

In the inspection order header, the required inspection quantity has been calculated via the sampling specification and the

document quantity. The quantity to be inspected defines the actual quantity to be inspected. In principle, the quantity to be

inspected can be kept different from the calculated required inspection quantity. You can set the quantity to be inspected lower

and you can also increase the quantity to be inspected up to a maximum of the total document quantity.

Item without article tracking

For items without item tracking, the required check quantity is automatically written to the Quantity to check field. 

Item with article tracking

For articles with article tracking, it is mandatory that the indicator "Batch no. warehouse" or "Serial no. warehouse" is set to Yes

for the article tracking codes used. The item tracking information must also be carried across storage bins.

For items with item tracking, the required inspection quantity is automatically written to the Quantity to inspect field only in the

intermediate inspections of production. In incoming inspections, final inspections or manual inspections, the quantity to inspect

must be defined via the item tracking lines assigned to the inspection order. To do this, use the Assist button of the Quantity to

check field. In the page opened by this, all posted batch numbers with movement quantity (base) or all posted serial numbers

with movement quantity (base) = 1 are displayed. In the Quantity to check column, enter the required check quantity for the

respective batch number. For serial numbers, you must enter the quantity to check = 1 for the respective serial number to be

checked until you have reached the required quantity to check.

RECORD TEST RESULTS

The inspection results for the individual inspection order lines can be recorded in two different ways:

Field Description

Number of exams This field displays the number of recorded tests for the test order line.

Actual value (min.) This field displays the smallest measured value of the test order line.

Actual value (average) This field displays the average value of all measurements of the test order line.

Actual value (Max.) This field displays the largest measured value of the test order line.

Quantity Deviating This field shows how many measurements are outside the tolerance of Min. Set point value lie

Test result Finally, the inspector must enter the inspection result for the inspection order line in this field.

1.3.14 Quality Management

- 1509/1545 - Copyright © 2018 - 2024 KUMAVISION AG



Recording in the test result matrix

The test result matrix is called up via the Test result matrix button in the menu ribbon of the test order.

In the inspection result matrix, all inspection order lines are displayed one below the other. Behind the information from the

inspection order lines (position, inspection characteristic code, unit code, attribute, min. nominal value, nominal value and max.

nominal value), the fields for recording the inspection results are displayed in the following numbered columns. Target value),

the fields for recording the inspection results are displayed in the following numbered columns. The number of columns

corresponds to the quantity to be inspected defined in the inspection order. A maximum of 32 columns for recording the results

can be displayed on one page of the test results matrix. If the "Quantity to check" is larger, you can scroll to the next recording

record using the "Next record" button. The "Previous record" button is used to return to the previous record of test results. In

the test results matrix, no more results can be recorded than have been defined via the quantity to be tested.

General information from the test order is displayed in the header of the test result matrix. Filters of the test result matrix are

displayed in the Display options area. These display options can be changed. According to the display options set, it is possible to

switch to the test result matrices of other test orders without having to leave the test order itself. The buttons on the left and

right of the test result matrix page are used for this purpose.

Acquisition via test data

The test data is called up via the Lines > Test data button. In the test data page, the individual test results are recorded line by

line for the test order line from which the call was made. No number of lines is predefined based on the quantity to be inspected.

If test results have already been recorded via the test result matrix, they are displayed line by line on the test data page. The test

data can be used to record other values in addition to the pure test result.

Fields of the Test Data table

Field Description

Test specimen

no.

You can enter a number in this field for each specimen to be inspected. If the data was recorded via the

test results matrix, the test data is already available. The test data lines are numbered chronologically

starting with 1.If the data is recorded via the test data, the test specimen no. can also be assigned

manually. Test data is only displayed in the test results matrix if the manual test specimen no. is assigned

chronologically starting with 1.

Actual value

Attribute

fulfilled

If the characteristic is not attributive, the Actual value column is displayed. The measured actual value

must be entered in this field.

If the attribute is an attributive characteristic, the Attribute fulfilled column is displayed. In this field it is

to be indicated whether the attribute is fulfilled or not.

Deviation If the characteristic is not attributive, the Deviation column is displayed. The value displayed is the

deviation of the actual value from the minimum setpoint or the deviation of the actual value from the

maximum setpoint. Setpoint resulting from the actual value. A deviation of 0 means that the actual value

is within the min. and max. setpoint. Setpoint. The field is not editable.

Deviation

present

Non-attributive characteristic

The Deviation present field is displayed with Yes if the actual value is outside the min. and max.

setpoints. Setpoint.

Attributive characteristic

The field Deviation present is displayed with Yes if attribute fulfilled was entered with No. The field is not

editable.

Check error

code

A check error code can be entered in this field

Error category

code

In this field the error category code of the test error is automatically taken over. This field can also be

filled manually

Test error

description

In this field the description of the test error is automatically taken over. A test error description can also

be entered as free text in this field.
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TEST FEATURE TEST RESULT

After an inspection has been performed and recorded for all test items, the "Inspection data" window or the "Inspection results

matrix" can be closed. The entered data is transferred to the lines of the test order. From the input of the actual values, the

minimum and maximum actual values are determined and an average is calculated. These values are entered by the system in

the Actual value (min.), Actual value (average) and Actual value (max.) fields. The number of your test data per test order line is

displayed in the Number of tests field. Via Drilldown you can display the respective test data. 

On the basis of the test data entered and the min., max. and average values determined from them, you must carry out a test

result for each test item. To do this, select your assessment in the "Test result" field. The following options are available: * blank

No check result set * in order

The inspection characteristic is free of defects. This result can only be set, if there are no deviations. * Minor defect

The inspection characteristic is not free of defects. The error is classified as a minor error * Main error

The inspection characteristic is not error-free. The error is classified as a main error * critical error

The inspection characteristic is not free of errors. The error is classified as a minor error

The definition of a minor, major and the critical error must be defined internally. A minor defect is not of great importance, while

a major defect restricts the use of the item and a critical defect could have serious consequences. If you leave the field blank, you

have not recorded a valuation for this inspection item and cannot complete the inspection order. The characteristic of the result

is subject to the subjective assessment of the user and can be fixed per inspection characteristic, but not per inspection item.

TEST DECISION FOR A TEST ORDER

An inspection order is completed via an inspection decision. Depending on whether the Inspection requirement on release field is

activated, the inspection can only be completed if you have entered the specified quantity to be inspected in the inspection data

for each inspection order line. Once you have recorded all the prescribed tests and assigned a test result to each test order line,

you can use the menu with the respective buttons to complete the test order as follows:

Release document quantity

Release 

Special release 

Document quantity locks

• 

• 

• 

• 
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The following table illustrates which inspection decision is possible depending on which recorded inspection data and quantity

fields.

Field Release document

quantity

Release Special release Document quantity

locks

"Test result" field

in test order

lines

All test order lines

must be "in order".

All test order lines

must be "in order".

At least one test

order line must be

unequal to "in

order".

At least one test

order line must be

unequal to "in order".

Quantity to be

released" field in

the test order

header

The complete

document quantity is

automatically

released. Entries are

not taken into

account.

Inputs are

processed.

Inputs are

processed.

Inputs are not

processed; an error

message occurs when

the action is executed

Quantity to

block" field in

the test order

header

Inputs are not

processed; an error

message occurs

when the action is

executed

Inputs are

processed

Inputs are

processed

The complete

document quantity is

automatically

blocked. Entries are

not taken into

account.

Quantity

destroyed" field

in the test order

header

Entries are only

possible for the

Destructive test type.

Inputs are not

processed; an error

message occurs

when the action is

executed

Inputs are only

possible with

Destructive test

type Inputs are

processed.

Entries are only

possible for the

Destructive test

type. Inputs are

processed

Entries are only

possible for the

Destructive check

type. Inputs are not

processed; an error

message is displayed

when the action is

executed.

Which quantity

check takes

place in the

background?

The reference

quantity for the

quantity check is

always the total

document quantity

Sum of quantity to

be released,

blocked and

destroyed may be

max. the document

quantity

Sum of quantity to

be released,

blocked and

destroyed may be

max. the document

quantity

The reference

quantity for the

quantity check is

always the total

document quantity

What quantities

are booked?

Always the entire

document quantity

maximum the

document quantity,

or less

maximum the

document quantity,

or less

Always the entire

document quantity

Is a follow-up

test order

possible?

no yes, with the

remaining quantity

yes, with the

remaining quantity

no

Feature none none Field Reason

special release

becomes

mandatory field

none
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If the document quantity is blocked for a check order, it is possible to create a purchasing complaint.

It is possible to create a purchase complaint in the following cases:

• Block document quantity in a single-level storage location

• Block document quantity in a two-level storage location without picking

CHANGE INSPECTION PLAN FOR INSPECTION ORDER

Via "Action>Function>Change test plan" you have the possibility to manually use another test plan for the test order instead of

the test plan set up in the test plan usages.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

1. 

1.3.14 Quality Management

- 1513/1545 - Copyright © 2018 - 2024 KUMAVISION AG



1.3.15 Sales Order Status

Overview

The Sales Order Status app provides you with visual cues of how far customer orders have progressed at line level regarding:

Item availability

Transfer of items to the warehouse area

Picking

Shipment

Invoicing

Multiple filters can be set on each view, and the existing color indicators can be replaced with icons of your choice.

Benefits:

Visual representation for maximum transparency

Quick response to bottlenecks in warehousing and logistics

Prompt billing after order fulfillment

Satisfied customers thanks to easy-to-glean stock levels

Timely information flow to management for data-driven decision-making

Introduction

Sales Order Status | KUMAVISION App from KUMAVISION on Vimeo.

Get KUMAVISION Sales Order Status from Microsoft AppSource

More learning resources

Besides this article, you can consult the following user-friendly resources to learn more about the Sales Order Status feature:

Product videos

To see all videos about the app, use the general search function in Microsoft Dynamics 365 Business Central1 and enter Product

Videos. Pick a video from the page and run it.

Tours

You can also take a tour explaining the app’s most important features. When you’re on a page that includes Sales Order Status

content, go to the ribbon at the top, choose the Help icon, and then select Take a Tour in the first About… FactBox.

Setup

SALES ORDER STATUS SETUP

After installation of the app:

Choose the Search icon, enter Sales Order Status Setup, and then choose the related link.

Fill in the fields as described in the following table.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

1. 

2. 
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Item Availability

The Incl. Planning Suggestions and Incl. Sales Blanket Orders in Avail. Calc. settings only affect the calculation of availability

indicators; they have no impact on standard app calculations, such as Item Availability by Event.

Signal Lights

During installation, icons for the red, yellow, and green indicators and a blank (transparent) icon are automatically stored in

setup. If you prefer to use your own symbols, select one of the icons on this FastTab and choose the file you want to upload.

To avoid performance issues (long loading times) when opening the sales order list, we recommend that you use small-size images

when replacing the existing files.

Order statuses

ORDER INDICATORS

After installation, the sales order list shows the following additional indicators:

As the indicators aren't calculated automatically, the fields listed will be blank when you open the Sales Orders page for the first

time.

Field Description

Incl. Planning Suggestions in Avail.

Calc.

Specify whether you want to include planning worksheets in item availability

calculations.

Incl. Sales Blanket Orders in Avail.

Calc.

Specify whether you want to include blanket sales orders in item availability

calculations.

Calculate status when opening sales

order status

Specify if all indicators should be calculated automatically when the Sales Order

Statuses page is opened.

Note

Note

Field Description

Availability Status Specifies if the required items are available in full (green), available in part (yellow), or not available

at all (red).

Whse. Shipment

Status

Specifies if the related item lines are included fully (green), partially (yellow), or not at all (red) in

warehouse shipments.

Pick Status Specifies if the related item lines are included fully (green), partially (yellow), or not at all (red) in

warehouse or inventory picks.

Shipment Status Specifies whether the relevant items have been shipped completely (green), partially (yellow), or not

at all (red).

Inv. Status Specifies whether the relevant items have been invoiced completely (green), partially (yellow), or

not at all (red).

Note
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CALCULATE STATUSES

To determine the status of one or more sales orders, open the sales order list, select the relevant documents and choose Actions

> Function > Calc. Sales Order Statuses on the ribbon.

FILTER BY ORDER STATUS

To filter sales orders by status, for example, to see all orders that are ready to be shipped, open the sales order list and choose

Related > Order > Sales Order Statuses on the ribbon.

On the General FastTab, you can then use the following filter options to see if enough items are available for a certain sales order

or determine how far their inclusion in warehouse, picking, shipping, and invoicing processes is:

No Status

Red

Yellow

Green

Show All

The following actions can also be run from the ribbon of the page:

Update Sales Orders Statuses

Determines the status of all selected sales orders.

Update All Sales Orders Statuses

Determines the status of each sales order on the page.

Show Document

Shows the related order document.

Sales Order Lines Status

Shows the sales order line statuses of the currently selected sales order.

Invt. Pick Lines

Shows the inventory pick lines related to the currently selected sales order.

Whse. Shipment Lines

Shows the warehouse shipment lines related to the currently selected sales order.

LINE STATUSES

To see a detailed list of sales line statuses, you can use the general search function (and enter Sales Order Lines Status) or

choose Related > Order > Sales Order Lines Status on the ribbon of a sales order or the order list.

This list can be especially useful regarding lines where the status is set to Yellow. The following functions are also available on

the page ribbon:

Calc. Sales Order Lines Statuses

Recalculates the sales order statuses on the lines.

Pick Lines

Shows the associated pick lines.

Whse. Shipment Lines

Shows the associated warehouse shipment lines.

• 

• 

• 

• 

• 

• 

• 

• 
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Colors

SALES ORDER LIST

If a sales order doesn’t contain any lines or the status lights on all its lines are blank, the lights on the Sales Orders page are also

blank. Otherwise, the colors have the following meaning on the page:

If a certain indicator is yellow on at least one order line, the light is also yellow for the order overall.

If a certain indicator is red on some sales lines but green on other lines, the light on the sales order list is yellow.

If a certain indicator is green on some sales lines but non-existent on other lines, the light on the list is green.

If a certain indicator is red on some lines but non-existent on other lines, the light on the list is red.

SALES LINES

The following tables describe the meaning of each status color on individual order lines.

Availability

If an assembly order is connected to a sales line, an availability calculation by event is performed for each assembly line that is of

type Item and where the remaining quantity is greater than zero. Availability indicator colors have the following meaning in

reference to assembly orders:

WHSE. SHIPMENT

• 

• 

• 

• 

Color Meaning

(blank) Either the sales line is not of type Item or the No. field on the line is blank, the Quantity (Base) is negative

or zero, or the line is part of a drop shipment.

Green The outstanding quantity on the sales line is zero.

The indicator is also green if the Projected Available Balance is greater than zero before the item

transaction scheduled on the sales line and zero or greater than zero after the event (same rules as for

standard Item Availability by Event calculations).

Yellow The projected available balance before the item transaction scheduled on the sales line is positive but

negative thereafter (see standard Item Availability by Event calculations).

Red The balance before the item transaction scheduled on the line is negative or zero (for more details, see

standard Item Availability by Event calculations).

Color Meaning

Green The sales line is not linked to an assembly line of type Item with a remaining quantity greater than zero.

Yellow The quantity that is consumed is greater than zero. Additionally, the Projected Available Balance before

the item transaction scheduled on the assembly line is negative or zero (same rules as for Item Availability

by Event calculations).

Red At least one assembly line carries an availability warning.

Color Meaning

(blank) The Quantity (Base) is negative or zero on the sales line or the line does not require a warehouse

shipment.

Green A shipment is necessary, but the Quantity (Base) equals the Quantity Shipped on the sales line so that

there is nothing to deliver anymore.

Yellow A warehouse shipment line exists for the sales line and some items still need to be delivered.

Red A warehouse shipment is required, but a warehouse shipment line does not exist for the sales line.
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A warehouse shipment is required if:

The sales line is of type Item.

The No. field is filled in on the line.

A location code has been selected.

The Require Shipment toggle is turned on for that location.

PICK

A pick is required if:

The sales line is of type Item.

The No. field is filled in on the line.

A location code has been selected.

The Require Pick toggle is turned on for that location.

SHIPPING

INVOICING

What happens after the free trial has expired?

What happens after the free trial? from KUMAVISION on Vimeo.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

• 

• 

• 

• 

Color Meaning

(blank) The Quantity (Base) is negative or zero on the sales line or the line does not require picking.

Green A pick is necessary, the outstanding quantity on the pick line is zero, and the quantity left on the sales line

equals the total of Qty. Picked and Quantity Shipped on the associated warehouse shipment line.

Yellow A pick or registered pick exists for the sales line.

Red A pick is required, but a pick or registered pick does not exist for the line.

• 

• 

• 

• 

Color Meaning

(blank) The Quantity (Base) on the sales line is zero.

Green The Quantity Shipped equals the Quantity (Base) on the sales line so that there is nothing to deliver

anymore.

Yellow The Quantity Shipped is smaller than the Quantity (Base) on the line.

Red The Quantity Shipped is zero.

Color Meaning

(blank) The Quantity (Base) on the sales line is zero.

Green The Quantity (Base) on the line equals the Quantity Invoiced on the sales line so that there is nothing to

bill anymore.

Yellow The Quantity (Base) is greater than the Quantity Invoiced on the line.

Red The Quantity Invoiced is zero.

1. 
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1.3.16 Sanction Check

Overview

Thanks to a whole host of fully automatic processes integrated into Microsoft Dynamics 365 Business Central, the Sanction

Check app helps avert situations where you might run the risk of getting into business with sanctioned individuals or

organizations around the world.

With the new functionality, you can make sure that your vendors, customers, and employees comply with all applicable export

control legislation, multiple trade restriction lists issued by the United States, and the EU’s anti-terrorism regulations (EC

881/2002 and 2580/2001).

What you get:

Highly efficient checks against export restrictions

A log that meets all regulatory requirements

Manual review of address and personal information and periodic review of base data

Automatic checks when creating sales or purchase documents

Blocked contacts listed during transactions

No hidden costs—pay only for the checks you need

Introduction Sanction Check

See the following playlist for more videos explaining the app's functions:

Link to Microsoft App Source "KUMAVISION Sanction Check"

More learning resources

Besides this article, you can consult the following user-friendly resources to learn more about the Sales Order Status feature:

Product videos

To see all videos about the app, use the general search function in Microsoft Dynamics 365 Business Central1 and enter Product

Videos. Pick a video from the page and run it.

Tours

You can also take a tour explaining the app’s most important features. When you’re on a page that includes Sales Order Status

content, go to the ribbon at the top, choose the Help icon, and then select Take a Tour in the first About… FactBox.

Setup

WIZARD

After installation of the Sanction Check app, the setup wizard opens.

Alternatively, you can run the wizard by selecting Assisted Setup > Sanction Check or enter the required information directly in 

Sanction Check Setup.

• 

• 

• 

• 

• 

• 
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SANCTION CHECK SETUP

General FastTab

S-Check FastTab

The S-Check FastTab and the information provided on it are only available in on-premises environments.

Sales FastTab

On this FastTab, you can select the document transactions and addresses that sanction checks should be run on in sales.

Purchasing FastTab

Here you can select the document transactions and addresses that sanction checks should be run on in purchasing.

Field Description

Validity Period Specify, in days, until when the results of sanction checks are valid. Afterward, the checks must be

rerun with the help of the job queue.

Save Request and

Return Data

Specify if, besides the results, all incoming and outgoing data streams related to the checks should

be saved.

If this toggle is turned on, requests to and responses by the web service are stored in the app and

can be viewed on the Sanction Check Entities page.

Max. Message Size Specify, in bits, the message size limit for search requests.

Note

This value should only be changed if a corresponding error message is returned by the web service.

Use Own Contract Our partner company ecovium is in charge of keeping the sanctions database up to date.

We, on the other hand, provide you with prepay packages for a quick and easy start to checking for

sanctions. Typically, checks are billed based on a pay-per-use model, the details of which were

negotiated between ecovium and KUMAVISION AG.

If your company entered into a separate agreement with ecovium, turn on this toggle and enter the

account information for the agreement.

You can also specify allowlists and blocklists here and run other ease-of-use functions.

Note

Switching from pay-per-use packages to annual contract-based billing might lead to additional costs.

Field Description

S-CHECK Endpoint Address Shows the web service endpoint. The default address is:

"https://z3.tia.com/Kumavision-SCHECK/addressScreening"

S-CHECK User Name Specify the username for login to the web service.

S-CHECK Password Specify the password for login to the web service.

S-CHECK Company Specify the S-CHECK company for connecting to the web service.

S-CHECK Search Profile Name Specify the search profile name for the web service.
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Result Bitmaps FastTab

On this FastTab, you can specify the icons that should be used to indicate the results of sanction checks. Options are:

None

No check has been run.

Undecided

The check results aren’t clear.

OK

No sanctions seem to be in place.

Blocked

Sanctions have been found.

Ribbon functions

Batch Check of Entities

Checks if sanctions have been placed on a business contact or employee within the specified filters.

Excluded from the check are contacts and employees with a check result that is still valid or for whom the Skip Sanction Check

toggle is turned on.

Force Batch Check of Entities

Rechecks if sanctions have been placed on a customer or vendor within the specified filters.

This function can be used to check business contacts that the Skip Sanction Check toggle is turned on for or contacts whose last

check is still valid.

Job Queue Entries

These entries specify—based on Report 70112170 (Sanction Check Batch)—when checks should be repeated.

Adding a sanction check entry to the job queue means that the check is going to be run regularly (that is, when it hasn’t been run yet

and whenever its result is no longer valid), with each check needing to be paid for.

Workflows

Indicates the response to changes in check results.

A template named ‘Block customer or vendor due to sanction check result,’ to block customers or vendors entered on sanctions

lists, is already available for this purpose.

Use sanction checks

CUSTOMER CHECK

To check for sanctions placed on a customer, open the relevant customer card, and then choose the Force Sanction Check Update

action in the Sanction Check FactBox.

If sanctions are found, the customer is blocked. Otherwise, the system returns a result of OK or Undecided.

You can use the lookup on the Result field to open the Sanction Check Entities page, where you find more information about the

result.

• 

• 

• 

• 

Note
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VENDOR CHECK

To check for sanctions placed on a vendor, open the relevant vendor card, and then choose the Force Sanction Check Update

action in the Sanction Check FactBox.

If sanctions are found, the vendor is blocked. Otherwise, the system returns a result of OK or Undecided.

You can use the lookup on the Result field to open the Sanction Check Entities page, where you find more information about the

result.

CONTACT CHECK

To check for sanctions placed on a contact, open the relevant contact card, and then choose the Force Sanction Check Update

action in the Sanction Check FactBox.

If sanctions are found, the contact is blocked. Otherwise, the system returns a result of OK or Undecided.

You can use the lookup on the Result field to open the Sanction Check Entities page, where you find more information about the

result.

EMPLOYEE CHECK

To check for sanctions placed on an employee, open the relevant employee card, and then choose the Force Sanction Check

Update action in the Sanction Check FactBox.

If sanctions are found, the employee is blocked. Otherwise, the system returns a result of OK or Undecided.

You can use the lookup on the Result field to open the Sanction Check Entities page, where you find more information about the

result.

AUTOMATIC CHECKS BEFORE DOCUMENT TRANSACTIONS

In Sanction Check Setup, you can specify the documents and addresses that should be checked prior to making transactions.

Automatic check of customer or vendor

A check specified for a document and address in Sanction Check Setup is run automatically when you initiate the corresponding

transaction (such as the release of a sales order).

Checks are only run if they haven’t been or if their results are no longer valid.

If an entry on a sanctions list is found during a check, the relevant document function is blocked.

ENTITY SANCTION CHECKS

This list shows all the checks that have been run so far, including their results and associated details. You can specify in Sanction

Check Setup whether the list should also store all incoming and outgoing XML files related to the checks.

Sanctions check lists

Australian Consolidated List [aus-csl]

CH – SECO Sanctions List [ch-seco]

Consolidated Canadian Autonomous Sanctions List [can-ccasl]

EU – Common Foreign & Security Policy [eu-cfsp]

EU – Ukraine-/Russia-Related Sanctions [eu-ruua]

Iran Watch – Iranian Entities [iw-sus]

Iran Watch – Suppliers [iw-sup]

JP – METI End User List [jp-meti]

List of Foreign Financial Institutions Subject to Correspondent Account or Payable-Through Account Sanctions (CAPTA List)

List of Foreign Financial Institutions Subject to Part 561 [us part561]

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Military End User (MEU) List

Non-SDN Chinese Military-Industrial Complex Companies List (NS-CMIC List)

Non-SDN Menu-Based Sanctions List (NS-MBS List)

Palestinian Legislative Council List [ns-plc]

UK – Consolidated List of Financial Sanctions Targets [hm-list1]

UN – Al-Qaida Sanctions List [un-aqsl]

UN – Consolidated Sanctions List [un-csl]

US – Denied Persons List [dpl]

US – Entity List [el]

US – Foreign Sanctions Evaders List [fse]

US – List of Persons Identified as Blocked Solely Pursuant to Executive Order 13599 [13599-list]

US – Nonproliferation Sanctions List [isn]

US – Sectoral Sanctions Identifications List [ssil]

US – Specially Designated Nationals List [sdn]

US – Statutorily Debarred Parties List [dtc]

US – Unverified List [uvl]

Buy additional requests

If you want to buy additional requests, open the KUMAVISION Module Setup page, and then choose Actions > Buy App Packages

on the ribbon.

FAQs

Yes. You can use the Update Sanction Check action in the Sanction Check FactBox for this.

Set the Skip Sanction Check toggle on the relevant customer or vendor card (on the Shipping or Receiving FastTab). This skips the

check so that you can edit the record.

Note: Make sure that the result of the check really is a false positive.

No. The batch job excludes contacts who have already been reviewed unless their last check is no longer valid. Use the Validity Date

field in Sanction Check Setup to specify when checks should be rerun.

The Sanction Check Entities page lists every check available, whatever its result. If specified in setup, the page also stores all

incoming and outgoing data streams related to the checks.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Can I rerun a sanction check after editing a business contact despite the result of the current check still being

valid?

How can I deactivate a check, for example, because the result from it turned out to be a false positive?

Does the batch job run checks on all business contacts?

Where do I find information about all the sanction checks run in the app?
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You need to right-click the link, and then choose Open Link in New Tab.

No. This is because you need to be able to trace the checks that have been run. You can find all their results (and more) on the

Sanction Check Entities page.

What happens after the free trial has expired?

What happens after the free trial? from KUMAVISION on Vimeo.

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

How can I open a link shown in the Entity Line Comment FactBox on the Sanction Check Entity page?

Can I delete the result of a check?

1. 
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1.3.17 Split by Picking Area

Overview

The KUMAVISION Split by Picking Area app allows you to define different picking areas within a location by specifying individual

bins. When picking is initiated, the app will create picking lists based on these areas. For each picking area, a separate picking

list will be generated. The app can only be used if the company uses a two-staged logistics solution consisting of warehouse

shipping and picking. In addition, controlled warehousing may not be implemented.

Benefits of the Split by Picking Area app:

Optimization of your picking processes

Quick and simple definition of picking areas

Clear structure by aggregation of multiple picking lists in a single delivery note

Practical examples:

Example of small and bulky items:

In a particular storage location, small items are picked manually, bulky items by using a forklift truck. The Split by Picking Area

app allows you to generate separate picking lists for small items and for bulky items. The customer, however, will only receive a

single delivery note.

Example of multiple warehouses:

Your main storage location consists of multiple warehouses. The Split by Picking Area app allows you to generate one picking list

per warehouse – instead of a single overall picking list.

Introduction

Split by Picking Area | KUMAVISION App from KUMAVISION on Vimeo.

Get KUMAVISION Split by Picking Area from Microsoft AppSource

Setup

After successful installation of the app, some setup steps are required. These are explained below.

LOCATION

You need to enable the following switches for the location where you want to define picking areas:

Split Picks By Picking Area

Require Shipment

Require Pick

The Split Picks By Picking Area field has been added to the Location card automatically after successful installation of the app.

All other fields are default fields.

CREATE PICKING AREAS

To define the picking areas for your location, use the Tell Me function to open the Picking Area List.

• 

• 

• 

• 

• 

• 

Note
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Click New in the ribbon to define a new picking area, using the following fields:

ASSIGN AREAS TO BINS

To assign picking areas to the bins existing in a location, open the location and then click Bins from the ribbon. The Bins card

opens. Here, you can assign the desired picking area to each bin by selecting it in the Picking Area Code field.

Use the app in your processes

Once all setup steps have been completed, the system will generate separate picking lists for each picking area in the warehouse

shipping process.

EXAMPLES

Example 1: Small and bulky items

Your items are stored in a location where the warehouse employees pick smaller items from the floor rack manually, while

picking bulky items from the high-level rack using a forklift truck. This means that you need to create two picking areas. If an

order includes mixed items from the high-level rack and from the floor rack, two picking lists will be generated. Your warehouse

employees can then start with picking the floor rack items manually and then pick all items from the high-level rack using the

forklift truck.

Example 2: Different Warehouses

Your main storage location consists of different warehouses. Instead of creating one picking list for all warehouses, the app will

generate a separate picking list for each warehouse.

Field Description

Location Code Select the location code of the location for which you want to define the picking area.

Code Assign a meaningful abbreviation for the picking area, e.g. High.

Description Enter a description for the picking area. Example: High-level rack.
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What happens after the free trial has expired?

What happens after the free trial? from KUMAVISION on Vimeo.
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1.3.18 Vendor Rating Management

Overview

Vendor rating is used for classifying and categorizing vendor master data based on transparent standards.

This means that vendor rating supports you in evaluating critical vendor requirements.

The following requirements can be defined:

Audits

Adherence to schedules

Adherence to quantities

Freely definable rating types

Setup

Before you can use the Vendor Rating Management app, prepare the system accordingly. This section describes and explains the

required setup.

VENDOR RATING SETUP

The basic setup for Vendor Rating Management is done in the Vendor Rating Setup card. Open this card via the Tell Me function.

In the Rating Reference Date, you can specify the reference date used for determining adherence to schedules. The following

options are available:

Promised Receipt Date

Specifies the date for which the vendor promised delivery of the purchase order line items.

Expected Receipt Date

Planned Receipt Date + Safety Lead Time + Inbound Whse. Handling Time = Expected Receipt Date

Planned Receipt Date

Order Date + Vendor Lead Time = Planned Receipt Date

In the Audit No. Series field, you can specify the number series for audits.

• 

• 

• 

• 

1. 

2. 
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RATING TYPES

You can create various rating types in the system, distinguishing manual and system-defined criteria. System-defined criteria are

the criteria for adherence to schedule and quantity, as well as quality.

Field Description

Code Here, you can specify a unique rating type abbreviation.

Rating Group This field is used to specify the system-defined criteria.

Select one of the available options:

Blank

For manual criteria.

Due Date

For the ‘adherence to schedule’ system-defined criterion.

Qty.

For the ‘adherence to quantity’ system-defined criterion.

Quality

For the ‘quality’ system-defined criterion.

(Please note that Quality rating is only possible in connection with the Quality Management (QM)

module.)

Audit

For creating audits.

Note

For creating an audit, it is mandatory to set up an Audit rating type with Rating Group=Audit.

For this rating type, you can neither specify ratings nor rating points.

The sole purpose of this rating type is that a corresponding rating entry will be created automatically

once an audit is completed.

Description Shows the description of the rating type.

Value Type Here, you can specify whether to use absolute or percentage values.

Note

The Value Type field is linked to conditions. For example, if Rating Group=Due Date, select Absolute to

enter absolute values, and for Rating Group=Qty, select Percentage to enter percentage values.

Otherwise, the system will display an error message.

Status Specifies the status of the rating type. The following options are available:

• New

• Certified

• Under Development

• Closed

Note

Only rating types with the Certified status can be used in your processes.

Rating Values

exist

Indicates whether rating values have been specified for the rating type.

Rating Points

Exist

Indicates whether rating points have been specified for the rating type.
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For each rating type, you can specify rating values. To do so, select the desired rating type and click Rating Values from the

ribbon.

You can enter rating points for each rating value. To do so, select the desired rating value and click Rating Points from the

ribbon.

RATING TEMPLATES

Using rating templates, it is easy to rate your vendors based on identical criteria. As a prerequisite, you need to define the rating

template.

To do so, open Rating Templates card via the Tell Me function. To create a new rating template, click New in the ribbon. The

available fields are explained below:

Field Description

Rating Type

Code

This field is preset by the system according to the selected rating type.

Code Abbreviation of the rating value.

Description Shows the description of the rating value.

Qty. Indicates the quantity for the rating value that will be applicable in later processes with respect to the

specified rating reference date.

Scored Points Indicates the score for the corresponding rating value.

Note

When you enter the points, the system will automatically create a row for the scored points in the Rating

Points table.

Field Description

Rating Type Code This field is preset by the system according to the selected rating value.

Rating Code This field is preset by the system according to the selected rating value.

Vendor Group

Code

If you want to rate certain vendor groups by assigning rating points that differ (are higher or lower)

from the default, you can assign the vendor group in this field.

Note

You need to enter a separate line with the corresponding rating points for the corresponding vendor

group.

Item Group Code If you want to rate certain item groups by assigning rating points that differ (are higher or lower) from

the default, you can assign the item group in this field.

Note

You need to enter a separate line with the corresponding rating points for the corresponding item group

group.

Starting Date Shows the date as of which the record is valid.

Scored Points Displays the points scored for this rating.
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General FastTab

Rating Types FastTab

On the Rating Types FastTab, you can add any number of rating types for your rating template. The available fields are explained

below:

Classification FastTab

VENDOR GROUP RATINGS

On the Vendor Group Ratings card, you can group vendors so that rating points can be defined individually for each group.

Field Description

Code Here, you can specify a unique rating template abbreviation.

Description Shows the description of the rating template.

Status Shows the status of the rating template. The following options are available:

• New

• Certified

• Under Development

• Closed

Note

Only rating types with the Certified status can be used in your processes.

Total Weight Displays the total of the weights from the rating template lines.

Field Description

Sequence No. This field defines the order of rating types for later processes, i.e., how they will be displayed in the

rating template and later in the rating result. This sequence can be customized.

Rating Type

Code

In the Rating Type Code field, you can assign the desired rating type for your rating template.

Description Shows the description of the assigned rating type.

Weight Here, you can specify the weight of this rating type.

Note

The total weight of all rating types must be 100.

Default Points Here, you can specify default points that should be included in the rating, if applicable. This means that

in case no rating entries are available for the vendor and rating type, the default points will be applied

when the system calculates the rating.

Note

Default points will be used if there are no rating entries for the respective vendor and rating type in the

system.

Field Description

A -H: Classification

Points

Here, you can specify the classifications. Enter the score from which on each classification

should be applied.

Note

You need to enter a score at least for classification A. All other classifications are optional.
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Open the Vendor Group Ratings card via the Tell Me function. Click New to define a new vendor group, using the fields described

below:

Once defined, the vendor rating group can be assigned in the Vendor Group Code field on the Vendor Rating FastTab of the

corresponding Vendor Card.

ITEM GROUP RATINGS

On the Item Group Ratings card, you can group items so that rating points can be defined individually for each group.

Open the Item Group Ratings card via the Tell Me function. Click New in the ribbon to define a new item group using the

following fields:

Once defined, the item rating group can be assigned in the Item Group Code field on the Vendor Rating FastTab of the

corresponding Item Card.

AUDIT QUESTIONS

Audit questions help you define audits in a structured manner. First, open the Audit Questions card via the Tell Me function.

Click New to define a new audit question using the fields described below:

Use the Instructions action to specify more detailed instructions for the corresponding question. These instructions will be

copied to the audit templates or audits automatically and help clarify the intention of the interview to be conducted.

AUDIT TEMPLATES

Audit templates will ease your job when composing an audit for a vendor.

For this purpose, open the Audit Templates card via the Tell Me function. Click the New action to define a new audit template.

The available fields are explained below:

Field Description

Code Assign a unique abbreviation for the vendor rating group.

Description Shows the description of the vendor rating group.

Field Description

Code Assign a unique abbreviation for the item rating group.

Description Shows the description of the item rating group.

Field Description

Code Assign a unique abbreviation for the audit question.

Description Shows the description of the audit question.
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General FastTab

Lines FastTab

Use the Instructions action on the ribbon to specify more detailed instructions for the corresponding question. These instructions

will be copied to the audits automatically and help clarify the intention of the interview to be conducted.

REPORT SELECTION - VENDOR RATING

Several reports are available for vendor rating:

Vendor Rating

Rating List

Finished Audits

Audit

Before you can use these reports, you need to initialize the report selection once. To do so, open the Report Selection - Vendor

Rating card via the Tell Me function. Click the Initialize action to initialize the reports. Initialization automatically sets the

reports in the report selection.

ITEM

Vendor Rating FastTab

On the Vendor Rating FastTab of the Item Card, you can specify the following vendor rating settings:

Field Description

Code Here, you can specify a unique audit template abbreviation.

Description Shows the description of the audit template.

Status Shows the status of the audit template. The following options are available:

• New

• Certified

• Under Development

• Closed

Note

Only audit templates of the Certified type can be used in your processes.

To edit an existing audit template, set its status to Under Development.

Field Description

Question Code Specify the question code here (audit question).

Description Shows the description of the question code (audit question).

• 

• 

• 

• 

Field Description

Item Group Code Selection of an item group.

Excluded from Rating Enable this switch if you want to exclude the item from vendor rating.
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VENDOR

Vendor Rating FastTab

On the Vendor Card, you can specify the following vendor rating settings on the Vendor Rating FastTab:

In addition, this FastTab shows data of the last vendor rating that was performed. For more details, see the Rate a Vendor

section.

Vendor Rating

AUTOMATIC VENDOR RATING

Automatic vendor rating refers to the Quantity, Due Date, and Quality rating criteria. When the system posts a purchase order, it

will automatically register the adherence to quantity and schedule (due date), and quality rating criteria.

For automatic quality rating, you need the separate QM - Quality Management module from KUMAVISION AG. It is not included in

this module!

MANUAL RATING

The purpose of manual rating is to record soft rating criteria, such as communication, and to include them in vendor rating.

Besides automatic rating using the Quantity, Due Date, and Quality rating criteria, you can add manual criteria in all purchase-

related documents. This applies to the following documents:

Purchase Quote

Purchase Order

Purchase Invoice

Purchase Return Order

Purchase Credit Memo

Warehouse Receipt

The function can be invoked in an identical manner in all these documents. Select the desired line, open the Lines FastTab, click

the Line menu item and select Manual Rating.

As an alternative, you can specify manual vendor rating directly in the associated Vendor Card. To do so, click Actions > Vendor

Rating > Manual Rating from the ribbon.

Field Description

Vendor Group Code Selection of a vendor rating group.

Excluded from Rating Enable this switch if you want to exclude the vendor from vendor rating.

Note

• 

• 

• 

• 

• 

• 
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Manual rating includes the following information:

You can enter multiple ratings in this form.

In order to generate vendor rating entries based on manual ratings, you need to post the manual ratings. To do so, invoke the

posting function by selecting Actions > Post Manual Rating from the ribbon. When the action is completed, the system displays

an acknowledgement message Then, the Manual Rating Entries area of the form will display the generated vendor rating entries.

In the Manual Rating form, you can also cancel a vendor rating entry resulting from manual rating. To do so, click Cancel Manual

Rating next to Manual Rating Entries. This opens the Cancel Rating Entries form. For details, please refer to the Canceling

Vendor Rating Entries section.

Field Description

Rating Type Code Selection of the rating type (rating criterion).

Rating Type Description Shows the description of the selected rating type.

Rating Code Selection of a rating value associated with the selected rating type.

Rating Description Shows the description of the selected rating value.

Rating Points Shows the rating points for the selected rating value.

Posting Date Shows the date on which the manual rating was posted.
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VENDOR RATING ENTRIES

The Vendor Rating Entries page is the central place for vendor rating data. It stores the results of both automatic and manual

entry registrations.
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Field Description

Entry No. This field contains the sequential number that has been assigned to this vendor rating entry. Each

vendor rating entry has a unique number, which is assigned to it automatically in the posting process.

Vendor No. Specifies the vendor number associated with the entry. This field is copied automatically from the Buy-

from Vendor No. field of the purchase order when the entry is registered.

Type Indicates the type of document line.

The following options are available:

Blank

This field remains blank if the rating is not related to a document line of a G/L Account, Item, Fixed

Asset, Charge (Item), or Work Center type and consequently the No. field is not populated.

G/L Account

The line refers to a G/L account.

Item

The line refers to an item.

Fixed Asset

The line refers to a fixed asset.

Charge (Item)

The line refers to a surcharge/reduction. 

Work Center

The line refers to a work center (subcontractor).

No. Shows the number of the corresponding type.

Description Shows the description of the No. field.

Vendor Group

Code

Shows the vendor group the vendor has been assigned to. This field is populated automatically when

the entry is registered.

Item Group Code Shows the item group the item has been assigned to. When the entry is registered, this field is

populated automatically based on the data specified for the item.

Posting Date Shows the date on which the associated document has been posted.

Document Date Shows the date on which the associated document was created.

Rating Group Shows the item or vendor rating group.

Rating Type Shows the code of the assigned rating type.

Rating Type

Description

Shows the description of the assigned rating type.

Rating Code Shows the assigned rating code. In case of automatic ratings, this code is assigned by the system; for

manually entered ratings, the code entered manually is displayed.

Rating Description Shows the description of the rating code.

Scored Points Shows the points scored in this rating.

Target Qty. Shows the original quantity in the purchase order line.

Actual Qty. Shows the actually delivered quantity in the purchase order line.

Qty. Delta Shows the difference between the original quantity and the actually delivered quantity for the

purchase order line.
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Source Document Action

You can display the source document of each vendor rating entry. The source document is the document that triggered the

generation of the vendor rating entry. This includes both manual and system-generated (Quantity, Due Date) ratings.

Field Description

Qty. Delta

(Percent)

Shows the percentage difference between the original quantity and the actually delivered quantity for

the purchase order line.

Rating Reference

Date

Specifies the basis for the Due Date rating of the delivery (Promised Receipt Date, Expected Receipt

Date, or Planned Receipt Date).

Promised Receipt

Date

This is the date for which the vendor promised delivery of the purchase order. This field is populated

based on the data in the purchase order line.

Expected Receipt

Date

Shows the date on which the item is expected to be available in the warehouse. This field is populated

based on the data in the purchase order line.

Planned Receipt

Date

Shows the date on which the item will arrive in the warehouse. This field is populated based on the

data in the purchase order line.

Date Delta in Days This field shows the day difference between the rating reference date and the actual date of receipt.

Source Type This is an internal field. It shows the system table based on which the entry was created.

Source Info This field contains a description of the source document this vendor rating entry was created from.

Source Purch.

Doc. Type

This field is only relevant for purchase documents. It indicates the purchase documents type of the

source document.

Source System ID This is an internal field. This field shows the unique ID of the record in the table of the corresponding

source document.

Source ID This is an internal field. This field indicates the number of the table record that triggered the

generation of this entry.

Source Ref. No. This is an internal field. It shows the line number of the record of a table based on which this entry

was created.

Cross-Ref. Type This is an open document (Purchase Order), while the source type references the receipt.

Reference Info This field contains a description of the reference document this vendor rating entry was created from.

Ref. Purch. Doc.

Type

This field is only relevant to purchase documents. It indicates the purchase document type of the

reference document.

Ref. System ID This is an internal field. This field shows the unique ID of the record in the table of the corresponding

source document.

Reference ID This is an open document (Purchase Order), while the source type references the receipt.

Reference Ref. No. This is an open document (Purchase Order), while the source type references the receipt.

Cancelation A checkmark in this field indicates that this entry has been canceled. This can be caused by the

cancellation of a delivery or the cancelation of a vendor rating entry. For details, please refer to the 

Canceling Vendor Rating Entries section.

Cancelation Date This field shows the date when the vendor rating entry was canceled.

Cancelation User This field shows the user who canceled the vendor rating entry.

Cancelation

Description

This field shows the comment that was entered when the entry was canceled.
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Reference Document Action

A vendor rating entry may reference a reference document. In this context, a reference document is considered a purchase order

or a purchase return order because links to other documents, such as Warehouse Receipts, Receipts, Invoices, Return Receipts,

and Credit Memos, are based on these documents. This means that if a vendor rating was entered, e.g., for a posted purchase

receipt, the posted purchase receipt is entered as the source document in the entry. The purchase order, which was the basis for

creating the receipt, is then entered as the reference document.

Cancel Rating Entries Action

It is possible to cancel vendor rating entries. For this purpose, you can use the Cancel Rating Entries action in the Vendor Rating

Entries list. When you invoke this action, the selected vendor rating entries are displayed in a separate cancelation document.

For details, please refer to the Canceling Vendor Rating Entries section.

CANCEL VENDOR RATING ENTRIES

It is possible to cancel vendor rating entries, no matter whether they were generated automatically by the system when you

posted a document or whether they were created manually. Canceled vendor rating entries are not taken into account for vendor

rating.

Vendor rating entries can be canceled in the following ways:

1. Automatically when canceling a purchase receipt:

When you cancel a posted purchase receipt, the vendor rating entries associated with the corresponding lines are also canceled.

You need not do anything.

2. On the Manual Rating form:

The Cancel Manual Rating function is directly available on the Manual Rating form for canceling selected vendor rating entries.

To do so, click Cancel Manual Rating next to Manual Rating Entries. This opens the Cancel Rating Entries form, displaying the

selected entries. Here, you can cancel these entries after entering a cancelation description.

3. Directly from the Vendor Rating Entries list:

The cancelation function for vendor rating entries is also available in the Vendor Rating Entries list. To cancel entries, select

them from the list and then click Actions > Cancel Rating Entries from the ribbon to open the Cancel Rating Entries form. Here,

you can cancel these entries after entering a cancelation description (reason for canceling) in the Cancelation Description field.

It is not possible to cancel entries without giving a reason. Then, cancel the vendor rating entries by clicking the Cancel Rating

Entries action.

When a vendor rating entry has been canceled, the following fields will be populated:

RATING ENTRIES ON PURCHASE DOCUMENTS

Vendor rating entries can not only be displayed on the Vendor Card, but also in the associated purchase documents. This applies

to open and posted as well as archived documents. For this purpose, the Vendor Rating Entries action is available on the Lines

FastTab.

When you select the Vendor Rating Entries action, the system will show the entries associated with the corresponding document

line where this document line has been specified as the source document.

Exceptions are purchase orders and purchase return orders because links to further purchase documents, such as posted

purchase receipts or posted purchase invoices, are based on these documents. For these types of documents, vendor rating

entries can be displayed in the following ways:

Field Description

Cancelation A checkmark in this field indicates that this entry was canceled.

Cancelation Date This field shows the date when the entry was canceled.

Cancelation User This field shows the user who canceled the entry.

Cancelation Description This field shows the reason for canceling the entry.
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1. Document Rating Entries

Document rating entries are vendor rating entries that are associated directly with the document. Such a direct association

exists if the respective document is specified as the the source document in the vendor rating entries.

2. Related Rating Entries

Related rating entries are vendor rating entries that have not been associated directly with the corresponding purchase order /

purchase return order, but reference the corresponding purchase order / purchase return order as a reference document.

Example: The vendor rating entries for Quantity and Due Date that are associated with a posted purchase receipt (source

document), but contain the related purchase order as the reference document. This means that the corresponding entries can be

viewed in the corresponding purchase order as Related Rating Entries.

Audit

DEFINE AND PERFORM AUDITS

Audits are helpful to review and evaluate processes, requirements, and rules using general investigation procedures. This is a

method used frequently in quality management. You can define, rate, and document audits of your vendors and use them as

proof, if required. Audit rating results yield a possible characteristic for vendor rating.

Open the Audits card via the Tell Me function. To create a new audit, click New in the ribbon. As an alternative, you can create

the audit directly from the Vendor Card by clicking Actions > Vendor Rating > Audits from the ribbon.

The fields available on the Audits card are explained below:
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General FastTab

Lines FastTab

Use the Instructions action on the ribbon to specify more detailed instructions for the corresponding question. These instructions

may clarify the intention of the interview to be conducted.

If an answer is given to a question that cannot be accommodated in the Comment field due to its length, click the Audit Comment

action to enter it there.

Field Description

No. This field contains a unique identification of the audit. The number can be assigned using a

number series or manually.

Description In this field, enter a description of the audit.

Vendor No. Use the lookup button to select the target vendor of the audit.

Audit Director In this field, select the auditor in charge from the user table.

Audit Date In this field, enter the date of the audit.

Status In this field, you can view the current status of the audit. To edit it, click the Change Status menu

item from the ribbon.

The following settings are available:

New

This status indicates that the audit has just been created.

Planned

This status can be set to indicate that the audit will be performed or rated shortly.

In Progress

This status indicates that the audit is being conducted now or is being processed.

Completed

You can set this status once the audit has been completed.

Completed on This field is populated automatically by the system. It shows the date when the audit was

completed.

Completed by This field is populated automatically by the system. It indicates the user who created the audit.

Achieved Points Scored The contents of this field is calculated by the system based on the audit lines. This is the audit

result that can be incorporated into the vendor rating.

Max. achievable Points

Scored

This field indicates the maximum points (100) that can be achieved in the audit.

Template No. This field shows the audit template being used. For further details, please refer to the Setting a

Template” section.

Field Description

Question Code In this field, you can select the predefined questions you are going to ask your vendor in this audit.

Description This field is defaults to the description (=Audit Question) of the assigned Question Code.

Points Scored This field indicates the result, i.e. the rating of this audit question.

Comment Here, you can enter additional comments on the audit question and the associated score.
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Actions

Set Template

The action bar includes the Set Template function. It can be used to add previously created audit templates to the audit so that

the questions defined in the template will be used in the audit.

Print

The Print action (available via Reports) allows you to print the audit questionnaire.

This printout can be forwarded to your vendor, asking them to answer it, or you can use it when conducting the audit. For this

reason, neither the points scored nor the comments are included in the printout.

Change Status

To change the status of your audit, click the Change Status action. The following options are available:

ARCHIVED AUDITS

Audits with the Completed status are listed in the Archived Audits list. Alternatively, the archive can be invoked directly from the

Vendor Card by clicking Related > Vendor Rating > Archived Audits from the ribbon.

Rate a vendor

Vendor rating can be conducted either by opening the respective Vendor Card and clicking Actions > Vendor Rating > Vendor

Rating, or generally by opening the Perform Vendor Rating window via the Tell Me function. If you call the function from the

Vendor Card, a filter has been set for this vendor.

The following filter criteria are available on the Vendor Ratings form:

Status Description

New This status indicates that the audit has just been created.

Planned This status can be set to indicate that the audit will be performed or rated shortly.

In Progress This status indicates that the audit is being conducted now or is being processed.

Completed Set this status once the audit has been completed. Once an audit has the Completed status, it is no longer

displayed in the Audits list, but in the Archived Audits list.

Field Description

Rating Date The rating date is preset by the system. It is the same as the work date of the system.

Rating Template Code This field shows the code of the rating template to be used for vendor rating.

This field is mandatory.

Rating Template Description Shows the description of the selected rating template code.

Start of Rating Period Shows the beginning of the rating period.

This date is optional.

End of Rating Period Shows the end of the rating period.

This date is mandatory. It must not lie before the rating date or the current work date.

No. This field can be used to filter on a certain vendor.

Purchaser Code This field can be used to filter on a certain purchaser.

Responsibility Center This field can be used to filter on a certain responsibility center.
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Generated vendor ratings can be viewed later either generally via the Tell Me function by entering Vendor Ratings or, for a

particular vendor, by opening the respective Vendor Card and clicking Related > Vendor Rating > Vendor Ratings from the

ribbon.

The following fields are available on the Vendor Ratings list:

VENDOR CARD

On the Vendor Card, the Vendor Rating FastTab shows the last rating determined for this vendor.

API communication

Microsoft Dynamics 365 Business Central1 On-Premise and online provide an API that allows integration with other services. In

order to activate the integration using these APIs, some preliminary steps must be performed to enable access to the APIs. For

more details, please refer to Enabling APIs for Dynamics 365 Business Central.

KUMAVISION Vendor Rating Management adds multiple endpoints to the standard API in order to enable the integration of the

Vendor Rating app.

Field Description

Entry No. This field contains the sequential number that has been assigned to this vendor rating.

Each vendor rating has a unique number. XXX

Vendor No. Indicates the vendor number related to this rating.

Vendor Name Indicates the name of the vendor related to this rating.

Rating Date Shows the date on which the vendor rating was created.

Rating Template Code Indicates the rating template based on which this vendor rating was created.

Rating Template Description Shows the description of the rating template.

Start of Rating Period Shows the start date of the relevant rating period.

End of Rating Period Shows the end date of the relevant rating period.

Scored Points Indicates the points scored in this rating.

Rating Classification Indicates the rating classification based on the points scored.

Field Description

Last Rating Entry No. Indicates the sequential number of the last rating entry created.

Last Rating Date Shows the date of the last rating.

Last Rating Template Code Indicates the code of the rating template based on which the last vendor rating was

created.

Last Rating Template

Description

Indicates the description of the rating template code.

Start of Rating Period Shows the start date of the last rating period.

End of Rating Period Shows the end date of the last rating period.

Rating Points Indicates the points scored in the last rating.

Rating Classification Indicates the classification of the last rating.
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For information on how to activate the APIs for Microsoft Dynamics 365 Business Central1, please refer to Enabling the APIs for

Dynamics 365 Business Central.

API RESOURCES

Rating

Rating Type

Rating Entries

Audit Template

Audit Template Line

Audit

Audit Line 

Archived Audit

Audit Archive Line

Microsoft, Microsoft Dynamics, and Microsoft Dynamics 365 are trademarks of the Microsoft group of companies. 

Note

• 

• 

• 

• 

• 

• 

• 

• 

• 

1. 
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